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1  Hazard Warning

Dieser Warnhinweis ist Bestandteil des erworbenen Pandoras Box Produktes.

This warning note is part of the Pandoras Box product that you have purchased.

Cet avertissement fait partie du produit Pandoras Box que vous avez acheté.

Gefahrenhinweise:
Betreiben Sie das Gerät nur in Innenräumen und vermeiden Sie den Einfluss von
Feuchtigkeit,Staub sowie Sonnen- oder andere Wärmebestrahlung. Öffnen Sie
das Gerät nicht, es enthält keine durch den Anwender zu wartenden Teile.

Hazard information:
This device is to be operated indoors only and to be kept away from the influences
of humidity,dust and sunshine or other radiating heat sources. Do not open the
device. It does not contain any parts to be maintained by the user.

Avertissements de danger:
Installez l'appareil dans un endroit à l'abri de la chaleur, de l'humidité et de la
poussière. N'exposez pas l'appareil directement aux rayons solaires ou à des
sources de chaleur telles que radiateurs, fours, etc. Ne pas ouvrir l’appareil, il
contient aucun composant a maintenir par l’utilisateur.zzz

Vorsicht!
Explosionsgefahr bei unsachgemäßem Austausch der Batterie. Ersatz nur durch
den denselben oder einen vom Hersteller empfohlenen gleichwertigen Typ.
Entsorgung gebrauchter Batterien nach Angaben des Herstellers.

Caution! 
Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions. 

Attention! Il y danger d’explosion s’il y a replacement incorrect de la batterie.
Remplacer uniquement avec une batterie du meme type ou d’un type équivalent
recommandé par le constructeur. Mettre au rebut les batteries usagées
conformément aux instructions du fabricant.

Verbrauchte Batterien gehören nicht in den Hausmüll! Entsorgen Sie diese in Ihrer
örtlichen Batteriesammelstelle!

Used batteries are not to be disposed of with the house-hold waste! Please
dispose them at your local battery collection point!

Ne pas jeter les piles aux ordures menageres (loi relative aux piles et accu).
Veuillez rapporter vos piles usagees dans un centre de collecte agree.
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Entsorgungshinweis:
Gerät nicht im Hausmüll entsorgen! Elektronische Geräte sind entsprechend der
Richtlinie für Elektro- und Elektronik-Altgeräte über die örtlichen Sammelstellen für
Elektronik-Altgeräte zu entsorgen.

Instructions for disposal:
Do not dispose off the device as part of household garbage! Electronic devices are
to be disposed of in accordance with the guidelines concerning electrical and
electronic devices via the local collecting point for old electronic devices.

Instruction pour l’ élimination des dechets:
Ne jetez pas l’appareil en fin de vie avec les ordures ménagères, mais déposez-le
à un endroit prévu à cet effet par les pouvoirs publics pour son recyclage.

Dieses Gerät darf nur unterhalb von 2000m Höhe genutzt werden.

This device may only be used lower than 2000m altitude.

Ce produit est seulement utilisable à une altitudes inférieures à 2000m.

Dieses Gerät darf nicht in Tropenregionen genutzt werden.

This device may only be used in non-tropical regions. 

Ce produit est seulement utilisable dans les régions non tropicales.
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2  Conformity and Electrical Information

Electrical Information

AC Input:
100VAC / 240VAC
12 / 6A (max.)
50/60Hz

Warning! This is a class A device. Operation of this equipment in a residential area is likely to cause
harmful interference in which case the user will be required to correct the interference at his own
expense.

Please see below the declarations of conformity and compliance statements for Player and Server
hardware. Please contact the support team if you need documents for other hardware e.g. the SMPTE
Link, NET Link, software dongles, or if you need them in German or another language.

Pandoras Box Server Conformity

The Pandoras Box Server devices (including the models Server Dual, Server Quad and Server Broadcast;
hardware revision 2) are ETL and CE certified. The devices comply with FCC Rules and Regulations as
Part 15 devices, as well as Industry Canada standard ICES-003.

FCC and ICES-003 compliance statement

FCC, part 15, Class A verification:
This equipment has been tested and found to comply with the limits for a class A digital device, pursuant
to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of these
equipment in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.

mailto:support@coolux.de
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Pandoras Box Player Conformity

The Pandoras Box Player devices (including the models Player Dual and Player Quad) are CE certified.
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3  What's New?

This "What's New" chapter lists updates from Pandoras Box including its tools. For updates regarding
Widget Designer , please go to the next chapter.

[Rev 15083 and 14583] - Version 6.0 

++ Multi-User ++

Pandoras Box version 6 introduces the Multi-User feature
allowing several operators to work on the same Master file loaded
with a Manager license. As the ways to build shows with
Pandoras Box are so versatile, Multi-User editing is a flexible
feature. This means that you can choose what exactly you would
like to synchronize and how often or when you like to do so.
As soon as another Manager is in the same LAN network (and

Domain) it participates as another Multi-User. The new tab Multi-User  allows to setup the Multi-
User environment and gives an overview on all Users (also called Places) online.

The first possibility for Multi-Users is to work in a "Sync Session" where all changes are synced
continuously and seamlessly between all Users. However, you can also activate the "Blind Mode"
within the Sync Session for working with an independent Nowpointer and Active Values. This allows
you for example to jump to "your" time in the Sequence to store content or to view content in the
Preview.
You can leave and (re-) join the Sync Session at any time. When joining a Sync Session you are
asked to load the session project. 

Alternative to (fully or partly) synchronized programming, you can work asynchronously in a separate
project and send ("push") your changes at a certain time, e.g. checked or newly encoded content,
warp and softedge settings, parts of a Sequence, etc. The "Run Operation" button in the Multi-User
tab opens a dialog to define these Pull and Push Operations.

Note also that the Configuration is newly structured. All settings that are listed in the Global category
apply to all Multi-Users whilst the other ones apply only locally.

++ New Structure for the Preview Tab ++

As you will see when reading on, many v6 features are
associated with the Preview making it as powerful as never
before. Together with the features, we enhanced the structure
of the Preview by adding buttons and drop-down lists around
the main window. Some buttons are fixed and they either set a
view option or toggle to one of the new modes (the image to
the left shows where to find these buttons). Tools on the other
hand vary because they depend on the chosen mode.

Mostly, a "Parameter Floater"  is contained. The Floater
refers to certain parameters and allows very fast and accurate programming. The Floater dialog can
be undocked from its position.

In case you maximize the Preview to full screen (shortcut [CTRL+SHIFT+F]) a new window "Button
Bar" opens and shows all modes and associated tools. Its shortcut is [T] to show and hide it. 

See the Preview chapter  for full and accurate information about all the new options or read on for a
short description of the new Preview features.
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++ Editable Meshes Allow Warping in the Preview ++

One of the biggest v6 features is the Editable Mesh which allows
to warp in the Preview.
To create one, right-click in the Project tab and choose "Add
Editable Mesh". Per default the newly created Editable Mesh
folder lists one Sub Mesh called "Surface" being a planar 2D
mesh in fullscreen size. The Surface's Inspector lets you change
the Segment count (known as Mesh points in the Warper), the
Control Point count (aka FFD), mesh size and segments and

other parameters.
Alternatively, you can import an existing object and convert it to an Editable Mesh using the right-
click menu.
An Editable Mesh can be assigned to a Layer or an Output. When you set the Preview to the new
"Mesh Editing Mode" the Segments and Control Points become visible. Above the Preview you may
find according buttons to select and move either the orange FFD points or gray vertex points. You can
warp using the mouse or the keyboard. The above mentioned "Parameter Floater" shows the exact
position in pixels.

In the Output layer  you may find a new "Edit Warp Mesh" button. It either selects the Output
Mesh or creates a new one for you and enters the "Editable Mesh" mode.

All this and more is explained in the chapter about the Mesh Editing Mode .

++ UV Texture Mapping in the Preview ++

In addition to the introduction to warp inside Pandoras Box, we
also included texture mapping to the Preview. In short, texture
mapping is the way how the texture (i.e. the media file) fits onto
the mesh or in other words, which pixel from the 2D (UV) texture
belongs to which 3D (XYZ) coordinate. The Pandoras Box
Preview now offers two different modes to apply and modify the
UV source: the planar and the perspective UV Mapping Mode.

The planar one probably reminds you of how you worked in the
Warper. You have the choice between two differently sized
planar maps and the default 1:1 map.
The perspective mapping is totally new. Depending on the Layer
and Camera position a so called Reference Layer positions itself
and "projects" the UV source onto the 2D or 3D mesh.

Either way, after choosing the method, you click the "Imprint"
icon to calculate the UV coordinates and toggle back to another
Preview mode. Of course you can always go back and modify
the UV source, e.g. you can fine-tune the mapping by moving
selected vertices.
The Sub Mesh Inspector  offers the option to reset all
changes.

Read more in the chapter about the UV Mapping Modes  in
the Preview...
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++ Enhanced Canvas ++

Version 6 comes with a significantly improved Canvas. It is
now possible to draw directly in Pandoras Box with tools
provided in the Preview tab. In addition, the Canvas Asset can
be saved, exported and (re-)imported. All together the Canvas
feature now also allows to mask directly in Pandoras Box.
Right-click in the Project tab and choose "Add Canvas".
Assign the Canvas to a Layer overlaying your other Layers.
Until now nothing changes as the default Canvas is still empty.
To draw on it select the "Canvas Editing Mode" in the Preview,
leave the Brush tool selected but change the Color to black.

You can draw (and erase) freehand by clicking and dragging. Straight lines can be done by clicking
once on the beginning and holding the Shift key when clicking on the end point of the line.
To export the mask as a *.png file, right-click on the Canvas and choose "Export". After editing the
image for example with another graphics software you can import it with another right-click on the
same Canvas. Alternatively, you can add an image file to the project, right-click it and say "Create
Canvas from Image".
Read more about the Canvas Editing Mode...

++ Camera Interaction in the Preview ++

With this version you can interact with Cameras in the Preview in
the same way as you are used to position Layers.
First, set the Preview to a Camera View (incl. the "All Cameras"
view) and switch to the new mode "Camera Transformation
Mode".

If you now click on the Camera rectangle it highlights blue and
you can drag it around. This changes the X and Y Offset
parameters.

Cameras of a Server have more parameters available. First, click
the "Camera Visibility" button to toggle the Camera icon and

frustum as seen in the left picture. Now you can either drag the Camera icon around which influences
the Camera Viewpoint and Target simultaneously, or you can drag the Viewpoint and Target
separately. Hold the [ALT] key down to move the Camera / Viewpoint only and the [ALT] and [SHIFT]
key for the Target.

++ Enforced 2D Interaction in the Preview ++

The continuous development to interact with more and more
items in the Preview directly now allows to change Layers,
Cameras, Mesh Points etc. To optimize this workflow and reduce
errors, version 6 introduces a slightly changed interaction.
Eventhough you still work with 3D parameters, each interaction
happens in a 2D plane which depends on your viewpoint. This
results in those changes you aimed for and prevents you from
dragging items to an unwanted position, e.g. a distant Z position.
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++ Pixel-Oriented Workflow ++

The pixel-oriented workflow, introduced in version 5.7 to allow
pixel accurate settings is now the new default when creating a

project.
In short, this involves:
- most units displayed (e.g. in the Device Parameter tab) are in pixel units
- the size of a media on a Layer is pixel accurate due to the Layer Sizing Mode  in the Inspector
- the size of a Camera window is pixel accurate
- in the Configuration tab > "Unit Management " the "Unit Translation Mode" is set to "Fixed
relationship" and a translation factor is automatically set (this factor transfers 3D Units to pixel units
within one or multiple systems)

++ Preview Window Allows Multi-View and Shows Tools in Fullscreen ++

The Preview of version 6 can be toggled
to a Multi-View window. Per default you
see one view port as usual, but now you
can also choose to work with a split view
with 2, 4 or 8 view ports in various arrays.
If you have loaded the "All Cameras" view
before toggling to more view ports, the
newly created ones will show "None"; in
case you have loaded a Cameras (or
Output) view, the newly created windows
will automatically show other Camera (or
Output) views if they are available. Of
course you can change each view port
individually using the drop-down menu.

Please note that for the time being it is not allowed to view a Camera and the corresponding Output at
the same time. Another restriction in this version is that one view can be loaded into one view port
only. In other words, the "All Cameras" view or "Camera 1" can not be depicted twice.

Independent from the number of view ports, it is possible to maximize the Preview to full screen. This
is especially of interest in case you warp several Outputs in the Manager using the Editable Mesh
feature.

++ New Project Data Format ++

 A Pandoras Box project can now be saved as a binary file. The
"Pandoras Box Binary" format with the extension "pbb" is the new
default but the xml format is still supported. The advantages of a binary
code are a smaller memory space and thus faster saving and loading.

[Rev 13338] - Version 5.10
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++ NEW PRODUCT STRUCTURE ++

Pandoras Box version 5.10 introduces a product structure with
new products. In the long term these will replace old licenses
and hardware but at present the license structure supports old
and new licenses equally. All products purchased or upgraded

after May, 2nd 2016 represent the new product structure.

For existing products nothing changes with the installation of
version 5.10 at first sight. At second sight you might notice that
the number of Layers or Sequences has increased.

Note that the software features of all Servers have been unified and include the Server PRO features
with unlimited Audio, Graphic, Video Layers and since 5.10 unlimited Sequences. Existing Server
PRO products are upgraded automatically. It is possible to upgrade a LT or STD Server.
Same applies to the software Players: The software features of the Player PRO, STD and LT have
been unified and include the Player PRO features with more Audio, Graphic, Video Layers and since
5.10 multi-license Sequences. Each license unlocks an additional Sequence in the same way as the
layer count is multiplied. Existing Player PRO products are upgraded automatically. It is possible to
upgrade a LT or STD Player. 
DUAL and QUAD Players are automatically upgraded to represent the Hardware Player features with
more Layers and four Sequences. Compact Players are automatically upgraded with two Sequences.
Last, the software features of all Managers have been unified and include the Manager STD features
with 8 Sequences and the option to have unlimited ones. Existing STD and PRO products stay
unchanged, whilst it is possible to upgrade the Manager LT.

All products have now unified software features with the exception that each product group (Server,
Player, Compact Player, Software Player) is available with a different number of Output layers. The
hardware is separated into the categories ULT, PRO, STD and LT.

The Product Overview chapter  includes more detailed information and an overview table  with all
products and their features.

[Rev 12803] - Version 5.9

++ NEW KIOSK MODE: A SIMPLIFIED USER INTERFACE ++

Pandoras Box version 5.9 comes with a new Kiosk Mode. The
idea behind the Kiosk Mode is to offer a selection of Pandoras
Box features including our playback standards within a simple,
easy-to-operate interface.

When a PB Player or Server software is installed, you can start
the Kiosk Mode through the Start Menu > Programs > Coolux. In

the View menu you may activate "Show Playlist" to view and edit a selection of videos or images. The
File menu offers the commands to load a single file, save or open existing playlists. More settings 
can be found in the Configuration menu: audio playback, general options or output settings. The
output settings depend on the originally installed license. A Dual Server offers for example the option
to set up an overlap, softedge and warping for a maximum of two outputs.

In sum, the Kiosk Mode offers an interface for user-operated installs such as nightclubs or similar.

64 65
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++ MANAGER PREVIEW GOES FULLSCREEN ++

The Preview in the Manager is now able to be toggled into fullscreen when
previewing a Camera or Output. This is of interest for all who like to preview a site
without loosing pixel accuracy. The new feature also applies to so called non-local
nodes, e.g. when using a Player as a Master and programming on a Server Client.
In both cases, the coolux watermark appears in the fullscreen preview irregularly.

In addition there is an improvement when working with two (Dual View) outputs on the Master PC. In
earlier versions it was only possible to render the Preview on the primary output. Now, it is visible on
any output! Note that it can only swap between  outputs. It's not possible to see it on two outputs at
the same time.

Last but not least, we made it easier to toggle Cameras and Outputs into the preview. Right-click
them in the Device Tree and choose "Load in Preview".

++ REVISED PATCH TAB AND NEW PATCH TEMPLATES ++

For Pandoras Box version 5.9 we revised the Patch tab
completely. In addition we introduced the possibility to create,
apply, export and import patch templates. This allows easier and
faster workflows when patching Pandoras Box layers with DMX
addresses and remote controlling them with a lighting console or
the like.

In the Patch tab you decide to include a layer in the patch by ticking the check box next to it. The
number to the left is the total number of patched channels in this layer. To exclude a parameter from
the patch open the layer and uncheck the according check box. Note that the total patch count
drops. When you have decided for all layers, you can patch them from the top to bottom with a "Start
Address". Enter the start address for the site to affect all layers included in it at once.
The most used workflow is to decide once which parameters are included in a layer patch and apply
this to all layers. To meet this requirement we introduced the possibility to copy and paste a patch or
to create and apply patch templates. As described above, check or uncheck parameters from a layer,
then right-click the layer and choose "Patch > Copy". On another layer choose "Patch > Paste".
These options are available in the Patch tab as well as in the Device Tree.
Alternatively, you can choose "Patch > Create Template" on the first patched layer. In the Project
tab, there is a new folder "Patch Templates" into which your templates are saved. Here, you can also
edit the template, i.e. adding or removing parameters and renaming the template. To patch another
layer according to the template drag it onto a layer in the Device Tree or Patch tab, alternatively right-
click the template and choose to apply it to a selection of layers.
At last, you can create a folder and drag a Video Layer template into it (followed with one for the
Graphic Layer, Camera Layer etc). Now you can drag the folder onto a site and all layers will patch
their parameters according to the template.

You now simply assign different starting addresses for all sites and all patched parameters will have
unique DMX addresses. You can do this in the Patch tab as described above, or by right-clicking a
site in the Device Tree and choosing the option "Patch > Set Patch Start Values". The entire patch
state (parameters and channels) can be exported as a csv file when right-clicking on a site (or layer
or parameter) and choosing this option. You may want to exchange this with the lighting desk
operator.

When you have created a layer template or folder with various layer templates and you like to use it
again, you will find the options to export and import templates in the Project tab. Note that in a new
project, you will now be able to adjust your patch without the need to work in the Patch tab itself.
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++ NEW CUES TAB ++

In Pandoras Box version 5.9 you
may now find a new tab, the Cues
tab. It gives you a great overview of
all cues in your sequence and
allows fast changes. In addition,
you can also export the information
about cues as a csv file.

With a right-click in the title line,
you can adjust which rows show
according information: Cue ID,
Name, [Internal] Note, Type, Time,

Countdown, Jump/Wait [Time], Target [Time / Cue].
When adding or editing cues in the Sequence tab, changes are displayed instantly in the Cues tab,
and vice versa. To edit a cue in the Cues tab, click in the according cell, e.g. Name from Cue2, and
enter your changes. You can also multi-select cues and change them at once.
When right-clicking on a cue, you can either choose to "Select Cue in Sequence" to display it in the
Inspector, or you can choose to "Jump" to its position in the Sequence. Additional options are to
"Add Cue at Current Time" and to export the entire cue sheet as an excel or csv file.

++ NEW TIME MONITOR TAB ++

Besides the Cue tab, version 5.9 introduces the "Time Monitor"
tab. You can choose to display the Sequence Time, the System
Time or the Countdown for the next cue. Or you open three Time
Monitors and display all time editions. Of course you can adjust
the size of the new tab, or as known from previous versions, 
break it out  the main user interface. The new layout can be

saved to a view .

++ NEW LAYER TYPES: PARTICLE AND TEXT LAYER ++

With this version we introduce new layer types for all Player and
Server editions. To add a new layer type, go to the Device Tree
tab, right-click on the site and choose to "Add (multiple)
Device(s)" and the type.

The Particle Layer has significantly reduced layer parameters and one Particle System with a Particle
Emitter already applied, hence its ready to be used.
The Text Layer is a common Video Layer which only accepts Text Assets as a media.

By the way, it is still supported to drag Particle Systems or Text Assets to a normal Video Layer.
The new layer types simply provide an easier workflow or save the number of Video Layers. All new
layers can be added unlimited times. So, on a system with a reduced amount of Video Layers, you
can now add an unlimited number of Text Layers for example to display scrolling text.
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++ ADJUSTABLE LINE HEIGHT FOR LAYERS IN SEQUENCE ++

In the Sequence tab  you can now adjust the line height of a
shown layer or device.
At the end of the button bar , there is a "Line Height" button
that lets you choose between Standard, Medium and Large. For
medium or large line heights parameter keys can not only be
dragged to the left or right, which changes their time, but also up
and down, which changes their value. To do this, hold the Shift
key down whilst dragging the key. In addition to that small
feature, keys from the "Bezier" type show their Bezier handles

when being selected. Again, you can drag them in the sequence directly.

In the Sequence section  from the Configuration tab , there is an initial value for the Line Height. 

++ ADDED CONFIGURATION OPTIONS ++

In the Configuration tab , there are various new options.
One of the most important ones is to enter the number of
"Created layers" per site. This describes how many layers
exist initially when creating a new site in the Device Tree

. From the number of existing layers you can choose
which ones to show and which ones to hide. So to provide
a faster workflow, you can now adjust the number of

existing and shown layers separately.
In addition, it is a recommended method to reduce the number of existing layers to save time and
disk space when saving a project, especially when working with a big amount of Players or Servers. 

++ ADDED HARDWARE SUPPORT: 3D MOUSE INPUT ++

Any Pandoras Box Master versions now support the product SpaceNavigator from 3Dconnexion. In
short, this is a mouse device that allows to navigate in three axes (position and rotation).

After installing the driver, go to the Configuration tab  > 3D hardware and enable the new mouse
input. Now you have the choice to either control selected layer(s) with it, or to control the camera
selected in the Preview tab . Note that the mouse input alters the parameters relatively, not
absolutely.
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++ NEW PARAMETERS ON OUTPUT LAYER: BLEND MEDIA AND PIXEL WARP ++

For the Output layer, there are two new parameters. The first one is the "Blend
Media" and allows for custom softedge. Drag any image format that describes
your softedge preferences, e.g. a softedge following a curve. Preferably the image
is black and white as it is multiplied to the entire image from the Output. Note
that all other Softedge parameters have no effect when using the Blend media!
With the "Warped" check box, you can decide whether the blend media should
be affected by keystone adjustments or the warp mesh that is applied to the
Output or not.
"Blend Media" is available on all Server and Player editions, excluding the Player
LT.

The second new parameter "Pixel Warp" is for internal use and will be described in the future.

[Rev 12383] - Version 5.7

++ NEW VIDEO FORMAT SUPPORT: HAP CODEC ++

Pandoras Box version 5.7 now supports three additional formats
of the Hap codec family: Hap, Hap alpha and Hap Q.
Technically, these formats are comparable to the DDS snappy
image sequence formats: DDS, DDSA and DDS with YCoCg.
This is in regards to image quality, file size and playback
performance as well as to the necessity that the width and

height of the video is divisible by 4.

++ ADDITIONAL CODEC INFORMATION IN FILE INSPECTOR ++

With the support of the Hap codec, we also introduced a small
new feature for the File Inspector . When clicking on a *.mov
file in the Project tab , the Inspector now displays additional
information regarding the codec included in the mov container.
When using the Hap codec, the inspector shows that the "Frame
Type" is "Hap" in that case. The Frame Type can only be

displayed, when the codec is supported natively by Pandoras Box, i.e. is not loaded via the
Quicktime Extension which also consumes more performance.
The native support of mov codecs includes now the Hap family as well as the coolux codec  of
course.
Regarding the coolux codec, you can either render a mov file or an image sequence. In both cases,
clicking on the *.mov file or the image sequence file, the Inspector displays the current file format,
e.g. "BMP with alpha" or "DDS (in snappy)".

++ NEW LOOP OPTION IN CLIP INSPECTOR ++

Imagine, you have a video on the timeline and after playing it
back you like to keep the last frame as a still image on the
screen.

First, you change the length of the container in the sequence,
then you select the container and look in the Inspector . You
will find a new check box called "Loop". Per default this option is

on, resulting in a looping video when the length of a container is longer than the clip itself. When
deactivating the "Loop" option, the last frame is hold.
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[Rev 11903] - Version 5.7

++ SYNCHRONIZED AND 4K LIVE INPUT ++

Current Pandoras Box Server hardware can be customized with DVI or SDI input cards. For the SDI
input cards this revision offers the possibility to synchronize genlocked input feeds with the same
resolution and framerate. This is of interest for a "mask-and-fill" setup or for creating a larger format
like a 4K texture. For a Dual SDI card, you can synchronize both feeds from the same card. For a
QUAD SDI card, you can synchronize two pairs (the first two and the last two) and for the QUAD 3G
SDI card, you can in addition synchronize all four inputs.
To synchronize two or four inputs: Pandoras Box Master > Assets tab  > choose the Client with
the card and open its "Live Input" folder. Drag all feeds into the Project tab , select them there and
make a right-click to choose to synchronize them.
To create a 4K input texture: Pandoras Box Master > Assets tab  > choose the Client with the
card and open its "Live Input" folder. Drag only the first feed into the Project tab , and there, right-
click it to choose to toggle into 4K mode.
Note: The icon of the Live Input in the Project tab will change if the synchronized or 4K mode is
activated.
Important: The coolux input card driver installer includes a new version 5.16. 5.16 is only mandatory
when you like to use the new SDI input features. There is no need to update, when you like to use the
SDI inputs the way you used to.

Very important: Please do not update yet when you use DVI inputs. Currently there is an issue with
Dual Link signals!

++ MORE FLEXIBLE VIRTUAL SITES ++

Virtual Sites  combine several Clients to one
Site to fasten the programming workflow. This
greatly used feature is now more flexible, as it is
possible to create a Virtual Site of unalike
Clients. For example, you can now sum up a
QUAD Server and a DUAL Server, as long as
both are PRO or STD or LT editions, meaning
that the different number of cameras or output

does not matter any more.

[Rev 10386] - Version 5.7

++ NEW QUICKTIME COMPONENT / COOLUX CODEC ++

coolux has developed a codec for use on PC and Mac. With this codec, content artists can directly
produce image sequences for Pandoras Box without any further transcoding step. Keep in mind that
image sequence playback is mainly aimed for SSD based systems. Pandoras Box is able to
playback uncompressed image sequences. So if the sequence was rendered in an according
lossless file format, you can play it back without any quality loss as Pandoras Box never compresses
files internally!
More information about the coolux codec in general  and the codec settings  in detail (including
the description about the Quicktime Converter).

++ NEW IMAGE (DE-)COMPRESSION: SNAPPY FORMAT ++

With this revision we now support a new format for images and image sequences : .snp files. The
tools Dome Master , Splitter , Image Converter  and the new Quicktime Converter  offer to
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save images using the snappy format. Pandoras Box itself can playback the format.

To be accurate, the snappy format is actually not an image format itself but a compression library
offered from Google. So if you have a .jpg, .png, .bmp or .dds image, snappy compresses the file size
but keeps the available quality as it simply reduces the file data. If you work with .snp files, the saving
or reading process does not need more time, as the (de-)compression works in highspeed and real-
time. In other words, Pandoras Box can decompress snappy image sequences on the fly.
The result is a much smaller file size whereas the size difference depends on redundancy in your
visual content, such as alpha channels or same colors in motion graphics. This way you gain a lot
more drive space which is especially interesting for SSD systems as their drives normally offer less
space.

++ NEW TOOL: THE QUICKTIME CONVERTER ++

Naturally, it is not recommended to playback .mov files with
Pandoras Box due to several reasons, e.g. synchronization. The 
Quicktime Converter  enables you to convert .mov files, for
instance if the content has been rendered and delivered in that
format and there is no time to render it again.

You may find the Converter along with all other coolux tools
(Warper; Matrix Patcher,...) in the "Tools" menu.

Choose "Convert Single File" or, in case you have multiple files,
"Add Files to batch" and select the original .mov file(s). The

Converter requires an installed Quicktime Player. Keep in mind that .mov is a container format not a
codec itself. Thus, the container can contain any common or uncommon codec. To convert a .mov,
the codec used in it, must be installed on the PB system as well.
As a next step, choose the format into which the file(s) should be converted. For instance, you may
choose the .avi format or to render an image sequence. 

++ COLORIZABLE LAYERS ++

 The new Pandoras Box
version offers the
possibility to colorize
layers and other
devices. The color is
seen in these tabs:
- Device Tree
- Sequence  
- Device Viewer

Simply select a single or
multiple devices (i.e.
Video Layers, Cameras,

etc) to open the Video and Graphic Layer Inspector . There you click on the color field and choose
any new color. The button "Reset" applies the default color again.

++ PANDORAS BOX SUPPORTS KINET ++

With this version we introduce the support of a protocol called KiNET. KiNET is a lightweight UDP/IP
based protocol used to communicate via Ethernet with Philips Color Kinetics light fixtures and power
supplies. The KiNET settings are available in the Matrix Patcher  only.
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++ NEW SHORTCUTS ++

The following shortcuts have been added or changed:
- CTRL + F: enters or leaves the fullscreen mode
- CTRL + A: selects all entries in a playlist
- CTRL + T: calls the Assets tab

See here all keyboard shortcuts for a Master system  and for a Client system .

++ VERSION 4 PROJECT CONVERSION ++

There is a considerably improved import / conversion of older Pandoras Box projects saved under
version 4. 

Before, the entire timeline was missing. Now, all sites and devices, as well as cues, containers and
other timeline settings are converted. Please note that still there are elements that are not possible to
be imported:
- Layer Effects (version 5 introduced the Aeon FX engine )
- some Layer Parameters  (e.g. Rotation) as version 5 offers two parameters for constant and
continuous rotation, instead of one
- Presets  in general as version 5.1 introduced a new type of sequence presets not based on active
values
- DMX patches  as version 5 offers new FX and other parameters

Depending on your project, there might be further attributes. Please check and edit the converted
project thoroughly to make sure it works as you expect. 

++ BLEND MODES AVAILABLE ON PLAYER ++

Until this version, the Blend Mode parameter was only available on Servers. It is used to determine
how two layers are blended into each other. The default called “Normal” simply hides the lower layer
with whatever is present in the top layer. With other modes you can for instance "add" the top layer's
pixels to the ones from the lower layer, or set up a Mask and Fill combination.

All Player version have now the included this Blend Mode. More information about Blend Modes ...

++ NEW HELP ICONS IN THE USER INTERFACE ++

The sub sections in the Configuration tab now contain a small question mark
icon. When you click it, the manual opens and displays the according
information for this configuration section. So, if you wonder what a specific
check box or option does, simply click the help icon next to it.

236

138

316 320

137

323

276

647

340



35

[Rev 10045] - Version 5.7
Please find below descriptions for the most important features and new hardware devices. Not
mentioned are minor settings as this version comes with an exceptional amount of small but helpful
changes. Most of the new options and settings can be found in the Inspector of each item and in the
right-click menus. For additional information, see the changelog (e.g. C:\Program Files (x86)
\coolux\Pandoras Box... Rev 9929)

++ VENUE SITES: The new way of previewing content by rendering it directly on your digital 3D stage +
+

Undoubtedly the coolest feature in version 5.7: Venue Sites. In
difference to normal sites a Venue Site is never a real Player or
Server. The purpose of a Venue Site is to render your
programming (of real sites) on 3D objects that form a virtual copy
of your stage. That turns the Preview tab from being an abstract
image to a very real representation of what is happening on
stage.

Regarding real Clients, you include them into the sequence by
dragging them from the Assets tab  or from the Device Types

tab  into the Devices tab . You render content on them by spreading media files to it and
assigning these resources to layers. With respective settings (opacity, scaling, effects) the resources
appear in the 3D space of Pandoras Box. Whenever a Camera Device sees a resource, it renders it
as part of its camera texture. Then this texture is send to the Output Device to be re-rendered with
the output settings (warping, keystone, softedge). This texture is the real output of your graphics card
and is connected to a display device.

Regarding Venue Sites, you include them into the sequence by dragging them from the Device Types
tab  into the Devices tab . You render content on them by routing textures to it and assigning
these textures to Venue Layers. A valid texture is either a camera or output texture from a real site. It
can be a real media file too. Mind, that the site needs to be toggled into the preview. Besides the
texture, you would mostly apply a 3D object to a Virtual Layer too. The object represents a part of
your stage. This can be for instance a flat 2D object representing a display, or it can be a curved
object representing a curved projection screen, or it can be a chair object, moving head object, human
object. From that point on, the render pass is the same as above. The Venue Layer is captured by a
Venue Camera which sends its own texture to the Venue Output, again offering the known output
settings. But the Venue Output does not send its result to a real display but to the Preview tab.

You may also preview a Venue Camera and animate it on the timeline. This way you can fly through
your 3D stage and look at the content from different angles. Of course you can always export this
animation using the Video Export feature .

As with other sites, all settings for Venue Sites can be kept as active values  or be stored to the
timeline  in form of containers. Or you remote control them using for instance the Widget Designer

.

There is the possibility to (roughly) simulate projectors including the deformation when hitting
screens. That is what makes keystoning and warping necessary. Softedging can be roughly
simulated too.
First, add a light layer  to your Venue Site. The light represents the projector. The light controls
like position stand for the projector's position and the field of view, represents the lens FOV. The
projectors image is of course a texture from another site. Now you need another Venue Layer with a
3D object that represents the real screen. Apply a light effect  to the layer to "receive" the
projector's light.

A sample project can be found in C:\coolux\content\projects\VenueSites_Training_Stage
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++ ADDING MULTIPLE CAMERAS AND ENHANCED CAMERA FEATURES ++

It is now possible to add multiple cameras to your Server site
and connect them individually to the output. The number of
outputs is still determined by your product, e.g. two per Dual
Server license.
Up until today, there was a fixed pair: one camera per single
output. Whatever was seen by this camera was automatically
routed to the Output Device  as the "camera texture". Now
you may choose to add another Camera Device  per right-
click onto the respective site (Server). Regarding the routing,
you may decide what camera sends its image to the Output
Device. The Device Controls tab offers a new field, right-click

into it and choose your camera. Similar to assigning different images to a graphic layer, you may
store the different camera textures as containers to the timeline .

Find new individual settings including the size of the camera texture in the Camera Inspector . This
allows for higher (or lower) resolution for rendering the individual passes which helps in many
applications: First Pass Anti alias, Flexible texture mapping, Video Export ,…

The navigation in the preview tab developed to be more direct which makes the orientation in preview
tab easier and more efficient. First of all, you may now choose to preview a camera just as you used
to do with an output (right-click in Preview tab > Select Preview ). Then the chosen camera view
can be navigated similar to the global preview . It is a great time saver that the navigation changes
reflect as active values for the controls of the Camera Device. By storing these to the timeline, you
can create great camera fly-through animations in a glimpse of an eye. Another option is to create
accurate views, e.g. top view, site view, isometric view, particular video export view etc.

++ REDESIGNED PREVIEW ++

The new Preview tab  renders camera wireframes  with
improved design. Per default they are now more plastic and
overlapping cameras / outputs can be identified easier. You may
adjust the camera's wireframes in the camera Inspector , e.g.
set the color and transparency for individual cameras.

Secondly, the rendering from 3D objects has been reformed:
object default color, grid appearance and a default light source can be set up to meet your needs.
Last but not least the new preview puts forward with an adjustable grid marking the XZ-plane to make
it easier to orient in 3D space. Find these settings in the Configuration tab > Preview Display  (also
accessible through the right-click menu of the Preview tab).

++ TEXT INPUT OFFERS NEW OPTIONS AND DESIGN ++

This version comes with a completely re-designed text editor .
The Text Input Resource now offers enhanced formatting options
including the possibility to assign different font styles withing the
same resource. There is also an automatic horizontal and / or
vertical scrolling and offset option. 
In addition, it is possible to have an unlimited amount of text or to
use a continuous text input.

Create a text input as usual (right-click in the Project tab > Add Text Input), the Inspector tab now
offers new options and the button "Open in Resource Editor". There you may find the full scope of
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possibilities.
You may need .net 4 installed for using the new text input plugin.

++ AUDIO INPUT, AUDIO RECORDING, AUDIO ROUTING ++

The latest Pandoras Box audio feature development makes it
possible to input ASIO sound as well as HD-SDI embedded
audio, opening up a whole new world of real-time media
compositing. 

You may input ASIO sound and route it to any ASIO output by
assigning the input to the according ASIO track. This means that
audio inputs can be arranged on any Pandoras Box timeline, or
can alternatively be triggered via external commands.

Audio delay settings are available per Resource, Layer or on Clip
Level. That enables you to set up different delays for different

output signal chains.

Next to the feature to input, route and delay audio inputs, it is possible to record ASIO inputs via the 
Video Recording tab .

++ NEW HARDWARE: COMPACT PLAYER AND COMPACT STATION ++

The Compact Player is a 9.5" wide and 1.5 rack units high. It is a
i5 hardware running a Win7 operating system. It is equipped with
a 120 GB SSD hard drive and an NVIDIA graphics card (GT640
GPU 1Gb dedicated RAM). The systems RAM is 2GB.

The Compact Player comes with an included Compact Player
license (no sequence, 2 Video Layers, unlimited Graphic Layers, 1 Output).
The Compact Station can be combined with any other additional license, e.g a Manager, Player
(multi-license), Widget Designer...

The allowed playback performance is 2 x 1920x1080 for MPEG2 or DDS image sequence.

Regarding audio support, the Compact Player license has no included ASIO Tracks as other licenses
do. Eventhough the hardware does not nativly support ASIO, to install the ASIO4ALL driver is
possible. When using this driver, coolux cannot guarantee synchronization. Audio playback on Video
Layer (with MP3, WMA, WAV format and embedded sound) is supported. 

The connections in the back and front: 
        1x DVI Out (DVI-D Single Link and Dual Link, DVI-A)
        1x HDMI Out (incl. Audio Support)
        1x GB Net
        5x USB (2x USB 2.0 (black) + 3x USB 3.0 (blue)
        1x eSATA (red)
        1x DC Power IN, external 19V PSU
        2x Mini Stereo Jack Out, 1x Mini Stereo Jack In, 1x Optical Toslink Out (so far not supported)
        1x SD Card Reader
Read more...

308

http://www.coolux.de/en/products/pandorasboxcompactplayer/


38

++ NEW HARDWARE: NET LINK ++

The NET Link is a modifiable interface device build to:
- provide sensor information as input signals to Widget Designer

 or the Warper  and / or
- control relays by sending output signals.
Through these programs sensors can control layer and sequence
parameters in Pandoras Box . In return, Pandoras Box can
trigger the devices too.

Regarding the hardware features , the NET Link is a
customizable device and comprises:

- a housing: choose between the small chassis depicted above or the 19" rack module
- min. one processor unit
- changeable boards: coolux delivers the NET Link ready-to-use as ordered by you. However, you
may modify the NET Link by changing the boards at any time. Currently, seven boards are available
covering analog and digital boards as well as input and output ones. Show examples...

The Calibration Link is a small NET Link device equipped with two analog fibre input boards for the
input of 16 fibre cables (single-core, diameter of 0.98mm²). It is specially designed for an automated
re-calibration of a projection setup, e.g. in a fixed installation where a projector or a screen have been
moved. Show example...

++ NEW HARDWARE: EDID LINK ++

The EDID Link is a device to manage DVI-EDIDs and
communicate these to the graphics card. 

It can be used to generate and constantly hold an EDID
whenever a display device is not able to send a correct or the

exact needed EDID to the source. In addition the EDID Link will ensure, that a monitor is simulated
even when none is connected to it, or powered down. The EDID Link does not need any separate
power.

Per default, the EDID Link comes with preinstalled EDIDs (i.e. a preset list) and can be used without
additional software. The software addresses more advanced users and allows to read and modify
EDIDs or create new ones and store them to the available preset list. Read more about the hardware
and software .
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++ SEQUENCE ICON BAR (Including merge and split Clips) ++

Above the Sequence tab you will now find a button bar, offering
the most used commands like "Store Active" and "Reset"in an
easy and fast accessible way.
The bar with its icons can be hidden, and enabled again via the
Tabs menu > Button Bar > Sequence. 

When you right-click on a container, you find additional options
in the context menu. You may split one clip at the nowpointer's position. If you have several container
within the same track selected, you may merge them. If they have different options regarding Lock to
time or free-run, media file, mesh file etc., the first container in time wins.

++ FULLSCREEN IS SINGLE ++

The option "fullscreen is single" has moved. It still has the same
effect: ignoring a second display and forcing Pandoras Box'
fullscreen onto one single display. In previous versions, it was
present in the Pandoras Box Client window, now it is available in
Pandoras Box Master interface. Open the Configuration tab > 
Render Engine  and select the Client you like to set up. There
you might also find all other options regarding the Client's render
engine.

++ NEW OBJECT SUPPORT: FBX, 3DS and OBJ FORMAT ++

Besides the known .x format, Pandoras Box version 5.7 now
supports 3 additional formats for two- and three-dimensional
objects. The Project tab  accepts .fbx, .3ds and .obj files,
either dragged in from the Assets tab  or any file explorer .
If your *.fbx or *.3ds contains subobjects (groups of objects), you
may set up the hierarchy level in the automatically opened
dialog. "1" results in one file in the Project tab whereas "2"
results in a folder containing subfiles and so on. In that case,
you may drag any hierarchy level, single file or folder onto a layer

(Video Layer, Graphic Layer, Output Device, Venue Site Layer etc.).

You may adjust the global appearance of 3D files in the Configuration tab  > Preview Display
and for each file separately in the File Inspector .
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++ SPREADING ENHANCEMENTS ++

Regarding the
spreading
mechanism,
several
optimizations have
been undertaken,
leading to more
robustness,
flexibility as well

as better and safer file administration. Most importantly you will notice a new behavior indicating
inconsistent files. Before, only the missing or corrupt file itself had a red exclamation icon, not the
folders above. This has changed. Every folder, regardless of his hierarchy level is marked with the
warning icon as soon as it includes an inconsistent file. Furthermore there is an "Inconsistency Info"
dialog that helps to identify defective or missing media. To access it, right-click on any folder and
select "Inconsistency Info".

++ USER DEFINED INITIAL VALUES  ++

Since ever the Configuration tab amasses numerous settings
influencing the overall appearance and behavior of the Pandoras
Box Master interface. Now it consists of many more sections
and settings that allow to be user-defined and perform as initial
settings. In other words, we implemented the feature to have
default settings which individualizes, eases and fastens your
entire workflow immensely.

Amongst many settings you may define for instance the
properties of a container (Lock To Time, Preroll, Fade In,

Duration) or the type for a cue or whether resources should have FluidFrame enabled per default.
Each newly created container, cue or resource, is initialized with these settings.

++ EFFECTS: FX SEARCH, FX BROWSER EXPLORER, FX DOCUMENTATION, NEW FX TYPE:
Creating content on the fly, no matter what resolution ++

The Aeon FX tab awaits you with three improvements.

A new Search Field helps all who forgot the exact name of a particular effect or just the folder
containing it. It also makes finding an unknown but suitable effect easier too. Simply start typing into
the Search Field (e.g. Color) and automatically it filters effects and shows only those somehow

including the typed letters, e.g. Color Only, Target Color Burn, ....
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Secondly, an Effect Explorer has been developed. You may find it under Tabs > Launch FX Explorer
or within the right-click menu from an effect.
To the left, it shows all effects in a file tree. Select one and its description pops up in the right part. It
is almost the same description as the one found in the manual: exemplary images, a short sentence
what the effect does and a table listing all available parameters. At the browser's bottom you may find
the controls of the currently selected layer. By clicking on an effect, it is instantly added to the
controls and you may try out how the effect interacts with the layer's media file and how changing the
parameters influences this. If you found the effect you were looking for, click the "Ok" button
underneath the controls and the Effect Explorer will close after adding the chosen effect to the layer
with its the current parameters (as active values). If you like to keep that effect but add another one
on top, click the "Add Next FX" button. If you like to try another effect instead, simply select it from
the file tree. When adding more effects, you may even say where an effect should be positioned, e.g.
between FX3 and 4.
"Close" will discard the entire effect collection added since launching the Explorer and close the
dialog itself.

Last but not least, there is a new effect type: so called generic effects allow to generate moving
content in real time, without the need of pre rendering anything. In addition they are independent from
the pixel resolution from your outputs as the layer with the effect can be scaled as you wish.

++ ADDITIONAL SOFTEDGE SETTINGS ++

Pandoras Box version 5.7 added a new set of softedge blending shaders to the Aeon FX tab . The
main change to the default softedge options for an Output device is that the curve parameter controls
are strength and width of the curve instead of shifting it left and right. Plus, there is an additional
Offset parameter that lets you control the center /white/grey point of the blend. Thirdly, there are
parameters for RGB gamma corrections which might need to be applied when you want to adjust a
good projector to a bad one.

++ LEICA 3D DISTO TOOL ++

The Leica 3D Disto tool  comes automatically with the
installation of a Pandoras Box Manager. It is accessible in
the "Tools" menu. The tool requires that the Leica hardware,
specifically the 3D Disto, is connected and the drivers are
installed. Please note, that the distometer cannot be
purchased through your local distributor but we are happy to
forward contact details.

In short, the motorized distometer measures points with great
accuracy and in return can laser to any point, measured
before. It draw our attention as it can be used in complex 3D

scenarios to measure projector positions and object position. It reduces setup times significantly.

++ UNIT HANDLING EASES PIXEL ACCURATE WORKFLOW ++

With this Pandoras Box version we included fundamental
settings to allow easy adjustable, pixel accurate settings. The
new section in the Configuration tab "Unit Management "
lets you setup how 3D Units relate to pixel units within one
system or across multiple Clients.

When the "Unit Translation Mode" is set to "Fixed
relationship" you can enable in the Configuration tab section
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"Devices / Parameters " a Pixel Readout for Parameter
Values. The Device Control tab then allows to type pixel values for parameters like Position.
Furthermore, the Layer Inspector allows additional settings like "Media Pixel Size" or "1:1" for the 
Layer Sizing Mode  to match the main medias resolution instead of scaling it to fit in the horizontal
or vertical fullscreen size.

Using this decidedly "pixel oriented workflow" makes it easy to set up and use split pictures, and
also aids the communication flow between operators and content designers, who are used to thinking
in terms of pixel values anyway.
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[Rev 9055] - Version 5.5
++ NEW IMAGE SUPPORT: DDS FORMAT ++

Pandoras Box revision 9055 now supports a new format for images and image sequences. The dds
format claims to perform better than other formats like jpg, png or bmp. In Comparison to these
formats dds images save performance. In addition, always depending on the kind of content, it
possible to achieve better results regarding the quality than the mpeg format can provide with videos.

The Image Converter supports the dds format as well, thus it is possible to convert images and
provide them for Pandoras Box. More information about image sequences in general  and the
Image Converter .

++ NEW ASSET: CANVAS ++

There is a new media type provided by Pandoras Box and Widget Designer: a so called "Canvas". To
create a Canvas in your Pandoras Box project, right-click in the Project tab and choose "Add
Canvas". It can then be applied to a layer of your choice, e.g. a Graphic Layer. The Canvas consists
of graphical elements that may be created in Widget Designer. It is for example possible to draw on it
and create other elements on the fly. Hence, the Canvas changes the appearance dynamically and
Pandoras Box renders the image interactively in real-time. 

In Widget Designer (higher Rev 506) please find the "Canvas Template Manager" under "Tools". It lets
you create a template which is seen in a preview window. Then you can set a background color and
when right-clicking in the preview, you may add text, ellipses and rectangles.

Furthermore, there are dedicated nodes under "Create > Nodes > Interaction". They can be used to
draw on an existing Canvas Asset in Pandoras Box based on the local mouse movement. To
visualize these movements in Widget Designer as well, you may use the item "Drawing Canvas"
under "Create > Panel".

[Rev 8499] - Version 5.5

++ CONTAINER DRAG AND CONTAINER COPY ++

Dragging and copying containers has been improved. If you now
drag a container it can be shifted to another layer as well, it is
not restricted anymore to the layer were it was created. If shifting
a container to another layer type, the container turns red to
indicate that some keys might get lost. In addition a warning
dialog pops up. This dialog can be deactivated in the 
Configuration tab - Sequence  by unchecking the option "Warn
when clip drag would lead to change of layer type"

If you like to shift a container without moving it to another layer, hold down the [SHIFT] key. This
locks the layer "borders".

Holding down the [CTRL] key whilst dragging a container activates the copying function. As soon as
you let go on the same layer or on another layer you have created a copy from the original container.
You might do this with multi selected containers or keys as well. More information about 
programming in the sequence...
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++ STORING ACTIVE VALUES ++

Storing active values as key frames in the timeline has been
extended with more options. First of all, there is a new command
"Store Active to Time" when right-clicking in the Sequence tab's
time bar. A dialog opens asking for a time where all keys should
be created.

Furthermore, you may decide whether you like to store ALL
active parameters or just those belonging to a certain device or
parameter group. In order to store, for example just the X
Position, expand all parameters in the Device Tree (e.g. using
the +-symbol) and make a right-click on the parameter "X Pos"
and say "Store active". If right-clicking on a level higher, in our
case "Position", keys for X Pos, Y Pos and Z Pos are created if

they were all active. In the same manner active values can be stored per layer or per Server / Player /
DMX device.

Last but not least, if you have an active value and then create a key by right-clicking in the timeline on
the parameter track, the newly created key will adopt instantly to the value and thus deactivate the
active status from the parameter.

More information about the right-click menus in the Device Tree tab ...

++ AUTOMATIC FADE IN AND OUT FOR OPACITY AND VOLUME ++

The Configuration tab
offers now the possibility to
set up automatic key
creation. You may choose
whether there should be
always keys programmed for
the parameters opacity and
volume as soon as a
container is created. If you
choose the option "single
key" a key is created at the
beginning of a container, the
option "Fade in" creates two
keys and "Fade in and Out"
four keys. If choosing a fade
scenario you may set up the
fading times.

In the example depicted left
(click to enlarge the picture),a
fade in and out scenario is set
up with the default time of one
second. As soon as a right-
click is now made in the
Sequence tab, for example in
the opacity track or X Pos
track, a container is created
holding automatically four
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keys, two for the fade in and
two for the fade out.

Besides, these four keys are generated as soon as an active value is stored (creating a container) or
when an asset is dragged from the Project tab into the sequence.

++ PANDORAS BOX WEB BROWSER, CLICK EVENTS AND POINTER LAYER ++

Pandoras Box version 5.5 includes the feature to access internet
pages and render them as so called "Browser Assets" in order to
make them visible on graphic or video layers.
To create a browser asset, simply right-click in your Project tab
and say "Add Browser", then assign a domain (e.g. http://
coolux.de) and texture size within the Browser Inspector . You
may as well change the look by influencing the background color.
The asset can then be assigned to a layer, just like a video or
image. You may click on the left picture in the middle to enlarge
the depicted GUI.

Please note that the render and loading process might take up to
15seconds depending on the texture size and web site
complexity. This is also subject to the internet connection.

In addition, version 5.5 features the possibility to accept click
events (click inputs) happening on the Master or Client system,
for example when a mouse button is clicked or when an AirScan
is used. The click input is then routed to the visible layer and in
case it is a browser asset, it executes the underlying link. These
click inputs can be single touch inputs when using Win XP or
multi-touch inputs when using Windows 7 and higher.
To activate click events, select the Client in the Device Tree tab
and turn to its Inspector . The button "Input Settings" opens a
dialog where you can activate your output(s) of choice and the
option to route the local inputs to layers.

Routing them to a Widget Designer Device  requires this device
in your Device Tree and allows to monitor and work with the
mouse input information in the Widget Designer. This recently
introduced feature is called Layer Picking . The chapter
includes a step-by-step example and detailed information about
Layer Picking.
If you like to be able to click in the rendered preview tab on your
Master, simply activate the "Picking Mode" by highlighting the
link symbol in the right upper side from the tab as seen in the left
image at the bottom.

As a third feature we introduced "Pointer Layers " to make the
mouse pointer visible. Right-click in the Device Tree tab, choose
"Add Layer > Pointer" and assign a media to it. Now, depending
on the layer's opacity, this pointer layer is automatically shown:
a) in the Preview tab if you are in the picking mode
b) in the Client's small render window
c) in the Client's fullscreen render window
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++ PANDORAS BOX WEB SERVER ++

Version 5.5 comes with the newly developed Pandoras Box Web
Server. It offers remote control of a Pandoras Box project that
can be implemented into a web site. All PB Automation
commands, known from the SDK, are now executable in 
JavaScript language , and thus can be embedded in the HTML
code by your web developer.

The Web Server settings can be found in the Configuration tab -
Web Server .

Per default the port number used by the web server is 6214. We have prepared a demo web site to
show what can be done and how the PBAutomation commands are implemented in the web site's
code. If you like to view it, open a Pandoras Box Master - this activates the web server. Then go to
your browser and enter your IP address and the port number, e.g. http://2.0.0.100:6214

(alternatively you may copy-paste the address from the Configuration tab) - this calls the web server
and shows the delivered web site. This site contains a link to the demo site which is installed per
default in the web root folder under c:/coolux/content. If you like to write your own site please make
sure to place it in this web page root directory.

Please note that the internal Pandoras Box Web Server can be used without access to the internet, it
is meant to be used in (secure) local networks. For bigger installations it might be of interest that
external web servers can be used in combination with the PB web server. For example, an Apache
HTTP Server can be used or any other web server that supports the scripting language php. This
server is then used to deliver the web sites to the browser and forward commands to or receive
information from the PB web server. This setup has advantages for larger installations and for those
that need access to the internet (as the PB server can be invisible), or for database applications.

++ FIREFLY™ 2D PARTICLE SYSTEM AVAILABLE FOR PLAYER SOFTWARE ++

Pandoras Box now offers a particle system for Player solutions
as well. Up until version 5.5 the FireFly™ particles were
restricted to Server systems. The feature has been redesigned to
match the 2D compositing space on Players.
Particle systems make flexible content creation possible and
can be used for creative as well as interactive solutions. As
known from the 3D particles, various emitters can be setup
consisting of different parameters that influence the look and
behavior of the FireFly Particles .

++ NEW STARTUP DIALOG AND CONFIGURATION TAB ++

A new startup dialog pops up as soon as Pandoras Box is
started. It gives you the choice to either load a (recently) saved
project or start a new one.
If you like to start a new project you can name it in this dialog
but it is not mandatory any more to decide the saving path at this
stage. As well, the choice is given to start with or without
defining advanced configuration settings.

These configuration settings can be found as usually in the 
Configuration tab  which has been restructured into several

chapters. The configuration settings for Clients were moved from the Inspector tab to here as well and
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can be viewed after selecting the according Client from the drop-down list. The tab in general includes
some new options, e.g. regarding the behavior of the  Pandoras Box Web Server.

All configuration changes concerning software settings are stored in the show file itself and are loaded
when opening the project on a different computer. Settings concerning the hardware (the system
itself) are stored on the local machine.

++ RELATIVE CONTENT PATH AND BUNDLE PROJECT ++

We now support a relative path whereto content can be saved. This is especially of interest for users
that use the "Bundle Project " feature.

When saving a project a folder named "assets" is generated just next to the show file. If you copy
content files to that folder and drag them from here into your Pandoras Box project the content links
are relative. That means that you can move the project folder ( including the *.xml and asset folder) to
every path wanted without the need of re-linking the content.
You may as well use the assets folder as a "Watch Folder" in Pandoras Box...

++ IMPORTING CONTENT: WATCH FOLDER AND EXPLORER DRAG ++

Importing content to your Pandoras Box project has been
facilitated by two features.

Firstly, you may turn a folder in the Project tab into a so called
"Watch Folder" by clicking on it to view its properties in the 
Folder Inspector  and, there, ticking the according check box.
If the folder already contains files, the check box can be found
after clicking on the +-symbol in front of "Attributes of Folder".
A dialog opens and lets you choose a folder on the hard drive.
Now, all files contained in that folder are imported to your Watch
Folder and in consequence to the project. Additional files copied
to the folder on the hard drive automatically appear in the Watch

Folder. Modified files are reloaded optionally (read below). Removed files, either in Pandoras Box or
on the hard drive will still exist in the other place.

Secondly, it is possible to open the Windows Explorer or any other file explorer and simply drag files
and folders from there into Pandoras Box. You may either complete the mouse drag in the Project tab

, in the Preview tab or in the Device Tree tab as depicted left.

++ RELOADING CONTENT HAPPENS AUTOMATICALLY ++

All files in the project are monitored constantly on the hard drive and as soon as a file changes, an
automatic reload is executed by Pandoras Box. In addition the reloaded file is spread to connected
Clients.

In former versions you only had the possibility to reload content manually, either by restarting
Pandoras Box entirely or by clicking the Reload button in the File Inspector . A reload is
necessary when content has changed on the hard drive after having been imported to Pandoras Box.
This concerns especially still images as Pandoras Box saves them as a separate cache file. With the
triggered reload, this cache file is now renewed automatically.

If you like to turn the monitoring off, please uncheck this option in the Configuration tab , section
"General Settings". There you find as well the option to deactivate an automatic spread triggered by a
file change.
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++ DEFAULT OPACITY VALUE ++

The default value for the opacity parameter has changed to be 255 or 100%. In former versions the
default value has been 0. If you like to return to that behavior you may uncheck the check box
"Default Opacity is full" in the Configuration tab , section "General Settings". Please note that this
option results in a different show appearance when switched during or after show programming.

The default volume parameter for video layers and ASIO tracks has changed from -96dB to 0dB and
can be toggled with the same check box.

++ PARAMETER VALUE SMOOTHING ++

Setting up parameter smoothing is now possible per each Layer and Parameter separately not only
for translation, rotation and scaling parameters per system. The default smoothing setting for all
parameters is still 500. That means that active values are applied to the parameter not instantly or
abruptly (0ms) but within 500ms in order to smooth movement.

If you like to change the time frame or deactivate the smoothing entirely, e.g. when working with a
lighting console and color effects on the layers, select the Client in the Device Tree tab and turn to
the Inspector tab. The system-wide smoothings are still modifiable in the Inspector directly, whereas
the button "Individual Parameters" opens the Smoothing dialog  that enables specific
modifications.

++ PLAYLIST ++

A Playlist offers the easy and fast possibility to play a certain number of media files in a row without
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the need of programming separate containers on the sequence. 

In the Project tab's right-click menu , you may find the command to add a Playlist. In order to add
media files to it, select the Playlist and look for the new tab "Playlist"  (next to the Particles tab).
Now you may drag and drop images, videos and audio files from the Project tab into the Playlist tab.
Each newly dragged resource will simply be added at the end of the list (even when the Playlist is
already playing back). If you like to put the files in another order, (multi-)select an entry and drag it
between to others or assign a different "Index" number. Deleting files is possible with the Delete key
on your keyboard or by choosing the respective command in the right-click menu. 
You may as well change the duration, fade time and transition effect - again, multi selection applies
the chosen setting for all selected items. Further to the right you find "In" and "Out" times that take
effect on videos or audio files only and define the starting and ending frame. Notes for internal use can
be added too.

The overall duration of all files (minus the fade times, as there, two files are played back at the same
time) results in the length of the Playlist. This is displayed in the Playlist Inspector . It offers
general settings like Folder and File ID, resolution or aspect mode.

As a last step, the Playlist needs to be assigned to a video layer. You may assign it as an active
value or program it on the timeline as one single container. Please note, that you may assign the
same Playlist to several video layers. Then the playback status can be different per layer, e.g. one
layer can be in pause mode showing the file with index 5, the other in play mode between index 10
and 11. The Playlist tab offers a drop-down menu containing all layers the Playlist has been assigned
to. Depending on this drop-down menu, the Playlist changes and displays the layer's playback mode
and the currently active index file with a green highlight. In the image to the left (which can be
enlarged) the chosen Playlist on Layer 1 is currently fading between two images.

++ NEW WARPER WITH AUTOMATIC MARKER CALIBRATION ++

Version 5.5 includes a new version of the Warper . In addition to the import of third party 3D
objects it is now possible to attach so called "Markers" on them. They are available using the tab
"Marker". First add some markers and position them on the virtual object looking at your screen. In
the "Calibration Mode" you may position the marker's second instance within the projected image on
the real object. Having done so, the button "Update Cal" calculates the camera position that fits the
best to the relative distance of the two marker instances.
As a last step (that can be alternatively taken before positioning the markers) you need to set the
Lens factor or FOV in the tab "Camera / View". Read more...

[Rev 7831] - Version 5.3

++ NEW MATRIX PATCHER AND MATRIX OPTIONS IN PANDORAS BOX ++

We developed a new interplay of Pandoras Box and our tool
"Matrix Patcher" that is more time-saving and opens up new
possibilities when working with Art-Net LED walls. Create a patch
in the Matrix Patcher and export (or update) it in real-time to your
Pandoras Box project with one click. Drag the new format ".pbx
file" on any(!) output  and save it onto the timeline. The preview

 can be toggled between the visualization of the DVI output
and the Art-Net patch.

The maximum number of controllable panels has increased
enormously as it is now possible to save a specific network card
and target IP address within a fixture. This allows as well to
separate the Art-Net data from the Pandoras Box show data.
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In addition to these improvements, the Matrix Patcher  offers
an array tool, a great time-saver when working with several tiles
from the same type.

From now on, Art-Net data for matrix patches can be sent within
any IP range, it is not tied to the Art-net specification to be sent
over a 2.x.x.x network anymore!
As well, Pandoras Box accepts incoming Art-Net from outside the
2 IP range.

++ NETWORK CARD SELECTION ++

The Configuration tab  offers per each protocol a drop-down lists with all network cards installed on
the system. Select one and restart the application. Now the entire Pandoras Box communication of
Master and Clients will be transferred by this defined adapter and its IP address.
You may choose a different network adapter for the Pandoras Box show data , DMX / Art-Net
Mode , CITP Thumbnail Exchange  and Streaming ACN  and of course for the Client .
Thus you can for example separate the show data generated  by the video / graphic containers and
their keys in the timeline from all Art-Net data.

++ BREAKOUT PANES ++

The User Interface of Pandoras Box Master software may be
altered in a more flexible way. Right-click on a pane or tab and
choose to break it out of the main frame. Now it can be moved
and scaled independently. In addition each tab can be split into
two. Read more...

++ IMAGE SEQUENCE AND UNCOMPRESSED PLAYBACK ++

Image sequences  have the advantage of keeping the best
possible image quality, preserving alpha channel information and
allowing more flexible and safe workflow. With Pandoras Box 5.3
it is now possible to add image sequences directly to your
project and play them back.

In addition we do offer SSD drives for our Server hardware.
Compared to normal hard drives they allow better playback performance regarding image sequences
and other uncompressed video formats.
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++ WIDGET DESIGNER DEVICE ++

The new device type "Widget Designer" allows to execute
commands directly from the timeline in a very convenient
workflow. The commands can be now stored within keys.

Primarily, Widget Designer  has a built-in script language
allowing you to create customized routines of commands that
control specific features of Pandoras Box, Widget Designer or
other 3rd party products and protocols but it was only possible to
call these commands from Widget Designer itself. Currently
there are over 800 commands  available.

Now it is possible to execute commands as soon as Pandoras
Box' timeline calls them up, that means at a defined time in the show. This topic  explains in detail
how to program Widget Designer commands directly into the timeline and how to get trigger values
from it.

++ CONTENT AS INTERFACE: LAYER PICKING ++

With the feature "Layer Picking" in version 5.3, content
interaction has gone one step further. It is now possible to
recalculate the mouse position within the preview or even the
Client´s fullscreen window and thus recognize what layer is
touched and where exactly on the layer the mouse is located. A
layer has become a true interface. This chapter  explains
"Layer Picking" in more detail.

++ RENDER PASSES AND BLACKLEVEL COMPENSATION++

From now on, layers can explicitly set to be included or excluded
by the first Pandoras Box render pass and thus be placed
outside from the warp / keystone / softedge structure. This
setting is available in the layer's Inspector . More details
regarding the Video Processing Pipeline  can be found here.

Combined with new effects, it allows to set up blacklevel
compensation  when working with multi-softedged
projection(s).

++ IMAGE CONVERTER: Transparency in mpeg-videos ++

The Image Converter  is able to render a mpeg video from an image sequence. In version 5.3 it
includes the feature to generate a black-and-white mask in addition to the main video. You may
choose to include the b/w information  side-by-side like, resulting in one video. In Pandoras Box,
the Masking effect "Alpha Left Right" (respectively "Alpha Top Bottom") separates the two videos
again and renders them while applying a keying effect to the main video.

This workflow leads to transparency (alpha channel) in mpg-videos and saves far more performance
than other codec solutions.
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++ SOFTWARE DEVELOPMENT KIT ++

There are new functions within the Pandoras Box SDK (PB Automation). Please refer to the chapter 
SDK  that has been revised and now offers many examples and detailed description.

++ UNLIMITED ASIO TRACKS++

The number of available ASIO Tracks has been increased. Unlimited audio tracks for synchronized
audio playback, are available for:
- all Pandoras Box Server PRO versions
- Pandoras Box Manager PRO
- Pandoras Box Editor and 
- Pandoras Box Offline Manager

See Audio Tracks  for more information. The Product Overview  informs about the available
number of ASIO Tracks on other products.

++ WIDGET DESIGNER VERSION 4 ++

There is a new version for the Widget Designer . Among many features and enhancements, the
new build-in Web Server  allows to export pages to be accessed online with using a standard web
browser.

[Rev 7135] - Version 5.1

++ STREAMIX ++

StreamiX  is a TCP based Desktop Streamer that works as a Live Input in Pandoras Box. This tool
streams any Windows XP / Win7 desktop region without using capture cards.

++ MEDIA ENCRYPTION ++

Pandoras Box Media Encryption  is a technology that encrypts media in order to protect content
from being played back by unauthorized persons or systems without permission. To decrypt the
media it is necessary to possess the correct key and policy. They can be transmitted digitally or be
bind to an optional additional hardware Media Dongle to make the process even more safe. It is
possible to set a time limit for the playback.

++ LIGHT AND SHADOW ++

Light Layers  allows setting a light source to illuminate other
Video and Graphic Layers. The light source is customizable, e.g.
it can be adjusted in its direction and color. As well it can project
any media, images and videos. Video and Graphic Layers with a 
Light Effect  may receive the light and cast shadows on
themself and other layers. Again, the way how they reflect light
is adjustable, thus it is possible to give them a specific material
look.
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++ ASIO CLIENTS: Audio Tracks on all playback products ++

All Pandoras Box 5.1 playback products support ASIO Audio Tracks. In most cases the number of
ASIO Tracks available to each playback product is equal to the number of Video Layers. For detailed
information please have a look at the Product Overview .

++ DYNAMIC WARPING AND NEW WARPER 3D ++

Users can now animate and control the Warper via keys in the timeline or any other Art-Net sending
device. In return the warping object influences the layer on the timeline in real-time.
This new development is perfect for realizing projects that involve the tracking of moving head
projectors and moving sets, where the warping has to change in a seamless way according to the
different positions. Click here  for a step-by-step tutorial.

With version 5.1 there are two different Warper variations available. The Warper 2D is available for all
Player products. The new Warper 3D is available on Server products. 
3ds Max files can now be directly imported and used for warping - they can be edited too. In addition,
the Warper mesh points can be moved and worked with along the Z axis. Camera View settings are
possible and can be applied to a Camera Layer in Pandoras Box with one mouse click.
Global planar textures can now be applied to multiple meshes as well.

The Warper 3D will be explained in detail in the next version of this manual.

++ PRESETS ++

The preset feature has been improved. Not only single snapshots
from active values can be taken. Now, a preset can hold an entire
set of keys. Both preset variations can be applied at any (other)
point in time to any (other) layer. In this way one situation can be
created and then be reused severally in the programming
process.
In addition a preset can be modified in later programming and
automatically change all according keys in the sequence.

++ QUAD SERVER AND PLAYER SUPPORT 3G++

V5 QUAD Server and QUAD Player workstations now support 3G. The manual explaining the Quad
setup can be found here .

[Rev 6700] - Version 5.0

++ MULTI-INSPECTOR ++

The Inspector  has been improved, allowing a faster and easier work flow. It is now possible to
multi-select items and modify them all at once. This applies to all possible items such as key frames
and containers, cues, files and layers. The Inspector informs you how many items are selected and
applies the new settings to all in the same way.
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++ NEW MATRIX PATCHER AND PIXEL REMAP FX ++

 

Pandoras Box is featuring an easy and fast work flow when
working with rotated LED video tiles.

Previously the Matrix Patcher was only used if working with LED
tiles controlled via Art-Net. From now on it plays also an important
role if working with LED video tiles that are connected via DVI and
a LED video processor. Most LED video processors are capable
of creating only horizontal and vertical layouts for the video tile
alignment. As soon as any of the tiles are rotated (in any angle),
content mapping can be very difficult and complex to setup.
For those creative applications Matrix Patcher  and a new Pixel
Re-Mapping FX  were designed.

++ IMAGE CONVERTER ++

Pandoras Box Image Converter  now supports direct Mpeg Encoding (where PB Encoder license is
available). This will decrease render and converting time significantly.

++ SPLITTER ++

Pandoras Box Splitter  now allows to export 24bit png files requiring less space on the hard disk.
In addition a new function "Output Auto-Alignment" allows easier and faster work flow.

++ CURVE EDITOR ++

The Curve Editor  has been improved: New value references,
different mouse modes and an improved zoom function create a
more comfortable overview and faster work flow.

[Rev 6107] - Version 5.0

++ VIDEO EXPORT & LIVE INPUT RECORDING ++

The video export offers users to greatly improve their work flow and export entire scenes as HD video
while having the flexibility of a real-time editing system. For live video ingest, you can now record &
capture from any live input source up to 2K/HD.

++ AEON™  FX ENGINE ++

The dynamic shader effects engine enables users to create and combine an almost unlimited number
of effects. All effects and animations are automatically synchronized across the system network,
see AEON™ FX Engine .
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++ FIREFLY™ 3D SYSTEM ++

FireFly™ allows for the creation of elaborate real-time particle effects in a true interactive 3D
compositing space. Various emitters can be setup and applied with forces such as Wind & Gravity,
see FireFly Particles .

++ QUAD HD Output ++

The new QUAD Server and QUAD Player workstations offer users up to four independent HD DVI
outputs with built-in EDID Management.

++ ASIO Multi-Channel Audio++

The Pandoras Box Manager Software now supports ASIO audio interfaces and offers synchronized
multi-channel audio playback, see Audio Tracks .

++ LAYER FLEXIBILITY ++

It is now possible to re-structure individual layers easily per drag & drop. This way the rendering order
can be instantly re-ordered and organized according to your project setup. Arranging your layer
structures has never been easier, see Device Tree  chapter.

++ UNLIMITED GRAPHICS & SOURCE ROUTING ++

Create and add any number of graphic layers depending on your project needs. Make use of the new
efficient source routing to route any video layer sources to any other layer.

++ THREE NEW WORKFLOW TOOLS IMPLEMENTED ++

IMAGE CONVERTER
Many operators find themselves being handed an ever greater variety of picture data with different
sizes. The Image Converter can recalculate images prior to them being used, in order to maximize
the overall system’s performance efficiency. It also offers high performance batch conversions and
can turn image sequences into video files.

DOME MASTER
This tool is a spherical map converter that allows the conversion of dome master files to spherical
map files, making it an essential tool for the dome content production workflow. Its sub-pixel
accuracy allows optimum image sharpness for large scale projections. It processes up to 8K files.

183

602

169

868

862



56

SPLITTER
With the Splitter, one can create files for panoramic projections and/or dome projections. The Splitter
allows users to render out the individual split files needed for individual projectors. The Splitter can
also batch image sequences and export video files.

++ HIGH PERFORMANCE MODE ++

With Pandoras Box version 4.7 50/60p video playback has introduced a "High Performance Mode"
that requires more system and gpu ram.
From this release on the "High Performance Mode" should only be used if you intend to playback or
process high frame rate content or live inputs.
This feature can be found in the Client/device inspector or if you are running in standalone mode in
the Configuration Tab .

++ FLUIDFRAME ++

FluidFrame™  Technology addresses a challenging and highly complex topic in frame rate
conversion common to all media servers, live video processing units as well as signal processing in
general.
With FluidFrame™, a smooth cross-conversion that can take any input and output frame rate,
supporting both interlaced and progressive sources and clips is possible now.
This way for example 59.94 video input signals are displayed without any frame drop on 60Hz output
displays. FluidFrame™ can therefore also handle 50Hz to 60Hz real-time conversions.
In addition to this, it allows smooth playback of high-speed frame rates such as 50 or 60p content
and higher. FluidFrame™ Technology can be applied to any live video input or content playback
scenario ranging from straight forward Live Video processing to the synchronization of multiple HD
SDI streams for Live Stereo 3D applications.

++ BUNDLE PROJECT ++

The File Menu  now allows you to bundle your project under a new name and location. All content
used in the timeline will be copied to the new location as well as the show file. This option allows you
to only have one folder to archive your show on a external hard drive. To play your show again, just
copy this folder at its original location on your hard disc and all paths will be recovered.

++ AUTO ASPECT RATIO ++

Choose for each layer how it should handle the aspect ratio of the loaded media files. 
Four modes are available, see detailed information in the Layer Inspector :
1. none (by default) - same behavior like before, see Figure B.
2. Horizontal Fit, see Figure C.
3. Vertical Fit, see Figure D.
4. Horizontal and Vertical Fit, see Figure E.
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Example:

Figure A: this is the original media file.

Figure B: Layer Aspect Ratio is set to "None" and the image is scaled to a 4:3 layer.

Figure C: Layer Aspect Ratio is set to "Horizontal Fit", the files aspect ratio is kept and it fits
horizontally into the layer.
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Figure D: Layer Aspect Ratio is set to "Vertical Fit", the files aspect ratio is kept and it fits vertically
into the layer.

Figure E: Layer Aspect Ratio is set to "Horizontal and Vertical Fit". Regardless whether the file is
upright or crosswise, all parts of the file will always be shown in its original aspect ratio.
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4  What's New in Widget Designer

This "What's New" chapter starts with updates for the Widget Designer  version 6. The changelog lists
also earlier changes, minor ones and fixed issues. You may find it in the installation path, e.g. C:
\Program Files\Christie\Widget Designer 6 6077

[Rev 6077 and 4216] - Version 6.0

++ New Widget Designer Licenses ++

The Widget Designer licenses are newly structured. Earlier, there was a free STD version, a PRO
version and an ULT version. The free version, that you can simply download, install and run without a
dongle (or another key) is now called Widget Designer Free edition. The PRO version is unchanged
but is simply called the Widget Designer or the licensed Widget Designer. It can be extended with
the Unlimited Web Clients Option to enable the Web Server to have multiple-sessions and session-
based values.

++ Run and Edit Mode Have New Shortcuts ++

Surely a minor change with great effect. The shortcuts for the Run and Edit Mode are changed.

Go into the Run Mode with [F8] and into the Move / Edit Mode with [F9]. 
[CTRL + SHIFT] lets you create the last Widget. By the way, the right-click menu from any Widget
gives you the command to create this Widget again as a new control.

All shortcuts can be found in the Keyboard Shortcuts  chapter.

Alternatively, use the icons from the new toolbar to toggle between the Run and Edit Mode or choose

the Last-Created icon.

++ New Interface Behavior and Additional Toolbar ++

One of the first things you might notice is that Widget Designer and all its Widgets have a new look.
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When you create a larger project you will also soon notice that its performance is better and in
general everything goes faster.

It also starts within a default window, not in fullscreen mode any more. One WD application can have
several windows, whilst each window can be subdivided into pages (that are known from older
versions already).
To set up the project, a window or the page go to the Project Settings , Window Settings  or
Page Settings .

In general all menus and dialogs are newly structured and designed. Starting at the top, the menu bar
("Controls" or "Create" is now "Widgets" and the Tools were separated) adjoins the new toolbar. It
contains all available widgets...

Further down, you will notice that the right-click menu is cleaner and "smarter", e.g. right-clicking on
a Widget like a Fader offers the commands to either generate relating nodes or to create this Widget
again. The item property dialog and others are subdivided into extendable sections. How to work with
them and why it matters how you draw a selection box is explained in the chapter User Interface .
At the bottom you will see a new Status bar. 

++ Widget Explorer, User Profiles and Import  ++

In addition to the above and below mentioned enhancements, there are further workflow optimizations:
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The completely new Widget Explorer  found in the View menu or via [CTRL + W] is depicted to the
left. It displays a tree view of all items of your project. They are sorted by windows , pages ,
types (of widgets  or nodes ) and individual items. The four buttons below the tree view allow you
to blank out the corresponding type. You can also search for a special item. Once clicked on an item
its Item Properties are loaded to allow very fast programming.

Widget Designer supports user profiles  [File Menu > Profile Settings] where you can specify some
general settings concerning the usage of the WD application itself.

Eventhough working in Widget Designer was never as easy and fast, the fastest way of course is to
re-use projects and solutions you have already created. For this, we have designed an Import tool that
helps you choosing and loading the required widgets, nodes, pages etc. The Import Settings can
be found in the File menu.

++ CSS Styles ++

Since Widget Designer 6, the Widget Designer interface is based on
HTML-5 and features the possibility to style and manipulate complete
pages or single widgets due to internally used CSS3 styles
(Cascading Style Sheets). Those can be imported and applied to the
local user interface. Web designers can easily style customized
control panels for a variety of different users and applications. But you
can also utilize the full power of CSS in WD6, with or without any
technical knowledge of CSS specifics.

Most widgets (and pages and windows) can be modified using web
styles. This includes layout, design, filters, images, animations -
basically anything you can do with CSS. 
In the widgets' properties dialog, these styles can be found in the
panel "Effects & Animations". There you can add and apply several
styles that you can choose from a large selection of out-of-the-box

styles, but you can also add your own styles, of course. Any Window, Page and Widget 

See more in the chapter Effects & Animations (Web Styles)

++ Protection and Encryption ++

Widget Designer allows you to lock and/or encrypt single or
multiple widgets, nodes, pages, windows or the whole project file.
Hence the Protection Settings are part of many dialogs:
To protect the project, open the Project Settings  from the Edit
menu .
To protect a page, open its Edit Page dialog either with the right-
click menu or from the Pages menu .
To protect a widget, open its Item Properties dialog with the right-
click menu or the shortcut [ALT + P].

All passwords can be remembered in Widget Designer so that you do not have to enter them every
time. However, this applies only to the current session. After closing the Widget Designer, the
passwords will be expired.
You have the possibility to reset all passwords during an open session with Edit  > Reset
protection passwords...

Please note that the protection settings are rather designed for protecting your data in case of
distribution. If you like to set passwords for windows, pages and widgets in order to prevent other
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people from using them, please use the command WDPasswordDialog. A common example would
be a page containing only nodes that should not be accessed by customers using the project.

See more in the chapter Protection Settings .

++ Web Server and Group Values++

The integrated web server  now also drives the native Widget Designer interface. In addition it is
completely redesigned to work more efficiently so that viewing pages and using controls is much
more fluent than before. The web server can host multiple sessions of Widget Designer. This means
that multiple pages can be controlled independently of one another from an unlimited amount of
clients. This is perfect for installations where several remote controls are needed with a centralized
control station. The later requires the optional feature "Unlimited Web Clients".

If you are familiar with Session values from version 4.7, you will understand Group Values very fast.
By adding Widgets to a certain Group, they are not synchronized on all interfaces, the main Widget
Designer interface and browser interfaces, anymore. Each interface can either have individual
Widgets, whereas some Widgets even support different styles, or Widgets are synchronized for
certain Group participants. Read more in the chapter Group Values .

++ Major Changes in the Scripting and Member notation ++

The Script Language is improved. The Script Assistant offers commands only, when an associated
Widget is part of the interface already. In addition, it helps you filling out the commands by telling you
the format, e.g. ID needs to be an integer. It also offers an example for the chosen command. The
Debug Logger (explained below) also helps you with scripting.
In addition, there are some new rules when it comes to scripting. The Scripting Cheat Sheet  sums
up all changed and is a fast guide line for all who are familiar with scripting in WD.

Member and Session Values are now referred to as Member and Group Values (which were explained
above), to work with them please read the topic Object and Member Notation .

++ Debug Logger ++

In any Script Field you can choose from
the right-click menu to "Test" the entire
script or to "Test Selected Lines". This
will execute your commands and in case
there is an error or warning, the Debug
Logger opens and shows it. 

++ Composite Nodes ++

A compilation of numerous nodes can be integrated in a re-usable custom node for further use. This
drastically reduces the amount of required nodes, makes changes to the system much more efficient
and enhances the overview when it comes to extensive node systems. See the chapter Composite
Nodes . (Examples will follow shortly...)

++ Copying Nodes is Faster ++

Node dependencies are now also copied. For example, if you copy a Label and a Label output node
that refers to it, the pasted node will refer to the pasted Label
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++ New Widget InputBox and Added Features to Existing Widgets ++

The InputBox can be best described as a Textbox with a single line
only.

A Label has now the ability to execute a script when being clicked on. 

The TreeView is now usable to upload from external web browsers.

++ 64bit and New Project Data Format++

Widget Designer has transitioned to a 64bit application, so please make sure to run the Widget on an
appropriate operating system. Due to this you will find the data in the 64bit application folder “C:
\Program Files\Christie”.

Additionally, the data format of the project has changed to the json format (JavaScript Object
Notation).
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5  Product Overview

Introducing the Manager, Player and Server

The Pandoras Box product family consists of software and hardware based solutions. In short:

The "Manager" product range is a software solution. Hardware can be custom hardware or Pandoras Box
hardware. Mainly, the Manager functions as a Master system used for show control. There is also a
special Manager Offline solution that is used for show pre-programming and video editing. Other
differences are listed in the product structure table  at the end of this chapter.

The Pandoras Box Player product range is divided in two groups of upgradeable models featuring a real-
time 2D compositing engine for image and video playback.
A "Software Player" can be purchased as a software solution to be free to run it on custom hardware or
Pandoras Box hardware. The "Player" and "Compact Player" solutions are bound to Pandoras Box
hardware. As shown in the product structure table , the product defines, among others, the number of
available layers and sequences.
Any Player can run in Master mode for show control to control other Clients, in Master mode as stand-
alone to combine show control and video playback on one output in one machine, or as a third solution,
in Client mode for video playback on one or multiple outputs.

The Pandoras Box "Server" product range features a real-time 3D compositing engine for image and
video playback at any size.
A Server is always bound to Pandoras  Box hardware. Depending on the product, the number of available
output viewpoints (cameras) for individual output setup differs. A Servers includes all different layer types

.
A Server can run in Master mode for show control to control other Clients, in Master mode as stand-
alone to combine show control and video playback on one output in one machine, or as a third solution,
in Client mode for video playback on one or multiple outputs.

Show Control

We offer the Pandoras Box Manager for interactive media control. It is a timeline based show control
solution, allowing fast and easy on the fly programming and show setup. A Manager is always the so
called Master system, to which one or several Clients connect to. The Master administrates Client(s),
media file(s) and timeline(s) whilst the Client renders and plays back what the Master commands. A
Client can be either a Player or Server.
Note that a Player or a Server can be used as a Master software as well, e.g. if used stand-alone.

Please refer to the chapter User Interface > Master  to learn more about the elements of the Master’s
user interface.
As additional interactive media control device we offer the Widget Designer .

Video Processing / Playback

Pandoras Box Servers and Players make the scalable Pandoras Box playback system. They
communicate directly via TCP/IP with any Pandoras Box Master control system. A synchronization
process takes care of all connected Client devices to be controlled in sync. Read more about the Master
/ Client remote setup . In difference to a Manager, a Player or Server can toggle into full screen.

Please refer to the chapter User Interface > Master  to get more information about the elements of the
Server’s / Player’s user interface if they are started in the Master mode. The chapter User Interface >
Client  explains the Client's user interface. Device Control  describes the different device types, i.e.
layers.

For hardware settings regarding the included input and graphic cards, please read the topic about 
Hardware and Accessories .
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Accessories

All Pandoras Box Systems are designed to interact with multiple protocols and output devices. Beside
the Pandoras Box product range other SMPTE, DMX, RS232 / 422 or any TCP/IP devices might be
remote controlled from any timeline as well. This allows perfectly synchronized show control.
We offer specialized interfaces for SMPTE I/O, DMX, serial and sensor control.

All accessories and optional features are described in Hardware and Accessories  whilst the
programming is detailed in Device Control  and External Control .

Additional Tools

There is software pre-installed on Pandoras Box hardware called the PB Menu . It starts automatically
when booting. It covers the Windows desktop and consists of a few buttons that give access to the most
needed actions, e.g. starting the Master or Client software, opening the Windows Explorer (File
Browser).
The PB Menu includes another software called the VNC Remote , or simply Remote. With that
software you can establish a VNC connection to another computer that is in your network. The other
computer needs to have a VNC client running to pick up the connection. If PB Menu is installed and
running on the remote computer, you do not need an additional VNC client. You enter the according IP
address and see the desktop of that computer. Now you can click your local mouse and use the local
keyboard to interact with the remote desktop.

Product Structure

The following product structure was introduced in May 2016 with version 5.10.
Pandoras Box Server and Software Player Version 5.x "LT" and "STD" as well as the "Manager LT"
purchased earlier are supported and provided with free software updates for one year. Existing features or
software restrictions are not altered. Please contact your distributor in case you are interested in
upgrading your products to the new product structure.
In case you purchased a "PRO" version or "Manager STD" you might notice that some features were
upgraded to meet the figures listed below.

The products "Server", "Player" and "Compact Player" include hardware. We offer three to four editions
(Light to Ultimate) defining the size of memory and in case of Servers the CPU and RAM. The number of
physical outputs is defined through the graphics card, for the time being that is four Display Port outputs.
The number of Output layers is defined with the software, e.g. with a Server Single Output you will have
access to the parameters of one Output layer.
Below, you see that all hardware models can be purchased with zero (software) outputs, this is of
interest for applications with backup systems or in case you like to use them for Pandoras Box software
products. In other words, for the software products EDU Server (Educational version), Software Player,
Manager, Manager Offline and Widget Designer you have the choice of using your own custom hardware
or purchasing additional hardware from us.

The Software Player is a Multi-License product, meaning that multiple licenses multiply some features,
e.g. the number of Layers or Sequences. When you start the software, it will automatically recognize
how many licenses are available on your hardware and start in the according Multi-License mode. This
applies in case you use multiple dongles or in case you purchased one single dongle with multiple
licenses. 
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Show Control and Playback Solution

Server Player

Server
EDU

Server 6*
Player

Compact

Player 4*

Software
Player

Hardware / 
Software

Hardware +
Software

Software
Hardware +
Software

Hardware +
Software

Software

Software Model -
Output Layers

Zero - 0
Single - 1
Dual - 2
Quad - 4

Dual - 2 

Zero - 0
Single - 1
Dual - 2
Quad - 4

Zero - 0
Single - 1
Dual - 2

Single - 1 
3*

Base Parameters 3D 3D 2D 2D 2D

Video Playback max. 16k max. 16k max. 4k max. 4k max. 4k

Video Layer Unlimited Unlimited 8 4 4 3*

Graphic Layer Unlimited

Audio Tracks Unlimited Unlimited 8 4 4

Effects / Layer Unlimited Unlimited 8 4 4 3*

Particle Sys. / Layer Unlimited Unlimited 8 4 4 3*

Warping, Keystone,
Softedge, Matrix

Yes

Network Sync Yes

Sequences 5* Unlimited Unlimited 4 2 1 3*

Mpeg2 Encoder 5* Included Included Optional Optional Optional

StreamiX Inputs 5* 32 32 8 4 4

Input Recording 5* Yes Yes No No No

Media Encryption 5* Decryption
De- and
Encryption

Decryption Decryption Decryption

Playlists 5* Yes

Web Browser 5* Yes

Hardware Model -
Redundant SSD
(in GB)

LT    - 480
STD - 1440
PRO - 2880
ULT - 5700

LT - 480
STD - 1440
PRO - 2880
ULT - 5700

LT - 480
STD - 1440
PRO - 1900
7*

 

Form Factor
4U 
19" Rack

4U 
19" Rack

1U ½ 
19" Rack

 

Video Input
None, DVI,
HD/3G SDI *

None, DVI,

HD/3G SDI 2*

DirectShow
only

Audio Output
None, 1x/4x
ADAT or MADI

None, 1x/4x
ADAT or MADI

Framelock / Sync Optional Optional

10Gb Ethernet Optional Optional

Optional Accessories
DVI Processor
SDI Processor

DVI Processor
SDI Processor
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Show Control Solution Interactivity Solution

Manager

Manager
Offline
Manager

Widget Designer

Hardware / Software Software Software
Unlimited

Web Clients
Optional

Audio Tracks
16, optional
unlimited

Unlimited

Network Sync Yes No

Sequences
8, optional
unlimited

Unlimited

Mpeg2 Encoder Yes Optional

Input Recording Yes No

Media Encryption
De- and
Encryption

Decryption

Playlists Yes Yes

Optional Accessories

Jog Shuttle
Fader Board
SMPTE Link
DMX Link

Optional
Accessories

Jog Shuttle
Fader Board
SMPTE Link
DMX Link

* A maximum of 2 input boards can be configured
2* Only 1 input board can be configured
3* Count multiplies with number of Multi-Licenses
4* Expected 2016 Q4
5* Available in show control mode
6* The Education edition is available only to universities and schools with an approved education
contract
7* The Compact Player has no redundant storage

Date: May, 2016. All information contained in this document is subject to change without prior notice.
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6  Pandoras Box

The Pandoras Box section is divided into these themes:
Content
User Interface
Device Control
Input / Output Control
Network & Synchronization
StreamiX Live Input

6.1  First Steps and Troubleshooting

This chapter is for all who are new to the Pandora Box product family, it covers:

- how to troubleshoot  (e.g. for technicians who have to maintain a Pandoras Box installation but did
not attend a training)
- the most important tabs and buttons of the user interface to do basic changes
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6.1.1  How to Connect via VNC Remote

This is the screen you start with. What you see is called the PB Menu. If you like to access another
computer, click the "Remote" button.

You will see a an image, while you wait for the Remote window to open.

Now, you see the interface from the Remote tool. With that software you can establish a VNC
connection to another computer that is in your network. The other computer needs to have a VNC client
running to pick up the connection. If PB Menu is started on that computer, it automatically started one
for you. Now, you can enter the according IP address in the "VNC" text field.



70

Now VNC Remote tries connect. If the connection cannot be established, check:
- if you entered the correct IP address
- if the computer is in the network
- if the network is OK, e.g. by pinging the computer

When the connection is established, you see the desktop of that computer. Click your local mouse and
use the local keyboard to interact with the remote desktop.
If you connected to client computer that renders in fullscreen, you might want to leave fullscreen: click
into the window and then use the shortcut keys: CTRL + F
If you connected to a Win7 client that renders in fullscreen, you do not see the fullscreen, even though it
is there. Instead you see the desktop underneath it. You will notice that you cannot click something in
the desktop. Do the above steps, click in the Remote window and use CTRL + F and you will see the
small rendering window.
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Above you see the fullscreen rendering and after CTRL + F the small rendering window.

If the Client does not render anything, for example because the content was not spread, it looks like this.
How to spread content is explained in the chapter "Basic steps" .
If there are problems, also check, that "Master IP" displays the correct IP and not the words "Not
connected"
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6.1.2  How to See the Taskbar

This is the screen you start with. What you see is called the PB Menu. It hides the taskbar. If you like to
see it, click the "Settings" button.

Then click on "Taskbar On".
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6.1.3  How to Ping Other Computers and Check Your IP and Mac Address

This is the screen you start with. What you see is called the PB Menu. It hides the taskbar. To see it,
click the "Settings" button and then the "Taskbar On".
Now click the Windows Start button and choose "Run...".

Enter the below code and click OK:
cmd 

The Command Prompt window opens. Simply write (behind the already existing entry) the below codes
and hit the Enter key.
In order to ping another computer in the network, write "ping " and the IP address. If the ping goes
through it looks like the below image.
Enter for example:
ping 2.0.4.1
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If the ping request is not successful, there is either:
- a fundamental network problem (loose or broken cables, overloaded or broken switches or other
connected devices)
- an IP conflict with other devices, for example because other devices have the same IP address (check
all IP addresses within the Windows settings or with the PB Menu button "Network Setup" or the
command in the below image)
- the entered IP address is wrong. The answer takes then longer and says for example "host not
available"
- entered text is wrong, check that you have not forgotten to write "ping", that there is a space and that
the numbers are separated with dots

In order to check what your own IP address and the MAC address, enter:
ipconfig
For more advanced results:
ipconfig /all
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6.1.4  How to Check and Change the Resolution

This is the screen you start with. What you see is called the PB Menu. If you like to check the
resolution or need to change it, click the "Display Setup" button.

Now you see the NVIDIA Control Panel (or another window if another graphics card is used). To check
the current resolution, or in order to change the resolution, click on "Change resolution". For other
settings, see this chapter .712
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6.1.5  How to Access Log Files

This is the screen you start with. What you see is called the PB Menu. If you had problems and the
technical support asked to receive your log files, first of all you need to connect to the computer you had
problems with. That means, if it was a Client, first connect to it. These steps are described in the
chapter "How to connect via VNC Remote" . 

Now, click the "Settings" button and then the "Show log" button.

You see the Windows Explorer with the according Logs folder. 

Take all files that you see and mail them all to the technical support.

You might need to do that for the Manager as well as for the Clients (Players and Servers). If yes, enable
a VNC connection to the Client as described in the chapter "How to connect via VNC Remote" . Then
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do the above steps to enter the logs folder. In order to copy them through the network to your local
machine, open a second browser. In there, you enter two backslashes and the IP address, e.g.
\\2.0.1.100
Then you can make a new folder, in our example it is called "files to be copied to USB stick" and copy
the files from the Client to that folder.

Afterwards you close the VNC Remote tool again, and back on your local PC you can then copy the files
to an attached USB stick and transfer them to a PC that is online and send a mail to coolux support. 
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6.1.6  How to Install a New Pandoras Box Version

If you need or wish to update your current Pandoras Box version, you first of all need to download the
new installer. To do so, go to coolux.de > Support > Download-Center and log in with your user account
settings. If you have not registered, please do so, it will only take a minute. Click on the link for the new
version to start the download.

Copy the installer file to all (!) computers that run Pandoras Box. That applies to the Manager as well as
all Players and Servers. Please read the chapter "How to copy files from and to a remote PC" .

Run the installer on each computer.

Then, you need to tell the PB Menu to start the newly installed version when clicking the Master and
Client button. If you do not do that, the buttons will start the old version. So please click on "Settings"
and "Pandoras Box".

A dialog opens where you can see all already installed versions of Pandoras Box. Pick the newest
version and press "OK".
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6.1.7  How to Copy Files to a Remote PC

This is the screen you start with. What you see is called the PB Menu. 

This explains how to copy files to a remote PC (e.g. a new installer). Important notice: Do not follow
these steps if you simply want to copy content to all your Clients. The content spreading and
management is done via the PB Master (e.g. the Manager).

Open two Windows Explorers by clicking twice on the button "File Browser".

In order to copy files through the network to a remote computer, enter two backslashes and its IP
address. In the example below, the browser on PC 2.0.4.1 copies files to the remote 2.0.1.100, so this
was entered in the second browser:
\\2.0.1.100

Afterwards you close the VNC Remote tool again, and back on your local PC you can then copy the files
to an attached USB stick and transfer them to a PC that is online and send a mail to coolux support.
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6.1.8  How to Copy Content to Your Hard Drive

This explains how to copy files from an external hard disk, e.g a USB stick, to Pandoras Box hardware.
Important Note: There is no anti-virus software running and protecting Pandoras Box hardware!! It is
highly recommended to check ANY hard drive for viruses BEFORE plugging it in.

This is the screen you start with. What you see is called the PB Menu. To copy files we need the
Windows Explorer, so click the "File Browser" button.

In the explorer, go to the drive "Removable Disk".

Search for the files you need. Make a right-click on them, and say "Copy". You can also use the short
cut CTRL + C.
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Go back to the "Local Disk (C:)" > coolux > content and the folder that already exists.
OR
Go back to the "Local Disk (C:)" > coolux > content and create a new folder. Choose a good name.

Paste the content into the folder with a right-click and "Paste" and the shortcut CTRL + V.
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6.1.9  How to Copy Content to the Project

The last chapter explained how to copy content from an external hard disk, e.g a USB stick, to
Pandoras Box hardware. Now, it needs to be included in the Pandoras Box software.

This is the screen you start with. What you see is the Pandoras Box Master, in this case a Manager.

In the "Assets tab" open the C drive from the "local" and then go to the folder you have copied the files
to. Mostly, that is C:/coolux/content/... 

If you do not see the folder, make a right-click and choose "Refresh Drive".
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Then drag the folder or single files to the "Project tab" to the project folder you want to have the files in.

Sometimes you need to Spread the file manually. Spreading means that the Master sends this file to
ALL of its Clients (Players or Servers).
Right-click on the file and choose "Spread".
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6.1.10  Basic Steps in the User Interface

This chapter covers the most important tabs and buttons of the user interface to do basic changes.

This is the screen you start with. What you see is called the PB Manager. In the chapter "How to copy
content ... to the project"  you have already met the "Assets tab" and the "Project tab".

This is the "Devices tab" where you see all Clients. The icon displays a red exclamation mark that warns
you that the Client is not properly connected, e.g. because
- network problems
- wrong IP address (in below picture, the "Inspector tab" shows IP 2.0.1.1. for the selected Client "[1]
area 1 - PB..."
- Client not turned on
- Client software not started (no Auto-Start)

If that happens, try to ping the Client  or try to connect to it via VNC .
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The Clients in the "Devices tab" have different layer types. Below, is an example of a Video Layer [1.1] of
the selected Client "[1] area 1 - PB...". To the right side you see the "Sequence tab" with the according
container. The container has stored parameters for the Video Layer. Stored parameters are called keys
and are displayed as diamonds.
On top of the sequence there is the time bar with play or pause "cues". On of them is called in the
example "HOME position".

If you need to change the parameters of a Layer, select it and then go to the "Device Control tab" which
is right next to the "Sequence tab". Here you see for example the parameter "Media / Mesh". If you need
to exchange content, simply drag the file from the "Project tab" onto the media thumbnail.
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To see what the Client renders and what your changes look like, you have the option, to use the
"Preview  tab" on the top right side. If your Client is not seen in there, right-click on it and choose
"Toggle Preview". All previewed Clients show a blue icon in the "Devices tab".

If you stand in front of the display and want to see your changes but the Client is only running in the
smaller window, you can enter fullscreen in the same menu.
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To store your changes, go back to the sequence and choose the time:
- click in the timecode and enter a new number ( 500 means 5 seconds and 0 frames)
- drag the blue line (now pointer) by clicking in the time bar
- use the shortcut CTRL + ALT + "left arrow" to move in front of a container

Right-click and say "Store active". You can do the right-click on:
- the time bar
- a Client
- a layer
- a parameter

When you make changes like these, you might want to save your project. To do that, click "File" >
"Save project".
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6.2  Content

All Pandoras Box systems are Windows 8.1 based and will allow you to play back multiple audio, video
and image formats.
Since real-time rendering requires specific encoding settings, you will find detailed information about the
supported file types in the following chapters.

Display and Content Formats
Defining Content Resolution
Output Resolution Table
Audio Formats
Image Formats
Image Sequence Formats
Video Formats
Encoding

6.2.1  Display & Content Formats

Since the invention of film and the area of black & white as well as colour TV, a lot of image formats have
been around and are still in use. Three different fields have their specific image formats:

Film 8mm, 16mm, 35mm, IMAX

Television SD: PAL, PAL+, NTSC

HD: 720i/p, 1080i/p

Digital Displays VGA, SVGA, XGA, SXGA, SXGA+, QXGA, 4k

Aspect ratio

All these different image formats have different aspect ratios. The aspect ratio describes the relationship
of the image's width and height. A very common aspect ratio used by standard TVs and computer
monitors is a 4:3 ratio.
Another - very common - aspect ratio is 1:1,85 which is used for widescreen cinema projection.
In HD digital projection the common aspect ratio is 16:9.
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The aspect ratio is a very important figure to consider during content production. Wrong settings lead to
distortions in your images, e.g a circle may not look round anymore. In Pandoras Box, you have the
following possibilities to influence the aspect ratio of an image:
- Layer Inspector
- X and Y scaling
- for more advanced users, the Camera  settings might be of interest.

Resolution

It is also useful to know the resolution differences between film, television and digital displays. Film is an
analog way of recording and projecting images, while TV and digital displays have specific resolutions.
When film is transferred to a digital medium, it has to be scanned at a specific resolution; 2K and 4K are
common. At this point, it is important to say that the resolutions are superior to High Definition TV.

TV is available through different standards today. The formats PAL and NTSC are called SD: Standard
Definition. High Definition is an independent format and is subdivided into progressive scan and interlaced
image. Since most digital devices are optimized for progressive scan, this is important for digital
projection and digital lighting. High definition is known in two common standards 720i/p (1280x720pixel)
and 1080i/p (1920x1080pixel).
In Pandoras Box, the setting "Deinterlacing" can be found in the content's Inspector tab .

Digital displays support multiple resolutions that reach from VGA (640x480pixel) to QXGA
(2048x1536pixel).
In the past the most common resolution for digital projectors was XGA (1024x768pixel). Today HD
formats are widely used by high profile video projectors on the market.

The next topics give suggestions how to define your content resolution , provide an output resolution
 table and explain in detail different content formats, such as audio , single images , image

sequences  and videos .

6.2.2  Defining Content Resolution

Resolution optimization for onscreen design

Depending on the screen design, you may not always need a fullHD resolution for playback. If your setup
consists of a large background image with a smaller video insert window, the video resolution of the
insert window does not necessarily need to be fullHD resolution. Playing it back with an originally
smaller size, will save you performance!
Resizing content to a smaller output resolution may lead to a worse image quality. Therefore it can be
more effective if the content has been created for the desired image size.

It is recommended to work with high resolution files if you need the largest flexibility. If the flexibility is
not required or if the performance limit is reached, it is better to decide which content must have a
smaller resolution.
For a maximum of performance and image quality, the optimum case would be to have all video files in
several resolutions. A standard case would be HD, SD and Video-CD format.

HD or not HD

Even if your screen has a large dimension, this does not necessarily create the need for a high definition
video projection. Creating content in 4k or HD is more expensive than SD and the decision should be
taken upon the following considerations. Based on these criteria you should decide, in which resolution
your content needs to be created.
How far or close will the audience get to the screen?
Is the nature of the projected image more graphical background animation or real film footage?
What kind of projection medium is used? 
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What kind of aspect ratio is intended?
What is the native resolution of the projector / display?

The last topic describes the display and content formats  in general. The next one provides an output
resolution  table and explains in detail different content formats, such as audio , single images ,
image sequences  and videos .

6.2.3  Output Resolution Table

After talking about display and content formats  in general and how to define content resolution ,
this topic shows the standard digital and television resolutions and display sizes.
The next chapters explain in detail different content formats, such as audio , single images , image
sequences  and videos .
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6.2.4  Audio Formats

Audio files may be played back in several different ways within Pandoras Box. 

Firstly, you may playback a video file with an embedded audio stream or play an .wav, .mp3 or .mp4 file
directly. In order to play .mp4 files please make sure the Quicktime Player is installed on your computer.
To convert other audio formats for use in Pandoras Box Servers, you might want to use Adobe Premiere
or CleanerXL from Discreet.

Please Note: Please be aware that embedded audio will only synchronize to the local audio clock! It is
recommended to separate audio and video files onto individual layers for proper playback.

Secondarily you may play back an audio file using ASIO. The PB Manager, Player and Server software
support all common ASIO sound cards and offers audio and video playback synchronization to the audio
clock via dedicated Audio Tracks. The number of available tracks differ according to the chosen product.
The topic "Product Overview " gives an overview.
The ASIO Tracks will play mono and stereo PCM Wave files (16 or 24 bit) whilst the sample rate
depends on the ASIO sound card.
More details regarding the setup and use of ASIO in Pandoras Box can be found in the chapter "Audio
Tracks ". 

Another possibility would be using Sonic Emotion, supporting up to 16 channel audio, please use the
Sonic Emotion Hardware Player. For more details please contact www.sonicemotion.com.

With the Sonic Emotion 16CH device , mono wave files with 48 kHz 16 bit can be uploaded and
synchronized to the Pandoras Box Timeline Playback.

The next topics describe other content formats, such as single images , image sequences  and
videos .

6.2.5  Image Formats

Pandoras Box supports the most common file types such as .bmp, .jpg, .tga, .png. Since version 5.5
the dds format is supported too. With version 5.7 we introduced the support of .snp files.
Please make sure, that the images are saved with an RGB(A) color profile as CMYK is not supported.

Image resolution

There is no resolution limit for the images, but bigger files will be scaled to the maximum texture size of
your graphics card. So you don't get any effort using images larger as your texture size!

When using graphic (as well as video) content with more than 2048 x 2048 pixels you might need to alter
the texture size in the Configuration > Render Engine . Some FX and features like deinterlacing and
FluidFrame need to buffer the media file. The memory space for that purpose is limited to 2k per default.
Choosing another texture size will enlarge the buffer for all textures, which increases the used memory
space. Thus it will consume plenty of graphic card memory. Please use the option only if needed.

Image compression, quality and file size

Bitmaps and Targa images provide uncompressed images; this means that there will be no loss of colour
depth or resolution. In general uncompressed files have a larger file size than compressed data, thus
they are using more memory on the hard drive. Nevertheless, don’t be afraid to use them. Pandoras Box
converts any image to an uncompressed format anyway to play it back in real-time.

The image format .jpg does an image compression that leads to a lower image quality. The conversion of
a .jpg to a .bmp does not enhance its quality, it only maintains the quality. If you save a .jpg as .jpg
again, the quality will decrease even more due to the re-compression.
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The image format .png does an image compression too, but other than jpg it is a loss-less data
compression. 

The dds format is a special format. Different to the other mentioned formats, most tools cannot edit or
display this format. Photoshop for example offers dedicated plug-ins to support the format. The Image
Converter supports the dds format as well, thus it is possible to convert images and provide them for
Pandoras Box. You may use them as single images or for image sequences. More information about 
image sequences in general  and the Image Converter ...
The dds format claims to perform better than other formats like jpg, png or bmp. In comparison to these
formats dds images save performance because it is a texture format that can be interpreted by the
graphics card directly. In other words, the CPU and the bus have no load regarding the decompression.

To be accurate, the .snp (snappy) format is actually not an image format itself but a compression library
offered from Google. So if you have a .jpg, .png, .bmp or .dds image, snappy compresses the file size
but keeps the available quality as it simply reduces the file data. If you work with .snp files, the saving or
reading process does not need more time, as the (de-)compression works in highspeed and real-time. In
other words, Pandoras Box can decompress snappy image sequences on the fly.
The result is a much smaller file size whereas the size difference depends on redundancy in your visual
content, such as alpha channels or same colors in motion graphics. This way you gain a lot more drive
space which is especially interesting for SSD systems as their drives normally offer less space.
The tools Dome Master , Splitter , Image Converter  and the new Quicktime Converter  offer to
save images using the snappy format.

Alpha channel

Alpha is the transparent part of an image where you can always see thru and choose a different
background. Pandoras Box will play both alpha file types: Straight Alpha and Premultiplied Alpha.

Each pixel from an image is now saved with its RGBA information: Color and transparency. Not all image
format do support this, some are designed to save the RGB color information only. So if you like to
create see-through logos or transparent images, use the .tga or png file format, or dds.

The previous topics describe the display and content formats  in general, how to define the content
resolution  and provide an output resolution table . Please click these links, if you are interested in
other content formats, such as audio , image sequences  and videos .

6.2.6  Image Sequence Formats

An image sequence is a series of sequential still images that represent frames of an animation.
Commonly, the images are saved within one folder and are labeled with an incrementing file name in
order to preserve the chronological order. They have the same pixel resolution, size and file format,
whereas Pandoras Box supports .bmp, .jpg, .png and the graphics card texture format .dds. With version
5.7 we introduced the support of .snp files.
Please read the previous chapter Image Formats  where - among other things - the difference between
these formats is explained.

Most high-level programs like Adobe After Effects, Premiere Pro or 3D Studio Max are able to render an
image sequence.

The advantages of working with image sequences

+ Quality
When rendering an animation as one single video you need to decide which codec should be used. Each
codec must decide between high / low file size and low / high image quality. When rendering a png or
bmp image sequence, no image information, e.g. color depth or resolution are discarded and thus the
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best possible quality is preserved. The downside is the file size.
A good balance is the dds format, eventhough it compresses the file size the quality does not suffer
much. The dds format is a special texture format send directly to the graphics card without drawing
performance from the bus and the processor. This way you may play back much more dds image
sequences than with the other image formats. Please refer to the previous chapter, "Image Formats"
for more information.
In addition, always depending on the kind of content, it possible to achieve better results regarding the
quality than the mpeg video format can provide.

+ Alpha channel
Only few codecs support the alpha (transparency) channel. The recommended codec for Pandoras Box
playback - mpg2 - only supports RGB. Transparent parts must be keyed out, for example with a
masking effect and an according mask which can be generated using the Image Converter . When
rendering a png or dds image sequence, you can decide to keep the alpha information.

+ Safety
When playing back a video you need to have the same codec installed that was used to render the
video. When working with special / unusual codecs you have to keep in mind that they need to work
platform independently and with good performance. When rendering and playing back an image
sequence, no codecs are needed.

+ Flexibility
Most of the times content production starts before all hardware or technical decisions are made. In case
of large scaled high-resolution softedge projections, for example, the total number of projectors might not
be known, or the final projector positions are still in question. Cropping images or scaling them down
with a batch program is far easier than editing a video. Please see other coolux tools Dome Master ,
Image Converter , and Splitter  that are free of charge. Other image adjustments can be made e.g.
with Adobe Photoshop.
Furthermore there might be limitations and misunderstandings regarding the communication between
companies that participate in the same project. Sometimes there is no direct contact between the
content creator and the operator or other companies within the production chain. In some cases it is a
safer or more confident workflow for them to receive an image sequence and either do the final rendering
process with one of our above mentioned tools or - since version 5.3 - to playback the image sequence
directly in Pandoras Box.

The disadvantages of working with image sequences

- File Size
Bmp image sequences preserve the best image quality possible thus no information is compressed or
discarded. That increases the entire system requirements regarding file transfer and memory. The critical
question for a smooth playback is definitely the number of pixels per frame and the number of file
accesses per second.

- Decompression
Png and jpg sequences compress the image's information in order to get a smaller file size. When being
played back, the system need to decompress each single frame. Here not only the number of file
accesses per second is critical, but also the processor's performance consumption due to
decompression. For that reason we recommend to use bmp sequences. If you like to playback png or
jpg sequences you might want to alter the number of threads used, this is described below.

It is recommended to use image sequences in Pandoras Box with SSD drives as normal hard
drives are slower regarding the number of file accesses per second. If you do not necessarily need to
change individual frames during playback it is a very good and recommended workflow to render an
uncompressed avi at the very end of the content production; you may use the Image Converter  for
example. The avi format combines all advantages but as it is only one file, the system will be able to
load it faster and the playback requires less performance.
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How to use an image sequence in Pandoras Box

Just like any other file an image sequence must be first added from the Asset tab into the Project tab. It
is recommended to save all images belonging to one sequence within one folder as well as to remove all
other images (and other files, e.g. .dsstore, indexing files added automatically from MAC operating
systems) not belonging to the sequence from this folder! In order to add the image sequence you cannot
simply drag the folder, as this would generate a folder with multiple files. Right-click on the folder within
the Assets tab and choose "Import As Image Sequence". A dialog opens and asks for the frame rate;
depending on how the content was created enter for example 25fps or 30fps. As seen below, at this time
a new resource with the sequence icon was added to the Project tab.
A second way to add a sequence to the project would be to right-click in your Project tab, choose "Add
Image Sequence" and attach a sequence using the Inspector.

Now you can start programming with the image sequence by dragging the sequence from the Project tab
into the timeline or by assigning it to a layer via double-click after selecting one in the Device Tree tab. If
the sequence does not play back fluently, you can activate "Fluid Frame" in the Inspector (select the
sequence in the Project tab to see its information in the Inspector). As well you can choose another
setting in the text field "Number of Threads". The other options are explained in the topic "Image
Sequence Inspector".

The number of threads influence how many threads are called by the Pandoras Box application from the
operating system in order to run the sequence. There is no rule of thumb how many threads are the best.
A higher number of threads can make the sequence run more smoothly and at the same time a too large
number can make the playback more stuttery. There is no definite minimum or maximum. It depends on
your hardware, e.g. the processor and type of hard drives. Regarding bmp sequences the default setting
of 5 will give you good results. As png and jpg sequences require more processor performance, another
thread number can give you better results. The optimal number depends on their compression rate.
Please make sure that the threat number is smaller than the total number of images in the sequence.

Tips for the workflow for image sequences

Before using image sequences in Pandoras Box...:

- Check the file names:
  best is to name all files with the same number of characters, in other words, if you have 100 files, the
first one should be named image001 instead of "image"

- Delete additional files from the folder:
  best is to have a folder including the same number of files as images (there should be no thumbs file,
notes or administration data)

- Name the folder with the frame rate:
  best is to have a folder including the frame rate the image sequence was rendered out for, e.g.
"Stars_25fps"; ask the content creator to do that for you; this way you will later on, know for sure with
which frame rate the image sequence should be imported
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The previous topics describe the display and content formats  in general, how to define the content
resolution  and provide an output resolution table . Please click these links, if you are interested in
other content formats, such as audio , single images  and videos .

6.2.7  Video Formats

There are several video formats on the market. Pandoras Box Server aims to support most of them. 

PB supports the following video file types:
.avi, .wmv, .mpg1, .mpg2, mpg4, .mov.

 Also supported video file types:
.mxf (e.g. used by Avid and Sony XDCam). A dedicated decoder is required.
.mxl (proprietary coolux file type, basically it is a mpg2 format). The implemented Encoder Extension
enables you to encode and decode 4k resolution files in this format (depends on available graphic card
RAM).

Please note:
PB Player versions are limited regarding the play back of large videos, currently the limit is 4k for the
maximum file resolution.
On PB Servers, when using video content with more than 2048 x 2048 pixels you might need to alter the
texture size in the Configuration > Render Engine . Some FX and features like deinterlacing and
FluidFrame need to buffer the media file. The memory space for that purpose is limited to 2k per default.
Choosing another texture size will enlarge the buffer for all textures, which increases the used memory
space. Thus it will consume plenty of graphic card memory. Please use the option only if needed.

For more information about differences in Players and Servers, please read the Product Overview

Codecs

A video codec is a compression / decompression method based on a specific algorithm, optimized for
different uses, e.g. for web, CD or DVD use. Not all codecs are optimized for synchronized playback.
An important thing about the AVI, Quicktime and .mxf file format is its kind of container format. This
format may contain different video codecs, it is not clearly determined by its file extension.

Pandoras Box uses all available codecs that are currently installed on your Windows system.
If a video file may not play in Pandoras Box, please check if the codec is installed. For Windows XP
systems you may try to playback the file in Windows Mediaplayer. Windows Mediaplayer is able to
display the properties and codecs of the loaded files.
Other media players are not recommended as they might use their own codecs which are installed on
the system and cannot be used by other applications.

You might need to re-encode the file in a codec that is supported by Pandoras Box. For re-encoding we
recommend to use the Encoder Extension .

Optimum video playback and bit rates for encoding

For a proper video playback with synchronization we recommend video files to be encoded to Mpeg2
(.mpg), respectively to .mxl. Other codecs might be used, but it is recommended to test new codecs
before using them on a show.
Each codec must meet the two demands to encode a file with low file size but high image quality. The
mpeg codec strikes a good balance between the two demands. At the same time it supports the
possibility to playback the file with frame accuracy and synchronization.
In general it does not support to have an alpha channel included (transparent information). However,
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coolux developed a feature in the external tool Image Converter that allows to use mpeg with alpha
channel .

To provide a synchronized playback it is mandatory to encode the Mpg2 files with a constant bit rate
(CBR) and as elementary video only! That means that the audio information needs to be splitted or
discarded. Even if the audio level is at 0db, it is still included in the file and will destroy the possibility to
play it back synchronized.

The bit rate itself depends on the content. The more pixels each frames has, the higher the bit rate
needs to be. The more different color information the frame has, the higher the bit rate should be to
preserve quality. The statement that coolux gives, e.g that a Server may play back 4 HD files smoothly
refers to the recommended bit rates seen below. If you encode HD files with a higher bit rate you will not
be able to play back four files at the same time!

Recommended bit rates:
PAL or NTSC resolution: up to 8.000 kbit/s with a progressive scan
HD resolution: up to 20-25.000 kbit/s 
4k resolution: up to 80-120.000 kbit

Playback with uncompressed formats

If you are interested in playing in uncompressed formats please keep in mind that those codecs preserve
the best possible image quality but also lead to very large files. They draw plenty of performance during
playback. We recommend to use uncompressed formats with SSD drives. You might also be interested
in image sequences .

The previous topics describe the display and content formats  in general, how to define the content
resolution  and provide an output resolution table . Please click these links, if you are interested in
other content formats, such as audio , single images  and image sequences .

6.2.8  Encoding

To transcode most AVI-and Quicktime as well as WMV files to Mpeg1 or 2 in SD, HD or custom
resolution, please use one of the following tools:
- Pandoras Box Encoder Extension
This Encoder is implemented in every Pandoras Box Software (up from Vers. 4.5). It allows Auto-
Encoding when adding files into the project.
Please note that the Encoder Extension needs to be activated on your dongle, depending on your
license this will be fee required.

- Mainconept MPEG Encoder
This Encoder is installed on older Pandoras Box Servers. This chapter is only interesting for users who
have no access to the Pandoras Box Encoder Extension.

To transcode any Quicktime codec to a .dds, .png and .bmp image sequence (a folder containing
sequential images), or .mov files (containing sequential frames) please use the Quicktime Converter:
- Quicktime Converter
This tool comes with every Pandoras Box installation and can be found in the "Tools" menu of the PB
Master.

To encode your content to a .dds, .png and .bmp image sequence (a folder containing sequential
images), or .mov files (containing sequential frames) please use the coolux codec:
- coolux codec / Quicktime component
The codec can be used for content creation. Load the codec into third-party rendering software solutions
like AfterFX; or third-party content converters like the Quicktime Player.
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6.2.8.1  Encoder Extension

The built-in Pandoras Box Encoder Extension allows to transcode most AVI -and Quicktime- as well as
WMV files to Mpeg1 or 2 up to a 4k resolution. The files will be encoded to MPEG Elementary Video
Streams. If the original file contains audio, a separate wav-file will be created
The resolution can be set to SD, HD or a custom one. The Encoder Extension allows you to transcode
files larger than 1080p to our proprietary .mxl format. The maximum resolution is 4080x2800 px and the
encoding process depends on available graphic card RAM.
Please read the topic "Video Formats " if you are interested in knowing more about video formats and
codecs that are supported by Pandoras Box and about optimum video playback.

To open the Encoder Extension Tab, please click on the Tabs Menu and choose Extensions - Encoder
Extension. The Encoder Extension tab will appear next to the Inspector tab.
Please note that the Encoder Extension needs to be activated on your dongle, depending on your
license this will be fee required.

Auto-Encode

To use the Auto-Encode function please set a check in front of all file formats that should be
automatically encoded when added into your project.

The Encoder Extension supports the following file formats:
avi
wmv (Windows Media Video)
mpeg (Mpeg)
mpg (Mpeg)
m2v (Mpeg 2 Video only)
mov (Quicktime Video)
mpv (Mpeg)
m4v (Mpeg 4 Video)
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mxf (File Exchange Format e.g. used by Avid and Sony XDCam)
m1v (Mpeg 1 Video only)
mxl (proprietary coolux file type)
mpe (Mpeg)

The added files will appear in the Encoder Extension Window, the encoding starts automatically. The
status bar shows the progress of the currently encoded file. Once a file is completely encoded, the file
extension in the project tab changes to .mpv. The original file is discarded from the project but kept in
the windows folder from where you added the file into the project.
To stop encoding, please press "Stop Encoding". Pressing "Start Encoding" will continue the encoding
process. 

Manual encoding

To encode files manually please select the files in the project tab. 
In the Encoder Extension press "Add Resources", the selected files will be added into the Encoder
Extension window. The drag and drop function does not work here. To start the encoding process press
"Start Encoding". 
Now everything behaves as described for the Auto-Encoding.

REMOVE FROM LIST:
To clear files from the encoder extension window - no matter if new encoded or not, select the files and
press "Remove from List".

Settings

Auto-Settings
Using Auto-Settings will encode all your files to MPEG2 Elementary Video Stream.

The bit rate will be set to a constant bitrate: CBR 8.000 kbit/s (SD) or CBR 20.000 kbit/s (HD).
The field encoding will be set to “Progressive Frame”.
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All other parameters like video mode (PAL or NTSC), resolution and frame rate will be adopted from the
original file and are not affected through encoding.

Choose Profiles manually
By unchecking "Auto-Settings" you will be able to choose one of the default profiles manually.

Using one of the default profiles will not only affect the bitrate and field encoding but might change the
files resolution: e.g. encoding an HD-file (resolution 1920x1080 px) using the SD PAL Profile will resize
the video to 720x576 px.

Please note: the default profiles can not be edited.
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Creating new profiles

Please uncheck "Auto-Settings" and press "New Settings" to create a new encoding profile.

The new dialog allows you to:

[Name]
Name the profile

[MPEG Type]
Choose the MPEG Type (MPEG-1 or MPEG-2) 

[MPEG Profile / Level]
Set MPEG Profile and Level. Please note that you will need High Profile (Profile 4:2:2:) and High Level for
HD 1920x1080 px resolution. The Level automatically changes to MXL if you encode files to a format
bigger then 1920 x 1080 px.

[Resize Video]
To resize your video, check the box and insert the resolution your video file should be resized to. Note
that the "MPEG Type" and "Level" influence the maximum allowed resolution. In general, the highest
resolution is 4080x2800 px for the mpeg2 format and MXL level.
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[Bitrate]
Choose an amount of kbit/s (recommended are about 8.000 kbit/s for SD, 20-25.000 for HD and 80-
120000 kbit/s for 4k)

[GOP-Length]
The length of the Group of Pictures is editable from 1 to 100. The higher the GOP-Length the better the
compression rate gets at the expense of quality.

[Number of B-Frames]
Choose a value between 0 and 7.

[Deinterlacing]
To enable Deinterlacing, please check the box and also choose a Field Order.

[Motion Estimation Level]
Set a value between 0 (no motion search) and 15 (high quality). The higher the value, the better the
quality, the longer the encoding process.

[Motion Estimation Range]
Set a value between 0 (no motion search) and 15 (high quality).

[Scene Change Detection]
Choose between None, Fast and Refined.

[Audio Processing] 
- Discard: discards the Audio Part, the video file extension
- Split to separate wav: splits the Audio part to a separate wav-File. This file will be added into the
project. automatically. On the hard-drive it will be created in the same folder where the related video
source is located. 
- Include: includes the Audio Part into the encoded video (the video file extension will be "mpeg").

The Audio Part is discarded by default.
If there is no Audio Part included in the encoded video file, the file extension will be *.mpv (Video
Elementary Only). Including an Audio Part, the video file gets the extension *.mpg

Click OK when the new setting is finished. The created profile will appear in the drop down menu.

EDIT SETTINGS:
Select your profile from the drop-down list and click "Edit Settings". All settings are described above in
"Create New Settings". 
Please note that the default profiles are not editable!
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6.2.8.2  Encoding (up to Version 4.5)

Pandoras Box Servers up to Version 4.5 ship with the Mainconcept MPEG Encoder that allows to
transcode most AVI and Quicktime as well as WMV files to Mpeg1 or 2 in both SD, HD or custom
resolution.

An extensive help file is provided with the encoder. The easy steps to encode SD or

HD files are explained below.

SD - PAL/NTSC Encoding

To start encoding, please open the Mainconcept Encoder from the Start menu.
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Click on the “Open…” button in the video source section to load your source file that you want to
encode. You may also drag and drop a file from a directory directly into this section.

Choose “MPEG2” as MPEG type and - depending on the format - choose NTSC or PAL. If your source
file contains any audio that should be encoded, use Program (Audio and Video) or Elementary Video to
encode Video only.

Then click on details to set up the advanced features of the encoder.

PLEASE NOTE:

FOR SYNCHRONIZED NETWORK PLAYBACK, ALL FILES MUST BE ENCODED AS ELEMENTARY
VIDEO ONLY!

Then click on details to set up the advanced features of the encoder.
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In the detailed settings you will need to set the field encoding to “Progressive Frame”.

The video resolution can be set in width and height.

In the Video Settings tab of the advanced menu make sure to set the frame rate aspect-ratio according
to the source file.
It is important to set the bit rate type to constant bit rate and choose a bit rate between 6000-8000 kbp/
s.
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Click on the “Advanced Video Settings” tab and make sure that both profile and level ID are set to main,
all other parameters should be set to default.

Now return to the main menu by clicking “OK”.

To launch the encoder, click in the main user interface on “Convert”
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HD - PAL/NTSC Encoding

Compared to SD, the HD encoding requires both the profile and level ID to be set to high.
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With these settings, resolutions above 768x576 can be accessed and configured.

It is recommended to start further reading in the Mainconcept Encoder manual for more in-depth details.

PLEASE NOTE:

FOR SYNCHRONIZED NETWORK PLAYBACK, ALL FILES MUST BE ENCODED AS ELEMENTARY
VIDEO ONLY!

For HD playback, you may choose a constant bit rate of 10000-20000 kbp/s.
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Before you leave the advanced mode, check the target resolution as well as field 

encoding and frame rate.

6.2.8.3  coolux Codec

coolux has developed a codec for use on PC and Mac. With this codec, content artists can directly
produce .mov files or image sequences for Pandoras Box without any further transcoding step. Keep in
mind that image sequence playback is mainly aimed for SSD based systems. Pandoras Box is able to
playback uncompressed image sequences. So if the sequence was rendered in an according lossless
file format, you can play it back without any quality loss as Pandoras Box never compresses files
internally!

In what programs can the codec be used?

Obviously, Pandoras Box software itself can play back videos rendered with the coolux codec. No further
steps are necessary, simply install Pandoras Box (Rev 10386 or newer) and the latest Quicktime Player.

The codec can be used for content creation, especially when there must not happen quality reducing and
time consuming format conversion. Load the codec into third-party rendering software solutions like
AfterFX.
It can be also used in (third-party) content converters like the Quicktime Player or the Quicktime
Converter from coolux.
In both workflows, the codec renders content by using the Quicktime API. This is, why the codec is also
called the "Pandoras Box Quicktime Component".

As soon as you have installed the coolux codec you can access it. Simply start or execute the
according encoding / transcoding command which then offers a drop-down list to choose a custom
format. The coolux codec is listed as "coolux". 

Where can the codec be downloaded?

If you have installed the latest Pandoras Box version, the codec is already available on your system.
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If you like to use the component without PB, download it from our web site's "Download Center" and
install it on your PC or Mac system. Note that Mac OS 10.7 or newer is the minimum required version
for the coolux QT components to work, older OS version will not be supported. On Mac and Windows PC
systems, the codec requires the latest Quicktime Player for rendering as well as playback.

In what formats does the codec render?

First of all, the component allows to create .dds, .png and .bmp image sequences  (RGB or RGBA,
i.e. with transparency). To save  disk space you can choose to directly compress the image files using
the .snp format. No matter what format you chose, the result from the rendering process is a folder with
separate single (image) files. The folder can be played back from Pandoras Box by choosing "Import as
Image Sequence" in the PB Assets tab . Snappy image sequences are decompressed on the fly.
To play the image sequence on another system than Pandoras Box, you need to choose a media player
that supports image sequences.

Secondly, the component allows to render a .mov file. By using our codec in the mov container, you have
the advantage of the same quality as an image sequence offers. That is because the container simply
contains the single (image / frames) files, there is no additional intra-frame compression. On the other
hand, you gain the advantage of a single file, that is a more convenient file handling and management.
The advantage of using a .mov file is, that everybody can play the content with a Quicktime Player.
To play the .mov file in Pandoras Box, simply drag it into your Project tab .
Please keep in mind that eventhough PB can playback these .mov files, .mov files containing other
codecs are not recommended playback formats!
All .movs require an installed Quicktime Player during playback.
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http://www.coolux.de/index.php?id=dowload-center#file/cat-55/cat-25
http://www.apple.com/de/quicktime/download/
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How to convert other .mov files? What is the coolux Converter?

As mentioned above, .mov files containing other codecs are not recommended playback formats for
Pandoras Box.
However, you can convert other .mov files using either a Quicktime PRO Player or the new coolux tool
called the Quicktime Converter.

The Quicktime PRO Player allows to access the coolux codec as soon as it is installed on the system.

The Converter allows to read, i.e. decode any .mov file as long as the codec used in its container is
installed on the system. Again, the latest Quicktime Player needs to be installed.
Afterwards it renders i.e. encode the file into an image sequence or single .mov using the new coolux
codec instead. You may find the Converter along with all other coolux tools (Warper; Matrix Patcher,...)
in the "Tools" menu in Pandoras Box.

The next chapter covers the use of the Quicktime Converter and the codec settings .

6.2.8.4  Quicktime Converter

This topic explains how to use the coolux Quicktime Converter using the coolux codec, and the codec
settings itself. Please refer to the previous chapter for general information about the coolux codec
also called the coolux Quicktime Component.
If you use the coolux codec in third-party software like AfterFX and the Quicktime Player PRO, please
refer to their documentation to learn how to start the encoding process itself. There should be
somewhere a choice what format you like to render in. The coolux codec is listed as "coolux". The first
of the below steps do not apply to you, the others do eventhough the dialogs probably look different.

As mentioned in the last topic, the Quicktime Converter allows to transcode other .mov files into a format
that is recommended for Pandoras Box. The coolux codec renders i.e. encodes image sequences (a
folder containing sequential images), or .mov files (containing sequential frames).
Keep in mind that image sequence playback is mainly aimed for SSD based systems.
To convert other .mov files, install the latest Quicktime Player and start the coolux Quicktime Converter.

How to start the coolux Quicktime Converter?

You may find the QuicktimeConverter along with all other coolux tools (Warper; Matrix Patcher,...) in the
"Tools" menu in Pandoras Box. Alternatively, you can open the Windows Start Menu or File Browser and
go to Programs > coolux > Pandoras Box Rev ... (> data) > Tools > Quicktime Converter
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How to choose a source file?

Single File:
The "Convert Single File" button opens a dialog where you can choose a .mov file as a source. As soon
as you have picked one, the "Export As" dialog opens automatically.

Batching:
With the button "Add Files to batch" you may choose several source files that will be added to the batch
list. Click the button again to (multi-)select additional files. Enter a output folder yourself or click the [...]
button. In this folder all new files will be exported with the same name as the source files. Click one of
the "Batch To..." buttons to convert all files.

Please note that a .mov file is a so called container format, which means that it can contain other
codecs. If the coolux Converter fails to read your source file(s), make sure that the source codec is
installed on your system.
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How to choose the export format?

Single File:
The "Export As" dialog opens automatically. Enter a name and choose the entry "Film -> QuickTime
Movie" in the "Export" drop-down list.
Click the "Options" button to the right, to set up the output format in more detail. If you use the Converter
for the first time, its strongly recommended to set up the format according to your needs. Every following
rendering will call the settings previously chosen as a new default. 

Batching:
This dialog is skipped when you clicked a "Batch To..." button.
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In the "Movie Settings" dialog, click "Settings".

Click "Filter" only if you like to add or adjust additional video filters. If you wish to resize your movie, click
"Size".
If your original .mov file contains audio information, you can choose to export a separate wave file. Click
"Settings" if you like to change the default settings regarding sample rate etc. For ASIO playback please
ensure that "PCM" is chosen.
Internet-Streaming is not needed.
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In the "Standard Video Compression Setting" dialog there is a drop-down list to select a codec. All the
standard as well as third-party video codecs installed on your system are available. Select "coolux".
Now, three sections "Motion", "Data Rate" and "Compression" offer adjustments influencing the quality
of your export. Define the "Frame Rate" of your exported movie only if you like to change the original
one. The "Data Rate" should be set to be optimized for Upload. The Compression settings are explained
in the next paragraph.
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How to export a .mov file based on the coolux codec?

Follow the above steps until you reach the section "Compression"
in the "Standard Video Compression Setting" dialog. To convert
your source .mov file into a .mov that uses the coolux codec
(recommended for Pandoras Box playback), follow these steps:

1) Choose the image format : .dds, .png, or .bmp
(in short: .dds compresses the most and allows the best playback
performance, .png compresses the file size but not the image
quality but generally needs more performance whilst .bmp is
uncompressed but demands most performance). Choose the
alpha version if your source file consists of transparent parts.

The image format mainly influences the quality of your content. The coolux codec simply renders single
frames and bundles them into a mov container. There is no additional intra-frame compression!

2) Decide whether the chosen image format should be compressed (in real-time) using the snappy
compression library . Snappy reduces the file size but keeps the available quality. The result is a
much smaller file size which is especially interesting for SSD systems as their drives normally offer less
space.

3) Uncheck the option "As Image Sequence".

Single File:
Click "OK" twice to return to the "Export As" dialog. The button "Save" starts the conversion. The result
is a .mov file with the name and path chosen in the "Export As" dialog.

Batching:
Click "OK" twice to return to the "PB Quicktime Converter" dialog that starts the conversion
automatically. The result are several .mov files with the original source name in the folder chosen in the
"Output Folder" text field in the "PB Quicktime Converter" dialog.

drop-down in "Standard Video
Compression Setting" dialog

-

"Choose Folder" button -

Single File) "Export As" dialog: C:\folder A\newname.mov

Result for single converted file C:\folder A\newname.mov

Batching) "PB Quicktime Converter" dialog: C:\folder A\

Result for batch list item #1 C:\folder A\sourcename1.mov

Result for batch list item #2 C:\folder A\sourcename2.mov

To play the exported .mov in Pandoras Box, simply drag the file into your Project tab .
To play it back without using Pandoras Box, use the Quicktime Player and install the coolux codec.
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How to export an image sequence - a folder with separate image files?

Follow the above steps until you reach the section "Compression"
in the "Standard Video Compression Setting" dialog. To convert
your source .mov file into an image sequence, that is a folder
containing separate, sequential images, follow these steps:

1) Choose the image format : .dds, .png, or .bmp
(in short: .dds compresses the most and allows the best playback
performance, .png compresses the file size but not the image
quality but generally needs more performance whilst .bmp is
uncompressed but demands most performance). Choose the
alpha version if your source file consists of transparent parts.

The image format mainly influences the quality of your content. The coolux codec simply renders single
frames and bundles them into a mov container. There is no additional intra-frame compression!

2) Decide whether the chosen image format should be compressed (in real-time) using the snappy
compression library . Snappy reduces the file size but keeps the available quality. The result is a
much smaller file size which is especially interesting for SSD systems as their drives normally offer less
space.

3) Check the option "As Image Sequence". Now, the images are not bundled into a mov container but
will be rendered as separate image files into a folder.

4) Choose a folder where the folder(s) should be saved that contains the separate images. It is a good 
workflow to choose the folder whereto the .mov file is exported as well. That was the step in the "Export
As" dialog or "Output Folder" text field in the first "PB Quicktime Converter" dialog. In both cases, the
image sequence folder will be named with the same name as the .mov.

Single File:
Click "OK" twice to return to the "Export As" dialog. The button "Save" starts the conversion. The result
is a image sequence folder with the name and path chosen in the "Export As" dialog.

Batching:
Click "OK" twice to return to the "PB Quicktime Converter" dialog that starts the conversion
automatically. The result are several image sequence folders with the original source names, all in the
folder chosen in the "Output Folder" text field in the "PB Quicktime Converter" dialog.
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drop-down in "Standard Video
Compression Setting" dialog

From Latest file

"Choose Folder" button choose where you saved the mov file (e.g. C:\folder A)

Single File) "Export As" dialog: C:\folder A\newname.mov

Result for single converted file

C:\folder A\newname.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\newname\newname_[00000001].png
C:\folder A\newname\newname_[00000002].png
etc.

Batching) "PB Quicktime Converter" dialog: C:\folder A\

Result for batch list item #1

C:\folder A\sourcename1.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\sourcename1\sourcename1_[00000001].png
C:\folder A\sourcename1\sourcename1_[00000002].png
etc.

Result for batch list item #2

C:\folder A\sourcename2.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\sourcename2\sourcename2_[00000001].png
C:\folder A\sourcename2\sourcename2_[00000002].png
etc.

drop-down in "Standard Video
Compression Setting" dialog

Unique Number

"Choose Folder" button choose where you saved the mov file (e.g. C:\folder A)

Single File) "Export As" dialog: C:\folder A\newname.mov

Result for single converted file

C:\folder A\newname.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\folder A_[001]\folder A_[001_00000001].png
C:\folder A\folder A_[001]\folder A_[001_00000002].png
etc.

Batching) "PB Quicktime Converter" dialog: C:\folder A\

Result for batch list item #1

C:\folder A\sourcename1.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\folder A_[001]\folder A_[001_00000001].png
C:\folder A\folder A_[001]\folder A_[001_00000002].png
etc.

Result for batch list item #2

C:\folder A\sourcename2.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\folder A_[002]\folder A_[002_00000001].png
C:\folder A\folder A_[002]\folder A_[002_00000002].png
etc.
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drop-down in "Standard Video
Compression Setting" dialog

None (All Files in Main)

"Choose Folder" button choose where you saved the mov file (e.g. C:\folder A)

Single File) "Export As" dialog: C:\folder A\newname.mov

Result for single converted file

C:\folder A\newname.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\folder A_[00000001].png
C:\folder A\folder A_[00000002].png
etc.

Batching) "PB Quicktime Converter" dialog: C:\folder A\

Result for batch list item #1

C:\folder A\sourcename1.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\folder A_[00000001].png
C:\folder A\folder A_[00000002].png
etc.

Result for batch list item #2

C:\folder A\sourcename2.mov
C:\folder A\...hst

(these files can be deleted)

C:\folder A\folder A_[00000001].png
C:\folder A\folder A_[00000002].png
etc.
Note that this overwrites the files from the first batch item!

To playback the image sequence in Pandoras Box, right-click on the folder in the Assets tab, and
choose "Import As Image Sequence".
To play it back without using Pandoras Box, use a media player that supports image sequences.
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6.3  User Interface - Master

This chapter explains the user interface of a Pandoras Box Master system. The Client's interface  is
covered in the next chapter. The chapter Master / Client Remote Setup  explains the general
difference between a PB Master and PB Client, how to connect them and how to include a Client device
in your Master project.

To ensure an easy learning curve throughout all Pandoras Box products, we have created a unique user
interface design. Importantly, the user interface of each Pandoras Box product looks identical.
This image includes links to different chapters, please click on the tab to read its respective description.
The tabs not included in the default view can be found in the topic "Tabs Overview ".

The user interface is designed for real-time playback and operation; therefore all important functions are
accessible directly through a tab and view oriented workflow. 
Pandoras Box supports a dynamic context-menu structure. A right-click on a particular item opens a
context sensitive menu and shows the corresponding commands.

Of course the entire user interface layout can be customized to meet your needs. The tabs size and
location can be adjusted either within the main frame or independently on the entire desktop area as a
so called breakout pane. You may store several views  and recall them with one click at any time
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during operation.

Tabs with customizable commands are available as well. Add your own buttons to the tab and assign a
desired command in order access it faster.

The Master User Interface section is divided into these themes:
Startup Dialog : explains the menus File, Edit, Tabs, Tools and Backup seen in the top
Menu Bar : explains the menus File, Edit, Tabs, Tools and Backup seen in the top
Layout : illustrates how to influence and rearrange the look of the user interface
Tabs Overview : gives an overview on each visible and hidden tab
Keyboard Shortcuts : includes all shortcuts existing in the Master version of Pandoras Box

6.3.1  Startup Dialog

128
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With version 5.5 a Startup Dialog was introduced. It gives you the possibility to start fast with the project
of your choice, you may load a new project, a recent project or one from the directory.

On the left side you may choose to open a new project. If necessary, change the default settings and
then click the button.

- Name: Enter a name for your project. It will appear in the Project tab  and will be the file name when
you later on save the project to a directory of your choice. Until you do so, the project is temporarily
saved under "C:\coolux\content\projects\temp_projects\temp".

- Mode: Decide to load a standard project or one that has optimized settings for being remote controlled
by a lighting console .

- Settings: Choose whether the default settings should be applied or whether a pop-up should show the 
Configuration tab  first to let you decide particular settings.

The button in the middle opens a dialog where you can choose the directory from where to load an
existing project.

The right side shows a list of recently saved or opened projects. Simply click on the "Load" button next
to a name.

Click the check box at the bottom if you do not like to display this dialog on the next startup. The same
option can be found in the Configuration tab > Startup .
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6.3.2  Menu Bar

The menu bar on top of your Pandoras Box Software contains the following application menus:

- File Menu
- Edit Menu
- Tabs Menu
- Tools Menu
- Backup
- Help (?)

6.3.2.1  File Menu

The file menu allows you to achieve all project related actions.

[New Project]
Click here to create a new project. Before leaving the current project you will be asked if you want to
store the current project. You will have to choose if you want to create a project in Standard Mode
(shortcut: CTRL-N) or in Lighting Console Mode .

[Open Project]
Click here (or use CTRL-O) to open an existing project.

[Open Recent Project]
Open a list with recently used projects.

[Save Project]
Click here (or use CTRL-S) to save the current project. 
Please note: There is no auto-save function!

[Save Project As]
Click here (or use CTRL-Shift-S) to save the current project under a different name and go on working in
the renamed project.

[Save Project Copy]
Click here (or use CTRL-Shift-Alt-S) to save a copy of the current project and go on working in the
current project. 

[Bundle Project]
Click here (or use CTRL-Shift-B) to bundle your project under a new name and location. All content used
in the timeline will be copied to the new location in a folder called "Assets" next to the show file. This
option allows you to only have one folder to archive your show on a external hard drive. To play your
show again, just copy this folder at its original location on your hard disk and all paths will be recovered.
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Since version 5.5 Pandoras Box supports a relative path whereto content can be saved. When saving a
project a folder named "assets" is generated just next to the show file. If you copy content files to that
folder and drag them from here into your Pandoras Box project the content links are relative. That means
that you can move the project folder ( including the *.xml and asset folder) to every path wanted without
the need of re-linking the content.
As bundling the project creates an assets folder as well, you can copy the bundled folder wherever you
like to. As all paths are relative paths, Pandoras Box is able to load all the content. It will not become
inconsistent any more.

[Close Project]
Click here (or use CTRL-W) to close the current project.

[Remove Unused Resources]
Click here to remove all content files from your project that are not used in the timeline.

[Exit]
Click here (or use CTRL-Q) to Exit Pandoras Box. You will be asked if you want to store your project if
there are not stored changes.

6.3.2.2  Edit Menu

The edit menu allows you to execute the following commands. Most commands influence the Sequence
tab  and the Device Tree tab  and can be found in the respective context menus as well.

[Undo]
Undoes a step of sequence editing as well as changes in project tab. Actions that are not stored to the
timeline like changing a value on fader cannot be undone.

[Redo]
Redoes a step of sequence editing as well as changes in project tab.

[Refresh Asset Tree]
If any changes have been made on the local hard disc system, you have to refresh the File Tree in the
Asset Tab to see these changes inside Pandoras Box. Please note that refreshing the whole tree will
close all subfolders and you have to open them again. See the Asset tab  to get information about
how to refresh single subfolders.

[All Active]
Sets all parameters to the active status.

[Clear All Active]
This command clears all active parameters.

[Reset All]
Resets all parameters to their default values and removes their active status.

[Store Active]
Stores all active parameters as containers to the sequence.
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[Store Active (Selected Devices]
In contrast to the above command, this one filters active values for those devices (layers) that are
selected. The values are stored at the current time at the blue nowpointer. All active values influencing
other layers will stay active.

[Store Active To Time]
A small dialog opens and asks for the time whereto all active values will be stored. The time can be
entered in the format H:MM:SS:FF or shortened to SS:FF or even SFF. So, for example 3 seconds can
be 0:00:03:00 or 03:00 or 300. Click Enter or the button [Ok] to close the dialog and save the active
values.

[Copy]
Saves an selected item, for example a key or a clip container from the sequence.

[Paste]
Pastes the copied selection to the device where it was copied from in the Sequence Tab.

[Paste to Selected Devices]
Pastes the copied selection (keys, clip containers) to other devices in the Sequence Tab. To do this,
select one or more devices holding down SHIFT or CTRL. Please see Sequence  for detailed selection
information.

[Cut]
Cuts out an selected item, for example a key or a clip container from the sequence.

[Trim Left]
This applies to a selected container, it erases everything between the nowpointer and the left clip
boarder. The last key of a parameter before the nowpointer will be moved to the new clip boarder time.
The video clip will now be shortened at the beginning.

[Trim Right]
This applies to a selected container, it erases everything between the nowpointer and the right clip
boarder. There will be a new key set at the right clip boarder containing the value a parameter had at the
nowpointer before.

[Trim To Clip Borders]
If a clip container was scaled down, there could be hidden keys beyond the clip borders. This command
removes these hidden keys and sets new keys at the left and right clip border to ensure the wanted
behavior in the visible part of the clip.

[Add Cue at Current Time]
Adds a cue at the current time, indicated by the blue nowpointer. Click onto the cue to select it and see
its properties in the Inspector tab .

6.3.2.3  Tabs Menu

The tabs menu allows you to open / reopen all tabs in the user interface. Each tab is explained in detail
in the topic "Tabs Overview"  and "User Interface ".
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Please note:
There is no option to open a preview tab, because you can not close this tab (running a PB preview
version). If you are running a non-preview manager version, you do not have a preview tab at all.

The Extension drop-out includes all extensions that are available like the Encoder Extension and
Compulite. The Encoder Extension is only available on certain Pandoras Box products, please see the
chapter “Product Overview ”.

6.3.2.4  Tools Menu

The Tools menu allows you starting the additional tools from within the Pandoras Box Master software: 

Warper ,
Matrix Patcher,
Dome Master,
Image Converter,
Splitter,
Art-Net Monitor
Leica 3D Disto
Quicktime Converter

6.3.2.5  Backup Menu

The backup menu allows you to run a second Master as backup device in the same domain as the
“show” Master device without causing any conflict. As long as this device is in Backup Mode, it won’t
give out any control data.

If it is necessary to change over to the backup device, this backup Master may take over all sites in the
domain in order to run the show.

To change a Master into backup mode, go to the Backup menu and choose “Change Mode to Backup”.
The status line at the bottom of the user interface displays “Backup” highlighted in orange instead of
“Live”. When you have to change over to Show Mode, choose “Take Over All Sites In Domain” from the
Backup Menu.
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Images: The status bar at the bottom of the user interface shows:
Top) Manager in Backup Mode, Bottom) Manager in Live Mode.

6.3.3  Status Bar

The Status Bar at the bottom of the Pandoras Box Master user interface includes four sections.



133

Information field Align function Backup Mode  Revision

Information Field

This field informs you about specific actions, like loading or saving the project file or spreading media
files. If there is a show critical or very important information this field is highlighted red and the
information stays. In that circumstance you can click onto the field to open a dialog containing a
description.

Align Function

If you multi-select Layers or Cameras, you can align their parameters following a certain pattern. Per
default the Align function is switched off. You can click onto the "Align" label to switch through the
available options: <, >, ><, <>, Off.

Example: Assign five different media files to Layer 1-5,then scale and position them like depicted in the
image.

To select all Layers, click on Layer 1 in the Device tree  and hold [SHIFT] whilst
clicking on Layer 5. The Align function depends on the order of selection, in our case
we have selected Layer 1 first, then 2,3,4 and 5. If you now open the Device Controls
tab  you will see the parameters of Layer 5, this  is visualized in the Device Tree
with a white dotted border. You can click on the other Layers to see their parameters
in the Device Control tab without loosing the selection. Re-load Layer 5 into the tab.
In case you made an error with the selection, press [ESC] to unselect and then
select the Layers again.

With this selection, click on the Align label in the Status Bar to switch to another Align pattern. Change
the Z Rotation Angle parameter of Layer 5 to 90°. The value range of 0°-90° is applied to the Layers in
different patterns but the change from one layer to another is always equal. See the result in the Preview.

The applied rotation values increase.
Smallest value = Layer 1.
Highest value = Layer 5.

The applied rotation values decrease.
Smallest value = Layer 5. 
Highest value = Layer 1.

The applied rotation values increase
from the middle but in opposite
directions. 
Smallest value = Layer 3. 
Highest value = Layer 1 and 5.

The applied rotation values decrease
from the middle. 
Smallest value = Layer 1 and 5. 
Highest value = Layer 3.
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The applied rotation values are
constant.

The Align function can be applied to almost
all parameters like position, rotation, scaling,
effects etc.

You can align Layer parameters but also
Camera parameters and others. For the left
image the Lens Shift "X Offset" parameter of
four Cameras was aligned.

Backup Mode

This field shows whether your Manager is in "Live" or "Backup" Mode. For more information please see
the chapter "Backup Menu" .

Revision

This field informs you about the revision you are using-
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6.3.4  Tabs Overview

In this chapter information about each tab in the user interface may be found.

See here the list of all available tabs in the PB Master Device. A picture with all tabs available in the
default view can be seen in the chapter "User Interface ". If you are not famliar with the names, it
might be of interest for you, that it includes integrated links to each tab, simly click on one tab.

Active Values
Aeon FX
Assets
Configuration
Controller Setup
Curve Editor
Device Control
Device Tree
Device Types
Device Viewer
Encoder Extension
FireFly Particles
Groups
Group View
Inspector
Media Encryption
Patch
Presets
Preset View
Preview
Project
Sequence
Sequence Control
Tabs
Taskmanager
Text Input Editor
Thumbnail Viewer
Video Export
Video Recording
View Tab
Virtual Site
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224
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308

310
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6.3.4.1  Active Values

Device parameter values are designed to have different states: 
Active and Inactive.

As you edit and change device parameter values from within the device tree or device control tab, all
manually changed values will be activated and highlighted in red.

The active value state of a parameter value indicates the changes you have made but not stored yet.
Therefore any store operation within Pandoras Box will be based on the active values only.

Active values are always displayed in red everywhere in the user interface until the values are either
stored to a preset or sequence, reset to default or simply deactivated. As long as there are active values
for a parameter, all values that have previously been stored in the timeline will be ignored until you store
or reset these active values.

The Active Values tab lists all currently active values. This gives you an overview of all changes you
made since the last store operation.
To see all active values of the selected devices only, check [Restrict to Selected] at the bottom of the
Active Values Tab.

By left-clicking on the values in the Active Values tab you may apply direct changes to any parameter
value.

This concept is particularly useful if you do not want to mess around with programmed timeline values
and change values only temporarily for creation and setup.

To reset a value right-click on the desired parameter and choose “Reset”. In the right click menu it is
also possible to activate parameters or to clear active parameters.
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Every reset command will deactivate the active values based on the reset target.

6.3.4.2  Aeon FX

The AEON FX tab allows choosing between varieties of different effects. 

Depending on your PB Device, different FX are available. Choose your PB Device from the Filter View
drop-down list (Player LT / Player STD / Player PRO / Dual Player / Quad Player or all kind of Servers).

Now all available FX can be found inside the FX folders, sorted by themes.
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The FX may be assigned to video and graphic layers and to the outputs. To do this, choose the effect
and drag and drop it onto the device, or select the device (it will be highlighted in blue) and execute a
double-click on the desired effect.

The FX list  shows all FX that are included in the FX theme collections as well as the availability of the
effects for the different PB products.

6.3.4.3  Assets

The Asset Browser tab has two main functions:

1. Import files from any available file system
2. Load available Client devices into the device tree of the current project.

FILE IMPORT

Files are imported from the asset tree by drag and drop into the project tab.
The best way to import files is to get these exclusively from the local hard disc system of the Master
system. This is especially useful, if you want to transfer show files to other systems later on for backup
scenarios or other purposes.
Even though you may import files from Client systems as well, it is important to know that each time you
import a file; the source location will be used as a reference for remote file management.

When a file is imported to the project tab, it will be shown as a link to the file system.

To view the properties of the imported file, click on the inspector and after that on the desired file. Then
you can see the file location on the systems. 
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All files will automatically be spread (copied) to all connected Clients by default. To change this
spreading mode into a manual mode, please see Configuration > Resources .

Since live input cards are treated as live video textures, please import your live input sources from the
asset browser as well. Each listed Client will list its live inputs that are available for import.

CLIENT IMPORT

Once the Master and Clients are started and set up, they can communicate via the same domain
channel.

To check if a Client can be connected with a Master system, the Client should be in the same IP
address range and on the same domain channel. Once this is set up, the Client will display the Masters
IP address in its main user interface window.

The Master system will then show all available Clients in the asset browser.

To import a Client from the asset browser, simply drag and drop the unit from the asset list into the
device tree of the Master GUI.
The device IP information and properties will be stored from now on with the current project.

A right click on a Client lets you refresh the whole Client Tree. You can toggle the Client into or out of
the fullscreen. If the connection between Master and Client was disconnected, choose [Reset
Connection] to recover this Client device.

Please note: 
If any changes have been made on the local hard disc system, you have to refresh the folder containing
these changes. Do this either by 
- selecting the changed folder and pressing [F5], 
- by doing a right click on your local folder and choose 'Refresh Tree' or 
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- by doing a right-click on the drive containing the changes and choosing 'Refresh Drive' or
- by doing a right-click on a folder and choose 'Refresh Folder'.

Please note that refreshing the whole tree, a drive or a folder will close all subfolders and you have to
open them again.

6.3.4.4  Configuration

The Configuration tab is divided in several sections, each described in detail on
the following pages:
- Devices / Parameters
- Resources
- Sequence
- Network
- Remote Control Protocols : e.g. DMX, Art-Net, Midi...
- Startup
- Unit Management
- Preview Display
- Local Preview
- Render Engine
- ASIO Audio
- Extensions
- SMPTE Time Code
- Web Server
- Cache

6.3.4.4.1  Devices / Parameters

The section "Devices / Parameters" in the Configuration tab  enables you to set up the general
appearance and behavior of devices and parameters in your project.

Site Initial Values

- Number of Shown Layers in New Sites
- Show Pointer Layer
Enter the amount of layers  that should appear when a
new site is added to the Devices tab. Choose whether it
shows the Pointer Layer or not.

All other layers are hidden to ensure a good overview. To unhide or add additional layers to an existing
site, right-click on the site. (see "Site context menu" .)
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Layer Initial Values

- Layer Sizing Mode
Choose the Layer Sizing Mode  that should be applied
for newly added layers, e.g. whether they should be
stretched fullscreen or keep their original resolution.

Click "Apply now" if already existing layers should adopt that mode.

Params

- Default Opacity and Audio Volume is full
When checked, the default value for Opacity is 255 and for
Volume it is 0dB, i.e. both are at 100%. This means that
as soon as a media file is assigned to a layer, it will be
visible or hear-able. When a container is created, and no
key for Opacity / Volume is generated, the default value
takes place.
In Versions before 5.5 the default value has been 0. If you
like to return to that behavior you may uncheck this option.

Please note that this option results in a different show appearance when switched during or after show
programming, thus it is recommended to test the show or check this option only once before starting to
program.

- Parameter Value Readout
-- Percentage
Use the check box to enable percentage readout for all values of all parameters in the project, see figure
b) and c). This setting can be changed at any time during runtime. 

-- Pixel (where applicable)
This option is available, if the Unit Translation Mode  is changed to "Use Fixed Relationship".
Some parameters (like Position and most Camera parameters) are then based on pixel values. This
makes it possible to enter an exact pixel number, e.g. move right by 50 pixels.
By default, the positive X-axis points to the right direction and the Y-axis to the top. If you like to have
the Y-axis pointing down, check the option "Invert Y-Axis".

-- Centered (where applicable): Some of the parameter values appear in centered position by default
(default value is here set to 0), irrespective if the readout is decimal or percentage, e.g. the following
parameters: X/Y/Z Rotation Speed of a Layer, Keystone faders of an Output. If you disable this function,
0 will be the minimum and the 8 bit /16 bit decimal value (depending on the properties of each parameter)
will be the maximum value. With percentage value readout the value range goes from 0 to 100%. Please
note that the value parameter or the layer appearance is not changed, it is just a way of displaying the
value.
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   a    b    c    d

 Percentage
 Centered

 Percentage
 Centered

 Percentage
 Centered

 Percentage
 Centered

- Initial Values (for Parameter)
Check the option "Link Scale Params" if all newly added layers should have a locked aspect ratio. If you
now change the X Scale, the Y and Z scale follow.
For existing layers, you can link parameters by using the chain icon underneath the parameter fields,
see Device Control tab  and Linking Parameters .

6.3.4.4.2  Resources

The section "Resources" in the Configuration tab  enables you to set up the general settings for
resources to improve your workflow. In addition you can influence the (initial) properties of specific
resources like videos, image sequences and others.

General

- Set maximum DMX File / Folder ID to 255
When checked, the File ID and Folder ID  can
reach a maximum of 255. The next item would start
with 1 (instead of 256) and a consecutive Folder ID.
This option is especially useful when working with a
lighting desk and / or exchanging thumbnails via CITP

.

- Auto Spread Resources after adding to Project
All media files added to the project will automatically be spread to all available Clients (by default). To
determine the time of spreading manually, uncheck this option.

- Monitor changes to files on disk
This applies when a file that is part of your Pandoras Box project is saved by another program under the
same name, i.e has changed. In versions before 5.5 it was necessary to reload the file manually or to
reload the entire PB project to load the new state of the file. Now, you can decide to monitor the hard
disk and reload a file automatically as soon as it has changed. If you like to spread it too, please
activate the next check box as well " Auto Spread Resources after change to file".
Please note that this only applies to the system from where the file was originally added to the project. If
you spread a file and change it on the remote node, you will not see the updated file as the remote disk
is not the source disk and was not monitored.
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- Auto-Spread Resources after change to file
If a file change is monitored (see check box "Monitor changes to files on disk") it will be spread to
available nodes too.

- Show Folders in Thumbnail Browser
If you click on a folder in the Project tab or Assets tab, its contained files are displayed as individual
thumbnails in the Thumbnail tab. If the folder includes sub folders, they are depicted with a folder icon. If
you do not like that and only wish to see the files itself, untick the check box.

Initial Values (for Resources)

These options apply to newly added images, videos,
playlists, etc. For more information about the settings
see the File Inspector .

Video Initial Values

These options apply to newly added videos. For more
information about the settings see the File Inspector

.

Image Sequence Initial Values

These options apply to newly added image
sequences. For more information about the settings
see the Image Sequence Inspector .

Text Input

Choose whether you like to be warned with a
message box when a Text Input is changed from
"Static" or "Scrolling" to "Streaming".

All other options apply only to newly added text
assets.
For more information about the text settings see the 
Text Inspector Editor .
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Playlist Initial Values

These options apply to newly added playlists .

 For more information about the settings see the 
Playlist Inspector .

Browser Initial Values

- Default Browser URL:
Enter a URL that you wish to assign to a Browser
asset as soon as it is created in the Project tab, e.g. 
http://www.coolux.de

- FPS
Enter the frame rate a newly created Browser asset should be rendered with.

Mesh Import Initial Values

The following options are offered in an additional
dialog as soon as you import an object. The dialog
opens with the values set up in the Configuration tab.
- Apply object transformation to vertices
This is of interest if your object was saved with sub
meshes or levels and one sub mesh exists multiple
times. In case you de-activate "Apply object
transformation to vertices" it can happen these copied

sub meshes are imported with a different position, i.e. their own 0,0,0 origin (pivot point) has moved to
the coordinate system's origin, the global 0,0,0. point.

- Import separated sub meshes
This is of interest if your object was saved with sub meshes or levels.
None: The imported object consists of only one mesh. All sub meshes are merged into it.
All: The original hierarchy is not changed. All sub meshes will be available as separate meshes. In the
Project tab, double-click onto the main object and a tree structure will open with all available sub folders
and sub meshes. Please note, that it is possible to use either a single sub mesh or an entire folder entry
above it; the folder merges all consisting sub meshes when assigned to a Layer.
Specifies Levels: The original hierarchy can be flattened. Enter how many levels you like to use. If the
original file was saved with more “deeper” levels, they will be merged.

-Units of measurement
-- Import scale factor
Enter a scale factor for newly added meshes. For example: 0.5=half size; 2.0=double size
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--Override system unit
If the "Scale factor" does not return the expected result, you may enable the option to override the
system units the file was saved with. If you see this scaling issue with 3ds files, in most cases it helps
to set "Inch".

6.3.4.4.3  Sequence

The section "Sequence" in the Configuration tab  enables you to set up (initial) properties of timeline
specific elements like the sequence itself, container, cues and others.

Sequence Initial Values

- Framerate
- Length
- Auto Scroll
- Enforce Defaults
Enter the properties that should be applied as
soon as a new sequence is added to the project.
For more information about these and other
sequence settings see the Sequence Inspector

.

Clip

- Overlapped Clips Resolution Mode
When a container is being copied (or dragged) to
a time where another container already exists
there is a conflict. With the options from the drop-
down menu you can decide how this conflict
should be resolved.

- Show warning with option to cancel: A pop-up warns about the container overlap. You can choose to
cut the existing container or to cancel the action.
- Cancel operation: The action that would lead to the overlap will simply not be executed. This is the
same result as choosing "Cancel" in the above mentioned pop-up.
- The existing container will be cut at the beginning and/ or end of the pasted container. This is the same
result as choosing "Ok" in the above mentioned pop-up.

- Trim / Split adds Keys at Clip border
When you trim a container or split it, per default a new key is added at the new container end. Image,
that you have a container with a value fade from 0 to 255. If you split the container in the middle, a key
with value 125 is added to new clip borders. Uncheck this option if these keys should not be generated
automatically.

- Warn when clip drag would lead to a change of layer type
Since version 5.5 containers can be dragged  from one layer to another. When a container is dragged
to a different layer type (that does not share the same parameters as the original layer) its borders turn
red and a dialog pops up that warns you about the parameter key loss and needs to be confirmed. If you
like to deactivate this additional dialog, untick this check box.
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Clip Initial Values

- Clip Duration for duration-less Resources
Images, meshes and other resources do not have
a duration like videos. However, if you drag them
onto a device in the timeline, they create a
container that needs to have a duration. Per
default, this container is 10 seconds long. If you
like to change this for all new containers, enter a
new time. For 5 seconds you can enter "5:00" or

simply "500".

- Lock to Time
- Pre Roll
Enter the properties that should be applied as soon as a new clip / container is added to the timeline.
For more information about these and other clip settings see the Clip Inspector . 

Cue

- Auto-Increase Cue Number
When checked, the Cue Number will
automatically increase when the next cue is
created. When unchecked, all cues will be
created with ID 0 and can be edited later on.

- Show Cue ID
Per default the ID from a cue is shown in front of
its name. If you like to see the name only, untick
this check box.

- Initial Values
-- Mode
Choose whether a newly created key should be a Play-key or another mode.

-- Wait Time
If you generate a Wait-key it has a default Wait time of 2 seconds. If you like to change this for all new
Wait-keys, enter a new time. For 5 seconds you can enter "5:00" or simply "500".

Key Initial Values

- Generate Opacity Keys (in new Clips)
This takes place when a container is created:
- when saving active values
- dragging media files from the Project tab
directly in the Sequence
- right-clicking in a parameter track to create a
key

Choose with the drop-down menus whether you
want to have automatically created Opacity and /
or Volume keys in new containers. You can
choose to have
- a single key for a constant value
- two keys for a fade in (the maximum value for
the fade is either 100% or the active value
- two keys for a fade out
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- four keys for a fade in and out
- no key at all

The Fade Time can be entered in the format
H:MM:SS:FF or SFF, e.g. "100" equals 1 second

6.3.4.4.4  Network

The section "Network" in the Configuration tab
 enables you to set up connection

properties applying to the Master-Client-
connection. In addition Multi-User settings are
available. Note that it belongs to the Local
category  which means that the following
settings apply only locally on your system.

General Connection Settings

- Domain
Per default, the Domain channel number is 0. If
you have problems connecting to another PB
system, make sure that the Domain is set to
the same channel on all Masters and Clients in
the network. If the Master is on a different
Domain than the Client, they cannot connect! It

is recommended to only change the Domain if necessary, e.g. if there are two Masters in the same
network that should only connect to a certain group of Clients.
Valid channel numbers are from 0-65535.

- Preferred Network Adapter (In Next Session)
The drop-down menu contains all network cards installed on the system. Select one and restart the
application. Now the entire Pandoras Box communication of Master and Clients will be transferred by
this defined adapter and its IP address. This applies for example to show data generated by the video /
graphic containers and their keys in the timeline. With choosing a different network adapter for other
protocols like Art-Net, you can separate different communication levels from each other.
These protocols can be assigned separately: Pandoras Box show data, DMX / Art-Net Mode , CITP
Thumbnail Exchange  and Streaming ACN .
Here, "Art-Net" refers to the data generated when a layer has been patched or if DMX devices are
included in the timeline. It does not refer to possible Art-Net data generated by using matrix patches on
an output layer  (when working with LED walls and the Matrix Patcher ).
If an explicitly named network adapter is not found, the "any" adapter will be used. "Any" is to be
decided by the operating system Windows and its internal adapter order.

Multi-User Connection

- Show Multi-User Tab
This will open the Multi-User tab which is not activated per default.
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6.3.4.4.5  Remote Control Protocols

The section "Remote Control Protocols" in the Configuration tab  enables you to set up connections
between your Pandoras Box Master system and other devices. You may receive and send Art-Net and
DMX, exchange thumbnails via CITP or run MANet, Midi Show Control and Streaming ACN.

Art-Net and DMX

Art-Net:
- Press “Activate Input” to toggle Art-Net receive mode
for remote control of devices or sequences according to
the settings in the Patch tab .
- Press “Activate Output” to toggle Art-Net output mode

 for sending data from DMX devices added to the
sequence.

Since version 5.3 the IP address does not necessarily need to be in the 2.x.x.x range to be able to
receive Art-Net. Sending Art-Net is still tied to this specification. If you are working witch matrix patches

, you may address a different IP range there, but currently this is not possible for DMX fixtures.

DMX via USB:
- Press “Activate Input” if you want to toggle DMX receive mode  via a local DMX Link In USB interface

. This is for remote control of devices or sequences, see also the Patch tab .
- Press “Activate Output” if you want to toggle DMX send mode  via a local DMX LinkOut USB
interface. This is for sending data from DMX devices added to the sequence.

Please note: While Art-Net supports multiple DMX universes simultaneously, a DMX Link USB interface
offers only 512 DMX channels that are send on Subnet/Universe 0/0.

- Preferred Network Adapter (In Next Session):
The drop-down menu contains all network cards installed on the system. Select one and restart the
application. Now the entire Pandoras Box communication regarding the DMX / Art-Net protocol will be
transferred by this defined adapter and its IP address. This applies to the DMX / Art-Net data generated
when a layer has been patched or if DMX devices are included in the timeline. It does not refer to
possible Art-Net data generated by using matrix patches on an output layer  (when working with LED
walls and the Matrix Patcher ).

With choosing a different network adapter for other protocols like for the Pandoras Box show data, you
can separate different communication levels from each other.
These protocols can be assigned separately: Pandoras Box show data , DMX / Art-Net Mode, CITP
Thumbnail Exchange  and Streaming ACN .
If an explicitly named network adapter is not found, the "any" adapter will be used. "Any" is to be
decided by the operating system Windows and its internal adapter order.

CITP based Thumbnail Exchange

If you want to exchange Thumbnails with a Chamsys
MagicQ console or with the Widget Designer:
- Enter a TCP Port
- Press "Exchange Thumbnails"

Please note: The ChamSys console / Widget Designer
have to use the same TCP Port to get a connection.

Pressing "Exchange Thumbnails" again will stop the CITP connection.

- Preferred Network Adapter (In Next Session):
The drop-down menu contains all network cards installed on the system. Select one and restart the
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application. Now the entire Pandoras Box communication regarding the CITP based thumbnail exchange
will be transferred by this defined adapter and its IP address. With choosing a different network adapter
for other protocols like for the Pandoras Box show data, you can separate different communication levels
from each other.
These protocols can be assigned separately: Pandoras Box show data , DMX / Art-Net Mode ,
CITP Thumbnail Exchange and Streaming ACN .
If an explicitly named network adapter is not found, the "any" adapter will be used. "Any" is to be
decided by the operating system Windows and its internal adapter order.

GrandMA

To interface with GrandMA lighting consoles, please
enable the MA-Net:
- Choose the GrandMA Series from the combo boxes.
- Enter the MA-Net Session ID.
- Press "Run MA-Net".

Please note:
MA-Net Series 1 supports up to 64 DMX Universes, MA-Net Series 2 supports up to 256 DMX Universes.
They can be patched in the Patch tab . For more info please read the topic about DMX Input .

Midi Show Control

To control a Sequence via Midi Show Control Protocol:

- Midi Device:
Choose an installed Midi Device from the drop down list

- ID:
Enter the ID of MSC Message Mapping ( = Device ID -
you find it in front of the Servers/Players name in the
device tree)

- Sequence:
Enter the ID of the Sequence to be controlled via MSC

- Run Midi:
Press Run Midi to launch MSC and MIDI Input

- "Use Cue Subsection": 
As decimal places for cue numbers are not supported in Pandoras Box, you can use the check box
option "Use Cue Subsection". Doing this will multiply the incoming cue command x1000 (for example:
GO to Cue 1.020 will be interpreted as GO to Cue 1020). With this option three decimal places are
supported.

- Cue ID 0 Handling:
Choose between Regular Cue, Ignore, Stop and Stop & Reset all for Cue ID 0 Handling.

The following message types are supported:
Midi: Channel Voice Messages (all Note-On messages are processed)
MSC: System Exclusive messages (SysEx) according to the MSC specification

Please see the following links for detailed information: Midi  / Midi Show Control .
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Streaming ACN

 If you want to control Pandoras Box Master via
Streaming ACN (sACN), please prepare the patch  as
usual. For more info please read the topic about DMX
Input .
To run sACN press [Run sACN].
Please note that Streaming CAN does not use Universe
0, so do not patch below Universe 1.

- Preferred Network Adapter (In Next Session):
The drop-down menu contains all network cards installed
on the system. Select one and restart the application.
Now the entire Pandoras Box communication regarding

Streaming ACN will be transferred by this defined adapter and its IP address. With choosing a different
network adapter for other protocols like for the Pandoras Box show data, you can separate different
communication levels from each other.
These protocols can be assigned separately: Pandoras Box show data , DMX / Art-Net Mode ,
CITP Thumbnail Exchange  and Streaming ACN.
If an explicitly named network adapter is not found, the "any" adapter will be used. "Any" is to be
decided by the operating system Windows and its internal adapter order.

6.3.4.4.6  Startup

The section "Startup" in the Configuration tab  enables you to set up the look and properties when a
project is loaded.

- Open Project on Startup:
Here you can set up the system to load the lastly opened
project or a specific project file:
- Press “Browse” to choose a specific project file
- Press “Clear” to reset the load option
- Tick the check box to always open the lastly opened
project file

- Show Startup Dialog
This de-/activates the startup dialog  that pops up as
soon as Pandoras Box is loaded. There you can choose a

project to be loaded instead of using the File menu .

- Use Dark Skin
If the check box is activated, the user interface is rendered in the so called Dark Skin. If the check box is
not ticked, the interface looks light gray. This option takes effect in the next session.

- Pane Separator Color
You may choose between a darker and a lighter color for the space between two panes. This option
takes effect in the next session.

6.3.4.4.7  Unit Management

The section "Unit Management" in the Configuration tab  enables you to set up what units Pandoras
Box 3D space is based on. If you are interested in a pixel-oriented workflow, please note, that an
according check-box is offered in the Startup Dialog, when you create a new project.
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Pandoras Box allows you to work in a 3D space based on
so called 3D units or generic units (GU).
The result you see on your display is a rendering of the
3D space done in two steps, so called render passes.
First a 3D compositing and then a 3D output space is
created. The chapter "Video Processing Pipeline"
describes the Composition and Output Pass in more
detail.
The final render output is based on pixel units. Depending
on the resolution set up in the Display driver , the pixel
width and height changes.

Now, there are different options how to translate a 3D unit to a pixel. When choosing the option "Map 16
3D Units to each Resolution", Pandoras Box sizes the 3D spaces so that 16 3D units exactly match the
pixel width of each render pass. This is achieved by applying specific parameters to the camera; the
XYZ-position equals 0,0,-25 and the opening angle, the field of view, is 35.489°.
To give you an example, no matter whether your display / render pass resolution is 1024px or 1920px,
moving a layer with 8 units has the same result in both displays. If the layer's center was in the middle of
the screen, it will now be at the monitor's edge.
In other words, different render passes may map same 3D unit distances to different pixel distances. In
the example, 16 units were mapped to the 1024px as well as the 1920px output, hence 8 units is half
the width of both monitors.
16units / 1024px = 0.15625 units / px = 15.625 units / 1000 px
16units / 1920px = 0.83333 units / px = 8.333 units / 1000 px

When positioning and sizing elements based on pixel values it can be helpful to ensure that the entire
system globally uses only one fixed relationship for translating between 3D units and pixels. This is for
example of interest when displays with different resolution form one "pixel space", one large screen. Or,
when you like to work with pixel values in general e.g. to be able to shift the layer exactly 512px.
This form of unit translation can be enabled by selecting 'Use Fixed Relationship' below. In this mode, a
distance in pixels always results in the same distance in 3D units independent of render pass
resolution. 
If you choose to use a fixed relationship, enter how many 3D units should be mapped on 1000 pixel. Per
default the Output Pass uses the same translation factor and should be changed only if needed. If your
Clients are already connected to the Master system, you may click the "Init with Resolution" button.
This opens a dialog that lists all output resolutions from the Clients. Choose one resolution and
Pandoras calculates the translation factor automatically. As a result, the cameras of each site will adopt
to new default values. Whilst the Z-position stays at -25units, the FOV (field of view) changes to a value
according to your translation factor. To ensure consistent translation of units, leaving the cameras in the
default state is strongly recommended!

"Origin Settings" are further options that become available when working with a fixed relationship. Layers
and other devices (Camera, Output) can be positioned differently in regards to the origin of the coordinate
system.

In the left image you see that the layer's and the camera's center
match the origin of the coordinate system XYZ=0,0,0.

This is the default when the "Unit Translation Mode" is set to
"Map 16 3D Units to each Resolution".
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In this example the "Compositing space" is left in the center
(check box not ticked) but the "Default Layer Mesh" is activated
so that the 0,0,0 origin is in the layer's upper left corner.

At last, in this example the upper left corner of the "Compositing
Space" and the "Default Layer Mesh" match the 0,0,0 origin.

This is the default when the "Unit Translation Mode" is changed to
"Use Fixed Relationship". Note that the default values for the
camera's XY-position have changed.
If you now like to invert the Y-axis to point downwards, go to 
Configuration > Devices / Parameters  and tick the according
check-box "Invert Y-Axis".

At last, these three buttons ensure that your workflow is
based on correct settings.
"Set All Layer Sizing Modes To 'Media Pixel Size' "
changes the Sizing Mode from a Layer. Please see
further information in the Layer Inspector .

"Reset All Cameras" resets all (active) parameters from the Camera Layer. As explained above, the
translation modes set different default parameters for the cameras. In case you have already changed
some parameters, please click this button (and adopt your programming).
"Reset All Layer Z-positions" resets all (active) Z-position parameters from all Video and Graphic Layers.
If you work with "Fixed Relationship" and  the pixel-oriented workflow the pixel accuracy is only achieved
when leaving the layers on Z-position 0.

All these options are already prepared for you in case you open a new project and click the check-box
"Pixel-Oriented Workflow" in the Startup Dialog.

6.3.4.4.8  Preview Display

The section "Preview Display" in the Configuration tab  allows to influence how the grid and untextured
objects are rendered in the Preview tab  as well as the output of a Client. You can also access the
settings through the right-click menu of the Preview tab.

Ground Grid

- Display in...
With these check boxes you may choose were you like to see
the Ground Grid.

- Width / Height
With the number fields you can influence the size of the Ground
Grid.
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Mesh Shading and Color

Please note that the Inspector for an object  allows to
overwrite the below settings with individual ones.
The left bottom example shows an untextured object with gray
material color and blue wireframe edges.

-Shade untextured object
With an activated option, even objects without an assigned
texture are visible as they can be shaded according to the
below settings e.g. colored and with visible wireframes.

- Wireframes
Choose whether an untextured object should be rendered
without Wireframes, with Wireframe Edges or Wireframe
Triangles.

- Width
Define the thickness of above mentioned Wireframes.

- Mesh Colors
Adjust the color of untextured objects.
--Define Colors
Click on the color fields to define a color that is used for the Fill
Color and Wireframes. Use the number fields to adjust the
transparency.
--Use in file defined color
If the object was originally saved with an assigned fill and
wireframe color, Pandoras Box can use them also. Use the
number field to adjust the wireframe's brightness.

- Material
Adjust the Ambient, Diffuse, Specular reflection levels and the
shininess that influence how an untextured object reflects the
global light, e.g. to appear rather glossy than dull. Further
information...

- Global Point Light
You may adjust the X-, Y- and Z-position of a global light that is
reflected from untextured objects according to the "Material"
settings.
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6.3.4.4.9  Local Preview

The section "Local Preview " in the Configuration tab  enables you to set up properties of the local
Preview .

- Use Thumbnails for Preview
Using this option will show thumbnails instead a full
preview of the file. This saves graphic card power on
the Master system.

- Global Camera Aspect Ratio
The Aspect Ratio of the Global Camera can be set to
one of the options in the pull down list: Current Screen
Ratio, 5:4, 4:3, 3:2, 16:10, 5:3, 16:9 or 17:9.
This setting refers only to the global cameras
wireframe in the preview. If you like to change the
aspect ratio from your output, please refer to the 
Camera Inspector  or Output Inspector ; or
change the resolution in your graphics card driver .

- Don't Scale Camera Resolution in Preview
This is of interest when working with Matrix Patches

 on a Player or Server as Master. In case you are not rendering fullscreen but in the Preview tab, the
Art-Net data would be based on a scaled image. If you need to see correct Art-Net pixels even if the
preview is toggled into the user interface, tick the check box. The checked option saves graphics card
memory on the Master system. This is especially helpful when previewing many Clients e.g. working
with a Venue Site.

- Preview Anti-Aliasing
The Anti-Alias level for the preview can be set to the value 0, 2 or 4, 4 being the maximum. For memory
and performance enhancement the default value is set to 2. 

- Camera manipulation by mouse input for Cameras and Outputs
When the preview displays the "Global" camera, you can use the mouse to navigate it. Using the middle
mouse button (wheel): Scroll = Zoom, Drag = Pan, ALT+Drag = Rotate
If the preview displays a camera from a Site, and the according manipulation check box is ticked, the
navigation works as well and results in active values in the Camera Layer, i.e. Target and Viewport
parameters.
Same applies for the output. Per default the navigation is activated for the camera but not the output.

6.3.4.4.10  Render Engine

The section "Render Engine " in the Configuration tab  enables you to set up properties of the local
and remote render outputs.

The following settings are site sensitive, please select the
according Pandoras Box system with the "Site" drop-down menu.
If the node is found in the network the below information will say
"Manifest on Node with IP:..." otherwise it says "Node not available
in Network".

These settings are also accessible with the button "Open Engine Configuration"in the Inspector for the
site .

Output hardware configuration

Depending on the settings in the graphics card , different configurations are possible.
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If the driver reports to be in Dual or Extended View, all outputs can be configured individually regarding
the ability to go into full screen. This is depicted in the left image. In case one screen should not toggle
full screen, check the "Full Screen is single" option and the grayed out check boxes in the column "Use
for Full Screen" become available to be activated or deactivated. This is of interest when you like to see
the user interface of your Master eventhough you are in full screen mode.
In addition, you can route the physical output adapter (meaning the graphics card output) to an Output
Layer. "DISPLAY1" means the primary display, "DISPLAY2" the secondary. This setting is also
available in the Output Inspector .

If the driver reports to be in Stretched Desktop (Horizontal Span or Vertical Span) you have two
possibilities. First, you can leave the default option, meaning that Pandoras Box subdivides the available
output. In case you have two displays devices, the value for "Used Subdivision" is "2" whilst the first one
starts at XY-position 0,0 and the second one with an offset of one subdivision width or height. As a next
step you can change the routing of physical output adapter (meaning the graphics card output) to an
Output Layer. This setting is also available in the Output Inspector .
If you have chosen a setup with a Vertical Span, make sure that the "Subdivide vertically" option is
ticked. 

The second possibility for both stretched modes is to change the subdivision count to "1". In that case,
Pandoras Box handles the entire output as one software adapter. This means that you have one Camera
and one Output covering the reported width / height. But as the driver splits the image, you still have an
image on all graphic card outputs.
This can be an advantage as you work with less parameters and options. The second Camera and
Output have no effect and can be hidden  or removed from the timeline. On the other hand this also
means that you loose the flexibility of having more parameters. If you like set up one display differently
e.g. less opacity, softedge on another side, etc. you need both Output Layers, hence 2 or more
subdivisions.

Please note that you cannot take one subdivision out of full screen!

If the Client is not available in the network, e.g.
because
- it is not turned on
- it is assigned with no or a wrong IP address
- the PB Client software is not started
- the PB Client software is with a wrong Revision

no hardware configuration can be read from the
driver or the operating system. If you like to preprogram your show, you can enter the resolution you will
later setup in the Client's graphics card and the Camera and Output will adopt to it. This also influences
some "Layer Sizing Modes" . If this resolution change in the real setup, Pandoras Box warns you by
displaying a red exclamation mark icon in this Configuration tab. Click on it to see a pop-up showing the
user-defined resolution. Check whether this effects your programming and adjust it if needed.

 The "Remap" button routes the physical output
adapter (meaning the graphics card outputs) in the same order as found displays or subdivision are
listed. This is of interest if you have changed the routing and want to go back to the default setting.
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Rendering Performance Settings

Again, these settings depend on the Site chosen in the drop-down list at the top.

- Full Screen Anti-Aliasing
This refers to a anti-aliasing method used for smoothing object edges in
the last rendering pass. Per default this is the Output Pass, thus the
anti-aliasing works on the output mesh. In case you have set the
Output's parameter "State" to Bypass , the anti-aliasing applies to
the Compositing Pass meaning objects on layers. The higher the anti-
aliasing value, the more memory and performance is drawn but the
smoother object edges are rendered (as seen in the below example).
The maximum anti-aliasing level depends on the graphics card. For
performance enhancement the default value is set to 2.

100% zoom

500% zoom

Level 0 Level 4 Level 8

 - Full Screen Alternate Rendering
Check Alternate Rendering to get a better performance for laptops or older PCs. This setting can
influence the fluent playback of videos.
Please note, the settings for Antialias and Alternate Rendering only take effect in full screen mode. In
preview mode Antialias will be set to 0 and Alternate Rendering is off.

- Increase Video Buffer Count
When using FluidFrame  with high-framerate content (50p, 60p files or live inputs), please check the
option “High Performance Mode” to ensure smooth playback. In all other cases the High Performance
Mode should NOT be used because it requires more system and GPU RAM.

- Enable Alpha Backbuffer:
Tick this check box if you like to clear the background from the backbuffer texture with alpha. The
backbuffer is the result from the output pass. More information regarding Pandoras Box' render passes
can be found in the topic "Video Processing Pipeline ".The background RGB(A) color can be set up in
the Output Layer  (Server only!)

- Load videos in single thread
This is of interest when you have programmed multiple containers with video content all starting at the
same time. Under circumstances (number of containers, resolution of videos, etc.) this can lead to
different render issues as all videos start to be decoded at the same time. With the enabled option the
videos start with a millisecond offset enhancing the robustness of the render engine. A drawback is that
delay is added. If you need to sync many videos, disable the option and make sure that your
programming does not affect the robustness of the render engine.

- Max. Internal Texture Size
During the rendering process content is buffered onto a so called internal texture. The internal texture is
only called when the content is used with
- deinterlacing
- FluidFrame (= frameblending)
- particular effect combination, e.g with Blur

Depending on the resolution of the content you are using with those optional features, you might need to
select another entry from the drop-down list. Please note that EVERY content file is then buffered with
this size. As this consumes plenty of graphic card memory it is recommended to choose the entry next
in size and not simply the largest available.
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The drop-down list replaces the 2k or "4K Texture Support" check box known from version below 5.5.

6.3.4.4.11  ASIO Audio

The ASIO Audio section in the Configuration Tab  allows
setting up connected a ASIO sound card for Pandoras Box.
ASIO sound cards are used by dedicated Audio tracks
in PB Manager software or (since version 5.1) in PB
Player / Server running as Client or Master. Audio tracks
allow playing back ASIO wav files while being synchronized
to a master clock.

Video to audio synchronization

Choose with the "Site" drop-down menu a Pandoras Box
system, and assign an available ASIO device with the
"Device" drop-down. Decide by ticking the check box "Use
Audio Clock as Master" whether this system should send
the master clock. Please note, that there can be only ONE
Master in the system! The ASIO clock will be the system’s
master clock and all video layers on all Clients within the
entire PB network will be synched to it.

It is possible to output ASIO on multiple systems but it is
not possible to synchronize the audio on more than one
system while playing back. If you output ASIO on another
system (than the one that generates the master clock),
THEIR audio tracks cannot be synched while playing back.
They will be triggered in synch but as soon they are running
they are in a free-run mode.

Timecode master – not timecode slave

The ASIO clock will be the system’s Timecode master. It is
not possible to have two master clocks in a system; ASIO

and SMPTE can’t be used simultaneously. 

Sample accurate audio and master volume

Choose a sample rate from the "Sample Rate" drop-down list (41 kHz, 44.1, 48 kHz, 96 kHz as
supported by the sound card). All sound files within the project should be created as wave files with the
same sample rate.
Please note that the ASIO Tracks will play mono and stereo PCM Wave files (16 or 24 bit) with the
sample rate that is preset in the Audio Configuration only, there is no sample rate conversion. Each
sample will be played back 1:1. 
There are test files with various sample rates and volumes in the Stock Assets folder.

The fader sets the master volume of your ASIO sound card. Value Range: -96 dB (muted) up to 6 dB
(max.). Default value is -9 dB.

Multi-channel ASIO output

The ASIO protocol allows multichannel audio output, depending on the sound card up to 64 audio
channels are supported. In order to assign a track to a specific audio channel of your ASIO sound card,
please refer to the Track Inspector .
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Show Channel Details:
This list reads the sound cards settings and gives you an overview how the channels are routed in the
sound card.

6.3.4.4.12  Extensions

The section "Extensions" in the Configuration tab  allows to set up additional extensions.

To interact with WYSIWYG CE coolux console edition, enable this option
first by pressing [Enable] and then start your WYSIWYG console edition.

6.3.4.4.13  SMPTE Time Code

The section "SMPTE Time Code" in the Configuration tab  allows to set up timecode options for an
attached SMPTE Link interface .

If you want to use a SMPTE Link interface for either
SMPTE send or receive mode, please connect the SMPTE
Link USB device, the availability will then switch to "YES".
If not, Pandoras Box cannot find the SMPTE Link. Try to
reconnect it to the hardware, restart Pandoras Box or re-
install the driver found in the coolux Download Center our
web site. To set a timeline to "Send" or "Receive" please
see the Sequence Inspector .

- Retry:
Use the “Retry” button if you have lost communication or the SMPTE Link was removed from the USB
port.

- Frame Rate:
Setup the frame rate that you want to use for either send or receive mode of the SMPTE Link interface.

- Level:
The level setting is important for send mode only. You may enter values between 0 and 1 to amplify the
SMPTE output signal level.

- Transport Changes if Input Repeats
Some SMPTE sending devices continue sending the last frame instead of stopping the SMPTE
transmission.
If this option is not enabled, and the SMPTE devices sends 3x an identical frame, the timeline will
continue running until it receives a different frame.
If this option is enabled, the timeline will execute the Stop-Action set up for this sequence.
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6.3.4.4.14  Web Server

The section "Web Browser" in the Configuration tab  allows to set up the integrated web server in
Pandoras Box. See here a list with all ports  used by Pandoras Box and Widget Designer.

The principle of Pandoras Box' Web Server

Version 5.5 comes with the newly developed Pandoras Box Web Server. It offers remote control of a
Pandoras Box project that can be implemented into a web site. All PB Automation commands, known
from the SDK , are now executable in JavaScript language, and thus can be embedded in the HTML
code by your web developer.

There is a demo web site that shows what can be done and how the PBAutomation commands are
implemented in the web site's code. If you like to view it, open a Pandoras Box Master system and
activate the web server. Then go to your browser and enter your IP address and the port number, e.g. 
http://2.0.0.100:6214 (alternatively you may copy-paste the URL from the Configuration tab) to -

this calls the web server and shows the delivered web site. This site contains a link to the demo site
which is installed per default in the web root folder under c:/coolux/content. If you like to write your own
site please make sure to place it in this web page root directory.

Please note that the internal Pandoras Box Web Server can be used without access to the internet, it is
meant to be used in (secure) local networks. For bigger installations it might be of interest that external
web servers can be used in combination with the PB web server. For example, an Apache HTTP Server
can be used or any other web server that supports the scripting language php. This server is then used
to deliver the web sites to the browser and forward commands to or receive information from the PB web
server. This setup has advantages for larger installations and for those that need access to the internet
(as the PB server can be invisible), or for database applications.

Settings in the Configuration tab

Click the Start button to activate the web server which acts then as an interface. You may send
commands to the web server, it "translates" them and forwards them to Pandoras Box; in return
Pandoras Box sends requested information through the Web Server to you.

Per default the port number used by the web server is 6214, it can be changed if needed. As well the
directory and URL for the web page root can be altered. There is a log file that logs when a command
was send or received, an error or another action happened. The log entries can be filtered; choose your
logging mode (None, Limited or Full) in the drop-down list.
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6.3.4.4.15  Cache

The section "Cache" in the Configuration tab  allows to clear the internal cache in Pandoras Box.

Thumbnails are used in various places in Pandoras Box:
- the Thumbnails tab
- the Inspector when a media file in the Project is selected
- as a small thumbnail in a container in the Sequence tab
- in the Preview if "Use Thumbnails for Preview" (Configuration tab > Local Preview )

For every file in the Project tab, Pandoras Box generates an according thumbnail and saves it in the
project folder\local_cache_thumbs. 

In case that you encounter any issues with loading images or thumbnails,
you may press “Clear Thumbnail Cache” which deletes all files in the

"thumbs" folder , and the next time you start the project, the thumbnail and image files will be rebuilt.

6.3.4.5  Controller Setup

In the Controller Setup Tab the assignment of Sequence Faders and Cue Button controls for the coolux
Jog Shuttle and the coolux Fader Controller will be done. Without assigning these Faders / Buttons the
controller boards won’t work.

HAVING A JOG SHUTTLE CONTROLLER CONNECTED
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The image above shows the Controller Tab with the Jog Shuttle Controller Board  connected to the
Pandoras Box Master device. 

[Reload]:
Press this button if the connected Controller Board is not shown in the tab. This will reload the
connection.

[Enable Sequence On/Off Key]:
This option is valid for the former Jog Shuttle Controllers . The Sequence On/Off Key is enabled by
default. This button will toggle the opacity of the selected sequence between 0% and 100%. This option
may be disabled so that the sequence can’t be turned off by fault.

[Load Selected Sequence]:
When this option is enabled, the sequence selected by the sequence faders will be active and loaded
into the Sequence Tab .

[Jog Shuttle]:
The Jog Shuttle Board allows controlling two sequences. To assign a sequence in Pandoras Box to a
Sequence Fader and Select Button on the Jog Shuttle Board, please enter the sequence ID into the text
field next to Fader 1 or Fader 2.

[Cue IDs]:
For each sequence that is linked to the faders 16 specific cues may be called via the Cue Buttons.

To assign the Cue Buttons to specific CueIDs in Pandoras Box:

- Select the Sequence whose cues you want to link to the Cue Buttons by clicking on Fader 1 or Fader
2 in the Jog Shuttle section.

- The title of the Cue IDs changes to the Fader number and the Sequence ID linked to this fader.

- Enter a Cue ID for a Cue Button.

HAVING A FADER CONTROLLER CONNECTED
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If there is a Fader Extension Board  attached to the Pandoras Box Master Device as well, the
Controller Setup Tab shows 6 additional faders.

Assign sequences in Pandoras Box to these additional faders the same way you do when working with a
Jog Shuttle Board. For each of these sequences 16 specific cues may be called via the Cue Buttons on
the Jog Shuttle Controller as well. For information about how to assign these CueIDs, please see
“CueIDs” above.

6.3.4.6  Curve Editor

To open the Curve Editor Tab, please click on 'Tabs' in the Toolbar - Curve Editor.

For changing the curve of a parameter, make a right-click
on this parameter in the device tree and choose "Load
into Curve Editor".
You can also double-click on the Curve Editor icon in front
of the parameter's name in the device tree.

Please note that you need a sequence in order to edit
curves. 

In the example, the opacity of Device [2.1] is loaded into
the curve editor.

Underneath the tabs you see the timeline and the current
position of the now pointer. The first time you open the
Curve Editor it opens with time 0:00:00:00, press play (or
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hit the space bar) to jump to the time the now pointer is
located in the sequence tab. From now on as soon as
you position the now pointer differently in the sequence
tab, the frame in the Curve Editor will follow automatically
and vice versa. 

As well container and keys are synchronized.

Below the timeline there is the clip container including a
thumbnail and the name of the clip. The greyish borders
on the left and right mark the start and end time of the
clip container. The greyish borders on the top and bottom
mark the value range of the parameter (depending on 8 or
16 bit values).

In this example the opacity key at the left border shows a
constant value going until the end of the clip.

To navigate in the Curve Editor there are three modes:

 - select and edit clips, key frames and their handles

 - zoom the y-axis (the parameter value range) that is
depicted on the left diagram border. Pressing ALT will
zoom out. Alternatively you may use the shortcuts SHIFT
and + / - on your main keyboard. 
To zoom the x-axis (the time) use + / - , just as you do it
in the sequence.

 - move the content depicted in the Tab in both axes
(without moving the now pointer). Alternatively hold down
the M key on your keyboard.

INSERTING / REMOVING KEYS

To insert more keys for the used parameter, right-click in
the Curve Editor and a new key will be created.
To remove a key, select it and press DEL on the
keyboard.

EDITING KEYS

To move a key, please drag and drop it to the new
position.
Moving it left and right will move it within time.
By moving it up and down, the value of the key increases
or decreases. 

With the shortcut CTRL and the left / right arrow keys you
snap the now pointer exactly to key frame. Now, when
dragging the key frame up and down it will stick to the
same time.

If you want to move it to a certain value, do a right-click
on the key and insert the value or click inside the value
field and move the mouse-cursor up and down.

Alternatively you may use the Device Control Tab or the
Inspector Tab. But only the Inspector gives the possibility
to multi-select item and change them synchronously.
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CURVE TYPES

To change the curve type of a key, select the key and
choose a Curve Type from the drop down menu in the
Inspector Tab.
You can choose between Linear (Standard), Bezier,
Bezier Corner, Constant and Stop.

- Linear
  A linear line is drawn between the previous and next
key.

- Bezier
 The key gets two handles and you can intuitively
smoothen the curve by moving the handles and changing
their length. The handles always will stay in a line.

- Bezier Corner
  Compared to Bezier the handles can be modified
independently from each other.

- Constant
  The value of the key will be continued until a new value
is given.

- Stop
  The connection to the next key will be removed, the
key's value will be held until a new value is given.
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6.3.4.7  Device Control

Figure: The Device Control Tab, having Layer 1.1 loaded.

Depending on the device selection from the device tree in the Device tab , the device parameters will
be loaded into the Device Control tab. 
A selected device in the device tree will have its node icon highlighted in blue.

See the following chapters for information about the handling of the Device Control tab:
Parameter Value Readout
Parameter Value Ranges
Changing Parameter Values
Linking Parameters
Expand & Collapse Parameter Sections

If you are interested in detailed information about all available layer types and parameters, please refer to
the topic "Device Control ", e.g. including a chapter only describing the controls within a Video Layer
on Pandoras Box Servers .

6.3.4.7.1  Parameter Value Readout

The parameter values are shown in decimal readout and centered by default. 
To display them in percentage readout and/or non-centered, please have a look in the Configuration tab >
Devices / Parameters .

6.3.4.7.2  Parameter Value Ranges

Depending on the parameter type the values cover different value ranges.

For example the opacity parameter can be set from 0 up to 255, the rotation parameters can be set from
-9999.99° up to +9999.99°.

When controlling the Pandoras Box Master via DMX, MA-Net, Art-Net or sACN there is only a limited
value range useable for the most parameters. This is due to the 8 bit / 16 bit channels of DMX control.

For example the opacity parameter value range can be used completely (0-255 = covered by one 8bit
DMX channel). But the rotation parameter values range only from -1080° up to 1080° (instead from -
9999.99° up to +9999.99°). This value range is divided into 65535 DMX steps (one 16Bit DMX channel),
so that 1 DMX step corresponds 0.033°. Please see the DMX tables  and the Device Control
Section for detailed information about each parameter of the different device types.
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6.3.4.7.3  Changing Parameter Values

All changes made to the parameter values will turn the parameter active and red.

If there is a fader for the parameter, you have the following possibilities to change the
parameters value:

- Use the fader handle for coarse control

- Click the fader once and use the arrow keys (up/down) = +1 / -1 value;
Holding [CTRL] while using the arrow keys (up/down) = +10 / -10 values.

- Click in the numeric value field above the fader, hold the mouse button clicked and move
the mouse up / down for sharp tuning.

- Click + / - next to the numeric value field for finest control.

- Enter the new value manually into the numeric value field and press [ENTER] to apply the
change.

- Press [Reset] to set the parameter back to its default value. The status “active” will be removed from
the parameter.

 

If there is only a numeric value field for the parameter, you have the following possibilities
to change the parameters value:

- Click in the numeric value field, hold the mouse button clicked and move the mouse up /
down for sharp tuning.

- Click + / - next to the numeric value field for finest control.

- Enter the new value manually into the numeric value field and press [ENTER] to apply the change.

- Press [Reset] to set the parameter back to its default value. The status “active” will be removed from
the parameter.

6.3.4.7.4  Linking Parameters

To link several parameters click on the link icons above the faders or numeric text fields in the device
control tab or left to the listed parameters in the device tree. If one of the parameters is changed now, all
parameters linked will accept the values in relation to it. 

Please note:
Only parameters from the same type (like rotation or scaling) can be linked!
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Figure 1: X-, Y- and Z Scale parameters are linked in the device control tab; changes on X Scale apply to
Y- and Z Scale as well.
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6.3.4.7.5  Expand & Collapse Parameter Sections

To have a better overview in the Device Control Tab, parameter sections may be shown in collapsed or
expanded mode.

Figure1: nearly all parameter sections are expanded.

Figure2: the parameter sections that are currently not relevant for the programming are collapsed. 

To collapse a parameter section:
- Click the “-“ icon in front of a parameter section name
- Double-click the parameter section name or its following line
- Double-click in the area below the parameters
- Use the right-click menu

Expand a parameter section:
- Click the “+“ icon above the parameter section name
- Double-click the line following the parameter section name 
- Double-click in the area below the parameters
- Use the right-click menu
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Right-click menu:

The right-click menu (right-click in the height of the parameter section names) allows to:
- Collapse / Expand the current parameter section
- Collapse all other parameter section except this one
- Remove All FX  from the device
- Expand any parameter section by name.

6.3.4.8  Device Tree

The device tree is the main place to browse and edit all available devices in the project.

If you are working with a Pandoras Box Player or Server system in stand-alone mode the "local" lists all
layers that are part of your system. If you are not working in stand-alone mode but with a Master and
Client system(s) you need to add these Clients (including their layers) to the Device Tree as well. If the
Clients are already connected, i.e.:
- started (in the same Revision as the Master system) and showing the Pandoras Box Client window
and
- set to the correct IP address and Pandoras Box domain
you may see them in the Assets tab  and add them from there to the Devices tab (shown in the right
image below).If this is not the case, e.g. if you like to pre-program a show, you may drag an according
system from the Device Types tab  into the device tree. Later on, when the real systems are
connected, you can simply select the pre-programmed Client and enter the IP address in the Device
Inspector .
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After adding a system to the Devices tab, it is shown with collapsed layers. To unfold/fold a site or
device tree double-click on it.

Figure left: The Site named “Server Light” is collapsed. Figure right: After a double-click on the Site icon
the standard amount of devices is shown.
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The Device Tree...
- Is always linked to the Sequence Tab in order to browse and edit keys stored to the sequence
- Allows you to sort the layer and FX structure
- Allows to show / hide parameters, layers, sites
- Allows a site to be included in / excluded from the preview.

The Device Tree section is separated into the following themes:
Build-Up
Context Menus
Device Selection
Structured View

If you are rather interested in the devices itself, e.g what is the meaning of a parameter in a Video Layer,
how to add an effect to a layer or how to use a DMX device (DMX fixture) please refer to the topic about
"Device Control ".

6.3.4.8.1  Build-Up

This topic explains how to change the view in the Device Tree tab itself and how to change the render
order of layers.

Device structure and different layers

When adding a site (from the Assets tab  or Device Types tab ) to the Device Tree it does not show
the included layers. The site looks like the one in the left image.

Once a site is unfolded (by double-clicking on the site) the default device structure is shown, see the
middle image. The default view includes for example the first two graphic, video and audio layers as well
as all available cameras and outputs. The number of layers shown per default, can be changed in the 
Configuration tab  > General Settings. 

You may unhide layers or add new ones. The right image shows the Server with an added Pointer and
Light layer. The commands can be found when right-clicking on the site itself; as explained in the next
topic "Context Menus ".

  

How many and what type of layers you may add, depends on your PB device. See the topic Product
Overview  for more details. See here the list of the different layer/device types:
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Manager Player Server

Video Layer - yes yes

Graphic Layer yes yes yes

Pointer yes yes yes

Light - - yes

Audio Track yes yes yes

Camera - yes yes

Output - yes yes

Changing the render order of layers

All Video and Graphic Layers are arranged close to each other in Z order:
Layer 1 is the bottommost layer, all other layers enqueue above this layer 1. 

The device tree allows you to change this layer order (without having any Z Position changes applied to
any layer). Simply unfold the site and drag and drop any layer to another position.

The two images above show the default layer order.

Then, layer 3 is selected and dragged above layer 1. Note that the
mouse cursor changes and that the new position of the selected layer
is indicated by a slender white line (enhanced with a red rectangle in
the left image). 

After dropping layer 3 it now sits above layer 1 in the device tree The
result is that layer 3 will be positioned behind layer 1 now in Z order and
the preview looks like in the image below.
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6.3.4.8.2  Context Menus

Several context-menus are available to filter the view of the device tree. This topic explains the context
menus from a site, a device  and a parameter .

The context menu of a site

[Site Name]
The site’s name (in the example above: local)

[Toggle Preview]

Toggles the site to be included in / excluded from the preview . When the site is
included in the preview the site icon is highlighted in blue as seen in the top image.
If it is not in the preview the icon not highlighted.

[Store Active]
Stores all active parameters of the site's devices as containers to the sequence.

[All Active]
Activates all parameters of all devices of this site (every parameter will turn red).

[All Active (Partially Active Devices)]
Activates all parameters of all layers of this site that already have active parameters.

[Clear All Active]
De-activates the active status off all parameters of all devices of this site. The values will be kept and not
set back to default.

[Reset All]
Resets all parameters for all devices of this site to their default values and removes their active status.

[Rename]
Enables you to rename the site. You can do this by pressing F2 as well.

[Remove]
Removes the site irrevocably from the device tree. You will have to confirm this action in a pop-up
window.

[Hide]
This command will hide the site in the device list. To show it again, right-click on another site and
choose the "Toggle Sides" command as explained below.

[Toggle Devices]
Choose if you want to show all devices, hide all devices or show / hide single devices of this site in the
device tree. A time-saving way to select and hide more than one layer is using the right-click menu of a
device.

174 175

239



174

[Toggle Sites]
Choose which sites you want to show or hide in the device tree.

[Add Layer]
Adds one new layer to your site. A pop-up lets you choose the type of layer. This command depends on
your PB product.

[Add Multiple Layers]
Adds several new layers to your site. A pop-up lets you choose the type of layer. This command
depends on your PB product.

[Create Virtual Site]
This command will create a Virtual Site out of all selected sites. Please see Virtual Site  for detailed
information.

[Adopt from Site]
Loads all current values and contents of the chosen site into the layers of this site (timeline programming
will not be affected).

[Toggle Fullscreen]
This command toggles the site into fullscreen and out of fullscreen.

The context menu of a device or layer

[Device Name]
Shows the device’s / layer's name (in the example above: Layer 1)

[Store Active]
Stores all active parameters of the device as containers to the sequence.

[All Active]
This command will activate all parameters of this device (every parameter will turn red).

[Clear All Active]
De-activates the active status off all parameters of this device. The values will be kept and not set back
to default.

[Reset All]
Resets all parameters of this layer to their default values and removes their active status.

[Rename]
This command will enable you to rename the device. You can also do this by pressing F2.

[Remove]
Removes the layer from the site. Please note that the layer will not only be hidden as with the command
"Hide".

[Copy FX Structure]
This command copies the FX structure of this device in order to provide it for another layer. This refers to
the FX types and their order.
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[Paste FX Structure]
Copy a FX Structure from another layer first. This command then pastes the FX structure to this layer. If
this layer already contains FX, it will add the copied FX structure after the existing FX.

[Remove All FX ]
This command removes all FX of this device. Please note: Once an effect is removed from the layer, it
won’t be available any more for all of the layer’s clip containers which used this effect. 

[Hide]
This command will hide the device in the device tree.

[Toggle Devices]

The pop-up enables you to show and
hide layers. This can be done with
single or all layers, or depend on your
current layer selection.
Selected layers are highlighted blue.
To multi-select layers, press CTRL or
SHIFT.
For an example refer to the topic
"Structure of devices" explains the 

[Toggle Parameters]

The pop-up enables you to show and
hide parameters. This can be done
with single or all parameters, or
depend on your currently used once
(stored keys in the sequence).
In addition, the list shows you the 
keyboard shortcuts  to apply the
filtering to any device selection.

[Toggle Selection Lock]
Choose Toggle Selection Lock to lock the current selection. A lock icon will display the locked
selection. Clicking on a device beside this selection will load the device into the device control tab. You
can modify its parameters without loosing the locked selection. This explained in more detail in the next
topic "Device Selection ".

The context menu of a parameter

 

[Parameter Name]
Shows the parameter’s (in the example above: Opacity).

[Store Active]
Stores all active parameters of the device as containers to the sequence.
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[Active]
Activates the parameter (parameter will turn red).

[Clear Active]
De-activates the active status off this parameters. The value will be kept and not set back to default.

[Reset]
Resets the parameters to its default value and removes its active status.

[Hide]
Hides the parameter in the device tree. To show it again, right-click on the layer and choose the "Toggle
Parameter" command as explained above. The topic "Structure of the Device View " shows as well
the keyboard shortcuts to toggle parameters.

[Toggle Key Mode]
Allows you to detach the parameters events from the existing clip containers. This applies to all
sequences. 
Please note: This command cannot be undone. For more details see the topic "Programming ".

[Load into Curve Editor]
To edit the parameter curve do a right-click and choose "Load into Curve Editor" or double-click on the
Curve Editor icon in front of the parameters (you will find the Curve Editor Tab under Tabs - Curve Editor).
Please see the Curve Editor  description for detailed information.

The device tree also allows direct changes to any parameter
value: 
1) left-click the value and drag it
2) double-click in the numeric box and enter a new value
using the keyboard.
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6.3.4.8.3  Device Selection

This topic explains ways how to select sites (i.e. Players and Servers) and devices (i.e. layers). If you
like to save selection-groups, please refer to the topic "Groups ".

Selection of a site or device

Select a site (Server) or a device (layer) by left-clicking on it. The layer icon will turn blue and the
selected device will be loaded into the device control tab.

Multi-Selection

To select several devices, select the first one and hold down the CTRL or the SHIFT key while clicking
on other devices to select them, too.
When several devices are selected, the last one selected will be loaded into the Device Control tab .

Once you have done your selection, all parameter changes (adding new media/mesh, moving a fader) on
one of these selected layers will be assigned to all selected layers. E.g.: Changing the opacity of layer 1
will result in opacity changes in all selected layers.
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Selection Lock

To keep your multi-selection while modifying other devices, right-click on one of the devices and choose
Toggle Selection Lock or press CTRL+L. A lock icon will display the locked device selection.

If you now click e.g. on Layer 5, it will be loaded into the device control tab. You are able to modify this
layer and keep your selection for later purposes.
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6.3.4.8.4  Structure of the Device View

This topic shows how to hide and show layers and parameters in order to adjust the Device Tree.

Hide devices

As best practice we recommend to display only those devices or layers that are used in the show. This
allows faster navigating through the device tree when a lot of devices are loaded in the project. Choose
the “Toggle Device” entry from the site context menu to hide or show individual items or all items at
once.

Using multi-selection to show/hide several devices could be time-saving. 

To select several devices, select the first one and use holding down the CTRL or the SHIFT key while
clicking on other devices to select them too.
Right-click on one of these layers and choose Hide from the context menu.
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Show devices

Once the devices are hidden, right-click on the site and choose Toggle Devices -Show All or -Show to
display all or parts of them again.

Hide and show parameters

The device tree can also be filtered on the parameter level. To do so, right-click on any device and
choose Toggle Parameter to hide or show individual items or all items at once. In addition, the list shows
you the keyboard shortcuts to apply the filtering to any device selection.

When working in device tree, the following shortcuts apply to current selected device:

A Show all Parameters
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H Hide all Parameters

U Show only Parameters used in Sequence/Show all Parameters

M Show/Hide Media Parameter

O Show/Hide Mesh (Object) Parameter

I Show/Hide Opacity Parameter

V Expanse/Collapse Playback Parameters

X Expanse/Collapse Audio Parameters

P Expanse/Collapse Position Parameters

R Expanse/Collapse Rotation Parameters

S Expanse/Collapse Scale Parameters

T Expanse/Collapse Rotation Pivot Parameters

D Expanse/Collapse Scale Pivot Parameters

B Expanse/Collapse Blend Mode Parameter

F Expanse/Collapse FX Parameters

G Expanse/Collapse Particle System Parameters
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6.3.4.9  Device Types

The Device Types tab shows you the contents of the
built-in device library.
From this device list you may choose any device and
drag & drop it into the device tree list to control it within
your current project.

If you are adding a "Multi License" item a pop-up will
ask how many licenses should be applied. The number
of licenses depends on the number of dongles used
and will result in the multiple number of Video Layers,
Camera and Output layers. Hence, whilst a normal
Player STD consists of 2 Video Layers and 1 render
output (1 Camera + 1 Output), the same Player started
with two dongles will have 4 Video Layers and 2 render
outputs. See the Product Overview for more information
regarding the layer and output count.
Please note that starting a system with multiple
licenses is only possible for certain Players and
requires absolutely identical dongles. Differences can
be an additional Widget Designer license, or supporting
version 4.x

Please note: 
When adding a Pandoras Box device to the device tree,
the node icon will show a red "!". This means that you
will need to set up the IP address of the device via the 
Inspector tab  and make sure that the device is
available in the network in order to connect to it.
If you are starting to program a show and the Client
systems are already connected you may drag them
from the Assets tab instead.

Using Lighting Console Configuration
With the new dynamic layer structures, users can now
easily add more parameters and effects to any layer. In

order to facilitate the control, users may start Pandoras Box in a dedicated Lighting Console Mode or
simply create and extend the DMX library from within the interface. This means that any parameter can
now be individually patched.

In the lighting console configuration the most relevant parameters are automatically patched and the
sites will have Multi-FX added and patched as well. Within these Multi-FX you will be able to choose FX
from the whole FX range.

Please find more information in the respective chapters:
- Layout and commands from the Device Tree tab
- Controls, faders and values information in the Device Control tab  
- Programming and storing containers and navigating through the Sequence tab
- Detailed information about each device, e.g. a Video Layer or Serial Link device, in the topic "Device
Control "
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6.3.4.10  Device Viewer

The device viewer shows an overview of the loaded content and additional media information, based on
the selected node item in the device tree.

Please note: 
Only devices displayed in the device tree are shown in the device tab (no hidden devices).

In the top left corner you will see the media size, in the top right corner the frame rate for videos is
shown. On the bottom of the thumbnail the clip container length is displayed. Below the thumbnail you
see the media´s name, its DMX file and folder ID and the current opacity value. The last entry at the
bottom shows the asset's countdown (when it is stored to the timeline).

Click on a layer field here in the device viewer in order to select the layer in the Device Tree.

6.3.4.11  Encoder Extension Tab

The built-in Pandoras Box Encoder Extension allows to transcode most AVI -and Quicktime- as well as
WMV files to Mpeg1 or 2 up to a 4k resolution. Please see this chapter "Encoder Extension"  for
more information...

6.3.4.12  Firefly Particles

The FireFly™ particle system allows creating elaborate real-time particle effects in a true interactive 3D
compositing space. Various emitters can be setup and applied with forces such as Wind & Gravity. The
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3D and 2D particle systems are available on Pandoras Box Server systems whilst the Player systems
support 2D particles only.

Basics information:
In order to use the Firefly Particles you have to add a Particle System to a video or graphic layer first. As
a second step you may then drag one or several emitters onto the specific system. 

Adding a Particle System to a layer

To add a particle system to your layer, drag and drop the 2D or 3D Particle System from the FireFly
Particles Tab on the layer, just like you are adding FX to the layer. The particle system will appear right
from the default layer parameters, see image below.

If you expand the layer in the device tree tab now, you will see that there
is a new entry for the particle system in the folder “PS”, see image to the
left.

With the particle system you define the environment, setting up the
opacity of the system, Gravity and Wind. To see how these settings
affect the emitters, you have to add at least one emitter.

Adding a Particle Emitter  to a Particle System

To add a particle emitter to your system, drag and drop the 2D or 3D Particle Emitter from the FireFly
Particles Tab onto the system, not the layer:
- either into the Device Controls tab where you can see the faders of the Particle System
- or into the Device Tree tab, onto the entry that says "Particle System"

The particle system section is now enhanced by the emitter parameters.
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System and Emitter: Parameter overview

SYSTEM

Parameter Description Value Range Default

PS Opacity Opacity of the whole Particle System 0-255 255

Gravity Amount of Gravity affecting the emitters 0.000-1000.000 0.000

Wind Amount of Wind affecting the emitters 0.000-1000.000 0.000

Wind Rot X 0-360° 0°

Wind Rot Y 0-360° 0°

Wind Rot Z 0-360° 0°

EMITTER

Parameter Description Value Range Default

Media Media File used as Emitter None

Mesh Object File for the Media None

Emitter Type Choose how the emitter will appear: None, Point, Line,
Area, Circle, Sphere,
Cylinder

None

Particle Alignment Alignment of the emitting particles None, Billboarding,
Flight Direction

None

Radius Radius of the emitter type, in units
(a PB fullscreen is always 16 units
wide)

0-100 1

Length the emitter sources dimension 0-100 1

Angle Angle of emitting particles 0-360° 45°

Range Range 0-100 0.000

X Pos Position of emitting particles in X -999.999 - +999.999 0.000

Y Pos Position of emitting particles in Y -999.999 - +999.999 0.000

Z Pos Position of emitting particles in Z -999.999 - +999.999 0.000

X Angle X Angle of particle source -1000° - +1000° 0°

Y Angle Y Angle of particle source -1000° - +1000° 0°

Z Angle Z Angle of particle source -1000° - +1000° 0°

Rot Pivot X Pos X Pos of rotation pivot -999.999 - +999.999 0.000

Rot Pivot Y Pos Y Pos of rotation pivot -999.999 - +999.999 0.000
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Parameter Description Value Range Default

Rot Pivot Z Pos Z Pos of rotation pivot -999.999 - +999.999 0.000

Count/Sec Amount of particles per second 0.000 – 1000.000 100.000

Time To Live (Sec) Amount of seconds a particle will live
until it fades out and disappears

0.000 – 1000.000 5.000

Speed * Define the particles speed Start:20, End: 20

X Scale * Define the particles X Scale Start:0.1, End: 0.1

Y Scale * Define the particles Y Scale Start:0.1, End: 0.1

Z Scale * Define the particles Z Scale Start:0.1, End: 0.1

X Rot * Define the particles X Rotation value Start:0, End: 0

Y Rot * Define the particles Y Rotation value Start:0, End: 0

Z Rot * Define the particles Z Rotation value Start:0, End: 0

Mass Mass of particles; the flight behavior
of an objects is defined by its
momentum (mass*velocity or
speed); the momentum decreases
the influence of gravity and wind

1.000 – 100.00 1.000

Drag Drag of particles; as drag is a force
which decreases the velocity / speed
of an object it resists the particle´s
motion, thus it increases the
influence of gravity and wind

0.000 – 1000.000 0.000

Color * Color added to particles. Choose color

Particle Opacity * Define the particles opacity over
lifetime

Choose color Start:white (full
opacity), End: black
(opacity=0)

*: The parameters marked with * allow defining a curve over the particles lifetime. A right-click into the
faders background adds a new point in time whereto a parameter can be defined.
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Particle Examples

In the following examples these files are used:

In the examples only the parameter values different from the default values are mentioned.

Example 1:

Image above: Here the emitter type is set to “Point”, there is no gravity set for the particle system.

Image above: The particle systems gravity is now set to 155 – the emitters will fall down after they flew
into positive Y direction.



188

Images above: The emitter type is changed to “Line”, with the Radius set to 12. No gravity.
Left) Viewed from the front, Right) viewed from the side.

Images above: The emitter type is changed to “Circle”, with the Radius set to 12. No gravity.
Left) Viewed from the front, Right) viewed from downside.

6.3.4.13  Group View

The group view lets you create, edit and select groups in a browser view. The same functions are
accessible in the Project tab > Groups .

To create a new group, select multiple devices in the device tree.

Then right-click in the group view tab to create a new group based on the current selection.

To select a group, only press ESC to clear the current selection and click on the group item in the group
browser to select all group members in the device tree.
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If you want to edit an existing group, right-click on the desired group and choose one of the following
actions:

- Load From Selected Devices
This command will overwrite the actual group selection with the current selection in the device tree.

- Reset All
This command will reset all parameters for all devices stored within this group.

- All Active
This command will activate all parameters of all devices stored within this group.

- Clear All Active
This command will de-activate all parameters of all devices stored within this group.

- Remove
This command will delete the group from the project.

6.3.4.14  Inspector

The inspector is a dynamic, context sensitive property window that will constantly display the properties
of the selected items in the user interface.

Based on the selected item, the inspector offers different control and property settings.
Since version 5.1 it is possible to multi-select items and modify them all at once. This applies to all
possible items such as key frames and containers, cues, files and layers.
If you select items that have different settings at the time you select them the changes done apply to all
in the same way. That is, a setting that is possible to be a toggle function (e.g. a check box) would not
toggle the other way if it was already used in one of the selected items. Please note, there is no grayed
out symbol if items with different settings are within the selection. The options shown in the inspector
always refer to the item last selected or to the one afterwards chosen via the drop-down menu the
inspector offers. Underneath the drop-down you see the information how many more items you have
currently selected.
The only exception of the rule are explained in the file inspector .
Generally changes made for IDs apply to the first item selected. The IDs for the other items are set
incrementally 
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The different Inspectors are described in the following order:

Inspectors to be called from Project Tab:
- File Inspector
- Folder Inspector
- Browser Inspector
- Canvas Inspector
- Image Sequence Inspector
- Object Inspector
- Sub Mesh Inspector
- Playlist Inspector
- Text Inspector
- Sequence Inspector
- Tab Button Inspector

Inspectors to be called from Timeline Tab:
- Clip Summary Inspector
- Clip Inspector
- Cue Inspector
- Parameter Keyframe Inspector

Inspectors to be called from Device Tree:
- Device Inspector
- Video and Graphic Layer Inspector
- Pointer Inspector
- Light Layer Inspector
- Track Inspector
- Camera Inspector
- Output Inspector
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6.3.4.14.1  File Inspector

The File Inspector opens when a media file is selected in the
Project tab . The left depicted Inspector shows all properties of
a video file. A still image has less options. The File Inspector is
also included in the Folder Inspector . If you do any changes in
the Folder Inspector, they apply to all files as if they were multi-
selected.
The Inspectors for other resources (Browser , Canvas , Image
Sequence , Object , Playlist , Text ) are described
separately.
Since version 5.7 it is possible to set initial values in the 
Configuration tab > Resources , e.g. if you always want an
activated FluidFrame option.

IDs Folder / File
Set numeric virtual file and folder IDs for DMX , PB Automation

 and Widget Designer  remote control and thumbnail
exchange . To easily address several files in ascending order,
move over to the Folder Inspector  and enter the Folder ID and
the start File ID. 
Press the button "Clear" to remove the virtual file and folder ID.

Anisotropic Filtering
Anisotropic Filtering does pixel smoothing for real-time video and
image scaling, default is on.

Ignore Thumbnail for Preview
Even if using the “Thumbnail for Preview”-Option (see Configuration
Tab ) this file can nevertheless be rendered and played back in
full quality instead of showing its thumbnail, (e.g.. if you need to
know where exactly the video playback currently is). Check the
Ignore Thumbnail for Preview option to make this exception for this
file.

Video Alpha channel
If movie type supports embedded alpha, this option lets you
activate the alpha channel. The alpha channel inside images is
always activated.

FluidFrame
Choose this option for slow motion or smooth motion frame-
adaptive frameblending and framerate conversion.
With FluidFrame™, a smooth cross-conversion that can take any
input and output framerate, supporting both interlaced and
progressive sources and clips is possible now. This way for
example 59.94 video input signals are displayed without any frame
drop on 60hz output displays. FluidFrame™ can therefore also
handle 50hz to 60hz real-time conversions.
In addition to this, it allows smooth playback of highspeed frame

rates such as 50 or 60p content and higher. FluidFrame™ Technology can be applied to any live video
input or content playback scenario ranging from straight forward Live Video processing to the
synchronization of multiple HD SDI streams for Live Stereo 3D applications.
Please note:
When using fluid frame with 50p, 60p files or live inputs, please check the option “High Performance
Mode ” to ensure smooth playback. In all other cases the High Performance Mode should NOT be
used because it requires more system and GPU RAM.
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Optimize Mpeg Colorspace
MPEG has a reduced colorspace, this option stretches the colorspace (black will become a real black).

Do Colorspace Conversion in Decoder
The mpeg format saves colors in the so called YUV colorspace, whilst Pandoras Box requires the RGB
colorspace. Per default the YUV>RGB conversion is done by the graphics card. The advantage is that
performance is saved. The disadvantage is that the card's conversion is different to the one used when
actually creating an *.mpeg file. This is for example the case when taking use of any encoding features
in Pandoras Box, i.e. Video Export or the Encoder Extension. But also when encoding an mpeg with
other programs and tools.
In other words, the Video Export converts RGB>YUV, when using this exported file in Pandoras Box, the
graphics card converts YUV>RGB. As the two ways of converting colors do not match, there are different
RGB values. To convert in the same way, tick the check box. Note that this will consume more
performance and is optimized for the Pandoras Box encoding and decoding features. There still could be
a color difference when encoding mpegs with third party tools.
This option can be used in addition to stretching the colorspace, as described above.

Underscan (Title Safe)
This option is mostly designated for Live Input Signals to crop the image to the Title Safe Area.

Optimize Looping 
Check this option if a looped file does not play back smoothly when jumping from the last to the first
frame.

Use Video Memory Buffers
If the system memory (RAM) tends to run low and you have a  powerful graphics card, this option may
be activated to use the video memory buffers of your graphics card in order to reduce the system
memory load.

Mute Sound:
If a video files contains audio as well, you may check this option if you want to completely mute the
sound part of the video file without using the Volume fader.

Deinterlacing: 
This is a real-time (zero-delay) de-interlacer for live-input sources based on top or bottom field first. The
option fieldblending adds a half-frame delay.

Texture Address Mode
This setting determines how the texture is going to be addressed on objects that use texture coordinates
beyond the range [0-1].
- Wrap: the texture will be repeated (wrapped) to infinity
- Clamp (by default): the texture's last pixel will be stretched out to infinity
- Mirror: the texture will be flipped back-and-forth to infinity.

Clip Color
In case this media file the Inspector refers to is saved as a container in the Sequence, the Clip Color is
the color the container is filled with. Per default it is gray. In case you set it to "Transparent" it will be of
the same color the Layer is set to (see Layer Color ).
By clicking into the color field a dialog opens where you can choose any other color for the container.
Now, any time you save the file to the Sequence, the container will be filled with the chosen color.
Example: Select a folder in the Project (automatically, the Inspector now refers to all files inside) and set
up a purple Clip Color. Select a different folder and choose a different color for it. If you now save files
from both folders to the timeline, you can see instantly which folder they belong to.
Note that the (global) Clip Color set up in the File Inspector can be overwritten with the Clip (summary)
Inspector . Simply select the containers that should be different and select a new Clip Color.
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File location table
Please see the next topic  for a detailed explanations.
- Remove: to remove a specific entry
- Attach: used to attach a different file on individual machines when files are not spread.
- Copy: manual copy of files from one location to another.
- Spread: multi-file transfer to all available Clients that are spared from spread.
- Reload: reloads media 

Please note, that the changes made in the File location table do NOT apply in a multi-inspector. If you
have more than one file selected these changes only apply to one file at time.

6.3.4.14.1.1  Attaching Files

The attach function is a very powerful tool in Pandoras Box. In a nutshell, it achieves that different files
are loaded in different Clients even though the Master is programmed with only one file. This chapter
shows three exemplary applications after an explanation of the file location list

Example: A Manager is started as a Master system and two Players Clients are connected to it.
All three systems are listed as consistent in the Device Tree. The default spreading
behavior is not changed in the Configuration tab > Resources .
As soon as a file is dragged from one of the system's hard disks into the project

(see Media Files) , it is spread to the other systems in the Device Tree. That means it is copied via
the network to an according file path on the others systems. Selecting the file in the Project loads the 
File Inspector  and as described in the last chapter it includes the file location list. For our example it
looks similar to this picture.
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6.3.4.14.2  Folder Inspector

The Folder Inspector opens when a folder is selected in the
Project tab . It includes the properties of the folder itself
which can be viewed when clicking the + icon as seen in the
left image. In addition it supplies the File Inspector of all files
that are part of the selected folder. If you do any changes in
this File Inspector, they apply to all files as if they were multi-
selected.

IDs Folder / File
Set numeric virtual file and folder IDs for DMX , PB
Automation  and Widget Designer  remote control and
thumbnail exchange . All files in this folder will get the
same folder ID, the file ID will be counted up based on the
given file ID. If needed you can set the maximum number to
255 in the Configuration tab > Resources . In that case the
folder ID will increase as well.

Clear
Press Clear to remove the virtual file and folder ID.

Spread Content to following Sites
Per default, the check boxes for the local Master and all
connected Clients are ticked, meaning that content is spread
to them. In case you don't like to spread content to a Client,
deactivate its check box. Note that this does not delete the
content if is was already spread.
"Apply to Subfolders" copies the check box status to all
subfolders within the selected folder. To (un-)select all check
boxes click the according button.
Hint: If you right-click on a folder in the Project tab, you may
find the option "Spread to...".

Watched Folder
First of all, make sure the option "Monitor changes to files on
disk" in the Configuration tab > Resources  is activated.
Click the button "Browse" to choose a folder from the hard
disk that should be watched. If you like to watch subfolders
as well tick the according check box. This will automatically
add all subfolders as Watched Folders.
All files that are part of the watched disk's folder will be added

to this Pandoras Box project folder. All files that are afterwards added to the watched folder will
automatically appear in the PB folder. Files that are changed will be reloaded by Pandoras Box. Files
(and sub folders) that are deleted in the watched folder will remain in the PB folder unless "Remove files
from project / Clients on delete" is checked. 
Click the button "Clear" to delete the Watch function.

Inspector for
Please see the File Inspector  for information about these options.

Spread Resources
This spreads the entire content of the folder to all sites according to the above option "Spread Content to
following Sites".

Clean up Inconsistent
Removes all inconsistent files from the Master system.
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File Management
Please see the File Inspector  for information about these options.

6.3.4.14.3  Browser Inspector

The Browser Inspector opens when a browser asset is selected in the
Project tab. Please refer to the chapter about media files in the Project
tab  if you like to know how to create and work with a browser asset.
If your displayed web page includes links you would like to click, please
read the chapter about Layer Picking .
If you like to set up initial values for new Browsers, please refer to the
Configuration tab > Resources .

IDs Folder / File
Set numeric virtual file and folder IDs for DMX , PB Automation
and Widget Designer  remote control and thumbnail exchange .

Clear
Press "Clear" to remove the virtual file and folder ID.

URL
Enter a web site's address that the browser should open, e.g. http://
www.coolux.de

If you like to open a web site saved on a hard disk, the syntax for the
URL is: file://host/path.

Example for local hard disk: file:///C:/coolux/web site/
index.html

Example for remote hard disk: file://2.0.0.100/coolux/web
site/index.html

Note that rendering from a remote path will add delay. The space
character in the folder name "web site" can also be represented with "%
20".

Use Domain as Resource Name
If this option is ticked, the browser asset in the Project tab refers to the
URL. In this example it is called coolux.de

Texture Width and Height
Set the size of the texture the browser renders on.

Webpage Styles
Decide how the web page's background should be displayed. You may
choose to display it like a normal browser would do, to replace it with

transparency or a custom color.

Clear Cache
This clears the browser cache which stores temporary information from the web site including styles and
images.

Please see the File Inspector  for the options "Anisotropic Filtering", "FluidFrame" and "Use Video
Memory Buffers" and "Texture Address Mode".

Additional, advanced options including font anti-aliasing for web content and FPS settings can be found
in the file "tweak_config.txt" in the installation path, e.g. C:\Program Files (x86)\coolux\Pandoras Box V5
Player Pro Rev 9924\data\config.
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6.3.4.14.4  Canvas Inspector

The Canvas Inspector opens when a Canvas is selected in the
Project tab .

IDs Folder / File
Set numeric virtual file and folder IDs for DMX , PB
Automation  and Widget Designer  remote control and
thumbnail exchange .

Clear
Press "Clear" to remove the virtual file and folder ID.

Texture Width and Height
Set up the size of the Canvas. This should match the size set
up in the application used for drawing onto the Canvas.

Texture Format
Clear Texture
This deletes all input actions from the Canvas so you can re-
start with an empty one. In case you created a Canvas from an
image, this command will also erase the image pixels, turning it
into a black texture.

Anisotropic Filtering and Texture Address Mode
Please see the File Inspector .

Block canvas updates for selected nodes
You can define which connected Clients receive and which
ones do not receive the Canvas updates in order to save
performance.

Clip Color and File location table
Please see the File Inspector .

6.3.4.14.5  Image Sequence Inspector

The Image Sequence Inspector opens when an image sequence
is selected in the Project tab .
Since version 5.7 it is possible to set initial values in the 
Configuration tab > Resources , e.g. if you always want an
activated FluidFrame option.

Number of Threads:
This alters how many threads are called by the Pandoras Box
application from the operating system in order to run the sequence.
The number of threads must be smaller than the total number of
images in the sequence.
Please read the chapter Image Sequence Formats  for more
information.

Frame Ordering
Choose whether the image sequence should be played

- from the first to the last frame
- from the last to the first frame
- from the first to the last frame and again back the first
- from the last to the first frame and back to the last
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Please see the File Inspector  for all other options like "Anisotropic Filtering" etc. and the file table.

6.3.4.14.6  Object Inspector

The Object Inspector opens when an object (also an Editable
Mesh) is selected in the Project tab .
Since version 5.7 it is possible to set initial values in the 
Configuration tab > Resources .

IDs Folder / File
Set numeric virtual file and folder IDs for DMX , PB
Automation  and Widget Designer  remote control and
thumbnail exchange .

Clear
Press "Clear" to remove the virtual file and folder ID.

Override global configuration
In the Configuration tab > Preview Display  you can set up
how meshes without an assigned texture are rendered per
default. Check this override option to "activate" all further
options in order to render the selected mesh different from the
default settings.

Shade untextured object /.../ Material
Please see the explanation of these settings in the
Configuration tab > Preview Display .

File location table
Please see the File Inspector .
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6.3.4.14.7  Sub Mesh Inspector
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6.3.4.14.8  Playlist Inspector

The Playlist Inspector opens when a Playlist is selected in the Project
tab .
Please note that you can set up initial values for new Playlists, in the
Configuration tab > Resources .

First of all the Inspector depicts the duration. The first time refers to the
duration if the playlist is played back once (here: 36 sec) and the other if
the playlist loops (here: 34 sec). In this example the cross-fade time
from the last to first clip is set to 2 seconds.

Click the "Show in Resource Editor" to display the playlist and its
content in the Playlist tab .

IDs Folder / File
See the File Inspector .

Playlist Resolution Determination
Choose the texture size each content file should be rendered on. You
can for example choose the size from the "Largest Entry" or enter a
custom width and height after choosing "User Defined" in the drop-down
list.

Playlist Entry Sizing
Choose the aspect ratio for the texture each content file is rendered on.
"Retain resolution" renders the playlist's content in 1:1 mode, having the
advantage of not possibly stretching the content but the disadvantage of
not filling the fullscreen and allowing different sizes.
All other option like "Fit Horizontally" or "Stretch Fullsize" possibly alter
the content's size. Please see the Video Layer Inspector  for an
illustrated explanation for the different Fit-options.

Framerate
Choose a framerate for the playback of the playlist, this is only for
calculating the duration. The playlist's content files are not converted to

this framerate.

Please see the File Inspector  for "Anisotropic Filtering" and "Texture Address Mode".
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6.3.4.14.9  Text Inspector

Create your Text Input by right-clicking on a folder in the Project tab
 > Add Text Input. Select it to see its properties in the Text

Inspector.

Use 1st Word as Resource Name
This names the Text input in the Project tab with the first word entered
in the Text Input Editor .

Open in Resource Editor
In the Text Input Editor you may set up all options regarding the
content of the selected Text Input, e.g. the text itself. Some of the
options from the Editor are available in the Text Inspector too and
apply to all (multi-) selected Text Inputs. The Editor also allows to
transfer style properties to other Text Inputs. Please note, that .net
framework 4.0 is needed to display this tab.

IDs Folder / File
Set numeric virtual file and folder IDs for DMX , PB Automation
and Widget Designer  remote control and thumbnail exchange .

Clear
Press "Clear" to remove the virtual file and folder ID.

Mode /.../ Texture Height
Please see the Text Input Editor  for these options.

Anisotropic Filtering
Anisotropic Filtering does pixel smoothing for real-time video and
image scaling, default is on.

Offset on Clients
Enter a pixel value to offset the Text Input for the according Client. This is especially useful when
rendering text that spans across multiple outputs from different Clients.
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6.3.4.14.10  Sequence Inspector

The Sequence Inspector opens when a Sequence is selected in the Project
tab .

Sequence Name
Enter an internal name for the Sequence that is for example shown in the 
Project , Sequence  or Sequence Control  tab.

Numeric ID
Enter an ID which is for example used for DMX , PB Automation  and
Widget Designer  remote control.

Frames per second
This changes the displayed time resolution in the Sequence tab , i.e. how
many frames are available per second. Please note that this does not effect
the frame rate used for rendering files! Pandoras Box renders each file
according to its own frame rate, the final results seen on a display device
depends on the refresh rate  set up in the graphics card driver.

Length of sequence
Default is three hours. You can manually set a new length e.g. 30 minutes by
entering 00:30:00:00 or just 300000. Apply the new length with pushing Enter!

Auto Scroll
If Auto Scroll is on (by default), the timeline will always show the area around
the nowpointer when it is set to play. 
With the Auto Scroll option unchecked, you will be able to scroll to any point
of the timeline while the nowpointer is running.

Enforce Defaults
Choose between three states: ON, OFF and ONLY MESH / MEDIA.
Please see Tracking  for detailed description!

End Action
Once the sequence reaches the end of its length, you may choose a specific
action: 
The sequence stops and jumps to first frame, it will pause or it will continue
playing.

Serial
These settings apply when a Serial Link  or TCP/IP device is used to
remote control the sequence. The supported commands are listed in the
chapter explaining the TCP/IP input protocol .
[Pandoras Box] <== TCP/IP ==> [Serial Link] <== Serial ==> [Serial Device
sending commands to control the PB sequence]
TCP IP / IP
This refers to the Sender's IP address.
Serial port
This refers to the port on the Serial Link where your serial device is attached

to. This is a specific serial port on the Serial Link Box, not a TCP/IP port. Please note, that the used
TCP/IP port from Pandoras Box is always 23 and can not be configured.

Time Code
These settings apply when a SMPTE Link  is used and set up in the Configuration tab > SMPTE
Time Code .
Mode
NONE - this sequence will not be effected by SMPTE timecode
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SEND - this sequence will send its timecode via the SMPTE link device. Please note that if a
sequence in your project is set to Send-Mode, all other sequences will be set into None-Mode.
RECEIVE - the sequence will be controlled via the incoming SMPTE timecode.

Offset
If needed enter a timecode offset here.

Stop Action
Choose which action should be executed if incoming time code stops. The timeline play mode can be
set to Stop, Pause or Continue.

(Sequence) Opacity
This fader works as a master fader for the opacity and volume of the sequence (and all the layers that
have clip containers in this sequence).
The sequence opacity works as a value multiplier. If you have the sequence fader at a 50% position
(value 127) all containers or layers will be shown with an opacity that is 50% of their stored or active
opacity value. If one layer has a current active opacity value of 200, it will be shown with 100. In the
same way, another layer that has a stored opacity key will reduce its opacity by one half.
This also means, if a container has no opacity key or value i.e. it is only visible because the default
opacity  was set to full, it is not influenced by the sequence fader! This way you can include or
exclude layers from the sequence “group”.

In the same manner the volume parameter is influenced.

6.3.4.14.11  Tab Button Inspector

The Tab Button Inspector opens when a Button from a Tab folder  is
selected in the Project tab .

Button Name
Change button name and text

Command
Choose a command from the drop-down list, e.g. "Paste to Selected
Devices".
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6.3.4.14.12  Clip Summary Inspector

The Clip Summary Inspector opens when a container is selected in the
Sequence tab .

 

The container is highlighted with a blue outline.

Time
To change the start timecode of the clip, enter the new timecode using
the following syntax: enter e.g. 0:00:06:09 or just 609 to get the new time
0:00:06:09.
To just add e.g. two seconds to the current time, enter "++200", to
subtract e.g. two seconds, enter "--200".

Duration
To enlarge or to reduce the duration of the clip, enter the new duration using e.g. 0:00:12:00 or just 1200
to get the new duration of 12 seconds.
To just add e.g. two seconds to the current duration, enter "++200", to subtract e.g. two seconds, enter
"--200".

Clip Color
The Clip Color is the color the container is filled with. Per default it is gray. In case you set it to
"Transparent" it will be of the same color the Layer is set to (see Layer Color ). By clicking into the
color field a dialog opens where you can choose any other color for the container.
Note that in case you have chosen Clip Colors in File Inspectors , they are overwritten with individual
container colors. If you like to reset the container to be colored according to the File Inspector, click
"Reset".

All settings below the line are taken from the Clip Inspector .
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6.3.4.14.13  Clip Inspector

The Clip Inspector opens when a clip within a container is selected in
the Sequence tab .

The media track is highlighted in blue.
Note, that some effects have their own
media clip. Open the FX track and select

this media to see its properties and adjust for example a Pro Roll time.
When you select a mesh or object, you will see less options. When
selecting an audio clip there is one additional setting "Time Offset
Millisecs" that allows to offset the audio content.

Reset
This removes the content from the Container and places a "None" key
instead.

Time
To change the timecode of the start timecode clip, enter the new
timecode using the following syntax: enter e. g. 0:00:06:09 or just 609 to
get the new time 0:00:06:09.
To just add e. g. two seconds to the current time, enter "++200", to
subtract e. g. two seconds, enter "--200".
Note that the container itself stays on the same time. So by shifting the
clip, you just start with another frame when entering the container.
When you shift the left container border to the right, i.e. you crop the
container, the clip stays at the original time which has the same result

as shifting the clip to the left.
Empty frames are not possible, thus you can only shift the clip to the left, meaning that you start with a
later frame. The "Time in Clip" adjust according to your entry.

Time in Clip
Whilst the "Time" expressed the start of the clip regarding the absolute timecode, the Time in Clip
expresses the time relative to the clip beginning. So by default, this value is 00:00:00:00 as the clip
starts at the same time as the container. If you crop the clip container on its left side, this value will get
negative and shows you the starting time of your clip. You can change this value back to 00:00:00:00 to
let the video inside the clip start from its beginning.
Note that the "In" parameter also effects which frame of the clip is seen when entering the container. 

Lock to Time 
There are two different modes how a container clip is played back.To switch the mode, you can either

use the "Lock To Time" option in the Inspector or the toggle button
in the button bar displayed above the Sequence. The mode is
depicted by a small icon in the container.
Per default, "Lock To Time" is enabled. The clip icon is a clock. In
this mode, the clip synchronizes to the timeline. If the nowpointer
is paused inside the container, the clip playback is also paused. If
you have programmed video playback keys , the sequence

playback overrides them.

If you uncheck the option, the container is in "Free-run" mode. The clip icon is a running-stick-figure. In
this mode, the clip playback does not depend on the sequence playback mode. As soon as the
nowpointer enters the container, its video playmode keys (play once, play loop, pause, stop) take effect.

Loop
This option is only available with the Lock to Time option.
Per default, the Loop option is enabled which means that a clip starts again from the beginning in case
its container was extended manually and is now longer than the duration of the clip itself.
But imagine, you have a video on the timeline and after playing it back you like to keep the last frame as
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a still image on the screen. First, you increase the length of the container in the sequence, then you
select the container and untick the Loop check box. Now, the last frame is hold.

Pre Roll time
If the Pre Roll time is 0, the media clip is loaded into RAM as soon as the nowpointer enters the
container. The higher the resolution of the media is, or the more containers start at the same time, the
longer the loading process takes. To display the media faster, Pandoras Box can start pre-loading it
before the container actually starts. The Pre Roll Time defines the starting point ahead of the container.
The Pre-Roll Time can  overlap with a preceding container.

In, Out
When the nowpointer enters the clip, it will start/stop/loop at the given In- and Outpoint. These Playback
parameters  can be adjusted in the Device Control tab or by entering the exact frame count in this
Inspector. You can also enter a timecode value:enter e.g. 0:00:06:09 or just 609 to get the new time
0:00:06:09.
If you like to loop within the In- and Outpoint you can adjust the duration from the container easily: right-
click on the container > "Set duration to Main Media In/Out"
Delete the values in the Inspector to get the original value.
Please note that in addition to the In- and Outpoint you can start with a later frame by using "Time in
Clip" as explained above.

6.3.4.14.14  Cue Inspector

The Cue Inspector allows you to setup the following:

[Time]:
To change the timecode of the cue, enter the new timecode using the following syntax: enter e.g.
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0:00:15:09 or just 1509 to get the new time 0:00:15:09.
To just add e.g. two seconds to the current time, enter "++200", to subtract e.g. two seconds, enter "--
200".

[Mode]:
Available cue mode settings are: 
- Play: the timeline play status will stay the same when reaching the Cue (Timeline is playing = it
continues playing; Timeline is paused = it continues pausing)
- Pause: the timeline play status will change to "Pause" when reaching the Cue
- Stop: the timeline play status will change to "Stop" when reaching the Cue. This means that the
nowpointer stops and then jumps to the timecode 0:00:00:00
- Jump: when reaching the Cue the nowpointer will jump to the Jump Target entered and the timeline
keeps its previous play status
- Wait: the nowpointer will wait at the Cue for the Wait Time entered and then keeps on playing if it was
in play mode before.

[Name]:
By default the cue is named with its Cue ID as shown in the tool tip on top of a cue. A new cue name
may be entered here.

[ID]:
The numeric cue ID is increased for each new cue by default, this function may be deactivated in 
configuration tab . To change a cue ID enter a new one here. 

[Jump Target]:
Enter here the jump target timecode if cue mode is set to "Jump", using the following syntax: enter e.g.
0:00:15:09 or just 1509 to get the new time 0:00:15:09.
To just add e.g. two seconds to the current time, enter "++200", to subtract e.g. two seconds, enter "--
200".

[Repeat Count]:
Enter here the amount of iterations if cue mode is set to "Jump", 0=endless loop. If repeat count is set to
a number >=0, the jump cue will be executed this amount of times and then will be ignored to infinity.
The amount of remaining repeats are displayed in front of the Cue Name. When the timeline is stopped
(not paused) the repeat count will always be reset to the value entered here. To reset the Trigger Count
automatically after the last repeat, please check the option [Reset Trigger Count when Repeat Count
Hit].

[Reset Trigger Count when Repeat Count Hit]:
When this option is checked, the Trigger Count for the Jump Repeat will be reset automatically after the
last repeat.

[Reset Trigger Count]:
By pressing this button the Trigger Count will be reset manually to the value entered as Repeat Count.

[Wait Time]:
Enter here the time the nowpointer should wait on this cue before continuing to play. The remaining wait
time is displayed and highlighted in orange in the devices tab below the play, stop and pause buttons.
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Please note: 
It is recommended to leave 10 frames between two cues!

6.3.4.14.15  Parameter Keyframe Inspector

The Parameter Keyframe Inspector allows you to set up the following:

The left image shows the standard inspector for a keyframe.
The right image shows the multi-inspector of three keyframes that belong to a preset . 

Note the additional drop down menu where you can choose that keyframe the below information should
refer to. The keyframe's name in the menu consists of:
[2.1] - the site and layer ID it belongs to,
Opacity Event - the parameter it belongs to, and 
@0:00:00:05:15 - the time it belongs to.

Underneath the drop down menu you see the information that you have two more preset keyframes
selected.

Under the horizontal line the standard inspector lists all customizable control and property settings.
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- Name:
Informs you about the parameter's name the selected keyframe belongs to. In case the selected key
belongs to a preset, the preset's ID and name are listed as well.

- Time: 
To change the timecode of the key, enter the new timecode using the following syntax: enter eg.
0:00:06:09 or just 609 to get the new time 0:00:06:09.
To just add eg. two seconds to the current time, enter "++200", to subtract eg. two seconds, enter "--
200".

- Time in Clip
To change the Time of the key inside the clip, enter the new time using the following syntax: enter eg.
0:00:06:09 or just 609 to get the new time 0:00:06:09.
To just add eg. two seconds to the current time, enter "++200", to subtract eg. two seconds, enter "--
200".

- Curve Type: choose between Linear (Standard), Bezier, Bezier Corner, Constant and Stop. To edit the
curves please open the Curve Editor , here the different types are explained and illustrated.

- Value:
To change the key´s value, enter the new value or move the fader.

6.3.4.14.16  Device Inspector

The Device Inspector opens when a site (node) is selected in the Device Tree tab .
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[Site Name]
Change site/node name here

[ID Start]
Set up the numeric start ID

[Preview Offset]
Setting up the Preview  Offsets: apply an X and Y offset for the
global cam by typing in the value or by clicking in the black box and
moving the mouse cursor up and down. Press the Reset button to
set the Preview Offsets back to default.

[IP]
Edit the device IP address this site should refer to

[Spare from Spread]
Disables content to be spread to this device.

[Show Cursor in Fullscreen]
Enables to see the mouse cursor in the Client´s fullscreen window.
This is useful when working with Layer Picking in the Preview  or
with Clients. Instead of this option you may as well use a Pointer
Layer , giving you more options to influence the look of the mouse
cursor.

[Input Events Settings]
The pop-up dialog offers settings regarding the feature "Layer
Picking". In short, you can route input events like a mouse click to
Pandoras Box' layers, for example to execute links in a Browser
Asset .
The first option "Show Cursor in Fullscreen" conforms with the above
described option.
If you like to use Layer Picking on an output (instead of only in the
preview tab and the Global Cam), the left setting "Enable device"
must be activated, either for Output 1 or 2 or both.
The settings to the right routes the Layer Picking data to either a 
Widget Designer Device  and, or to the layers.
For more detailed information and a step-by-step example, please
refer to the chapter about Layer Picking .

To see the Input Event Settings for all systems in the Device Tree
combined in one dialog, right-click in the Preview tab and choose
"Show Input Events" there.

[Parameter Value Smoothing]
Edit the settings for Translation, Rotation, Scaling and Effect
Smoothing. Default is 500, the value range goes from 0 - 65535 (min
to max). It defines the time in milliseconds the object will need to
reach the given parameter value.
These settings only have an effect for all incoming data, like from the
fader of the device control, DMX, data from the Widget Designer, Art-
Net etc. The timeline behavior will not be influenced by these
settings.
The button "Individual Parameters" opens a dialog where you can set
the smoothing time for almost every parameter separately for each
layer.

239

248

605

271

633

248



210

The button "Open Engine Configuration" gives access to hardware
related engine settings especially influencing rendering performance.
Please refer to the chapter Configuration tab > Render Engine .

6.3.4.14.17  Video and Graphic Layer Inspector

The Layer Inspector allows you to set up the following:

[ID Start]
Numeric start ID

[Layer Color]
Per default each layer in the Sequence tab is displayed in
gray. Clicking into the gray field opens a color dialog
where you can choose a different color. Note that you can
also color a container .

[Include in Store Active]
Uncheck this option to exclude the layer from the Store
Active command.

[Mute External Input]
Tick this check box to block this layer from any external
input, like Art-Net, Input Data from Widget Designer etc.

[Layer Sizing Mode]:
Choose from the drop-down list how each layer should
handle the aspect ratio of the media files loaded into it. By
default the Layer Aspect Ratio is set to “horizontal and
vertical fit”. Examples are depicted below.
horizontal and vertical fit: the media file will be shown in its
original aspect ratio. Regardless whether the file is upright

or crosswide, all parts of the media file will be shown, see figure B.
horizontal fit: the media file will be shown in its original aspect ratio. It will fit horizontally into the layer,
see figure C.
vertical fit: the media file will be shown in its original aspect ratio. It will fit vertically into the layer, see
figure D.
fixed ratio: choose between the ratios 5:4; 4:3; 16:10; 16:9; 1.85:1. The media file will be stretched into
the defined aspect ratio when loaded, see figure E.
Media Pixel Size: this is a dynamic mode that depends on the translation factor set up in the
Configuration tab > Unit Management . For example, if you have an output with a width resolution of
1920px (and a height resolution of 1080px) the according translation factor is 8.333. Now, the Layer
Sizing Mode is based on 8.333 as well. If a 1920x1080px testpattern is assigned to a Layer, it will be
displayed fullscreen. A 1024x768px texture will be displayed with a border of 1920-1024=896 and 1080-
768=312. In case the Layers of a second Client with a 1024x768px output are set to "Media Pixel Size"
as well, the same texture is fullscreen whilst the first testpattern would be cut off.

[Render Layer in Pass]
The radio buttons "Composition" and "Output" toggle the layer between Pandoras Box' two render
passes. Per default, the layer is included in the composition pass - it will be part of the so called render
target and then be send through the entire output pass. It will be affected by its settings e.g. warp object,
keystone or softedge etc. If the layer is only part of the output pass, it will not be seen by the camera as
it is sent directly to the according output. In return it will not be affected by all the output settings and
can be placed outside the warped / softedged area. This is especially interesting when working with
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multi-softedged projection(s) and blacklevel compensation  is needed. Find more information in the
topic Video Processing Pipeline .

The check boxes "Output..." depend on the number of cameras / outputs. A Dual Server has two
cameras, for example, and you may decide whether a layer should be only rendered by one of them. A
possible application is working with different outputs for a key & fill scenario.

Examples for different aspect ratios:

Figure A: this is the original media file.

Figure B: Layer Aspect Ratio is set to "Horizontal and Vertical Fit". Regardless whether the file is upright
or crosswide, all parts of the file will always be shown in its original aspect ratio.

Figure C: Layer Aspect Ratio is set to "Horizontal Fit", the files aspect ratio is kept and it fits
horizontally into the layer.
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Figure D: Layer Aspect Ratio is set to "Vertical Fit", the files aspect ratio is kept and it fits vertically into
the layer.

Figure E: Layer Aspect Ratio is set to "4:3" and the image is stretched to this aspect ratio.

6.3.4.14.18  Pointer Inspector

The Pointer Inspector opens when a Pointer Layer  (used for Layer Picking )is selected in the
Device Tree tab .

[ID Start]
Numeric start ID

[Include in Store Active]
Uncheck this option to exclude the layer from the Store Active
command.

[Mute External Input]
Tick this check box to block this layer from any external input, like
Art-Net, Input Data from Widget Designer etc.

[Available Pointers]
Choose how many inputs should be substituted with the Pointer
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Layer. If you are working with an Windows XP system only one
input is possible, whereas Windows 7 and above is able to work
with multi-touch events.

[Render in Scene (Use for Softedge)]
Per default, the Pointer Layer is not included in the Composition
pass. Hence, it is not part of the so called render target and not
influenced by any Output settings, like warp object, keystone or
softedge etc. Find more information in the topic Video Processing
Pipeline .

6.3.4.14.19  Light Layer Inspector

The Light Layer Inspector allows you to set up the following:

[ID Start]
Numeric start ID

[Include in Store Active]
Uncheck this option to exclude the layer from the Store Active command.

[Mute External Input]
Tick this check box to block this layer from any external input, like Art-Net, Input Data from Widget
Designer etc.

[Shadow Map Size]
Choose from the drop down list how high the resolution from the light texture should be. By default the
Shadow Map Size is set to 1024*1024 px.

The example below shows the difference between 256 - 512 - 1024 - 2048 - 4096. Keep in mind that a
higher resolution uses more performance.
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6.3.4.14.20  Track Inspector

The Track  Inspector on the Manager allows you to set up the following:

- Set up the Numeric Start ID

- Include in Store Active: uncheck this option to exclude the track in the Store Active command

- Mute External Input:
Tick this check box to block the track from any external input like Art-Net, Input Data from Widget
Designer etc.

602



216

- Audio Channel:
Choose the channel of your ASIO sound card this track should be routed to. When adding an audio file
to the track, the first channel of the audio source will be routed to the sound card’s audio channel you
set up here (channel x). The second channel will be routed to the next sound card’s channel (channel x
+1) etc. Whether the sound file is mono or stereo, always at least two channels will be addressed. If you
want to hear a mono source only on one channel, turn PAN to the left.

6.3.4.14.21  Camera Inspector

The Camera Inspector allows you to set up the following:

[ID Start]
Setup the numeric start ID of the camera device.

[Include in Store Active]
Uncheck this option to exclude the camera layer in the Store Active command

[Mute External Input]
Tick this check box to block the camera from any external input like Art-Net, Input Data from Widget
Designer etc.

[Adopt Output Aspect Ratio]
Uses the aspect ratio of the site’s graphics card output as aspect ratio for the internal camera. 

The Output Aspect Ratio will be read out of the site’s graphics card and transferred when connected to
the Master device.
If this read-out is not correct, you may:
- overwrite the read-out data in the site inspector. This will change all camera and output devices of this
site to the new resolution after next start-up.
- overwrite single camera / output devices by removing the tick from the check box “Adopt Output Aspect
Ratio” and enter a new aspect ratio. 

[Enable Activate Matrix] 
This output will additionally be played out as matrix via Art-Net (only for camera 1).
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6.3.4.14.22  Output Inspector

The Output Inspector allows you to set up the following:

[ID Start]
Setup the numeric start ID of the output device.

[Include in Store Active]
Uncheck this option to exclude the output layer in the Store Active
command

[Mute External Input]
Tick this check box to block the output device from any external input
like Art-Net, Input Data from Widget Designer etc.

[Adopt Output Aspect Ratio]
Uses the aspect ratio of the site’s graphics card output as aspect
ratio for the internal output device. 

The Output Aspect Ratio will be read out of the site’s graphics card
and transferred when connected to the Master device.

If this read-out is not correct, you may:

- overwrite the read-out data in the site inspector. This will change all
camera and output devices of this site to the new resolution after next
start-up.
- overwrite single camera / output devices by removing the tick from
the check box “Adopt Output Aspect Ratio” and enter a new aspect
ratio. 

[Enable Input Events]
Tick the check box if you like to use the feature Layer Picking .

[Input Settings]
Choose whether you like to see the mouse cursor in the Client's
fullscreen window and how / where Layer Picking  should work.
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6.3.4.15  Media Encryption

Pandoras Box Media Encryption is a technology that encrypts media in order to protect content from
being played back by unauthorized persons or systems without permission.

ENCRYPTION

With a 
- PB Manager, 
- Editor or the 
- Server EDU version 
you can now choose to encrypt  media by generating two ASCII strings inside the Pandoras Box (PB)
interface. The Media Encryption is based on AES 256-bit technology similar to the DCI Digital Cinema
Standard, which means you will get the same powerful level of encryption that most governments use for
secret documents.
Currently, *.mpg (including *.mxl, *.m2v, ...) and *.wav files are supported. Encrypted media obtains the
ending .mpx or .wax.

DECRYPTION

Any Pandoras Box system is able to decrypt the media with the correct ASCII strings while playing it
back:
- PB Manager, 
- any PB Player and Server (stand alone or Client mode)

The content gets decrypted on the fly when being played back on the timeline or as an active value.
There is no decryption period beforehand, thus there is no decrypted version of the content on your hard
drive. Each frame needs to be decrypted (except the thumbnail). Only PB systems are able to
understand the ASCII string and decrypt the media !

Of course encrypted content cannot be exported using the Video Export  feature. In return it is
possible to encrypt an exported video itself.

POLICIES, KEYS AND MEDIA DONGLES

The encryption is based on two different ASCII strings - the key string and the policy string. At all times,
the end customer needs both to decrypt media.
The key itself encrypts the content. The media "remembers" which key can unlock it. If you encrypt the
same content with two different keys you will get two different encrypted files.
The policy holds meta information regarding the validity of a key. A key without meta information cannot
be used, in return, meta information without the key is useless as well. Currently the only meta
information is the time stamp, you can either decide to have no time restriction or to create a string that
can only validate the key for a certain time.
As described later on , it is possible to modify a policy, e.g. if you need to extend the validity. That
means that the customer keeps the same encrypted media file and the same key, only the policy will be
updated.
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In case of a time-based encryption, you can save and transfer the policy as a "digital policy" or as a
"dongle policy" meaning that it is written onto a Media Dongle. A Media Dongle may be purchased as
any other coolux product, please contact your local dealer.
Working with a Media Dongle will give you the safest encryption solution possible. The Media Dongle
holds the definite time reference itself and does not refer to the system time. The Media Dongle is more
secure in other terms as well. As seen in the image above, you can transfer the strings (key string and
policy string) in different ways to the customer, including the possibility to send both via email. In that
case you have no chance to control whether he sends them to somebody else as well. If you choose to
export the policy to a Media Dongle and send it via mail, the customer needs to have that special
hardware. You have created the necessity of a physical key which cannot be copied.

Example:
It is possible to create content, encrypt it once with a key and create two different policies, both being
allocated to the same key. Let´s say the unlimited policy is written onto a Media Dongle and a time-
based policy is a more simple "digital policy". You will then have one encrypted file, one key string but
two policy strings.
You may then send one media file, one key and one Media Dongle to the show operator. He will be only
able to play the content on a PB system if the Media Dongle is inserted. The other media file, key and
(time-based) digital policy goes to the customers in the event agency. They will be only able to play the
content on a PB system within a given time limit. They may as well send the key and policy to another
person.
Of course you can encrypt as many files as you wish with the same key. In this scenario it has the
following advantage: Now, as soon as the agency or the operator want some changes to be done, you
can encrypt new content with the key and send only the media files to the two parties, both being in
possession of the key and being restricted to their policy version.

Please note that currently only one Media Dongle per system is read and each dongle can hold only one
policy. Likewise only one digital policy can be assigned to each PB system. As a result,one dongle
policy plus one digital policy can validate two keys per PB system.

In the future it might be possible to create meta information such as a fixed MAC addresses etc. If you
want to contribute your feedback to this new feature please contact support@coolux.de.

The difference between a creator key / policy and an user key / policy is described in the following
chapter .

Media Dongle hardware specifications: 
- Battery Life Warranty: 4 Years
- Real Time Clock Accuracy (@ 25°C  +/- 5°C)  < 12.8 minutes/year
Consequentially, we recommend to factor 13 minutes per year into your time limits.
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6.3.4.15.1  Encrypting Media

To open the Media Encryption Tab, please click on 'Tabs' in the Toolbar - Media Encryption.
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In order to encrypt media files please follow these steps:

Key: Click „Create Key“ in the Media Encryption tab to generate a Creator Key .The appendix
"[Creator Key]" is automatically added to the given name.

Media: Now choose the media files (mpeg or wav) which are part of your project and add them to
the key via the „Add Files“ command. If you have chosen a file by mistake, select it and
click "Remove Files".

Encryption: Select the command „Encrypt“ to start the actual encryption. The "status" and "%" row
inform you whether the media is unencrypted, in progress or already encrypted with the
chosen key. As a rule of thumb, two minutes fullHD footage take 10sec to be encrypted.
Already encrypted files will not be encrypted again, there is no need to remove them from
the list.

The encrypted files (mpx or wax) are saved in the same sub folder on your hard disk as
the original files. Please note that another encryption with a second key will overwrite the
first file when the original file was not moved to another folder.
The encrypted files are automatically added to the project and will be shown in the list as
soon as you choose the used key via the drop down menu. The list helps you to keep an
overview and to allocate the key if you have forgotten it.

You may choose whether you like to encrypt the files before even assigning the policy.
This is because the key encrypts the media. The policy validates the key and has
nothing to do with the media itself.

Policy: In order to setup the time limit, please choose „Create“.
In the pop up dialog choose a Creator Key from the drop down list. This will join the
policy and the key. Metaphorically speaking it imprints the necessary meta information
on the key. Only then, the key is of value for the end customer.
A policy will always remember the key it was allocated to at last.

Time Limit: Choose if you want to have an unlimited policy or a time-based encryption.

How does a time-based policy work on a Media Dongles?
After having chosen a time restriction including the day and time, the time difference to
your local time will be added to the time reference on the Media Dongle, and later on from
the dongle to the customer´s time. This way the timeout is always calculated correctly
even if the system´s time has changed.

Key Delivery: It doesn’t matter which string you export first. For security
reasons there is no text file generated automatically on your
hard drive. Select the „Export Key“ button to generate the key
string. Click the "Copy" button and insert the string to a file of
your choice or into an email directly. The key is always
transferred digitally.

Policy
Delivery:

The policy string can be transferred as a "digital policy" or as a more secure  "dongle
policy":

To export the policy string and send it for example via email, select the "Export" button
and copy the string.

To write the policy string onto a Media Dongle, scroll further down to the list with "Active
Policies" and select the site the Media Dongle is attached to. Then click the button
"Assign" at the very bottom of the tab where it says "Change Dongle Policy On Selected
Sites". The list will update automatically and the column "Dongle" will show your policy.
In case there was already an older policy string, it will be overwritten by the new data.
The button "Clear" deletes the current policy from the dongle.
Now, you need to ship the Media Dongle to the customer and send the key via mail.
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At any time you may rename the key and policy, this does not alter the functionality! The button "Edit"
allows you to edit a policy before exporting it, you may either choose another Creator Key or  time-limit.

If you have created a key it is saved within the project and the appendix "[Creator Key]" is automatically
added to its name. After exporting a Creator Key it will loose this special status and will become a
regular key. 
What is special about a creator key? Only the „creator“ of a key can create a corresponding policy,
exchange it with another policy or prolong the time limit if necessary. 
As the creator of a key, you can always play the encrypted files – without a policy being required, even
connected Clients will play them back. A creator key can only exist within the original project, the key is
saved as a part of it. The project has to be kept/stored in case more files should be encrypted with that
particular key or in case a Client demands content updates.
When exporting the key and importing it into a new project it will not be a creator key anymore. A regular
key cannot be joined with another policy! The key will only be valid if the assigned policy is allocated and
still active. This counts even when there are no specific limitations saved. 

In general you can use any key in the system for encrypting media content, not just a creator key. Of
course you are restricted to the originally assigned policy when choosing an imported key. Without the
policy, no content can be played out.
Additional media files can be encrypted even later on using the same key as for the content before. As
long as the customer is in possession of the key and the policy, he will be able to play out content that
was encrypted at a later stage. In this case no update would be necessary.

Same distinction applies to policies. After creating a policy the appendix "[Creator Policy]" is added to
its name. Only creator policies can be edited and load (creator) keys, in other words imprint the time
stamp on them. After exporting a Creator Policy or writing it to a Media Dongle it will loose this special
status and will become a regular policy. A regular policy cannot be edited at all, except of its name. 

Please note: We strongly recommend to:
- use specified creator projects. If you want to use encrypted content yourself it is more secure to work
with projects not containing the original creator key but the exported key. 
- backup the creator projects to a separate place.
- keep encrypted content and the key and policy strings separate from each other.

It may be useful to create a data sheet to keep an overview which file was encrypted with which key
+policy and to whom it was sent. In addition you may want to create a folder on your (external) hard drive
where you copy the encrypted version to.



223

6.3.4.15.2  Decrypting Media

To open the Media Encryption Tab, please click on 'Tabs' in the Toolbar - Media Encryption.

In order to decrypt content you have to copy the key, the policy and the content to the project. The order
in which you go through these steps doesn’t matter, since the files can be played only if all elements are
present:

Key: Copy the string from the email or text file. Select „Import Key“ and click the "Paste"
command. After clicking "OK" the key string is imported to the project and spread
automatically to all connected Clients and to all Clients added to the project later on.
You may rename the key (and policy) at any time, this does not alter the functionality!

Policy: If you have received a digital policy via email or an text file, import it in the same way by
selecting the "Import" button. As policies are not spread automatically, you need to
assign them to each PB system. To do so:
- choose the particular policy in the policy`s drop down list
- scroll further down to the list with "Active Policies" and (multi-)select the site(s) where
you want the selected policy to be active
- click the button "Assign" at the very bottom of the tab where it says "Change Digital
Policy On Selected Sites". 

The list will update automatically and the column "Digital" will show the according policy.
If you have assigned a wrong policy simply choose another one in the drop down menu
and repeat the mentioned steps. 

If you have received a dongle policy via one or more Media Dongles insert them to the PB
systems which should be able to decrypt media. The dongle and its containing policy are
recognized automatically. The column "Dongle" in the list with "Active Policies" will show
the current status. As well the policy will be added to the drop down list "Available
Policies" in the PB Master (even though no dongle is attached there). The appendix
[From Dongle] informs you that it is no regular digital policy.

Now, on each PB Master and PB Client the policy recognizes imported keys and
validates the according one.

Please keep in mind that every system that has to decrypt media needs to have a valid
key, that may require a Media Dongle per each system! 
As soon as you would unplug a Media Dongle, assign a wrong digital policy, exceed the
allowed time-limit or remove the key in the Master, the system cannot decrypt any more
and either the preview or the fullscreen window will show a dummy picture instantly. The
dummy picture tells you whether there is an issue with the key or the policy status.

Media: Now drag the encrypted content into the project. The
content recognizes its key and can be unlocked. The files
are automatically added to the particular key list. If it
cannot find the correct key it will be substituted with a
dummy picture. 

The icons in the project tab tell you whether a file is
a) encrypted with a key / policy that is not part of the project, 
b) encrypted with a known key / policy 
c) not encrypted.
The status does not affect the functionality of spreading. E.g. the Manager will spread
encrypted content to all Clients, even though it is not equipped with a dongle-based
policy. Only those Clients with the correct key and policy will actually decrypt the media.

We strongly recommend not to change keys or policies during a show! Any change in a key or policy
status or Media Dongle connection will update all encrypted files.
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6.3.4.15.3  Updating a Policy

In case the key is allocated to a time-based policy it might be necessary to prolong it.

Client: Choose the policy you wish to prolong. Click the
command "Request Update". 
Copy the string and send it to the content creator. There
is no need to send the Media Dongle!

If you are working with dongle-based policies, please note that the string created for the
request holds not only information about the policy itself but also information about
attached dongles. While creating the request string, please be sure that all Clients are
connected and all dongles are plugged in if they need to be updated. Otherwise a
particular Media Dongle can not be updated later on without sending a new request
string! This makes the entire encryption process more safe.

Creator: Open the project with the
corresponding creator key
and creator policy. Copy the
string you received from the
end customer. Click the

button "Load Request" and paste the string. The information line tells for how many
Media Dongles the update will be valid and eases to keep an overview.
Choose the policy the customer wishes to extend and click the button "Edit". After
entering new limitations click the command "Export Update". Copy the string and send it
to the customer.
The button "Clear Request" simply discards the request information. Please note that
you cannot export an update string without loading a request string. Your customer
needs to generate that request string first hand.

Client: This time you click the button "Import Update" and paste the update string you received
from the content creator. 

The policy status from all systems in the entire network is updating automatically.
If one Client is not online whilst updating it will receive the prolonged digital policy as
soon he is connected to the Master system.

In case you are working with dongle-based policies, the dongle data is automatically
overwritten with the new policy. A pop up lets you know if all dongles (that were part of
the original request) can be reached and updated. You may continue updating even
though one Media Dongle is missing. As the update procedure can be executed
repeatedly, simply import the update as soon as the dongle is available. Meanwhile the
policy will not only be listed with the appendix "[From Dongle]" but also with "[Variant]" in
order to inform you about different time limits within the network.

6.3.4.16  Patch

The patch tab lets you assign an Art-Net and DMX input & output patch for individual devices.

Please note:
All Pandoras Box devices and sequences are patched to DMX input and all DMX devices are patched to
DMX output.

The patch tab is context sensitive, please first open the patch tab and then choose a device to be
patched from the device tree.
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The patch is divided into the
following section:

Site Patch
Sequence Patch
DMX Start Address

6.3.4.16.1  Site Patch

Within PB V5 there are two different patch configurations available:

- Standard Configuration and

- Lighting Console Configuration.

These two configuration types may be chosen when

- Creating a new project (see File Menu )

- Adding a site via the Device Types Tab  into the project.

STANDARD CONFIGURATION

In the Standard Configuration there is no parameter patched by default, no FX are added to the layers.
When no parameter of a layer is patched, there is just an empty check box in front of the DMX Channel,
Subnet and Universe settings.
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When double-clicking on a layer / device you will see the parameters / parameter sections belonging to
this layer.

All parameters may now be patched manually by ticking the parameter’s check box and entering the
DMX start address.

By pressing [Autopatch Selected] you may patch one or several whole layers / devices.

[Autopatch Selected]:
Select the layers/devices you want to patch. Do this with the Windows standard selection method:

To select several devices click on the first one so that it is highlighted in blue, hold [CTRL] pressed while
selecting more devices one by one or hold [SHIFT] pressed and click on the last device to be selected.
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Example:

Press [Autopatch Selected]. A pop-up window appears.

You may now tick the check box several times to activate different parameter activation settings:

  = the current parameter selection will be kept

 = all parameters will be unpatched

 = all parameters will be patched.

The DMX start address that is set by default (starting with Ch. 1, Art-Net Subnet 0, Universe 0) may be
changed by entering a different DMX start address. All devices selected will be patched according to the
patch mode you set with the check box.

Going on with the example, the pop-up window is set to patch all parameters, beginning with the DMX
start address: DMX Channel 1, Subnet 0 and Universe 4, see image below.
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The patch tab now is patched like shown in the image below. 

All selected layers are patched one after each other, according to the amount of parameters (see DMX
patch tables ). When there were FX added to the layer before patching, the amount of parameters will
be higher. When adding FX to a layer after the patch was done, these FX are not patched. This needs to
be done manually.

LIGHTING CONSOLE CONFIGURATION

In the Lighting Console Configuration there are specific parameters patched by default, see DMX patch
tables , others, like i.e. Scale Pivot are not patched. 

Different to a site added in STD mode, the Video and Graphic layers of sites added Lighting Console
Mode contain multi-effects by default.

The patch appears with check boxes that are ticked but grayed out. This means that there is a mix of
patched and not patched parameters in this layer, see image below.
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If expanded you will see that some parameters are patched, others not.

If you need additional parameters patched you may do it manually by entering a DMX start address and
ticking the check boxes or use the autopatch function like described under “STANDARD
CONFIGURATION”.
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6.3.4.16.2  Sequence Patch

When selecting the sequence folder in the project tab, the patch tab shows all available sequences
within the project.
The sequences may be patched just like the site patch is done.
See the sequence DMX tables .

6.3.4.16.3  DMX Start Address

See here some hints for the DMX start address.

- Channel: 
Enter here the DMX start address for the device.

- DMX Universe
Enter here the DMX Universe address. As the Pandoras Box patch is related to Art-Net, you have to
enter two numbers in the text fields. 

Art-Net Patch: the first text field is the Art-Net Subnet, the second one the Art-Net ID / Universe.

MA-Net Patch has to be translated to Art-Net addressing. 

Please see the following translation chart:

Grand MA Patch Pandoras Box Patch

Universe.Channel Ch. DMX Universe

1.1 1 0 : 0

2.1 1 0 : 1

3.1 1 0 : 2

15.1 1 0 : 14

16.1 1 0 : 15

17.1 1 1 : 0

6.3.4.17  Multi-User

The Multi-User tab allows to setup the Multi-User feature and gives an overview on all Places (i.e. Multi-
Users) online with their IP address and network name. The tab is not contained in the default view. To
open it, go to the Menu Bar and choose Tabs > Multi-User.

647
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The Multi-User Feature in General

Pandoras Box version 6 introduces the Multi-User feature allowing
several operators to work on the same Master file loaded with a
Manager license. As the ways to build shows with Pandoras Box
are so versatile, Multi-User editing is a flexible feature. This means
that you can choose what exactly you would like to synchronize
and how often or when you like to do so.
As soon as another Manager is in the same LAN network (and

Domain) it participates as another Multi-User. The new tab Multi-User allows to setup the Multi-User
environment and gives an overview on all Users online.

The first possibility for Multi-Users is to work in a "Sync Session" where all changes are synced
continuously and seamlessly between all Users. However, you can also activate the "Blind Mode" within
the Sync Session for working with an independent Nowpointer and Active Values. This allows you for
example to jump to "your" time in the Sequence to store content or to view content in the Preview.
You can leave and (re-) join the Sync Session at any time. When joining a Sync Session you are asked
to load the session project. 

Alternative to (fully or partly) synchronized programming, you can work asynchronously in a separate
project and send ("push") your changes at a certain time, e.g. checked or newly encoded content, warp
and softedge settings, parts of a Sequence, etc. The "Run Operation" button in the Multi-User tab opens
a dialog to define these Pull and Push Operations.

Note also that the Configuration is newly structured. All settings that are listed in the Global category
apply to all Multi-Users whilst the other ones apply only locally.

Setting up a Sync Session

This Multi-User tab shows that there are two Places as two Users are online. They are in the same
network, share the same Domain and the Manager is started.

Multiple Managers in the same LAN network (and Domain) participate automatically as Multi-Users. Now
they have the choice to work in a Sync Session. As a possible scenario for a Sync Session, imagine, for
example, that one operator is assigned to the Warping job whilst another one previews and arranges
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content in the Project tab and a third operator wants to setup the connection to Clients and their output
resolution.

The first Manager (from now on the Main Manager) clicks the button "Start Session" in the tab. All
Clients will automatically connect to the Main Manager. His project becomes the so called Session
Project.
All other Managers have then the option to join this session. 

When they do so, they are asked to
load the Session Project and
become Sub Managers. A Sub

Manager can control a Client but the connection is through the Main Manager. Important note: If a Sub
Manager chooses the command "Take Over All Sites in Domain" (from the Backup Menu  or the
Assets  tab) he will become the Main Manager!
Sub Managers can leave and (re-) join the Sync Session at any time. Please note that other Users are
not notified if somebody leaves the session. The Multi-User tab shows the status next to each system,
e.g. "in Sync Session".

In short: the Main Manager is connected to the Clients and hosts the Sync Session. As described
below, he cannot enter the Blind Mode.

Within a Sync Session all changes are synced between all Users, including the:
- Device structure (for the Device Tree and Sequence),
- Sequences (with all Containers and Cues),
- Resources (meaning folders and content in the Project tab),
- Active Values and Sequence Playback (if not in Blind Mode).

Tip: In a Multi-User setup you might not want to spread all content to all Managers. First, deactivate the
Auto-Spread option in the Configuration tab > Resources . The right-click menu in the Project tab then
offers options to spread content or folders to specific sources. In addition, the Folder Inspector  offers
spread options.

Blind Preview and Blind Programming

As explained above, all project data is synced in a Sync Session. If you like to
detach the Active Values and Playback status (including the time for the
Nowpointer), you can activate the option "Blind Mode". Note that this option is only
available for Sub Managers (those that join an existing session).
Now you can use the partly synchronized Manager as a Blind Preview system or a

Blind Programming system. It is for example possible to change the timeline to the next cue and preview
or verify the content. Or you can edit the scene by activating parameters and storing them to the timeline
without interfering with the current output of the show. However, you need to make sure to not work at
the time from the Main Manager's Nowpointer! Note that content spreading also uses performance on the
Main Manager.
When the Blind Mode is activated, the Multi-User tab of other systems will display the status: "In Sync
Session" and "Is in Blind Mode".

Local and Remote Active Values

With the possibility to synchronize active values, the necessity
arose to distinguish local active values from remote active values.
If active values are synchronized, their effect in the Preview is
visible for all Multi-Users. However, the programming behavior is
different and the GUI display reveals their origin:
Local active values are highlighted in red whilst a remote active
value is colored in beige / yellow.
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All "Store Active" commands will only store red local active
values!

You can right-click on a Parameter / Layer / Client and choose to
either "Reset" (respectively "Reset All Active from Remote" or to
"Take over Activity" in order to adopt them to local active values.

Note that the tab "Active Values" displays local and remote active
values without distinction.

Remote active values can only exist in a Sync Session without an activated Blind Mode. Hence, they
dis-/appear when you toggle the Sync Session state or the Blind Mode on or off. In addition red local
active values may change. Please see the following diagram.

Saving and Loading Synchronized Projects 

When starting with all Users on another day, the Main Manager loads the project and starts the session
again. All others can then join it as usual. This option is also included in the Start-up dialog. Note that
the saved project data does not include information about other Users.

Asynchronous Programming

So far, continuous synching was explained. For some events however it might be more convenient to not
sync every small step but to work asynchronously, at least for a certain time until a more or less final
state is achieved and should be shared.
Before you begin, it is recommended to decide for a hierarchy as it makes sense that there is a leading
Manager to which all others send their selected project data.

First, decide whether you want to work in a separate project or whether you like to start with the same
project that includes for example already some Clients with named Layers and some Resources in the
Project tab. For the later case, there are two possibilities. First, you can open a Sync Session as
described above and leave it again after having synced the project once. Alternatively, one Manager
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loads the project. All other Users open the Multi-User tab and click on the "Run Operation" button
depicted next to the network address and name of this Manager. This opens the "Edit Multi-User
Operation" dialog where the drop-down menu offers the possibility to "Pull Project" which copies the
project to the local system. 

Now every operator can work in his own project and click the "Run Operation" button whenever he needs
to.

Run Operation

Whenever an operator likes to distribute (parts of) his work, he clicks the "Run Operation" button
depicted next to the network address and name of another Manager. This opens the "Edit Multi-User
Operation" dialog where the drop-down menu offers the following possibilities:

Operation Description

Pull Project Load the currently opened project from another system.

Push Project Send your currently opened project to a another system. The chosen system
loads the project without asking to save its own current project.

Pull Sequence Choose a remote system and a Sequence ID. The other Sequence is added to
your sequence folder in the Project tab, meaning that it might get a new ID. 

Push Sequence Choose a Sequence ID and  remote system to send it to. The other system adds
your Sequence to its sequence folder in the Project tab, meaning that it might get
a new ID.

Push Sequence
Section

Send a part of your Sequence to another system. You can define the source
Sequence ID, and whether Cues are included or not. You can send the entire
Sequence ("No Filter") or a part which can be defined with a starting and ending
Cue or with Devices. In the Device dialog you can multi-select using the SHIFT
and CTRL key. Regarding the receiving system you can choose the remote
Sequence ID and whether your data should be added at a certain time or Cue.

Transfer
Resources

Choose a remote system to view its content tree next to your own content tree
from the Project tab. You can now drag and drop files and folders from left to right
and vice versa.



235



236

6.3.4.18  Playlist

A Playlist offers the easy and fast possibility to play a certain number of media files in a row without the
need of programming separate containers on the sequence. 

Adding, deleting and reordering content in the Playlist

In the Project tab's right-click menu , you may find the command to add a Playlist. In order to add
media files to it, select the Playlist and look for the new tab "Playlist"  (next to the Particles tab). You
may as well click the "Show in Playlist Tab" button in the Playlist Inspector.

Now you may drag and drop from the Project tab into the Playlist tab:
- images
- image sequences
- videos
- audio files

Each newly dragged resource will simply be added at the end of the list (even when the Playlist is
already playing back). If you like to put the files in another order, (multi-)select an entry and drag it
between to others or assign a different "Index" number. Deleting files is possible with the Delete key on
your keyboard or by choosing the respective command in the right-click menu. 

Duration and other settings in the Playlist

The duration of images is automatically set to 10 seconds; all other media keeps its real duration. You
may change the duration, fade time and transition effect - again, multi selection applies the chosen
setting for all selected items. Further to the right you find "In" and "Out" times that take effect on videos
or audio files only and define the starting and ending frame. Notes for internal use can be added too.

The overall duration of all files minus the fade times result in the length of the Playlist. The fade times
need to be subtracted as fading two files is obviously shorter then playing them back one after another.
The duration is displayed in the Playlist Inspector . It offers general settings like Folder and File ID,
resolution or aspect mode.

Assigning a Playlist to a layer

As a last step, the Playlist needs to be assigned to a video layer. You may assign it as an active value
or program it on the timeline as one single container. Please note, that you may assign the same
Playlist to several video layers. Then the playback status can be different per layer, e.g. one layer can be
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in pause mode showing the file with index 5, the other in play mode between index 10 and 11. The
Playlist tab offers a drop-down menu containing all layers the Playlist has been assigned to. Depending
on this drop-down menu, the Playlist changes and displays the layer's playback mode and the currently
active index file with a green highlight. In the image above the chosen Playlist on Layer 1 is currently
fading between two images.

Please note that not only during the cross-fade the Playlist consumes the memory for the current and
the following content file, thus it needs the same performance as assigning the assets separately to two
layers!

6.3.4.19  Preset View

The preset tab lets you create, edit,  paste and apply presets in a browser view. To open a preset tab,
navigate to Tabs - Presets and choose one of the preset banks to be shown in the tab. You may as well
make a right-click on a preset type in the project tab and choose "Open Browser".

Please note that the preset feature itself is described in the Preset  chapter.276
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The context menu of the preset view provides the following
options for creating and organizing presets:

[Create Preset]
Creates a snapshot preset by looking at the current active
values and copying them as a preset key (at zero time)
according to the current preset bank.

[Remove]
Deletes the entire preset bank and all including presets. A new
preset bank can be created in the Project Tab

[Export]
Saves all including presets as an xml file.

[Import]
Adds the previously exported presets to the preset bank.

The context menu of the preset itself provides the same
options for creating and organizing presets as in the project tab
(except the rename function):

[Apply (Selected Devices)]
Applies a preset, starting at the first selected layer and
activates those layer parameters that are stored inside the
preset. The values are nor inserted into the timeline.

[Paste Keys (Selected Devices)] or make a single left-click on
the preset
Creates a new instance from the preset by pasting its keys the
into the currently open sequence starting at the first selected
layer.

[Revert All Preset Instances]
Discard the changes made in one or more instance and make
them all comply with to the master preset again.

[Store Active]
Stores all active parameter values to the preset that are
allowed to be stored in this preset type.

[Store Active (Selected Devices)]
Stores all active values of the selected devices to the preset.

[Remove]
Removes the preset.

[Export]
Saves all including presets as an xml file.
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6.3.4.20  Preview

The Preview tab renders your programming. Further, you may edit Layers, Cameras, Meshes etc.
directly in the Preview.

With version 6 we introduced new powerful features and enhanced the structure of the Preview by adding
buttons and drop-down lists around the main window. They call....
Modes: These buttons are fixed, each mode is covered in the linked chapters.
Tools: These buttons vary because they depend on the chosen mode.
Views: These options are fixed and influence what the Preview displays, e.g. multiple view ports with 
Camera and Output views .

Modes          Tools View                                           

    
 

Layer

Camera
Transformation

Picking

Canvas Editing

Mesh Editing

Planar UV Mapping

Perspective UV
Mapping

Per default, the Preview tab is part of the main user interface. However, you can also choose to
work in a maximized Preview. The according bottom left button or the shortcut [CTRL+SHIFT+F]
toggle your Preview tab to a fullscreen window. All tools, modes and view options are available
within the Button Bar (shortcut [T] to show and hide it). In addition you can navigate  and use the
mouse cursor as usual. Each Master (Manager or a Server / Player in stand-alone mode) offers this
feature.

Servers and Players (in stand-alone mode) offer an additional function as their Preview is also their
Render Output. As this is not the editable Preview anymore, there is no Button Bar etc. and you
cannot switch views. Use the according top right button  or the shortcut [CTRL+F] to toggle to
fullscreen. 

In case you work with multiple displays, you can choose your display adapter within the
Configuration tab > Local Preview (also accessible through the settings button ). More Preview
settings can be found under Configuration > Preview Display.

Note that the Preview window is protected with a watermark. It only appears in the Preview, never in the
Output! 

If working with Art-Net LED walls, you can toggle the patch on and off with the "Select Matrix Mask"
command from the Previews context menu .
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Important information about the Preview

First, the Preview of the Master renders the content from all Clients in full quality. To render efficiently,
you can decide which Client(s) are included in the Preview. The next chapter  explains how to toggle a
Client's Preview on and off. This is of interest in case you work with many Clients and / or content with
high resolution, frame rate,etc..

Second, in case you work in a Master-Client setup, content needs to be copied to all hard drives. If the
Master is missing the content, its Preview cannot render it. If the Client is missing the content, its output
cannot render it even though the Preview shows it. The Preview does not provide a real-time feedback of
the Client's outputs!

Third, the Preview allows you to pre-program a show without having Clients connected (yet).

Forth, there are a couple of Preview "sizes". Per default, the 

The next chapters:
- let you know how to include Sites into the Preview
- explain the different Camera or Output views
- describe how to zoom, pan and rotate  the Preview
- explain what wireframes and pivot handles  are for
- inform how you can use the and Preview as an interactive interface with pivot handles  (Layer Mode
and Camera Mode) and Layer Picking  (Picking Mode)
- cover the advanced Preview Modes:  Canvas Editing Mode  for drawing and masking, Mesh Editing
Mode  for warping and last, Planar and Perspective UV Mapping Mode  for texturing
- describe the context menu from the Preview

6.3.4.20.1  Including Sites into the Preview

This chapter explains how to toggle Sites to the Preview. For other topics regarding the Preview tab
please see the introductory chapter .

Per default, a Site (i.e. a Server or Player) is not included in the Preview when added to the project. The
left image shows the Device tab  with a Site excluded from the Preview; note that its icon is not
highlighted.

 

To add a Site to the Preview rendering, right-click it to open the context menu and choose “Toggle
Preview”. Now, the icon is highlighted in blue as seen in the right image.

Please note: In order to see the Client(s) in the Preview, the Master needs to render their files. It does
not scale the content in any way! That means that the full content needs to be encoded and displayed.
The more Clients you add to the Preview tab, the more content files are playing, the higher the content's
resolution or frame rate is, the more performance is required on the Master PC. Please remember to
spread the content to the Master and the Client likewise.
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The next chapter explains the preview views . For example you can load a Site's Camera or Output
into the Preview or you can preview all Sites at once with the "All Cameras" view.

6.3.4.20.2  Select Preview: Camera or Output View

This chapter explains the views for the Preview. For other topics regarding the Preview tab please see
the introductory chapter .

You can load various views into the Preview tab, there
are three ways to do so:
- open the upper right drop-down menu "Select
Preview"
- right-click in the Preview and select "Select
Preview"
- right-click on a Camera or Output layer in the Device
tree and select "Load in Preview"

The "All Cameras" view is always available but the
Camera or Output view(s) depend on the Sites (i.e.
Server or Player) added to your project. One Compact
Player adds one Camera and one Output to the list, a
QUAD Server adds four of each.

The left image is an example for the "All Cameras"
view. It allows previewing all included Sites at once.
Furthermore the whole 3D space is shown instead of
only the specific area seen by the Site’s Camera
device.

The next chapter explains how to navigate in the
Preview tab .

Per default, Camera targets are shown as white
rectangles with a label hovering above it naming the
Camera Layer and resolution. Resolution and aspect
ratio can be changed in the Inspector of the Camera

, whilst Camera position etc. can be changed in
the Camera Device .

In addition to the rectangle you can toggle more
wireframes and handles. This is explained in one of
the next chapters: Preview handles and wireframes

.

The Camera view shows what a Camera from a Site
"sees", that is the so called render target or
Composition pass. The render target is forwarded to
the Output Pass where Output parameters like
Softedge or Warp can change it. Hence the Output
view shows the final result, the so called backbuffer,
that is also output through a Client's graphic card
output. The chapter "Video Processing pipeline"
explain the render passes in more detail.

The left image shows the left Camera from the scene
depicted above.
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By the way, renaming Cameras and Output Layers in
the Device Tree also changes their names in the
drop-down menu.

 

When working e.g. with LED walls
that are controlled via Art-Net you
can choose to preview the Art-Net
output instead of the video (e.g.
DVI) output. Whilst being in the
Output (!) view right-click and

select a matrix mask. To use the matrix feature you
first need to create a patch in the Matrix Patcher
and export it to your Pandoras Box project. Drag the
new format ".pbx file" on any Output Layer . Now,
you may choose to preview it. Right-click in the
Preview > Select Matrix Mask > Dark or Black
outside of Patch. Dark Outside of Patch dims the
area not covered by the patch whilst the Black option
does not display it at all. Choose None to see the
entire area without the highlighted patch.

The Preview of version 6 can be toggled to a Multi-
View window. Per default you see one view port as
usual, but now you can also choose to work with a
split view with 2, 4 or 8 view ports in various arrays.
If you have loaded the "All Cameras" view before
toggling to more view ports, the newly created ones
will show "None"; in case you have loaded a Cameras
(or Output) view, the newly created windows will
automatically show other Camera (or Output) views if
they are available. Of course you can change each
view port individually using the drop-down menu.
Please note that for the time being it is not allowed to
view a Camera and the corresponding Output at the
same time. Another restriction in this version is that
one view can be loaded into one view port only. In
other words, the "All Cameras" view or "Camera 1"
can not be depicted twice.

Independent from the number of view ports, it is
possible to maximize the Preview to full screen. This
is especially of interest in case you warp several
Outputs in the Manager using the Editable Mesh
feature.
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Previewing different Camera offsets

In the example below a softedge projection with 4 outputs is shown (the 4 Cameras have different X-
offsets).

When changing the Preview to show the single cameras, each one would show its area according to the
wireframes:

Camera 1 Camera 2 Camera 3 Camera 4

Previewing several Clients with equal Camera offsets

Having Sites that run separately from each other (with no X / Y Camera Offsets), the Sites outputs will
overlay in the Preview by default. The output at top is from the Site that was added to the project at last.
In the Inspector of Site 1 and Site 2 the Preview Offset may be changed. This way both Sites can be
shown at the same time.

When changing to the All Cameras view, only Site 2
is visible, because it was added to the project at last,
it overlays the Preview image of Site 1.
In the Device Tree tab select Site 1 or 2 and turn over
to the Inspector...
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...and modify the Preview Offset of a Site by 

(1) entering X and Y values manually in the text fields
or 
(2) click in the little black box and move the mouse
while holding the left mouse button clicked.

Image left: having different Preview Offset values
applied to the Sites allows you to see both at the
same time.

The next chapter  explains how to rotate, pan and
zoom within the Preview tab.

6.3.4.20.3  Navigating in the Preview

This chapter explains the navigation in the Preview. For other topics regarding the Preview tab please
see the introductory chapter .

Within the Preview you can look at your composition from any point: you can zoom, rotate and pan. You
can do so in the All Cameras view as well as in a Camera or Output view. Views are explained in the 
previous chapter .

For zooming use the mouse scroll wheel.

For panning keep the middle mouse button (scroll
wheel) pressed whilst moving the mouse. Panning
changes the Viewpoint and Target at the same time

For rotating keep the middle mouse button (scroll
wheel) and the [Alt] key pressed whilst moving the
mouse. Rotating the view changes the Viewpoint only.

Per default, the Camera Interaction Mode is set to
"Zoom". As soon as you change the view, e.g. rotate
it, the Zoom button is highlighted in orange. The R-
button applies the default view and resets your
changes. The same happens when you use the
shortcut [CTRL+0] or choose the command "Reset
Camera" from the right-click menu.

The other Interaction Mode, "Parameters", is of
interest when you are in a Camera or Output view.
Any view navigation is now represented in active
Viewpoint and Target parameters, hence can be
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stored to the timeline. Obviously, the according
Camera or Output Device needs to have Viewpoint and
Target parameters available. In this mode, only the R-
button resets parameter changes.

The next chapter  explains what Gizmos and Camera Frustums are ...

6.3.4.20.4  Gizmos and Wireframes in the Preview

This chapter explains the various handles that can be rendered in the Preview to help you in your
programming. For other topics regarding the Preview tab please see the introductory chapter .

The left image shows the Preview with only the layers visible.
For the right image all handles are turned on:

- Gizmo
In the example, the Gizmo is depicted on the Layer with the red cone. It is the icon with
three axes in the colors red, green and blue. Many objects in Pandoras Box have a
Gizmo: Layers, Cameras, Mesh points, etc. but they all work in the same way.

Enter the Layer Mode and click the "Gizmo Visibility" button . Now, activate the
Move Mode and change the Layer's position by dragging one of the axes. Note that the axis highlights
as soon as the mouse cursor touches it. When the mouse touches one of the corners (e.g. the yellow
one) both associated axes highlight (red and green).

A Layer can be moved, rotated and scaled and each transformation has its own Gizmo. The center of
each Gizmo marks the Layer's Pivot Point for the selected transformation. For more information see the
next chapters about the Layer and Camera Transformation Mode , the Rotate  and Scale Mode
and the Pivot .

As said above, not only Layers have Gizmos. Depending on the mode you are in, the "Gizmo Visibility"
button toggles Gizmos from other objects.

- (Camera) Frustum and Wireframes

In the Camera Transformation mode the "Camera Visibility" button 
toggles the Camera icon and the Frustum to visualize the opening angle and
Look-at point. The Frustum includes the Camera Wireframes (here in white)
and Area (in blue) plus the name (also blue). The Frustum's appearance can

be changed in the Camera Inspector tab .
A Camera can be moved with the Gizmo in the same way as described above. The blue highlighted
Camera area can also be dragged.

The "Camera Visibility" button can be found in the Layer and in the Camera Transformation Mode. In
case the Camera Frustum Visibility is toggled off, only the blue rectangle and name is shown. To switch
these items off, please go to the Configuration tab > Preview Display .
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Following the Camera's visualization, a Light Device  has its own icon and Frustum. The style can be
changed in the Light Inspector . The visualization is not influenced with the "Camera Visibility" button
but can be toggled in the Configuration tab > Preview Display .

The next chapter explains the Layer and Camera Transformation Mode .

6.3.4.20.5  Layer Mode and Camera Transformation Mode

This chapter explains how to interact directly with Layers and Cameras in the Preview. For other topics
regarding the Preview tab please see the introductory chapter . The chapter "Navigating in the
Preview"  explains how to pan, rotate and zoom the Preview. All keyboard shortcuts are listed on the
Shortcut  page.

 

The Layer Mode allows to select, move, rotate and scale Layers directly within the Preview interface. For
further Layer interaction please see the next chapter about "Layer Picking" .
The Camera Transformation Mode allows to select and move Cameras directly within the Preview
interface. Please go to the "All Cameras" view  first.

In both modes you can:
- move the selected Layer or Camera; Layers
can also be rotated and scaled
- open the dialog "Parameter Floater" showing
the parameters from the selected Layer or
Camera
- set a constraint, e.g. an activated (blue
highlighted) X constraint transforms along the X-
axis only
- toggle the Layer and Camera Gizmo

Layer Mode

First of all, please go to the "All Cameras" view  and then activate the

Layer Gizmo , the button should be highlighted in blue.

Select a Layer by clicking on it in the Preview or the Device Tree. Now, the
handles for the X, Y and Z-axis of the selected Layer are shown in the
Preview, as seen in the left image. The so called bounding box and the
Device ID of the selected Layer are shown as well in dark blue (in this
example: device ID 1.1).

Now, choose whether you would like to move, rotate or scale the Layer
(shortcut [1],[2],[3]) by clicking on the according button above the Preview.
Click anywhere on the Layer and drag it. Note that the transformation is
applied in the XY-plane. When holding the [SHIFT] key, the transformation

will be applied along one axis only. For example if you move the mouse from left to right the X-axis is
taken but as soon as the up-down movement is greater, the Y-axis is taken.

606

213

152

246

239

244

316

248

241

245

241



247

If you now position the mouse pointer on one handle of the Gizmo, it is highlighted in orange. Dragging
the mouse results in a transformation along one axis. You can also work in another plane by highlighting
one of the corners shown in magenta, cyan and yellow.

As an alternative to working in distinct axes, you can apply constraints. With an activated X Constraint
(shortcut [X]) the Y and Z-axis are shown in gray and any transformation happens along the X-axis only.
Please keep in mind that Servers have 3D but Players 2D parameters.

For the Rotation  and Scale Mode  you can also change the Pivot point. Drag the Layer whilst
holding the [ALT] key. The topics about the Rotation Pivot  and Scale Pivot  show how a moved
Pivot affects the transformation.

To multi-select several Layers, press [CTRL]. 

The Parameter Floater
(shortcut [Ctrl+P])
shows the most
important parameters
from the selected
Layer. Of course they
are synchronized with
the Device Control tab

. You can choose
to see the parameters
for Media Control,
Position, Scaling or
Rotation.

Camera Transformation Mode

First of all, please go to the "All Cameras" view  and activate the
Move mode.
If you now click on the Camera rectangle it highlights blue and you
can drag it around. This changes the X and Y Offset parameters.
Note that constraints work in the same way as for Layers. When
holding the [Shift] key, the transformation will be applied along one
axis only. For example if you move the mouse from left to right the X-
axis is taken but if the left-right movement is smaller than the up-
down movement, the Y-axis is taken.
Alternatively, you can apply constraints with the X,Y buttons.

Cameras of a Server have more parameters available: the Viewpoint
 and Target  XYZ position. First, highlight the "Camera

Visibility" button  and the Camera Gizmo . Now you can
either drag the Camera icon around which influences the Camera
Viewpoint and Target simultaneously, or you can drag the Viewpoint
and Target separately. Hold the [ALT] key down to move the
Camera / Viewpoint only and the [ALT] and [SHIFT] key for the
Target. The interaction with the Gizmo works in the same way as for
Layers.
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The Parameter Floater (shortcut [Ctrl+P]) shows the parameters of
interest for the selected Camera. Of course they are synchronized
with the Device Control tab . You can see the parameters for Lens
Shift and for Serves also the Viewpoint and Target.

The next chapter explains the Picking Mode .

6.3.4.20.6  Picking Mode

This chapter explains the (Layer) Picking
Mode of the Preview which allows to use
content as an interface, i.e. interact
directly with it. To give an example,
Layer Picking can be used to execute
hyperlinks in rendered web pages, so
called Browser Assets . For other
topics regarding the Preview tab please
see the introductory chapter . If you
are interested how you can use the
Preview's interaction data to draw on a
Canvas asset, please see the next
chapter "Canvas Editing Mode" .

Layer Picking "captures" the position
from the mouse pointer and if the mouse is moved in your Master's Preview tab or the Client's fullscreen
window the feature recognizes what layer is touched and where exactly on the layer the mouse is
located. A layer can now be used as a true interface as mouse clicks can be passed through.
The term "mouse pointer" actually does not only refer to a mouse device but to any device that is
recognized by the operating system as a pointing device and can send these input events. This includes
for example an AirScan  or a touch screen if they are set up to do "clicks". If you are working with an
Windows XP system only one input event can be sent, whereas Windows 7 (and above) is able to work
with multi-touch events.

The input events can be sent from a local pointing device. Let's say for example you have a Client that
renders layers in full screen that should be clicked with an AirScan. Connect the AirScan directly to the
Client to receive local input events. Another possibility is to connect the AirScan to another computer
which sends the input events to the Client through a so called "Mouse Injection". A Mouse Injection node
can be found in the Widget Designer.

If you like to be able to click in the rendered Preview tab on your Master, simply toggle the Preview to

the  "Picking Mode".

First example: Layer Picking with Web Page

Please follow these steps to use Layer Picking with a input device connected to a Client that is toggled
to fullscreen and shows a web page for example.
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In your Pandoras Box project, create a Browser
Asset . Right-click in the Project, choose Add
Browser and assign an URL in its Inspector.
Then assign the Browser to a Layer from the
Client. Of course you can work with a Client
connected or not connected yet.
(Please do not change the default render pass, i.e.
leave it assigned to the composition pass .)

    

To activate click events, open the dialog "Input
Event Settings".
a) Select the Client in the Device Tree tab  and
in its Inspector  click the according button .
b) Toggle the Preview to the Picking Mode, and

open the  "Show Input Event Settings". This
opens a dialog that shows the settings for all
systems in the Device Tree.

Activate the Output in which you like to click and
the option Layers. This passes clicks directly
through to the layers and executes underlying links
for example. The Widget Designer option is
covered in the next example.

Now, the mouse capturing works
- in the fullscreen window from the Client and
- in the Master's Preview if toggled to the Picking
Mode in the Output or All Cameras view .

The check box "Show Cursor in Fullscreen" (in the
Device Inspector or in the dialog) lets you display
the mouse cursor on-top of the Client's fullscreen.
In the Master's Preview you will see a special click
cursor. 

 or 

Alternatively you may use "Pointer Layers ";
they offer more creative options like displaying a
picture or even a Particle System instead of a
simple cursor. Depending on the layer's opacity,
this Pointer Layer is automatically shown:
a) in the Preview tab if you are in the Picking Mode
and toggled to the according Output View
b) in the Client's small render window
c) in the Client's fullscreen render window

Optional: Create a Pointer Layer, if you like. Right-
click the Client in the Device Tree and choose
"Add Device" > "Pointer".
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Without a Pointer Layer you will see the click
cursor in the Preview. With a Pointer Layer you will
see that one instead. If you wish to see the click

cursor additionally, activate the  "Always Show
Cursor" button.

Second example: Send Layer Picking data to Widget Designer

In addition to the Preview or Fullscreen interaction, you can also route the data to Widget Designer
Device, to execute actions there too. It is also possible to know where the mouse is located e.g. on-top
of Layer 1 and work with this data.

Start Widget Designer (4.0 or above) on the same
or another PC.
In Pandoras Box, create a new project and program
layer 1 and 2 next to each other so that your
Preview looks something like the example to the
left. Please do not change the default render pass,
i.e. leave it assigned to the composition pass .

    

To activate click events, open the dialog "Input
Event Settings".
a) Select the Client in the Device Tree tab  and in
its Inspector  click the according button .
b) Toggle the Preview to the Picking Mode, and

open the  "Show Input Event Settings". This
opens a dialog that shows the settings for all
systems in the Device Tree.

Activate the Output in which you like to click and
the option Widget Designer Devices . This
passes the cursor position through a Widget
Designer device in the timeline to the Widget
Designer application. By the way, the option 
Layers that we used before can be check or not. 

The check box "Show Cursor in Fullscreen" (in the
Device Inspector or in the dialog) lets you display
the mouse cursor on-top of the Client's fullscreen.
In the Master's Preview you will see a special click
cursor. Alternatively you can use a Pointer Layer as
described above.
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To add a Widget Designer Device , go to the
"Device Types" tab > "Widget Designer" > and drag
the "Widget Designer.clib" into the Device Tree.
Currently, the device cannot connect and is
depicted with a red mark. Select the Widget
Designer device in the Device tab to see its
Inspector. Enter the IP address from the Widget
Designer and the icon will not display the red mark
anymore. If it still does, check the IP address and
domain number from PB (in the Configuration tab)
and from WD as described in the next step.

In Widget Designer, open the Connection menu and
choose "PB Configuration". Then make sure that
the Domain (1) and IP address (2) under "Pandoras
Box Master Connection" matches with the PC
where Pandoras Box Manager or Player /Server as
Master is running on. In Pandoras Box, the IP
address is shown in the Assets tab, the Domain in
the Configuration tab.

Have a look in the section "Pandoras Box Widget
Device Connection" and enable the check box
"Enable Connections" (3). You can close the
dialog, but remember the button "Input Tester", it
opens a dialog that displays incoming information.

Press Alt+N and create the following node: Input >
Pandoras Box > Layer Interaction (the input nodes
"Layer Mouse Input" and "Layer Touch Input" can
be used in later projects as well). Make a right-click
on the node and choose "Item Properties". In this
dialog again, make sure that the IP address
matches with Pandoras Box. Leave the dialog
open.
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So far we have set up the data routing, now we can
already use Layer Picking within a fullscreen
window of a Client. If you like to use Layer Picking
in the Preview tab, enter the Picking Mode by
clicking on the according button on the left site from
the Preview and switch the view to the Output
you have activated in the Input Event Settings
dialog.

Please note, that the data is only transferred when
the mouse is actually moved.

Now we can move the mouse cursor across the
Preview tab or the Client's fullscreen display and
see the according data in the Item Properties dialog
from the input node in Widget Designer. 
Alternatively you can click on the "Input Tester"
button in Edit > Pandoras Box IP Configuration .

The node reports the Site ID and Device ID as soon
as the mouse touches a layer. Of course its
opacity value must be greater than zero.

X and Y relate to the width and height from the
Preview tab or fullscreen window and are measured
in pixels.

U and V relate to the layer's texture coordinates.
They run from 0 to 1, whilst (0,0) marks the upper
left and (1,1) the bottom right corner of a
rectangular texture. Of course, having an object e.g.
a cone assigned to a layer will result in other
coordinates. The UV-coordinates  are saved
within the object file.

The mouse buttons (value 0 or 1) and the wheel
(value depending on mouse) report whether the
according button was pressed or the wheel was
used.

The left image shows the reported data in Widget
Designer: the mouse touches layer 2 from Server 2
and hovers above its UV-coordinate (0.1,0.5) whilst
the XY-coordinate in the Preview tab is (316,160)
pixel.

If you like to use the data to click on Widget
Designer's Custom Script Buttons , please see
its chapter. You can also use further filter nodes,
e.g. the "Is in Bounding Box node" to check
whether the pointer is in a certain area.

The next chapter explains the Canvas Editing Mode .
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6.3.4.20.7  Canvas Editing Mode

This chapter explains the Canvas Editing Mode of the
Preview which allows you to use content as a drawing
background which allows for example to draw masks
directly in Pandoras Box. For other topics regarding the
Preview tab please see the introductory chapter .

If you like to draw in your Preview you first have to create a
Canvas Asset. To do so, right-click in the Project tab
and choose "Add Canvas", save the new Canvas and assign
it to a Layer. In case you like to use the Canvas as a mask,
make sure to assign it to a Layer overlaying all other Layers,
e.g.:
- use the last Layer in the render order before the Camera
- toggle the Layer into the Output render pass  only

 Alternatively you can right-click on any image file already
part of your project and choose "Create Canvas from Image".
This is of special interest in case you fine-tuned a mask with
third-party software and want to re-import the Canvas. To
export it initially, right-click the Canvas and choose
"Export".

In case you like to change the Canvas size, please go to
the Canvas Inspector .

 

To draw on the Canvas, go to the Canvas Editing Mode and make sure that the Editing Context
(highlighted above in orange) is set to the Layer your Canvas is assigned to. Now you can pick the Brush
or Flood tool and draw on the Layer. There are various other tools that let you choose the color or brush
softness for example. With the Erase tool you can turn pixels transparent again.
To draw a straight line click once with the brush tip and hold the [SHIFT] key when clicking the second
time.

The Drawing Canvas can also be used for a more creative application, e.g. to draw onto a facade or other
3D object. As for most interactive applications, the Widget Designer is of great help. Please see the
chapter about the "Layer UV Draw to Canvas"  node.

Note that in the Device Tree, the Layer that is picked as the Editing Context is marked
with the Editing Context icon. 

In case you delete the Canvas from the Layer whilst the Editing Context is still referring
to it, the Layer will be marked with a small red dot.

To export the mask as a *.png file, right-click on the Canvas and choose "Export".
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The next chapter explains the Mesh Editing Mode .

6.3.4.20.8  Mesh Editing Mode

This chapter explains the Mesh Editing Mode of the Preview which allows you to warp directly in
Pandoras Box. For other topics regarding the Preview tab please see the introductory chapter . The
next chapter covers general warping questions . The topic about the Multi-User tab  explains the
possibilities to work with several operators on one project, e.g. if one or more operators warp the screens
whilst other ones take care of the timeline and content.

How to Start with the Mesh Editing Mode

The fastest way to warp an Output is to select it in the Device Tree  and press the "Edit Warp Mesh"
button in the Device Control tab . This will automatically...:

1- create an Editable Mesh with the size of your output resolution and a 3x3 FFD  grid, name it "Warp
- Output no." under the project folder "Warp Meshes" and save it in the project path.

2- assign the Editable Mesh to the according Output.

3- toggle the Preview to the Mesh Editing mode.

4- set the correct Editing Context and View which is then scaled out slightly in order to make the
selection of FFD points easier.

If you click the "Edit Warp Mesh" button a second time, only step 3 and 4 are executed.

To do this manually...

1- right-click in the Project tab and choose "Add Editable Mesh" and save it. Right-click the Mesh
and choose "Rename" in case you like to change the name later again. Check the size in the Sub Mesh
Inspector . Note that the newly created Editable Mesh folder lists one Sub Mesh called "Surface"
which is a planar 2D Mesh in fullscreen size with a 3x3 FFD  grid.

2- assign the Editable Mesh or the contained Sub Mesh called "Surface" to your Output.

3- toggle the Preview to the Mesh Editing mode.

4- set the Editing Context (in the above image its highlighted in orange) and the View (highlighted in blue)
to the according Output and scale it out slightly by scrolling with the middle mouse button.

Of course you can also assign the Editable Mesh to another Device e.g. a Video or Graphic Layer.
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A Mesh can include one or multiple Sub Meshes. If you assign the Main Mesh to a Layer, and there are
multiple Sub Meshes all of them are assigned, i.e. the Layer texture is shared on all Sub Meshes. Of
course, you can also assign only one Sub Mesh. To do so, you can open the Main Mesh folder and pick
the Sub Mesh you like. If you like to assign all Sub Meshes to individual Layers, right-click the Main
Mesh and choose the command "Assign Sub Meshes to Devices Consecutively" after selecting the
"starting" Layer.

If you like to edit an imported object, simply right-click it in the Project tab and choose "Create Editable
Mesh from Mesh".

The Object Inspector  lets you change general settings like the wireframe color whilst the Sub Mesh
Inspector  includes options like the Segment count (known as Mesh points in the Warper), the Control
Point count (aka FFD), Mesh size and segments, etc. If you are not familiar with the warping process,
please also read the next chapter covering general warping questions.

Note that in the Device Tree, the Layer that is picked as the Editing Context is marked
with the Editing Context icon. 

In case you delete the Canvas from the Layer whilst the Editing Context is still referring
to it, the Layer will be marked with a small red dot.

Tools for the Mesh Editing Mode

As soon as the Preview is set to the Mesh Editing Mode, the Mesh Segments (per default light gray) and
FFD Control Points (per default orange) become visible. Above the Preview, there are many tools
available.

Choose whether you like to select the entire Sub Mesh, FFD points, or Mesh / Vertex
points. The shortcuts are the letters M, F and V.

Choose whether you like to move, rotate or scale the selection. The shortcuts are they
numbers 1, 2, 3 on the main keyboard.
The workflows how to transform are explained below the table.

The Parameter Floater [CTRL+P] shows the exact position in pixels. If you have
selected more than one point, the "In Layer" position refers to the center of your
selection. The "In Layer" position is the absolute position in regards to the Layer
bounds whilst the "Local Change" is a relative input, i.e. it is added or subtracted from
the absolute position and then reset to 0.
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If you work with an Editable Mesh that contains several Sub Meshes (Surfaces) you
have the choice to select on all Sub Meshes or only on the one you choose from the
drop-down list.

If you highlight one / several Constraints, a transformation is only executed along the
chosen axis / axes.

These buttons toggle the visibility of the Gizmo, the FFD grid and the Mesh Wireframe
in the local Preview. The last button toggles the Mesh Wireframes for all Outputs. For
more options, go to the Configuration tab > Preview Display  or Client Display.

This button can be found on the left site at the bottom and toggles your Preview tab to
a fullscreen window. All tools are available within the Button Bar, that you can toggle
with the shortcut [T]. Hence, the maximized Preview gives you the best overview when
warping.

To select one object or point, simple click on it or draw a selection box around it. To make a multi-
selection you can either draw a greater selection box or, in case you select FFD or Vertex points, use
the shortcut [CTRL + an arrow key] after having selected the first point. The shortcut [ALT + an arrow
key] moves the selection in terms of selecting the adjacent points.

You can transform the selection using the mouse, the keyboard or the dialog "Parameter Floater". With
your mouse you can click on one of the selected points and then drag it horizontally or vertically. When
holding the [Shift] key, the transformation will be applied along one axis only. For example if you move
the mouse from left to right the X-axis is taken but as soon as the up-down movement is greater, the Y-
axis is taken.

You can also work with the Gizmo, if it is visible. As soon as you position the mouse pointer on one
handle of the Gizmo, it is highlighted in orange. Dragging the mouse results in a transformation along
one axis. You can also work in another plane by highlighting one of the corners shown in magenta, cyan
and yellow.

As an alternative to working in distinct axes, you can apply constraints. With an activated X Constraint
(shortcut [X]) the Y and Z-axis are shown in gray and any transformation happens along the X-axis only.
Please keep in mind that Servers have 3D but Players 2D parameters.

Step-by-Step Description how to Deform a Mesh

Depending on your preference you can work either using the mouse or the keyboard, or both. At any

time you can maximize your Manager's Preview tab with this button  and toggle the Button Bar with
[T].

Mouse Keyboard

Choose the
Edit Mode  Choose whether you like

to select:
Sub Mesh
FFD points, or
Mesh / Vertex points.

Alternatively, use the shortcuts:

- [M]

- [F] or 

- [V]

Select points Select a single point by simply clicking
on it. 
Or, drag a selection box around one or
several points.

First, select all points with [CTRL+A].

[Up/Down/Left/Right] key selects a single
neighbor point.
[CTRL] + [arrow] adds the neighbor point(s)
to the selection.
[ALT] + [arrow] moves the current
selection.
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Choose a
Transformation
Mode

 Choose how you like to
transform the selection:
Move
Rotate
Scale.

Alternatively, use the shortcuts:

- [1]

- [2]

- [3]

Toggle the
Axis Locks
(if necessary)

 Apply a Constraint if you want to
transform along one axis only. Another
possibility is to use the Gizmo.

Alternatively, use the shortcuts [X], [Y] and
/ or [Z].

You can also hold the [CTRL] key whilst
dragging your selection.

Edit the
selection

Now, simply click on one of the
selected objects / points and drag it
with the left mouse button up/down or
left/right.

Alternatively, you can open the

Parameter Floater  and drag the
according number field up or down.

Hold the [SHIFT] key and click the arrow
keys Up/Down/Left/Right.

Alternatively, you can open the Parameter
Floater with [CTRL+P] and enter a number
to an according number field.

The next chapter covers general warping questions .

6.3.4.20.8.1  General Warping Questions

This chapter covers some general warping questions related to the Mesh Editing Mode  in the
Pandoras Box Preview.
- What is the difference between a Mesh and a FFD?
- How many FFD and Mesh points should I choose?
- What to get a good Mesh?
For other topics regarding the Preview tab please see the introductory chapter . 

Mesh versus FFD

This paragraph describes the difference between a Mesh point (Vertex) and an FFD point, thus it is
covering a fundamental function of the warping process.
The pictures below show a 2D plane with a green-colored 10x10 Mesh and orange-colored 3x3 FFD.

See here the differences between moving a FFD control point and moving a Mesh point. Please note that
the FFD is only a helping tool to set up the Mesh, you will not see the FFD in the final object.

This shows the grid without any editing. The green lines
represent the Mesh, the orange lines the FFD.
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The top left FFD control point is moved further down. The
whole Mesh is affected by this change: the horizontal
lines are bend together on the top left side, the Meshes
outline gets curved.
This effect can be of advantage or disadvantage. In the
beginning of the warping process it can simplify and
accelerate the workflow as it is not necessary to move
each individual Mesh point. The further the warping
process develops the more it is necessary to apply
changes to particular pixels only. At this point the FFD is
not sufficient any more as it affects large areas of the
grid. 

Now only one Mesh point is moved. Only the segment
lines between the moved point and the four neighbor
Mesh points are affected by this.
The more you are experienced with warping the better
you will be able to answer the question how many Mesh
points a grid should have. If too little points are chosen it
won't be possible to apply the detail changes that are
necessary. This is especially crucial when setting up
Meshes for a softedge projection as the pixels must
overlap each other exactly in the overlapping area.
If too many points are chosen, the warping process is
lengthened unnecessarily as all points must be adjusted.

Setting up FFD Control Points and Mesh Segments

Before you start moving the control points you have to decide with how many FFD control points and
Mesh segments you want to work. The FFD and Mesh count is set up in the Sub Mesh Inspector .
The perfect amount depends on your screen surface and outline.
The more warping projects you have done, the faster you will be able to tell the best FFD and Mesh
count. If you are not sure in the beginning, simply make a guess and start warping. You will see quite
fast, that you have picked too many or too less FFDs. Too many FFD points are not that bad, it might
take more time during the FFD-phase but you could save time during the Mesh-phase - at least if not
way too many FFDs were picked. If you have picked too less FFD points you will notice that you will
have to move Mesh points at a very early stage of warping. This will definitely be more time-consuming
than starting all over with a new Mesh. In addition, it is easier to obtain a good quality Mesh (as
described below) with FFDs instead of offsetting single Mesh points too far. If you like, you can save the
current project and have a quick look whether a new Mesh with more FFDs does give you better results
and eases your work. This can be found out in a few seconds but save minutes or even hours.

Example 1, a 4x3 FFD
A simply bend screen will go well with only 3 vertical FFD
control points. Horizontally there needs to be done more
warping, thus 4 FFDs work better. The more smooth the
outline has to be, the more horizontal Mesh segments you
should take. In this case there are 20 Mesh segments.
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Example 2, a 6x3 FFD
Curved screens that are more complex will be easier to
handle if you increase the amount of FFD control points. In
this case there are 6 horizontal control points and still 3
vertical ones. 
The curved outline of the Mesh is the result by only moving
the FFD control points.

Example 3, a 5x5 FFD
Spherical screens are bend in all directions. They require to
increase the amount of vertical FFD points as well. In the
depicted example a Mesh with an 5x5 FFD is shown. If the
projector looks straight on the equator, the Mesh deformation
will be quite homogenous and the FFD should look similar to
the example.

The amount of Mesh segments can be altered as long as working only with the FFD control points. As
soon as a Mesh point is moved, the amount should not be changed any more. 
In general, the amount of Mesh segments depends on how exact the warp needs to be. Firstly this is a
question how complex or detailed the screen is, including the outline, as shown in the above example
with the simply bend screen. If the screen is quite flat itself but has a very detailed outline, it could be a
faster solution to create a mask  instead of increasing the Mesh count.

Secondly, it is important whether you are projecting with single projectors only, or if several projectors
overlap each other. Within the softedge area the pixels from both projectors must overlay each other
perfectly. This requires a higher Mesh count. As a rule of thumb, at least 7 Mesh segments should lie
within the overlap area.

By the way, it could be helpful to work with Mesh segments that have the same height as width. If your
projector has an aspect ratio of 16:9, you could set up a Mesh count of 16 by 9 during the FFD-phase
and increase it to 32 by 18 or even 48 by 27 before starting the Mesh-phase.

The Warping Workflow

A good quality Mesh refers to a Mesh where the Mesh lines are uniformly distributed on the screen. For
example, if the screen is 2m wide, and there are 20 horizontal Mesh segments, each segment should be
10cm wide. If this is not achieved sufficiently, and you project text that moves across the screen, it
would scroll unevenly. Wherever there are smaller distances between Mesh lines, the text would be
smaller too. Wherever there are larger Meshes, the text is enlarged.
If your content does not contain critical movements or visible geometrical forms, you can warp a little
more rough. So before you start warping, or before you spend too much time within the last phase,
check the content and decide how perfect the result really needs to be.

For some people it is quite hard to perceive equal distances. To fasten and ease the warping workflow,
try to mark certain points on the screen. If you mark for example every 40cm with tape, it will be much
easier to arrange the Mesh equally. If you cannot tape on the screen, a rotatory laser can be helpful as
well.
For the same reason it can be worth the time to create special test patterns. This is definitely
recommended when projecting on complex geometries and the later on used content refers to the
geometry.
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Keeping this mind we can now start warping. The golden rule is always to warp as much as possible
with the FFD, but not more than necessary. Or in other words: the FFD is for the coarse adjustment
and the Mesh for fine-tuning.

Whilst moving the FFD points, match the Mesh outline (= content outline) as good as possible with your
screen outline. At the same time keep an eye on the distance between the horizontal lines and between
the vertical lines. As soon as you recognize that moving an FFD point helps within a small Mesh area
but "destroys" an higher number of other Mesh areas it is better to finish with the FFD-phase. Decide for
a final Mesh count and move on to moving Meshes. Here you will see that the better the FFD was
adjusted, the less time needs to be spend for finishing.

When warping with overlapping Meshes, you are done with warping as soon as all Mesh lines overlay
each other. This can be seen easily when both Meshes have a different colors as the resulting color will
be the sum. The closer the audience sees the projection, the more perfect the overlay needs to be.

In general it is possible to do a rough warp and start programming with it in the timeline. Later on, when
there is enough time or when it is sure the projector or screen will not move, you can go back in the
Editing Mode and finalize it.

The next chapter explains the Planar and Perspective UV Mapping Mode .

6.3.4.20.9  Planar and Perspective UV Mapping Mode

This chapter explains the Planar and Perspective UV Mapping Mode of the Preview which allows you to
assign a UV map directly in Pandoras Box. For other topics regarding the Preview tab please see the 
introductory chapter . The next chapter covers general mapping questions  and is of special
interest for mapping beginners.

Per default, a newly created Mesh in Pandoras Box has a 1:1 map meaning that any (existing)
deformation in the Mesh also deforms the UV source.

Pandoras Box offers two techniques to apply a new UV map to a Mesh or an object. There is the planar
mapping and the perspective mapping for which you can choose the point of view. With both mappings
you can "print" the texture on a 2D or 3D Mesh again without taking existing deformation into account.
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Before you get started with the UV mapping, assign a texture
and an Editable Mesh to a Layer. To create an Editable Mesh,
right-click in the Project tab and choose "Add Editable Mesh". If
you need more than one Surface, right-click on the Editable
Mesh and choose "Add Surface" adjust the size using the
Surface Inspector or the Mesh Editing Mode.
In case you like to work with an imported object, simply right-
click it and choose "Create Editable Mesh from Mesh".
Alternatively you can drag it on a newly created Editable Mesh
object as depicted to the left. Afterwards you can remove the
"Surface" that was added per default.

Tools for the Mapping Modes

Most buttons are also part of the Mesh Editing Mode , please see this chapter for an explanation. The
buttons starting with the stamp icon are explained in the example below.
For the Perspective UV Mapping Mode there is an additional drop-down menu to choose and reset a
Reference Layer.

Planar UV Mapping Example

 This example shows how the planar UV mapping works 

You can follow this example with any Editable Meshes. For now, it should be fine to program in a normal

preview but later on you might want to switch to the maximized preview . This button can be found
on the left site at the bottom and toggles your Preview tab to a fullscreen window. All tools are available
within the Button Bar, that you can toggle with the shortcut [T]. Thus, the maximized Preview gives you
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the best overview, allows to see more details of the image and adjust the UV Source grids better.  You
can also work with the Mesh Inspector to position, scale and rotate Meshes.

The planar mapping works for all
Meshes: 2D or 3D, single or
multiple Meshes. This example
depicts one Editable Mesh with two
Sub Meshes. One Sub Mesh was
already deformed with the FFD
handles as described in the Mesh
Editing Mode .

Per default, when assigning an
image (i.e. a texture) it covers the
entire (Sub) Mesh and is then
deformed along the Mesh lines.

Switch the Preview Mode to the 

 "Planar UV Mapping Mode".
Make sure that the view you are
working with is correct and that the
Editing Context is set to the
correct Layer.

Before starting to assign UV
coordinates select both Surface UV
Sources by clicking into the
Preview window and pressing
[CTRL+A]. You should see both
names on top of each other, e.g.
[UV Source - Surface] and [UV
Source - Surface (2)].
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Now, press the button  "Apply
Planar Map to Mesh Bounds".
Both UV Source grids are arranged
within the limits of the texture. Note
that they fit either horizontally or
vertically, i.e. the aspect ratio is
preserved. The size, position and
rotation of the grids does only
represent what part of the texture is
depicted on the Meshes. The
texture itself is displayed in its
pixel size.

Planar Map to Mesh Bounds

Press the stamp button  to
calculate the UV coordinates and

toggle into the  Layer Mode.
Note that the Meshes have their old
size, position and rotation but the
layer texture is shared differently.

Go back to the "Planar UV
Mapping Mode". Select the first

button  "Sub Mesh
Modifier" (shortcut[M]) and then
reposition, rotate or scale the UV
grids with the according buttons 

 or shortcuts [1,2,3].
If needed you can use the

Constraints . 
With the FFD or Mesh modifier you
could influence the UV map in
more detail. As the (drop-down)
Selection Mode is set to "All
selectable" you can transform each
grid. If only one Mesh is selected,
the other one will be locked.
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Custom Planar Map

Always press the stamp button to
calculate the UV coordinates.
Switch to the Layer Mode to view
the final result. Again, the Meshes
have their old size, position and
rotation but the layer texture is
shared differently.

Planar Map (to Fullscreen)

Enter the "Planar UV Mapping
Mode" again and select both grids.
Select the second mapping button 

"Apply Planar Map". This
time the UV source grids are not
scaled to fit the texture but
represent the size of the according
Meshes. The texture itself is
always displayed in its pixel size.
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1:1 Map

Last, try the third mapping button 

"Apply 1:1 Map". Note that the
UV source of the deformed Mesh is
not deformed. In other words, the
texture is first applied to the Mesh
and then deformed according to the
FFD grid. This was not the case in
the other planar maps where the
content was rather cut out following
the mesh lines.

Perspective UV Mapping Example

In difference to the planar mapping, the perspective mapping allows to influence from where the texture is
projected onto the Meshes.

This example shows how the perspective UV mapping works

You can follow this example with any Editable Meshes. For now, it should be fine to program in a normal

preview but later on you might want to switch to the maximized preview . This button can be found
on the left site at the bottom and toggles your Preview tab to a fullscreen window. All tools are available
within the Button Bar [CTRL+T] and thus, the maximized Preview gives you the best overview, allows to
see more details of the image and adjust the UV Source grids better.

Scene w ith 2D plane and 3D w ave and a Camera looking from a low er angle.

The perspective mapping works for
all Meshes: 2D or 3D, single or
multiple Meshes. This example
uses an imported object that
consists of a background plane and
three waves in front of it. The
images illustrates the scene. The
camera position resembles the
position of the audience.

The imported object is converted to
an Editable Mesh using the right-
click menu in the Project tab.
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Front view  of the scene and the view  from the Camera. Switch to the Preview mode
"Perspective UV Mapping"

The view automatically zooms out
to illustrate the mapping scene with
the 3D objects, the camera
position and a UV Mapping
Reference Layer spanned in the
opening angle of the Camera.

In addition, the Parameter Floater
opens and shows the Layer's
position, rotation and scaling. Per
default,. the Reference Layer
shares the texture from the Layer
you are working with, but if needed
you can drag any other media there
from the Project tab.

Press the stamp button to
calculate the UV coordinates and
toggle into the Layer Mode.

Reset the Camera view with the R-
button to view the scene again from
the saved Camera position which
resembles the position of the
audience. As the texture was
applied from this perspective and
spreads over all objects evenly, you
can not tell where one object starts
or where it is deformed. In other
words, the scene looks flat...
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... but as soon as you leave this
"sweet spot", your perspective
changes. The further you go, the
less you have the impression to
see a seamless image covering all
objects.

The next chapter covers general mapping questions  and is of special interest for mapping beginners.

6.3.4.20.9.1  General Mapping Questions

This chapter covers some general mapping questions related to the Planar and Perspective UV Mapping
Modes  in the Pandoras Box Preview.
What is a UV Map? What tools for texture mapping are provided by Pandoras Box?
For other topics regarding the Preview tab please see the introductory chapter . 

UV Texture Mapping

UV mapping is a process of defining how to
represent a 2D image on a 3D model.
The 2D source image (in our case an image
or video) is a so called texture. In contrast
to "X", "Y" and "Z", which are the
coordinates for the rendered 3D object, "U"
and "V" are the coordinates of the texture.
The UV map stores a defined U,V-
coordinate for each X,Y,Z- coordinate.

This creates the effect of painting the image
onto the surface of the 3D object, or in other
words, how to wrap or stretch the image
around the object. As shown below there
are different ways how to do that, hence the
chosen UV map is stored as a property of
the 3D model.

When working with objects modeled in a 
third party software  like Maya or 3DS
Max you will most likely also receive
textures with them. In Pandoras Box,
simply assign the object and the image or
video to the same Layer. Pandoras Box
loads the object, looks up its UV map and
wraps the texture around the object
accordingly. There are also effects that
influence the UV map .
In case you have not received any texture
but want to check whether there is a UV
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map, the fastest way is to assign any
image and check whether it somehow
covers the object. It is not important how
many pixels your image has as the UV map
stores UV-coordinates from 0 to 1. With
the Warper tool  you can also export the
UV map , e.g. to use it in another image
editing program.

With Pandoras Box you can also create
new UV maps. This works for 2D Editable
Meshes created in Pandoras Box but also
for imported 2D or 3D objects. You can
assign a planar map or a perspective one.

There are several standard mapping
techniques available to map a texture onto
an object: planar, cubic or box, cylindrical,
spherical mapping etc. Just as an example,
see the box to the left. First, it is assigned
with a planar map, then with a cubic
mapping that shares the texture multiple
times without stretching it.

The car is an example how a complex UV
map could look like.

The next chapter explains the Context Menu of the Preview .

6.3.4.20.10  Context Menu of the Preview

This chapter explains the context menu of the Pandoras Box Preview tab. For other topics regarding the
Preview tab please see the introductory chapter .
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Right-click anywhere in the Preview to open the context menu. The Mesh and UV Mapping Editing
Modes offer a few more commands than the other modes. In the Picking Mode, no context menu is
available.

The top line of the context menu informs you which view is active, e.g the view from the Camera with
Device ID 2.25. Below, the command "Select Preview" is explained.

Add Sub Mesh
This command is available in the Mesh Editing or UV Mapping Modes and adds a Sub Mesh to the
Editable Mesh that is assigned to the Editing Context Layer.

Remove Sub Mesh
This command is available in the Mesh Editing or UV Mapping Modes and removes a Sub Mesh from the
Editable Mesh that is assigned to the Editing Context Layer. Position your mouse over the Sub Mesh
that you like to remove and open the context menu.

Reset Sub Mesh
This command is available in the Mesh Editing or UV Mapping Modes and offers several reset options for
a Sub Mesh from the Editable Mesh that is assigned to the Editing Context Layer. Position your mouse
over the Sub Mesh that you like to edit and open the context menu.
Reset All resets the transformation, FFD and Vertex Modifier as well as the UV Coordinates which
means the mapping.
- In the Mesh Editing you can activate the Sub Mesh Modifier and change the position, scaling or
rotation for a Sub Mesh. This also changes the parameters displayed in the Sub Mesh Inspector. The
command Reset Transformation resets those changes.
- In the Mesh Editing you can activate the FFD and Vertex Modifier and change the FFD or Vertex
points. The command Reset Modifier resets those changes. Alternatively, you can go into the Sub
Mesh Inspector and reset the FFD and / or the Vertex grid.
- In the Planar and Perspective UV Mapping Modes you can change the UV Map of Editable Meshes.
The command Reset UV Coordinates resets those changes but only for Editable Meshes created in
Pandoras Box (not imported and converted ones). Alternatively, you can go into the Sub Mesh Inspector
and click the button "Reset UV Coordinates".

Preview Display Configuration
This opens the Configuration tab in a panel and displays the category "Preview Display" that includes for
example the visibility for Gizmos and Wireframes.

Select Preview
Open the sub menu and choose one of the offered views to switch to it. Note that a Site must be 
included in the Preview  rendering. The so called "All Cameras" view is always available and allows
previewing all included Sites at once. Furthermore the whole 3D space is shown instead of only the
specific area seen by the Site’s Camera or Output device. The so called "All Cameras" view is always
available and allows previewing all included Sites at once. Furthermore the whole 3D space is shown
instead of only the specific area seen by the Site’s Camera or Output device.
Please note: Everything that is set up in the Output device of this previewed Site, i.e. a warping object,
softedge etc. will NOT be shown in the All Cameras view! Please change to the Output’s preview if you
want to see the Output settings as well!

Select Matrix Mask
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When working e.g. with LED walls that are controlled via Art-Net you can choose to preview the Art-Net
output instead of the video (e.g. DVI) output. Whilst being in the output (!) view right-click and select a
matrix mask. To use the matrix feature you first need to create a patch in the Matrix Patcher  and
export it to your Pandoras Box project. Drag the new format ".pbx file" on any(!) Output Layer . Now,
you may choose to preview it as described. Dark Outside of Patch dims the area not covered by the
patch whilst the Black option does not display it at all. Choose None to see the entire area without the
highlighted patch.

Reset Camera

This command resets the view, i.e. the Camera or Output
position. Shortcut: [CTRL+0]
Note that only the "Zoom" Interaction Mode  is reset. When
you toggle to "Parameters", view changes influence the
parameters of the Camera or Output device which are not reset
with this command. However, the R-button at the top right
resets both modes.

Look here (Point on Grid)
Moves the view so that the point where you clicked (projected to the Ground Grid) is in the center of the
view port. This does not work for Camera and Output devices without the Target parameter.

Look at selected Layer
Moves the view so that the selected Layer is in the center of the view port. This does not work for
Camera and Output devices without the Target parameter.

Show Input Event Settings
Shows the dialog "Input Event Settings" which includes the Picking settings for all Sites included in the
Preview. See more in the chapter Picking Mode .

Select Pointer
This entry has a sub menu listing all Pointer Layers of your Sites. Choose the one you like to see in the
Preview. Pointer Layers are of interest for the Picking Mode  etc.
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6.3.4.21  Project

The Project tab holds all information regarding available media files
(called assets), sequences, groups, presets, views and tabs.
Whereas all devices that are managed by the project are located
and displayed in the Device Tree tab .

Please see the following chapters about:
- Media files  and folder structure
- Sequences
- Groups
- Presets
- Views
- Tabs

Commands in the Project tab

Right-click in the Project tab, e.g. on the very first folder and choose:

"Spread all Resources"
to copy all files from the Master system to all connected Clients. If you have done this before, a file will
only be re-spread if it has changed

"Add..."
to add another media source to the project. The supported media  is described in the next chapter

"Save As"
to save the current project with a different name and path

"Remove Unused Resources"
to delete media that is not used in any of the sequences

6.3.4.21.1  Media Files

Adding media files to the project and spreading it

The Project tab lists all available media files. Only media that is part of the project can be used by
layers. Add media files to the project by dragging them from the Assets tab , from the Thumbnails tab

, or from an external file explorer.

You may drag single files or entire folder(s), optionally including subfolders. 

Pandoras Box creates links to the media file, it will not copy the file! 

After adding content to the project it is automatically spread to all connected systems, if this default
setting is not deactivated in the Configuration tab . "Spreading" actually copies files to the other hard
disk. If the Auto-Spread function is deactivated you may spread single files or folders with the according
"Spread" command in the right-click menu. Content that was spread already is only copied again if the
file has changed.

Again, Pandoras Box creates a link to it, so if you move content to another folder, either on the Master
system or a Client system, the links point to an nonexistent file and it can not be displayed. In the
Project tab, the so called inconsistent file is then marked with a red explanation mark. To view the file
paths click the file and look into the File Inspector .
An exception to this rule is when you are using content from the project's "asset folder". As soon as a
project is saved, a folder named "assets" is generated just next to the show file. If you copy content files
to that folder and drag them from here into your Pandoras Box project the content links are relative. That
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means that you can move the project folder ( including the *.xml and asset folder) to every path wanted
without the inconsistency effect and the need of re-linking the content.
This is especially of interest for users that use the "Bundle Project " feature.

Since version 5.5 it is possible to add media files from an external file
explorer like the Windows Explorer for example. You may drag the
files (or entire folders) into the Project tab, into the Preview tab or on
a layer in the Device Tree tab.

Files that can be included (or rather linked) from the hard disk to
Pandoras Box are described in the content chapter, detailing
supported formats as well. You may add:
- Audio files
- Still Images
- Image Sequences
- Videos
- Matrix Patches

Other media types are described below.
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Different media types

In addition to the above described media types, Pandoras Box
supports other media sources. Mostly they are created in the
project itself and are stored in it. 
Right-click in the Project tab, e.g. on the first folder, to add one of
the following assets:

Text Input
displays text (in various formats). When the new text entry is
selected, you can change its properties in the Text Inspector .
At the top there is a button to open the "Text Input Editor" tab
where you can modify these and more settings.
A text input can be displayed by any layer starting from a simple 
Graphic Layer . If you are using the "Play" function e.g. for
scrolling text, a Video Layer is needed.

Playlist 
plays back various media files (images and videos) one after
another with an optional cross-fade on ONE layer. There is no
need to program all files separately in the timeline. To modify the
Playlist, e.g. add content or change its order, open it in the 
Playlist tab . A playlist can be displayed by any layer starting
from a simple Graphic Layer , if videos are included a layer with

a Playback functionality is needed, e.g. a Video Layer .

Browser
is able to render a web page. See its properties in the Browser Inspector .
A browser asset can be displayed by any layer starting from a simple Graphic Layer . Please note
that the render and loading process might take up to 15seconds depending on the texture size and web
site complexity. This is also subject to the internet connection.
A browser asset can be clicked as well, e.g. to execute included hyperlinks, if the feature Layer Picking

 is activated in the respective Device Inspector . A click input can be displayed by a Pointer Layer
.

Image Sequence
is an alternative to video files, see the differences in the according Content chapter . The best way to
add an image sequence is actually found in the Assets tab. Right-click on a folder and choose "Import
as Image Sequence". Choose the frame rate in the pop-up. More options can be found in the Image
Sequence Inspector . An image sequence can be displayed by any layer starting from a simple
Graphic Layer  but if you like to play it back a Video Layer  is needed.

Matrix Patch
feeds displays like LED walls that are connected via Art-Net instead of VGA, DVI or HDMI. You may add
an existing Matrix Patch file using the Assets tab. If you create a new one in the Project tab, the Matrix
Patcher  opens with a new file. Matrix patch files are meant to be used on a Output Layer  or with
an Aeon FX e.g. ReMap .

Canvas
is a dynamic image file. It is not a static image like a bitmap for instance, nor is it a predefined video that
has been rendered out beforehand. A Canvas is a still image texture but can receive drawing data,
meaning that it can be modified in real-time without the need of saving the image itself! The Canvas
Editing Mode  from the Preview allows to draw on the Canvas.  Alternatively the drawing data can be
sent from the Widget Designer and is generated through all possible tools, like a mouse or the AirScan.
You may set up a brush size (dots, circles, or even another texture using it as a brush tip) and the color.
This way you can apply the Canvas to a Layer to let your customer interact with your projection just for
fun. Or you can use the Canvas to generate a live mask. More information about the settings in Widget
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Designer...
As a third option, you can use the Pandoras Box SDK  to draw on a Canvas.

Creating and working with content folders

As Pandoras Box only creates links to files on the hard disk it is possible to create a folder structure in
the project that is independent from the one on the hard disk. You may create content folders that only
exist in the project, not on the hard disk. On the other hand you may drag entire folders from the hard
disk to the project and the entire folder structure including all subfolders is used, but again, it is only
linked. This means, that you are free to alter the folder structure.

Right-click in the Project tab, e.g. on the first folder, and choose "Add Folder". After selecting it, you
may rename it with another right-click or the shortcut F2. 

Since version 5.5 you may turn a folder into a so called watch folder. This will automatically add a media
file to your project if it is added to the watched folder on the hard disk. You may as well use the above
described project's assets folder as a "Watch Folder" in Pandoras Box... Read more in the Folder
Inspector .

6.3.4.21.2  Sequences

The Sequence folder in the Project tab  includes all
available sequences. Depending on the Pandoras Box version
(please see "Product Overview ") you are using as the
Master system, you are allowed to create more than one
sequence. To do so, right-click on the sequence folder an
choose "Create Sequence".

A new sequence with a new ID is created. To rename it, right-
click on the new sequence. The other commands available in

this context menu are the same as in the context menu  when you right-click in the time bar within
the Sequence tab . This chapter also explains how to program using the sequence and how to
navigate.
Alternatively there are explained in the chapter "Sequence Control ". This tab displays all available
sequences as large thumbnails. Among others, it enables you, to toggle play / pause of various
timelines with one click only.

To view the properties of a sequence select it in the Project tab and look into the Sequence Inspector
. It shows all settings, e.g. timecode settings and the Master sequence opacity.

6.3.4.21.3  Groups

Within Pandoras Box groups define a multi-selection of devices according to their selection order.

To select multiple devices hold down the CTRL key on the keyboard and left-click on the devices to
select.
All selected device node icons will turn blue now.
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In order to store this selection as a group for later editing, right-click on the group folder in the project tab
and choose Create Group.

Once the group is created, you can recall the saved selection by simply clicking on the entry.
Alternatively you can do this in the Group View tab .

If you right-click on the group name, the context menu gives access to more functions:

- Load From Selected Devices
This command will overwrite the actual group selection with the current selection in the device tree.

- Reset All
This  command will reset all parameters for all devices stored within this group.

- All Active
This  command will activate all parameters of all devices stored within this group.

- Clear All Active
This  command will de-activate all parameters of all devices stored within this group.

- Rename
This  command will allow you to rename the group.

- Remove
This  command will delete the group from the project.

To select all devices that are stored within this group, just click on the group name in the project tab.
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6.3.4.21.4  Presets

In Pandoras Box, presets can be used in two ways: 
1. A preset can be a single snapshot taken from active values at one point in time. The snapshot may
copy all parameters or it uses a predefined parameter filter, e.g. copy opacity values only.
2. A preset can hold an entire set of keys. The "source" keys must be stored in the timeline first before
being turned into a preset. Again the recorded parameters may be chosen.

Both preset variations can be applied at any (other) point in time to any (other) layer. In this way one
situation can be created and then be reused severally in the programming process.
In addition a preset can be modified in later programming and automatically change all according keys in
the sequence.

CREATING A SNAPSHOT PRESET

After setting up active values do a right-click on the preset type
you want to use and chose “Create Preset”. You can do this
either in the "Project Tab" or in the according preset browser
(the Tab "Preset View") .

The parameters that transfer their values to a preset will lose
their active status.

Please note:
By default, presets taken this way look at all devices (no
matter whether they are selected or not). If you wish to store
values for selected devices only, create an empty preset first,
then make a right-click on it in the project or preset tab and
choose "Store active (Selected devices)".

PRESET
TYPE

PARAMETERS
STORED

The preset folder contains default preset banks for active
value filtering during store operation. This means that by
creating a preset in any of these categories only the
parameters that match the category group will be stored.

Example:
When creating a preset in the GLOBAL bank, all active
parameters will be stored within this preset.

When creating a preset in the PRS bank, only the active
values of position, rotation and scale parameters will be
stored in this preset. All other parameter keys are not stored
and therefore will remain active.

Global All Parameters

INT Opacity

PRS Position, Rotation, Scale

MEDIA  File Selection, 
Transport Control
(Transport, Speed)

OBJ Object Selection

AUDIO Audio Parameters

CAM Camera Control Settings

OUT Output Control Settings

FX / PS FX & Particle System
parameters
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CREATING A SEQUENCE PRESET

After creating a set of keys in the timeline choose all the keys
you want to turn into a preset. In order to make a multi-
selection use the SHIFT key. Now make a right-click on one of
the keys and choose "Create Preset".

Please note:
Presets taken within the sequence tab are always stored in the
GLOBAL bank.

 Keys that belong to a preset will change their look
from the standard diamond icon to an icon that has right
angles along the top.

APPLYING AND PASTING PRESETS

"Applying" a preset to one or more layers will activate those
layer parameters that are stored inside the preset. The values
are not inserted into the timeline as long as they are not stored
intentionally.

Please note: "Applying" a sequence preset will call the first
value per parameter and ignore the following ones. E.g.,
assume a preset has three keys: X Pos = 6 @0sec and
8@2sec; Y Pos = 2 @1sec. The "Apply" command would lead
to a selected device having two activated parameters: X Pos =
6 and Y Pos = 2. Importantly, the second X Pos key (with
value 8) is ignored in this preset interpretation since only the
"leftmost" key for each parameter is taken into account.

In order to apply a preset, choose the command from the
presets right-click menu in the project or preset tab or double-
click it in the project tab.

"Pasting" a preset to one or more layers will insert all preset
keys into the timeline track (in the currently open sequence at
the time according to the nowpointer). These pasted keys are
called an "instance" of the preset. The inspector informs you
about the associated instance if you select a key in the
sequence.

In order to paste a preset, choose the command from the
presets right-click menu in the project or preset tab or make a
single left-click it in the preset tab.

Applying and pasting presets will always "start" with the
selected device. E.g., assume a preset has three keys:
Opacity for layer 1, X Pos for layer 2 and X Scale for layer 5.
When being used while Layer 6 is selected, Layer 6 itself will
obtain the opacity value, Layer 7 the position value and layer
10 the scale value. The lower left image depicts what happens
if layer 6 and layer 7 are selected the same time.
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You can, of course, repeat the "Apply" and "Paste Keys"
commands as often as you like. I.e. the preset is a form of
template which allows you to quickly create multiple
instances.

MODIFYING PRESETS

If you change the time or value of a key that belongs to an
instance, all associated keys are colored orange to show that
the instance diverts from the preset as saved in the project
tree. 

Starting from a divergent instance, you have four main options:
1) apply the changes made in the instance to the master
preset and all other instances
2) discard the changes and make the instance comply with the
master preset again
3) transform the keys to be normal keys again, not being
included in the instance any more
4) create an entirely new preset, starting from this situation

Note that, in the initial version of Pandoras Box that will have
these temporally oriented presets, you can only edit a preset
by first placing an instance of it in the sequence. In other
words, there is no editor available in which to manipulate the
master version of the preset directly. However, such an editor
is planned for future versions.

[Create Preset]
(4) Creates a new preset by mapping all selected keys. Note that non-selected keys would stay orange
as their instance has still changed.

[Update Preset From Instance]
(1) Applies the changes made in the instance to the master preset. Note that you do not need to select
all keys belonging to the instance, all together operate as the new source instance.
The current instance changes its color to grey, all other instances in the timeline change their values
additively in order to comply with the new preset.

[Update Preset From Selected Keys]
(1) In contrast to the command above, this time not the entire instance operates as the new source for
the preset, but the selected keys only.
This command is especially useful if an additional key (either before the first key or after the last key per
parameter or one in a totally new parameter) should be added to the preset.

Please note:
An instance is always pasted at the time according to the nowpointer. It is always the very first key from
the instance that is inserted at the nowpointer´s position and all other keys refer to this first key. If you
change the preset regarding the first key, the other presets will change so that it is always the first key
that holds the time the preset was once inserted. That could mean that other keys change their
particular time.

[Revert All Preset Instances]
(2) Discard the changes made in one or more instance and make them all comply with to the master
preset again.
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[Revert Preset Instance]
(2) Discard the changes made in the current instance and make this instance comply with the master
preset again.

[Release Selected Keys From Preset]
(3) Transforms all selected keys to normal keys again. They are not included in the instance any more.
Note that all other keys from the original instance will change they color to orange, as the instance has
now changed.

[Release Instance From Preset]
(3) Transforms all keys belonging to the according instance to be normal keys again. They are not
included in the instance any more.

[Select All In Preset Instance]
(-) Selects all keys belonging to the according instance.

ADDITIONAL COMMANDS

The context menu of the preset folder in the project tab
provides the following option for organizing presets:

[Create Bank]
Re-creates a preset banks if it was removed previously.

For each preset folder you may open a designated browser
as an individual tab within the user interface. This tab can be
stored in a view as well.

As well you may import previously saved presets to them.

The context menu of a preset type provides the following
options for creating and organizing presets:

[Create Preset]
Creates a snapshot preset by looking at the current active
values and copying them as a preset key (at zero time)
according to the current preset bank.

[Open Browser]
Opens the Tab "Preset View" .

[Remove]
Deletes the entire preset bank and all including presets.

[Export]
Saves all including presets as an xml file.

[Import]
Adds the previously exported presets to the preset bank.

237
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The context menu of a preset provides the following options for
creating, using and organizing presets:

[Apply (Selected Devices)] or double-click the preset
Applies a preset, starting at the first selected layer and
activates those layer parameters that are stored inside the
preset. The values are nor inserted into the timeline.

[Paste Keys (Selected Devices)]
Creates a new instance from the preset by pasting its keys the
into the currently open sequence starting at the first selected
layer.

[Revert All Preset Instances]
Discard the changes made in one or more instance and make
them all comply with to the master preset again.

[Store Active]
Stores all active parameter values to the preset that are
allowed to be stored in this preset type.

[Store Active (Selected Devices)]
Stores all active values of the selected devices to the preset.

[Rename]
Renames the preset.

[Remove]
Removes the preset.

[Export]
Saves all including presets as an xml file.

Please refer to PRESET VIEW tab  for further information.

6.3.4.21.5  Views

"Views" and the View tab  let you recall stored view layouts
of the user interface with a single mouse click. This makes it
very easy and fast to switch from one view, e.g. focusing on a
large Preview window and the AEON FX tabs open, to another
view, e.g. displaying not the Preview tab but the patch tab and
having the sequence and device control tab separated.

The chapter "Layout " describes how you can influence the
GUI layout: inserting new tabs and panes, breaking panes out,
removing and resizing them.

Once you have set up a view layout that you would like to
store, right-click on the Views folder in the Project tab and
choose "Create View".
The new view item has now stored all tab locations and sizes
of the user interface. If you're applying any changes now, you
can recall the stored view at any time later on by double-
clicking on the entry.
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Choose "Apply Default View To Tabs" if you want to reset the
views to default layout.

The Views folder holds all stored view entries. If you right-click
on them you get access to more functions:

"Apply to Tabs"
overwrites the current layout and applies the saved one,
alternatively you may double-click on the entry.

"Save Current Tabs To View"
overwrites the stored layout with the current one

"Rename"
lets you choose another name

"Remove"
deletes the view

6.3.4.21.6  Tabs

To access most of the common used context and main menu commands, custom tabs may be created
to allow you a quick access via a single click from within a view layout. 

Custom tabs consist of buttons that are especially useful for touchscreen operation with the user-
interface as well as for direct access to your favorite features to speed up your workflow.

As tabs are part of your project, all settings you make here will be stored with each project you are
working in.

To create a new tab, right-click in the project tab on
the folder called "Tabs" and choose "Create Tab".
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Once a new tab entry is created, you will need to
add button items to the tab.
Do this by right-clicking on the new tab item and
choose "create button".

To open and show the new tab in the user interface
right-click on the tab again and choose "open".
Now you should see a new tab with a single button
in the user interface. 

To assign a command to this button or to edit the
commands of any created button select the button
in the project tab. Go to the Button Inspector tab
and select your favorite command from the drop
down list. You may rename the button here as well.
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To remove a button from the Button Tab, right-click
on it and choose “Remove”.

In the Button tab view you may right-click in any
empty region to create new buttons.

Choosing “Remove” from this context menu will
remove the whole Button Tab from the user
interface.
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6.3.4.22  Sequence

The sequence tab is context sensitive and always displays the selected sequence.
Select a sequence from the project tab to load it into the sequence tab.

The next chapters:
- give you a general overview  regarding the layout and terms used
- inform you how to navigate through the time , 
- explain the commands  in the right-click menu
- tell you the most important things you need to know when programming and working  on the timeline
- give a closer look how to set up the underlying principle of value tracking  (i.e. how default values can
be enforced without setting keys)

6.3.4.22.1  Overview

Please look at the areas marked with red rectangles in the next illustration for an explanation of the
different sequence items.

 

1: Sequence Play Mode: Play/Pause/Stop
2: Sequence Zooming
3: Timecode (current position of the Nowpointer)
4: Countdown for next Cue in Timeline
5: Nowpointer
6: Cue with displayed Cue Name, see Cue Inspector .
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6.3.4.22.2  Sequence Button Bar

Above the Sequence tab you will now find a button bar, offering the
most used commands like "Store Active" and "Reset"in an easy
and fast accessible way.
The bar with its icons can be hidden, and enabled again via the Tabs
menu > Button Bar > Sequence. 

When you right-click on a container, you find additional options in
the context menu. You may split one clip at the nowpointer's position. If you have several container
within the same track selected, you may merge them. If they have different options regarding Lock to
time or free-run, media file, mesh file etc., the first container in time wins.

6.3.4.22.3  Control

Zooming

To zoom in/out the sequence:
- press +/- on your main keyboard or
- click on the zoom tool (magnifying glass icons) on top of the Devices tab or
- hold the SHIFT key and left-click in the time bar (just above the timeline) and move the mouse up and
down

Play/Pause/Stop

To start/pause the sequence, press the space button on your keyboard or use the sequence control
buttons Play, Stop and Pause on top of the Devices tab.

Navigation

- Navigate through the sequence by dragging the nowpointer (blue vertical line) on the time bar. 
- You can also enter the desired timecode on top of the Devices Tab. The timecode 00:00:00:00 stands
for hours:minutes:seconds:frames. Use this format to enter a new timecode or just type the last
numbers, i.e. "409" to get the displayed timecode 00:00:04:09.
- Use CTRL + --> (arrow right) or CTRL + <-- (arrow left) to jump from key to key (including the clip
borders).
- Use CTRL + ALT + --> (arrow right) or CTRL + ALT + <-- (arrow left) to jump from cue to cue (including
the clip borders)

All available shortcuts for Pandoras Box are included here  as a list.316
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6.3.4.22.4  Commands

To access all sequence commands right-click on the time bar of the sequence tab.

[Store Active]
This command stores all active values at the current time.

[Store Active (Selected Devices]
In contrast to the above command, this one filters active values for those devices (layers) that are
selected. The values are stored at the current time at the blue nowpointer. All active values influencing
other layers will stay active.

[Store Active To Time]
A small dialog opens and asks for the time whereto all active values will be stored. The time can be
entered in the format H:MM:SS:FF or shortened to SS:FF or even SFF. So, for example 3 seconds can
be 0:00:03:00 or 03:00 or 300. Click Enter or the button [Ok] to close the dialog and save the active
values.

[Add Cue at Current Time]
This command adds a cue at the current time, indicated by the blue nowpointer. Click onto the cue to
select it and see its properties in the Inspector tab .

[Add Cue Here]
This command adds a cue at the position of the mouse pointer. Click onto the cue to select it and see
its properties in the Inspector tab .

[Toggle Ignore Next Cue]
Click here to ignore the Next Cue in the sequence (or use CTRL+SHIFT+I) or to respect this cue again if
it was set to be ignored. An ignored cue will be displayed in orange. 

205
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[Insert Time (After Current Time)]
A small dialog opens and asks for the time interval which will be inserted after the current time indicated
by the blue now pointer. The time can be entered in the format H:MM:SS:FF or shortened to SS:FF or
even SFF. So, for example 3 seconds can be 0:00:03:00 or 03:00 or 300. Click Enter or the button [Ok]
to close the dialog and insert the time. 
Please note that the time of the "Jump Target" of jump cues will be adjusted automatically if the target
time and the jump cue are in front of the current time. In other cases the target time keeps its value.

[Select All (From Here To Current Time)]
All keys, containers and cues from the mouse pointer up to current time will be selected.

[All Active]
This command sets all parameters of all devices to active.

[All Active (Partially Active Devices)]
This command sets all parameters of partially active devices to active.

[Clear All Active]
De-activates the active status off all parameters. The values will be kept and not set back to default.

[Reset All]
Resets all parameters to their default values and removes their active status.

6.3.4.22.5  Programming

This topic explains how to generate a container in the sequence and how to edit, i.e. select, move,
change it. As well it shows how this can be done with keys

Creating containers

If you like to add containers to your timeline / sequence, you can simply drag a media file from the 
Project tab  onto a layer track. If there are no files in the Project tab, drag them first from the Assets
tab , or the Thumbnails tab . You can as well drag files from an external file manager like the
Windows Explorer into the Project tab or directly on the layer track.
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Alternatively, you can work with active values . For example, select a layer and double-click on the
media in the Project tab. Other parameters can be made active when moving the faders in the Device
Controls tab .

Once the store active command is executed, all active values are stored into the sequence at the current
time (position of the nowpointer).
- use the keyboard shortcut Ctrl + Alt + S to store all values that are active
- right-click into the time bar from the sequence and choose one of the commands named "Store Active"
as explained in the last chapter "Commands "
- right-click onto a certain layer or parameter or parameter group (in the Device Tree tab ) and choose
"Store Active" to store only this value

On the level of Layer 1 you see the clip summary container. Below that, there are the clip container and
the keys of different parameters. Most of the parameters are integrated in subfolders (see parameter
section of the respective layer type: Video Layer, Graphic Layer, Audio Tracks, Camera and Output
devices). To open these subfolders click on the +-icon in front of the folder’s name or just double-click on
the folder.

136
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The clip including all keys is framed by the clip boundaries on the left and right edge. 
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How to select, move, copy and edit in the Sequence tab

Clip containers can be positioned by selecting the summary clip
container and moving it with the mouse. Moving the mouse left and
right will change the container's time. Moving the mouse up and
down results in shifting the container to another layer. The container
changes the color to warn if it is another layer type and parameters
will be discarded. If you want to make sure that the container stays
on the same layer, press Shift whilst dragging the container. To
copy the container, press CTRL instead of Shift.

Clip containers can be stretched in time by selecting the clip container boundaries and moving them with
the mouse. You can also select it and change its value in the clip summary inspector tab .

To select a single key, just click on it or drag a window across it. To select multiple keys, drag a window
across the region of keys.
Once selected, the keys may be moved (left click and drag selection), copied (CTRL+C) and pasted
(CTRL+V) within the same layer or device. To copy a key within the container boundaries drag it whilst
holding CTRL.

To copy a selection of keys from one device to another, use CTRL+C to copy and CTRL+Shift+V to
paste to a new selection of devices. 
Please note: If copying parameters from one device to a different device, only those parameters which
are shared by both devices can be copied.

To select both, cues and keys hold down the “ALT” key.

203
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Keys can easily be added by right-clicking in the desired parameter track.

Once a key is created, you may change its value by right-clicking again on the key to access its
parameter handle. You can also select it and change its value in the key inspector tab .

To replace the content of a clip container, drag and drop the new content from the project tab onto the
clip. If the new clip has a different length, you may adopt the clip container to the new media duration by
right-clicking onto the clip summary container.

A right-click on the clip summary container gives you access to the following commands:
[Collapse Empty FX]
When there are FX added to the layer without being used, this command collapses expanded FX
subfolders.

[Trim To Clip Borders]
If a clip container was scaled down, there could be hidden keys beyond the clip borders. The command
Trim To Clip Borders will remove these hidden keys and sets new keys at the left and right clip border to
ensure the wanted behavior in the visible part of the clip.

[Trim Left]
This command erases everything between the nowpointer and the left clip boarder. The last key of a
parameter before the nowpointer will be moved to the new clip boarder time. The video clip will now be
shortened at the beginning.

207
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[Trim Right]
This command erases everything between the nowpointer and the right clip boarder. There will be a new
key set at the right clip boarder containing the value a parameter had at the nowpointer before.

[Adopt Media Duration]
This command adopts the duration of the clip if it was shortened/extended or replaced by another clip
with different duration before.

Toggle Key Mode

If you want a parameter value to be applied for the whole sequence and not to be set up for each single
clip, take it out of the clip orientated key mode by right-clicking on the parameter and choose “Toggle
Key Mode”. Press OK in the upcoming pop-up window to proceed this action (this command cannot be
undone!). Now the clip boarders are no longer effective for this parameter.

To undo steps of sequence editing press CTRL+Z on your keyboard (except for Toggle Key mode).

Please note: Changes done directly to any layer without saving these to the timeline cannot be undone!
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6.3.4.22.6  Tracking

- Enforce Defaults:
Choose between three states: ON, OFF and ONLY MESH / MEDIA:

In Pandora's Box timeline programming you normally determine the value of a parameter by setting a
key. In some situations, however, a certain parameter may not have a key associated with it that
explicitly determines its value at a certain point in time. For those situations the system can be set to
"enforce defaults", i.e. to ensure that the parameter in question has the default value even though the
default value is not explicitly set (by key) in the timeline.

There are two "default situations". First, the points in time in the "empty space" between clips (figure
1a). Second, the points in time to the left of the first key in a clip for a particular parameter (figure 1b). In
both of these situations, there are some parameters that the system can not associate with a key.

figure 1a: empty space between clips figure 1b: left of a first key in the clip

If Enforce Defaults is ON then the system will automatically apply default values to the parameters in
default situations. This behavior ensures that each frame in the timeline is associated with exactly one
definite state for all parameters. So if you click into the timeline at TC 0:00:09:00, for example, then jump
to other places in the timeline and return to TC 0:00:09:00 later, the output will be exactly the same as
before at TC 0:00:09:00, even though you may not have explicitly set values for all the parameters.

If Enforce Defaults is OFF then the system does not apply defaults in the situations described above.
Rather, the parameters retain whichever value was set before the situation was encountered. This means
that the state associated with a particular frame in the timeline depends on two things.
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All parameters which have explicitly set keys are changed to reflect those keys. The values of the
remaining parameters, however, are not changed at all (since defaults are not being enforced). The state
of the output therefore depends in part on how the parameters for which no keys were explicitly set were
edited before.

To see this, take a look at figures 2, 3a and 3b. At the beginning of the first clip, the scale of the object
is explicitly set by a key.
Imagine the timeline is started at TC 0:00:09:00 and runs on until it is paused at TC 0:00:18:00.

figure 2: Enforce Defaults is set to ON
 

figure 3a: Enforce Defaults is set to OFF; the scaling keys of the first clip have very low values
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figure 3b: Enforce Defaults is set to OFF; the scaling keys of the first clip have very high values

The state of the output when Enforce Defaults is OFF is "path dependent" in the sense that it depends
on the "path" you take to reach a particular timeline frame. When Enforce Defaults is ON it is "path
independent" in that the output state depends only on the frame that you are in.

Take a look at figure 4 and 5 for an example of path dependency when Enforce Defaults is set to OFF.
Consider a user clicking in the timeline at the different timecodes.

figure 4: Enforce Defaults is set to OFF. 
Jumping from TC 0:00:09:00 (low values for object scale) to TC 0:00:18:00 (no scaling values) results in
an object that is scaled very small.
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figure 5: Enforce Defaults is set to OFF
Jumping from TC 0:00:09:00 (low values for object scale) over TC 0:00:27:00 (high values for object
scale) to TC 0:00:18:00 (no values for object scale) results in an object that is scaled very high.

Path independence means that leaving Enforce Defaults set to ON is usually a good idea, especially
when working with a single timeline, since it helps you make sure that each frame in the timeline leads
to exactly the result you want it to. When working with multiple timelines, however, you may want to use
one timeline to control certain parameters of a device while using a different timeline to control other
parameters of the same device. In this and similar scenarios, it is necessary for each timeline to only
apply those values that are explicitly set in it via keys. This gives the other timelines the needed "space"
to apply the values determined by their keys.

In these cases, setting Enforce Defaults to OFF makes sure that each timeline yields as much as
possible to other timelines.

Note that you can use the inspector of a media or mesh assignment key to set the value of the key to
"none". This allows you to unload mesh or media from layers even when Enforce Defaults is set to OFF
by explicitly applying the default value ("none") via a key.

The setting ONLY MESH / MEDIA combines aspects of both of the other two Enforce Defaults modes.
When it is set defaults are automatically applied to the mesh and media parameters. All other
parameters besides mesh and media are not changed at all in the default situations.
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6.3.4.23  Sequence Control

Use the sequence control tab to monitor the status of available sequences.

All created sequences in the project's sequence folder are displayed in the sequence control tab.

The sequence tapper shows the following information:

- ID and name of the sequence
- the percentage value of the sequence opacity
- timecode of the nowpointer's position
- current play mode (play, pause or stop)

If the sequences opacity is set to zero, the sequence tapper background will turn red:

By clicking on a sequence item in the sequence control tab you may set the selected sequence to Play
or Pause.

To create a new sequence you may right-click in any empty region of the sequence control tab. The
newly created sequence will automatically be loaded into the Timeline Tab.
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Once a sequence is shown in the sequence control tab, you may right-click on the sequence item at
any time and choose one of the following available commands:

- Store Active
This command stores all active values at the current time.

- Add Cue
Adds a Cue at the position of the mouse pointer. See the Cue Inspector  for further information.
Please note: it is recommended to have a spacing of at least 10 frames in between two cues.

- Toggle Ignore Next Cue
Click here to Ignore the Next Cue in the timeline (or use CTRL+SHIFT+I) or to respect this cue again if it
was set to be ignored.

- Insert Time (After Current Time)
Enter the amount of seconds that will be inserted after current time. 

- Select All (From Here To Current Time) 
All keys, containers and cues from the mouse pointer up to current time will be selected.

- All Active
This command sets all parameters of all devices to active.

205
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- All Active (Partially Active Devices)
This command sets all parameters of partially active devices to active.

- Clear All Active
This command clears all active parameters.

- Reset All
This command resets all active values.

6.3.4.24  Task Manager

To open the taskmanager tab, navigate to Tabs - Taskmanager or press CTRL+SHIFT+M on your
keyboard.

The taskmanager lets you monitor if a site is still loading files and if all file send and receive actions that
were initiated by a file or folder spread process.

If you click on Show File Transfer Tasks, you will get a list with the status of all file transfers.
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The site icon with a green stripe indicates that the site is still active receiving or loading assets. 
The same icon will also be shown in the Devices Tab.

The number of assets to load is shown next to the site name in the taskmanager. As soon as the
loading process is done "complete" will be displayed and the site icon turns back to the normal one.

Clicking on [Cancel Spread] will cancel the spreading process.
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If you encounter any network problems or issues of spreading files, individual items may be selected
from the list and removed to continue with other spread operations.

If you encounter issues that you cannot solve yourself by removing and/or restarting the project, please
collect the "details" description of the task that is causing the issue and report it to support@coolux.de.

6.3.4.25  Text Input Editor

Create your Text Input by right-clicking on a folder in the Project tab  >
Add Text Input. Select it to see its properties in the Text Inspector . It
also offers the button "Open in Resource Editor" which opens the tab "Text
Input Editor". Alternatively, you can click on 'Tabs' in the Toolbar > Text
Input Editor.

In the Text Input Editor you may set up all options regarding the content of
the selected Text Input. It also allows to transfer style properties to other
Text Inputs.

Please note, that .net framework 4.0 is needed to display this tab.

At the top of the depicted Editor you see in the drop-down list that only one Resource named "MyText."
is selected. If multiple Text Inputs were selected, the section "Behavior / Texture" applies to all of them.
Afterwards, it is displayed, that the according Text Input is assigned to the first Video Layer of the
second Site and that the Playback command  (from the Layer) is set to Play Loop. The playback is
needed when the Text Mode is set to Scrolling or Streaming and the container is changed from Lock To
Time  to free run mode. If the container is locked to time, and the sequence is playing, the text will
"play", i.e. move also. Mind that playing back is only possible on Video Layers. If you like to use
scrolling text on a Graphic Layer, please use the Aeon FX "UV Scroll ".

- Mode
--Static
Your text is displayed on a fixed position according to the Layer's Position parameters.
--Scrolling and Streaming
Your text will move according to the following parameters.
For the Scrolling Mode, you enter text, click "Update" and instantly the entire text will be displayed as
scrolling text. Depending on the playback mode, the text will scroll once or endlessly. The old text will
be kept in the Editor window. If you like to show new text, enter it and press "Update". In case, your text
is scrolling endlessly (Play Loop) the old text will change abruptly to the new one.
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For the Streaming Mode, you enter text, click "Commit" and after a couple of seconds, your entire text
will scroll once through the window. Note, that it cannot scroll endlessly. The old text will be deleted from
the Editor window. As soon as you enter new text and click "Commit", it stands in a pending line. Only
when the old text has moved out of the window, the new one can be displayed. This means on the one
hand that you can commit unlimited text entries and PB takes care, that one follows the other. This is
done by rendering multiple textures at the same time. Which also means on the other hand, that
textures can be empty if now pending text is available. This explains why you have to wait for the
duration of one texture width / height before recently committed text becomes visible. If you like to clear
pending text click the "Pending" button underneath the Editor. If you like to clear pending text and the
one currently displayed, click "All".

Please note that Widget Designer can send text to a Pandoras Box Text Input regardless from its mode.
You can use the Text Input control  or the PB Text Output node .

- Base Speed
Enter the speed for Scrolling and Streaming text. It is measured in pixel per second. When entering
negative numbers the direction will be reversed.

- Direction
Choose how Scrolling and Streaming text should move: "Horizontal" for right-left movement and
"Vertical" for down-up. Note that the direction can be reversed with a negative Base Speed.

Loop Offset
Influence whether Scrolling and Streaming text should have an offset, i.e. blank space before the start of
a new text entry.

Start with Blank
Decide whether Scrolling text should start with blank space before its first letter. Use the option "Offset 

BG Color / Alpha
Choose a background color (for all text modes) and its opacity (0 = transparent)

Width / Height
Set up how large the texture for a text entry should be. Note that this influences the Base Speed and
Font Size. The larger the Font Size the smoother font edges look and the larger the texture needs to be.

Center Text
This centers Static Text vertically.

 Enter your text into the Editor. If you have chosen a Static or Scrolling text, click "Update" to
display your changes. In case you are working with a Streaming text, click "Commit". See above
explanation for further detail.

 Undo your last steps or Redo undone ones.

1031 1208



303

 Cut or Copy selected text and Insert it with the last button. CTRL+A selects all text in the
Editor.

"Word Wrap in Editor" creates a new line if your text is longer than one line in the Editor.

 Choose a Font and the Font Size for selected text. Note that the Font Size
also depends on the texture width/height.

 Choose a Font Style for selected text: Bold, Italic, Underlined, Strike through,
Font Color (opens a Color dialog)

  Align Left, Align Center and Align Right are used to position your text in regards to the
texture width.

The last button  opens the "Transfer
Text Properties dialog".

In case you have selected multiple Text
Inputs in the Project tab, you can choose
with the drop-down list (at the very top)
which text is the "master" or "source".
Per default, all "Text" options apply only to
the master text. With this dialog however,
you can choose to transfer the current
options to all other selected Text Inputs
too. In case you have set up more than
one style in your master text, only the first
one can be transferred.

Select which property you like to copy and
press "Ok".

If you like to create multiple copies of your
current Text Input, please right-click on it
in the Project tab and choose "Clone".
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6.3.4.26  Thumbnail Viewer

The thumbnail viewer is context sensitive and depends on either an asset browser folder to be viewed or
a project tab folder entry to be viewed.

The thumbnail viewer displays both 2D and 3D media.

Please note: 
The 3D media is displayed with a default texture to identify the UV mapping orientation.
All video thumbnails will display a frame from the middle of the video. They do not show the first frame.

When used with the project tab and selected devices such as layers or cameras, you may double click
on any thumbnail to assign it to the current selection of devices.

Please be aware that all thumbnail images are stored locally. If the media is not present on all Clients
you may have to spread the media to all Clients in order to assign it to the selected devices.
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6.3.4.27  Video Export

To open the Video Export Tab, please click on 'Tabs' in
the Toolbar - Video Export. Please note that the Video
Export feature is limited to Manager editions and requires
the Encoding option.

The video export tab allows you to define all settings for
exporting a video from a sequence.
Set the Preview tab  to preview the specific output that
should be exported. Note that not the Preview itself is
exported. It is rather the image the camera sees, not the
one from the output. As a result all changes made in the
output are not included in the exported video. That
includes effects on the output layer and parameters like
softedge and keystoning.
If you like to change the aspect ratio of the exported video
select a camera layer and change the camera aspect
ratio .
If you like to change the resolution of the exported video
make the according changes in the encoding settings. 
If you export an uncompressed image sequence the
resolution is adopted automatically to the current screen
resolution the local system is set to.

Please note that incoming active values will be ignored,
e.g. Widget Designer and Art-Net data. This is because
the export is not running in real time, thus the incoming
data cannot be allocated to a specific frame. Same
applies to containers that are not locked to the timeline

. Free-run containers behave differently than during
normal play back as the time reference is missing.

The Export feature is designed to work with mpeg-2
videos, images and ASIO wav tracks. Exporting other
formats such as *.mov and *.avi might lead to unexpected
behavior. Please see the File Inspector  for adjusting
colorspace settings.

Also encrypted media  cannot be exported. On the
other hand you may encrypt your exported video
afterwards.

[Export]:
Click [Export] to start the video export. Please not that
the user interface is locked while the export is in process.
To abort the export, press the shortcut [CTRL + Q].
Please note that the video export won’t be done in real-
time. The higher the quality and resolution set in the
encoder the export will take a longer time to be finished.

[In]:
Define the timecode at which the export should start in
the format hh:mm:ss:ff.

239
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[Out]:
Define the timecode at which the export should end in the
format hh:mm:ss:ff.

[Max. Duration]:
You may define the maximum duration of the exported video file in the format hh:mm:ss:ff. By default the
max. duration is set to 2 hours.
Example: Having the inpoint set to 00:00:00:00 and the output set to 03:00:00:00, the video export will
stop after 2 hours.

[Target Name]:
Enter the name for the video file you are going to export. 
By default the video will be named “’Project name’_video”. 
If the option “Ensure Unique Name” is checked, the video file will be enumerated serially if the chosen
name already exists.

[Target Directory]:
By default the video will be saved to the directory of your project file. Click [Browse Directory] to browse
to a new directory if you want to change this path.

[Encoder Settings]:
In this section you may choose the settings of the file you’re going to export.
There are several predefined profiles:

Profile Name Output Type
Mpeg Settings

Resolution, px
Bitrate
(constant
), kbit/s

Audio
Processing

Profile Level

SD NTSC 720x480 MPEG-2 High High 720x480 8000 separate wav

SD PAL 768x576 MPEG-2 High High 720x576 8000 separate wav

XGA 1024x768 MPEG-2 High High 1024x768 10000 separate wav

HD 1280x720 MPEG-2 High High 1280x720 12000 separate wav

HD 1408x1056 MPEG-2 High High 1408x1056 15000 separate wav

HD 1920x1080 MPEG-2 High High 1920x1080 20000 separate wav

2048x1080 MPEG-2 High MXL 2048x1080 80000 separate wav

4080x2160 MPEG-2 High MXL 4080x2160 80000 separate wav

Uncompressed Uncompressed Frame Images (.png) Computer’s resolution none

These profiles are not editable. You may choose one of these profiles from the drop-down list or create a
new profile by clicking on [New].

[New]:
Click [New] to create a custom encoding profile and name it.

[Output Type]:
Choose between MPEG-1, MPEG-2 and an image format to export an image sequence.
When using MPEG-1 or MPEG-2 go on with the MPEG settings. Pandoras Box Encoder allows to
encode files larger than 1080p to our proprietary .mxl format. The maximum resolution is 4094 x 2800
px, though it is recommend set 4080 x 2800 px as this conforms with the mpeg standard. The encoding
process depends on available graphic card RAM.
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If you like to export an image sequence, you may choose between three image formats: png as an
lossless compression format, bmp as an uncompressed format and dds as an lossy compression
format. For more information please see the chapter "Image Sequences" .
Now, simply enter the resolution for the final image sequence and tick the "Export Alpha" check box if
you need transparent image parts. Adjust the audio processing as described below.

[Profile]
Set the MPEG Profile and Level. 
Please note that you will need High Profile (Profile 4:2:2:) and High Level for HD 1920x1080 px 
resolution. The Level automatically changes to MXL if you encode files to a format bigger than 1920 x
1080 px.

[Resize Video]:
As long this option is not checked the video resolution will have the size of your windows desktop.
Check [Resize Video] and insert a custom resolution for X and Y (in px) if necessary.

[Bitrate (constant)]:
Choose the bitrate (in kbit/s). Recommended are about 8.000 kbit/s for SD and 20.000 or higher for HD.

[GOP-Length]:
The length of the Group Of Pictures is editable from 1 to 100. The higher the GOP-Length the better the
compression rate gets at the expense of quality. GOP set to 1 will use I-frames only.

[Number of B-Frames]:
Choose a value between 0 and 7.

[Motion Estimation Level]:
Set a value between 0 (no motion search) and 15 (high quality). The higher the value, the better the
quality, the longer the encoding process.

[Motion Estimation Range]:
Set a value between 0 (no motion search) and 15 (high quality).

[Scene Change Detection]:
Choose between None, Fast and Refined.

[Audio Processing]:
Please note that only the first and second ASIO channel are
processed.
Choose between the options to...
- discard the audio information, it is simply not present in the
resulting export files 
- split to separate WAV (stereo file) to render one wav file
with two channels; the file is created in the same export

folder
- split to separate WAV (mono files) to render two wav files each with one channel; the files are created
in the same export folder
- include the audio as a audio track; this is only possible for mpeg videos. Please see further information
and why it is sometimes not recommended to include audio tracks in the mpeg format .

98
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6.3.4.28  Video Recording

The Video and Audio Recording tab allows you to define
all settings for recording a local video and / or audio live
input source. Please note, that the recording tab is only
available in the Master interface, and that the feature is
restricted to local inputs excluding remote inputs from
Clients.

Record:
Click the "Record" button to start the video and audio
recording. Press this button again to stop the recording.

Video / Audio Input:
Choose the video and audio source you would like to
record. Note that these sources must be added to the
project first.

Limit Record Duration:
Enable this function and enter a time when you would like
to record the sources for a defined time.

Target Name:
Enter the name for the video file you are going to record. 
By default the video will be named “’Project
name’_video”. 
Please note: if the file name already exists and you start
a new recording with the same name, the existing file will
be overwritten without warning.

[Target Directory]:
By default the video will be saved to the directory of your
project file. Click [Browse Directory] to browse to a new
directory if you want to change this path.

[Encoder Settings]:
In this section you may choose the settings of the file
you’re going to record.

There are several predefined profiles:
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Profile Name Output Type
Mpeg Settings

Resolution, px
Bitrate
(constant
), kbit/s

Audio
ProcessingProfile Level

SD NTSC 720x480 MPEG-2 High High 720x480 8000 separate wav

SD PAL 768x576 MPEG-2 High High 720x576 8000 separate wav

XGA 1024x768 MPEG-2 High High 1024x768 10000 separate wav

HD 1280x720 MPEG-2 High High 1280x720 12000 separate wav

HD 1408x1056 MPEG-2 High High 1408x1056 15000 separate wav

HD 1920x1080 MPEG-2 High High 1920x1080 20000 separate wav

2048x1080 MPEG-2 High MXL 2048x1080 80000 separate wav

4080x2160 MPEG-2 High MXL 4080x2160 80000 separate wav

Uncompressed Uncompressed Frame Images (.png) Computer’s resolution none

These profiles are not editable. You may choose one of these profiles from the drop-down list or create a
new profile by clicking on [New].

[New]:
Click [New] to create a custom encoding profile and name it.

[Output Type]:
Choose between MPEG-1, MPEG-2 and Uncompressed.
When using MPEG-1 or MPEG-2 go on with the MPEG settings. 
Using the uncompressed output type there is nothing more to set up. This output type will render
uncompressed frame images (.png) in the resolution your local computer is set to. There will be no audio
processing.

[Profile]:
Set the MPEG Profile and Level. 
Please note that you will need High Profile (Profile 4:2:2:) and High Level for HD 1920x1080 px 
resolution. The Level automatically changes to MXL if you encode files to a format bigger than 1920 x
1080 px.

[Resize Video]:
As long this option is not checked the video resolution will have the size of your windows desktop.
Check [Resize Video] and insert a custom resolution for X and Y (in px) if necessary.

[Bitrate (constant)]:
Choose the bitrate (in kbit/s). Recommended are about 8.000 kbit/s for SD and 20.000 or higher for HD.

[GOP-Length]:
The length of the Group Of Pictures is editable from 1 to 100. The higher the GOP-Length the better the
compression rate gets at the expense of quality. GOP set to 1 will use I-frames only.

[Number of B-Frames]:
Choose a value between 0 and 7.

[Motion Estimation Level]:
Set a value between 0 (no motion search) and 15 (high quality). The higher the value, the better the
quality, the longer the encoding process.
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[Motion Estimation Range]:
Set a value between 0 (no motion search) and 15 (high quality).

[Scene Change Detection]:
Choose between None, Fast and Refined.

[Audio Processing]:
Discard the Audio Part (if applicable), split it to a separate wave-file (will be created in the same folder) or
choose to include it. The Audio Part is discarded by default.

6.3.4.29  View Tab

The view tab lets you recall stored view layouts of the user interface with a single mouse click. This
makes it very easy and fast to switch from one view, e.g. focusing on a large Preview window and the
AEON FX tabs open, to another view, e.g. displaying not the Preview tab but the patch tab and having
the sequence and device control tab separated.

The chapter "Layout " describes how you can influence the GUI layout: inserting new tabs and panes,
breaking panes out, removing and resizing them.
The chapter "Views ", explains how to store and recall views in the Project tab instead of doing this in
the Views tab.

Once you have set up a view layout that you would like to store,
right-click in the Views tab (in an empty region) and choose "Create
View".

The new view item has now stored all tab locations and sizes of the
user interface. If you're applying any changes now, you can recall the
stored view at any time later on by simply clicking on it.

Choose "Apply Default To Tabs" if you want to reset the views to
default layout.

In the view tab you will see now a new entry that you can click on to
activate the newly created view, or right-click on it to access its
functions:
- - Apply To Tabs
This command activates the view.

- Save Current Tabs To View
This command lets you update and overwrite the stored view with the
current view layout.

- Remove
This command removes the view.

6.3.4.30  Virtual Site

Instead of using groups to get changes made on several sites, it is more comfortable to work with a
Virtual Site. 

All desired devices with the same device type can be combined to one virtual site. Changing a value on a
layer of this virtual site will change the value on the same layer of all combined devices.

314
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Please note:
If the sites that you want to make part of a new Virtual Site contain sequence information, all this
sequence information will be deleted in the course of Virtual Site creation. This action cannot be undone!

Please select all sites that should be combined, make a right-click on one site and choose "Create
Virtual Site".

The selected sites will disappear from the device tree and you will now see the Virtual Site instead. 

Applying a parameter value or content to Virtual Layer 1 of the Virtual Site will apply it automatically to
all Layer 1 of all sites that are combined in the Virtual Site. 
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In order to see which sites are combined into the Virtual Site, please select the Virtual Site and open the
"Virtual Site" Tab (Tabs -Virtual Site). Find here all combined Sites listed.

If you select one of the sites you still have access to the site inspector to edit its settings.

To set up different camera offsets for each Server, select the camera device in the device tab and view
the virtual site tab. You will find all camera 1 of all Servers listed. Click on the parameter of the device
you want to edit and enter an offset value (plus or minus) or move the mouse cursor up and down. This
offset will always be added to the parameter's value that is set up for the virtual site's device. If the X
Offset for the virtual cam1 is set to 32768, in this example below the X Offset of Server 1 camera 1 will be
33658 (32768 + 800).

To reset the entered offsets, right-click on the device and choose 'Remove'.
To remove a Device from the virtual site, select the virtual site in the device tree. Then right-click on it and
choose Remove.

To remove the virtual site right-click on it and choose Remove. You will again get access to all single
devices that were combined in the virtual site.
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Please note:
If a single site is removed from the Virtual Site, all its sequence information will be deleted in the course
of removing the Virtual Site. The same happens when deleting the whole Virtual Site. This action cannot
be undone!

The right-click menu provides the following commands:

- Reset All
This command will reset all parameters for all layers of this node.

- All Active
This command will activate all parameters of all layers of this node.

- All Active (Partially Active Devices)
This command will activate all parameters of all layers of this node that have active parameters.

- Clear All Active
This command will de-activate all parameters of all layers of this node.

- Toggle Preview
This command sets the node to be included in the Preview tab.

- Rename
This command will enable you to rename the node. You can also do this by pressing F2.

- Toggle Devices
Choose which layers you want to show or hide in the device tree.

- Toggle Sites
Choose which sites you want to show or hide in the device tree.

- Remove
This command removes the virtual site from the device tree. You will again get access to all single
devices that were combined in the virtual site
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6.3.5  Layout

The user interface layout can be customized and stored in several views to be recalled at any time during
operation. A view is determined by the layout of the panes and the tabs they contain. For example the
default view consists of six panes, the top left pane displays the Project tab and Sequence Control tab.

The user-interface can be freely arranged by adding or
removing panes and by resizing them.

If you right-click between two existing panes as seen in the
image to the left, or if you click between a pane and the main
frame's border the context menu offers you to insert a new
pane. The command "Insert Pane ..." completes either with
"Above, Below, To Right or To Left" according to the position
where you clicked.

A new placeholder was inserted in the main frame, as a next
step you may drag an existing tab into it. Click on the title of
a tab and drag it into the title of the new pane.

To adjust the pane size, left-click between two panes and
drag the mouse.

If you right-click into the title of an existing pane, you will see
additional options to split the pane. If you choose to split it
horizontally the existing pane will be divided into two panes,
one upon the other. A vertical cut will give you two panes
side by side. You may choose where you like to keep the
existing tab.

The command "Break Out Pane" will release the pane from
the fixed structure - it will break the pane out of the main
frame. Now you can move and scale the new window
independently. Note that the window will always be on-top of
the GUI window.

A broken out pane offers the same options as an integrated
pane: you may drag tabs into it, insert new panes or split
them horizontally and vertically. You may as well remove it
completely. When deciding to keep the tabs they will be
moved to the next available pane.

To re-integrate a broken out pane, make a right-click into its
title and choose the option "Return To Main Frame Next To
Tab". Two new sub dialogs let you choose whereto position it
exactly. For example you may decide to insert the broken
out Inspector left to the Device Tree, it's default position.

Please note:
The Device Tree and Sequence tab can not be moved or be
broken out; these two tabs are always linked to each other.

The Preview tab can only render on the screen that is a
primary screen in Window´s!
For example, if you have an additional monitor attached to
your laptop where Pandoras Box Manager runs on and you
like to have a large Preview window, open the display
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settings first before starting Pandoras Box and make sure
that the attached screen is set up to be the primary screen.
Now open the Master software, break out a pane and drag
the Preview tab into it. Now you may move the broken out
pane to the attached display and maximize the window.
Please note that you will always see the Window´s title bar.

If you want to add additional tab items to your view layout
you may find all available tab items in the main menu bar
under “Tabs ”. By choosing one of the items, the
selected view will be created in the user-interface and can
then be moved to the desired pane.

You can save several views and toggle between them with
a single mouse-click. How to do this is described in the
chapter "View Tab ".

281

310



316

6.3.6  Keyboard Shortcuts

F1 Launch help

F2 Rename (e.g. in tabs: Project or Device Tree)

F5 Refresh selected folder in Assets tab

CTRL + SHIFT + A Refresh file tree in Assets tab

CTRL + left mouse click
in addition to the currently selected item, another one is selected too
(e.g. in tabs: Project, Asset, Device Tree, Timeline)

SHIFT + left mouse click
in addition to the currently selected item, another one and all in
between are selected too

CTRL + A Selects all entries in a playlist

SHIFT + S Spread all resources

CTRL + Pause lock/unlock GUI (keyboard, mouse, Jog Shuttle)

CTRL + Q Stop Video Export

CTRL + Z Undo last step

CTRL + SHIFT + Z Redo undone step

Preview Navigation

Scroll Zoom

Drag
(middle mouse button / wheel)

Pan

ALT + Drag Rotate

CTRL + 0 Applies default view to Camera or Output when in Zoom mode  (not
Parameter)

CTRL + F Toggle fullscreen

1,2,3 Move, Scale, Rotation Mode

X,Y,Z set axis constraint

M, F, V Select Sub Mesh, FFD or Vertex

 /  /  /  / left mouse click Select single sub mesh, FFD or Vertex point

CTRL +  /  /  / 
or left mouse click

Add control point to current selection

SHIFT (+ ALT) +  /  /  / Warp mesh according to selected sub mesh, FFD or Vertex points
(ALT key for 10 steps at once)

ALT +  /  /  /  Move current selection

Timeline and  Device Tree shortcuts:

SPACE Play / Pause

ESC Clear current device selection

CTRL + L Lock selection

Left mouse drag in the timeline
(+ ALT)

Select keys and containers in the timeline
(and cues in the time bar)

CTRL + C Copy keys, containers and cues to clipboard from source devices

CTRL + V Paste keys, containers and cues from clipboard to same device

CTRL + SHIFT + V Paste keys, containers and cues clipboard to selected devices

+ / - on the main keyboard;
SHIFT + left mouse drag up/down
in the time bar (above the timeline)

Zoom the timeline

SHIFT + +/- Zoom parameter value in the Curve Editor tab

 / Set the nowpointer to the previous / next frame

236
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CTRL +  / Jump to previous / next key (including clip borders)

CTRL + ALT +  / Jump to previous / next cue

SHIFT +  / Move selected keys and containers to previous / next frame

CTRL + left mouse drag Copies selected keys, containers and cues

CTRL + SHIFT + I
Toggle "Ignore Next Cue":
The current loaded timeline ignores the next cue or not (toggle), the
ignored cue will be colored orange.

CTRL + ALT + S Store active values as keys to the timeline

CTRL + ALT + R Reset all values

CTRL + ALT + C Clear all active values but do not reset them

CTRL + ALT + A All active (marks all values as an active value)
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File Menu shortcuts:

CTRL + N New project

CTRL + O Open project

CTRL + S Save project

CTRL + SHIFT + S Save project as

CTRL + SHIFT + ALT + S Save project copy

CTRL + B Bundle project

CTRL + W Close project

CTRL + Q
ALT + F4

Exit application

When working in device tree, the following shortcuts apply to current selected device:

A Show all parameters

H Hide all parameters

U Show only parameters used in sequence / Show all parameters

M Show / hide Media parameter

O Show / hide Mesh (Object) parameter

I Show / hide Opacity parameter

V Expanse / collapse Playback parameters

X Expanse / collapse Audio parameters

P Expanse / collapse Position parameters

R Expanse / collapse Rotation parameters

S Expanse / collapse Scale parameters

T Expanse / collapse Rotation Pivot parameters

D Expanse / collapse Scale Pivot parameters

B Expanse / collapse Blend Mode parameter

F Expanse / collapse FX parameters

G Expanse / collapse Particle System parameters

To open or load tabs use these shortcuts:

CTRL + R Open the Project tab

CTRL + T Open the Assets tab

CTRL + I Open the Device Viewer tab

CTRL + SHIFT + L Open the Device Controls tab

CTRL + D Open the Active Values tab

CTRL + E Open the Timeline tab

CTRL + M Open the Inspector tab

CTRL + SHIFT + R Open the Thumbnails tab

CTRL + K Open the Configuration tab

CTRL + P Open the Patch tab

CTRL + SHIFT + M Open the Taskmanager tab
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6.4  User Interface - Client

This chapter explains the user interface of a Pandoras Box Client system. The Master's interface  is
covered in the previous chapter. The chapter Master / Client Remote Setup  explains the general
difference between a PB Master and PB Client, how to connect them and how to include a Client device
in your Master project.

The Client User Interface allows you to set up as follows:

- Toggle Full Screen by clicking "Full Screen" or alternatively press CTRL+F
- Click "Configure Live Inputs" and a configuration window  will open (please see more details about
live inputs and how to use them in Pandoras Box in the chapter "Input Card Settings" )
- Change the domain channel and confirm it by clicking "Assign Domain"
- Choose a dedicated network adapter in the drop-down list
- Check "Open in Full Screen Mode" and the next time starting the Client it will open in full screen-mode

See the following chapters for more information about the Client:
Client Live Input Configuration
Client Keyboard Shortcuts

More settings regarding the render engine (e.g. Full Screen is single) can be found in the Master
interface: Configuration tab > Render Engine
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6.4.1  Client Live Input Configuration

Since you may have various different live input cards or software screen grabbers available within your
system, you may choose the one that you want to configure from the live input list.

Please note that Pandoras Box supports most input devices that are conform and support DirectShow.

Depending on the installed component, the according driver window will show up and lets you set up the
available parameters of the input device.

StreamiX Live Inputs are described in this chapter.

6.4.2  Client Keyboard Shortcuts

CTRL+F  Toggle Fullscreen

674
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6.5  Device Control

The following chapters explains all different devices and layer types
that can be added to the timeline.
Please see the topics Sequence , Device Tree  and Device
Control tab  if you are rather interested in learning how to actually
add devices to the device tree or how to work within the Sequence,
i.e. how to change and store values, program timelines etc. The topic 
User Interface  describes all tabs.

One of the most important features of Pandoras Box is its ability to
control a wide range of devices based on various output control
protocols. Beside the Pandoras Box product range other devices
such as  DMX, RS232 / 422 or any TCP/IP device might be remote
controlled from any timeline as well. This allows perfectly
synchronized show control. The topic External Control  goes more
into detail. The access to and the number of those devices is not
limited whilst Pandoras Box layers depend on the Manager, Player
and Server license. See the Product Overview  for detailed
information.

See the following chapters:
Video Processing Pipeline  – Get a clue about the layer and
rendering structure in Pandoras Box

function Manager Player Server

Video Layer full motion video (and audio) playback; images - yes yes

Graphic Layer static images or still frames of videos yes yes yes

Pointer displaying the mouse pointer or touch inputs yes yes yes

Light illumination of other layers including shadow - - yes

Audio Track ASIO playback, synchronized to the Master clock yes yes yes

Camera set up the viewpoint / look-at-point onto your 3D
composition; first render path / Composition Pass

- yes yes

Output controls the overall output of the Server or Player
including keystone and softedge; second render path
/  Output Pass

- yes yes

DMX Devices remote control external DMX device via DMX / Art-Net

Serial Link Device remote control Serial Link or other external RS232 / 422 or TCP/IP devices

Sonic Emotion multichannel audio plug-in for synchronized audio; requests Sonic Emotion
hardware

Widget Designer
Device

sending commands and values to Widget Designer application
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6.5.1  Video Processing Pipeline

This chapter explains the fundamental video processing pipeline in Pandoras Box V5. It is separated in
two render passes
- the (layer) composition pass, most important for the creation process
- the output pass, most important for the technical setup

Step 1, the Creation
Process:

Here you do your layer
composition - setting the
media, the video playback,
position, rotation and scale
parameters as well as the
visual effects. The render
history is determined by the Z
Position respectively, if it is
not set, by the layer
arrangement whereas the
topmost layer in the Device
Tree tab is rendered first and
thus overlaid by other layers.
The end of step 1 is
determined by adjusting the
camera’s perspective onto
your 3D composition.

Step 1 includes:
Video Layer Control
Graphic Layer Control
Camera Control

At the end of the composition pass, the "Output to Texture" process generates a so called render target.
There is a render target for each camera. If you have a Dual Server for example, there would be two
render targets. These textures are forwarded...
- to the next pass if the output's render state  is not set to bypass
- to the graphic card's output, thus your connected display if the output's render state  is set to
bypass
- to be send through the matrix patch  (note that the output's render state  may not be set to
bypass)
- to be rendered for the video export

Camera setup Render Target 1 Render Target 2
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Step 2, the Technical
Setup:

Here you match the texture to
your technical setup. 
The source media is
determined by the render
target or by a video / graphic
layer's media if the layer is set
to not be included in the
composition pass (and as a
result they are not part of the
render target). This can be set
up in the layer's Inspector .
As this is not the default
setting, the layers in the left
image are marked with a star
(*).

In the output pass you may set up:
- a warping object if the texture is projected on a bended screen,
- softedge or keystone adjustments,
- a color correction on the whole output (via FX)
- blacklevel compensation

Step 2 includes above mentioned video / graphic layers controls if a layer is only rendered in this pass,
and the Output Control .

At the end of the output pass, the "Output to Display" forwards a texture to the so called backbuffer
respectively to the graphic card and thus your connected display. 
For the above depicted example to possible outputs could be:

for output 1, a warp object
has been applied and
softedge settings were
used

 for output 2, keystone and
softedge settings were used

6.5.2  Video Layer Control

210
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A Video Layer allows full motion video playback as well as rendering still images.
The Video Layer Control includes the following sections. Information about DMX Control is included,
addressing customers who wish to remote control a layer with a lighting desk via DMX or Art-Net. If you
like to use the Widget Designer or another application instead, please refer to this parameter list .

Media Selection
Opacity
Playback
Audio
Position
Rotation
Scale
Rotation Pivot
Scale Pivot
Blend Mode
FX

6.5.2.1  Media / Mesh

Media Selection

To assign a media resource to a layer, drag and drop the resource from the project tab onto the
designated layer. You can also highlight the target layer by left-clicking on it and use the right-click
command on the resource in the project tab “assign to active device” or just double-click on the media
file. Media can also be assigned from the thumbnail browser by double clicking it for attributing it to the
selected highlighted layers.

Please note: When working in a network session in Master/Client mode, please make sure that all
media and objects are spread to all Clients in order to be available for all Servers to render.

To remove the resource of the layer, right-click on the thumbnail in the Device Control Tab and choose
“Reset”. Alternatively you can open the media or mesh parameter in the layer tree and after right-clicking
you can choose “Reset” there.

DMX Control
For DMX control depending on the ID assignment in the Pandoras Box Server user interface, each layer
can access 255 folder and 255 file IDs of individual media files as well as live inputs.
The media selection channels are 8bit, the default value is set to 0.

Media Folder

0 No folder

1..255 Folder 1..255

Media File

0 No file

1..255 File 1..255
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Share Layer Texture / Source Routing

A new feature of PB V5 Servers is sharing the texture of a layer with one or several other layers. This
way you can playback a video file without having to load it several time. This allows a better performance
than loading it several times.

Example:
To share the texture of layer 2 with layer 4, right-click in the field “Media” in the device control of layer 4
and click “Share Layer Texture”. A list with all available layers appears and “Layer 2” is chosen. Instead
of a media file’s thumbnail the Layer Icon now is shown, titled by the ID of the layer whose texture is
shared (here: Layer2).

Object Selection (Mesh)

Each Layer has a default layer object which defines the mapping of the texture (your media file). The
Mesh field allows loading custom object files to change this mapping behavior. Valid object file types are
.clx- and .x-files.

To assign an object to a layer, drag and drop the resource from the project tab onto the designated layer.
You can also highlight the target layer by left-clicking on it and use the right-click command on the
resource in the project tab “assign to active device” or just double-click on the object file.

To remove the resource from the layer, right-click in the layer tree on the object parameter and choose
“reset”.

DMX Control
For DMX control depending on the ID assignment in the Pandoras Box Server user interface, each layer
can access 255 folder and 255 file IDs of individual object files.
Object file selection set to 0% (000dec.) selects “no file”.

The object selection channels are 8bit, the default value is set to 0.

Object Folder

0 No folder

1..255 Folder 1..255

Object File

0 No folder

1..255 Folder 1..255
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6.5.2.2  Opacity

The opacity sets the transparency of an image or video content on each layer.  

Opacity 0% (value 0) fully transparent
Opacity 100% (value 255) fully visible 

The opacity control allows smooth transitions for every layer. To add a Transition FX , please see the
chapter FX .

Please note: 
Compared to the handling up to PB Version 4.7, the opacity parameter does not control the audio
volume anymore! No matter if the video file itself contains an audio part or a pure audio file is loaded.

The volume now is controlled by the parameter Volume in the Audio Section .

Use the opacity control in conjunction with the Transition FX  to define the behavior of a cross-fade
between two layers. Two layers blended with different kinds of TransitionFX create individual kinds of
dissolves. The opacity channel always affects the entire alpha channel of the selected layer, independent
from any chosen FX. A wide variety of wipes and dissolves is available in the TransitionFX section.
Together with the TransitionFX, the opacity channel can also be used to superimpose two images on top
of each other or to mask specific areas.

DMX Control
The opacity channel is 8bit, the default value is set to 0.

Opacity

0..255 Fully transparent..Fully visible
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6.5.2.3  Playback

Each layer has individual playback control for video and audio files. The playback section is divided into
the following parameters: Playback Transport, Speed, In- and Outpoint.

Playback Transport

The playback control channel allows setting the video mode to Play Once, Stop, Pause and Play Loop.

DMX Control
The Playback Transport channel is 8bit, the default value is set to 0.

Playback Transport

0 Stop

64 (1-127) Play Once

128 Pause

192 (129-255) Play Loop

Playback Speed

The speed of the video playback may be varied by changing the Speed Parameter value.
The default value (1:1 Speed) is 128 (=100% in percentage view, see configuration tab ).

Slowing down the speed of a video file will reduce the framerate. In order to keep a smooth playback you
may want to use FluidFrame™  for this video file.

Please note: The speed and playback behavior varies, depending on the used codec.
Some video codecs may not support different playback speeds and some codecs may not be suitable
for seamless looping. 
Optimal playback can be achieved if you use mpg2 files or Microsoft DV AVI files.
Please see the Encoding  section and the format  description for further information as well.

DMX Control
The Speed channel is 8bit, the default value is set to 128.

Playback Speed

0..127 slower

128 1:1 Speed

129..255 faster

140

191

102 101
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Inpoint / Outpoint

Set the in- and outpoint to define the specific start & end marks of a clip, the play once and play loop
video mode will work in the resized area.
The In- & Outpoint selection works on a percentage base of the overall frame length. Use “Pause” and
look up with the Inpoint the frames from where you want to start the file playback.
When programming containers in the timeline you can alternatively enter the exact frame number you
like to start (or end with) by using the "In" (or "Out") value in the Clip Inspector . It is also possible to
enter exact timecode in frames, seconds etc.

DMX Control
The In- and Outpoint channels are 16bit.

Inpoint, the default value is set to 0.

0 File beginning

65535 End of file

Outpoint, the default value is set to 65535.

0 File beginning

65535 End of file

6.5.2.4  Audio

With the Volume parameter in the Audio Section you will control the Volume of both: Video Files
including an audio part and plain audio files such as .wav- or .mp3-files.

Note that playing back sound with a video layer eliminates the possibility to synchronize the video
playback. If synchronized playback is demanded, please use ASIO tracks  instead.

DMX Control
The volume channel ranges from -96 dB to +6 dB, this corresponds to the DMX values 0..65535.
The Audio Channel is 16bit, the default value is set to – 96 dB.

Please note, that for Widget Designer or other controlling applications, the range of values is 0 - 2, more
information can be found in the parameter list .

204
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6.5.2.5  Position

For Server, each layer can be positioned in XYZ
individually. Players do not support the Z axis.

Each position parameter covers the value range from -
999.999 to +999.999 units for pixel accurate
positioning of layers (the DMX Control uses a 16 bit
channel covering the value range -256 to +256 units,
see below).

The Pandoras Box output is always 16 units wide. The height is calculated by the aspect ratio.
A 4:3 display is 16 units wide and 12 units high.
A 16:9 display is 16 units wide and 9 units high.

Example:

The image on the left shows a 16:9 image/layer with X-/Y-/Z-Position = 0.
Image in the middle: the X Pos is set to +8.000: the layer moves half of its width to the right.
Image on the right:  the Y Pos is set to -4.500: the layer moves half of its height down.

By default the position pivot is located in the layer’s center. Only the scale and rotation pivot can be
relocated.
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DMX Control
All position channels are 16bit and the default value is 32768.
Resolution: 1 DMX Step = 0.008 units

X Position (16 bit):

0 max. Image offset left (-256 units or 16 screen width to the left)

32768 Center

65535 max. Image offset right (+256 units or 16 screen width to the right)

Y Position (16 bit):

0 max. Image offset bottom (-256 units)

32768 Center

65535 max. Image offset top (+256 units)

Z Position (16 bit):

0 max. Image offset far (-256 units)

32768 Center

65535 max. Image offset near (+256 units)

Images above: Depending on the XYZ position of a layer, the Z position affects the rendering order .

Please note: If the camera  is set to “perspective projection mode”, the Z axis will visually affect the
size of the selected layer. This will not happen in the “orthogonal” mode.

Note that you can also use the Align function  as described in the chapter about the Status bar.
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6.5.2.6  Rotation

For Server, each layer can be rotated in XYZ
individually. Players only support the rotation about
the Z axis.

For each axis you have parameters to set the angle,
the rotation mode (Fixed Angle or Rotation Speed)
and the rotation speed.

By default the rotation pivot is located in the layer’s X/
Y/Z center. This can be changed by modifying the
rotation pivot’s position in the “Rotation Pivot”-Section

.

Rot Mode

Depending on the rotation mode a fixed angle (in °) or a
rotation speed (in rotations per hour) may be applied to the
X-/Y- and Z axis. By default the rotation mode is set to “fixed
angle”.
If the Rot Mode is set to “Rot Speed”, the layer will rotate

continuously. Any changes to the fixed Angle value won’t affect the rotation any more.

DMX Control
All Rotation Mode channels are 8bit and the default value is 0.

X Rot Mode

0 Fixed Angle

1 Rotation Speed

Y Rot Mode

0 Fixed Angle

1 Rotation Speed

Z Rot Mode

0 Fixed Angle

1 Rotation Speed

336



332

X / Y / Z Angle

Use the X/Y/Z Angle to set a fixed angle to the layer. Please note that the Rotation Mode needs to be
set to “Fixed Angle” to apply this angle!

Each angle parameter (X/Y/Z angle) covers the value range -999.999° to +999.999°, this corresponds to
almost 3x 360° turns into the positive and negative direction.
The DMX Control uses a 16 bit channel for each angle parameter, covering the value range -1080° to
+1080°, see below.

DMX Control
All angle channels are 16bit and the default value is 32768.
Resolution: 1 DMX Step = 0.033°

X Angle 

0 -1080° or 3 rotations forward

32768 0°

65535 +1080° or 3 rotations backward

Y Angle 

0 -1080° or 3 rotations to the right

32768 0°

65535 +1080° or 3 rotations to the left

Z Angle 

0 -1080° or 3 rotations clockwise

32768 0°

65535 +1080° or 3 rotations anti-clockwise
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X / Y / Z Rot Speed

Use the X/Y/Z Rot Speed to set a continuous rotation to the layer. Please note that the Rotation Mode
needs to be set to “Rotation Speed” to apply this continuous rotation!

Each rotation speed parameter (X/Y/Z rotation speed) is 16 bit and covers the value range -32768 to
+32768. 
1 Unit / DMX Step corresponds to 1 rotation per hour.

Example:
To turn the layer 2 times per second the Rot Speed should be set to
60 (minutes) x 60 (seconds) x 2 = 7200.

1 rotation per hour: value 1
1 rotation per minute: value 60
1 rotation per second: value 3600

DMX Control
All Rotation Speed channel are 16bit and the default value is 32768.
Resolution: 1 DMX Step = 1 rotation per hour.

X Rot Speed 

0 min. Rotation Speed

32768 Stop

65535 max. Rotation Speed

Y Rot Speed 

0 min. Rotation Speed

32768 Stop

65535 max. Rotation Speed

Z Rot Speed 

0 min. Rotation Speed

32768 Stop

65535 max. Rotation Speed

Note that you can also use the Align function  as described in the chapter about the Status bar.133
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6.5.2.7  Scale

Image scaling allows setting either individual aspect
ratios or object sizes. Whilst the Server supports
scaling along the XYZ axis, Players do support X and
Y only.

When using the scaling on a layer the assigned video
or still image is resized automatically to the scale of
the object. Scaling can also be used to zoom into a
layer while the pixels are interpolated to give a
smooth result.

Each scale parameter covers the value range from -
999.999 to +999.999 units (the DMX Control uses a
16 bit channel covering the value range 0 to 65535
units, see below).

By default the scale pivot is located in the layer’s X/
Y/Z center. This can be changed by modifying the
scale pivot’s position in the “Scale Pivot”-Section .

Scaling values:

2: double size

1 (default): original size

0.5: half size

0:
minimum size (layer is not
visible)

-0.5: half size, layer is flipped

-1: original size, layer is flipped

-2: double size, layer is flipped
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Example:
This is the original image.

The X Scale factor is varied in the image sequences below
Image Sequence1: Left: X Scale=2; Center: X Scale=1; Right: X Scale=0.5

Image Sequence2: Left: X Scale=-0.5; Center: X Scale=-1; Right: X Scale=-2

DMX Control
All scale channels are 16bit and the default value is 1000.
Resolution: 1 DMX Step = 0.001 units.

X Scale

0 min. Scale (layer is not visible)

1000 1:1 Scale

65535 max. Scale (scaling factor: 65.535)

Y Scale

0 min. Scale (layer is not visible)

1000 1:1 Scale

65535 max. Scale (scaling factor: 65.535)

Z Scale

0 min. Scale 

1000 1:1 Scale

65535 max. Scale (scaling factor: 65.535)

Please note: due to the reduced DMX control value range the image can not be flipped!

Note that you can also use the Align function  as described in the chapter about the Status bar.133
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6.5.2.8  Rotation Pivot

The rotation pivot section allows moving the rotation pivot to positions others than the layer’s center
point. Any X, Y and Z Rotation applied to this layer then will use the new position as pivot. Please
remember that Players do not support the Z axis.

Each position parameter covers the value range from -999.999 to +999.999 units (the DMX Control uses
a 16 bit channel covering the value range -256 to +256 units, see below).

The Pandoras Box output is always 16 units wide. The height is calculated by the aspect ratio.
A 4:3 display is 16 units wide and 12 units high.
A 16:9 display is 16 units wide and 9 units high.

How the Rotation Pivot effects the rotation

Applying a Z Rotation with the default position of the rotation pivot (X/Y/Z Pos=0) turns the layer around
its center point.

The image sequence shows Z rotation angles from 0° to -180°. The Rotation Pivot’s position is set to
default (X/Y/Z Pos = 0; Center Point).

Now the position of the rotation pivot is changed to X Pos=8 (right screen border) and Y Pos=4.5 (top
screen border).

The image sequence shows Z rotation angles from +90° to -90°, the rotation pivot is located in the corner
top right.

Viewing the Rotation Pivot

In order to see the position of the rotation pivot in the Preview window , please do this:
1. Check the option “Show Handles” below the Preview window.

246
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2. Now click the rotation icon on the top left.
3. The rotation pivot gets visible.

When changing the position of the rotation pivot with the rotation pivot X/Y/Z Pos parameters, the pivot
will move to its new position. If the rotation pivot is located outside the output area, you may change over
to Global Cam View to still see its position:

Image above: the position of the rotation pivot is changed to X Pos=-17.2, Y Pos=-7.1, it is outside the
outputs visible area.

DMX Control
All rotation pivot channels are 16bit and the default value is 32768.
Resolution: 1 DMX Step = 0.008 units

Rotation Pivot’s X Position

0 max. rotation pivot offset left (-256 units)

32768 Center

65535 max. rotation pivot offset right (+256 units)

Rotation Pivot’s Y Position

0 max. rotation pivot offset bottom (-256 units)

32768 Center

65535 max. rotation pivot offset top (+256 units)

Rotation Pivot’s Z Position
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0 max. rotation pivot offset far (-256 units)

32768 Center

65535 max. rotation pivot offset near (+256 units)

6.5.2.9  Scale Pivot

The scale pivot section allows moving the scale pivot to positions others than the layer’s center point.
Any X, Y and Z scale applied to this layer then will use the new position as pivot.  Please remember that
Players do not support the Z axis.

Each position parameter covers the value range from -999.999 to +999.999 units (the DMX Control uses
a 16 bit channel covering the value range -256 to +256 units, see below).

The Pandoras Box output is always 16 units wide. The height is calculated by the aspect ratio.
A 4:3 display is 16 units wide and 12 units high.
A 16:9 display is 16 units wide and 9 units high.

How the Scale Pivot effects the scale

Applying an X&Y Scale with the default position of the scale pivot (X/Y/Z Pos=0) scales the layer evenly
around its center point.

The image sequence shows a Layer, scaled in X and Y from factor 1 to factor 0.25. The Scale Pivot’s
position is set to default (X/Y/Z Pos = 0; Center Point).

Now the position of the scale pivot is changed to X Pos=-8 (left screen border) and Y Pos=4.5 (top
screen border).

The image sequence shows a layer, scaled in X and Y from factor 1 to factor 0.25 The Scale Pivot’s
position is located in the corner top left.

Viewing the Scale Pivot

In order to see the position of the scale pivot in the Preview window , please do this:
1. Check the option “Show Handles” below the Preview window.
2. Now click the scale icon on the top left.
3. The scale pivot gets visible.
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When changing the position of the scale pivot with the scale pivot X/Y/Z Pos parameters, the pivot will
move to its new position. If the scale pivot is located outside the output area, you may change over to
Global Cam View to still see its position:

Image above: the position of the scale pivot is changed to X Pos=-17.2, Y Pos=-7.1, it is outside the
visible output area.

DMX Control
All scale pivot channels are 16bit and the default value is 32768.
Resolution: 1 DMX Step = 0.008 units

Scale Pivot’s X Position

0 max. scale pivot offset left (-256 units)

32768 Center

65535 max. scale pivot offset right (+256 units)

Scale Pivot’s Y Position

0 max. scale pivot offset bottom (-256 units)

32768 Center

65535 max. scale pivot offset top (+256 units)
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Scale Pivot’s Z Position

0 max. scale pivot offset far (-256 units)

32768 Center

65535 max. scale pivot offset near (+256 units)

6.5.2.10  Blend Mode

Blend modes in digital image editing are used to determine how two layers are blended into each other.
On Pandoras Box Servers and Players, the default blend mode (called “normal”) is simply to hide the
lower layer with whatever is present in the top layer. However, as each pixel has a numerical
representation, a large number of ways to blend two layers is possible. 

Normal

The lower layer will be hided by the content on the top layer.

Mask / Fill

With a combination of the Blend Modes Mask and Fill a key and fill effect can be set up: 
Layer A is supposed to be mixed with Layer B with a Mask in between that benefits from all sizing,
positioning and rotation features in 2D and 3D.
The mask can be anything, a still image or a video file.

This KEY+FILL effect is based on the layer stack from back to front,
as the back layer is being rendered first and every other layer is
rendered on top of the previous one. By making use of this technique
every layer can make use of the alpha blend modes to define how its
pixel RGB+Alpha (RGB32) values are mixed with the previous
rendered images. 

Layer 1 = Background Content
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Layer 2 = Black&White Mask. 

Set the Blend Mode to “Mask”. Add a White Key and key out all
white parts of the image.
The “mix” parameter of the White Key needs to be set to 255

This is the result of Layer 1 and Layer 2.

Layer 3 = Content to be filled onto the mask. Set Blend Mode to
“Fill”.

This is the result: the Key & Fill effect.

Please note:
When alpha blend modes are used the opacity ranges from 1-255, a zero value switches off the layer to
be rendered, and therefore switches the mode back to default opacity mixing.

If the Key & Fill Layers (Layer 2 and 3 in the example above) should be faded in / faded out, please use
the Mix-Parameter of the White Key of the Mask Layer to do so, instead of using the Opacity of both
Layer 2 and 3.
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Screen

With Screen blend mode the values of the pixels in the two layers are negated, multiplied, and then
negated again. The result is a brighter picture.

Add

This blend mode simply adds pixel values of one layer with the other. In case of values above 255 (in the
case of RGB), white is displayed.

Custom

Here you may use a customized blend mode. By default the blend mode normal is set.
To create your own blend mode, you have to modify the dedicated entries in the tweak config file.
This can be found here:
Pandoras Box root folder\data\config\tweak_config.txt 
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When opening this .txt-file scroll down to this section:

;---------------------------------------------------------------------------------;

;description:
;define custom layer blending with operation and mode for color and alpha. 

;possible values for blend operations are defined in D3DBLENDOP

;find more information here: http://msdn.microsoft.com/en-us/library/bb172509(VS.85).aspx

;possible values for blend modes are defined in D3DBLEND

;find more information here: http://msdn.microsoft.com/en-us/library/bb172508(v=vs.85).aspx

;default:
;blendOpColor=1
;srcBlendColor=5
;destBlendColor=6
;blendOpAlpha=1
;srcBlendAlpha=5
;destBlendAlpha=7

[LayerBlending]
blendOpColor=1
srcBlendColor=5
destBlendColor=6
blendOpAlpha=1
srcBlendAlpha=5
destBlendAlpha=7

;---------------------------------------------------------------------------------;

Modify the entries under the section [LayerBlending] to create your own blend mode, like described
below in the tweak_config.

Please note:
Close the PB application before editing the tweak config file!
These edited mode settings have to be done on each PB device that should be able to use this mode!
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6.5.2.11  FX

The new dynamic shader effects engine allows creating and combining an almost unlimited number of
effects. All effects and animations are automatically synchronized across the system network.

Please note:
Depending on your PB device the amount of permitted effects can be limited. Please see the Product
Overview  for further details.

This chapter is divided into the following themes:
Adding FX
FX Order
FX Parameter
Copy / Paste FX
Removing FX
FX List

There are a few things important to know when working with FX:

- Generally the layers come without any effect applied (except if the site/project is started in Lighting
Console Configuration ). If necessary you may add one or several FX from the FX tab to your layer,
see chapter Adding FX .

- The FX build upon each other according to their order in the FX chain. Having the FX order FX1>FX2
may achieve a result different from FX2>FX1. So the result is influenced by the order of the FX! See
chapter FX Order . 

6.5.2.11.1  Adding FX

Generally the layers come without any FX applied, except if the site/project is started in Lighting
Console Configuration.

If you have a look into the Device Tree of a plain video layer, there are no FX inside the FX folder, see
image below.

To add an effect to a video layer, graphic layer or output device, change to the FX Tab  and choose the
effect from one of the theme folders. Using the Filter View drop-down list will show all FX that are
available for your PB device.
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Image above: the Filter is set to display all FX available for PB Servers.

Choose the effect and drag and drop it onto the layer, or select the layer (it will be highlighted in blue)
and execute a double-click on the desired effect.

After adding the FX it will be shown 
. in the layers FX folder in the Device Tree
- next to the standard parameters in the Device Control Tab.

Image above: the newly added FX “Radial Blur” is shown in the Device Tree in the folder “FX”. After
unfolding it (by double-clicking the “Radial Blur”-folder or by clicking the “+” icon in front of it) all
parameters belonging to this effect will be listed as well.

Image above: the FX “Radial Blur” is shown in the Device Control Tab next to the collapsed “Blend
Mode”. The new section is always titled with the name of the FX (“Radial Blur”). All parameters of the FX
are listed in this section.
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The default values of every effect are set in a way that the effect won’t affect the layer texture
automatically after it is added to the layer. You need to modify the Mix parameter in order to apply the
effect. 

If you need more effects on your device, just repeat this procedure as often as needed. Every effect will
be attached to the FX list in the Device Tree / next to the last effect section in the Device Control tab.

Please note:
The order of the FX is very important, as they build upon each other! Having FX1 applied in front of FX2 in
the FX chain may give a different result as having FX2 in front of FX1, see chapter FX Order .

6.5.2.11.2  FX Order

The FX build upon each other according to their order of appearance. When several FX are applied to a
layer, the order of these FX is important!

Having the order FX1>FX2 may achieve a result different from the order FX2>FX1. The following example
shows how the effect order influences the result.

Example:

This is the original image file on the layer.

Left image: Two FX are added to the layer. First FX: RGB Shift, second FX: B&W.
Right image: the result looks like this. After the RGB Shift FX was applied, the whole layer is turned into
Black&White mode.

Turning the order of the FX, the result can look totally different!
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Left image: Now the B&W FX is applied before the RGB Shift FX.

Right image: after the image was turned into Black&White mode, it is now shifted to the colour red.
If the order of the FX should be modified, go to the Device Tree tab. Drag the effect folder that should be
moved and drop it further up or down.

Image sequence above: the effect B&W is moved from the end of the effect chain into the middle.
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6.5.2.11.3  FX Parameter

Depending on your chosen effect different parameters can be set. 

One parameter that all of the FX have in common is the “Mix” parameter. 
It defines how much the effect is mixed to the image / video file.
As long as it is set to the value 0 the effect is not visible. 
Setting it to 100% (value 255) completely applies the effect.

See here two FX as example for different parameters:

Most of the FX consist of parameters that can be set by fader controls (see the Black Key in the image
above). Some FX allow setting RGB values by an colour picker (see the Color Only effect in the image
above).

How to use the Color Picker

The Color Picker is based on the RGB (Red, Green, Blue) color model, including
faders for HSB (Hue, Saturation, Brightness). 

You might set the desired color by entering the values for red, green and blue
manually above the color field. Note that the bar between the field and the values
show the corresponding values for HSB and is colored in the chosen color
instantly. If you want to see the color in the color field (marked with a black
outlined circle, click the white arrow.

  =>  

Another way is clicking on the desired parameter at the bottom of the color picker
(R,G,B,H,S or B) and using the little horizontal fader right above the parameter or
picking a color directly from the color field.
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6.5.2.11.4  Copy / Paste of FX

There are a few things worth to know about the behavior when copying and pasting FX / clip containers
including FX.

COPY AND PASTE THE FX STRUCTURE

If there are one or several effects added to a layer and another layer should get this effect structure, right-
click on the layer in the Device Tree and choose “Copy FX Structure”. Now right-click on the layer to
which you want to paste this FX structure and choose “Paste FX Structure”.

Example:
Layer 1 contains 3 effects, in the order “Crop Edges INV”, “Cropper HV RGBA” and “Frame RGBA”.
Layer 2 contains 2 effects, in the order “Frame RGBA” and “Softborder”, see images below.

Images: Left) Layer 1 contains 3 effects, Right) Layer 2 contains 2 effects.

To copy the effect structure of Layer 1 to Layer 2, right-click on Layer 1 and choose “Copy FX Structure”.
After this right-click on Layer 2 and choose “Paste FX Structure”, see images below.

Images: Left) Copying the FX structure from Layer 1 and Right) pasting it to Layer 2 via the Device
Context Menu.
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The FX structure of Layer 2 includes the FX that were on Layer 2 before the Copy+Paste command was
executed and the newly pasted FX coming from Layer 1, see image below.

Image above: Layer 2 now contains the 2 old FX and the 3 newly added FX.

COPY AND PASTE CLIP CONTAINERS

When copying a clip container from one layer (containing several FX) to another layer (containing FX as
well, but different ones or in a different order) it depends on the settings within the clip container how the
FX structure in the target layer will look like.

Example A:
Layer 1 contains 3 effects, in the order “Crop Edges INV”, “Cropper HV RGBA” and “Frame RGBA”.
Layer 2 contains 2 effects, in the order “Frame RGBA” and “Softborder”, see images below.

Images: Left) Layer 1 contains 3 effects, Right) Layer 2 contains 2 effects.
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The clip that should be copied from Layer 1 to Layer 2 has keys set for the first FX (Crop Edges INV).
The following 2 FX are not used in this clip container, see image below.

Image: The clip container on Layer 2 uses only the first FX, effect 2 and 3 have no keys set.

When this clip container now is pasted on Layer 2, only the FX “Crop Edges INV” will be pasted as well.
The other two FX won’t be pasted because they were not used in the clip container, see image below.

 

Image: After pasting the clip container to Layer 2, only the effect “Crop Edges INV” is added.
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Example B:
The same FX structure of Layer 1 and Layer 2 is used, but now the clip container that is going to be
pasted on Layer 2 has keys set for all three FX, see image below.

Image: The clip container on Layer 1 uses all three FX that are added to the layer.

When this clip container now is pasted on Layer 2, all FX from Layer 1 are added to the FX tree of Layer
2, see image below.

Image: After pasting the clip container to Layer 2, all effects from Layer 1 are added to the FX tree of
Layer 2.
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6.5.2.11.5  Removing FX

Please be careful with removing FX from layers! 
Once an effect is removed from the layer, it won’t be available any more for all of the layer’s clip
containers which used this effect. 

There are several ways to remove an effect from a layer
- Right-click on the effect’s name in the Device Control tab and choose “Remove FX” or “Remove All FX”,
see image left.
- Right-click on the effect’s name in the Device Tree tab and choose “Remove”, see image in the middle.
- Right-click on the layer in the Device Tree tab and choose “Remove All FX”, see image right.

6.5.2.11.6  FX List

The following tables will list all effects in the order of their according FX theme collection. In addition the
tables give an overview of the effect's availability regarding the different PB products.

6.5.2.11.7  Animation

6.5.2.11.8  Anti-Aliasing

Anti-Aliasing 1

All anti-aliasing effects improve the image quality by smoothing pixelated or jagged edges within the
image. There are various methods to achieve this. This anti-aliasing effect applies an directionally
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localized anti-aliasing (DLAA) algorithm that you can adjust with a "Mix" parameter.
An alternative to anti-aliasing are the Blur  effects, especially the downsampling ones.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Anti-Aliasing 2

All anti-aliasing effects improve the image quality by smoothing pixelated or jagged edges within the
image. There are various methods to achieve this. This anti-aliasing effect applies a normal filter anti-
aliasing (NFAA) algorithm that you can adjust with a "Mix" and "Scale" parameter.
An alternative to anti-aliasing are the Blur  effects, especially the downsampling ones.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Scale Scale 0-1000 250

Anti-Aliasing 3

All anti-aliasing effects improve the image quality by smoothing pixelated or jagged edges within the
image. There are various methods to achieve this. This anti-aliasing effect applies a super sampling
anti-aliasing (SSAA) algorithm that you can adjust with a "Mix", "Width" and "Softness" parameter.
An alternative to anti-aliasing are the Blur  effects, especially the downsampling ones.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Width Width 0-1000 175

Softness Softness 0-1000 250
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6.5.2.11.9  Blur

Blur - Downsampling 1

All Downsampling effects improve the image quality by smoothing pixelated or jagged edges within
the image and can be used alternatively to an anti-aliasing effect .
This applies a downsampling blur algorithm with a texture resolution of 75%. The middle image shows
the effect with the "Mix" set to a third, in the last image it is set to full.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Blur - Downsampling 2

All Downsampling effects improve the image quality by smoothing pixelated or jagged edges within
the image and can be used alternatively to an anti-aliasing effect .
This applies a downsampling blur algorithm with a texture resolution of 50%. The middle image shows
the effect with the "Mix" set to a third, in the last image it is set to full.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Blur - Downsampling 3

353
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All Downsampling effects improve the image quality by smoothing pixelated or jagged edges within
the image and can be used alternatively to an anti-aliasing effect .
This applies a downsampling blur algorithm with a texture resolution of 25%. The middle image shows
the effect with the "Mix" set to a third, in the last image it is set to full.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Blur XY Alpha Glow Color

Overlays those pixels of the layer that are alpha (transparent) and adjacent to opaque (non see-
through) pixels. The overlay line can be colored and blurred which creates the impression of a glowing
line. You can adjust the amount as well es the X- and Y-offset of the blur.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 32

X X Offset 0-255 255

Y Y Offset 0-255 255

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128
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Blur XY Alpha Glow Pre-Multiplied

Overlays those pixels of the layer that are alpha (transparent) and adjacent to opaque (non see-
through) pixels. In difference to the above effect "Blur XY Alpha Glow Color"  the overlay is simply
black. You can adjust the amount as well es the X- and Y-offset of the blur.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 32

X X Offset 0-255 255

Y Y Offset 0-255 255

Blur XY Alpha

Blurs the alpha (transparent) areas of the layer, all opaque (non see-through) areas stay sharp. You
can adjust the amount as well es the X- and Y-offset.

356
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 132

X X Offset 0-255 132

Y Y Offset 0-255 122

Blur XY

Blurs all RGBA pixels of the layer. You can adjust the amount as well es the X- and Y-offset.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of Blur 0-255 132

X X Offset 0-255 132

Y Y Offset 0-255 122

Dilate Alpha

This effect looks for opaque (non see-through) areas of the layer that are (partially) surrounded by
alpha (transparent) areas. Then it enlarges the size of the opaque areas according to the "Amount"
parameter by repeating the opaque pixels.
This effect might be of interest when working with a generated mask (e.g. keying a specific color) and
there are small areas left that should be either transparent or opaque. This appears as so called
noise. A combination of a dilate and erode effect can reduce the noise.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 132

Dilate

This effect looks for areas in the layer that are brighter than those areas that (partially) surrounded
them. Then it enlarges their size according to the "Amount" parameter by repeating the brighter
pixels.

This effect might be of interest when working with a generated mask (e.g. coloring regions of interest
in black or white) and there are small areas left that should be the opposite color. This appears as so
called noise. A combination of a dilate and erode effect can reduce the noise.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 132

Erode Alpha

This effect looks for opaque (non see-through) areas of the layer that are (partially) surrounded by
alpha (transparent) areas. Then it reduces the size of the opaque areas according to the "Amount"
parameter by repeating the adjacent transparent pixels.
This effect might be of interest when working with a generated mask (e.g. keying a specific color) and
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there are small areas left that should be either transparent or opaque. This appears as so called
noise. A combination of a dilate and erode effect can reduce the noise.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 132

Erode

This effect looks for areas in the layer that are darker than those areas that (partially) surrounded
them. Then it enlarges their size according to the "Amount" parameter by repeating the darker pixels.

This effect might be of interest when working with a generated mask (e.g. coloring regions of interest
in black or white) and there are small areas left that should be either black or white. This appears as
so called noise. A combination of a dilate and erode effect can reduce the noise.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 132

GaussianBlur On-Off

This is a switchable Gaussian Blur effect.

Parameter Description Value Range Default

On/Off On/Off - -

Blur Blur 0-100 0
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GaussianBlur

This adds a Gaussian Blur effect to the layer.

Parameter Description Value Range Default

Blur Blur 0-100 0

Glow

This effect looks for bright pixels in the layer texture and adds brightness to surrounding pixels, thus
they appear to glow.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Luminance Luminance 0-65535 60000

Mid Mid 0-255 46

Cut-Off Cut-Off 0-255 200

Bloom Bloom 0-255 190

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255
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Radial Blur Alpha Color

Overlays those pixels of the layer that are alpha (transparent) and adjacent to opaque (non see-
through)pixels. The overlay line can be colored and blurred with a radial blur which creates the
impression of a glowing shadow in one direction. You can adjust the amount as well es the X- and Y-
direction and the intensity of the radial blur.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 64

X X 0-65535 32768

Y Y 0-65535 32768

Intensity Intensity 0-255 128

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128
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Radial Blur Alpha

Blurs the alpha (transparent) areas of the layer with a radial blur effect. All opaque (non see-through)
areas stay sharp. You can adjust the amount as well es the X- and Y-direction and the intensity of
the radial blur.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 64

X X Direction 0-65535 32768

Y Y Direction 0-65535 32768

Intensity Intensity 0-255 128

Radial Blur 

Blurs all RGBA pixels of the layer with a radial blur. You can adjust the amount as well es the X- and
Y-direction and the intensity.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of Blur 0-255 64

X X Position of Center Point 0-65535 32768

Y Y Position of Center Point 0-65535 32768

Intensity Amount of Blur 0-255 128
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Refresh Delay

This adds a delay of one frame when applied to any Output device .
This is of interest when working with multiple displays that are mounted underneath each other and
have a hard edge. With sensitive displays and sensitive content it can look better when the second
signal is delayed by one frame which is the time it takes to process the first frame.

Note that this effect can not be applied twice to an Output to generate an delay of two frames!

Parameter Description Value Range Default

Mix Level of effect itself 0-255 255

Render Delay

This effect is based on the Layer's Z Position or render history as explained in the manual chapter 
"Compositing" . The layer with the assigned "Render Delay" effect makes a composition of all
layers behind it. In the example, the "render" layer is positioned in the foreground, its main media is a
transparent image. In the background there is a layer with a running timecode video and a particle
system  (also with a transparent media!).
All background pixels are delayed depending on the effect parameter "Delay".

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Delay Amount of Delay 0-65535 32768

Render Draw Media

This effect is based on the Layer's Z Position or render history as explained in the manual chapter 
"Compositing" . The layer with the assigned "Render Draw Media" effect makes a composition of
all layers behind it. In the example, the "render" layer is positioned in the foreground, its main media
is a transparent image whilst the effect's media is a rainbow image. In the background there is a

621
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grass layer and a particle system  (also with a transparent media!).
Depending on the effect parameter "Clear" the background pixels add up to the foreground texture.
E.g. the particle's movement draws onto the rainbow effect texture; the second image shows a low
"Clear", the third an increased "Clear" time. Another drawing result could be achieved by moving the
grass layer up and down or by using a video with moving pixels.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 255

Clear Clear 0-65535 32768

Media Media file as source for overlay or
mask

- -

Render Draw 

This effect is based on the Layer's Z Position or render history as explained in the manual chapter 
"Compositing" . The layer with the assigned "Render Draw Media" effect makes a composition of
all layers behind it. In the example, the "render" layer is positioned in the foreground, its main media
is a transparent image. In the background there is a grass layer and a particle system  (also with a
transparent media!).
Depending on the effect parameter "Clear" the background pixels add up to the foreground texture.
The particle's movement draws onto the transparent layer texture; the second image shows a low
"Clear", the third an increased "Clear" time. Another drawing result could be achieved by moving the
grass layer up and down or by using a video with moving pixels.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Clear Clears drawn areas 0-65535 32768

Video Delay

Delays a Video File as if it blends over several frames.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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Delay Amount of delay 0-65535 60000

6.5.2.11.10  Camera Projection

Perspective Projection Mapping

This effect is the only one that can (and must) be applied to a Camera layer . It allows special
tracking setups, e.g. when a camera movement is tracked for a real/virtual TV studio setup.
According to the (real) movement of the camera Pandoras Box renders a cut-out of a virtual space
which is then displayed as a background in the (real) setup. Therefore it is seen by the (real) camera
which results in a recorded mix of real and virtual elements. Only from the real camera's viewpoint the
background is in the correct perspective. This setup is an alternative to keying applications with a
green or blue screen.
The tracking data changes the parameters of a PB camera layer. The effect parameters on the other
hand are static, i.e they are setup once as fixed values. The four coordinates represent the corners of
the screen whereon the background is projected and can also be understood as a "window" through
which the (PB) camera sees and renders the background.
An example for this effect is the setup of the coolux booth on NAB 2013 seen here: https://
www.youtube.com/watch?v=7ectw1Z9BvA

Parameter Description Value Range Default

GenPerspTargetPt1X GenPerspTargetPt1X -999.999-999.999 -8

GenPerspTargetPt1Y GenPerspTargetPt1Y -999.999-999.999 -5

GenPerspTargetPt1Z GenPerspTargetPt1Z -999.999-999.999 0

GenPerspTargetPt2X GenPerspTargetPt2X -999.999-999.999 8

GenPerspTargetPt2Y GenPerspTargetPt2Y -999.999-999.999 -5

GenPerspTargetPt2Z GenPerspTargetPt2Z -999.999-999.999 0

GenPerspTargetPt3X GenPerspTargetPt3X -999.999-999.999 -8

GenPerspTargetPt3Y GenPerspTargetPt3Y -999.999-999.999 5

GenPerspTargetPt3Z GenPerspTargetPt3Z -999.999-999.999 0

613
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6.5.2.11.11  Color Effects

B&W Add

Adds Black and White values to the RGB colors, the result can be inverted.
Uses the color picker, with saturation set to 0 by default.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Color Picker 0-255 128

Green Color Picker 0-255 128

Blue Color Picker 0-255 128

Invert Inverts the RGB levels 0-255 0

B&W Multiply

All RGB colors are multiplied by B&W color mix value, the result can be inverted.
Uses the color picker, with saturation set to 0 by default.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Color Picker 0-255 128

Green Color Picker 0-255 128

Blue Color Picker 0-255 128

Factor Color Multiply Factor 0-255 64

Invert Inverts the RGB levels 0-255 0
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B&W

Turns the RGB image into Black and White, the result can be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Invert Inverts the RGB Levels 0-255 128

BiTone

Turns the RGB image into just two colors, using Threshold. Both colors can be set by color pickers.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red 1 Color Picker for Color 1 0-255 255

Green 1 Color Picker for Color 1 0-255 255

Blue 1 Color Picker for Color 1 0-255 255

Red 2 Color Picker for Color 2 0-255 0

Green 2 Color Picker for Color 2 0-255 0

Blue 2 Color Picker for Color 2 0-255 0

Threshold Defines the Threshold 0-255 128
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BiTone Luma

Colorizes the image based upon its luminance values in two colors, each for high (H) and low (L)
levels, using color pickers.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Color Picker for high luminance value 0-255 128

Green H Color Picker for high luminance value 0-255 128

Blue H Color Picker for high luminance value 0-255 128

Red L Color Picker for low luminance value 0-255 128

Green L Color Picker for low luminance value 0-255 128

Blue L Color Picker for low luminance value 0-255 128

Color Stripes H

Adds horizontal colored stripes.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-65535 1024



370

Color Stripes V

Adds vertical colored stripes.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-65535 1024

ColorFade

Fades all RGB colors to full RGB or CMY color saturation.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

R / C Fades into Red (up) / Cyan (down) 0-255 128

G / M Fades into Green (up) / Magenta (down) 0-255 128

B / Y Fades into Blue (up) / Yellow (down) 0-255 128

ColorScroll Add

Applies a color-changing effect to the layer texture by adding the RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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 Scroll Speed  Scroll Speed 0-65535 0

ColorScroll Multiply

Applies a color-changing effect to the layer texture by multiplying the RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Scroll Speed Scroll Speed 0-65535 0

ColorScroll Only

Applies a color-changing effect to the layer texture by overlaying the original RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

 Scroll Speed  Scroll Speed 0-65535 0

Emboss Angle

Emboss with control for Factor and Angle.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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Factor Amount of Emboss 0-255 128

Angle Angle of Emboss 0-255 128

Emboss Edges

Emboss with control for Threshold.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Threshold Level of Threshold 0-255 128

 Emboss 

Emboss with control for Threshold.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Threshold Level of Threshold 0-255 144

Factor Factor of Emboss 0-255 196

Granite 

Granite Effect.



373

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Level of Granite pattern 0-255 255

Invert 

Inverts the RGB levels.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

 LinearLight 

Linear light reflexion over the whole image.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

RGB Inversion

Inverts the RGB levels with the possibility of setting RGB levels, Threshold and Radius.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Threshold Threshold 0-255 255

Radius Radius 0-255 128

Invert Inverts the applied effect. 0-255 0

Sepiatone 

Tints the texture in sepia tones, amount is adjustable.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of sepia tone 0-255 128

Solarize 

Solarize inverts first dark then brighter colors.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of solarization 0-255 128
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Tone Mapping 

Allows to set Fog, Exposure, Gamma, Vignette and Blueshift to create specific photo style.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Defog Defog 0-255 2

Fog Red Fog Red 0-255 255

Fog Green Fog Green 0-255 255

Fog Blue Fog Blue 0-255 255

Exposure Exposure 0-255 144

Gamma Gamma 0-255 32

VignetteCenter X VignetteCenter X 0-65535 32768

VignetteCenter Y VignetteCenter Y 0-65535 32768

VignetteRadius VignetteRadius 0-65535 65535

VignetteAmount VignetteAmount 0-65535 64

BlueShift BlueShift 0-255 0

TriTone

Colorizes the image based upon its luminance values in a mix of three colors, each for high (H),
middle (M) and low (L) levels, using color pickers.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Color Picker for high luminance value 0-255 128

Green H Color Picker for high luminance value 0-255 128

Blue H Color Picker for high luminance value 0-255 128

Red M Color Picker for middle luminance value 0-255 128

Green M Color Picker for middle luminance value 0-255 128

Blue M Color Picker for middle luminance value 0-255 128
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Red L Color Picker for low luminance value 0-255 128

Green L Color Picker for low luminance value 0-255 128

Blue L Color Picker for low luminance value 0-255 128

6.5.2.11.12  Color Effects - Crop

B&W Add Crop Pixel

Applies the "B&W Add" FX within an adjustable rectangular area with hard edges. It adds Black and
White values to the RGB colors, the result can be inverted.
Uses the color picker, with saturation set to 0 by default.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

B&W Crop Pixel

Applies the "B&W" FX within an adjustable rectangular area with hard edges. It turns the RGB image
into Black and White, the result can be inverted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Invert Inverts the RGB levels or the effect 0-255 0

Left (px) Left (px) 0-8192 0
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Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

B&W Multiply Crop Pixel

Applies the "B&W Multiply" FX within an adjustable rectangular area with hard edges. All RGB colors
are multiplied by B&W color mix value, the result can be inverted.
Uses the color picker, with saturation set to 0 by default.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128

Factor Factor 0-255 64

Invert Inverts the RGB levels or the effect 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

BiTone Crop Pixel

Applies the "Bitone" FX within an adjustable rectangular area with hard edges. It turns the RGB image
into just two colors, using Threshold. Both colors can be set by color pickers.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red 1 First color picker / Level of red 0-255 255

Green 1 First color picker / Level of green 0-255 255

Blue 1 First color picker / Level of blue 0-255 255



378

Red 2 Second color picker / Level of red 0-255 0

Green 2 Second color picker / Level of green 0-255 0

Blue 2 Second color picker / Level of blue 0-255 0

Threshold Threshold 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

BiTone Luma Crop Pixel

Applies the "BiTone Luma" FX within an adjustable rectangular area with hard edges. It colorizes the
image based upon its luminance values in two colors, each for high (H) and low (L) levels, using color
pickers.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128

Blue H Color picker / Level of blue 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Color Stripes H Crop Pixel
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Applies the "Color Stripes H" FX within an adjustable rectangular area with hard edges. It adds
horizontal color stripes in different sizes.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-65535 1024

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Color Stripes V Crop Pixel

Applies the "Color Stripes V" FX within an adjustable rectangular area with hard edges. It adds
vertical color stripes in different sizes.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-65535 1024

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Color Fade Crop Pixel

Applies the "Color Fade" FX within an adjustable rectangular area with hard edges. It fades all RGB
colors to full RGB or CMY color saturation.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

R/C R/C 0-255 128
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G/M G/M 0-255 128

B/Y B/Y 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

ColorScroll Add Crop Pixel

Applies the "ColorScroll Add" FX within an adjustable rectangular area with hard edges. It applies a
color-changing effect to the layer texture by adding the RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

 Scroll Speed  Scroll Speed 0-65535 0

Bottom (px) Bottom (px) 0-8192 0

ColorScroll Multiply Crop Pixel

Applies the "ColorScroll Multiply" FX within an adjustable rectangular area with hard edges. It applies
a color-changing effect to the layer texture by multiplying the RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

 Scroll Speed  Scroll Speed 0-65535 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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ColorScroll Only Crop Pixel

Applies the "ColorScroll Only" FX within an adjustable rectangular area with hard edges. It applies a
color-changing effect to the layer texture by overlaying the original RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

 Scroll Speed  Scroll Speed 0-65535 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Emboss Angle Crop Pixel

Applies an emboss effect with different angles in an adjustable rectangular area with hard edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Factor Factor 0-255 128

Orientation Orientation 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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Emboss Crop Pixel

Applies an emboss effect in an adjustable rectangular area with hard edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Threshold Threshold 0-255 144

Factor Factor 0-255 196

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Emboss Edges Crop Pixel

Applies an emboss effect with a threshold in an adjustable rectangular area with hard edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Threshold Threshold 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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Granite Crop Pixel

Applies the "Granite" FX within an adjustable rectangular area with hard edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 255

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Invert Crop Pixel

Applies the "Invert" FX within an adjustable rectangular area with hard edges. It inverts the RGB
levels.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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Linear Light Crop Pixel

Applies the "Linear Light" FX within an adjustable rectangular area with hard edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB Inversion Crop Pixel

Applies the "RGB Inversion" FX within an adjustable rectangular area with hard edges. It inverts the
RGB levels with the possibility of setting RGB levels, Threshold and Radius.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128

Threshold Threshold 0-255 255

Radius Radius 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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Sepiatone Crop Pixel

Applies the "Sepiatone" FX within an adjustable rectangular area with hard edges. It tints the texture
in sepia tones, amount is adjustable.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Solarize Crop Pixel

Applies the "Solarize" FX within an adjustable rectangular area with hard edges. It inverts first dark
then brighter colors.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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Tone Mapping Crop Pixel

Applies the "Tone Mapping" FX within an adjustable rectangular area with hard edges. It allows to set
Fog, Exposure, Gamma, Vignette and Blueshift to create a specific photo style.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Defog Defog 0-255 2

Fog Red Fog Red 0-255 255

Fog Green Fog Green 0-255 255

Fog Blue Fog Blue 0-255 255

Exposure Exposure 0-255 144

Gamma Gamma 0-255 32

VignetteCenter
X

VignetteCenterX 0-65535 32768

VignetteCenter
Y

VignetteCenterY 0-65535 32768

VignetteRadiusVignetteRadius 0-65535 65535

VignetteAmou
nt

VignetteAmount 0-255 0

BlueShift BlueShift 0-255 64

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

TriTone Crop Pixel

Applies the "TriTone" FX within an adjustable rectangular area with hard edges. It colorizes the image
based upon its luminance values in a mix of three colors, each for high (H), middle (M) and low (L)
levels, using color pickers.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128

Blue H Color picker / Level of blue 0-255 128

Red M Red M 0-255 128

Green M Green M 0-255 128

Blue M Blue M 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

6.5.2.11.13  Color Effects - Softborder

B&W Add Softborder

Applies the "B&W Add" FX within an adjustable rectangular area with soft edges. It adds Black and
White values to the RGB colors, the result can be inverted. Uses the color picker, with saturation set
to 0 by default.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0
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B&W Multiply Softborder

Applies the "B&W Multiply" FX within an adjustable rectangular area with soft edges. All RGB colors
are multiplied by B&W color mix value, the result can be inverted.

Uses the color picker, with saturation set to 0 by default.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128

Factor Factor 0-255 64

Invert Inverts the RGB levels or the effect 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0

B&W Softborder

Applies the "B&W" FX within an adjustable rectangular area with soft edges. It turns the RGB image
into Black and White, the result can be inverted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Invert Inverts the RGB levels or the effect 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0
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BiTone Softborder

Applies the "Bitone" FX within an adjustable rectangular area with soft edges. It turns the RGB image
into just two colors, using Threshold. Both colors can be set by color pickers.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red 1 First color picker / Level of red 0-255 255

Green 1 First color picker / Level of green 0-255 255

Blue 1 First color picker / Level of blue 0-255 255

Red 2 Second color picker / Level of red 0-255 0

Green 2 Second color picker / Level of green 0-255 0

Blue 2 Second color picker / Level of blue 0-255 0

Threshold Threshold 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0

BiTone Luma Softborder

Applies the "BiTone Luma" FX within an adjustable rectangular area with soft edges. It colorizes the
image based upon its luminance values in two colors, each for high (H) and low (L) levels, using color
pickers.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128

Blue H Color picker / Level of blue 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Size Size 0-255 16
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Corner Corner 0-255 0

Color Stripes H Softborder

Applies the "Color Stripes H" FX within an adjustable rectangular area with soft edges. It adds
horizontal color stripes in different sizes.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-65535 1024

Size Size 0-255 16

Corner Corner 0-255 0

Color Stripes V Softborder

Applies the "Color Stripes V" FX within an adjustable rectangular area with soft edges. It adds vertical
color stripes in different sizes.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-65535 1024

Size Size 0-255 16

Corner Corner 0-255 0
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Color Fade Softborder

Applies the "Color Fade" FX within an adjustable rectangular area with soft edges. It fades all RGB
colors to full RGB or CMY color saturation.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

R/C R/C 0-255 128

G/M G/M 0-255 128

B/Y B/Y 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0

ColorScroll Add Softborder

Applies the "ColorScroll Add" FX within an adjustable rectangular area with soft edges. It applies a
color-changing effect to the layer texture by adding the RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

 Scroll Speed  Scroll Speed 0-65535 0

Corner Corner 0-255 0
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ColorScroll Multiply Softborder

Applies the "ColorScroll Multiply" FX within an adjustable rectangular area with soft edges. It applies
a color-changing effect to the layer texture by multiplying the RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Scroll Speed Scroll Speed 0-65535 0

Corner Corner 0-255 0

ColorScroll Only Softborder

Applies the "ColorScroll Only" FX within an adjustable rectangular area with soft edges. It applies a
color-changing effect to the layer texture by overlaying the original RGB values.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

 Scroll Speed  Scroll Speed 0-65535 0

Corner Corner 0-255 0

Emboss Angle Softborder

Applies an emboss effect with different angles in an adjustable rectangular area with soft edges.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Factor Factor 0-255 128

Orientation Orientation 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0

Emboss Edges Softborder

Applies an emboss effect with a threshold in an adjustable rectangular area with soft edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Threshold Threshold 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0

Emboss Softborder

Applies an emboss effect in an adjustable rectangular area with soft edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Threshold Threshold 0-255 144

Factor Factor 0-255 196

Size Size 0-255 16

Corner Corner 0-255 0
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Invert Softborder

Applies the "Invert" FX within an adjustable rectangular area with soft edges. It inverts the RGB levels.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0

Linear Light Softborder

Applies the "Linear Light" FX within an adjustable rectangular area with soft edges.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0

RGB Inversion Softborder

Applies the "RGB Inversion" FX within an adjustable rectangular area with soft edges. It inverts the
RGB levels with the possibility of setting RGB levels, Threshold and Radius.

Parameter Description Value Range Default
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Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 128

Blue Color picker / Level of blue 0-255 128

Threshold Threshold 0-255 255

Radius Radius 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0

Sepiatone Softborder

Applies the "Sepiatone" FX within an adjustable rectangular area with soft edges. It tints the texture in
sepia tones, amount is adjustable.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0

Tone Mapping Softborder

Applies the "Tone Mapping" FX within an adjustable rectangular area with soft edges. It allows to set
Fog, Exposure, Gamma, Vignette and Blueshift to create a specific photo style.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Defog Defog 0-255 2

Fog Red Fog Red 0-255 255

Fog Green Fog Green 0-255 255

Fog Blue Fog Blue 0-255 255
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Exposure Exposure 0-255 144

Gamma Gamma 0-255 32

VignetteCenter
X

VignetteCenterX 0-65535 32768

VignetteCenter
Y

VignetteCenterY 0-65535 32768

VignetteRadiusVignetteRadius 0-65535 65535

VignetteAmou
nt

VignetteAmount 0-255 0

BlueShift BlueShift 0-255 64

Size Size 0-255 16

Corner Corner 0-255 0

TriTone Softborder

Applies the "TriTone" FX within an adjustable rectangular area with soft edges. It colorizes the image
based upon its luminance values in a mix of three colors, each for high (H), middle (M) and low (L)
levels, using color pickers.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128

Blue H Color picker / Level of blue 0-255 128

Red M Red M 0-255 128

Green M Green M 0-255 128

Blue M Blue M 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0
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6.5.2.11.14  Color Shift

BW Media ColorShift Scroll

This effect mixes the layer texture with color values of (one horizontal line of) the effect media. The
overlaid color is taken from the very left position for black values and moves further to the right the
brighter the original pixel is. In the middle image the "Line" parameter is set to "0", so only the colors
from the top line are taken. Dark original pixels are now yellow or cyan, the most brightest ones are
red or even blue. For the last image the "Line" parameter is set to "255", so the bottom line from the
FX media is applied.
With the "Scroll" parameter the overlaid line scrolls with the according speed from top to bottom;
press "Reset" to match "0" to the top line again.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Line Line 0-255 0

 Scroll  Scroll 0-65535 0

Media Media file as source for overlay or
mask

- -
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BW Media ColorShift

This effect mixes the layer texture with color values of (one horizontal line of) the effect media. The
overlaid color is taken from the very left position for black values and moves further to the right the
brighter the original pixel is. In the middle image the "Line" parameter is set to "0", so only the colors
from the top line are taken. Dark original pixels are now yellow or cyan, the most brightest ones are
red or even blue. For the last image the "Line" parameter is set to "255", so the bottom line from the
FX media is applied.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Line Line 0-255 0

Media Media file as source for overlay or
mask

- -

Color Inversion

Inverts the image based upon its RGB values and allows to influence the color, threshold and feather.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Threshold Threshold 0-255 255
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Feather Feather 0-255 128

ColorOnly

Turns the image into a single color and allows to set an alpha value to define the transparency of the
layer. 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Alpha Set the transparency of the layer. 0-255 128

RGB Add

Adds RGB colors by the RGB color mix value, allows inverting the image.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Invert Inverts the RGB Levels 0-255 0
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RGB Channel Inversion

Allows to invert the image channel by channel (RGB & alpha)

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

R Red level inversion 0-255 0

G Green level inversion 0-255 0

B Blue level inversion 0-255 0

A Alpha level inversion 0-255 0

RGB Hue

Changes all color values of the layer texture to the chosen hue / color. Black and white pixels are not
influenced.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0
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RGB INV Add

Allows adding RGB colors by the color mix values after inverting the image.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 0

Green Green level, Color Picker 0-255 0

Blue Blue level, Color Picker 0-255 0

RGB INV Multiply

Allows multiplying with RGB colors by the color mix values after inverting the image.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

RGB Multiply

All RGB colors are multiplied by RGB color mix values. Multiply can be factorized and inverted.
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Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Factor Color Multiply Factor 0-255 64

Invert Inverts the RGB levels 0-255 0

RGB Replace

With this effect you can pick one color that should be replaced and if needed, fine tune the color
range with the "Threshold" and "Radius" parameters. Then pick a new color that replaces it.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Old Red Old 0-255 0

Green Old Green Old 0-255 0

Blue Old Blue Old 0-255 0

Threshold Threshold 0-255 64

Radius Radius 0-255 32

Red New Red New 0-255 0

Green New Green New 0-255 0

Blue New Blue New 0-255 0

RGB Screen

This applies the screen blend mode, i.e. it negates the RGB values of the layer texture, then
multiplying them and negates them again. The result is a brighter image.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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RGB Shift

With this effect you can tint your image with a certain color. In detail, the original RGB color values
are increased with the chosen RGB value, as long as their according RGB share is grater than 0.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

 RGB XY Shift

Allows shifting all RGB colors in X and Y direction. 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

R X Red level shift in X direction 0-65535 32768

R Y Red level shift in Y direction 0-65535 32768

G X Green level shift in X direction 0-65535 32768

G Y Green level shift in Y direction 0-65535 32768

B X Blue level shift in X direction 0-65535 32768

B Y Blue level shift in Y direction 0-65535 32768
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RGB-BGR Add

All RGB channels are shifted and added by the color mix value and may be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Invert Inverts the RBG values 0-255 0

 RGB-BGR Multiply

All RGB channels are shifted and multiplied by the color mix value and may be factorized and
inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Factor Factor of Multiplication 0-255 64

Invert Inverts the RBG values 0-255 0
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RGB-BRG Add

All RGB channels are shifted and added by the color mix value and may be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Invert Inverts the RBG values 0-255 0
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 RGB-BRG Multiply

All RGB channels are shifted and multiplied by the color mix value and may be factorized and
inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Factor Factor of Multiplication 0-255 64

Invert Inverts the RBG values 0-255 0

RGB-GBR Add

All RGB channels are shifted and added by the color mix value and may be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Invert Inverts the RBG values 0-255 0
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 RGB-GBR Multiply

All RGB channels are shifted and multiplied by the color mix value and may factorized and inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Factor Factor of Multiplication 0-255 64

Invert Inverts the RBG values 0-255 0

RGB-GRB Add

All RGB channels are shifted and added by the color mix value and may be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Invert Inverts the RBG values 0-255 0
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 RGB-GRB Multiply

All RGB channels are shifted and multiplied by the color mix value and may be factorized and
inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Factor Factor of Multiplication 0-255 64

Invert Inverts the RBG values 0-255 0

RGB-RBG Add

All RGB channels are shifted and added by the color mix value and may be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Invert Inverts the RBG values 0-255 0
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 RGB-RBG Multiply

All RGB channels are shifted and multiplied by the color mix value and may be factorized and
inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Factor Factor of Multiplication 0-255 64

Invert Inverts the RBG values 0-255 0

RGBA Modulo

Modulo on RGB channels.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Alpha Alpha level 0-255 255
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6.5.2.11.15  Compositing

 ++ General information for Compositing Effects ++

The Compositing Effects allow rendering a whole composition onto one layer, this is the so called
Renderhistory. This way the composition can e.g. be scaled or positioned somewhere else on the
output without the need of scaling or positioning every single layer.

Please note: 
Everything in the 3D space that gets behind the layer with the composition effect will be rendered
onto this layer. In doing so the composition does not longer exist as 3D composition, but is
transferred into a flat 2D texture.

The example below shows how the Compositing Effects works.

A: There is a layer with grass on it, a bottom layer and three cones. Each item stays in a different Z
position. The Compositing Effect will be applied to the layer in the background (with clouds on it).

B: The Compositing Effect is applied to the background layer. The layer now shows black, because
there is nothing behind it that could be rendered.

C: The background layer was moved in Z position. It is now in front of the grass, the bottom layer and
the first two cones, but behind the red cone. Everything except the red cone is now rendered as
texture on the background layer.

D: The background layer is moved further to the front. Every item of the composition is now behind it
and will be rendered as its texture.

When looking at the scene above by previewing the Output (and not in Global Cam Mode), you will
see this result:
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E: When seen from the front side, the composition looks like in the beginning.
F: When scaling and rotating the background layer, it is now visible, that the composition is turned
from a 3D composition to just a flat texture on the layer, from now on called “Rendering”.

The difference between the single Compositing Effects is the way the composition behind the layer is
rendered and mixed with the texture being originally on the layer.

The three images for each Compositing Effect show:
Left: Effect’s Mix Value=0; Center: Effect’s Mix Value =128; Right: Effect’s Mix Value =255

Render History

Fades between the Target’s texture and the Rendering.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Target Add

Adds the pixel values of the Target’s texture with the ones of the Rendering. In case of values above
255 (in the case of RGB), white is displayed.

Parameter Description Value Range Default
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Mix Level of Effect 0-255 0

Target Buffer

Example above: left: Mix=0; center: Mix=128; right: Mix=255

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Target Color Burn

The Color Burn effect divides the inverted Rendering by the Target layer, and then inverts the result.
This darkens the Target layer increasing the contrast to reflect the color of the Rendering. The darker
the Rendering, the more its color is used. Blending with white produces no difference.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Target Darken

Darken takes the darkest value for each pixel from both, the Rendering and the Target layer.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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 Target Difference

Difference subtracts the Target layer from the Rendering or the other way round; to always get a
positive value. Blending with black produces no change, as values for all colors are 0. (The RGB value
for black is 0,0,0). Blending with white inverts the picture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Target Lighten

Lighten takes the lightest pixel from both, the Rendering and the Target layer.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Target Multiply

Multiplies each pixel of the Target texture with the Rendering. The result is a darker picture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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 Target Reflect

Reflects the Target’s texture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Target Screen

With Target Screen effect the values of the pixels in the two layers (Target and Rendering) are
negated, multiplied, and then negated again. This is in some way the opposite of multiply.

The result is a brighter picture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Target Subtract

This Effect subtracts pixel values of the Target’s texture with the Rendering. In case of negative
values, black is displayed.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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6.5.2.11.16  Cropping

Crop Edges INV Softborder In

Crops all 4 edges individually into transparency and inverts them. In addition you can set a softborder
individually for each side which goes inwards.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Left 0-65535 0

Right Right 0-65535 0

Top Top 0-65535 0

Bottom Bottom 0-65535 0

Softness Softness 0-65535 0

Left Soft Left Soft 0-65535 0

Right Soft Right Soft 0-65535 0

Top Soft Top Soft 0-65535 0

Bottom Soft Bottom Soft 0-65535 0
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Crop Edges INV

Crops all 4 edges individually into transparency and inverts them.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Left Crops left edge inverted 0-65535 0

Right Crops right edge inverted 0-65535 0

Top Crops top edge inverted 0-65535 0

Bottom Crops bottom edge inverted 0-65535 0

Crop Edges Softborder In

Crops all 4 edges individually into transparency. In addition you can set a softborder individually for
each side which goes inwards.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Left 0-65535 0

Right Right 0-65535 0

Top Top 0-65535 0

Bottom Bottom 0-65535 0

Softness Softness 0-65535 0

Left Soft Left Soft 0-65535 0

Right Soft Right Soft 0-65535 0

Top Soft Top Soft 0-65535 0

Bottom Soft Bottom Soft 0-65535 0

Crop Edges Softborder

Crops all 4 edges individually into transparency. In addition you can set a softborder individually for
each side which goes outwards.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Left 0-65535 0

Right Right 0-65535 0

Top Top 0-65535 0

Bottom Bottom 0-65535 0

Left Soft Left Soft 0-65535 0

Right Soft Right Soft 0-65535 0

Top Soft Top Soft 0-65535 0

Bottom Soft Bottom Soft 0-65535 0
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Crop Edges

Crops all 4 edges individually into transparency.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Left Crops left edge 0-65535 0

Right Crops right edge 0-65535 0

Top Crops top edge 0-65535 0

Bottom Crops bottom edge 0-65535 0

Cropper HV RGBA

Crops both horizontal edges and independently both vertical edges. The color and transparency of the
cropped area can be set with the color and alpha mix parameters.
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Parameter Description Value Range Default

Mix Level of Effect 0-255 0

H Horizontal even crop 0-65535 0

V Vertical even crop 0-65535 0

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Alpha Alpha level of cropped area 0-255 128

Cropper HV

Crops both horizontal edges and independently both vertical edges. The color of the cropped area is
transparent.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

H Horizontal even crop 0-65535 0

V Vertical even crop 0-65535 0
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Frame RGBA

Crops all 4 edges equally at the same time creating the impression of framing the layer. The frame
size and inwards softborder are adjustable. The color and transparency of the frame can be set with
the color and alpha mix parameters.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of frame 0-255 8

Feather Softness of inner frame border 0-255 8

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Alpha Alpha level of cropped area 0-255 128
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Frame 

Crops all 4 edges equally at the same time creating the impression of framing the layer. The frame
size and inwards softborder are adjustable. The color of the frame is transparent.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of frame 0-255 8

Feather Softness of inner frame border 0-255 8

Framed Cropper HV

Crops both horizontal edges and independently both vertical edges. The cropped image can be
surrounded with a frame for which you can set up the border width in pixels and the roundness of the
corners. The color, transparency and softness of the frame can be set with the color, alpha mix and
soft parameters.
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Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Crop H (px) Horizontal even crop 0-4096 0

Crop V (px) Vertical even crop 0-4096 0

Frame (px) Size of frame in pixel 0-4096 0

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Alpha Alpha level of cropped area 0-255 128

Soft Softness of frame 0-255 0

Round Roundness of frame corners 0-255 0

Iris RGBA

Applies an iris shaped cut-out to the layer creating the impression of putting the layer into a circular
frame. The frame size, softborder, position and aspect ratio are adjustable. The color and
transparency of the frame can be set with the color and alpha mix parameters. The frame effect can
be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of frame 0-255 128

Softness Softness of iris 0-255 64

U Position of Iris horizontal 0-65535 32768

V Position of Iris vertical 0-65535 32768

Aspect Aspect Ratio of Iris. Default value 128
applies the images aspect ratio to the iris.

0.000 – 128.000 128

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Alpha Alpha level of the iris.

Invert Invert Iris
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Iris 

Applies an iris shaped cut-out to the layer creating the impression of putting the layer into a circular
frame. The frame size, softborder, position and aspect ratio are adjustable. The frame is transparent
and can be inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of frame 0-255 128

Softness Softness of iris 0-255 64

U Position of Iris horizontal 0-65535 32768

V Position of Iris vertical 0-65535 32768

Aspect Aspect Ratio of Iris. Default value 128
applies the images aspect ratio to the iris.

0-255 128

Invert Invert Iris 0-255 0
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Profile Edges Alpha

Crops all 4 edges individually into transparency. You can choose for each side how much it should be
cropped and rotated.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Left 0-65535 0

Left R Left R 0-65535 32768

Right Right 0-65535 0

Right R Right R 0-65535 32768

Top Top 0-65535 0

Top R Top R 0-65535 32768

Bottom Bottom 0-65535 0

Bottom R Bottom R 0-65535 32768
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Profile Edges Mask

Turns the layer texture into a transparent and black mask. Crops all 4 edges individually into black.
You can choose for each side how much it should be cropped and rotated.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Left 0-65535 0

Left R Left R 0-65535 32768

Right Right 0-65535 0

Right R Right R 0-65535 32768

Top Top 0-65535 0

Top R Top R 0-65535 32768

Bottom Bottom 0-65535 0

Bottom R Bottom R 0-65535 32768
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Softborder RGBA

Adds a softborder to all edges. The border size and roundness of the corners can be adjusted. The
color and transparency of the border can be set with the color and alpha mix parameters.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of softborder 0-255 16

Corner Softness of corner 0-255 0

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Alpha Alpha level of the border area 0-255 128

Softborder 
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Adds a softborder to all edges. The border size and roundness of the corners can be adjusted. The
color of the border is transparent.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of softborder 0-255 16

Corner Softness of corner 0-255 0

6.5.2.11.17  Distort

 Displace

Displaces the pixels of the target image.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Offset Amount of displacement 0-65535 32768

Distort

Distorts the image, using factorized UV mapping offsets.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

U Offset Offset of U Mapping 0-65535 32768

V Offset Offset of V Mapping 0-65535 32768

U Factor Factor of U Mapping 0-65535 32768

V Factor Factor of V Mapping 0-65535 32768
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Fluid Color

This effect multiplies the FX texture with a color and adds a fluid effect which is best seen when
applied to a video layer.
According to the Offset and Velocity parameters, the frames of this result change there position
which creates the impression, the frames would fly into a (changing) direction.
With the "Density difference" fader you can change how many frames are multiplied into the Layer
texture and with "Velocity Factor" how far frames move. The last image shows a higher velocity than
in the second image.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Vel Dir Vel Dir 0-65535 32768

Offset Offset 0-65535 0

Offs. Freq. Offs. Freq. 0-65535 32768

Vel Input Vel Input 0-65535 6553

Vel Factor Vel Factor 0-65535 5242

Vel Cutoff Vel Cutoff 0-65535 13000

Vel Diff Vel Diff 0-65535 63000

Den Diff Den Diff 0-65535 63000

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255
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Fluid Mask

This effect multiplies the FX texture with the Layer texture and adds a fluid effect which is best seen
when applied to a video layer.
According to the Offset and Velocity parameters, the frames of this result change there position
slightly which creates the impression, they are blurred fluidly.
With the "Density difference" fader you can change how many frames are multiplied into the Layer
texture. The last image shows a lower difference, resulting in a darker image and in a clearer FX
media. "Invert RGB"  inverts the FX texture before its mixed to the Layer.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

Vel Dir Vel Dir 0-65535 32768

Offset Offset 0-65535 0

Offs. Freq. Offs. Freq. 0-65535 32768

Vel Input Vel Input 0-65535 6553

Vel Factor Vel Factor 0-65535 5242

Vel Cutoff Vel Cutoff 0-65535 13000

Vel Diff Vel Diff 0-65535 63000

Den Diff Density Difference 0-65535 63000

Inv. RGB Invert RGB levels from FX media 0-255 0

Inv. Alpha Inverts transparency from FX media 0-255 0
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Fluid Paint

This effect multiplies the FX texture with the Layer texture and adds a fluid effect which is best seen
when applied to a video layer.
According to the Offset and Velocity parameters, the frames of this result change there position
which creates the impression, the frames would fly into a (changing) direction.
With the "Density difference" fader you can change how many frames are multiplied into the Layer
texture and with "Velocity Factor" how far frames move. The last image shows a higher velocity than
in the second image.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

Vel Dir Vel Dir 0-65535 32768

Offset Offset 0-65535 0

Offs. Freq. Offs. Freq. 0-65535 32768

Vel Input Vel Input 0-65535 6553

Vel Factor Vel Factor 0-65535 5242

Vel Cutoff Vel Cutoff 0-65535 13000

Vel Diff Vel Diff 0-65535 63000

Den Diff Den Diff 0-65535 63000
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Interactive Waves Buffer RH

This effect is based on the Layer's Z Position or render history as explained in the manual chapter 
"Compositing" . The layer with the assigned effect makes a composition of all layers behind it and
displays it ontop its own texture. In the example, the "render" layer is positioned in the foreground, its
main media is a transparent image. In the background there is a video layer showing a running
timecode and a particle system  (also with a transparent media!).
Whenever a pixel from the composition changes, it causes waves as if a rain drop deformed the
rendering texture.
The parameter "Strenght" influences the wave speed / frequency, whilst "Delay" influences the
amplitude, i.e. how far the waves go).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Strength Strength 0-255 0

Delay Delay 0-65535 60000

Interactive Waves Buffer

The main media from the layer is a transparent image whilst the effect's media is video showing a
running timecode. Whenever a pixel from the timecode video changes, it causes waves as if a rain
drop deformed the rendering texture.
The parameter "Strenght" influences the wave speed / freuquency, whilst "Delay" influences the
amplitude, i.e. how far the waves go).

Parameter Description Value Range Default

410
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Mix Level of effect itself 0-255 0

Strength Strength 0-255 0

Delay Delay 0-65535 60000

Media Media file as source for waves - -

Interactive Waves RH

This effect is based on the Layer's Z Position or render history as explained in the manual chapter 
"Compositing" . The layer with the assigned effect makes a composition of all layers behind it and
mixes it into its own texture. In the example, the "render" layer is positioned in the foreground, its
main media is a grass image. In the background there is a video layer showing a running timecode
and a particle system  (also with a transparent media!).
Whenever a pixel from the composition changes, it causes waves as if a rain drop deformed the
rendering grass texture.
The parameter "Strenght" influences the wave speed / frequency, whilst "Delay" influences the
amplitude, i.e. how far the waves go). "Offset" offsets the grass texture in the waves.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Strength Strength 0-255 0

Offset Offset 0-65535 32768

Delay Delay 0-65535 60000

Interactive Waves

410
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The main media from the layer is a color gradients image whilst the effect's media is video showing a
running timecode. Whenever a pixel from the timecode video changes, it causes waves as if a rain
drop deformed the rendering color gradient texture.
The parameter "Strenght" influences the wave speed / freuquency, whilst "Delay" influences the
amplitude, i.e. how far the waves go). "Offset" offsets the grass texture in the waves.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Strength Strength 0-255 0

Offset Offset 0-65535 32768

Delay Delay 0-65535 60000

Media Media file as source for waves - -

Lens Barrel Distortion Color Corr

Applies a barrel distortion to a layer or output texture. In addition it applies a correction for chromatic
aberration which is for example of interest when working with a device like an Oculus Rift.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Lens X Horizontal lens position 0-65535 32768

Lens Y Vertical lens position 0-65535 32768

Scale X Horizontal scale 0-65535 32768

Scale Y Vertical scale 0-65535 32768

ScaleIn X Horizontal scale 0-65535 32768

ScaleIn Y Vertical scale 0-65535 32768

Coef. 0 Coef. 0 0-65535 65535

Coef. 1 Coef. 1 0-65535 32768

Coef. 2 Coef. 2 0-65535 32768

Coef. 3 Coef. 3 0-65535 32768
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Lens Barrel Distortion

Applies a barrel distortion to a layer or output texture.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Lens X Horizontal lens position 0-65535 32768

Lens Y Vertical lens position 0-65535 32768

Scale X Horizontal scale 0-65535 32768

Scale Y Vertical scale 0-65535 32768

ScaleIn X Horizontal scale 0-65535 32768

ScaleIn Y Vertical scale 0-65535 32768

Coef. 0 Coef. 0 0-65535 65535

Coef. 1 Coef. 1 0-65535 32768

Coef. 2 Coef. 2 0-65535 32768

Coef. 3 Coef. 3 0-65535 32768

Lens Pincushion Distortion

Applies a pincushion distortion to a layer or output texture.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Lens X Horizontal lens position 0-65535 32768

Lens Y Vertical lens position 0-65535 32768

Scale X Horizontal scale 0-65535 32768

Scale Y Vertical scale 0-65535 32768

ScaleIn X Horizontal scale 0-65535 32768

ScaleIn Y Vertical scale 0-65535 32768

Coef. 0 Coef. 0 0-65535 65535

Coef. 1 Coef. 1 0-65535 32768
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Coef. 2 Coef. 2 0-65535 32768

Coef. 3 Coef. 3 0-65535 32768

 Magnify Glass

Magnifies an area of the layer image and allows to define the position and size of this area as well as
the used zoom factor.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

X X Position of magnifier 0-65535 32768

Y Y Position of magnifier 0-65535 32768

In Size of completely magnified area 0-65535 16448

Out Size of area where magnification ends 0-65535 17733

Magnify Amount of magnification 0-65535 32768

Aspect Aspect ratio of magnifier 0-65535 42662

PolarCoordinates

Polar Coordinates Effect. Can be used to either treat current coordinates as Cartesian and Resample
to Polar or vice versa. Created by Florian Mosleh www.s2gfx.com

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Operation Operation 0-255 0
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Ripple Animation

Distorts the texture with a ripple animation. Amplitude, frequency, motion speed and direction as well
as size and position can be set up.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amplitude Defines the height of the ripple’s amplitude 0-65535 16384

Frequency Defines the ripple’s frequency (=amount of
ripples coming out from its center)

0-65535 32768

Motion Defines the speed and direction of the
ripple’s motion

0-65535 16448

Pos U U Position 0-65535 17733

Pos V V Position 0-65535 32768

Scale U U Scale 0-65535 16384

Scale V V Scale 0-65535 16384

 Ripple 

Distorts the texture with a non-animated ripple effect. Amplitude, frequency, phase as well as size
and position can be set up.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amplitude Defines the height of the ripple’s amplitude 0-65535 16384

Frequency Defines the ripple’s frequency (=amount of
ripples coming out from its center)

0-65535 32768

Phase Define the phase of the ripple’s curve 0-65535 16448

Pos U U Position 0-65535 17733

Pos V V Position 0-65535 32768

Scale U U Scale 0-65535 16384

Scale V V Scale 0-65535 16384
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Swirl Angle

Distorts the texture with a non-animated swirl effect. Twist, Depth and Amount can be set up.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Twist Amount of Twist 0-65535 128

Depth Depth of the Swirl 0-65535 4096

Amount Amount of swirl waves 0-65535 2048

 Texture Morph

Morphs the image by using an additional media file as texture.

Parameter Description Value Range Default

Media Add the image file that should be used as
texture for the morph effect

Mix Level of Effect 0-255 0

Factor Amount of Texture Morphing 0-255 64
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Waves

Modifies the texture with non-animated waves.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of Waves 0-65535 64000

U Offset U Mapping Offset (in X direction) 0-65535 32768

V Offset V Mapping Offset (in Y direction) 0-65535 32768
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6.5.2.11.18  Fractals

 ++ General information for Fractal Effects ++

A fractal is a geometric pattern that is repeated at ever smaller scales to produce irregular shapes
and surfaces that cannot be represented by classical geometry. Fractals are used especially in
computer modeling of irregular patterns and structures in nature.

Julia Fractal

Shows a Julia Fractal that can be modified by Zoom, Position and Seed Parameters.
The texture being originally on the layer does not influence this effect except during blending.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Zoom Zoom into the fractal 0-65535 32768

Pos U Pos U 0-65535 32768

Pos V Pos V 0-65535 32768

Seed X Seed X 0-65535 25000

Seed Y Seed Y 0-65535 25000

Mandelbrot Fractal

Shows a Mandelbrot Fractal that can be modified by Zoom, Aspect Ratio and Position Parameters.
The texture being originally on the layer does not influence this effect except during blending.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Zoom Zoom into the fractal 0-65535 32768

Aspect Defines the Aspect Ratio of the Fractal 0-65535 16384

Pos U Pos U 0-65535 32768

Pos V Pos V 0-65535 32768
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6.5.2.11.19  FX Collections

++ General information for FX Collections ++

These FX collections will be added automatically when starting a Server or Player in Lighting Console
Mode. Depending on your PB product a different amount of these effects will be already added to the
layers and automatically patched in the Patch tab as well.

Depending on the Effect chosen from the “FX Name” list on the left, all or several of the FX Faders will
get active, displaying the name of their function instead of FX1, FX2 etc. Example:

When the Effect “Frame RGBA” is chosen from the list, all faders are renamed according to their
function in this effect. The last two faders in this example are without function (n/a).

All effects listed under the FX Name list are explained in the FX theme collections , so please have
a look here to receive more information about each effect.

Server FX 16bit 9Ch

Effects containing 9 channels (parameters) with 16 bit for each channel, available for PB Server
products, see example above.

Player FX 16bit 4Ch

Effects containing 4 channels (parameters) with 16 bit for each channel, available for PB Player
products, similar to the example above.

353
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6.5.2.11.20  Generator

RND Noise Add

Adds the RGB values of a random noise texture (animated) with the RGB values of the layer’s
texture. Size of noise can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of noisy items 0-65535 64

RND Noise Divide

Divides the RGB values of a random noise texture (animated) with the RGB values of the layer’s
texture. Size of noise can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of noisy items 0-65535 64

RND Noise Mix

Fades into a random noise texture (animated). Size of noise can be adjusted.

Parameter Description Value Range Default
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Mix Level of Effect 0-255 0

Size Size of noisy items 0-65535 64

RND Noise Multiply

Multiplies the RGB values of a random noise texture (animated) with the RGB values of the layer’s
texture. Size of noise can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of noisy items 0-65535 64

RND Noise Subtract

Subtracts the RGB values of a random noise texture (animated) with the RGB values of the layer’s
texture. Size of noise can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size of noisy items 0-65535 64
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6.5.2.11.21  Geometry

Inflate

Inflates the layer in XYZ, best visible when having a 3D object applied as Mesh. Using just the 2D
layer texture (without a mesh!) results in inflating the layer in X&Y, and moving the layer in Z Position
closer to the camera.

Parameter Description Value Range Default

Amount Amount of Inflation 0-65535 0

Lens Barrel Distortion - Vertex

Applies a barrel distortion to a layer or output.

Parameter Description Value Range Default

Lens X Horizontal lens position 0-65535 32768

Lens Y Vertical lens position 0-65535 32768

Scale X Horizontal scale 0-65535 32768

Scale Y Vertical scale 0-65535 32768

ScaleIn X Horizontal scale 0-65535 32768

ScaleIn Y Vertical scale 0-65535 32768

Coef. 0 Coef. 0 0-65535 65535

Coef. 1 Coef. 1 0-65535 0

Coef. 2 Coef. 2 0-65535 0

Coef. 3 Coef. 3 0-65535 0
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Lens Pincushion Distortion - Vertex

Applies a barrel distortion to a layer or output.

Parameter Description Value Range Default

Lens X Horizontal lens position 0-65535 32768

Lens Y Vertical lens position 0-65535 32768

Scale X Horizontal scale 0-65535 32768

Scale Y Vertical scale 0-65535 32768

ScaleIn X Horizontal scale 0-65535 32768

ScaleIn Y Vertical scale 0-65535 32768

Coef. 0 Coef. 0 0-65535 65535

Coef. 1 Coef. 1 0-65535 0

Coef. 2 Coef. 2 0-65535 0

Coef. 3 Coef. 3 0-65535 0

Morph A-B

This effect allows deforming an object by moving its vertices from one assembly to another. Please
refer to this live warping tutorial  in the manual.

Morph A-B-C

This effect allows deforming an object by moving its vertices from one assembly to a second and a
third one. Please refer to the live warping tutorial  in the manual.

Rotate Local Quaternion

The rotation set up with the default XYZ rotation parameters from a layer depends on the rotation
pivot's position. It rotates the object as well as the rotation pivot point.
In contrary, the "Rotate Local Quaternion" parameters apply locally, independent from the pivot's

858
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position but using its orientation. It rotates only the object not the rotation pivot point.
The "Rotate Local Quaternion" applies a fixed rotation value based on quaternion parameters in
difference to the standard summarization of Euler XYZ rotation angles.

Parameter Description Value Range Default

QX QX -1-1 0

QY QY -1-1 0

QZ QZ -1-1 0

QW QW -1-1 0

Rotate Local XYZ

The rotation set up with the default XYZ rotation parameters from a layer depends on the rotation
pivot's position. It rotates the object as well as the rotation pivot point.
In contrary, the "Rotate Local XYZ" parameters apply locally, independent from the pivot's position but
using its orientation. It rotates only the object not the rotation pivot point.
The "Rotate Local XYZ" applies a fixed rotation value, whilst "Rotation Speed Local XYZ" applies a
constant rotation over time.

Parameter Description Value Range Default

X Rotation of local X Axis 0-65535 32768

Y Rotation of local Y Axis 0-65535 32768

Z Rotation of local Z Axis 0-65535 32768

Rotation Speed Local XYZ

The rotation set up with the default XYZ rotation parameters from a layer depends on the rotation
pivot's position. It rotates the object as well as the rotation pivot point.
In contrary, the "Rotate Local XYZ" parameters apply locally, independent from the pivot's position but
using its orientation. It rotates only the object not the rotation pivot point.
The "Rotate Local XYZ" applies a fixed rotation value, whilst "Rotation Speed Local XYZ" applies a
constant rotation over time.

Parameter Description Value Range Default
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X X 0-65535 32768

Y Y 0-65535 32768

Z Z 0-65535 32768

XYZ Push

Pushes the layer texture in XYZ, depending on the settings of XYZ pivots.

Example above: 
Left: Effect is not applied
Center: Y Offset is applied; Y Pivot is centered (default value)
Right: X Offset is applied; X Pivot is moved to right edge of the layer

Parameter Description Value Range Default

X Off X Offset 0-65535 32768

Y Off Y Offset 0-65535 32768

Z Off Z Offset 0-65535 32768

PX Position of X Pivot 0-65535 32768

PY Position of Y Pivot 0-65535 32768

PZ Position of Z Pivot 0-65535 32768

XYZ Squeeze

Squeezes the layer texture in XYZ, depending on the settings of XYZ pivots.

Parameter Description Value Range Default

X Off X Offset 0-65535 0

Y Off Y Offset 0-65535 0

Z Off Z Offset 0-65535 0

PX Position of X Pivot 0-65535 32768

PY Position of Y Pivot 0-65535 32878

PZ Position of Z Pivot 0-65535 32768
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6.5.2.11.22  Gradients

Gradient Linear Horizontal

Allows turning the layer texture into a linear gradient with the possibility of choosing the colors for the
horizontal area. Alpha layers for both areas are adjustable.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Red C Red C 0-255 0

Green C Green C 0-255 0

Blue C Blue C 0-255 0

Alpha C Alpha C 0-255 255

Gradient Linear Vertical

Allows turning the layer texture into a linear gradient with the possibility of choosing the colors for the
vertical area. Alpha layers for both areas are adjustable.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Red C Red C 0-255 0

Green C Green C 0-255 0

Blue C Blue C 0-255 0
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Alpha C Alpha C 0-255 255

Gradient Linear

Allows turning the layer texture into a linear gradient with the possibility of choosing the colors for the
higher and lower area. Alpha levels for both areas are adjustable.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Red level of higher color, Color Picker 0-255 255

Green H Green level of higher color, Color Picker 0-255 255

Blue H Blue level of higher color, Color Picker 0-255 255

Alpha H Alpha level of higher color 0-255 255

Red L Red level of lower color, Color Picker 0-255 0

Green L Green level of lower color, Color Picker 0-255 0

Blue L Blue level of lower color, Color Picker 0-255 0

Alpha L Alpha level of lower color 0-255 255

Gradient Quad 16bit

Allows turning the layer texture into a gradient with four different areas with the possibility of choosing
16 bit colors and alpha channels. Size and softness of the quadrangle (four-sided figure) are
adjustable.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 65535

Red 1 First color picker / Level of red 0-65535 65535

Green 1 First color picker / Level of green 0-65535 65535
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Blue 1 First color picker / Level of blue 0-65535 65535

Alpha 1 Alpha 1 0-65535 65535

Softness 1 Softness 1 0-65535 250

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-65535 65535

Green 2 Second color picker / Level of green 0-65535 0

Blue 2 Second color picker / Level of blue 0-65535 0

Alpha 2 Alpha 2 0-65535 65535

Softness 2 Softness 2 0-65535 250

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-65535 0

Green 3 Third color picker / Level of green 0-65535 65535

Blue 3 Third color picker / Level of blue 0-65535 0

Alpha 3 Alpha 3 0-65535 65535

Softness 3 Softness 3 0-65535 250

Pt4 X Horizontal position of the fourth
point

0-65535 0

Pt4 Y Vertical position of the fourth point 0-65535 0

Red 4 Fourth color picker / Level of red 0-65535 0

Green 4 Fourth color picker / Level of green 0-65535 0

Blue 4 Fourth color picker / Level of blue 0-65535 65535

Alpha 4 Alpha 4 0-65535 65535

Softness 4 Softness 4 0-65535 250

Gradient Quad Black Lift 16bit

Allows turning the layer texture into a gradient with four different areas with the possibility of choosing
16 bit colors and alpha channels. Size and softness of the quadrangle (four-sided figure) are
adjustable. The gradient colors are added to the layer texture but only to dark values. The higher the
"Threshold" parameter the lighter the colors get that are influenced by the gradient colors.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 65535
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Red 1 First color picker / Level of red 0-65535 10000

Green 1 First color picker / Level of green 0-65535 10000

Blue 1 First color picker / Level of blue 0-65535 10000

Alpha 1 Alpha 1 0-65535 65535

Softness 1 Softness 1 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-65535 10000

Green 2 Second color picker / Level of green 0-65535 10000

Blue 2 Second color picker / Level of blue 0-65535 10000

Alpha 2 Alpha 2 0-65535 65535

Softness 2 Softness 2 0-65535 0

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-65535 10000

Green 3 Third color picker / Level of green 0-65535 10000

Blue 3 Third color picker / Level of blue 0-65535 10000

Alpha 3 Alpha 3 0-65535 65535

Softness 3 Softness 3 0-65535 0

Pt4 X Horizontal position of the fourth
point

0-65535 0

Pt4 Y Vertical position of the fourth point 0-65535 0

Red 4 Fourth color picker / Level of red 0-65535 10000

Green 4 Fourth color picker / Level of green 0-65535 10000

Blue 4 Fourth color picker / Level of blue 0-65535 10000

Alpha 4 Alpha 4 0-65535 65535

Softness 4 Softness 4 0-65535 0

Threshold Threshold 0-65535 30000

Gradient Quad Black Lift

Allows turning the layer texture into a gradient with four different areas with the possibility of choosing
8 bit colors and alpha channels. Size and softness of the quadrangle (four-sided figure) are
adjustable. The gradient colors are added to the layer texture but only to dark values. The higher the
"Threshold" parameter the lighter the colors get that are influenced by the gradient colors.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default
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Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 65535

Red 1 First color picker / Level of red 0-255 30

Green 1 First color picker / Level of green 0-255 30

Blue 1 First color picker / Level of blue 0-255 30

Alpha 1 Alpha 1 0-255 255

Softness 1 Softness 1 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-255 30

Green 2 Second color picker / Level of green 0-255 30

Blue 2 Second color picker / Level of blue 0-255 30

Alpha 2 Alpha 2 0-255 255

Softness 2 Softness 2 0-65535 0

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-255 30

Green 3 Third color picker / Level of green 0-255 30

Blue 3 Third color picker / Level of blue 0-255 30

Alpha 3 Alpha 3 0-255 255

Softness 3 Softness 3 0-65535 0

Pt4 X Horizontal position of the fourth
point

0-65535 0

Pt4 Y Vertical position of the fourth point 0-65535 0

Red 4 Fourth color picker / Level of red 0-255 30

Green 4 Fourth color picker / Level of green 0-255 30

Blue 4 Fourth color picker / Level of blue 0-255 30

Alpha 4 Alpha 4 0-255 255

Softness 4 Softness 4 0-65535 0

Threshold Threshold 0-255 75

Gradient Quad

Allows turning the layer texture into a gradient with four different areas with the possibility of choosing
8 bit colors and alpha channels. Size and softness of the quadrangle (four-sided figure) are
adjustable.
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This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 65535

Red 1 First color picker / Level of red 0-255 255

Green 1 First color picker / Level of green 0-255 255

Blue 1 First color picker / Level of blue 0-255 255

Alpha 1 Alpha 1 0-255 255

Softness 1 Softness 1 0-65535 250

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-255 255

Green 2 Second color picker / Level of green 0-255 0

Blue 2 Second color picker / Level of blue 0-255 0

Alpha 2 Alpha 2 0-255 255

Softness 2 Softness 2 0-65535 250

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-255 0

Green 3 Third color picker / Level of green 0-255 255

Blue 3 Third color picker / Level of blue 0-255 0

Alpha 3 Alpha 3 0-255 255

Softness 3 Softness 3 0-65535 250

Pt4 X Horizontal position of the fourth
point

0-65535 0

Pt4 Y Vertical position of the fourth point 0-65535 0

Red 4 Fourth color picker / Level of red 0-255 0

Green 4 Fourth color picker / Level of green 0-255 0

Blue 4 Fourth color picker / Level of blue 0-255 255

Alpha 4 Alpha 4 0-255 255

Softness 4 Softness 4 0-65535 250

Gradient Radial
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Allows turning the layer texture into a radial gradient with the possibility of choosing the colors for the
higher and lower area. Alpha levels for both areas are adjustable.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Red level of higher color, Color Picker 0-255 255

Green H Green level of higher color, Color Picker 0-255 255

Blue H Blue level of higher color, Color Picker 0-255 255

Alpha H Alpha level of higher color 0-255 255

Red L Red level of lower color, Color Picker 0-255 0

Green L Green level of lower color, Color Picker 0-255 0

Blue L Blue level of lower color, Color Picker 0-255 0

Alpha L Alpha level of lower color 0-255 255

Gradient Spiral

Allows turning the layer texture into a spiral gradient with the possibility of choosing the colors for the
higher and lower area. Alpha levels for both areas are adjustable. The amount of the spiral is
influenced by the opacity value of the layer as well.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Red level of higher color, Color Picker 0-255 255

Green H Green level of higher color, Color Picker 0-255 255

Blue H Blue level of higher color, Color Picker 0-255 255

Alpha H Alpha level of higher color 0-255 255

Red L Red level of lower color, Color Picker 0-255 0

Green L Green level of lower color, Color Picker 0-255 0

Blue L Blue level of lower color, Color Picker 0-255 0

Alpha L Alpha level of lower color 0-255 255

Gradient Swirl



454

Allows turning the layer texture into a swirl gradient with the possibility of choosing the colors for the
higher and lower area. Alpha levels for both areas are adjustable. 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Red level of higher color, Color Picker 0-255 255

Green H Green level of higher color, Color Picker 0-255 255

Blue H Blue level of higher color, Color Picker 0-255 255

Alpha H Alpha level of higher color 0-255 255

Red L Red level of lower color, Color Picker 0-255 0

Green L Green level of lower color, Color Picker 0-255 0

Blue L Blue level of lower color, Color Picker 0-255 0

Alpha L Alpha level of lower color 0-255 255

Gradient Triangle 16bit

Allows turning the layer texture into a gradient with three different areas with the possibility of
choosing 16 bit colors and alpha channels. Size, softness and rotation angle of the triangular (3-sided
figure) are adjustable. The gradient colors are added to the layer texture.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Red 1 First color picker / Level of red 0-65535 65535

Green 1 First color picker / Level of green 0-65535 65535

Blue 1 First color picker / Level of blue 0-65535 65535

Alpha 1 Alpha 1 0-65535 65535

Softness 1 Softness 1 0-65535 250

Pt2 X Horizontal position of the second
point

0-65535 32768

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-65535 65535

Green 2 Second color picker / Level of green 0-65535 0

Blue 2 Second color picker / Level of blue 0-65535 0

Alpha 2 Alpha 2 0-65535 65535

Softness 2 Softness 2 0-65535 250

Pt3 X Horizontal position of the third point 0-65535 65535
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Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-65535 0

Green 3 Third color picker / Level of green 0-65535 65535

Blue 3 Third color picker / Level of blue 0-65535 0

Alpha 3 Alpha 3 0-65535 65535

Softness 3 Softness 3 0-65535 250

Angle Angle 0-360 180

Gradient Triangle Black Lift 16bit

Allows turning the layer texture into a gradient with three different areas with the possibility of
choosing 16 bit colors and alpha channels. Size, softness and rotation angle of the triangular (3-sided
figure) are adjustable. The gradient colors are added to the layer texture but only to dark values. The
higher the "Threshold" parameter the lighter the colors get that are influenced by the gradient colors.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Red 1 First color picker / Level of red 0-65535 10000

Green 1 First color picker / Level of green 0-65535 10000

Blue 1 First color picker / Level of blue 0-65535 10000

Alpha 1 Alpha 1 0-65535 65535

Softness 1 Softness 1 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 32768

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-65535 10000

Green 2 Second color picker / Level of green 0-65535 10000

Blue 2 Second color picker / Level of blue 0-65535 10000

Alpha 2 Alpha 2 0-65535 65535

Softness 2 Softness 2 0-65535 0

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-65535 10000

Green 3 Third color picker / Level of green 0-65535 10000

Blue 3 Third color picker / Level of blue 0-65535 10000

Alpha 3 Alpha 3 0-65535 65535
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Softness 3 Softness 3 0-65535 0

Angle Angle 0-360 180

Threshold Threshold 0-65535 30000

Gradient Triangle Black Lift

Allows turning the layer texture into a gradient with three different areas with the possibility of
choosing 8 bit colors and alpha channels. Size, softness and rotation angle of the triangular (3-sided
figure) are adjustable. The gradient colors are added to the layer texture but only to dark values. The
higher the "Threshold" parameter the lighter the colors get that are influenced by the gradient colors.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Red 1 First color picker / Level of red 0-255 30

Green 1 First color picker / Level of green 0-255 30

Blue 1 First color picker / Level of blue 0-255 30

Alpha 1 Alpha 1 0-255 255

Softness 1 Softness 1 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 32768

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-255 30

Green 2 Second color picker / Level of green 0-255 30

Blue 2 Second color picker / Level of blue 0-255 30

Alpha 2 Alpha 2 0-255 255

Softness 2 Softness 2 0-65535 0

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-255 30

Green 3 Third color picker / Level of green 0-255 30

Blue 3 Third color picker / Level of blue 0-255 30

Alpha 3 Alpha 3 0-255 255

Softness 3 Softness 3 0-65535 0

Angle Angle 0-360 180

Threshold Threshold 0-255 75
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Gradient Triangle

Allows turning the layer texture into a gradient with three different areas with the possibility of
choosing 8 bit colors and alpha channels. Size, softness and rotation angle of the triangular (3-sided
figure) are adjustable. 

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Red 1 First color picker / Level of red 0-255 255

Green 1 First color picker / Level of green 0-255 255

Blue 1 First color picker / Level of blue 0-255 255

Alpha 1 Alpha 1 0-255 255

Softness 1 Softness 1 0-65535 250

Pt2 X Horizontal position of the second
point

0-65535 32768

Pt2 Y Vertical position of the second point 0-65535 65535

Red 2 Second color picker / Level of red 0-255 255

Green 2 Second color picker / Level of green 0-255 0

Blue 2 Second color picker / Level of blue 0-255 0

Alpha 2 Alpha 2 0-255 255

Softness 2 Softness 2 0-65535 250

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red 3 Third color picker / Level of red 0-255 0

Green 3 Third color picker / Level of green 0-255 255

Blue 3 Third color picker / Level of blue 0-255 0

Alpha 3 Alpha 3 0-255 255

Softness 3 Softness 3 0-65535 250

Angle Angle 0-360 180
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6.5.2.11.23  Image Adjust

Brighten 

Brighten simply shifts all pixel values higher or lower when adjusting the Brighten Factor. Technically,
each RGB value is multiplied with a factor. In difference to the "Gamma RGB " effect, this is a
linear function.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Factor Factor of Brightness 0-255 32

Burn 

The Burn Effect is used to lighten areas of the image. The Threshold parameter allows defining the
intensity value of the pixels from which on Burn should take effect. Use the Factor parameter to set
the amount of burning.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Factor Factor of Burning 0-255 32

Threshold Threshold of intensity value 0-255 64

CCB Multiply
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This is an alternative to the "ColorContrastBrightness"  effect. It allows adjusting Color, Contrast
and Brightness.
The Chroma parameter itself works like the "Brighten" effect, it multiplies each RGB value with a
factor. The Contrast parameter multiplies bright colors with a factor to make them brighter and divides
dark colors with a factor to darken them further. The Brightness parameter does exactly the same as
the Chroma parameter (in difference to the normal CCB FX).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Chroma Chroma 0-255 128

Contrast Contrast 0-255 128

Bright Bright 0-255 128

ColorContrastBrightness

The CCB Effect allows adjusting Color, Contrast and Brightness. The Chroma parameter itself works
like the "Brighten" effect, it multiplies each RGB value with a factor. The Contrast parameter
multiplies bright colors with a factor to make them brighter and divides dark colors with a factor to
darken them further. The Brightness parameter adds a value to each RGB value equally.
Note, there is an alternative to this effect, the "CCB Multiply" . There, the Brightness parameter
works in the same way as the Chroma one.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Chroma Level of Chroma 0-255 128

Contrast Level of Contrast 0-255 128

Brightness Level of Brightness 0-255 128

Gamma RGB

This shifts the RGB pixel values (individually or together) higher or lower to brighten or darken the
image.  when adjusting the Brighten Factor. Technically each RGB value is multiplied with a factor. In
difference to the "Brighten " effect, this gamma correction is a non-linear function.

459
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Gamma R Gamma R 0-65535 16384

Gamma G Gamma G 0-65535 16384

Gamma B Gamma B 0-65535 16384

HighMidLowLights

Creates a lighting effect on the image, the colors for High, Mid and Low Lights can be adjusted
separately.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Level of Red for High Lights 0-255 128

Green H Level of Green for High Lights

Blue H Level of Blue for High Lights

Red M Level of Red for Mid Lights 0-255 128

Green M Level of Green for Mid Lights

Blue M Level of Blue for Mid Lights

Red L Level of Red for Low Lights

Green L Level of Green for Low Lights

Blue L Level of Blue for Low Lights 0-255 128

HSV Adjust

Changes the color of the image based on the HSV (hue, saturation, value) RGB color model, also
called HSB (hue, saturation, brightness).

Changing the Hue in- or decreases all color hues in the image accordingly.
Changing the Saturation, in- or decreases the saturation (white to full color) of all colors in the image.
Changing the Value, in- or decreases the brightness value (black to full color) of all colors in the
image.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Hue Hue 0-255 128

Saturation Saturation 0-255 128

Value Value 0-255 128

HSV by Hue

Changes the color of the image based on the HSV (hue, saturation, value) RGB color model, also
called HSB (hue, saturation, brightness).
Pick a color / hue with color picker and set a threshold to influence neighboring colors.
The A Set of the following faders influences the chosen colors, the B set all other ones.

Changing the Hue in- or decreases the color hue of the color set.
Changing the Saturation, in- or decreases the saturation (white to full color) of the color set.
Changing the Value, in- or decreases the brightness value (black to full color) of the color set.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Threshold Threshold 0-255 32

Hue A Hue A 0-255 128

Saturation A Saturation A 0-255 128

Value A Value A 0-255 128

Hue B Hue B 0-255 128

Saturation B Saturation B 0-255 128

Value B Value B 0-255 128

HSV-HS for V range
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Changes the color of the image based on the HSV (hue, saturation, value) RGB color model, also
called HSB (hue, saturation, brightness).
Pick a value (black to full color) and set the value range using the "Width" parameter. Note that a high
width influences a small range and vice versa.

Changing the Hue in- or decreases the color hue for the value range.
Changing the Saturation, in- or decreases the saturation (white to full color) for the value range.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Value Value 0-65535 32768

Width Width 0-65535 8192

Hue Hue 0-65535 32768

Saturation Saturation 0-65535 32768

Levels RGB

Allows setting the gradation levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Dark Red Adjusting the dark limit for Red 0-255 0

Light Red Adjusting the light limit for Red 0-255 255

Dark Green Adjusting the dark limit for Green 0-255 0

Light Green Adjusting the light limit for Green 0-255 255

Dark Blue Adjusting the dark limit for Blue 0-255 0

Light Blue Adjusting the light limit for Blue 0-255 255

Levels 

Allows setting the overall level gradation.

Parameter Description Value Range Default
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Mix Level of Effect 0-255 0

Dark Adjusting the dark limit 0-255 0

Light Adjusting the light limit 0-255 255

Posterize 

Posterize allows reducing the colour range by adjusting the amount of steps.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Steps Amount of steps 0-65535 4096

 RGB Add

Adds RGB colors by the RGB color mix value, allows inverting the image.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Invert Inverts the RGB Levels 0-255 0
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RGB Clipper

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Min Min. level of Red 0-255 0

Red Max Max. level of Red 0-255 255

Green Min Min. level of Green 0-255 0

Green Max Max. level of Green 0-255 255

Blue Min Min. level of Blue 0-255 0

Blue Max Max. level of Blue 0-255 255

 RGB CTB

RGB CTB (color temperature blue) emulates the CTB filter that converts tungsten light of 3200K to
'daylight' color.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amt Amount of conversion into ‘daylight’ color 0-255 0
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RGB CTO

RGB CTO (color temperature orange) emulates the CTO filter that converts 'daylight' color to tungsten
light of 3200K.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amt Amount of conversion into tungsten light 0-255 0

RGB Gamma

Allows adjusting the gamma for all three channels, RGB. The default value of 255 for RGB equates to
a gamma value of 1.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

R Gamma Red, 0-255 255

G Gamma Green 0-255 255

B Gamma Blue 0-255 255

RGB Min Max

Allows setting minimum and maximum levels for all three channels, RGB.
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Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Min Min. level of Red 0-255 128

Red Max Max. level of Red 0-255 255

Green Min Min. level of Green 0-255 128

Green Max Max. level of Green 0-255 255

Blue Min Min. level of Blue 0-255 128

Blue Max Max. level of Blue 0-255 255

RGB Multiply

All RGB colors are multiplied by RGB color mix values. Multiply can be factorized and inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Factor Color Multiply Factor 0-255 64

Invert Inverts the multiplied RGB levels 0-255 0

RGB Squisher

Squishes the RGB levels. For lower parameters this effect can be compared to the "Levels RGB"
effect.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Min Min. level of Red 0-255 128

Red Max Max. level of Red 0-255 255

Green Min Min. level of Green 0-255 128

Green Max Max. level of Green 0-255 255
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Blue Min Min. level of Blue 0-255 128

Blue Max Max. level of Blue 0-255 255

RGB to HSL

Transforms the image from the RGB color space into the HSL color space.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

RGB to Video Colors 16-235

Transforms the image colors from RGB (value range: 0 – 255) to Video Colors (range: 16-235).

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Video Colors 16-235 to RGB

Transforms the image from Video Colors (range: 16-235) to RGB (value range: 0 – 255).

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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Video RGB CC

Changes the RGB values of the image. There is a "Lower" and a "Higher" fader for each Red, Green
and Blue. The "Lower" fader subtracts the according color from all image colors. For the second
image red was subtracted. The "Higher" fader increases the according color by multiplying it with a
factor. For the last image red was enhanced.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

R Lo R Lo 0-255 18

R Hi R Hi 0-255 43

G Lo G Lo 0-255 18

G Hi G Hi 0-255 43

B Lo B Lo 0-255 18

B Hi B Hi 0-255 43

Video YUV to RGB

Converts the YUV colorspace (PAL / NTSC) to RGB color space.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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6.5.2.11.24  Image Adjust - Crop

CCB Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

The CCB Effect allows adjusting Color, Contrast and Brightness. The Chroma parameter multiplies
each RGB value with a factor. The Contrast parameter multiplies bright colors with a factor to make
them brighter and divides dark colors with a factor to darken them further. The Brightness parameter
adds a value to each RGB value equally.

Note, there is an alternative to this effect, the "CCB Multiply". There, the Brightness parameter works
in the same way as the Chroma one.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Chroma Chroma 0-255 128

Contrast Contrast 0-255 128

Bright Bright 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

High Mid Low Crop Pixel

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

Creates a lighting effect on the image, the colors for High, Mid and Low Lights can be adjusted
separately.

Parameter Description Value Range Default
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Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128

Blue H Color picker / Level of blue 0-255 128

Red M Red M 0-255 128

Green M Green M 0-255 128

Blue M Blue M 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

Levels Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

Allows setting the overall level gradation.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Dark Dark 0-255 0

Light Light 0-255 255

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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Levels RGB Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

Allows setting the gradation levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Dark Red Dark Red 0-255 0

Light Red Light Red 0-255 255

Dark Green Dark Green 0-255 0

Light Green Light Green 0-255 255

Dark Blue Dark Blue 0-255 0

Light Blue Light Blue 0-255 255

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB Add Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

Adds RGB colors by the RGB color mix value, allows inverting the image.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0
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Invert Inverts the RGB levels or the effect 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB Clipper Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB CTB Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.
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RGB CTB (color temperature blue) emulates the CTB filter that converts tungsten light of 3200K to
'daylight' color.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB CTO Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

RGB CTO (color temperature orange) emulates the CTO filter that converts 'daylight' color to tungsten
light of 3200K.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB Gamma Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.
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Allows adjusting the gamma for all three channels, RGB. The default value of 255 for RGB equates to
a gamma value of 1.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

R Color picker / Level of red 0-255 255

G Color picker / Level of green 0-255 255

B Color picker / Level of blue 0-255 255

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB Min Max Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 128

Red Max Red Max 0-255 255

Green Min Green Min 0-255 128

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 128

Blue Max Blue Max 0-255 255

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0
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RGB Multiply Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

All RGB colors are multiplied by RGB color mix values. Multiply can be factorized and inverted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Factor Factor 0-255 32

Invert Inverts the RGB levels or the effect 0-255 0

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

RGB Squisher Crop Edges (px)

Applies the effect within a rectangular area with hard borders; the rectangle's edges can be shifted in-
or outwards independently.

Squishes the RGB levels. For lower parameters this effect can be compared to the "Levels RGB"
effect.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0
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Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Left (px) Left (px) 0-8192 0

Right (px) Right (px) 0-8192 0

Top (px) Top (px) 0-8192 0

Bottom (px) Bottom (px) 0-8192 0

6.5.2.11.25  Image Adjust - Iris

CCB Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

The CCB Effect allows adjusting Color, Contrast and Brightness. The Chroma parameter multiplies
each RGB value with a factor. The Contrast parameter multiplies bright colors with a factor to make
them brighter and divides dark colors with a factor to darken them further. The Brightness parameter
adds a value to each RGB value equally.

Note, there is an alternative to this effect, the "CCB Multiply". There, the Brightness parameter works
in the same way as the Chroma one.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Chroma Chroma 0-255 128

Contrast Contrast 0-255 128

Bright Bright 0-255 128

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0
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High Mid Low Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

Creates a lighting effect on the image, the colors for High, Mid and Low Lights can be adjusted
separately.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128

Blue H Color picker / Level of blue 0-255 128

Red M Red M 0-255 128

Green M Green M 0-255 128

Blue M Blue M 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

Levels Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.
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Allows setting the overall level gradation.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Dark Dark 0-255 0

Light Light 0-255 255

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

Levels RGB Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

Allows setting the gradation levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Dark Red Dark Red 0-255 0

Light Red Light Red 0-255 255

Dark Green Dark Green 0-255 0

Light Green Light Green 0-255 255

Dark Blue Dark Blue 0-255 0

Light Blue Light Blue 0-255 255

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0
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RGB Add Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

Adds RGB colors by the RGB color mix value, allows inverting the image.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Invert Inverts the RGB levels or the effect 0-255 0

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

RGB Clipper Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0
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Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

RGB CTB Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

RGB CTB (color temperature blue) emulates the CTB filter that converts tungsten light of 3200K to
'daylight' color.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

RGB CTO Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.
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RGB CTO (color temperature orange) emulates the CTO filter that converts 'daylight' color to tungsten
light of 3200K.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

RGB Gamma Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

Allows adjusting the gamma for all three channels, RGB. The default value of 255 for RGB equates to
a gamma value of 1.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

R Color picker / Level of red 0-255 255

G Color picker / Level of green 0-255 255

B Color picker / Level of blue 0-255 255

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0
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RGB Min Max Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 128

Red Max Red Max 0-255 255

Green Min Green Min 0-255 128

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 128

Blue Max Blue Max 0-255 255

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

RGB Multiply Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

All RGB colors are multiplied by RGB color mix values. Multiply can be factorized and inverted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0
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Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Factor Factor 0-255 32

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0

RGB Squisher Iris

Applies the effect within an elliptical area with a hard or soft border. Size, position and aspect of the
ellipse are adjustable too, and the effect can be turned inside out.

Squishes the RGB levels. For lower parameters this effect can be compared to the "Levels RGB"
effect.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Size Size 0-255 128

Softness Softness 0-255 64

U U 0-65535 32768

V V 0-65535 32768

AspectIris AspectIris 0-255 128

Invert Inverts the RGB levels or the effect 0-255 0
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6.5.2.11.26  Image Adjust - Mediamask

CCB MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

The CCB Effect allows adjusting Color, Contrast and Brightness. The Chroma parameter multiplies
each RGB value with a factor. The Contrast parameter multiplies bright colors with a factor to make
them brighter and divides dark colors with a factor to darken them further. The Brightness parameter
adds a value to each RGB value equally.

Note, there is an alternative to this effect, the "CCB Multiply". There, the Brightness parameter works
in the same way as the Chroma one.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Chroma Chroma 0-255 128

Contrast Contrast 0-255 128

Bright Bright 0-255 128

Media Media file as source for overlay or
mask

- -

High Mid Low MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Creates a lighting effect on the image, the colors for High, Mid and Low Lights can be adjusted
separately.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128
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Blue H Color picker / Level of blue 0-255 128

Red M Red M 0-255 128

Green M Green M 0-255 128

Blue M Blue M 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Media Media file as source for overlay or
mask

- -

Levels MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Allows setting the overall level gradation.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Dark Dark 0-255 0

Light Light 0-255 255

Media Media file as source for overlay or
mask

- -

Levels RGB MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Allows setting the gradation levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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Dark Red Dark Red 0-255 0

Light Red Light Red 0-255 255

Dark Green Dark Green 0-255 0

Light Green Light Green 0-255 255

Dark Blue Dark Blue 0-255 0

Light Blue Light Blue 0-255 255

Media Media file as source for overlay or
mask

- -

RGB Add MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Adds RGB colors by the RGB color mix value, allows inverting the image.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Invert Inverts the RGB levels or the effect 0-255 0

Media Media file as source for overlay or
mask

- -

RGB Clipper MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

RGB CTB (color temperature blue) emulates the CTB filter that converts tungsten light of 3200K to
'daylight' color.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Media Media file as source for overlay or
mask

- -

RGB CTB MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Allows adjusting the gamma for all three channels, RGB. The default value of 255 for RGB equates to
a gamma value of 1.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Media Media file as source for overlay or
mask

- -

RGB CTO MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

RGB CTO (color temperature orange) emulates the CTO filter that converts 'daylight' color to tungsten
light of 3200K.

Parameter Description Value Range Default
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Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Media Media file as source for overlay or
mask

- -

RGB Gamma MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Allows adjusting the gamma for all three channels, RGB. The default value of 255 for RGB equates to
a gamma value of 1.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

R Color picker / Level of red 0-255 255

G Color picker / Level of green 0-255 255

B Color picker / Level of blue 0-255 255

Media Media file as source for overlay or
mask

- -

RGB Min Max MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 128

Red Max Red Max 0-255 255

Green Min Green Min 0-255 128
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Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 128

Blue Max Blue Max 0-255 255

Media Media file as source for overlay or
mask

- -

RGB Multiply MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

All RGB colors are multiplied by RGB color mix values. Multiply can be factorized and inverted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Factor Factor 0-255 32

Invert Inverts the RGB levels or the effect 0-255 0

Media Media file as source for overlay or
mask

- -

RGB Squisher MediaMask

Applies the effect according to a mask. White areas in the mask apply the effect fully. Less brighter
areas reduce the effect accordingly.

Squishes the RGB levels. For lower parameters this effect can be compared to the "Levels RGB"
effect.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Media Media file as source for overlay or
mask

- -

6.5.2.11.27  Image Adjust - Softborder

CCB Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

The CCB Effect allows adjusting Color, Contrast and Brightness. The Chroma parameter multiplies
each RGB value with a factor. The Contrast parameter multiplies bright colors with a factor to make
them brighter and divides dark colors with a factor to darken them further. The Brightness parameter
adds a value to each RGB value equally.

Note, there is an alternative to this effect, the "CCB Multiply". There, the Brightness parameter works
in the same way as the Chroma one.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Chroma Chroma 0-255 128

Contrast Contrast 0-255 128

Bright Bright 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0

High Mid Low Softborder
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Applies the effect within within an adjustable rectangular area with soft edges.

Creates a lighting effect on the image, the colors for High, Mid and Low Lights can be adjusted
separately.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red H Color picker / Level of red 0-255 128

Green H Color picker / Level of green 0-255 128

Blue H Color picker / Level of blue 0-255 128

Red M Red M 0-255 128

Green M Green M 0-255 128

Blue M Blue M 0-255 128

Red L Color picker / Level of red 0-255 128

Green L Color picker / Level of green 0-255 128

Blue L Color picker / Level of blue 0-255 128

Size Size 0-255 16

Corner Corner 0-255 0

Levels RGB Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

Allows setting the overall level gradation.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Dark Red Dark Red 0-255 0

Light Red Light Red 0-255 255

Dark Green Dark Green 0-255 0

Light Green Light Green 0-255 255

Dark Blue Dark Blue 0-255 0

Light Blue Light Blue 0-255 255

Size Size 0-255 16

Corner Corner 0-255 0
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Levels Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

Allows setting the gradation levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Dark Dark 0-255 0

Light Light 0-255 255

Size Size 0-255 16

Corner Corner 0-255 0

RGB Add Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

Adds RGB colors by the RGB color mix value, allows inverting the image.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Invert Inverts the RGB levels or the effect 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0
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RGB Clipper Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Size Size 0-255 16

Corner Corner 0-255 0

RGB CTB Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

RGB CTB (color temperature blue) emulates the CTB filter that converts tungsten light of 3200K to
'daylight' color.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0
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RGB CTO Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

RGB CTO (color temperature orange) emulates the CTO filter that converts 'daylight' color to tungsten
light of 3200K.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0

RGB Gamma Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

Allows adjusting the gamma for all three channels, RGB. The default value of 255 for RGB equates to
a gamma value of 1.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

R Color picker / Level of red 0-255 255

G Color picker / Level of green 0-255 255

B Color picker / Level of blue 0-255 255

Size Size 0-255 16

Corner Corner 0-255 0
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RGB Min Max Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

Allows setting minimum and maximum levels for all three channels, RGB.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 128

Red Max Red Max 0-255 255

Green Min Green Min 0-255 128

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 128

Blue Max Blue Max 0-255 255

Size Size 0-255 16

Corner Corner 0-255 0

RGB Multiply Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

All RGB colors are multiplied by RGB color mix values. Multiply can be factorized and inverted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Factor Factor 0-255 32

Invert Inverts the RGB levels or the effect 0-255 0

Size Size 0-255 16

Corner Corner 0-255 0
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RGB Squisher Softborder

Applies the effect within within an adjustable rectangular area with soft edges.

Squishes the RGB levels. For lower parameters this effect can be compared to the "Levels RGB"
effect.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Min Red Min 0-255 0

Red Max Red Max 0-255 255

Green Min Green Min 0-255 0

Green Max Green Max 0-255 255

Blue Min Blue Min 0-255 0

Blue Max Blue Max 0-255 255

Size Size 0-255 16

Corner Corner 0-255 0

6.5.2.11.28  Keying

Alpha Adjust

491
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This effect influences the threshold between transparent (see-through) and opaque pixels. You can
either enlarge or reduce the transparent area when it has a soft border with partly transparent pixels.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Low Low 0-255 0

High High 0-255 255

Black Key Mask

Allows keying out black parts of the image based on the luminance values, all other parts will be
masked black. This result can be inverted: transparent areas get black.
In order to key out only black with the possibility not to get any transparency for other dark parts, use
RGB key instead.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range of color tolerance 0-255 255

Invert Inverts the Black Key Mask 0-255 0

 Black Key

Allows keying out black parts of the image based on the luminance values. This result can be
inverted: transparent areas get black.
In order to key out only black with the possibility not to get any transparency for other light parts, use
RGB key instead.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range of color tolerance 0-255 255

Invert Inverts the black key 0-255 0
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Difference Key Mask

This effect looks for pixels that match in the textures from the layer media and effect media.
Corresponding areas are keyed out, meaning that the background layer is visible. When there are
differences in areas, they are not keyed out but overlap the background as a black mask. You can
adjust a threshold to accept small color differences. The third image shows the result of the "Invert"
parameter: differences are keyed out and matching areas overlay the background in their original color
(and white if transparent).

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Threshold Threshold 0-255 0

Media Media File as Mask 0-255 255

Invert Inverts the difference key 0-255 0

 Difference Key

This effect looks for pixels that match in the textures from the layer media and effect media.
Corresponding areas are keyed out, meaning that the background layer is visible. When there are
differences in areas, they are not keyed out but overlap the background in the color from the layer
media. You can adjust a threshold to accept small color differences. The third image shows the result
of the "Invert" parameter: differences are keyed out and matching areas overlay the background in
there original color (and white if transparent).

Parameter Description Value Range Default
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Mix Level of Effect 0-255 0

Threshold Threshold 0-255 0

Media Media File as Mask 0-255 255

Invert Inverts the difference key 0-255 0

Difference Matte

This effect creates a mask from a captured frame and keys out all matching pixels from following
frames in the video applied to the layer. As seen in the second image, all black pixels from the layer
texture are keyed out in general. To capture a frame toggle the "Capture" parameter above 0 and back
to 0. Now this frame is memorized and compared to following frames. All matching pixels are keyed
out, different pixels overlap the background. The third image shows a train, which was not visible in
the captured frame, hence it can be seen on top the background layer.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Capture Capture 0-255 0

Threshold Threshold 0-255 64

Luma Key
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Allows adjusting a key based on luminance (brightness) values. A high range starts keying out, only
dark colors (see second image) whilst a smaller level enlarges the value range of affected pixel
brightness (see third image).

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range 0-255 255

Level Level 0-255 255

Invert Inverts the luma key 0-255 0

 RGB Key Factor Mask

Allows keying out any RGB color included in the picked Color Range. In the second image a bright
yellow color (RGB 255,255,0) and a small range was chosen which means that most dark colors,
dark red, dark green and  yellow tones are keyed out and the background can be seen there. All other
pixels are rendered as a black mask. In the third image, the result was inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range 0-255 128

Red Red level, Color picker 0-255 0

Green Green level, Color picker 0-255 0

Blue Blue level, Color picker 0-255 0

Invert Inverts the RGB key factor mask 0-255 0
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RGB Key Factor

Allows keying out any RGB color included in the picked Color Range. In the second image a bright
yellow color (RGB 255,255,0) and a small range was chosen which means that most dark colors,
dark red, dark green and  yellow tones are keyed out and the background can be seen there. In the
third image, the result was inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range 0-255 128

Red Red level, Color picker 0-255 0

Green Green level, Color picker 0-255 0

Blue Blue level, Color picker 0-255 0

Invert Inverts the RGB key factor mask 0-255 0
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RGB Key Mask

Allows keying out any RGB color by adjusting the Color Range, Threshold, Radius. In the second
image a yellow color was chosen which means that all yellow parts from the layer texture are keyed
out and the background can be seen there whilst all other pixels are rendered as a black mask. In the
third image, the result was inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range 0-255 128

Red Red level, Color picker 0-255 0

Green Green level, Color picker 0-255 0

Blue Blue level, Color picker 0-255 0

Invert Inverts the RGB key factor mask 0-255 0
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RGB Key

Allows keying out any RGB color by adjusting the Color Range, Threshold, Radius. In the second
image a yellow color was chosen which means that all yellow parts from the layer texture are keyed
out and the background can be seen there. In the third image, the result was inverted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range 0-255 128

Red Red level, Color picker 0-255 0

Green Green level, Color picker 0-255 0

Blue Blue level, Color picker 0-255 0

Threshold Threshold 0-255 64

Radius Radius 0-255 32

Invert Inverts the RGB key factor mask 0-255 0
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Spill Reduce Blue AVG

This effect is useful in blue screen applications. After keying out the blue color, e.g. with an "RGB
key " effect, sometimes there is a blue spill left (very light or dark blue pixels), which is depicted in
the second image. This Spill Reduce effect reduces the blue value in all colors but affects colors with
a red or green value less. In other words, pure blue colors are darkened fully (RGB 0,0,255 > 0,0,0)
whilst yellow, cyan and purple  change less (RGB r,g,255 > r,g,128) and red and green stay
unchanged. The intensity of the reducing accords to the value of the Mix parameter (Mix 0>255). Note
that depending on the colors of the cut out object, another blue spill effect might give better results, or
more RGB keys set to light and dark blue.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Spill Reduce Blue by Green
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This effect is useful in blue screen applications. After keying out the blue color, e.g. with an "RGB
key " effect, sometimes there is a blue spill left (very light or dark blue pixels), which is depicted in
the second image. This Spill Reduce effect reduces the blue value in all colors without a green value.
In other words, blue colors are darkened (RGB 0,255,0 > 0,0,0) and purple colors turn red (RGB
255,0,255 > 255,0,0) whilst red, green, yellow and cyan stay unchanged. The intensity of the
reducing accords to the value of the Mix parameter (Mix 0>255). Note that depending on the colors of
the cut out object, another blue spill effect might give better results, or more RGB keys set to light
and dark blue.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Spill Reduce Blue

This effect is useful in blue screen applications. After keying out the blue color, e.g. with an "RGB
key " effect, sometimes there is a blue spill left (very light or dark blue pixels), which is depicted in
the second image. This Spill Reduce effect reduces the blue value in all colors without a red value. In
other words, blue colors are darkened (RGB 0,0,255 > 0,0,0) and cyan colors turn green (RGB
0,255,255 > 0,255,0) whilst red, green, yellow and purple stay unchanged. The intensity of the
reducing accords to the value of the Mix parameter (Mix 0>255). Note that depending on the colors of
the cut out object, another blue spill effect might give better results, or alternatively more RGB keys
set to light and dark blue.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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Spill Reduce Green AVG

This effect is useful in green screen applications. After keying out the green color, e.g. with an "RGB
key " effect, sometimes there is a green spill left (very light or dark green pixels), which is depicted
in the second image. This Spill Reduce effect reduces the green value in all colors but affects colors
with a blue or red value less. In other words, pure green colors are darkened fully (RGB 0,255,0 >
0,0,0) whilst yellow, cyan and purple  change less (RGB r,255,b > r,128,b) and red and blue stay
unchanged. The intensity of the reducing accords to the value of the Mix parameter (Mix 0>255). Note
that depending on the colors of the cut out object, another green spill effect might give better results,
or more RGB keys set to light and dark green.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Spill Reduce Green by Blue
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This effect is useful in green screen applications. After keying out the green color, e.g. with an "RGB
key " effect, sometimes there is a green spill left (very light or dark green pixels), which is depicted
in the second image. This Spill Reduce effect reduces the green value in all colors without a blue
value. In other words, green colors are darkened (RGB 0,255,0 > 0,0,0) and yellow colors turn red
(RGB 255,255,0 > 255,0,0) whilst red, blue, cyan and purple stay unchanged. The intensity of the
reducing accords to the value of the Mix parameter (Mix 0>255). Note that depending on the colors of
the cut out object, another green spill effect might give better results, or more RGB keys set to light
and dark green.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Spill Reduce Green

This effect is useful in green screen applications. After keying out the green color, e.g. with an "RGB
key " effect, sometimes there is a green spill left (very light or dark green pixels), which is depicted
in the second image. This Spill Reduce effect reduces the green value in all colors without a red
value. In other words, green colors are darkened (RGB 0,255,0 > 0,0,0) and cyan colors turn blue
(RGB 0,255,255 > 0,0,255) whilst red, blue, yellow and purple stay unchanged. The intensity of the
reducing accords to the value of the Mix parameter (Mix 0>255). Note that depending on the colors of
the cut out object, another green spill effect might give better results, or alternatively more RGB keys
set to light and dark green.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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White Key Mask

Allows keying out white parts of the image based on the luminance values, all other parts will be
masked black. This result can be inverted: transparent areas get black.
In order to key out only white with the possibility not to get any transparency for other light parts, use
RGB key instead. 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range of color tolerance 0-255 255

Invert Inverts the white key 0-255 0

White Key

Allows keying out white parts of the image based on the luminance values. This result can be
inverted: transparent areas get white.
In order to key out only white with the possibility not to get any transparency for other light parts, use
RGB key instead.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Range Range of color tolerance 0-255 255

Invert Inverts the white key 0-255 0

6.5.2.11.29  Lighting

++ General information for Light Effects ++

The light feature in Pandoras Box can be best understood and used when the following fundamental
course of events is kept in mind:

1. Firstly, light is emitted by a light source. Here the light rays are determined in their starting
position, direction, intensity and color.
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A light source can be either the inherent light from the Lighting effect , or in all other cases, an
external light from a Light Layer .

2. The light then shines on an object's (i.e. layer's) surface. The object's properties, also called its
material, determine how the light interacts with it and in which direction and what amount and color it
bounces off.
Note that in Pandoras Box light cannot pass through objects or bend around them, it can only be
reflected.

3. Lastly, the reflected light enters the viewpoint. In the real world it would be the human eye whilst
here, it is the virtual camera. No adjustments can be made at this point of the sequence. It is now,
when the object becomes truly visible, its image is rendered.
Same as incident light, reflected light has no attenuation, which means that their intensity is not a
function of the distance but is always equally intense.

Light falling on an object holds a source color; in physical terms it has a specific wavelength, in
rendering terms it has an rgb value. The rgb value depends additionally on the light intensity. The
default color is white - consisting of red, green and blue components in equal amounts.
When interacting with the object's material the source color changes according to the target color
which is determined by the layer texture's color. The color of the reflected light is the common
intersection of the source and target color.

In all images seen left, the background is pure white, but the
opacity is lowered to 33% thus the reflected light's intensity
is reduced. 

The mushrooms texture is always covered with red spots; 
the main color is 
- blue with        rgb = 0,0,255 in image 1-3, 
- purple with     rgb = 125,0,255 in image 4-6 and 
- magenta with rgb = 255,0,255 in image 7-9.

The light changes from left to right:
- white with rgb = 255,255,255
- red  with   rgb = 255,0,0

- blue with   rgb = 0,0,255.

But materials in the real world do not only reflect in one color, rather with many shades and nuances.
In an effort to mimic this, more than one light is used to describe an virtual object's reflection. In
Pandoras Box (PB), three varieties of light have an effect: ambient, diffuse and specular light. Unlike
the first two, reflected specular color does not necessarily need to be modulated by the objects color.
In particular, materials like plastic often reflect only the source's color whilst metallic materials might
reflect with a shifted hue.

Another difference between the three lights is in which direction they reflect from a surface. The left
image below shows the first law of reflection theory, considering a perfectly smooth surface. The
perpendicular surface normal divides the angle between incident light rays and their reflection equally.
In other words, the angle of incidence equals the angle of reflection.
The surface normal is an imaginary line, perpendicular to the surface. If a layer has no mesh or a flat
one, the entire object has parallel surface normals.
Apart from that, the polygons forming the mesh determine the direction of each line and consequently
the direction of reflected light.

515
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To imitate a rough surface one could apply a mesh with
disarrayed polygons. However it is far easier to achieve
it with a material's attribute. This is what diffuse
reflection does. Diffuse light is reflected in all direction
(see right upper principle depiction). The larger the
angle between light source and surface normal gets,
the less intense is the reflection. As a result diffuse
light points the dimension of the object out and
enhances surface details.
Typically, an object with an high proportion of diffusion
appears to have a rough surface such as wood or rock.
For the left images a light source was first positioned to
the right, then to the left.

In opposite, the specular level influences how many
light rays bounce off coherently / parallel. This is what
creates highlights on an object's surface and makes it
appear to have a smooth surface such as plastic or
metal. The smoother a surface is, the smaller and
sharper the highlights are. This last adjustment is done
in PB with the smoothness parameter. Just as diffuse
reflection, specular reflection depends on the relative
position and orientation of light source and target. But
as the rays are not reflected in all directions any more,
the position of the camera plays an important role too.
It influences how intense the highlight shines.  

The third light variation that is added to the illumination term is ambient light. Other than the above
mentioned, ambient light is absolutely directionless. It illuminates all surfaces equally regardless their
orientation. Strictly speaking, it has no true counterpart in real-word but still it gives very good results
when it comes to simulate global light e.g. sun light and all the light reflected from the surrounding
environment.

The image sequence below illustrates how the ambient component with a level of 40, the diffuse
component with a level of 200 and the specular component with a level of 180 (with its softness set to
60) add up and result in a realistic shaded plastic palm tree.



511

Please note:
The effects described below are NOT designed to be applied more than once to a layer. If you want a
layer to be lit by two light source please use the according effect.
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 1 Light Mat-Spec-Color

Allows receiving light emitted by a Light Layer  by right-clicking on the Media parameter and
choosing "Share Layer Texture". Adjustments can be made influencing the reflection of the light in
order to imitate a specific material e.g. wood or plastic. In addition highlights caused by specular light
can be tinted. In the images, the light itself was not changed! The left image has no light turned on.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Mode None (0), Cast & Receive (1) Cast (2) 0-2 0

Media Media File as Mask 0-255 255

Ambient Proportion of Ambient Light 0-255 25

Diffuse Proportion of Diffuse Light 0-255 255

Specular Proportion of Specular Light 0-255 50

Softness Softness of highlights (= reflection of
Specular Light)

0-255 10

Spec Red Red level of reflection of Specular Light 0-255 255

Spec Green Green level of reflection of Specular Light 0-255 255

Spec Blue Blue level of reflection of Specular Light 0-255 255

1 Light Shadow Catcher

Allows using a layer as a shadow layer. This is of interest for Virtual Reality applications as this only
renders shadows from (multiple, virtual) 3D objects on to one layer, which then can be used as an
overlay layer for a Studio set.

The left image depicts the scene. A layer with a color bar image lies between a background cloud
image and a 3D globe which is illuminated by a light using the "1 Light"  effect.
For the second image, the "1 Light Shadow Catcher" FX on the color bars is switched on and
assigned with the same light as the globe is. The "Blend" parameter is turned to 255.
For the right image the parameter "Blend" is turned to 0 and a purple color is chosen to overwrite the
color bar texture with a solid color.
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Note, for this effect, the light texture should be a solid white or transparent one!

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Mode Mode - -

Light 1 Light 1 - -

Blend Blend 0-255 0

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

1 Light

Allows receiving light emitted by a Light Layer  by right-clicking on the Media parameter and
choosing "Share Layer Texture". Adjustments can be made that influence the reflection of the light in
order to imitate a specific material e.g wood or plastic. In the images, the light itself was not changed!
The left image has no light turned on.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Mode None (0), Cast & Receive (1) Cast (2) 0-2 0

Media Media File as Mask 0-255 255

Ambient Proportion of Ambient Light 0-255 25

Diffuse Proportion of Diffuse Light 0-255 255

Specular Proportion of Specular Light 0-255 50

Softness Softness of highlights (= reflection of
Specular Light)

0-255 10

2 Lights Mat-Spec-Color

see FX 1 Light Mat-Spec-Color . Here, the effect layer may be influenced by two different light
sources.
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2 Lights Texture Projection Adaptive

Allows adaptive softedge applications. When two projectors project onto a screen that moves towards
and away from them, the size of the overlapping area changes. It increases with the distance between
projectors and screen. Hence, the softedge parameters must adopt to the new screen position. An
adaptive softedge can be programmed using this effect (on the screen layer). The FX subtracts the
light amount from 2 Light Layers , it darkens the overlap area which compensates for the higher
light amount from the real projectors. For this setup a 3D setup is mandatory, i.e. the PB light
sources (as well as PB cameras) have the same parameters (position, FOV etc.) as the real
projectors and the PB screen layer corresponds with the real screen.

The left image depicts the scene. A green layer moves in front of a cloud image. The light overlap on
the background image is larger than on the green image as its nearer to the lights.
For the right image the green layer was moved further away from the lights / projectors, enlarging the
overlap, the area that PB now renders automatically darker.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amt Amt 0-255 255

Light 1 Light 1 - -

Light 2 Light 2 - -

2 Lights

see FX 1 Light . Here, the effect layer may be influenced by two different light sources.

3 Lights Mat-Spec-Color

see FX 1 Light Mat-Spec-Color . Here, the effect layer may be influenced by three different light
sources.

3 Lights

see FX 1 Light . Here, the effect layer may be influenced by three different light sources.
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Light Texture Projection

This is a "1 Light"  effect that is reduced to the parameters "Mix" and "Light 1". Right-click on the
Media field and choose "Share Layer Texture" to receiving its light. This effect is ideal if you simply
like to render a light texture on another layer to simulate a projected image.

The left image depicts the scene. The Light Layer  projects a cloud image onto a white layer with
the FX's Mix parameter at 125. For the second image the Light Layer changed the position resulting
in a different angle for the projection. The right image depicts the same position but with a Mix
parameter at 255, making the white texture invisible when no light is received.

Note that the effect "Texture Projection"  might also be of interest.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Light 1 Light 1 - -

Lighting

Allows setting an own light source that can influence only the effect layer itself. The layer's reflection
behavior can be adapted to match a specific material. The inherent light source can be adjusted in its
position. Other than the Light Layer this light source has no direction, it is rather a point light. In the
images, the light's position has changed as well as the material properties. The left image has no
light turned on.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Softness Softness of highlights (= reflection of
Specular Light)

0-255 16

Ambient Proportion of Ambient Light 0-255 128

Diffuse Proportion of Diffuse Light 0-255 16

Specular Proportion of Specular Light 0-255 255

Light X Pos X Position of light source;

equals a layer X position of + / - 50.000

0-65535 32768
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Light Y Pos Y Position of light source;
equals a layer Y position of + / - 50.000

0-65535 32768

Light Z Pos Z Position of light source;
equals a layer Z position of + / - 50.000

0-65535 32768

Texture Projection

This is the same effect as "Texture Projection Add"  but without the parameters XY Offset.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

X Offset X Offset -999.999-999.999 0

Y Offset Y Offset -999.999-999.999 0
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6.5.2.11.30  Lighting - Texture Projection

Texture Projection Add

This allows to simulate a projected image on a layer. There are similarities to the effect "Light Texture
Projection" , but as it combines the Light Layer parameters into the effect itself, no additional Light
Layer  is needed.

The left image depicts the scene. The Layer texture itself is a white-black-white gradient, the
projected texture (FX media) is a cloud image. For the second image, the position for the effect's light
source has changed, resulting in a different angle for the projection. In the right image, a 3D cone was
used as a Layer object.

Note that (in difference to "Texture Projection Mix" ) the RGB values from the FX texture are added
to the RGB values from the layer texture. This explains why the top left and bottom right corner of the
cloud image cannot be seen on top the gradient texture as these areas are already full white.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

X Offset X Offset -999.999-999.999 0

Y Offset Y Offset -999.999-999.999 0
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Texture Projection Alpha Mix AB

This allows to simulate a projected image on a layer, and mixes it with the transparency from the FX
media. The FX can blend between two textures. There are similarities to the effect "Light Texture
Projection" , but as it combines the Light Layer parameters into the effect itself, no additional Light
Layer  is needed.

The left image depicts the scene. In front of a background cloud image, you can see the layer texture,
a white-black-white gradient. The projected texture (FX media) is transparent with colorful circles. The
transparency channel is projected onto the gradient layer and creates transparent areas there. The
Mix parameter is at 100.
For the second image, the Mix parameter was risen to 255.
In the right image, the second FX media (stars on a transparent background) is taking place as the
"Mix AB" parameter is toggled.

Note that (in difference to "Texture Projection Mix"  and ...Add ) the RGB values from the FX
textures are discarded. It is only the alpha information that overlays the RGB values from the layer
texture.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Mix AB Mix AB 0-255 0

Media2 Media2 - -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

X Offset X Offset -999.999-999.999 0

Y Offset Y Offset -999.999-999.999 0

515

606

522 517
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Texture Projection Alpha Mix

This allows to simulate a projected image on a layer, and mixes it with the transparency from the FX
media. There are similarities to the effect "Light Texture Projection" , but as it combines the Light
Layer parameters into the effect itself, no additional Light Layer  is needed.

The left image depicts the scene. In front of a background cloud image, you can see the layer texture,
a white-black-white gradient. The projected texture (FX media) is transparent with colorful circles. The
transparency channel is projected onto the gradient layer and creates transparent areas there.
For the second image, the position for the effect's light source has changed, resulting in a different
angle for the projection. In the right image, a 3D cone was used as a Layer object.

Note that (in difference to "Texture Projection Mix"  and ...Add ) the RGB values from the FX
texture are discarded. It is only the alpha information that overlays the RGB values from the layer
texture.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

515

606
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X Offset X Offset -999.999-999.999 0

Y Offset Y Offset -999.999-999.999 0

Texture Projection Blend AB

This allows to simulate a projected image on a layer. Two FX textures can be used and blended.
There are similarities to the effect "Light Texture Projection" , but as it combines the Light Layer
parameters into the effect itself, no additional Light Layer  is needed.

The left image depicts the scene. The Layer texture itself is a white-black-white gradient, the
projected texture (FX media) is a cloud image. The Mix parameter is at 100.
For the second image, the Mix parameter was risen to 255.
In the right image, the second FX media (grass image) is taking place as the "Mix AB" parameter is
toggled.

Note that (in difference to "Texture Projection Add" ) the RGB values from the FX texture overlay
the RGB values from the layer texture, but not if there is no projection.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Mix AB Mix AB 0-255 0

Media2 Media2 - -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

X Offset X Offset -999.999-999.999 0

Y Offset Y Offset -999.999-999.999 0

515

606

517
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Texture Projection Mix AB

This allows to simulate a projected image on a layer. Two FX textures can be used and blended.
There are similarities to the effect "Light Texture Projection" , but as it combines the Light Layer
parameters into the effect itself, no additional Light Layer  is needed.

The left image depicts the scene. The Layer texture itself is a white-black-white gradient, the
projected texture (FX media) is a cloud image. The Mix parameter is at 100.
For the second image, the Mix parameter was risen to 255.
In the right image, the second FX media (grass image) is taking place as the "Mix AB" parameter is
toggled.

Note that (in difference to "Texture Projection Add" ) the RGB values from the FX texture overlay
the RGB values from the layer texture. This explains why the layer texture disappears when the Mix
parameter equals 255.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Mix AB Mix AB 0-255 0

Media2 Media2 - -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

X Offset X Offset -999.999-999.999 0

Y Offset Y Offset -999.999-999.999 0

515

606

517
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Texture Projection Mix

This allows to simulate a projected image on a layer. There are similarities to the effect "Light Texture
Projection" , but as it combines the Light Layer parameters into the effect itself, no additional Light
Layer  is needed.

The left image depicts the scene. The Layer texture itself is a white-black-white gradient, the
projected texture (FX media) is a cloud image. In the upper image, the Mix parameter is at 100; in the
bottom one at 255. For the second image, the position for the effect's light source has changed,
resulting in a different angle for the projection. In the right image, a 3D cone was used as a Layer
object.

Note that (in difference to "Texture Projection Add" ) the RGB values from the FX texture overlay
the RGB values from the layer texture. This explains why the layer texture disappears when the Mix
parameter equals 255.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

515

606

517
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X Offset X Offset -999.999-999.999 0

Y Offset Y Offset -999.999-999.999 0

Texture Projection

This is the same effect as "Texture Projection Mix"  but without the parameters XY Offset.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

Light Source X
Pos

Light Source X Pos -999.999-999.999 0

Light Source Y
Pos

Light Source Y Pos -999.999-999.999 10

Light Source Z
Pos

Light Source Z Pos -999.999-999.999 -25

Light Target X
Pos

Light Target X Pos -999.999-999.999 0

Light Target Y
Pos

Light Target Y Pos -999.999-999.999 0

Light Target Z
Pos

Light Target Z Pos -999.999-999.999 0

Light Angle Light Angle 0-180 20

Light Aspect Light Aspect 0-20 1

Light Z Roll Light Z Roll -9999.99-9999.99 0

522
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6.5.2.11.31  Masking

Alpha Black Fill RGB

Turns all parts containing alpha into black and allows choosing any RGB color for the non-transparent
parts of the image.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 0

Green Green level, Color Picker 0-255 0

Blue Blue level, Color Picker 0-255 0

Alpha Fill RGB

All parts of the image containing alpha stay transparent, allows choosing any RGB color for the non-
transparent parts of the image.
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Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 0

Green Green level, Color Picker 0-255 0

Blue Blue level, Color Picker 0-255 0

Alpha Left Right

The effect expects one media file on the layer that contains two information side-by-side. The left half
represents the video itself whilst the masking information is in the right half. You may prepare such
content using the Image Converter .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

870
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Alpha Media As Mask Invert

All parts of the layer texture containing alpha will stay transparent, all non-transparent parts of an
additional media file will turn the corresponding parts of the layer texture transparent as well.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Media Alpha Media as Mask Invert

Alpha Media As Mask 

All parts of the layer texture containing alpha will stay transparent, all transparent parts of an
additional media file will turn the corresponding parts of the layer texture transparent as well.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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Media Alpha Media as Mask 

Alpha Replace 

All parts of the layer texture containing alpha will be replaced by any RGB color.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 0

Green Green level, Color Picker 0-255 0

Blue Blue level, Color Picker 0-255 0

Alpha Top Bottom
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The effect expects one media file on the layer that contains two information on top of each other. The
upper half represents the video itself whilst the masking information is in the lower half. You may
prepare such content using the Image Converter .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

BW Mask 

All parts of the layer texture containing alpha will be turned into white, all non-transparent parts will be
turned into black.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

 BW Media As Mask Invert

870
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All white parts of an additional media file will turn the corresponding parts of the layer texture
transparent, black parts do not influence the layer texture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Media BW Media as Mask Invert

BW Media as Mask PreMul

All black parts of an additional media file will turn the corresponding parts of the layer texture
transparent, white parts do not influence the layer texture. In addition to the "BW Media As Mask "
effect the RGB values of the keyed out area are pre-multiplied before being turned transparent. This
means that all RGB values between 1-255 are set to 255 turning most pixels into white ones. Only
RGB values of 0 stay unchanged. In the second image you can see that some pixels from the wing
are rendered in yellow because originally their blue value was 0.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

530
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BW Media As Mask 

All black parts of an additional media file will turn the corresponding parts of the layer texture
transparent, white parts do not influence the layer texture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Media BW Media as Mask 

WB Mask 

All parts of the layer texture containing alpha will be turned into black, all non-transparent parts will be
turned into white.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0
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6.5.2.11.32  Mirror

Horizontal Flip

Mirrors the texture layer horizontally, what was on the left site will be on the right.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

HV Flip

Mirrors the texture layer vertically and horizontally; in other words, it rotates the layer by 180°.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Mirror 2D

Mirrors the layer texture vertically with a slight transparent fade-out. The vertical position can be
adjusted, the mirrored part may be colored by any RGB color as well.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Pos V Vertical Position of the Mirroring 0-65535 32768

Alpha Alpha level of the mirrored image 0-255 128
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Red Red level, Color Picker 0-255 128

Green Green level, Color Picker 0-255 128

Blue Blue level, Color Picker 0-255 128

Vertical Flip

Mirrors the texture layer vertically, what was on the top side, will be on the bottom.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

6.5.2.11.33  Overlay

Horizontal Dual Media Overlay

Mixes the current texture (media file) from the layer with the FX textures. Both FX textures are
displayed next to each other, taking up the full height but only 1/2 width of the layer texture.
The layer texture holds the resolution information. In the Stock Assets content you may find
transparent images with different resolutions (C:\coolux\content\Stock Assets\Textures

\Alpha Dummy).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Media2 Media2 - -
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Horizontal Quad Media Overlay

Mixes the current texture (media file) from the layer with the FX textures. All four FX textures are
displayed next to each other, taking up the full height but only 1/4 width of the layer texture.
The layer texture holds the resolution information. In the Stock Assets content you may find
transparent images with different resolutions (C:\coolux\content\Stock Assets\Textures

\Alpha Dummy).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Media2 Media2 - -

Media3 Media3 - -

Media4 Media4 - -
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Horizontal Triple Media Overlay

Mixes the current texture (media file) from the layer with the FX textures. All three FX textures are
displayed next to each other, taking up the full height but only 1/3 of the width of the layer texture.
The layer texture holds the resolution information. In the Stock Assets content you may find
transparent images with different resolutions (C:\coolux\content\Stock Assets\Textures

\Alpha Dummy).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Media2 Media2 - -

Media3 Media3 - -

Media Overlay Add 
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Allows overlaying the layer texture with a media file by adding the pixel RGB values of the media file
with the layer texture. Position and scaling of the overlaying media file can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

X X Position of the overlaying media file 0-65535 32768

Y Y Position of the overlaying media file 0-65535 32768

Width Red level, Color Picker 0-65535 65535

Height Green level, Color Picker 0-65535 65535

Media Overlaying Media File

Media Overlay Darken

Allows overlaying the layer texture with a media file by darkening the layer texture with the RGB
values of the media file. Position an scaling of the overlaying media can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

X X 0-65535 32768

Y Y 0-65535 32768

Width Width 0-65535 65535

Height Height 0-65535 65535

Media Media file as source for overlay or
mask

- -
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Media Overlay Divide Inv

Allows overlaying the layer texture with a media file by inverting the division of layer texture and RGB
values of the media file. Position an scaling of the overlaying media can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

X X 0-65535 32768

Y Y 0-65535 32768

Width Width 0-65535 65535

Height Height 0-65535 65535

Media Media file as source for overlay or
mask

- -

Media Overlay Divide
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Allows overlaying the layer texture with a media file by dividing the layer texture and the RGB values
of the media file. Position an scaling of the overlaying media can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

X X 0-65535 32768

Y Y 0-65535 32768

Width Width 0-65535 65535

Height Height 0-65535 65535

Media Media file as source for overlay or
mask

- -

Media Overlay Hue

Allows overlaying the layer texture with a media file by mixing the layer texture with the RGB hue
values of the media file. Position an scaling of the overlaying media can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

X X 0-65535 32768

Y Y 0-65535 32768

Width Width 0-65535 65535

Height Height 0-65535 65535

Media Media file as source for overlay or
mask

- -
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Media Overlay Lighten

Allows overlaying the layer texture with a media file by lightening up the layer texture with the RGB
values of the media file. Position an scaling of the overlaying media can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

X X 0-65535 32768

Y Y 0-65535 32768

Width Width 0-65535 65535

Height Height 0-65535 65535

Media Media file as source for overlay or
mask

- -

 Media Overlay Mix
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Allows overlaying the layer texture with a media file by mixing the pixel RGB values of the layer
texture with the media file. Position and scaling of the overlaying media file can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

X X Position of the overlaying media file 0-65535 32768

Y Y Position of the overlaying media file 0-65535 32768

Width Red level, Color Picker 0-65535 65535

Height Green level, Color Picker 0-65535 65535

Media Overlaying Media File

Media Overlay Multiply

Allows overlaying the layer texture with a media file by multiplying the pixel RGB values of the layer
texture with the media file. Position and scaling of the overlaying media file can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

X X Position of the overlaying media file 0-65535 32768

Y Y Position of the overlaying media file 0-65535 32768

Width Red level, Color Picker 0-65535 65535

Height Green level, Color Picker 0-65535 65535

Media Overlaying Media File



540

Media Overlay Screen

Allows overlaying the layer texture with a media file by using the screen blend mode, i.e. negating the
RGB values of both textures, then multiplying them and negating them again. The result is a brighter
image. Position an scaling of the overlaying media can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

X X 0-65535 32768

Y Y 0-65535 32768

Width Width 0-65535 65535

Height Height 0-65535 65535

Media Media file as source for overlay or
mask

- -
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Media Overlay Subtract

Allows overlaying the layer texture with a media file by subtracting the RGB values of the media file
from the layer texture. Position an scaling of the overlaying media can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

X X 0-65535 32768

Y Y 0-65535 32768

Width Width 0-65535 65535

Height Height 0-65535 65535

Media Media file as source for overlay or
mask

- -

Quad Media Overlay
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Mixes the current texture (media file) from the layer with the FX textures. All four FX textures are
displayed in a 2x2 grid, each taking up 1/2 height and 1/2 width of the layer texture.
The layer texture holds the resolution information. In the Stock Assets content you may find
transparent images with different resolutions (C:\coolux\content\Stock Assets\Textures

\Alpha Dummy).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Media2 Media2 - -

Media3 Media3 - -

Media4 Media4 - -

Vertical Dual Media Overlay

Mixes the current texture (media file) from the layer with the FX textures. Both FX textures are
displayed one upon the other, taking up the full width but only 1/2 height of the layer texture.
The layer texture holds the resolution information. In the Stock Assets content you may find
transparent images with different resolutions (C:\coolux\content\Stock Assets\Textures

\Alpha Dummy).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Media2 Media2 - -
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Vertical Quad Media Overlay

Mixes the current texture (media file) from the layer with the FX textures. All four FX textures are
displayed one upon the other, taking up the full width but only 1/4 height of the layer texture.
The layer texture holds the resolution information. In the Stock Assets content you may find
transparent images with different resolutions (C:\coolux\content\Stock Assets\Textures

\Alpha Dummy).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Media2 Media2 - -

Media3 Media3 - -

Media4 Media4 - -
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Vertical Triple Media Overlay

Mixes the current texture (media file) from the layer with the FX textures. All three FX textures are
displayed one upon the other, taking up the full width but only 1/3 height of the layer texture.
The layer texture holds the resolution information. In the Stock Assets content you may find
transparent images with different resolutions (C:\coolux\content\Stock Assets\Textures

\Alpha Dummy).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media1 Media1 - -

Media2 Media2 - -

Media3 Media3 - -

6.5.2.11.34  Pattern

BinaryPattern

Turns the layer texture into a binary pattern, the number of horizontal and vertical lines is adjustable.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Horizontal Horizontal 0-16 0

Vertical Vertical 0-16 0
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Invert Inverts the RGB levels or the effect 0-1 0

Checkerboard 

Adds a checkerboard of any RGB color and alpha level to the layer texture. The following parameters
can be adjusted as well: Amount, Softness, Size, Offset X&Y.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of checkers 0-65535 1024

Softness Softness of checker edges 0-65535 32

Size Size of checkers 0-65535 32768

Offset X Horizontal Offset 0-65535 32768

Offset Y Vertical Offset 0-65535 32768

Red Red level, Color Picker 0-255 192

Green Green level, Color Picker 0-255 192

Blue Blue level, Color Picker 0-255 192

Alpha Alpha level 0-255 255

 Grid 

Adds a grid of any RGB color and alpha level to the layer texture. The following parameters can be
adjusted as well: Amount, Softness, Size, Offset X&Y.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of grid segments 0-65535 1024

Softness Softness of grid edges 0-65535 32

Size Size of grid 0-65535 32768

Offset X Horizontal Offset 0-65535 32768

Offset Y Vertical Offset 0-65535 32768

Red Red level, Color Picker 0-255 192
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Green Green level, Color Picker 0-255 192

Blue Blue level, Color Picker 0-255 192

Alpha Alpha level 0-255 255

LED 

Turns the layer texture into single LED spots. Amount, Softness, Size, Offset X&Y.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of LED spots 0-65535 8192

Circle Shape of LED spots 0-65535 28000

Alpha Alpha level of the gaps between the LED spots 0-255 0

 Lines Horizontal

Adds horizontal lines of any RGB color and alpha level to the layer texture. The following parameters
can be adjusted as well: Amount, Softness, Size and the Offset.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of lines 0-65535 1024

Softness Softness of line edges 0-65535 32

Size Size of lines 0-65535 32768

Offset Vertical Offset 0-65535 32768

Red Red level, Color Picker 0-255 192

Green Green level, Color Picker 0-255 192

Blue Blue level, Color Picker 0-255 192

Alpha Alpha level 0-255 255
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Lines Vertical

Adds vertical lines of any RGB color and alpha level to the layer texture. The following parameters can
be adjusted as well: Amount, Softness, Size and the Offset.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of lines 0-65535 1024

Softness Softness of line edges 0-65535 32

Size Size of lines 0-65535 32768

Offset Horizontal Offset 0-65535 32768

Red Red level, Color Picker 0-255 0

Green Green level, Color Picker 0-255 0

Blue Blue level, Color Picker 0-255 0

Alpha Alpha level 0-255 255

Pixels

Turns the layer texture into a pattern of pixel dots. Threshold, amount and circularity can be adjusted,
as well as color, brightness and alpha value.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Threshold Threshold 0-255 128

Amount Amount 0-65535 6000

Circle Circle 0-65535 32768

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Level Level 0-255 128
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Simple Outline

Adds a simple outline of any RGB color between transparent / non-transparent parts of the layer
texture and removes the non-transparent parts of the file. 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255
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6.5.2.11.35  Remap

 ReMap Overlay

Reads the map exported from the Matrix Patcher  and routes automatically any source pixel to the
stored output location. Thus it routes the pixels according to the Patch / Map View setup in the
Matrix Patcher. The routed pixels overlay the original image.

Note that the effect has to be assigned to an output layer and is only visible in the Preview if it is set
to an output view, not the global camera. 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Media Media File as Mask 0-255 255

787
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 ReMap

Reads the map exported from the Matrix Patcher  and routes automatically any source pixel to the
stored output location. Thus it routes the pixels according to the Patch / Map View setup in the
Matrix Patcher. Only the routed pixels are visible.

Note that the effect has to be assigned to an output layer and is only visible in the Preview if it is set
to an output view, not the global camera.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Media Media File as Mask 0-255 255

787
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6.5.2.11.36  Shadows

Drop Shadow Alpha

Adds a drop shadow at the transitions between transparent and non-transparent parts of the layer
texture. The shadow’s position, color and alpha value can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

X X Position 0-65535 33280

Y Y Position 0-65535 32000

Red Red level, Color Picker 0-255 0

Green Green level, Color Picker 0-255 0

Blue Blue level, Color Picker 0-255 0

Alpha Alpha level 0-255 128

6.5.2.11.37  Shapes

Circle2D Mask

Adds a circular mask to the layer texture. The mask's color, alpha, size and radius value can be
adjusted, as well as its position, the edge's softness and fill-behavior.

Parameter Description Value Range Default
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Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 32768

Pt1 Y Vertical position of the first point 0-65535 32768

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 2048

Size Size 0-65535 1024

Radius Radius 0-65535 16384

Fill Fill 0-255 255

Circle2D

Adds a circle to the layer texture. The circle's color, alpha, size and radius value can be adjusted, as
well as its position, the edge's softness and fill-behavior.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 32768

Pt1 Y Vertical position of the first point 0-65535 32768

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 128

Size Size 0-65535 128

Radius Radius 0-65535 8192

Fill Fill 0-255 0
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Draw Point Alpha

Adds a transparent line to the texture layer and reveals the underlying background. The line can be
drawn manually by changing the X- and Y-value of the draw point. Size and pressure of the point can
be adjusted. As long as the "Clear" parameter is set to 0, you can draw; switching to 1 clears the
drawn line and covers the background again.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 255

Clear Clear 0-1 1

Size Size 0-65535 32768

Pressure Pressure 0-65535 32768

X X 0-65535 32768

Y Y 0-65535 32768

Draw Point RGB

Overlays the layer texture with a line that can be drawn manually by changing the X- and Y-value of
the draw point. Color, size and pressure of the point can be adjusted. As long as the "Clear"
parameter is set to 0, you can draw; switching to 1 clears the drawn line.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 255

Clear Clear 0-1 1
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Size Size 0-65535 32768

Pressure Pressure 0-65535 32768

X X 0-65535 32768

Y Y 0-65535 32768

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Ellipse2D Mask

Adds an elliptic mask to the layer texture. The mask's height an width, color, alpha level and radius
value can be adjusted, as well as its position, the edge's softness and fill-behavior.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 32768

Pt1 Y Vertical position of the first point 0-65535 32768

Width Width 0-65535 32768

Height Height 0-65535 32768

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 16384

Size Size 0-65535 2048

Fill Fill 0-255 255

Ellipse2D

Adds an elliptic circle to the layer texture. The circle's height an width, color, alpha and radius value
can be adjusted, as well as its position, the edge's softness and fill-behavior.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 32768

Pt1 Y Vertical position of the first point 0-65535 32768

Width Width 0-65535 32768

Height Height 0-65535 32768

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 1024

Size Size 0-65535 2048

Fill Fill 0-255 0

EQ Media

Adds 32 bars to the texture of the layer, the bars' texture layer is filled with selectable media content.
Each bar's level can be adjusted, e.g. by programming values into the sequence or by receiving them
from other programs, e.g by the Widget Designer's Audio Processor Input node .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Media Media file as source for overlay or
mask

- -

EQ1 EQ1 0-65535 32768

EQ2 EQ2 0-65535 32768

EQ3 EQ3 0-65535 32768

EQ4 EQ4 0-65535 32768

EQ5 EQ5 0-65535 32768

EQ6 EQ6 0-65535 32768

EQ7 EQ7 0-65535 32768

EQ8 EQ8 0-65535 32768

EQ9 EQ9 0-65535 32768

1070
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EQ10 EQ10 0-65535 32768

EQ11 EQ11 0-65535 32768

EQ12 EQ12 0-65535 32768

EQ13 EQ13 0-65535 32768

EQ14 EQ14 0-65535 32768

EQ15 EQ15 0-65535 32768

EQ16 EQ16 0-65535 32768

EQ17 EQ17 0-65535 32768

EQ18 EQ18 0-65535 32768

EQ19 EQ19 0-65535 32768

EQ20 EQ20 0-65535 32768

EQ21 EQ21 0-65535 32768

EQ22 EQ22 0-65535 32768

EQ23 EQ23 0-65535 32768

EQ24 EQ24 0-65535 32768

EQ25 EQ25 0-65535 32768

EQ26 EQ26 0-65535 32768

EQ27 EQ27 0-65535 32768

EQ28 EQ28 0-65535 32768

EQ29 EQ29 0-65535 32768

EQ30 EQ30 0-65535 32768

EQ31 EQ31 0-65535 32768

EQ32 EQ32 0-65535 32768

EQ Waveform

Turns the texture of the layer into a dynamic shape with hundreds of equalizer bars. The level of each
bar is automatically adjusted by the Widget Designer's Audio Processor Input node .
A high "Glow" parameter adds a fading overlay to the bars (2nd img.). The parameter "Alpha"
influences the background of the bars and blends between black and transparent, displaying
underlying layers. The parameter "Blend" colors the bars: 0 = white, 255 = layer texture (3rd img.).

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Glow Glow 0-255 255

Alpha Level of transparency 0-255 0

Blend Blend 0-255 0

1070
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EQ

Adds 32 rainbow colored equalizer bars to the texture of the layer. Each bar's level can be adjusted
e.g. by programming values into the sequence or by receiving them from other programs, e.g by the 
Widget Designer's Audio Processor Input node .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

EQ1 EQ1 0-65535 32768

EQ2 EQ2 0-65535 32768

EQ3 EQ3 0-65535 32768

EQ4 EQ4 0-65535 32768

EQ5 EQ5 0-65535 32768

EQ6 EQ6 0-65535 32768

EQ7 EQ7 0-65535 32768

EQ8 EQ8 0-65535 32768

EQ9 EQ9 0-65535 32768

EQ10 EQ10 0-65535 32768

EQ11 EQ11 0-65535 32768

EQ12 EQ12 0-65535 32768

EQ13 EQ13 0-65535 32768

EQ14 EQ14 0-65535 32768

EQ15 EQ15 0-65535 32768

EQ16 EQ16 0-65535 32768

EQ17 EQ17 0-65535 32768

EQ18 EQ18 0-65535 32768

EQ19 EQ19 0-65535 32768

EQ20 EQ20 0-65535 32768

EQ21 EQ21 0-65535 32768

EQ22 EQ22 0-65535 32768

EQ23 EQ23 0-65535 32768

EQ24 EQ24 0-65535 32768

EQ25 EQ25 0-65535 32768

EQ26 EQ26 0-65535 32768

EQ27 EQ27 0-65535 32768

EQ28 EQ28 0-65535 32768

EQ29 EQ29 0-65535 32768

EQ30 EQ30 0-65535 32768

EQ31 EQ31 0-65535 32768

EQ32 EQ32 0-65535 32768

1070
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Line Horizontal

Adds a horizontal line to the layer texture. The line’s position, color, width and alpha value can be
adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

V Pos Vertical Position 0-65535 32768

H Start Start of Line Horizontal 0-65535 0

H End End of Line Horizontal 0-65535 65535

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Alpha Alpha level 0-255 255

Width Width of line 0-65535 2048

Line Vertical

Adds a vertical line to the layer texture. The line’s position, color, width and alpha value can be
adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

V Pos Vertical Position 0-65535 32768

V Start Start of Line Vertical 0-65535 0

V End End of Line Vertical 0-65535 65535

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Alpha Alpha level 0-255 255

Width Width of line 0-65535 2048
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Line2D Mask

Adds a line shaped mask to the layer texture. The mask's endpoints, color, alpha level and size can
be adjusted, as well as the edge's softness.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 250

Size Size 0-65535 250

Line2D

Adds a line to the layer texture. The line’s endpoints, color, alpha level and size can be adjusted, as
well as the edge's softness.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Red Color picker / Level of red 0-255 255
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Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 250

Size Size 0-65535 250

MetaBall2D Add

Adds two glowing balls to the layer texture and dims the rest of it. The position and color of each ball
can be adjusted separately, the alpha level, blend, softness and size can be adjusted for both
together.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 25000

Pt1 Y Vertical position of the first point 0-65535 25000

Pt2 X Horizontal position of the second
point

0-65535 40000

Pt2 Y Vertical position of the second point 0-65535 40000

Red1 First color picker / Level of red 0-255 255

Green1 First color picker / Level of green 0-255 100

Blue1 First color picker / Level of blue 0-255 0

Red2 Second color picker / Level of red 0-255 0

Green2 Second color picker / Level of green 0-255 100

Blue2 Second color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Blend Blend 0-255 0

Softness Softness 0-65535 16384

Size Size 0-65535 16384
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MetaBall2D Multiply

Adds two glowing balls to the layer texture whose halos are multiplied and dims the rest of it. The
position and color of each ball can be adjusted separately, the alpha level, blend, softness and weight
can be adjusted for both together.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 25000

Pt1 Y Vertical position of the first point 0-65535 25000

Pt2 X Horizontal position of the second
point

0-65535 40000

Pt2 Y Vertical position of the second point 0-65535 40000

Red1 First color picker / Level of red 0-255 255

Green1 First color picker / Level of green 0-255 128

Blue1 First color picker / Level of blue 0-255 0

Red2 Second color picker / Level of red 0-255 0

Green2 Second color picker / Level of green 0-255 128

Blue2 Second color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Blend Blend 0-255 0

Softness1 Softness1 0-65535 16384

Weight Weight 0-65535 32768

MetaBall2D Outline Glow

Two black balls with glowing outlines are added to the layer texture and the rest of it is dimmed. The
position of each ball can be adjusted separately, the alpha level, blend, softness and size as well as
color and radius can be adjusted for both together.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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Pt1 X Horizontal position of the first point 0-65535 25000

Pt1 Y Vertical position of the first point 0-65535 25000

Pt2 X Horizontal position of the second
point

0-65535 40000

Pt2 Y Vertical position of the second point 0-65535 40000

Red Color picker / Level of red 0-255 128

Green Color picker / Level of green 0-255 196

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Blend Blend 0-255 0

Glow Glow 0-65535 32768

Radius Radius 0-65535 8192

Size Size 0-65535 62000

Quad 16bit

Adds a quadrangle (four-sided figure) shape to the layer texture. The corner positions and the inside
color and alpha level can be adjusted, as well as the softness of each edge.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 65535

Softness 1 Softness 1 0-65535 250

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Softness 2 Softness 2 0-65535 250

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Softness 3 Softness 3 0-65535 250

Pt4 X Horizontal position of the fourth
point

0-65535 0

Pt4 Y Vertical position of the fourth point 0-65535 0

Softness 4 Softness 4 0-65535 250

Red Color picker / Level of red 0-65535 65535

Green Color picker / Level of green 0-65535 65535

Blue Color picker / Level of blue 0-65535 65535

637

322 210
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Alpha Level of transparency 0-65535 65535

Quad Black Lift 16bit

Adds a quadrangle (four-sided figure) shape to the layer texture. The corner positions and the inside
color and alpha level can be adjusted, as well as the softness of each edge.
The shape color is added to the layer texture but only to dark values. The higher the "Threshold"
parameter the lighter the colors get that are influenced by the shape.

This effect can be used for blacklevel adjustment , when it is assigned to the output or to a layer
that is toggled into the Output Rendering Pass  by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 65535

Softness 1 Softness 1 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Softness 2 Softness 2 0-65535 0

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Softness 3 Softness 3 0-65535 0

Pt4 X Horizontal position of the fourth
point

0-65535 0

Pt4 Y Vertical position of the fourth point 0-65535 0

Softness 4 Softness 4 0-65535 0

Red Color picker / Level of red 0-65535 10000

Green Color picker / Level of green 0-65535 10000

Blue Color picker / Level of blue 0-65535 10000

Alpha Level of transparency 0-65535 65535

Threshold Threshold 0-65535 30000

637

322 210
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Quad2D Mask

Adds a quadrangle (four-sided figure) shaped mask to the layer texture. The corner positions, mask
color and alpha level can be adjusted, as well as the softness, size and fill-behavior of the mask.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 4096

Pt1 Y Vertical position of the first point 0-65535 61439

Pt2 X Horizontal position of the second
point

0-65535 61439

Pt2 Y Vertical position of the second point 0-65535 61439

Pt3 X Horizontal position of the third point 0-65535 61439

Pt3 Y Vertical position of the third point 0-65535 4096

Pt4 X Horizontal position of the fourth
point

0-65535 4096

Pt4 Y Vertical position of the fourth point 0-65535 4096

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 1024

Size Size 0-65535 0

Fill Fill 0-255 255

Quad2D

Adds a quadrangle (four-sided figure) shape to the layer texture. The corner positions, mask color and
alpha level can be adjusted, as well as the softness, size and fill-behavior of the shape.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0
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Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 65535

Pt2 X Horizontal position of the second
point

0-65535 65535

Pt2 Y Vertical position of the second point 0-65535 65535

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Pt4 X Horizontal position of the fourth
point

0-65535 0

Pt4 Y Vertical position of the fourth point 0-65535 0

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 250

Size Size 0-65535 250

Fill Fill 0-255 255

Rectangle 

Adds an outline of a  rectangle to the layer texture. The rectangle’s position, color, width and alpha
value can be adjusted.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Pos U Horizontal Position 0-65535 32768

Pos V Vertical Position 0-65535 32768

Width Width of the rectangle 0-65535 32768

Height Height of the rectangle 0-65535 32768

Red Red level, Color Picker 0-255 255

Green Green level, Color Picker 0-255 255

Blue Blue level, Color Picker 0-255 255

Alpha Alpha level 0-255 255

Size Thickness of the rectangle’s lines 0-65535 1024
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Rectangle2D Mask

Adds a rectangular mask to the layer of the texture. Its size and position as well as color, alpha and
fill level, edge softness, and the angle of the mask can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pos U Horizontal position 0-65535 32768

Pos V Vertical position 0-65535 32768

Width Width 0-65535 32768

Height Height 0-65535 32768

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Size Size 0-65535 1024

Softness Softness 0-65535 1024

Fill Fill 0-255 255

Angle Angle 0-360 180

Rectangle2D

Adds a rectangle to the layer of the texture. Its size and position as well as color, alpha and fill level,
edge softness, and the angle of the shape can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pos U Horizontal position 0-65535 32768

Pos V Vertical position 0-65535 32768

Width Width 0-65535 32768

Height Height 0-65535 32768
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Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Size Size 0-65535 1024

Softness Softness 0-65535 1024

Fill Fill 0-255 255

Angle Angle 0-360 180

Triangle2D Mask

Adds a triangular mask to the layer of the texture. Its size and position as well as color, alpha and fill
level, edge softness, and the angle of the mask can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 32768

Pt2 Y Vertical position of the second point 0-65535 65535

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 250

Size Size 0-65535 250

Fill Fill 0-255 255

Angle Angle 0-360 180
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Triangle2D

Adds a triangle to the layer of the texture. Its size and position as well as color, alpha and fill level,
edge softness, and the angle of the shape can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Pt1 X Horizontal position of the first point 0-65535 0

Pt1 Y Vertical position of the first point 0-65535 0

Pt2 X Horizontal position of the second
point

0-65535 32768

Pt2 Y Vertical position of the second point 0-65535 65535

Pt3 X Horizontal position of the third point 0-65535 65535

Pt3 Y Vertical position of the third point 0-65535 0

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Softness Softness 0-65535 250

Size Size 0-65535 250

Fill Fill 0-255 255

Angle Angle 0-360 180

6.5.2.11.38  Sharpen

Edges

Sharpens the layer texture on all edges. The effect generates three additional textures with black and
white edges. These textures then overlay the real layer. With the parameters "Width" and "Height"
you can influence the horizontal and vertical offset of these textures / edges.

Parameter Description Value Range Default
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Mix Level of Effect 0-255 0

Width Amount of sharpening 0-255 128

Height Offset factor 0-255 128

Outlines

Creates area outlines of the layer texture by separating the texture into two different groups. This
depends on the contrast level of adjacent pixels, which can be adjusted with the parameter
"threshold".
You can setup a color and alpha level for both areas.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Red H Red level of High Color, Color Picker 0-255 255

Green H Green level, Color Picker 0-255 255

Blue H Blue level of High Color, Color Picker 0-255 255

Alpha H Alpha level of High Color 0-255 255

Red L Red level of Low Color, Color Picker 0-255 0

Green L Green level of Low Color, Color Picker 0-255 0

Blue L Blue level of Low Color, Color Picker 0-255 0

Alpha L Alpha level of Low Color 0-255 255

Threshold Threshold 0-255 32

Sharpen Alpha Edges (Fill Color)

Sharpens the edges of the alpha (transparent) channel depending on the chosen threshold and
smoothing value. In addition, all non-transparent pixels, can be colored in.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Threshold Threshold 0-255 128

Smoothing Smoothing 0-255 128

Red Color picker / Level of red 0-255 255
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Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Sharpen Alpha Edges

Sharpens the edges of the alpha (transparent) channel depending on the chosen threshold and
smoothing value.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Threshold Threshold 0-255 128

Smoothing Smoothing 0-255 128

Sharpen

Sharpens the layer texture on all edges. You can influence the amount of sharpening as well as the
offset factor for an internal sharpening texture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amount Amount of sharpening 0-255 255

Factor Offset factor 0-255 64
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6.5.2.11.39  Snapshot

Render Feedback

The texture is replaced by the Renderhistory (see description in Composition FX)  creating a video
feedback. This is similar to the situation when a mirror mirrors another mirror and the picture
feedbacks itself again and again.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Size Size 0-65535 32768

Off U Texture Offset in X 0-65535 32768

Off V Texture Offset in Y 0-65535 32768

Add Factor Add Factor 0-65535 32768

Del Factor Del Factor 0-65535 0

 Render Freeze

Allows freezing the Renderhistory, (see description in Composition FX) .

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Fade Fade 0-255 255

Freeze Freeze 0-255 30

Video Freeze

Shows a freeze frame of the video playing on the layer as soon as “Freeze” is set to a value >0.
Meanwhile the playback is going on, so this is different from having the video paused.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Freeze Freezes the video 0-255 0

410

410
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6.5.2.11.40  Softedge

Alpha Softedge

Allows setting a softedge fading into alpha for each edge: left, right, top and bottom. The amount and
alpha curve of the softedge can be adjusted, markers for each softedge can help doing the setup.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Left Amount of Softedge left 0-65535 0

Left Alpha Alpha curve 0-65535 32768

Left Marker Marker for left softedge: 

0=no marker 

1 - 255 = black marker - white marker

0-255 0

L Width Width of left marker 0-255 32

The parameters Left, Left Alpha, Left Marker and L Width and its values will be repeated for each
corresponding edge: Right, Top and Bottom.

 RGB Softedge

Allows setting a softedge fading into any RGB color for each edge: left, right, top and bottom. The
amount and RGB curve of the softedge can be adjusted, markers for each softedge may help doing
the setup.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Left Amount of Softedge left 0-65535 0

Left Red Red curve 0-65535 32768

Left Green Green curve 0-65535 32768

Left Blue Blue curve 0-65535 32768

Left Marker Marker for left softedge: 

0=no marker 

1 - 255 = black marker - white marker

0-255 0
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L Width Width of left marker 0-255 32

The parameters Left, Left Red/Green/Blue, Left Marker and L Width and its values will be repeated for
each corresponding edge: Right, Top and Bottom.

Softedge Bottom Alpha

Allows setting a softedge fading into alpha for the bottom edge. The amount and alpha curve of the
softedge can be adjusted, a marker for the softedge may help doing the setup.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amt Amount of Softedge 0-65535 0

Curve Red curve 0-65535 32768

Marker Marker for softedge: 

0=no marker 

1 - 255 = green marker

0-255 0

Width Width of marker 0-255 32

Softedge Bottom RGB

Allows setting a softedge fading into any RBG for the bottom edge. The amount and RGB curve of the
softedge can be adjusted, a marker for the softedge may help doing the setup.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Amt Amount of Softedge 0-65535 0

Curve Red curve 0-65535 32768

Marker Marker for softedge: 

0=no marker 

1 - 255 = green marker

0-255 0

Width Width of marker 0-255 32
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Softedge Left Alpha

see FX Softedge Bottom Alpha

Softedge Left RGB

see FX Softedge Bottom RGB

Softedge Right Alpha

see FX Softedge Bottom Alpha

Softedge Right RGB

see FX Softedge Bottom RGB

Softedge Top Alpha

see FX Softedge Bottom Alpha

Softedge Top RGB

see FX Softedge Bottom RGB

6.5.2.11.41  Softedge - Softedge P-Curve Alpha

Alpha Softedge P-Curve

Allows setting a p-curve softedge fading into alpha for each edge: left, right, top and bottom.
Position, curve and offset of each softedge can be adjusted, markers can help doing the setup.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Amount of left softedge 0-65535 0

L Curve Left alpha curve 0-65535 32768

L Offset Left offset 0-65535 32768

L Marker Left marker 0-255 0

L Width Width of left marker 0-255 32
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573

573

573

573

573



575

These parameters and its values are repeated for each corresponding edge: Right, Top and
Bottom.

Softedge P-Curve Bottom Alpha

Allows setting a p-curve softedge fading into alpha for only one edge: bottom.
Amount, curve and offset of the edge can be adjusted, a marker can help doing the setup.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount of softedge 0-65535 0

Curve Curve 0-65535 32768

Offset Offset 0-65535 32768

Marker Marker 0-255 0

Width Marker width 0-255 32

Softedge P-Curve Left Alpha

see FX Softedge P-Curve Bottom Alpha

Softedge P-Curve Right Alpha

see FX Softedge P-Curve Bottom Alpha

Softedge P-Curve Top Alpha

see FX Softedge P-Curve Bottom Alpha
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6.5.2.11.42  Softedge - Softedge P-Curve Alpha Gamma

Alpha Softedge P-Curve Gamma

Allows setting a p-curve softedge fading into alpha for each edge: left, right, top and bottom.
Position, curve and offset of each softedge can be adjusted, markers can help doing the setup. A
color correction can be added via an RGB-gamma.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Amount of left softedge 0-65535 0

L Curve Left alpha curve 0-65535 32768

L Offset Left offset 0-65535 32768

L Marker Left marker 0-255 0

L Width Width of left marker 0-255 32

These parameters and its values are repeated for each corresponding edge: Right, Top and
Bottom.

Gamma R Gamma Red 0-65535 16384

Gamma G Gamma Green 0-65535 16384

Gamma B Gamma Blue 0-65535 16384

Softedge P-Curve Gamma Bottom Alpha

Allows setting a p-curve softedge fading into alpha for only one edge: Bottom.
Position, curve and offset of each softedge can be adjusted, markers can help doing the setup. A
color correction can be added via an RGB-gamma.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Amount Amount of softedge 0-65535 0

Curve Softedge curve 0-65535 16384

Offset Offset 0-65535 32768
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Marker Marker 0-255 0

Width Marker width 0-255 32

Gamma R Gamma Red 0-65535 16384

Gamma G Gamma Green 0-65535 16384

Gamma B Gamma Blue 0-65535 16384

Softedge P-Curve Gamma Left Alpha

see FX Softedge P-Curve Gamma Bottom Alpha

Softedge P-Curve Gamma Right Alpha

see FX Softedge P-Curve Gamma Bottom Alpha

Softedge P-Curve Gamma Top Alpha

see FX Softedge P-Curve Gamma Bottom Alpha

6.5.2.11.43  Strobe

Alpha Flash

Flashes a transparent alpha layer into the selected texture layer, the speed can be adjusted. The
cross-fade between both texture is regular and the in-fade of the transparent texture has the same
duration as the out-fade.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Flash Speed Flash Speed 0-65535 32768

576
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Alpha Pulse

Pulses a transparent alpha layer into the selected texture layer, the speed can be adjusted. The
cross-fade between both texture is irregular as the in-fade of the transparent texture is sudden whilst
the out-fade is smooth.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Flash Speed Flash Speed 0-65535 32768

RND Alpha Flash

Flashes a transparent alpha layer into the selected texture layer, the speed can be adjusted. The
cross-fade between both texture is absolutely irregular as the in-and out-fades have random durations.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Flash Speed Flash Speed 0-65535 32768

Sync Color Strobe

Flashes a colored layer into the selected texture layer, alpha value, speed and color can be adjusted.
There is no cross-fade between both textures.
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Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Color picker / Level of red 0-255 255

Green Color picker / Level of green 0-255 255

Blue Color picker / Level of blue 0-255 255

Alpha Level of transparency 0-255 255

Flash Speed Flash Speed 32768-65535 32768

6.5.2.11.44  Stylize

ASCII Replace

Replaces the texture of the layer with ASCII symbols, size and color intensity of the symbols can be
adjusted, as well as the type of symbols.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Tiling Tiling 0-65535 8192

Col Col 0-65535 0

ASCII Map ASCII Map - -

Film Look

Renders the layer texture in an old-fashioned film look, different values like sepia, grain and noise can
be adjusted separately.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Sepia Sepia 0-255 225

Noise Noise 0-255 220

Noise Size Noise Size 0-255 12

Grain Grain 0-255 93
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Flicker Flicker 0-255 220

Mask Mask 0-255 72

Scroll Scroll 0-65535 7900

Wireframe Edges

This effect works only with an assigned 3D object. It overlays the layer texture with two adjustable
colors. First, the edge wireframes of the object are made visible with a color and alpha level of your
choice. Second, a fill color and transparency can be assigned. The width of the wireframes can be
adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Edge Red Edge 0-255 255

Green Edge Green Edge 0-255 255

Blue Edge Blue Edge 0-255 255

Alpha Edge Alpha Edge 0-255 255

Red Fill Red Fill 0-255 0

Green Fill Green Fill 0-255 0

Blue Fill Blue Fill 0-255 0

Alpha Fill Alpha Fill 0-255 255

Width Width 0-65535 13500
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Wireframe

This effect works only with an assigned 3D object. It overlays the layer texture with two adjustable
colors. First, the polygon wireframes of the object are made visible with a color and alpha level of your
choice. Second, a fill color and transparency can be assigned. The width of the wireframes can be
adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Red Edge Red Edge 0-255 255

Green Edge Green Edge 0-255 255

Blue Edge Blue Edge 0-255 255

Alpha Edge Alpha Edge 0-255 255

Red Fill Red Fill 0-255 0

Green Fill Green Fill 0-255 0

Blue Fill Blue Fill 0-255 0

Alpha Fill Alpha Fill 0-255 255

Width Width 0-65535 13500
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6.5.2.11.45  Transition

Alpha 16bit

Fades the opacity of the texture layer in 16-bit increments by multiplying the alpha value with a factor.
This means that the color values are preserved.
Mix 1 = completely transparent, 65535 = completely visible.

Parameter Description Value Range Default

Mix Level of effect itself 0-65535 0

Dissolve 16bit

Dissolves the texture layer in 16-bit increments by multiplying the alpha as well as the RGB values
with a factor.
Mix 1 = completely transparent, 65535 = completely visible.

Parameter Description Value Range Default
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Mix Level of effect itself 0-65535 0

Transition Crop Media Mask

Per default, when a layer fades out (i.e. the opacity value decreases from 255 to 0) the opacity value
for each individual pixel is the same. With the TransitionFX you can set up a so-called “Opacity Map”.
Apply one of your own images to the effect.
The layer now fades according to the chosen map, but in contrary to other Transition FX it (dis-)
appears in steps, not gradually. Dark areas in the map fade out first, white ones at last. The contrary
applies for a fade in.

The TransitionFX depends only on the "XFade" parameter, not on the "Opacity" of the layer! 

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

XFade XFade 0-255 0

Media Media file as source for overlay or
mask

- -

Transition Media Mask

Per default, when a layer fades out (i.e. the opacity value decreases from 255 to 0) the opacity value
for each individual pixel is the same. With the TransitionFX you can set up a so-called “Opacity Map”.
Apply one of your own images to the effect.
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The layer now fades according to the chosen map. Dark areas in the map fade out first, white ones at
last. The contrary applies for a fade in.

The TransitionFX depends on the "Opacity" of the layer! 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Media Media to be used for transition

TransitionFX 

Per default, when a layer fades out (i.e. the opacity value decreases from 255 to 0) the opacity value
for each individual pixel is the same. With the TransitionFX you can set up a so-called “Opacity Map”.
Choose one of the hundreds Pandoras Box' predefined wipes and transitions.
The layer now fades according to the chosen map. Dark areas in the map fade out first, white ones at
last. The contrary applies for a fade in.

The TransitionFX depends on the "Opacity" of the layer! 

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Opacity Map Choose one of the Transition FX

All available TransitionFX are listed below:
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6.5.2.11.46  UV Mapping

AutoAspect Scroll Horizontal (infinite)

Scrolls the media from right to left or left to right by repeating it endlessly. The scrolling speed and
horizontal aspect ratio can be adjusted. If the "Width" parameter is set to the texture's width, no
scaling occurs.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Speed X Horizontal speed 0-65535 32768

Width (px) Width (px) 0-65535 1024
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AutoAspect Scroll Horizontal (steady speed)

Please use the effect "AutoAspect Scroll Horizontal (infinite)"  instead. The different calculation of
the scrolling allows infinite usage.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Speed X Horizontal speed 0-65535 32768

Width (px) Width (px) 0-65535 1024

Dual Head Split H

Splits the layer texture horizontally into two areas. The layer texture is repeated, whilst "Factor"
defines the offset. The separation can be softedged manually.

This effect allows splitting the Pandoras Box output when for example using (Matrox) Dual Head
Devices. Assign it to the output itself or to a layer that is toggled into the Output Rendering Pass
by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Factor Factor 0-65535 0

Softedge Softedge 0-65535 0

Curve R Curve R 0-65535 8000

Curve L Curve L 0-65535 8000

Center Center 0-65535 27000

Dual Head Split V

Splits the layer texture vertically into two areas. The layer texture is repeated, whilst "Factor" defines
the offset. The separation can be softedged manually.

589
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This effect allows splitting the Pandoras Box output when for example using (Matrox) Dual Head
Devices. Assign it to the output itself or to a layer that is toggled into the Output Rendering Pass
by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Factor Factor 0-65535 0

Softedge Softedge 0-65535 0

Curve Top Curve Top 0-65535 8000

Curve Bottom Curve Bottom 0-65535 8000

Center Center 0-65535 27000

Tripple Head Split H

Splits the layer texture horizontally into three areas. The layer texture is repeated, whilst "Factor"
defines the offset. The separation can be softedged manually.

This effect allows splitting the Pandoras Box output when for example using (Matrox) Tripple Head
Devices. Assign it to the output itself or to a layer that is toggled into the Output Rendering Pass
by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Left Left 0-65535 0

Right Right 0-65535 0

Softedge L Softedge L 0-65535 0

SE L R SE L R 0-65535 32768

SE L L SE L L 0-65535 32768

Center1 Center1 0-65535 32768

Softedge R Softedge R 0-65535 0

SE R R SE R R 0-65535 32768

SE R L SE R L 0-65535 32768

Center2 Center2 0-65535 32768

322
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Tripple Head Split V

Splits the layer texture vertically into three areas. The layer texture is repeated, whilst "Factor"
defines the offset. The separation can be softedged manually.

This effect allows splitting the Pandoras Box output when for example using (Matrox) Tripple Head
Devices. Assign it to the output itself or to a layer that is toggled into the Output Rendering Pass
by using the Layer Inspector .

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Top Top 0-65535 0

Bottom Bottom 0-65535 0

Softedge T Softedge T 0-65535 0

SE T T SE T T 0-65535 32768

SE T B SE T B 0-65535 32768

Center1 Center1 0-65535 32768

Softedge B Softedge B 0-65535 0

SE B T SE B T 0-65535 32768

SE B B SE B B 0-65535 32768

Center2 Center2 0-65535 32768

 Resize 

Resizes and repositions the image by adjusting the UV map, i.e. without affecting the layer’s scale
and position values.
Allows resize factors between 0 and 1, and setting an xy offset. The texture is not repeated.

To calculate the precise size parameter: size factor*65535,
e.g for a scale of 0.25: (1/4)*65535 = 16384

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

322
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FactorX Size in X (100% - 0%) 0-65535 65535

FactorY Size in Y (100% - 0%) 0-65535 65535

Pos U Horizontal Position 0-65535 32768

Pos V Vertical Position 0-65535 32768

Rotate Tiled

Allows rotating the UV map of the layer texture without affecting the layer's rotation values. The
texture is repeated.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Rot Rotation angle 0-65535 0

Rotate 

Allows rotating the UV Mapping of the layer texture without affecting the layer’s rotation values. The
texture is not repeated.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Rot Rotation of UV Mapping 0-65535 32768



594

Texture Zoom

Resizes and repositions the image by adjusting the UV map, i.e. without affecting the layer’s scale
and position values.
Allows resize factors between 1 and unlimited, and setting an xy offset. The texture is not repeated.

To calculate the precise size parameter: (1-1/2*size factor)*65535,
e.g for a scale of 4: (1-1/(2*4)*65535 = 7/8*65535 = 57343

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Factor X Horizontal scale factor (100% -...) 0-65535 0

Factor Y Vertical factor (100% -...) 0-65535 0

Pos U Horizontal position 0-65535 32768

Pos V Vertical position 0-65535 32768

Tiling

Allows tiling the UV Mapping of the layer texture.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Factor Amount of tiling

Examples:

0       ~ 1x texture width

1024 ~ 1.5 x texture width

2048 ~ 2x texture width

4094 ~ 3x texture width

6144 ~ 4x texture width

8192 ~ 5x texture width

…

0-65535 0
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Underscan

Enlarges the content of the layer texture slightly.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

UV Offset

Resizes and repositions the image by adjusting the UV map, i.e. without affecting the layer’s scale
and position values.
Allows resize factors between 0 and unlimited, and setting an xy offset. The texture is repeated.

To calculate the precise size parameter: (1-1/2*size factor)*65535,
e.g for a scale of 4: (1-1/(2*4)*65535 = 7/8*65535 = 57343

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Offset X Horizontal offset 0-65535 32768

Offset Y Vertical offset 0-65535 32768

Factor X Horizontal scale factor (0% -...) 0-65535 32768

Factor Y Vertical scale factor (0% -...) 0-65535 32768
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UV Remap 4x

Replicates the layer texture four times and adjusts the UV map.
Allows resizing and xy offsetting by mapping four individual, customizable source textures onto a
target space. The source texture can not be repeated.
The color and alpha level of the target background can be adjusted. All four quadrants of the target
can be edited separately similar to the "UV Remap" effect.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

T1 Opacity T1 Opacity 0-255 255

T1 X Horizontal t1 0-65535 0

T1 Y Vertical t1 0-65535 0

T1 Width T1 Width 0-65535 32768

T1 Height T1 Height 0-65535 32768

S1 X Horizontal s1 0-65535 32768

S1 Y Vertical s1 0-65535 32768

S1 Width S1 Width 0-65535 65535

S1 Height S1 Height 0-65535 65535

T2 Opacity T2 Opacity 0-255 255

T2 X Horizontal t2 0-65535 32768

T2 Y Vertical t2 0-65535 0

T2 Width T2 Width 0-65535 32768

T2 Height T2 Height 0-65535 32768

S2 X Horizontal s2 0-65535 32768

S2 Y Vertical s2 0-65535 32768

S2 Width S2 Width 0-65535 65535

S2 Height S2 Height 0-65535 65535

T3 Opacity T3 Opacity 0-255 255

T3 X Horizontal t3 0-65535 0

T3 Y Vertical t3 0-65535 32768

T3 Width T3 Width 0-65535 32768

T3 Height T3 Height 0-65535 32768

S3 X Horizontal s3 0-65535 32768

S3 Y Vertical s3 0-65535 32768

S3 Width S3 Width 0-65535 65535

S3 Height S3 Height 0-65535 65535

T4 Opacity T4 Opacity 0-255 255

T4 X Horizontal t4 0-65535 32768

T4 Y Vertical t4 0-65535 32768
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T4 Width T4 Width 0-65535 32768

T4 Height T4 Height 0-65535 32768

S4 X Horizontal s4 0-65535 32768

S4 Y Vertical s4 0-65535 32768

S4 Width S4 Width 0-65535 65535

S4 Height S4 Height 0-65535 65535

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Alpha Level of transparency 0-255 0

UV Remap

Resizes and repositions the image by adjusting the UV map, i.e. without affecting the layer’s scale
and position values.
Allows resizing and xy offsetting by mapping a customizable source texture onto a target space. The
source texture can not be repeated.
The color and alpha level of the target background can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Target X Horizontal target position 0-65535 0

Target Y Vertical target position 0-65535 0

T Width Hor. target scaling (0% -100%) 0-65535 32768

T Height Vertical target scaling (0% -100%) 0-65535 32768

Source X Horizontal source position 0-65535 32768

Source Y Vertical source position 0-65535 32768

S Width Hor. source scaling (100% -...) 0-65535 65535

S Height Vertical source scaling (100% -...) 0-65535 65535

Red Color picker / Level of red 0-255 0

Green Color picker / Level of green 0-255 0

Blue Color picker / Level of blue 0-255 0

Alpha Level of transparency 0-255 0
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UV Scroll

Scrolls the media endlessly in horizontal and / or vertical direction. The scrolling speed in x- and y-
direction as well as x- and y-scale can be adjusted.

Parameter Description Value Range Default

Mix Level of effect itself 0-255 0

Speed X Horizontal speed 0-65535 32768

Speed Y Vertical speed 0-65535 32768

Factor X Horizontal scale factor (100% -...) 0-65535 32768

Factor Y Vertical scale factor (100% -...) 0-65535 32768

UV Wrap Blend Horizontal 

Allows to blend the left edge of a texture with a copy of the content of the right edge. At the same
time the right edge blends into the left part. This is of interest when you have a 360° projection and
your setup in Pandoras Box is that cameras are spread out and look onto one layer (see image). In
case your content shows a hard edge because the right and left pixels do not match you can blend
the area with this effect.
For other applications, you may combine this effect with the Resize, UV Offset or Texture Zoom.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Blend Level of right / left blend 0-65535 32768
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UV Wrap Blend Vertical 

Allows to blend the upper edge of a texture with a copy of the content of the bottom edge. At the
same time the bottom edge blends into the upper part. This is of interest when you have a 360°
projection with rotated projectors and your setup in Pandoras Box is that cameras are spread out and
look onto one layer (see image). In case your content shows a hard edge because the top and
bottom pixels do not match you can blend them.
For other applications, you may combine this effect with the Resize, UV Offset or Texture Zoom.

Parameter Description Value Range Default

Mix Level of Effect 0-255 0

Blend Level of top / bottom blend 0-65535 32768
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6.5.2.11.47  Warp

Warp

This effect allows deforming an object by moving its vertices live in the Warper tool . Please refer to
the live warping tutorial  in the manual for more information.

Note that this effect has no parameters, you will not see it in the Device Control tab  itself. Only
when opening the FX parameter in the Device Tree  you will see the effect. The effect cannot be
turned off like other effects, the only way to deactivate it, is to delete it entirely.

Parameter Description Value Range Default

none! - -

Warp Target

810

858

165

169
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This effect allows deforming an object by moving its vertices according to the saved data in the Warp
Target media file. The media file can be either one or several Morph Targets from the Warper tool. Per
default that would be a png file, respectively a png image sequence. You may also convert your files
to bmp files or a uncompressed video format, e.g. the avi format or a lossless format from the coolux
codec . In any case, activate the "Video Alpha channel" in the File Inspector ! Note that the
target media has no separate playback control, use a video file as a layer texture or work with the
Share layer feature.
Please refer to the live warping tutorial  in the manual for more information about the steps in the
Warper.

Parameter Description Value Range Default

Target Target - -

6.5.3  Graphic Layer Control

Graphic and Video Layers have very similar functions, they only differ in the properties listed below.
For information about all other sections of the graphic layer (like position, rotation, scale…) please refer
to the explanation of the Video Layer Control .

No Playback Control / No Audio Section

Video and audio files can’t be played back on a graphic layer. But you have the possibility of choosing
and showing a still frame from a video file.
Use the parameter “Frame” to scroll through the video file. The value range of 0..65535 corresponds the
100% video length.
To show animated files on a graphic layer, use the option “Share Layer Texture” and route the texture
of another layer to this graphic layer.

You may add an unlimited amount of Graphic Layers to your project. Do this by right-clicking on the site
to open the context menu  > Add Graphic Layer. The new Graphic Layer will be added below the
highest Graphic Layer in the Device Tree. The layer can be moved to another position in the device tree
by drag and drop .

114 191

858

323

325

173

171
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6.5.4  Audio Tracks

Dedicated audio tracks are available for Pandoras Box Manager, Player and Server systems. Audio
tracks allow playing back ASIO wav files while being synchronized to a Master clock.
Please note that an ASIO sound card needs to be set up in the Configuration tab, section ASIO Audio

. This chapter also includes more information regarding the ASIO support, e.g. synchronization and
channel settings.

Another possibility to playback sound is, to use a video layer but in that case it can not be
synchronized.

The Audio Track Control includes the following sections: Information about DMX Control is included,
addressing customers who wish to remote control a layer with a lighting desk via DMX or Art-Net. If you
like to use the Widget Designer or another application instead, please refer to this parameter list .
Media
Playback Transport
Volume
Inpoint/Outpoint
Pan

6.5.4.1  Media

The Audio Tracks will play mono and stereo PCM Wave files (16 or 24 bit) with the sample rate that is
preset in the Audio Configuration only, there will be no sample rate conversions done: each sample will
played back 1:1.

To assign an audio resource to a track, drag and drop the resource from the project tab onto the
designated track. You can also highlight the target track by left-clicking on it and use the right-click
command on the resource in the project tab “assign to active device” or just double-click on the audio
file. Media can also be assigned from the thumbnail browser by double clicking it for attributing it to the
selected highlighted layers.

To remove the resource of the track, right-click in the layer tree on the media parameter and choose
“reset” or right-click on the media thumbnail in the Device Control Tab.

DMX Control:
For DMX control depending on the ID assignment in the Pandoras Box manager user interface, each

157
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layer can access 255 folder and 255 file IDs of individual media files as well as live inputs, see DMX
Tables  > DMX Table PB Manager .

The media selection channels are 8bit, the default value is set to 0.

Media Folder

0 No folder

1..255 Folder 1..255

Media File

0 No file

1..255 File 1..255

6.5.4.2  Playback Transport

The Playback Transport channel allows setting the play mode of the audio file to Play Once, Stop,
Pause and Play Loop.

DMX Control:
DMX values for Playback Transport, see DMX Table PB Manager .

The Playback Transport channel is 8bit and the default value is 0.

0 Stop

64 (1-127) Play Once

128 Pause

192 (129-255) Play Loop

6.5.4.3  Volume

With the Volume parameter the Volume of the audio files may be controlled.

DMX Control:
DMX values for Volume Control, see DMX Table PB Manager .
The Volume channel is 16bit and the default value is 0.

Volume

0 No Audio, -96dB

..

32768 0dB

46300 3dB

65535 Max. Volume

Please note, that for Widget Designer or other controlling applications, the range of values is 0 - 2, more
information can be found in the parameter list .
The volume is measured in decibel and is based a logarithmic function. To convert an external WD value
to a decibel value in Pandoras Box or vice versa, please use this formula: 

          

0 -96 dB

0.2 -13.98) dB

647 647

647

647

1315
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0.4 -7.96 dB

0.6 -4.44 dB

0.8 -1.94 dB

1.0 0 dB

1.2 1.58 dB

1.4 2.92 dB

1.6 4.08 dB

1.8 5.11 dB

2.0 6.02 dB

6.5.4.4  Inpoint / Outpoint

Set the in- and outpoint to define a specific start & end marks of an audio clip, the play once and play
loop video mode will work in the resized area.
The In- & Outpoint selection works on a percentage base of the overall audio file length. 

DMX Control:
DMX values for Inpoint Control, see DMX Table PB Manager .
The Inpoint channel is 16bit and the default value is 0.

Inpoint

0 File Beginning

1 ... 65534

65535 End of File

DMX values for Outpoint Control, see DMX Table PB Manager .
The Outpoint channel is 16bit and the default value is 65535.

Outpoint

0 File Beginning

1 ... 65534

65535 End of File

6.5.4.5  Pan

The Pan Control allows varying the relative levels of the two channels of a stereo source. 
When not having the Pan Parameter modified, both channels of a stereo source will have the same level.
Turning Pan to 0 will output the left channel only, turning Pan to 65535 will output the right channel only.

DMX Control:
DMX values for Pan Control, see DMX Table PB Manager .
The Pan channel is 16bit and the default value is 32768.

Pan

0 Left Channel only

32768 Center - L+R Channel

65535 Right Channel only

647

647

647
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6.5.5  Pointer Layer Control

A Pointer Layer displays the local mouse or touch input(s). Per default it is not shown in the Device
Tree, please right-click on your Master or Client system and choose "Add Layers" > "Pointer Layer".
As the Pointer Layer has very similar functions to those of a Video Layer, this chapter focuses on the
exclusive options. For information about all other sections (like position, rotation, scale…) please refer to
the explanation of the Video Layer Control .

For general information how a Pointer Layer can be used, please see the chapter explaining the feature 
Layer Picking . The number of inputs can be set up in the Pointer Inspector .

Loop Target and Pointer Fade Out

Both settings are more interesting when using a touch device instead of a device like a mouse. The
difference between both devices is that a touch device only sends data when the device is in use, whilst
a mouse device is always present.

The Loop Target can be understood as a playback command.
If you are using an always present input, you could use an image sequence or video and set the Loop
Target to the starting frame.

If you are using working with touch inputs and your media file has a defined fade-in scene and then an
looping scene, you can use the Loop Target Time to loop only the images AFTER the fade-in images. An
example is depicted below. This means that the Pointer Layer "fades" in as soon as a touch input is
received. And as long as the touch input stays present, the pointer loops starting from the Loop Target to
the real end of the media file.

The Pointer Fade Out Time is the duration for fading the pointer out if the touch input is not present any
more.

Both time can be entered in the format H:MM:SS:FF or shortened to SS:FF or even SFF. So, for
example 3 seconds can be 0:00:03:00 or 03:00 or 300

Offset X and Offset Y

Enter an offset (in generic units) for the X-axis and Y-axis that should be added to the real X and Y
position of the input.
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6.5.6  Light Layer Control

A Light Layer allows setting a light source to illuminate other video and graphic layers. With the help of a
particular effect (Aeon FX tab  > Lighting  folder) another layer can "receive" this light and hence be
illuminated. Without an lighting effect they will be rendered as always.
1a. Create a Light Layer (right-click on Site > Add Device > Add Light Layer)
1b. Assign a texture to the light, e.g. a white image from the Stock Assets.
2a. Assign a texture to a common video or graphic layer.
2b. Drag a Lighting FX from the Aeon FX tab onto this layer. Right-click into the effect's "Media" field,
choose "Share Layer Texture" and select the respective light source. Now, the chosen light illuminates
the video / graphic layer.

The Light Layer Control includes the following sections:
Media Selection
Intensity
Playback
Position
Target
Color
Settings

The following chapters include information about DMX Control, addressing customers who wish to remote
control a light layer with a lighting desk via DMX or Art-Net. If you like to use the Widget Designer
instead, please refer to this parameter list .

The according inspector information is described here .

Even though it is possible to add as many light layers as you wish,keep in mind that calculating light
effects requires a lot of the system's performance. Depending on your settings and of course your
hardware, three lights might be already the limit.
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If you wish to see the spanned light cone
in your Preview window, make a right-click
and toggle the light wireframes on. Make
sure that under "Show Handles" "Show in
Local Node" (or ...Client) is enabled.
Please refer to this chapter  if you wish
to know more about wireframes and
handles.

6.5.6.1  Media

The Media parameter for a light layer is very similar to the one from a normal video layer. Please refer to 
this chapter  if you want to learn how to assign a media to a layer and what layer sharing means. As
well you will find there the DMX Control chart. 
At present, it is not possible to use transparency (α channel) as see-through parts, for this simply use
white color.

The media for a light layer acts as a mask or gobo or even as a transparent image in front of a light. In
case of choosing a video, it turns the light into a projector. 

The emitted
light cone has
the shape of a
soft dot, the
black parts are
not visible.

The emitted
light cone has
the shape of a
star.

Emitted light
interacts with
the object's
color. The
reflected light
depends on
both colors!

Contrary to a video layer, you can not assign a mesh to a light layer.
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6.5.6.2  Intensity

The Intensity parameter sets the intensity of a light source, i.e turning it on and off. Please keep in mind
that layers receiving this light as a single light source will not be visible anymore. 

Intensity 0% (value 0) off
Intensity 100% (value 255) on

DMX Control
The intensity channel is 8bit, the default value is set to 0.

Intensity

0..255 Fully turned off..Fully turned on

6.5.6.3  Playback

The light layer's Playback parameter section does not differ from a video layer's one. Please refer to this
chapter  to learn how to set a video to play, how to run it faster and how to change its first frame. As
well you will find there the DMX Control chart.

6.5.6.4  Position
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The Position parameters allow changing the position from where the light rays are emitted originally in
the 3D space. Just as a camera a light's default position is located at (XYZ = 0,0,-25).

The reason for the units of the position parameter lies in the following: one screen width is always 16
units wide, the height is calculated by the aspect ratio. A 4:3 display is 16 units wide and 12 units high,
a 16:9 display is 16 units wide and 9 units high.

Lights in Pandoras Box have no attenuation, which means that their intensity is not a function of the
distance from a light source to an object's surface. Thus, the position does only affect the angle of
incidence, i.e. how steep the light shines on an object. The second parameter influencing the angle is
the target position . The affect of the angle of incidence is described here  in detail.

DMX Control
All position channels are 16bit and the default value is 32768.
Resolution: 1 DMX Step = 0.008 units

X Position:

0 max. position left (-256 units or 16 screen width to the left)

32768 Center

65535 max. position right (+256 units or 16 screen width to the right)

Y Position:

0 max. position bottom (-256 units)

32768 Center

65535 max. position top (+256 units)

Z Position:

0 max. position far (-256 units)

32768 Center

65535 max. position near (+256 units)

6.5.6.5  Target

The Target parameters allow changing the position to where the light rays are emitted in the 3D space
without moving the light itself. Just as a camera a light's default position is located at X,Y,Z = 0,0,-25.

The reason for the units of the position parameter lies in the following: one screen width is always 16
units wide, the height is calculated by the aspect ratio. A 4:3 display is 16 units wide and 12 units high,
a 16:9 display is 16 units wide and 9 units high.

Lights in Pandoras Box have no attenuation, which means that their intensity is not a function of the
distance from a light source to an object's surface but is always equally intense. Thus, the target
position does only affect the angle of incidence, i.e. how steep the light shines on an object. The second
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parameter influencing the angle is the source position . The affect of the angle of incidence is
described here  in detail.

Target X Position:

0 max. position left (-256 units or 16 screen width to the left)

32768 Center

65535 max. position right (+256 units or 16 screen width to the right)

Target Y Position:

0 max. position bottom (-256 units)

32768 Center

65535 max. position top (+256 units)

Target Z Position:

0 max. position far (-256 units)

32768 Center

65535 max. position near (+256 units)

6.5.6.6  Color

The Color parameter allow changing the color of the emitted light rays. Please refer to this chapter  if
you want to learn how to use the color picker.

DMX Control
All Color channels are 8bit, the default value is set to 255.

Red

0...255 Red level, Color Picker

Green

0...255 Green level, Color Picker

Blue

0...255 Blue level, Color Picker
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6.5.6.7  Settings

Next to the parameters Position and Target the Settings parameter section allows adjusting the area in
your 3D space that will be affected by light. Layers that are not within the spanned light cone cannot be
shed with light, cast shadows or be shadowed. 

"Angle" resizes the dihedral angle of the light and spanns the light cone. By default it is squarish, that is
the height equals the width. "Aspect Mode" influences the width-height-ration, whereas "Z Roll" rotates
the entire light cone. Contrary to the next mentioned parameters all these parameters can be seen in the
Preview window if the Light Wireframes  are toggled on. 

Figure 1a,b

Figure 2a,b

Figure 3a,b
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Figure 1a,b) "Near Plane" and "Far Plane" have their origin in the Camera Control . When looking at
the distance from the light source itself, the near plane describes the minimum distance an object is
allowed to have in order to cast shadows; the far plane refers to the maximum distance. In the example
the near plane starts behind the front part of the jug. Even though it is dipped in light it is not casting
shadow any more. Note that the light simply cuts the shadows of the front part of the jug, it is not
rendering them any more. It cannot see through the first layers of the object and render the shadow of
the back side instead.

Note that the planes are not designed to be an artistic tool. They are rather meant to be used if the depth
resolution is too small and objects being to close to each other are rendered in a wrong way. If you have
such an issue decrease the distance between both planes without cutting objects.

Figure 2a,b) A higher light "Tolerance" decreases the shadowed area, either on the object itself or
another object. If a particular area lies within the light-shadow-border it now tends to be on the illumined
side. 
The tolerance level helps to decrease the phenomenon called self-shadowing which can be especially
problematic when using objects with a very rough surface.

In the example the tolerance level is set to 0.005 for the left image, and to 0.990 for the right image. Note
that 0.990 is so high that even the shadow of the handle is influenced.

Figure 3a,b) A higher shadow "Softness" blurs the shadow border, on the object itself and on another
object. It can be especially helpful when working with a Shadow Map  set to a low resolution .

In the example the tolerance level mentioned above is set back to the default value of 0.10.
The softness level is set to 0 for the left image, and to 900 for the right image. Note the difference to the
image above. There, the light-shadow-border has moved whereas here, the border remains but the
transition is softer.

DMX Control 
If not listed differently, Settings Channels are 16bit.

Angle
Default value is set to 57. Resolution: 1 DMX Step = 0.003 units

0 0.000

14564 40.002

65535 180.000

Aspect Mode 
Default value is set to 3277.

0 0

3277 1

65535 20

Z Roll
Default value is set to 32768.

0 -1080° or 3 rotations clockwise

32768 0°

65535 +1080° or 3 rotations anti-clockwise

Near Plane
Default value is set to 5.

0..65535 -256 units

Far Plane
Default value is set to 50000.

0..65535 -256 units
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Tolerance
Default value is set to 6554.

0 0.000

6554 0.100

65535 1.000

Softness
Default value is set to 16384.

0 0

16384 250

65535 1000

6.5.7  Camera Control

As mentioned in the chapter Video Processing Pipeline  the camera control allows setting up the 3D
look-at-point onto your 3D composition. Here you can determine whether each camera should display
the same or different areas in 3D space. This allows stretching layers over several outputs or to create
softedge blended setups. 

Depending on your PB product one, two or four cameras are available whilst a camera on a Server has
more parameters than on a Player.

The Camera Control chapter is divided into the following sections. Information about DMX Control is
included, addressing customers who wish to remote control a layer with a lighting desk via DMX or Art-
Net. If you like to use the Widget Designer or another application instead, please refer to this parameter
list .
Projection Mode
View Point  (only available for Servers)
Target  (only available for Servers)
Settings
Lens Shift
Background Color  (only available for Servers)

322

1316

614

615

616

618

618

620



614

6.5.7.1  Projection Mode

There are two projection modes available for each camera device:
- Perspective Mode (by default) and
- Orthogonal Mode.

The perspective mode allows a perspective angle to your view from different 3D scene.
The orthogonal mode switches off the depth and perspective view of the camera.
The control channels do still access the three dimensional orientation of the 3D camera.

Please note: 
The Z position of any layer will only affect the rendering order but won’t make any visual change to the
layer.

See here an example of how the projection mode affects the output:

The images at the top show the 3D scene in the global cam Preview: in perspective mode (left) and in
orthogonal mode (right). The 3D scene stays the same, but the camera wireframes change according to
the projection mode. The images at the bottom show the resulting output: in perspective mode (left) and
in orthogonal mode (right).
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DMX Control 
The Projection Mode Channel is 8bit and the default value is set to 0.

Perspective Mode 0

Orthogonal Mode 1

6.5.7.2  View Point

The viewpoint (only available for Servers) allows changing the camera’s position in the 3D space without
affecting its target. The default position of the camera is at (XYZ = 0,0,-25).
The output is always 16 units wide, the height is calculated by the aspect ratio.
A 4:3 display is 16 units wide and 12 units high, a 16:9 display is 16 units wide and 9 units high.

Example:
The viewpoint is changed to (XYZ = -8,4.5,-25), the camera’s new position is orthogonal to the upper left
corner of a 16:9 output. See how the viewpoint affects the output.

The images at the top show the 3D scene in the global cam Preview: with default viewpoint (left) and with
viewpoint changed to the new position (right). The images at the bottom show the resulting output: with
default viewpoint (left) and with new viewpoint position (right).
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DMX Control 
All Viewpoint Channels are 16bit.
Resolution: 1DMX Step = 0.008 units

X Position
Default value: 32768

0 max. position left (-256 units or 16 screen width to the left)

32768 Center

65535 max. position right (+256 units or 16 screen width to the right)

Y Position
Default value: 32768

0 -256 units

32768 Center

65535 +256 units

Z Position
Default value: 29568

0 -256 units

32768 Center

65535 +256 units

Note that you can also use the Align function  as described in the chapter about the Status bar.

6.5.7.3  Target

The target parameters (only available for Servers) allow changing the camera’s target position in the 3D
space without moving the camera itself. The output will show another detail of the 3D space and the
perspective will be affected as well (as long as you do not work in Orthogonal Projection Mode).
The output is always 16 units wide, the height is calculated by the aspect ratio.
A 4:3 display is 16 units wide and 12 units high, a 16:9 display is 16 units wide and 9 units high.
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Example:
The target position is changed from the default position (XYZ = 0,0,0) to (XYZ = -4.7,-1.3,0).

The images at the top show the 3D scene in the global cam Preview: with default target (left) and with
target changed to the new position (right). The images at the bottom show the resulting output: with
default target (left) and with new target position (right).

DMX Control 
All Target Position Channels are 16bit, the default value is 32768.
Resolution: 1DMX Step = 0.008 units

Target X Position

0 max. position left (-256 units or 16 screen width to the left)

32768 Center

65535 max. position right (+256 units or 16 screen width to the right)

Target Y Position

0 -256 units

32768 Center

65535 +256 units

Target Z Position

0 -256 units

32768 Center

65535 +256 units

Note that you can also use the Align function  as described in the chapter about the Status bar.133
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6.5.7.4  Settings

The Settings section allows adjusting the Camera’s Field of View, the area in your 3D space that will be
rendered (Near and Far Plane) and the Aspect Mode of the camera. Players have only access to the
FOV parameter.

DMX Control 
All Settings Channels are 16bit.

FOV (Field of View)
Default value is set to 17745.

0 0.001

17734 35.489

65535 131.070

Near Plane
Default value is set to 5.

0..65535 -256 units

Far Plane
Default value is set to 50000.

0..65535

Aspect Mode 
Default value is set to 10924.

0 0

10924 1

32768 3

65535 6

6.5.7.5  Lens Shift
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The Lens Shift section allows adjusting X and Y Offset as well as the Z Roll. 

X&Y Offset

The camera X&Y offset allows positioning the center of the cameras perspective. 
This is especially used when one perspective view needs to be shared across several outputs.

For example, if you have 4 screens set up next to each other, you would offset each screen in the way
that you can move your layers with the XYZ position smoothly across all outputs, while maintaining a
correct perspective 3D view.
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Z Roll

The Z Roll allows rolling the camera across its Z Axis. 

DMX Control 
All Lens Shift Channels are 16bit, the default value is set to 32768.

X Offset

0 -256 units

32768 Center

65535 +256 units

Y Offset

0 -256 units

32768 Center

65535 +256 units

Z Roll

0 -1080°

32768 0°

65535 +1080°

Note that you can also use the Align function  as described in the chapter about the Status bar.

6.5.7.6  Background Color

The Background Color section (only available for Servers) allows adjusting the red / green / blue / alpha
channels for the main background from the resulting texture rendered by the camera (the so called
render target). More information about the render target can be found in the chapter Video Processing
Pipeline , a possible application for adjusting the background color could be blacklevel compensation

 when working with multi-softedged projection(s). If you are not familiar how to use the color picker
tool, please read the topic "FX Parameter ".

DMX Control 
All Background Color Channels are 8bit.

Red, the default value is set to 0

0...255 Red level, Color Picker

Green, the default value is set to 0

0...255 Green level, Color Picker

Blue, the default value is set to 0

0...255 Blue level, Color Picker
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Alpha, the default value is set to 255

0...255 Alpha / transparency level

6.5.8  Output Control

The output device is the device that controls the overall output of the Pandoras Box Server or Player.
Here you may add a matrix file and a 3D / Warping object, adjust keystone and softedge settings.
You may add FX for i.e. a color correction of the whole output!

The camera control is the first render path. The result of this camera filming your 3D composition is
passed to the output control, which is the second render path. The passes are described in detail in the
chapter "Video Processing Pipeline ".

The output control section is divided into the following chapters. Information about DMX Control is
included, addressing customers who wish to remote control a layer with a lighting desk via DMX or Art-
Net. If you like to use the Widget Designer or another application instead, please refer to this parameter
list .
Matrix
Object
Viewpoint  (only available for Servers)
Target  (only available for Servers)
Settings  (only available for Servers)
Lens Shift  (only available for Servers)
Keystone  (not for Player STD + Player LT)
Softedge  (not for Player LT)
Render State
FX

In the Output layer  you can now also find an "Edit Warp Mesh" button. It either selects the Output
Mesh or creates a new one for you and enters the Mesh Editing mode .
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6.5.8.1  Matrix

With the matrix section you may use Pandoras Box to output the pixels RGB(W) or CMY color
information over Ethernet via the Art-Net protocol in addition to the normal DVI video output. This allows
you to sent color information to specific lamps or Art-Net based LED walls. More detailed information
can be found in the chapter "Matrix Patcher " as well.

Matrix

The Matrix field accepts either outdated csv files or the newer pbx files that are part of the project
already. Of course each Client in your PB network may be programed with different matrix files. In
addition they can be saved on the timeline and may change throughout the show.
Use the right-click menu in the Preview  to visualize the matrix files. If changes are needed, select the
matrix file in the Project tab and choose to edit it with the Matrix Patcher, alter the patch and update it in
real-time.
Please note, that effects dragged onto the output layer cannot be considered by the patch file, thus you
will not see output effects on your DMX panels.

Creating a matrix file

First of all, use the Matrix Patcher to define the entire pixel workspace that you want to use and patch
the fixtures to the DMX channels and subnet addresses. You can either make use of predefined fixture
within the library or create individual lamp/wall types and use them as templates for your custom matrix
design. You can use RGB or CMY mixing devices.
The topic Matrix Patcher  has further information and a patching guide .

The limitation regarding how many pixel data in form of Art-Net universes can be transferred is a question
of your network components and receiving devices. As a rule of thumb, we do not recommend to output
more than 60 universes per network.
Per default, Art-Net is set up as a broadcast protocol; nevertheless, using the Matrix Patcher, you have
the option to use the transfer rate of each transmitting and receiving device to its full capacity by sending
the pixel information more efficiently with the multi- or even unicast method.

There are certain network switches like the ones from ELC that support DMX lines and dedicated Art-Net
routing. If you need more information concerning these devices please contact your local ELC Dealer.
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6.5.8.2  Object

The object section allows controlling the overall opacity of the output, setting a 3D / Warping object or
patch file as well as adjusting its position, scale and rotation state.

Object Selection

The camera allows the selection of the same object as for the layers. The big difference is that the
overall rendering will now be displayed on the selected object depending on its texture mapping.
You may consider the use of an object with the camera as an image filter that is applied to the overall
rendering of each individual output.
This feature may be used as visual effect or to select specific objects that allow keystone correction on
any curved or non-planar screen. 

To assign an object to the output, drag and drop the resource from the project tab onto the designated
output. You may also highlight the target output by left-clicking on it and use the right-click command on
the resource in the project tab “assign to active device” or just double-click on the object file.

To remove the resource from the output, right-click in the layer tree on the object parameter and choose
“reset”.

To create a keystone object, we recommend creating it with the Warper  or another third party
software  (3D Studio Max or its freeware version GMAX). Once you have set up the object according
to your screen, you can export it to Pandoras Box and use it individually for each output.

For DMX control depending on the ID assignment in the Pandoras Box Master user interface, each layer
can access 255 folder and 255 file IDs of individual object files.
Object file selection set to 0% (000dec.) selects “no file”.
The object channels are 8bit, the default value is set to 0.

Object Folder

0 No folder

1..255 Folder 1..255

Object File

0 No file

1..255 File 1..255
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Opacity

The opacity sets the overall output brightness level as well as the overall audio level.
Opacity 0% black, no output / no sound
Opacity 100% full brightness / 1:1 sound level

DMX Control
Opacity

0..255 Fully transparent..Fully visible

Position, Rotation, Scale (Server only)

The 3D / Warping Object may be adjusted in its position and scale and may be rotated.
Please see the according chapters under Video Layer Control , as all outputs position, rotation and
scale parameters work the same way.

6.5.8.3  View POint

The view point (only available for Servers) allows changing the position from where the output (which can
be seen as a second camera that passes its result to the graphics card) looks at the camera texture.
The default position of the output (-camera) is at (XYZ = 0,0,-25).

Please note:
Typically the view point option will not be used in 99% of all cases. Advanced users only!
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6.5.8.4  Target

The target parameters (only available for Servers) allow changing the position of the target which the
output (that can be seen as a second camera that passes its result to the graphics card) is looking at.
When not changed, the target is the whole camera texture. 

Please note:
Typically the target positions will not be used in 99% of all cases. Advanced users only!

6.5.8.5  Settings

The Settings parameters are only available for Servers. Please refer to the topic "Settings " in the
Camera chapter.

Please note:
Typically the setting options will not be used in 99% of all cases. Advanced users only!
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6.5.8.6  Lens Shift

The Lens Shift parameters are only available for Servers. Please refer to the topic "Lens Shift " in the
Camera chapter.

Typically the lens shift option on the output will not be used in 99% of all cases. Advanced users only!

For softedge projections: 
Please use the Lens Shift  parameters on the camera control to adjust which part of the 3D space
each output will show!

6.5.8.7  Background Color

The Background Color section (only available for Servers) allows adjusting the red / green / blue / alpha
channels for the main background from the resulting backbuffer texture rendered by the graphic card.
More information about the backbuffer can be found in the chapter Video Processing Pipeline , a
possible application for adjusting the background color could be blacklevel compensation  when
working with multi-softedged projection(s). If you are not familiar how to use the color picker tool, please
read the topic "FX Parameter ".
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Please note: If you like to use the alpha fader, i.e. clear the backbuffer with the transparency channel,
you need to enable this feature first. This can be done either in the Configuration tab's  section called
Local Engine Settings  or, if working with a Client in its Inspector .

DMX Control 
All Background Color Channels are 8bit.

Red
The default value is set to 0

0...255 Red level, Color Picker

Green
The default value is set to 0

0...255 Green level, Color Picker

Blue
The default value is set to 0

0...255 Blue level, Color Picker

Alpha
The default value is set to 255

0...255 Alpha / transparency level

6.5.8.8  Keystone

The keystone function of the Pandoras Box Server and Player PRO is a powerful feature for planar
projection. 

It is designed in the way that it can be operated as standard beam shapers. Each output edge can be
moved in or out and rotated according to the projection surface. Please note that it is not possible to
keystone an image if an object is used as the object already deforms the camera texture.

Once you have set up each edge, you might compensate for the linearity distortion with the X&Y
Keystone parameters. To do this, use a raster grid test pattern on a layer and reset the image center
with the X&Y channels.  
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6.5.8.9  Softedge

Pandoras Box Servers and most Players feature a four sided image blending for any output configuration.
Softedge allows smooth image blending of multiple projectors.

Overlap

Traditionally, the overlap was an important information for anybody who wanted to create images for
softedge projection. The amount can still be important depending on the setup of your softedge.

The overlapping area is that part of the projection, where the projected images of two projectors share the
same image information to create a smooth image-blending from one projector to the other.

Due to the physical setup of the projectors - their light output and contrast - the overlapping has to be
adjusted carefully to match a seamless image.

Pandoras Box softedge feature allows a variable overlap between 0% and 100% of each image edge.

Each edge (left/right, top/bottom) has its own softedge gradient with an individual gradient curve control
for the light falloff of the projector.

Creating content for softedge projections

In general, for an optimum image quality, the best way is to create two parts of an image: a left part for
the left projector and a right part for the right projector. 

But if you would like to move a layer across the two projectors you will need to stretch the content and
use the same image for both projectors and match them by X&Y positioning on top of each other. 

It is also possible to use both methods in the same show, i.e. having overlapping content and stretched
content in the same timeline but different layers.

Softedge setup

After setting up the projectors properly (matching the raster, size and keystone) the overlapping edges
need to be blend together. The best way to do this is by using a test-pattern with text and positioning it
precisely on top of each other. Now you may bring the soft edges in and adjust the curves until there is
no more hotspot area.
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DMX Control
For each edge (left, right, top and bottom) you have the possibility to set up the following parameters:

Parameter 
(Alias
within GUI)

Name for external Control
(e.g. Widget Designer,
SDK)

Description Value
Range

Default

Left SE L Amount of softedge left 0-65535 0

L Curve SE LC Individual gradient curve 0-65535 32768

L Marker SE L Marker Marker for left softedge: 

0=no marker 

1 - 255 = black marker - white marker

0-255 0

L Width SE L Width Width of left marker 0-255 32

The parameters Left, L Alpha, L Marker and L Width and its values will be repeated for all other edges: 
Right (R), Top (T) and Bottom (B).

The values may be displayed in percentage read-out as well, see configuration tab ).
Please note: Softedge always affects the whole output and will be adjusted automatically according to
the keystone settings or the applied mesh. 

6.5.8.10  Render State

By default the State of the Output Control is set to “Render”. That means the output is working as a
second render path, all settings done in the output control will affect the camera result.

When the state is changed to “Bypass” all settings done in the output (like the object, keystone and
softedge) will be ignored to gain the highest rendering performance. This mode might be used in setups
where no keystone or screen warping is needed and highest image rendering quality is required.
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6.5.8.11  FX 

The new dynamic shader effects engine allows creating and combining an almost unlimited number of
effects. All effects and animations are automatically synchronized across the system network.

FX can be used on the output control device like on a video or graphic layer. The difference is that these
FX will influence the overall output instead of only the layer.

Example: It could be very helpful using color correction FX on the output to compensate color corruptions
of displays or projectors.

Please refer to the section FX  in the chapter Video Layer Control  for further information.

6.5.9  DMX Devices

All Pandoras Box Systems feature DMX device control. This is especially useful for synchronized control
of moving video projectors and the dynamic keystone correction of Pandoras Box. Furthermore it's used
for installations where DMX needs to be programmed in sync to the video playback.

On the one hand, it is possible to input DMX  and remote control layers by an external lighting desk.
On the other hand, Pandoras Box features DMX output  as well. This way you may include DMX
devices into the timeline and control them with parameter keys in the same way as controlling video
layers.
To input or output DMX you can either use the coolux DMX Link  or devices that convert the data to
ethernet, like the DMX Link 8  or others. 

Pandoras Box features both 8bit and 16 bit DMX parameters and supports the protocols DMX, Art-Net,
MA-Net and sACN.

As said above, to output DMX data to a device, it needs to be part of the timeline. As explained in the
following two chapters, you may choose your DMX device from the built-in device list  or create a
custom device  as XML file for DMX control.

6.5.9.1  Built-In DMX Devices

All Pandoras Box systems ship with a built-in DMX device list. You may access it in the Device Type tab
 and add your device to the Device Tree .

If your device is not included in the list, please read the following chapter about custom DMX devices .

The chapter about DMX output  explains how to patch a device, configure the output protocol and
finally, send data.
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6.5.9.2  Custom DMX Devices

As said in the previous chapter, all Pandoras Box systems ship with a built-in DMX device list . If your
device is not included in the list, you may create a custom file and add it to the Device Type tab  as
explained below. Afterwards, please follow the chapter about DMX output  that explain how to patch a
device, configure the output protocol and finally, send data.

A custom DMX library file can be created as a text file with WordPad. The file needs an extension called
“.clib” and needs to be stored in the installation folder of the Master under: “\data\types\DMX Fixtures”.

Please find here an example of a DMX .clib file for a Martin MAC500:
 <?xml encoding="yes" ?>
 <descripDevice type="fixtureDmx" artNetIndexScope="16">
 <descripModule type="param8bit" name="STROBE" default="34" artNetIndexOff="0" />
 <descripModule type="param8bit" name="DIM" default="0" artNetIndexOff="1" />
 <descripModule type="param8bit" name="COLOR1" default="0" artNetIndexOff="2" />
 <descripModule type="param8bit" name="COLOR2" default="0" artNetIndexOff="3" />
 <descripModule type="param8bit" name="GOBO1" default="0" artNetIndexOff="4" />
 <descripModule type="param8bit" name="GOBO1 ROT" default="0" artNetIndexOff="5" />
 <descripModule type="param8bit" name="GOBO2" default="0" artNetIndexOff="6" />
 <descripModule type="param8bit" name="FOCUS" default="50" artNetIndexOff="7" />
 <descripModule type="param8bit" name="IRIS" default="0" artNetIndexOff="8" />
 <descripModule type="param8bit" name="PRISMA1" default="0" artNetIndexOff="9" />
 <descripModule type="param16bit" name="PAN" default="32768" artNetIndexOff="10" />
 <descripModule type="param16bit" name="TILT" default="32768" artNetIndexOff="12" />
 <descripModule type="param8bit" name="SPEED1" default="0" artNetIndexOff="14" />
 <descripModule type="param8bit" name="SPEED2" default="0" artNetIndexOff="15" />
</descripDevice>

As you can see the first line gives the general device description and the overall DMX channel count
“artNetIndexScope=”. 
The following lines describe each DMX channel of the fixture by a zero based offset of the DMX channel
count at the end of each line by “artNetIndexOff=”.
You may also choose the type of parameters “param8bit” or “param16bit” as well as setting the
descriptive name and reset and default value. 

6.5.10  Serial Link Device

With the Serial Link device you may control most routing switchers, projectors, shutters or other device
parameters that are remote controllable via the common RS 232 and 422 serial protocols. Simply add
the serial command according to the device's syntax as a key to the timeline.

Even though, the device's name is Serial Link, you do not necessarily need the hardware device itself
. For more information on the connection to the Serial Link hardware, please read these chapters: Serial
Link input  and Serial Link output .

If you like to control another hardware, please see here an example regarding a projector: Output
Protocols > TCP/IP .
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6.5.11  Sonic Emotion

MULTI-CHANNEL AUDIO

The optional multichannel audio plug-in integrates up to 24 channels of synchronized audio. 

When using the Sonic Emotion stereo audio device please use only: Mono wav files at 48kHz, 16 bit.

With the Sonic Emotion 16CH device, mono wave files with 48 kHz, 16 bit can be uploaded and
synchronized to the Pandoras Box Timeline Playback. To access it, drag the device from the tab Device
Types into the tab Device Tree. The available controls are depicted below. If you like to interact with the
device whilst using a custom application (SDK ) or the Widget Designer, please refer to this
parameter list .

The audio can be interfaced with audio processors of our partner Sonic Emotion
(www.sonicemotion.com) that provide spatial placing through their patented Wave Field Synthesis.

6.5.12  Widget Designer Device

This topic explains how to add a Widget Designer Device to the Device tab allowing to: 
- program Widget Designer commands directly in timeline

1670
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- send (trigger or feedback) values from the timeline to Widget Designer
- send mouse and touch input events from an attached Client to Widget Designer

Widget Designer  is another coolux software product. One of the main purposes of Widget Designer is
to enable users who do not have any programming skills, to create their own custom applications or
interfaces. Widget Designer provides a graphical user interface and runtime environment. You can create
user-controls such as faders, buttons, labels and many more and instantly use them. The PRO version
allows to program visually with so called nodes. By simply connecting those visual control components
you may create a dedicated interaction logic. In addition WD has a built-in script language allowing you
to create customized routines of commands. For example, a command can be assigned to a button
click. Currently there are over 1000 commands that control specific features of Pandoras Box, Widget
Designer or other 3rd party products and protocols. There are topics explaining how to use commands

 and containing the entire command list .

If you like to execute commands at a defined time within the timeline you can simply add the Widget
Designer Device to the Device Tree tab and then program keys directly into the timeline, just as you
would add keys for a Video Layer's position for example. If you are not familiar with the timeline and key
programming, please read the topic "Sequence ".

The second purpose of a Widget Designer Device is to route mouse / touch input from the PB Master or
even PB Client to Widget Designer itself. This is described step-by-step in the Layer picking chapter of
the Preview . If you like to route this data to a Canvas asset in order to draw on it, the node "Layer UV
Draw to Canvas " is of interest. Its chapter includes a step-by-step description of all necesary settings
in WD and PB. You can also use the data to click on Custom Script Buttons  as described in its
chapter.

Please follow these steps to set up a Widget Designer Device:

First of all, start the Widget Designer 4.0 and enable
the connection to a Widget Designer Device in
Pandoras which we will set up in the next step.
To do so, right-click in the main window and choose
"Pandoras Box IP Configuration ". Then make
sure that the Domain (1)and IP address (2) under
"Pandoras Box Master Connection" matches with
the PC where Pandoras Box Manager or Player /
Server as Master is running on. In Pandoras Box,
the IP address is shown in the Assets tab, the
Domain in the Configuration tab.

Have a look in the section "Pandoras Box Widget
Device Connection" and enable the check box
"Enable Connections" (3). You can close the dialog.

As an example, please create a fader. Again, right-
click in the main window to call the main context
menu. Choose Create > Fader Controls > Fader
Vertical and make one left-click into the main
window. You have now created a fader with the
default settings: ID = 1, minimum value = 0 and
maximum value (also current value) = 255 .

So far, everything is set up in Widget Designer,
please switch to your Pandoras Box Master
software.
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After creating a project, you can add a WD devices
to it. For this, go to the "Device Types" tab >
"Widget Designer" > and drag the "Widget
Designer.clib" into the Device Tree tab.
As we have already set up the WD in the first step,
the device can connect successfully.

If you see a red exclamation mark in the symbol
within the Device Tree (as shown in the left image for
the Server device), check the IP address and
domain number (in the Configuration tab). If the
Widget Designer runs on a different PC, the Widget
Designer device must be set to the according IP
address. Select the Widget Designer device in the
Device tab and edit the text field "IP" within the
Inspector tab.

To send commands from the timeline double-click
"Widget Designer" in the Device tab, and then
"Script" as well. You should see the parameter
"Command" whereto we will now program a key. 

Make a right-click into the timeline at the height of
the command parameter, as seen in the left image.

To assign a command to this key select it and
switch to the Inspector tab.
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In the key's Inspector, choose a command from the
drop-down list and paste it into the text field by
pressing Add. Mostly, a command consists of
several arguments separated by a comma - the first
one always describes the command function the
following ones are variables. Substitute them with
according values.

Let's say, we want the fader created in Widget
Designer in the very first step to lower its value by
50 steps.

The command to add is:
WDFaderGoDown,ID,Value.
As the ID is 1 and the value to deduct is 50, the
customized command in the text field should be:
WDFaderGoDown,1,50

As soon as the nowpointer in the timeline passes
the key, the command is executed and the fader will
go down 50 steps.

If you like to execute more than one command
press carriage return and add another one. There is
the possibility to work with functions and macros
as well.

More advanced users who have a Widget Designer
PRO version may use another feature that allows to
send (trigger) values to WD.

- in the Device Types tab open the Widget Designer
folder and drag "Values.clib" onto the Widget
Designer site in the Device Tree tab. Now the WD
site offers one script device with the command
parameter and a new values device with eight value
parameters (each with a value range from -999.999
to +999.999)

- program keys either by right-clicking in the timeline
as described in the example above. Or, you switch
over to the Device Control tab and then store active
values

- in Widget Designer, press Alt+N to create a node
: Nodes > Input > Pandoras Box > Widget

Device in order to retrieve the values and send them
to filter nodes or directly to output nodes

- in the node's Item Properties dialog, adjust the IP
address, the site and device ID. Following the
example above, the site ID is 3 and the device ID
refers to the newly generated value device, in this
case number 2
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6.5.13  Blacklevel Compensation

Blacklevel compensation is only available on Pandoras Box Servers.

For blacklevel compensation layers are needed that are not included in the first render pass, the
composition pass (the render passes are explained in the topic Video Processing Pipeline  ). To
exclude a layer from the composition pass, check the radio button "Output" in the layer's Inspector .
This layer is now not affected by the output settings in regards to warp object, keystone and softedge
settings.

Use the layer with effects  that suit your need (area-coloring or black lifting colors), e.g Gradient  or
Shapes  FX. There are effects available, e.g. triangle and square gradients / shapes, to set up a
geometry that matches exactly the shape needed. The different overlapping types are depicted in the
above image. In addition, the shapes can be adjusted with different colors per corner. This is important
when working with projectors that show a gradient due to lens errors or worn out lamps.

It is possible too, to adjust the backgrounds RGB values in the camera  and output  layer.
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6.5.14  Spark

for WINDOWS XP (Microsoft .Net 2 Runtime must be installed)

PB Spark is designed to be connected to any Pandoras Box timeline as a Serial Link  TCP IP device.

PB Spark can be used for remote controlling applications, mouse and keyboard actions as well as
displaying full-screen video playback and web page presentations among many other useful remote
control features.

Pandoras Box Spark is available from the coolux website as freeware download www.coolux.de.

To get started, install PB Spark on the desired PC that you want to control (Spark can be accessed also
on the same machine that runs Pandoras Box)

Important Notice: Please switch off any firewall on all connected systems before using this application!

PB SPARK SETUP

Launch PB Spark. 
Since PB Spark acts as a TCP IP server that will wait for a Pandoras Box connection you will need to
specify the TCP/IP port that Spark should use to listen to incoming commands. 
Set the TCP/IP port (any number between 1 and 9999) you want to listen to in PB Spark.
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To start the TCP/IP server click "connect", PB Spark will now wait for a connection to be established.
 

PANDORAS BOX SETUP

Go to Pandoras Box Manager or Server/Player Standalone Software. 
First add a Serial Link device from the Device Tab to the Device Control Tree. 
Open the tree icon and click on the Serial Link Device to view its properties in the Inspector Tab.
Uncheck the check box "Use Serial Link Header" as this option is only for use with Serial Link devices.
Enter the IP address of the computer that PB Spark is running on as well as the Port number entered in
PB Spark.
Click on "Apply IP and Port".

Tip: PB Spark displays its local IP address in the bottom left corner.

The red "!" in the device tree should disappear once the connection is established and the connection
icon in PB SPARK should turn to green.
Now you may start implementing commands as keys in the timeline for the COM parameter.

 Spark will give you the following TCP messages as feedback:
on success (SparkProc,"Original Message",Processed)
on fail (SparkProc,"Original Message",ProcessError)
on syntax error (SparkProc,"Original Message",SyntaxError)

COMMAND LIST

The following commands are all in ASCII format and need to be put in parentheses ()

Remote control features offer by PB Spark:

PB REMOTE SERVER CONTROL
COMPORT ASCII COMMUNICATION
SYSTEM COMMANDS
WEB BROWSER (Fullscreen)
SOUND COMMANDS
VIDEO PLAYER (Fullscreen)
APPLICATION COMMANDS
KEYBOARD EVENTS
MOUSE EVENTS
DESKTOP FADE TO BLACK -BETA
WAKE ON LAN
PB AUTOMATION REMOTE CONTROL
 

COMMAND DESCRIPTION

PB REMOTE SERVER CONTROLS 
compatible with Pandoras Box Menu Rev7 and later 

(PBShutdownAll) - Shuts down All Pandoras Box Servers on the network 
(PBRebootAll) - Reboots All Pandoras Box Servers on the network 
(PBShutdown,IP Address) - Shutdown Pandoras Box Server by IP Address 
(PBReboot,IP Address) - Reboot Pandoras Box Server by IP Address 
(PBStartMaster,IP Address) - Start Pandoras Box Server / Master by IP Address 
(PBStartClient,IP Address) - Start Pandoras Box Client by IP Address 
(PBClose,IP Address) - Close Pandoras Box Server / Master or Client by IP Address 
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UDP Sender allows sending broadcast ASCII messages 
UDPSend,Port,Message
 

COMPORT ASCII COMMUNICATION

(Serial,Settings,"Portname","Baudrate","Parity","Databits","Stopbits","Flowcontrol")

   ex: (Serial,Settings,Com12,9600,None,8,1,None) 
   Valid Parameters:
   Portname: Com1 - Com 255
   Baudrate: 110 / 300 / 1200 / 2400 / 4800 / 9600 / 19200 / 38400 / 57600 / 115200 / 230400 / 460800 /
921600
   Parity: "Even"/ "Odd" / "None" / "Mark" / "Space"
   Databits: 5 / 6 / 7 / 8
   Stopbits: 1 / 1.5 / 2
   Flowcontrol: "None" / "Xon/Xoff"

(Serial,Connect,"Portname")
(Serial,Send,"Message")

(Serial,SendHex,"Message") 
example: (Serial,SendHex,41 42 43) 
This hex values should send ABC as hex

(Serial,Disconnect)
 

SYSTEM COMMANDS

(System,Logoff)  - logoff current user
(System,Shutdown) -  shut down the system
(System,Reboot)  - reboot the system
 

WEB BROWSER (Fullscreen)

(Browser,Open)  - starts web browser
(Browser,Go,www.coolux.de) -  navigate in an open web browser to www.coolux.de 
(Browser,Close)
 

SOUND COMMANDS

(Sound,Play,C:\myaudio.wav)  - plays the file myaudio.wav located in C:\
(Sound,Volume,50) - sets system volume to 50%, valid range is 0 to 100%
(Sound,Mute,On)  - disables the system sound output
(Sound,Mute,Off)  - enables the system sound output
 

VIDEO PLAYER (Fullscreen)

(Video,Load,C:\myvideo.avi) - open & loads video player with myvideo.avi located in C:\ - to play video
use (Video,Play)
(Video,Playfile,C:\myvideo.avi) - open & plays video player with myvideo.avi located in C:\ 
(Video,Play) -plays video from current position
(Video,Pause) - pause video at current position

http://www.coolux.de
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(Video,Stop) - stop video show 
(Video,Close) - close video player
 

APPLICATION COMMANDS

(Application,Start,C:\notepad.exe) - starts C:\notepad.exe
(Application,StartFile,C:\notepad.exe,C:\mytext.txt) - starts notepad with mytext.txt
(Application,FileOpen,C:\myvideo.avi) - opens file with registered application, in this case windows media
player
(Application,Stop,notepad.exe) - based on the process name in the windows taskmanager the specified
process will be terminated
 

KEYBOARD EVENTS

(Keycode,A) - will generate a keystroke for the letter "A" 
Access special Keys:
use "~" to send  "Enter"

The keys argument can specify any single key or any key combined with ALT, CTRL, or SHIFT (or any
combination of those keys). Each key is represented by one or more characters, such as a for the
character "a", or {ENTER} for the ENTER key. 

  To combine a key with SHIFT, precede the key code with + (plus sign). 
  To combine a key with CTRL, precede the key code with  ̂(caret). 
  To combine a key with ALT, precede the key code with % (percent sign). 

  To specify repeating keys, use the form {key number}. You must put a space between key and
number. For example, {LEFT 42} means "press the LEFT ARROW key 42 times"; {h 10} means "press
'h' 10 times." 

  The following table lists the codes that can be used to specify characters that are not displayed when
you press the corresponding key (such as ENTER or TAB). 

BACKSPACE  {BACKSPACE} or {BS}, BREAK  {BREAK}, CAPS LOCK {CAPSLOCK}, CLEAR 
{CLEAR}, DELETE {DELETE} or {DEL}, DOWN ARROW {DOWN}, END  {END}, ENTER (numeric
keypad)  {ENTER}, ENTER  ~, ESC  {ESCAPE} or {ESC}, HELP {HELP}, HOME  {HOME}, INS 
{INSERT}, LEFT ARROW {LEFT}, NUM LOCK  {NUMLOCK}, PAGE DOWN {PGDN}, PAGE UP 
{PGUP}, RETURN  {RETURN}, RIGHT ARROW {RIGHT}, SCROLL LOCK {SCROLLLOCK}, TAB  {TAB},
UP ARROW {UP}, F1 through F15 {F1} through {F15}.
 

MOUSE EVENTS

Screen coordinates are handled as percentage of primary screen
x coordinate is 0 to 100.00 left to right
y coordinate is 0 to 100.00 bottom to top

(Mouse,Move,x as Percent,y as Percent) will move the mouse to xy screen coordinate
(Mouse,LeftClick, x as Percent, y as Percent) will perform a left click at specific screen coordinate
(Mouse,RightClick,x as Percent, y as Percent) will perform a right click at specific screen coordinate
(Mouse,MiddleClick, x as Percent, y as Percent) will perform a mouse middle click at specific screen
coordinate
(Mouse,LeftClick) will perform a left click at current screen coordinate
(Mouse,RightClick) will perform a right click at current screen coordinate
(Mouse,MiddleClick) will perform a mouse middle click at current screen coordinate
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DESKTOP FADE TO BLACK -BETA

(FadeToBlack,Out,1.5) fades out to black in 1.5 sec (timing may not be 100% accurate, based on
systems performance)
(FadeToBlack,In,4.7) fades in from black in 4.7 sec (timing may not be 100% accurate, based on
systems performance)
 

WAKE ON LAN

(WakeOnLan,Macadress) - wakes up a target computer with its matching MacAdress 
Make sure the Ethernet Card accepts WakeOnLan with Magic Packet
 

PB AUTOMATION REMOTE CONTROL 

Please note: 
The following commands are only valid for PB Spark Rev. 16 or higher!
Old syntax (up to Spark Rev. 12) is still valid (see here ).

(PBA,Connect,IP_Adress,Domain)
(PBA,Disconnect)

(PBA,DeviceSetParam,SiteID,DeviceID,ParamName,AbsoluteValue)
(PBA,DeviceSetParamRelative,SiteID,DeviceID,ParamName,RelativeValue)
(PBA,DeviceSetMedia,SiteID,DeviceID,FolderID,FileID)
(PBA,DeviceSetMesh,SiteID,DeviceID,FolderID,FileID)

(PBA,ActivateAll)
(PBA,ActivateSite,SiteID)
(PBA,ActivateDevice,SiteID,DeviceID)
(PBA,ActivateParam,SiteID,DeviceID,ParamName)

(PBA,ClearAllActive)
(PBA,ClearActiveSite,SiteID)
(PBA,ClearActiveDevice,SiteID,DeviceID)
(PBA,ClearActiveParam,SiteID,DeviceID,ParamName)

(PBA,ResetAll)
(PBA,ResetSite,SiteID)
(PBA,ResetDevice,SiteID,DeviceID)
(PBA,ResetParam,SiteID,DeviceID,Opacity)

(PBA,SeqSetTimecode,SeqID,Hours,Minutes,Seconds,Frames)
(PBA,SeqGotoCue,SeqID,CueID)
(PBA,SeqNextCue,SeqID)
(PBA,SeqLastCue,SeqID)
(PBA,SeqNextFrame,SeqID)
(PBA,SeqLastFrame,SeqID)
(PBA,SeqSetState,SeqID,State) - States: Play, Pause or Stop

(PBA,SeqStoreActive,SeqID)
(PBA,SeqStoreActiveToTime,SeqID,Hours,Minutes,Seconds,Frames)

(PBA,ResourceSetText,FolderID,FileID,Text)

(PBA,ResourceAdd,Path,SiteID,FolderID,FileID)
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(PBA,ResourceSpreadAll)
(PBA,ResourceSpreadMedia,FolderID,FileID)
(PBA,ResourceSpreadMesh,FolderID,FileID)

(PBA,ResourceSetFrameBlending,FolderID,FileID,State) - State: True or False
(PBA,ResourceSetDeinterlacing,FolderID,FileID,State) - State: 1,2,3,4 - according to De-Interlace
Combobox in PB File Inspector
(PBA,ResourceSetAnisotropicFiltering,FolderID,FileID,State) - State: True or False
(PBA,ResourceSetUnderscan,FolderID,FileID,State) - State: True or False
(PBA,ResourceSetMpegColourSpace,FolderID,FileID,State) - State: True or False
(PBA,ResourceSetAlphaChannel,FolderID,FileID,State) - State: True or False

(PBA,ResourceRemoveInconsistent)
(PBA,ResourceRemoveMedia,FolderID,FileID)
(PBA,ResourceRemoveMesh,FolderID,FileID)

(PBA,ToggleFullScreen,SiteID)

OLD SYNTAX FOR PB AUTOMATION REMOTE CONTROL  (up to Rev. 12):

(PBA,Connect, "IP_Adress", "Domain")

(PBA,Disconnect)

(PBA,SetParam,"NodeID","DeviceID","ParamName","Value")

(PBA,SetMedia,"NodeID","DeviceID","DMX_Folder_ID","DMX_File_ID")

(PBA,SetMesh,"NodeID","DeviceID","DMX_Folder_ID","DMX_File_ID")

(PBA,SetCue,"SeqID","CUE_ID")

(PBA,SetSeq,"SeqID","Mode") - Mode "Play","Pause", "Stop")

(PBA,SetTime,"SeqID",Hours,Minutes,Seconds,Frames)

(PBA,NextFrame,"SeqID")

(PBA,LastFrame,"SeqID")

(PBA,NextCue,"SeqID")

(PBA,LastCue,"SeqID")

(PBA,SeqLevel,"Value")

 

UDP COMMUNICATION - 
Send messages to ports 

(UDPSend,Port,Message)
 

PB Server V4 Control 
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(PBShutdownAll) 
(PBRebootAll) 
(PBShutdown,IP) 
(PBReboot,IP) 
(PBStartMaster,IP) 
(PBStartClient,IP) 
(PBClose,IP)
 

CHANGELOG

Rev 12 
- HTTP Querystring listener built-in. 
This means you can use a webbrowser or link to send commands as well ex: 
http://192.168.0.141/?(Commandstring)
- Comport Input Support 
- All Inputs TCP/UDP/HTTP/COM can send input messages asynchronously 
- multiple commands can be send in one message 

Rev7 
- UDP Send and Receive Support 
- PB Server Network Controls, for application commands and system shutdown 
- General Code Cleanup Rev6 - support for broken packets, AMX related fix 
- Autoconnect as Start option 
- TCP connection close optimization 
- PB Spark will always send a null character upon null receive 
- Revision ID shown GUI 
- New Feature Comport Send Hex-codes 

v1.0.0.9 
- PBAutomation v4 commands added

v1.0.0.8
- New Feature Application Stop to terminate running programs and processes

v1.0.0.7
- New Feature Remote PB Automation Support
- Help page display

v1.0.0.6
- New Feature Fullscreen video player
- New Feature Com Port ASCII communication
- fixed pending Network Process on closing application
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6.6  External Control (DMX,Midi,...)

Pandoras Box offers many ways to use various industry standard control protocols.

You may want to remote control lighting or sound or interact with media through contact closures or
sensors.

With Pandoras Box Spark, even Windows PC applications can be controlled and triggered at the right
cue of the show.

Currently supported protocols are:
TCP/IP, RS232/422, SMPTE, MIDI, MSC, Art-Net, MA-NET, DMX and CITP.

Please find in the following topics the detailed information regarding:

Input Protocols Output Protocols

DMX Tables
(Patch Sheets for all products)

DMX Input DMX Output

MIDI

MSC (MIDI Show Control)

Serial Link Serial Link

SMPTE Input SMPTE Output

Spark

TCP / IP TCP / IP

UDP - PB Automation and SDK

6.6.1  Input Protocols

Pandoras Box aims to support a wide range of various input control sources.

Since Pandoras Box can be used in many different configurations and applications, you may choose
from several available control protocols to remote control or interact with the system. 

6.6.1.1  DMX Input

DMX input can be used in many different ways with Pandoras Box products. Since the entire system is
mainly network based, coolux is continuing to integrate all available network-protocols to allow
interfacing with modern lighting systems.
DMX input is mainly designed to remote control individual sequences, layers and output settings of your
Pandoras Box system via an external DMX device, e.g. a lighting desk. 
If you, on the other hand, are interested in controlling DMX devices with Pandoras Box itself, please read
the topic covering the DMX Output .
For any DMX input the following settings need to be done.

1 - Connection
Connect the Master system to the remote system. In general only the Master (Pandoras Box Manager,
Server or Player) needs to be connected as it controls its Clients. In other words, it is not necessary to
connect the Client with the remote device.

2 - Patch
In case you like to remote control a sequence, select the according sequence in the Project tab  and
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open the Patch tab . Enter the channel, subnet and universe. The patch must accord to the patch in
the remote device. Please load a fixture or see the DMX tables  for more information.
In case of remote controlling layers from the Master itself, select the Master in the Device Tree tab
and patch it.
In case of remote controlling layers from Clients, drag the Client from the Asset tab  or Device Types
tab  into the Device Tree tab first. Select the Client node and patch it. 

3 - Configuration
Activate the DMX input in the Configuration tab  in the section Remote Control Protocols . You can
choose a dedicated network adapter.

As soon as data is sent to the Master system, all patched layers or sequence parameters are remote
controlled.

If you like to work with media files, i.e. assign it to a layer, it needs to have a so called File and Folder
ID. This can be assigned in the File Inspector  as well as Folder Inspector . Pandoras Box supports
a CITP based thumbnail exchange.

MA-Net

To interface with GrandMA lighting consoles, please enable the MA-Net in the Configuration tab .
Please note that MA-Net supports up to 64 DMX universes in MA-Net Series 1 and up to 256 DMX
universes in MA-Net Series 2.

Art-Net

As one of the most popular Ethernet protocols, Art-Net can be used to control multiple units with
multiple DMX universes via a single Ethernet network.
To use Art-Net please connect your lighting system that is Art-Net enabled and make sure that both
lighting control and Pandoras Box system are in the same IP address range.

The first Art-Net specification demands a 2.xxx.xxx.xxx IP address, the most common used subnet
mask is 255.0.0.0 . Pandoras Box is still tied to this specification when working with DMX fixtures (i.e.
sending Art-Net data). If you are working witch matrix patches , you may address a different IP range
there. Since version 5.3 the IP address does not necessarily need to be in the 2.x.x.x range to be able
to receive Art-Net.

To enable Art-Net within a Pandoras Box Master system, please activate the Art-Net Mode in the 
Configuration tab .

DMX Link In

DMX input via USB is supplied by the DMX Link USB interface cable . To enable it, press the input
button "DMX via USB" in the Configuration tab .
Please be aware that a single USB DMX interface will allow you to control a maximum of 512 DMX
channels on subnet 0 and universe 0.

DMX Link 8

The DMX link 8 converts up to 10 DMX universes to Ethernet (Art-Net protocol). Backwards, 8 DMX
universes can be converted from Art-Net to DMX.
Please see the DMX Link 8 Device Manual  for further information.

Streaming ACN

In the Configuration tab, click the button "Run sACN" if you want to control Pandoras Box via Streaming
ACN (sACN).
Please note that Streaming CAN does not use Universe 0, so do not patch below Universe 1.

224

647

169

138

182

140 148

191 194

140

787

140

765

140

766



647

6.6.1.1.1  DMX Tables

All Pandoras Box Products are designed to be fully controlled via DMX or Art-Net from any DMX Lighting
Controller. The general workflow how to work with DMX Input is described in the previous chapter .

In this section you will find all necessary information about the individual DMX fixture libraries for Layers,
Cameras, Outputs and Sequences.
Please note that there are different libraries for Server, Player and Manager Products.

DMX Table PB Manager
DMX Table Sequence Control
DMX Table PB Server
DMX Table PB Player

6.6.1.1.1.1  DMX Table PB Manager
Pandoras Box Media Manager

PB Audio Track (11 Ch)

DMX Ch Parameter Values Meaning default

1 Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

2 Media 8 Bit 0 no Media 0

1..255 File 1..255

3 Video Control 8 Bit 0 Stop 192

64 Play Once

128 Pause

192 Play Loop

4 Volume 16 Bit 0 no Audio -96db 0

32768 0db

46300 3dB

65535 full Audio

6 Inpoint 16 Bit 0 File Beginning 0

65535 End of File

8 Outpoint 16 Bit 0 File Beginning 65535

65535 End of File

10 Pan 16 Bit 0 Left Ch only 32768

32768 Center - L+R Ch

65535 Right Ch only

6.6.1.1.1.2  DMX Table Sequence Control
PB Sequence (5 Ch)

DMX Ch Parameter Values Meaning default

1 Opacity 8 Bit 0 OFF 255

1.254

255 ON

2 Transport Control 8 Bit 0 Pause 0

128 Play

255 Stop

3 Cue 8 Bit 0 no Cue 0

1..255 select Cue by Cue ID

4 Frame 16 Bit 0 Set Nowpointer to Frame Pos 0

65535
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6.6.1.1.1.3  DMX Table PB Server

 

Server Video Layer

Lighting Manager

97 CH 53 CH

Parameter Values Meaning default

1 1 Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

2 2 Media 8 Bit 0 no Media 0

1..255 File 1..255

3 3 Obj Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

4 4 Obj Media 8 Bit 0 no Object 0

1..255 File 1..255

5 5 Opacity 8 Bit 0..255 0

Playback

6 6 Video Control 8 Bit 0 Stop 192

64 Play Once

128 Pause

192 Play Loop

7 7 Speed 8 Bit 0..127 10% to 100% 128

128 1:1 Speed (100%)

129..255 100% to 500%

8 8 Inpoint 16 Bit 0 File Beginning 0

65535 End of File

10 10 Outpoint 16 Bit 0 File Beginning 65535

65535 End of File

Audio

12 12 Volume 16 Bit 0

Position

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

14 14 X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

16 16 Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

18 18 Z Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Rotation

Note Resolution: 1 DMX Step = 0.033°

20 20 X Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

22 22 Y Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

24 24 Z Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

Note Mode Channel deside between Angle and Speed

26 26 X Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

27 27 Y Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

28 28 Z Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

Note Resolution: 1 DMX Step = 1 Rotation per hour

29 29 X Speed 16 Bit 0 32768

32768 Stop

65535

31 31 Y Speed 16 Bit 0 32768

32768 Stop

65535

33 33 Z Speed 16 Bit 0 32768

32768 Stop

65535
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Server Video Layer

Lighting Manager

97 CH 53 CH

Scale

Note Resolution: 1 DMX Step = 0.001 Unit

Scale 0.5 = half size

Scale 2.0 = double size

35 35 X Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

37 37 Y Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

39 39 Z Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

Rotation Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

41 X Rot Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

43 Y Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

45 Z Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Scale Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

47 X Scale Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

49 Y Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

51 Z Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Blend Mode

Note: Details on Blend Mode see Helpfile

53 Blend Mode 8 Bit 0 Normal 0

1..255 Blend Mode

Effekts

Note: All MultiFX have 9 16Bit Parameter Ch.. Not all Parameters are used for all FX

For Detailed Information on each FX have a look at the Helpfile

41 FX1 Selection 8 Bit 0 no FX 0

1..255 FX Id

42 FX 1.1 16 Bit 0..65535 Parameter 1 32768

44 FX 1.2 16 Bit 0..65535 Parameter 2 32768

46 FX 1.3 16 Bit 0..65535 Parameter 3 32768

48 FX 1.4 16 Bit 0..65535 Parameter 4 32768

50 FX 1.5 16 Bit 0..65535 Parameter 5 32768

52 FX 1.6 16 Bit 0..65535 Parameter 6 32768

54 FX 1.7 16 Bit 0..65535 Parameter 7 32768

56 FX 1.8 16 Bit 0..65535 Parameter 8 32768

58 FX 1.9 16 Bit 0..65535 Parameter 9 32768

60 FX2 Selection 8 Bit 0 no FX 0

1..255 FX Id

61 FX 2.1 16 Bit 0..65535 Parameter 1 32768

63 FX 2.2 16 Bit 0..65535 Parameter 2 32768

65 FX 2.3 16 Bit 0..65535 Parameter 3 32768

67 FX 2.4 16 Bit 0..65535 Parameter 4 32768

69 FX 2.5 16 Bit 0..65535 Parameter 5 32768

71 FX 2.6 16 Bit 0..65535 Parameter 6 32768

73 FX 2.7 16 Bit 0..65535 Parameter 7 32768

75 FX 2.8 16 Bit 0..65535 Parameter 8 32768

77 FX 2.9 16 Bit 0..65535 Parameter 9 32768

79 FX 3 Selection 8 Bit 0 no FX 0

1..255 FX Id

80 FX 3.1 16 Bit 0..65535 Parameter 1 32768

82 FX 3.2 16 Bit 0..65535 Parameter 2 32768

84 FX 3.3 16 Bit 0..65535 Parameter 3 32768

86 FX 3.4 16 Bit 0..65535 Parameter 4 32768

88 FX 3.5 16 Bit 0..65535 Parameter 5 32768

90 FX 3.6 16 Bit 0..65535 Parameter 6 32768

92 FX 3.7 16 Bit 0..65535 Parameter 7 32768

94 FX 3.8 16 Bit 0..65535 Parameter 8 32768

96 FX 3.9 16 Bit 0..65535 Parameter 9 32768
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Server Graphic Layer

Lighting Manager

91 CH 46CH

Parameter Values Meaning default

1 1 Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

2 2 Media 8 Bit 0 no Media 0

1..255 File 1..255

3 3 Obj Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

4 4 Obj Media 8 Bit 0 no Object 0

1..255 File 1..255

5 5 Opacity 8 Bit 0..255 0

6 6 Frame 16 Bit 0 1st Frame 0

65535 Last Frame

Position

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

8 8 X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

10 10 Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

12 12 Z Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Rotation

Note Resolution: 1 DMX Step = 0.033°

14 14 X Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

16 16 Y Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

18 18 Z Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

Note Mode Channel deside between Angle and Speed

20 20 X Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

21 21 Y Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

22 22 Z Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

Note Resolution: 1 DMX Step = 1 Rotation per hour

23 23 X Speed 16 Bit 0 32768

32768 Stop

65535

25 25 Y Speed 16 Bit 0 32768

32768 Stop

65535

27 27 Z Speed 16 Bit 0 32768

32768 Stop

65535
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Server Graphic Layer

Lighting Manager

91 CH 46CH

Scale

Note Resolution: 1 DMX Step = 0.001 Unit

Scale 0.5 = half size

Scale 2.0 = double size

29 29 X Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

31 31 Y Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

33 33 Z Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

Rotation Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

35 X Rot Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

37 Y Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

39 Z Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Scale Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

41 X Scale Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +250.000 units or 16 Screenwidth to the right

43 Y Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

45 Z Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Effekts

Note: All MultiFX have 9 16Bit Parameter Ch.. Not all Parameters are used for all FX

For Detailed Information on each FX have a look at the Helpfile

35 FX1 Selection 8 Bit 0 no FX 0

1..255 FX Id

36 FX 1.1 16 Bit 0..65535 Parameter 1 32768

38 FX 1.2 16 Bit 0..65535 Parameter 2 32768

40 FX 1.3 16 Bit 0..65535 Parameter 3 32768

42 FX 1.4 16 Bit 0..65535 Parameter 4 32768

44 FX 1.5 16 Bit 0..65535 Parameter 5 32768

46 FX 1.6 16 Bit 0..65535 Parameter 6 32768

48 FX 1.7 16 Bit 0..65535 Parameter 7 32768

50 FX 1.8 16 Bit 0..65535 Parameter 8 32768

52 FX 1.9 16 Bit 0..65535 Parameter 9 32768

54 FX2 Selection 8 Bit 0 no FX 0

1..255 FX Id

55 FX 2.1 16 Bit 0..65535 Parameter 1 32768

57 FX 2.2 16 Bit 0..65535 Parameter 2 32768

59 FX 2.3 16 Bit 0..65535 Parameter 3 32768

61 FX 2.4 16 Bit 0..65535 Parameter 4 32768

63 FX 2.5 16 Bit 0..65535 Parameter 5 32768

65 FX 2.6 16 Bit 0..65535 Parameter 6 32768

67 FX 2.7 16 Bit 0..65535 Parameter 7 32768

69 FX 2.8 16 Bit 0..65535 Parameter 8 32768

71 FX 2.9 16 Bit 0..65535 Parameter 9 32768

73 FX 3 Selection 8 Bit 0 no FX 0

1..255 FX Id

74 FX 3.1 16 Bit 0..65535 Parameter 1 32768

76 FX 3.2 16 Bit 0..65535 Parameter 2 32768

78 FX 3.3 16 Bit 0..65535 Parameter 3 32768

80 FX 3.4 16 Bit 0..65535 Parameter 4 32768

82 FX 3.5 16 Bit 0..65535 Parameter 5 32768

84 FX 3.6 16 Bit 0..65535 Parameter 6 32768

86 FX 3.7 16 Bit 0..65535 Parameter 7 32768

88 FX 3.8 16 Bit 0..65535 Parameter 8 32768

90 FX 3.9 16 Bit 0..65535 Parameter 9 32768
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Server Camera Device

Lighting Manager

23 CH 27 CH

Parameter Values Meaning default

1 1 Mode 8 Bit 0 Perspective 0

1 Orthogonal

Viewpoint Position

Note: Z Pos needs to be at -25.000 as Default!

The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

2 2 X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

4 4 Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

6 6 Z Pos 16 Bit 0  -256.000 units 29568

32768 Center

65535  +256.000 units

Target Position

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

8 8 Traget X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

10 10 Target Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

12 12 Target Z Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Settings

14 14 FOV 16 Bit 0 0.001 17745

17745 35.489

65535 131.070

16 Near Plane 16 Bit 0..65535 5

18 Far Plane 16 Bit 0..65535 50000

16 20 Aspect Ratio 16 Bit 0 0.000 10924

10924 1.000

32768 3.000

65535 6.000

Lens Shift

18 22 X Offset 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

20 24 Y Offset 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

22 26 Z Roll 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°
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Server Output

Lighting Manager

124 CH 113 CH

DMX Ch Parameter Values Meaning default

1 1 Bypass 8 Bit 0 0

1..255

Object

2 2 Obj Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

3 3 Obj Media 8 Bit 0 no Object 0

1..255 File 1..255

4 4 Opacity 8 Bit 0..255 255

Position

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

5 5 X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

7 7 Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

9 9 Z Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Rotation

Note Resolution: 1 DMX Step = 0.033°

11 11 X Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

13 13 Y Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

15 15 Z Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

Note Mode Channel deside between 

17 17 X Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

18 18 Y Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

19 19 Z Rot Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

Note Resolution: 1 DMX Step = 1 Rotation per hour

20 20 X Speed 16 Bit 0 32768

32768 Stop

65535

22 22 Y Speed 16 Bit 0 32768

32768 Stop

65535

24 24 Z Speed 16 Bit 0 32768

32768 Stop

65535

Scale

Note Resolution: 1 DMX Step = 0.001 Unit

Scale 0.5 = half size

Scale 2.0 = double size

26 26 X Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

28 28 Y Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

30 30 Z Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535
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Server Output

Lighting Manager

124 CH 113 CH

Rotation Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

32 X Rot Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

34 Y Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

36 Z Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Scale Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

38 X Scale Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +250.000 units or 16 Screenwidth to the right

40 Y Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

42 Z Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Viewpoint Position

Note: Z Pos needs to be at -25.000 as Default!

The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

44 X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

46 Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

48 Z Pos 16 Bit 0  -256.000 units 29568

32768 Center

65535  +256.000 units

Target Position

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

50 Traget X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

52 Target Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

54 Target Z Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Settings

56 FOV 16 Bit 0 0.001 17745

17745 35.489

65535 131.070

58 Near Plane 16 Bit 0..65535 5

60 Far Plane 16 Bit 0..65535 50000

62 Aspect Ratio 16 Bit 0 0.000 10924

10924 1.000

32768 3.000

65535 6.000

Lens Shift

64 X Offset 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

66 Y Offset 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

68 Z Roll 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°
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Server Output

Lighting Manager

124 CH 113 CH

Keystone

32 70 Keystone L 16 Bit 0..65535 32768

34 72 Keystone L Pos 16 Bit 0..65535 32768

36 74 Keystone R 16 Bit 0..65535 32768

38 76 Keystone R Pos 16 Bit 0..65535 32768

40 78 Keystone T 16 Bit 0..65535 32768

42 80 Keystone T Pos 16 Bit 0..65535 32768

44 82 Keystone B 16 Bit 0..65535 32768

46 84 Keystone B Pos 16 Bit 0..65535 32768

48 86 Linearity X 16 Bit 0..65535 32768

50 88 Linearity Y 16 Bit 0..65535 32768

Softedge

52 90 Softedge Left 16 Bit 0..65535 0

54 92 Softedge Left Curve 16 Bit 0..65535 32768

94 Softedge Left Marker 8 Bit 0 no marker 0

1..255 black to white marker

95 Softedge Left Maker Width 8 Bit 0..255 32

56 96 Softedge Right 16 Bit 0..65535 0

58 98 Softedge Right Curve 16 Bit 0..65535 32768

100 Softedge Right Marker 8 Bit 0 no marker 0

1..255 black to white marker

101 Softedge Right Maker Width 8 Bit 0..255 32

60 102 Softedge Top 16 Bit 0..65535 0

62 104 Softedge Top Curve 16 Bit 0..65535 32768

106 Softedge Top Marker 8 Bit 0 no marker 0

1..255 black to white marker

107 Softedge Left Top Width 8 Bit 0..255 32

64 108 Softedge Bottom 16 Bit 0..65535 0

66 110 Softedge Bottom Curve 16 Bit 0..65535 32768

112 Softedge Bottom Marker 8 Bit 0 no marker 0

1..255 black to white marker

113 Softedge Bottom Maker Width8 Bit 0..255 32

Effekts

Note: All MultiFX have 9 16Bit Parameter Ch.. Not all Parameters are used for all FX

For Detailed Information on each FX have a look at the Helpfile

68 FX1 Selection 8 Bit 0 no FX 0

1..255 FX Id

69 FX 1.1 16 Bit 0..65535 Parameter 1 32768

71 FX 1.2 16 Bit 0..65535 Parameter 2 32768

73 FX 1.3 16 Bit 0..65535 Parameter 3 32768

75 FX 1.4 16 Bit 0..65535 Parameter 4 32768

77 FX 1.5 16 Bit 0..65535 Parameter 5 32768

79 FX 1.6 16 Bit 0..65535 Parameter 6 32768

81 FX 1.7 16 Bit 0..65535 Parameter 7 32768

83 FX 1.8 16 Bit 0..65535 Parameter 8 32768

85 FX 1.9 16 Bit 0..65535 Parameter 9 32768

87 FX2 Selection 8 Bit 0 no FX 0

1..255 FX Id

88 FX 2.1 16 Bit 0..65535 Parameter 1 32768

90 FX 2.2 16 Bit 0..65535 Parameter 2 32768

92 FX 2.3 16 Bit 0..65535 Parameter 3 32768

94 FX 2.4 16 Bit 0..65535 Parameter 4 32768

96 FX 2.5 16 Bit 0..65535 Parameter 5 32768

98 FX 2.6 16 Bit 0..65535 Parameter 6 32768

100 FX 2.7 16 Bit 0..65535 Parameter 7 32768

102 FX 2.8 16 Bit 0..65535 Parameter 8 32768

104 FX 2.9 16 Bit 0..65535 Parameter 9 32768

106 FX 3 Selection 8 Bit 0 no FX 0

1..255 FX Id

107 FX 3.1 16 Bit 0..65535 Parameter 1 32768

109 FX 3.2 16 Bit 0..65535 Parameter 2 32768

111 FX 3.3 16 Bit 0..65535 Parameter 3 32768

113 FX 3.4 16 Bit 0..65535 Parameter 4 32768

115 FX 3.5 16 Bit 0..65535 Parameter 5 32768

117 FX 3.6 16 Bit 0..65535 Parameter 6 32768

119 FX 3.7 16 Bit 0..65535 Parameter 7 32768

121 FX 3.8 16 Bit 0..65535 Parameter 8 32768

123 FX 3.9 16 Bit 0..65535 Parameter 9 32768
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6.6.1.1.1.4  DMX Table PB Player
Note: DUAL and QUAD Players have the same Patch as Player PRO

Player Video Layer

Player Pro Player STD Player LT

Lighting Manager Lighting Manager Lighting Manager

62 CH 34 CH 44 CH 34 CH 26 CH 34 CH

Parameter Values Meaning default

1 1 1 1 1 1 Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

2 2 2 2 2 2 Media 8 Bit 0 no Media 0

1..255 File 1..255

3 3 3 3 3 3 Obj Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

4 4 4 4 4 4 Obj Media 8 Bit 0 no Object 0

1..255 File 1..255

5 5 5 5 5 5 Opacity 8 Bit 0..255 0

Playback

6 6 6 6 6 6 Video Control 8 Bit 0 Stop 192

64 Play Once

128 Pause

192 Play Loop

7 7 7 7 7 7 Speed 8 Bit 0..127 slower 128

128 1:1 Speed

129..255 faster

8 8 8 8 8 8 Inpoint 16 Bit 0 File Beginning 0

65535 End of File

10 10 10 10 10 10 Outpoint 16 Bit 0 File Beginning 65535

65535 End of File

Audio

12 12 12 12 12 12 Volume 16 Bit 0

Position

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

14 14 14 14 14 14 X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +250.000 units or 16 Screenwidth to the right

16 16 16 16 16 16 Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Rotation

Note Angle Resolution: 1 DMX Step = 0.033°

Speed Resolution: 1 DMX Step = 1 Rotation per hour

18 18 18 18 18 18 Z Angle 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

20 20 20 20 20 20 Z Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

21 21 21 21 21 21 Z Speed 16 Bit 0 32768

32768 Stop

65535

Scale

Note Resolution: 1 DMX Step = 0.001 Unit

Scale 0.5 = half size

Scale 2.0 = double size

23 23 23 23 23 23 X Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

25 25 25 25 25 25 Y Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535
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Player Video Layer

Player Pro Player STD Player LT

Lighting Manager Lighting Manager Lighting Manager

62 CH 34 CH 44 CH 34 CH 26 CH 34 CH

Rotation Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

27 27 27 X Rot Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

29 29 29 Y Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Scale Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

31 31 31 X Scale Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

33 33 33 Y Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Effekts

Note: All Player MultiFX have 4 16Bit Parameter Ch.. Not all Parameters are used for all FX

For Detailed Information on each FX have a look at the Helpfile

27 27 FX1 Selection 8 Bit 0 no FX 0

1..255 FX Id

28 28 FX 1.1 16 Bit 0..65535 Parameter 1 32768

30 30 FX 1.2 16 Bit 0..65535 Parameter 2 32768

32 32 FX 1.3 16 Bit 0..65535 Parameter 3 32768

34 34 FX 1.4 16 Bit 0..65535 Parameter 4 32768

36 36 FX2 Selection 8 Bit 0 no FX 0

1..255 FX Id

37 37 FX 2.1 16 Bit 0..65535 Parameter 1 32768

39 39 FX 2.2 16 Bit 0..65535 Parameter 2 32768

41 41 FX 2.3 16 Bit 0..65535 Parameter 3 32768

43 43 FX 2.4 16 Bit 0..65535 Parameter 4 32768

45 FX3 Selection 8 Bit 0 no FX 0

1..255 FX Id

46 FX 3.1 16 Bit 0..65535 Parameter 1 32768

48 FX 3.2 16 Bit 0..65535 Parameter 2 32768

50 FX 3.3 16 Bit 0..65535 Parameter 3 32768

52 FX 3.4 16 Bit 0..65535 Parameter 4 32768

54 FX4 Selection 8 Bit 0 no FX 0

1..255 FX Id

55 FX 4.1 16 Bit 0..65535 Parameter 1 32768

57 FX 4.2 16 Bit 0..65535 Parameter 2 32768

59 FX 4.3 16 Bit 0..65535 Parameter 3 32768

61 FX 4.4 16 Bit 0..65535 Parameter 4 32768
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Player Grafik Layer

Player Pro Player STD Player LT

Lighting Manager Lighting Manager Lighting Manager

56 CH 28 CH 38 CH 28 CH 20 CH 28 CH

Parameter Values Meaning default

1 1 1 1 1 1 Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

2 2 2 2 2 2 Media 8 Bit 0 no Media 0

1..255 File 1..255

3 3 3 3 3 3 Obj Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

4 4 4 4 4 4 Obj Media 8 Bit 0 no Object 0

1..255 File 1..255

5 5 5 5 5 5 Opacity 8 Bit 0..255 0

6 6 6 6 6 6 Frame 16 Bit 0 1st Frame 0

65535 Last Frame

Position

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

8 8 8 8 8 8 X Pos 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +250.000 units or 16 Screenwidth to the right

10 10 10 10 10 10 Y Pos 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Rotation

Note Resolution: 1 DMX Step = 0.033°

12 12 12 12 12 12 Z Rot 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°

14 14 14 14 14 14 Z Mode 8 Bit 0 Indexed Rot 0

1 Cont Rot

15 15 15 15 15 15 Z Speed 16 Bit 0 32768

32768 Stop

65535

Scale

Note Resolution: 1 DMX Step = 0.001 Unit

Scale 0.5 = half size

Scale 2.0 = double size

17 17 17 17 17 17 X Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535

19 19 19 19 19 19 Y Scale 16 Bit 0 0.000 1000

1000 1.000

65535 65.535
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Player Grafik Layer

Player Pro Player STD Player LT

Lighting Manager Lighting Manager Lighting Manager

56 CH 28 CH 38 CH 28 CH 20 CH 28 CH

Rotation Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

21 21 21 X Rot Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

23 23 23 Y Rot Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Scale Pivot

Note: The Display is always 16.000 units wide. The height is calulated by the aspect Ratio.

A 4:3 Display is 16.000 units wide and 12.000 units high

Resolution: 1 DMX Step = 0.008 units

25 25 25 X Scale Pivot 16 Bit 0  -256.000 units or 16 Screenwidth to the left 32768

32768 Center

65535  +256.000 units or 16 Screenwidth to the right

27 27 27 Y Scale Pivot 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

Effekts

Note: All Player MultiFX have 4 16Bit Parameter Ch.. Not all Parameters are used for all FX

For Detailed Information on each FX have a look at the Helpfile

21 21 FX1 Selection 8 Bit 0 no FX 0

1..255 FX Id

22 22 FX 1.1 16 Bit 0..65535 Parameter 1 32768

24 24 FX 1.2 16 Bit 0..65535 Parameter 2 32768

26 26 FX 1.3 16 Bit 0..65535 Parameter 3 32768

28 28 FX 1.4 16 Bit 0..65535 Parameter 4 32768

30 30 FX2 Selection 8 Bit 0 no FX 0

1..255 FX Id

31 31 FX 2.1 16 Bit 0..65535 Parameter 1 32768

33 33 FX 2.2 16 Bit 0..65535 Parameter 2 32768

35 35 FX 2.3 16 Bit 0..65535 Parameter 3 32768

37 37 FX 2.4 16 Bit 0..65535 Parameter 4 32768

39 FX3 Selection 8 Bit 0 no FX 0

1..255 FX Id

40 FX 3.1 16 Bit 0..65535 Parameter 1 32768

42 FX 3.2 16 Bit 0..65535 Parameter 2 32768

44 FX 3.3 16 Bit 0..65535 Parameter 3 32768

46 FX 3.4 16 Bit 0..65535 Parameter 4 32768

48 FX4 Selection 8 Bit 0 no FX 0

1..255 FX Id

49 FX 4.1 16 Bit 0..65535 Parameter 1 32768

51 FX 4.2 16 Bit 0..65535 Parameter 2 32768

53 FX 4.3 16 Bit 0..65535 Parameter 3 32768

55 FX 4.4 16 Bit 0..65535 Parameter 4 32768

Note: DUAL and QUAD Players have the same Patch as Player PRO

Player Camera Device

Player Pro Player STD Player LT

Lighting Manager Lighting Manager Lighting Manager

7 CH 7 CH 7 CH 7 CH 7 CH 7 CH

Parameter Values Meaning default

1 1 1 1 1 1 Mode 8 Bit 0 Perspective 0

1 Orthogonal

Lens Shift

Note : This is the Offset that you use to arange the Cameras for a Softedge Setup

2 2 2 2 2 2 X Offset 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

4 4 4 4 4 4 Y Offset 16 Bit 0  -256.000 units 32768

32768 Center

65535  +256.000 units

6 6 6 6 6 6 Z Roll 16 Bit 0  -1080.00° 32768

32768 0°

65535  +1080.00°
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Player Output Device

Player Pro Player STD Player LT

Lighting Manager Lighting Manager Lighting Manager

76 CH 49 CH 38 CH 29 CH 4 CH 4 CH

Parameter Values Meaning default

1 1 1 1 1 1 Render State 8 Bit 0 Render 0

1 Bypass

Object

2 2 2 2 2 2 Obj Folder 8 Bit 0 no Folder 0

1..255 Folder 1..255

3 3 3 3 3 3 Obj Media 8 Bit 0 no Object 0

1..255 File 1..255

4 4 4 4 4 4 Opacity 8 Bit 0..255 255

Keystone

5 5 Keystone L 16 Bit 0..65535 32768

7 7 Keystone L Pos 16 Bit 0..65535 32768

9 9 Keystone R 16 Bit 0..65535 32768

11 11 Keystone R Pos 16 Bit 0..65535 32768

13 13 Keystone T 16 Bit 0..65535 32768

15 15 Keystone T Pos 16 Bit 0..65535 32768

17 17 Keystone B 16 Bit 0..65535 32768

19 19 Keystone B Pos 16 Bit 0..65535 32768

21 21 Linearity X 16 Bit 0..65535 32768

23 23 Linearity Y 16 Bit 0..65535 32768

Softedge

25 25 5 5 Softedge Left 16 Bit 0..65535 0

27 27 7 7 Softedge Left Curve 16 Bit 0..65535 32768

29 9 Left Marker 8 Bit 0 no Marker 0

1..255 black to white

30 10 Left Marker Width 8 Bit 0..255 32

29 31 9 11 Softedge Right 16 Bit 0..65535 0

31 33 11 13 Softedge Right Curve 16 Bit 0..65535 32768

35 15 Right Marker 8 Bit 0 no Marker 0

1..255 black to white

36 16 Right Marker Width 8 Bit 0..255 32

33 37 13 17 Softedge Top 16 Bit 0..65535 0

35 39 15 19 Softedge Top Curve 16 Bit 0..65535 32768

41 21 Top Marker 0 no Marker 0

1..255 black to white

42 22 Top Marker Width 8 Bit 0..255 32

37 43 17 23 Softedge Bottom 16 Bit 0..65535 0

39 45 19 25 Softedge Bottom Curve 16 Bit 0..65535 32768

47 27 Bottom Marker 8 Bit 0 no Marker 0

1..255 black to white

48 28 Bottom Marker Width 8 Bit 0..255 32

Effekts

Note: All Player MultiFX have 4 16Bit Parameter Ch.. Not all Parameters are used for all FX

For Detailed Information on each FX have a look at the Helpfile

41 21 FX1 Selection 8 Bit 0 no FX 0

1..255 FX Id

42 22 FX 1.1 16 Bit 0..65535 Parameter 1 32768

44 24 FX 1.2 16 Bit 0..65535 Parameter 2 32768

46 26 FX 1.3 16 Bit 0..65535 Parameter 3 32768

48 28 FX 1.4 16 Bit 0..65535 Parameter 4 32768

50 30 FX2 Selection 8 Bit 0 no FX 0

1..255 FX Id

51 31 FX 2.1 16 Bit 0..65535 Parameter 1 32768

53 33 FX 2.2 16 Bit 0..65535 Parameter 2 32768

55 35 FX 2.3 16 Bit 0..65535 Parameter 3 32768

57 37 FX 2.4 16 Bit 0..65535 Parameter 4 32768

59 FX3 Selection 8 Bit 0 no FX 0

1..255 FX Id

60 FX 3.1 16 Bit 0..65535 Parameter 1 32768

62 FX 3.2 16 Bit 0..65535 Parameter 2 32768

64 FX 3.3 16 Bit 0..65535 Parameter 3 32768

66 FX 3.4 16 Bit 0..65535 Parameter 4 32768

68 FX4 Selection 8 Bit 0 no FX 0

1..255 FX Id

69 FX 4.1 16 Bit 0..65535 Parameter 1 32768

71 FX 4.2 16 Bit 0..65535 Parameter 2 32768

73 FX 4.3 16 Bit 0..65535 Parameter 3 32768

75 FX 4.4 16 Bit 0..65535 Parameter 4 32768
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6.6.1.2  Midi

The Midi Input protocol supports the following message types:
Channel Voice Messages
All Note-On messages are processed.

PRESET CONTROL

The channel is mapped to the Pandoras Box preset tree. Channel 1 = GLOBAL ... Channel 9 = CTRL

The note calls the equivalent preset. The notes are being processed with a negative offset of 35 to assign
the value 1 to the lowest note of a standard midi keyboard

SEQUENCE CONTROL

Channel 10 is used for transport control. Each octave controls one sequence:

The lowest octave (Offset 35) controls sequence 1, the next octave sequence 2 etc,...

Play, (C)
Pause, (D)
Stop, (E) 
Prev Cue + Play, (F)
Prev Cue + Pause (F#)
Next Cue + Play (G)
Next Cue + Pause (G#) 

GUI - Configuration Tab

Midi Device: Choose an installed Midi Device.
ID: ID of MSC Message Mapping
Sequence: Choose the sequence to be controlled via MSC.
Run Midi: Launch MSC and MIDI Input.

6.6.1.3  MSC Midi Show Control

The Midi Show Control input protocol supports System Exclusive messages (SysEx) according to the
MSC specification.

MSC SEQUENCE CONTROL
The format of a MSC (Midi Show Control message) is defined as:
F0h 7Fh <device_ID> 02h <command_format> <command> <data> F7h
(<data> is optional, all others are needed)

<device_ID>
determines the ID of the sequence to control. This is set up in the MIDI menu in the configuration tab.

<command_format> 
The following command-formats are processed by Pandoras Box:
01h Lighting (General Category)
30h Video (General Category)
40h Projection (General Category)
7Fh All-Types

<command>
The following commands are processed by Pandoras Box:
01h GO
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02h STOP
03h RESUME
05h LOAD
06h SET
0Ah RESET
0Bh GO_OFF

<data> 
All data must be encoded in ASCII Format.
Multiple data elements must be separated (SET) with 00h. 
Separators as dec.(2Eh) are accepted but the next value is not processed.

Example for: 
GO to Cue 24:
F0h 7Fh <device_ID> 02h 7Fh 01h 32h 34h F7h (min required format)

also valid:
F0h 7Fh <device_ID> 02h 7Fh 01h 32h 34h 2E 30 30 31 00 F7h (equivalent to cue 24.001 – is processed
as Cue 24)

F0h 7Fh <device_ID> 02h 7Fh 01h 32h 34h 2Eh 30h 30h 31h 00h 31h 00h 32h 00h F7h 
(according to the GrandMA format with cue list and cue path – only the first cue is processed)

GO - in conjunction with a cue: 
Jump to Cue + Play (the cue will overwrite a previously loaded cue) 

GO - without a cue:
a) if the last command was a LOAD cue, the loaded cue will be called.
b) in all other cases the timeline will continue from its actual play position.

STOP
Pause

RESUME:
Play at the actual position of the timeline.

LOAD:
LOAD must be used with a cue. The loaded cue will be processed by the next incoming GO command.

RESET and GO_OFF
Stop

SET
Set allows you to transmit individual device parameters. The message consists of 4 values.

MSC PARAMETER CONTROL

F0h 7Fh <device_ID> 02h <command_format> 06h <data1> 00h <data2> 00h <data3> 00h <data4> 00h
F7h
Only data after a 00h-separator will be processed. All decimal values will be ignored.

<data1>: Device ID
<data2>: Layer ID
<data3>: Parameter ID in Pandoras Box
<data4>: Value

Sample message for Device 1, Layer 3, X-Position, new value 26465:
F0h 7Fh <device_ID> 02h 7Fh 06h 31h 00h 33h 00h 38h 00h 32h 36h 34h 36h 35h 00h F7h
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List of Pandoras Box Parameter IDs:

None 0
Opacity 1
Mesh 2
Media 3
Inpoint 4
Outpoint 5
Transport 6
TransFx 7
XPos 8
YPos 9
ZPos 10
XRot 11
YRot 12
ZRot 13
XScale 14
YScale 15
ZScale 16
Colour1 17
Colour2 18
Colour3 19
ColourFx 20
Fx1 21
Fx2 22
Fx3 23
VideoFx 24
XAxis 25
YAxis 26
ZAxis 27
Rot 28
XOffset 29
YOffset 30

Mode 31
KSL 32
KSLR 33
KSR 34
KSRR 35
KST 36
KSTR 37
KSB 38
KSBR 39
LinX 40
LinY 41
SEL 42
SELC 43
SER 44
SERC 45
SET 46
SETC 47
SEB 48
SEBC 49

Sonic Emotion device:
BLevelS 50
BLevelR 51
BLevelG 52
BLevelB 53
Volume 54
X 55
Z 56
RoomSize 57
Ambience 58
Diffusion 59

All commands but SET are sequence related controls. The sequence to control must be set in the MIDI
configuration tab.

GUI:

Midi Device: Choose an installed Midi Device
ID: ID of MSC Message Mapping
Sequence: Choose the sequence to be controlled via MSC
Run Midi – Launch MSC and MIDI Input
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Use Cue Subsection: 
As decimal places for cue numbers are not supported in Pandoras Box, you can use the check box
option "Use Cue Subsection". Doing this will multiply the incoming cue command x1000 (for example:
GO to Cue 1.020 will be interpreted as GO to Cue 1020). With this option three decimal places are
supported.

6.6.1.4  Serial Link

Please note, that coolux has discontinued the Serial Link. Please refer to JLCooper Electronics
and their product eBOX.

The optional external SERIAL Link interface provides 4x serial RS 232/422 ports via ethernet.
A SERIAL Link port can be used to control the playback control of the timeline via RS232 or RS422.
Each port can be connected to a separate sequence to allow multiple input devices to control individual
sequences.

Once the serial connection is set up, the following commands are valid:

(Play) 
Sets the sequence state to play

(Pause) 
Sets the sequence state to pause

(Stop) 
Stops and rewinds the sequence

(CueID) 
ID = enter number based on cue ID to jump to that cue directly

Example:
(Cue13), sets the timeline now-pointer to the time of cue 13

See further instructions in the Serial Link Device Manual .

6.6.1.5  SMPTE Input

All Pandoras Box Manager, Server or Player products with timelines can send and receive LTC SMTPE
via the USB SMPTE Link interface .

To connect the SMPTE Link please refer to Configuration tab , section SMPTE Time Code . Then
go to Sequence Inspector  to set up the "Mode", "Offset" and "Stop Action".

759

765

140 158

201

http://www.jlcooper.com/
http://www.jlcooper.com/_php/family.php?fam=ebox
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6.6.1.6  TCP/IP

If you need to interface with Pandoras Box via Ethernet, TCP/IP communication is there to enable you to
remote control sequences and cues.

For external control you may create a TCP/IP server connection for each sequence that uses TCP/IP
Port 23. This can be set up in the Sequence Inspector .

The packet data is formatted as follows:
FFh 00h 00h nn <data>

nn defines the virtual com port 00h, 01h, 02h or 03h that can be set in the serial device in Pandoras Box
Manager, for direct IP communication without a Serial Link  interface you may ignore these virtual port
values.

Once the connection is set up, the following commands are valid:

(Play) 
Sets the sequence state to play

(Pause) 
Sets the sequence state to pause

(Stop) 
Stops and rewinds the sequence

(CueID) 
ID = enter number based on cue ID to jump to that cue directly 

Example:
(Cue13) sets the timeline nowpointer to the time of cue 13.

6.6.1.7  UDP - PB Automation

For custom remote control application, PB Automation uses a UDP based ethernet protocol to allow you
both sequence and device input control to all available devices within your project.

For more information about the integration and use of the PB Automation SDK please refer to the SDK
description .

201

759

1670
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6.6.2  Output Protocols

Pandoras Box show control communication architecture allows various devices to be controlled via
several industry standard protocols.

6.6.2.1  DMX Output

DMX output is designed to remote control external DMX device from the timeline in the Pandoras Box
Master, i.e a Manager, Player or Server. You may for example program a synchronized light and video
show by including moving lights, spots and other possible DMX devices into the timeline.
If you, on the other hand, are interested in controlling Pandoras Box with a lighting desk for example,
please read the topic covering the DMX Input .
For any DMX output the following settings need to be done.

1 - Connection
Connect the Master system to the DMX devices.

2 - Patch
All Pandoras Box systems ship with an extensive library of DMX devices. You may access all built-in
DMX devices  in the Device Type tab . Simply drag and drop the desired library into the Device Tree

. If your device is not included, you may write a custom fixture and then drag your custom device
into the Device Tree.
Select your device and patch the channel, subnet and universe using the Patch tab .

3 - Configuration
Activate the DMX output in the Configuration tab  in the section Remote Control Protocols . You
can choose a dedicated network adapter.

As soon as a key is stored in the timeline , the DMX data will be sent constantly. Only changes to
DMX values will be sent over Art-Net. Resetting a DMX node will send all values at once. 

Art-Net

As one of the most popular Ethernet protocols, Art-Net can be used to control multiple units with
multiple DMX universes via a single Ethernet network.
To use Art-Net please make sure that the lighting system and the Pandoras Box system are in the
same IP address range.

The first Art-Net specification demands a 2.xxx.xxx.xxx IP address, the most common used subnet
mask is 255.0.0.0 . Pandoras Box is still tied to this specification when working with DMX fixtures (i.e.
sending Art-Net data). If you are working witch matrix patches , you may address a different IP range
there. Since version 5.3 the IP address does not necessarily need to be in the 2.x.x.x range to be able
to receive Art-Net.

To enable Art-Net within a Pandoras Box Master system, please activate the Art-Net Mode in the 
Configuration tab .

DMX Link Out

DMX output via USB is supplied by the DMX Link USB interface cable . To enable it, press the output
button "DMX via USB" in the Configuration tab .
Please be aware that a single USB DMX interface will allow you to control a maximum of 512 DMX
channels on subnet 0 and universe 0.

645

631 182

169 632
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DMX Link 8

The DMX link 8 converts up to 10 DMX universes to Ethernet (Art-Net protocol). Backwards, 8 DMX
universes can be converted from Art-Net to DMX.
Please see the DMX Link 8 Device Manual  for further information.

6.6.2.2  Serial Link

Please note, that coolux has discontinued the Serial Link. Please refer to JLCooper Electronics
and their product eBOX.

The serial control will give you access and control to most routing switchers, projectors, shutters or other
device parameters that are remote controllable via the common RS 232 and 422 serial protocols.

In order to control external serial devices over RS 232 or RS 422 you will need to add a serial link device
from the Device Types tab  to the Device Tree tab . Any serial ASCII or hex string can be stored
and copied to any point in the timeline. It can be recalled at any time the time cursor hits the stored
serial key. Once you set the first key you can assign the IP address and port ID in the keys properties
as well as the ASCII or hex command for that key.

You will need a serial link device to receive and output serial commands. See further instructions in the 
Serial Link Device Manual .

Please see the topic TCP/IP  for an example how to control a projector without the Serial Link
hardware itself.

6.6.2.3  Spark

for WINDOWS XP (Microsoft .Net 2 Runtime must be installed)

Spark offers you various remote control over external applications as well as standalone Windows XP
PCs. 
Spark is designed to be connected to any Pandoras Box timeline as a Serial Link  TCP IP device.

Spark can be used for remote controlling applications, mouse and keyboard actions as well as
displaying full-screen video playback and web page presentations among many other useful remote
control features. Pandoras Box Spark is available from the coolux website as freeware download 
www.coolux.de .

To get started, install Spark on the desired PC that you want to control (Spark can be accessed also on
the same machine that runs Pandoras Box)

COMMAND LIST

See here an overview of remote control features offered by Spark:

COMPORT ASCII COMMUNICATION

SYSTEM COMMANDS - Shutdown & Reboot

WEB BROWSER (Fullscreen)

SOUND COMMANDS

VIDEO PLAYER (Fullscreen)

766

182 169

759

668

759

http://www.jlcooper.com/
http://www.jlcooper.com/_php/family.php?fam=ebox
http://www.coolux.de
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APPLICATION COMMANDS

KEYBOARD EVENTS

MOUSE EVENTS

DESKTOP FADE TO BLACK -BETA

WAKE ON LAN

PB AUTOMATION REMOTE CONTROL

Please see Spark  for detailed information.

6.6.2.4  SMPTE Output

All Pandoras Box Manager, Server or Player products with timelines can send and receive LTC SMTPE
via the USB SMPTE Link interface .

To connect the SMPTE Link please refer to Configuration tab , section SMPTE Time Code . Then
go to Sequence Inspector  to set up the "Mode", "Offset" and "Stop Action".

6.6.2.5  TCP/IP

With the Serial Link device you may control most routing switchers, projectors, shutters or other device
parameters that are remote controllable via the common RS 232 and 422 serial protocols. Even though,
the device's name is Serial Link, you do not necessarily need the hardware device itself .

For TCP/IP output, please open the Device Type  library and drag the Serial Link device  to the
Device Tree .

Select the device in the tree to load it's properties into the Inspector tab . Since the Serial Link device
uses a direct TCP/IP communication, you will need to switch off "Use Serial Link header".
Now, type in the right IP address of the projector (or any other device) and its connection port. The
Christie Mirage 3D projectors for example listen to port 3002. The IP and port can be either set on the
device itself or they are predefined. Please check the device's manual.

Click the button "Apply IP and Port" and the red exclamation mark on the Serial Link device in the
Device Tree disappears which means that you are connected to the projector. Some devices cannot
open two connections at the same time. In that case please close any other remoting ports, this
includes also interfaces for browsers.

As the connection is now established, the commands can be send. Simply add the serial command
according to the device's syntax as a key to the timeline. In detail this means to open the parameter
"COM" and insert a key frame by right-clicking on the according time whenever you want to send
commands to the projector.

Then select the created key frame and edit it in the Inspector. Enter the command in the "Data" field.
Please refer to the user manual of the projector to get the specific commands you want to send. For
example, (SHU 0) or (SHU 1) are common commands to open and close the shutter. The round brackets
are not requested from Pandoras Box but most devices demand that a command is enclosed with
brackets. If your device demands to send a special character like a "carriage return" or "start of text"
send your entire message "As Hex" and write everything including that special character using
hexadecimal values. You may find a list with ASCII characters  and the according hex code in the
Widget Designer chapter.
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As soon as the nowpointer reaches the key frame the command is send via the TCP connection to the
projector. In that way any serial ASCII or hex string can be stored and copied to any point in the
timeline.
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6.7  Network & Synchronization

Pandoras Box Systems rely on a dedicated network architecture that enables fast file sharing and
management as well as a proprietary frame adaptive network video-synchronization.

6.7.1  Network Setup

To run Pandoras Box Server over Ethernet, the IP setup of your system is essential. 

The coolux MediaNet allows you to link any Pandoras Box product together via MediaNet (this feature is
disabled in standalone mode). The MediaNet takes care of the synchronization of the units and allows
you to remote control and share files via Ethernet within the Pandoras Box software. For this a TCP (via
port 1234) and UDP (via port 1235) protocol is used.

Art-Net is available as an open industry standard DMX protocol via Ethernet.
It allows transporting multiple DMX universes on a single Ethernet link. Therefore the protocol offers
subnets and IDs that a DMX universe can be assigned to. If your controller does not support Art-Net
nativly, you might use an Art-Net converter, which converts standard DMX signals into Art-Net. They are
available i.e. from Artistic License or ELC.

Since Art-Net is sending UDP packets, this may slow down regular computer networks for office use. It
could also interfere with ongoing downloads that may result in dropping DMX frames that will cause
image jittering. 

So please make sure that Art-Net runs on a separate network that is not connected to “normal”
computer network or internet.

SYNCHRONIZATION 

The way Pandoras Box synchronizes all control data for vector calculations as well as for video playback
has been optimized, so that you simply have to set up a project that contains all connected units in the
network. 

Therefore one unit acts as a Master while all other units connected to it become Clients. A Client is fully
independent. The unit gets its resource and control data from the Master system only. In the project you
may define which resources should be assigned to which Client. At the same token, the Master system
will automatically take care of the full synchronization of all motion and video-only data. Even if you
encounter a performance drop on one of the machines, it will catch up once the necessary resources are
available.

IP CONFIGURATION 

For a proper network communication and bandwidth, we strictly recommend setting up standalone local
area networks. 

To receive MediaNet or Art-Net with your Pandoras Box Server, any firewall needs to be switched off! By
factory default the internal Windows firewall is switched off! When building up the network-link you may
either use straight peer-to-peer connection with a cross-link cable or use regular network cables in
conjunction with an Ethernet hub or switch.
If you like to configure your firewall differently, keep in mind that the Pandoras Box Master and Clients
communicate via port 1234 and 1235!

Please note: 
Some switchers and routers include filtering or even a firewall that won’t let MediaNet or Art-Net data
through.
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The IP address of your Pandoras Box Server
needs to be set in the range of
2.xxx.xxx.xxx with the subnet mask
255.0.0.0 if you like to send Art-Net data.
For receiving MediaNet or Art-Net any IP
address can be chosen.

The IP address can be changed in the
properties of the network connection. 
You may also use Art-Net with a DHCP
server that sets all IP in the same
2.xxx.xxx.xxx address range.

6.7.2  Master / Client Remote Setup

General explanation: PB Master, PB Client

If you have only one Pandoras Box system, you start the Master mode. This configuration is also called
"stand-alone mode".

When multiple Pandoras Box systems need to be linked, e.g. for synchronized video playback, they
need to be set up in a Master/Client configuration. A Master system may connect to multiple Client
systems whilst a Client may only connect to one single Master system. Pandoras Box Playback
systems (PB Players and PB Servers) may be started in either Master or Client mode. The PB Manager
has only a Master mode.
You run one Pandoras Box Manager or Player or Server as a Master and start the Client mode on all
other machines.

The Master acts in general as the main controller for all attached devices, whilst a Client system is
"only" receiving commands and media to playback in fullscreen.
On the Master, you create a project which holds all information about the resource media files and
connected Clients (and other devices ). The Master takes care of the remote file management,
meaning the media upload called "spreading" to all Clients; and of course the video synchronization
throughout the entire network. In addition the Master send all control parameters to the Clients and
organizes the protocol patch and routing, e.g. it sends all incoming control-data like DMX or Art-Net in
sync to the Clients.

Revision number and Domain channel

In order to connect Master and Client systems, please make sure that the identical software revision is
used and that both Master and Client use the same domain channel for communication.

The revision number is displayed in the bottom right corner of the Master interface. In the Client GUI the
revision number is displayed next to the Preview window when the fullscreen mode is off.

The domain channel can be found in the Configuration tab > Network  in the Master system and in the
main window of the Client. Per default, the domain channel is set to 0 and is only changed when multiple
Masters or multiple PB networks need to be set up.
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So if multiple Masters exist within the same network, assign different domain channels to them. Two
Masters may not share the same domain channel. Choose the domain channels for your Clients
according to the Master it should connect to. For the other Master, this Client is invisible.

Controlling Clients in the Master interface

When the network, the revision and the domain are set up correctly, all Clients appear in the Assets tab
 of the Master. The Clients in return display the Master's IP instead of “not connected”.

To start controlling the Client, for instance assigning media files to it, drag the unit from the Assets tab
into the Device Tree tab . Now the Client is in the project and files can be transferred across the
network.

To include media files to your project, drag the file from the Assets tab to the Project tab . Per default,
all added media files are auto-spread to the available Clients (that are part of the Device Tree). To share
files or entire folders manually, you right-click on the entry in the Project tab and choose the according
‘Spread’ command.

Now you can start assigning the sources (media files) to the outputs (Layers on the Clients). This is
explained in the chapter Media Files .

Please note:
When re-starting the project on the Master with unconnected Clients, they will show up with a red“!”.
Once the Clients are started, they will automatically reconnect to the Master

Programming with Clients that are not connected yet

If you want to assign a Client that is not connected to the network yet, you can also choose the
Pandoras Box Client type from the Device Types tab  and drag it into the project from there. Once the
unit will be present on the network, make sure that you set the correct IP address in the Client's
Inspector  in order to be connected to the Master.

6.7.3  Video Synchronization

Pandoras Box Systems offer a network based automatic frame adaptive video synchronization.

No matter the input protocol, once a Master/Client setup is set up, all control data that is sent across
the network via Pandoras Box MediaNet will be processed in sync on all connected Client machines.

A few words about video synchronization and timecode sync:

In order to deliver a frame accurate synchronization all connected Client systems synchronize
themselves with the Master at any time. This means that - independent from running sequences videos
that are played back in play loop - freewheel mode will stay in sync with each other. This is also
important for external input protocols that do not provide a synchronization method like DMX, GPI or
many others.

The remote input protocol commands are collected as a series of commands on the Master unit and
then processed in sync to the Master's time clock for each configuration.

It also very important, when video synchronization should be used, that all videos are used as
elementary video files only, otherwise the embedded audio will disconnect the video sync and sync to
the audio only.

This is important for content production and encoding: If you want to playback audio files in sync to an
entire network system, the audio files must be played back through the sonic emotion audio device built
into every Master system.
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The sonic emotion real-time audio player and time synchronizer ensures that all audio files that are
played back through dedicated audio track will stay in sync with the Masters time clock.

6.7.4  Ports Used by PB and WD

This chapter lists all ports used by Pandoras Box and Widget Designer.

Decimal Ports

Ports Purpose

1234 Pandoras Box Communication UDP

1235 Pandoras Box Communication UDP

1300 Pandoras Box Communication TCP/IP

1301 Pandoras Box Communication TCP/IP

1302 Pandoras Box Communication TCP/IP

1303 Pandoras Box Communication TCP/IP

2234 Pandoras Box Communication (Heartbeat) UDP

2235 Pandoras Box Communication (Heartbeat) UDP

6211 Pandoras Box Automation  TCP

6212 Pandoras Box Automation UDP

6213 WD Device in Pandoras Box TCP

6214 Pandoras Box Webserver TCP

80 Pandoras Box Webserver

23 SerialDevice in Pandoras Box

80 / 30300 Widget Designer HTTP Port / Listener
If port 80 is occupied, WD uses the next available port starting with 30300. Same
applies to the websockets and upload port.

8080 / 30400 Widget Designer Websockets

81 / 30500 Widget Designer Upload Port / Listener

Hexadecimal Port

0x2320 PB Health Report UDP

1670

159

1662
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6.8  StreamiX Live Input

StreamiX Desktop is a TCP based Desktop Streamer that works as a Live Input in Pandoras Box (PB).
This tool streams any Windows desktop region, for example a dedicated area of an Excel sheet or any
other application content, and may be used as a Live Input of a PB Client or PB Master directly. In
addition it may stream a chosen file from the hard disk. In return you might as well stream the Preview
area to other PB Clients.

This way you can send any desktop content directly into Pandoras Box without using capture cards. As
the content is transferred via TCP please keep in mind that the tool is not designed to be a fully-fledged
substitution for DVI input cards. It is rather meant to stream either low frame rate content or single
images or low resolution content.
To meet the systems performance it is possible to set up different frame-rates and sizes of the desktop
region to be streamed.



675

Even though StreamiX is designed to be used as a 1:1 connection, you may use several instances of
StreamiX Desktop at the same time on one system. These may either send their data to a single PB
Client or to several PB Clients.
In return one PB Client may receive data from several StreamiX Desktop applications. However, keep
your systems performance and network traffic in view, a 1:1 stream may be already the limit!
By rule of thumb one stream with a resolution of 1024x768 px and a frame rate of 30fps will run fluently
on a gigabit network.

The total number of StreamiX Live Inputs depends on the license of your PB Client. See the Product
Overview  for detailed differences.

The Pandoras Box CITP based Desktop Streamer for users of WYSIWYG or Capture Polar is described 
here .

6.8.1  StreamiX Desktop User Interface

The User Interface is divided into the following sections:

Network Connection

Desktop Region

Output Format

Transmission

General information
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6.8.1.1  Network Connection

You may start several instances of StreamiX Desktop Streamer at the same time to pass several TCP
streams to PB application. The number shown in the Window Title [] displays the stream number:
Pandoras Box CITP Desktop Streamer [1] = Stream 1.

[IP]:
Enter the IP address of the PB Client (or PB Master if stand alone) you want to sent the stream as a live
input to.

[Port]:
Enter the same port as the receiving PB application is set to.

[ID]:
Enter the ID. Each stream received from the PB Client (or PB Master) must have a unique ID and refers
to the StreamiX Live Input with the same number. 

[Connect / Disconnect]:
Click [Connect] to connect to the device with the entered IP and Port. As StreamiX Desktop is a TCP
client, the connection must be built up in the first place from the PB Client (or PB Master) as this device
poses as the TCP server. Please set up the stand alone Master first, or if a PB Client is used, it must
additionally be part of a project and the live input must be added to it as an asset already. 
After you have done so the TCP connection can be built up and the StreamiX Desktop can pick it up.
The text "Waiting for connection..." will change to "Client connected". When the button [Disconnect] is
pressed you will read "Client stopped".

In case of closing the PB Client or Master receiving the StreamiX live input "Server lost" will be
displayed.

6.8.1.2  Desktop Region

There are two possibilities to define the region of your desktop that is going to be captured for TCP
streaming:

Enter the region’s starting horizontal pixel [X] and the vertical pixel [Y] as well as the regions width [W]
and height [H] into the text fields and press [Apply].
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Or click [Pick Region]. The desktop will be overlaid with a transparent white mask and you may span the
desired desktop region with the mouse. 

Please note:
To capture a desktop region that is not on the primary monitor, enter the region’s starting pixel and its
size as described in option 1. This can’t be done by picking a region with the mouse.

The example shows a typical use. By picking a smaller region, you will stream the graph only without
the surrounding columns and rows within the table.

6.8.1.3  Output Format

[Size]:
By choosing a size from the drop-down list you define the resolution and aspect ratio of the outgoing
stream. Picking the same (or at least a multiple unit) in regards to the captured desktop region and Live
Input setting will give you the best result.

[Format]:
Choose whether the frames of the stream are to be encoded as jpeg or png format.

[Interpolation]:
If a size has been picked that does not match the captured desktop region, the pixel within the new
width and height have to recalculated. Choose whether the calculation should base upon 1:1, Cubic,
Linear or Soft interpolation. 
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6.8.1.4  Transmission

[FPS]:
The Framerate can be set to values between 1 and 30 fps, according to your system’s performance and
network´s capacity. 
Please note:
You do not have to press [Apply] as your changes are applied immediately.

[Run]:
Enable the check box to stream successive frames of the desktop.
Disable the check box to stream a single image only. This may either apply to a desktop or file stream.
Please note that the check box is ticked automatically by the following buttons as well.

[Send Desktop]:
Captures the assigned desktop region with the assigned format and enables automatically the check
box [Run]. However, you may tick it again in order to stream a single screen shot of the desktop. This
will not interrupt the TCP connection itself but the capturing process.

[Send File...]:
Streams a file from the hard disk and disables the [Run] option. Please note that only single images
(*.bmp, *.jpg,*.png,*.gif)*.may be streamed.

6.8.1.5  General Information

On the left bottom of the menu you find the local computer’s IP address
and a link to coolux' website.
On the right bottom the revision is displayed. 

The [Hide] button will hide the user interface (menu) of StreamiX
Desktop. To unhide it again, open the system tray and make a right-
click on the StreamiX Desktop icon or make a left click and choose
"Show".



679

6.8.2  StreamiX Live Input Settings

As the StreamiX Desktop application can only pick connections up, it is necessary to establish them
with the PB Client (or Master) beforehand. To do this you need to configure the live input. StreamiX is
designed to be used as a live input on a Pandoras Box Player or Server, it is not available on a PB
Manager. The Player or Server System may run in stand alone mode or as a PB Client.

In order to configure the StreamiX live input on a PB Client, the Client must
be part of a project and the live input must be added to it as an asset
already. 

As live inputs are only available (and render-able) on the system were the
physical input is, all other system including PB Manager cannot display
the input. In order to preview a dummy file, select the StreamiX asset and
use the attach function on the local node. Scroll down the Inspectors
window, highlight "local" and click the "Attach" button. Choose the file you
want to preview instead of the non-existing live input and Click "Ok". 

In order to configure the StreamiX live input on a PB Master (PB Player or PB Server) drag the StreamiX
live input from the Assets Tab to the Project Tab as well. Select the StreamiX asset and have a look at
its options in the Inspector Tab. Scroll down, select the local entry and click the button "Configure". 

Change the incoming resolution and the listening port. 
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Now the StreamiX live input may be used just like any other still image or video file. It is possible to
assign it to a layer and use it in the sequence as usual. 
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7  Factory Reset Tool

The factory reset tool is especially useful for rental machines. On the one hand it allows you to create
disk images i.e. a backup of the system including all files, programs, driver versions, computer names
and all other structures and settings. On the other hand it allows you to restore the system by loading
created images. At all times an image is provided, representing the system’s condition when it has been
shipped out (with all recommended settings and drivers!)

The tool is available on V4Rev2 hardware which has been sold since the V5 release.

Please note: Until now, all images affect only the c-drive itself. The content partition is embedded into
the c-partition, nevertheless it cannot be included when saving a backup, nor does a backup restore the
content partition.
If you wish to delete certain content files from prior users, we advise to do this manually in the windows
browser. Please be aware that the content partition has no bin, thus by deleting them and confirming the
warning, you cannot restore them anymore

The user interface of the factory reset tool appears on each start up (booting process) after successfully
booting the BIOS. If it is not entered actively within 5 seconds the system will continue booting and the
Windows boot screen appears.

In order to halt the booting process and enter the active state of the tool, press one of the arrow keys on
your keyboard. You will see this screen until the Exit button is pressed.
Navigate through the user interface by pressing the up and down keys. Press enter to confirm.
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Factory Reset

Restores the c-drive to the factory setting. The factory reset image is a read-only file. It cannot be
overwritten or deleted.
The content partition (c:/coolux/content) will remain as it is.

Factory Reset & Erase Content

Restores the c-drive to the factory setting and erases the files from the content partition (c:/coolux/
content). All files will be deleted. There is no backup of the content partition stored separately!
As soon as a Pandoras Box application (Client or Master) will be loaded the first time the folder
_Pandoras_Box_Data with its subfolders will be recreated.

Create Image

Draws an image from the current system. The image file will be saved on an additional rescue partition
(60GB). Please be aware that the latest image will be overwritten by the recent image. There is a
warning message you will have to confirm before saving a new image and possibly overwriting an older
one. This does not affect the factory reset image which is stored separately!

The content partition (c:/coolux/content) will not be included in the image.

Restore Image

Restores the c-drive to the status when the latest image has been stored.
The content partition (c:/coolux/content) will remain as it is.

Restore Image & Erase Content

Restores the c-drive to the status when the latest image has been stored and erases the files from the
content partition (c:/coolux/content). All files will be deleted. There is no backup of the content partition
stored separately!
As soon as a Pandoras Box application (Client or Master) will be loaded the first time the folder
_Pandoras_Box_Data with its subfolders will be recreated.

EXIT

Leaves the user interface from the factory reset tool. The booting process will continue and Windows will
load.
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8  Hardware and Accessories

This topic focuses on the hardware description of coolux products.

First of all topics are included that explain hardware and hardware peripherals, included in Server, Player
or Manager hardware:
- Compact Player
- LCD Menu
- DVI Processor
- Graphic Card Settings
- Input Card Settings

Then, hardware devices are described that work as an optional feature. They can be purchased as stand-
alone accessories. 
- Controller Boards , i.e. Jog Shuttle Controller  and the Fader Extension
- SENSOR Link
- SERIAL Link
- SMPTE Link
- DMX Link
- DMX Link 8
- EDID Link
- NET Link and Calibration Link
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8.1  Server Hardware

The Pandoras Box Server is a software and hardware based solution for show control and video
processing.

When looking at the Pandoras Box product family, the Server product range can be found next to the
Player product range. The Server is an upgradeable model featuring a real-time 3D compositing engine
for image and video playback. The playback performance depends on the content format, its resolution
and framerate. The Download-Center includes a performance sheet listing many examples.

The Server hardware is 19" wide and 4 rack units high and includes server grade components built for
24/7 use. There are five Server hardware models, called performance kits PK1-PK5, which define the
amount of hard drives (SSD), hard drive space and CPU speed. The number of physical outputs is
defined through the graphics card. Either four or eight DisplayPort outputs are available.
The Server software variations define the number of software outputs. You may choose between a Single,
Dual, Quad and Octa edition. The option of zero outputs is of interest when you require hardware for
backup scenarios or for software products like the Manager , Widget Designer  or others.

A LCD interface allows for basic setup of the server such as network, output configuration or to select a
test pattern without the need of setting up a network before.

For more information regarding the Pandoras Box product structure, please see the chapter "Product
Overview"  in the Pandoras Box manual. It also includes links to chapters that explain the different
software solutions and possible hardware accessories. We offer specialized interfaces for SMPTE I/O,
DMX, serial and sensor control.

Drivers

All drivers are preinstalled on the system. Also, software like the PB Menu is preinstalled. Please check
the Download-Center for drivers, software updates and more documentation.

PB Menu

There is software pre-installed on Pandoras Box hardware called the PB Menu . It starts automatically
when booting. It covers the Windows desktop and consists of a few buttons that give access to the most
needed actions, e.g. starting the Master or Client software or opening the Windows Explorer (File
Browser).
The PB Menu includes another software called the VNC Remote , or simply Remote. With that
software you can establish a VNC connection to another computer that is in your network. The other
computer needs to have a VNC client running to pick up the connection. If PB Menu is installed and
running on the remote computer, you do not need an additional VNC client. You enter the according IP
address and see the desktop of that computer. Now you can click your local mouse and use the local
keyboard to interact with the remote desktop.
For more information see the according topics in the main Pandoras Box manual.
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Product Specifications

Operating system: Windows 8.1

Processor: Dual XEON processor

SSD drives (for content): depends on hardware edition, i.e. PK1: 960GB, PK2: 1,92TB, PK3: 3,84TB,
PK4: 7,68TB, PK5: 15,36TB

RAID: RAID-0 

Storage for operating system: M.2 with 256GB SSD

USB ports: 10x USB ports (front: 2x USB 3.0, rear: 6x USB 3.0 and 2x USB 2.0)

LAN: 2x 1 Gigabit Ethernet ports

Audio (onboard): Optical S/PDIF output; 4x stereo playback output; 1x stereo playback input (Line-in)
and 1x microphone input

Graphics card: NVIDIA Quadro M4000

Product Size (WxHxD): 422mm x 177mm x 646mm - without handles (19" wide and 4U high); 482mm x
177mm x 686mm - with handles

Weight: approx. 30kg (depends on performance kit and optional cards)

Power: (depends on performance kit) 100-240V AC, 15-7.5A, 47-63Hz with an integrated 1200W power
supply unit; 100-240V AC, 12-6A, 47-63Hz with an integrated 850W power supply unit 

Optional cards:

- max. two video input boards (DVI or 3G SDI)

- 8ch or 32ch ADAT or 64ch MADI audio card

- Framelock and Genlock input card

- 10Gb Ethernet card

For more information regarding each card see the according topics in the main Pandoras Box manual.
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Server Hardware

Front view, connections from left to right

Power switch The power switch allows powering on and off the system.
Press the power button after connecting the supplied power cord.

2x LED Status Lights The upper blue LED indicates the power status. The lower orange LED indicates
access to hard drives.

2x USB 3.0 port Connect USB devices such as external hard drives, SSDs and flash drives to this
port. The USB 3.0 port supports SuperSpeed USB 3.0 devices and is backwards
compatible with USB 2.0/1.1 devices.

LCD interface The display allows for basic setup of the server such as network, output
configuration or to select a test pattern without the need of setting up a network
before. Use the rotary push button to navigate through the menu.

4x Playback button If the Server is used in stand-alone mode you can use these buttons to control
the Sequence with Play, Pause, Last Cue, Next Cue commands.

Rotary push button See "LCD interface".
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Rear view, connections from left to right

Power input
100-240V / 850W or 1200W

Connect the supplied power cord. Then press the power switch on the
front panel to turn on the system.

PS/2 port Connect a PS/2 mouse or keyboard.

2x USB 2.0 ports Connect USB devices such as external hard drives, SSDs and flash drives
to this port.

2x buttons These buttons are for special applications and not to be used.

Optical (S/PDIF out) jack Connect digital audio receivers and speakers to the optical S/PDIF output.

6x USB 3.0 ports Connect USB devices such as external hard drives, SSDs and flash drives
to this port. The USB 3.0 port supports SuperSpeed USB 3.0 devices and
is backwards compatible with USB 2.0/1.1 devices.

2x Ethernet ports Connect a network router, hub or switch or another computer to this port.
The eight-pin RJ-45 LAN port supports standard Ethernet cables for
connections to local area networks (LAN) with speeds of
10/100/1000Mbps.

4x Audio Out jack
2x Audio In jack

Connect amplified speakers or headphones to the stereo output jack
(3.5mm) and receive the system’s audio output signal. There are four
output connections: orange: Center / LFE, black: Rear / Surround, gray:
Side, lime: Line Out / Front

Connect a Line signal to the light blue stereo input jack (3.5mm).
Connect a microphone signal to the pink stereo input jack (3.5mm).

4x DisplayPort Connect a digital display device to the Display port (max. resolution:
4096x2160 @60Hz).
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8.2  Player Hardware

The Pandoras Box Player is a software and hardware based solution for show control and video
processing.

When looking at the Pandoras Box product family, the Player product range can be found next to the
Server product range and includes the Compact Player , the Software Player and the here described
Hardware Player. The Player is an upgradeable model featuring a real-time 2D compositing engine for
image and video playback. The playback performance depends on the content format, its resolution and
framerate. The Download-Center includes a performance sheet listing many examples.

The Player hardware is 19" wide and 4 rack units high and includes server grade components built for
24/7 use. There are four Player hardware models, called performance kits PK1-PK4, which define the
amount of hard drives (SSD) and hard drive space. The number of physical outputs is defined through the
graphics card, which features four DisplayPort outputs. The Player software variations define the number
of software outputs. You may choose between a Single, Dual and Quad edition. The option of zero
outputs is of interest when you require hardware for backup scenarios or for software products like the 
Manager , Widget Designer  or others.

For more information regarding the Pandoras Box product structure, please see the chapter "Product
Overview"  in the Pandoras Box manual. It also includes links to chapters that explain the different
software solutions and possible hardware accessories. We offer specialized interfaces for SMPTE I/O,
DMX, serial and sensor control.

Drivers

All drivers are preinstalled on the system. Also, software like the PB Menu is preinstalled. Please check
the Download-Center for drivers, software updates and more documentation.

PB Menu

There is software pre-installed on Pandoras Box hardware called the PB Menu . It starts automatically
when booting. It covers the Windows desktop and consists of a few buttons that give access to the most
needed actions, e.g. starting the Master or Client software or opening the Windows Explorer (File
Browser).
The PB Menu includes another software called the VNC Remote , or simply Remote. With that
software you can establish a VNC connection to another computer that is in your network. The other
computer needs to have a VNC client running to pick up the connection. If PB Menu is installed and
running on the remote computer, you do not need an additional VNC client. You enter the according IP
address and see the desktop of that computer. Now you can click your local mouse and use the local
keyboard to interact with the remote desktop.
For more information see the according topics in the main Pandoras Box manual.
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Product Specifications

Operating system: Windows 8.1

Processor: Single XEON processor

SSD drives (for content): depends on hardware edition, i.e. PK1: 960GB, PK2: 1,92TB, PK3: 3,84TB,
PK4: 7,68TB

RAID: RAID-0 

Storage for operating system: 480GB SSD

USB ports: 11x USB 3.0 ports (2x front and 9x rear panel)

LAN: 2x 1 Gigabit Ethernet ports

Audio (onboard): Optical S/PDIF output; 4x stereo playback output; 1x stereo playback input (Line-in)
and 1x microphone input

Graphics card: NVIDIA Quadro M4000

Product Size (WxHxD): 422mm x 177mm x 646mm - without handles (19" wide and 4U high); 482mm x
177mm x 686mm - with handles

Weight: approx. 30kg (depends on performance kit and optional cards)

Power: 100-240V AC, 12-6A, 47-63Hz with an integrated 850W power supply unit

Optional cards:

- max. one video input board (DVI or 3G SDI),

- 8ch or 32ch ADAT or 64ch MADI audio card

- Framelock and Genlock input card

- 10Gb Ethernet card

For more information regarding each card see the according topics in the main Pandoras Box manual.
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Player Hardware

Front view, connections from left to right

Power switch The power switch allows powering on and off the system.
Press the power button after connecting the supplied power cord.

2x LED Status Lights The upper blue LED indicates the power status. The lower orange LED indicates
access to hard drives.

2x USB 3.0 port Connect USB devices such as external hard drives, SSDs and flash drives to this
port. The USB 3.0 port supports SuperSpeed USB 3.0 devices and is backwards
compatible with USB 2.0/1.1 devices.
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Rear view, connections from left to right

Power input
100-240V / 850W

Connect the supplied power cord. Then press the power switch on the
front panel to turn on the system.

PS/2 port Connect a PS/2 mouse or keyboard.

2x USB 3.0 ports Connect USB devices such as external hard drives, SSDs and flash drives
to this port. The USB 3.0 port supports SuperSpeed USB 3.0 devices and
is backwards compatible with USB 2.0/1.1 devices.

1x VGA port VGA onboard for service, no Pandoras Box output!

4x USB 3.0 ports See above.

2x Ethernet ports Connect a network router, hub or switch or another computer to this port.
The eight-pin RJ-45 LAN port supports standard Ethernet cable for
connections to local area networks (LAN) with speeds of
10/100/1000Mbps.

3x Audio Out jack
2x Audio In jack

Connect amplified speakers or headphones to the stereo output jack
(3.5mm) and receive the system’s audio output signal. There are three
output connections: orange: Center / LFE, black: Rear / Surround, lime:
Line Out / Front

Connect a Line signal to the light blue stereo input jack (3.5mm).
Connect a microphone signal to the pink stereo input jack (3.5mm).

Optical (S/PDIF out) jack Connect digital audio receivers and speakers to the optical S/PDIF output.

4x DisplayPort Connect a digital display device to the Display port (max. resolution:
4096x2160 @60Hz).

3x USB 3.0 ports See above.
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8.3  Compact Player

The Compact Player is a software and hardware based solution for show control and video processing.

When looking at the Pandoras Box product family, the Compact Player can be found in the Pandoras
Box Player product range. Like all Players, the Compact Player is an upgradeable model featuring a
real-time 2D compositing engine for image and video playback. The playback performance depends on
the content format, its resolution and framerate. The Download-Center includes a performance sheet
listing many examples.
Its distinctive hardware feature is its size: the Compact Player is only one rack unit high and roughly half
19" wide. The Compact Player software variations define the number of outputs. The option of zero
outputs is of interest when you require hardware for backup scenarios or for software products like the 
Manager  or Widget Designer  or others.

For more information regarding the Pandoras Box product structure, please see the chapter "Product
Overview"  in the Pandoras Box manual. It also includes links to chapters that explain the different
software solutions and possible hardware accessories. We offer specialized interfaces for SMPTE I/O,
DMX, serial and sensor control.

Drivers

All drivers are preinstalled on the system. Also, software like the PB Menu is preinstalled. Please check
the Download-Center for drivers, software updates and more documentation.

PB Menu

There is software pre-installed on Pandoras Box hardware called the PB Menu . It starts automatically
when booting. It covers the Windows desktop and consists of a few buttons that give access to the most
needed actions, e.g. starting the Master or Client software or opening the Windows Explorer (File
Browser).
The PB Menu includes another software called the VNC Remote , or simply Remote. With that
software you can establish a VNC connection to another computer that is in your network. The other
computer needs to have a VNC client running to pick up the connection. If PB Menu is installed and
running on the remote computer, you do not need an additional VNC client. You enter the according IP
address and see the desktop of that computer. Now you can click your local mouse and use the local
keyboard to interact with the remote desktop.
For more information see the according topics in the main Pandoras Box manual.

Product Specifications

Operating system: Windows 8.1

Microprocessor: Intel i5 processor

SSD drives: depends on hardware edition, i.e. LT - 480GB, STD - 960GB, PRO - 1900GB

USB ports: 4x USB 3.0 ports (1x internal, 3x front and rear panel)

LAN: 2x 1 Gigabit Ethernet ports

Audio*: Optical S/PDIF output; stereo analog audio output and microphone input

Graphics card: NVIDIA GeForce GTX 750 Ti

Product Size (WxHxD): 210mm x 42mm x 172mm (roughly half 19" wide and 1U high)

Power: DC 19.5V/120W with an external power supply unit

* Regarding audio support, the Compact Player license includes ASIO Tracks. Eventhough the
hardware does not natively support ASIO, it is possible to install the ASIO4ALL driver. When using this
driver, we cannot guarantee perfect synchronization. Audio playback on Video Layer (with MP3, WMA,
WAV format and embedded sound) is supported.

125 894

64
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http://www.coolux.de/cooluxsupport/dowload-center/
http://www.coolux.de/cooluxsupport/dowload-center/
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Compact Player Hardware

Front view, connections from left to right

Power switch The power switch allows powering on and off the system.
Press the power button after connecting the supplied PSU to the power jack on
the system rear panel. Note that the button's back light LED lights up when the
system is on.

USB 3.0 port Connect USB devices such as external hard drives, SSDs and flash drives to this
port. The USB 3.0 port supports SuperSpeed USB 3.0 devices and is backwards
compatible with USB 2.0/1.1 devices.

Memory card slot The built-in memory card reader reads SD/SDHC/SDXC/MMC cards.

Microphone jack Connect a microphone to the microphone jack (3.5mm).

Headphone/
Audio Out jack

Connect amplified speakers or headphones to the stereo headphone jack
(3.5mm) and receive the system’s audio output signal.
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Rear view, connections from left to right

Power input
DC 19.5V/120W

Connect the supplied power adapter to this jack. Then press the power
switch on the front panel to turn on the system.

Please note: To prevent damage to the PC, always use the supplied
power adapter. The power adapter may become warm to hot when in use.
Do not cover the adapter and keep it away from your body.

HDMI port Connect a digital display device to the HDMI 1.4a port (max. resolution:
4096x2160 @24Hz).

DVI-I port Connect a digital display device to the DVI-I Dual Link port (max.
resolution: 2560×1600 @60Hz).

2x USB 3.0 ports Connect USB devices such as external hard drives, SSDs and flash drives
to this port. The USB 3.0 port supports SuperSpeed USB 3.0 devices and
is backwards compatible with USB 2.0/1.1 devices.

2x Ethernet ports Connect a network router, hub or switch or another computer to this port.
The eight-pin RJ-45 LAN port supports standard Ethernet cable for
connections to local area networks (LAN) with speeds of
10/100/1000Mbps.

Optical (S/PDIF out) jack Connect digital audio receivers and speakers to the optical S/PDIF output.
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8.4  LCD Menu

The LCD Menu is included in the Pandoras Box Servers, it cannot be purchased as an optional features.

Status Display

The top level menu of the front panel LCD display is the status display.

The status displays indicates:

The units IP address of the “Lan” adapter Output1 Resolution

The units IP address of the “Lan2” adapter Output2 Resolution

The units computer name Free hard disc space

By pressing the encoder once you will enter the main menu.

Main Menu

From the main menu you may access several sub menus: Use the encoder to navigate through the
menu entries and press the encoder to enter each of the sub menus. Press STATUS to return to the top
level status menu.

Lan1 & Lan2 - Network Menu

The network menu allows you to quickly change the unit's IP address and subnet mask settings as well
as the DHCP enabled-setting of the unit.

 

Use the encoder to navigate through the network menu and turn the encoder to set the individual
settings.
Please note that applying changes to the network setting may take several seconds until the unit is
ready to proceed.
Press CANCEL to return to the main menu without changes.

Output Menu

The output menu gives you a direct access to the available default resolutions.
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Use the encoder to navigate and choose from the list of display modes.
To enable Output2 please make sure that the check box next to Output2 is checked in order to setup
both outputs.

Please note:  The current version of Pandoras Box Server supports only matching resolutions on both
outputs.

For more advanced resolution and refresh rate setups please use the onscreen menu to open the Output
Nvidia Control Panel window.

Press CANCEL to return to the main menu without changes.

Pattern Menu

When working offline (i.e. neither Pandoras Box Master or Client is running) you may assign test-
patterns to the outputs.

Press MENU to return to the main menu, the last selected pattern will stay active until it is changed or
rebooted.

Playback Menu

The functions of the playback menu are enabled when Pandoras Box is in Master mode in order to
control the timeline. When working in Master mode, the playback buttons are enabled as well. 

- Press PLAY to run the timeline.
- Press STOP to reset the timeline to 00:00:00:00
- Press LAST to jump to the last cue available
- Press NEXT to jump to the next cue available
- Edit GOTO TIME lets you enter a specific timecode to jump to after you entered all value in hh:mm:ss:ff
format
- Edit GOTO CUE lets you enter a specific cue number to jump to.
- Press MENU to return to the main menu.

Mode Menu

The mode menu defines which version is loaded for the onscreen menu buttons. It also determines which
Master or Client mode to choose if multiple revisions are installed on the unit.

In the top scroll list you may choose one of the installed revisions.

Choose the mode you want to start by clicking on either Master or Client. 
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To start a chosen mode, select START. 
To close a running Master or Client, choose CLOSE. 

Press MENU to return to the main menu.

Display Menu

The display menu lets you setup both brightness and contrast of the LCD display.

Press MENU to return to the main menu

Shutdown Menu

The Shutdown Menu lets you either shutdown or reboot the unit.

Press MENU to return to the main menu.
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8.5  DVI and SDI Processor

The DVI Processor and SDI Processor can be purchased as separate products. In the past they were
shipped with the QUAD Players, QUAD Servers, Broadcast DUAL Servers, or Broadcast QUAD Servers.

DVI Processor

The DVI Processor has two functionalities: on the one hand it splits the DVI signals coming from
Pandoras Box hardware thus, it is possible to connect up to 4 monitors, projectors, other display
devices via DVI. Please note that the DVI Processor can handle DVI-D signals only, any adaptation and
conversion to analog signals like VGA or RGBHV is not supported! Many supported resolutions and
timings accord to the international VESA standards. In addition, we included more 50Hz timings. Note
that 75Hz and 85 Hz timings are not included but supported with custom EDIDs.
It is also possible to import custom EDIDs, defining not included resolutions and timings. DisplayIDs are
supported as well; for the sake of simplicity this manual will use the term "EDID" meaning EDID as well
as DisplayID.

All connected devices must support the same EDID. It is not possible to set up different
resolutions per output.

On the other hand the DVI Processor converts the DVI signals coming from Pandoras Box hardware to
SDI signals, wherewith SD-SDI, HD-SDI and 3G-SDI signals are supported. All supported SDI Timing
EDIDs are standardized (EIA/CEA-861-D). The SDI signals accord to the specifications of SMPTE
(274M, 296M, 125M, ITU-R BT.656).

The DVI Processor settings can be called via the PB Menu , please find their description in the
software chapter  whilst the hardware  is explained in detailed on the following page.

SDI Processor

The SDI Processor converts the DVI signals coming from Pandoras Box hardware to SDI signals,
wherewith SD-SDI, HD-SDI and 3G-SDI signals are supported. All supported SDI Timing EDIDs are
standardized (EIA/CEA-861-D). The SDI signals accord to the specifications of SMPTE (274M, 296M,
125M, ITU-R BT.656).

Optionally, the SDI Processor splits each signal into two slices. Each output signal is duplicated, thus it
possible to connect up to 8 monitors, projectors, other display devices via SDI.

All connected devices must support the same EDID. It is not possible to set up different
resolutions per output.

The SDI Processor settings can be called via the PB Menu , please find their description in the
software chapter  whilst the hardware  is explained in detailed on the following page.
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8.5.1  DVI and SDI Processor Hardware

After dismantling please connect the DVI or SDI Processor to the power supply unit and plug the USB
cable. The blue LEDs confirm the connected status.

We recommend establishing a network access via VNC. Depending on your display device it may scale
the signal if it cannot display it properly, but it is possible as well that the display devices will stay black
completely if you choose a resolution they do not support at all. Thus you will not see the desktop and
the menu anymore. 

The required driver for the DVI and SDI Processor is pre-installed. All drivers and their updates are free to
download on the homepage's Download-Center after login. 

Shut down the Player / Server. Do never hotplug the inputs into the DVI / SDI Processor as the graphic
card driver might get damaged and needs to be reinstalled. Connect the DVI / SDI Processor's two
inputs with the graphic card's outputs via the short DVI (dual link) cables provided. Please be sure, not to
use other ones, especially longer cables in order to avoid signal noises or even breakdowns.

Connect the DVI Processor's outputs (either DVI or SDI) to your devices. Contrary to the inputs, the DVI
Processor's outputs are hotplug-able.
Connect the SDI Processor's SDI outputs to your devices. Contrary to the inputs, the SDI Processor's
outputs are hotplug-able.

Please make sure that the DVI / SDI Processor is powered before switching the Player / Server on.

All connected inputs and outputs are indicated by a blue LED. Red LEDs indicate that the signal is not
passing through.

When choosing a different EDID all LEDs except the power and USB LED turn off, then according to
your setting the input and output LEDs will change to magenta, red or blue once or twice. Please wait 5
seconds until the desktop background images are displayed properly and do not change anymore. If you
choose different settings too fast, the graphic card driver might come into conflict. Then the two input
LEDs will stay red no matter what EDID you choose. Please reboot the hardware.

LED Status of DVI Processor:

DVI input red inactive, no valid signal detected or input not connected

blue active, DVI single link signal detected

magenta active, DVI dual link signal detected

Sync status off / blue currently not used

DVI output off deactivated

red inactive, no valid signal

blue active, valid signal output

SDI output off deactivated

red inactive, no valid signal

blue active, valid signal output

USB / Power off deactivated, input not connected

magenta device is booting

blue active

http://www.coolux.de/index.php?id=dowload-center#file/cat-12/cat-52
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LED Status of SDI Processor:

DVI input red inactive, no valid signal detected or input not connected

blue active, DVI single link signal detected

magenta active, DVI dual link signal detected

Sync status off / blue currently not used

SDI output off deactivated

red inactive, no valid signal

blue active, valid signal output

USB / Power off deactivated, input not connected

magenta device is booting

blue active

8.5.2  Software - Quad Setup Menu

Before accessing the DVI / SDI Processor's  software settings, please connect it as explained in the
previous hardware chapter . Now, you may access the menu by clicking "Setup" > “Display Setup”. If
the DVI / SDI Processor is not connected properly the button opens the NVIDIA control panel. In that
case please check that the USB cable and power supply are connected and that the USB driver is
installed properly. Then press “Shutdown” > “Reset Menu”.

With choosing the resolution and frame rate in the Quad Setup Menu, most of the changes and settings
within the NVIDIA Control Panel have become obsolete. The only setting not influenced is the order of
the primary and secondary screen. If you want to change it you may do so within the NVIDIA Control
Panel as usual, as this does not influence the setting of the Quad Setup Menu.

In case the chosen timing does not seem right to you, we advise to have a look in the NVIDIA Control
Panel, if the resolution is set to the native one for sure. The native resolution is now reported by the DVI /
SDI Processor, not the display devices. In general, the driver is told to switch to the native resolution
when the DVI / SDI Processor changes its timings. Please do not change any other resolution settings
in the NVIDIA Control Panel as they will influence the DVI / SDI Processor's incoming signal but as the
setting for the output ports are not changed, the displayed image will look as if it were cut off. 

Thus the workflow is to take the resolution changes in the Quad Setup Menu only and to check in the
NVIDIA Control Panel if the driver has switched to “native”. Below, you find the available options for the
DVI Processor's output configuration and at the end of this chapter the SDI Processor's output options

. The next chapter explains how to create a new timing  in case you like to complement the below
output presets.
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Output Configuration for the DVI Processor

- Dual Mode – 2x Input 2x DVI Output

The primary Windows screen is distributed to
DVI output 1 and 2. The secondary Windows
screen is distributed to DVI output 3 and 4.

(The SDI outputs are inactive if the chosen
EDID does not apply to one of the supported
SDI specifications. If it does, the primary
screen is passed to SDI output 1 additionally,
as well as the secondary Windows screen is
passed to SDI output 2.)

The button "Auto Generate Timing" generates
a timing based on the information from the
device plugged into DVI output 1. The timing
is applied to DVI output 1-4 and the incoming
signal is set accordingly.
The new timing is saved as an *.edid file in
the according sub folder under C:\system

\LCD_Menu\Quad DVI SDI Modes. It

also appears in the according menu with a
distinct name e.g. 1920x1080@50p

custom AutoGenerated, so that you can

select it later again.

The button "Create New timing" opens a
dialog to define any custom resolution. The
dialog is explained in the next chapter .

With both options, "Auto Generate Timing"
and "Create New Timing", you add a new
EDID to the output presets. As you are in a
"Dual Mode", the EDID will be assigned to
the graphics card outputs one-to-one. This
behavior differs to the one from the "Quad
Modes".

708
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- Quad Mode – 2x Input 4x DVI Output (max
720p)

The left half of the primary Windows screen is
shown on DVI output 1, the right half on DVI
output 2. The left half of the secondary
Windows screen is shown on DVI output 3,
the right half on DVI output 4. 

All resolutions and frame rates available are
specified as single link DVI standard.

(The SDI outputs are inactive if the chosen
EDID does not apply to one of the supported
SDI specifications. If it does, the primary
screen is passed to SDI output 1 additionally,
as well as the secondary Windows screen is
passed to SDI output 2.)

The button "Auto Generate Timing" generates
a timing based on the information from the
device plugged into DVI output 1. The timing
is applied to DVI output 1-4 and the incoming
signal is set accordingly.
The new timing is saved as an *.edid file in
the according sub folder under C:\system

\LCD_Menu\Quad DVI SDI Modes. It

also appears in the according menu with a
distinct name e.g. 1920x1080@50p

custom AutoGenerated, so that you can

select it later again.

The button "Create New timing" opens a
dialog to define any custom resolution. The
dialog is explained in the next chapter .

With both options, "Auto Generate Timing"
and "Create New Timing", you add a new
EDID to the output presets. As you are in a
"Quad Mode", the EDID will automatically be
doubled to replace the resolution of the
graphic card outputs. If this timing does not
exceed a DVI Single Link timing, you will find
it in the menu "Quad Mode – 2x Input 4x DVI
Output (max. 720p), otherwise it will be
added to the "...max.1080p / 2k).

708
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- Quad Mode – 2x Input 4x DVI Output (max
1080p / 2K)

The left half of the primary Windows screen is
shown on DVI output 1, the right half on DVI
output 2. The left half of the secondary
Windows screen is shown on DVI output 3,
the right half on DVI output 4. 

All resolutions and frame rates available are
specified as dual link DVI standard.

The SDI outputs are inactive.

The button "Auto Generate Timing" generates
a timing based on the information from the
device plugged into DVI output 1.The timing is
applied to DVI output 1-4 and the incoming
signal is set accordingly.
The new timing is saved as an *.edid file in
the according sub folder under C:\system

\LCD_Menu\Quad DVI SDI Modes. It

also appears in the according menu with a
distinct name e.g. 1920x1080@50p

custom AutoGenerated, so that you can

select it later again.

The button "Create New timing" opens a
dialog to define any custom resolution. The
dialog is explained in the next chapter .

With both options, "Auto Generate Timing"
and "Create New Timing", you add a new
EDID to the output presets. As you are in a
"Quad Mode", the EDID will automatically be
doubled to replace the resolution of the
graphic card outputs. If this timing does not
exceed a DVI Single Link timing, you will find
it in the menu "Quad Mode – 2x Input 4x DVI
Output (max. 720p), otherwise it will be
added to the "...max.1080p / 2k).

708
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- SDI HD Mode – 2x Input 2x SDI Output
(1080i/p / 720p)

The primary Windows screen is passed to
SDI output 1, the secondary Windows screen
to SDI output 2.

All resolutions and frame rates available are
specified as HD-SDI standard.

The DVI outputs are inactive.

The button "Create New timing" opens a
dialog to define any custom resolution. The
dialog is explained in the next chapter .708
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- SDI 3G Mode – 2x Input 2x SDI Output

The primary Windows screen is passed to
SDI output 1, the secondary Windows screen
to SDI output 2.

All resolutions and frame rates available are
specified as 3G-SDI standard.

The DVI outputs are inactive.

The button "Create New timing" opens a
dialog to define any custom resolution. The
dialog is explained in the next chapter .708
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Output Configuration for the SDI Processor

- Quad HD Mode – 2x Input 4x SDI Output
(max 1080i/p / 720p)

The left half of the primary Windows screen is
shown on SDI output 1 and 2, the right half on
SDI output 3 and 4. The left half of the
secondary Windows screen is shown on SDI
output 5 and 6, the right half on SDI output 7
and 8. 

All resolutions and frame rates available are
specified as HD-SDI standard.
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- Quad 3G Mode Level A – 2x Input 4x SDI
Output

The left half of the primary Windows screen is
shown on SDI output 1 and 2, the right half on
SDI output 3 and 4. The left half of the
secondary Windows screen is shown on SDI
output 5 and 6, the right half on SDI output 7
and 8. 

All resolutions and frame rates available are
specified as 3G-SDI standard.
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8.5.3  Software - Create New Timing

This chapter explains the dialog "Create New timing" that can be called from within the configuration
menus  from the DVI Processor . Please note that the term "EDID" means EDID as well as
DisplayID.

The dialog offers settings to define a custom timing, which includes the settings to...:

- create an entirely new EDID
- read out a display's EDID or load it from a file
- modify EDIDs
- save new EDIDs to a file and generate a preset for the DVI Processor's output configuration menus.

Name
You can name your timing optionally. In case the timing is displayed as an preset in the output
configuration menus, the name appears at the end of the entry, e.g. 1920x1080@50p custom

"name". In addition, the name is also mentioned in the NVIDIA control panel as it is part of the EDID

Descriptor Block.

Load File
Use “Load File ...” to load a stored EDID into the dialog. You can edit the timing, generate an output
preset or save it as an *.edid file.

Save File
Use “Save File ...” to export the currently displayed EDID timing into a *.edid file.

700 698
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Read Output 1...4
These buttons generate a timing based on the information from the device plugged into the according DVI
output. Note that SDI outputs can not be read-out. The timing is displayed in the dialog. Note that all
values will equal zero if no valid EDID can be read. You can edit the timing, generate an output preset or
save it as an *.edid file.

Generate & Exit
This option generates an output preset based on the currently displayed timing and closes the dialog.

Please note, that it is of importance from which menu you opened the dialog. If you were in the DVI
"Dual Mode" (2in 2out), your EDID is assigned to the graphics card outputs one-to-one. In case you were
in a DVI "Quad Modes" (2in 4out, either Single Link with max. 720p or Dual Link with max.2k), your
EDID is automatically doubled as the graphic card outputs are split in the Quad Modes. In both cases
the displayed timing in this dialog and the entry in the menus always refer to the Processor's outputs.

The new EDID is saved as an *.edid file in the according sub folder under C:\system\LCD_Menu

\Quad DVI SDI Modes. It also appears in the according menu with a distinct name e.g.

1920x1080@50p custom (optional name). Go to the DVI Processor's output configuration menu

and select it to apply it to DVI output 1-4 whilst the incoming signal is set automatically.

Cancel
Use "Cancel" to close the dialog and discard all settings.

EDID Description

The EDID Description shows the content of the “First Detailed Timing Descriptor Block” along with the
“Monitor Name” out of the EDIDs “Descriptor Block 2”.
The displayed information changes automatically when "Load File" or "Read Output 1...4" is used. You
can edit the timing, generate an output preset or save it as an *.edid file as described above. 

Detailed Timing

Name Read out or change the monitor name with a maximum of 13 characters.

PixelClock
This value shows the signal’s PixelClock in MHz.
The maximum value is 330.

Rate Hz
This value shows the signal’s Refresh Rate in Hz when an EDID is loaded. It results of
all other definable settings regarding pixel count and PixelClock.

Res X
This value shows the signal’s active pixel per horizontal line. Active pixels are the
shown ones within a display device and equal the horizontal resolution.
The maximum value is 4095.

Res Y
This value shows the signal’s active lines per image. Active lines are the shown ones
within a display device and equal the vertical resolution.
The maximum value is 4095.

Blank X

This value shows the signal’s total horizontal blanking pixels including (definable) front
porch, (definable) sync width and (resulting) back porch.
The combination of the horizontal active, blanking and border pixels equals the
picture’s horizontal total pixels.
The maximum value is 4095.

Blank Y

This value shows the signal’s total vertical blanking lines including (definable) front
porch, (definable) sync width and (resulting) back porch.
The combination of the vertical active, blanking and border lines equals the picture’s
vertical total lines.
The maximum value is 4095.

H Sync Off
This value shows the signal’s horizontal sync offset (front porch) in pixels.
The maximum value is 1023.
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V Sync Off
This value shows the signal’s vertical sync offset (front porch) in lines.
The maximum value is 1023.

H Sync Width
This value shows the signal’s horizontal sync width in pixels.
The maximum value is 1023.

V Sync Width
This value shows the signal’s vertical sync width in lines.
The maximum value is 1023.

H Img Size
This value shows the monitor’s horizontal image size in mm. This information value is
optional and has no influence on the signal processing.
The maximum value is 4095.

V Img Size
This value shows the monitor’s vertical image size in mm. This information value is
optional and has no influence on the signal processing.
The maximum value is 4095.

H Border
This value shows the signal’s horizontal border in pixels.
The maximum value is 255.

V Border
This value shows the signal’s vertical border in lines.
The maximum value is 255.

Interlaced
This check box shows if the signal is interlaced (checked) or progressive
(unchecked).

Sync Signal
Readout or select the desired sync option required by the signal.
Depending on the chosen sync option, there are additional check boxes to be de-/activated.

Stereo Mode
Readout or select the desired Stereo Mode required by the signal.
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8.6  Input and Output Cards

This chapter will be updated soon with links to new sub chapters.

This chapter includes information about input and output boards for the Server and Player hardware. For
other hardware components regarding the Server  and Player hardware  itself, please see the
according topics. If you are interested in other Christie Pandoras Box hardware, please see the
introductory chapter Hardware and Accessories .

For all cards it is recommended to check the Download-Center from time to time in order to always use
the up-to-date driver.

Graphics Card

The graphics card is the only board included be default in every hardware. For the time being, the Server
and Player hardware come with the same NVIDIA graphics card. Please see the chapter Graphics Card
Settings .

Optional Boards

There are various input and output boards available for the Server and Player hardware.

Sync Card
The Sync Card allows for a frame lock option for frame and pixel line accurate synchronization. With the
card you can either generate an internal sync or lock to an incoming signal.

Audio In- and Output Cards
Audio Cards allow for more audio input and output channels to be used in Pandoras Box. They also
include a MIDI option. The cards offer various audio protocols and connections.
ADAT Audio Card (8 or 32 channel)
MADI Audio Card (64 channel)

Video Input Cards
3G-SDI Input Cards (Single, Dual and Quad)
DVI Input Cards (Single and Dual)

Custom Boards

If you prefer to install a custom board please bear in mind that hardware changes void the warranty. In
addition, using Christie Pandoras Box Input and Output Cards guarantees the best software support
especially in terms of synchronization and latency. Regarding other live inputs, please note that
Pandoras Box supports only input devices that are conform and support DirectShow.

684 688
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8.6.1  Graphics Card Settings

All Pandoras Box hardware (Server, Player and Manager) is equipped with NVIDIA graphics cards. 

The NVIDIA Control Panel allows to change the current output settings, e.g. the resolution or the way
multiple displays should be addressed.

With Pandoras Box Dual Servers or Players you will be able to open the NVIDIA
Control Panel via the "Display Setup" button of the PB Menu  to manually set
resolutions and display settings. 

However, with a connected DVI Processor (e.g. Pandoras Box Quad Servers or
Players) this button opens another dialog which includes an "NVIDIA Control
Panel" button in the bottom left corner. For detailed information for handling the 
DVI Processor  please see its chapter.

In case you are working with a Server that is equipped with a LCD Menu , you
may access basic resolution settings through the front panel i.e. without the
NVIDIA Control Panel.

Please see the following topics:
- Changing the resolution
- Setting up multiple displays  (horizontal span and Dualview)
- Setting up the frame lock option
- Installing and setting the graphics driver
- ATI cards  (discontinued)

Do not disconnect any VGA or DVI display cable from the graphics card during runtime!
When changing display cables directly on the graphics card, coolux recommends to always
shut down the system first!

In addition it is required to close the Pandoras Box Client or Master software BEFORE
modifying the display setting.
Restart Pandoras Box software after applying changes regarding the resolution or display
mode.

8.6.1.1  Changing the Resolution

This topic explains how to change a resolution with the NVIDIA Control Panel . The next topic
describes the setup of multiple displays , synchronization  and driver update .

In the NVIDIA Control Panel you may choose from any of the reported display resolutions by selecting
the "Change resolution" menu in the task tree on the left of the control panel. To change the resolution of
a specific display, click on the monitor icon and then select one of the available resolutions below to set
the desired resolution for the selected output.

Please remember to close the Pandoras Box Client or Master software before clicking "Apply" to modify
the display setting.
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If the desired resolution is not listed in the change resolution menu, you may click the "Customize"
button below the list of available resolutions to set up custom timings and refresh rates that are
supported by your display. For more detailed timing settings please use the "Advanced>>" menu.

Please be aware that changing your graphics card to unsupported resolutions and frequencies might
damage your display and graphics card. coolux can not be held liable for any damages that may occur
from these custom setups. Instead of creating custom timings, coolux recommends to use EDID
managers to force the graphics card into the resolution you need.
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8.6.1.2  Multiple Displays

This topic explains how to setup multiple displays with the NVIDIA Control Panel . The previous topic
describes how to change a resolution , the next ones how to frame lock displays  and update the
graphics driver .

Setting up multiple displays in "Horizontal span"

If your Server or Player runs as a Master or Client and is connected with multiple displays and you need
to render full screen on all displays, it recommended to use the mode "As one large horizontal desktop
(Horizontal span)". This ensures best video rendering and (synchronous) playback performance.
In case you are using a Master system, please note that it is not possible to see the user interface any
more.

This mode will also force the graphics card to use the same resolution on both outputs. It is not possible
to use different resolutions or frequencies!

If you like to swap the order of the two displays you may open the drop-down list as highlighted in the
image and choose another entry.

Please remember to close the Pandoras Box Client or Master software before clicking "Apply" to modify
the display setting.

Setting up multiple displays in "Dualview"

If your Server, Player or manager runs as a Master and is connected with multiple displays and you wish
to see the user interface at the same time as a full screen preview, it recommended to use the mode
"Dualview". This enables two independently configurable outputs, a so called primary screen and a
secondary screen. The Preview tab in Pandoras Box can only be rendered on the primary screen. You
may change the order by choosing another entry in the according drop-down list. 

Please note that since version 5.7 Pandoras Box supports different resolution and frequency on outputs.

To run Pandoras Box in Master mode with this setup above you also have to enable an option in the 
Configuration tab  section Render Engine . The check box "Fullscreen is single" will allow to decide
which output toggles into fullscreen and which one does not in order to view the user interface at any
time.
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8.6.1.3  Setting up Frame Lock

This topic explains how to setup the frame lock option for frame and pixel line accurate synchronization.
Please refer to the main chapter if you are interested in other NVIDIA settings  e.g. settings for
resolution, multiple displays and the driver.

General information regarding frame lock

The frame lock option is for NVIDIA cards with a sync board, e.g the K5000. These graphics cards have
the possibility to synchronize the output to an external frame lock signal. They are per default available
for Broadcast Servers, but are optional for all other Servers too.

In order to input the sync signal, plug the BNC cable into the sync board located next to the graphics
card. Make sure that the sync signal fits to the resolution and frame rate that is set up in the graphics
card for the displays attached.
Then the below described driver settings are necessary to set up the graphics card. It will then clock to
the incoming signal. This procedure might take up to 10 minutes as the card's clock needs to shift step
by step towards the external clock.

To synchronize the graphics clock to the external clock directly, has the advantage of saving latency.
The not-direct way would be to not set up the frame lock option in the Server but to input the Server's
output into another frame lock device which then locks the image to the external clock, e.g a Frame
Buffer or Frame Synchronizer. This workflow causes a latency of one frame.
In no scenario it is currently possible to frame lock the live input of Pandoras Box. If you need frame
locked inputs, you need to feed the sync signal to the device that produced the live feeds and make sure
that the live inputs are fed frame locked into Pandoras Box.

Setting up the frame lock option for one system

To set the frame lock option, open the NVIDIA Control Panel as described in the first chapter .

The first step is to set up the outputs in the so-called Dualview:
- go to "Display > Set up multiple displays"
- under "1", choose Dualview
- under "2", open the drop-down and make sure the depicted setting is chosen "Output (1 of 2) + Output
(2 of 2). In most cases you probably have the DVI Processor attached to the Server, hence one output is
called "CLX DVI-Proc"
- under "3", choose "Output (1 of 2)" as the primary display
- "Apply" the settings
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Check the resolution and framerate as described in the chapter "Changing the resolution" .

The second step is then to set up that the first output listens to the external clock but the second output
to the first one, in other words, to the internal clock:
- go to "Workstation > Synchronize displays"
- under "1", click the second option "Onto this system"
- highlight the "Output (1 of 2)" and
- under "2", make sure that the check box is ticked to synchronize "Output (2 of 2)" to the first output
- "Apply" the settings.

Third step: In the "Synchronize displays" window, click the button "Server Settings" to set the properties
of the frame synchronization pulses generated by the timing server:
- choose the setting "An external house sync signal" as the basis for the synchronization pulses
- make sure that the sync frequency matches with the frame rate
- only if needed, change the drop-down list for the sync signal detection and tick the check box whether
the "signal is interlaced"
- choose how the sync pulses from the frame start signal should be triggered: leading -, falling -or both
edges
- in most cases the outgoing sync interval is 0
- set the correct Sync delay, then "Apply" the settings to verify their correctness
In the depicted example, the sync delay is 300µs, but this number depends on your setup and the
current graphics card clock. It is likely you will have to try out different delays. As experienced, it is
mostly 300-500µs, you may start with 300µs and increase in 50µs steps if it was not correct. Mind that it
takes the system up to 10 minutes to reach the set clock.
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Forth step: You may check in "Workstation > View system topology" whether all settings are correct:
- the external sync signal should be present and in use
- the frame lock sync pulse should be present
- the first DVI should be listed with "Output (1 of 2)", the second with "Output (2 of 2)"
- the first output's display state should be "Server" and its timing depends on the external house sync
signal
- the second output's display state should be "Client" and its timing depends on the internal frame lock
sync pulses
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Setting up the frame lock option for one stand-alone system

This describes, how to set up the frame lock for one machine that needs to frame lock its both outputs,
but does not receive an external timing. This might be needed when you need to frame lock both (or the
four) outputs 100%, e.g. if you pass the output signal to a 4K screen / projector that does not include a
frame buffer and needs to have frame locked input signals. 

No cables are connected to the sync board.
The above settings regarding the first step to set up DualView, apply as well. Nothing changes in the
second step either, in "Workstation > Synchronize displays" under "Onto this system", synchronize the
second output onto the first one.
Nothing must be set up in the dialog "Server settings".

In "Workstation > View system topology" the timing for the first output says"Synchronized to an internal
timing", the second stays on the internal frame lock sync pulses.

Setting up the frame lock option for several systems

If you have more than one machine that need to be frame locked, one machine is the so-called "Master"
whilst the others are "Slaves".

The Master is set up as described above, either with the external sync or with the internal one if you only
want to synchronize the Pandoras Box playback systems to each other. The Master provides an
external sync signal via the RJ-45 plug on its synchronization board. Connect the board's output with an
ethernet cable to the input of the next Server, which is then the slave. You may daisy-chain the sync
signal in this way to all slaves.
In "Workstation > View system topology" 
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For the slaves, the above settings regarding the DualView step, apply to the slave as well. As a second
step, do not choose "Onto this system" but "Onto another System", this applies for the first and second
output. In other words, tick both check boxes. 

In "Workstation > View system topology" the lines "Framelock..." have changed as you now use the
ethernet plugs: "Framelock 0" and "Framelock 1" should automatically change to "Input" or "Output".
The timing for the first output says"Synchronized to an internal timing", the second stays on the internal
frame lock sync pulses.

8.6.1.4  Graphics Driver

This topic explains how to install and setup a new graphics driver and how to check your current driver
version. Please refer to the main chapter if you are interested in other NVIDIA settings .

Installing a graphics driver

The graphics card driver on your coolux hardware product is tested and certified by us for best video
rendering and playback performance. Even if the installed driver might not be the newest one available
from the NVIDIA website it is NOT recommended to update this driver to their latest one.

If it's necessary or you were told by our support team to reinstall or update the graphics card driver
please follow these steps:

1) Download the driver according to your hardware version. Please refer to the coolux Download Center
for recommended driver versions.

2) Run the driver setup in user custom (advanced) mode.

3) Deselect the options for NVIDIA update and nView but select the option for "Perform a clean
installation"

4) After the installation is finished please reboot the computer, also if it does not do it automatically

5) After the reboot go to the NVIDIA Control Panel, section "Manage 3D settings" and change the
following options to match the coolux defaults:

Antialiasing – Gamma correction = OFF

Maximum pre-rendered frames = 1

Texturing filtering = High Quality

Vertical Sync = Force ON
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Checking the current driver version

You can always see which graphics card model and driver version is installed in your coolux hardware by
clicking on the "System Information" button on the bottom left corner of the NVIDIA Control Panel. 

In the upcoming window you can see the graphics card model on the left and the driver version in the first
line on the right part of the window.
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8.6.1.5  ATI Cards

This topic explains how to apply display settings for ATI graphics card. Please note that Pandoras Box
hardware is now equipped with nVidia cards . Only Rev3-hardware was equipped with ATI X1800 /
X1900 cards. However, this topic might also be of interest for users who run Pandoras Box on their own
hardware that is equipped with an ATI card. In that case please note that the below menus description
and images might change according to the used driver.

The ATI graphics card allows several output configurations based on the alignments you make in the
display settings. ATI supplies the Catalyst Control Center for detailed display setup.

To configure the graphics card’s outputs, please setup your display configuration and resolution in the
display manager.

In case that you have a system with an earlier card than the ATI X1800, please contact coolux for an
upgrade or hardware trade-in of the system.

Pandoras Box Server Output Resolutions with ATI X1800 / X1900 Cards
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SingleOutput DVI / RGBHV DualOutput DVI / RGBHV

640x480 VGA 1280x480 2x VGA

800x600 SVGA 1600x600 2x SVGA

1024x768 XGA 2048x768 2x XGA

1280x720 HD 720p 2560x1024 2x SXGA

1280x1024 SXGA 3200x1200 2x UXGA

1400x1050 SXGA+

1600x1200 UXGA

1920x1080 HD 1080p

2048x1536 SUXGA

Refresh Rates 50*, 60 or 75hz

*50hz Modes can be set via the EDID of the attached display.

Please note: 
not all displays allow specific EDID settings, please use an EDID manager or a comparable device to set
custom frequencies.

S-Video (Pal/Ntsc) – Output thru the onboard S-Video and Composite connector

Please note: 
when using display devices that support EDID (Extended display identification data) via DVI, please
reboot the Server in order to get the EDID information and settings in the Catalyst Control Center

After changing these settings, please restart the Pandoras Box Server application to apply the changed
settings of the graphics card.

SINGLE OUTPUT MODE

Once your system is connected to a single display, it is by default set to single output mode. If you want
to add or change the display configuration, please shut down all Pandoras Box applications before
making any changes. 
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DUAL OUTPUT MODE

When a new display is connected to the graphics card, it will be shown in the “Attached displays
currently disabled” section.

Right-Click on the disabled display and choose “Stretch Main horizontally onto digital panel”



725

Once the display settings are changed, you will have to confirm these changes, otherwise the graphics
card will reset to the previous settings.
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Once confirmed, you may adjust the overall desktop area resolution, colour quality and refresh rate.
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Please note: The driver allows only specific resolutions in dual output mode.
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SINGLE FULLSCREEN MODE

If you want to use Pandoras Box in single fullscreen mode in order to display the user interface on the
secondary monitor, please set the secondary output to “Extend Main horizontally onto digital panel”

When using the extended display mode, Pandoras Box will only be rendering on the primary output,
while the user interface can be operated on the secondary output.
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CLONE MODE

If both outputs should be set up to always emit the same content, the output can be set up to be cloned.
Simply choose the right click option “Clone Main with digital panel” 
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8.6.2  Winnov Videum 4400 VO / Xpress (Composite)

Configuration

Please note: 
Make sure to always use the up-to-date driver from our homepage. Visit our user forum www.coolux.de/
kb, you will find all input card drivers under Downloads - Drivers - Input Card drivers. A short registration
is required.

To configure the Composite Capture Card, please click on [Configure Live Inputs] and choose your
Composite Capture Card from the live input list (Client Mode) or mark your Input Device in the Project
Tab and click on [Configure] in the Inspector Tab (Master Mode).

http://www.coolux.de/kb
http://www.coolux.de/kb
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Choose the video standard (NTSC or PAL). 
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If you want to crop some parts of the input signal (for example a timecode at the bottom), do it by
defining values for the 4 sides of the Input Rectangle.
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Brightness, Contrast, Hue, Saturation and Sharpness of the Input Signal can be adjusted by moving the
faders.
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The Information Control Panel simply provides useful information such as the product name, installed
driver version, and PCI bus number. This information may be requested by our support if a problem
occurs.
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The Overlay Tab, in which you normally can add graphics as an overlay on the image, is enabled by
using with Pandoras Box.
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In the Processing Amplifier Tab an automatic luminance and chrominance control is set by default. By
unchecking ‘Auto’ you can set new values manually. 

To set new values for brightness, hue, saturation, contrast and sharpness you can do it by moving the
faders left and right or typing the values in the textboxes next to the faders.

To capture the input signal in grey scale, uncheck ‘Color Enable’. You may also flip the image
horizontally or vertically.

After clicking OK the Output Pin Properties Dialog appears. Please set here the frame rate, colour space
and output size.
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Please note:
Using the Winnov Videum Video Control Panel (you will find it here: WindowsStart/Programs/Winnov/
Videum/Video Control Panel) you also can adjust the processing amplifier settings per board/channel/
source. The settings are modified out of process and independent of software using the drivers. 

As the Winnov Videum Capture Card works like a matrix, you can set in the Video Control Panel you
can set which physical source will be linked to which channel.

To do this, choose the channel from the 4 channel tabs and set the source by the source scroll down
list.

After clicking OK the Output Pin Properties Dialog appears. Please set here the frame rate, colour space
and output size.
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8.7  Controller Boards

The Jog Shuttle Controller and the Fader Board Extension can be purchased as an optional accessory
for Pandoras Box products, e.g. a Manager.

The Jog Shuttle Controller  allows to control up to two sequences. Based on the selected sequence
16 cue buttons let you go to 16 cues directly.
The Fader Controller  is the extension for the Jog Shuttle Controller and allows to control up to 6
sequences.

See here information about the products Jog Shuttle  (discontinued) and Playback Extension
(discontinued).

8.7.1  Jog Shuttle Control

The Jog Shuttle Controller is available to control up to two sequences.

Based on the selected sequence (use the select button for each sequence) the top 16 cue buttons let
you go to 16 cues directly.
Based on the selection, use the Jog Shuttle controller to navigate back and forth through the timeline.
The fader on the left will control one sequence; the fader on the right will control a second sequence.

Please note:
The faders and cue buttons need to be mapped in Pandoras Box in order to control the sequences and
to jump to cues! Use the Controller Setup Tab  in Pandoras Box Master System to set up this
mapping.

FADER CONTROLS+

SELECT (Button above fader):

Selects the sequence. The blue led on the button will light as indicator for the selection.
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As soon as a sequence is selected, all Cue Buttons as well as the Jog Dial and the Playback Buttons
are linked to this sequence!

LED light status:
Blue LED is on: Sequence is selected.
Red LED is blinking: Sequence status is “Play”
Red LED is on: Sequence status is “Pause”

FADER: 
Controls the sequence opacity.

Fader position on top = Opacity FULL
Fader position at bottom = Opacity 0%

PLAY/PAUSE (Button below fader):
Toggles the Sequence between Play and Pause. This Play/Pause Button can be used without having the
sequence selected via the SELECT-Button.

CUE BUTTONS
For each sequence you may assign the 16 Cue Buttons via the Controller Setup Tab in Pandoras Box.
Depending on the selected sequence, the Cues Buttons are linked to this sequence.
The last Cue Button pressed will light up in blue.

JOG DIAL
The Jog Dial allows scrolling through the selected sequence:
The inner knob allows scrolling frame by frame, the outer know does a faster scrolling.

PLAYBACK BUTTONS
Depending on the selected sequence, the Playback Buttons are linked to this sequence.

LAST / NEXT CUE
These buttons allow to step backward / forward from cue to cue.

PLAY / PAUSE
This button toggles the selected sequence between the playmodes Play and Pause.
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8.7.2  Fader Extension

The Fader Controller Board acts as extension for the Jog Shuttle Controller . It allows controlling 6
more sequences.

The faders need to be mapped in Pandoras Box in order to control the sequences! Use the Controller
Setup Tab  in Pandoras Box Master System to set up this mapping.

FADER CONTROLS

SELECT (Button above fader):
Selects the sequence. The blue led on the button will light as indicator for the selection.
As soon as a sequence is selected, all Cue Buttons as well as the Jog Dial and the Playback Buttons
are linked to this sequence!

LED light status:
Blue LED is on: Sequence is selected.
Red LED is blinking: Sequence status is “Play”
Red LED is on: Sequence status is “Pause”

FADER: 
Controls the sequence opacity.
Fader position on top = Opacity FULL
Fader position at bottom = Opacity 0%

PLAY/PAUSE (Button below fader):
Toggles the Sequence between Play and Pause. This Play/Pause Button can be used without having the
sequence selected via the SELECT-Button.

As soon as a sequence is selected on the Fader Extension, the Cue Buttons, the Jog Dial and the
Playback Buttons on the Jog Shuttle Controller are assigned to this selected sequence.
See the Jog Shuttle Controller  for more information about Cue Buttons, Jog Dial and Playback
Buttons.
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8.7.3  Jog Shuttle Control (Discontinued)

The Jog Shuttle Controller is available to control up to two sequences.

Based on the selected sequence (use the select button for each sequence) the top 18 cue buttons let
you go to cue 1-18 directly.

Based on the selection, use the Jog Shuttle controller to navigate back and forth through the timeline.

The keyboard block on the left will control the sequence with the ID 1, the block on the right will control
the sequence with the ID 2.

For each sequence choose:
SELECT: selects the sequence
ON/OFF: to hide all layers from the selected sequence
KEY LAST/NEXT
CUE LAST/NEXT
STOP PAUSE
PLAY

Use the “STORE” key to store all currently active value to the selected sequence.

Use the “CUE” key to store a new cue at the current time of the selected sequence.

Use “COPY” and “PASTE” for key frames in the selected sequence.

Use “RESET” to reset all devices to default.

Use “DELETE” to delete chosen keys in the selected sequence.
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8.7.4  Playback Extension (Discontinued)

The Playback Extension enables a Pandoras Box Manager PRO to control up to 8 individual sequences
directly, plus giving access to the command line architecture via the numeric keypad and dedicated
command buttons. 

Depending on the desired operation, any command line input must be started with a mode button:

“VIEW”, “GROUP”, “DEVICE”, “SEQUENCE”, “PRESET” and ends with pressing the “ENTER” key.

DEVICE CONTROL

Within the device tree, all items are organized in nodes that the devices belong to. In the properties you
can assign a unique ID for both nodes and devices. For example if you have a Pandoras Box Server in
the device tree, its node ID might be set to 1 and the individual layer ID count from 1 to 10.

DEV 1.5 Enter 
to select layer 5 of node 1.

Once a device is selected, you may use the encoders to adjust the parameters values.
To select multiple devices you can keep adding devices to you current selection by simply selecting
another one.
To clear your current selection press “CLEAR” once.
You may also use the “+” or “THRU” key to select multiple devices at once. For example: DEV 1.1 thru
1.10 Enter or DEV 1.1 + 1.3 Enter.

Once you start changing values with the encoders, wiper or joystick, all changed values will turn red and
get indicated as active values. Active values will be processed during a store-operation. If a parameter is
inactive it will not be stored at any time.
To de-activate and reset individual values to default, hold down the “RELEASE” key and turn the desired
parameter encoder. In the device tree, the same operation can be achieved by right-clicking on the
individual parameter and choosing “CLEAR ACTIVE”. If you want to clear all active values you may also
double click the “CLEAR” button. To reset all parameters back to default you may click the “CLEAR”
button three times. 

The same commands are also available from the right-click menus in the user-interface in the device tree
or by right-clicking in the time-bar of a sequence. 
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Device Command Overview

[Preview DEV 1 Enter]
switches the Preview window to display the selected device

[Dev 1.1 Enter]
selects device 1.1 and allows access to encoders and parameters

[Dev1.1 + 1.2 Enter]
selects device 1.1 and 1.2

[Dev1.1 thru 1.11 Enter]
selects all devices from ID 1.1 to 1.11

[Align]
Based on the align setting <, >, <> or >< when multiple devices are selected you may align the
parameters according to the align setting. 

[Clear 1x]
Clear Selection

[Clear 2x]
Clear Active

[Clear 3x]
Reset All

[Release + Encoder]
de-activates and resets parameters to default of current selection

[Dev 1.1 Enter Enter]
sets all parameters of selected devices to active 

[ @@ ]
sets opacity value to 255 (100%)

GROUPS

If you need to control a single layer on multiple machines or to add the same values to multiple layers at
once, the device tree control tab allows you to select multiple devices at the same time by clicking and
holding the CTRL key. 
All selected device icons will turn white, showing that they are selection members. 

To release the current selection press ESC or press “CLEAR” once.

Please note: 
When multiple devices are selected, all changes of parameter values will apply to all members of the
selection.

Creating & Editing Groups

Once a single or multiple devices is/are selected, you can store this specific selection as a group in the
group bin of the project tab.

To create a group, please select the desired devices, then right-click on the group bin in the project
folder and choose ‘create group’ or type "Store GRP 5 Enter" to create a new group of the current
selection with the ID 5.



744

To delete a group, right-click on the group element in the project and choose “REMOVE” or type "Delete
GRP 5 Enter".

HINT: When working in device tree editing, you may also use the right-click menu on groups to
determine if the members of the group should be activated, de-activated or reset.

PRESETS

Individual preset banks can be created by right-clicking on the preset folder in the project tab.
For each folder you may open a designated browser as a tab to be stored in views.
The presets are designed to hold a snap shot of active values, to be reused for later programming.

Presets apply to all selected devices. As source, the first stored values for each individual type of
parameter are taken. When creating a preset with two layers that have different opacity values only the
opacity value for the first selected layer will be applied when assigning the preset on a selected device.
Applying a preset always causes setting relevant parameters to active.

The preset folder contains default preset banks for active value filtering during store operation.

This means that by right-clicking on any of these categories only the parameters that match the
category group will be stored there as a new preset.

Global All Parameters

INT Opacity, Transition FX

PRS Position, Rotation, Scale

MEDIA
File Selection, Playback
Controls

OBJ Object Selection

COL Colour FX

AUDIO TBA

FX Video FX

CTRL Camera Control Settings

Preset Commands

[Store|ID.ID|Enter ]
stores a new preset with specified ID.

[Delete|ID.ID|Enter]
deletes selected preset.

[ID.ID|Enter]
if no device is selected, the preset will recall the value to the stored selection 
If devices are selected, the selected preset will be assigned to the entire selection.

SEQUENCE CONTROL

To create a new timeline, enter the following on the console:
"Store SEQ 1 Enter" or simply right-click on the sequences folder in the project tab.

Once the timeline is created, you will have access to it in the sequence tab by selecting it in the project
bin.

Similar to the device control, all sequences can have a unique ID within the project. The ID can be set
during the store operation from the console or via the properties of the sequence itself.
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To load a SEQ into the jog shuttle controller type "SEQ 1 Enter"

To load the SEQ into the sequence tab type "Edit SEQ 1 Enter"

To go to a specific timecode in the selected sequence type "Goto Time hhmmssff Enter"

Time-format is interpreted like this: Hours minutes seconds frames.

You can also type in “1000” => timecode 00:00:10:00.

To generate these new keys in the timeline, you will then have to right-click on the time-bar and choose
“Store active” or type "Store Enter" to store all active values at the current time in the selected
sequence.

SEQUENCE COMMAND OVERVIEW

Store|Enter – stores all active values at current time of selected sequence.

Store|Seq|X|Enter – stores new sequence with ID X.

Store|Cue – stores new cue at current time of selected sequence.

Delete|Seq|X|Enter – deletes specific sequence.

Seq|X|Enter – selects Seq X and loads to Jog Shuttle Controller.

Goto|Time|XX|Enter – jumps to Timecode XX. Use syntax HMSF or e.g. "105" for Timecode 00:00:01:05

Goto|Cue|XX|Enter or Goto|XX|Enter  – jumps to Cue XX

Goto|Time|+/-|HMSF|Enter  – relative movement in the current sequence with the time value HMSF.

Store|Time|HMSF|Playback button  – stores active values to the sequence controlled by playback
button.

Store|Cue|XX|Enter  – stores active values at time of cue XX in selected sequence.

Store|Cue|XX|Time|HMSF|Enter  – creates cue with ID xx at time HMSF in selected sequence.

Store|@|Cue|XX|Enter  – stores active values and creates cue XX in selected sequence.

Store|@|Cue|XX|Time|HMSF|Enter  – stores active values and creates cue with ID XX at time HMSF in
selected sequence.

Delete|Cue|ID|Enter  – deletes selected cue.

Delete|Cue|ID|Thru|ID|Enter  – deletes cues within selected ID range.

Delete|Time|HMSF|Enter  – deletes all keys at selected time.

Delete|Time|HMSF|Thru|HMSF|Enter  – deletes all keys in selected time range, independent of activation
of selection of devices.

Delete|@|Cue|ID|Enter  – deletes all keys at time of the selected cue ID.

Delete|@|Cue|ID|Thru|ID|Enter  – deletes all keys in selected sequence which are between the entered
Cue IDs.
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Delete|TYP|...|Enter, with TYP @, Cue, or Time  – can now be applied to another sequence than the
selected sequence, if directly after “DELETE” follows the number of the sequence.

View Commands

Store|ID|Enter  – stores the current view-layout as a new view with specified ID.

Delete|ID|Enter  – deletes selected view ID.

8.8  Sensor Link

The Sensor Link is a unique highspeed sensor interface that is designed to provide input signals from
standard industrial encoders, distometers as well as analog potentiometers and contact closures.

8.8.1  Technical Features

From one unit there can be used simultaneously:

2x 12V industrial encoder  inputs with internal or external reset (GPI) with 5-pin M12-Connectors,
2x 0-10V analog inputs  and
8x GPI contact closures

Since the SensorLink is based on TCP/IP communication (outputs TCP/IP at variable frequency between
50 and 5000 Hz), multiple units can be used at the same time.

The internal sample rate reads incoming data at 7 kHz to allow high resolution encoder inputs to be used
for accurate motion sensing.
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The front panel shows the Neutrik Ethernet input jack as well as the 4 pin XLR 12V power input. 

On the rear side you will find the connection for encoders (E1 & E2, please use 5-pin M12-Connectors,
Pin Connections: 1= +Volt, 2=B, 3=0Volt, 4=A, 5= N Index), analog devices (A1 & A2) and contact
closures S1 – S8).

RESET
As the unit can be programmed for various encoder step count settings or remote rest indexing a reset
button is provided to restore the factory settings of the unit.

STATUS LED
Three status LEDs give feedback information of the current state of the unit.

8.8.2  Connecting Encoders and Sensors

You may connect the following inputs to the Sensor Link Device:

Analog inputs with their own voltage supply of 0-10 Volt ,
Switch Inputs with or without their own voltage supply of 12 V ,
Incremental Encoders, using 5-pin M12-Connectors ,

Please never connect Pin 12 and Pin 1 as this could cause a short circuit!
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8.8.2.1  Analog Inputs A1 and A2

Connect – to Ground and the gate input to A1 or A2. The sensor link will read out a voltage range of 0-10
Volt and will transfer this range in 512 steps. They have 30kΩ input impedance, resulting in a minimum
of 0,5A. 

Please make sure that you are using the same grounding in order not to get any potential equalization!

8.8.2.2  Switch Inputs S1-S8

It is recommend to use potential-free relay contacts as triggers. Connect these to 12V and to one of the
Switch Inputs S1-S8.
If you are using triggers with their own voltage supply (11-13 V) connect – to Ground and the gate input
to one of the Switch Inputs S1-S8.
Note that the contacts should not be switched faster than twice per second to be recognized correctly. 4
times (4 Hz) could be reached under circumstances, but maximal 2Hz is recommended.

Please make sure that you are using the same grounding in order not to get any potential equalization! 

8.8.2.3  Encoder Inputs E1 and E2

You may connect incremental Encoders to input E1 or E2, using 5-pin M12-Connectors.

Pin assignment female connector:

Pin 1 = positive power supply, +12V or +24 V 
Pin 2 = Pulse signal B 
Pin 3 = negative power supply, Ground 
Pin 4 = Pulse signal A
Pin 5 = Pulse signal N, Reset
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Guideline for choosing the right Encoder:

In order to specify the right encoder for your application, a couple of parameters need to be determined
first.

- What kind of encoder should it be? Hollow Shaft Encoder or Shaft Encoder
- The diameter of the axis where the encoder should be mounted to
- Minimal and maximal speed of the axis. Measured in rotations per second

In general you might say: the more steps the encoder has, the better is the result, BUT it is important to
know that the coolux Sensor Link is limited to a maximum of 7000 steps per second.

If the encoder turns faster and generates more steps per second, the Sensor Link will lose track of the
absolute step count of the encoder. This can lead to drifting and wrong values, if the Sensor Link is being
used for accurate Screen Tracking.

To avoid this, it is recommended to specify an encoder that will run at a maximum amount of 6000 steps
per second.

!!! Please be aware that 6000 steps are not equal to rotation per second or Pulses per Revolution!!!

Due to the output circuit data of the encoder (which is a HTL) there are four shoulders for one circuit.
That means for example: An encoder with 1500 PPR (Pulses per Revolution) generates 6000 steps per
second at one full rotation per second. (4x1500 PPR = 6.000 steps/sec.)

To choose the right encoder for your application you will also need to take into consideration the
following:

Is there any further gear mounted on the device which is turning?
Is the shaft, where the rotation is coming from, bigger than the axis of the encoder?

This is why you need to know the environment of where the encoder is going to be used as well as how
many rotations per second the axis of the encoder will be turning.

Sensor Link has been tested with Wachendorff Encoders (www.wachendorff.com). 
You may get similar encoders from other manufacturers as well, but the naming of the different signals
and product specifications may vary.

Here is an example of how to determine the right product code for a Wachendorff encoder suitable for
Sensor Link.

Please Note: All the encoders are custom-built. These are not stock items!

Example encoder: WDG40S 360 ABN H24 SB5

WDG40S - is the type of the encoder – here it means that it’s a shaft encoder.
360 - is equal to 360 PPR (Pulses per Revolution)
ABN - is the channel type
H24 - determines an HTL Output circuit
SB5 - determines the connector type, for Sensor Link a 5-Pin, M12-sensor Connector

Although encoders can be ordered with a fixed mounted cable, this is not recommended for service
flexibility.

The connection cable between encoder and Sensor Link is available in various lengths.

Below graphic shows an example from Wachendorff:

http://www.wachendorff.de/
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8.8.3  User Interface

The Sensor Link UI acts as the interpreter of the incoming data from a Sensor Link to a Pandoras Box
Master System.

There are two different ways to use the Sensor Link to control the Pandoras Box Master software:
- Using the Sensor Links Configuration Tool  and the Widget Designer PRO (recommended!). 

This allows you to use the Sensor Link’s whole functional range.
- Using the User Interface of the Sensor Link Software  that will be delivered with the Sensor Link.

8.8.3.1  Configuration Tool and Widget Designer Pro

For the best flexibility and to be able using the whole function range to control Pandoras Box we
recommend using the Widget Designer as processing tool for the data coming from the Sensor Link.

Please start the Sensor Link Configuration Tool (for the download link, please log into the Download-
Center first, then click here). 
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http://www.coolux.de/support/dowload-center/
http://www.coolux.de/support/dowload-center/
http://www.coolux.de/index.php?id=dowload-center#file/cat-12/cat-33/file-95
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To configure the Sensor Link device, please enter the Sensor Link IP address and port and press
[CONFIG]. You may now change the IP or Encoder settings if necessary:

SensorLink IP and TCP/IP Port:
Enter here the Sensor Link’s IP address and TCP/IP Port.

[CONFIG]:
Press [CONFIG] to switch the unit to configuration mode.

[INFO]:
Press [INFO] to download the current settings from the unit.

[IDENTIFY]
Press [IDENTIFY] to identify the units, the right LEDs will blink for 3 seconds.

Changing the Sensor Links Settings

[DEFAULT]
Press DEFAULT to load the default settings in the settings fields.

IP:
Please enter the new IP address that you want to assign to the unit here.

MASK
Please enter the new Subnet Mask that you want to assign to the unit here.

PORT
Please enter the new TCP/IP Port number that you want to assign to the unit here.

RATE
The Rate setting changes the transmission rate, the default of 14 is recommended as this is ~70 Hz
refresh cycle in order to be ahead of any displays refresh cycle. Faster rates (<14) are possible but may
cause your network or processor to slow down.

E1
Please set the step count of your encoder 1 here. If the encoder provides e.g. 1440 steps, enter 1439
because the counting starts with zero.

E1 Checkbox
If you need to use an external index GPI switch to reset the encoder 1 counter to 0 you may check this
box and enable switch S7 to be the index switch.
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E2
Please set the step count of your encoder 2 here. If the encoder provides e.g. 1440 steps, enter 1439
because the counting starts with zero.

E2 Checkbox
If you need to use an external index GPI switch to reset the encoder 2 counter to 0 you may check this
box and enable switch S8 to be the index switch.

[UPDATE]:
Press [UPDATE] to upload the new settings to the unit.

[SAVE]:
Press [SAVE] to store the new settings in the unit.

[CANCEL]:
You may press [CANCEL] at any time to leave the config mode directly.

No access?
If you can not access the unit anymore, press the blue reset button for 5 seconds during power on.

The unit is set by default to
IP 192.168.178.50
Subnet 255.255.255.0
Port 10001

Important:
To use the Sensor Link now please powercycle the unit first!

If this setup is done you can start to read out and process the data coming from the Sensor Link Device.
To do this create a Sensor Link Input Node  and route the data to any filter or output nodes.1133
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8.8.3.2  Stand-Alone Software

To configure the Sensor Link device, please enter the Sensor Link IP address and port in the top left
fields, do not press connect at this time.

Press [CONFIG] in the ConfigSensor Link box.
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[CONFIG]
When [CONFIG] is pressed the left LED will blink and the Sensor link is switched to config mode.

[INFO]
Press [INFO] to retrieve the current settings of the Sensor links into the settings fields.

[IDENTIFY]
Press [IDENTIFY] to identify the units, the right LEDs will blink for 3 seconds.
 Changing the Sensor Links Settings

[DEFAULT]
Press [DEFAULT] to load the default settings in the settings fields.

IP
Please enter the new IP address that you want to assign to the unit here.

MASK
Please enter the new Subnet Mask that you want to assign to the unit here.

PORT
Please enter the new TCP/IP Port number that you want to assign to the unit here.

RATE
The Rate setting changes the transmission rate, the default of 14 is recommended as this is ~70 Hz
refresh cycle in order to be ahead of any displays refresh cycle. Faster rates (<14) are possible but may
cause your network or processor to slow down.

E1
Please set the step count of your encoder 1 here.

E1 Checkbox
If you need to use an external index GPI switch to reset the encoder 1 counter to 0 you may check this
box and enable switch S7 to be the index switch.

E2
Please set the step count of your encoder 2 here.

E2 Checkbox
If you need to use an external index GPI switch to reset the encoder 2 counter to 0 you may check this
box and enable switch S8 to be the index switch.
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UPLOAD a new Configuration to Sensor Link

To upload new settings into the unit, press [UPDATE].

Press [SAVE] to store the new settings into the unit.
The save process takes several seconds and will reboot the unit.

Once all LEDs light up again the unit exits config mode and is ready to being connected for data
transmission.

You may press [CANCEL] at any time to leave the config mode directly. 

RUN Mode

Once all settings are stored into the unit, you may connect to the Sensor Link device for data
transmission by entering its IP address and port and pressing  the [Connect] button.

If you do not know the current IP address, you might want to use the default IP 192.168.178.50 and Port
10001.

Please note that your PC must be in the same IP address range in order to communicate with the
Sensor Link Device.

Once connected, you should be able to read the incoming values in the Sensor Link Status box. To
check the switches, you may want to connect the 12V pin with any of the switch pins, the switch status
S1-8 will turn green once the contact is closed.

Please do not short circuit the 12V (left most pin) with the ground pin (right most pin), this might damage
the unit.

Triggering Pandoras Box from Sensor Link

In order to communicate with Pandoras Box, you need to define the function of the incoming data via
Sensor Link.
For each Encoder and each switch you may choose between parameter and sequence trigger mode.
Use the checkboxes to set each input up for the according mode.
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Encoder and Analog Inputs

Parameter Mode:
In Parameter Mode you may enter one or multiple devices to be linked to the incoming values.

Device Selection
To enter a single device like Server1 Layer 4 enter in the Dev field: "1,4".
To enter multiple devices, leave a space between each device like: "1,4 2,4 3,4" this setting will route all
incoming data to layer 4 of machine one, two and three.

Parameter Setup
Please enter here the desired parameter name that you want to link to, like "Opacity" or "X Pos".

Start and End values
Please enter here the start and end value range that you want to map your incoming data to.

Steps
Please enter the amount of steps of your connected device (for encoders only). While the Encoder Step
count is determined by the hardware connected to the Sensor Link, any analog input device can be read
between 0-10V with a step count of 0-255.

Sequence Mode:
In sequence mode you may enter the desired sequence and cue to be triggered above or below the
incoming min. and max. values of the connected Encoder or analog input device.
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Switch Inputs

Switch inputs are handled similar to encoder inputs, besides the fact that you can setup only an on and
off value in parameter mode. In sequence mode you may choose a sequence and cue separate for the
on and off state of the switch. 

Sensor Link Data Transmission to Pandoras Box

In order to connect to a Pandoras Box Master System your PC must be in the same IP address range
and you will need to enter the Masters IP and Pandoras Box domain in the according setting fields and
connect to Pandoras Box.

Please be aware that once the connection to Pandoras Box is enabled the Sensor Link user interface
will pause all interface updates of faders and switch states for optimum live performance.

Resetting the Unit
To reset the Sensor Link, please press the reset button on the rear side of the unit and hold it for 5 sec
while power-cycling: 
Power off the Serial, press the reset button, power it on again and hold the button for 5 sec pressed.

When the unit is reset the following settings will be set:
IP: 192.168.178.50
Subnet-Mask: 255.255.255.0
Port: 10001
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Troubleshooting:

Problem: The incoming data comes in slowly and does not update fast enough.
Solution: Press cancel to exit config mode and reconnect to the Sensor Link unit or power-cycle the unit
to exit config mode as well.

Problem: You caused a short circuit because of connecting Pin 12 (+12V) and Pin 1 (Ground).
Solution: There is an internal fuse inside the Sensor Link that has to be replaced. Please contact 
support@coolux.de

mailto:support@coolux.de
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8.9  Serial Link

Please note, that coolux has discontinued the Serial Link. Please refer to JLCooper Electronics
and their product eBOX.

The Serial Link is a general purpose interface box that converts 4 serial communication ports and 24 GPI
(General Purpose Interface) inputs and outputs to 100/10baseT Ethernet. The serial ports can be
configured in the field to appear as EIA/TIA RS-232E and CCITT V.28 or as EIA/TIA RS-422A, RS-423
and Federal Standards 1020 & 1030 ports. Additionally, the port direction can be configured as DTE or
DCE on each port independently. 

The Serial Link communicates over standard TCP/IP which allows is be used with any host computer
running any operating system that uses TCP/IP protocol. The Serial Link can also be connected to other
Serial Links to allow longer runs than traditional serial and GPI cables. Since the Serial Link uses TCP/
IP, traffic can be routed over internal LANs, wireless LANs, MANs, WANs and even over the public
Internet. 

Most configurations can be accomplished through a web page server built into the Serial Link. Items
such as port speed, parity, IP address, remote IP address and TCP port are set using a standard web
browser. Settings are stored in nonvolatile memory. 

Typically, the Serial Link functions as a Server, passively waiting for Client devices to connect to it. The
device can be a computer or another Serial Link configured as a Client. When the Serial Link is
configured as a Client, it will actively attempt to connect to the Server Serial Link. Once this is
accomplished, the Serial Link will either pass data received in the serial or GPI ports to the remote Serial
Link. If there is no data received in the Serial Link, the Serial Link will not send any TCP packets. 

In addition, the Serial Link can operate as a GPI to Serial Converter or GPI to Ethernet Converter. In
these modes, the Serial Link will convert GPI input triggers to deck commands. 

SERIAL LINK SETUP

The serial control will give you access and control to most routing switchers, projectors, shutters or other
device parameters that are remote controllable via the common RS 232 and 422 serial protocols.

In order to control external serial devices over RS 232 or RS 422 you will need to add a serial link device
to the device tree. Any serial ASCII or hex string can be stored and copied to any point in the timeline
and be recalled at any time the time cursor hits the stored serial key. Once you set the first key you can
assign the IP address and port ID in the keys properties as well as the ASCII or hex command for that
key.

You will need a serial link device to receive and output serial commands. See further instructions in the
serial link manual for port setting baud rates and parity settings.

Please find below the .clib code for the basic Serial Link device:
<?xml encoding="yes" ?>
<descripDevice type="fixtureSerial" artNetIndexScope="1">  
<descripModule type="paramSerial" name="Com" default="0" artNetIndexOff="0" />
</descripDevice> 

Connections

The Serial Link connections are straightforward:
1. Plug the power supply into the Serial Link.
2. Plug a network cable into the Ethernet jack.
3. Connect serial cables into ports 1-4.

http://www.jlcooper.com/
http://www.jlcooper.com/_php/family.php?fam=ebox
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The rear side

ETHERNET
This Serial Link port is just like an Ethernet port on a computer, to connect it to a hub, switch or router,
use a straight through cable. To connect it to another Serial Link or computer, use a crossover cable.

The Serial Link supports IEEE 802.3u clause 28 Auto-Negotiation which automatically senses the
Ethernet port speed & duplex operation and chooses the highest performance settings. 

The front panel

Four LEDs on the front panel indicate various operating conditions of the Ethernet port. These LEDs are:
• Link
• 100BaseT activity
• 10BaseT activity
• Collision

CONFIGURATION

Operating Modes
The Serial Link has five distinct modes of operation that are set by the rear panel DIP switches. The DIP
switches are read only at power on so the Serial Link must be power cycled for the changes to take
effect.

SW8 SW7 SW5  

On X Off Access web page at 192.168.254.102

Off Off Off Serial Link is server at address specified on next page

Off On Off Serial Link is client at address specified on next page

Off On On Serial Link performs GPI to serial conversion

Off Off On Serial Link performs GPI to Ethernet conversion

X = Don't care

Configuration Mode
On the Configuration Web page, various settings such as port rate and parity, IP addresses and ports,
and password can be modified.

Note: The Serial Link will not send Serial/GPI messages when the Serial Link is set to
configuration mode.
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To access the Configuration Web Page of the Serial Link Device, please set SW8 and SW6 to ON and
all others to OFF. The PC Firewall and an Antivirus system have to be turned off!

This page is accessed by setting SW8 to the ‘On’ position and typing "http://192.168.254.102" into your
web browser (use Internet Explorer, Safari and Firefox do not work). During this time, the normal
operation of the Serial Link is suspended. 

Note: The configuration web page is always set to 192.168.254.102 regardless of the state of the
DIP switches.

Note: In the configuration mode, the subnet mask is set to 255.255.255.0. This means that the Serial
Link will only see traffic from computers with and IP address of 192.168.254.nnn. You will need to
change your computers IP address to 192.168.254.nnn where nnn = any number except 0, 102 and 255.
This will allow your computer to access the configuration page of the Serial Link.

Make any changes that are necessary for your system and click on SUBMIT. These changes are stored
in non-volatile memory and are loaded at power up.
Default settings:  Timeout = 100ms and max buff size = 255.

A Page with a Pink background should now be loaded into Internet Explorer to tell you to power cycle
the unit, but first:
- Switch DIP8 to OFF position.
- Wait approx 10 – 15 sec ! 
- Now power cycle the Serial Link!

To verify the Settings:
-Power Off Serial Link
-Set DIP 8 to ON again
-Power Cycle the Serial Link
-Launch internet explorer and make sure to empty the browser cache by clicking on Safety -> Delete
Browsing History… -> check all check boxes and click on the delete button
-Now type in 192.168.254.102 in the address field of Internet Explorer.

To use Serial Link with a custom IP address please make sure to set DIP 1,2,3 to ON and 8 to OFF

DIP 6 should always remain in the ON position as this is disables the internal password protection that
is currently not used.
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Image: Configuration Web Page

Operational Settings

Device IP Address:
IP address of this Serial Link when SW1, SW2 and SW3=On.
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Subnet Mask:
The mask is a binary pattern that is matched up with the IP address to turn part of the host ID address
field into a field for subnets.

Gateway Address:
IP address of gateway router which connects to other networks.

Port Number:
TCP port of this Serial Link when SW1, SW2 and SW3=On.

Destination IP Address:
IP address of remote Serial Link when SW1, SW2 and SW3=On. This is used when Serial Link is
configured as a client (SW7=On).

Destination Port Number:
TCP port of remote Serial Link when SW1, SW2 and SW3=On. This is used when Serial Link is
configured as a client (SW7=On).

Password:
Eight character alphanumeric password that is embedded in the Ethernet packet that prevents
unauthorized Serial Links from passing unintended packets. Both Serial Links must have the same
password and have password protection turned on (SW6=Off) for this feature to work.

Baud Rate:
Sets the port speed of the individual serial ports.

Parity and Parity Type:
Enables or disables parity and sets parity type of the serial ports.

Serial Time Out:
Sets the time that the Serial Link will wait for data from the serial ports.

Max Buff Size:
Sets the maximum buffer size of the serial ports.

Serial Link IP Address:
The IP address of the Serial Link can be set by the rear panel DIP switches or by the internal web page.
As above, the DIP switches are read only at power on so the Serial Link must be power cycled for the
changes to take effect.
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Here is a table of how IP address and the TCP port are set with the DIP switches in Serial Link Server
and Serial Link Client modes.

SW3 SW2 SW1 SW7 Mode IP Address Port

Off Off Off Off Server 192.168.254.102 23

Off Off On Off Client 192.168.254.103 23

Off Off On Off Server 192.168.254.104 23

Off Off On On Client 192.168.254.105 23

Off On Off Off Server 192.168.254.106 23

Off On Off On Client 192.168.254.107 23

Off On On Off Server 10.0.0.128 23

Off On On On Client 10.0.0.129 23

On Off Off Off Server 10.0.0.130 23

On Off Off On Client 10.0.0.131 23

On Off On Off Server 10.0.0.132 23

On Off On On Client 10.0.0.133 23

On On Off Off Server 172.16.0.128 23

On On Off On Client 172.16.0.129 23

On On On Off Server Set by user

On On On On Client Set by user

IP Address Configuration for Serial Link Server and Serial Link Client modes

Electrical Connections

Power
The Serial Link requires a 9 volt DC supply capable of delivering at least 500 milliamps. The unit comes
with a power supply appropriate for the country in which the unit was sold. If you need a power supply
specific to your location, please contact your local distributor or coolux.

Warning: Using a power supply other than the units specified in the above table can result in damage to
the Serial Link and/or other equipment which is not covered by the coolux warranty.
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8.10  SMPTE Link

All Pandoras Box Manager, Server or Player products with timelines can send and receive LTC SMTPE
via the USB SMPTE Link interface.

To connect the SMPTE Link please refer to the Configuration tab , section SMPTE Time Code .
Afterwards, the Sequence Inspector  allows to set up the "Mode", "Offset" and "Stop Action".

The SMPTE Link Interface provides balanced signal transmission:

Pin1: ground
Pin2: signal
Pin3: signal

It does not matter which signal is +/ -.

8.11  DMX Link

The DMX Link is a DMX - USB interface offering an
easy setup for DMX 512 control.

All Pandoras Box Manager, Server or Player
products with timelines can send or receive DMX
data. There are two versions available, the DMX
Link In and the DMX Link Out. Please note that it is
not possible to use gender changer adapters to turn
the signal flow!

The DMX Link In allows to remote control Pandoras
Box via a DMX device. In other words, it provides
direct sequence and layer control from any
common lighting controller.
Connect the DMX Link to your Master system, e.g.
a PB Manager, Server or Player. In case of remote
controlling Clients, drag them from the Asset tab

 or Device Types tab  into the Device Tree tab
. Patch the layers in the Patch tab  to the

according channel, subnet and universe. There is
no need to have another DMX-Link connected to a
Client, it is controlled by the Master. Activate the
DMX input in the Configuration tab  and as soon

140 158

201

138 182

169 224

140
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as data is sent to the Master system, all patched
layers or sequence parameters are remote
controlled.

The DMX Link Out allows to remote control DMX
devices with Pandoras Box. It is mostly used to
control moving lights, spots etc. with the Pandoras
Box timeline for a synchronized video and light
show.
Connect the DMX Link to your Master system, e.g.
a PB Manager, Server or Player. Drag the built-in or
custom designed DMX devices from the Device
Types tab  into the Device Tree tab . Patch
the layers in the Patch tab  to the according
channel, subnet and universe. Activate the DMX
output in the Configuration tab  and as soon as a
key is stored in the timeline , the DMX data will
be sent constantly to the devices. Only changes to
DMX values will be sent. Resetting a DMX node will
send all values at once.

Please be aware that a USB DMX interface will
allow you to control a maximum of 512 DMX
channels on subnet 0 and universe 0.

LED Status:

magenta no driver found; please install the current coolux driver for USB devices

blue / magenta pulse the driver is in idle state; please start a Pandoras Box Master software and
setup to receive or send data as described above
if using a DMX Link In, this status means that the connection between the DMX
Link and PB software is not setup

blue / red pulse only for DMX Link In; in contrast to the above, this status means that the
connection between the DMX Link and the sending device is not alright

blue blinking ok, the DMX Link is sending / receiving data

8.12  DMX Link 8

Please note, that coolux has discontinued the DMX Link 8. Please refer to ELC and their
product dmXLAN Node 8GB.

The DMX link 8 converts up to 10 DMX universes to Ethernet (Art-Net protocol).
Backwards, 8 DMX universes can be converted from Art-Net to DMX.

Furthermore it can be used stand alone as a universal programming digital merger (ex. 2 in 8 out) or
splitter (ex. 2 splitters of 1 in to 4 out). Saving the lastly received signal DMX signal in the unit, it also
acts as a perfect backup (ex. 4 in 4 out).

FEATURES

- Remote programming and monitoring 
- DMX input options like Normal or Backup 
- DMX output options like Normal, Merging in HTP/LTP or custom /Priority merging, Merging with
channel by channel softpatch
- Remote takeover of fixture parameters

182 169

224

140

284

http://www.coolux.de/index.php?id=dowload-center#file/cat-12/cat-52/file-245
http://elclighting.com
http://elclighting.com/products/ethernet-dmx-nodes/14-dmxlan-node8gb
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- Visualizer input support like WYSIWYG, ESP, Capture and many others 
 

HARDWARE DESCRIPTION

Front Panel

The front panel has a graphic LC-display, 3 keys and a jog-encoder with push function and 3 LEDs.

Connections at the back

The dmXLAN node8 has many connectivity options. Viewed at the back from left to right:

RS-232 (top SUB-D 9pin) Pin Description

To connect the RS-232 port to a PC you’ll need a 1 to 1 male/
female sub-d 9pin cable. (NO null-modem / cross cable)

1 -

2 TX

3 RX

4 -

5 Ground

6-9 -

Contact Closure Inputs (bottom SUB-D 9pin) Pin Description

These inputs have an internal pull-up resistor. A simple switch
can be connected between the input pin and a ground pin. The
contact inputs can be used to temporarily recall a patch setting.

1 Ground / Shield

2 Input 1

3 Input 2

4 Input 3

5 Input 4

6-9 Ground

Network 10/100 MBit Ethernet (on Neutrik Ethercon)

The network connection uses a standard UTP network
connection.

USB 2.0 Full-speed

The USB connection uses standard USB pinout.

DMX port 1 – 8 Pin Description

The DMX ports 1 to 8 are bi-directional(via programmable
setup), have an internal terminator resistor and are RDM
prepared.

1 Ground / Screen

2 Data -

3 Data +

4 -

5 -



768

DMX port 9 and 10 Pin Description

DMX ports 9 and 10 are fixed DMX inputs and have a fixed
internal terminator.

1 Ground / Screen

2 Data -

3 Data +

4 -

5 -

There are 2 versions of node8 available, the normal and the Full Isolated (FI). The full isolated version has
an optical/galvanic isolation barrier on all DMX ports (up to 1500V).

CONTROL THROUGH FRONT PANEL

Main Display

A Select config menu, to recall 1 of 4 previously saved configurations
(patches)
B View DMX values
< (Setup) Enter setup menu
Encoder +/- Select information displays

INFORMATION DISPLAYS

DMX port status

x > port does not receive data (or DMX when input)
v > port receives data (or DMX when input)

ID setting

IP address

Version and serial number

This product may only be used for controlling dimmers and moving lights. Using the product out of these
specifications will remove all responsibility from the supplier

Configuration Menu

From the main display press A (config). Now you can either recall a previous setup or store the current
one in one of the 4 options. Use the encoder to select a setup:

Press A to load the selected configuration
Press B to store the current configuration
Press _ to cancel the operation
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The 4 contact closures on the back can be used to temporarily recall any of the 4 setups. The
configuration is loaded on closing the contact and the normal configuration is loaded when the contact is
opened. Contact closure 4 has the highest priority. Any change to the configuration, either thru the menu
or via remote software (dmXLAN) is stored in the temporarily selected configuration.

DMX View Menu

small bars (120ch) large bars (40ch) decimal (6ch)

From the main display press B (View DMX). Now you can view the DMX values of each port (input or
output). Use the encoder to change the channel:

Press A to select a different port
Press B to change the view mode
Press < to exit

Setup menu
Enter the setup menu from the main screen by pressing <

By using the encoder select the item you would like to adjust.

Options:
· Edit DMX port 1 to 8 or DMX input 9 and 10
· Set the ID
· Rename the current configuration
· Change network settings (IP address and netmask)
Edit the item by pressing A or the encoder.
All settings will be stored AFTER exiting the setup menu via the < key, a message will appear.

Edit DMX ports 1 to 8 or DMX input 9 and 10
Use the encoder to change the current selected option and press the encoder to select the next option.
Press A to store the configuration
Press B to set the DMX port to it’s default value
Press < to cancel any changes

DMX port as output
When a port is set up as a DMX output, then you can select the working mode of that port.
Modes are:
· disabled > the DMX output is disabled
· outzero > the DMX sends out a DMX test signal with all channels at 0%
· single > the output sends out the DMX values of the selected (primary) Art-Net universe. The DMX
output is enabled the first time when it detects the DMX universe on the network (or internal DMX inputs).
If the universe on the network fails, the DMX output will go into DMX hold.
· dual HTP > like single, but merge two DMX universes (primary and secondary) in highest take
precedence.
· dual LTP > like dual LTP, like dual HTP but in latest takes precedence (on a channel by channel basis)

DMX port as input
When a port is set up as a DMX input, it can be operated in the following modes.
· disabled > the DMX input does nothing
· normal > any valid DMX is sent onto the network (and internal use) using the
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selected universe (Art-Net)
· backup > the DMX input will not send data if the selected universe is present on the network. If the
selected universe is not present on the network for several seconds and the input has valid DMX, then it
will send DMX data. If another sender starts sending the same universe, the input will go back input
backup mode. Please note. DMX input 9 and 10 are always fixed to work as input.

Set ID

Used the encoder to change the current selected digit, and press the encoder to select the next digit.
The digits are in hexadecimal (16 possibilities 0-9, A-F). This means you can have up to 4095 different
IDs in the system (ID 000 means that the ID is not used).

Press A to store
Press B to disable (---)
Press < to cancel the operation

Rename current configuration

The name of the current configuration is presented in the main display and in the dmXLAN software. The
name is also used to indicate the configuration setting when it is stored in one of the 4 built in
configurations.
Use the encoder to change the current character, and press the encoder to select the next.

Press A to store the name
Press B to select the next character
Press < to cancel the operation

Network settings

Use the encoder to change the current parameter, and press to select the next.

Press A to store the configuration
Press B to select the factory default IP address and Netmask
Press < to cancel the operation

GENERAL INFORMATION

CE – Product
The DMX Link 8 permits to the CE requirements set up by the European Community.
This can be recognized by this label on the outside of the product.

Technical Specifications:
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Power: 85-264 VAC 47-440 Hz 10VA max
Dimensions 19” 1HE rack unit 483 x 44 x 150 mm
Weight 2kg

8.13  EDID Link

Overview

The EDID Link is a device to manage DVI-EDIDs and communicate these to the graphics card. EDIDs
(Extended Display Identification Data) are used to describe the (preferred) timing of a display device. The
timing is describing the display’s resolution and its sync pixels. It is communicated to the graphic
source via the DVI-cable.

The EDID Link can be used to generate and constantly hold an EDID whenever a display device is not
able to send a correct or the exact needed EDID to the source. In addition the EDID Link will ensure,
that a monitor is simulated even when none is connected to it, or powered down. The EDID Link does not
need any separate power as it receives the voltage from the graphics card.

The EDID Link handles DualLink-DVI-I signals and creates / emulates DVI-EDIDs. Analog signals will be
routed through. The device is not HDCP compliant.

Features

Per default, the EDID Link comes with preinstalled EDIDs and can be used without additional software.
The hardware features  are explained in the following chapter. In short, it allows to:
- select an EDID via a preset
- work in transparent mode to route the display device's EDID information to the graphics card

For more advanced users, the EDID Link offers an additional software . In short, it allows to:
- read out a display's EDID or load it from a file
- create an entirely new EDID
- modify EDIDs
- write this EDID to one of the user presets or to a file

772
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8.13.1  EDID Link Hardware

This chapter explains the features of the EDID Link's hardware. The previous chapter offers general
information about the EDID Link  whilst the next covers its software features .

Presets

With its two selection knobs, you can select from up to 99 different EDIDs directly. Presets 01-49 are
holding read-only default EDIDs while presets 50-99 can be configured by the user. All EDIDs can be
exported to a file to be used on a different system, such as the Pandoras Box Quad Server with its DVI
Processor .

Preset 00 acts like a “transparent mode” which will route through the EDID coming from the connected
display device. More than that, the last seen, valid EDID is stored to preset 00. Therefore you can
disconnect the display while the graphics card will still see the display’s information. Whenever a
different EDID is transferred into the device, this information will be written into preset 00, even while
emulating another preset at that time.

In order to read out a new EDID, the EDID Link needs to receive 5V either coming from the graphics
card, or the USB-plug. With any 5V input connected, you may read out and store the display’s
information to preset 00 and later on edit it or download it to your computer using the software "EDID
Link Editor" .

Usage

Your EDID Link is directly ready to use. You do not need any installation in order to use the default
EDIDs. A list is printed onto the device and is part of the delivered documentation.

- Power down your signal source (e.g. a computer) first.
- Connect the EDID Link’s DVI “in” connector with the included short DVI cable to the graphics card’s
output of your signal source.
- Connect the EDID Link’s DVI “out” connector to your display device (e.g. a monitor).
- Select the desired EDID by rotating the selection knobs.
- Power up your signal source.

The signal source will now receive the EDID adjusted on the EDID Link. You may need to select and
confirm to change to this resolution using the graphics card driver. From now on, there is no direct
connection from the graphic source to the display any longer. Therefore, you may power down the
display without loosing your graphics card settings as the EDID Link is still emulating the device. Even a
loose connection of the DVI cable will not harm the settings any more. When using presets other than
00, you will be able to switch display devices without transferring this information to the source.

It is recommended to power down the complete system before disconnecting a DVI cable.

Rotating the selection knobs while running the system will lead to a disconnect of the attached EDID
Link and the graphics card. It may switch to a not connected state. As long as you turn the knobs, the
EDID Link remains in the disconnected state. After two seconds of not changing the preset, the device
will output the selected EDID. You may need to set the resolution again within your graphics cards
settings or source device settings.

771 774
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LED Codes

The LED next to the USB plug features different LED codes:

Red blinking the device is in firmware programming mode

Blue pulsing to magenta every 5s the device is idle and ready to use

Blue switching once off for 0,5s the device is used by the software to read from or write to a preset

Important information about internal EDID handling

EDIDs (Extended Display Identification Data) are used to describe the (preferred) timing of a display
device. The timing is describing the display’s resolution and its sync pixels. It is communicated to the
graphic source via the DVI-cable.

A single EDID may feature a list of different timings which can be processed by the monitor. This may be
a combination of “Established Timings”, “Standard Timings” and “Detailed Timings” at the same time.
This gives the user the flexibility to choose from more than one resolution, whenever the native one is not
about to be used.

As this flexibility often leads to not having the desired resolution set within the signal source, the EDID
Link limits all its EDIDs to only one single timing.

Using this fact, the graphics card will be forced to output the exact desired resolution and timing.

Note: All default EDIDs as well as imported or read out ones from any device are changed and
limited to the “First Detailed Timing Descriptor”. Extensions are being cut off as well as soon
as they are stored into the EDID Link.

As preset 00 acts as a transparent mode, you will find the original EDID including all timings and
extensions. Storing this data into a preset will reduce the timing to a single one. How to do this is
explained in the next chapter covering the EDID Link's software .774
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8.13.2  Software - EDID Link Editor

This chapter explains the features of the EDID Link's software. The previous chapters offer general
information about the EDID Link  and cover its hardware features .

Installation and Software

Run the “EDID Link Editor Installer” on a Windows operating system and proceed through the
installation. The installer is available on the delivered CD or in the coolux Download-Center. After the
installation you will find the EDID Link Editor software within the Windows start menu and a shortcut on
your Desktop.

The EDID Link Editor software can be used with or without a connected EDID Link to create, edit or
organize EDIDs.
If you like to read an EDID out or write presets onto it, connect your EDID Link via the included USB-
cable to your computer. Use the USB-driver “coousb-driver v6.0.13.0” (or a newer one) to finish the
hardware installation of the device. The EDID Link is now communicating with your system and ready to
be used.

The software is divided into three sections as pictured below.

771 772

http://www.coolux.de/index.php?id=dowload-center
http://www.coolux.de/index.php?id=dowload-center#file/cat-12/cat-52
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Menu Bar 

File Menu
Use “Load EDID File ...” to load a stored EDID into the Editor. You can then edit and store this EDID to
an EDID Link preset or export it into a file again.
Use “Save EDID File ...” to export the currently displayed EDID timing into a file.

Edit Menu
Use “Read Monitor EDID” to force the EDID Link to read the currently connected EDID (again) and
display it within the Graphical User Interface (GUI). If no valid EDID can be read, all values will equal
zero.
Note: If you want to read out what has already been stored automatically to preset 00 when the monitor
has been attached, you can recall preset 00 without using this menu item.

Use “Initialize Default EDID List” in order to re-initialize the default EDIDs on all presets.
Note: This action will overwrite all user data.

Preset Settings

Use the “EDID Link Preset” numeric box in order to recall the particular preset 00-99 by either clicking
up/down or typing in the desired preset number followed by the return key.
Choosing a preset will read out its content stored within the EDID Link and display it in the "EDID
Description" section.

Check the “Update GUI” check box in order to directly recall content from a preset while changing the
preset number. You may uncheck the check box in order to select a preset without loading its content
(and overriding your changes done in the EDID settings).

Use the “Save to Preset” button in order to store the currently displayed EDID timing into the selected
preset. You may want to uncheck the “Update GUI” check box in order to select a preset you want to
overwrite without loosing your settings entered in the "Detailed Timing" settings below.

EDID Description

The EDID Description shows the content of the “First Detailed Timing Descriptor Block” along with the
“Monitor Name” out of the EDIDs “Descriptor Block 2”.
The displayed information can be edited and stored to the EDID Link or to a file as described above.
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Detailed Timing

Name Read out or change the monitor name with a maximum of 13 characters.

PixelClock
This value shows the signal’s PixelClock in MHz.
The maximum value is 330.

Rate Hz
This value shows the signal’s Refresh Rate in Hz when an EDID is loaded. It results of
all other definable settings regarding pixel count and PixelClock.

Res X
This value shows the signal’s active pixel per horizontal line. Active pixels are the
shown ones within a display device and equal the horizontal resolution.
The maximum value is 4095.

Res Y
This value shows the signal’s active lines per image. Active lines are the shown ones
within a display device and equal the vertical resolution.
The maximum value is 4095.

Blank X

This value shows the signal’s total horizontal blanking pixels including (definable) front
porch, (definable) sync width and (resulting) back porch.
The combination of the horizontal active, blanking and border pixels equals the
picture’s horizontal total pixels.
The maximum value is 4095.

Blank Y

This value shows the signal’s total vertical blanking lines including (definable) front
porch, (definable) sync width and (resulting) back porch.
The combination of the vertical active, blanking and border lines equals the picture’s
vertical total lines.
The maximum value is 4095.

H Sync Off
This value shows the signal’s horizontal sync offset (front porch) in pixels.
The maximum value is 1023.

V Sync Off
This value shows the signal’s vertical sync offset (front porch) in lines.
The maximum value is 1023.

H Sync Width
This value shows the signal’s horizontal sync width in pixels.
The maximum value is 1023.

V Sync Width
This value shows the signal’s vertical sync width in lines.
The maximum value is 1023.

H Img Size
This value shows the monitor’s horizontal image size in mm. This information value is
optional and has no influence on the signal processing.
The maximum value is 4095.

V Img Size
This value shows the monitor’s vertical image size in mm. This information value is
optional and has no influence on the signal processing.
The maximum value is 4095.

H Border
This value shows the signal’s horizontal border in pixels.
The maximum value is 255.

V Border
This value shows the signal’s vertical border in lines.
The maximum value is 255.

Interlaced
This check box shows if the signal is interlaced (checked) or progressive
(unchecked).

Sync Signal
Readout or select the desired sync option required by the signal.
Depending on the chosen sync option, there are additional check boxes to be de-/activated.

Stereo Mode
Readout or select the desired Stereo Mode required by the signal.
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8.14  NET Link and Calibration Link

The NET Link is a modifiable interface device build to:
- provide sensor information as input signals to Widget Designer  or the Warper  and / or
- control relays by sending output signals.
Through these programs sensors can control layer and sequence parameters in Pandoras Box . In
return, Pandoras Box can trigger the devices too.

The hardware features  are explained in the following chapter in detail. In short, the NET Link is a
customizable device and comprises:
- a housing: choose between the small chassis depicted above or the 19" rack module
- min. one processor unit
- changeable boards: coolux delivers the NET Link ready-to-use as ordered by you. However, you may
modify the NET Link by changing the boards at any time. Currently, seven boards are available covering
analog and digital boards as well as input and output ones. Show examples...

The Calibration Link is a small NET Link device equipped with two analog fibre input boards for the input
of 16 fibre cables (single-core, diameter of 0.98mm²). It is specially designed for an automated re-
calibration of a projection setup, e.g. in a fixed installation where a projector or a screen have been
moved. Show example...

The NET Link supports a sensors range from standard industrial encoders, distometers as well as
analog potentiometers and contact closures to specially designed Phidget sensors or self-build
solutions. As long as a sensor can be connected to one of the offered boards, meaning that it meets the
technical specifications, its data can be send to Widget Designer. More details regarding the software

 are included on the following pages.

8.14.1  NET Link Hardware

This chapter explains the hardware of the NET Link. Please see the introductory chapter  for other
information.

As mentioned in the previous overview chapter, the NET Link is a customizable device. Choose between
two housings: a small 4 slot high housing or a larger 21 slot wide housing. At least one processor unit is
needed, it takes up the space of 2 slots. You may then choose from six boards, each 1 slot: analog /
digital and input / output ones.

Both editions are powered with 12V. The AC adapter has an input of 110-240V, max. 1.2A and an output
of 12V, 7A via a 4pin-XLR plug.
The allowed voltages and ampere for sensors depend on the board. Some boards do not provide power
for the connections, thus an external power supply is needed!
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The housing & power supply

In general the NET Link comes in two editions regarding its housing. The above mentioned power supply
is the same for both.

Small edition, e.g. for rental purposes

The first housing is a smaller case. Its dimensions are H: 85mm, W: 172.1mm, D: 121mm. It is 4 slots
high. The modules are mounted horizontally.
Inherently, it comes with one processor unit (2 slots high) that cannot be removed. There is space for
two boards.

Larger edition, e.g. for fixed installations

The second housing is a 19" rack housing which is 3 rack units high (H: 133.35mm, W: 482.6mm, D:
183mm). It is 21 slots wide. The modules are mounted vertically.
The rack housing does not include a processor unit per se. In difference to the small housing, the 19"
housing can contain more than one processor (2 slots). If only one is chosen, up to 19 boards (each 1
slot) can be mounted.

The processor unit

The processor is the part of the NET Link responsible for the communication to connected software
(Widget Designer  or Warper ). It takes up the space of two slots and consists of:
- a network plug with a network adapter that can be set to any IP address and port number
- a "Reset" button to apply the default IP address (192.168.178.222),subnet mask(255.255.255.0 and
5000). To reset the device, hold the reset button down whilst recycling the NET Link, i.e. re-connecting
the XLR power plug at the back.
- a "Run" LED indicating the status of the unit. The green LED blinks once a second if everything is
alright and net work packages are send correctly. If the flashing is slower, the processor unit does not
perform properly because network packages can not be send in the expected way. This could be caused
by a faulty network environment like cables, switches or IP settings. Please check the status after
approx. 100seconds after establishing the communication between the NET Link and Widget Designer.

In addition it manages the connected input / output boards. The processor has four connectors: A1, A2,
D1 and D2, available for the connection to the boards.

A1 and A2 can be connected to one analog board each. Currently there are only analog input boards
available. In other words one processor can be connected to max. two analog boards.
D1 and D2 can be connected to digital boards. There are input and output boards available. A digital
board has a connector itself to be linked to another board. The daisy chained boards must be of the
same type (input or output) and must not exceed the maximum number of 16. In theory you could
combine 16 digital inputs (or outputs) to D1 and 16 additional inputs (or outputs) to D2. De facto, 32
boards exceed the space of one 19" housing.
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Board modules

Each board is depicted and described in detail in the next chapter. As well there are examples in which
application they can be used.

Analog boards - Input modules
- Calibration Fiber Input
- 0 - 5V Input
- 0 - 10V Input
- 0 - 5V Sensor Input

Digital boards - Input modules
- 12V Relay Input
- 24V Relay Input

Digital boards - Output modules
- 48V AC / 30V DC Relay Output

Every board is 1-slot-wide. As explained above they are connected either to the processor unit itself or to
a preceding board. In addition it has a power connection plug.
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8.14.2  NET Link Boards and Examples

This chapter explains the available boards for the NET Link and shows examples how to use them.
Please see the introductory chapter  for other information.

Analog board - Input modules

Currently there are only analog input boards available, no output ones. Each board has 8 galvanically
isolated connectors. They detect the incoming voltage in specific, gradual steps providing detailed data
information from the connected sensor. Software-wise this is expressed through a value range from 0 to
1023. An application would be a light sensor controlling automatically the brightness of the projection.
Principally it is like in the below depicted example with the buzzer, only that the buzzer's place is taken
by the sensor and that the switch closes gradually instead of open / close.

Please find below a list with all available input modules:

Calibration Fiber Input

  8 fiber connectors for single-core (!) fiber cables with a diameter of 0.98mm²
  cables obtainable at your local distributor 
  DIP switch on the printed circuit board that sets the sensitivity: coarse / fine; fine is default and should
be only changed when measured values exceed the value range; coarse mode has the same value range
but roughly halves the measured value

The depicted example is
explained in detail in the chapter "Projector Calibration Manager ".
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0 - 5V Input

  8 connectors, galvanically isolated
 
  maximum voltage of 5V
  30kΩ input impedance
  value resolution (in software): 5V / 1024 = 4.88mV per step
  external power source for sensors is needed
  could be used for GPI In if 5V are used; an If-node could filter all values > 0 for "On"

- 0 - 10V Input
  8 connectors, galvanically isolated
 
  maximum voltage of 10V
  30kΩ input impedance
  value resolution (in software): 10V / 1024 = 9.77mV
  external power source for sensors is needed

- 0 - 5V Sensor Input
  8 connectors, galvanically isolated
  dedicated separate Molex 
+5V, White: Signal 0-5V)
  maximum voltage of 5V
  30kΩ input impedance
  value resolution (in software): 5V / 1024 = 4.88mV per step
  provides internal power source of 5V for each connected sensors

Digital boards - Input modules

There are two digital input boards: one for 12V and one for 24V. Both have 8 galvanically isolated
connectors. They detect the incoming voltage in two steps and provide the information, whether the
connected sensor is in On- or Off-mode. Software-wise this is expressed through the two values 0 and 1.
If the voltage exceeds 80%, the status switches to "On". If the voltage falls below 20%, it switches to
"Off". An exemplary application would be a buzzer that triggers a cue.
If you need to work with 230V, a power circuit breaker is needed for 12V / 230V.

http://www.phidgets.com/docs/Devices_with_Analog_Inputs
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- 12V Relay Input
  8 connectors, galvanically isolated
 
  maximum voltage of 12V
  30kΩ input impedance
  "On" or "1": > 9,6V
  "Off" or "0": < 1,2V
  external power source for sensors is needed
  operating lifetime: 100 000 switchings
  could be used for GPI In if 12V are used; for the commonly used 5V, the analog input would apply

- 24V Relay Input
  8 connectors, galvanically isolated
 
  maximum voltage of 24V
  30kΩ input impedance
  "On" or "1": > 19,2V
  "Off" or "0": < 2,4V
  external power source for sensors is needed
  operating lifetime: 100 000 switchings

Digital boards - Output modules

Currently there is one digital output boards. It has 8 galvanically isolated connectors / contact closures.
They close the circuit at the software's command. 
All boards connected to the same digital bus are synchronized . If the maximum number of 16 daisy-
chained output relays are connected to D1 (or D2), 16 x 8 = 128 contacts can be closed in sync. D1 and
D2 can have a delay of maximum one frame.

- 48V AC / 30V DC Relay Output
  8 connectors, galvanically isolated, polarity can be reversed
 
  maximum voltage of 48V AC or 30V DC and maximum ampere of 4A
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  30kΩ input impedance
  contacts are normally open (NO)
  external power source is needed
  could be used for GPI Out if external voltage is used as commonly done in broadcast environment; for
other application, an external power source must be considered somehow

8.14.3  NET Link Software

This chapter explains the software settings for controlling the NET Link and getting information from it.
Please see the introductory chapter  for other information.

Software-wise the NET Link is included in the Widget Designer. The communication between WD and
the device is based on an ethernet connection, not USB.

Create > Nodes > Input > Devices > ... or Create > Nodes > Output > Devices > ...
Relay Output node : receiving information from other nodes and controlling the connected NET Link, if
it is mounted with (digital) relay output boards
Calibration Link Input node : receiving information from the connected Calibration Link or NET Link
with analog input board for fibers; values are transferred to other nodes or software (e.g. the Warper); the
Calibration Input works with the tool "Projector Calibration Manager "
NET Link Input node : receiving information from the connected NET Link (or Calibration Link)
according to the input boards and  transferring this information to other nodes or software

All nodes are controllable with node commands . Using them, the input node turns into an output
node as well. For instance, this command closes a relay. SetRelayDigitalBus1,ID,State
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9  PB Menu

The onscreen menu enables you to control and access most common tasks and applications from the
onscreen button menu.
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MASTER & CLIENT
Depending on the mode set up in the mode menu of the LCD display, you may start Pandoras Box
either in MASTER or CLIENT mode.

WARP
Press WARP to launch Pandoras Box Warper.

BROWSER
Press BROWSER to open the Windows Explorer.

OUTPUT
Press OUTPUT to open the Nvidia Control Panel for advanced graphics card and output configurations.

NETWORK
Press NETWORK to open the network dialog to set individual IP addresses for each “Lan” adapter. 
Please note: the status menu of the LCD display shows only the IP address for the “Lan” adapter.

SERVICE
Press SERVICE to launch the service menu, including the commands TASKMANAGER, RAID UTILITY,
MODE and RESET MENU.

Inside the service menu you have the following options:

TASK MANAGER
The task manager provides detailed information about computer performance and running applications,
processes and CPU usage, commit charge and memory information, network activity and statistics,
logged-in users and system services

RAID UTILITY
This tool allows collecting information about the Server's raid system and gives the possibility to manage
it. 

Please note: Do not touch the raid system settings unless you are well skilled in doing this. If there are
hard drive / raid problems, please contact support@coolux.de or your local distributor for support!

MODE
Press MODE and the version dialog opens. 

mailto:support@coolux.de
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Choose one of your installed PB versions within the drop down list. The MASTER and CLIENT buttons
then will refer to this choice.

Checking the Auto Start option with Master or Client will automatically launch the selected PB revision
after the Onscreen Menu started. Set up the desired delay by entering the amount of time in seconds.

RESET MENU
Press RESET MENU to reboot the LCD Display and the onscreen menu. This is important to refresh the
current state to the menu when settings were changed directly under Windows.

VNC REMOTE
Press VNC REMOTE to launch the VNC Remote application. It enables you to scan the network for PB
devices running the onscreen menu Rev. 32 or higher and to remote-control them.

HELP
Press HELP to launch the Pandoras Box Helpfile.

TASKBAR ON
Press TASKBAR ON / OFF to show or hide the Windows taskbar.

SHUT DOWN
Press SHUT DOWN to power off the Server.

Below the buttons the system's IP addresses and the onscreen Rev. are displayed.

890
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10  Matrix Patcher

For special applications where LED or lighting fixtures are required to be patched to individual pixels, you
will need to use the Matrix Patcher to set up your patch. With the saved patch file in your Pandoras Box
project, the output will be additionally rendered to multiple Art-Net universes.

Since revision 6700 the Matrix Patcher plays also an important role if working with LED video tiles that
are connected via DVI and a LED video processor. Most LED video processors are capable of creating
only horizontal and vertical layouts for the video tile alignment. As soon as any of the tiles are rotated (in
any angle), content mapping can be very difficult and complex to setup.
For those creative applications Matrix Patcher and a new Pixel Re-Mapping FX were designed.

Please see the topics below for working with the Pandoras Box Matrix Patcher:
Matrix Patcher User Interface
Fixture Editor
Patching Guide
ReMapping Guide

10.1  Matrix Patcher User Interface

The Matrix Patcher User Interface is divided into several sections:

File Menu , Edit Menu , Toolbar , Fixture Library , Fixture Navigation Tools , Fixture Patch
 and Patch Settings .
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10.1.1  File Menu

[New…]
Select this option to create a new Patch. A pop-up dialog will open:
 It allows to select the size when creating a new patch. Please
make sure to match the display resolution of the Pandoras Box
Client!
You may change the size anytime later as well via [Resize Patch] in
the Edit menu.

[Load Patch]:
Loads a saved Matrix Patcher project file.

[Save Patch]:
Saves the current Matrix Patcher project file and adds the patch to
an open Pandoras Box project (and spreads it to all connected PB
Clients). If the patch has been already saved, this command
updates the Matrix Patcher project status and the file in the
Pandoras Box project in real-time.

[Save Patch As...]:
Saves a new copy of the current Matrix Patcher project file and adds
the patch to an open Pandoras Box project.

[Update Patch]:
Saves the current Matrix Patcher project file and adds the patch to
an open Pandoras Box project (and spreads it to all connected PB
Clients). If the patch has been already saved, this command
updates the Matrix Patcher project status and the file in the
Pandoras Box project in real-time.

Please note: Since revision 49 the *.csv format is an obsolete
format. From now on, Pandoras Box version 5.3 can read the Matrix
Patcher file directly. However, if you still have copies of those *.csv
files and want to work with them, simply drag them into the project
manually. From here, Pandoras Box treats a csv like a pbx file.

[Export Map (ReMap FX)]:
Exports a png file for use in Pandoras Box as a media for the
ReMap FX. 

[Exit]:
Quits Pandoras Box Matrix Patcher.
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10.1.2  Edit Menu

[Fixture Editor]:
From within the Edit Menu you have access to the Fixture Editor

 to create or modify your fixtures.

[1:1 Mode]:
Adds new tiles with a scaling factor of 100% - per default it is
set to 500%. This command is especially useful when working
with Video Tiles.

[Load Background Image]:
This option opens a Windows explorer dialog where you may
select an image to be loaded as background image in order to
simplify creating the patch. To display the image the option
[Show BG] in the Patch Settings  has to be enabled!

[Initialize Map]:
Redraws the Map view . It discards all changes made there
and applies all position / rotation / scale information from the 
Patch view . For more information please have a look at the
ReMapping Guide .

[Resize Patch]:
Choose the new patch size (Width and Height, in px) in the pop-
up dialog. Please make sure to match the display resolution of
the Pandoras Box Client exactly!

10.1.3  Toolbar

[Add]:
To add a new fixture to the patch, select a fixture from the Fixture Library first! Every click inside the
patch now will create one fixture of the selected fixture type.

[Move]:
The Move Mode allows to move the fixtures on the patch. Just click on it and move it to the desired
position. For accurate positioning you may want to enter the fixtures location in the Fixture Patch .

[Rotate]:
The Rotation Mode allows to rotate a fixture on the patch. Select the fixture by clicking on it. Hold the
left mouse button pressed while moving the mouse cursor up (=clockwise rotation) or down (=anti-
clockwise rotation). To rotate the fixture in an accurate angle you may want to enter the angle value in
the Fixture Patch .
To rotate the fixture in 90° steps, you may as well simply use the Buttons [Rotate 90° ->] and [Rotate
90° <-] that you will find under Fixture Navigation Tools .

[Scale]:
The Scaling Mode allows to scale a fixture on the patch. Select the fixture by clicking on it. Hold the left
mouse button pressed while moving the mouse cursor left (=decreasing the fixture size) or right
(=increasing the fixture size). To scale the fixture to an accurate size you may want to enter the scaling
factor value in the Fixture Patch .
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[Drag]:
When being in Drag Mode you may move the whole Patch around in order to reach every part of the
patch.

[Patch / Map Mode]:
This mode is interesting when working with rotated LED video tile connected via DVI and a LED video
processor.
For more information please have a look at the ReMapping Guide .

[Add Array]:
After selecting a fixture from the Fixture Library this command will help you to add not only ONE copy to
your current patch file (as the "Add" command does), but several ones. A dialog opens where you can
set up how many copies you would like to add and the way how the array is inserted.
The Art-Net settings are of course only available if a DMX fixture was chosen from the library. The
options are descriped here .

10.1.4  Fixture Library

The Fixture Library contains a stock of common LED-Fixtures,
sorted by vendor name. Every Fixture you created with the Fixture
Editor will appear here as well.

To add one of the fixtures to the patch, select the fixture and choose
[Add] from the toolbar. Then click inside the patch field.
If you need to add more copies, the "Add Array"  function is a
great time saver.
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10.1.5  Fixture Navigation Tools

[<<<] / [>>>]:
These buttons allow you to easily step through the fixtures added in
the patch. The selected fixture will turn green and will be loaded into
the Fixture Patch  section.

[Rotate 90° ->] / [Rotate 90° <-]:
To rotate the selected fixture in 90° steps, you may simply use the
Buttons [Rotate 90° ->] and [Rotate 90° <-].

10.1.6  Fixture Patch

The Fixture Properties Patch displays information about the type of the selected fixture and allows as
well to set up a unique name, its location, size, angle and the DMX addressing including network
settings.

[Vendor] and [Type]:
See here the Vendor and Type of the currently selected fixture.

[Fixture Name]:
Here you may add a unique name to the currently selected fixture. 
Press [Apply] to assign the modification to the fixture.

[Location X /Y]:
See here the selected fixture’s location for X and Y (in px, according
to your patch size).
The location may be changed by entering new values for X and Y, or
by using the Move Mode (see Toolbar ).
Press [Apply] to assign the modification to the fixture.

[Size]:
See here the selected fixture’s size (in %). This size may be
changed by entering a new value or by using the Scaling Mode (see 
Toolbar ). Any new fixture added on the patch will be scaled to
500% by default.
Press [Apply] to assign the modification to the fixture.

[Angle]:
See here the selected fixture’s angle (in °). To change its angle enter a new value in the text field, use
the Rotation Mode (see Toolbar ) or the 90°-Rotation Buttons (see Fixture Navigation Tools .
Press [Apply] to assign the modification to the fixture.

[DMX Addressing]:
Using the DMX Addressing (including DMX Start address, Art-Net Subnet and Art-Net Universe) you may
set up the fixtures in two different ways:

1. on the one hand it allows to modify the addressing of the selected fixture (press [Apply] to assign the
modification to the selected fixture).

2. On the other hand you may enter the start address for the fixtures that are going to be added to the
patch. Don’t press [Apply] in order to use this function! Otherwise the modified DMX addressing is
going to be assigned to the currently selected fixture.
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++ Background information regarding DMX Addressing and network performance ++

One Art-Net-Universe contains 512 DMX channels (from 1-512). One Art-Net-Subnet contains 16 Art-
Net-Universes (from 0-15). There can be 16 Art-Net Subnets (from 0-15). So in theory you may be
able to address 512x16x16 = 131.072 DMX channels within one patch. As one pixel is represented
by its color information, e.g. RGB, it takes up three channels, resulting in 43.690 pixels.

But when putting this into practice, we have to take the transfer rates of the transmitting network
components and receiving devices into account too. This is the true limitation regarding the question
how many pixel data in form of Art-Net universes can be transferred. As a rule of thumb, we do not
recommend to output more than 60 universes per network.

Let´s have a closer look: One Art-Net universe takes up 572bytes. As soon as you send only one
channel, the entire universe needs to be transmitted. The default transfer frequency is 44Hz (40Hz,
33Hz and 25Hz are common too, especially for older devices). Thus each components needs to
transfer 0,1-0,2 Mbit/s. This applies to switches as well as to the receiving devices. Most of the time
these ones have lower specifications, e.g 10Mbit/s, which limitates us to approx. 60 universes. With
60 universes you can transfer approx. 100*100px. 

Per default, Art-Net is set up as a broadcast protocol which means that all data is send to each
Client within the network. Considering the above mentioned, this means that 100*100px is the
limitation for the entire network, not only per device.

Since revision 49 the Matrix Patcher gives you the possibility to apply multi- or even unicast methods.
The advantage is, that you may decide where the information is actually send to. Thus you may use
your network resources more efficiently.

To do so, set up the "Target IP Address" per fixture.
2.255.255.255  -   example for fixture 1 - the default address is a broadcast address.
2. 0 .255.255   -   example for fixture 2 - the multicast method saves network resources.
2. 0 . 0 . 255    -   example for fixture 3 - the multicast method saves network resources.
2. 0 . 0 . 5       -   example for fixture 4 - the unicast method uses the network resources to its full
capacity.

If we had the following devices connected via a switch to the Pandoras Box Client:
2. 0 . 0 . 5       -   Device A receives the information from fixtures 1, 2, 3, 4
2. 0 . 0 . 22     -   Device B receives the information from fixtures 1, 2, 3
2. 0 . 11. 5      -   Device C receives the information from fixtures 1, 2
2. 3 . 11. 5      -   Device D receives the information from fixture   1

As you can see, the broadcast information is sent to all devices. Even though it transfers information
only for ONE panel, the other panels have to read and discard this information. This lowers the
remaining amount of data that can be sent to this panel per second. If programming the patch to sent
the information only via unicast, the receiving devices in the network do not need to discard
unnecessary information and can be used more efficiently.

A downside of this method is, that you loose flexibility. In case the entire network routing has to be
changed or only a single device needs to be set to a different IP address, keep in mind that the
software patch needs to be updated as well. In conclusion, the multicast method combines efficiency
and flexibility.

[Network adapter]:
Choose the name of the network adapter that should output the Art-Net information. If an explicitly
named network adapter is not found, the "any" adapter will be used. This is to be decided by the
operating system and depends on your network adapter settings.
In case of processing a lot of Art-Net data it is very much recommended to use one network adapter for
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the communication with the Pandoras Box Master software and one separate network adapter for the
Art-Net communication. All Pandoras Box Servers are shipped with a dual network card providing this
working method.

[Auto Increment]:
Use this function to automatically increment the DMX addressing when adding several fixtures to the
patch. If checked, the application will calculate the next free DMX and Art-Net Address and patch added
fixtures to it.

Example:
You want to add fixtures with a total channel count of 120 channels. You set the addressing to (1,0,0):
DMX Start address = 1, Art-Net Subnet = 0 and Art-Net Universe = 0. Auto Increment is checked.
· The 1st  fixture gets the Start address ( 1 ,  0 , 0 ), 
· the 2nd  fixture gets the Start address (121, 0 , 0 ),
· the 3rd  fixture gets the Start address  (241, 0 , 0 ),
· the 4th fixture gets the Start address   (361, 0 , 0 )
· the 5th fixture gets the Start address   (  1  , 0 , 1 ).
The 5th fixture with its 120 channels won’t completely fit any more into the Universe 0, so it gets
assigned to the next higher Universe.

10.1.7  Patch Settings

The Patch settings allow you to change the Patch View.

[Zoom]: 
You may set a higher zoom factor to zoom into the patch (by default
the zoom factor is set to 1).

[Center]:
Press [Center] to move the patch’s center point into the center of
the user interface. This can be helpful after dragging the patch.

[Patch Width & Height]:
The patches size is displayed here.

[Show Info]:
When enabling this option, the DMX Addressing will be shown on
the patch for each fixture.
In the left image you see two fixtures. Their DMX address is shown
in the respective upper left corner.
The lower fixture is highlighted blue as it is currently selected.

[Show BG]:
A background image (for example a floor plan) may be displayed on
the patch, this can be helpful for some patches.
To do so, load a background image (see Edit Menu ) and enable
the option [Show BG].

[Show Pixel Grid]:
Uncheck this option if you don’t want to see the pixel grid in the
patch.

Please note that with some patch sizes and zoom factors the pixel
grid can’t be displayed.

789
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10.2  Fixture Editor

The Fixture Editor allows to create and modify
fixtures that can be used in the patch.
Open the fixture editor via the Edit Menu  from
the Main Matrix Patcher User Interface.

The Fixture Editor is divided into the following
sections:
File Menu ,
Fixture Library ,
Fixture Channel ID  and
Fixture Workspace .

See here a guide of how to create and edit fixtures
.

10.2.1  File Menu

[New Fixture]
Creates a new fixture. Please note that any prior work won’t be saved.
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In the pop-up dialog you may enter the Vendor Name, the fixture type, its Width and Height (in px), the
Start ID and the Offset. An offset of 3 (by default)  will create 3 DMX channels (RGB or CMY) per pixel.

If you wish to create a fixture that should be controlled via DMX or Art-Net, tick the check box "DMX
Fixture". 
To create dimmer only fixtures, please use RGB Mode and Offset=1.
You may choose as well the colour mode: RGB or CMY, according to your fixture.

If you wish to create a fixture that should be controlled via DVI, tick the check box "Video Tile". 

[Import Fixture]:
Imports existing fixtures (.mfx) into the library.

[Export Fixture]:
Exports fixtures from the library to be saved for later use (as .mxf-files).

10.2.2  Fixture Library

The Fixture Library contains a stock of common LED-Fixtures,
sorted by vendor name. Every Fixture that was created with the
Fixture Editor will appear here as well.

This section allows to create a new custom fixture and edit or
delete any existing fixture.

[Vendor Name / Fixture Type]:
As soon as a fixture is created or set to be edited, the Fixture’s
Vendor Name and Type will be displayed in the text fields.

[Fixture Colour]:
The small colored box next to the Vendor Name (in the picture
above shown in orange) allows to choose the fixture’s background
colour. It will open a colour-picker once you click on it
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[New…]:
Allows to create a new fixture, see File Menu . Please note that any prior work won’t be saved
automatically. The Fixture will be loaded into the Workspace now for further editing.

[Edit]:
To start editing an existing fixture, please select the fixture in the Fixture Library and press [Edit]. The
Fixture will be loaded into the Workspace now for further editing.

[Save]:
Saves the changes in the fixture under the Vendor Name and Fixture Type currently displayed.

[Delete]:
Deletes the fixture currently selected in the fixture library.

10.2.3  Fixture Channel ID

Within the Fixture Channel ID section the DMX Addressing for the
selected fixture will be set up.

[Fixture Channel Count]:
This is the amount of channels the fixture contains. It is calculated
by the Fixtures Width and Height multiplied with the Channel
Offset. For example, the fixture is 4 px wide and 4 px high and has
an offset of 3 channels (for RGB), then the Fixture Channel Count
is 4x4x3 = 48 channels. This Channel Count is used to calculate
the start address for the next fixture when setting up the patch.

In order to create fixtures with unpatched pixels you need to
manually modify that number, so that the start address for the
next added fixture is correct when using auto increase while
patching the matrix.

[Start ID]:
This is the DMX Start Address for the next pixel.

[Channel Offset]:
Amount of DMX channels per pixel

[RGB / CMY]:
Defines if the colour values of the pixels will be interpreted as RGB or as CMY.

[Auto Increment ID]:
When activated the starting channel of the pixels will automatically be incremented according to the
chosen offset.

Default [Size]:
This is the fixture’s size when added on the patch. By default it is set to 500%, you may change this
size when editing a fixture.
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[Default Angle]:
The default angle refers to the fixture’s angle when it will be added on the patch.

[Rotate 90° ->] / [Rotate 90° <-]:
To rotate the selected fixture in 90° steps, you may simply use the Buttons [Rotate 90° ->] and [Rotate
90° <-].

[Mirror Horizontal / Mirror Vertical]:
This allows to mirror the selected fixtures horizontally or vertically.

[Reset]:
Clears the DMX addressing of the currently selected fixture.

[DMX Order]:
When this option is checked, it shows the pixel addressing order in the fixture with a red line. The
starting pixel is marked with a red dot.

10.2.4  Fixture Workspace

When creating a new fixture or editing an existing one, the fixture will be loaded into the workspace.

In the workspace you see every pixel the fixture
contains.

In case of a DMX fixture, the pixels are displayed as
dots. The applied DMX order is shown as red line, the
DMX starting pixel is marked as red dot.

When moving the mouse cursor over the fixture, the line
at the bottom displays the information about each pixel:
the Channel ID, the colour mode (RGB or CMY), the
pixel’s position as well as the Fixture’s Width and
Height.

The fixture’s DMX Order may be modified when the
fixture is created or when being in Edit-Mode, please
see How To Create And Edit Fixtures .

In case of a video tile, the pixels are displayed as squares. Of course no DMX order needs to be
displayed. No adjustments have to made.
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10.2.5  How to Create and Edit Fixtures

This chapters explains in more detail how to set up
DMX fixtures. If you are working with Video Tiles
feel free to proceed with the next  chapter or
the ReMapping Guide .

A new fixture with the Width=10, Height=10 and
the offset=3 was created by pressing [New…]. The
default DMX channel order goes from the fixture’s
top left pixel (the first channel is marked as red
dot) over to the right and then starts at the left in
the next line and so on. You see this channel
order displayed by the small red line.

By mouse-over on any of these point  you find the
pixel information according to this point at the
bottom left: the channel ID, the colour mode,  X
and Y position and the total width and height of
your fixture.

To arrange a new DMX order for your fixture, press
[Reset] at the bottom right to clear the channel
settings, see next picture.

Now there is no channel order for the fixture. You
have two possibilities to apply a custom DMX
channel order to the fixture:

- DMX Addressing using the Auto Increment ID
Option or

- Manually DMX Addressing.

DMX Addressing using the Auto Increment ID
option:
To automatically increment all Channel IDs based
on the Start ID, check “Auto Increment ID”. The
text fields for Start ID and Channel Offset will be
greyed out then.
Please be sure that you begin with the right Start
ID: While creating a new DMX order and resetting
it, the Start ID counts up and does not reset
automatically.
Now start drawing the channel order on the fixture
with the mouse cursor:
Click on the start pixel (it will be shown in full red)
and go on in the correct order. Do it click by click
or hold down the left mouse button.
If you did a wrong click, re-click on this pixel to
remove the addressing again.
It could look like the next picture now: 
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In the Fixture Channel ID section you see that the
Start ID was counted up, so that the next pixel you
click on would get the start address 301. If you’re
not confident with the current addressing, the
button [Reset] may be pressed again to clear the
pixel addressing.

Please note: before re-drawing the pixel
addressing check the Start ID to be set back to 1!
To do this disable the Auto Increment ID option,
enter the Start ID 1 and enable the Auto Increment
ID option again.

Having finished your new DMX order, if needed,
you can rotate the matrix 90° to the left or right or
mirror it horizontally or vertically by clicking the
corresponding buttons down left.

Very important: Press [Save] to assign all
changes! 

Manually DMX Addressing 
This way could make sense if you have a fixture that has unpatched pixels. Let’s start again with the
plain fixture.

When not using the Auto Increment ID function, enter every pixels Start ID BEFORE you click on it on
the fixture! 

Example: 
The 10x10 px fixture should be addressed so that after every second pixel there a 3 unpatched channels:
Pixel (1,1) starts with channel 1, Pixel (1,2) starts with channel 4, Pixel (1,3) starts with channel 10,
Pixel (1,4) starts with channel 13, pixel (1,5) starts with channel 19 and so on.

To achieve this DMX order, do this:
Enter Start ID=1, then click on Pixel (1,1).
Enter Start ID=4, then click on Pixel (1,2).
Enter Start ID=10, then click on Pixel (1,3).
Enter Start ID=13, then click on Pixel (1,4), 
…

Having finished your new DMX order, if needed, you can rotate the matrix 90° to the left or right or mirror
it horizontally or vertically by clicking the corresponding buttons down left.

Very important: Press [Save] to assign all changes! 

Editing existing Fixtures
If you want to edit an existing fixture, choose it from the fixture-list scroll down menu and press [Edit].
Now you can modify it by acting as if you create a new one. Keeping the old name will result in
overwriting the fixture when saving it. You may type in a different name as well, then it will be saved
under this one as a new fixture.
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10.3  Patching Guide

The Pandoras Box Matrix Patcher starts with the main patching window:

The Fixture Library on the top right contains a stock of fixtures by different vendors. If the fixtures you
need are not included or if the fixtures need to be modified, you have to create/edit them first using the 
Fixture Editor . See here a guide of how to create and edit fixtures .

As soon as all fixtures needed are available in the Fixture Library you may start setting up your patch.

Important information about setting up the patch size

The Matrix Patcher up from Revision 12 should be used with big patch sizes, although you maybe only
need a patch that is 10x10 pixels big! The reason for this is that the patch size always refers to the size
of the Pandoras Box output that is used for the Matrix.

Example 1:
The Pandoras Box output 1 of a PB Server should be used to control your LED Panels. The display
attached to this output is set up to the resolution 1024x768 px. The LED Panels where the video content
should be displayed on are 20 px wide and 20 px high.

a) If the patch is only 20x20 px large (according to the amount of pixels of the LED Panels), only a
fraction of the whole PB layer size will be used for the Matrix, illustrated by the red square in the
picture below. This way the content (in this example the coolux logo) has to be scaled very small to
be completely displayed on your devices. And this is quite unhandy.
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Left side: 

By default the video content (the coolux logo)
covers the whole output (output size: 1024x768
px). A patch with the size 20x20 px would only
give out DMX data for the area that is covered by
the red square.

Right side:

To ensure that the logo will be shown on your LED
Panels with its whole height, it has to be scaled
down a lot.

b) A better and more handy workflow inside Pandoras Box is given when the patch gets close to the
size of the Pandoras Box Matrix output (PB output= 1024x768 px). You may create a patch now that
is 1024x768 px. The fixtures on the patch will be scaled up and arranged so that they form a square
(because of the pixel aspect ratio 20:20) covering the whole patch’s height. The colour values for one
pixel of the patch will now be calculated as average value from a bigger area, not only from one pixel
as shown in the example 1a. See picture below.

Left side: 

By default the video content (the coolux logo)
covers the whole output (output size: 1024x768
px). The fixtures on the patch with the size
1024x768 px cover nearly the whole output, shown
by the red square.

Right side:

To ensure that the logo will be shown on your LED
Panels with its whole height, it has not to be
scaled down any more!
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Patch Size
In the Patch Settings  the current patch size is displayed. By default the size is set to 1024x768 px.
Adjust this patch size to fit your PB Matrix output resolution.

Adding Fixtures
Now that the patch is set up, you need to add one or several fixtures to your patch. Let’s assume that
you want to place 3 square fixtures (with the size 10x10 px) side by side in a line, covering the whole
width of the patch.

Select the fixture in the Fixture Library. If it is not available set it up in the Fixture Editor  first. But
before adding the fixtures on the patch, think about how they should be addressed if working with DMX
fixtures. Turn over to the Fixture Patch  and enter the DMX starting address and the Art-Net Subnet
and Universe for the first fixture. Don’t press [Apply] as this should be used only when modifying DMX
addresses after the fixture is created.
If the DMX addressing should be automatically incremented for all following fixtures, enable [Auto
Increment]. If you want to address the following fixtures manually, you may enter the new DMX
addressing in the Fixture Patch before adding the fixture to the patch.
Now click on [Add] in the Toolbar  or choose the add-function via the right-click menu and proceed a
left mouse click in the patch area. Your first fixture will appear. Do this two more times to get all 3
fixtures on the patch.
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Adjusting the fixtures on the patch
As the fixtures should cover the whole width of the patch, you have to position and scale them to the
correct size. So that the result looks similar to this:

The scaling can be done in several ways: by eye, by calculating the correct zoom factor or by using a
prepared background image.
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· By eye:
Turn to scale-mode using the right-click menu or pressing the scale button in the toolbar . Click on
the fixture and move the mouse cursor to the right while holding down the left mouse button. Do this
for every fixture. Then adjust the positions by turning into the move-mode.

 

· By calculating the correct size (in %):
The patch is 1024 px wide, one fixture is 10 px wide (zoom factor =
100%). A fixture should cover 1/3 of the patches width. So 1/3 of
the patch width are 1024/3 = 341,3 px. To get the new size, divide
the size 100% through the fixture’s width (10 px) and multiply this
with the width the fixture should cover (341,3 px):
100% / 10px x 341,3px = 3413 %.
Select the first fixture when being in move-mode. Now enter the new
size into the according text field in the Fixture Patch  and press
[Apply]. Do this for all fixtures and position them on the patch. 
Please note: the size can only be applied in 10%-steps, so that
you have to round the value up or down. In this case you could use
a size of 3410% or 3420%.
A faster workflow using this method is: when starting from the
beginning, choose the fixture from the library and press the button
"Add array", set up 3420% and choose to insert a "1D" array.
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· By using a prepared background image:
You may prepare an image, that shows the correct adjustment of three items over the width of the
image. This can be loaded as background image. To do so, go to Edit> Load Background Image and
browse to the image path. To show / hide this image, toggle the option [Show BG] in the Patch
Settings  down right.
This background image helps you now to scale and arrange the items on the patch.

Useful Hints:
You may check and modify the settings in the Fixture Patch for each fixture if necessary (e. g. the DMX
addressing or the positioning).
To remove a fixture from the patch, highlight the fixture by clicking it and press [Del] on your keyboard.

Save Patch & Export Matrix:
When patching the matrix is completed, it is recommended to save this patch file in order to still be able
to modify it later on. Do this by File > Save Patch. In addition this command adds an according *.pbx file
as a media file to the project if a Pandoras Box Master software is running at the same time plus it
spreads the file to all connected Clients. This is very important, especially when working with DMX
Fixtures as the Art-Net data is generated by the Client and output through its network adapter.
Please note: In older versions (before Rev 49 and Pandoras Box 5.3) it was necessary to export a patch
separately. Automatically a “pixelpatch.csv” was saved in the directory where the Matrix Patcher.exe file
is located (e.g. C:\coolux\program files\Pandoras Box SERVER STD Rev xxx). This is now not
necessary anymore. However, if you still have copies of those *.csv files and want to work with them,
simply drag them into the project manually. From here, Pandoras Box treats a csv like a pbx file. 
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The next step is, to use the generated matrix file in Pandoras Box. As soon as the file is included in the
project you may start programming it onto the timeline. To do so, choose which Pandoras Box Client
should calculate the Art-Net data (in addition to the normal video output via DVI) and drag the matrix file
on its output . Please note, that effects dragged onto the output layer cannot be considered by the
patch file, thus you will not see output effects on your DMX panels.
Of course each Client in your PB network may be programed with different matrix files. In addition it can
be saved on the timeline and may change throughout the show.
Use the right-click menu in the Preview  to visualize the matrix files.

If working with Video Tiles please proceed to the ReMapping Guide .

10.4  Remapping Guide

This chapters explains in more detail how to use the remapping feature if working with Video Tiles that
are connected via DVI and a LED video processor. If you are working with DMX Fixtures connected via
Art-Net feel free to skip this chapter.

BACKGROUND INFORMATION
Most LED video processors are capable of creating only horizontal and vertical layouts for the Video Tile
alignment. As soon as any of the tiles are rotated (in any angle), content mapping can be very difficult
and complex to setup.
For those creative applications Matrix Patcher and a new Pixel Re-Mapping FX  were designed. 

DIFFERENCE BETWEEN PATCH AND MAP VIEW
The patch view represents the output pixels, that is how the tiles are programmed and located in the
LED processor.
The map view is for relocating the individual tiles in any orientation and size according to the real setup.
In other words the map view represents the source pixels of a Pandoras Box Layer Composition Space.
In Pandoras Box you set up the content (and layers) according to the stage in the real world. There is no
need to create special content in a complex way anymore.

The combination of both views results in the exported map png. The map stores for each source pixel the
position of the output pixel. Afterwards the ReMap FX in Pandoras Box reads the map and routes
automatically any source pixel to the stored output location. Thus it routes the pixels according to the
patch / map setup that you may influence at any time of programming.

When creating Video Tiles you would first create a Video Tile layout as in the video processor view and
then switch to the Map View and adjust the tiles as seen in the real world.
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STEP BY STEP: How to use the ReMapping feature

- Create a new Patch with the same (!) resolution Pandoras Box Output is set to and how the LED video
processor is controlled

- If the fixtures needed are nor included in the Fixture Library, create new Video Tiles in the Fixture Editor

- Add these Video Tiles in the Patch View as they would be laid out in the LED processor

- Then choose "Initialize Map" from the Menu and switch to the Map View that now looks like the Patch
View to start with

In the image below a background image was chosen. It shows a scene from the real stage setup. This is
helpful for the next step.

- Now re-arrange and rotate the Video Tiles in the Map View as they are in the real world. You can do
this by eye or by using a prepared background image.

- Once you are confident with the setup, use the "Export Map" option from the File Menu in order to
store the map as a png file for the ReMap FX in Pandoras Box.
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- Load the map.png into a Pandoras Box project and make sure that anisotropic filtering is turned off. To
do so, click the file in the Project Tab and have a look in the File Inspector. This step if very important for
the entire process !
The image below shows a setup up without the ReMap effect turned on.

- Add the ReMap FX to the desired Output and load the Map.png into the Media Input of the ReMap FX
 and set the Mix to 255. Now, the pixels are routed differently as seen in the Preview depicted in the

image below. Note that the effect has to be assigned to an output layer and is only visible in the Preview
if it is set to an output view, not the global camera.
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If you need to change something regarding the fixture setup in the Matrix Patcher please keep in mind
that for any exported png file the anisotropic filtering must be turned off in Pandoras Box. 
If you have to add one more tile to the scene or if you have to replace some of them, it is the easiest to
position the few tiles in the Patch View and WITHOUT using "Initialize Map" you position them in the
Map View. Keep in mind that the "Initialize Map" command resets all changes made in the Map View so
far.

If you need to enlarge the entire Patch, please use the "Resize Patch" command. Do not scale the
exported Map. It is very critical to keep every single pixels' information.
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11  Warper

The Warper enables you to project on any screen shape. The Warper is a specialized, basic 3D
modeling software using custom shapes with scalable free-form-deformers (FFD ).
The application is included in the Pandoras Box installation and requires an attached dongle when
started. Any PB Manager and PB Server comes with the full 3D edition. The PB Player comes with the
2D edition that has restricted  features, e.g. no Z axis, object import, live warping, markers, camera
settings etc. The chapter Product Overview  gives details regarding the Manager, Player and Server.

More advanced objects can be imported from many 3D modeling programs as described in the topic " 
Third Party Software ".

Solutions for projecting on bended surfaces and complex objects

The main problem with projection surfaces that are not positioned
perpendicularly to the projection axis is that the light source from the
projector does not have the same distance to all projection points
any more. A rectangular image is not rectangular any more and
furthermore, the distances between particular points in the original
image may be very different in the projected image. In short the
projected image is distorted. The distortion relates to the shape of
the screen (or object) and to the way the projector "looks" at it which
includes the orientation and distance as well as all lens settings.

The challenge is to output an image that will look correct,
considering the viewpoint of the audience. On simple planar screens,
the keystone parameters for the top, bottom, left and right side of the
image can already achieve a satisfactory results (see left, middle
image).

As soon as the projection surface is not a single plane anymore, e.g.
it is a bended screen or a more complex object like a cube the
keystoning reaches its limit.
Those setups can be mastered in two ways. Which solution you
choose depends on your setup, time as well as experience and
knowledge of the team.
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projection before ... . ... and after warping

2D Warping

The first approach is to create a 2D plane offering for example a grid
with 100 intersection points. The entire plane and each individual point
can be moved, scaled and rotated until the original image is distorted
in a way that the projected image looks correct. The plane is then
exported as an *.x file and applied to the PB output layer  (or
another layer) and acts like a map for each pixel of the original
content. 
This workflow can not be prepared beforehand. It is indispensable that
you work in the Warper with the real projector connected and distort
the 2D image whilst looking at the real screen. When something is
changed in the setup the chances are high that ALL points must be
adjusted.

The advantage of the workflow is that you do not need to have any
knowledge about 3D objects. You simply need to move the plane's
intersection points until all lines are straight and all distances between
certain points are equal. Measuring tools, tape to mark distances and
(rotary) lasers can help you in that process and simplify and speed up
the workflow.

3D Warping

The second approach is to represent the real 3D setup as a virtual 3D
setup. It includes to import a 3D object into the Warper; the 3D model
must match the real screen or object as accurately as possible. Then,
the virtual camera in the Warper is set up in the same way as the
projector looks at the real screen. For this, you need to adjust the
camera's and the object's position, orientation and lens settings. Two
ways to do this are manual measurement, described in the Camera/
View tab  and the automatic camera calibration based on markers,
described in the Marker tab . This feature is available since
Pandoras Box version 5.5.

In addition, fine-tuning adjustments with the object's vertices can be
done too. As soon as the virtual model and the virtual camera accord
with the real screen and real projector the projected image looks
correct. 
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As the final steps, the Warper's camera values are transferred to the 
PB camera layer  and the object is exported as an *.x file and
applied to a individual graphic  or video layer .

This workflow can be prepared beforehand. You may for example
create the screen model using a 3D modeling program like 3ds Max

 and Maya from Autodesk, blender  from Blender Foundation or
CINEMA 4D from MAXON Computer GmbH. It is possible to setup the
virtual settings for XYZ position of the object and the camera in
accordance to available plans.
The advantage of the workflow is that you can nevertheless adopt
changes conveniently. If, for example, the real setup is changed or not
as accurate as scheduled you can adopt these changes easily for the
virtual setup in the Warper.

For more information about how to use the Warper please refer to the following pages: 
General 3D Modeling Terms
User Interface,
Warping Guide,
Keyboard Shortcuts

11.1  General 3D Modeling Terms

This chapter covers the common 3D modeling term definitions:
- coordinate system
- generic units
- Vertices, Pivot Point, Edges and Faces
- UV texture mapping
- mesh versus FFD

Please make yourself familiar with these terms. They will be used in the following chapters when the
Warper interface and workflow is being explained. As well, the explanations might help you when
communicating with 3D artists who prepare 3D models for you or when getting in touch with one of the 
third party applications  yourself.

Coordinate System

Each 2D and 3D world needs a coordinate system which defines the position and orientation of each
object. There are two possible systems: the right-handed and left-handed system. In both systems the
positive X and Y direction are the same and show to the right and upper side (as seen in the picture
below). The Z axis makes the difference, it shows either to the back or to the front.

Pandoras Box and the Warper are based on the left-handed system. If you import an object from an
application that is based on another orientation make sure to adapt it.
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The origin of the 3D space (X,Y,Z) = (0,0,0) is situated in the exact middle of the screen when starting
Pandoras Box and the Warper with default settings. The origin is the reference point for every object. The
camera has a position of (0,0,-25) and a FOV (field of view = opening angle) of 35,489 degree (or 56,251
mm).

Generic Units

Next to the coordinate system's orientation, units are of
great importance. An object has a defined position and size
which is defined and saved in units.

Many 3D modeling programs can save an object with so
called generic units (GU), e.g. a cube may have a height/
width/depth of 8 GUs, rather than being measured in metric
or pixel units. The advantage is that GUs adapt to the
current screen, they "generate" a relative size and must not
be scaled when the resolution changes. Per default a screen
width is exactly 16 GUs, the height is calculated by the
aspect ratio. Hence, a 4:3 display is 16 GUs wide and 12
GUs high, whereas a 16:9 display has the same width but a
height of 9 GUs.
For example: A 3D modeler works an a 1024x768 pixel
display and creates a cube that covers half of his display,
i.e. it is 8GUs wide. If you import the cube into the Warper it
will have the same relative size (half of your display) no
matter which aspect ratio or resolution is chosen at your
computer.
The height will always be the same size as the width, it will
never be "squeezed", however it might cover less or more
space than on the modelers screen.

The Warper and Pandoras Box are based on generic units
since version 5. The coordinates (X,Y) = (0,0) are situated in
the middle of the display. If a layer or object moves 8 units
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to the right its center will be exactly on the right edge of the
screen.

Vertices, Pivot Point, Edges and Faces

Every 3D model and geometric shape consists of corners and
intersections. These special points are saved as so called
"vertices" (singular: "vertex"). In a 3D space a vertex must consist of three
coordinates, X,Y and Z to definitely mark the position of a corner. A cube,
for example must be defined by a minimum of 8 vertices. In the example,
these are the small blue points.

The default mesh in the Warper consists of vertices as well, the more
mesh segments you set up, the more vertices are generated by the
Warper.

In most 3D modeling programs there is a so called pivot point. In the left
image it is depicted as a round orange point. The pivot starting point is the
center of a transformation like rotation and scaling. If the cube is scaled, all
vertices still would have the same distance to the pivot point. For more
examples, please see the topics Scale Pivot  and Rotation Pivot in
Pandoras Box .
In the 3D modeling program itself you may position the pivot point where
you like but please keep in mind that file formats like *.x, *.fbx and *.3ds
do not support pivot points. These formats always save the coordinates of
the vertices as absolute coordinates. That means that the position of the
object and all its vertices will be kept. But when importing the object in the
Warper, the center of rotation and scaling is the center of the object itself.
This cannot be influenced. Pandoras Box, on the other hand, supports pivot
points itself. Thus, when importing the object, the pivot point is set to the
origin of the coordinate system (0,0,0) and can be moved to the position of
your choice with the parameters of the layer.

The connections between two vertices are called "edges". Here, they are
depicted as orange lines. A cube consists of 12 edges.

Some 3D modeling programs define that exactly three vertices make one
face. Thus faces are always triangular.

The next hierarchy is then called "polygon" whereas one or more face(s)
form one polygon. The outlines from a polygon are the edges.
In the example image they are 6 gray squares forming a cube; 6 polygons.
If faces exist, there would be at least two faces per polygon.

No matter how your 3D modeling program works, either faces or polygons
can be applied with a texture.
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UV Texture Mapping

 

UV mapping is a process of defining how
to represent a 2D image on a 3D model.
The UV mapping transforms a 2D source
image (in our case an image or video) into
an image buffer called a texture. 
In contrast to "X", "Y" and "Z", which are
the coordinates for the rendered 3D object,
"U" and "V" are the coordinates of the
texture. The UV map stores for each X,Y,Z-
coordinate a defined U,V-coordinate.

This creates the effect of painting the
image onto the surface of the 3D object, or
in other words, how to wrap or stretch the
image around the object. As explained
below there are different ways how to do
that, hence the chosen UV map is stored
as a property of the 3D model.

If a 3D model has no UV map, neither the
Warper nor Pandoras Box can paint a
texture on it which leads to the fact that
the object is invisible and cannot be
displayed. The Warper has tools that can
influence the UV Map, e.g. scale or move it

. When not importing 3D models from
third party programs but working with
meshes in the Warper you can define how
to apply a texture on it. A texture can
cover more than one mesh as well. This is
described in the chapter "Edit Menu ".
On the Pandoras Box side, there are 
effects influencing the UV map  as well.

There are several standard mapping
techniques available to map a texture onto
an object:
- planar
- cubic or box
- cylindrical and 
- spherical mapping.

Planar mapping can be referred to an
image projection from one side onto an
object.
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A cubic mapping for example maps the
texture to all sides of a object like a box.

The cylindrical mapping wraps an image
around an object like a cylinder, the left
and right edge will join each other.

Spherical mapping wraps the image all
around an object as a sphere. Please be
aware that the top edge of the texture
shrinks down into the top north pole and
the bottom edge in the south pole.

For proper spherical mapping textures with
an aspect ratio of 2:1 apply best to a
spherical object.

Mesh versus FFD

This paragraph describes the difference between a mesh point and an FFD point, thus it is covering a
fundamental function of the Warper.
The pictures below show a 2D plane with a green-colored 10x10 mesh and orange-colored 3x3 FFD.

See here the differences between moving a FFD control point and moving a mesh point. Please note that
the FFD is only a helping tool to set up the mesh, you won´t see the FFD in the exported object.

a. The grid without any editing. The green lines represent
the mesh, the orange lines the FFD.
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b. The top left FFD control point is moved further down.
The whole mesh is affected by this change: the horizontal
lines are bend together on the top left side, the meshes
outline gets curved.
This effect can be of advantage or disadvantage. In the
beginning of the warping process it can simplify and
accelerate the workflow as it is not necessary to move
each individual mesh point. The further the warping
process develops the more it is necessary to apply
changes to particular pixels only. At this point the FFD is
not sufficient any more as it affects large areas of the
grid. 

c. One mesh point is moved. Only the segment lines
between the moved point and the four neighbor mesh
points are affected by this.
The more you are experienced with warping the better
you will be able to answer the question how many mesh
points a grid should have. If too little points are chosen it
won't be possible to apply the detail changes that are
necessary. This is especially crucial when setting up
meshes for a softedge projection as the pixels must
overlap each other exactly in the overlapping area.
If too many points are chosen, the warping process is
lengthened unnecessarily as all points must be adjusted.

For more information about how to use the Warper please refer to the following pages: 
User Interface,
Warping Guide,
Keyboard Shortcuts

If you are interested in other 3D modeling programs, please refer to the topic covering third party
applications .
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11.2  Warper User Interface

When opening the Pandoras Box Warper application in the background you will see a default 2D plane
with orange lines (FFD - Free Form Deformers ) and white lines (mesh ), the grid displays a
testpattern that is generated automatically according to the output resolution. How to work with the grid
is explained in the chapter "Warping Guide ".

In the foreground you have a gray Toolbox, wherein you set up the grid properties and other features. 
Edit > Advanced Mode activates more advanced options and settings. Please note that there are
differences between the 2D and 3D edition as explained in the previous introductory chapter .

The Toolbox' title bar displays the ID of the application (e.g. "1 | PB Warp 3D") and the IP address, this
is quite useful when working on several Warper windows at the same time, for example when setting up
two meshes for a softedge projection. Note that the x-button closes the toolbox only (T brings it back),
File > Exit closes the entire program.

Title bar

Menu bar

Tools bar

Tabs and
their
content
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11.2.1  Menu Bar

The Menu Bar is divided into the File Menu , the Edit Menu , the Mesh Selection  and [?] -
Button  and the Camera Selection .

11.2.1.1  File Menu

The depicted menu is the advanced one. Per default, the basic menu is shown, to get access to all
options, go to 
Edit > Advanced mode
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New

NEW
When creating a new file, this dialog box opens up. Please
note that this will close your current project. (In case you
simply like to add another mesh, click the Add Button  next
to the mesh selection drop-down list.)

Decide how many horizontal and vertical FFD control points
should be applied. How many to choose depends on the shape
of the screen you need to warp. For more details, there is a 
tutorial  at the end of the Warper chapter.

Tick the check box [1:1 Full Screen Start Size] if the new
mesh should cover the complete output instead of keeping a
small border uncovered. You may as well decide what aspect
ratio the new fullscreen grid will have. The width of 16 generic
units  will always cover the current output screen's width.

If you decide for a pixel size please note that it will generate
values relative to your local output resolution and aspect ratio
and will apply them to the object. For example: if you are
working on a 1920x1080px display and choose a 1024x768px
mesh, the new plane will have a width of 8.533 generic units
(16GU * 1024/1920) and a height of 6.4 GU (9GU * 768/1080).
Defining a unit size for the width and height will apply those
generic units directly.

NEW...
Again, this option will close your current project.

Choosing "Dual / Triple / Quad" will generate two / three / four
new meshes (on the screen that is set to be the primary
monitor). There is a UV Map covering all meshes.
This option is very useful when working with a device that
splits one output into several parts. If you use this device in a
softedge projection, it is recommended to create special
testpatterns with a grid that is colored differently per region.
That allows you to see if the warped meshes overlay each
other pixel per pixel. Alternatively you may open the Warper
several times and use the Triple / Quad option  as described
below.

The settings offered in the dialog box are the same as
explained in the previous paragraph.

Load and Save Settings

LOAD SETTINGS
If you want to load an existing warping file (*.wrp), choose the directory and file name in the opening
dialog .

SAVE SETTINGS
Choose the directory and file name in the saving dialog to save your warping file (*.wrp). In contrast to an
exported *.x file object, the warping file includes all internal settings like FFD points, the Mask and all
other Warper settings. It is recommended to always save in this format as well.
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LOAD LAST SETTINGS
Check this option if you like to load the last project as soon as the Warper is started.

Import Object

This command allows to import an object from another 3D modeling program . A pop-up asks whether
you like to merge the imported object, i.e. include it into your current setup. If "No" is chosen your
current project file closes and a new project is opened containing nothing but the imported 3D object.

Choose the directory and file name in the opening dialog. The following formats are supported:
- *.3ds
- *.fbx
- *.obj
- *.x

The next dialog asks you whether you would like to load the 3D scene of the chosen file in separate
parts or as one united object. In case your scene has more than 32 individual objects, it is not
recommended to load them as separate elements as this consumes much memory.

If your object is larger than 16 generic units  a pop-up lets you rescale the object. Though, due to
possible rounding errors, it is recommended to scale the object in the software it was originally created
with.
Please note that *.x files can be written by many exporters and sometimes the same data is written
differently. The build-in importer is optimized to work with the exporters provided by coolux . Importing
files from other exporters could result in changed orientations, normals,... .

Export Modes

EXPORT ALL
Use this export option to export all meshes as one *.x file.
For example, if you have created two meshes and use the "Export All" option the resulting *x.file will
behave as follows. Both meshes are covered with the same texture. If applied to a layer in Pandoras Box
its media will be displayed twice, according to the scaling and the position of the two meshes. If applied
to an output layer, everything that is seen by the camera layer will again, be displayed twice.

Choose the directory and file name in the saving dialog to save all meshes as one scene.

EXPORT SELECTED
Use this export option to export only the selected mesh as an *.x file.
In contrast to the above option you may now export each mesh individually and apply it to different video
or graphic layers or different output layers.

Choose the directory and individual file name in the saving dialog to save only the selected mesh.

Please note: Changes done to the UV texture mapping (by editing the texture’s Zoom or Offset settings
in the Mesh tab ) will be included in the exported file. This will influence the size or position of a
texture used with this object in Pandoras Box as well! If you want to have the whole texture mapped on
the object, please use the option “Export Selected (1:1 UV)” instead.

Example: The left image below shows a mesh in the Warper. The texture mapping has been modified to
see only a part of the testpattern. After having exported this file via the option “Export Selected”, in
Pandoras Box (depicted in the right image) the object’s texture will look corresponding to texture in the
Warper.
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EXPORT SELECTED MESH (1:1 UV)
Use this export option to export the selected mesh as an *.x file without the changes done in the Mesh
tab .
In contrast to the above option any texture's Zoom or Offset settings will not be included in the exported
file  - the UV map is applied with the original 1:1 setting. When the mesh is applied to a graphic, video or
output layer (depicted right) the object's texture will look different to the texture in the Warper (shown
left).

 

EXPORT SELECTED AS INDEX OBJECT
Use this export option to export the selected mesh as an index object (*.x file) to be used for morphing
or live warping within Pandoras Box.
Choose the directory and file name in the saving dialog to save the index object. In Pandoras Box, the
index object can be used as any other object on a video, graphic or output layer. Please refer to this
chapter to learn more about morphing and live warping .

Please note that a new index file must be exported each time when the FFD and mesh count is
changed.
If you like convert an external *.x file to an index object please use the option "Convert .x File to Index
Object".

EXPORT SELECTED AS MORPH TARGET
Use this export option to export the selected mesh or 3D object and its current look as a morph target
(*.x file) to be used for morphing within Pandoras Box.
Choose the directory and file name in the saving dialog to save the morph state. Then you may alter the
mesh / object deformation and save this as a new morph target. In Pandoras Box, the morph objects can
be used as effect media files for various morph effects. Please refer to this chapter to learn more about 
morphing and live warping .

Please note that a mesh / object used for morphing should not be placed outside the area that reaches
from -32 to +32 generic units.

If you like convert an external *.x file to a morph target please use the option "Convert .x File to Morph
Target".
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EXPORT ALL OBJECTS AS SINGLE FILES
Use this export option to save each 3D objects from your scene as individual *.x files. Choose the
directory and folder name in the saving dialog. Automatically, the files are named with a consecutive
name like "3ds Obj1.x" and "3ds Obj2.x".

Save Mask

Use this option to export the screen mask you created in the ScreenMask tab. 
Choose the directory and file name in the saving dialog to save the mask as a *.png file, which can be
inserted in your Pandoras Box project and used as a mask object on a layer. Read more...

Convert Files

CONVERT .X FILE TO INDEX OBJECT
CONVERT .X FILE TO MORPH TARGET
The above described options "Export Selected as Index Object" and "... as Morph Target" refer to an
object made within the Warper. If you have exported your object from another third party program as an
*.x file and you like to use it for morphing and live warping within Pandoras Box please use the
"Convert..." option.

First, choose the directory and file name from your external *.x file in the opening dialog. Then, choose
the directory and file name for the converted index object (or converted morph target) in the saving dialog.
Please refer to this chapter to learn more about morphing and live warping .

CONVERT OBJECT SEQ TO MORPH TARGET
Some programs can export a movement from objects as an object sequence - a folder consisting of
several *.3ds, .obj or .x files. To convert all of them in one step to be used as a morph target, choose
this option.
An opening dialog opens where you can navigate to the folder and multi-select all object files that should
be converted. If needed, set a resizing factor. A progress bar is shown in the right upper corner of the
menu. Each object is converted to a *.png file, the new name consists of a consecutive number followed
by the original name. The image files are automatically saved in the same folder.

As a next step you might copy those images into a new folder that can be used as an image sequence
in Pandoras Box, for example on the Aeon Effect "Warp Target " in the folder "Warp" or "Morph A-B-C

" in the folder "Geometry". In order to save performance, you may convert the *.png files as well into
an *.avi video file, e.g. using the coolux tool Image Converter  or to a lossless video format from the
coolux codec .

BATCH CONVERT OBJECT TO .X FILE
Some programs can export a movement from objects as an object sequence - a folder consisting of
several *.3ds, .obj or .x files. This command allows to convert all of them to *.x files in one step.
An opening dialog opens where you can navigate to the folder and multi-select all object files that should
be converted. If needed, set a resizing factor. A progress bar is shown in the right upper corner of the
menu. Each object is converted to an *.x file, the original name is not changed. The files are
automatically saved in the same folder and can now be imported in Pandoras Box.

MERGE (WARP .X FILES)
This option enables you to merge several warping files (*.x files) into one file.

In the dialog, browse to the folder and select all files you want to merge. A new dialog opens asking you
under what name and whereto the merged file should be saved. The merged object may now be imported
in Pandoras Box or the Warper itself.
This option might be useful when you already exported separate meshes instead of using the "Export all"
option.
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Output

PRIMARY / SECONDARY OUTPUT
By default the warping grid opens on your primary output.

When you have two outputs and the graphic card is in "Extended Mode" mode / "Dual View", please use
this option to position the Warper's mesh on the left or right output. This is contrary to the below
described graphic card setting "Horizontal Stretch".

You may open the Warper application twice whilst the first is positioned on the primary output and the
second on the secondary output. This has the advantage of working on both outputs simultaneously.

MOVE TO LEFT / RIGHT OUTPUT
Choose these options if you are working with a stretched desktop consisting of more than one "display
area" in order to move the warping area one step further.

STRETCH LEFT / RIGHT
When you have two outputs and the graphic card is in "Horizontal Stretch" mode (recommended display
mode for soft edge projection), please use this option to position the Warper's mesh on the left or right
half. This is contrary to the above described graphic card setting "Extended Mode" mode / "Dual View".

Triple Output and Quad Output

This command is useful when having three or four outputs, for example whilst working with a QUAD
SERVER and using the DVI Processor that splits the desktop into numerous outputs. Open the Warper
application and send it to Quad Output 1, then open the Warper 3 more times and send each to another
quarter of your screen. Now you may work on all meshes simultaneously.

Alternatively you may open the Warper only once and work on several meshes using the New...
command  as described above.

Minimize
Minimizes the Warper window. As the Toolbox always stays in the foreground you have to close it as
well or just press [H] to hide it.

Exit
Quits the application. A dialog box will appear and ask you if you want to save the project before closing.
Choose [Yes] to save it, [No] for exiting without saving or [Cancel] to get back to the application.

11.2.1.2  Edit Menu
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Activate all Vertices

If you toggled some vertices/faces of the mesh with the shortcut [D] to be invisible, you can activate all
hidden vertices again using this menu entry.

Apply Map and Mapping

The following commands change the UV texture map for generated planes and objects. If you are not
familiar with UV mapping, the chapter "General 3D modeling terms " includes a short section covering
it and can get you started with that important 3D modelling technique. The Mesh tab  allows to offset
and zoom a previously applied UV map.

The depicted example shows one single mesh that
was bended by using the FFD. 

APPLY 1:1 MAP
In the Texture tab you may find the button "Load
Texture...".It applies a texture 1:1 like, that is, the
texture is scaled and deformed to fit exactly into
the corners of the mesh. The command "Apply 1:1
Map" always brings you back to that state. It
applies a texture to the currently selected mesh or
object.
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APPLY PLANAR MAP
This command applies the texture to the selected
mesh in a way that it is first scaled to the current
fullscreen resolution and then applied to the mesh
without being influenced by its scaling, position or
deformation. It stays planar.
One could imagine that the fullscreen texture is
projected and burned into the mesh. If you now
deform the mesh further, the deformation applies to
the texture as well. If this is not required you may
apply a planar map again.

PLANAR MAP TO BOUNDS
This command applies the texture to the selected
mesh in a way that it is first positioned and scaled
to the bounds of the mesh. The size of the mesh is
indicated in the left image by the white dashed line.
Then the texture is applied to the mesh without
being influenced by its deformation. It stays planar.
One could imagine that the resized texture is
projected and burned into the mesh. If you now
deform the mesh further, the deformation applies to
the texture as well. If this is not required you may
apply a planar map again.

MAPPING
If you are working with cylinder and sphere objects,
select the object and apply the according special
mapping techniques. The available ones include a
cylindrical and spherical mapping. For more
information please read the chapter "General 3D
modeling terms ". Please note that the mapping
technique expects the object to be positioned at
(X,Y,Z) = (0,0,0).

The command "Export UV Template" generates a
template that can be used for creating content that
should be mapped on the object. The feature
unfolds an object, the result is a 2D image that can
be colored in and later used as a texture on the
object. For modifying the UV template you may use
any graphics editing software of your choice as the
UV template is saved as a *.png file.

In the dialog click the [...] button to choose the
directory where the *.png image should be saved. 
The ideal width and height of the UV template
depend on the object. The higher the resolution the
more details can be shown but the more
performance is drawn.
"Draw Lines" will show the edges of the faces. In
the Warper you can not see faces, but the larger
polygons when activating the Wireframe mode in
the Texture tab .
"Draw Dots" referes to the vertices themself which
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are shown as red crosses when activating them in
the General tab .

If ticking the "Alpha" check box there will a
transparent background instead of a black
background. Vertices and edges are always white.

Apply Map to All

A UV map can cover several meshes and objects at the same time, that is, it applies to one mesh only
partly. This is for example of interest when...
1) you like to show one layer on two separated screens
2) you have a complex screen that could be divided into several regions in order to make the warping
process easier and faster. Imagine, that you want to project on a facade. Everything should be covered
by the same picture. The facade probably consists of areas that are differently complex. Maybe there are
quite plane areas and others, that need some more warping, e.g round pillars or stucco decoration. On
these areas you can place meshes with a finer mesh grid and more FFD points. On the easier parts you
can place more rough meshes. The alternative would be, that everything is covered by a mesh that has
everywhere the same fine grid resolution. This would mean that you spend a lot of time on the easier
parts too, as you have to work with unnecessary mesh points.

For both applications the following mapping commands can be helpful. For understanding the meaning
and potential of planar mapping it is recommended to build some examples and try it out practically.

As an example, let's take this setup. At the top,
there is one large mesh, a 2D plane, covering the
entire fullscreen width. In the middle, there is
another mesh, a square like 2D plane. As a third
object, a cube has been imported as an *.x-file and
is positioned in the bottom right corner. The camera
stays at the default position at (X,Y,Z) = (0,0,-25).

APPLY 1:1 MAP TO ALL
In the Texture tab you may find the button "Load
Texture...".It applies a texture 1:1 like, that is, the
texture is scaled and deformed to fit exactly onto
each mesh and object that exists in your project.
You do not need to select a mesh or object first.
The command "Apply 1:1 Map To All" always
brings you back to that state. As seen in the cube
object, the texture is applied in a planar way, the
front face shows the image, the side face stretches
the left pixel line. The same is happening on the
right,top and bottom side.
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APPLY PLANAR MAP TO ALL
This command applies the texture to all meshes
and objects in a way that it is first scaled to the
current fullscreen resolution and then applied to
them without being influenced by their scaling,
position or deformation. It stays planar.
One could imagine that the fullscreen texture is
projected and burned into the meshes. If you now
deform the meshes further, the deformation applies
to the part of the texture as well. If this is not
required you may apply a planar map again.

APPLY PLANAR MAP TO BOUNDS TO ALL
This command applies the texture to all meshes
and objects in a way that it is first positioned and
scaled to the bounds of the meshes. This can be
best seen in the above described section "Planar
Map To Bounds" where the size is indicated by a
white dashed line.

Then the texture is applied to the meshes without
being influenced by their deformation. It stays
planar.
One could imagine that the resized texture is
projected and burned into the meshes. If you now
deform the meshes further, the deformation applies
to the part of the texture as well. If this is not
required you may apply a planar map again.

Planar Mapping Mode

An activated Planar Mapping Mode applies the chosen texture constantly onto all meshes and objects in
the project. The texture is not influenced by their scaling, position or deformation, it stays planar until the
mode is deactivated again.
This is useful for positioning and scaling meshes before the Warping process as described above .

Marker

Please find a general description of markers in the topic describing the Marker tab .

SHOW CALIBRATION OVERLAY
An activated Calibration Overlay is the default state. If you deactivate this option, the object will always
be rendered in the Wireframe mode (i.e. the texture will be hidden) as soon as you enter the Calibration
mode when working with Markers. This is useful when you want to position a marker without being
distracted by the texture.

CALIBRATION SETTINGS
A new dialog opens where you can influence the calculation that is called to estimate the camera
position after setting up markers . The calculation is based on an algorithm that runs a defined
number of times until it finds a position for which the two instances of all markers match each other,
allowing a certain accuracy. If the result does not meet your expectations you can set up, that the
algorithm should run more often, e.g. to reach the expected accuracy. Whether a more accurate (less
than 0.00010) calculation or a more tolerant one gives better results, depends on your setup.

CREATE TEST MARKER
This command creates four markers that can be used to estimate a camera position automatically as
described in the Marker tab .
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DELETE ALL MARKERS
Choose this command if you like to delete all markers .

RESET ALL 2D POINTS
After adding a marker to the project, a 3D point and a 2D point are generated. You may relocate the
second instance, the 2D point, onto the real object (in the projected image). Choose "Reset All 2D
Points" to discard this reposition and bring back the second instance. According to the current view, the
3D point and the 2D point share the same position again.

ADD TO SELECTED VERTEX
First, select a vertex from your 3D object, then choose this command in order to attach a marker to it.
Instead of this workflow you may as well add a marker using the Marker tab .

Clone Object

The command "Clone Object" allows to make a copy from the currently selected 3D object or 2D plane.
If you are in the FFD mode, please make sure that all FFDs are selected. If you are in the Object mode,
just select the object or plane that should be copied. Now, go into the Move mode and drag the object
whilst holding down the right mouse key.

Options

In the Options menu you may find settings of interest when working with a camera tracking. A problem
that you might encounter is, that the image seen by the camera is distorted due to a non-orthogonal
camera position or due to lens deformation, the so called cushion effect. Same as with projectors, the
(input) image needs to be keystoned or even warped. This is especially needed if the projector(s) is (are)
not positioned on the same axis and output the image in a different angle.
The goal is, that the input coordinate of a tracked point can be translated into an output coordinate. 

First, open the Warper on the computer where your Camera is attached to. On the default mesh, apply
the video input image as a texture. You may do this is in the Texture tab . Now, open the Options
menu and choose in the command "Show Camera Region" your camera resolution. Relative to your local
screen resolution, a blue rectangle marks the camera size. Depending on the camera position and how it
records the scene you need to deform the mesh in order to have a straightened tracked region as if the
camera would look straight onto it without lens deformation, see the example depicted left. As a last
step in the Warper, choose "Export Camera Lookup" and the directory whereto the *.dat file should be
saved.
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The camera records 640x480 px but the position is
not orthogonal to the region that should be tracked.
The corner points have coordinates that depend on
the camera position. If a projector is not positioned
where the camera is, it is very complicated to
project a layer at the exact position from a tracked
point. The input image needs to be keystoned and
transformed.

The screen resolution in this example is 1920x1080
px. The camera region (the blue rectangle) is set up
to match the input resolution of 640x480 px. The
mesh's texture shows the Live Input. Then the FFD
is used to deform it in a way that the tracked region
fits the camera region. This is the same result as if
the camera would have been installed at an ideal
position.
With the lookup table, the tracked input coordinates
can be translated into valuable output coordinates
(for a layer).

Now, the lookup table can be used in the Widget Designer  for example. In the Camera Point Tracker
tool  you may find the check box "Use Lookup". Click the [...] button to choose the directory from the
saved *.dat file. Press the "Apply" button.
If a person now walks along the top edge for example, the tracked camera point will report a movement
in one axis only, e.g. from (X,Y) = (0,0) to (640,0). Without the lookup table the same movement would
have resulted in an X position change and Y position change, e.g. (200,20) to (530,60). It would have
been impossible to prepare a Widget Designer project without knowing the exact camera position and
how the input image looks like. With the lookup table you may straighten the image according to the
camera position and use prepared Region nodes  or Custom Script Buttons  that are positioned in
certain areas on your page. For example you can take a draft image from the scene and use it as a 
background image  for your Widget Designer page. With the lookup table you can as well use the
Camera Input node  and route the X,Y Pos directly into a Range node  and PB Device Output node

 without further calculation.

Advanced Mode

The Warper application starts per default in a basic mode, that is, certain menus, commands and tabs
are hidden. Activate the advanced mode if you like to have access to all functions of the Warper.

Network Settings

If you’re running the Warper on the same computer as your PB
Master software (Manager, Player or Server), the exported
mesh or mask can directly be added into your current PB
Project. To use this function, please make sure that the IP
address and Domain of your local computer match the PB
Masters settings.

The next time you export a mesh or mask, it will be added to
your Pandoras Box project automatically.

894

1275

1152 935

916

1074 1166

1204



831

11.2.1.3  Mesh Selection

The Warper allows to deal with several mesh objects or 2D / 3D objects within one warping project.
Choosing one of the existing objects from the drop-down list will select the object in the main window.
Alternatively you may go into the "Object mode"  (e.g. via the shortcut "O") and click on the object to
select it.
The settings in the tab "Mesh" are stored per each individual mesh and apply as soon as another mesh
is selected.

[Add]
If you want to add one more mesh object, press [Add]. A pop-up dialog allows to define the amount of
FFD control points and the size for the new mesh. For more information, go to the chapter "File Menu
".
The new mesh will be added to the main window.

[Del]
In order to delete one of the existing objects, please select it first and then press [Del]. A pop-up dialog
needs a further confirmation for this action, as it can not be undone.

11.2.1.4  [?]-Button

Here you find a listing of all keyboard shortcuts available in the application. Alternatively, you may open
this window using [F1].

The "Output Resolution Info" informs you about the current resolution, reported from the graphic card.
Before you start warping please make sure that the resolution is the correct one as all meshes and
settings relate to the absolute resolution!

Lastly, the current revision is depicted.

11.2.1.5  Camera Selection

The Warper allows to deal with multiple cameras within one warping project. This is needed when using
the Warper for a 3D application, meaning to import a 3D object from the screen you are projecting on
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and to transfer the position from the real projector(s) to the virtual camera(s) rather than doing a 2D
warping .

Choosing one of the existing cameras from the drop-down list will activate it and change the current view
according to the stored settings from the chosen camera.
The settings in the tabs "PB Camera " and "Camera / View " are stored individually per camera.

[Add]
Per default a camera with the name "Global Camera" exists. If you want to add one more camera, press
[Add].
Any changes done in the tabs "PB Camera " and "Camera / View " are automatically assigned and
stored to the selected camera.

As you can create as many cameras as you like, you can create the ones that you need for a 3D set up
in Pandoras Box and in addition some cameras that can be used to get an overview from your 3D scene.
For example, next to the "Global Cam" you may create a "Front View", a "Side View" and a "Top View".
The front view is applied with a camera position (X,Y,Z) = (0,0,-25), the side view could be (25,0,0) and
the top view (0,25,0).

[Del]
In order to delete one of the existing cameras, please select it first and then press [Del]. A pop-up dialog
needs a further confirmation for this action, as it can not be undone.
Please note that the "Global Camera" can not be deleted.

11.2.2  Tools Bar

Undo / Redo

 Use this button to undo the last change done in the mesh, FFD or 3D object. 
Please note: Undo only refers to moving tools. Changes done in the tabs themselves can’t be undone.
To enable the Undo/Redo function for the ScreenMask, please go to the tab and tick the check box

 Use this button to redo the last undone change.

Move-Modi

There are 3 possibilities to transform the selected mesh / FFD point(s) or entire object: you can either...

 move

 rotate or

 scale the selection.

The fourth tool works for mesh points only! If you like to drag the entire texture, please use the tool "Drag
Texture" as described below or the settings in the Mesh tab . The UV icon can only be seen in the
advanced mode. To activate it, open the "Edit" menu and choose "Advanced Mode".

 drags the UV map  within selected mesh points.
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Before moving points, decide whether you like to work with mesh points, FFD points or an object by
switching to the according Edit mode . Then select some points:
- mouse: click on a single point to select it, hold down the [CTRL] key additionally to multi-select points
or drag a selection box
- keyboard: click the Up/Down/Left/Right key to select a single point and hold down the [CTRL] key
additionally to multi-select points

Now, there are 3 different ways of applying a transformation change:
- keyboard: you can move the selection by holding down the Shift key and press the Up/Down/Left/Right
key

- dialog: make a right-click on the move/rotate/scale icon to open the "Relative ... Dialog". There you can
enter a specific numeric value and apply the change. Please note, that this works in a relative way, not
absolutely! You can either undo the changes done in the dialog by hitting the Undo icon or by applying
the inverse value, e.g after scaling by 50%, you may scale by 200%.

- mouse: you can move, rotate or scale the selection by holding the right mouse button pressed and
moving the mouse up, down, left and right. You can switch from one transformation mode to another by
clicking the respective button or by using the keyboard shortcuts. Press the following numeric
characters on your main keyboard: [1] for moving, [2] for rotating and [3] for scaling. (When the Toolbox
is active/selected, these shortcuts will not work. In that case, click into the Warper's main interface to
unselect the Toolbox). If you like to transform along a certain axis, you may lock it with the according
buttons X, Y, Z.

  
See here examples for a) Move Mode, b) Rotate Mode and c) Scale Mode.

Texture-Tools

 Drags the UV map  from the entire object. Please activate the Textured mode  and then use
this function to drag the visible texture on the mesh. In the Mesh tab  you may adjust the UV map
more precisely.

 Zooms the UV map  from the entire object. Use this function to zoom the visible texture on the
mesh. Moving mouse up zooms in, moving mouse down zooms out. Again, the Mesh tab  provides a
more precise adjustment.

Masking-Tools

Please change to the Mask tab  before using the following tools. This will show you a white texture
instead of the texture chosen before.
The chapter covering the ScreenMask explains as well how to work with the mask in more detail.

   Draws on the mask on your warping object which later will hide parts of the real texture.

 Unfold the drop-down list to see all available brush types for the painting tool.

 Fills the whole texture black, which means that the mask covers everything from the texture and
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nothing is visible. Alternatively you may use the button [Black Mask] in the ScreenMask tab .

 Erases the black parts and thus makes the texture visible again.

Clear

 After you have selected mesh or FFD control points, you can press this button to unselect the
points again, that is to clear the selection.

Reset

 Resets the position of selected mesh points. They will loose their offset (set up in the mesh mode)
and go back to their origin position related to the FFD. 
Please note: Changes applied to the FFD control points and the screen mask will not be reset!

Edit-Modi

Use these buttons (or the according shortcuts) to change between editing the object, the FFD or the
Mesh. (When the Toolbox is active/selected, these shortcuts will not work. In that case, click into the
Warper's main interface to unselect the Toolbox)

 Objects can be selected and edited. (Keyboard Shortcut [O])

 FFD control points can be selected and edited (Keyboard Shortcut [F])

 Mesh control points can be selected and edited (Keyboard Shortcut [E])

Axis-Locks

 Use these three buttons to lock or unlock the according axis. With a locked axis
(highlighted button) any transformation like movement, scaling or rotation can solely be performed on this
axis. The drawing tools are effected as well.
As an example, let's say you are in the standard camera view, have selected some FFD control points
and move them with mouse. Moving the mouse horizontally makes the FFD points move along the X-axis
whilst moving the mouse vertically makes them move along the Y-axis. With a locked X axis, the points
can not move along the Y-axis howsoever the mouse is moved.

11.2.3  Tabs

The Menu Bar is divided into the following tabs: General , Mesh , Texture , Mask , Keyboard/
Mouse , PB Camera , Camera/View , Marker , Live Warp
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11.2.3.1  General

The "General" tab includes options that influence the appearance of the Warper interface. You may
activate, deactivate or color certain visual objects. Some options are hidden in the basic mode and are
only shown in the advanced mode. To activate it, open the "Edit" menu and choose "Advanced Mode".

Show IP and Screen ID

The "Show IP" check box displays the computer's IP address at the bottom left corner of the screen.
This is helpful when working with several instances of the Warper.
The "Screen ID" check box displays the Screen ID in the center of the screen. Choose an ID number
from the list on the right.

Soft Selection

Selects also neighboring mesh points within a particular radius. In the example depicted below, only one
mesh point is originally selected (a), the surrounding once are soft selected automatically (b).
When the selection is moved (i.e. dragged using the mouse), the middle point is affected with the
biggest possible offset. The further a point is away from the center, the smaller its offset gets (c and d).
This is useful when you like to correct areas within your mesh without the result of having clear edges
because the mesh points were not moved equably.
Set the radius with the numeric box. The default value for the radius is 1 generic unit . As a soft
selection is affected differently than a normal multi-selection (where all points would move with the same
offset), a soft selection is represented with another color. Per default it is yellow. If you like to change it,
click in the color field and choose your color in the newly opened color dialog.

a  b  c  d 

Show Crosshair

If this option is active, the position of the mouse cursor is clarified by showing a screen spanned
horizontal and vertical line. You may set up how many pixels thick these two lines are and what color
they have.

Backface Selection

When working with a three-dimensional object there might be vertices  that can not be seen from the
current view point as another part of the object lies in front of them. The default setting - an inactive
backface selection - lets you only select those vertices that are visible in the current view. An activated
backface selection will select all vertices within your selection rectangle (drawn with the mouse). This
option might need more time depending on the number of vertices and the size of the rectangle.
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Specular, Grid, Vertex and Background color

Click into the specular color field to assign another color for the global light source. The specular light
reflection enhances the three-dimensional look when the textured mode  is active.

 With these color fields you may change the color of the mesh lines. It is
useful to work with different grid colors if you have an overlap between two warping grids. Once the lines
match exactly, the color of the doubled grid lines change. This lets you work more precisely. Click into
the leftmost color field to open a dialog that lets you pick a color of your choice. The five color field to the
right apply the depicted color directly.

Click into the vertex color field to choose a different color for vertices / mesh points that are selected.
Selected mesh points are indicated with a small rectangle.

Click into the BG color field to choose a different color for the background of the Warper interface.
Activate the option "Show Background" and click the [...] button to display an image instead of a solid
color.

Check boxes

Check / uncheck the boxes to show / hide different visual auxiliaries.
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11.2.3.2  Mesh

The "Mesh" tab allows to setup more mesh segments and to influence the UV texture map applied
automatically to it. Please note that changes can only be applied to original meshes, not to imported
objects.

Mesh Segments

Enter the amount of horizontal and vertical segments you want to use in your mesh. For more details,
there is a tutorial  at the end of the Warper chapter.

Important:
Adjust the amount of mesh segments BEFORE you modify the mesh, because this will reset any
changes you did to the mesh before! There is no CTRL-Z function. Nevertheless you may modify the
mesh count as long as you are working with the FFD only.

UV Texture Mapping: Zoom, Offset and Aspect ratio

These settings influence the UV texture map  and can also be adjusted using the Texture tools
from the tools bar. Please activate the Textured Mode  first to see the changes done here.

ZOOM and ASPECT

Use the zoom option (or the Texture Tool  from the Tools Bar ) to zoom into the selected texture.
The zoom values range from 1 to 99. The texture is enlarged while retaining the aspect ratio given by the
mesh size.
A change in the aspect ratio, influences the texture's height only. The aspect values range from 0 to
99999999. 

Press  to reset the value for the zoom and the aspect ratio to the default value 1.

X and Y OFFSET

The X- and Y-Offset (or the Texture Tool  from the Tools Bar ) enable you to move the displayed
texture in both X and Y position. The possible values range from -1 to 1, whereas 0.5 would mean for
example that the texture is moved half the way to the right and upwards.

Press  to reset the X- and Y-Offset to the default value 0. Please note that the Z-Position will be set to
default as well!

Z Position

The Z position does not influence the UV map but the position from the mesh / object. According to the 
coordinate system , positive Z values move the object backwards whilst negative values move it
forwards. To change the Z position is especially important when objects overlap each other.

As seen in the example below, overlapping meshes with same Z-Order values will result in Z position
fighting when the objects (exported as one object) are used in Pandoras Box. As this issue also
depends on the camera position, it can happen that you see a Z fighting problem only under certain
circumstances and maybe not in the Warper itself but with in the exported file in another program.
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To export positions that can be clearly assigned, you have to define an unambiguous Z-Order (for the
overlapping meshes).

A new warping project with two meshes is created. The meshes
overlap each other partially. The Textured Mode  is active and
Mesh 1 is selected.

Now Mesh 2 is selected, and therefore overlaps Mesh 1.

As long as the Z-Order for none of the meshes is modified, the
selected mesh will always be displayed in front of the not-selected
one

The two meshes are exported using the command "Export All" and
assigned to a layer in Pandoras Box. Both meshes share the same
Z position, withing the overlapping area Pandoras Box can not
clearly decide which polygons from which mesh are in front of other
ones. The result is that both meshes intersect.

To create a clear assignment, Mesh 2 is brought to the front of
Mesh 1 by changing its Z position to a lower value,

Now, it is irrelevant which mesh is selected in the Warper. Always,
Mesh 2 covers Mesh 1.Also, the export in Pandoras Box shows no
Z fighting any more.

11.2.3.3  Texture

The "Texture" tab includes options that influence how meshes and objects appear in the Warper in terms
of whether they are rendered with a texture or just in a wireframe mode. Some options are hidden in the
basic mode and are only shown in the advanced mode. To activate it, open the "Edit" menu and choose
"Advanced Mode".
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Wireframe versus Textured Mode

Click the "Wireframe" button to render meshes and 3D objects
in a wireframe / grid mode only. Only the object that is
currently selected is visible. Make sure that the check boxes
"Mesh" and "FFD" are activated in the General tab .

Click the "Texture" button to change to the additional Textured
Mode. All objects are then rendered with a texture applied to
them. The object that is currently selected is rendered with the
wireframe on top.

In the Textured Mode you will see the same texture on all
objects. You may choose between the default texture, a coolux
testpattern, a picture of your choice or a live input:
- Click the "Default Texture" button to return to the default view
- Click the "Load Texture" button to browse to a picture of your
choice
- Click the "Video Input" button and choose an available input
from the drop-down list. If needed you may flip the input
horizontally or vertically

All textures can be rendered with a full opacity (value 255) or a
lower one.

The Shortcut [G] toggles between the Wireframe/Grid and the
Textured View.

Toggle Face Visibility

This is another function that should be mentioned in this Texture Section.
With the keyboard shortcut [D] you are able to toggle the visibility of selected faces. This could be handy
if there are parts in the projection where you do not want to have anything textured, e.g. when there is
the need to cut out doors on a stage design. 

As you just toggle hard edged faces, this is more a rough masking function. To create a finer mask for
your screen, please refer to Mask tab .

Please have a texture loaded to your mesh. To turn a face (the area surrounded by four mesh lines) to be
invisible, select the mesh point that is down left of the face and press [D]. Turn several faces to be
invisible when selecting more mesh points.

One mesh point is selected (red arrow is pointing at it).
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After pressing the shortcut [D] the face top right of the selected
mesh point turns invisible.

To reload the texture later on, select the same points and press [D] again.
To reload all hidden faces without selecting the according mesh points, use ‘Activate all Vertices’ from
the Edit Menu .

11.2.3.4  Mask

The ScreenMasking Tool allows you to mask while painting onto the projected surface from within the
Warper. After finishing the mask, export it as *.png file and use it on a high layer in Pandoras Box. This
way the mask will perfectly match your warped surface. It is as well possible to open the *.png file with
other graphical programs.

When changing to the ScreenMask tab, the grid
disappears and you see a white plane instead.
Everything what is white will turn transparent in the
exported *.png file, i.e. it will not be visible and thus
not hide underlying layers. 

Now, select the Paint Mask Tool  from the
Tools Bar  and draw onto the background by
holding the left mouse button clicked. Everything
what is painted will be black, also in the exported
*.png file. Thus it will cover underlying pixels when
being exported to Pandoras Box.

The axis locks  can be useful when wanting to
draw a straight line.

If you want to remove parts of your paintings again,

select the Erase Tool  from the Tools Bar and
move your mouse with the left mouse button
clicked.

Please note that due to the fact that each object within the project is applied with the same texture, all
objects will as well show the same mask. If you would like to create individual masks for each mesh or
3D object, please save the project after finishing the first mask and apply a new mask to all objects to
start with the second mask.
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Per default the undo function  does not cover the changes done in the mask as this consumes much
memory space. However, if you like to use the undo option, tick the check box "Enable Undo/Redo for
Mask".

Brush type and size

Choose a brush from the drop-down list in the Tools Bar.

Define the Brush Size by moving the slider left and right in the Mask
tab.

Mask Buttons

Click the "White Mask" button to get a plain white mask (all parts are transparent). Paint the parts that

should be masked with the Painting Tool .
Click the "Black Mask" button to get a plain black mask (all parts will be masked). Erase the parts that

should NOT be masked with the Erase Tool .
Click the "Texture Mask" button to use the normal texture as a mask background. You can set the
texture in the Texture tab . According to the brightness of the texture's pixels, the exported mask will
be transparent, partly transparent or nontransparent.
Click the "Invert Mask" button to invert the mask. An example could be the right image (b) as an inverted
mask from the left one (a).

 a) Black parts painted on white background  b) White parts erased from a black background

Using the mask in Pandoras Box

First of all the mask needs to be exported. Click on File > Save mask, browse to the location where you
want to store your mask-file and name it. A *.png file will be created.
Use the mask on a layer in Pandoras Box that lies in front of other layers. It is a good practice to use
the very last layer (before the Camera layers) and to rename this layer.
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a) The mask from the example above is used in
Pandoras Box on top of the content layer.

b) The inverted mask from the example above is
used in Pandoras Box on top of the content layer.

The great benefit of this masking tool is the live painting on the projected surface, because this mask will
exactly fit to your warping file.

11.2.3.5  Keyboard / Mouse

Keyboard

Use the keyboard control settings to adjust the keyboard behavior for editing the mesh.

PRECISION
The precision value ranges from 0,01 to 99, whereas the default value is 1 which means that one
keystroke results in a movement of 1 pixel. When doing a rough Grid / FFD adjustment start with less
precision (> 1) to save time. Later on the fine adjustment can be done with a higher precision (< 1) if
needed.

INVERT X AND Y
When warping a rear projection and / or the picture is upside down, inverting X and / or Y movement can
help you adjusting the mesh with the keyboard.

Mouse

Use the mouse control settings to adjust the mouse behaviour for positioning the camera.

Tick the check box "Mouse Fine Mode" if you like to shift the camera position with more precision. You
will see the result in the Camera / View tab .843
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11.2.3.6  PB Camera

The tab is hidden in the basic mode. To activate the advanced mode, open the "Edit" menu and choose
"Advanced Mode". This is only available in the Warper 3D edition.

The "PB Camera" tab enables you to transfer values from a camera set up in the Warper to a camera
, output  or light layer  in Pandoras Box. 

First of all, choose the camera from the Warper from which you would like to transfer data. Once you
have picked a camera via the drop-down list  at the top right of the Toolbox, make sure that the
settings in the tab "Camera / View"  are correct. Now set up the connection to a Pandoras Box
Master system (PB) via Edit > Network Settings .

Click the "Enable" check box to send values permanently from the Camera / View tab  to the Output
or Camera layer in PB. The site and layer ID can be set up with the numeric boxes. The interval can be
adjusted with the numeric box at the bottom.

If you do not want to update the layer permanently you may click the button "Update Camera" instead.
This will transfer the current values only once. As an alternative, you may press Ctrl+U.
If you like to transfer the values to a light layer, click the button "Update Light".

11.2.3.7  Camera / View

The "Camera / View" tab is hidden in the basic mode. To activate the advanced mode, open the "Edit"
menu and choose "Advanced Mode". This is only available in the Warper 3D edition.

The tab enables you to adjust the position, orientation and lens settings of a camera in the Warper. This
is needed when you do 3D Warping as described in the introductory chapter . A camera can be added
and selected in the camera selection field  at the top right of the Toolbox. Choosing a different camera
will change the currently seen settings in this tab.
Please read the last chapter to learn how to transfer these settings to a camera in a Pandoras Box
Master system. The next chapter covers a marker based camera calibration .

Meaning of parameters and how to measure them for 3D Warping

Position
Look At
Roll

The six parameters for the X, Y, Z Position from the camera and its "Look At" target plus
the roll parameter define where the camera is positioned, where it is looking and how it is
orientated.
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As said in the introductory chapter where 3D Warping is compared with 2D Warping, you
need to adjust the camera's and the object's position and orientation as well as the lens
setting. Regarding the position and orientation, there are two possible ways to do so:
manual measurement or marker-based calibration .
To measure distances and sizes manually, you should first define where the zero point of
the coordinate system is; to simplify the process you can define that it lies on a certain
corner of the object or projector. Based on that zero point, you need the relative X,Y and Z
distances to the screen (exactly where the object's pivot point  lies) and projector lens
(center of the lens). Then you need the size of the real object to convert the measured
"number" into the unit that has been used for the size of the virtual object. If the virtual size
is 2 GU, and the real size is 200cm, the conversion factor is 1 GU / 100 cm. Thus, you
know, that a distance of 150cm is 1.5 GU (distance * conversion factor).
Now you can calculate the XYZ position of the camera and the object (corresponding with
the Look At Target) as well as their orientation. The orientation from the object results from
its XYZ angle. The orientation of the camera is the result of the difference between the
position and the Look At target plus the Roll parameter

FOV
Lens

The parameters FOV and Lens express the same setting: the opening angle. When you
enter the FOV, the Lens parameter is automatically calculated and vice versa.

There are two ways to find out the opening angle: manual measurement or iteration.
For manual measurement you need the width of the projected image plus the distance
between the center points of the lens and the image (at the depth where the width was
measured). These two numbers can be entered in the FOV calculator available with the
Calc button. The measuring unit does not matter as long as it applies to both values. Click
"Apply" to transfer the calculated value to the main tab.

Alternatively you can simply try out and approximate what the lens factor is. If you have a
lens with a fixed zoom, use this lens factor and try out whether a slightly higher or lower
number gives better results. (Even fixed zoom lenses, can slightly change due to
mechanical vibrations.) If the lens has a variable zoom, start with the smallest lens factor
and increase it slowly. It is clearly visible in the projected image whether you are
approaching the correct factor or not.

Aspect
The Aspect parameter expresses whether the cameras aspect mode is the same one as
the output's aspect mode.

Near Plane
Far Plane

Near and Far plane define what part of the cameras cone is rendered. If an object lies
outside of the range, it is not seen and rendered by the camera. In 99.9% of all cases the
default values give good results and should be not be changed.

Lens Shift

The Lens Shift parameters define how much
a projector is lens shifted. For 3D Warping

 (either measuring or marker-based) it is
strongly recommended to reset the
projector(s) lens shift to 0,0. However, some
projectors have a build in lens shift that
cannot be adjusted. You can see that easily
by looking onto the lens if the projected
image is in the center of the lens. If it is
outside of the center, there is an active lens
shift. Or, you can see it from the side: check
whether the lens' center matches the center
of the projected image. In the left image, one
can clearly see that the projected blue
outlines image is above the projector itself. If
the projector had no lens shift applied, the
image would look like the one with the
orange outline.
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In the case that the lens shift cannot be adjusted in the projector, use the lens shift
parameters in the Warper. In practice you can measure the lens' center to the floor and mark
it on your screen depending on the projectors angle, or you can use a laser. At the end you
should be able to know where the unshifted image center should be.

Then adjust the lens shift so that the center of a default mesh is at the same height and
width as the marked lens center. That could mean of course that parts of the mesh are
outside of the projected image. This will be corrected after adjusting the position and
orientation of the camera.

The Reset button resets all parameters. Please note, that there is no undo function!

Moving a camera using the mouse

- Zoom: Scrolling with the mouse wheel influences the camera's Z position
- Rotation: Moving the mouse whilst holding the Alt key and the middle mouse button influences the
camera's X and Y position. As all other parameters are not influenced this has an effect as if the camera
rotates around a fixed point.
- Pan: Moving the mouse whilst holding the middle mouse button influences the camera's X and Y
position and the "Look At" position at the same time.

For a finer adjustment, activate the option "Mouse Fine Mode" in the Keyboard / Mouse tab .

Adjusting a camera using the numeric boxes

At the same time you may set up these and other settings, e.g. lens settings, with the numeric boxes in
the tab. You may enter a number directly or increase / decrease it. For this you can either use the up /
down buttons next to each field, or click once into the numeric box and scroll using the mouse. The in-,
decreasing adjustment can be made more or less precise with the radio buttons: Coarse Mode, Fine
Mode and Finest Mode.

11.2.3.8  Marker

The "Marker" tab is hidden in the basic mode. To activate the advanced mode, open the "Edit" menu and
choose "Advanced Mode". This is only available in the Warper 3D edition.

The tab enables you to add and position so called markers. As well view settings concerning the marker
representation can be found here. There are more commands under Edit > Marker .

Please read the previous chapters to learn what the Warper camera's parameters  are and how to
transfer them to a camera in Pandoras Box .

General meaning of markers

Markers enable an automatic calibration of a camera's position and orientation (but not its lens
settings!). A minimum of 4 markers is needed to adjust a camera in a 3D environment. The marker-
based calibration is an alternative to manual measurement (of the projector's and screen's XYZ position)

842

828

843

843



846

and data transfer to the parameters in the Camera tab. Both ways are attempts for a virtual 3D
representation of the real 3D setup. Please keep in mind that this is not always necessary. Especially
when working with only one camera or without 3D objects you can realize warping as well by
straightening the projected image with a 2D mesh. This workflow is described in more detail in the 
introductory chapter .

The calibration is based on the position of the markers. When creating
one marker, a 3D point plus a 2D point are added to the project. At first,
the two points share the same position but when you change the view
by modifying the position/orientation of the camera you will see that
there is a difference. The 3D point - per default a yellow circle with an ID
- is "glued" to the object, thus it changes the position on the screen.

The 2D point - a smaller blue circle with a white cross inside - has no reference to the object but stays
on the same position of the screen as if painted on it. This explains the name "2D" it has no Z Position.
In short: Whilst the 3D point has its place on the virtual object, the 2D point needs to be placed on the
same spot but looking at the projected image, i.e. the real model. After positioning the markers (placing
the 3D and 2D points) the calibration finds the best camera position where both points share the same
position again.

How to warp with markers

Before you start warping, you might want to setup an additional screen to have an better view of the
Warper interface (as the projected interface is obviously distorted). You could either connect a second
display and set the display driver to clone/duplicate the screen. Or you could connect another computer
via VNC to the computer that is connected to the projector and that runs the Warper.

Import the 3D model from the screen / object you are projecting on. It must match the real screen /
object as accurately as possible. However, if changes were applied to the real object after the virtual
model has been created or if it simply does not fit, you can adjust the model by moving its vertices . If
you are projecting on a two-dimensional screen you can create the object in form of a mesh in the
Warper directly. Choose File > New and set a size according to the real screen's dimensions.

Open the "Edit" menu and activate the "Advanced Mode". Adjust the object size if needed (as described
in the Tools Bar ) and the view in the Warper (as described in the previous chapter ) so that the
interface looks very roughly like your view onto the object.

Now you can start adding markers. A minimum of 4 non-planar markers is needed when working with a
3D object. "Non-planar" means that one point must not lie on the plane that is defined through the other
3 points. When working with a 2D object, on the other hand, a minimum a 4 co-planar markers is
needed. "Co-planar" means that all 4 points must share the same plane. In general the best results are
achieved when placing the markers "far away" from each other.

1. step: adding markers

According to your view onto the object, decide where you want to place
the 4 markers. You can do this in two ways.
a) Click on the "Add" button. The mouse cursor becomes a thick plus
(+) icon when the mouse is within an object. Click onto a vertex to add
the marker there. If you have many vertices and the marker did not snap
to the right one, you can select the right vertex and click the button
"Snap Sel Vertex"
b) Select a vertex by clicking on it directly or by selecting it through a
selection rectangle. Now, choose "Edit > Marker > Add to selected
vertex" to add the marker there.

You may modify the view, rotate or zoom, at any time. This is useful
when working with an object with many vertices, as it can be tricky to
pick a certain one. If you are done with the fourth marker, adjust the
view so that you can see all markers again; if you like to relocate all 2D
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Points to the position of the 3D points, choose "Edit > Markers > Reset
all 2D Points"

Now we have placed the markers, or rather the yellow 3D points of
them. The next step is to position the blue 2D points.

2. step: dragging the 2D points

In order to get access to the 2D points, tick the check box "Calibration
Mode". The view varies: the grid and 3D points are dimmed and the
mouse cursor changes to a cube-like cursor as highlighted in the left
image. If the texture distracts you, you can dim it with the number field
to the right or toggle it off with "Edit > Marker > Show Calibration
Overlay".

Underneath the check box there are two radio buttons "2D" and "3D".
- Pick "2D" if working with a two-dimensional object and having placed
the four markers in a co-planar way.
- Pick "3D" if working with a three-dimensional object and having placed
the four markers in a non-planar way, as seen in the example.

Again there are two ways how you can influence the position of the 2D
points. Please note that the camera view should not be altered from
now on.
a) Use the mouse, especially for the first rough setup. Click with the
cube-cursor onto the first marker (i.e. the yellow 3D point) to select it.
The blue 2D point jumps onto the cursor and can now be dragged. Move
the mouse until you see on your real screen that the 2D point is at the
same spot as the 3D point is on the virtual model.

b) Use the number fields "Screen X" and "Screen Y", especially for fine-
tuning. You may select another marker by changing the drop-down list

If you have difficulties locating the cursor (and the attached 2D point) it
could be helpful to activate the "Show Crosshair" option in the General
tab . At the end all four 2D points are moved to the according spot
from the real screen object. In other words, the 2D points have formed a
specification for the camera position that needs to be found in the next
step. 

3. step: the Warper calculates a
new camera position

According to the new position of the 2D points the camera can now be
calculated. Click the button "Update Cal".
Now an algorithm runs over and over and returns the best possible
position for the camera. From this position the camera sees the object
just like the real projector "sees" the real screen. As a result the virtual
object with its "glued" yellow 3D points is depicted in the camera view
in such a way that the blue 2D points share the same position again.

If the result does not meet your expectations, please check the
following options.

- Are the lens settings set up in the correct way?
Please select the Camera/ View tab . If you have a projector with a fixed lens shift or if you cannot
shift it to 0,0 for any reasons, enter the lens shift (X and Y) in the according fields and run the calibration
again by clicking "Update Cal". The algorithm now considers this offset in the calibration.
Please check as well whether the FOV accords with the lens factor of the projector lens. How to
measure it is explained in the section "FOV / Lens". You do not necessarily need to click the "Update
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Cal" button. With an active Calibration Mode, you can tick the check box "FOV Re-Cal" and now, the
calculation is done each time when a new FOV is entered. This way you can find the correct settings in
just a couple of seconds.

- Is the 3D model correct?
Obviously the calculation depends on the accuracy of the 3D model. If changes need to done to the
model you can select a vertex and move it to the correct position. You may transform a selection of
multiple points as well.

- Are the 2D points positioned correctly?
Try to find a better position for the 2D points (using the mouse or the number fields as described above).
You do not necessarily need to click the "Update Cal" button each time. With an active Calibration
Mode, you can tick the check box "Live Re-Cal" and now, the calculation is done each time when a new
position is entered. This way you can find the correct position in a very short time. Due to the cushion
effect from the lens it's quite possible that the 2D points must be placed slightly outside the object.

- Have you tried adding more markers?
As said above the minimum marker number is 4. Adding more markers can give better results. When
working with a 3D model, place additional markers outside of planes defined by three other markers as
then a plane is overdetermined.

- Does the projector lens have a strong cushion effect?
If the projector distorts the lines due to a strong cushion effect you may apply a mesh to the output layer
that evens it out. A good way to generate the needed mesh is to first apply all settings to the PB camera
that were found with the current project. Then you may open a new project with a default mesh and use
the Live Warping  feature.

- Have you tried other options for the algorithm?
Under "Edit > Marker > Calibration Settings " there are options that adjust the algorithm.

Meaning of parameters, options and buttons

yellow color field
click into the field to open a dialog where you can pick another color for the
3D points and their ID

drop-down menu
allows to select another marker to adjust the according position of the 3D
(parameters X Y Z) and 2D point (parameters Screen X and Y) as well as the
3D point's color and size (parameter radius)

button Add
turns the mouse cursor to a thick plus (+) icon and generates a marker
when clicked

button Del
deletes the marker chosen in the drop-down menu; this command cannot be
undone!

check box Snap
when a marker is added to the object with an activated Snap function, it will
snap to the nearest vertex

button Delete All deletes all markers; this command cannot be undone!

button Snap Sel Vertex snaps the selected marker (via the drop-down menu) to the vertex that has
been selected

button Snap Next Vertex snaps the selected marker (via the drop-down menu) to the nearest vertex; if
a marker is already located on a vertex it will not change its position

number fields X, Y, Z position of the 3D point of a marker

number fields Screen X, 
Screen Y

position of the 2D point of a marker

number field Radius size of the 3D point (in generic units)

check box
Calibration Mode

activates the Calibration Mode (and its overlay), i.e. the mouse cursor
changes to a cubic-like icon that allows to drag the blue 2D points; only with
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an activated Calibration Mode it is possible to activate the FOV Re-Cal and
Live Re-Cal

radio buttons 2D / 3D must be chosen before the calibration is started;
- pick "2D" if working with a two-dimensional object and having placed the
four markers in a co-planar way;
- pick "3D" if working with a three-dimensional object and having placed the
four markers in a non-planar way, as seen in the example above

check box FOV Re-Cal enables to "interactively" change the FOV in the Camera / View tab; each
time another value is entered, the calibration runs and returns the new
camera position

check box Live Re-Cal enables to "interactively" change the 2D points; each time a new value is
entered and each time a 2D point is dragged, the calibration runs and
returns the new camera position

button Update Cal starts the calibration. An algorithm runs and estimates the best camera
position depending on the position of the 2D points, as well as on the lens
shift and FOV set up in the Camera / View tab

number field to the right changes the opacity of the overlay shown when the Calibration Mode is
active; the overlay can be toggled with "Edit > Marker > Show Calibration
Overlay"

check box 3D Point toggles the visibility of the yellow 3D point of a marker

check box Show ID toggles the visibility of the identification number above a yellow 3D point of a
marker

check box 2D Point toggles the visibility of the blue 2D point of a marker

11.2.3.9  Live Warp

The "Live Warp" tab is hidden in the basic mode. To activate the advanced mode, open the "Edit" menu
and choose "Advanced Mode". This is only available in the Warper 3D edition.

The tab enables you to setup a connection to another device in order to input and / or output data so that
the Warper is controlled by another device and / or controls another device itself.

A guide that explains the Live Warping feature in more detail can be found here .

Art-Net Input

The settings on the left side of the tab allow to activate the Art-Net input as well as to set the patch, i.e
the Subnet, Universe and the starting number also known as the channel.

The general purpose of this feature is to be able to control a mesh from another device, may it be a
lighting desk or Pandoras Box (outputting Art-Net). In detail, an FFD point can be moved along the X, Y
and Z axis. Each of these 3 parameter has a resolution of 16bit. Hence, one FFD point listens to 6 Art-
Net channels. In this manner, up to 9 FFD points can be remote controlled. An according device is
available in Pandoras Box ( tab "Device Types" > "DMX Fixtures" > "COOLUX" >  "PB Warp 3x3.clib").
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The first channel is applied to the FFD point in the upper left corner, or more precisely to the X parameter
of it. Please see the following table for more information about the internal patch.

Ch 1,2 Ch 3,4 Ch 5,6 Ch 7,8 Ch 9,10 Ch 11,12 Ch 13,14 Ch 15,16 Ch 17,18

X Y Z X Y Z X Y Z

1st FFD point 2nd FFD point 3rd FFD point

Ch 19,20 Ch 21,22 Ch 23,24 Ch 25,26 Ch 27,28 Ch 29,30 Ch 31,32 Ch 33,34 Ch 35,36

X Y Z X Y Z X Y Z

4th FFD point 5th FFD point 6th FFD point

Ch 37,38 Ch 39,40 Ch 41,42 Ch 43,44 Ch 45,46 Ch 47,48 Ch 49,50 Ch 51,52 Ch 53,54

X Y Z X Y Z X Y Z

7th FFD point 8th FFD point 9th FFD point

Please note that due to the Art-Net protocol the IP address needs to be set to 2.x.x.x and the subnet
mask to 255.0.0.0. The FFD count of the mesh must not exceed 3x3 points.

It is possible to input Art-Net at the same time as the warp output is activated.

Warp Output

The settings on the right side of the tab allow to activate the Pandoras Box Warp Output and to set the
according settings, that is the target Site ID, Device ID and interval (transmission rate).

This feature enables you to control an object on a Pandoras Box layer in real time from within the
Warper or through another device. Or in other words, it makes it possible to warp live. This if of particular
interest when projecting on a moving, deforming screen or when the projector is moving itself. Another
application is described below.
In detail, the feature works like this that single or multiple mesh points can be moved in the Warper
along the X, Y and Z axis (by hand or by an input device). According to the interval time, the changes
done in the Warper are transmitted directly to an object that is part of a graphic / video layer  or output

 in Pandoras Box. The object needs to be a so called "index object". An index object can be
exported from any object or mesh from within the Warper. The command is available in the File menu
. Furthermore, a Warp FX is required on the layer. The effect actually receives the data and influences
the index object accordingly. For more information and a step-by-step tutorial, please read the Live
Warping guide .

You can remote control Pandoras Box from one or more Warper applications. The Warper may run on
the same computer or on another one connected via network. In the last case, please check the network
settings  in the Edit menu and make sure that the used network switch is capable to transmit the
data in the set time.

As said above the application for the Live Warp feature include the projection with a moving screen or
projector. Another application would be in a scenario where an object, a 2D or 3D object, is already
applied to a graphic or video layer and thus deforms the according media file; or in a scenario where a
camera is moved to another position. Under certain circumstances it is needed to deform this result
again. For example, if the projector's lens has a strong cushion effect. In that case, generate a mesh and
export it as a index file. Apply it together with the Warp FX to the output layer. Now you can address this
output layer in the tab "Live Warp" and whilst you are deforming the mesh in the Warper the output's
object deforms as well and influenced all underlying graphic / video layers.
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11.3  Warping Guide

This chapter includes step-by-step tutorials about 2D warping. Whilst 2D warping is based on deforming
the 2D content in a way that it looks correct again, 3D warping achieves this by placing (3D) objects and
the camera in 3D space. For more information please read the introductory chapter .

The first tutorial explains, how to warp a 2D mesh . It shows how to decide for the best FFD and mesh
count and how points can be moved.

Afterwards it is explained in detail how to export the mesh and use it in Pandoras Box .

Then there is an tutorial showing how to work with associated meshes .

The last one tells more about the live warping feature .

11.3.1  General Warping Workflow

Setting up FFD control points and mesh segments

Before you start moving the control points you have to decide with how many FFD control points and
mesh segments you should work. Please follow this link if you are not sure about the difference between
FFD and mesh . The FFD count is set up via the File  menu and the mesh count in the Mesh tab

. The perfect amount depends on your screen surface and outline.
The more warping projects you have done, the faster you will be able to tell the best FFD and mesh
count. If you are not sure in the beginning, simply make a guess and start warping. You will see quite
fast, that you have picked too many or too less FFDs. Too many FFD points are not that bad, it might
take more time during the FFD-phase but you could save time during the mesh-phase - at least if not
way too many FFDs were picked. If you have picked too less FFD points you will notice that you will
have to move mesh points at a very early stage of warping. This will definitely be more time-consuming
than starting all over with a new mesh. In addition, it is easier to obtain a good quality mesh (as
described below) with FFDs instead of offsetting single mesh points too far. If you like, you can save the
current project and have a quick look whether a new mesh with more FFDs does give you better results
and eases your work. This can be found out in a few seconds but save minutes or even hours.

Example 1, a 4x3 FFD
A simply bend screen will go well with only 3 vertical FFD
control points. Horizontally there needs to be done more
warping, thus 4 FFDs work better. The more smooth the
outline has to be, the more horizontal mesh segments you
should take. In this case there are 20 mesh segments.

Example 2, a 6x3 FFD
Curved screens that are more complex will be easier to
handle if you increase the amount of FFD control points. In
this case there are 6 horizontal control points and still 3
vertical ones. 
The curved outline of the mesh is the result by only moving
the FFD control points.
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Example 3, a 5x5 FFD
Spherical screens are bend in all directions. They require to
increase the amount of vertical FFD points as well. In the
depicted example a mesh with an 5x5 FFD is shown. If the
projector looks straight on the equator, the mesh deformation
will be quite homogenous and the FFD should look similar to
the example.

The amount of mesh segments can be altered as long as working only with the FFD control points. As
soon as a mesh point is moved, the amount should not be changed any more. 
In general, the amount of mesh segments depends on how exact the warp needs to be. Firstly this is a
question how complex or detailed the screen is, including the outline, as shown in the above example
with the simply bend screen. If the screen is quite flat itself but has a very detailed outline, it could be a
faster solution to create a mask  instead of increasing the mesh count.

Secondly, it is important whether you are projecting with single projectors only, or if several projectors
overlap each other. Within the softedge area the pixels from both projectors must overlay each other
perfectly. This requires a higher mesh count. As a rule of thumb, at least 7 mesh segments should lie
within the overlap area.

By the way, it could be helpful to work with mesh segments that have the same height as width. If your
projector has an aspect ratio of 16:9, you could set up a mesh count of 16 by 9 during the FFD-phase
and increase it to 32 by 18 or even 48 by 27 before starting the mesh-phase.

Deforming the FFD and mesh

A good quality mesh refers to a mesh where the mesh lines are uniformly distributed on the screen. For
example, if the screen is 2m wide, and there are 20 horizontal mesh segments, each segment should be
10cm wide. If this is not achieved sufficiently, and you project text that moves across the screen, it
would scroll unevenly. Wherever there are smaller distances between mesh lines, the text would be
smaller too. Wherever there are larger meshes, the text is enlarged.
If your content does not contain critical movements or visible geometrical forms, you can warp a little
more rough. So before you start warping, or before you spend too much time within the last phase,
check the content and decide how perfect the result really needs to be.

For some people it is quite hard to perceive equal distances. To fasten and ease the warping workflow,
try to mark certain points on the screen. If you mark for example every 40cm with tape, it will be much
easier to arrange the mesh equally. If you cannot tape on the screen, a rotatory laser can be helpful as
well.
For the same reason it can be worth the time to create special test patterns. This is definitely
recommended when projecting on complex geometries and the later on used content refers to the
geometry.

Keeping this mind we can now start warping. The golden rule is always to warp as much as possible
with the FFD, but not more than necessary. Or in other words: the FFD is for the coarse adjustment
and the mesh for fine-tuning.

Whilst moving the FFD points, match the mesh outline (= content outline) as good as possible with your
screen outline. At the same time keep an eye on the distance between the horizontal lines and between
the vertical lines. As soon as you recognize that moving an FFD point helps within a small mesh area
but "destroys" an higher number of other mesh areas it is better to finish with the FFD-phase. Decide for
a final mesh count and move on to moving meshes. Here you will see that the better the FFD was
adjusted, the less time needs to be spend for finishing.
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When warping with overlapping meshes, you are done with warping as soon as all mesh lines overlay
each other. This can be seen easily when both meshes have a different colors as the resulting color will
be the sum. The closer the audience sees the projection, the more perfect the overlay needs to be.

In general it is possible to do a rough warp and start programming with it in Pandoras Box. Later on,
when there is enough time or when it is sure the projector or screen will not move, you can load the warp
project again and finalize it.

Different ways how to move FFD or mesh points

Depending on your preference you can work either using the mouse or the keyboard, or both. For more
detailed information, please see the Tools bar chapter .

Mouse

You might have to unhide the Toolbox
by clicking the key [T]. [H] hides it
again.

Keyboard

You might have to unselect the Toolbox
first by clicking into the Warper's main
interface.

Switch the
Edit Mode

In the Toolsbar, click on

-Object 

- FFD 

- Mesh 

Use the shortcuts

-[O]

- [F] or 

- [E]

Select points Select a single point by simply clicking
on it. 
Select multiple points by holding down
[CTRL] additionally. 
Or, drag a selection box.

Navigate to another selected point by
clicking the Up/Down/Left/Right key.
Select multiple points by holding down
[CTRL] additionally.

Switch the
Move Mode

In the Toolsbar, click on

- Move 

- Rotate 

- Scale 

Use the shortcuts on the main keyboard

- [1]

- [2]

- [3]

Toggle the
Axis Locks
(if necessary)

In the Toolsbar, click on the according

axis button 

Use the shortcuts
- [X]
- [Y]
- [Z]

Edit the
selection

To move, rotate and scale, hold the
right mouse button and move the
mouse up/down or left/right.

To move, hold the [SHIFT] key and click
the arrow keys Up/Down/Left/Right

When working with keyboard shortcuts, you can adjust the precision of the arrow presses for positioning
the Mesh / FFD points in the toolbox section “Keyboard / Mouse ”.

A third alternative to edit points is to use the dialog for relative transformation . Left-click on the

according mode  to open the dialog. Now you can enter an exact factor for each axis and
press "Apply".

The next tutorials explain how to export your mesh and use it in Pandoras Box , how to work with
associated meshes  and how to use the live warping feature .
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11.3.2  Using an Object in Pandoras Box

This chapter explains how a single mesh can be exported from the Warper and be used in Pandoras
Box. In the next tutorial  there is an example with a project containing associated meshes.

When you finished your mesh, please export your file in order to use it in Pandoras Box. Choose File
menu  > Export Modes > Export selected.
A small browser window opens. Browse to the directory to where you want to export your mesh as an
*.x-file.

It is highly recommended to always save the warping project too. Choose File menu  > Save Settings.
Whilst the exported *.x file contains only the mesh information, the *.wrp file saves all other settings and
the FFD data. If the projector or a screen has moved, for whatever reason, or if you like to fine-tune /
finalize your mesh, you can then simply load your warping project file (File > Load Settings) and make
your changes.

Open your Pandoras Box application (Pandoras Box Manager, Player or Server). In the Assets tab
browse to the directory to where you exported your mesh. Drag and drop this *.x-file into the Project tab

. You might need to spread the file. If you have created this file for a specific output (e.g. Output 2),
assign it to the according Output layer . Now all affected layers will be deformed in the same way. If
you have created it for only one layer, assign it to an available Graphic  or Video layer . Both
scenarios are depicted in the example below.

This grid is exported as screen5.x. File menu > Export
Modes > Export selected

In Pandoras Box there are two layers in use - one for the
blue background and one for the orange content. Currently
there is no object assigned to any layer, neither to the
content layers nor to the output.

The Preview tab is shown in the left image.

The saved object screen5.x is dragged from the Assets tab
into the Project tab. Now it is part of the project.
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The Preview shows
the result when the
object is assigned to
the Output layer,
everything is mapped
onto the object ... 

...whereas this would be the
result if the object was assigned
to the orange layer, and not to
the output. As you can see,
only the orange layer is
deformed, the blue background
keeps its original shape.

Please note that it is possible to
combine these two ways: you
might assign an object to a
layer and to the output at the
same time. Then, the image will
be deformed twice.

11.3.3  Warping with Several Meshes

See here an example for a workflow if you have to project on a screen setup as shown in the image
below.

The task is to project on this screen setup in this way:
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The screen in the middle should show the whole content. Each of the two side screens should show only
the a half of the content.

Important:
If your setup will contain overlapping meshes, please read the information about the Z-Order  as well!

Start with a new warping file. As three meshes are needed, you
could create additional meshes with the "Add" button in the mesh
selection from the Menu bar .

Alternatively, choose File Menu  > New… > Triple. 

The project contains three side by side meshes as seen in the left
image. One texture is applied to all three meshes at the same
time.

For an easier recognition of an individual mesh, you may alter the
texture mode. Open the Texture tab  and click "Wireframe". Or,
lower the opacity to a value of 120. If you like to use another
texture, click the button "Load Texture", but in this example we will
keep the coolux test pattern.

Now, the FFD and mesh lines of the selected mesh are better
visible. To change the selection, use the according drop-down
menu in the Menu bar (the so called mesh selection ). For the
next step, select the leftmost mesh, Mesh1.

Mesh 1 is now modified in order to cover the first screen in our
setup. You can either work with FFD points by moving or scaling a
multi-selection of them, or you can scale the entire mesh whilst
being in the object mode. The previous tutorial shows different
ways how to do this. 
First, adjust the outer FFD points so that the borders of your
projected mesh exactly fit to the borders of the left screen. The
mesh segments should all have the same size as well. This can be
adjusted by moving the inner FFD points.

The size of the mesh is Ok, but as seen when switching back to
the Textured View, it depicts only third of the content. The task
was to show the left half of the content. This is done by influencing
the so called texture map . Please have a look at the current
settings in the Texture tab . 

Up until now, the mesh's width is covered with a third of the
texture. That means, the entire texture is zoomed with a factor of
3.
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At the same time the height is not covered with only a third of the
texture, but the entire texture height. Setting the aspect ratio to 3
as well, zooms the height back in.

The last setting is the X Offset. For now, it is set to 0.3333 in order
to shift the image 1/3 (of the image width) to the right side.

If you like you can reset the settings and try to find the solution for
the task by yourself...

All three settings need to be adjusted to accomplish our task. We
would like to: 

- see half of the content's width => set the Zoom to 2
- see the whole height => set the aspect ratio to the same zoom
factor of 2
- see the leftmost pixel row at the left object edge => set the X
offset to 0.25

Why 0.25? We see half of the content on the mesh, in other
words, one quarter is "behind" the left edge and the other quarter
behind the right edge. So, to see the leftmost pixel we must shift
the texture by 1/4 of the texture to the right side. One quarter is
0.25 and "to the right" requires a positive value.

Now the texture sits perfectly on the first mesh. 

Repeat these steps for the right mesh covering the ride side
screen. The result is seen left. If your result is different, check the
texture mapping. As the texture needs to be shifted to the left, the
X Offset should be negative: -0.25

Again, repeat the steps for the center mesh. First, transform the
mesh according to the screen it is projected on. Then, adjust the
texture mapping for the correct content. This time we would like
to: 

- see all of the content's width => set the Zoom to 1
- see the whole height => set the aspect ratio to the same zoom
factor of 1
- see the leftmost pixel row at the left object edge => leave the X
offset to 0

The last thing to do now, is to export the whole scene.
Go to File > Export All and choose the file location. All three
meshes will be combined in the newly created *.x-file. Use this
object on the Output in Pandoras Box.
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11.3.4  Live Warping

The live warping feature (previously known as dynamic warping) allows to have non-static objects on a
layer. While projecting, the mesh can be influenced in real-time. Another feature - Morphing  - allows to
fade between two or three saved meshes.
Please note that those features are not available on Pandoras Box Player Systems!

Controlling Pandoras Box via Warper

- In the Warper, set up the connection to the
Pandoras Box (PB) Master system. To do this go
to "Edit" > " Network Settings ".

- For the next steps advanced features will be
used, please go to "Edit" > "Advanced Mode" to
toggle between the basic and advanced user
interface where all features are visible in the
menus and tabs.

- Set up the FFD and mesh count  from your
mesh you would like to use, or import an object.

- Export the selected mesh as an index object (as
the previous mentioned step influences the object,
the export has to be done each time you change
the FFD and mesh count). To do this go to "File

" > "Export Modes" > "Export Selected as
Index Object". Save the *.x file. If the PB Master
is connected and a project is opened, all exported
objects will be automatically loaded into this
project. If you start the project later drag and drop
your saved object from the Asset tab  to the
Project tab .

- In PB, choose which layer (or output) you want
to warp live. First of all assign a media file to it
and make sure the opacity is on.
Then go to the Project tab and assign the
exported object as a mesh to the layer. The layer
will now be stretched as if it was one line.
Go to the "Aeon FX " tab > Folder "Warp" >
drag the effect "Warp" onto the layer. Note that
this effect has no parameters, you will not see it
in the Device Control itself. Only when opening
the FX parameter in the Device Tree  you see
the effect. The effect cannot be turned off like
other effects, the only way to deactivate it, is to
delete it entirely.

 - In the Warper, go to the tab "Live Warp ",
tick the check box "Enable Pandoras Box Warp
Output" and set up the site and device whereto
you assigned the object and the effect in PB.

- Now, as soon as you edit the FFD or mesh in
the Warper the layer in PB will not look like one
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line anymore. From now on it is influenced in real-
time according to the mesh in the Warper.

Controlling Warper via Pandoras Box / another Art-Net Device

 

- As this feature is based on an Art-Net
communication make sure that Pandoras Box
and the Warper are set to an IP address 2.x.x.x
and Subnet Mask 255.0.0.0.

- In Pandoras Box go to the "Device Types" tab
 > "DMX Fixtures" > "COOLUX" > and drag

the "PB Warp 3x3.clib" into the Device Tree.

- Now select the warp device and go to the 
"Patch" tab  to patch it, for example to Channel
1 on Subnet / Universe 1/1 .

- Lastly, go to the "Configuration" tab , open
the section "Remote Control Protocols" and press
the button Art-Net "Activate Output".

- In the Warper, set up a mesh with an FFD count
of 3 x 3 and a mesh count of your choice.

- Go to the "Live Warp " tab, tick the check
box "Enable Art-Net Input" and patch the Channel
as done in the previous step.

- Now, as soon as you change the parameters
within the warp device in PB, the FFD points and
therefore the mesh are influenced.

- Instead of the warp device in PB you can use
any Art-Net sending device to control the FFD in
the Warper.

- Of course this feature can be combined with the
above mentioned feature and the Warp FX. If you
do this you are limited to a 3 x 3 FFD.

Morphing between several objects

- In the Warper, first of all open the "Edit "
menu and activate the "Advanced Mode". Then 
set up the FFD and mesh count . Export the
mesh as an Index Object. This has to be done
only once, as long as you do not change the FFD
and mesh count anymore.

- Then deform the mesh as you wish to have it
when starting the morph process.

- Export this state as the first Morph Target (as the previous mentioned step influences the file, the
export has to be done each time you change the mesh). To do this go to "File " > "Export Modes" >
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"Export Selected as Morph Target". Save the *.png file. If the PB Master is connected and the Warper is
set to its IP address and domain and if a project is opened, all exported objects will be automatically
loaded into this project. If you start the project later drag and drop your saved object from the Asset tab

 to the Project tab .

- Do the same for the second (and third) status of the mesh. These states represent the in-between look
or how you wish to have the deformation when the morph process is finished.

- Alternatively, you can also save one morph target per frame, meaning that each morph target represent
a step from the transformation. (Some programs can export a movement from objects as an object
sequence - a folder consisting of several *.3ds, .obj or .x files. To convert all of them in one step to be
used as a morph target, choose the option File > Convert Object Seq to Morph Target . 

- In PB, choose which layer (or output) you want
to morph between the meshes. First of all assign
a media file to it and make sure the opacity is on.
Then go to the Project tab and assign the
exported object as a mesh to the layer.

- Go to the "Aeon FX " tab > Folder
"Geometry" > drag the effect "Morph A-B" (or
"Morph A-B-C)" onto the layer.
Then, again, go to the Project tab and assign the
exported morph targets as effect medias. 

- When you have a morph sequence, import it as
an image sequence in Pandoras Box or
convert it to an *.avi video file, e.g. using the
coolux tool Image Converter  or to a lossless
video format from the coolux codec .
- Go to the "Aeon FX " tab > Folder "Warp" >
drag the effect "Warp Target " onto the layer.
- Assign the morph image sequence or video to
the effect.

138 271

819

137

98

868

114

137

600



861

11.4  Keyboard Shortcuts

[F1] – Help
[T] – Show Tools
[H] – Hide Tools

[S] – Select Mode
[M] – Move Mode ([1] Pos, [2] Rot, [3] Scale)
[F] – FFD Mode
[E] – Edit Points Mode

G – Toggle Grid / Textured View
[Space] – Play/Pause Video Texture

[D] – Toggle Face Visibility

[ESC] – Clear Selection
[CTRL+A] – Select All
[R] – Reset Offset of Selected Points
 
[Up] – Selection Up
[Down] – Selection Down
[Right] – Selection Right
[Left] – Selection Left
 
[Shift]+[Up] – Move Selection Up
[Shift]+[Down] – Move Selection Down
[Shift]+[Right] – Move Selection Right
[Shift]+[Left] – Move Selection Left
 
[CTRL]+[Up] – Multi-select Up
[CTRL]+[Down] – Multi-select Down
[CTRL]+[Right] – Multi-select Right
[CTRL]+[Left] – Multi-select Left

12  Leica 3D Disto

The Leica 3D Disto tool comes automatically with the installation
of a Pandoras Box Manager. It is accessible in the "Tools"
menu. The tool requires that the Leica hardware, specifically the
3D Disto, is connected and the drivers are installed. Please note,
that the distometer cannot be purchased through your local
distributor but we are happy to forward contact details.

In short, the motorized distometer measures points with great
accuracy and in return can laser to any point, measured before.
It draw our attention as it can be used in complex 3D scenarios
to measure projector positions and object position. It reduces

setup times significantly.
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13  Dome Master

The Dome Master is a spherical map converter that allows the conversion of dome master files to
spherical map files. Its sub-pixel accuracy allows optimum image sharpness for large scale projections.

Input formats:
- Bitmap (.bmp),
- GIF (.gif),
- JPEG (.jpg),
- PNG (.png),
- PSD (.psd),
- TGA (.tga),
- TIF (.tif),
- TIFF (.tiff).

Output formats:
- BMP 24bit (Bitmap, RGB),
- BMP 32bit (Bitmap, RGB+Alpha),
- PNG 32 bit (RGB+Alpha),
- AVI Sequence

Loaded image: Courtesy of Triad, Berlin
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13.1  What Is a Dome Master?

A Dome Master file describes a sphere or a hemisphere as circular image within a square. The outer
edge of the circle corresponds to the dome’s equator, the circle’s center point corresponds to the
dome’s pole.

To map content to 3D spheres or Dome Warpings it is reasonable to convert Dome Master files to
spherical maps. These spherical maps will have the aspect ratio 2:1 (full sphere) or 4:1 (hemisphere).

The Dome Master Converter allows a 1:1 conversion via pixel blending to achieve the best quality for the
spherical map. Due to this process it can take a longer time for the conversion.

13.2  Dome Master User Interface

The Dome Master User Interface is divided into three sections: File , Image  and Settings .864 864 867
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13.2.1  File

To process files with the Dome Master you may do it image by image or as batch conversion.

Single Image conversion:
Select [Single Image] and then Click on […] to browse to your file’s location to convert a single Dome
Master file.
The file will be displayed on the left side in the Image section.

Batch Conversion:
Select [Batch Folder] and click […] to choose the folder where all of the Dome Master Files are located.
You have to define an output folder as well, where the converted files will be stored.
The first file from the Input folder will be displayed on the left side in the Image section.

You may want to enable the option [Use Multi-Core] to split the conversion process evenly over all
available cores of your computer for faster conversion.

13.2.2  Image

On the left side you will see the original image you loaded to the Dome Master Converter.

Loaded image: Courtesy of Triad, Berlin
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[Convert]:
Press this button to convert the image. Per default (without using the Resize option in the Info section)
the image will be converted in the according image size with the aspect ratio 4:1 and the file format
chosen under [Format]. The processed image will be displayed on the right side.

For example:
Converting an image with the native size 4096x4096 px, will result in the image size 8192x2048 px.

Loaded image: Courtesy of Triad, Berlin

Saving a single image:
To save this single image just press [Save] and choose the location where to save it.

Saving and converting files from batch folder:
If you loaded a whole file folder for batch conversion, you may press [Batch] now to start the conversion
process. This will deliver single Bitmap images in your output folder.
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While the batch conversion process is running, the message “Batching files …” is displayed in the image
fields.

To skip the batch conversion process press [Stop].

To create a video out of all files located in the Input folder, press [AVI Export] instead of pressing
[Batch]. A pop-up dialog opens up.

File Name:
Choose a File Name for your AVI video and use […] to browse to the location where it should be stored.

Frame Rate:
Choose the Frame Rate out of the following ones:

24, 25, 30, 50 and 60 Frames per Second.

Now press [Start Export] and your AVI video will be created.
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13.2.3  Settings

Use this section to define the image’s output settings.

[Format]:
Choose one of the following image formats for the processed spherical maps:
BMP 24bit (Bitmap, RGB),
BMP 32bit (Bitmap, RGB+Alpha),
PNG 32 bit (RGB+Alpha).

[Resize]:
By default this option is disabled. Converting images without Resize enabled will result in images with
the aspect ratio 4:1 and the file format chosen under [Format].

If you want to resize the image, enable [Resize] You now may choose one of the settings from the drop
down list on the right or enter the new values for Width and Height manually in the text fields.
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14  Image Converter

The Image Converter is a tool for content preparation and modification, and can be used to increase the
performance of the PB Playback system.

The Image Converter allows to process either single images or - as it supports batch processing -entire 
image sequences . It resizes images to smaller file sizes or it converts the format. In addition it may
export an image sequence as a mpeg or an avi video. You may choose to read the frames forwards or
backwards.
Since version 5.1 it is possible to extract an additional black and white movie to be used as a mask for
keying in Pandoras Box. This is the most recommended workflow when an alpha (transparent) channel
is needed in videos!

When you work with large, high resolution multi-softedged projections, you might be interested in a tool
that splits images in order to have separate playback videos per Client. Please have a look at another
coolux product, the Splitter .

The following pages explain the user interface .
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14.1  Image Converter User Interface

The Image Converter User Interface is divided into three sections: File , Image  and Settings .

14.1.1  File

To process files with the Image Converter you may do it image by image or as batch conversion.

Possible input formats

- Bitmap (.bmp)
- GIF (.gif)
- JPEG (.jpg)
- PNG (.png)
- PSD (.psd)
- TGA (.tga)

869 870 873



870

- TIF (.tif)
- TIFF (.tiff)

Single image conversion

Select [Single Image] and then Click on […] to browse to your file’s location to convert a single image
file to a new size.
The file will be displayed on the left side in the Image section.

Batch folder conversion

Select [Batch Folder] and click […] to choose the folder where all of the image files are located. You
have to define an output folder as well, where the converted files will be stored.
The first file from the Input folder will be displayed on the left side in the Image section.

Additional options (Batch folder conversion only)

Include Sub Folder
Recursively searches for images in subfolders.

Use Multi-Core
Enables the Image Converter to use multiple processor cores, this uses more system performance but is
accordingly faster.

Delete Input Images
Removes the source images after conversion.

Odd/Even Frames Only
Tells the Image Converter to convert only odd or even images. This useful when getting an image
sequence that is produced for 3D-content where the first, third, fifth... frame is for the right eye and the
second, forth, sixth... frame contains the information for the left eye. A typical framerate would be for
example 120Hz. With the feature you may separate the right and left content and render two videos to be
played back with 60Hz.

14.1.2  Image

On the left side you will see the original image you loaded to the Image Converter.
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Below the image you see the format information of the currently loaded image:
Size, Colour Depth and Aspect Ratio. For batch conversion, it also shows you the file count.

The image size in the example above is 1920x1080 px, its colour depth is 24 bit (containing RGB +
Alpha) and the aspect Ratio is 1,778 (=16/9).

Converting single images

To convert a single image press the button "Convert". Per default (without using the resize option in the
info section) the image will keep its size and it will be converted into the file format of your choice. The
processed image will be displayed on the right side.
Once you converted the image, you can export it using the save button.

Converting multiple files (batch conversion)

To start, choose the batch conversion mode. Now you can specify the path to the folder where all your
source images are located in. After that you will need to specify the target folder right below the source
folder. Once you have set up both paths, adjust the conversion settings to suit your needs. Finally press
the "Batch" button to start. While the batch conversion process is running, the message “Batching files
…” is displayed in the image fields.
To skip the batch conversion process press "Stop".

Converting images to an .avi movie

Do the same as described above in the section "Converting multiple files". Instead of using the "Batch"
button you click the "AVI Export" button. The following dialog will be shown:

File Name
Choose a File Name for your AVI video and use […] to browse to the location where it should be stored.

Frame Rate
Choose the framerate in FPS (frames per second). Possible values are 24, 25, 30, 50 and 60.

Now press the "Start Export" button and your AVI video will be created.
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Converting images to a .mpg movie

The MPEG export feature allows you to render a sequence
of images to a mpeg file.
Enter a file name and click the [...] button for determining
the entire file path.
Choose the appropriate frame rate and the playback
direction. "Bounce" will play all images forward and then
once again in reversed order.

The alpha splitting section gives you the possibility to
maintain the alpha channel when converting to the mpeg
format. The mpeg format was originally specified as a
codec not supporting the alpha channel. Therefore the
Image Converter enables the following workflow: First the
main mpg video that naturally supports RGB only is
generated, then an additional mpeg is saved which holds
the original transparency information in terms of a black
and white mask. In Pandoras Box dedicated effects merge
the main video and the mask video resulting in one video
with transparency.

Split Splits color and alpha information into two
separate tracks.
In Pandoras Box, use the effect Alpha
Media as Mask

Top Bottom /
Left Right

The color information is rendered to the
top/left half of the video. The other half
contains the alpha information.
Please note that this option lowers the
image quality but saves playback
performance.
In Pandoras Box, use the effect Alpha Top
Bottom , respectively Alpha Left Right

Top Bottom /
Left Right
HQ Double
Resolution

The video height/width is doubled. The
alpha information is stored as a
black&white video attached at the bottom/
right of the video.
Other than the above option, the quality is
preserved. On the other hand the playback
takes more processing power!

Choose a "Mpeg Encoding Preset" or define a custom
setting. The encoder is based on the Pandoras Box
Encoder Extension, please find more detailed descriptions
for the encoder settings  here, including
recommendations regarding the bitrate setting.

Click "Start Export" to confirm all settings. When the
process is finished a dialog will pop up.

524
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The advanced settings
make in depth
configuration of the
MPEG encoder possible.

The maximum resolution
for an mpg2 video is
4094x2800 px, though it
is recommend to set
4080x2800 px as this
conforms with the mpeg
standard. The encoding
process depends on
available graphic card
RAM.

For further information
regarding the encoder
settings please see the 
Encoder Extension .

14.1.3  Settings

Use this section to define the image’s output settings.

[Format]:
Choose one of the following image formats for the converted images:
BMP 24bit (Bitmap, RGB),
BMP 32bit (Bitmap, RGB+Alpha),
PNG 32 bit (RGB+Alpha).

[Resize]:
By default this option is disabled. Converting images without Resize enabled will result in images with
their original size and the file format chosen under [Format].

If you want to resize the image, enable [Resize] You now may choose one of the settings from the drop
down list on the right or enter the new values for Width and Height manually in the text fields.
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[Match Size]:
This option allows to easily resize the image to any size without having to calculate the correct Width
and Height to keep the image’s original aspect ratio.

Example:
To convert an image file with the size 2560x1200 px (aspect ratio is 2,133) to a file that is 1000 px wide,
you have two options:

Not using [Match Size]
Enter the new values for Width and Height manually into the text fields: Width = 1000px, Height = 469
px. This assumes that you know (or calculate) the Height to keep the correct Aspect Ratio.

Using [Match Size]:
If you don’t want to calculate the value for the according Height, just enter the Width value (=1000) and
then enable the [Match Size] option. Now press [Convert]. The new image size is displayed next to
[Match Size]: 1000x469 px.

[BG (=Background)]:
This option allows to replace transparent image parts with a background colour. Enable the option and
click on the small box next to [BG] to choose the background colour.
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Example 1:

The coolux oo-logo contains transparent parts. Converted with [BG] disabled: the transparent parts will
be kept.

Example 2:

The same logo is converted with [BG]-option enabled, a white BG colour is chosen: the former
transparent parts on the logo are replaced by white.
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[Output Fit]:
This option allows to resize an image to a size with a different aspect ratio without stretching the
content.

Example 1:

The logo (size 1024x410 px) is resized to 800x800 px. The result is a stretched image.

Example 2:

The logo (size 1024x410 px) is resized to 800x800 px, but this time the [Output Fit]-option is checked.
The logo keeps its aspect ratio, only the canvas size’s aspect ratio changed. The canvas area that is
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added on top and bottom to fit to the output will appear transparent if [BG] is not checked. With [BG]
checked it shows the chosen background colour.

[Scaling]:
Choose between several filtering and quality options for the scaling.
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15  Splitter

The Splitter is designed for splitting one big master-file into several smaller split-files for Multi-Display or
Multi-Projection purposes. This allows a good performance and capacity on the playback systems, with
native playback of Video Content of nearly any size.

Features:
-Setup of any amount of Output regions
-Output Regions can wrap around top/bottom or left/right. This is important for 360° Panorama / Sphere
content overlap setups

Using the Splitter primarily makes sense when the content has to be created before the technical setup
is defined, e.g.. without knowing how many projectors will be used or how big the overlap between the
projectors will be. This way the content producers may work independently from the technical setup.
Only the total image resolution has to be defined.

Please note that it is only possible to load image sequences:

Supported Input Formats:
- BMP Sequence
- JPEG Sequence
- TIFF Sequence
- TGA Sequence
- PNG Sequence

The advantage of using Image Sequences is that the data transfer will be considerably faster and allows
an easier replacement of certain scenes inside a movie.
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Supported Video Sizes:
The Master Files may have 8192x2048 px (on Windows XP).
Under Win7 (and above) 64bit files with up to 65535x2048 px may be processed.

See here more information about the Splitter User Interface  and the Splitter Workflow .

15.1  Splitter User Interface

The User Interface is divided into the File Menu , the Edit Menu , the Toolbar  and the Main
Window . 
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15.1.1  File Menu

[New…]
All Output Regions will be removed and you may start loading a new image sequence.

[Load Settings]
You may load a Splitter project (.vsp) that you saved before.

[Save Settings]
You may save your current Splitter project as .vsp-file.

[Load Image Sequence]
Please browse to the folder your image sequence is located in. This will be loaded then into the current
project.

[Export Video…] 
Please browse first to the folder where you want to export your AVI video file to.

The upcoming AVI Export Settings dialog allows you to set the frame rate (24, 25, 30, 50 or 60 fps).

It displays as well the amount of frames.

Press [Start Export] to render out the video file.

[Export Image Sequence…]
Please browse to the folder your image sequence should be exported to. When the export is finished
you will be notified by a pop-up window.

[Exit]
Exits the application.
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15.1.2  Edit Menu

RESET ALL OUTPUT REGIONS
This option resets all output regions.

HIGH PERFORMANCE MODE IMAGE SEQ I/O
Using this option enables / disables the High Performance Mode for exporting Image Sequences.

OVERRIDE MPEG SIZE LIMITS
This option is of interest when working with still images, image sequences or avi. With the activated
option "Override Mpeg Size Limits" you are free to set up any output region size.

According to the Mpeg specifications, the image width (in pixels) must be dividable by 16 and the height
by 8. If you enter a region that does not conform to this specification, the Splitter corrects it
automatically to the nearest smaller number allowed. For instance, a 33 pixel wide and 15 high region
results in 32 x 8. If overriding the size limits, the output region can be 33 x 15. When using the Option in
the File Menu to "Export Image Sequence + MPEG Video..." now, the exported MPEG file is being
encoded without the specified settings and might cause unexpected issues when being played back.

15.1.3  Toolbar

Use the toolbar to create and manage the Output Regions.

[  Create Region]:
Click the left mouse button and span the desired region.

[  Move Region]:
Select the desired region and move it to it’s correct place.

[  Drag View]:
Use this mode to drag the view around.

[  Zoom]:
Choose one of the Zoom factors to adjust the Preview window. You may enter an individual zoom factor
as well. You may use the keys + / - on your keyboard as well.
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Output Region options:

Output Region:
You may choose an Output Region from the list in order to delete it, to adjust its name, position or size.

[X]:
Press the cross to delete the selected Output Region.

[Name]:
To change the name of an Output Region, please select it first from the drop-down list, enter the new
name and press [Enter].

[X / Y Pos]:
The Pixel values inside these two text fields display the position of the region’s top left corner. To change
its position to an exact place please enter new values for X and Y here. 
To move a region with the mouse please use the option [Move Region], see above.

[Width / Height]:
These two values display the size of the selected Output Region. To change its size please enter the
new Width and Height into the text fields.

[  Colorspace]:
Choose here the colorspace for the Image Sequence. You may choose between

· BMP 24bit (Bitmap, RGB)
· BMP 32bit (Bitmap, RGB + Alpha)
· PNG 32bit (PNG, RGB + Alpha)

This setting does not affect an exported AVI file, it will always be exported as Uncompressed AVI.
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15.1.4  Main Window

In the middle of the Main Window the loaded master file is shown, which is repeated at the left, top, right
and bottom side. This allows you to wrap the Output Regions around top/bottom or left/right. This is
important for 360° Panorama / Sphere content overlap setups.

You may set up any amount of Output Regions, using the right-click menu or the create mode (see 
Toolbar ). In the example above two Output Regions were created (green and red rectangle). Both
have the size 1024x768 px. When exporting the master file, there will be a separate file created for each
of the Output Regions.
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The right-click menu inside the Main Window:

The right-click menu gives you access to 

· Create an Output Region: Choosing Custom Size will enable you to span a rectangle in the Main
Window. Choosing one of the pre-defined sizes you just have to define the position of the Output
Regions top left corner by clicking into the Main Window.

· Move existing Output Regions.
· Drag the whole View around (incl. Masterfile and Output Regions).

15.2  Splitter Workflow

To split a master file into separate split files, see here a short workflow overview:

1. Loading the master file:
Load an Image Sequence or an existing Splitter Project using the File Menu.

2. Creating Output Regions:
Create as many Output Regions as you need, using the “Create Region” function in the Toolbar or
using the right-click menu inside the Main Window.
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3. Adjusting Output Regions:
Probably the Output Regions need to be adjusted in their position and/or size. You may do this by
moving the Output Regions with the mouse (using the “Move”-option from the toolbar). To do an exact
positioning, select the Output Region (by name in the Toolbar or by clicking on it when being in
Move-Mode) and enter the Pixel values of the top left corner in the Width and Height text fields.

4. Exporting the split files:
After the setup for the Output Regions is done you may export the separate split files now as Image
Sequence or as AVI File. When exporting an Image Sequence choose the Image Sequence format in
the Toolbar first (BMP 24bit, BMP 32bit or PNG 32bit).

5. Saving the current project:
Don’t forget to save your settings in order to be able to modify the Output Regions after you once
closed the Splitter. Do this inside the File Menu.
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16  CITP Desktop Streamer

The Pandoras Box CITP based Desktop Streamer is a versatile tool to stream any Windows desktop
region, for example the Preview section of Pandoras Box Manager or any application content, into
WYSIWYG or Capture Polar directly.

This way you can project your favorite video content directly into WYSIWYG without using any capture
cards. It is designed for pre-programming and can also be set up at different frame-rates to match the
systems performance.

You may use several instances of the Desktop Streamer at the same time!

Please note that StreamiX Desktop (since V5.1) - a TCP based Desktop Streamer that works as a Live
Input in Pandoras Box - is described here .

16.1  CITP Desktop Streamer User Interface

The User Interface is divided into three sections: the Streaming settings , the Preview Window  and
the Capture Settings .

16.1.1  Streaming Settings

[Window Title]:
You may start several instances of the Desktop Streamer at the same time to pass several CITP
streams into your WYSIWYG application. The number shown in the Window Title [] displays the stream
number: Pandoras Box CITP Desktop Streamer [1] = Stream 1.
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[IP / Port]:
On the top left the computer’s IP address and the used TCP/IP-Port are displayed.

[RGB]:
The [RGB] option allows you to match to the CITP colour space of your WYSIWYG version.

If this option is disabled, the colour space BGR is used for CITP streaming. Enable it and the colour
space will be changed to RGB.

Background:
Up to WYSIWYG Rev.25 the colour space BGR (according to CITP 1.0) is used. 

Up from WYSIWYG Rev. 26 the colour space RGB (according to CITP 1.2) is used.

[FPS]:
The Framerate can be set to values between 1 and 30 fps, according to your system’s performance. 
Please note: you don’t have to press [Apply], your changes are applied immediately.

[?]:
See here information about the settings you will need in WYSIWYG in order to use the CITP stream,
see WYSIWYG settings .

16.1.2  Preview

The Preview shows the part of your desktop that is sent via CITP.

According to the CITP specifications the size of the streamed media is 144x144 px.

Example:
In the image above the Pandoras Box Preview window is streamed via the Desktop Streamer.
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Please note: 
The Preview will not show modifications like image flipping or a change in the colour space. This will be
seen in WYSIWYG only.

16.1.3  Capture Settings

[Defining the capture region]:
There are two possibilities to define the region of your desktop that is going to be captured for CITP
streaming:

1. enter the region’s width and height (W/H) as well as its starting pixel (X/Y) into the text fields and
press [Apply].

2. press [Pick] and span the desired desktop region with the mouse.

Please note:
To capture a desktop region that is on a secondary monitor, enter the region’s Width, Height and starting
pixel as described in option 1. This can’t be done by picking a region with the mouse.

[Flip Horizontal / Flip Vertical]:
Depending on the texture mapping in WYSIWYG, these two options offer you to flip the CITP stream
horizontally and / or vertically.

Please note: 
You don’t have to press [Apply], your changes are applied immediately.

16.2  Capture Polar Settings

In order to stream your desktop or parts of it over to Capture Polar, please follow these steps:
- Start Capture Polar.
- Open a new or existing project.
- Start the Pandoras Box Desktop Streamer.
- Go to the Video Tab.
- The COOLUX Pandoras Box stream should be displayed in the list.
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- Go to the Design tab.
- In Materials you add a new material".
- Select the Coolux Pandoras Box stream, in the right window next to Video.
- Add this material as a texture to the desired objects.
- The Video Stream can be stretched manually or automatic to one or more objects.

16.3  WYSIWYG Settings

In order to stream your desktop or parts of it over to WYSIWYG, please follow these steps:

- Start WYSIWYG.
- Go to "Options - Application Options" tab "Additional Interfaces" and check "Enable CITP".
- Close and restart WYSIWYG.
- Within a project open the Video Manager.
  (this can be found in the menus Tools/Design/Live depending on your Working-Mode).
- Add a new video source.
- Check "CITP Video Stream" and click browse.
- Select the COOLUX Pandoras Box stream from the device list.
- Assign the stream as a texture to the desired objects.
- Open the "Video Tool" from "Live/Design".
- Select the CITP stream from the drop-down list and click the play-button.
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17  VNC Remote

The PB VNC Remote application lets you scan the network for PB devices and to remote-control them.

Pressing MENU in the menu bar allows you to:

CONNECT to a VNC Server

Enter the server's IP address or name. 
To add this server to the drop down list, press ADD. 
To delete it from the list, press DELETE.
To connect to the server, press CONNECT.
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DISCONNECT
The connection to the VNC server will be stopped by pressing this button.

SERVER CONTROL

Press SCAN NETWORK and you will get a list of all PB devices running the Onscreen Menu Rev. 32 or
higher.
The list contains information about:

- the Server's name
- IP and Mac Address 1 (and 2 if existing) 
- the resolution of Output 1 and 2
- the graphic card's desktop setup
- the status of running PB software (Master, Client or None)
- the Server's graphics card

Selecting one of the Servers and right-clicking lets you control this device.
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 You can either connect to IP 1 or IP 2, start the PB Master or Client or close the PB application. 

You may set different output resolutions for Output 1 and 2. Just
choose the supported output resolution from the drop down list.

You may deactivate Output 2. 

Please note: Only Nvidia graphic cards are supported.

The Reboot and Shutdown commands are also available.

EXIT
Close the VNC Remote Application by pressing EXIT.

Pressing VIEW in the menu bar allows you to:
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VIEWER ONLY
If this option is checked, the VNC Remote tool works as viewer only. You will not be able to manage the
connected server.

AUTO SCALE
This option is checked by default, it will automatically scale the viewed desktop into the VNC Remote
window. 

Without Auto Scale you will get a 1:1 resolution.

Pressing Commands in the menu bar allows you to:
- control the Pandoras Box application:

Start Master, Start Client or Close PB on your local machine.

Start All Masters, All Clients or Close All PB on all machines in the network running the onscreen menu
Rev. 32 or higher.

 - control the system:

Reboot or Shutdown the local machine.

Reboot or Shutdown All machines in the network running the onscreen menu Rev. 32 or higher.
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18  Widget Designer

The Christie® Pandoras Box Widget Designer is an advanced control surface creation framework, that
lets you create dedicated user interfaces and interaction logic. The great number of features are all
based around the idea, that even non-programming specialists should be given the tools to create truly
immersive interactive experiences for their customers.

You can add Widgets to you interface, e.g. buttons and faders. The Widget Designer interface is based
on HTML-5 and features the possibility to style and manipulate complete pages or single widgets due to
internally used CSS3 styles. Those can be imported and applied to the local user interface. Web
designers can easily style customized control panels for a variety of different users and applications.

In addition, visual node based programming is available to create customized show-control scenarios.
With the embedded node programming environment users can route and set up almost any possible
control scenario. Easily interact with sensors and data sources to route input data to any other output
protocol such as Art-Net, Midi/MSC, TCP/UDP, DMX or RS-232/-422 devices. Node programming can be
an alternative or an addition to scripting.

One of the most powerful concepts in WD is the script language . Anywhere in WD where commands
can be entered a Script Assistant helps you to find and use the desired command. Currently over 1000
commands  are available to control specific features of Pandoras Box, Widget Designer or other 3rd
party products and protocols.

Regarding the Pandoras Box  integration, Widget Designer can be directly used as a sequence device
as part of the Pandoras Box GUI. One also has the option of reading out a great variety of Pandoras Box
values. 

The Widget Designer comes in two versions :

Widget Designer Free Edition (formerly known as STD)
This edition is provided as a freeware license and can be downloaded on the official Christie website. It
allows you to create custom user interfaces and to work with commands.
Using the build-in Web Server  you may publish one page to be accessed by one user.
You may open a project that was originally programmed with a licensed Widget Designer. All project
elements, that are also available in of the Free edition will be displayed and will run in the dedicated way.
If licensed features were used (e.g. the AirScan) you will get a message that these elements are not
available in the Free version. Other features, like nodes  or variables  for example still exist even
though they are not part of the Free package, but are restricted in their use. In short, the Free version
can run but not change the settings of those features. Only a licensed Widget Designer provides full
editing access.

Widget Designer (formerly with the addition PRO)
The licensed Widget Designer offers various advanced features and tools to give you the most flexible
and easy way of programming user interfaces and interactive show elements. This version allows to
program visually with so called nodes. By simply connecting those visual control components you may
create a dedicated interaction logic. The Script Language  is fully supported including variables ,
functions and macros .
Using the build-in Web Server  you may publish one page to be accessed by several users at the
same time whereas the sessions are all synchronized.

Unlimited Web Clients Option (formerly known as the ULT edition)
This option extends the Web Server feature of a licensed Widget Designer.
Using the build-in Web Server  you may publish an unlimited number of pages to be accessed by
several users at the same time. In addition you may decide whether the users see a synchronized
interface of an individual one. This is perfect for installations where several remote controls are needed
with a centralized control station, or other large multi-user projects that focus on the integrated Web
Server
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Please see the following topics for working with the Widget Designer:
Setup
User Interface
Widgets
Nodes
Tools
Scripting
Web Server

18.1  Setup

The following two chapters explain how to setup and get started with Widget Designer.
Whilst Installation and Launching  helps you with the very first steps, Network Setup  enlightens
the settings when using WD to receive and send data to Pandoras Box.

18.1.1  Installation and Launching

Installation

All WD versions require Microsoft .NET framework (4.5.1) and C++ Redistributables 2013 to be installed
on the computer, they are included at the installation package and are being installed automatically if
necessary.

Please note that Widget Designer requires a 64-bit processor hardware.

If you have any issues with the installer itself, you may need to update your windows installer from the
Microsoft homepage. As well, we recommend to use the newest dongle driver version when installing the
software Widget Designer or Widget Designer with unlimited web clients. 
WD Free Version does not require any dongle, neither for the installation nor for running the software.

Launching

Once WD is installed on your PC, you may launch the application from the start menu or create a
shortcut on your desktop. 

Another way to start the WD in a defined edition is the so called command line argument from the
application. Create a shortcut of the Widget Designer .exe file (for example on your desktop). Right-click
on this shortcut > Properties. On the tab “Shortcut” attach the following to the Target text field (with a
space in between):
STARTWDF: free edition
STARTWD: regular edition, or leave the path as it is
STARTWDU: edition with unlimited web clients

Example:
"C:\Program Files\Christie\Widget Designer 6.0 Rev 5002\PB_Widget_Designer.exe" STARTWDF.
You may also use these additions with the command ApplicationStart(Filepath,Optional

Commandline Arguments) .

The chapter Widget Designer  explains the different editions.
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18.1.2  IP Configuration (PB Network Setup)

Depending on how you want to use and integrate Widget Designer (WD) to control Pandoras
Box (PB) or other devices, the first thing you might want to set up is the network
communication. When working in a network environment  you need to make sure that the IP
address, domain and port are correct otherwise you might not be able to send or receive
control data.

To access the PB network configuration dialog click "Connections" > "PB Configuration" in the menu
bar, alternatively right-click anywhere on the empty main background window and choose the command
in the context menu.

In the top section the local IP address is displayed. When
the PC is not connected to a network, the local IP is
127.0.0.1. If you make any changes in the network adapter
please save your project settings and restart Widget
Designer.
The next options are needed if WD should communicate
with a PB system. If you are running WD on the same
computer with the PB Master system that you would like
to control, all that needs to match are the version in the
drop-down list and the domain setting. Per default the
domain is 0, if it is changed it can be found in the 
Configuration Tab  of Pandoras Box.

TCP / UDP
The connection to Pandoras Box may be set up via TCP or
UDP. The ports that are used are 6211 for TCP and 6212
for UDP. 

TCP: this connection is bi-directional, it enables you to
receive feedback messages from Pandoras Box besides
sending commands only.
UDP: this connection is uni-directional. You will only be
able to send commands to Pandoras Box without getting
any feedback messages.

PB
Please choose here the version of the Pandoras Box
Master Device (Version 5 (and above) or Version 4.7). This
setting is very important, as from PB Version 5 on the
value ranges changed completely. When choosing a 4.7
version please note that only Rev 5771 or higher are
supported. When working with an older PB version please
downgrade Widget Designer to Revision 178 or lower.
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Pandoras Box Master Connection
If you would like to connect to Pandoras Box Master please enter the IP and domain of the Pandoras
Box Master Device here.
In case your systems use multiple network adapters simultaneously, please always check the IP
address in the asset browser tab  of Pandoras Box to get the right IP address of the network adapter
in use.
When using a Widget Designer ULT edition you may define a dedicated network adapter used for
transmitting this protocol. For more information about multiple network adapters please see the chapter 
Connection Manager .

Pandoras Box Backup Connection
The network configuration dialog also allows you to set up a backup IP and domain. This setting is used
when your Pandoras Box system is set up as full redundant backup with two Master systems. If you
wish to send all Pandoras Box related controls to both the Master and backup system then enter all
fields here.

Pandoras Box Widget Device Connection
The device type "Widget Designer" in Pandoras Box allows to execute commands directly from its
timeline in a very convenient workflow. Commands can be stored within keys. In addition to that, trigger
values can be sent to the Widget Designer application. Furthermore, mouse and touch data from the PB
Master or Client can be forwarded to Widget Designer either in total screen resolution or interpreted in
UV data.

The check box "Enable Connections" allows Widget Designer Devices in Pandoras Box to connect to
this WD application via TCP port 6213. "Execute Scripts" allows that commands programmed into a
timeline key within the Widget Designer Device can be executed by this WD application. The button "PB
Update Commands" updates the available commands in PB's drop-down list, e.g. if you are using an
older PB version or newer WD version.
The topic "Widget Designer Device " explains the workflow in more detail.

"Enable Touch" and "Enable Mouse" allow touch and mouse inputs to be transmitted. This is explained
in more detail in the PB chapter about Layer Picking . The button "Input Tester" shows incoming data
with following allocation: Action, IP address, Site and Device, TouchID, (Screen resolution in pixel) X and
Y, (Texture coordinates in vector size) U and V.
The Site and Device ID relate to the layer that is "touched" by the touch point or mouse cursor,
depending on the Input Event settings  of the Site in PB, i.e. whether "Route to Layers" is checked. In
special applications, there might be an overlaying foreground layer with different texture coordinates. In
that case you want to disregard this first layer but route the touch / mouse input to one layer further
done. This is achieved by clicking the check box "Use secondary hit" in Widget Designer.

V" option.

PB System Menu
Some nodes  in WD (e.g. Nodes > Input > Pandoras Box > System Menu (or search for PB Menu)
connect to the PB System Menu  and receive status information. Click the check box to enable the
connection and choose how often it is updated.

CITP Thumbnails Exchange
Up from V4.5 of Pandoras Box you may want to download the media thumbnails for later use in button
controls.

The thumbnail exchange is provided via the CITP thumbnail exchange of Pandoras Box. Before
downloading any thumbnail please first activate the CITP mode in Pandoras Box configuration tab
and make sure that the IP domain and port matches and is applied in WD.

Please keep in mind that CITP is transmitting only indexed media. This means that any media that you
would like to download needs to have a Folder and File ID  assigned in Pandoras Box. Once this is
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set up, you may press [Download Thumbnails] and once the blue progress bar is completed, all
thumbnails of Pandoras Box will appear.

To get an overview of the downloaded images you may click on [Thumbnail Browser] to check if all files
were successfully received and stored into WD file structure.

Please be aware that all thumbnails are stored into the WD file structure based on the given source IP
address. Once you change the IP address of Pandoras Box you will have to download the files again in
order to have WD find them on the local hard drive system.

Network Broadcasting Service
This section has been moved to the Remote  dialog > Network Broadcasting Service1257 1259
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18.2  User Interface

When starting WD, you will see an empty screen with a main menu bar and a toolbar containing all
available widgets. The empty screen represents the main background of your application window. A right-
click here opens a context menu that offers ALL options from the main toolbar as well.

Please see the following topics for detailed description regarding the different menus, from File Menu
until Tools Menu .

The topics Project Settings  and Window Settings  explain how general settings can be influenced.
For example, if you are creating a touch screen user interface, you can hide the standard windows
borders and the icons to close, maximize or minimize the application.

The last topic within this chapter lists all available keyboard shortcuts .

You may use the entire background area to
create and position any controls you wish to be
part of your user interface (UI) to remote control
Pandoras Box or any other device connected.

Widget Designer has three operating modes: 
The default "run mode" makes the function of
each tool available. For example, buttons may
be clicked, fader bars may be dragged. Tools
that are remoted by incoming data behave
accordingly.

Shortcut to enter the run mode: [F8]
Or click the play symbol in the toolbar.
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In the "edit mode", also called "move mode"
you may move, resize and copy any controls
and - if talking about nodes - connect them.

In order to select an item, simply click on it. In
order to select multiple elements, left-click and
drag a selection frame or click on additional
items whilst holding the CTRL key.

To draw a selection frame, hold the left mouse
button whilst dragging the mouse. If you start
somewhere and drag to the bottom right side, a
blue selection frame appears selecting all
items completely surrounded by the frame. All
other directions create a green frame, selecting
all items it touches.

Most widgets will show a small diagonal double
arrow icon at their bottom right corner. Click
and drag it to change the size.

All standard user control and nodes support
copy and paste with [CTRL+C] and [CTRL+V]. 

If you need to delete an item, right-click on the
element and click "Delete" or select it and
press the delete key on the keyboard.

Even though data is still calculated and
processed in the background whilst being in
the edit mode, tools and labels will only be
updated as soon as you switch back into the
run mode.

Shortcut to enter the edit / move mode: [F9]
Or click the arrow cross symbol in the toolbar.

The third operating mode is only active if you
have chosen an item from the widgets menu
or nodes menu . WD will automatically
change the mouse cursor to a crosshairs icon.
Wherever you left-click now, the chosen item is
generated. When you have as many copies
from the item as you need, enter the edit mode
to edit, e.g. resize them or enter run mode in
order to use them.

It is possible to deactivate the create mode
after creating a widget per default, please refer
to Profile Settings . 

Shortcut to enter create mode (last widget
created): [CTRL + SHIFT]
Or click the crosshairs symbol in the toolbar.
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The edit dialogs contain different, extendable sections. Widget Designer remembers which panel is
extended and which not for all other newly opened dialogs. The check box at the right side of each bar
allows you to keep the panel opened when it is ticked. If it is unchecked, the panel will close as soon as
another one is opened.

The default behavior can be set in the User Profile .

All edit dialogs offer the possibility to "Automatically apply changes", this mode is ticked by default. All
changes involving check boxes, buttons and drop-downs will be applied directly. Changing the content of
a text box will take place as soon as you leave the box or press [Enter].

906
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18.2.1  File Menu

The File menu in WD lists commands that influence your WD project.

New
Creates a new WD project file.The shortcut is: [Ctrl + N]

Open
A click on "Open..." (shortcut [Ctrl + O]) opens a file browser where you can choose the WD project file
to be loaded.
Open recent
This opens a list of recent projects. Items from the list can be removed manually.

Open last on Startup
To load the current project on next start, click on "Open Last On Startup".

Save
Click on save or use the shortcut [CTRL+S] to save your WD project file.
If you choose this option, a folder will be created at the location you specified. Inside this folder, you will
find the WD project file as well as a data-folder containing all images applied to different controls in WD,
as well as a folder containing custom CSS templates  if used. Without the extra folder, the data-folder
will be saved at the same location as the project file if there is any such data used at the project.

Save as...
Use this option to save the current WD project file under a different name.
Please note: WD only asks you to save the current project file when exiting the application, there is NO
AUTOSAVE.

926
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Save copy
"Save Copy" creates a copy of the current project and saves it at the specified location while you keep
working in the current file. This is especially useful when saving backup versions of your work.

Import...
With WD V6, it is possible to import widgets, nodes, pages or whole windows from another project. If
you choose this option, all parent elements of the desired element(s) will be imported, too. E.g.:
Importing a single custom script button would import the page and the window as well, unless you define
something else in the Import Settings .

Import to current page...
This option imports the selected widgets and / or nodes to the current page, for more information see 
Import Settings .

Import to current window...
This option imports the selected pages, widgets and / or nodes to the current window, as well as
selected data. For more information see Import Settings .

Profiles
Choose between different user profiles or edit existing ones in the Profile Settings . A profile stores
your working environment.

Restart
Restarts the application (with asking if changes made within a project should be saved).

Exit
Closes the application (with asking if changes made within a project should be saved).

18.2.1.1  Import Settings

With WD V6, it is now possible to import objects and data from other WD project files. As explained in
the previous chapter, the File menu  in WD offers several Import commands. When selecting one of
them you are asked to choose a project and then a dialog opens which is explained below.
By the way, if one or more objects that have to be imported are encrypted with a password, they can
only be imported after entering the correct password. 
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Widgets & Nodes

In this section you can choose between three ways of handling conflicting items. If you tick "Rename
conflicting new items during import", the imported item will be renamed with a "_2" at the end (or higher
numbers if this one exists already).
Example: CustomScript1 -> CustomScript1_2

You can also choose to ignore any item from the imported project that conflicts with the current project,
or to replace existing items with the new imported ones.

If you only want to import pages or windows without any widgets and nodes, tick "Do not import Widgets
& Nodes".

Pages

If you tick "Rename conflicting new items during import", the imported page will be renamed with a "_2"
at the end (or higher numbers if this one exists already).
Example: Page1 -> Page1_2

Like above, you can also choose to merge existing pages while keeping the properties of the current
project ("Merge imported widgets/nodes to existing pages") or adopt the imported pages' properties
("Merge and update existing pages' properties"). With both modes, only the widgets and nodes are
transferred directly.
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With "Import widgets to page ..." you can even import all selected widgets and nodes to a specified page
from your current project.

Windows

If you tick "Rename conflicting new items during import", the imported window will be renamed with a
"_2" at the end (or higher numbers if this one exists already).
Example: Window1 -> Window1_2

Like above, you can also choose to merge existing windows while keeping the properties of the current
project ("Merge imported pages to existing windows") or adopt the imported windows' properties ("Merge
and update existing windows' properties"). With both modes, only the pages are transferred directly.

With "Import pages to window ..." you can even import all selected pages to a specified window from
your current project.
Last, you can choose to not import any windows at all.



906

18.2.1.2  Profile Settings

With the user profiles, you can specify
some general settings concerning the
usage of the WD application itself. To open
the profile dialog, go to the File menu ,
choose "Profile" and one from the list. Other
project Settings can be found under Edit
menu > Project Settings .

The "Owner" is the Windows account you
are logged in with. When creating new
profiles, you can define the "Name"
yourself. 
If the Public box is ticked, everyone using
this PC will be able to access this profile. If
it is not ticked, only the "Owner" can see
and edit the profile.
The Encrypt box encrypts the profile
information. This might come in useful in
later versions, when passwords can be
saved with the user profile.
"Activate profile" activates the profile you
are currently editing, "Remove profile"
deletes it. With "Export" you can save it.

Settings

Changing the Startup language (English
or German) takes effect after restarting
Widget Designer.

The Script filter affects the results shown
in the Script Assistant . You can choose
between "Starts with expression", "Contains
expression" and "Camel Case Search". The
last option allows you to abbreviate your
search entry to the letters used at the
command's camel case nomenclature.
E.g.: "wdcstc" for
"WDCustomScriptTextColour"

If you like working with a grid, you can also
set your grid to automatically be visible
when opening the Widget Designer, or to
start in snap mode.

The list of recent projects can be edited, entries can be removed.

If you uncheck the box "Stay in create mode after creating a widget", the mode changes to edit/
move mode  automatically after creating a widget. Multiple widgets of the same kind then can be
produced at once while pressing [CTRL + SHIFT].

"Keep property dialog panels open by default" automatically ticks or unchecks all check boxes at
the expandable property dialog panels. Without the check box a section closes when another one is
opened. If you have preferred layouts of extended sections for certain types of widgets, tick "Override
defaults using cached panel states" to open all respective property dialogs with the same layout.
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You can also decide to keep the property windows always on top, this is especially useful while
adjusting and testing different settings.

Message Cache

Most of the pop-up dialogs offer the possibility "Do not ask again". The answer to this dialog will be
cached for future occasions. If you want to display the message again, select it at the Message Cache
and press "Remove selected messages".

18.2.2  Edit Menu

The Edit menu in WD lists commands influencing the look and behavior of your working environment. 

Item Properties
Opens the Item Properties dialog of the selected widget or node.

Run
Activates the operating mode called "run mode". (Shortcut: [F8])
The operating modes are explained here .

Edit / Move
Activates the operating mode called "edit / move mode" (Shortcut: [F9]).

Copy
Copies widgets that have been selected before.

899
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Paste
Pastes widgets that have been copied before. The controls are inserted according to the mouse pointer's
position. If you like to paste controls to another page use the shortcut [CTRL + P] while being in the
edit / move mode.

Delete
Deletes widgets that have been selected before.

Selection
This opens a list of actions that can be executed for single or multiple selected widgets. For example
they can be moved pixel-wise, or snapped to the grid (the grid does not have to be visible though).

Align Selection
To align multiple UI elements to each other, you will first need to select the items while being in the edit
mode and then apply the desired alignment method.
Please click here  when you like to learn more about the edit mode.

Z-Order
When you need to place one element on top of another, you may click on the desired element(s) and
choose "Send to Back" or "Bring to Front".

Reset protection passwords
Deletes all passwords from the project cache. If you have objects protected by passwords, you will have
to enter each password again for accessing those objects. For more information on the usage of
passwords, please refer to the Project Settings dialog .

Project Settings
This opens the Project Settings dialog .

Web Server Settings
This opens the Web Server Settings dialog .

Web Styles
This opens the Effects and Animations dialog, please see the chapter Effects & Animations (Web
Styles) .
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18.2.2.1  Project Settings

The Project Settings include
adjustments for the whole project. To
open the dialog go to the Edit menu
in WD and choose "Project Settings".
More project settings can be found
under File menu > Profile .

Project Properties Panel

Tick "Run on System Start" if you
would like the project to automatically
open after your system finished booting.

"Activate Skinning" loads the dark
skinning of the WD application. Restart
WD after changing this option.

If you like to run a script (consisting of
one or more commands) each time the
project is loaded, add the commands to
the text box and tick the check box 
"Execute Startup Script". The topic
Script Language  explains commands

and how to use them in more detail. Tip: You may use a macro .

Protection Settings

Setup a password and / or encryption for the whole project file. Please see the chapter "Protection
Settings"  for more information. To activate the protection for the entire project, open the View menu

 and choose the command "Lock Project" at the very bottom. Alternatively use the shortcut [CTRL +
SHIFT + L].

18.2.3  View Menu

The View menu in WD lists commands influencing the setup of your working environment. 
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Reload
Reloads the current page.

Zoom
The maximum zoom factor is 300%, minimum 25%. To reset the zoom, press [CTRL + 0].

Grid
"Show Grid" will display a pattern in the background. In the "Settings" dialog you can adjust its size.
With the "Snap to Grid" feature, you may use the (in-)visible grid as magnetic guides.

Widget Explorer
Opens the Widget Explorer  dialog that displays a tree view of all items of your project.

Browse Page
Opens a browser where all pages created are displayed with a thumbnail and their name. This makes it
possible to navigate satisfactorily through many pages. By clicking on one of the pages you will switch
to it. You may open the page browser via a command: OpenPageBrowser  
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Find Entry
Opens a dialog where
you may enter a (part)
of a command.

"Scope" opens a drop-
down list where you
may choose to search
the entire project or only
on the current page /
window.
"Find all References"
starts the search and
displays where the
command was found, for
example in a Custom
Script Button , a
Script Output node ,
a Function/Macro ,
or Page .
Right-click on the result
to open the according
properties or go to the
page where it is located.

If you look for a tool that
helps you debugging,
i.e. finding errors in your
command programming,
open Tools > Options >
Debug .

Find Item
Opens a dialog where you may enter a widget´s
name.
"Goto Page" calls the page where the control is
located.
"Show" will not switch pages but overlays them
with the control. The control will flash three times
and then stay in front of them until you go to its
source page. Thus you may use the control or edit
its item properties. 
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Show Sticky Notes
Sticky Notes  are only visible if enabled in the menu or by using [CTRL + ALT + N].

Show Hidden Controls
If there are any hidden widgets or nodes in the project, this option opens a dialog where all hidden items
are listed. You can choose which ones of them you want to be visible again.

Kiosk View
This option removes all bars and menus and resizes the main GUI to full screen. For leaving the Kiosk
mode, press [F11] again. Additionally, you can decide whether to use the [ESC] key for exiting Kiosk
mode.
The Kiosk view gives you the largest available space to arrange any controls forming an individual user
interface.

Full Screen
Maximizes the WD window over the whole screen and hides the standard Windows border and
application title bar for sure. You may as well use the shortcut [CTRL + 1]

Maximize
Maximizes the WD window over the whole screen. Shortcut: [CTRL + 2]

Normal Size
Brings the WD to the size and style it had before maximizing, or the default window size of 800x600px.
Shortcut: [CTRL + 3]

Minimize
Minimizes the WD window. Shortcut: [CTRL + 4]

Close Window
Closes the current WD window. If there is no other window opened, the program will be closed after
asking for the project to be saved.

Lock Project
This locks your entire project as defined in the Protection settings of the Project Settings  in the Edit
menu. To unlock the project enter the password you have set up. Shortcut [CTRL + SHIFT + L].

18.2.3.1  Widget Explorer

The widget explorer [CTRL + W] displays a tree view of all items of your project. They are sorted by 
windows , pages , types (of widgets  or nodes ) and individual items. The four buttons below
the tree view allow you to blank out the corresponding type. You can also search for a special item.
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Left-clicking on an item will load the item's properties directly into the widget explorer. Of course the
properties can be edited directly. You can also left-click on items in the main user interface to load their
properties into the widget explorer. Note that the Item Properties dialog can not be opened in addition to
the widget explorer.

Right-clicking on an item will show you some additional options for interacting with the tree view itself.
For example you can show or delete items and expand, collapse or delete branches.
Please bear in mind that deleting branches will result in deleting the respective items as well.

The lower case letter in front of each node indicates its type (e.g.: iFader = Fader Input Node, oFader =
Fader Output Node)

The widget explorer is being refreshed automatically.

18.2.4  Windows Menu

The Windows menu in WD allows you to create a new window, edit or delete the current one, and to
open already created windows.

Multiple Windows enable you to split your interface, for example if you have two or more monitors you
want to work on, or because you want to work parallel on several pages. Each window can be edited
separately, each page can be assigned to each window, which allows a flexible usage of your interface.
Please note that multiple windows still belong to the same instance of the application. Exiting the
program in one window will close all others as well!
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When you create a new window, a new page is also being created. A dialog asks you to name both of
them.

When you delete a window all contained pages will also be erased. In case you like to move them to
another window first, go to Page > Edit Page .916



915

Edit Window

In the first section, there are
some settings concerning the
outer appearance of your current
window, like name, size and
XY position. You can either
enter the absolute values, or
adjust the size of your window
by dragging the right bottom
corner. This updates the values
in the boxes immediately if the
box "Update above defaults
after manual change" further
down in the Window Options is
ticked.
The maximum window size
depends on your maximum
desktop size (e.g. If you use two
FullHD displays with your PC,
the maximum window size
would be 2x1920px = 3840px).

The Screen drop-down lists all
available displays attached to
your PC. Choose on which one
you like to see WD.

The background color is only
visible if the page is smaller than
the window itself.

If you like to give your window a
special icon (it is displayed at
the left corner of the window's
title bar), you can do so either
with one of the Widget Designer
default icons or with your own
image. Choose the directory
with the [...] button or choose an
image within the Image
Resource Manager  that is
opened with the [Res] button.

Window Options

Choose to show or hide the 
status bar (at the bottom), the menu bar (topmost bar) and the toolbar. If you check "Hide window
elements in run mode", those three bars are hidden as soon as the run mode is activated. Press
either [F9] (edit / move mode) or [CTRL + SHIFT] (create mode) to show them again.

Additional to the settings from the View menu  (Kiosk Mode, Minimize, Maximize, Full Screen,
Normal size), you can choose to display your window at the center of the monitor and to keep your
Window always on top (tick "Topmost" for this option).

You can adjust the opacity of the whole window including all bars. The smaller the value is the more
transparent the window gets. This does not apply to any dialog, such as properties or drop downs.
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The color key applies to anything inside your window that matches the chosen color. For example, if you
set your color key to blue and add a Shape filled with the same color, the blue area will be completely
removed from the window so that you can click on items lying somewhere behind this Widget Designer
window. To use this feature, set the opacity to 1.00 and check the "Transparancy" option.

The "Open window when project loads" option is especially useful if there is more than one window
in the project, and some of them should open automatically when loading the project while others should
not. This box is ticked by default, so if you only want to open your main window on startup, uncheck the
box for every further window. Please note that at least one window must be set to open when project
loads.

Open / Close Scripts

 If you like to run a script (consisting of one or more commands) each time the window is opened or
closed, add the commands to the text box. The topic Script Language  explains commands and how
to use them in more detail.
Tip: You may use a macro . 

Ui Effects & Animations

Please refer to the chapter Effects and Animations .

Protection Settings

You can protect your entire window by setting passwords and / or encrypt the window's source code. For
more information, see Protection Settings .

18.2.5  Pages Menu

The Pages menu in WD lists all pages you have already created in the current window   and eases
the navigation through your custom user interface.

Widget Designer supports unlimited pages to create dynamic menu systems. Buttons and commands
 can be used to change from one page to another.

Specifics about Pages: When nodes are set up, different pages can help to keep an overview. If you like
to deactivate (respectively mute) an output node when the page is not active, you can do so in the node's
Item Properties. Upon Page enter all nodes of the entered page are automatically activated. When VNC
Panels are used with pages, the page change will cause all invisible VNC panels to disconnect their
VNC Connection for performance reasons.

The command Browse Pages  in the View menu opens a page browser, where you will see all pages
as thumbnails.
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When you create a new page, an empty page is added to the window. The dialog with the page's
properties opens where you can choose a name and all other properties as explained further down. To
edit the current page, click on "Edit page...".

When you delete a page all contained items will also be erased. In case you like to move them first to
another page, open their Item Properties.
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Edit Page

First you can define a name for
the page. The name may contain
letters, capital or lower-case, as
well as numbers and underscore,
the first character has to be a
letter. 

If you use multiple windows  for
your project, you can assign your
page to any window from the
drop-down list.

Define the size of your page,
widgets and nodes are not visible
outside that area. If you reduce
the size of an already used page
and happen to lose some of the
widgets, they can still be
accessed with the widget explorer,
they also still react to being
dragged in the move mode, even if
you can't see them. The maximum
size of a page is 8192x8192px.

You may set up a background
image. Choose the directory with
the [...] button or choose an image
within the Image Resource
Manager  that is opened with
the [Res] button. Alternatively, a
solid color or gradient can be set
with the color fields.

"Background Image Size" offers
different aspect modes for the
background texture:
- Stretch: stretches the images so
that it fits into the page size
- Cover: resizes the image so that
it fits either horizontally or
vertically, the other side will be
cropped according to the page
size
- Contain: resizes the image so
that the larger side fits into the

page size
- None: maintains the original picture size and positions it in the center of the page

The In/OutClass enables you to set up transition effects for page changes. Choose one of the effects
from the drop-down and edit them according to your needs. Those effects are often designed to work in
pairs and may not produce the intended results if combined in other ways.

You can also import your own effects. CSS Import is covered in the chapter Effects & Animations (Web
Styles) .
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With the two additional check boxes, you can determine the behavior for the Web Server . If "Make
this page accessible..." is not ticked, you cannot access it from an external client. This is especially
useful for pages with nodes and configuration items, someone from outside is not supposed to see.

One page in the project can be set to an index page, check "Redirect to this page..." for the chosen
page. Any web server client will then be redirected to this page first when accessing the project.
checking this box will automatically uncheck the former index page.

Extended Page Settings
Enter custom commands  to the On-Page-Enter- or On-Page-Leave-Script to assign an additional
action to every page change. The topic Script Language  explains this in more detail. Tip: You may
use a macro .

Ui Effects & Animations
You can set up advanced render. Please see the chapter Effects & Animations (Web Styles) .

Protection Settings
You can protect your entire page by setting passwords and / or encrypt the page's source code. For
more information, see Protection Settings .

18.2.6  Widgets Menu

The Widgets menu lists all controls you may create in Widget Designer. Since Widget Designer version
6 all widgets are also supported by the Web Server .

Once you have chosen an item, the mouse cursor will change to a crosshair icon. Wherever you left-
click now, the chosen item is generated. More information about each control can be found in the 
Widgets chapter .
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18.2.7  Nodes Menu

The Nodes menu lists all node categories including all nodes you may create in Widget Designer PRO
and ULT, currently there are over 250 nodes available.

Once you have chosen a node, the mouse cursor will change to a crosshairs icon. Wherever you left-
click now, the chosen node is generated. More information about each node and how to work with them
can be found in the Nodes chapter .1040
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18.2.8  Connections Menu

The Connections menu in WD lists all available connection possibilities you can set up in Widget
Designer. Other than the listed input and output protocols, you can connect to devices  and other
tools .

Once you have chosen an entry a dialog opens with more options.

For a detailed description please see the following pages from the Connections chapter :

Connection Manager
Midi Input
TCP/UDP/COM Connections
Art-Net Monitor
Remoting

18.2.9  Devices Menu

The Devices menu lists all (physical hardware) devices you can work with in Widget Designer. In case
your device is not available, bear in mind that it is also possible to set up a connection , e.g. a TCP
connection. Additionally, WD supports several Tools . Note that the Devices are not supported in the
Widget Designer Free Edition.

Once you have chosen an entry, a dialog opens with more options.

For a detailed description please see the following pages from the Devices chapter :

AirScan
Kinect
Face Tracker  (not available in the Free Version)
Motion Detector  (not available in the Free Version)
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Camera Point Tracker  (not available in the Free Version)
Phidgets  (not available in the Free Version)

18.2.10  Scripting Menu

The Scripting menu lists all helping tools and other actions regarding scripting in Widget Designer.

Once you have chosen an entry, either a dialog opens with more options or the command is executed.
More information about the Script Language can be found in the Scripting chapter .

Scripts (Functions & Macros)
Here you can create Macros and Functions with "New Macro..." or "New Function...". To open the
macro/function editor for editing existing ones, simply click on the respective macro//function name.
To delete one, press "Delete" at the respective menu entry and a dialog will open where you can tick all
scripts you want to erase.

Variables
This opens the Variable List  where you can create global variables or edit existing ones.

Show Running Scripts
Opens a dialog where you may see all currently running scripts. The Context shows where a script is
executed from, e.g. from a Custom Script Button, a Script Output node, a Macro, or Page.

The dialog is meant to help finding out whether there is a script being executed and allows to stop it.
Right-click on an entry to get access to the stop and refresh commands.
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Enable Debug Logging
This toggles the debug logging on and off  to show or hide possible error messages in the dialog Debug
Logger.

Open Debug Logger
This opens the dialog Debug Logger and enables debug logging to display error messages. Its shortcut
is [CTRL+D].

As soon as you are working with more complex scripts, it might me useful to generate your own debug
messages with the command "DebugMessage(message text)" that will be displayed here, too.

This feature is currently not available for the WD Free Version.

This helps to find errors in your programmed scripts. The logger includes indications whether..:

-  a command is wrongly spelled or an arguments are not enclosed in double quotation marks

e.g. WDLabelText(1,giraffe) instead of WDLabelText(1,"giraffe")

=> * "Unknown token will be processed as a literal!" for "giraffe" at 1/15 [Warning/Executing]

- a command argument is not put in round brackets

e.g.WDLabelText,1,"giraffe"

=> * "Parameters must be enclosed in '()'!" for "WDLabelText" at 0/0 [Severe/Parsing]

- a command has not enough arguments

e.g. WDLabelText(1)

 * "A required parameter is missing." for "(" at 1/12 [Severe/Preparing]

- a command has too many arguments

e.g. WDLabelText(1,"giraffe","toomuch")

 * "Too many parameters!" for "(" at 1/12 [Severe/Preparing]

- a command includes a reference to a nonexistent ID

=> Label '2' does not exist. Command 'WDLabelText' exception: Object reference not set to an
instance of an object.

When you check the Verbose option, more details are listed including where the error happened, e.g.  >
Window1/Page1/CustomScript1/ClickScript

Alternatively you can copy the text into the "Find Entry" dialog  (from the View menu) or work with
Find Item .

Always show errors/warnings
Per default, the Debug Logger does not open automatically to show whether a script includes an error. It
opens only if you choose the "Test"command from the right-click menu. If you like to always see errors
and warnings, enable this option.

Recompile all scripts
Scripts are normally compiled as soon as they are written.
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However, if you have changed something, e.g. a variable type, it might be necessary to recompile all
scripts to update the adjustment.

Stop all scripts
Stops all running scripts and aborts all fades, macros and functions.
This is especially useful if you have programmed very long scripts, maybe with some wait-commands,
and have to abort them prematurely because something is not working correctly.

Enable scripts
Per default this option is enabled to allow scripts (including macros and functions) to be executed. If it is
disabled, no script will be executed.

18.2.11  Tools Menu

The Tools menu lists all tools available in Widget Designer. In contrast to a physical hardware device ,
a tool is rather a software tool. In addition, it is also possible to set up a connection , e.g. a TCP
connection.

Once you have chosen an entry a dialog opens with more options.

For a detailed description please see the following pages:

Events
Keyboard Input
Midi Input
Blacklist  (not included in the WD Free Edition)
Email Settings  (not included in the WD Free Edition)
RSS Settings  (not included in the WD Free Edition)
SMS Settings  (not included in the WD Free Edition)
Projector Calibration Manager  (Beta)
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Pandoras Box >
Canvas Template Manager
Add Layers to Pandoras Box
Array Align Layers 
Circle Align Layers
Cue Generator

Video Logger
Video Recorder
Image Resource Manager

Options…

Lock Interface
When choosing the "Lock Interface" command from the Tools menu a password dialog will pop up and
restrict the access to the interface from Widget Designer. The interface can be only unlocked when the
correct password is entered.
The default password is empty. 

18.2.12  Protection Settings

Widget Designer allows you to lock
and/or encrypt single or multiple
widgets, nodes, pages, windows or
the whole project file. Hence, the
Protection Settings are part of many
dialogs:
To protect the project, open the 
Project Settings  from the Edit
menu .
To protect a page, open its Edit Page
dialog either with the right-click menu
or from the Pages menu .
To protect a widget, open its Item
Properties dialog with the right-click
menu or the shortcut [ALT + P].

All passwords can be remembered in
Widget Designer so that you do not
have to enter them every time.
However, this applies only to the

current session. After closing the Widget Designer, the passwords will be expired.
You have the possibility to reset all passwords during an open session with Edit  > Reset protection
passwords...

Please note that the protection settings are rather designed for protecting your data in case of
distribution. If you like to set passwords for windows, pages and widgets in order to prevent other people
from using them, please use the command WDPasswordDialog. A common example would be a page
containing only nodes that should not be accessed by customers using the project.

Activate lock using password
You can choose what should be locked with a specified password:
- Show (the element will not be visible without the correct password, not available at the project's
settings)
- Edit (the element is not editable without the correct password)
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- Scripts (the element cannot be edited with member methods, such as e.g. Fader1.SetFix or
CustomScript2.SetSize(100,50)) 

A new dialog will appear when you tick the box "Activate..." that requests the password a second time.
This happens too, if you change the password.

The same locks can be applied to all child elements of this specific element (e.g: if you set up a
password for a window, all pages at this window will require the password, too.) 

If any locks were inherited from a parent element, they are displayed here, too.

Encrypt using optional password
This option encrypts the element's data inside the project file, so that it can't be decoded by reading the
project file's source code. The project can not be opened without entering the password as well. This
might come in useful if you have created complex Composite Nodes  and want to distribute them
without others being able to see the logic behind it. In this case, you would lock the node with a
password against editing in Widget Designer and additionally encrypt the project source code.

Title
Within the text field "Use the following title when prompting for decryption / unlocking" you can
add an additional title for the dialog asking for the password.

18.2.13  Effects & Animations (Web Styles)

Effects & Animations (Web Styles)

Since Widget Designer 6, the graphical user interface
you build relies on modern web technologies. It is
based on HTML-5 and features the possibility to style
and manipulate complete pages or single widgets due
to internally used CSS3 (Cascading Style Sheets)
styles, a "language" created for design. You can
utilize the full power of CSS in WD6, with or without
any technical knowledge of CSS specifics.
Web designers can easily style customized control
panels for a variety of different users and applications.

Applying styles

Most widgets (and pages and windows) can be
modified using web styles. This includes layout,
design, filters, images, animations, basically anything
you can do with CSS. 
In the widgets' properties dialog, these styles can be
found in the panel "Effects & Animations". There you
can add and apply several styles that you can choose
from a large selection of out-of-the-box styles, but you
can also add your own styles, of course.
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After adding a new (empty) item to the list
with the Add button, you can determine
the style (effect or animation) for that item
by choosing from a drop-down list. The
check box in front of the line enables and
disables the style. With the Edit button
you can change its settings. The available
effects and animations are stored in the

following structure:
- Effects: a collection of effects that can be applied to a widget, page or window. Commonly split further
into groups like 2D, 3D and Design.
- Pages: a folder for page transitions, grouped by "Enter" and "Leave" transitions.

Depending on the element you add a style to (window, page or widget), you will only be able to choose
styles that are applicable for that specific context in the property dialogs. Within the folders above, you
can organize the styles as you wish (and it is highly suggested that you keep your own custom styles in
separate folders).

You can add as many styles as you like, but be aware that not all combinations make sense, i.e. the
settings can contradict or influence each other:
- Page enter- and leave-transitions are often designed to work in pairs and may not produce the intended
results, if combined in other ways.

- Both transitions will start at the same time and the shorter transition determines the total length of both
transition effects.
That is why page transitions will only be animated, if both pages have defined and activated transitions.

- 2D effects are often intended to be combined with "Transition speed". 
- 3D effects often assume that the parent element (page and/or window) has defined a "Perspective"
style.

- Some effects may not be able to override the styles defined for an element in other ways, like styles
that are usually set using the item's properties (e.g. label's fore color). Sometimes reloading the page
(F5) helps, or extending the rendered selector in the templates so that it is more specific.

Note also that, except for page transitions, the styles will only be applied in run mode [F8]!

Editing parameters

From within the properties dialog, you can edit the parameter values used for each style. Editing a style
(in an item's properties dialog) will only effect the respective item. All other items using the same style
will remain unaffected. In the application, this is called editing "local overrides". If a value was changed to
be different than the default value (defined in the style's template), will be added behind the value's label
for your information.

Style templates

Each style is defined by a template file that is stored in one of the folders described below. These
templates are rendered into CSS files, they can contain any valid CSS code. Plus, they may contain
special placeholders for inserting parameters that can be changed from within the application, using local
or global overrides. These placeholders are detected and used to a) create a dynamic dialog for editing
the values and b) render different values for the different contexts in which a template is used.

Example for a CSS template (effect scale): 

<<Meta|Description=Resize the element. Requires TransitionSettings style to
be added and activated.|Elements=Widget>>

.RunMode .<<Selector>>{

   transform: scale(<<XFactor=2>>,<<YFactor=2>>); }

This description is depicted below the chosen effect
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Placeholder for the specific widget

Placeholders for local overrides with default values

Creating new templates, of course, requires a certain amount of knowledge about CSS. But, since it is
an open web technology, there are sheer endless amounts of examples and tutorials that make creating
impressive effects and animations feasible even for complete CSS-newbies. 

"w3 schools" for example offers tutorials for starters as well as additional information on expressions for
advanced users: http://www.w3schools.com/css/

Please note: The commands that can edit the CSS styles for widgets, like e.g.
WDCustomScriptCssStyleEdit, are not meant to do so continuously. Every time this commands
changes values, a new CSS file has to be generated from the template. If you want to build complex
animations, it is rather recommended to write your own CSS template than successively alternating the
values of a single effect.

Managing styles

All available styles are managed in the "Web Style Explorer" (Menu > Edit > Web Styles...). The
explorer shows a tree view of all styles using the structure described above (Effects, Pages/Enter,
Pages/Leave). All styles are defined by template files that are saved in one of the following locations:
- System (out-of-the-box) styles are stored with the application.
- Project styles are stored in the project's folder in "Data\Styles".
- Profile styles are stored in the user's profile's resource folder in "Styles." 

Widget Designer expects the above folder structure to be in one or all of the locations above. Identical
paths and names will be handled as only one style and the location from which the template is loaded, is
determined by the following order: first check for Project files, then Profile files, then System files. 

From within the Web Style Explorer, you can copy styles between the locations:
- Copy them to the project, if it is to be shared.
- Copy them to the profile, if the profile data is used on several computers, or to use different styles for
different users.
- Using the System styles (without copying them) has the advantage that they can be extended/
enhanced by future updates. (Hence they are not intended to be modified.)

You can also edit the parameter values of each style. These are "global overrides" that will effect all other
elements that use the same style - unless they have their own "local overrides".

http://www.w3schools.com/css/
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18.2.14  Keyboard Shortcuts

File:

CTRL + N Create new project

CTRL + O Open project

CTRL + S Save

CTRL + SHIFT + S Save as

ALT + F4 Exit Application

F1 Help

User Interface: 

F8 Run Mode

F9 Edit / Move Mode

CTRL + SHIFT Create last Widget

F5 Reload

CTRL + + Zoom in

CTRL + - Zoom out

CTRL + 0 Reset Zoom

F11 Toggle Kiosk Mode

CTRL + 1 Full Screen

CTRL + 2 Maximize Window

CTRL + 3 Set Window to normal Size

CTRL + 4 Minimize Window

CTRL + F4 Close Window

ALT + G Show / Hide Grid

ALT + S Toggle Snap to Grid

ALT + N Create Node

CTRL + W Open Widget Explorer

CTRL + F Find Entry

CTRL + SHIFT + F Find Item

CTRL + ALT + N Show / Hide Sticky Nodes

CTRL + ALT + L Lock Project

Page Up Go backwards in history (Pages)

Page Down Go forwards in history (Pages)

CTRL + Page Up Previous Page in list

CTRL + Page Down Next Page in list

Selection:

CTRL + A Select all

CTRL + Mouse Multi-select widgets and nodes

ESC Clear selection

CTRL + C Copy

CTRL + V Paste (if in edit / move mode)

CTRL + ARROW Move selected items

CTRL + SHIFT + ARROW Snap selected items

ALT + P Item Properties of selected item

Align Selection:

ALT + SHIFT + L Align selection to the left border
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ALT + SHIFT + R Align selection to the right border

ALT + SHIFT + T Align selection to the top border

ALT + SHIFT + B Align selection to the bottom border

ALT + SHIFT + H Align selection to its horizontal center

ALT + SHIFT + V Align selection to its vertical center

CTRL + SHIFT + H Align each item of the selection to the horizontal center of the UI

CTRL + SHIFT + V Align each item of the selection to the vertical center of the UI

CTRL + ALT + H Align the selection as a Group to the horizontal center of the UI

CTRL + ALT + V Align the selection as a Group to the vertical center of the UI

CTRL + ALT + SHIFT + H Spread selection horizontally

CTRL + ALT + SHIFT + H Spread selection vertically

18.3  Widgets

The Widgets menu lists all controls you may create in Widget Designer. 

This chapter includes general information about creating and editing widgets. The following chapters
explain each Widget in detail. The Widgets marked with (*) are not included in the Widget Designer Free
Edition.

"Search" helps you navigate to the correct (sub) menu.

Analog Clock
Buttons
Digital Clock
Displays  (*)
Drop Down List
Fader Controls
Input Box
Label
List View  (*)
Panels
Picture Box
Playlist  (*)
Shapes
Sticky Note
Textbox
Text Input
Timecode
Tree View
Video Player  (*)
Web Browser  (*)

Here you can change the order of the widgets in the menu.
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To create a control
a) open the Widgets menu from the main menu bar...
b) click on the widget symbols in the toolbar...
c) right-click anywhere in the empty main background and open the Widgets menu there...

...and choose the desired widget. The mouse cursor will change to a crosshairs icon, telling you that you
are in the operating mode  called "create mode". Wherever you left-click now, the chosen item is
generated. When you have as many copies from the item as you need, enter the edit / move mode (e.g.
with [F9]) to edit, e.g. move or resize them or enter the run mode [F8] in order to use their function.

If you want to set up the properties of the newly built control, right-click on it and choose the menu entry
"Item Properties" or press [ALT+P]. The widget's property dialog opens up. It contains all properties
influencing the widget's behavior and look, as well as its ID which is important when you want to use it
together with a node  or command . As you will need them many times, the Control IDs are
displayed when you are in the edit / move mode [F9].
Use the keyboard shortcuts [CTRL+C] and [CTRL+V] in order to copy and paste items, use the
[DELETE] key if you want to erase them. These commands can be found in the edit menu as well.
Additionally, all properties can be accessed via the Widget Explorer , too.

The image shown above gives an overview how many widgets Widget Designer supports. Since Widget
Designer version 6 all widgets are also supported by the Web Server . 

18.3.1  Analog Clock

Use this control to display the current computer time via an AnalogClock.

To edit the AnalogClock parameters simply right-click on the Analog Clock control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The Analog Clock Property Dialog opens up.
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The AnalogClock ’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the AnalogClock will be displayed on every page.

Size
Enter a pixel size for the AnalogClock's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

1642
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Caption
Here, you can enter a label for the clock, color and font can be selected with the respective buttons.

Resize Fonts
This features adjusts the fonts of caption and numbers when changing the size of the widget.

Background
An image can be loaded as a background. You can either browse your system for a picture or choose
one out of the Resource Manager .
It is also possible to set a background color and transparency.

You may design your Analog Clock using different colors for Center, Border, Labels, Hours, Major
Ticks, Minor Ticks, Minutes and Seconds.
Tick the check boxes to hide / display the mentioned units. A decorative frame can be displayed as
well.

UTC Offset
Enter here the time offset the AnalogClock should have from your computer's time.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.
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18.3.2  Buttons

Choose between various kinds of buttons:

Custom Script Buttons:
The Custom Script Button control is the most flexible button control. With this control you can set up
any button style and any click-able user interaction. Over 1000 commands are available to remote
control all important Pandoras Box features as well as Widget Designer interface elements and much
more.

Script Timer
The Script Timer control lets you execute commands after a certain amount of time. This can be done
once or continuously.

Media Control
The Media Panel control is designed to create thumbnail button tables based on the thumbnail
downloads of the CITP feature of Pandoras Box.

Cue Control
The Cue Control is designed to easily get access over the sequence control of Pandoras Box.

Image Loader
The Image Loader control is designed to easily exchange an image file that is added to the Pandoras
Box project with any other image file.

Video Snapshot
The Video Snapshot control is designed to easily exchange an image file within a Pandoras Box project
by a Video Snapshot from your attached Video Input.

Art-Net Snapshot
The Art-Net Snapshot Button is designed to record a full Art-Net DMX universe state, with the ability to
record from Universe A and output to Universe B.

Art-Net Recorder
The Art-Net Recorder Button is designed to record a full Art-Net DMX universe over a certain time, with
the ability to record from Universe A and output to Universe B.

Scroller Horizontal / Vertical 
The Scroller is designed to change the X or Y position of assigned media files in your Pandoras Box
project, so that you can scroll through a certain amount of pictures.

FlipSwitch Horizontal / Vertical
The Flipswitch is designed to execute commands only when the control reaches the specified unlock
position.
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18.3.2.1  Custom Script Button

The CustomScript button allows you to execute one or more commands whenever the button is clicked
or activated in a different way. You can set up any button style and any click-able user interaction. Over
1500 commands are available to remote control all important Pandoras Box features as well as Widget
Designer interface elements and much more.

To create a CustomScript button choose "Widgets > Buttons > Custom Script".
To edit the CustomScript button parameters simply right-click on the desired
CustomScript button control and choose the menu entry "Item Properties", press
[ALT+P] whilst the mouse is hovering above it or double-click on it when being in
the edit / move mode ([F9]).
The CustomScript button property dialog opens up.

The property dialog is divided into eight sections additional to the general widget properties on the top:
Settings, Button Styles, four different kinds of Scripts, Network Broadcasting and Ui Effects &
Animations.
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General Widget Settings

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The CustomScript button’s ID may be changed by entering a new one in the text field top left. If you
change it, you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the CustomScript button will be displayed on every page.

Size
Enter a pixel size for the CustomScript button's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Settings

Timeout (ms)
The timeout setting can be used to call the click script after a given timeout. The timeout is always
restarted upon mouse enter on the control.
This feature is particularly useful for AirScan or touch applications where the user can only position the
mouse but not cause a click with the input device.

Mute Click Script
Set a specific time in milliseconds for a CustomScript click script to be muted (not executed).
This protects a CustomScript button from accidental double clicks.

Type
You may set the button type to be Click or Toggle. The toggle state of the CS button will be kept when
the project is saved and loaded.

After creating a button it is always in the "Released"
mode. A button with the Click type has no other
status. If you click on it, each time, the "On Press"
script is executed. When releasing the mouse click,
the button is again into the "Released" mode and the
Release Script executed (if defined).

The toggle button has two modes. First it is
"Released". When clicking on it, the "On Press" script
is executed and the button changes to the "Pressed"
mode. The next time it is clicked, the "On Release"
script is executed and the button changes to the
"Released" mode again.
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The modes can be indicated by an image (see below). There are commands  that press a button, with
or without executing the associated script and with or without changing the mode.

Mouse Capture
CustomScript buttons allow to capture a mouse left click even when WD GUI is in the background, as
well as Mouse Enter and Mouse Leave events. This is useful when WD is used on the same machine as
Pandoras Box Players or Servers.

Interaction (Mouse Click / Release Scripts)
This section is of interest if you like to "click" a CustomScript button without using a mouse device,
including node solutions addressing a mouse. It is possible to use the input device directly to execute
the "On Press / Release" or "On Mouse Enter / Leave" script. If the device generates more than one
input event you can use all of them even if running a Win XP system that is normally restricted to one
input event. The following input devices are supported: AirScan , Camera Tracker , iPhone ,
Kinect , Remote Input , TUIO .
In addition you can also receive inputs from a device that is physically connected and set up on the
Pandoras Box Master or even Client system. The Client sends the mouse / touch / etc. inputs to the
Master system which sends it through the Widget Designer Device  to the Widget Designer interface.

Set up the supported device connection as usual to generate input events. 

Last, open the Item Properties of the Custom Script Button that should receive the input data. Enter the
script as usual and in the section "Interaction" enable then the check box for the input device, e.g
Camera Tracker as shown in the below screenshot. If you like to click the button with data from a PB
Master or Client, decide whether the screen (i.e. output resolution) or UV data of a layer is of interest. If
you like to filter data from a specific site / layer only, enter the Master's IP address, then the Site (and
Device ID) and the filter type. For more info about UV data see the chapter about Layer Picking .

Web Link URL
The Web Link section is of special interest when working with the  Web Server  feature, i.e. clicking
the CustomScript button in a web browser. Enter a URL e.g. "http://www.coolux.com" that your browser
should call when clicking the button.
But it is also possible to achieve a quick page change with the URL, simply enter a hash tag "#" and the
page name. E.g.: #Page2
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Button Styles

Label
Enter a label that will be displayed on the button. The text's color can be set via the color field and its
font via the according button.

Tint
CustomScript buttons can be colored by selecting a tint color, this applies only to the default button
images. 

Three images can be assigned to the different states of the button (the modes are explained above).
“Release” refers to no click or not toggled.
“Click” is on press or toggled.
“Highlight” can be used to draw a png with alpha over either the click or release image.

Click on the "..." button to open a file dialog where you can choose your path and image. If you like to
choose an image from the Widget Designer "library", click on the "Res" button. The Resource Manager

 opens where you can double-click on the image of your choice. You can also save custom images
in the Resource Manager to access them faster. The small "x" at the right sets the default image.

Script

In the Script section you may enter commands to be executed. You can type directly in the text field,
the Script Assistant will help you finding the expression you search for. The topic Script Language
explains this in more detail.

The scripts for Press, Release, Mouse Enter and Mouse Leave are executed when the Widget Designer
button is being used, on the local interface as well as on any web client.
You can put as much text in one of the scripting fields as you like, but for keeping a good overview,
using Macros and Functions  is recommended for sophisticated scripts
If you are interested in the Web Server feature and some small examples, please read the topics Web
Server  and Object and Member Notation  .

See here a list of all commands .

Network Broadcasting

The NBS (Network Broadcast Service) allows transmitting and updating Faders, Labels and
CustomScript buttons across multiple WD Designers instances on the network. To activate this service,
please refer to the Remoting dialog !

Enable Send
To send the CustomScript buttons state (clicked or released) as broadcast into the network, you only
have to check “Enable Send”.

Enable Receive
To receive values from other CustomScript buttons, please check “Enable Receive”.

Now you have to specify which item should update your CustomScript button:
Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the CustomScript button through another CustomScript button on the same Widget Designer) or a
different computer in the network. If you do not want to specify the computer but want to listen to all
computers in the network, enter “255.255.255.255”. 

As next step specify the CustomScript button you want to take the status from. This could be e.g.
“CustomScript1” or “ CustomScript2”.
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Ui Effects & Animations

CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.926
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18.3.2.2  Script Timer

The Script Timer control lets you execute a script after a certain amount of
time. This can be done once or continuously.

By the first click on the ScriptTimer it will be started. A second click on it
stops it again.

To edit the ScriptTimer ’s parameters simply right-click on the desired ScriptTimer control and choose
the menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on
it when being in the edit / move mode [F9]. The ScriptTimer Property Dialog opens up.

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

1642
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ID
The ScriptTimer ’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the ScriptTimer will be displayed on every page.

Size
Enter a pixel size for the ScriptTimer's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Interval
Enter here the Interval time in ms, after which the ScriptTimer executes the script once or continuously.

Start/Stop
Starts and stops the ScriptTimer.

Execute on Start
If this box is checked, the script will be executed immediately when the ScriptTimer is started.
Otherwise, the first script will be executed in the second interval.

Run Once
When “Run Once” is enabled, the Script Timer will execute the script once after the Interval Time is
expired and then stops again. 
When “Run Once” is disabled (by default) the Script Timer will execute the script continuously in the
Interval you entered in the text field to the right (in ms).

Three images can be assigned to the different states of the ScriptTimer:
“Release” refers to no click or not toggled.
“Click” is on press or toggled.
“Active” is the image appearing shortly at the beginning of each interval.

Click on the image place holder itself to open a file dialog where you can choose your path and image. If
you like to choose an image from the Widget Designer "library", click on the "Res" button. The Resource
Manager  opens where you can double-click on the image of your choice. You can also save custom
images in the Resource Manager to access them faster. The small "x" at the right sets the default
image.

Script
In the Script section you may enter commands to be executed. You can type directly in the text field,
the Script Assistant will help you finding the expression you search for. The topic Script Language
explains this in more detail.
See here a list of all commands . To control the Script Timer itself via commands, please use these
ones .

You can put as much text in the scripting field as you like, but for keeping a good overview, using 
Macros and Functions  is recommended for sophisticated scripts

Ui Effects & Animations
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CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

18.3.2.3  Media Control Panel

The Media Panel control is designed to create thumbnail button tables based on the thumbnail
downloads of the CITP feature of Pandoras Box.

To edit the Media Panel parameters simply right-click on the desired Media Panel control and choose
the menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on
it when being in the edit / move mode [F9]. The Media Panel Property Dialog opens up.

ID:
The Media Control’s ID may be changed by entering a new one in the text field top left.

926
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Fix:
When the option “Fix” is checked, the Media Control will be displayed on every page.

Control Settings

The Control Settings section lets you design and set up the Media Control Panel.

Devices:
To assign the media files to one or multiple devices, enter the site and device ID into the device text field.

Example:
To assign the media files to Layer1 of Server1 and Layer1 of Server2 enter "1.1 2.1" 

Folder ID, Index, Rows and Columns:
The media control is automatically built based on the selected FolderID, the start index of the files as
well as the rows and columns count.

Size:
The size sets the width of every thumbnail button.

Script

In the Script section you may enter commands to be executed. They will be assigned to all buttons of
the Media Panel. This way you can assign an additional action to every media change, e.g. an opacity
fade-in.
To enter commands you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.
See here a list of all commands .

1312
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18.3.2.4  Cue Control

The CueControl is designed to easily get access over the sequence control of Pandoras Box.

Sequence
By default the CueControl is assigned to Sequence 1 (displayed down right in the command window).
To change the sequence you want to control, please press
[SEQ+SeqID+ENTER], e.g. SEQ+2 will control Seq. 2 as long as you do not change the sequence.

Cues
To jump to the next / last Cue or frame in the sequence, use the arrow buttons on the left.

To jump to a dedicated Cue, please press
[CUE+CueID+ENTER], e.g. [CUE+5+ENTER] and the nowpointer jumps to Cue 5.
As long as you do not press another command like SEQ, TIME or CLEAR entering any number +
ENTER will be interpreted as "jump to Cue xx".

Time
To jump to a specific timecode, please press
[TIME+hh:mm:ss:ff+ENTER], e.g. [TIME+1041513+ENTER] lets the nowpointer jumps to the timecode
1:04:15:13. 

A more simple way to enter the timecode is to just enter the last numbers different from 0,
e.g. [TIME+213+ENTER] lets the nowpointer jumps to the timecode 0:00:02:13. 

As long as you do not press another command like SEQ, CUE or CLEAR entering any number +
ENTER will be interpreted as "jump to Timecode xx".

Clear
Press [Clear] to clear the current entered values.
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To edit the AnalogClock parameters simply right-click on the Analog Clock control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The Analog Clock Property Dialog opens up.

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The CueControl ’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the CueControl will be displayed on every page.

Size
Enter a pixel size for the CueControl's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Font and Color
Changes the font and its color of the text displayed on the buttons and the command window.

1642
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18.3.2.5  Image Loader

The ImageLoader control is designed to easily exchange an image file that is added to the Pandoras Box
project with any other image file on your PC. An interesting application for this could be e.g. if pictures of
the audience are made and by button click are displayed on a Pandoras Box output. 

Click on the ImageLoader button and a Windows explorer opens at the locations, from where you want to
send image files to Pandoras Box.

The newly loaded image file will automatically spread to all connected Clients.

To edit the Image Loader parameters simply right-click on the ImageLoader button and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The ImageLoader Property Dialog opens up.



947



948

General Widget Settings

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The ImageLoader button’s ID may be changed by entering a new one in the text field top left. If you
change it, you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the ImageLoader button will be displayed on every page.

Size
Enter a pixel size for the ImageLoader button's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Reload Settings

Folder and File ID
Enter here the File and Folder ID of the image in Pandoras Box, to which the new image should be
loaded. 

Width, Height, Fit
You may enter the Width and Height the image should get. Press Fit to enable this size option,
otherwise the image will be fitted to the size of the original image file inside Pandoras Box.

Target Path
Press [Target Path...] and browse to the image file which should be exchanged through the new loaded
images.

Start Path
Press [Start Path...] and choose or create a folder, from where you later choose the new image files,
that should be transferred to Pandoras Box.

Delay
The Delay between copying the new image to the original image file and loading it inside Pandoras Box
is set to 2,0 secs. This delay is set to be sure that the copy process is finished before the image is
loaded into Pandoras Box. This value can be edited by entering a new delay time.

Web Link URL
The Web Link section is of special interest when working with the  Web Server  feature, i.e. clicking
the ImageLoader button in a web browser. Enter a URL e.g. "http://www.coolux.com" that your browser
should call when clicking the button.
It is also possible to achieve a quick page change with the URL, simply enter a hash tag "#" and the
page name. E.g.: #Page2

1642
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Button Style

Label
Enter a label that will be displayed on the button. The text's color can be set via the color field and its
font via the according button.

Tint
ImageLoader buttons can be colored by selecting a tint color, this applies only to the default button
images. 

Three images can be assigned to the different states of the button (the modes are explained above).
“Release” refers to no click or not toggled.
“Click” is on press or toggled.
“Highlight” can be used to draw a png with alpha over either the click or release image.

Click on the "..." button to open a file dialog where you can choose your path and image. If you like to
choose an image from the Widget Designer "library", click on the "Res" button. The Resource Manager

 opens where you can double-click on the image of your choice. You can also save custom images
in the Resource Manager to access them faster. The small "x" at the right sets the default image.

Script

In the Script section you may enter commands to be executed. You can type directly in the text field,
the Script Assistant will help you finding the expression you search for. The topic Script Language
explains this in more detail.

The scripts for Click, Mouse Enter and Mouse Leave are executed when the Widget Designer button is
being used, on the local interface as well as on any web client.
You can put as much text in one of the scripting fields as you like, but for keeping a good overview,
using Macros and Functions  is recommended for sophisticated scripts
If you are interested in the Web Server feature and some small examples, please read the topics Web
Server  and Object and Member Notation  .

See here a list of all commands .

Network Broadcasting

The NBS (Network Broadcast Service) allows transmitting and updating Faders, Labels and buttons
across multiple WD Designers instances on the network. To activate this service, please refer to the 
Remoting dialog !

Enable Send
To send the ImageLoader buttons state (clicked or released) as broadcast into the network, you only
have to check “Enable Send”.

Enable Receive
To receive values from other ImageLoader buttons, please check “Enable Receive”.

Now you have to specify which item should update your ImageLoader button:
Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the ImageLoader button through another ImageLoader button on the same Widget Designer) or a different
computer in the network. If you do not want to specify the computer but want to listen to all computers in
the network, enter “255.255.255.255”. 

As next step specify the ImageLoader button you want to take the status from. This could be e.g.
“ImageLoader1” or “ ImageLoader2”.

1309

1312

1635

1662 1642

1319

1259



950

Ui Effects & Animations

CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

18.3.2.6  Video Snapshot

The VideoSnapshot widget is designed to easily exchange an image file within a Pandoras Box project
by a Video Snapshot from your attached Video Input.

A click on the VideoSnapshot button and the created snapshot is immediately send to an image file
within Pandoras Box.
The newly loaded image file will automatically spread to all connected Clients.

To send a Video Snapshot to Pandoras Box, you need to
1. have an image file added into Pandoras Box project with assigned File and Folder ID .
2. create a Video Input Display  and enter the Video Input ID of your Video Source.
3. set up the VideoSnapshot Properties, see below.

To edit the VideoSnapshot parameters simply right-click on the VideoSnapshot Button and choose the
menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it
when being in the edit / move mode ([F9]). The VideoSnapshot Property Dialog opens up.

926
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General Widget Settings

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The VideoSnapshot button's ID may be changed by entering a new one in the text field top left. If you
change it, you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the VideoSnapshot button will be displayed on every page.

1642
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Size
Enter a pixel size for the VideoSnapshot button's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Reload Settings

Video Input Display ID
Enter here the ID of the VideoInput display you want to generate the snaphots from.

Folder and File ID
Enter here the File and Folder ID of the image in Pandoras Box, to which the new image should be
loaded. 

Width, Height, Fit
You may enter the Width and Height the image should get. Press Fit to enable this size option,
otherwise the image will be fitted to the size of the original image file inside Pandoras Box.

Delay
The Delay between copying the new image to the original image file and loading it inside Pandoras Box
is set to 1000ms. This delay is set to be sure that the copy process is finished before the image is
loaded into Pandoras Box. This value can be edited by entering a new delay time.

Target Path
Press [Target Path...] and browse to the image file which should be exchanged through the new loaded
images.

Web Link URL
The Web Link section is of special interest when working with the  Web Server  feature, i.e. clicking
the VideoSnapshot button in a web browser. Enter a URL e.g. "http://www.coolux.com" that your
browser should call when clicking the button.
But it is also possible to achieve a quick page change with the URL, simply enter a hash tag "#" and the
page name. E.g.: #Page2

Button Style

Label
Enter a label that will be displayed on the button. The text's color can be set via the color field and its
font via the according button.

Tint
VideoSnapshot buttons can be colored by selecting a tint color, this applies only to the default button
images. 

Three images can be assigned to the different states of the button (the modes are explained above).
“Release” refers to no click or not toggled.
“Click” is on press or toggled.
“Highlight” can be used to draw a png with alpha over either the click or release image.

Click on the "..." button to open a file dialog where you can choose your path and image. If you like to
choose an image from the Widget Designer "library", click on the "Res" button. The Resource Manager

 opens where you can double-click on the image of your choice. You can also save custom images
in the Resource Manager to access them faster. The small "x" at the right sets the default image.
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Script

In the Script section you may enter commands to be executed. You can type directly in the text field,
the Script Assistant will help you finding the expression you search for. The topic Script Language
explains this in more detail.

The scripts for Click, Mouse Enter and Mouse Leave are executed when the Widget Designer button is
being used, on the local interface as well as on any web client.
You can put as much text in one of the scripting fields as you like, but for keeping a good overview,
using Macros and Functions  is recommended for sophisticated scripts
If you are interested in the Web Server feature and some small examples, please read the topics Web
Server  and Object and Member Notation  .

See here a list of all commands .

Network Broadcasting

The NBS (Network Broadcast Service) allows transmitting and updating Faders, Labels and buttons
across multiple WD Designers instances on the network. To activate this service, please refer to the 
Remoting dialog !

Enable Send
To send the VideoSnapshot buttons state (clicked or released) as broadcast into the network, you only
have to check “Enable Send”.

Enable Receive
To receive values from other VideoSnapshot buttons, please check “Enable Receive”.

Now you have to specify which item should update your VideoSnapshot button:
Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the VideoSnapshot button through another VideoSnapshot button on the same Widget Designer) or a
different computer in the network. If you do not want to specify the computer but want to listen to all
computers in the network, enter “255.255.255.255”. 

As next step specify the VideoSnapshot button you want to take the status from. This could be e.g.
“VideoSnapshot1” or “ VideoSnapshot2”.

Ui Effects & Animations

CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.
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18.3.2.7  Art-Net Snapshot

The Art-Net Snapshot Button is designed to record a full Art-Net DMX universe state, with the ability to
record from Universe A and output to Universe B.
A click on the Art-Net Snapshot Button and the captured Art-Net values are send out to the specified
Universe.

Please note:
In order to use the Art-Net Snapshot Button Art-Net Input and Art-Net Output needs to be enabled in the 
Connection Manager !

To edit the Art-Net Snapshot parameters simply right-click on the Art-Net Snapshot Button and choose
the menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on
it when being in the edit / move mode ([F9]). The Art-Net Snapshot Property Dialog opens up.

1239
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ID:
The Art-Net Snapshot’s ID may be changed by entering a new one in the text field top left.

Fix:
When the option “Fix” is checked, the Art-Net Snapshot Button will be displayed on every page.

The Art-Net Snapshot Property dialog is divided into three sections: Art-Net Snapshot Settings, Button
Style and Script.

Art-Net Snapshot Settings

Subnet and Universe:
Enter the Subnet and Universe the Art-Net values should be captured from.

DMX Link Out:
Check this option if you want to play out the Art-Net values via the DMX Link 1 Port Output device.
Please note that the device has to be enabled in the Connection Manager .

Fade Time:
If you want to fade to the Art-Net values stored in this button instead of sending them out abruptly, you
may define a fade time here (in sec).

[Capture Art-Net]:
Press [Capture Art-Net] and the current state of the specified Universe will be recorded.
To send out these Art-Net values on the same Universe, close the Item Properties dialog and just press
the Art-Net Snapshot Button.
To send out these Art-Net values on a different Universe, do it as following:
Enter the Subnet and Universe the Art-Net values should be captured from.
Press [Capture Art-Net] and the current state of the specified Universe will be recorded.

Now change the Art-Net settings to the Universe on which you want to send out the recorded Art-Net
values (do NOT press [Capture Art-Net] again) and press [OK] or [Apply] at the bottom of the Item
Properties dialog. Close this dialog and click on the Art-Net Snapshot Button.

Button Style

In the Button Style you may set up the button's text as well as its font and colour.
Three images can be assigned to the different states of the button.
“Release” refers to no click.
“Click” is on press.
“Highlight” can be used to draw a png with alpha over either the click or release image. 

You may also set the Buttons Height and Width.

Script

In the Script section you may enter commands to be executed. You may use the drop-down list and the
"Add" button or type directly in the text field. The topic Script Language  explains this in more detail.
See here a list of all commands . These ones  are available to control the Art-Net Snapshot Button
itself.
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18.3.2.8  Art-Net Recorder

The Art-Net Recorder button is designed to record a full Art-Net DMX universe over a certain time, with
the ability to record from Universe A and output to Universe B.
A click on the Art-Net Recorder and the captured Art-Net sequence is send out to the specified Universe.

Please note:
In order to use the Art-Net Recorder Art-Net Input and Art-Net Output needs to be enabled in the 
Connection Manager !

To edit the Art-Net Recorder parameters simply right-click on the Art-Net Recorder Button and choose
the menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on
it when being in the edit / move mode ([F9]). The Art-Net Recorder Property Dialog opens up.

1239
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ID:
The Art-Net Recorder’s ID may be changed by entering a new one in the text field top left.

Fix:
When the option “Fix” is checked, the Art-Net Recorder Button will be displayed on every page.

The Art-Net Recorder Property dialog is divided into three sections.

Recorder Settings

Subnet and Universe:
Enter the Subnet and Universe the Art-Net values should be recorded from.
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[Rec]:
Press [Rec] and the specified Universe will be recorded until you press the button again, that meanwhile
changes its name to [Stop].
To send out the Art-Net values on the same Universe they were recorded from, close the Item Properties
dialog and just press the Art-Net Recorder Button.
To send out these Art-Net values on a different Universe, do it as following:
Enter the Subnet and Universe the Art-Net values should be captured from.
Press [Rec] and the current state of the specified Universe will be recorded.
Press [Stop] to stop the recording.

Now change the Art-Net settings to the Universe on which you want to send out the recorded Art-Net
values (do NOT press [Rec] again) and press [OK] or [Apply] at the bottom of the Item Properties dialog.
Close this dialog and click on the Art-Net Recorder Button.

[|>] and [<|]:
With these two buttons you may browse through the recorded Art-Net sequence step by step.

[Play]:
Press [Play] to play the recorded Art-Net sequence.

[Pause]:
Press [Pause] to pause the recorded Art-Net sequence.

[Rewind]:
Press [Rewind] to bring the sequence to ist Inpoint.

[Loop]:
Activate this checkbox and the Art-Net sequence will be looped instead of played once.

In & Out:
Here you may define an In- and Output different from the originally reccorded sequence. To cut off 2
seconds from the beginning of the recording, enter “50” as inpoint (25 frames = 1 second).

[DMX Link Out]:
To play the recorded Universe via the DMX Link Out,  aktivate this checkbox. 
Please note that “DMX LINK Out” needs to be enabled in the Connection Manager .

Button Style

In the Button Style you may set up the button's text as well as its font and colour.
Three images can be assigned to the different states of the button.
“Release” refers to no click.
“Click” is on press.
“Highlight” can be used to draw a png with alpha over either the click or release image. 

You may also set the Buttons Height and Width.

Script

In the Script section you may enter commands to be executed. You may use the drop-down list and the
"Add" button or type directly in the text field. The topic Script Language  explains this in more detail.
See here a list of all commands . To control the ArtNet Recorder via commands itself, please use
these ones .
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18.3.2.9  Scroller

The Scroller is designed to change the X or Y position of assigned media files in your Pandoras Box
project, so that you can scroll through a certain amount of pictures. 

To edit the Scroller’s parameters simply right-click on the desired Scroller control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The Scroller Property Dialog opens up.

The property dialog is divided into two sections: the Scroller Style and the Scroller Control.
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ID:
The Scroller’s ID may be changed by entering a new one in the text field top left.

Fix:
When the option “Fix” is checked, the Scroller will be displayed on every page.

Scroller Style

Location:
To position the scroller enter here the Scroller’s X and Y Position (in px) or move it manually with the
mouse over the WD user interface when being in the edit / move mode [F9].

Control Size:
To adjust the Scroller’s size enter the desired values (in px) for Width and Height. Or scale the Scroller
manually with the mouse at its corner down right when being in the edit / move mode [F9].

Item Size:
Choose here how wide an item on the scroller should be. According to the width of the items you may
see more or less items on the Scroller’s interface. The Height of an item can’t be influenced here – it
always refers to the Height of the Scroller’s Size itself. To adjust the Height please change the Height for
the Control Size.

Relation of the Control / Item Size and the layers in Pandoras Box:

The size of an item influences the size of a layer inside Pandoras Box. To have a layer in Pandoras Box
(that is controlled via an Scroller Item) covering the whole output, the Scroller size has to cover the whole
Height of the WD interface. The Width of the Scroller does not necessarily have to cover the whole width
of the WD interface as long as the Item’s width gets the width resolution of the WD interface. 

Example 1:
The Scroller in this example controls layers 1
through 3 in Pandoras Box. As you see the
relation between the Scroller’s size and the size
of the whole WD interface is reflected in the
Pandoras Box output.

Example 2:
The Scroller’s location is now set to X/Y = 0/0
and the Scroller’s Height got the same Height the
WD interface covers (without adjusting any width
value). To bring the layer in Pandoras Box to
aspect ratio, at least the Width of the Scroller’s
Items has to be adjusted to the Width of the WD
interface, see next example.

Example 3a:
The Scroller now covers the whole WD interface.
The Item’s Width is set to half of the Scroller’s
Width.
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Example 3b:
The Scroller covers the whole WD interface. The
Item’s Width is set to the Scroller’s Width.

Orientation:
The Scroller can work horizontally and vertically, you may change its orientation here.

Damping:
The damping value influences the acceleration of the follow-up movement when the Scroller is released.
The default value is set to 2000. The minimum value is 0 (no follow-up movement), the maximum value is
10000 (longest follow-up movement).

Snap Mode
Without the Snap Mode enabled the Items will be moved over the Scroller as far as you scroll the
Scroller. When the Snap Mode is enabled and an Item is e.g.. moved about half of its width to the left,
the Scroller will automatically go on scrolling until the next Item snaps at the Scroller’s left border.

--> Distance: 
The distance value (in px) defines how far you have to scroll the scroller until the snap mode snaps to the
next Item. By default it is set to 0, so each small movement to the left or to the right will activate the
snap mode to snap to the next Item to the left or to the right. If the distance is set to e.g.. the value 100,
you have to scroll the scroller about 100 px to the left / right to let the snap mode snap to the next item
to the left/right.

--> Speed: 
The speed value defines how fast the scroller is scrolled to the next item when the snap mode is being
activated: 100= max. speed, 1 = min. speed.

Scroller Control

Site ID:
Enter here the Site ID of the site in Pandoras Box the Scroller should be linked to.

Display:
Please choose here the aspect ratio of the Pandoras Box output. This is important to bring the layers in
Pandoras Box to the correct aspect ratio, according to the Scroller Item sizes.

Range:
The range value defines how far a selected Scroller Item has to be moved in order to generate a click on
it, see explanation under Device / Click. The default value is 5, that means that within moving the Item 5
pixels to the left / right the Item won’t be clicked. This range function is useful not to activate an item by
fault.

Count:
Set here the amount of Items visible in the Scroller and controllable in Pandoras Box.

Gap:
You may increase or decrease the gap between each Item by entering a new value (in px). It ranges from
0 (=no gap) up to 2048 (=max. gap).

Device / Click:
Set here the PB Layer ID (Device ID) which should be linked to each Item inside the Scroller.
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Example:
Here the Count is set to 3, so only 3 Items are visible inside the Scroller
and only 3 layers in PB can be controlled through the Scroller Items.

The devices are set so that:
Item 1 controls Layer 3 of site 1,
Item 2 controls Layer 4 of site 1,
Item 2 controls Layer 5 of site 1.

To execute a command when an Item is clicked please enter the command in the Click text field. The
topic Script Language  explains commands and how to use them in more detail. 
As these small text fields do not offer a good overview when using multiple commands, working with 
macros  is a good option.
See here a list of all commands . To reset the Scroller via a command (bringing it back to display the
first Item), please use the following one:
WDScrollerReset,’ID’

18.3.2.10  Flipswitch Horizontal / Vertical

The Flipswitch is designed to execute scripts only when the control reaches the specified unlock
position.

To edit the Flipswitch’s parameters simply right-click on the desired Flipswitch control and choose the
menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it
when being in the edit / move mode ([F9]). The Flipswitch Property Dialog opens up.
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The property dialog is divided into two sections: Style and Control.

ID:
The Flipswitch’s ID may be changed by entering a new one in the text field top left.

Fix:
When the option “Fix” is checked, the Flipswitch will be displayed on every page.

Flipswitch Style

Location:
To position the Flipswitch enter here the Flipswitch ‘s X and Y Position (in px) or move it manually with
the mouse over the WD user interface when being in the edit / move mode [F9].

Control Size:
To adjust the Flipswitch’s size enter the desired values (in px) for Width and Height. Or scale the
Flipswitch manually with the mouse at its corner down right when being in the edit / move mode [F9].

Item Size:
Choose here how wide the handle-item on the Flipswitch should be. The height of an the item can’t be
influenced here – it always refers to the Height of the Flipswitch‘s Size itself. To adjust the height please
change the height for the Control Size.

Relation of the Control / Item Size and the linked layer in Pandoras Box:
The size of the handle item influences the size of the linked layer inside Pandoras Box. To have the layer
in Pandoras Box (that is controlled via the handle item) covering the whole output, the Scroller size has
to cover the whole height of the WD interface. The width of the Scroller does not necessarily have to
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cover the whole width of the WD interface as long as the Item’s width gets the width resolution of the WD
interface.

Orientation:
The Flipswitch can work horizontally and vertically, you may change its orientation here.

Inverse:
Tick the check box to bring the Flipswitch Item to the opposite border of the Control.

Relax Speed:
The Relax Speed defines how fast the Flipswitch Item will move back to its default position after it was
moved and the Click Script was NOT executed. The default value for the Relax Speed is 50. Decrease
this value to get a slower move, increase it to quicken it. 

Hold Time:
The Hold Time (in ms) defines how long the Item will stay on the position where the click script will be
executed before it jumps back to its default position.

Flipswitch Control

Device ID:
Set here the PB Layer ID (Device ID) which should be linked to the Flipswitch.

Example: 
With the Device ID 1 | 1 the Layer 1.1 in PB will be controlled.

Display:
Please choose here the aspect ratio of the Pandoras Box output. This is important to bring the layers in
Pandoras Box to the correct aspect ratio, according to the Flipswitch Item size.

Range:
The range value defines how far the Flipswitch Item has to be moved to the opposite border (in pixels).
The default value is 5, that means that within moving the Item 5 pixels to the border opposite the
Flipswitch Item the click script will be executed. This range function is useful to define how far the
Flipswitch Item has to be moved to execute the script.

Click Script:
To execute a command when the Flipswitch Item is moved into the click-area, please enter the
command in the Click Script field. You may use the drop-down list and the "Add" button or type directly
in the text field. The topic Script Language  explains this in more detail.
See here a list of all commands .

18.3.3  Digital Clock

Use this control to display the current time via a DigitalClock.

To edit the DigitalClock parameters simply right-click on the DigitalClock control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The DigitalClock Property Dialog opens up.
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The DigitalClock’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the DigitalClock will be displayed on every page.

Size
Enter a pixel size for the DigitalClock's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

You may design your DigitalClock using different colors for Background, Inside, Glow and Inactive,
you can also show or hide the border.

UTC Offset 

1642
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Enter here the time offset the DigitalClock should have from your computer's time.

Ui Effects & Animations 
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.926
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18.3.4  Displays

Angular Display
The Angular Display allows showing any numeric value that is routed to the Angular Display Output Node

.

Bar Graph
The Bar Graph allows showing any numeric value that is routed to the Bar Graph Output Node .

Digital Display
The Digital Display allows showing any numeric value that is routed to the Digital Display Output Node

.

Motion Mask
The Motion Mask Display allows using a DirectShow Video input to create a soft motion-detected Mask.
The MotionMask as well supports AirScan/Camera Point Tracker/Kinect & iPhone multi-touch input for
mask painting.

Video Input Display
Use the Video Input Display displaying a video source on the WD user interface or to send a Video
Snapshot  to Pandoras Box.
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18.3.4.1  Bar Graph

The BarGraph allows showing any numeric value that is routed to the Bar Graph Output Node .

To set up the BarGraph’s properties, simply right-click on the BarGraph and choose the menu entry
"Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being
in the edit / move mode ([F9]). The BarGraph Property dialog opens up.

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The BarGraph ’s ID may be changed by entering a new one in the text field top left. If you change it, you
will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

1193
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Fix
When the option “Fix” is checked, the BarGraph will be displayed on every page.

Size
Enter a pixel size for the BarGraph's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Direction
Set the orientation of the BarGraph to up, down, left or right. You may also want to edit the Edge
Radius.

Max / Min
Set the value range for incoming data using Max and Min.

Design the BarGraph for your own needs by choosing different type of colors (for background, Max,
Center and Min Colour). Max, Center and Min Color are only applicable when "Gradient" is checked.
Otherwise, the BarGraph will have only the Center Color.

Check "Glossy" to add a 3D gloss to the widget.

18.3.4.2  Digital Display

The DigitalDisplay allows to show any numeric value that is routed to the DigitalDisplay Output Node .

To set up the DigitalDisplay simply right-click on the display and choose the menu entry "Item
Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being in the
edit / move mode ([F9]). The DigitalDisplays Property dialog opens up.

1196
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The DigitalDisplay ’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the DigitalDisplay will be displayed on every page.

Size
Enter a pixel size for the DigitalDisplay's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Max / Min
Set the value range for incoming data using Max and Min. Enter the amount of digits.

Leading Zeros
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The option "Leading Zeros" fills all empty digits with zeros if amount of digits is smaller than the
maximum, e.g. "7" will be displayed as "007" if maximum value is set to 100.

You may design your DigitalDisplay using different colors for Background, Inside, Glow and Inactive,
you can also show or hide the frame.

Ui Effects & Animations 
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

18.3.4.3  Gauge

The Gauge allows showing any numeric value that is routed to the Gauge Output Node .

To set up the Gauge’s properties, simply right-click on the Gauge and choose the menu entry "Item
Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being in the
edit / move mode ([F9]). The Gauge Property dialog opens up.

926
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The Gauge’s ID may be changed by entering a new one in the text field top left. If you change it, you will
be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the Gauge will be displayed on every page.

Size
Enter a pixel size for the Gauge's size.
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X and Y
Enter the location of the widget (upper left corner) in pixels

Caption
Here, you can enter a label for the display, color and font can be selected with the respective buttons.

Resize Fonts
This features adjusts the fonts of caption and numbers when changing the size of the widget.

Background
An image can be loaded as a background. You can either browse your system for a picture or choose
one out of the Resource Manager .
It is also possible to set a background color and transparency.

You may design your Gauge using different colors for Center, Hand, Label, Major Ticks, Minor Ticks
and Border.
Tick the check boxes to hide / display the mentioned units. A decorative frame can be displayed as
well.

Degree / Range
Set Min and Max for Degree and Range to change the Gauge's size and range. Enter the amount of
steps for your range.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

18.3.4.4  Graph Display

The GraphDisplay allows showing the graphical procession of a value over time that is routed to the
Graph Display Output Node.

To set up the GraphDisplay ’s properties, simply right-click on the GraphDisplay and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The GraphDisplay Property dialog opens up.
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The BarGraph ’s ID may be changed by entering a new one in the text field top left. If you change it, you
will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the BarGraph will be displayed on every page.

Size
Enter a pixel size for the BarGraph's size.
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X and Y
Enter the location of the widget (upper left corner) in pixels

Max / Min
Set the value range for incoming data using Max and Min. If you checked "Automatic Min/Max", those
values are automatically to the incoming values.

X-/Y-Factor
Set here a factor to adjust the coordinate system by compressing or stretching the graph.

X-Axis
Enter here an offset for your X-axis.

Interval
If you check "Update Always", the graph is being constantly updated within the given interval.
Otherwise, it will only be updated on value change.

Background
An image can be loaded as a background. You can either browse your system for a picture or choose
one out of the Resource Manager . Additionally, you can define two different colors for a background
gradient by clicking on the two far right color buttons.

Title
Enter here a title that is displayed at the top of the GraphDisplay. Uncheck the box "Show Title" if you
want to remove the title bar.

Labels
The labels show the the current value as well as Min and Max. Check the box on the left to show the
data and set color and font with the respective buttons. Adjust the exactness of the displayed values
with the Decimal field.

Customize your GraphDisplay design by adjusting the Line Color and Thickness, the amount of Blur
for the line and the Axis Color, as well as the Opacity of the graph.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.
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18.3.4.5  Video Input Display

Use the Video Input Display to display a video source on the WD user interface or to send a Video
Snapshot  to Pandoras Box.

To set up the Video Input Display’s simply right-click on the display and choose the menu entry "Item
Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being in the
edit / move mode ([F9]). The Video Input Displays Property dialog opens up.

ID:
The Display’s ID may be changed by entering a new one in the text field top left.

Fix:
When the option “Fix” is checked, the Video Input Display will be displayed on every page.

Choose a Video Source from the list.

18.3.5  Drop Down List

A Drop Down List is a control element that allows to select one value from a series of predefined options.
First, the Drop Down List displays a single line, e.g. "Select a language". When the user clicks on the

950
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small down arrow, a list is displayed from which one entry can be chosen. Once this is done, Widget
Designer displays the chosen value and in addition returns an internal index number. For the above
depicted example, the operator gets the information that "French" and the index "1" has been chosen.
Note that the indexing starts with "0". Depending on this information further commands can be executed
accordingly. For example, Widget Designer toggles to a certain page with French labels or Pandoras
Box calls a cue with French content.

To create a Drop Down List choose "Create"->"Drop Down List". The mouse cursor changes to a
crosshair icon, indicating the create mode. To create one or multiple Drop Down Lists just left-click
anywhere on the empty main background window and you will see a new Drop Down List being assigned
and displayed. Right-click to quit the create mode.

To edit the DropDown List's parameters simply right-click on the desired DropDown List and choose the
menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it
when being in the edit / move mode ([F9]). The DropDown List property dialog opens up.

Name
A unique name can be entered to identify
the widget via the Object and Member
Notation . The default name is based
on the widget type and ID.

Page
This drop-down offers all available pages
to place the widget on.

ID
The DropDown List’s ID may be changed
by entering a new one in the text field top
left. If you change it, you will be asked if
you also want to adapt the name to the
new ID.

Notes
A short note can be added here. It is not
displayed outside the widget but can be
set and retrieved with the WidgetID.Note
property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the
DropDown List will be displayed on every
page.

Size
Enter a pixel size for the DropDown List's
size.

X and Y
Enter the location of the widget (upper left
corner) in pixels

Title
Enter the text that is displayed per default
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before the Drop Down List is opened.
To set this text back you can use the
command 
WDDropDownListSetText(ID,Text)

Font and Color
Pick a font setting and color for the
displayed text including the DropDown
Items.

Drop Down Items
Enter the items for the list to be displayed
when the Drop Down List is opened with
the down arrow.
The "Command List " lists all available
commands.

Selected Index
Choose here the selected item. 

Variable Source
Check this option and enter the name
from an existing array variable .

Group Values
This option is only available for the
Unlimited version and offers the possibility
to assign a group. Please refer to the
chapter Group Values  for more
information.

Ui Effects & Animations
CSS based effects and animations can be
applied to this widget. Please refer to the
topic Effects & Animations  for more
information.

Network Broadcasting

The NBS (Network Broadcast Service) allows transmitting and updating Faders, Labels and
CustomScript buttons etc. across multiple WD Designers instances on the network. To activate this
service, please refer to the Remoting dialog !

Enable Send
To send the DropDown List's state as broadcast into the network, you only have to check “Enable Send”.

Enable Receive
To receive values from other DropDown Lists, please check “Enable Receive”.

Now you have to specify which item should update your DropDown List:
Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the DropDown List through another DropDown List on the same Widget Designer) or a different computer
in the network. If you do not want to specify the computer but want to listen to all computers in the
network, enter “255.255.255.255”.

As next step specify the DropDown List you want to take the status from. This could be e.g.
“DropDown1” or “DropDown2”).
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Programming with Drop Down Lists

This is a short description how you can program with the DropDown List.

First of all there is a DropDownList Input node  which can be used to forward the chosen text and
index number to a following filter or output node.

Second, the DropDown control returns member values, allowing for example the following script. Please
find more information in the topic Object and Member Notation  .

If DropDownList1.Index = 1
{
Label1.Text = "Bonjour"
}

Lastly, the "Command List " lists all available commands.

18.3.6  Fader Controls

A fader can be created to control Pandoras Box device parameters or sequence parameters.

Choose between four kinds of faders:
Colour Picker
Encoder
Fader Vertical / Horizontal
Wheel Vertical / Horizontal

18.3.6.1  Color Picker

The ColorPicker allows you to choose a RGB / CMY color and its brightness. The values of this RGB /
CMY color can be transferred to the Color FX faders on a layer in Pandoras Box.

To edit the ColorPicker parameter simply right-click on the ColorPicker control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]).The ColorPicker property dialog opens up.

1081

1642

1506

979

981

984

988



980

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The ColorPicker ’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the ColorPicker will be displayed on every page.

Size
Enter a pixel size for the ColorPicker 's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Devices
Enter single or multiple devices the ColorPicker should effect. Separate multiple devices with a space
character (e.g.: "1.1 1.2 1.3")

Red / Green / Blue
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The ColorPicker can send its RGB values directly to an FX in Pandoras Box. Just enter the name of the
FX (as it is written in Pandoras Box) and the parameter name, i.e. the color, separated by a pipe
symbol.

Example:
RGB Multiply|Red
RGB Multiply|Green
RGB Multiply|Blue

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

18.3.6.2  Encoder

An Encoder can be created to control Pandoras Box device parameters or a sequence opacity,
additionally you can retrieve and set its value with nodes  and Object and Member Notation .

To edit the Encoder’s parameters simply right-click on the desired encoder control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The Encoder property dialog opens up.
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Name
A unique name can be entered to identify
the widget via the Object and Member
Notation . The default name is based
on the widget type and ID.

Page
This drop-down offers all available pages
to place the widget on.

ID
The Encoder’s ID may be changed by
entering a new one in the text field top
left. If you change it, you will be asked if
you also want to adapt the name to the
new ID.

Notes
A short note can be added here. It is not
displayed outside the widget but can be
set and retrieved with the WidgetID.Note
property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the
Encoder will be displayed on every page.

Size
Enter a pixel size for the Encoder's size.

X and Y
Enter the location of the widget (upper left
corner) in pixels

Wheel Style

Two images can be assigned to the
different parts of the Encoder, “Handle”
and “Background”.

Click on the "..." button to open a file
dialog where you can choose your path
and image. If you like to choose an image
from the Widget Designer "library", click
on the "Res" button. The Resource
Manager  opens where you can double-
click on the image of your choice. You
can also save custom images in the
Resource Manager to access them faster.
The small "x" at the right sets the default
image.
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Seq
Check this box to directly control the opacity of a Sequence and enter the respective sequence ID.

Invert
Check this box to invert your value.

Devices
Check the box on the right to send the Encoder value to a Device (layer) parameter. Enter the Site and
Device ID of the respective Device, multiple Devices can be entered too, with a white space as separator
(e.g.: "2.1 2.2 2.17)

Parameter
This drop-down offers you all available Device parameters of Pandoras Box. If you want to access an FX
parameter, use the FX name and the pipe symbol to specify it (e.g.: "RGB Multiply|Blue"). If the
parameter list does not show the desired parameter (in case that you use a custom device) simply type
in the name of the parameter here.

Minimum / Maximum
Enter here the minimum and maximum value your Encoder should have, as well as the Default position
of the handle.

Mouse Wheel Input
If you check this box, the Encoder will react to your mouse's scroll wheel when hovering over the widget.

Group Values
This option is only available for the Unlimited version and offers the possibility to assign a group. Please
refer to the chapter Group Values  for more information.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

Network Broadcasting

The NBS (Network Broadcast Service) allows to transmit and update Faders, Labels and Custom Script
Buttons across multiple WD Designers instances on the network.

To activate this service, please refer to the IP Configuration !

Enable Send
To send the Encoder values as broadcast into the network, you only have to check “Enable Send”.

Enable Receive
To receive values from other Encoders, please check “Enable Receive”.

Now you have to specify which item should update your Encoder:

Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the Encoder through another item on the same Widget Designer) or a different computer in the network.
If you do not want to specify the computer but want to listen to all computers in the network, enter
“255.255.255.255”.

As next step specify the item you want to take the values from. This could e.g. be “Encoder1” or
“Encoder2

Once all values are set, the Encoder is ready to be used or edited at any time.

1665

926

896



984

18.3.6.3  Fader

A Fader can be created to control Pandoras Box device parameters or a sequence opacity, additionally
you can retrieve and set its value with nodes  and Object and Member Notation .

To edit the fader's parameters simply right-click on the desired fader control and choose the menu entry
"Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being
in the edit / move mode ([F9]). The Fader Property dialog opens up.
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Name
A unique name can be entered to
identify the widget via the Object and
Member Notation . The default
name is based on the widget type and
ID.

Page
This drop-down offers all available
pages to place the widget on.

ID
The Fader’s ID may be changed by
entering a new one in the text field top
left. If you change it, you will be asked
if you also want to adapt the name to
the new ID.

Notes
A short note can be added here. It is
not displayed outside the widget but
can be set and retrieved with the
WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the
Fader will be displayed on every page.

Size
Enter a pixel size for the Fader's size.

X and Y
Enter the location of the widget (upper
left corner) in pixels

Seq
Check this box to directly control the
opacity of a Sequence and enter the
respective sequence ID.

Seq(INV)
Choose a second sequence to send
the inverse value to. This is especially
useful if you like to cross-fade two
sequences.

Invert
Check this box to invert your value.

Devices
Check the box on the right to send the
Fader value to a Device (layer)
parameter. Enter the Site and Device
ID of the respective Device, multiple
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Devices can be entered too, with a
white space as separator (e.g.: "2.1
2.2 2.17)

Parameter
This drop-down offers you all available
Device parameters of Pandoras Box. If
you want to access an FX parameter,
use the FX name and the pipe symbol
to specify it (e.g.: "RGB Multiply|
Blue"). If the parameter list does not
show the desired parameter (in case
that you use a custom device) simply
type in the name of the parameter
here.

The inverse Fader value can also be
assigned to device parameters.

Minimum / Maximum
Enter here the minimum and
maximum value your Fader should
have, as well as the Default position
of the handle.

Link To Fader
Enter here the ID of a second Fader,
this Fader should listen to. The actual
Fader can be used as it is, but as
soon as the linked Fader is moved, the
first one will follow.

Silent (Inactive)
Check this box if you temporarily want
to mute its output

Mouse Wheel Input
If you check this box, the Fader will
react to your mouse's scroll wheel
when hovering over the widget.

Fader Style

Two images can be assigned to the different parts of the Fader, “Handle” and “Background”.

Click on the "..." button to open a file dialog where you can choose your path and image. If you like to
choose an image from the Widget Designer "library", click on the "Res" button. The Resource Manager

 opens where you can double-click on the image of your choice. You can also save custom images
in the Resource Manager to access them faster. The small "x" at the right sets the default image.

With the Orientation parameter, you can set your Fader either vertically or horizontally. 

Group Values
This option is only available for the Unlimited version and offers the possibility to assign a group. Please
refer to the chapter Group Values  for more information.

Ui Effects & Animations

1309

1665



987

CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

Network Broadcasting

The NBS (Network Broadcast Service) allows to transmit and update Faders, Labels and Custom Script
Buttons across multiple WD Designers instances on the network.

To activate this service, please refer to the IP Configuration !

Enable Send
To send the faders values as broadcast into the network, you only have to check “Enable Send”.

Enable Receive
To receive values from other faders, please check “Enable Receive”.

Now you have to specify which item should update your fader:

Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the fader through another item on the same Widget Designer) or a different computer in the network. If
you do not want to specify the computer but want to listen to all computers in the network, enter
“255.255.255.255”.

As next step specify the item you want to take the values from. This could e.g. be “Fader1” or “Fader2

Once all values are set, the fader is ready to be used or edited at any time.
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18.3.6.4  Wheel

A Wheel can be created to control Pandoras Box device parameters or the sequence opacity,
additionally you can retrieve and set its value with nodes  and Object and Member Notation .

To create a wheel right-click anywhere on the empty main background window and go to
"Widgets">"Fader Controls">"Wheel Vertical" or “Wheel Horizontal”.

Once you have clicked on the last menu item the mouse cursor will change to a cross hairs
icon. This icon tells you that you are in the create mode.
To create one or multiple wheels just left click anywhere on the empty main background
window and you will see a new wheel being assigned and displayed.
The wheel may now be clicked on and moved up and down.

To edit the Wheel’s parameters simply right-click on the desired Wheel control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The Wheel property dialog opens up.
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Name
A unique name can be entered to identify
the widget via the Object and Member
Notation . The default name is based
on the widget type and ID.

Page
This drop-down offers all available pages
to place the widget on.

ID
The Wheel’s ID may be changed by
entering a new one in the text field top
left. If you change it, you will be asked if
you also want to adapt the name to the
new ID.

Notes
A short note can be added here. It is not
displayed outside the widget but can be
set and retrieved with the WidgetID.Note
property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the
Wheel will be displayed on every page.

Size
Enter a pixel size for the Wheel's size.

X and Y
Enter the location of the widget (upper left
corner) in pixels

Wheel Style

Three images can be assigned to the
different parts of the Wheel, "Frame",
“Handle” and “Background”.

Click on the "..." button to open a file
dialog where you can choose your path
and image. If you like to choose an image
from the Widget Designer "library", click
on the "Res" button. The Resource
Manager  opens where you can double-
click on the image of your choice. You
can also save custom images in the
Resource Manager to access them faster.
The small "x" at the right sets the default
image.
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With the Orientation parameter, you can
set your Wheel either vertically or
horizontally. 

Show Frame
Uncheck this box to hide the frame.

Seq
Check this box to directly control the opacity of a Sequence and enter the respective sequence ID.

Invert
Check this box to invert your value.

Devices
Check the box on the right to send the Wheel value to a Device (layer) parameter. Enter the Site and
Device ID of the respective Device, multiple Devices can be entered too, with a white space as separator
(e.g.: "2.1 2.2 2.17)

Parameter
This drop-down offers you all available Device parameters of Pandoras Box. If you want to access an FX
parameter, use the FX name and the pipe symbol to specify it (e.g.: "RGB Multiply|Blue"). If the
parameter list does not show the desired parameter (in case that you use a custom device) simply type
in the name of the parameter here.

Minimum / Maximum
Enter here the minimum and maximum value your Wheel should have, as well as the Default position of
the handle.

Mouse Wheel Input
If you check this box, the Wheel will react to your mouse's scroll wheel when hovering over the widget.

Group Values
This option is only available for the Unlimited version and offers the possibility to assign a group. Please
refer to the chapter Group Values  for more information.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

Network Broadcasting

The NBS (Network Broadcast Service) allows to transmit and update Faders, Labels and Custom Script
Buttons across multiple WD Designers instances on the network.

To activate this service, please refer to the IP Configuration !

Enable Send
To send the Wheel values as broadcast into the network, you only have to check “Enable Send”.

Enable Receive
To receive values from other Wheels, please check “Enable Receive”.

Now you have to specify which item should update your Wheel:
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Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the Wheel through another item on the same Widget Designer) or a different computer in the network. If
you do not want to specify the computer but want to listen to all computers in the network, enter
“255.255.255.255”.

As next step specify the item you want to take the values from. This could e.g. be “Wheel1” or “Wheel2

Once all values are set, the Wheel is ready to be used or edited at any time.

18.3.7  Input Box

The InputBox enables you, like the TextBox, to enter text and retrieve the string for further use with the
respective member  or node .

To edit the InputBox parameters simply right-click on the desired InputBox Widget and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The InputBox Property Dialog opens up.

Name

1642 1040
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A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The InputBox ’s ID may be changed by entering a new one in the text field top left. If you change it, you
will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the InputBox will be displayed on every page.

Size
Enter a pixel size for the InputBox 's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Font
Edit the InputBox text font and the font size by clicking on the button with the current font.

To change the text color click in the small box on the right side.

Background Color
Click the box to open a color picker dialog for the background color.

Show On-Screen Keyboard on click
Check this box to open the integrated on-screen keyboard as soon as a click is performed inside the
InputBox. This is especially useful for touch applications such as tablet PCs or touch monitors.

Is Password
This check box turns all entered characters to dot characters.

Max.Length
Enter the maximum length of the entered character string. "0" stands for an infinite number of
characters.

Execute script on Enter key
Enter a script that will be executed when the Enter key is pressed. Functions and Macros  are a good
option to manage large and sophisticated scripts.

Group Values
This option is only available for the Unlimited version and offers the possibility to assign a group. Please
refer to the chapter Group Values  for more information.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.
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18.3.8  Label

The Label control lets you add text labels to your user interface.

To edit the Label parameters simply right-click on the desired Label control and choose the menu entry
"Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being
in the edit / move mode ([F9]). The Label Property Dialog opens up.
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The CustomScript button’s ID may be changed by entering a new one in the text field top left. If you
change it, you will be asked if you also want to adapt the name to the new ID.

Notes

1642
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A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the CustomScript button will be displayed on every page.

Size
Enter a pixel size for the CustomScript button's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Label
Edit the label text by entering it in the text field.

Font
Edit the label font and the font size by clicking on the button with the current font.

To change the label text color click in the small box on the right side.

BG
The background color is transparent by default. If you want to underlay the text with a color, uncheck
“Transparent” and choose a color for the background by clicking in the small box.

Round
Check this box if you want to display floating point values with a reduced amount of digits. Enter the
desired amount of digits in the field at the right.

Drag Mode
If this box is checked, the Label can be dragged around in the GUI with the mouse in Run mode.

Flash
When this option “Flash” is checked, the label will flash (visible / not visible). The flash interval time is set
to 250 ms by default. To increase or decrease the flashing interval time, change the value here or use the
command WDLabelFlashInterval(ID,Value) .

Auto Resize Mode

Choose here one out of three modes to correlate the widget's size and the font:
Disabled: The size of the widget is adjustable, the text will not be adjusted automatically. Text that
overlaps the borders will not be displayed.
Font: The font will be adjusted automatically to the widget's size so that the text always fits in.
Control: The widget's size will follow the text, it cannot be adjusted manually except by setting the font
size.

The options "Disabled" and "Font" also offer the possibility to set the text alignment within the widget to
"Left", "Center" and "Right".

Display Time
Choose this option to display the local computer's time, either in the "24 Hours" or in the "AM/PM" 
format. An offset can also be set if necessary.

PB Timecode
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If a Pandoras Box is connected, the Label can be used to display the timecode of a sequence. Specify
the Sequence ID in the respective field and check "Use Backup" if you need to backup machine's
timecode instead of the main machine. Please see also the dialog PB Configuration .

Variable Source
If the value of a variable  should be displayed as label text, check the option “Variable Source” and
enter the name of the variable. If the variable’s value is going to be updated, the label text will be updated
as well.

If one of the options "Display Time", "PB Timecode" or "Variable Source" is checked, the Label's text will
be overwritten by those values.

Web Link URL
The Web Link section is of special interest when working with the  Web Server  feature, i.e. clicking
the Label in a web browser. Enter a URL e.g. "http://www.coolux.com" that your browser should call
when executing the On Click Script.
It is also possible to achieve a quick page change with the URL, simply enter a hash tag "#" and the
page name. E.g.: #Page2

On Click Script
Enter a script that will be executed when clicking on the Label. Functions and Macros  are a good
option to manage large and sophisticated scripts.

Network Broadcasting

The NBS (Network Broadcast Service) allows to transmit and update Faders, Labels and Custom Script
Buttons across multiple WD Designers instances on the network.

To activate this service, please refer to the IP Configuration !

Enable Send
To send the labels values as broadcast into the network, you only have to check “Enable Send”.

Enable Receive
To receive values from other faders, labels or Custom Script Buttons, please check “Enable Receive”.

Now you have to specify which item should update your label:

Enter the IP address of the computer you want to listen to. This could be the local computer (to control
the fader through another item on the same Widget Designer) or a different computer in the network. If
you do not want to specify the computer but want to listen to all computers in the network, enter
“255.255.255.255”.

As next step specify the item you want to take the values from. This could be a fader (e.g. “Fader1” or
“Fader2”), a label (e.g. “Label1” or “Label2”), or a Custom Script Button (e.g. “CustomScript1” or
“CustomScript2” – you will be able get its status: 1/0).

Group Values
This option is only available for the Unlimited version and offers the possibility to assign a group. Please
refer to the chapter Group Values  for more information.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.
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18.3.9  List View

A List View is a control element that displays data in a table with rows and columns. To fill the List View
with a new database, you can either import it from other sources (e.g. Microsoft Excel) or create it in
Widget Designer. Furthermore in WD, you can edit every cell, add new rows or columns, or use one of
the offered WD table operations. You can use the cell values for your Widget Designer programming,
e.g. through variables.

To create a List View choose "Create"->"List View". The mouse cursor changes to a crosshair icon,
indicating the create mode. To create one or multiple List Views just left-click anywhere on the empty
main background window and you will see a new List View being assigned and displayed. Right-click to
quit the create mode.

To edit the List View's parameters simply right-click on the desired List View and choose the menu entry
"Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being
in the edit / move mode ([F9]). The ListView property dialog opens up.

ID:
The List View's ID may be changed by entering a new
one.

Fix:
When the option “Fix” is checked, the List View is
available on every page.

Name:
Enter a new name to be displayed above the List View.

Column Names:
The command WDListViewSetColumnName,ID,-

Col,Name lets you assign name for columns.

Excel File and Worksheet:
In case you like to import an existing database from an
Excel Sheet, enter the path (or select one with the [...]
button) and select one of the loaded names from the
sheets. Please note that the file must be saved from
Microsoft Excel as an *.xls file!
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As an alternative to the xls-format, you can use the 
command WDListViewLoadCSVFile,ID,-

FileName,Separator to import data from a csv-file. 

Col / Row Start and End:
Pick the start and end column and row if you like to
import a Excel Sheet.

Auto-Reload and Reload Interval:
If you would like to update your database in a certain
interval, check the option "Auto-Reload" and enter the
time in seconds after which your data is updated.
Please note, that the Excel Sheet must be saved under
the same path.

Programming with List Views

This is a short description how you can program with a List View.

There are commands available that write a value, or set another property from a List View. The
description of all WDListView... commands  is included in the command list.
If you like to manually edit a cell value, simply right-click into the cell and enter the new value into the
small text field.

In addition there are various commands that read a value (or column/row) and write it into a(n array)
variable. Further, WD offers operations that calculate the sum or average from a column or row. Again,
the detailed description of all VGetListView... commands  is included in the command list.

Last, the List View control offers member values, allowing for example the following script. Please find
more information in the topic Object and Member Notation .

Listview1.Cell.1.1 = 1
Listview1.Cell.1.1 = var2
Listview1.Cell.1.1 = Math[6/2]

var3 = Listview1.Cell.1.1

18.3.10  Panel

See here the available panel types:
Drawing Canvas
MultiTouch Panel
XY Panel
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18.3.10.1  Drawing Canvas

The Drawing Canvas lets you draw with the mouse. It can be used as creative item on the WD interface
on the one hand. But the more interesting feature is to use it as live input in Pandoras Box, so that you
will be able to paint on screen from within Widget Designer.

Please note that a Direct Show capture device like the coolux DVI capture card needs to be installed on
the Pandoras Box Server/Player in order to use it as live picture / mask.

 

Item Properties:
To design the Pen and Background colors simply right-click on the Drawing Canvas control and choose
the menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on
it when being in the edit / move mode ([F9]).The item property dialog opens up.

ID:
The Panel’s ID may be changed by entering a new one in the text field top left.

Fix:
When the option “Fix” is checked, the Drawing Canvas will be available on every page.

Pen Size:
Choose here a different pen size by entering it or by using the arrows up and down.

Pen Colour:
You may change the pen colour by clicking in the small colored box. A new window opens where fixed
colors or user defined ones are available.

BG:
You may change the background colour by clicking in the small colored box. A new window opens
where fixed colors or user defined ones are available.

Clearing the drawing Canvas interface

To remote control the Drawing Canvas with commands e.g. in a Custom Script Button, these ones
are available:

1502
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18.3.10.2  Multitouch Panel

The MultiTouch Panel allows direct control of up to 48 layers in PB as interactive touch surfaces.

Any changes done to these items in the MultiTouch Panel (in the example above numbered 1-4), like
moving, scaling or rotating them will be applied to the Layers in Pandoras Box as well:

See here information about the Item Properties of the MultiTouch Panel .1001
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18.3.10.2.1  Multitouch Item Properties

To set up the properties of the MultiTouch Panel simply right-click in the GUI and choose the menu entry
"Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when being
in the edit / move mode ([F9]). The MultiTouch Dialog opens up. Don’t worry if this takes a bit longer than
opening the Item Properties of other controls.

The Item Properties dialog is divided into three different sections:
Panel Settings,  Device Settings  and PB Settings.

18.3.10.2.1.1  Panel Settings

ID:
The MultiTouch Panel’s ID may be changed by entering a new one in the text field top left.

Fix:
When the option “Fix” is checked, the MultiTouch Panel will be displayed on every page inside WD.

1001 1005 1009
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Fullscreen:
Check this option so that the MultiTouchPanel covers the full screen of your WD computer.

Display Mode:
Please choose between the Display Modes 4:3, 16:9 and 16:10, according to the aspect ratio of your
WD computer screen. This is needed to have the devices in the correct aspect ratio inside the
MultiTouch Panel.

Multi Site:
The Multi Site Mode allows controlling multiple Servers simultaneously. This is useful when virtual sites
can not be used. Check this option and enter the amount of Sites the position and scale data of the
MultiTouch Items should be routed to.

Example: 
MultiTouch Item 1 refers to Site1, Layer1. When Multi Site Mode with 2 Sites is enabled, the data of this
Item will now refer to Site1, Layer1 and Site2, Layer 1 as well.

Relaxed Drag:
When Relaxed Drag is enabled, an item will not stop hard at a position to which it was dragged, but it
will run out smoothly depending on the dragging speed. This option is active by default.

Example:

The Relax time (in ms) and the maximum Relax Delta (in px) may be adjusted in the text fields below
“Relaxed Drag”. The higher the Relax time, the longer the Item will be dragged. The Relax Delta defines
the max. distance in px the Item will be dragged.

Bounce:
When the Bounce Mode is enabled, an Item running out smoothly with relaxed drag will bounce back
from the display border and reverse its direction towards the display region.

Auto Z-Order:
When this option is checked, the selected item inside the MultiTouch Panel will automatically be placed
in front of other items inside Pandoras Box (if one item overlays another one). This option influences the
Z Position of the layer in PB the devices are linked to. Do not use Auto Z-Order, if you have assigned
non-default Z Positions to the layers manually.

Please note: this option is not working when controlling PB Players, as there is no Z Position available
for Player devices.
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Example:

Left: Item2 is in front of Item1.  Right: After selecting Item1 the Z Order changes and Item2 is behind
Item1.

Left and right: see this effect in PB.

Pan Mode:
The Pan Mode needs to be checked if you want to move items on the MultiTouch area or out of it by
clicking in the background and proceed a move there. This will then apply to all items that have the Pan
option enabled. 

Please note:
Pan is only working when option [Enable Mouse] is checked inside the MultiTouch Panel and when your
device (Mouse, Kinect, AirScan, Multitouchdevice etc.) controls the mouse of your WD computer.
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Example:

Pan-Mode is enabled for the MultiTouch Panel and for the Items 1, 2 and 3, but not for Item4.

The two pictures above show the result after clicking in the panel’s background and moving the mouse
over to the left side:

Item4 stays at its previous position while the Items 1,2 and 3 are moved to the left side as well.
The little + in the panel’s background shows you the PAN position.

Left / Right / Top / Bottom:
The values inside the text fields define how many percent the MultiTouch area can be moved in each
direction when PAN is enabled. 

Example:
If you change the value for Top and Bottom to 0 (%) you won’t be able to move the MultiTouch area up
and down, but only to the left and right side.

Input Sources:

Important notice regarding Multi-Touch Input on Win7: 
The Tablet Service must be active in order for Win7 to provide the multi touch data!

Enable Mouse:
Enable the mouse input if you want to use the mouse to control the MultiTouch items. 

Please note: 
The Mouse Input needs to be enabled when you want to use the Pan Mode!
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Enable Gestures:
Enable this option if you want to use Synaptics Touch Pads and Wacom Bamboo Devices.

Enable Touch:
Enable this option if you want to use touch devices like (Multi-)Touch Monitors.

Enable AirScan:
Enable this option if you want to use the AirScan .

Enable Kinect:
Enable this option if you want to use the Kinect .

Enable Camera Point Tracker:
Enable this option if you want to use the Camera Point Tracker .

Enable iPhone:
Enable this option if you want to use your iPhone with the Widget Designer Remote App to control the
MultiTouch items.

18.3.10.2.1.2  Device Settings

Check box in front of each line:
To enable items in the MultiTouch Panel, that will control a layer in Pandoras Box, you have to check
the small box in front of a line. To enable all possible 48 items at once, check the small box that is
located above all others.

Device (Site/Dev1/Dev2):
To link a MultiTouch Item to a layer in Pandoras Box, enter the Site ID (Site) and the Layer ID (Dev1). 

Example: If MultiTouch item 1 should control Layer 2 of site 1 (number in front of the Layer is 1.2),
please enter 1 in the first text field and 2 in the second one.

You may link a second layer to the same MultiTouch Item – for example a shadow that is on a separate
layer – enter the Layer ID into the Dev2 text field. 

Example: If MultiTouch item 1 should control Layer 4 and 5 of site 1, please enter 1 | 4 | 5.
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X Pos and Y Pos:
The X and Y position values are percentage values. 

Example:
Having an item (1) inside the MultiTouch Panel with the value 50 for X and Y Position means that its
center point is located at 50% of the whole Panel’s X and Y range. The center point of an item (2) with
the values X=0 and Y=25 is, according to this, located leftmost and in the upper quarter of the panel, see
image below at the left side.

As the whole MultiTouch Panel (no matter up to which size you scale it) always represents the visible
PB output area (if no Cam Z Position is changed) these values will be transferred 1:1 to the PB fullscreen
output, see image below at the right side.

Rotate:
The rotation value of an item (in °) can be entered manually in this text field.

The interactive rotation of an item will be achieved when using a multi-point / -touch device. 

Enter the Item with two touch points and change the angle between them, see picture below.

Please note: the option [Rotate] has to be enabled for this Item!



1007

Scale:
The scale of an item (in %) refers, same as the position values, to the whole MultiTouch Panel area and
therefore to the PB Output area. The item in the example below (left side) has the scaling value 30, so it
covers 30% of the width and the height. An item with the scaling value 100 covers the whole screen.

The interactive scaling of an item will be achieved when using a multi-point / -touch device. 

Enter the Item with two touch points and change the distance between them, see picture below.

Please note: the option [Size] has to be enabled for this Item!

Mouse Down / Up / Enter / Leave:

The MultiTouch Panel offers script processing for different mouse interactions.

“Mouse Down” is processed when a mouse left button down click on the item is done.
“Mouse Up” is processed when a mouse left button up click on the item is done.
“Mouse Enter” is processed when the mouse cursor enters the item.
“On Mouse Leave” is processed when the mouse cursor leaves the item.

Any command that is available from the command list  may be used, just enter it in the text field.
Multiple commands (i.e. one script) can be executed by delimiting every command with a carriage return
at the end of the command. As these small text fields do not offer a good overview when using multiple
commands, working with functions or macros  is a good option. The topic Script Language
explains commands and how to use them in more detail.

Zoom:
The Zoom option applies to the whole MultiTouch Panel and to all Items that have the Zoom option
enabled.

The interactive zooming will be achieved when using a multi-point / -touch device. 

Enter the MultiTouch Panel with two touch points and change the distance between them.

Please note: this only works for Items that have the option [Zoom] enabled. All other items will keep their
original size.
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Example: 

Item 1 and 2 have the Zoom option enabled, Item 3 doesn’t. 

So after zooming the MultiTouch Area with two touch points, the zoom is applied to Item 1 and Item 2.
Item 2 keeps its former size.

The Zoom factor may be changed via commands as well:
WDMultiTouchSetZoom,'ID','Zoomfactor'

Layer:
Please choose the Aspect Ratio for the item (4:3, 16:9 or 16:10), according to the aspect ratio of the file
assigned to the layer. This is needed to display the media file with its correct aspect ratio in Pandoras
Box.

If all media files on the layers in Pandoras Box have the same aspect ratio just check the small box on
top to apply this aspect ratio to all items.

Drag:
To move an item on the MultiTouch Panel you need to have the mouse clicked on this Item or place a
touch point on it. Moving the mouse / touch point will drag the Item. See example below.

Please note: The option Drag needs to be enabled for the Item.

1552
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Example: Dragging an Item.

Pan:
Enable Pan if you want to move an item on the MultiTouch area or out of it by clicking in the background
and proceeding a move there (instead of moving the item itself directly). This allows moving several items
that have the Pan option enabled at once. 
The Pan Mode in the Panel Settings as well as [Enable Mouse] needs to be checked!

--> See an example for Pan in the section “A. Panel Settings”!

Size:
Enable Size if you want to scale an item with a support device that provides two (mouse-) points (e.g.
the AirScan) instead of a single touch (e.g. the mouse). By changing the distance between the two
points you will increase or decrease the item’s scaling when the item is selected.

--> See an example for Size in the section “B. Device Settings” under the cue “Scale“!

Rotate:
Enable Rotate if you want to rotate an item with a support device that provides two (mouse-) points (e.g.
the AirScan) instead of a single touch (e.g. the mouse). By changing the angle between the two points
you will rotate the item clockwise or anti-clockwise when the item is selected.

--> See an example for Rotate in the section “B. Device Settings”!

18.3.10.2.1.3  PB Settings

[Store Defaults]:
Once the MultiTouch Panel is set up, you may want to store the current values as Default Values within
this WD Project. To do so, press [Store Defaults] or use the command WDMultiTouchStoreDefaults,'ID'

.

[Apply Defaults]:
To recall the default values for the MultiTouch Panel (see [Store Defaults] above) press [Apply Defaults]
or use the command WDMultiTouchApplyDefaults,'ID' .
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[Clear Inputs]:
In case that the network connection to the AirScan or another Remote input was lost while these devices
sent active touch points, the MultiTouch Panel can be cleared from these hanging touch points by
pressing [Clear Inputs].

PB X Offset / PB Y Offset:
If you need an offset for the X or Y position of all items in Pandoras Box please enter it here. The values
correspond to the position values used in Pandoras Box.

Example:
Item 1 is on position 50 (this corresponds to the X Pos value 32768 in PB, when being in non-centered
mode). Entering a PB X Offset of 200 changes this X Pos value from 32768 to 32968 in PB – the item in
the MultiTouch Panel stays at the same position.

PB X Factor / PB Y Factor:
To use the MultiTouch Panel with several Pandoras Box Outputs (e.g. with an softedge projection with 3
outputs in a line) the X and/or Y Factors have to be adjusted to assign the MultiTouch panel area to the
new screen dimension. 

By default the PB X/Y Factor is set to 1, so the MultiTouch Panel refers to only one PB fullscreen
output. 

See here an example how to assign the MultiTouch Panel area to a new screen dimension:

Having a softedge projection with 3 Pandoras Box outputs in a line, the PB X Factor has to be changed
to the new screen width (in the image above the new factor has to be 2.7). Otherwise you won’t be able
to position a MultiTouch Item on the left or right screen.

Link To Mouse:
The value 0 means that no MultiTouch item is linked to the mouse. If you change this value to e.g. 1,
Item 1 will be linked to the mouse until this entry is changed (manually or via commands). As long as
the item is linked to the mouse, it will follow the mouse over the MultiTouch Area although Drag is
disabled.

Relevant for this feature the following commands may be executed, from within the MultiTouch Panel or
from other controls like e.g. Custom Script Buttons:
WDMultiTouchLinkToMouse,'ID', 'ItemID'
WDMultiTouchLinkItemToMouse,'ID'
WDMultiMouseLinkPlay,'ID'
WDMultiMouseLinkLoop,'ID'
WDMultiMouseLinkPause,'ID'
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WDMultiMouseLinkStop,'ID'

Mouse Down / Up / Enter / Leave:
The MultiTouch Panel offers script processing for different mouse interactions, valid for the whole
MultiTouch area:

“Mouse Down” is processed when a mouse left button down click on the panel is done.
“Mouse Up” is processed when a mouse left button up click on the panel is done.
“Mouse Enter” is processed when the mouse cursor enters the panel.
“On Mouse Leave” is processed when the mouse cursor leaves the panel.

Any command that is available from the command list  may be used, just enter it in the text field.
Multiple commands (i.e. one script) can be executed by delimiting every command with a carriage return
at the end of the command. As these small text fields do not offer a good overview when using multiple
commands, working with functions or macros  is a good option. The topic Script Language
explains commands and how to use them in more detail.

Zoom:
Here you may change the Zoom factor that will be applied to all items having the Zoom option enabled. 
The factor can be changed via the command (WDMultiTouchSetZoom,'ID','Zoomfactor' ) as well.

Min / Max Zoom:
These adjustable values will allow you to limit the minimum and maximum zoom factor (in %).
--> See an example for using the Zoom in the section “B. Device Settings”!

Min / Max Rot:
The values (in degree) for minimum and maximum rotation allow you to set the amount of degrees the
items are allowed to be turned. This function is limited to maximum +/- 360 degree.
--> See an example for Rotate in the section “B. Device Settings”!

Min / Max Size:
Enter new values here (in %) in order to change the minimum and maximum size an item is allowed to
have.
--> See an example for Size in the section “B. Device Settings” under the cue “Scale“!

See here  the list of all commands that influence the MultiTouch Panel:

1542
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18.3.10.3  XY Panel

The XY Panel represents a graphical touch pad with relative or absolute value controls. 

To create an XY Panel right-click anywhere on the empty main background window and go to "Create"-
>"Panel"->"XY Panel"

Once you have clicked on the last menu item the mouse cursor will change to a crosshair icon.

This icon tells you that you are in the create mode.

To create one or multiple XY Panels just left click anywhere on the
empty main background window and you will see a new panel
being assigned and displayed.

The XY Panel can now be used by clicking inside of the panel
region and dragging the mouse around.

Next you will need to set up the properties of the newly built XY Panel control. To edit the XY Panel
parameters simply right-click on it and choose the menu entry "Item Properties", press [ALT+P] whilst
the mouse is hovering above it or double-click on it when being in the edit / move mode ([F9]). The XY
Panel Property Dialog opens up.
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The XY Panel’s ID may be changed by entering a new one in the text field top left.

To assign the XY Panel to one or multiple Pandoras Box devices enter the site and device ID in the
device text field. 

For example to control Server 1 Layer 1 and Server 2 Layer 2 enter "1.1 2.2"

You may assign different parameters to the X and Y axis by choosing the parameters from the drop-
down list. 

Default values are sent on page enter when the option “Reset Values On Page Change” is checked.

Depending on the mode you can either set a minimum or maximum value for absolute parameter control.

If you choose to use the relative mode then you might apply a factor to affect the strength of the value
increment based on the mouse input motion.

The parameter’s distance and angle are reserved for the AirScan & iPhone multi-touch input.
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Check “Mouse over Mode” if you want the panel to react on any mouse motion independent of the left
mouse button press.

This is in particular useful and depending on the settings of the attached touch screen driver.

“Show info” allows you to display the current values of the panel.

Script

The XY Panel offers script  processing for different mouse interactions.

“On Click” is processed when a mouse left button down click on the panel control is being performed by
the user.
“On Release” is processed when a mouse left button up click on the panel control is being performed by
the user.
“On Mouse Enter” is processed when the mouse cursor enters the panel control.
“On Mouse Leave” is processed when the mouse cursor leaves the panel control.

To enter commands you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.
See here a list of all commands .

18.3.11  Picture Box

The PictureBox control lets you add images on your user interface.

To edit the PictureBox parameters simply right-click on the desired Image control and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The PictureBox Property Dialog opens up.

1312
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The PictureBox ’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible

1642
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Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the PictureBox will be displayed on every page.

Size
Enter a pixel size for the PictureBox's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Resource
Click on the "..." button to open a file dialog where you can choose your path and image. If you like to
choose an image from the Widget Designer "library", click on the "Res" button. The Resource Manager

 opens where you can double-click on the image of your choice. You can also save custom images
in the Resource Manager to access them faster. The small "x" at the right sets the default image.

The image file will be copied to the project's data folder while saving.

Prevent Selection
Check this box to avoid selecting the widget. It then can't be selected when in moving mode, except with
a right-click directly on the PictureBox. Ticking this box also has the effect that the PictureBox 's Z-
position is being sent to the back.

Lock Size Ratio
If this box is checked, the current size ratio will be maintained, even if you change the size manually.

Restore original size
Click this button restore the image's original size. The original size can be displayed when hovering the
mouse over the the image's thumbnail.

Web Link URL
The Web Link section is of special interest when working with the  Web Server  feature, i.e. clicking
the PictureBox in a web browser. Enter a URL e.g. "http://www.coolux.com" that your browser should
call when executing the On Click Script.
It is also possible to achieve a quick page change with the URL, simply enter a hash tag "#" and the
page name. E.g.: #Page2

On Click Script
Enter a script that will be executed when clicking on the image. Functions and Macros  are a good
option to manage large and sophisticated scripts.

On Web Click Script
This script will be executed if the PictureBox is being clicked in a Web Client. When the box "Web
Script Only" is not checked, both "On Click Script" and "On Web Click Script" will be executed.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

1309
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18.3.12  Playlist WD

This chapter describes the Playlist in Widget Designer, for the Playlist in Pandoras Box , please
follow the link.

The WD Playlist in General

The Playlist widget offers the possibility to create a composition of different media files that playback in a
certain order on dedicated Pandoras Box Layers.
You can set up whether the chosen files cross-fade one after another or playback with a hard cut. The
playback order can be set to shuffle mode or simply from the beginning to the end whilst in both modes
you can set up jumps, e.g. when a certain file should always be played back after another one. The
Playlist assigns the media files to two alternating Layers, or rather Layer groups as the main media can
be played back with two overlays and an audio file. Last but not least, you can enter individual script
commands that should be executed when a file is played back.

As for all widgets, the Widget Designer script language offers commands that change certain widget
settings or functions. See here a list of the available WDPlaylist...  commands. All widgets can also
be controlled using the member notation .

Adding Files and Folders to the Playlist

When connected to a PB project (see dialog PB Configuration ), the tree view section from the
Playlist shows the files in the Project tab . If you changed something in PB, right-click in the tree view
section and choose "Refresh tree".
However, it is also possible to add, rename and delete files and folders from the PB project by working in
the WD Playlist only. Right-click in the tree view to open its menu and choose an according command.
Note that the check-box "Show Menu" in the Item Properties must be ticked. Note that you can also add
content from a remote computer by using the Web Server feature . This is explained in more detail
further down under "Adding and Uploading Files to the Pandoras Box Project" .

Now you can drag and drop graphic, video and audio files and entire folders into the Playlist.
(a) If you release the mouse anywhere under the existing list, a new item is generated at its end and it
gets the highest ID. Any item in the list can be identified by its ID which starts with 1 and counts up with
every new item.
(b) When you release the mouse on an existing folder, the selected item is added to the end of this
group. If a Playlist folder has the ID 9, its files will be 9.001, 9.002 etc. When adding a folder from the PB
project, WD asks whether you like to keep the items in a folder. Otherwise you can also choose to
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"Insert a folder" from the right-click menu in the Playlist, or to "Move to folder" when an item is selected.
(c) Lastly, you can release the mouse between two items (note the wide line). All IDs after the new item
as well as already created jump IDs will increase automatically.
Alternatively, you can right-click in the Playlist and say "Insert Item" and right-click the item to choose
"Edit cue".

Editing Existing Files and Folders

You can edit the Playlist as follows (note that the check-box "Editing Mode" in the Item Properties must
be ticked).
Double-click on the property of the item that you want to edit, e.g. the cell "Duration". Enter a new value
and press [ENTER].

Alternatively, you can right-click on the item and choose "Edit cue" which opens a dialog that offers even
more properties. All properties are explained below together with some commands from the right-click
menu.

ID and Renumber
As explained above, new files or folders get unique IDs. If you like to change the order from items in
most cases it is the fastest way to drag the item to its new place as WD renumbers all items
automatically. However you can also enter new IDs manually. Note that the right-click menu offers some
commands to "Renumber" items. 

Duration, Fade, Pre Roll and Show Total Duration
The Duration is the playback duration of the file including the fade time. Both times are displayed in the
hour:minutes:seconds format. The default duration of video and audio files is automatically adopted to
the file length. Graphic files are added with the "Default Length " set up in the Playlist Item Properties
dialog. If you like to set up a duration of one minute and 5 seconds, enter "1:05" or "65".
The Fade time is the duration where the opacity from one file drops from 255 to 0 and where two files
are visible at the same time. This is also available as a default option  in the Item Properties.
Use the Pre Roll time setting to start loading the next media from the hard disk before the Play cue.
This ensures a smooth playback and fade. If you notice that media files are loaded to late, e.g. graphics
with a large resolution, increase the Pre Roll time. Again, this is also available as a default option  in
the Item Properties.
If you like to know how long your Playlist will playback, right-click in the Playlist and choose "Show
total duration".
The duration of a sub folder is displayed automatically.

Name
The Name is only used internally and can be changed, e.g. for a better overview. Note that you can also
enter a Name for a folder.

Media, Audio, Overlay1 and Overlay2
Enter a project path, e.g. "PB Projectname\File.png" in the Media, Audio, Overlay1 and Overlay2 field.

Inpoint and Loop
Both options are only available in the "Edit cue" dialog and apply to the respective Media, Audio,
Overlay1 and Overlay2 media.
An Inpoint above 0 means that the file does not start at its beginning but at the Inpoint time.
With an activated "Loop" option the media starts to play from the beginning (i.e. the Inpoint time) in case
the duration is longer than the media length.

Mode
The "Edit cue" dialog offers a drop-down-list with three Cue Mode options. This is also available as a 
default option  in the Item Properties.

Continue: In Play Mode, one item plays after another and the layers fade.

1022
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Pause and hold: In Play Mode, only one item plays. When the duration of this item is over, the item
does not fade down, it stays visible (and loops if not deactivated).
The next item in order is assigned to the layer but the opacity is set to 0. Note that this item is
highlighted in dark cyan. The Playlist pauses. Once you hit the "Play" button, the item plays with an
immediate opacity value of 255 and is now highlighted in green. 

Pause and fade: In Play Mode, only one item plays and fades down before its duration is over.
The next item in order is assigned to the layer but the opacity is set to 0. Note that this item is
highlighted in dark cyan. The Playlist pauses. Once you hit the "Play" button, the item plays with an
immediate opacity value of 255 and is now highlighted in green.

Jump, JumpCount, JumpsLeft and Reset Jumps
Enter the ID from the file that should be played back after this item into the "Jump" field. If you like to
jump to this file twice before going on with the next one in order, enter "2" in the "JumpCount" field, enter
nothing for an endless routine. During Playback the field "JumpsLeft" displays the number of jumps that
are still going to happen. As soon as all jumps were executed, the number will be reset. If you like to
reset it manually, click the button "Reset Jumps" at the bottom of the Playlist. You can of course also
double-click the "JumpsLeft" field and enter a new number.

Script
Enter a command  into the list that should be executed with the playback of the according item. This
property is not available in the "Edit cue" dialog.

Start Date, End Date, Verify and Filter by date
You can limit the playback of an item to a time window between the Start Date and End Date that can
be entered in the "Edit Cue" dialog. If the current time is not in the time slot, the item is simply ignored.
In that case it can be displayed in italics if the "Verify" option is ticked. With the option "Filter by date"
from the Playlist's right-click menu you can toggle the visibility from verified items in order to see only
those files that are currently available.

Edit column Title
This command is offered when you right-click on one of the titles in the bar just above the list section,
e.g. Duration. You can rename each column.

Removing Files and Folders

If you like to remove a folder or a single item, right-click it and choose "Delete". Alternatively, a selected
item can be deleted with the [DEL] key. Click once on a list item to select it, note that the text is
displayed in white. You can also multi-select items by holding the [CTRL] or [SHIFT] key. 

Playing Back the Playlist in WD

The buttons below the Playlist allow to start, pause or stop the playback from the Playlist. If no item is
selected, the playback starts with the first available item from the list. If you like to start with a certain
one, you can either stop the Playlist first. Select the item with a left-click (or use the buttons "<<" /
">>") so that the item is displayed in white and click "Play". Otherwise you can also right-click the
according item and choose "Play cue" which is also possible during playback.
Per default, the items are played back one by one, starting at the top of the list and going down. The
right-click menu offers the command to switch to shuffle mode. Uncheck "Loop" in the right-click menu
or in the Item Properties if the Playlist should not play continuously. 

1319
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The currently playing file is highlighted in light green and is depicted next in the "Playing Now" section
together with a counting-up timer. During a fade when two items are visible, the fading item is highlighted
in dark green. The section "Playing next" shows a counting-down timer with the name in The file Above
the buttons you can see the section  Use the Play, Click once on a list item to select it, note that the
text is displayed in white.

Item Properties dialog

The Item Properties offer general widget settings, style options and other settings for the Playlist
including the to layer assignment for Pandoras Box.
Right-click in the Playlist and open the Item Properties. When you are in the Run Mode click to top or
bottom part of the Playlist as the list itself or the tree view open their menus with editing commands.
Alternatively you can toggle to the Create Mode and either double-click on a widget or use the shortcut
[ALT+P] to open the Item Properties dialog.

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The widgets’s unique ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID. Note the property member .

Visible
Uncheck the "Visible" option to hide the widget.

Fix
Check the option “Fix” to display the widget on every page. If the option is unchecked (again) the widget
is only displayed on the page chosen with the Page drop-down list.

Size
Enter the width and height for the widget in pixels.
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X and Y
Enter the position in pixels of the widget on the page in pixels. 0,0 is the top left corner of the Page and
the position refers to the top left corner of the widget.

Layer, Track and Overlays A/B
Enter the Site and Device IDs, e.g. "2.1" for Layer A and "2.2" for Layer B if the main media files from the
Playlist items should alternate between Layers 1 and 2 of Site 2 (e.g. a Player or Server). You can also
enter "2.1 2.2 2.3" if you like to share the media with multiple Devices. The "Track" refers to the audio
media and the Overlay fields to the according Overlay media files. 
Note that the B layers should be visible in front of the A layers, otherwise the "Cross-Fade" option might
be of interest.

Default Length
The default length applies to all media files e.g. graphics that have no own media length. Note that the
Fade time is included in the length.

Title
The Title is displayed above the Playlist and can be toggled on and off and renamed.

Path Filter
Per default, the tree view section shows the entire PB project path, with the Path Filter you can restrict it
to display only certain sub folders. For example, with "PB Projectname\Testpattern" all other folders in
the project "PB Projectname" than the one called "Testpattern" are invisible.

Editing Mode
The Editing Mode allows to edit items that are already part of the Playlist. You can edit an item by either
double-clicking a property or choosing "Edit cue" from the right-click menu.

Show Buttons
Deactivate this option to hide the lower button part of the Playlist (Play, Pause etc.).

Show Project Tree
Deactivate this option to hide the right tree view part of the Playlist.

Show Menu
Deactivate this option if a right-click in the list or tree view section of the Playlist should not display their
menus with editing commands but the context menu of WD.

Cross-Fade
The Cross-Fade option is deactivated per default which means that only the B layers fade up and down
whilst the A layers alternate their media files but keep a constant opacity of 255. If the A layers should
also fade up and down, i.e. if the layers should cross-fade, activate the option. This is especially useful
when some media files in the Playlist are partly transparent.
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Please note that changes in the Pre Roll Time, Fade Time and the Default Cue Mode do not affect items
that are already added to the Playlist!

Pre Roll Time and Fade Time
Please see above the explanation for "Duration, Fade, Show Total Duration" .

Default Cue Mode
Please see above the explanation for "Mode" .

Loop Cue List
Uncheck "Loop" in the right-click menu or in the Item Properties if the Playlist should not play
continuously.

In the section "UI effects & Animations" you can apply CSS based style effects to all widgets. For more
information please see the chapter Effects & Animations (Web Styles) .

Adding and Uploading Files to the Pandoras Box Project

If you perform a right-click in your Pandoras Box tree, a context menu will offer you some additional
options:

Add Media to Project
Opens an explorer dialog where you can choose a file to add
to the selected folder in the Pandoras Box project.

Create New Folder
Creates a new folder in the selected directory. A dialog will
ask you to enter the name of the new folder.

Delete Media from Project
Removes the selected item, folder or file, from the project.

Refresh Tree
Refreshes the tree if changes were made from outside

One special feature of the Playlist is an easy way to transfer files from an external computer to the local
machine and the direct import to Pandoras Box. To achieve this, simple access the Widget Designer
project with an external browser. Here  you can learn more about the Web Server feature.

In the browser, you will see the Playlist still containing the Pandoras Box tree. If you execute a right-
click on a folder there, you have the same options as in the main GUI. When you choose to add media,
a new dialog will open and offer you a possibility to browse the external PC for files. The progress bar
shows how much of the file is already transferred. If an error occurs, a respective message is displayed
in the upper left corner of the dialog. Multiple files can be selected and transferred at once.

If you transfer files directly to a Pandoras Box project, they will be physically copied to the Widget
Designer project's data folder (Data/Uploads) which will also automatically be created if it didn't exist
before. Both applications have to run on the same PC! 
In PB, the file is added to the selected project folder, but as usual only as a link. This link points to the
data folder of Widget Designer. Upon content spread, the file is copied physically to the PB clients.
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Browse
Opens a dialog to browse for files to upload.

Submit
The selected file is transferred to the data folder of Widget Designer and then added (as a link) to the
selected PB folder.

Abort
Aborts the current transfer process.

18.3.13  Shape

Shapes can be used for highlighting elements in the user interface, to group widgets, to subdivide areas
or simply as a decorative item.

To edit the Shape parameters simply right-click on the desired Shape Widget and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The Shape Property Dialog opens up.
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The Shape’s ID may be changed by entering a new one in the text field top left. If you change it, you will
be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the Shape will be displayed on every page.

Size
Enter a pixel size for the Shape's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

1642
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Style
You can choose one out of three designs: ellipse, rectangle and rounded rectangle

Fill Color
Check this box to activate the fill color, a color picker for changing the hue will open when you click on
the small box on the right.

Line Color
Check this box to activate the line color, a color picker for changing the hue will open when you click on
the small box on the right.

Line Size
Enter here the thickness of the outline in pixels.

Opacity
Enter the transparency for the widget, "255" equals not transparent at all while "0" means completely
transparent.

Corner
This parameter is only available for rounded rectangle Shapes and specifies the rotundity of the corners.
A value of "0" would be a straight rectangle, increasing the value leads to more rounded corners.

Prevent Selection
Check this box to avoid selecting the widget. It then can't be selected when in moving mode, except with
a right-click directly on the Shape. Ticking this box also has the effect that the Shape's Z-position is
being sent to the back.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.926
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18.3.14  Sticky Note

The StickyNote is a tool for adding short messages or instructions to the user interface. They are only
visible if enabled in the View menu  or by using [CTRL + ALT + N].

To write on the StickyNote, simply left-click on the widget and enter a text with the keyboard. 

To edit the StickyNote parameters simply right-click on the desired StickyNote Widget and choose the
menu entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it
when being in the edit / move mode ([F9]). The StickyNote Property Dialog opens up.

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.
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ID
The StickyNote ’s ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the StickyNote will be displayed on every page.

Size
Enter a pixel size for the StickyNote 's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Font
Edit the StickyNote text font and the font size by clicking on the button with the current font.

To change the text color click in the small box on the right side.

Background Color
Click the box to open a color picker dialog for the background color.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.
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18.3.15  Textbox

The TextBox widget allows you to add an editable text to remote control text assets within Pandoras
Box via the Textbox Input Node  and the PB Text Output Node .

To edit the TextBox 's font and color, first switch to the edit / move mode ([F9]) and then right-click on
the desired TextBox widget and choose the menu entry "Item Properties", press [ALT+P] whilst the
mouse is hovering above it or double-click on it when being in the edit / move mode ([F9]). The TextBox
property dialog opens up.

1138 1208
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The TextBox ’s ID may be changed by entering a new one in the text field top left. If you change it, you
will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the TextBox will be displayed on every page.

Size
Enter a pixel size for the TextBox 's size.

X and Y
Enter the location of the widget (upper left corner) in pixels
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Font
Edit the TextBox text font and the font size by clicking on the button with the current font.

To change the text color click in the small box on the right side.

Background Color
Click the box to open a color picker dialog for the background color.

Show On-Screen Keyboard on click
Check this box to open the integrated on-screen keyboard as soon as a click is performed inside the
TextBox. This is especially useful for touch applications such as tablet PCs or touch monitors.

Max.Length
Enter the maximum length of the entered character string. "0" stands for an infinite number of
characters.

Title
Enter here a title that is displayed at the top of the TextBox. Uncheck the box "Show Title" if you want to
remove the title bar.

Execute script on Enter key
Enter a script that will be executed when the Enter key is pressed. Functions and Macros  are a good
option to manage large and sophisticated scripts.

Group Values
This option is only available for the Unlimited version and offers the possibility to assign a group. Please
refer to the chapter Group Values  for more information.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

To link the TextBox to a Text asset in Pandoras Box, please use a Text Box Input Node and connect it
to a PB Text output node.

To change the text of a TextBox e.g. via a Custom Script Button, these commands  are available:

Dynamic script setup

With the following commands you can use a TextBox to hold and collect script snippets that could be
executed at any given time:
WDTextboxAppend(ID,Value)
WDTextboxNewline(ID)
WDTextboxExecuteAsScript(ID)

Imagine you want to build a signal router remote application.
You can use buttons to set the source selection and buttons to append the script code for the target
selections. A take button would use the entire script that is inside the TextBox and executes it as one
big dynamically created script.
This way it is much easier to create and react to certain conditions and logics that would require many
more nodes to be set up.
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18.3.16  Text Input

The TextInput control lets you add an editable text to remote control text assets  within Pandoras
Box.

Depending on the configuration of the TextInput control you may update dedicated text assets by
clicking on the Last Line and Next Line button. This way you may continuously update text assets line
by line or update the entire TextInput contents to the text asset on all connected Pandoras Box Client
systems.

To edit the TextInput parameters first switch to the edit / move mode ([F9]) and then right-click on the
desired TextInput control and choose the menu entry "Item Properties", press [ALT+P] whilst the mouse
is hovering above it or double-click on it when being in the edit / move mode ([F9]). The TextInput
Property Dialog opens up.

301
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Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The TextInput’s ID may be changed by entering a new one in the text field top left. If you change it, you
will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the TextInput will be displayed on every page.

Size
Enter a pixel size for the TextInput's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Text Asset FolderID.FileID
Define one or multiple Text Assets in PB this Text Input should be linked to. To do this please enter the
Folder and File IDs.

1642

1642



1033

Example:
To assign the Text Input to Server 1 Layer 1 and Server 1 Layer 2, enter: “1.1 1.2”.

Title
Enter here a title that is displayed at the top of the TextInput. Uncheck the box "Show Title" if you want
to remove the title bar.

Font
Edit the TextInput text font and the font size by clicking on the button with the current font.

To change the text color click in the small box on the right, to change the background color click on the
far right button.

Auto Update On Next/Last
This option will send text contents directly upon button press.

Update Selected Line / Update All Text
Choose between these two options to update only by line or complete text. If the "Update Selected Line"
mode is active, only the line highlighted in blue will be sent.

Ui Effects & Animations
CSS based effects and animations can be applied to this widget. Please refer to the topic Effects &
Animations  for more information.

To control the Text Input from e.g. a Custom Script Button, these commands  may be used.

18.3.17  Timecode

The Timecode control displays the timecode sent or received via a connected SMPTE Link device.
Set up the SMPTE Link device in the Connection Manager .

You may also route the sent / received SMPTE Timecode via the SMPTE Input Node  within the WD
Node System.

To design the timecode colors simply right-click on the Timecode control and choose the menu entry
"Item Properties”, press [ALT+P] whilst the mouse is hovering above it or double-click on it when being in
the edit / move mode ([F9]).]. The Timecode property dialog opens up.

926
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The Timecode’s ID may be changed by entering a new one in the text field on the top.

It allows you to choose the colour for the timecodes
- background,
- inside,
- glow,
- Inactive,
- background cell.

18.3.18  Tree View

The TreeView enables you to browse and manage data on your local PC or in your Pandoras Box
project, especially for easily retrieving file paths. It is also able to easily transmit files from an external
device to the local machine, using the TreeView in a web client.
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To edit the TreeView parameters simply right-click on the desired TreeView widget and choose the menu
entry "Item Properties", press [ALT+P] whilst the mouse is hovering above it or double-click on it when
being in the edit / move mode ([F9]). The TreeView Property Dialog opens up.

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

ID
The TreeView ’s ID may be changed by entering a new one in the text field top left. If you change it, you
will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the TreeView will be displayed on every page.

Size
Enter a pixel size for the TreeView 's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

Source

1642
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Choose between the computer's file system or the Pandoras Box project the Widget Designer is
connected to.

Root
Specify here a root of the displayed file tree, you can also click on the "..." button to choose a path from
the explorer. This parameter is only available if the source is set to "File System".

Background Color and Font
Click the box to open a color picker dialog for the background color.
Edit the TreeView text font and the font size by clicking on the button with the current font. To change
the text color click in the small box on the right side.

Title
Enter here a title that is displayed at the top of the TreeView. Uncheck the box "Show Title" if you want
to remove the title bar.

How to use the TreeView

The TreeView serves two purposes: file management and file path retrieval.

Retrieving a file path is quite quick: just select the respective file in the TreeView so that it is highlighted
in blue and get the path information with the SelectedPath member. 
You could then write the path information in a string variable or use it directly as parameter in a
command. Please refer to the chapter Object & Member Notation  for more information on the
member.

Local file management can be performed by right clicking on a file or folder in the TreeView, the opening
context menu depends on the selected TreeView source:

File System

Add File
Opens an explorer dialog where you can choose a file to
copy to the selected folder

Add File + Load to Pandora
Opens an explorer dialog where you can choose a file to
copy to the selected folder. The copied file will also
immediately be added to the Pandoras Box project if the
software is connected.

Create New Folder
Creates a new folder in the selected directory. A dialog will
ask you to enter the name of the new folder.

Delete Item
Deletes the selected item. If a folder is selected, it has to be
empty to be deleted.

Refresh Tree
Refreshes the tree if changes were made from outside

Pandoras Box

1642
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Add Media to Project
Opens an explorer dialog where you can choose a file to add
to the selected folder in the Pandoras Box project.

Create New Folder
Creates a new folder in the selected directory. A dialog will
ask you to enter the name of the new folder.

Delete Media from Project
Removes the selected item, folder or file, from the project.

Refresh Tree
Refreshes the tree if changes were made from outside

One special feature of the TreeView is an easy way to transfer files from an external computer to the
local machine and the direct import to Pandoras Box. To achieve this, simple access the Widget
Designer project with an external browser. Here  you can learn more about the Web Server feature.

In the browser, you will see the TreeView still containing the file system of the local machine or
Pandoras Box tree. If you execute a right-click on a folder there, you have the same options as in the
main GUI. When you choose to add a file or a media, a new dialog will open and offer you a possibility to
browse the external PC for files. The progress bar shows how much of the file is already transferred. If an
error occurs, a respective message is displayed in the upper left corner of the dialog. Multiple files can
be selected and transferred at once.

If you transfer files directly to a Pandoras Box project, they will be physically copied to the Widget
Designer project's data folder (Data/Uploads) which will also automatically be created if it didn't exist
before. Both applications have to run on the same PC! 
In PB, the file is added to the selected project folder, but as usual only as a link. This link points to the
data folder of Widget Designer. Upon content spread, the file is copied physically to the PB clients.

Browse
Opens a dialog to browse for files to upload.

Submit
As described above, if the TreeView displays the file system, the selected file is transferred to the
selected directory. In case it displays the Pandoras Box folder, the file is transferred to the data folder of
Widget Designer and then added (as a link) to the selected PB folder.

Abort
Aborts the current transfer process.

1662
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18.3.19  Video Player

The Video Player control lets you add a borderless Windows Media Player control to your interface.

To edit the Video Player parameters first switch to the edit / move mode ([F9]) mode and then right-click
on the desired Video Player control and choose the menu entry "Item Properties", press [ALT+P] whilst
the mouse is hovering above it or double-click on it when being in the edit / move mode ([F9]). The Video
Player Property Dialog opens up.

The Video Player’s ID may be changed by entering a new one on the top.

In the property dialog you can choose the file and set the size, volume and transport controls of the file.

Please note:
In order to control the Video Player control within your interface it is a best practice to create dedicated 
Custom Script Buttons  or use commands  in general to control the Video Player Control. The
Video Player related commands are these ones .

Please note that only those files can be played that are supported by your system. If additional codecs
are required you might need to download or install them from the codec vendor or distributor.

935 1312
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18.3.20  Web Browser

The WebBrowser control lets you add a borderless WebBrowser control to your interface.

To edit the WebBrowser parameters first switch to the edit / move mode ([F9]) and then right-click on the
desired  WebBrowser widget and choose the menu entry "Item Properties", press [ALT+P] whilst the
mouse is hovering above it or double-click on it when being in the edit / move mode ([F9]). The
WebBrowser Property Dialog opens up.

Name
A unique name can be entered to identify the widget via the Object and Member Notation . The default
name is based on the widget type and ID.

Page
This drop-down offers all available pages to place the widget on.

1642
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ID
The WebBrowser's ID may be changed by entering a new one in the text field top left. If you change it,
you will be asked if you also want to adapt the name to the new ID.

Notes
A short note can be added here. It is not displayed outside the widget but can be set and retrieved with
the WidgetID.Note property member .

Visible
Uncheck this box to hide the widget.

Fix
When the option “Fix” is checked, the WebBrowser will be displayed on every page.

Size
Enter a pixel size for the WebBrowser's size.

X and Y
Enter the location of the widget (upper left corner) in pixels

URL
Enter the URL which should be displayed in the WebBrowser.

If you want to add buttons to navigate to different URLs or to clear the cache info you may use
CustomScript buttons and these commands  to remote control the WebBrowser.

18.4  Nodes

The Nodes menu lists all node categories including all nodes you may create in Widget Designer Pro
and Ult, currently there are about 250 nodes available. This chapter includes general information about
the node system. 

"Search" helps you navigate to the correct menu and sub menu.

Input Nodes

Filter Nodes

Output Nodes

Script Nodes

Interaction Nodes

Composite Nodes

Here you can change the order of the nodes in the menu.

The node system in Widget Designer PRO allows to create custom logic routing of control data. For
example you achieve to...

- remote control a Pandoras Box Layer with a standard Joystick
- connect a sensor input to any Pandoras Box Layer Parameter
- receive Art-Net values from another device and map these to Midi output values

1642
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etc,... The list of possible scenarios is probably endless.
If you have never worked with a node based system, the way it works within Widget Designer is very
easy to learn.

The next chapter  informs you about the different types of nodes and how to create and work with
them. Then a small tutorial  follows.

There are different types of nodes: Inputs , Filters , Outputs  and the more advanced Scripts
and Interactions . The table below lists all available nodes. Additionally, you can create your own
custom node using all other types of nodes with the Composite Node.

More advanced users might need to enter incoming or outgoing values as string, decimal or hexadecimal
values, please find here the Syntax TCP- / UDP- / Serial Messages .
Another advanced technique is to control nodes via methods, which is explained in the chapter Object
and Member Notation .

Input Controls Colour Picker

Custom Script

Drop Down List

Encoder

Fader

Label

Media Control

Multi/Touch Item

Multi/Touch Panel Point

Page

Textbox

Wheel

XY Panel

Connections Art-Net

COM ASCII Stream

COM Port

COM Query String

COM Status

DMX Link In

Midi In

Midi Note Catch

OSC

Remote Touch Item

Sensor Link

SerialLink GPI

SMPTE Link

TCP

TCP ASCII Stream

TCP Query String

TCP Status

TrackScan

TrackScan Serial Link

UDP

1046

1049

1062 1152 1188 1223

1229

1052

1642

1062 1075

1083

1085

1116

1116

1121

1122

1127

1138

1150

1152

1069

1077

1076

1078

1081

1117

1118

1126

1131

1133

1135

1141

1142

1143

1145

1146

1147
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UDP ASCII Stream

UDP Data Parser

UDP Status

Devices Airbar

AirScan

AirScan Multi-Point

Black Box (BETA)

IPhone Remote

Jog / Fader Extension

Joystick

Kinect

Kinesys K2

Mouse

Natural Point Marker

ODSL 30

Phidgets InterfaceKit 0/16/16

Phidgets InterfaceKit 8/8/8

Phidgets HS Encoder (1047)

Space Navigator

Timax

Wii

File System Excel Reader

Text Reader

Watch Folder

Generic Audio

Audio Processor

Clock

Count Down

Counter

Generator

GPS

Ping

Random

Value

Variable

Pandoras Box Clip Remaining Time

Cue Remaining Time

Device Parameter

Layer Interaction

Sequence Timecode

Widget Device

Tools Camera Point Tracker

Email

Events

Face Tracking

Motion Detector

1148

1066

1067

1068

1071

1112

1113

1114

1114

1120

1125

1137

1140

1151

1139

1070

1075

1079

1080

1086

1128

1130

1149

1150

1127

1074

1082

1083

1085

1119
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RSS

SMS

Filter Add Relative

Angle Distance

Angle to Point

Compare

Damping
Prediction

Damping Timed

Delay

Delta

Dynamic Trigger

If

Is In Bounding
Box

Is In Range

Jitter Reduce

Math Nodes Abs

ACos

Add

ASin

ATan

Ceiling

Cos

Degree > Radians

Divide

Floor

Log

Modulo

Multiply

Percent

Power X̂ Y

Radians > Degree

Round

Sin

Sqrt

Subtract

Sum

Tan

Max

Min

Polar >
Rectangular

Prediction

1132

1136

1152 1155

1156

1157

1158

1159

1160

1161

1162

1168

1168

1169

1170

1170

1171

1171

1172

1172

1173

1174

1174

1175

1176

1176

1177

1178

1178

1179

1180

1180

1181

1163

1164

1165



1044

Range
Asymmetric

Range

Text Nodes Compare Text

Contains Text

Date To Text

Leading Zeros

RegEx Text

RegEx Compare

Text Combiner

Vector Distance 1D

Distance 2D

Distance 3D

Output Controls Angular Display

Bar Graph

Digital Display

Label

Graph Display

Fader

Textbox

Page

Video Player Time

Video Player Volume

Connections Art-Net

COM Port ASCII Stream

COM Port Message

DMX Link Out

Midi Note On/Off

Midi Raw Message

Midi Value

SerialLink

TCP Message

TCP ASCII Stream

UDP Message

UDP ASCII Stream

File System Excel Writer

Generic Mouse

Script

Variable

Value

Pandoras Box Device Control

Device Export To Sequence

Layer Control

Rotation Wrap

Layer Shuffle

Sequence Control

1167

1166

1182 1182

1183

1184

1185

1188

1188 1191

1193

1196

1198

1198

1218

1203

1222

1223

1192

1195

1194

1196

1199

1200

1201

1214

1216

1217

1219

1220

1197

1202

1212

1221

1221

1204

1206
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Sequence Seek

Text

Text Unicode

Scripts Action

COM

TCP

UDP

Phidget IR

Phidget RFID

1207

1208

1209

1223

1224

1225

1226

1227

1228
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18.4.1  Creating and Setting up Nodes

To create a node
a) open the node menu from the main menu bar...
b) click on the node symbol in the toolbar...
c) right-click anywhere in the empty main background and open the Widgets menu there...
c) use the keyboard shortcut Alt+N whilst you are in the edit / move mode ...

...and choose the desired node. The nodes are attributed to five node types: Inputs , Filters ,
Outputs , the more advanced Scripts  and Interactions  and additionally the customizable
Composite Node. Some categories are sub-divided once more in order to make it easier and faster to
find the nodes you are looking for. The table on the previous  page lists all categories and nodes. If
you know how your node is called, it may be faster to click on "Search" and start typing, the drop-down
will suggest possible nodes to you.

Node types

Input nodes provide numeric or text based input values.
For example the Mouse or Joystick Input node provides you with an X&Y value.
This value might be related to screen coordinates based on your local display resolution 1920x1080.

Filter nodes are used between Input and Output nodes, they recalculate the input value.
For example you might want to map the mouse motion to the 16bit value range of a layer in Pandoras
Box between -8 and +8.
To resolve this you simply connect a Range Filter node to the Mouse Input and tell the Range Filter to
recalculate the range from {0 to 1023} to {-8 to +8}. This is all it takes, this example is described step-
by-step in this short tutorial .

Output nodes are used to send values out.
They receive an incoming value (from Input nodes directly or Filter nodes) and -according to their
category- send them to another external device, or to Pandoras Box, or to a widget used in Widget
Designer itself.
For example, you if you connect a Range Filter node with a Layer Output node, you can set up in the
Layer Output node that the Range value should be send to the X Position parameter of a given layer.

Script nodes execute your customized script; they are triggered through a certain action.
They cannot be linked to other nodes, they are stand-alone. One could also say they are a fixed
combination of an Input node to several Script Output nodes. This makes them very performance saving.
In detail, Script nodes execute directly customized scripts as soon as a chosen action happens within
Widget Designer. This can be, for example, a certain ASCII or Byte value coming in through the local
COM port. One single Script node would combine one ASCII value with the first script and another ASCII
value with another script and so on. Another type of (incoming) trigger can be an Action (e.g. a button is
clicked, a fader changes the value etc.) or even a Gesture (e.g. Swipe Up) that is recognized in a tool
like the AirScan.

Interaction nodes execute an underlying application that enables to interact with a remote system. 
They cannot be linked to other nodes, they are stand-alone. Each Interaction node has a special function
that would require a complex node and command combination. For example:
- they send the mouse or touch events happening on the local system to another system, or
- they use the local mouse or touch events to draw on a Canvas Asset , or
- they watch a folder on the local hard drive and add new files to a Pandoras Box project plus append it
to a Playlist

Composite Nodes are especially useful if certain combinations of nodes are being used multiple times,
for reducing complexity or for distribution of node-based solutions of any kind. As you can create your
own customized node containing a composition of nodes and widgets, this feature offers high flexibility.

1062 1152

1188 1223 1229

1040

1049

273

236
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Once you have chosen a node, the mouse cursor
will change to a crosshair icon, telling you that
you are in the operating mode  called "create
mode". Wherever you left-click now, the chosen
node is generated. You may click again, to
generate a second node from the same type.

The small number in the upper left corner is the
node`s ID.

If you want to configure the newly built node,
simply double-click it, or right-click on it and
choose "Configure Node...".

The node's configuration dialog opens up. The left
image depicts the configuration of a Range Node

. (It is already set up with example values.)

Here you can set up the static parameters and
everywhere you see a drop-down list you may
choose to pick a source node value output or
enter a static numeric value into the text field of
the combo box directly.

In many nodes you will notice little index
numbers next to the input fields. These index
numbers are important if you wish to remote
control a node source or node value via
commands from any other element such as a
Custom Script Button or external remote or other
output script node. This makes the node system
very dynamic and lets you design systems that
can change their behavior based on specific input
parameters and controls.

To connect two nodes with each other first
switch to the edit mode by pressing [F9] (the
mouse cursor differs from the standard mouse
icon). Now, left-click and drag the source node
output pin to the target node and release the left
mouse button.

The connection between the node is now
displayed as a gray line.

It is possible as well to connect nodes on
different pages.

899

1166
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To achieve this press [Page-Up] or [Page-Down]
on your keyboard when dragging the connect
node line to navigate to the desired page.

To delete a single connection between two
nodes, switch to the edit / move mode and select
the Node Connection by clicking on it. The Node
Connection turns blue. Now press [Delete] on
your keyboard to delete the Node Connection
and confirm the upcoming pop up dialog.

Multiple connections can be selected with a
selection frame (left-click and drag).

Removing connections does not reset all node
values. Some node parameters are not based on
source node values and can be set manually.

To copy and paste nodes, you have to be in the
edit / move mode [F9]. To copy a single node,
just click on it or drag a window across it. 
To select multiple nodes, hold [CTRL] pressed
while clicking on the nodes or drag a window
across all the nodes. Once selected, the nodes
may be copied (CTRL+C) and pasted (CTRL+V)
within the Widget Designer Project.

All Node Properties will also be copied, as long
as the Node Sources are copied as well. This
means also, that copied Input Nodes will not
have any connections attached, in opposition to
Filter and Output Nodes which will automatically
be connected to the same Input Node(s) as the
original.

To set up the properties of the node (= the node's
look, i.e. Text and background color as well as
Protection Settings), 

In addition to the Config dialog there is also an
Item Properties dialog. Right-click on the node
and choose the menu entry "Item Properties" or
press [Alt + P] whilst having it selected. The left
depicted dialog opens up.

Now you can change various settings like the
text of the node or its background color. The
Name is of interest when using the member
notation . You can also set up Protection
Settings .

1642
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18.4.2  Tutorial: Nodes

Please see here a little example of how to map the X and Y position of a layer in Pandoras Box to a
mouse cursor. Moving the mouse cursor to the left /right /upper or lower screen side should result in also
moving the layer left / right / up or down.

At first please make sure that the IP Configuration  of your Widget Designer is set up correct to
control Pandoras Box.

Create three different types of nodes:
- one Mouse Input Node ([ALT+N] > Input
> Devices > Mouse),
- two Range Filter Nodes (one for the
translation of the X position, one for the
translation of the Y position) ([ALT+N] > 
Filter > Range),
- one Layer Control Output Node.

Whilst being in the edit / move mode [F9],
connect the nodes as depicted.
The range nodes will be the translators
between the mouse cursor X and Y
position data and the X and Y Position
values in Pandoras Box. Now, we need to
find out what input range needs to
converted to what output range.

Double-click on the Mouse Node to open
the Node Configuration. Now the cursor
positions are shown.

When your mouse cursor is at the left
border of your screen, the mouse X
Position shows 0 (at the right border e.g.
1023 is shown, this depends on your
screen resolution).

896
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Now, we have a look at the Preview window
of Pandoras Box Software. Here Layer 2
(the scaled black and white image) is
moved to the left side, the X position value
for this position is - 5.8 (according to this,
when the layer is moved to the right side,
the X Position value is +5.8. If you prefer to
have the center of the image at the
screens border, use -/+ 8 as 16 generic
units correspond to one screen width. 

The Range Filter Nodes allow to map the
mouse position data to Pandoras Box
Layer Position data.

We start with the first Range Node that we
set up to map the X position. Please
double-click on the first Range Node.

Choose "Mouse X Pos" from the list as
Input. 
The Input Min and Input Max text fields are
related to your mouse cursor X position. 
For Input Min enter the min mouse X
position value (keeps the value 0), assign
the max mouse X position value for Input
Max (read it from mouse input node
properties, when your mouse cursor is
moved to the right side of your screen).

Output Min and Max are related to Layer 2
in Pandoras Box. 
For Output Min enter the value -5.8 (value
is read out of Pandoras Box Layer 2 X
Position, when the layer is moved to the
left side of the screen) and for Output Max
enter +5.8 (layers X position value at the
right side of the screen). Press Apply /
OK. The filter node properties should look
like the left example.

After preparing the translation of X position,
the second range filter node needs to be
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set up for translation of Y position.
The mouse cursor at top of the screen
delivers Y position value 0, at the bottom of
the screen it delivers Y position value 767
(according to your screen size).
The Layer in Pandoras Box gets the
following values in this example: Y position
on top of the screen is 4.2, Y position on
bottom of the screen is -4.2.

The last thing to do is setting up
the Layer Control Output Node.
Right-click on it and choose Item
Properties.

Enter the Layer ID on top of the
dialog. In the first text field enter
the site ID, in the second text field
enter the layer ID.
Tick the check box next to X Pos
and choose the Range Output from
the list, that is set up for the X
position. 
Tick the check box next to Y Pos
and choose the Range Output from
the list, that is set up for the Y
position. 
Press Apply / OK.

Move your mouse cursor and the
layer now will be mapped to it
(make sure you are in the run
mode [F8]).
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18.4.3  Syntax TCP- / UDP- / Serial Messages

Via TCP-, UDP- and COM Port nodes incoming or outgoing values can be entered as string, decimal or
hexadecimal values.

Example:
Let’s say, you would like to express a “Carriage Return” at the end of other values. This control character
is used in many codes as a command to move to a new line. On a normal keyboard you have the
possibility to press the key [Carriage Return], also known as the return key or enter key, the operating
system understands this automatically and translates it into the correct code. When writing strings in
ASCII or decimal or hexadecimal language you need to translate the command yourself. Please see the
DEC HEX ASCII Table below to find the code for the character.

Use [d13] to enter a carriage return as a decimal value.
Use [h0D] to enter a carriage return as a hexadecimal value.
Use [CR] to enter a carriage return as a ASCII symbol.

Please note: Mostly, you need a “Line Feed” command as well. For two commands you may use this
syntax: [d13 d10] respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example
String[CR d10].

Command in a Custom Script Button that sends a
string via a TCP connection

Displayed string

TCPSend,1,Hello world, how are you ? Hello world, how are you ?

TCPSend,1,Hello world,[CR LF]How are you [d191]
Hello world,
How are you ¿

DEC HEX
ASCII
Symbol

Description

0 0 NUL Null char

1 1 SOH Start of Heading

2 2 STX Start of Text

3 3 ETX End of Text

4 4 EOT End of Transmission

5 5 ENQ Enquiry

6 6 ACK Acknowledgment

7 7 BEL Bell

8 8 BS Back Space

9 9 HT Horizontal Tab

10 0A LF Line Feed

11 0B VT Vertical Tab

12 0C FF Form Feed

13 0D CR Carriage Return

14 0E SO Shift Out / X-On

15 0F SI Shift In / X-Off

16 10 DLE Data Line Escape
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DEC HEX
ASCII
Symbol

Description

17 11 DC1 Device Control 1 (oft. XON)

18 12 DC2 Device Control 2

19 13 DC3 Device Control  3 (oft. XOFF)

20 14 DC4 Device Control 4

21 15 NAK Negative Acknowledgement

22 16 SYN Synchronous Idle

23 17 ETB End of Transmit Block

24 18 CAN Cancel

25 19 EM End of Medium

26 1A SUB Substitute

27 1B ESC Escape

28 1C FS File Separator

29 1D GS Group Separator

30 1E RS Record Separator

31 1F US Unit Separator

32 20   Space

33 21 ! Exclamation mark

34 22 "  Double quotes (or speech marks)

35 23 # Number

36 24 $ Dollar

37 25 % Procenttecken

38 26 & Ampersand

39 27 ' Single quote

40 28 ( Open parenthesis (or open bracket)

41 29 ) Close (or close bracket)

42 2A * Asterisk

43 2B + Plus

44 2C , Comma

45 2D - Hyphen

46 2E . Period, dot or full stop

47 2F / Slash or divide

48 30 0 Zero

49 31 1 One

50 32 2 Two

51 33 3 Three
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DEC HEX
ASCII
Symbol

Description

52 34 4 Four

53 35 5 Five

54 36 6 Six

55 37 7 Seven

56 38 8 Eight

57 39 9 Nine

58 3A : Colon

59 3B ; Semicolon

60 3C < Less than (or open angled bracket)

61 3D = Equals

62 3E > Greater than (or close angled bracket)

63 3F ? Question mark

64 40 @ At symbol

65 41 A Uppercase A

66 42 B Uppercase B

67 43 C Uppercase C

68 44 D Uppercase D

69 45 E Uppercase E

70 46 F Uppercase F

71 47 G Uppercase G

72 48 H Uppercase H

73 49 I Uppercase I

74 4A J Uppercase J

75 4B K Uppercase K

76 4C L Uppercase L

77 4D M Uppercase M

78 4E N Uppercase N

79 4F O Uppercase O

80 50 P Uppercase P

81 51 Q Uppercase Q

82 52 R Uppercase R

83 53 S Uppercase S

84 54 T Uppercase T

85 55 U  Uppercase U

86 56 V Uppercase V
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DEC HEX
ASCII
Symbol

Description

87 57 W Uppercase W

88 58 X Uppercase X

89 59 Y Uppercase Y

90 5A Z Uppercase Z

91 5B [ Opening bracket

92 5C \ Backslash

93 5D ] Closing bracket

94 5E ^ Caret - circumflex

95 5F _ Underscore

96 60 ` Grave - accent

97 61 a Lowercase a

98 62 b Lowercase b

99 63 c Lowercase c

100 64 d Lowercase d

101 65 e Lowercase e

102 66 f Lowercase f

103 67 g Lowercase g

104 68 h Lowercase h

105 69 i Lowercase i

106 6A j Lowercase j

107 6B k Lowercase k

108 6C l Lowercase l

109 6D m Lowercase m

110 6E n Lowercase n

111 6F o Lowercase o

112 70 p Lowercase p

113 71 q Lowercase q

114 72 r Lowercase r

115 73 s Lowercase s

116 74 t Lowercase t

117 75 u Lowercase u

118 76 v Lowercase v

119 77 w Lowercase w

120 78 x Lowercase x

121 79 y Lowercase y
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DEC HEX
ASCII
Symbol

Description

122 7A z Lowercase z

123 7B { Opening brace

124 7C | Vertical bar

125 7D } Closing brace

126 7E ~ Equivalency sign - tilde

127 7F   Delete

128 80 € Euro sign

129 81    

130 82 ‚ Single low-9 quotation mark

131 83 ƒ Latin small letter f with hook

132 84 „ Double low-9 quotiation mark

133 85 … Horizontal ellipsis

134 86 † Dagger

135 87 ‡ Double dagger

136 88 ˆ Modifier letter circumflex accent

137 89 ‰ Per mille sign

138 8A Š Latin capital letter S with caron

139 8B ‹ Single left-pointing angle quotation

140 8C OE Latin capital ligature OE

141 8D    

142 8E Ž Latin capital letter Z with caron

143 8F    

144 90    

145 91 ‘ Left single quotation mark

146 92 ’ Right single quotation mark

147 93 “ Left double quotation mark

148 94 ” Right double quotation mark

149 95 • Bullet

150 96 – En dash

151 97 — Em dash

152 98 ˜ Small tilde

153 99 ™ Trade mark sign

154 9A š Latin small letter S with caron

155 9B ›
Single right-pointing angle quotation
mark
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DEC HEX
ASCII
Symbol

Description

156 9C oe Latin small ligature oe

157 9D    

158 9E ž Latin small letter z with caron

159 9F Ÿ Latin capital letter Y with diaeresis

160 A0   Non-breaking space

161 A1 ¡ Inverted exclamation mark

162 A2 ¢ Cent sign

163 A3 £ Pound sign

164 A4 ¤ Currency sign

165 A5 ¥ Yen sign

166 A6 ¦ Pipe, Broken vertical bar

167 A7 § Section sign

168 A8 ¨ Spacing diaeresis - umlaut

169 A9 © Copyright sign

170 AA ª Feminine ordinal indicator

171 AB « Left double angle quotes

172 AC ¬ Not sign

173 AD Soft hyphen

174 AE ® Registered trade mark sign

175 AF ¯ Spacing macron - overline

176 B0 ° Degree sign

177 B1 ± Plus-or-minus sign

178 B2 ² Superscript two - squared

179 B3 ³ Superscript three - cubed

180 B4 ´ Acute accent - spacing acute

181 B5 µ Micro sign

182 B6 ¶ Pilcrow sign - paragraph sign

183 B7 · Middle dot - Georgian comma

184 B8 ¸ Spacing cedilla

185 B9 ¹ Superscript one

186 BA º Masculine ordinal indicator

187 BB » Right double angle quotes

188 BC ¼ Fraction one quarter

189 BD ½ Fraction one half

190 BE ¾ Fraction the quarters
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DEC HEX
ASCII
Symbol

Description

191 BF ¿ Inverted question mark

192 C0   Latin capital letter A with grave

193 C1 Á Latin capital letter A with acute

194 C2 Â Latin capital letter A with circumflex

195 C3 Ã Latin capital letter A with tilde

196 C4 Ä Latin capital letter A with diaeresis

197 C5 Å Latin capital letter A with ring above

198 C6 Æ Latin capital letter AE

199 C7 Ç Latin  capital letter C with cedilla

200 C8 È Latin capital letter E with grave

201 C9 É Latin capital letter E with acute

202 CA Ê Latin capital letter E with circumflex

203 CB Ë Latin capital letter E with diaeresis

204 CC Ì Latin capital letter I with grave

205 CD Í Latin capital letter I with acute

206 CE Î Latin capital letter I with circumflex

207 CF Ï Latin capital letter I with diaeresis

208 D0 Ð Latin capital letter ETH

209 D1 Ñ Latin capital letter N with tilde

210 D2 Ò Latin capital letter O with grave

211 D3 Ó Latin capital letter O with acute

212 D4 Ô Latin capital letter O with circumflex

213 D5 Õ Latin capital letter O with tilde

214 D6 Ö Latin capital letter O with diaeresis

215 D7 × Multiplication sign

216 D8 Ø Latin capital letter O with slash

217 D9 Ù Latin capital letter U with grave

218 DA Ú Latin capital letter U with acute

219 DB Û Latin capital letter U with circumflex

220 DC Ü Latin capital letter U with diaeresis

221 DD Ý Latin capital letter Y with acute

222 DE Þ Latin capital letter THORN

223 DF ß Latin small letter sharp s - ess-zed

224 E0 > Latin small letter a with grave

225 E1 á Latin small letter a with acute
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DEC HEX
ASCII
Symbol

Description

226 E2 â Latin small letter a with circumflex

227 E3 ã Latin small letter a with tilde

228 E4 ä Latin small letter a with diaeresis

229 E5 å Latin small letter a with ring above

230 E6 æ Latin small letter ae

231 E7 ç Latin small letter c with cedilla

232 E8 è Latin small letter e with grave

233 E9 é Latin small letter e with acute

234 EA ê Latin small letter e with circumflex

235 EB ë Latin small letter e with diaeresis

236 EC ì Latin small letter i with grave

237 ED í Latin small letter i with acute

238 EE î Latin small letter i with circumflex

239 EF ï Latin small letter i with diaeresis

240 F0 ð Latin small letter eth

241 F1 ñ Latin small letter n with tilde

242 F2 ò Latin small letter o with grave

243 F3 ó Latin small letter o with acute

244 F4 ô Latin small letter o with circumflex

245 F5 õ Latin small letter o with tilde

246 F6 ö Latin small letter o with diaeresis

247 F7 ÷ Division sign

248 F8 ø Latin small letter o with slash

249 F9 ù Latin small letter u with grave

250 FA ú Latin small letter u with acute

251 FB û Latin small letter u with circumflex

252 FC ü Latin small letter u with diaeresis

253 FD ý Latin small letter y with acute

254 FE þ Latin small letter thorn

255 FF ÿ Latin small letter y with diaeresis

18.4.4  Node Commands

Please note that this topic will be updated soon with changes introduced with version 6. In the
meantime, please refer to the support team if you have any questions.
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Widget Designer version 4.5 introduces the feature to remote control nodes  with so called "Node
Commands". Up until now, commands were "only" for items like a Fader etc. but with the introduction of
more advanced nodes, the need arose to control their features with commands too. These more complex
nodes allow to enter advanced settings directly in the node and are able to execute functions
themselves. Nodes that have remote controllable functions are for example:
- Projector Control Input node
- OptiTrack ID Tag Input node
- Watchfolder to PB Playlist Interaction node, etc.

Node commands are executed as any other command. It can be written, for example, in a Custom
Script Button to be executed as soon as the button is pressed. Please refer to the chapter "Script
Language " for more details about commands.

There are two ways to write a node command. One form is a more direct form whilst the other reminds of
the structure of other common commands. As with all commands, the original form includes
placeholders. By replacing them with according information the command addresses one particular
setting from one particular node. So by typing the command, it assumes a definite shape.

Node commands that access a function of a node

As an example please see the table below. It shows the two basic command forms and examples how
they could be filled out.

Direct node command Common node command

Basic command to
access an function

NodeID.Nodecommand WDNodeCommand,NodeID,Args0,ArgsN

Examples for:
Projector Control 

node1.PowerOn
node1.PowerOff
node1.LampOn
...
node1.Input4

WDNodeCommand,1,PowerOn
WDNodeCommand,1,PowerOff
WDNodeCommand,1,LampOn
...
WDNodeCommand,1,Input4

Examples for:
Watchfolder to PB
Playlist 

node2.ResetPlaylist
node2.ClearWatchFolder

WDNodeCommand,2,ResetPlaylist
WDNodeCommand,2,ClearWatchFolder

The Script Assist feature, offers the available functions for the according node:
- For the direct form: As soon as the dot behind the ID is typed...
- For the common form: As soon as the comma behind the ID is typed...
... , Script Assist looks up what this node is (e.g. a Projector Control) and displays the according
commands in a list box. Use the arrow keys (up and down) to select an entry and press Enter. The ESC
key hides the list box.

Node commands that access a parameter of a node

In addition to the purpose of controlling functions, node commands can also be used to assign a value to
a parameter within a node. The examples refer to the depicted node chain.
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Example for entering the Fader ID 5 into the Fader Output node:
The Fader Output node has the NodeID "3" as depicted in the upper left corner in the node. Its parameter
for "Fader" is identified with "1" as depicted by the small superscript number next to the parameter field
in the Node Properties dialog.
There are 3 possible command forms: (please note that the two direct forms do not support variables yet)
1) A direct node command
2) A 2nd direct node command
3) Common node command

Node Commands Examples

1 NodeID.ParamID@Value node3.1@5

2 NodeID.SetParamValue,ParamID,Value node3.SetParamValue,1,5

3

WDNodeSetParam,NodeID,ParamID,Value WDNodeSetParam,3,1,5
WDNodeSetParam,3,1,Variable

Example for setting the "Input" source in the Delta Filter node to "Y Pos" from the Mouse Input
node:
The Delta Filter node has the NodeID "2" and the Mouse Input node "1". Their IDs are depicted in the
upper left corner in the node. The parameter for "Input" (that can accept input values from other nodes) is
identified with "1" as depicted by the small superscript number next to the parameter field in the Node
Properties dialog. The Mouse Input node provides several values, "Y Pos" is the second of them, thus it
gets the ID "2".

Node Commands Examples

1 NodeID.ParamID&NodeID,ParamID node2.1&1,2

2 NodeID.SetParamValue,ParamID,Value node2.SetParamSource,1,1,2

3
WDNodeSetParamSource,NodeID,ParamID
,SourceNodeID,SourceNodeParamID

WDNodeSetParamSource,2,1,1,2
WDNodeSetParamSource,2,1,1,Variable
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18.4.5  Input Nodes

Input nodes provide numeric or text based input values. Please see the introductory chapter if you like to
learn more about other node types or how to create and work with nodes  in general.

AIRBAR
The Airbar Input node provides the following output values: Min, Max, Size and Center. Set up the Airbar
via Com Port.

AIRSCAN
The AirScan Input node provides the following output values: X1/X2 position, Y1/Y2 position, distance,
angle, P1/P2 (Point) enter, P1/P2 leave.

AIRSCAN MULTI-POINT
The AirScan Multi-Point Input node provides the position of each detected points as well as his status.

ART-NET
The Art-Net input node lets you receive an 8 or 16 bit DMX Value by choosing the desired source Subnet
and Universe.

AUDIO (BETA)
The Audio input Node allows you to define three frequency band passes with a limiter and gate settings.

BLACK BOX (BETA)
The Black Box input node allows using the 3D position data provided from Cast’s device Black Box.

BUTTON
The Button input node allows you to intercept Button presses within Widget Designer. Select the Button
ID to output the current Button state. The output value is either 0 or 1.

CAMERA POINT TRACKER
The Camera Point Tracker Input Interface and the Camera Point Tracker Input Node allows you to track
up to 99 objects / points.

CAMERA TRACKING (Beta)
The CameraTracking Input Interface and Camera Input Node allow you to track up to 8 Tracking points.

CLOCK
The Clock node provides the current Date values: Year, Month, Day, Hour, Minute´and Second.

COLOUR PICKER
The Colour picker input allows you to pick a colour. The values of this RGB colour can be transferred to
the Colour FX faders on a layer in Pandoras Box.

COM PORT
The Com port input node allows receiving either ASCII or Byte values over a local COM port connection.
This input node can output by default any incoming packet as text if no ASCII filter is applied. 

COM ASCII STREAM
The Com ASCII Stream input node allows receiving ASCII values over a local COM port connection. This
input node can output by default any incoming packet as text if no ASCII filter is applied. 

COM QUERY STRING
The Com Query String input node allows receiving ASCII feedback messages from COM devices over a
local COM Port connection. 
This input node will output any incoming packet as Text Only, Numeric Only or mixed string. 
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COUNT DOWN
The Count Down input node allows you to set a target time to which it counts down. 
It will give out both the total amount of remaining years, months, days, hours, minutes, seconds and the
Count Down of hours, minutes and seconds.

COUNTER
The Counter input node can be set up to continuously count a certain value range in a given amount of
time.
The counter can also be set to bounce up and down.

DMX LINK IN
The DMX Link input node provides all incoming DMX data via the coolux DMX Link interface.

EMAIL
The Email input node provides all incoming Emails for further processing.

ENCODER
The Encoder input node allows intercepting Encoder Values within Widget Designer. 

EVENTS
The Events Input Node provides you information about the last events, current events and next events.

EXCEL READER
The Excel Reader Input Node allows you to readout cells from an excel sheet as text.

FACE TRACKING
The Face Tracker input node allows proceeding the position values delivered by the Face Tracker Tool. 

FADER
The Fader input node allows intercepting Fader Values within Widget Designer. Select the Fader ID to
output the current fader value.

GPS
The GPS COMPort input node supports the GPGGA data format and is compatible with NMEA 0183.

ID Tag  Tracker
The iPhone Remote input node allows to receive the current iPhone remote single and multi-touch
values.

ID Tag Data Client

iPHONE REMOTE
The iPhone Remote input node allows to receive the current iPhone remote single and multi-touch
values.  

JOYSTICK
The Joystick input node allows intercepting standard Windows gaming device input values for axis slider
and button input.

KINECT
The Kinect input node allows capturing up to 8 filtered and tracked points/regions of interest via the
Kinect device.

KINESYS
The Kinesys K2 Input Node allows you to grab X,Y,Z, Pitch, Tilt & Roll data from a Kinesys K2 

LABEL
The Label input node allows using label texts as Input.
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MEDIA CONTROL
The Media Control input node allows to intercept the last called Folder and File ID of one or multiple
Media Control Panels.

MIDI IN
The Midi input node allows to receive 7bit or 15bit input values as well as Note On/Off and raw byte
messages. The midi connection needs to be enabled in the Connection Manager .

MIDI NOTE CATCH
The Midi Note Catch node catches and outputs the first incoming Midi Note Message.

MOTION DETECTOR
The Motion Detection input node provides the data given by the Motion Detector Tool for further
processing.

MOUSE
The Mouse input node provides the Mouse X&Y position as well as the three button press states Left,
Middle and Right.

MULTI-TOUCH ITEM
The Multi-Touch Item input node provides the current state of a Multi-Touch Item (Position, Rotation and
Size) as well as the current state of the Layer in PB linked to this Item

MULTI-TOUCH PANEL POINT
The Multi-Touch Panel Point input node provides the current Position of a Point inside a Multi-Touch
Panel.

ODSL 30
The ODSL 30 Input node lets you read out distance data from the optical distance measuring sensor
ODSL 30 via a local COMPort connection (RS232).

OSC
The OSC Input node lets you receive data via the Open Sound Control Protocol, e.g. from iPhone, iPad
or iPod (tested with Touch OSC). A UDP Broadcast Input Connection is required. 

PAGE
The Page input node allows using the current page name for further processing.

PB DEVICE PARAMETER INPUT
The PB Device Parameter input node provides feedback values for all layer parameters from a Pandoras
Box Master and Backup System for further processing.

PING
The Ping input node gives you feedback in a certain time interval if the specified IP is online.

RANDOM
The Random input node provides a random number on a given update interval and value range.

REMOTE TOUCH
The Remote Touch input node allows processing any incoming remote touch point. 

RSS
The RSS input node provides all incoming RSS feeds as Input.

SENSOR LINK
The SensorLink input node provides the absolute, relative and delta values of the encoder inputs, the
analog 0-10v inputs and the switch states 1 to 8.
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SERIAL LINK GPI
The SerialLink input node provides all 24 GPI contact closure states. Connect a Serial Link via TCP in
the Connection Manager  and set its TCP ID in the input node to listen to the incoming packets.

SMS
The SMS input node provides all incoming SMS for further processing.

SPACE NAVIGATOR
The Space Navigator input node provides the 3D Mouse's X, Y and Z position and rotation data.

SMPTE LINK
The SMPTE Link input node allows reading and using timecode within Widget Designer.

TEXTBOX
The Textbox input node allows intercepting Textbox Values within Widget Designer. Select the Textbox
ID to output the current Textbox Value.

TEXT READER
The Text Reader input node allows you to read out text files (.txt) for further processing. 

TIMAX
The Timax input node provides XYZ data of the Ubisense Timax tracker.

TCP
The TCP input node allows receiving either ASCII or Byte values based on the selected TCP connection.
It can output by default any incoming packet as text if no ASCII filter is applied. The TCP connection is
set up in the Connection Manager.

TCP ASCII STREAM
The TCP ASCII Stream input node allows to receive either ASCII values based on the selected TCP
connection. It can output by default any incoming packet as text if no ASCII filter is applied. 

TCP QUERY STRING
The TCP Query String input node allows to receive ASCII feedback messages from TCP devices over a
TCP Port connection

TRACKSCAN
The TrackScan input node provides the integration of a Barcode scanner to read values in mm from 0 to
up to 2 km of distances via the local COM Port.

TRACKSCAN SERIAL LINK
The TrackScan SerialLink input node provides the integration of a Barcode scanner to read values in mm
from 0 to up to 2 km of distances via the coolux SerialLink device.

UDP
The UDP input node allows receiving either ASCII or Byte values based on the selected UDP connection.
It can output by default any incoming packet as text if no ASCII filter is applied. The UDP connection is
set up in the Connection Manager.

UDP ASCII STREAM
The UDP input node allows to either ASCII values based on the selected UDP connection. It can output
by default any incoming packet as text if no ASCII filter is applied. 

VALUE
The Value input node allows you to set a numeric value for further processing.

VARIABLE
The Variable input node allows you to use a variable for further processing.
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WHEEL
The Wheel input node allows intercepting Wheel Values within Widget Designer. Select the Wheel ID to
output the current Wheel value.

WII
The Wii input node provides all 4 IR tracking coordinates as well as all Button presses and
accelerometer data for up to 4 Wii controllers. The additional Nunchuk and Balance Board are also
supported. The Wii controller needs to be connected via Bluetooth as HID.

XY PANEL
The XY Panel input node allows intercepting XY Panel Values within Widget Designer. Select the XY
Panel ID to output the current XY Panel values.

18.4.5.1  Airbar Input

The Airbar Input node provides the following output values: Min, Max, Size and Center. Set up the Airbar
via Com Port.

Node Properties:

Port:
Enter the number of the COM Port the Airbar is connected to. Press Connect.

The Node generates the following output:
- Airbar Min Output = Minimum Position from left 
- Airbar Max Output = Maximum Position from left 
- Airbar Size Output = distance between two points
- Airbar Center Output = center Position between Min and Max.
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18.4.5.2  AirScan Input

The AirScan Input node provides the following output values: X1/X2 position, Y1/Y2 position, distance,
angle, P1/P2 (Point) enter, P1/P2 leave.
Please set up the AirScan in the AirScan Tools Menu .

Node Properties

The Node generates the following output:
- AirScan X1 Pos,
- AirScan Y1 Pos,
- AirScan X2 Pos,
- AirScan Y2 Pos,
- AirScan Distance (between two points),
- AirScan Angle (between two points),
- AirScan P1 Enter (true or false),
- AirScan P1 Leave (true or false),
- AirScan P2 Enter (true or false),
- AirScan P2 Leave.(true or false).
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18.4.5.3  AirScan Multi-Point Input

The AirScan Multi-Point Input node provides the positions of each detected points as well as his status,
the detected active point count and its orientation.
The AirScan has to be set up in Multi-Point Mode, see AirScan Tools Menu .

Node Properties:'

ID: 
Enter here the ID of the point whose data you want to use (1-24).

The Node generates the following output:
- X Pos
- Y Pos
- Active (true or false)
- Active Point Count
- Orientation
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18.4.5.4  Art-Net Input

The Art-Net input node lets you choose an 8 or 16 bit DMX value by choosing the desired source Subnet
and Universe.

Node Properties:

Subnet:
Enter subnet ID.

Universe:
Enter the Universe ID.

Channel: 
Enter the Channel ID.

8bit / 16 bit:
Choose if you want to get a eight or sixteen bit DMX value.

Monitor:
Click here to open the Art-Net Monitor .
Confirm your settings by pressing OK or Apply.

The Node generates the following output:
- Art-Net In DMX Channel.
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18.4.5.5  Audio Input

The Audio input node allows you to define three frequency band passes with a limiter and gate settings.

Node Properties:

Audio Interface:
Choose your Audio Interface from the list.

Samples:
Enter the amount of used samples.
Define the three frequency band passes (Low, Mid, High) by entering their Start and End frequency.

Limiter:
Set the limit for upper peak.
Confirm your settings by pressing OK or Apply.

The Node generates the following output:
- Audio In Low,
- Audio In Low Peak,
- Audio In Mid,
- Audio In Mid Peak,
- Audio In High,
- Audio In High Peak,
- Audio In Volume,
- Audio In Volume Peak.
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18.4.5.6  Black Box Input

The Black Box input node allows using the 3D position data provided from Cast’s device Black Box.

Node Properties:

ID:
Enter the ID. 

The Node generates the following output:
- Black Box Input X,
- Black Box Input Y,
- Black Box Input Z.

18.4.5.7  Calibration Link Input

The Calibration Link Input node allows to communicate with the Calibration Link or a NET Link equipped
with fibre input boards. Please see more information in the chapter covering the NET Link .
On the one hand the node receives information send from the 16 fibre inputs, hence, it provides this data
to other nodes in Widget Designer. On the other hand, it allows to configure the device and send
commands to it.

The NET Link Input node , the Relay Output node  and the tool "Projector Calibration Manager"
might also be of interest for you.
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Create > Nodes > Input > Devices > Calibration Link

Node properties

IP and Port
Enter the correct IP address and port from the NET Link's processor or from the Calibration Link.

Reset To Factory Default
This buttons resets the above settings in the Widget Designer interface. To reset the device itself (to the
IP address 192.168.178.222 and the port to 5000), hold the "Reset" button down whilst plugging the
power into the device. Release the button again.

Connect / Disconnect
Before starting to communicate with the device, for instance receive data, the node must be connected
to the device. The connection itself consumes no performance.

Change IP Address
This button opens a new dialog whereto you may enter another IP address and port for the device.
Power-cycle the device to apply the changes.

Config Module
A NET Link / Calibration Link is configured by coolux as you have ordered it. However, if you have
changed some input / output boards, the processor must be configured in terms of giving him the
information which boards are connected to it. Click the "Config Module" button to open a new dialog
where you may choose the according boards per processor connection. Find more details in the NET
Link hardware chapter .

Start Data, Start Integrate and Stop Data
As soon as data is processed via the network from the device to Widget Designer, performance is drawn.
For normal use, click "Start Data" (sets a high data rate). For the use of measuring the light distribution
over a longer time period, activate the slower data rate with "Start Integrate".
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Store Last Transmission State to NET Link CPU
Click this button and power-cycle the device if you wish that it remembers whether it should (not) send
data as soon as it is powered up.

Node control

This node allows to be remote controlled via so called node commands . Node commands access
functions from a node and / or set a parameter.

Enter "node", followed by the according ID and a dot and a list will pop up showing all available
commands for the node. For instance, node1.StartData will execute the function automatically

without the need of opening the Item Properties dialog and clicking the according button manually.
In addition, the node properties with a parameter ID (the small superscript number) can be edited via the
commands WDNodeSetParam,NodeID,ParamID,Value or nodeID.ParamID@Value.

Node output values

The node generates the following output:

- Value 1 to 16 (0 - 1023)
- Connected

18.4.5.8  Custom Script Input

The Custom Script Input node allows you to intercept Custom Script Button  presses within Widget
Designer. Select the CS Button ID to output the current click state. The output value is either 0 or 1.
Please note that the output stays at 1 as long as the button is hold down. If you like to count for
example how many times a button was used, you need the information when it was clicked, not how
long it was hold down. This can be achieved with the help of other filtering nodes, e.g. Delta  and If
node.

Node Properties:

Custom Script ID:
Enter here the Custom Script Button ID this node should refer to.
Confirm your settings by pressing OK or Apply.

The Node generates the following output:
- Value (True=1, False=0)

1059
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18.4.5.9  Camera Point Tracker Input

The Camera Point Tracker Interface  and the Camera Point Tracker Input Node allows you to track up
to 99 tracking points.

ID:
Select the ID of the Point that is tracked via the Camera Point Tracker.

The Node generates the following output:
- X Pos
- Y Pos
- Active (0 or 1)
- Active Point Count (amount of current active points)
- Average Red
- Average Green
- Average Blue
- Orientation
- Width
- Height

Please note:
Each tracked point whose data you want to get out for further processing needs its own Camera Point
Tracker Input Node.
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18.4.5.10  Clock Input

The Clock node provides the current Date values: Year, Month, Day, Hour, Minute and Second.

The Node generates the following output:
- Clock Year,
- Clock Month,
- Clock Day,
- Clock Hour,
- Clock Minute,
- Clock Second.

18.4.5.11  Color Picker Input

The Colour picker input allows you to pick a colour. The values of this RGB colour can be transferred to
the Colour FX faders on a layer in Pandoras Box.

The Node generates the following output:
- Colour Picker Red,
- Colour Picker Green,
- Colour Picker Blue,
- Colour Picker Cyan,
- Colour Picker Magenta,
- Colour Picker Yellow.
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18.4.5.12  COM Port Input

The Com port input node allows receiving either ASCII or Byte values over a local COM Port connection.
The COM Port connection needs to be enabled in the Connection Manager.
This input node can output by default any incoming packet as text if no ASCII filter is applied. 

Node Properties:

COM Connection ID:
Enter the ID of the COM Port connection .

Output Channels:
Enter the amount of output channels you want to use for this node.

ASCII / Bytes:
Choose to receive either ASCII or Byte values.

Multi-Packets:
Check this box to enable Multi-Packets.

1239
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ASCII Start, Split, Stop (if ASCII is enabled):
Enter the Byte header.

Byte Header (if Byte is enabled):
Enter symbols for ASCII Message Start, Split and Stop.

The Node generates the following output:
- COM Port Input Value 1 up to Input Value X (X=number of entered output channels).

18.4.5.13  COM ASCII Stream Input

The Com ASCII Stream input node allows receiving ASCII values over a local COM Port connection. The
COM Port connection needs to be enabled in the Connection Manager .
This input node can output by default any incoming packet as text if no ASCII filter is applied. 

Node Properties:

COM Connection ID:
Enter the ID of the COM Port connection .
The ASCII message between Start [STX] and End [ETX] symbol will be given out.
Confirm your settings by pressing OK or Apply.

The Node generates the following output:
- COM Stream In String.

1239
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18.4.5.14  COM Query String Input

The Com Query String input node allows receiving ASCII feedback messages from COM devices over a
local COM Port connection. The COM Port connection needs to be enabled in the Connection Manager

.
This input node will output any incoming packet as Text Only, Numeric Only or mixed string. 

Node Properties:

COM Connection ID:
Enter the ID of the COM Port connection .

Query String:
Enter the query string that you want to send to the specified COM Device.

Interval:
Enter the time interval in ms in which the query string will be send to the COM Device. 
If you want to query the device manually (e.g. by pressing a Custom Script Button using the command
“WDNodeSetParam,'NodeID','ParamID','Value' ”), please set the Interval Time to 0 ms.

Message:
The response of the COM Device will be displayed here. Please note that the responding device needs to
send a "carriage return", a "line feed" or an "end of text" at the end of its message. This can be done in 
ASCII, decimal or hexadecimal language . 
- carriage return is either [CR] or [d13] or [h0D]
- line feed is either [LF] or [d3] or [h3]
- end of text is either [ETX] or [d10] or [h0A]

Timeout:
The Timeout gives you feedback about the connection status. If Timeout is “0”, there is no
communication with the specified COM Device. If Timeout is “1” the communication works.
Confirm your settings by pressing OK or Apply.

The Node generates the following output:
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- COM Query String Response, 
- COM Query String Text Only,
- COM Query String Numeric Only
- COM Query String Timeout.

18.4.5.15  Count Down Input

The Count Down input node allows you to set a target time to which it counts down. 
It will give out both the total amount of remaining years, months, days, hours, minutes and seconds and
the Count Down of hours, minutes and seconds.

Node Properties:

Target Time and Date values:
Please choose the target date from the list or enter it in the text fields below. Enter here also the time
target (hours, minutes and seconds).
Confirm your settings by pressing OK or Apply.

The Node generates the following output:
- Count Down Years Left,
- Count Down Months Left,
- Count Down Days Left,
- Count Down Hours Left,
- Count Down Minutes Left,
- Count Down Seconds Left,
- Count Down CD Hours,
- Count Down CD Minutes,
- Count Down CD Seconds.
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18.4.5.16  Counter Input

The Counter input node can be set up to continuously count a certain value range in a given amount of
time.
The counter can also be set to bounce up and down.

Node Properties:

Time:
Set the amount of time.

Range:
Set the value range.

For example:
To get a counter that counts continuously in 5 seconds from 0 to 5 enter for Time=5000 ms and for
Range=5.
To get a counter that counts continuously in 5 seconds from 0 to 10 enter for Time=5000 ms and for
Range=10.
To get a bouncing counter (counting continuously from 0 to X and back to 0 etc.) please tick the Bounce
check box.

The Node generates the following output:
- Counter Value.
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18.4.5.17  DMX Link Input

The DMX Link input node provides all incoming DMX data via the coolux DMX Link interface.

Node Properties:

Channel:
Choose the DMX channel and if it is a 8bit or 16 bit value.

The Node generates the following output:
- DMX Link In DMX Value

18.4.5.18  DropDownList Input

The DropDownList Input node allows intercepting values from a Widget Designer Drop Down List
control. Select the Drop Down List ID to output the current text value and the index number of the
chosen entry. 

Create > Nodes > Input > Controls > Drop Down List

Node properties

Item ID
Choose the Drop Down List ID.
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Node output values

The node generates the following output:

- Index (starting with 0!)
- Text

18.4.5.19  Email Input

The Email input node provides all incoming Emails for further processing. 
Please configure your mail server in the Email Settings .

Node Properties:

Start Index:
Enter the Index of the email where the cycling should start. This will effect the outputs Current Email and
Current ID.

Interval (seconds):
All incoming emails will be cycling in the entered amount of time. This will effect the outputs Current
Email and Current Email ID.

Single Index:
Enter the Index of the email that you want to route to the output Single Email.

The Node generates the following output:
- Email Input Email Count,
- Email Input Last Email,
- Email Input Current Email,
- Email Input Current Email ID,
- Email Input Single Email,
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- Email Input RND Email (Random Email).

18.4.5.20  Encoder Input

The Encoder input node allows intercepting Encoder Values within Widget Designer. Enter the Encoder
ID to output the current Encoder value.

Node Properties:

Encoder ID:
Enter the Encoder ID.

The Node generates the following output:
- Encoder Input Value.

18.4.5.21  Events Input

The Events Input Node provides information about the last events, current events and next events.
Setup your events in the Event Editor .

The Node generates the following output: (Information about the Current Event):
- Events Current Event (Events name),
- Events Current Year,
- Events Current Month,
- Events Current Day,
- Events Current Hour,
- Events Current Second.

The same information is provided for the last and the next event.
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18.4.5.22  Excel Reader Input

The Excel Reader Input Node allows you to readout cells from an excel sheet as text.

Node Properties:

File:
Use the Path-Button to browse to the document you want to read.

Worksheet:
Press apply after you have selected your file. 
In the list select now one of the worksheets your file contains.

Single Cell:
Enter the cell you want to read out, e.g. B11.

Update File:
Enter the update interval.

The Node generates the following output:
- Excel Reader Cell (as String).
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18.4.5.23  Face Tracker Input

The Face Tracker input node allows proceeding the position values delivered by the Face Tracker Tool
. 

Node Properties:

The Node generates the following output:
- Face Tracker X (X Pos of bounding box)
- Face Tracker Y (Y Pos of bounding box)
- Face Tracker Z
- Face Tracker w (Width of bounding box)
- Face Tracker h (Height of bounding box)

18.4.5.24  Fader Input

The Fader input node allows intercepting Fader Values within Widget Designer. Select the Fader ID to
output the current fader value.

Node Properties:

Fader ID:
Choose the Fader ID.

1273



1086

The Node generates the following output:
- Fader Input Value.

18.4.5.25  GPS Input

The GPS COMPort input node supports the GPGGA data format and is compatible with NMEA 0183. 
This node was tested with Navilock USB GPS Input device.

Node Properties:

COM Connection ID:
Choose the COM Port your GPS device is connected to.

The Node generates the following output:
- GPS Hours
- GPS Minutes
- GPS Seconds
- GPS Longitudes Text
- GPS Longitudes Degrees
- GPS Longitudes Minutes
- GPS Longitudes Seconds
- GPS LattitudeText
- GPS Lattitude Degrees
- GPS Lattitude Minutes
- GPS Lattitude Seconds
- GPS Altitude
- GPS SignalOK
- GPS Active Satellites
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18.4.5.26  ID Tag Tracker Input

The ID Tag Tracker Input node consists of all settings related to tracking coolux IR ID tags. The node
requires the enabled option "OptiTrack Camera  Manager" in the Connection Manager . It is available
in Widget Designer PRO and ULT edition. The tag configuration is included in the Widget Designer STD
too.

The ID Tag Tracker node includes a lot of
settings to set up, adjust and optimize the
tracking. It includes the following sections:
- Preview
- Preview Settings
- Camera Settings
- Camera Lens Calibration
- Camera XYZ Calibration
- Marker Settings & Rendering
- Global Tracking Settings
- 2D Camera Tracking Settings
- 3D Tracking Settings
- Performance Options
- Motion Prediction
- MA PSN Output
- ID Tag Settings  and Config ID Tag

Below the principle of ID camera tracking is explained whilst the next chapter covers the hardware and
environment requirements . The very last chapter approaches tracking with moving lights
(automatic follow spot) and how to set up your GrandMA console for it.

The principle of optical camera tracking and IR ID tags

The general idea behind the optical tracking method with infrared cameras and infrared identification tags
-short IR ID tags - is to locate a person or any object, identify it and track its movement. This can be
done without any cables attached to the person / object as the tag is pinned on the tracked object and is
seen by one or several cameras. 

The tag is an active marker with an internal power source: in contrary to a passive marker it does not
reflect but emits light itself which allows a higher luminosity (and hereby a maximum range) as well as
more flexibility in your stage setup.
In addition to that it can be configured with an identifiable number. Thus it is possible to distinguish two
objects from each other, even if they overlap and separate again. This is a huge advantage compared to
other camera tracking methods. As well, it allows playful interactive scenarios. For instance it is
possible to assign dedicated  properties (e.g. content media or color) to dedicated persons or objects.
As well, these properties can be shared or swapped if two objects meet.
Currently, you may track up to 256 different IDs. Several tags can be set up with the same ID. The
maximum total number of trackable tags depends on the hardware system.
Another requirement in the tag development was allowing it to be hidden in scene pieces, costumes etc.
whilst providing good handling on stage. We met this need by reducing the tag to the minimum size
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possible, the pure printed circuit board with an onboard power source. Furthermore, the tag can be used
out of the box or it can be modified to suit individual needs. That includes different power and / or light
sources, e.g. spatially divided from the tag board.

The Widget Designer offers a unique,self-developed tracking method that processes the camera data,
allows user adjustments and provides the object's position. With a minimum of three cameras, it is
possible to track the 3D position, that is the exact location in a 3D space, expressed through the X-, Y-
and Z-position. It is also possible track only in two dimension ( i.e. a plane), for instance, if one axis
does not change. This reduces the camera count to one and other hardware too.
The 2D or 3D data can then be send (through other Output nodes) to a Pandoras Box playback system,
e.g a Video Layer. Alternatively or in addition, the data can be directly send to the MA PSN protocol and
auxiliary tracking servers.
Besides the position tracking itself the Widget Designer offers the management of the tags properties
mentioned above. To fulfill creative tracking scenarios you may adjust settings in the tracking node itself
or combine it with everything else, the Widget Designer offers: from the command language and the
entire nodes system to other tools and user-controls through to variables and functions. The combination
of all this allow to program even the most complex logic.

Hardware-wise the IR ID tracking method requires tags, cameras, (a switch), and a PC running Widget
Designer. The surrounding environment must be suitable. The next page explains more about
requirements regarding hardware and the environment .

18.4.5.26.1  Required Hardware and Tracking Environment

This topic describes the requirements for the IR ID tracking method regarding hardware and environment.
For general information about IR ID tracking and links to other chapters please see the topic ID Tag
Tracker .

Hardware-wise the IR ID tracking method requires tags, cameras, (a switch), and a computer running
Widget Designer. The surrounding environment must be suitable.

The tags can be purchased through your local Christie distributor. You can choose between an "ID Tag"
that provides one configurable ID and the "Quad ID Tag" that provides up to four configurable IDs.

(Single) ID Tag

The tag is a printed circuit board with two onboard
infrared LEDs, one onboard control LED and a power
source. It has a size of 26x26mm and a weight of
10g. The board offers pads for external interfaces,
thus it can be modified to suit individual needs, e.g.
a spatially divided LED or another power source.
Please note that the warranty is not voided by using
these pads but malfunctions due to faulty use (too
hot soldering, too much power etc.) are not covered!

The onboard or added LEDs blink in a certain pattern
according to the set identification number. The
LEDs' luminosity can be adjusted whilst only the
onboard ones can be powered by 100%. Additional
LEDs can be driven with max. 70%, independent
from the power source. You may set up to use one
or both onboard LEDs and up to three possible
additional ones. A brighter tag allows a more distant
camera, a more lightened surrounding and a more
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robust tracking. On the other hand it consumes
more power.

The power source can be one of the following three:
- onboard hearing cell holder: holds two button cells;
smallest space; feeds one LED with 70%; battery
life span approx. 10 hours (as soon as the batteries
are activated this span cannot be stopped!)
- onboard Micro-USB interface: allows to plug the
delivered battery (with four 1.5 AA batteries); a
battery pack lasts up to 24 hours; auxiliary battery
packs should deliver 4.2 to 6.5V
- custom power source: the pads allow to add
another power source with max. 3V

The tag can be configured  via the onboard Micro-
USB interface. Connect the tag via the delivered
USB cable (Micro-USB to Standard Type A plug) to
your computer running Widget Designer. The
configuration involves the number and power of the
IR LEDs as well as the brightness of the blue control
LED. Further, the blinking mode including the ID can
be set up. See below for more details regarding the
software settings. The settings are stored in the tag,
allowing to unplug it from the computer to change
back to the delivered battery pack.

Quad ID Tag

The quad tag's printed circuit board is covered with a
housing. It provides four twist-lock connectors to
which you can connect the provided external infrared
LEDs. The tags have a cable length of 1,5m. The
housing also includes the power source: two AAA-
batteries. A power switch and an onboard control
LED are also included. It has a size of
110x70x20mm and a weight of 50g.

The connected LEDs blink in a certain pattern
according to the set identification number. Each port
can be numbered individually. The LEDs' luminosity
can also be adjusted. A brighter tag allows a more
distant camera, a more lightened surrounding and a
more robust tracking. On the other hand it
consumes more power.

The tag can be configured  via the onboard Mini-
USB interface. Connect the tag via the delivered
USB cable (Mini-USB to Standard Type A plug) to
your computer running Widget Designer. The
configuration involves the options for the brightness
of the IR LEDs as well as the brightness of the blue
control LED. Further, the blinking mode including the
four IDs can be set up. See below for more details
regarding the software settings. The settings are
stored in the tag.

1092

1092



1090

The cameras supported are third-party motion capture cameras from the OptiTrack system developed
by the company NaturalPoint. Please contact an OptiTrack distributor if you are interested as they
cannot be purchased through your coolux distributor.
The implemented and supported OptiTrack models are called:
V120:SLIM
V100:R2
Flex3
Flex13
s250e
Prime13
Prime17
Prime41

The camera models differ in resolution, frame rate, field of view (opening angle), max. tracking distance,
latency, etc. Please refer to the "Compare Cameras" web site offered by NaturalPoint.

The question how many cameras are needed and where they need to be positioned depends first of all
on the choice to track 2D or 3D. As mentioned above, to capture the 3D position of a tag, a minimum of
three cameras must "see" it at any time. For the 2D position, only one camera is needed. Secondly, the
maximum distance from a camera to a tag must be defined by combining the camera model's
specifications in theory with the stage environment in field. This is influenced by light, the stage setup
itself, object movement etc. Please see the below paragraph about "Environment". Afterwards, you may
position the cameras in such a way that they cover the area of interest so that one tag is seen by either
one or three cameras at any time.
Please keep in mind that the cameras' position should be as static as possible. If they are mounted with
other devices such as moving lights on a truss, we strongly advice to check whether any light cue state
moves the cameras so much that it worsens the tracking too much.

An PoE Ethernet switch is needed when working with cameras with an Ethernet interface, e.g. the
s250e or the Prime models. coolux recommends to consider the product recommendation from
NaturalPoint. They offer accessories including switches. As well they provide detailed information about
the specification a switch must meet as not all PoE switches are suitable for use with OptiTrack PoE
Ethernet cameras. Quoting their FAQ page: " Ethernet cameras require PoE or PoE+ Gigabit (1000
Mbit/s) Ethernet switches. Standard PoE switches must provide a full 15.4 watts to every port
simultaneously and PoE+ switches must provide a full 25 watts to every port simultaneously." Please
consider that the required power is provided on all ports simultaneously and not only to a subset of ports
whilst downgrading other ones. The cameras will not function properly when insufficient power is available
to them.
Same applies to the bandwidth per port. "(...) the switch must support Gigabit (1000 Mbit/s) for every
port. Connecting multiple PoE switches in a star topology to a non-PoE Gigabit uplink switch is
recommended for larger camera counts." It is not recommended to connect more than 4-8 cameras on
one switch.

As the Ethernet cameras assign themselves an IP address, the switch must not provide a DHCP Server!

The cabling between Ethernet cameras and the switch must be done with Cat6 or Cat7 cables; Cat5/
Cat5e/etc not supported. For the USB cameras (e.g. V100:R2) the USB cable length must match the
NaturalPoint recommendations. Both camera types, Ethernet and USB, draw their power from the
connected "data" cables, an additional power supply and connection is not needed.

Lastly, the Widget Designer communicates with the cameras, processes all the (image) data and
extracts the object's position in real-time.

Hardware-wise it is recommended to meet at least the specifications from a coolux Workstation. Please
contact your local distributor for more detailed information. Next to the network hardware (cables,
switches, etc.), the type of Widget Designer hardware (network card, processor...) determine the amount
of cameras and tags per system. As a very rough rule of thumb, one Widget Designer hardware and one

http://www.naturalpoint.com/
http://www.naturalpoint.com/optitrack/hardware/compare/
http://www.naturalpoint.com/optitrack/products/sync-switches-hubs
http://www.naturalpoint.com/optitrack/support/faq/general.html
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LAN (local area network) may process the data of six cameras and 32 tags. Several options may
increase or decrease this number.
However, if the limits are reached, it is possible to set up another LAN and a Widget Designer that works
as a tracking client. It sends the extracted position data to a main Widget Designer. This WD in return,
does the actual tracking processing. It gathers the position data from the clients and assembles them. In
addition it manages the objects' properties and runs the entire interactivity. This data containing the
interactivity information for dedicated (video) layers or other devices is then send to another system, for
instance a Pandoras Box Master or another lighting console. It is a very recommended workflow to
separate these data flows from each other. This can be either done by using manageable switches or
with network cards that offer multiple network adapters / NICs (Network Interface Card, physical RJ-45
connector). All coolux hardware comes standard with a network card providing two NICs; by request we
supply four NICs . 
An exemplary application with separated data flows is depicted below...

Widget Designer PRO and ULT edition support the tracking node itself and the tag configuration. Widget
Designer STD supports only the tag configuration.

The setup for Widget Designer is described in the "Installation" chapter . If you like to configure tags,
connect one via the delivered USB cable (Micro-USB to Standard Type A plug) to your computer. Use
the USB-driver “coousb-driver v6.0.13.0” (or a newer one) to finish the hardware installation of the device.
Further steps are described in the chapter "Config ID Tag" .
If working with Ethernet cameras, the computer must be set up with a static IP address in a range and
subnet mask freely chosen.
If working with USB cameras, please make sure to install the driver NaturalPoint provides.

The user interface offers several settings including the configuration of the tags, the cameras, the
tracking itself including the management of objects' properties and finally the system to which all this
data is send. The following pages will explain all option in the user interface.

The surrounding environment must match the needs of an optical tracking method based on infrared
light. In the nature of things, any other infrared light source influences the stability of the tracking
system. Please note, that many materials (glass, metal, etc.) reflect infrared light.
To reduce light noise, it is possible to adjust the cameras' sensitivity and tags' luminosity. These
settings help to get rid of most unwanted light sources but still see the tag's light. In addition, masking is
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available. A mask can be used to exclude certain areas from the image a camera sends to Widget
Designer, for instance areas outside the stage or too bright areas on stage. However, these areas need
to be static and will also absorb the tag's information.
It is highly recommended to schedule sufficient time on site to cope with these interferences. Keep in
mind that any changes done to the stage setup and scenery could influence the tracking behavior.

18.4.5.26.2  Config ID Tag

This topic describes how to configure a tag software-wise. For general information about IR ID tracking
and links to other chapters please see the topic ID Tag Tracker .

(Single) ID Tag

The software configuration of the tag involves to set up the number
and power of the IR LEDs as well as the brightness of the blue
control LED. Further, the blinking mode including the ID can be set
up.

The tag can be configured via the onboard Micro-USB interface.
Connect the tag via the delivered USB cable (Micro-USB to Standard
Type A plug) to your computer running Widget Designer. If you
connect it the first time, and the driver cannot be found
automatically, use the USB-driver “coousb-driver v6.0.13.0” (or a
newer one) to finish the hardware installation of the device.

Now, please open the configuration dialog in Widget Designer:
a) Tools > Connection Manager > section ID Tag Configuration
b) Nodes > Input > Devices > ID Tag Tracker > section ID Tag
Settings

Quad ID Tag

The software configuration of the tag involves to set up the
brightness of the IR LEDs and the brightness of the blue control
LED. Further, the blinking mode including the ID for each port can
be set up. Note that it is possible to set each port to an individual ID
or to share the same ID.

The tag can be configured via the onboard Mini-USB interface.
Connect the tag via the delivered USB cable (Mini-USB to Standard
Type A plug) to your computer running Widget Designer. If you
connect it the first time, and the driver cannot be found
automatically, use the USB-driver “coousb-driver v6.0.14.0” (or a
newer one) to finish the hardware installation of the device.

Now, please open the configuration dialog in Widget Designer:
Tools > Connection Manager > section ID Tag Configuration
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Mode

This influences the maximum ID a tag can hold. It is recommend to choose the smallest
mode available that covers the number of tags you use.
"4" allows four tags holding the ID 1,2,3 and 4. If you want to use ID 5, you need to
choose a higher mode, e.g. 8. The tags transmit their ID with a certain blinking pattern
that needs to be seen by cameras. The higher the mode is, the longer this pattern gets.
Hence, the more time needs to pass in order to recognize a tag if it (re-)appears in the
tracking area.
Please note that it is possible to set up several ID tags with the same ID. This does not
mean to increase the mode as long as the ID fits into the range. In the section "3D
Tracking Settings"  you can set up that "same" IDs should result in one averaged
position.

Interval

This influences how fast the above described blinking pattern is transmitted. Per default it
is set to 20ms.

The lower the frame rate of the used cameras is, the longer an interval needs to be, the
slower a tag is recognized. For a frame rate below of 100-120fps an interval of 40 ms is
recommended. That applies for most USB cameras.

The higher the frame rate of the used cameras is, the shorter an interval can be, the faster
a tag is recognized. A frame rate of 120fps allows to lower the interval to 20ms; 150fps
allows even 10ms. However, a longer interval still works with fast cameras and is more
robust. In theory, a 10ms interval also works for 120fps but in practice this is very prone to
error, hence an 20ms interval is better.

ID
The "ID" depends on the "Mode" chosen above and means the identification number of the
connected tag.

Power

Choose the power source of your tag.

Choose "USB / 3V" if you use the onboard Micro-USB interface with the delivered battery
pack or your own 3V power source
Choose "A675 Cell" if you use two onboard hearing cells.

See more information regarding the power options in the previous chapter "Required
Hardware" .

IR LED
Choose which LEDs should blink. 1 and 2 are the onboard ones. Only the "USB / 3V"
power source allows to use all LEDs at the same time.

IR Pulse

Set the minimum and maximum brightness used in the blinking pattern when transmitting
the tag's ID. It is recommended to set the minimum to 0. The brighter the maximum is,
the higher the tracking distance gets and the more disturbing light is possible. Only the
"USB / 3V" power source allows to power the LEDs with 100%.

Blue LED

Set the minimum and maximum brightness used for the blue control LED. If you do not
want a blinking LED, set an equal value.
The blue LED serves no other purpose than being able to see at first glance whether a tag
is on or off.

Save Config

This stores the above settings to the connected ID tag. Now you can unplug it and power
it (later).
The settings in the dialog are not reset, hence you can plug a new tag to the PC, change
only the ID and save all settings to it.
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18.4.5.26.3  Preview

This topic explains the section "Preview" of the ID Tag node, for general information about IR ID tracking
and links to other chapters please see the topic ID Tag Tracker .

Preview
Window

Depending on the options in the section "Preview Settings"  this window shows either a
camera's image (in grayscale, segment or tracking mode) or the virtual 3D space with all
cameras and markers inside. To navigate in the 3D space use the middle mouse button
(wheel): Scroll = Zoom, Drag = Pan, ALT+Drag = Rotate. More 3D rendering settings...

If a mask is set up, it is displayed as an blue overlay.

If a tag is found, it is displayed with...
- its ID if possible (here: 10)
- a white circle indicating the maximum speed (see "2D Tracking Settings")
- another circle underneath the white one, if you change the default minimum distance to
another tag (see "2D Tracking Settings")
- a white cross indicating the tag`s position with the added damping time (see "Prediction
Settings").

Please see the below table for detailed information about "Grayscale / Segment / Tracking".

Show
Info

This displays the Information in the left upper corner. The frame rate (FPS) depends on the
mode chosen: the maximum rate is reached only in tracking mode and is lowered for the
other modes. The Point Count informs about the number of valid areas. All valid areas are
analyzed whether they hold an ID. If so, their tag ID and circles are displayed.

Show
Origin
Markers

This displays a red circle at the location from a origin marker when the "Mouse Mode" of the 
"Camera XYZ Calibration"  was used.

Scaled
Preview

This toggles between a scaled view of 640x480px and the camera image in its original size
(e.g. for the s250e model: 832x832px). A non-scaled view will be shown 1:1 and with
scrollbars.

Show
Cross
Hair

This displays a horizontal and vertical line at the mouse pointer's position. Under certain
circumstances it might be useful to see a crosshair overlay in the preview. The center of the
image is marked as well as the size of a quarter of a frame. For instance, it is useful for the 
"Camera Lens Calibration"  process.
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18.4.5.26.4  Preview Settings

This topic explains the section "Preview Settings" of the ID Tag node, for general information about IR ID
tracking and links to other chapters please see the topic ID Tag Tracker .

2D Camera View
3D Tracking

Choose what you like to see in the preview .
"3D Tracking" shows a virtual 3D space with visualized camera icons, all tags and a
3D model of your stage if set up in the section "Marker Settings & Rendering" . To
navigate in the 3D space use the middle mouse button (wheel): Scroll = Zoom, Drag
= Pan, ALT+Drag = Rotate
The "2D Camera View" shows the real camera image. Here, you may choose
between grayscale, segment and tracking mode...

Grayscale
Segment
Tracking

If the preview is in "2D Camera View" mode, the camera's image is seen as:
- a grayscale image with detailed information (draws most performance)
- a segment image with information reduced to pixels above the setup threshold - all
these pixels are examined to wear a tag ID, if they do, a tag is displayed as
described in "Preview Window"
- a tracking image with information reduced to pixels found to belong to a tag (draws
less performance, each time the node properties are closed, this mode is entered)
The frame rate of a camera (depicted in the corner of the preview) depends on the
selected mode. The maximum available rate is only achieved in the tracking mode. 

18.4.5.26.5  Camera Settings

This topic explains the section "Camera Settings" of the ID Tag node, for general information about IR ID
tracking and links to other chapters please see the topic ID Tag Tracker .

Camera List

All cameras found within the network are listed with their serial numbers. If a camera is
missing, try to re-initialize the list (see below). Secondly, check the connection to it,
e.g. restart your switch. NaturalPoint offers a tool called "Camera Tester" (also available
under C:\Program Files (x86)\coolux\Widget Designer...), if you have

problems connecting the Widget Designer to the cameras, try to connect to them using
the tool to see whether the problem lies in the physical connection or not.
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The selection of a single camera or "All Cameras" affects many settings, e.g. the
"Frame Rate". Keep in mind, that "All Cameras" overwrites a change to all cameras,
even if they were set up individually per camera before"

Re-Acquire
Cameras

This button tries to (re-)connect to all available cameras (and removes obsolete
cameras). All settings like "Exposure" are kept.

Active

This check box toggles the camera active or inactive.
An inactive camera does not contribute its view to the calculation of the tag's position
anymore. This can be helpful during setup to find out how "good" a camera matches
with other cameras. If a tag jumps far when toggling a camera, it is not setup well.
Another necessity for deactivating a camera might be when the connection suddenly
became bad or if it's position has changed by accident or something else happened that
disturbs the tracking calculation.

IR Filter

This check box influences what light is seen by the camera - only infrared light with a
ticked check box or additional visible light if not ticked. You might want to deactivate
the filter during setup (e.g. camera position, focus,...) in order to see a camera image
containing more information.

Camera Type
This informs about the camera type when a camera is selected from the list, e.g.
"V100:R2".

Frame Rate

The frame rate determines how man images are takes per second. For instance, "250"
means that 250 images are taken and send per second. In other words one image has
a time frame of 1/250 of a second = 0.004 sec = 4 ms = 4000 µs
You may lower the frame rate to save performance. You must not exceed the highest
frame rate supported by your camera.

Exposure

The Exposure determines how man microseconds (1µs = 1/1 000 000 of a second =
0.000001 sec) the lens shutter is open for light to pass through it and expose the
image. The longer that is, the brighter the image gets, meaning that dark areas will be
not black any more but dark-gray whilst light-gray areas will become white. Every pixel
that is not black is later on examined to be a potential tag.
Hence, adjust the time as short as possible to still see the tag's light but nothing else.
Before increasing it, lower the threshold first. Exposure and threshold are engaged to
each other! Also, you could increase the brightness of a tag or set up a mask.
Note that the exposure time depends on the frame rate and should not be longer than
one frame itself.

Threshold

The effect of the threshold is only seen in camera mode "Segment" or "Tracking" as it
works "after" the grayscale image. It sets the minimum brightness a pixel from the
grayscale image must have in order to be considered as a valid pixel. Valid pixels are
displayed in the segment mode as pink pixels and are potential tags.
The value range is 0-255. In contrary to the exposure, which should be set to a
minimum level, the threshold should be set to a maximum level. The higher the
threshold is, the brighter a pixel in the grayscale needs to be in order to be handed over
into the segment mode, hence to be examined to be a tag. The less pink pixels you
see, the less calculation needs to be done.
In short, adjust the exposure as low as possible and the threshold as high as possible
to still see the tag's light but nothing else. If you need a brighter image, it is better in
regards to the performance, to adjust the threshold than the exposure. 

ID and LED
If the LED check box is activated, the camera will show the set up ID. This is useful
during setup. For show use, you might not want to see the ID. If you untick the check
box, the ID itself stays unchanged for later use You may setup a maximum ID of 99.

IR Lights

The cameras are equipped with infrared LEDs themself as they can be used in tracking
scenarios with passive (i.e. reflecting) markers. As the coolux tag is an active marker,
you won't need to illuminate it. However during setup (with an activated "IR Filter") it
might be useful from time to time to illuminate the scene. A value of 0 turns the LEDs
completely off whilst 15 results in the maximum brightness.
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Mask

With an activated mask, certain areas of the camera's image are blocked. A mask can
be set up from the user interface itself (see "Block Visible") or prepared with another
image software (see "Load Mask" and "Save Frame")
This way you can eliminate areas with reflections or other light noise from the tracking
calculation.
You may see a mask overlay in the preview mode "Grayscale" and "Segment", not in
"Tracking".

Show
Crosshair

Block Visible

This option works only in the camera mode "Segment". It creates a mask. All visible
pixels seen in the segment preview are used for the mask and are blocked in
consequence. For instance, turn off all tags so that you are sure to block only external
light and then press the button.  Tick the "Mask" check box to see the blocked pixels
as a blue overlay.

Clear Mask
This option clears a mask if you have used the "Block Visible" or "Load Mask" before. If
you do not need a mask anymore it is recommended to clear it as well as deactivate it.

Load Mask...

Click this button if you wish to load a mask that you have prepared with a third-party
image software. All black areas in the mask, hide the according pixels in the camera's
image whilst visible pixels let them pass through. It does not matter whether you use
white pixels, or any color, as long as it is not pure black.
Supported file formats are: bmp, png, jpg, gif

Save Frame...

This option saves the current frame of the selected camera that is seen in the preview. It
is possible to save a frame from the Camera modes: Grayscale, Segment and Tracking.
If you have ticked the "Mask" check box, the mask will not be shown as black pixels.
Saving a frame is useful when you like to prepare a mask or if you like to document light
ratio, e.g. how much light there was during rehearsals.

Highprecision
Filtering

This option is needed in order to enable camera pre-filtering of detected segments above
threshold, a higher threshold might be chosen for this mode.

18.4.5.26.6  Camera Lens Calibration

This topic explains the section "Camera Lens Calibration" of the ID Tag node, for general information
about IR ID tracking and links to other chapters please see the topic ID Tag Tracker .

This section includes all settings for calibrating the lens.
Each lens deforms its image in a different way and it increases the accuracy of the tracking if this
deformation is compensated. The lens deformation usually needs to be done only once as long as the
lens is not removed. For the very best accuracy it is recommended to redo the calibration if the lens
focus is altered.
As long as the cameras are not calibrated by you, Widget Designer calls the default calibration files from
its installation path:
C:\Program Files (x86)\coolux\Widget Designer 4.5 Rev 708\Data\camera
If the default or your custom calibration files were able to be loaded, the section will be colored green,
otherwise red.
For calibrating a lens you need a special image that depicts a checkerboard (details below...). You can
either print on a hard board or glue a printed paper to it. Note, that the board needs to be as straight and
plane as possible.
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Wrench Icon

The button opens the "Camera Calibration Settings" dialog which is described in
more detail below... In short, here you set up how the image looks like that you use
for the calibration. The image is a checkerboard and is hold in different poses in
front of the camera whilst snap shots are saved.

Calibrate
This calibrates the selected camera with the settings taken in the "Camera
Calibration Settings" dialog.

Folder / Load Icon
Click the Folder Icon if you have calibrated the selected camera before and  wish to
load its data from a different path than the default one: C:\Program Files (x86)
\coolux\Widget Designer...\Data\camera

Disk / Save Icon
Click this button if you wish to save the calibration data for the selected camera to
a different folder than the default one: C:\Program Files (x86)\coolux\Widget
Designer...\Data\camera

Camera /
Precision Icon

Click this button if you wish to see the result of the Calibration (again).

FOV
This informs you about the field of view of the camera lens. The FOV is calculated
during the Calibration and cannot be changed manually.

Camera Lens Calibration Steps

First, click the Wrench Icon to open the left depicted dialog.

The first drop-down and two check-boxes let you choose the calibration
method. Afterwards, enter the FOV of the camera lens. Now, all
settings relate to the checkerboard:
Square Size: how wide and high is one square, measure in centimeters!
H Count and V Count: how many horizontal internal corners are there
and how many vertical ones (click the info button for more information)
Image Count: how many images will be taken (16 is the recommended
minimum)
White / Black Board: is the border around the checkerboard white or
black
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  This dialog explains the horizontal and vertical square count.

You then hold the checkerboard in front of the camera and take pictures
whilst moving either the board or the camera in such a manner that the
board covers different parts of the taken image.

The left image shows recommended calibration poses. Click it, to
enlarge the image.

After the last snapshot, a Calibration file is calculated, saved, displayed for your information and
afterwards applied to the currently selected camera. To see the Calibration file again, click the Camera /
Precision Icon
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empty Calibration file; after Calibration, the dots
are shifted slightly and represent the lens
deformation

wrong Calibration file, the corners must not be 
folded inwards

18.4.5.26.7  Camera XYZ Calibration

This topic explains the section "Camera XYZ Calibration" of the ID Tag node, for general information
about IR ID tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section includes all settings for the setup of the fundamental XYZ World description needed when
working with multiple cameras in 3D and 2.5D mode. If you work with one camera only or only in 2D
mode, you have the choice to skip this step and work with a Range filter node  instead.

In general, if one determines a XYZ coordinate, first, an origin of the 3D space is needed, meaning the
coordinate system's origin, the orientation of the X-, Y- and Z-axis as well as their scaling.
Only when the cameras share the same 3D space information, they can agree on correct XYZ position
values for a tag. In other words, only if the origin for each camera can be determined accurately, their
reported tag position coincides. If the origin from one camera does not correspondent with the one from
another camera, they position the tag differently. As long as both cameras see the tag, its final position
is averaged but as soon as it is covered for one camera, it can not be averaged anymore and could jump
significantly.
The origin calibration also means that the cameras themself are positioned in the 3D space, this is why
this section is called "Camera XYZ Calibration". This can be observed in the 3D mode in the Preview
section.

For calibrating the origin for one camera or all of them at the same time, you need to
measure and mark a rectangle somewhere on your stage (i.e. four co-planar points).
For most applications a 1-2m² spot that is seen by all cameras is ok, but this depends
on the distance and orientation of the camera(s). For example, if a camera sees a very
large area, a 1m² spot could be too small to achieve accurate results. Enlarge the
rectangle until it covers 1/4 - 1/3 of the camera image seen in the Preview. Ideally it

should be positioned in the center of the camera image. For complex applications, you might need to
constitute several rectangles for different cameras.
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For the sake of simplicity, you could mark four points on the floor. To achieve a better accuracy, the
rectangle should include the origin itself, the coordinate 0,0,0. Now, you may decide how the orientation
of your 3D space should be. For most scenarios, it makes sense to place the XZ plane onto the ground.
A positive X axis means "move right" in Pandoras Box; a positive Z axis "move backwards"; a positive Y
axis "move to ceiling". Having these axises in mind measure the XYZ position for each point of the
rectangle (in meters!) and copy the data to Widget Designer into the "Origin Settings" dialog as
described below. It's a good idea to number the corners 1-4 to remember the order. If you need to work
with more than one rectangle, measured these points starting from the 0,0,0 point!

Note: Widget Designer now also offers a "5 Point Calibration Mode". Instead of calibrating the cameras
with four points forming a rectangle, you can now also calibrate with five points. This method is of
interest when you need to achieve a very precise tracking or if you are not satisfied with your results
using a rectangle. In order to make text more readable, the manual will talk about four points or a
rectangle, but all information applies comparably to the "5 Point Calibration Mode".

In the next step, the four points belonging to one rectangle will be found in the image of each camera.
There are two modes available, an automatic and a manual one. Depending on the camera's position, the
rectangle's shape looks different and this is how the camera's position is calculated. 

< > buttons
With the help of these buttons you can select the preceding or following camera
without using the camera list. 

Set Origin XYZ
This button calibrates the selected camera based on the settings in the origin dialog
(and the current camera image). 

Wrench icon

This opens the below described dialog for the origin settings for the selected camera. 
For most applications, you calibrate the cameras using one rectangle. Choose "All
Cameras" and click the wrench icon. Only if different rectangles are used for different
cameras, select the specific camera in the camera list and enter its rectangle corners.

XYZ

This informs you about the calibrated XYZ position in meters for each camera and
helps you to determine whether the calculation ran without errors. It is a good workflow
to (roughly) measure the camera positions from the origin and compare these figures
with the WD values for the assumed position. If the calculation is wrong, the WD
position does not correspondent with the real one. If this is the case you can simply
click on the "Set Origin XYZ" button again to run the calculation again and achieve a
better result. If no result satisfies you, check the origin settings, the camera, the tags
and network.
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As said above, there are two modes available to find the four points of the drawn rectangle in each image
of a camera: the "Mouse Mode" and the "ID Tag Mode" which is easier and faster but requires four
different tags.

ID Tag Mode

1
Position four tags (holding four different IDs) on the rectangle's points. You might want to cordon
off the area so that the cameras keep a free view during the Calibration.

2a
Select "All Cameras" and open the "Origin Settings" dialog. Enter the XYZ location that you
measured in the rectangle into the fields of PT1, 2, 3 and 4.

2b Select "ID Tag Mode".

2c

Enter the corresponding IDs into the text field. Separate the ID numbers with a space, no comma
is needed. If you, for example, got tags with ID 11-14 and positioned them onto the rectangle
points as follows: 11 on 1, 12 on 2, 13 on 3 and 14 on 4, then you would enter into the text field:
11 12 13 14

2d Close the dialog.

3a Select one camera in the Camera List or with the < > buttons.

3b Adjust the "Camera Settings " and ... so that you see all four IDs in the Preview .

3c Click the "Set Origin" button.

4a
Now, the camera looks for the four IDs, the camera's position is calculated and displayed in the
XYZ field. 

4b
Check (roughly) whether the calculated position is correct. If you don't like the result, check
whether all tags are positioned accurately, check the camera itself (focus etc.), the origin
settings, lens settings and the network. You may click "Set Origin" again.

Start with step 3a for the remaining cameras.

If some cameras do not see the rectangle, a second one needs to be drawn, measured and equipped
with ID tags. Redo all above steps, only for step 2a, do not select "All Cameras" but a single one.
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Mouse Mode

1
You might want to cordon off the rectangle area so that the cameras keep a free view during the
Calibration.

2a
Select "All Cameras" and open the "Origin Settings" dialog. Enter the XYZ location that you
measured in the rectangle into the fields of PT1, 2, 3 and 4.

2b Select "Mouse Mode".

2c Close the dialog.

3a Select one camera in the Camera List or with the < > buttons.

3b

Adjust the "Camera Settings " so that you see all four IDs in the Preview .
If you like you can disable the IR Filter, or increase the exposure. If you have at least one tag,
you can use it to mark one corner after another. This helps you as the tag's light is seen more
clear and brighter .

3c Click the "Set Origin" button.

4

Now, a crosshair and magnifying glass is shown in the preview section. Click on the spots that
mark PT 1, then PT 2...
As soon as all 4 points are marked, the camera's position is calculated automatically and
displayed in the XYZ field.

4b

Check (roughly) whether the calculated position is correct. If you don't like the result, check
whether all marked points are positioned accurately ("Show Marker"  check box, check the
camera itself (focus etc.), the origin settings, and the network. You may click "Set Origin" again
to  mark the points again, for example after adjusting the exposure or light on stage.

Start with step 3a for the remaining cameras.

18.4.5.26.8  Marker Settings & Rendering

This topic explains the section "Marker Settings & Rendering" of the ID Tag node, for general information
about IR ID tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section includes an information field for markers and further settings for the 3D view in the Preview
. To toggle this on, choose "3D Tracking" in the section "Preview Settings" .

Marker Size
This changes the size of the circle that depicts an ID marker. Per default it is
rendered with 25cm.

Show Marker ID This displays a number on top of the ID marker.

Marker Test Info

This is a helpful tool. Enter an ID marker, e.g. 1 and next to the text field 4 numbers
will appear, e.g. 1.2 3.0 0.5|4, meaning that the position of the marker is X=1.2,
Y=3.0 and Z=0.5 whilst the camera count that see the tag currently is 4.
Using this tool you can control whether the calculated position of a stage marker
equals the measured one, verifying that the cameras are well calibrated. Secondly,
with the camera count, you can control whether all cameras work.

Note that the IDs need to be listed in the table in the section "ID Tag Settings" .

1095 1094

1095

1087

1094 1095

1109



1104

Stage (.3ds)
Click on the [...] button to load a .3ds file as a 3D model of your stage into the
preview. Make sure that it is saved in meter units and with a pivot point on top the XZ
plane .

Grid With/Depth This changes the amount of the rendered grid lines. One square is always 1m x 1m.

18.4.5.26.9  Global Tracking Settings

This topic explains the section "Global Tracking Settings" of the ID Tag node, for general information
about IR ID tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section is includes important settings that influence whether tags are seen and tracked.

2D
2.5D
3D Tracking

Y

Choose how you like to track the ID tags.

"2D Tracking" works only with one active camera (that does not need to be calibrated in
XYZ-space).
The result for the tag(s) is a position described with X and Y, there is no Z-coordinate! The
X- and Y-values depend on the resolution of the used camera, hence their unit is pixel. To
scale the values down, for example if you like to follow with a Video Layer, you can use a 
Range Filter  node.
If you calibrate the XYZ-position  of the camera, the output values are in meters and
independent from the camera resolution.

"2.5D Tracking" works with one or several active cameras. They need to be calibrated in
XYZ-space .
The result for the tag(s) is a position described with X and Z, both represented in meter
values and depending on the XZ-movement of the tag. The Y-coordinate does exist, but is
independent from the real up-down-movement. Set a constant height with the "Y" number
field.

"3D Tracking" works with several active cameras. At least three cameras must see a tag
at every time. The cameras need to be calibrated in XYZ-space .
The result for the tag(s) is a position described with X, Y and Z, all represented in meter
values and depending on the real XYZ-movement of the tag.

Mode
The mode (consisting of two figures) must match the "Mode" and "Interval" used when 
configuring the tags .

Blink ID

This option allows high tracking distances.

Per default, the option "Blink ID" is on. As soon as you exceed tracking distances of
10m, this option must be ticked.
If you track with lower distances and you have problems detecting a tag ID it might be
that the exposure is too high. In that case the off state in the blinking still produces a little
bit of light and disturbs the detection.
For distances below 1m, reducing the exposure might not be sufficient. In that case,
deactivate the "Blink ID" option.

An deactivated "Blink ID" option detects the on and off states of the blinking by comparing
brighter and darker pixels. This method allows maximum tracking distances of 5m and
requires slow movement towards the camera lens.

Double
Check ID

This influences the behavior of keeping the tag ID in case of an error. This does not apply
for the initial recognition of a tag which is always a double check, i.e. an ID is initialized
as soon as it is recognized twice. During and after recognition, tags transfer their ID with
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a blinking pattern. As an exception, it might happen that the pattern is not identified as
the same ID as before, it can either be lost or identified as a different ID. This can happen
when the tag is not seen by the cameras, e.g. when it disappears behind a set piece or is
hidden by another object for a moment.

Per default, the option "Double Check ID" is off. In case the ID is stable for a long time
and then changes or disappears for a short time, this error weighs comparatively little.
The "Off" option allows to soften or damp errors. As long as a blinking light is seen within
the diameter set up with "Max Motion" (in "2D Camera Tracking Settings")  it is
assumed that it is the ID it was in the last frames.

If "Double Check ID" is ticked, errors are not seen relatively but count absolutely. Even if
a tag ID changes or disappears for one moment, this counts. The old ID is removed and
deactivated if the error occurred for at least the number of the "Hold" frame count set up
in "2D Camera Tracking Settings" .
If you activate "Double Check ID" it is very important that the tracking recognition is 100%
stable as it is demanded that the ID stays constantly the same.

Max Pts

This option defines how many points are examined to "wear" an ID. The information in the
left upper corner of the preview  depicts how many "points" a camera sees. This is
influenced by the exposure and threshold set up in the section "Camera Settings" . In
best case, the point count matches the ID tag count. Realistically, it is a little higher due
to disturbing light. The higher "Max Pts" is, the more performance is needed. It is
recommended to increase this option only if necessary. If you decrease it to save
performance make sure that the real point count does not exceed it.

18.4.5.26.10  2D Camera Tracking Settings

This topic explains the section "2D Camera Tracking Settings" of the ID Tag node, for general information
about IR ID tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section includes settings that influence when a tag is recognized as an ID and when the ID is
blocked. Before changing these options, make sure that you see the tag's light in the preview  by
setting up the "Camera Settings"  and that the "Mode" in the section "Global Tracking Settings"
matches the one the IDs were configured with . 

Max
Motion

This defines the maximum distance an ID can move from one frame to the next. If it is
faster, the ID will be removed from the tag.
The value is depicted as an outer red circle in the preview .
The higher the value is, the more performance is needed. See also the below description of
"Min Distance".

Min
Distance

This defines the minimum distance two IDs can be next to each other. If they get closer,
their IDs will be removed.
The value is depicted as an inner red circle in the preview .
The smaller the value is, the less stable the ID detection might become as it is more likely
that the two blinking patterns or physical tags overlap each other. 

For a scenario where several tags are attached to one object (e.g. on a panel) it is likely
that they are quite close to each other (from the view of a camera or a certain rotation
angle). The minimum distance should be set up in such a way that the tags do not
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disappear when rotating and moving the object. At the same time the max. motion should
not be larger than the min. distance as this could allow that an ID "jumps" over to another
tag in case of a short fault detection. This is why the two parameters are linked to each
other.

Min /Max
Height
Width

This defines how small or big a tag can be seen from a camera before its ID is blocked.

Pre-Filter
This can be called a pre-damping as it defines the number of passed frames from which the
position of a processed 2D point is averaged.

18.4.5.26.11  3D Tracking Settings

This topic explains the section "3D Tracking Settings" of the ID Tag node, for general information about
IR ID tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section includes settings when the 3D Tracking Mode is used (see section "Global Tracking
Settings" ).

Average
3D Points

Enable the "Average 3D Points" option if you have set up several ID tags with the same ID
and like to average their position. With the number field you define how many tags with the
same ID should be taken into account.

Max Ray
Count

This defines how many cameras are taken to determine the 3D position of a tag. The
higher the value is, the more performance is needed.

Offset XYZ
With the offset options you can shift the origin of the 3D space, and thus all positions of
the tags, without the need of re-calibrating all cameras. Read more...

Scale XYZ
With the scale options you can increase or decrease the scaling of the coordinate-system
of the 3D space, and thus all positions of the tags, without the need of re-calibrating all
cameras. Read more...

3D
Threshold

The better the cameras are calibrated and the better the tag light detection and
environment is, the more the position from a tag for one cameras consents to the position
for another camera. Realistically, the tag's position is a little bit different for each camera. If
the estimated position from one camera is further away then the "3D threshold", which is
25cm per default, then this camera is not taken into account and the next available one is
taken.

XYZ Swap
and Invert

With the swap and invert options you can rotate the X-, Y- and Z axises of the 3D space to
change its orientation, and thus all positions of the tags, without the need of re-calibrating
all cameras. Read more...
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18.4.5.26.12  Performance Options

This topic explains the section "Performance Options" of the ID Tag node, for general information about
IR ID tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section includes settings influencing the performance of the tracking calculation.

Use Latest Frame
The default option is to always use the latest frame transmitted from the cameras
for the next processing interval. If the option is deactivated, the process waits for all
cameras to send a newer frame.

High Performance
Mode

This increases the prioritization of the thread for the operating system and allows
ultimate CPU usage. Per default the prioritization is set to a normal level.

CPU Sleep
This is the time in milliseconds that is waited before the next frame from the
cameras is read and processed.

18.4.5.26.13  Motion Prediction

This topic explains the section "Motion Prediction" of the ID Tag node, for general information about IR ID
tracking and links to other chapters please see the topic ID Tag Tracker .

This section includes settings for smoothing, predicting and damping a tag's position. For predicting
where the tag will be in the next frame, a complex formula is needed. Depending on the specific
movement of your tag, some factors need to be adjusted. A fast movement without abrupt stops is very
different to a slow continuous one.
The factors include adjustments for velocity and acceleration. However, the most important settings are
"Smoothing", "Time" and "Damping". For most tracking scenarios, the Velocity and Acceleration
settings can stay on there default values.

Smoothing

The prediction calculation includes an internal velocity and acceleration part. The
"Smoothing" value smoothes this data. It can be understood as a multiplying factor.
The smaller Smoothing is, the more the data is damped and modified to reduce
noise. Recommended values of 0.1 - 0.2 result in a lot of smoothing as commonly
there is much data noise that needs to be reduced.
The higher it is, the more the VA-part influences the prediction calculation. A factor
of 1 means no data modification, no smoothing.

Time (ms)

"Time" should be adjusted to meet the real duration that exists between measuring
the tag's position and seeing or hearing the result, e.g. projecting an image onto this
position. This delay is measured in milliseconds. Delay times up to 80-120ms are
common.

1087
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Blend VA
V Start
A Start

The velocity and acceleration part contribute to the calculation as soon as a "Start"
value is met. In other words, if the velocity (and acceleration respectively) is below
that start value, the VA-part is not taken into account. Velocity is measured in mm/
sec and Acceleration in mm/sec². If your tag jitters slightly eventhough the tag does
not move at all, you can raise the VA Start to 0.3 mm for instance to discard the VA-
prediction for these small movements
Blend VA blends between these two formulas with and without the VA-part.

Lighting and
Aux. Tracking

This applies when you have a node attached to the ID Tag Tracker node. Per default
you see in the node's input drop-down list, that every tag is expressed with a
position (X, Y, Z). In case you have more than one device following the tracking it
might be needed to add different damping times to the XYZ-position to route them to
different output nodes. When enabling "Lighting (PSN)" you will see that each tag
has an additional X2, Y2 and Z2 value; when enabling "Auxiliary Tracking" X3, Y3
and Z3 are available. As soon as you add different damping times (see below) to
these values, they will not coincide any more.
Please note that the two check boxes are not of interest when outputting PSN data
directly from the node!

Post Damping

This activates an additional damping calculation.
"Damping" is similar to the "Smoothing" as it smoothes the data. But as "Damping"
happens at the very end of the calculation, after prediction, it can be understood as a
post damping that smoothes the predicted curve to reduce jittering.
"Post Damping" can be applied to three data sets introduced above. You can setup
different damping times to...:
- "XYZ Tracking Values" = X1 Y1 Z1 (default values of the node)
- "Lighting (PSN)" = PSN output  send out directly from the node as well as X2 Y2
Z2 if the left check box is ticked
- "Auxiliary Tracking" = X3 Y3 Z3 if the left check box is ticked
You can set up damping times to adjust the tracking behavior for different devices. A
factor of 1 means no data modification, no damping whilst values between 0 and 0.1
mean a lot damping.

18.4.5.26.14  MA PSN Output

This topic explains the section "MA PSN Output" of the ID Tag node, for general information about IR ID
tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section includes settings for the PSN data output. The PosiStageNet protocol is for example
supported by MA Lighting consoles; more information can be found on www.posistage.net.
In general PSN needs to be activated in the Connection Manager  where you can also find other
settings like the IP and port for the PSN MA Tracking Server.

Enable This outputs the X-,Y- Z-coordinate of each tag.

Inv XYZ and
Swap

The coordinate system on which the tag positioning is based can be set up in two
steps.

First is when calibrating the cameras, second is in the section "3D Tracking
Settings". Both influence the values for a tag in Widget Designer. However, if the
lighting system uses a different coordinate system, you can change the position for
the tags only for the PSN output without the need to adjust Widget Designer or
Pandoras Box.
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You may invert the orientation of each axis, or even change the XYZ order into a YXZ
one, for example.

18.4.5.26.15  ID Tag Settings

This topic explains the section "ID Tag Settings" of the ID Tag node, for general information about IR ID
tracking and links to other chapters please see the topic ID Tag Tracker .

 

This section includes tag settings, most of them apply when the 3D Tracking Mode is used (see section 
"Global Tracking Settings" ).
If you like to use data of a tag as an output value of the ID Tag Tracker node or if you like to see the tag
in the preview , the tag needs to be listed in the table. To add a tag, click into the row and enter its ID
or use the "Add Multiple Tags" button. If you need to change an entry, simply (right-)click into the cell.
To delete a tag ID, you need to delete the entire row. To do so, click into the first cell (*) to select the
row and press the "Delete" key on your keyboard.
To see the data from the node activate "ID Data Output".

Enable Swap

This enables the "Swap" function. After enabling "Swap", two listed tags need to wear a
"Swap ID". Then, a "Radius" needs to be set up. Now, as soon as two tags meet each,
meaning that there are as close as the "Radius" says, they will exchange their "Swap
ID".

Enable Share

This enables the "Share" function. After enabling "Share", at least two listed tags need
to wear a "Share ID". Then, a "Radius" needs to be set up. Now, as soon as two tags
meet each, meaning that there are as close as the "Radius" says, one tag will overwrite
the "Share ID" of the other one.

ID Data
Output

This enables the data output meaning that the ID Tag Tracker node outputs data that
can be used in other nodes. 

Add Multiple
Tags

This opens a dialog that fastens the process of entering multiple tags to the list that is
described above.

Config ID Tag Please see the chapter "Config ID Tag" .

1087

1104

1094

1092



1110

18.4.5.26.16  Lighting Console Settings

This topic explains how to setup tracking with lights, e.g. a moving
light (or follow spot) follows the position of a person wearing a tag.
The goal is to give you a short to do list with settings for Widget
Designer and for the lighting console. For general information about
IR ID tracking and links to other chapters please see the topic ID Tag
Tracker .

As an exemplary console the GrandMA 2 was chosen. Other
consoles supporting PSN work also but their settings might differ.

Requirements

Network connection between console and Widget Designer PC
Widget Designer and the lighting console are connected via network and both are setup with a static IP
address. You can use any IP range but if you additionally like to send Art-Net data you should use a 
2.x.x.x IP address and 255.255.255.0 as subnet mask. Make sure that this connection works by pinging
the console from the WD PC! When using the onPC-version, double-check also that your anti-virus
software and Firewall are not blocking incoming data.

Same origin
The 3D world setup in WD for the tracking and the 3D space setup in the console for the (moving) lights
should be based on the same origin position, i.e. 0,0,0 point and scaling. It is possible to offset and
rescale data, but it makes life much easier to work with the same reference point from the beginning.
You may choose to use different orientations (rotation of axises) but you must then swap or invert the
axises  for the PSN data. Most likely you need to choose XZY.

Lights position and orientation are measured and the light fixtures are setup accordingly
  Based on the mentioned origin, the moving lights' position and orientation needs to be measured and in
Stage View all light fixtures need to be placed according to these figures.
  1st tip: Level the moving lights (e.g. with a water level). 0.5° rotation can have a huge impact on the
position of the follow spot and it is far easier to level a device than measure its exact rotation.
  2nd tip: Using a laser distometer saves time especially for many lights and large distances. There are
3D laser tools available. coolux offers a tool for the 3D Disto from Leica .
Before mounting the lights it makes sense to mark the point whereto you like to measure e.g with tape.
Check whether the console knows your light and the distance (offset) between the pivot in the yoke and
the lens. Measure then the distance between your own marker and the lens and add / subtract this when
entering the height for the light
 3rd tip: Mark 4-8 positions on your stage, measure them and tell the lights to go to this point.
Depending on a light's offset to these various stage positions, you can modify its position and orientation
until it is accurate enough.
4th tip: Check whether the movement of the lights in Stage View accords with the real movement, if not
swap the Pan / Tilt parameter. For doing so, you might need to deactivate "XYZ Positioning" in "Fixture
Types" temporarily.

- Tracking in WD is setup
  All cameras are calibrated and when a tag moves around, it does the same in the preview without
disappearing and jittering. Mark 4-8 positions on your stage, measure them and place a tag onto them.
Check whether the value from the ID Tag Tracker node coincides with your measurement.
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Settings to control a Moving Light / Stage Marker with a tag

In WD...
- Connection Manager > Enable PSN  protocol (do not change
the IP from the PSN Server)
- ID Tag Tracker node > Enable PSN  data
- ID Tag Tracker node > ID Tag Settings  > add all tag IDs you
want to use

In the lighting console...
- Setup > Network > PSN Network Configuration > Enabled =>
button is highlighted in yellow
- Add > Tracking System 
  - the column "Enabled" should say "Yes"
  - the column IP" should display the IP address from the WD PC
  - the columns "Multicast" and "Port" should coincide with the
(default) settings found in the WD Connection Manager

- as explained above, your patch should already include the light-
fixtures; check in "Fixture Types" that "XYZ Positioning" is turn on
- add a MA-Stage Marker-fixture to the patch, that is one fixture per
ID tag

- Setup > Network > PSN Network Configuration > View Tracker =>
displays a list of all PSN IDs, their Fixture ID and incoming XYZ-
position
- assign a fixture to each PSN ID (i.e. tag ID)

- the below images depict 14 moving light fixtures hanging site by
site in a truss whilst 2 stage markers (IR tags) lay on stage

- as the last step, select a fixture and go to "Position" to attach a
marker to it
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18.4.5.27  iPhone Remote Input

The iPhone Remote input node allows receiving the current iPhone remote single and multi-touch values.
Set up your iPhone Remote Control in the Remoting Tool .

The Node generates the following output:
- Absolute and Relative Positions of two points (X1/Y1 and X1/X2),
- Distance and Angle Absolute / Relative,
- P1 or P2 pressed (True=1 and False=0),
- X,Y and Z Accelerometer.

1257
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18.4.5.28  Joystick Input

The Joystick input node allows intercepting standard Windows gaming device input values for axis slider
and button input.

Node Properties:

Device:
Choose your gaming device from the list.

The Node generates the following output:
- X Axis,
- Y Axis,
- Z Axis,
- X Rot Axis,
- Y Rot Axis,
- Z Rot Axis,
- Point of View
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- Slider 1 to 12
- Button 1 to 12

18.4.5.29  Kinect Input

The Kinect input node allows capturing up to 8 filtered and tracked points/regions of interest via the
Kinect device. Setup your device in the Kinect Tool  first.

Node Properties:

The Node generates the following output for each of the 8 points:
- Active,
- Pos X,
- Pos Y,
- Depth,
- Delta Pos X,
- Delta Pos Y,
- Delta Depth.

It outputs the overall active point count as well:
- Point Count.

18.4.5.30  Kinesys Input

The Kinesys K2 Input Node allows you to grab X,Y,Z, Pitch, Tilt & Roll data from a Kinesys K2 
Please note, that a Multicast UDP Client on Port 6061 is required. Set it up in the Connection Manager

.

1269

1239



1115

Node Properties:

UDP ID:
Choose the ID of your UDP Multicast Connection (see Connection Manager ).

Construct ID:
Choose the ID of the Construct as it is named in your Kinesys K2.

The Node generates the following output:
- Kinesys K2 X,
- Kinesys K2 X Delta,
- Kinesys K2 Y,
- Kinesys K2 Y Delta,
- Kinesys K2 Z,
- Kinesys K2 Z Delta,
- Kinesys K2 Pitch,
- Kinesys K2 Pitch Delta,
- Kinesys K2 Tilt,
- Kinesys K2 Tilt Delta,
- Kinesys K2 Rotate,
- Kinesys K2 Rotate Delta.

1239
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18.4.5.31  Label Input

The Label input node allows using label texts for further processing.

Node Properties:

ID:
Enter the Label ID in the text field.

The Node generates the following output:
- Label Input Value (as String).

18.4.5.32  Media Control Input

The Media Control input node allows to intercept the last called Folder and File ID of one or multiple
Media Control Panels.

Node Properties:

ID:
Enter the Media Control Panel ID in the text field.

The Node generates the following output:
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- Media Control Input Folder ID and
- Media Control Input File ID of the last called File.

18.4.5.33  Midi Input

The Midi input node allows receiving 7bit or 15bit input values as well as Note On/Off and raw byte
messages. 
The Midi connection needs to be enabled in the Connection Manager .

Node Properties:

Enter the Status, Channel and Note value. Choose between 7bit or 15bit input values.

The Node generates the following output:
- Midi Input Current Value
- Midi Input Trigger
- Midi Input Status Byte
- Midi Input Channel Byte
- Midi Input DataByte 1 to DataByte 3 and
- Midi Input BPM.

1239
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18.4.5.34  Midi Note Catch  Input

The node catches and outputs the first incoming Midi Note Message.
This is in particular useful for game scenarios where WD needs to identify the first incoming Midi Note
event.
This node can be reset by setting Parameter 1 to 0 via the command “WDNodeSetParam ”.

The Node generates the following output:
- Midi Catch Input Channel,
- Midi Catch Input Note,
- Midi Catch Input Velocity,
- Midi Catch Input isCatched.
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18.4.5.35  Motion Detector Input

The Motion Detection input node provides the data given by the Motion Detector Tool  for further
processing.

Node Properties:

X/Y:
Choose here the Input Cell Index from the Motion Detector Tool whose data you want to use by entering
the column number (X) and the row number (Y).

The Node generates the following output:
- Motion Detector Value (the value of the chosen cell)
- Motion Detector Last X (X index of the cell in which the last motion was detected)
- Motion Detector Last Y (Y index of the cell in which the last motion was detected)
- Motion Detector Last Value
- Motion Detector Sum (Sum of all cell values)
- Motion Detector Average (Average of all cell values).
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18.4.5.36  Mouse Input

The Mouse input node provides the Mouse X&Y position as well as the three button press states Left,
Middle and Right.

The Node generates the following output:
- Mouse X Pos,
- Mouse Y Pos,
- Mouse Wheel,
- Mouse Left Click,
- Mouse Middle Click,
- Mouse Right Click.
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18.4.5.37  Multi-Tocu Item Input

The Multi-Touch Item input node provides the current state of a Multi-Touch Item (Position, Rotation,
Size) as well as the current state of the Layer in PB linked to this Item. See the Multitouch Tool  for
further information and setup.

Node Properties:

Panel ID:
Enter the ID of the Multi-Touch Panel.

Item ID:
Enter the ID of the Multi-Touch Item you want to use.

The Node generates the following output:
- Multi-Touch Item X Pos %
- Multi-Touch Item Y Pos %
- Multi-Touch Item Z Rot °
- Multi-Touch Item X Size %
- Multi-Touch Item Y Size %
- Multi-Touch Item X Size %
- Multi-Touch Item X Pos PB
- Multi-Touch Item Y Pos PB
- Multi-Touch Item Z Rot PB
- Multi-Touch Item X Size PB
- Multi-Touch Item Y Size PB
- Multi-Touch Item X Size PB
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18.4.5.38  Multi-Touch Panel Point Input

The Multi-Touch Panel Point input node provides the current Position of a Point inside a Multi-Touch
Panel. See the Multitouch Tool  for further information and setup.

Node Properties:

Panel ID:
Enter the ID of the Multi-Touch Panel.

Point ID:
Enter the ID of the Multi-Touch Point you want to use.

The Node generates the following output:
- Multi-Touch Point X Pos
- Multi-Touch Point Y Pos
- Multi-Touch Point Active

18.4.5.39  NET Link - Generic I/O

The NET Link Input node allows to communicate with the Calibration Link or a NET Link equipped with
input and / or output boards. Please see more information in the chapter covering the NET Link .
On the one hand the node receives information send from available inputs, hence, it provides this data to
other nodes in Widget Designer. On the other hand, it allows to configure the device and send
commands to it. In case of output boards, a contact closure can be commanded through this node.

The Calibration Input node , the Relay Output node  and the tool "Projector Calibration Manager
" might also be of interest for you.
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Create > Nodes > Input > Devices > NET Link - Generic I/O

Node properties

IP and Port
Enter the correct IP address and port from the NET Link's CPU or from the Calibration Link.

Reset To Factory Default
This buttons resets the above settings in the Widget Designer interface. To reset the device itself (to the
IP address 192.168.178.222 and the port to 5000), hold the "Reset" button down whilst plugging the
power into the device. Release the button again.

Connect / Disconnect
Before starting to communicate with the device, for instance receive data, the node must be connected
to the device. The connection itself consumes no performance.

Change IP Address
This button opens a new dialog whereto you may enter another IP address and port for the device.
Power-cycle the device to apply the changes.
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Config Module
A NET Link / Calibration Link is configured by coolux as you have ordered it. However, if you have
changed some input / output boards, the processor must be configured in terms of giving him the
information which boards are connected to it. Click the "Config Module" button to open a new dialog
where you may choose the according boards per processor connection. Find more details in the NET
Link hardware chapter .

Start Data / Stop Data
As soon as data is processed via the network from the device to Widget Designer, performance is drawn.

Store Last Transmission State to NET Link CPU
Click this button and power-cycle the device if you wish that it remembers whether it should (not) send
data as soon as it is powered up.

Node control

This node allows to be remote controlled via so called node commands . Node commands access
functions from a node and / or set a parameter.

Enter "node", followed by the according ID and a dot and a list will pop up showing all available
commands for the node. For instance, node1.StartData will execute the function automatically

without the need of opening the Item Properties dialog and clicking the according button manually.
In addition, the node properties with a parameter ID (the small superscript number) can be edited via the
commands WDNodeSetParam,NodeID,ParamID,Value or nodeID.ParamID@Value.

Node output values

The node generates the following output:

- A1 to A8 (0 - 1023) for the first analog bus
- B1 to B8 (0 - 1023) for the second analog bus
- D1.1 to D1.128 (Open = 0, Closed = 1) for the first digital bus
- D2.1 to D2.128 (Open = 0, Closed = 1) for the second digital bus
- Connected
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18.4.5.40  ODSL 30 Input

The ODSL 30 Input node lets you read out distance data from the optical distance measuring sensor
ODSL 30 via a local COMPort connection (RS232). The COMPort Connections can be found and setup
in the Connection Manager .

Node Properties:

COM Connection ID:
Choose the COMPort Connection ID to listen to. The COMPort Connections can be found and setup in
the Connection Manager .

The following settings need to be used: 
600/8n1 (Baud Rate: 9600, Parity: None, Data Bits: 8,Stop Bits:1).

Value Range:
The range defines the jump point of a maximum value back to zero.
Enter the range in mm. This is only important for correct calculation of delta values when using as
incremental length count.  

The Node generates the following output:
- ODSL 30 RS 232 Value
- ODSL 30 RS 232 Delta
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18.4.5.41  OSC Input

The OSC Input node lets you receive data via the Open Sound Control Protocol, e.g. from iPhone, iPad
or iPod (tested with Touch OSC). 
A UDP Broadcast Input Connection is required, see Connection Manager .

Node Properties:

UDP Connection ID:
Choose the UDP Connection to listen to. The UDP Connections can be found and setup in the 
Connection Manager .

OSC Filter:
If an OSC message is incoming, the OSC Message Header will be displayed. To assign messages with
this Header to this OSC Input Node (e.g. send from a fader or button in OSC Touch), press [take]. 
Float1 to Float8 and Int1 to Int8 will now display the message details.

The Node generates the following output:
- OSC Input Float 1-8
- OSC Input Int 1-8
- OSC Input Msg
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18.4.5.42  Page Input

The Page input node allows using the current page name for further processing.

Node Properties:

The Node generates the following output:
- Page input value

18.4.5.43  PB Device Parameter Input

The PB Device Parameter input node provides feedback values for all layer parameters from a Pandoras
Box Master and Backup System for further processing.

Node Properties:

Site ID:
Enter the Site ID from which you want to get feedback values.

Device ID:
Enter the Device ID from which you want to get feedback values.

Parameter:
Choose the parameter you want to monitor from the list.
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The Node generates the following output:
- PB Device Parameter Input Value
- PB Device Parameter Input Backup Value

Example:
To route the current value of the parameter X Position of layer 1.3 to another node, enter “1” as SiteID, “3”
as DeviceID and choose “X Position” from the drop-down list.

The PB Master and Backup Connection needs to be set up in the IP Configuration  first!

18.4.5.44  Pink Input

The Ping input node gives you feedback in a certain time interval if the specified IP is online.

Node Properties:

IP Address:
Enter the IP Address you want to ping.

Interval:
Enter the update interval in milliseconds.

The Node generates the following output:
- Ping status (true or false). 

18.4.5.45  Projector Control Input

The Projector Control Input node allows to communicate with projectors via a TCP connection. The
communication includes controlling the projector, e.g. closing the shutter or powering it, as well as
receiving feedback information, e.g. regarding the shutter or power status. The node itself has three
status "lights" that change color depending on the projector's response. Hence, the node provides a
good overview without the need to open its properties or connect the node with other controls like labels

. In order to send a message to a projector you may either press the according button in the node or
execute a node command as described below. 
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Create > Nodes > Input > Devices > Projector Control

Node properties

IP and Port
Enter the correct IP address and port from the projector.

Connect / Disconnect
If the connection can be enabled, the third "light" from the node changes to green; yellow indicates that
the connection attempt failed whilst red means that the projector is definitely not connected, e.g.
because the connection has not been initialized yet or the Disconnect button has been pressed.

Command Messages
The Command Messages allow you to control the projector. Enter the messages for each according
action. You may find the syntax in the documentation of your projector, mostly referred to as TCP or
serial commands. Please note, that a carriage return or line feed could be demanded. Please see the
chapter Syntax TCP, UDP, serial messages  for more information.
Click the according Send button to forward the message to the projector. Alternatively you may execute
a node control as described below.

If your projector supports PJLink and the password is disabled (by using the browser control window) the
syntax to turn it on would be: %1POWR 1[CR]

Projectors from Barco usually request hexadecimal commands. Please find an example in our forum. To
send "Lamp On" for example: [hfe h00 h00 h03 h02 h76 h1a h01 h96 hff]
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Request Messages
The Request Messages allow you to get feedback from the projector. First, enter the messages for the
according request. You may find the syntax in the documentation of your projector, mostly referred to as
TCP or serial commands. Please note, that a carriage return or line feed could be demanded. Please
see the chapter Syntax TCP, UDP, serial messages  for more information.
Enter the time interval in which the request should be forwarded to the projector.
Lastly, enter the expected message what the projector responds, one for a positive answer and one for a
negative one. As long as the request is answered positively, the according "light" of the node stays
green. A negative answer is indicated by a red color.
The first light informs about the shutter state, the second about the lamp status and the third about the
connection status.

Node control

This node allows to be remote controlled via so called node commands . Node commands access
functions from a node and / or set a parameter.

Enter "node", followed by the according ID and a dot and a list will pop up showing all available
commands for the node. For instance, node1.PowerOn will execute the function automatically without

the need of opening the Item Properties dialog and clicking the according button manually.
In addition, the node properties with a parameter ID (the small superscript number) can be edited via the
commands WDNodeSetParam,NodeID,ParamID,Value or nodeID.ParamID@Value.

Node output values

The node generates the following output:
- Connected 0,1
- Lamp State 0,1
- Shutter State 0,1

18.4.5.46  Random Input

The Random input node provides a random number on a given update interval and value range.

Node Properties:

Interval:
Enter the update interval in milliseconds.
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Range:
Enter the value range.

The Node generates the following output:
- Random Value.

18.4.5.47  Remote Touch Input

The Remote Touch input node allows processing any incoming remote touch point. 

The remote input needs to be set up in the Connection Manager .

Node Properties:

Point ID:
Enter here the ID of the incoming remote touch point you want to use for further processing.

The Node generates the following output:
- Point X Pos
- Point Y Pos
- Point Active

1239
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18.4.5.48  RSS Input

The RSS input node provides all incoming RSS feeds for further processing. 
Please setup the RSS connection in the RSS Settings  before.

Node Properties:

Start Index:
Enter the Index of the RSS Feed where the cycling should start. This will affect the outputs Current RSS
and Current ID.

Interval (seconds):
All incoming RSS Feeds will be cycling in the entered amount of time. This will affect the outputs Current
RSS and Current ID.

Single Index:
Enter the Index of the RSS Feed that you want to route to the output Single RSS.

The Node generates the following output:
- RSS Count, 
- Last RSS,
- Current RSS,
- Current ID,
- Single RSS,
- RND RSS.
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18.4.5.49  Sensor Link Input

The Sensor Link input node provides the absolute, relative and delta values of the Sensor Link  device
- the encoder inputs, the analog 0-10V inputs and the switch states 1 to 8.

Node Properties:

Please enter the Sensor Link IP and Port number. 
Connect the WD with the Sensor Link.

E1 Range:
Enter the encoder's amount of steps. If the encoder provides 1440 steps, enter 1439 because the
counting starts with zero.
Please note that the encoder's range has to be entered in the SensorLink Configuration Tool , too.
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E2 Range:
Enter the encoder's amount of steps. If the encoder provides 1440 steps, enter 1439 because the
counting starts with zero.
Please note that the encoder's range has to be entered in the SensorLink Configuration Tool , too.

E1 Relative:
Enter zero to reset the relative step count for the current encoder position or enter an offset value.

E2 Relative:
Enter zero to reset the relative step count for the current encoder position or enter an offset value.

The Node generates the following output:
- E1,
- E2,
- Analog 1,
- Analog 2,
- Switch 1,
- Switch 2,
- Switch 3,
- Switch 4,
- Switch 5,
- Switch 6,
- Switch 7,
- Switch 8,
- E1 Delta, 
- E2 Delta,
- E1 Relative,
- E2 Relative,
- Link Connection State.
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18.4.5.50  SerialLink Input

The SerialLink  input node provides all 24 GPI contact closure states. 
Connect a Serial Link via TCP in the Connection Manager  and set its TCP ID in the input node to
listen to the incoming packets.

Node Properties:

TCP Connection ID:
Enter here the SerialLink's TCP Connection ID.

The Node generates the following output:
- Status for all 24 GPIs (True (10V)=1 or False (0V)=0).
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18.4.5.51  SMS Input

The SMS input node provides all incoming SMS for further processing. 
Please setup the required GSM modem in the SMS Settings  before.

Node Properties:

Start Index:
Enter the Index of the start SMS, where the cycling should begin. This will effect the outputs Current
SMS and Current ID.

Interval (seconds):
All incoming SMS will be cycling in the entered amount of time. This will effect the outputs Current SMS
and Current ID.

Single Index:
Enter the Index of the SMS that you want to route to the output Single SMS.

The Node generates the following output:
- SMS Count, 
- Last SMS,
- Current SMS,
- Current ID,
- Single SMS,
- RND SMS (Random SMS).
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18.4.5.52  Space Navigator Input

The Space Navigator input node provides the 3D Mouse's X, Y and Z position as well as its X, Y and Z
Rotation.
It is necessary to install the 3D Connexion Driver before using this tool.

The Node generates the following output:
- X Pos,
- Y Pos,
- Z Pos,
- X Rot,
- Y Rot,
- Z Rot.

18.4.5.53  SMPTE Link Input

The SMPTE Link input node allows reading and using timecode within Widget Designer. 
The SMPTE connection needs to be enabled in the Connection Manager . 

The Node generates the following output:
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- Hours,
- Minutes,
- Seconds,
- Frames,
- FPS,
- Drop Frames.

18.4.5.54  Textbox Input

The Textbox input node allows intercepting Textbox Values within Widget Designer. Select the Textbox
ID to output the current Textbox Value.

Node Properties:

Textbox ID:
Enter the Textbox ID.

The Node generates the following output:
- Textbox Input Value.
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18.4.5.55  Text Reader Input

The Text Reader input node allows you to read out text files (.txt) for further processing. 

Node Properties:

File:
Click on [Path] and choose your text file via the windows browser.

Update File:
Please enter the interval time the files should be updated in seconds.
To do it manually click on [Update File].

Start Index:
Enter the Index of the line where the cycling should start. This will affect the outputs Current Line and
Current ID.

Interval (seconds):
All Text Lines will be cycling in the entered amount of time. This will affect the outputs Current Line and
Current Line ID.

Single Index:
Enter the Index of the line that you want to route to the output Single Line.

The Node generates the following output:
- Text Reader Line Count,
- Text Reader Last Line,
- Text Reader Current Line,
- Text Reader Current Line ID,
- Text Reader Single Line,
- Text Reader RND Line (Random Line),
- Text Reader Entire Text.
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18.4.5.56  Timax Input

The Timax input node provides XYZ data of the Ubisense Timax tracker.

Node Properties:

Port:
Enter the Timax UDP Port.

Tag ID:
Enter the Timex Tag ID.

The Node generates the following output:
- Timax X Position,
- Timax Y Position,
- Timax Z Position.
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18.4.5.57  TCP Input

The TCP input node allows receiving either ASCII or Byte values based on the selected TCP connection.
It can output by default any incoming packet as text if no ASCII filter is applied. 
The TCP Connections can be found and setup in the Connection Manager .

Node Properties:

TCP Connection ID:
Choose the TCP Connection to listen to. The TCP Connections can be found and setup in the 
Connection Manager .

Output Channels:
Set the Amount of Output Channels of this Input Node. 
Input Value 1 will output Data 1, Input Value 2 will output Data 2, etc.

ASCII Mode:
The ASCII Mode allows creating a custom ASCII protocol for data transfer. 
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Multiple data can be separated by the split string.
To determine the Start and End of the message, use the Start and Stop strings.

ASCII Start, Split and Stop:
Enter values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages .

Bytes Mode:
The Byte protocol allows data transmission based on a byte stream.
First send the header with any amount of Bytes, 
followed by the data count as 4 Byte integer, 
followed by a single Byte to describe the datatype used 
(1 = 4byte integer, 2 = 8byte double).

Byte Header:
Enter values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages .

Multi-Packets:
If the TCP packets are being received in parts, this option allows reading all part packets as one.

The Node generates the following output:
- TCP Input Value 1 - Value X (X = Amount of Output Channels).

18.4.5.58  TCP ASCII Stream Input

The TCP ASCII Stream input node allows receiving either ASCII values based on the selected TCP
connection. It can output by default any incoming packet as text if no ASCII filter is applied. 
The TCP Connections can be found and setup in the Connection Manager .
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Node Properties:

TCP Connection ID:
Choose the TCP Connection to listen to. The TCP Connections can be found and setup in the 
Connection Manager .

Message:
To determine the Start and End of the message, use the Start symbol [STX] and Stop symbol [ETX]
Enter values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages .

The Node generates the following output:
- TCP Stream In String.

18.4.5.59  TCP Query Input

The TCP Query String input node allows receiving ASCII feedback messages from TCP devices over a
TCP Port connection. The TCP Port connection needs to be enabled in the Connection Manager .

This input node will output any incoming packet as Text Only, Numeric Only or mixed string. 

Node Properties:

TCP Connection ID:
Enter the ID of the TCP Port Connection

Query String:
Enter the query string that you want to send to the specified TCP Device.

Interval:
Enter the time interval in ms in which the query string will be send to the TCP Device. 
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If you want to query the device manually (e.g. by pressing a Custom Script Button using the command
“WDNodeSetParam,'NodeID','ParamID','Value' ”), please set the Interval Time to 0 ms.

Message:
The response of the TCP Device will be displayed here. Please note that the responding device needs to
send a "carriage return", a "line feed" or an "end of text" at the end of its message. This can be done in 
ASCII, decimal or hexadecimal language . 
- carriage return is either [CR] or [d13] or [h0D]
- line feed is either [LF] or [d3] or [h3]
- end of text is either [ETX] or [d10] or [h0A]

Timeout:
The Timeout gives you feedback about the connection status. If Timeout is “0”, there is no
communication with the specified TCP Device. If Timeout is “1” the communication works.
Confirm your settings by pressing OK or Apply.

The Node generates the following output:
- TCP Query String Response, 
- TCP Query String Text Only,
- TCP Query String Numeric Only
- TCP Query String Timeout.
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18.4.5.60  TrackScan Input

The TrackScan input node provides the integration of a Barcode scanner to read values in mm for up to 2
km of distance.

Please note: 
There are two different revisions of the TrackScan device in circulation:
Rev.1 TrackScans (57600/8-N-1) only connect to the WD with this TrackScan Input Node (via the local
COM Port).
Rev.2 TrackScans (9600/8-N-1) can be used with this TrackScan Input Node (via the local COM Port)
and can also be connected via the TrackScan Serial Link  Input Node (through a Serial Link Device).

Node Properties:
Port:
Choose the TrackScan COM Port to listen to. The COM Port Connections can be found and setup in
the Connection Manager .

Range:
The range defines the jump point of a maximum value back to zero.
The range is only important for rotating platforms, to determine the index point. Enter the range in mm.
This is only important for correct calculation of delta values when using as incremental length count.

Revision:
Please choose here the Revision of your TrackScan (1 or 2).

The Node generates the following output:
- TrackScan Value,
- TrackScan Delta,
- TrackScan Byte 1,
- TrackScan Byte 2,
- TrackScan Byte 3.
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18.4.5.61  TrackScan Serial Link Input

The TrackScan Serial Link input node provides the integration of a Barcode scanner to read values in mm
for up to 2 km of distance via the coolux SerialLink device. It requires a Serial Link to be connected as
TCP client in the Connection Manager.

Please note: 
There are two different revisions of the TrackScan device in circulation:
Rev.1 TrackScans (57600/8-N-1) only connect to the WD with the TrackScan Input Node  (via the
local COM Port) and not with this TrackScan Serial Link input Node!
Rev.2 TrackScans (9600/8-N-1) can be used with the TrackScan Input Node (via the local COM Port) and
can also be connected via this TrackScan Serial Link Input Node (through a Serial Link Device).

Important:
The Serial Link Ports must be set to 9600 Parity off. Please make sure that TX and RX are crossed (e.g.
by using gender changers and a null modem cable between Serial Link and each TrackScan)!

Node Properties:

TCP Connection ID:
Enter here the Serial Links Connection ID. The TCP Connections can be found and setup in the 
Connection Manager .

Serial Port ID:
Choose here the Serial Links Port ID the TrackScan is connected to.

Value Range:
The range defines the jump point of a maximum value back to zero.
The range is only important for rotating platforms, to determine the index point. Enter the range in mm.
This is only important for correct calculation of delta values when using as incremental length count.

The Node generates the following output:
- TrackScan Serial Link Value,
- TrackScan Serial Link Delta.
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18.4.5.62  UDP Input

The UDP input node allows receiving either ASCII or Byte values based on the selected UDP connection.
It can output by default any incoming packet as text if no ASCII filter is applied. 
The UDP connection can be found and set up in the Connection Manager .

Node Properties:

UDP Connection ID:
Choose the UDP Connection to listen to. The UDP Connections can be found and setup in the 
Connection Manager .

Output Channels:
Set the Amount of Output Channels of this Input Node. 
Input Value 1 will output Data 1, Input Value 2 will output Data 2, etc.

ASCII Mode:
The ASCII Mode allows creating a custom ASCII protocol for data transfer. 
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Multiple data can be separated by the split string.
To determine the Start and End of the message, use the Start and Stop strings.

ASCII Start, Split and Stop:
Enter values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages .

Bytes Mode:
The Byte protocol allows data transmission based on a byte stream.
First send the header with any amount of Bytes, 
followed by the data count as 4 Byte integer, 
followed by a single Byte to describe the data type used 
(1 = 4byte integer, 2 = 8byte double).

Byte Header:
Enter values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages .

Multi-Packets:
If the UDP packets are being received in parts, this option allows reading all part packets as one.

The Node generates the following output:
- UDP Input Value 1 - Value X (X = Amount of Output Channels).

18.4.5.63  UDP ASCII Stream Input

The UDP ASCII Stream input node allows receiving ASCII values based on the selected UDP connection.
It can output by default any incoming packet as text if no ASCII filter is applied. 
The UDP connection can be found and set up in the Connection Manager .
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Node Properties:

UDP Connection ID:
Choose the UDP Connection to listen to. The UDP Connections can be found and setup in the 
Connection Manager .

Message:
To determine the Start and End of the message, use the Start symbol [STX] and Stop symbol [ETX]
Enter values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages .

The Node generates the following output:
- UDP Stream In String.

18.4.5.64  Value Input

The Value input node allows you to set a numeric value for further processing.

Node Properties:

Value:
Enter the numeric value.

The Node generates the following output:
- Value.
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18.4.5.65  Variabel Input

The Variable input node allows you to use a variable for further processing.

Node Properties:

Variable:
Enter the variable name.

The Node generates the following output:
- Variable.

To set up and process variables, please use these scripts :
To see all existing variables and their values, see the Variable List .

18.4.5.66  Wheel Input

The Wheel input node allows intercepting Wheel Values within Widget Designer. Select the Wheel ID to
output the current Wheel value.

Node Properties:

Wheel ID:
Enter the Wheel ID.
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The Node generates the following output:
- Wheel Input Value.

18.4.5.67  WII Input

The Wii input node provides all 4 IR tracking coordinates as well as all Button presses and
accelerometer data for up to 4 Wii controllers. The additional Nunchuk and Balance Board are also
supported. The Wii controller needs to be connected via Bluetooth as HID.

The Node generates the following output:
- Please see all items listed in the picture above.
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18.4.5.68  XY Panel Input

The XY Panel input node allows intercepting XY Panel Values within Widget Designer. Select the XY
Panel ID to output the current XY Panel values.

Node Properties:

ID:
Choose the XY Panel ID.

The Node generates the following output:
- Input X Position,
- Input Y Position,
- Input Distance,
- Input Angle.

18.4.6  Filter Nodes

Filter nodes are used between Input and Output nodes, they recalculate the input value. Please see the
introductory chapter if you like to learn more about other node types or how to create and work with
nodes  in general.

ADD RELATIVE
The Add Relative filter node continuously adds up incoming data. Since the Node system is updated 60
times per second the sampling speed of the node system is limited. As property windows update 25
times per second the sampling speed is increased with every property windows of an element in the
node chain. It is recommended to keep all node property dialogs closed when an add relative filter node
is being used.

ANGLE TO POINT
The Angle To Point filter node allows to calculate Pan and Tilt angles based on the relationship of moving
targets xyz position input values according to the fixed position of the source. This node is useful to be
used for tracking setups that require calculating the exact Pan and Tilt angle for remote cameras or
Moving Light projectors.

DAMPING PREDICTION
The prediction based damping filter node allows reducing noisy input values and extrapolating a trend
based on the history of the received values.
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DAMPING TIMED
The time based damping filter node allows to set a delay time for the input data to be damped.

DELTA
The delta filter node allows calculating the incremental delta value of the current value vs. the last input
value. The Range defines the maximum value count in case of rotary encoders that would provide the
same value range per 360°.

DYNAMIC TRIGGER
The Dynamic Trigger filter node allows to act as a gate with a given hold and release time and an
additional target value. The Dynamic Trigger filter node is one of the few nodes that is related to the
sample rate of the node system. When no node property window is opened, the filter works at the given
time values. If the updates are increased by open node property dialogs of the node chain, then the
timings will be affected. It is recommended to keep all node property dialogs closed when an add relative
filter node is being used.

IF
The If filter node allows comparing incoming data and outputs a true or false output value.

JITTER REDUCE
The jitter reduce filter node allows to eliminate jittering input data, for example when using the
TrackScan.

The filter updates the output value, if the input is outside the min/max range. If the input is within the min/
max range, the last value is on hold.

MAX
The Maximum filter node allows setting a maximum limit to input values. 

MIN
The Minimum filter node allows setting a minimum limit to input values.

POLAR > RECTANGULAR
The Polar to Rectangular filter node allows converting radial XY values to rectangular XY values. This
node is useful to convert tracking values received from a spherical surface to apply them to a two
dimensional texture coordinate space.

RANGE ASYMMETRIC
The Range Asymmetric node allows to convert a low and high range of an input source value and to leave
a gap between the ranges. This filter is especially useful for filtering inconsistent joystick data, for
example when the XY motion is mechanically snapping back to center, the center value might not
always return the same values. Instead of creating a long node chain with multiple Range and min max
nodes this nodes does it all in one step.

RANGE
The Range filter node allows to map any input range to a new output range. You may set limits,
otherwise if the input range is exceeded in both, positive or negative values, the conversion will still be
applied.

MATH FILTER NODES
The Math Filter nodes provide access to all standard math calculations.

ABS
Return an absolute positive value of the input source value.

ACOS
Arcus Cosine calculation.
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ADD
Additive calculation of two source values.

ASIN
Arcus Sine calculation.

ATAN
Arcus Tangent calculation.

CEILING
Returns the maximum value of a decimal input value.

COS
Cosine calculation.

DEGREE > RADIANS
Converts a value from degrees to radians. This filter node is useful for cosine, sine and tangent
calculation and value conversion.

DIVIDE
Division calculation of two source values.

FLOOR
Returns the minimum value of a decimal input value.

LOG
Logarithm calculation of the input source value.

MODULO
Modulo calculation of the input source value.

MULTIPLY
Multiplies two input source values.

PERCENT
Calculates the percent of an input source value.

POWER X̂ Y
Power of two input source values.

RADIANS>DEGREE
Converts a value from radians to degrees. This filter node is useful for cosine sine and tangent calculation
and value conversion.

ROUND
This filter allows to round decimal values to a given amount of decimal places.

SIN
Sine calculation.

SQRT
Square Root calculation of the input source value.

SUBTRACT
Subtraction of two input source values.

SUM
Sums up all input values attached.
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This is useful when connecting many delta nodes to determine easily when one of them has changed its
value.

TAN
Tangent calculation.

TEXT NODES

Use these nodes to handle text assets, e.g. to compare texts.

COMPARE TEXT
Compares two text sources.

CONTAINS TEXT
This filter allows scanning a text input source for specific words.

DATE TO TEXT
Converts numeric input values to date string.

LEADING ZEROS
Generates Leading Zeros for Text.

TEXT COMBINER
Combines up to eight text input sources or entered text to one string.

18.4.6.1  Add Relative Filter

The Add Relative filter node continuously adds up incoming data. Since the Node system is updated 60
times per second the sampling speed of the node system is limited. As property windows update 25
times per second the sampling speed is increased with every property window of an element in the node
chain. It is recommended to keep all node property dialogs closed when an add relative filter node is
being used.

Filter Properties:
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Input:
Choose input node from list or enter numeric value

Default:
Enter the Default Value to which the Input Values will be added.

Min:
Enter the limit for the minimum output value.

Max:
Enter the limit for the maximum output value.

The filter generates the following output:
- Add Relative Output.

18.4.6.2  Angle to Point Filter

The Angle To Point filter node allows to calculate Pan and Tilt angles based on the relationship of moving
targets xyz position input values according to the fixed position of the source. This node is useful to be
used for tracking setups that require calculating the exact Pan and Tilt angle for remote cameras or
Moving Light projectors.

Filter Properties:

Input Point X:
Choose input node from list or enter numeric value
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Input Point Y:
Choose input node from list or enter numeric value

Input Point Z:
Choose input node from list or enter numeric value

Location X:
Enter the X Position of the reference point

Location Y:
Enter the Y Position of the reference point

Location Z:
Enter the Z Position of the reference point

The filter generates the following outputs:
- Pan Angle
- Tilt Angle

18.4.6.3  Damping Reduction Filter

The prediction based damping filter node allows reducing noisy input values and extrapolating a trend
based on the history of the received values.

Filter Properties:

Input:
Choose input node from list or enter numeric value

Damping:
Enter the damping factor.
0,1 = maximum damping
1    = no damping

The filter generates the following output:
- Damping Output
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18.4.6.4  Damping Timed Filter

The time based damping filter node allows setting a delay time for the input data to be damped.

Filter Properties:

Input:
Choose input node from list or enter numeric value

Delay (ms):
Enter the delay time in milliseconds

The filter generates the following output:
- Damping Timed Result
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18.4.6.5  Delta Filter

The delta filter node allows calculating the incremental delta value of the current value vs. the last input
value. The Range defines the maximum value count in case of rotary encoders that would provide the
same value range per 360°.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

Range:
Enter maximum value if incremental values are used to calculate correct delta values between the start
and end value. 
You will need this for example when using encoders from 0 to 1439.

The filter generates the following output:
- Delta Output.
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18.4.6.6  Dynamic Trigger Filter

The Dynamic Trigger filter node allows acting as a gate with a given hold and release time and an
additional target value. The Dynamic Trigger filter node is one of the few nodes that is related to the
sample rate of the node system. When no node property window is opened, the filter works at the given
time values. If the updates are increased by open node property dialogs of the node chain, then the
timings will be affected. It is recommended to keep all node property dialogs closed when an add relative
filter node is being used.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

Hold Time (ms):
Enter the Hold Time in milliseconds 

Release Time (ms):
Enter the Release Time in milliseconds

Release Value:
Enter the Release Value, this will be the minimum value the node gives out.

The filter generates the following output:
- Dynamic Trigger Result
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18.4.6.7  If Filter

The IF filter node allows comparing incoming data and it outputs a true or false output value.

Filter Properties:

A:
Choose input node from list or enter numeric value.

Operator:
Choose the Operator.

B:
Choose input node from list or enter numeric value.

True:
If the operation is True, this input node value or entered numeric value will be given out as Output Value.

False:
If the operation is False, this input node value or entered numeric value will be given out as Output Value.

The filter generates the following output:
- Output Value
- Output State (1=True, 0=False)
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18.4.6.8  Jitter Reduce Filter

The jitter reduce filter node allows to eliminate jittering input data, for example when using the
TrackScan.

The filter updates the output value, if the input is outside the min/max range. If the input is within the min/
max range, the last value is on hold.

Filter Properties:

Input:
Choose input node from list (a delta value).

Min:
Enter minimum value for filtering the jitter from the delta input.

Max:
Enter maximum value for filtering the jitter from the delta input.

The filter generates the following output:
- Jitter Reduce Output.

Example: 
Place a delta filter node behind your sensor input node to calculate the jittering delta. In the jitter reduce
node choose the delta node output as "Input". If you do not want to route the sensor input data to an
output node as long as the delta is between e.g.. -1 and 1, enter these values for min and max. Connect
the sensor output node as well to the jitter reduce filter node and choose the sensors output data for
"Output".
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18.4.6.9  Max Filter

The Maximum filter node allows setting a maximum limit to input values. 

Filter Properties:

Input:
Choose input node from list or enter numeric value.

Threshold:
Choose the Threshold (maximum output value).

The filter generates the following output:
- Max Output Value
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18.4.6.10  Min Filter

The Minimum filter node allows setting a minimum limit to input values.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

Threshold:
Choose the Threshold (minimum output value).

The filter generates the following output:
- Min Output Value
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18.4.6.11  Polar>Rectangular Filter

The Polar to Rectangular filter node allows converting radial XY values to rectangular XY values. This
node is useful to convert tracking values received from a spherical surface to apply them to a two
dimensional texture coordinate space.

Filter Properties:

X Pos:
Choose input node from list or enter numeric value.

Y Pos:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Polar>Rect X
- Polar>Rect Y
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18.4.6.12  Range Filter

The Range filter node allows mapping any input range to a new output range. You may set limits,
otherwise if the input range is exceeded in both, positive or negative values, the conversion will still be
applied.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

Input Min:
Enter the Input Minimum value.

Input Max:
Enter the Input Maximum value.

Output Min:
Enter the Output Minimum value. The Input Minimum value will be mapped to the Output Minimum value.

Output Max:
Enter the Output Minimum value. The Input Maximum value will be mapped to the Output Maximum
value.

The filter generates the following output:
- Range Output.
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18.4.6.13  Range Asymetric Filter

The Range Asymetric node allows to convert a low and high range of an input source value and to leave a
gap between the ranges. This filter is especially useful for filtering inconsistent joystick data, for example
when the XY motion is mechanically snapping back to center, the center value might not always return
the same values. Instead of creating a long node chain with multiple Range and min max nodes this
nodes does it all in one step.

Input:
Choose input node from list or enter numeric value.

Input Min / Output Min End:
For all values below the Input Minimum the Output Min End Value will be the output.

Input Min Threshold / Output Min End :
For all values from Input Min up to Input Min Threshold the range between Output Min End and Output
Min Start will be given out.

Input Max Threshold / Input Max:
For all values between Input Min Threshold and Input Max Threshold the output will be the Default Value.

Input Max / Output Max End:
For all values above this Input Maximum the Output Max End Value will be the output.

Default:
This value will be given out for all input values between Input Min and Input Max Threshold.

The filter generates the following output:
- Range Asymmetric Output
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18.4.6.14  Math Filter Nodes

The Math Filter nodes provide access to all standard math calculations. Please see here  a summary
of all available math nodes.

18.4.6.14.1  Abs Filter

Returns an absolute positive value of the input source value.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Abs Output

18.4.6.14.2  ACos Filter

Arcus Cosine calculation.

Filter Properties:
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Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- ACos Output

18.4.6.14.3  Add Filter

Additive calculation of two source values.

Filter Properties:

Input A:
Choose first input node from list or enter numeric value.

Input B:
Choose second input node from list or enter numeric value.

The filter generates the following output:
- Add Result: Input A + Input B.
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18.4.6.14.4  ASin Filter

Arcus Sine calculation.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- ASin Result.

18.4.6.14.5  ATan Filter

Arcus Tangent calculation.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- ATan Result.
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18.4.6.14.6  Ceiling Filter

Returns the maximum value of a decimal input value. 

For example: Input value 5,1 results in the output value 6.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Ceiling Result.

18.4.6.14.7  Cos Filter

Cosine calculation.

Filter Properties:

Input:
Choose input node from list or enter numeric value.
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The filter generates the following output:
- Cosinus Result.

18.4.6.14.8  Degree > Radians Filter

Converts a value from degrees to radians. This filter node is useful for cosine, sine and tangent
calculation and value conversion.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Radians Result.

18.4.6.14.9  Divide Filter

Division calculation of two source values.
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Filter Properties:

Input A:
Choose input node from list or enter numeric value.

Input B:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Divide Result.

18.4.6.14.10  Floor Filter

Returns the minimum value of a decimal input value.

For example: Input value of 4,3 will result in the Output value 4.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Floor Result
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18.4.6.14.11  Log Filter

Logarithm calculation of the input source value.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Logarithm Result.

18.4.6.14.12  Modulo Filter

Modulo calculation of the input source value.
For Example: 7 modulo 3 = 1.

Filter Properties:

Input A:
Choose input node from list or enter numeric value.
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Input B:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Modulo Result.

18.4.6.14.13  Multiply Filter

Multiplies two input source values.

Filter Properties:

Input A:
Choose input node from list or enter numeric value.

Input B:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Multiply Result.
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18.4.6.14.14  Percent Filter

Calculates the percent of an input source value.

Filter Properties:

Input A:
Choose input node from list or enter numeric value.

Input %:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Percent Result.

18.4.6.14.15  Power x^y Filter

Power of two input source values.
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Filter Properties:

Input X:
Choose input node from list or enter numeric value.

Input Y:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Power Result.

18.4.6.14.16  Radians > Degree Filter

Converts a value from radians to degrees. This filter node is useful for cosine sine and tangent calculation
and value conversion.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Radians>Degree Result.
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18.4.6.14.17  Round Filter

This filter allows to round decimal values to a given amount of decimal places.
For Example: Input value 7,633 rounded to 1 digit results in the output value 7,7.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

Digits:
Enter amount of decimal places.

The filter generates the following output:
- Round Result.

18.4.6.14.18  Sin Filter

Sine calculation.
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Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Sin Result.

18.4.6.14.19  Sqrt Filter

Square Root calculation of the input source value.

Filter Properties:

Input:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Square Root Result.
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18.4.6.14.20  Subtract Filter

Subtraction of two input source values.

Filter Properties:

Input A:
Choose input node from list or enter numeric value.

Input B:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Subtract Result.

18.4.6.14.21  Sum Filter

The Filter Node SUM allows summing up all input values attached.
This is useful when connecting many delta nodes to determine easily when one of them has changed its
value.

Filter Properties:

The filter generates the following output:
- Sum.
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18.4.6.14.22  Tan Filter

Tangent calculation.

Filter Properties:

Input A:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Tangent Result.
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18.4.6.15  Text Filter Nodes

Use these nodes to handle text assets, e.g. to compare texts. Please see here  a summary of all
available text nodes.

18.4.6.15.1  Compare Text Filter

Compares two text sources.

Filter Properties:

Input A:
Choose input node from list or enter text.

Input B:
Choose input node from list or enter text.

True:
Choose input node from list or enter text that should be the output if the result is true.

False:
Choose input node from list or enter text that should be the output if the result is false.

The filter generates the following output:
- Compare Output value
- Compare State (true=1 or false=0)

1155
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18.4.6.15.2  Contains Text Filter

This filter allows scanning a text input source for specific words.

Filter Properties:

Input A:
Choose input node from list or enter text.

Input B:
Choose input node from list or enter text.

True:
Choose input node from list or enter text that should be the output if the result is true.

False:
Choose input node from list or enter text that should be the output if the result is false.

The filter generates the following output:
- Contains Output Value
- Contains Output State (true=1 or false=0)
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18.4.6.15.3  Date To Text Filter

Converts numeric input values to date string.

Filter Properties:

Year:
Choose input node from list or enter numeric value.

Month:
Choose input node from list or enter numeric value.

Day:
Choose input node from list or enter numeric value.

Hour:
Choose input node from list or enter numeric value.

Minute:
Choose input node from list or enter numeric value.

Second:
Choose input node from list or enter numeric value.

The filter generates the following output:
- Time Text Output
- Date Text Output 
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18.4.6.15.4  Leading Zeros Filter

Generates Leading Zeros for Text. This is especially useful for scoreboard counts

Filter Properties:

Input:
Choose input node from list or enter numeric value.

Digits:
Enter the amount of digits the filter should generate in front of the input.

The filter generates the following output:
- Leading Zeros Number

18.4.6.15.5  RegEx Text Filter

The RegEx Text Filter node extends the "Find and Replace" feature known from common text editor
software with RegEx expressions. A Regular Expression (short: RegEx) is a pattern that describes a
certain combination / amount of text including word, number and (non-) printable characters. By
supporting character classes (wild cards), grouping, back-references, etc. the RegEx engine allows very
flexible and efficient text processing.
There are different RegEx flavors i.e. implementations in various programming languages. Widget
Designer uses the RegEx the .NET framework library.

Below you will find a few examples how regular expressions work. For further information and complete
description of supported character classes, operators and constructs, please visit:
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx

Note: The Filter node "RegEx Compare " also searches for text that matches the used RegEx but
does not replace it, it simply returns a TRUE or FALSE.

1187
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Node properties

Input:
Choose an input node from the list or enter a string.

Pattern:
Enter a regular expression describing the text you like to search for.

Replacement:
Enter a regular expression that should replace a found pattern.

Node output values

The node generates the following outputs:
- Output

Examples for Regular Expressions

These examples are based on the input string:
A cat wears 99 hats - What? - Yes, yes!

Pattern ReplaceOutput Meaning

[a-z]+ 1 A 1 1 99 1 - W1? - Y1, 1!Searches case-sensitive any letter from character group
"a-z" that occurs at least once. Replaces with digit "1!

(cat)[ \̂?]* $1 A cat? - Yes, yes! Searches for the word "cat" followed by any character
that is not a "?" occurring zero or more times. By putting
"cat" in round brackets, it became group no.1. Replaces
with first group.

[ â-zA-Z0-9 ]  A cat wears 22 hats 
What  Yes yes

Searches for any character that is not a-z nor A-Z nor 0-9
nor a space. Replaces with nothing.
The mentioned characters can be described shorter with
the "character class" word character "\w". Hence, we can
search alternatively for the negated group.

[ \̂w]

\W

(?i)yes yes A cat wears 22 hats -
What? - yes, yes!

Searches case-insensitive for the word "yes". Replaces
with "yes".
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For further information and complete description please visit:
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx

18.4.6.15.6  RegEx Compare Filter

The RegEx Text Filter node extends the "Find" feature known from common text editor software with
RegEx expressions. A Regular Expression (short: RegEx) is a pattern that describes a certain
combination / amount of text including word, number and (non-) printable characters. By supporting
character classes (wild cards), grouping, back-references, etc. the RegEx engine allows very flexible and
efficient text processing.
There are different RegEx flavors i.e. implementations in various programming languages. Widget
Designer uses the RegEx the .NET framework library.

Note: The Filter node "RegEx Text " also searches for text that matches the used RegEx, but in
addition to the "RegExCompare" node it can also replace it. In the chapter for "RegEx Text " node you
will find a few examples how regular expressions work. For further information and complete description
of supported character classes, operators and constructs, please visit:
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx

Node properties

Input:
Choose an input node from the list or enter a string.

Pattern:
Enter a regular expression describing the text you like to search for.

Node output values

The node generates the following outputs:
- Output
- State

1185
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18.4.6.15.7  Text Combiner Filter

Combines up to eight text input sources or entered text to one string.
The Text Combine Filter now supports single entry for Line Feed [LF].

Filter Properties:

Inputs (8x):
Choose input node from list or enter text string.

The filter generates the following output:
- Time String Output

18.4.7  Output Nodes

Output nodes are used to send values out that are provided by other nodes. Please see the introductory
chapter if you like to learn more about other node types or how to create and work with nodes  in
general.

ANGULAR DISPLAY
The Angular Display output node allows routing any incoming numeric value to be displayed on an
Angular Display.

ART-NET
The Art-Net output node allows assigning incoming source values to either an 8 or 16bit DMX output
value on a given Art-Net Subnet and Universe.

1046

1191

1192
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BAR GRAPH
The Bar Graph output node allows assigning incoming source values to a Bar Graph.

COM PORT MESSAGE
The Com Port Message value acts like an if node, the incoming data can be compared and depending on
the true or false result a dedicated ASCII or Byte packet can be sent to the local COM Port.

COM PORT ASCII STREAM
The Com ASCII Stream output node allows sending ASCII values over the local COM Port connection. 

DIGITAL DISPLAY
The Digital Display output node allows assigning incoming source values to a digital Display.

DMX LINK OUT
The DMX Link output node allows to send out DMX data via the coolux DMX Link Out interface (interface
is still in development).

EXCEL WRITER
The Excel Writer output node allows to write incoming data to Excel sheets.

FADER
The Fader output value allows to remote control any fader based on its ID within Widget Designer
project.

LABEL
The Label output value allows to display any input value to a label inside the Widget Designer.

MIDI NOTE ON/OFF
The Midi Note On/Off node allows to send Midi Note on/off values to a given note on a given Midi
Channel.

MIDI RAW MESSAGE
The Midi Raw Message node allows mapping individual input source values to all 5 midi control bytes.

MIDI VALUE
The Midi Value output node allows sending a 7 or 15bit value on a given Midi Channel.

MOUSE
The Mouse output node allows to remote control the local mouse and map input values to emulate
mouse clicks and mouse motion.

PAGE
The Page output node allows executing a page change inside WD via an input source.

PB DEVICE CONTROL
The Device node allows controlling any Pandoras Box Device with any parameter name in both, absolute
or relative mode.

PB SEQUENCE CONTROL
The Sequence Control output node allows mapping any input or filtering data to any sequence parameter
value.

PB SEQUENCE SEEK
The Sequence Seek output node allows mapping any input or filtering data in order to set any sequence
to any timecode.

PB TEXT
The PB Text output node allows routing any input or filtering data to a PB Text Asset.
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PB TEXT UNICODE
The PB Text Unicode output node allows sending text strings in any language format to Pandoras Box
text assets.

SCRIPT
The Script output node acts like an if node, the incoming data can be compared and depending on the
true or false result a dedicated script can be executed within Widget Designer. It is recommended for
performance reasons to choose "Update on input value change only".

SERIAL LINK
The Serial Link output node connects to a serial link via the connection managers TCP ID. Incoming
values can be compared to send ASCII or Byte packets to any of the four serial ports of the connected
Serial Link. All 24 GPI contact closures can be mapped and assigned to input values as well 0 is off, 1 is
contact closed. It is recommended for performance reasons to choose "Update on input value change
only".

TCP MESSAGE
The TCP Message value acts like an if node. The incoming data can be compared and depending on the
true or false result a dedicated ASCII or Byte packet can be sent to the TCP connection setup by the its
ID in the Connection Manager.

TCP ASCII STREAM
The TCP ASCII Stream output node allows sending ASCII values over the local COM Port connection. 

TEXTBOX
The Textbox output node allows sending incoming texts to a text box within Widget Designer.

UDP MESSAGE
The UDP Message value acts like an if node. The incoming data can be compared and depending on the
true or false result a dedicated ASCII or Byte packet can be sent to the UDP connection setup by the its
ID in the Connection Manager.

UDP ASCII STREAM
The UDP ASCII Stream output node allows to send ASCII values over an UDP connection. 

VALUE
The Value output node allows to easily change the value of a Value input node .

VARIABLE
The Variable output node allows assigning new values to an existing Variable. 

VIDEO PLAYER TIME
The Video Player Time output node allows controlling the current time of an video played in the Video
Player  that is integrated within Widget Designer.

VIDEO PLAYER VOLUME
The Video Player Volume output node allows controlling the Volume of the Video Player integrated within
Widget Designer.
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18.4.7.1  Angular Display Output

The Angular Display output node allows routing any incoming numeric value to be displayed on an
Angular Display.

Node Properties:

Angular Display:
Please enter the ID of the Angular Display.

Value:
Please choose the input source that should be given out via this Angular Display.

Tick the check box to Mute Node on Page Change.
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18.4.7.2  Art-Net Output

The Art-Net output node allows to assign incoming source values to multiple 8 or 16bit DMX output
Channels on a given Art-Net Subnet and Universe. 
Simply type in all DMX start addresses and use a white space in between them i.e.:1 2 123.
The Art-Net output node updates Art-Net only on change of the input value.

Node Properties:

Tick one of the check boxes to give out either 8bit or 16 bit DMX values.

Art-Net Subnet, Universe:
Set here the Art-Net Subnet and Universe.

Channel:
Set here the DMX channel. To send Art-Net to multiple channels, use a white space in between the
channel IDs, e.g. 1 2 509.

Value:
Please choose one of your incoming source values.

Highspeed Mode (60 Hz):
Enable this option to use the Highspeed Mode that does a refresh rate of 60 Hz (Default is off)

Please note:
The Highspeed Mode is not supported by GrandMA consoles.

Tick the check box to Mute Node on Page Change.
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18.4.7.3  Bar Graph Output

The Bar Graph output node allows assigning incoming source values to a Bar Graph .

Node Properties:

Bar Graph:
Please enter the ID of the Bar Graph.

Value:
Please choose the input source that should be given out via this Bar Graph.

Tick the check box to Mute Node on Page Change.

968



1194

18.4.7.4  COM Port Output

The Com Port Message value acts like an if node, the incoming data can be compared and depending on
the true or false result a dedicated ASCII or Byte packet can be sent to the local COM Port. Set up its
ID in the Connection Manager .

Node Properties:

COM Connection ID:
Enter the COM Port Connection ID.

Update:
Choose if the output should be updated either "On Change of Input Value Only" or permanently.

If:
Choose the first input node from list or enter numeric value. This input will be compared to the second
input.
Choose the Operator.
Choose the second input node from list or enter numeric value. 

Then send:
If the operation is True, this input node value or entered numeric value will be given out as Output Value.

Else send:
If the operation is False, this input node value or entered numeric value will be given out as Output Value.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.5  COM Port ASCII Stream Output

The Com Port ASCII Stream output node allows sending ASCII values over the local COM Port
connection. 
Set up the COM Port Connection in the Connection Manager .

Node Properties:

COM Connection ID:
Enter the COM Port Connection ID.

Start and Stop Bytes:
Enter Start and Stop Bytes that should frame the message.
Enter these values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages

.

Input Message:
Please choose the input source that should be given out via this COM Port Output Node.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.6  Digital Display Output

The Digital Display output node allows assigning incoming source values to a Digital Display .

Node Properties:

Digital Display:
Please enter the ID of the Digital Display.

Value:
Please choose the input source that should be given out via this Bar Graph.

Tick the check box to Mute Node on Page Change.

18.4.7.7  DMX Link Output

The DMX Link output node allows sending out DMX data via the coolux DMX Link Out interface (interface
is still in development).

Node Properties:

969
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DMX Channel:
Choose the channel and if it is an 8bit or 16bit value.

Value:
Please choose the input source that should be given out via this DMX Link Output Node.

Tick the check box to Mute Node on Page Change.

18.4.7.8  Excel Writer Output

The Excel Writer output node allows writing incoming data to Excel sheets.
Please note that as long the output node is active you won’t be able to open the file in Excel at the same
time.

Node Properties:
File:
Click on [Path] to browse to the Excel file to which the node should write the incoming data. Press
[Apply] in order to choose the File.

Worksheet:
Please choose the worksheet from the list that should be edited. Press [Apply] in order to choose the
Worksheet.

Single Cell:
Enter the cell in which the node should write the incoming data, for example A1.

Update File:
By default the Excel File will be updated every 10 seconds. You may increase or decrease this value
here.

Value:
Please choose the input source that should be written into the specified document.
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18.4.7.9  Fader Output

The Fader output value allows to remote control any fader based on its ID within Widget Designer
project.

Node Properties:

Fader:
Please enter the ID of the Fader.

Value:
Choose the input source that should remote control the fader.

Tick the check box to Mute Node on Page Change.

18.4.7.10  Label Output

The Label output value allows displaying any input value to a label inside the Widget Designer.

Node Properties:
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Fader:
Please choose the Label ID.

Value:
Please choose the input source that should be displayed to the label.

Tick the check box to Mute Node on Page Change.

18.4.7.11  Midi Note On/Off Output

The Midi Note On/Off node allows to send Midi Note on/off values to a given note on a given Midi
Channel.
The Midi connection needs to be enabled in the Connection Manager .

Node Properties:

Channel:
Please choose the Midi Channel.

Note:
Please choose the Midi Note.

Value:
Please choose the input source. Its values will be sent as Midi Note on/off values.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.12  Midi Raw Message Output

The Midi Raw Message node allows mapping individual input source values to all 5 midi control bytes.
The Midi connection needs to be enabled in the Connection Manager .

Node Properties:

Status:
Choose an input source from the list or enter a numeric value.

Channel:
Choose an input source from the list or enter a numeric value.

Data1:
Choose an input source from the list or enter a numeric value.

Data2:
Choose an input source from the list or enter a numeric value.

Data3:
Choose an input source from the list or enter a numeric value.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.13  Midi Value Output

The Midi Value output node allows sending a 7 or 15bit value on a given Midi Channel.
The Midi connection needs to be enabled in the Connection Manager .

Node Properties:

Please choose if you want to send a 7 or 15bit value.

Status:
Enter the Midi Status.

Channel:
Enter the Midi Channel.

Note/Data1:
Enter the Midi Note / Data1.

Value:
Choose the Input Source from the list to send on this Midi Channel.

Tick the first check box to Send on change Only.
Tick the second check box to Mute Node on Page Change.

1239
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18.4.7.14  Mouse Output

The Mouse output node allows to remote control the local mouse and map input values to emulate
mouse clicks and mouse motion.
New feature from WD Rev 130 on: the Mouse Output Node only moves the mouse when input value has
changed.

Node Properties:

Enable the parameter of your local mouse that you want to remote control by ticking its check box. 

Please note:
The values for Mouse X and Mouse Y range from 0 to the max. value of your screen resolution.
The values for all other parameters have to be either 0 (False) or 1 (True).

Tick the check box to Mute Node on Page Change.
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18.4.7.15  Page Output

The Page output node allows executing a page change inside WD via an input source.
Please note that the input coming from another node needs to be written exactly like the page name you
want to change to (case sensitive)!

Node Properties:

Source:
Choose the input source from the list that should provide the page names.

Tick the check box to Mute Node on Page Change.
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18.4.7.16  PB Device Control Output

The Device node allows controlling any Pandoras Box Device with any parameter name in both, absolute
or relative mode.

Node Properties:

Device ID:
Enter the Device ID, e.g. 1 in the first text field and 2 in the second text field. This will control Layer 2 of
Site 1.

Absolute / Relative:
Choose absolute or relative mode. In absolute mode the PB device will take the input value, in relative
mode the input value will be added or subtracted to the PB device parameter's value.

Parameter:
Choose the parameter you want to control from the list.

Input:
Choose the input source from the list that should provide the values.

Multi-Site:
In order to control several devices simultaneously the Multi-Site option can be used instead of adding a
second PB Device Control Output Node. To do so please tick the check box and enter the amount of
sites. 

Example:
To control Layer 1 of Site 1 and Layer 1 of Site 2, enter “1” “1” in the text fields for the Device ID.
Enable the Multi-Site option and enter the amount of sites: “2”.
To control Layer 1 of Site 2 and Layer 1 of Site 3, enter “2” “1” in the text fields for the Device ID and “2”
for the Multi-Site Count.

Tick the check box to Mute Node on Page Change.
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18.4.7.17  PB Device Export To Sequence Output

This node allows you to record any incoming data and export the recorded value sequence as keys
directly to a device parameter in the specified sequence.

 

Node Properties:

Device ID:
Enter the Device ID, e.g. 1 in the first text field and 2 in the second text field. This will control Layer 2 of
Site 1.

Input:
Choose the input source from the list that should provide the values for the record.

Parameter:
Choose the parameter you want to export the keys to from the list.

Seq ID:
Enter the Sequence ID.

Record:
Tick this check box and press “Apply” to start recording the input values, untick it and press “Apply”
again to stop recording.

FPS:
Enter the frames per seconds with which should be recorded.

Start Time:
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Enter the hours, minutes, seconds and frames at which you want to export your value sequence first.

Export To Sequence by Time:
Clicking this button after having recorded a value sequence will export those values as keys to the
specified device parameter on the Pandoras Box sequence. Please pay attention to have a container
already prepared that enfolds the time of the whole recorded sequence. Otherwise, containers with a
default length of 10s will be created and set to the sequence. If your record is longer than this, it will
become disrupted in several containers.
Every further click will add the key sequence another time to your sequence, directly subsequent to the
previous one. This behavior can be reset by clicking “Apply” again.

Export To Sequence by Frame:
Clicking this button after having recorded a value sequence will export two keys to the specified device
parameter on the Pandoras Box sequence. The first key will be placed at the Start Time and contains
the first value of your recorded value sequence. The second key will be placed at the current position of
the now pointer during the record and contains the last recorded value.

18.4.7.18  PB Sequence Control Output

The Sequence Control output node allows mapping any input or filter node data to any sequence
parameter value.
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Node Properties:

Sequence ID:
Enter the Sequence ID.

Parameter:
Enable all parameters you want to control by ticking its check box. Choose the input source for the
parameter from the list.
The parameters accept different value ranges:

Opacity 0 to 255

Play, Pause, Stop 0=false, 1=true

GotoCue Cue ID

Next/Last Cue and Next / Last Frame 0=false, 1=true

Tick the check box to Mute Node on Page Change.

18.4.7.19  PB Sequence Seek Output

The Sequence Seek output node allows mapping any input or filter node data in order to set any
sequence to any timecode.

Node Properties:

Sequence ID:
Enter the Sequence ID.

Hours:
Choose the input source from the list.

Minutes:
Choose the input source from the list.
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Seconds:
Choose the input source from the list.

Frames:
Choose the input source from the list.

Tick the check box to Mute Node on Page Change.

18.4.7.20  PB Text Output

The PB Text output node allows routing any input or filter node data to a PB Text Asset.

Node Properties:

Text ID:
Enter the Text Asset's DMX File and Folder ID. Set up this Text ID in Pandoras Box.

Start Text:
Enter any text the Text Asset should start with.

Input:
Choose the input source from the list.

End Text:
Enter any text the Text Asset should end with.

Tick the check box to Mute Node on Page Change.



1209

18.4.7.21  PB Text Unicode Output

The PB Text Unicode output node allows sending text strings in any language format to Pandoras Box
text assets.

Node Properties:

Text ID:
Enter the Text Asset's DMX File and Folder ID. Set up this Text ID in Pandoras Box.

Start Text:
Enter any text the Text Asset should start with.

Input:
Choose the input source from the list.

End Text:
Enter any text the Text Asset should end with.

Tick the check box to Mute Node on Page Change.

18.4.7.22  Relay Output Link

The Relay Output Link node allows to communicate with the NET Link equipped with output boards.
Please see more information in the chapter covering the NET Link .
The node configures the device and sends commands to it, for instance to close a contact.

The NET Link Input node  might also be of interest for you.

777
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Create > Nodes > Output > Devices > Relay Output Link

Node properties

IP and Port
Enter the correct IP address and port from the NET Link's processor or from the Calibration Link.

Reset To Factory Default
This buttons resets the above settings in the Widget Designer interface. To reset the device itself (to the
IP address 192.168.178.222 and the port to 5000), hold the "Reset" button down whilst plugging the
power into the device. Release the button again.

Connect / Disconnect
Before starting to communicate with the device, for instance receive data, the node must be connected
to the device. The connection itself consumes no performance.

Change IP Address
This button opens a new dialog whereto you may enter another IP address and port for the device.
Power-cycle the device to apply the changes.

Config Module
A NET Link / Calibration Link is configured by coolux as you have ordered it. However, if you have
changed some input / output boards, the processor must be configured in terms of giving him the
information which boards are connected to it. Click the "Config Module" button to open a new dialog
where you may choose the according boards per processor connection. Find more details in the NET
Link hardware chapter .777
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Start Data / Stop Data
As soon as data is processed via the network from the device to Widget Designer, performance is drawn.

Store Last Transmission State to NET Link CPU
Click this button and power-cycle the device if you wish that it remembers whether it should (not) send
data as soon as it is powered up.

Channel, Input list and State
First, connect an Input node or Filter node to the Relay node to provide the information "0" or "1". Then
open the Item Properties and choose the incoming source data for the channel you like to control. The
"State" informs you about the current state of the what the incoming signal. "0" leaves the contact open,
whilst "1" closes it.

Node control

This node allows to be remote controlled via so called node commands . Node commands access
functions from a node and / or set a parameter.

Enter "node", followed by the according ID and a dot and a list will pop up showing all available
commands for the node. For instance, node1.StartData will execute the function automatically

without the need of opening the Item Properties dialog and clicking the according button manually. 
node1.SetRelay,1,1 will set the first channel to the state "1".

In addition, the node properties with a parameter ID (the small superscript number) can be edited via the
commands WDNodeSetParam,NodeID,ParamID,Value or nodeID.ParamID@Value.

1059
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18.4.7.23  Script Output

The Script output node acts like an If Node, the incoming data can be compared and depending on the
true or false result a dedicated script can be executed within Widget Designer.

Node Properties:

Update:
Choose if the output should be updated either "On Change of Input Value Only" or permanently. It is
recommended for performance reasons to choose "Update on input value change only".
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If:
Choose the first input node from list or enter numeric value. This input will be compared to the second
input.
Choose the Operator.
Choose the second input node from list or enter numeric value. 

True and False Script:
In the Script sections you may enter commands to be executed. If the operation is true, the True script
will be executed. If the operation is False, the False script will be executed.
To enter a command you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.

See here a list of all commands .

Tick the check box to Mute Node on Page Change.

1312
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18.4.7.24  Serial Link Output

The Serial Link output node connects to a serial link via the connection managers TCP ID. Incoming
values can be compared to send ASCII or Byte packets to any of the four serial ports of the connected
Serial Link . All 24 GPI contact closures can be mapped and assigned to input values as well 0 is off,
1 is contact closed.

Node Properties:
TCP Connection ID:

759
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Enter the TCP Connection ID. The TCP Connections can be found and setup in the Connection Manager
.

Update:
Choose if the output should be updated either "On Change of Input Value Only" or permanently. It is
recommended for performance reasons to choose "Update on input value change only".

If:
Choose the first input node from list or enter numeric value. This input will be compared to the second
input.
Choose the Operator.
Choose the second input node from list or enter numeric value. 

Then send:
If the operation is True, the True script will be executed. You have the possibility to assign a different true
send command for each Serial Link port. The topic Script Language  explains commands and how to
use them in more detail.
See here a list of all commands .

Else send:
If the operation is False, the Else script will be executed. You have the possibility to assign a different
else send command for each Serial Link port.

GPI Outputs:
All 24 GPI contact closures can be mapped and assigned to input values as well 0 is off, 1 is contact
closed.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.25  TCP Message Output

The TCP Message value acts like an If Node. The incoming data can be compared and depending on the
true or false result a dedicated ASCII or Byte packet can be sent to the TCP connection setup by the its
ID in the Connection Manager .

Node Properties:

TCP Connection ID:
Enter the TCP Connection ID.

Update:
Choose if the output should be updated either "On Change of Input Value Only" or permanently.

If:
Choose the first input node from list or enter numeric value. This input will be compared to the second
input.
Choose the Operator.
Choose the second input node from list or enter numeric value. 

Then send:
If the operation is True, this input node value or entered numeric value will be given out as Output Value.

Else send:
If the operation is False, this input node value or entered numeric value will be given out as Output Value.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.26  TCP ASCII Stream Output

The TCP ASCII Stream output node allows sending ASCII values over a TCP connection. 
Set up the TCP Connection in the Connection Manager .

Node Properties:

TCP Connection ID:
Enter the TCP Connection ID.

Start and Stop Bytes:
Enter Start and Stop Bytes that should frame the message.
Enter these values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages

.

Input Message:
Please choose the input source that should be given out via this TCP Output Node.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.27  Textbox Output

The Textbox output node allows sending incoming texts to a textbox within Widget Designer.

Node Properties:

Textbox ID:
Enter the Textbox ID the values should be sent to.

Value:
Please choose the input source.

Tick the check box to Mute Node on Page Change.
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18.4.7.28  UDP Message Output

The UDP Message value acts like an If Node. The incoming data can be compared and depending on the
true or false result a dedicated ASCII or Byte packet can be sent to the UDP connection setup by the its
ID in the Connection Manager .

Node Properties:

UDP Connection ID:
Enter the UDP Connection ID.

Update:
Choose if the output should be updated either "On Change of Input Value Only" or permanently.

If:
Choose the first input node from list or enter numeric value. This input will be compared to the second
input.
Choose the Operator.
Choose the second input node from list or enter numeric value. 

Then send:
If the operation is True, this input node value or entered numeric value will be given out as Output Value.

Else send:
If the operation is False, this input node value or entered numeric value will be given out as Output Value.

Tick the check box to Mute Node on Page Change.

1239
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18.4.7.29  UDP ASCII Stream Output

The UDP ASCII Stream output node allows sending ASCII values over an UDP connection. 

Set up the UDP Connection in the Connection Manager .

Node Properties:

TCP Connection ID:
Enter the UDP Connection ID.

Start and Stop Bytes:
Enter Start and Stop Bytes that should frame the message.
Enter these values as string, dec or hex value. Please refer to Syntax TCP- / UDP- / Serial messages

.

Input Message:
Please choose the input source that should be given out via this UDP Output Node.

Tick the check box to Mute Node on Page Change.
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18.4.7.30  Value Output

The Value output node allows changing the value of a Value input node .

Node Properties:

Node ID:
Enter the ID of the Value Input Node whose value you want to change.

Value:
Choose the input source that should be routed to the specified Value Input Node.

Tick the check box to Mute Node on Page Change.

18.4.7.31  Variabel Output

The Variable output node allows assigning new values to an existing Variable. 

Node Properties:

Name:
Enter here the Variable’s name.

1149
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Value:
Choose the input source that should be routed to the specified Variable.

Tick the check box to Mute Node on Page Change.

To set up and process variables, please use these scripts :
To see all existing variables and their values, see the Variable List .

18.4.7.32  Video Player Time Output

The Video Player Time output node allows controlling the current time of a video played in the Video
Player  that is integrated within Widget Designer.
The time is always handled in seconds. 

Example:
To jump to the timecode 1min 25 seconds, the input source has to take the value 85 seconds.

Node Properties:

Video Player ID:
Enter the Video Player ID.

Value:
Choose the input source that should remote control the Video Player Time.

Tick the check box to Mute Node on Page Change.
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18.4.7.33  Video Player Volume Output

The Video Player Volume output node allows controlling the Volume of the Video Player  integrated
within Widget Designer.

Node Properties:

Video Player ID:
Enter the Video Player ID.

Value:
Choose the input source that should remote control the Video Player Volume.

Tick the check box to Mute Node on Page Change.

18.4.8  Script Nodes

Script nodes execute your customized script; they are triggered through a certain action. Please see the
introductory chapter if you like to learn more about other node types or how to create and work with
nodes  in general.

COM SCRIPT
The COM script node allows receiving either ASCII or Byte values over a local COM port connection. Any
input data can be linked to directly execute dedicated commands.

TCP SCRIPT
The TCP script node allows receiving either ASCII or Byte values over a local TCP connection. Any input
data can be linked to directly execute dedicated commands.

UDP SCRIPT
The UDP script node allows receiving either ASCII or Byte values over a local UDP connection. Any input
data can be linked to directly execute dedicated commands.

PHIDGET IR SCRIPT
The Phidget IR script node allows linking commands to incoming IR Codes.

PHIDGET RFID SCRIPT
The Phidget RFID script node allows linking commands to incoming RFID Codes.

1038
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18.4.8.1  COM Scripts

The COM script node allows receiving either ASCII, decimal or hexadecimal values over a local COM port
connection. Any input data can be linked to directly execute a dedicated script within WD. The COM
Port connection needs to be enabled in the Connection Manager .

Node Properties:

COM Connection ID:
Enter the ID of the COM Port Connection .

Input:
Please enter the string of the incoming data for which you want a command to be executed. Please note
that values can only be entered in ASCII, not hexadecimal, decimal or mixed. Special symbols are not
supported. Please use the COM Port Input node  or COM ASCII Stream Input node  instead.

Command:
In the Script section you may enter commands to be executed when the according data is received.
Each "Input" string may have a different script assigned.
To enter commands you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.

Use [Delete Macro] to delete the selected script.
Use [Delete All Macros] to delete all scripts.
Use [Clear All] to clear the script text box of the selected script.
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18.4.8.2  TCP Scripts

The TCP script node allows receiving either ASCII, decimal or hexadecimal values over a local TCP
connection. Any input data can be linked to directly execute a dedicated script within WD. The TCP
connection needs to be enabled in the Connection Manager .

Node Properties:

TCP Connection ID:
Enter the ID of the TCP Port connection .

Input:
Please enter the string of the incoming data for which you want a command to be executed. Please note
that values can only be entered in ASCII, not hexadecimal, decimal or mixed. Special symbols are not
supported. Please use the TCP Input node  or TCP ASCII Stream Input node  instead.

Command:
In the Script section you may enter commands to be executed when the according data is received.
Each "Input" string may have a different script assigned.
To enter commands you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.

Use [Delete Macro] to delete the selected script.
Use [Delete All Macros] to delete all scripts.
Use [Clear All] to clear the script text box of the selected script.
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18.4.8.3  UDP Scripts

The UDP script node allows receiving either ASCII, decimal or hexadecimal values over a local UDP
connection. Any input data can be linked to directly execute a dedicated script within WD. The UDP
connection needs to be enabled in the Connection Manager . 

Node Properties:

UDP Connection ID:
Enter the ID of the UDP Port connection .

Input:
Please enter the string of the incoming data for which you want a command to be executed. Please note
that values can only be entered in ASCII, not hexadecimal, decimal or mixed. Special symbols are not
supported. Please use the UDP Input node  or UDP ASCII Stream Input node  instead. 

Command:
In the Script section you may enter commands to be executed when the according data is received.
Each "Input" string may have a different script assigned.
To enter commands you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.

Use [Delete Macro] to delete the selected script.
Use [Delete All Macros] to delete all scripts.
Use [Clear All] to clear the script text box of the selected script.
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18.4.8.4  Phidget IR Scripts

The Phidget IR script node allows linking scripts to incoming IR Codes.
Please set up the Phidget IR Receiver Transmitter Tool  first in order to enable the IR controller.

Node Properties:

Input:
Please enter the incoming data string you want a command to be executed.

Command:
In the Script section you may enter commands to be executed when the according data is received.
Each "Input" string may have a different script assigned.
To enter commands you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.

Use [Delete Script] to delete the selected script.
Use [Delete All Scripts] to delete all scripts.
Use [Clear All] to clear the script text box of the selected script.
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18.4.8.5  Phidget RFID Scripts

The Phidget RFID script node allows linking scripts to incoming RFID Codes.
Please set up the Phidget RFID Tool  first in order to enable the RFID controller.

Please note:
It is possible that the Phidgets RFID do work only under Win7.
App hang has occurred on XP when a RFID Tool and RFID Script Node Property Window is open at the
same time

Node Properties:

Input:
Please enter the incoming data string you want a command to be executed.

Command:
In the Script section you may enter commands to be executed when the according data is received.
Each "Input" string may have a different script assigned.
To enter commands you may use the drop-down list and the "Add" button or type directly in the text
field. The topic Script Language  explains this in more detail.

Use [Delete Script] to delete the selected script.
Use [Delete All Scripts] to delete all scripts.
Use [Clear All] to clear the script text box of the selected script.
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18.4.9  Interaction Nodes

Interaction nodes execute an underlying application that enables to interact with a remote system.
Please see the introductory chapter if you like to learn more about other node types or how to create and
work with nodes  in general.

Touch Injection
With the Touch Injection Interaction node you may send touch data to a dedicated Output of a Pandoras
Box Site. The touch data is injected there meaning that it is as if it was generated on the remote
machine using a connected touch screen for instance.

Mouse Injection
With the Mouse Injection Interaction node you may send mouse click and move data to a dedicated
Output of a Pandoras Box Site. The mouse data is injected there meaning that it is as if it was
generated on the remote machine using a connected mouse for instance.

Mouse Draw to Canvas
With the Mouse Draw to Canvas Interaction node you may send mouse click and move data to a
dedicated Canvas asset in Pandoras Box to draw on it. The mouse data (happening in Widget Designer)
is injected into the Pandoras Box system meaning that it is as if it was generated on the remote
machine using a connected mouse for instance.

Layer UV Draw to Canvas
With the Layer UV Draw to Canvas Interaction node you may send mouse click and move data to a
dedicated Canvas asset in Pandoras Box to draw on it. In difference to the previously described "Mouse
Draw to Canvas" node, this node does not work with the mouse connected to the Widget Designer
system but with a mouse / touch /... input connected to the PB Client or Master directly. This means
that this node routes the remote input events to a Canvas.
Below the explanation of the node's parameters, you will find a step-by-step description of the settings
from Widget Designer and Pandoras Box that are necessary when drawing on a Canvas, or receiving
mouse or touch input events in general.
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18.4.9.1  Touch Injection

With the Touch Injection Interaction node you may send touch data to a dedicated Output of a Site. The
touch data is injected there meaning that it is as if it was generated on the remote machine using a
connected touch screen for instance.

Set up the Site ID and Output ID from the Master or
Client that you like to send the data to.

Decide whether the data should be injected to the
Output or the Composition pass. More information...

Tick the according check-box for each tool that
should generate touch data.

Choose between
- "1:1" to keep the resolution as on your local screen
and
- "Re-Map" with more settings to send other
coordinates to the remote computer. This is not only
of interest when the screen resolution of the
systems you inject input events in is different to the
local resolution. But also when the resolution is
much higher due to more outputs. In case the
outputs are softedged you need to set up two
Injection nodes with different source and target
coordinates.

Lastly, you may set up what mode generates a
click.

Tick the check box "Mute Node on Page Change" if
the node should not process and output data when
another page is active.

322
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18.4.9.2  Mouse Injection

With the Mouse Injection Interaction node you may send mouse click and move data to a dedicated
Output of a Site. The mouse data is injected there meaning that it is as if it was generated on the remote
machine using a connected mouse for instance.

Set up the Site ID and Output ID from the Master or
Client that you like to send the data to.

Decide whether the data should be injected to the
Output or the Composition pass. More information...

Choose between
- "1:1" to keep the resolution as on your local screen
and
- "Re-Map" with more settings to send other
coordinates to the remote computer. This is not only
of interest when the screen resolution of the systems
you inject input events in is different to the local
resolution. But also when the resolution is much
higher due to more outputs. In case the outputs are
softedged you need to set up two Injection nodes
with different source and target coordinates.

Tick the check box "Mute Node on Page Change" if
the node should not process and output data when
another page is active.

18.4.9.3  Mouse Draw to Canvas

With the Mouse Draw to Canvas Interaction node you may send mouse click and move data to a
dedicated Canvas asset  in Pandoras Box to draw on it. The mouse data (happening in Widget
Designer) is injected into the Pandoras Box system meaning that it is as if it was generated on the
remote machine using a connected mouse for instance. Please see the next chapter about the node
"Layer UV Draw to Canvas " if you like to draw on the Canvas with a mouse / touch /... input
connected to the PB Client or Master directly.
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Set up the Folder and File ID from the Canvas Asset

The Size parameter influences whether you draw a
fine line or with a thicker brush.
With Red, Green, Blue and Alpha you set up the
color of the brush. Note that small numbers next to
parameter fields indicate that they can be changed
with the command NodeSetParam .

Choose between
- "1:1" to keep the resolution as on your local screen
and
- "Re-Map" with more settings to send other
coordinates to the remote computer
In case you send. This is not only of interest when
the screen resolution of the systems you inject input
events in is different to the local resolution. But also
when the resolution is much higher due to more
outputs. In case the outputs are softedged you need
to set up two Injection nodes with different source
and target coordinates.

1556
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Tick the check box "Mute Node on Page Change" if
the node should not process and output data when
another page is active.

18.4.9.4  Layer UV Draw to Canvas

With the Layer UV Draw to Canvas Interaction node you may send mouse click and move data to a
dedicated Canvas asset  in Pandoras Box to draw on it. In difference to the previously described
"Mouse Draw to Canvas" node, this node does not work with the mouse connected to the Widget
Designer system but with a mouse / touch /... input connected to the PB Client or Master directly. This
means that this node routes the remote input events to a Canvas.

Below the explanation of the node's parameters, you will find a step-by-step description of the settings
from Widget Designer and Pandoras Box that are necessary when drawing on a Canvas, or receiving
mouse or touch input events in general.

Set up the Folder and File ID from the Canvas Asset.

273
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The Size parameter influences whether you draw a
fine line or with a thicker brush.
With Red, Green, Blue and Alpha you set up the
color of the brush. Note that small numbers next to
parameter fields indicate that they can be changed
with the command NodeSetParam .

If you like to filter input data from one Site or even
only a Layer, enter the PB Masters IP address, the
Site and Device ID and set the filter type.

Enter the same Canvas width and height as set up in
the File Inspector in Pandoras Box.

Enter a Brush Path if you like to draw with a media
e.g an image. The asset name is the one displayed
in the PB Master's Project tab (case-sensitive!), e.g.
"Sub folder/Image.png".

The interval parameter influences how continuous or
interrupted the drawn line looks like.

"Use Single Touch As Input" discards multiple input
or touch data and takes only the input with the
specific "ID".

The Compositing Mode influences the Overlay
behavior of semi-transparent (Alpha < 255) lines
drawn on the Canvas. "Source Over" covers any
underlaying layers, the Alpha level simply darkens
the color. "Source Copy" does not cover existing
layers fully but only according to the Alpha level, i.e.
they shine through the Canvas Layer.

Tick the check box "Mute Node on Page Change" if
the node should not process and output data when
another page is active.

General connection settings in WD and PB required to communicate remote UV data

The below screenshot depicts settings in Pandoras Box and Widget Designer for a test setup that
shows how to draw on a Canvas, or receive mouse or touch input events in general:
- one Manager with WD on IP 192.168.2.120
- one Player Client (in fullscreen mode) on another PC with a mouse device attached

1556
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- in the PB Master, drag the Client into the Device tab and in addition a Widget Designer device  (from
the Device Types tab > Widget Designer > Widget Designer.clib)
- select the WD Device and check the IP address in the Inspector  (in our case, as it runs on the
same machine, it should be the local IP)
- in WD, go to Edit > Pandoras Box IP Configuration  and check the IP address from PB Master then
scroll down to the "PB Widget Device Connection" section and tick the check box "Enable Connections"
- now, in the PB Master's Devices tab, the WD Device should not have a red exclamation mark anymore
which means that it now is able to transmit (touch) data from the PB application to the WD application
and its nodes)

Receiving remote mouse / touch data from a PB Client or PB Master

Before drawing on a Canvas we will check that the UV touch data is send from the PB Client to the PB
Master and from the PB Master to WD.

- first drag a testpattern into the PB project and display it on the first layer of the Client (Site/Device ID
2.1)
- in the PB Master's Devices tab, select the Client to display the settings in the Inspector tab  and
click the button "Input Event Settings ". Tick the options for enabling the Output as well as for the
Widget Designer Device. Optionally, tick the check box to render the mouse pointer in the fullscreen
window

- in WD, go again to Edit > Pandoras Box IP Configuration  to the "PB Widget Device Connection"
section and click the button "Input Tester" to open a dialog that should display incoming information
when moving the input device in the PB Client
- alternatively, you can receive UV data from an input device connected to the PB Master: toggle the
Client into the local PB Master's Preview and change to the Picking mode (by clicking the hand icon), 
more information about the Picking Mode...

- if you like to view the incoming data outside this dialog, create a small node chain and a Label. 1)
Nodes > Input > Pandoras Box > Layer Mouse Input and 2) Nodes > Output > Controls > Label
- in the PB Mouse Input node, enter the Master's (!!) IP address. If you like not to receive data from all
sites and devices, enter the according Site ID and Device ID and set the filter drop-down menu to suit
your needs. For our purpose, this is not needed, so the filter can say "Any"
- in WD, set the Label Output node to display the "Texture U" data in the according Label. If you now
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move the Client's attached mouse from left to right in the fullscreen render window, the Label should
display texture data from 0 - 1

If this is working, the data transmission works fine. Now we can set up to draw in the Clients screen.

Forwarding remote mouse / touch data to a Drawing Canvas 

- first in the PB Master's Project tab, create a Drawing Canvas  asset and assign Folder / File ID 1/1
using the Inspector. Set up the resolution you need and then assign it to the Client's second layer (2.2)

- in WD, create the node Nodes > Interaction > Layer UV Draw to Canvas Pandoras Box. The obligatory
settings are what Folder / File ID the Canvas asset has (in our case 1/1), what width / height it has and
what the Source IP is ( the PB Master is in our case the local IP). Optionally you can set up a color and
size for the "pen", this is described at the top of this chapter.

- as already mentioned above, you can as well draw on the Canvas with the mouse connected to the PB
Master: toggle the Client into the local PB Master's Preview and change to the Picking mode (by clicking
the hand icon), more information about the Picking Mode...

18.4.10  Composite Nodes

The Composite node offers you the possibility to create your own sophisticated node structure  and
bundle it up to one compact, reusable node. 

It allows you to arrange your entire node system much more clearly and to integrate larger structures
easier and faster. Additionally, combined with the enhanced security and protection settings , you are
able to provide customers with your solutions.

To construct a new Composite
node, open the Nodes menu,
select Composite Nodes and
click on "New Composite
Node...". If you have done this
already or imported one, this sub
menu lists available Composite
nodes to create or edit them.

After you have entered a
significant and valid name for
your node (name may contain
letters, numbers and underscore,
and has to start with a letter), a
new window will pop up, already
containing a Comp. input and a
Comp. output node.

The Comp. input and output
nodes represent the interfaces to
your main node system, similar
to the inputs and outputs at any
ordinary filter node. You can add
or remove as many of them as
you need, either with copy /
paste of the existing ones, or by
creating new ones out of the
node menu.
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It is highly recommended to label
those input and output nodes
according to their purpose, as
this name will be visible at the
Composite node's configuration
later and thus simplifies
assignment. To relabel a node,
please open the node's
properties either by right-clicking
at the node and selecting "Item
Properties", or with the keyboard
shortcut [Alt + P], and enter a
suitable label. Please do not
change the name of the node
(field at the top), unless you
really need to, as this is not the
one being displayed later.

The next step would be setting up
your node structure as needed, for
this you have all input, filter and
script nodes available. You can
even place widgets inside of your
Composite node if necessary.

If you decide to provide your Composite node to others, please bear in mind to do a proper
documentation how to setup the required environment. For example, If you have a TCP input node in your
Composite node, your customer has to prepare the TCP connection  correctly beforehand, or has to
be informed to import this part of data from your project.

For protecting your work from being displayed, please refer to the Protection Settings , accessible in
the node properties.

When you are done with your setup, simply close the Composite node window. A dialog asks you,
whether you like to create an instance of the new node immediately.

Editing an existing Composite node is possible as follows
- via the Node menu > Composite > Edit > your Node
- right-click on the Node > Configure Node > button "Edit 'Name' Composite"

However, the later method enables you to view the concrete values handled by this instance. Opening
the configuration dialogs of the nodes inside of the Composite window, displays all input and output
information, an essential tool for testing and debugging your node system.

Please bear in mind that if you edit a Composite node while one or more instances are already located in
the project, the changes will affect all of those. What you edit is always the master node and never a
specific instance of it, despite the values shown inside of it.

18.5  Connections

The Connections menu in WD lists all available connection possibilities you can set up in Widget
Designer. Other than the listed input and output protocols, you can connect to devices  and other
tools .

Once you have chosen an entry a dialog opens with more options.
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PB Configuration

Connection Manager
Midi Input
TCP/UDP/COM Connections
Art-Net Monitor
Remoting
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18.5.1  Connection Manager

The Connection Manager is the tool  to setup all main input and output communication protocols. All
connections and protocols set up here are accessible to any command and user control as well as
Nodes for in and output communication. 

For further information please see

- SMPTE Link
- Art-Net
- DMX Link
- Midi
- WD Remote Touch Input/Output
- TUIO Transmitter
- TUIO Receiver
- ID Tag Tracking Server
- PSN MA Tracking Server
- OptiTrack Camera Connection Manager
- ID Tag
- IP Info & Setup
- TCP Connections
- UDP Connections
- Serial COM Connections

Working with multiple network adapters

Where applicable, a protocol can be assigned to a dedicated network adapter using the Widget Designer
ULT edition. This is of interest when working with multiple protocols that you would like to separate from
each other or when dedicated IP addresses / ranges should be supported.

Per default, the Widget Designer PRO and STD use the same network adapter for each protocol. They
cannot access the drop-down list to choose another adapter. If you open a new project in the PRO or
STD, the drop-down list will always say "Any (System Selects)". That means that the operating system
Windows decides what adapter is chosen. In general that would be the one that you have set up as the
primary adapter in the (advanced) network settings.
However, if you have set up dedicated adapters using the ULT edition, and open this project in a PRO or
STD, the settings still apply and are not discarded. If the operating system finds the named adapter it
will use it for the desired protocol. Only if the system does not offer a network adapter with the exact
name, the choice drops back to "Any...".

18.5.1.1  SMPTE Link

1287

1239

1240

1241

1241

1242

1242

1243

1245

1247



1240

When a SMPTE Link device is connected to the WD computer, choose if you want to send or receive
SMPTE timecode. 

Choose the framerate from the second drop-down list if you are sending timecode.

In the text field next to the framerate you will see the current timecode. When you are in send mode, it
allows you to enter the timecode start time manually.

Use the "Timecode " control to display the current timecode on the WD userinterface. The SMPTE
Link device can be controlled via commands .

You may also route the sent / received SMPTE Timecode via the SMPTE Link Input Node  within the
WD Node System.

18.5.1.2  Art-Net

Art-Net can be used both as input and output. Art-Net can technically transmit up to 256 DMX Universes
but you should be cautious about the amount of Universes to be sent and managed from one Widget
Designer System. The processor and network card limit the amount of possible Art-Net universes.

By default if you enable Art-Net output, there are no values being sent until you use either an Art-Net
Output Node or Art-Net output commands . Once, a particular DMX channel is sent on a given Art-Net
Subnet and Universe, Widget Designer will store that universe as an output universe and constantly
update this Universe. As defined in the Art-Net specifications, as soon as one channel is transmitted
with a certain value, all other channels are included in the packet, if not specified, with a value of "0". In
other words, a single channel data can not be send, it is send with the entire universe.

To display the Art-Net data received by Widget Designer, click on [Art-Net Monitor ]. In the dialog you
may select a subnet and universe.  Then all channels are displayed with the according incoming Art-Net
value. If you use WD to send Art-Net and you do so by broadcasting the values, you will be able to see
these values in the Art-Net Monitor too. If you are unicasting the values, please switch to another Art-Net
Monitor, e.g. the one in the PB Menu . 
More information  about broadcast and unicast...

If you wish to stop sending specific Universes to the network you can open the Art-Net Universe List from
the connection Manager and remove a Universe from the output list by right-clicking on the desired
Subnet and Universe to delete the entry.

1033

1312

1137

1323

1256

784

792



1241

You may also use commands to deactivate  a certain Subnet and Universe from being updated
constantly anywhere where scripts are applicable in the user interface.

Reuse Port:
When reuse Port is checked Artistic License devices that require a reuse UDP port option are
supported.

18.5.1.3  DMX Link

WD supports DMX Input data via the coolux DMX Link 1 Port IN device . To use this function, activate
the check box “Enable”.

You may receive and process the incoming DMX data via the DMX Link Input node.

DMX Output is supported via the coolux DMX Link 1 Port OUT device. To use this function, activate the
check box “Enable”.

18.5.1.4  Midi

For Midi input and output connect and install a windows compatible midi device with the Widget
Designers computer first in order to access and choose the device in the Connection Manager.
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18.5.1.5  WD Remote Touch

The WD Remote Touch Input/Output allows to share touch data within several Widget Designer
instances (one WD Master receives the data, several WD Clients may send it). This enables you to work
with multiple cameras, AirScans or Kinect devices. The touch data handling can be split to several
processes or computers.

Server (Touch Receiver):
Enable the server if you want to receive touch data from other WD instances.

Client (Touch Sender):
In order to send the touch data of this WD instance to another WD (set up as Remote Touch Input
Server), enter the IP address of the WD Server and tick the check box [Client (Touch Sender)]. The
receiving WD may run on the same computer or on a different one.

Enable the devices that should send its touch data to the WD Server:

AirScan , Camera Point Tracker  and/or Kinect .

18.5.1.6  TUIO Transmitter

The open source protocol TUIO allows outputting the AirScan’s multi touch data to other applications 

This protocol is widely used around the world by many application developers and is a commonly known
way to transmit the individual touches.

See a list of compatible software and operating system frameworks here:
http://tuio.org/?software

To use the AirScan with TUIO, set up the TUIO host IP and Port here and press [Apply]. The TUIO
transmitter needs to be enabled by ticking the check box [Enable].

To start sending the AirScan’s touch data, open the AirScan Tool  and check the option [TUIO] inside
the Multi Point Mode section.

18.5.1.7  PSN MA Tracking Server

In the Connection Manager  dialog, the section PSN MA Tracking Server allows to setup whether and
how Widget Designer outputs PSN data. The PosiStageNet protocol is for example supported by MA
Lighting consoles; more information can be found on www.posistage.net. The data itself is generated for
example in the ID Tag Tracker node .
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Please enter the IP address and port whereto the PSN data should be send to and click "Apply". For MA
Lighting consoles, the default IP is 236.10.10.10 with port 56565.

When using a Widget Designer ULT edition you may define a dedicated network adapter used for
transmitting this protocol. For more information please see the introductory chapter .

Check "Enable" to activate the protocol in general and choose whether you like to send "PSN V1.0" or
"PSN V2.0".

18.5.1.8  TCP Connections

To create a new TCP connection press [Add] in the TCP section.

In a TCP environment a computer or device (such as a router or projector) can be set up as either Client
or Server.

The reason for these two types of modes is related to the way how a connection should be established
between two devices. A Server waits for incoming connections while a Client can only connect to a
Server.

Widget Designer offers the option to create a connection type where Widget Designer as TCP server can
receive data packets from multiple Clients at the same time.

Every time a packet is send via a Server with Multi Client the data is sent to all connected Clients at the
same time.

If you need to constantly stream data via TCP output nodes, it is recommended to enable No Delayed
Buffer so that the packets are not concatenated and sent immediately.

When setting up a TCP Server connection you will only need to specify the listening Port.

When creating a Client connection you will need to provide the TCP port and IP address of the TCP
Server that you would like to connect to.

1239
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The Name property of the connection is only internal to the Connection Manager to let you label the
connection with logical names for a better overview of multiple connections. Once the connection is
created you will find the ID in the TCP list table. This ID will be required by commands and nodes to
hook to this connection to either send or receive data.

After you created a TCP connection, it will be displayed in the TCP Connection list. If you do a right-click
on this TCP connection, you will be able to manually Start, Stop, Edit and Test this connection.
If you have a large number of connections, you may find a longer list enabling a better overview under
Tools > TCP/UDP/COM Connections  > TCP Connection. 

Choose “Edit” to change the Connection ID:

.

Choose “Test” and the TCP Message Tester opens. It displays the incoming UDP message as Decimal,
Hex and ASCII/Symbol.

1255
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18.5.1.9  UDP Connections

To create a new UDP connection press Add in the UDP section.

UDP Broadcast
The UDP connections are by default set up as broadcast connections. A UDP connection does not
require a dedicated IP address or a Server to connect to (with IP 255.255.255.255 the data will be send
as broadcast into the whole network).

When sending Broadcast packets to the network, all UDP receivers that listen to the sending Port of
Widgets Designers UDP connection will process the packets they receive. This way a UDP connection
can be used for both sending and receiving UDP packets from the network.

Please make sure to choose different Ports for Input and Output.
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UDP Unicast
You may want to send a UDP message as Unicast to a specified destination, e.g.. to the device with the
IP address 192.168.5.5. To do this, keep the type “Broadcast Server Client” but change the Broadcast IP
255.255.255.255 to the desired one.

Please make sure to choose different Ports for Input and Output.

UDP Multicast
In an UDP multicast there is one Master sending messages to a specified port and multicast IP (within
the Multicast IP range: 224.0.0.0 – 239.255.255.255) and any Client may listen to this multicast IP.

Check “Multicast Client” to listen to a multicast IP, enter the Multicast IP (within the Multicast IP range:
224.0.0.0 – 239.255.255.255) and specify the Input Port. 

There is no Output Port as only a Master is able to send messages into this IP.

The Name property of the connection is only internal to the Connection Manager to let you label the
connection with logical names for a better overview of multiple connections. Once the connection is
created you will find the ID in the UDP list table. This ID will be required by commands and nodes to
hook to this connection to either send or receive data.

After you created a UDP connection, it will be displayed in the UDP Connection list. If you do a right-
click on this UDP connection, you will be able to manually Start, Stop, Edit or Test this connection.

If you have a large number of connections, you may find a longer list enabling a better overview under
Tools > TCP/UDP/COM Connections > UDP Connection.

Choose “Edit” to change the Connection ID:

.

Choose “Test” and the UDP Message Tester opens. It displays the incoming UDP message as Decimal,
Hex and ASCII/Symbol.
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18.5.1.10  Serial COM Connections

To create a new COM Port connection press Add in the COM section.

Any local Com Port will be listed in the Port drop-down list. Windows supports up to 255 comports that
can be either local ports or virtual ports that are connected via network. A couple of manufacturers offer
network based virtual Com Port extensions that can also be assigned here.

To setup a Com Port connection you will need to make sure that all the settings as seen above need to
match the attached device settings 1:1. If the settings are not set correctly to the connected devices
settings you may end up receiving corrupt or no data on this connection.
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The Name property of the connection is only internal to the Connection Manager to let you label the
connection with logical names for a better overview of multiple connections. Once the connection is
created you will find the ID in the UDP list table. This ID will be required by commands and nodes to
hook to this connection to either send or receive data.

After you created a COM connection, it will be displayed in the COM Connection list. If you do a right-
click on this COM connection, you will be able to manually Start, Stop, Edit and Test this connection.

If you have a large number of connections, you may find a longer list enabling a better overview under
Tools > TCP/UDP/COM Connections > COM Connection.

Choose “Edit” to change the Connection ID:

.

Choose “Test” and the Com Message Tester opens. It displays the incoming COM message as Decimal,
Hex and ASCII/Symbol.
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18.5.2  Midi Input

Choose between these Midi Inputs:

Midi Notes
You may choose to setup Midi Notes On/Off commands by using the Midi Note Editor.

Midi Messages
If you require intercepting any Midi Message you may use the Midi Message Editor.

MIDI DEVICE SUPPORT
If you wish to use an additional Midi Interface to control Widget Designer you may choose one of these
supported midi devices to map its buttons and fader to scripts, parameters and value ranges.

AKAI APC40
BCD 2000
BCF 2000
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18.5.2.1  Midi Notes Editor

Widget Designer supports standard Windows Midi Devices.

You may choose to setup Midi Notes On/Off commands by using the Midi Note Editor.

In order to receive any Midi Note Message please first setup the Midi Input device in the Connection
Manager .

Tick the check box [Enable] to activate the Midi Notes Editor and remove the check if you want to
disable incoming Midi Notes again.

Once this is up and running you will be able to see the incoming Midi Note messages in the Midi Note
editor.

Scripts

In the Script section you may enter commands to be executed as Midi Note On and/or Midi Note Off
script. You may use the drop-down list and the "Add" button or type directly in the text field. The topic 
Script Language  explains this in more detail.
See here a list of all commands .
To delete a script text box entirely, click [Clear All] above each script.

If you would like to setup the Midi Note On/Off scripts offline, just click on the graphical piano to choose
the desired note and enter the desired Note On and/or Note Off script.

Press Apply to store the script for this note.
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18.5.2.2  Midi Message Editor

If you require intercepting any Midi Message you may use the Midi Message Editor.

In order to receive any Midi Note Message, please first setup the Midi Input device in the Connection
Manager .

With the Midi Message Editor you can filter out specific Midi Data and store commands like a Macro
into a List of Midi Message Scripts. This list you can store for your Widget Designers project.

Use the check boxes to define if you wish the script to ignore or filter the related Midi Data.

Use the [Take] button to grab the incoming Midi Data values and store them with the script  as Midi
Message Script.

To Store a new Midi Message Script enter a new Name in the top drop-down list and press [Apply] or
[OK].

If you wish to delete an existing Midi Message Script, pick the Midi Message Script to delete from the
top drop-down list and press the Delete button. 

1239
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18.5.2.3  AKAI APC40

If you wish to use an additional Midi Interface to control Widget Designer you may choose a AKAI
APC40 to map its buttons and fader to commands , parameters and value ranges.

The AKAI APC40 allows using a separate Midi input device which is set up in the top section of the
AKAI APC40 Editor:

To enable the Midi Input for the AKAI APC 40 board please choose your Midi Receive Device from the
list and press [Apply].

Tick the check box [Enable] to enable the AKAI APC 40 board and remove the check if you want to
disable the device again.

Once connected to the AKAI APC40 you may press a button or move a control to let Widget Designer
intercept and give you access to the Controls scripts or Fader Encoder Settings.

To change any setting press on the control, enter your values and press [Apply].

1312
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18.5.2.4  Behringer BCD 2000

If you wish to use an additional Midi Interface to control Widget Designer you may choose a Behringer
BCD 2000 to map its buttons and fader to commands , parameters and value ranges.

The BCD 2000 allows using a separate Midi input device which is set up in the top section of the BCD
2000 Editor:

To enable the Midi Input for BCD 2000 board please choose your Midi Receive Device from the list and
press [Apply].

Tick the check box [Enable] to enable the BCD 2000 board and remove the check if you want to disable
the device again.

Once connected to the BCD 2000 you may press a button or move a control to let Widget Designer
intercept and give you access to the Controls scripts or Fader Encoder Settings.

To change any setting press on the control, enter your values and press Apply.

1312
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18.5.2.5  Behringer BCF 2000

If you wish to use an additional Midi Interface to control Widget Designer you may choose a Behringer
BCF 2000 to map its buttons and fader to commands , parameters and value ranges.

The BCF 2000 allows using a separate Midi input device which is setup in the top section of the BCF
2000 Editor. 

Since the BCF 2000 is a freely programmable Midi Interface you will need to use the Learn function of
the BCF 2000 to store the Midi value from WD into the unit. 

To do this first set up the Midi Send Device in Order to receive the values in the BCF2000:

To enable the Midi Input for the BCF 2000 board please choose your Midi Send Device from the list and
press [Apply].

Tick the check box [Enable] to enable the BCF 2000 board and remove the check if you want to disable
the device again.

To store the faders, encoders and buttons you will need to select the desired page in both the BCF 200
Editor and on the BCF 2000 Control itself.

Once this is done, hold the learn button on the BCF and press or move any control item to go to the
learn mode. Now click or click and drag any fader in the BCF 2000 Editor with the mouse until the BCF
2000 LCD Menu reads “Good”.

To store commands or a value range for the individual control, click on the controls and enter your values
and confirm with [Apply] or [OK] to store the value in Widget Designer.

1312
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18.5.3  TCP/UDP/COM Connections

The TCP, UDP and COM Port connections are all setup in a similar way as you may want to manage
multiple connections to hardware or software devices via any of the three protocols. Please refer to the
Connection Manager and the sub-chapters TCP , UDP  & COM  for more information. The
Connection Manager  is the tool to setup all main input and output communication protocols and
includes short lists for TCP, UDP and COM connections as well.

If you like to setup or get a better overview of a larger number of connections you may open a dialog
holding a longer list. Of course, all lists are synchronized.

Tools Connection Manager = dialog with short lists of all connections

TCP/UDP/COM
Connections

TCP Connection
UDP Connection
COM Connection

= dialog with a long list of TCP conn. only
= dialog with a long list of UDP conn. only
= dialog with a long list of COM conn. only
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18.5.4  Art-Net Monitor

The Art-Net Monitor can be a very useful tool if you would like to monitor Art-Net data on the network or
simply find out if the DMX channels you are looking for have the right values. 

In the dialog you may select a subnet and universe.  Then all channels are displayed with the according
incoming Art-Net value. If you use WD to send Art-Net and you do so by broadcasting the values, you
will be able to see these values in the Art-Net Monitor too. If you are unicasting the values, please switch
to another Art-Net Monitor, e.g. the one in the PB Menu . 
More information  about broadcast and unicast...
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18.5.5  Remoting

The Remoting Tool allows you to setup a TCP/IP Server (single client or multi client), UDP and HTTP-
Listener, the iPhone WD Remote and a Serial Input without using the Connection Manager and nodes for
incoming communication.

Any incoming data will directly be executed as a command  when the syntax of WD commands is
used. The command must be put in curly brackets, e.g. {WDFaderUp(1,2)}. As a more detailed

example, the command to send a remote command via the TCP Connection 1 would be:
TCPSend(1,"{wdfaderup(301,1)}")

Due to processing "{" and "}" cannot not be used within literals.

The messages received will be displayed in the message log.

Please see the following topics for further information:

TCP Server,
UDP Listener,
HTTP Listener,
Network Broadcasting Service
iPhone WD Remote  and
Serial Input.
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18.5.5.1  TCP Server

In a  TCP environment a computer or device (such as a router or projector) can be set up as either Client
or Server.

The reason for these two types of modes is related to the way how a connection should be established
between two devices. A Server waits for incoming connections while a Client can only connect to a
Server.

The Remoting Tool in Widget Designer offers the option to create a connection type where Widget
Designer as TCP server can receive data packets from multiple Clients at the same time.

TCP Port:
When setting up a TCP Server connection you will need to specify the listening TCP port.

Single Client / Multi Client:
Choose if you want to establish a connection to only one client or if you want to allow multi clients to
connect to your TCP server.
Press [Enable] to start the TCP Server.

18.5.5.2  UDP Listener

The UDP connection is by default set up as broadcast connection. An UDP connection does not require
a dedicated IP address or a Server to connect to.

When setting up a UDP Listener connection you will only need to specify the listening Port. Press
[Enable] to start the UDP Server.

18.5.5.3  HTTP Listener

The HTTP Listener allows you to use a web browser or link to send commands to Widget Designer.

Use this syntax:
http://'WD_IP_Address'/?(Commandstring)

Example: 
http://192.168.1.20/?(FaderUp,2,2000)

iPhone WD Remote (available soon)

Use the Coolux iPhone App (not released yet) to connect via TCP or UDP to the Widget Designer. 
Enter the same port that is set up in the iPhone and check [Enable].

Rev 12 
- HTTP Querystring listener built-in. 
This means you can use a web browser or link to send commands as well ex: 
http://192.168.0.141/?(Commandstring)
- Comport Input Support 
- All Inputs TCP/UDP/HTTP/COM can send input messages asynchronously 
- multiple commands can be send in one message 
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18.5.5.4  Network Broadcasting Service

This section in the Remoting dialog of Widget Designer, Network Broadcasting Service (NBS), allows to
transmit and update Labels , Faders  and Custom Script Buttons  across multiple WD Designer
instances on the network.
Please check the according options to enable/disable the Widget Designer to Send or Receive Network
Broadcasting data.

993 984 935
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18.5.5.5  IPhone WD Remote

Features of the App

The free "Widget Designer Remote" App for Apple devices such as the iPhone, the iPad or iPod allows
to remote control a running Widget Designer with your mobile device. You may send
- single or multi-touch data to remote control the mouse or work directly in various controls such as the
"Multi Touch Panel "
- commands to execute a certain function, either by clicking a button or via a text field
- images taken with your mobile device
- acceleration data from the in-build accelerometer, e.g. to track an object

  

It might be of interest that Widget Designer offers another feature to be remote controlled by mobile
devices. The in-build Web Server  is capable to export any page as a page that can be viewed by any
web browser such as Safari. 

Settings within the device

After downloading and installing the App, please open the "Settings" menu.
Under "Wi-Fi", make sure that you share the same wireless network as the
PC Widget Designer is running on. Afterwards, scroll down the "Settings"
list and search for "coolux", here you may set up the optional settings for
this App.

Protocol:
Choose the connection type: TCP or UDP. For sending touch and tracking
data, UDP is the better choice - for the button and command data TCP is
more reliable. If you like to use the camera mode, TCP must be used.
Please see this chapter  for detailed info about these two protocols. 

IP Address:
Enter the IP address from Widget Designer. If you are not sure, have a look
into the dialog "Pandoras Box IP Configuration ".

Port:
Enter the listening port for the TCP or UDP connection. The same port
needs to be set in Widget Designer, per default it is already set to 23.

Accelerometer:
Enable this option if you like to transmit XYZ acceleration values.

1000
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Button Settings:
Per default all buttons are labeled with the numbers 1-20. Enter a new name
to change this. In the "Script" field, a command can be allocated to each
button. It is mandatory to enclose the command in parentheses. It does not
matter whether it is written in capitals or lower-cased. Please refer to the 
command list  for more details.

Please note that you can enter a command in the App itself as well. The
buttons screen includes a text field, when clicking into it you may enter a
command without parentheses and click "Send" on the keyboard. If you like
to send more than one command at once, you can either send one
command that executes a macro or clicks a Custom Script Button that
holds these commands. Both, the macro and the Custom Script Button
need to be set up in Widget Designer.

If you are using iOS 5 and encounter problems with the App, please update
to a newer operating system, e.g. iOS 6; so far no problems were reported
with that version.

Settings within Widget Designer

Go to the Tools menu and open the "Remoting" dialog. The section "iPhone WD Remote" offers the
following settings.

Port:
Enter the listening port for the TCP or UDP connection. The same port needs to be set in the settings for
the App, per default it is already set to 23.

TCP / UDP:
Decide which protocol you like to use, again it needs to be the same as set in the App. For more
details, see the above.

Enable:
Tick the check box to enable the connection.

Mouse:
This option allows to remote control the position of the mouse cursor with the touch data from the WD
Remote App user interface. Regardless of that setting many controls like the "Multi Touch Panel "
allow to enable the input mode "iPhone" to receive the touch data.

Click 2x:
This option allows receiving a mouse click when the WD Remote App user interface is touched twice.

Click 4x:
This option allows receiving a mouse right-click when the WD Remote App user interface is touched four
times in a row.

If you wish to work with the acceleration values, please create an input node: Input > Device > iPhone
Remote .
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If you like to use the camera mode, please follow these steps. First, pick an image using the App and
send it to Widget Designer. It then appears in the Image Resource Manager  under Style: User,
Control: User. With the help of commands, you may then display it in the Image / Picture Box, use it on
a Custom Script Button or save it directly on the hard drive before adding it to your Pandoras Box
project. The commands including "Recent" refer to the last image send from the App.

Some helpful commands could be:
- WDCustomScriptReleaseImageResource(ID,ResourceName)
- WDImageLoadResource,ID,Resource
- WDImageLoadRecentResource,ID
- WDResourceSave,Resource,Path
- WDResourceRecentSave,Path

18.5.5.6  Serial Input

Any local Com Port will be listed in the Port drop-down list. Windows supports up to 255 comports that
can be either local ports or virtual ports that are connected via network. A couple of manufacturers offer
network based virtual Com Port extensions that can also be assigned here.

To setup a Com Port connection you will need to make sure that all the settings as seen above need to
match the attached device settings 1:1. If the settings are not set correctly to the connected devices
settings you may end up receiving corrupt or no data on this connection.

18.6  Devices

The Devices menu lists all (physical hardware) devices you can work with in Widget Designer. In case
your device is not available, bear in mind that it is also possible to set up a connection , e.g. a TCP
connection. Additionally, WD supports several Tools .

Once you have chosen an entry a dialog opens with more options.

AirScan

Kinect

Face Tracker

Motion Detector

Camera Point Tracker

Phidgets

18.6.1  AirScan

The AirScan is a touch-less hardware interface that is available as an optional input device for Widget
Designer and can be used for any touch-less interactions with a display or a projected touch surface. It
is based on a rotation IR Laser field that allows to read two point multi-touch input gestures and use
them for various applications within Widget Designer.
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The AirScan unit can be mounted above, below or on the side of a screen and its recommended distance
to the input screen area should be not further away then 10m or 30ft. Longer distances can be set up,
but will lead to a less accurate readout. The AirScan measures every 0.36 degrees if anything has
crossed the screen area and transmits its data via TCP over network to Widget Designer for further data
processing.

Due to its IR laser technology, the AirScan device itself should not be exposed to direct sunlight or direct
tungsten lighting as this would distort the correct readout of the sensed data.

AirScan Tool Setup in Widget Designer

Open the AirScan tool from the Tools menu. In the
AirScan setup tool you set up and connect to the IP
address of the unit. Once connected you will see a
yellow outline of the laser field. The input screen
rectangle needs to be placed between a minimum and
maximum range. All setup parameter related to the
AirScan values are set in millimeters.

Once you got your touch data into the system you can
map the first point to the local mouse and use one or
more additional multi-touch points with a Multitouch
Panel or an XY Panel.

The AirScan Tool is divided into several sections:

General Settings,
Input Point Processing,

Calibration,
Multipoint Mode
Mouse Control  and the 
Point Read-out.

18.6.1.1  General Settings

IP:
Enter the AirScan’s IP address and click [Connect] to the AirScan. 

Now you should see a yellow outline of the laser field.

Auto Connect (at the bottom of the AirScan Tool):

Check this option to automatically connect to the AirScan (once the connection to the AirScan is
established) after a disconnect or restart of the Widget Designer.
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18.6.1.2  Input Point Processing

Zoom:
Use the zoom factor to zoom in / out the AirScan field.

Multi Point Mode:
The Multi Point Mode is checked by default, it allows to detect up to 24 points. With this mode the
performance and precision of point detection is enhanced compared to the previous detection mode (that
only allowed to detect two points).

To use the multi-point read-out for further processing, please use the AirScan Multi-Point Input Node .

When not using the Multi Point Mode, please use the AirScan Input Node  for further processing.

Damping:
As you can see in the AirScan setup tool there is also a damping filter value. This value is important as
the IR readout of the AirScan can have noticeable noise that is filtered out with this prediction based
damping.

The damping factor is set by default to 0,10. You can change this setting from 0,1 = maximum damping
up to 1 = no damping.

Motion:
The Dynamic Motion Damping improves the stability of the touch point in motion and stabilizes the
points when they are not moving. It is set by default to 0,3. Its value ranges from 0 (max. smoothness) to
1 (no motion filtering).

Resolution:
Enter here the resolution of your Widget Designer GUI (width and height). 

Range:
The Range is defined through n (near field) and f (far field) in mm. 
Beyond this range no AirScan position data will be transferred to the Widget Designer. Please be sure
that the Active Field (the white rectangle) is positioned within the near and far field.

1068
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Active Region:
X&Y - The coordinates x and y define the position of the Active Region in relation to the AirScan's
position in mm. Please enter the size of the region for W (Width) and H (Height) in mm.

W&H - Enter here the size of the Active Region (width and height) in mm.

Safe Region:
The Safe Region makes the detection of points on the border of the active region more robust.
Enter values in mm for X&Y, ideally the Safe Region is a bit bigger than the Active Region.

Processing (only used when the older mode for only 2 point detection is chosen):
t (Threshold) is equivalent to the angle-ray-count to the distance between point 1 and 2.
ct (count) is the maximum ray count per point.

Inv X / Inv Y / Swap
Use these options if the AirScan is not located above the active field. 
If the AirScan position is e.g. below the active field, check Inv Y to receive correct Y Position data.

18.6.1.3  Calibration

The calibration buttons enable an intuitive calibration of the Active Region.

[P1], [P2]:
[P1] captures the coordinates of the upper left corner (as seen in the AirScan tool).
[P2] captures the coordinates of the lower right corner (as seen in the AirScan tool).
Both corner orientations refer to the view in the AirScan Tool.

How to do the Auto-Calibration?

Interrupt the AirScan field at the position of the first corner, press [P1]. You will see the corner’s position
(x/y in px) next to the button. Now interrupt the AirScan field at the position of the second corner, press
[P2]. When this is done, press [Calc] and the position values will be transferred into the Active Region
Settings.  Please note: the Safe Region has to be adjusted manually!

18.6.1.4  Multi Point Mode
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The Multi Point Mode is used by default unless you disable this function in the Input Point Processing.

Points:
Enter here the amount of points that should be detected and provided for further processing.

Point ID Offset:
The Point ID Offset should be used when you are sending the Multitouch data from this AirScan via the 
Remote Input  to another Widget Designer. It avoids that the Multitouch points from several data
inputs get the same IDs and that there are any ID conflicts. 

Trim:
Trim allows to minimize errors on Point enter, with this value a number of scans will be ignored until the
point motion processing is activated. The default value for Trim is 0.

VCount (Validation Count)
The Validation Count defines the amount of rays that have to be interrupted in order to validate a touch
point. The default value is 2.

Gap:
The default value for the Gap is 5. This means that within 5 rays distance of a detected point all other
interrupts will be discarded. 

Max Delta:
The default value for Max Delta is 100. The Max Delta function determines the maximum speed for Multi
touch Point Tracking.
X&Y Offset:

These offsets allow to run the Widget Designer on a secondary screen. If you’re doing so please enter
here the pixel offset for x and y. 

Example: resolution of primary and secondary screen is 1024x768, WD runs on the secondary screen,
enter x=1025 and y=0.

Start Ray:
The AirScan sends out 500 Rays over 180° clockwise. If you want to discard rays up from the start,
enter the new value here (0-499).

Stop Ray:
The AirScan sends out 500 Rays over 180° clockwise. If you want to discard more or less rays, enter the
new value here (0-499).

Range: (Touch point offset):
The Point offset for the Multi-Point mode allows running the WD on a secondary screen.

TUIO:
In order to output multi touch data to other applications this option allows to send the AirScan’s multi
touch data via the open source protocol TUIO.

This protocol is widely used around the world by many application developers and is a commonly known
way to transmit the individual touches.
To use AirScan with TUIO, set up the TUIO host IP and Port in the Connection Manager .

INFO:
Enable this check box to show the Point Read-Out Dialog  with the data of all multi touch points.
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18.6.1.5  Mouse Control

Enable Mouse
Check this option if the Point1 input data should control the mouse of your WD computer.

Enable Click
If this option is checked the mouse cursor generates clicks. Use the tick boxes to define when the click
should be executed.
Default generates mouse down on enter and mouse up on leave.
On Enter: the click is generated on enter.
On Leave: the click is generated on leave.

Another option to generate a click on a Custom Script Button  is not to use "Enable Click" but to use
the buttons timeout settings. When positioning the mouse cursor over a button for e.g. 500 ms a mouse
click is executed automatically. 

Mouse Down on Move
If this option is checked, left mouse down on move is always active.

935
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18.6.1.6  Point Read-Out

This section shows the status for up to 24 points.
Generally the first ray interrupt will be displayed as P1, second one as P2 and so on.
Each point will be tracked until it is removed out of the AirScan Field. So if there are P1 and P2 detected
and P1 is removed, P2 stays P2 and does not changes its ID to be P1.

Point Active (true or false)
A point turns active as soon as there is a ray interrupt started inside the Active Region of the AirScan.
As long as the interrupt stays within the Safe Region, the point stays active.
If the interrupt started out of the Active Region or if there is no interrupt, the Point’s status turns to False.

Point Enter
If there is an interrupt detected inside the Safe Region (whether it is active or not), the value for the X & Y
position of a Point where it entered the AirScan field will be displayed here.

Point Move
As long as the value for Point Enter is true (1), the X and Y position of this Point will be displayed here.

Point Leave:
The last valid X & Y position of a Point while leaving the AirScan field will be displayed here.

To use this point read-out for further processing, please use the AirScan Multi-Point Input Node .

To control the AirScan via commands, please use these ones :

1068
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18.6.2  Kinect

The Kinect hardware interface is available as optional input device for Widget Designer.
It can be used for capturing up to 8 filtered and tracked points/regions of interest.

Use the Kinect Tool to control PB via the Multitouch Panel , to control the mouse of your WD
computer in order to e.g. proceed button click or process the data you get out of the Kinect Input Node

.

Originally designed for Xbox the Kinect Sensor features a Colour Camera and a so called Depth Camera.
The Depth Sensor (640x480@30fps) delivers a distance value per pixel (0-2047 units). It has an angular
field of view of 57° horizontally and of 43° vertically.
The Depth Camera is used to determine motion at specific distances; it can read distance data between
1.2 - 3.5m distance quite well.

A motorized pivot is capable of tilting the sensor as much as 27° either up or down.

Important Notice Regarding Kinect Device usage:
Kinect driver from codelaboratories is still an early version and seems to run stable on WIN7 only.
When the Kinect Device is connected to a Win7 system there might be a driver conflict when using
Logitec USB cameras at the same time.

Please install the Platform driver first in order to use Kinect within Widget.
The Kinect must be plugged in for the Driver to work other wise it will terminate the WD application when
no device is attached.

Current Kinect Driver for Win 7 64bit Systems:
http://codelaboratories.com/downloads/
This driver MUST be used in order to work with the Kinect device.

Please note: 
Do not use the Kinect Dialog in Show mode (the rendering of the Depth Camera requires too much
system performance).

1000
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Starting and adjusting the device

To start the Kinect device, tick the [enable]-check box and press the button [Start Device]. Now you
should see the colored camera image in the upper image field. 

Depth camera image:
The different colors symbolize different distances from the sensor (e.g. blue=very near, orange=far).

Motorized Pivot:
Use the fader next to the upper camera image to bring the Kinect’s sensor in the right position by tilting
it up and down.

Binary camera image:
In this image every item that is detected by the camera in between a certain distance range will be
shown as white parts on a black background. To define which distance range should be taken, use the
faders “Depth” and “Near” next to the binary camera image.

Depth and Near Faders:
With these faders please define the distance range from which the points should be detected.

Move the Depth-Fader up or down to define the farthest point of the distance range.
Move the Near-Fader up or down to define the nearest point of the distance range.
The Near-Fader always has to be lower than the Depth-Fader.
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Points:
By default two points will be detected. Change this value to decrease it down to one point or increase it
to get up to eight points.

If you choose Points=0, a Fullscreen Mask in Kinect Dialog is shown - currently built-in for evaluation
purposes.

Image processing settings

Blur:
Use this option to smooth the detected areas, so that rough pixels become smooth spots (0 = minimum
blur, 15 = maximum blur).

Please be aware that this takes more performance!

Inflate: 
This option inflates the detected areas (0 = minimum inflation, 15 = maximum inflation).

Shrink:
The result of the (eventually blurred and inflated) areas will be shrunk when using this option (0 =
minimum shrinking, 15 = maximum shrinking).

Please note:
There are no recommendations which values would be best to enter for Blur, Inflate and Shrink. It
depends on your setup and especially the lighting conditions.

Points Detection

Min Width / Max Width:
Define which minimum and maximum width (in pixels) a spot should have to be detected as point.
The pixel sizes are related to the Kinect’s camera resolution of 640x480 px.

Min Height / Max Height:
Define which minimum and maximum height (in pixels) a spot should have to be detected as point.
The pixel sizes are related to the Kinect’s camera resolution of 640x480 px.

Max Delta:
The Max Delta value defines how far a point is allowed to move (in px, related to the Kinect's resolution of
640x480 px) between two frames in order to still be detected as point.

Damping:
The damping allows to reduce noisy input values. The damping factor is set by default to 0,3. This
setting can be changed from 0,1 = maximum damping up to 1 = no damping.

Region:
If it is necessary for a good point detection to use only a certain region of the Kinect’s point of view,
please check the option “Region”. Every movement outside this region will not be executed.

Width / Height:
Choose the region’s size by entering the values (px) for Width and Height. Please note that due to the
Kinect’s Camera resolution the maximum region size is 640x480 px.

X/Y:
The region’s top left pixel is located in 0/0 (X/Y) be default. To move the region to a different position
please enter the according X/Y position here.
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Resolution:
Please enter here the resolution of your monitor. This is needed to adopt the positions of the detected
points to fit to your screen.

Inv X:
Check “Inv X” if you need to invert the X axis.

Inv Y:
Check “Inv Y” if you need to invert the Y axis.

Swap:
Check “Swap” if you need to swap the X and Y axis, e.g. when the Kinect is turned about 90°.

Mouse Control

Mouse:
Enable the mouse if Point1 input data should control the mouse of your WD computer. 

Click:
If this option is checked the mouse cursor generates clicks. Use the tick boxes to define when the click
should be executed.
- Default generates mouse down on enter and mouse up on leave.
- On Enter: the click is generated on enter.
- On Leave: the click is generated on leave.
- On 2nd Hand: the click is generated as soon as a 2nd point (through the 2nd hand) is detected.

Another option to generate a click on a Custom Script Button  is not to use "Enable Click" but to use
the buttons timeout settings. When positioning the mouse cursor over a button for e.g. 500 ms a mouse
click is executed automatically. 

To change the Kinect settings from e.g. a Custom Script Button, these commands  are available.

935
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18.6.3  Face Tracker

The Face Tracker Tool tracks a detected face and outputs its position data via the Face Tracking Input
Node for further processing.

Choose your DirectShow Camera Device from the drop-down list and press [Apply.]

Choose the Tracking Method from the 2nd drop-down list. The following modes are available:
Frontal Face Alt
Frontal Face Alt_Tree
Frontal Face Alt2 (default)
Full Body
Lower Body
Upper Body

As soon as the Face Tracker detects a face / body, it will be surrounded by an red rectangle. 
The position data of this rectangle (x,y,z) is displayed top left of the Window.

To use this data for further processing, please refer to Facetracking Input Node .1085
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18.6.4  Motion Detector

The Motion Detector Tool lets you divide a video input into any amount of columns and rows. It displays
the colour difference per segment caused by moving objects and outputs this data via the Motion
Detector Input Node  for further processing.

Please note: 
This tool as well as the other video processing tools inside WD needs a lot of RAM and CPU power!

Camera:
Choose your DirectShow Camera Device from the drop-down list.

Noise Reduction:
Check this option to apply a noise reduction on the video input.

Columns:
Enter here the amount of columns the video input should be divided in.

Rows:
Enter here the amount of rows the video input should be divided in.

The values inside the single segments display the colour difference caused by moving objects.

To use these values for further processing, please refer to Motion Detector Input Node .

1119
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18.6.5  Camera Point Tracker

The camera point tracker lets you track up to 99 objects and outputs via an attached DirectShow
compatible camera.

The tracking data is available via the Camera Point Tracking Input Node for further processing. The touch
points may be used in e.g. the Multitouch Panel as well.

Please note: 
This tool as well as the other video processing tools inside WD needs a lot of RAM and CPU power!

The tool window is divided into several sections:
Camera settings,
Color Processing ,
Image Processing ,
Point Tracker  and
Touch Output Processing .
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18.6.5.1  Camera Settings

Camera:
Choose your Direct Show Device from the list. Apply it by pressing [Connect Camera].

Settings:
Pressing this button the settings window will appear, where you may set up brightness, contrast etc. for
your camera. This dialog depends of your camera’s driver.

Points:
If you want to track more than 2 points (default setting) you may increase this value here to be able to
track up to 99 points. 

ID Start:
The generated touch points may get an ID offset that you can set up here. This offset can be helpful for
the source identification if you have several touch inputs in a multi-touch panel coming from different
touch point sources within the Widget Designer or from several Widget Designer instances.

Cam / BW:
When “Cam” is chosen the camera image will be displayed in the camera window above. This mode is
helpful to set up the camera as well to choose a tracking color, see section Image Processing .
When “BW” is chosen the Image Processing  and Point Tracker  settings will be applied to the
camera input, the result is shown in black and white.

Example:

See here 2 scenes. Left image: in „Cam“ view, right image: in „BW“ view.

1277
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18.6.5.2  Color Processing

Output Average Color:
When this option is checked the Camera Tracker Input Node  will additionally output the average color
of the camera input, separated in the colors red, green and blue.

18.6.5.3  Image Processing

The image processing section allows adjusting the camera BW image to get the best point detection,
depending on your lighting conditions and your setup. Therefore there are no recommended settings; you
will always have to modify different parameters to get the best result.

Please note: 
The point detection will take effect for the white parts of the black & white image, not for the black parts.

Color Tracking:
The tracking can be done with two different methods: 
1. Based on all colors in the camera image,
2. Based on a color you picked.

The default setting is based on all colors in the camera image. If you want to use the Color Tracking,
please tick the check box [ColorTracking]. 

To set a color that should be tracked, activate the “CAM”-Mode in the camera settings section so that
you see the colored camera image above.

Picking a color directly from the camera image: 
Proceed a mouse-click on the desired color in the camera image. The box next to the ColorTracking
check box will overtake this color.

Picking a color from the color picker box:
Click on the colored box next to the ColorTracking check box. Now you may choose a color from the
list.

Invert:
The inverted mode is enabled by default. In BW-Mode all lighter parts of the camera image will be shown
in black, the darker parts will be shown in white, depending on the Threshold value. To disable the color
inversion please remove the check.
As already mentioned above: The point detection will take effect for the white parts of the black & white
image, not for the black parts.

Threshold:
Set up here the value for the threshold. The threshold defines which parts of the camera image will be
converted into white and which ones into black parts when turning on the BW-Mode. It is related to the
camera images luminance value by default. When Color Tracking is enabled, it is related to the special
color chosen.

1074
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Example:

In the setup above the Color Tracking is enabled. The color was picked from the darker pink plane inside
the camera image. The two pictures below show the tracking result depending on the threshold value.

Left image: The threshold value is very small (17), only the darker pink plane is tracked.
Right image: The threshold value is increased to 53. The lighter pink plane is now tracked as well.
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Blur:
Use this option to smooth the detected areas, so that rough pixels become smooth spots (0 = minimum
blur, 15 = maximum blur).

Please be aware that increasing the blur value takes more performance!

Inflate: 
This option inflates the detected areas (0 = minimum inflation, 15 = maximum inflation).

Shrink:
The result of the (eventually blurred and inflated) areas will be shrunk when using this option (0 =
minimum shrinking, 15 = maximum shrinking).

Please note:
There are no recommendations which values would be best to enter for Blur, Inflate and Shrink. It
depends on your setup and especially the lighting conditions.

18.6.5.4  Point Tracker

Min Width / Max Width:
Define which minimum and maximum width (in pixels) a spot should have to be detected as point.
The pixel sizes are related to the camera’s resolution.

Min Height / Max Height:
Define which minimum and maximum height (in pixels) a spot should have to be detected as point.
The pixel sizes are related to the camera’s resolution.

Max Delta:
The Max Delta value defines how far a point is allowed to move (in px, related to the camera’s resolution)
between two image frames in order to still be detected as point.

Damping:
The damping allows reducing noisy input values. The damping factor is set by default to 0,3. This setting
can be changed from 0,1 = maximum damping up to 1 = no damping.
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18.6.5.5  Touch Output Processing

Resolution (w/h):
Please enter here the resolution of your monitor (w=width, h=height) where the WD runs on. This is
needed to adopt the positions of the detected touch points to fit to your screen.

Inv X:
Check “Inv X” if you need to invert the X axis.

Inv Y:
Check “Inv Y” if you need to invert the Y axis.

Swap:
Check “Swap” if you need to swap the X and Y axis, e.g. when the camera is turned about 90°.

TUIO:
In order to output multi touch data to other applications this option allows to send the Camera Point
Tracker’s multi touch data via the open source protocol TUIO.
This protocol is widely used around the world by many application developers and is a commonly known
way to transmit the individual touches.
To use Camera Point Tracker with TUIO, set up the TUIO host IP and Port in the Connection Manager

.

x/y/w/h (Range Conversion for Touch points):
The range conversion for touch points can be used if the camera point tracker should only affect a
specific screen region, or if multiple Widgets are used with multiple camera point trackers together.
Enter the position of the region’s starting pixel (left top pixel) inside the text fields for x and y.
The regions size will be defined by entering its width (w) and height (h).

Example:

In the image above a point is tracked (point 1) in the center of the camera point tracking tool.

In the images below you see the usage of this touch point in a Multitouch Panel with different range
conversion setups.

1239
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Image 1: There is no range conversion setup in the camera tracking tool. The point that is detected in the
center of the camera image appears in the center of the Multitouch Panel.

Image 2: There is a range conversion setup in the camera tracking tool. The region defined is shown by
the red dashed rectangle. The point that is detected in the center of the camera image appears now in
the center of the defined region instead of appearing in the center of the whole panel.
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18.6.6  Phidgets

Phidgets are a set of "plug and play" building blocks for low cost USB sensing that can be controlled via
the Widget Designer amongst others. The Phidgets are available via www.phidgets.com.

The following Phidgets are implemented already:

Interfacekit 0/16/16
This tool allows receiving the status of 16 Digital Inputs sensing up to 30 VDC and controlling 16 Digital
Outputs up to 30 VDC.

IR – Receiver Transmitter
This Tool allows sending and receiving of IR Codes, e.g. to and from an old remote control.
Received IR Codes can be learned and stored with an Alias name to be used in commands to retransmit
the code. 

Relay Interface 0/4/4
The PhidgetInterfaceKit 0/0/4 allows opening and closing 4 Relay Outputs for switching AC or DC power;
the relays are Single Pole Double Throw (SPDT).

RFID
The RFID (Radio Frequency Identification) Phidget reads RFID tags that are brought in close proximity to
the reader and returns the tag identification number.

Servo Motor Advanced 8
The Phidget Advanced Servo provides an interface to control 8RC analog servo motors.
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18.6.6.1  Interface Kit 0/16/16

(P/N 1012 –PhidgetInterfaceKit 0/16/16)

The Interface Kit 0/16/16 allows receiving the status of 16 Digital Inputs sensing up to 30 VDC and
controlling 16 Digital Outputs up to 30 VDC.

Setting up the digital inputs

The Digital Inputs are activated by an external voltage source, triggering on a wide voltage range - 4 to
30VDC. Depending on the status of the digital inputs dedicated scripts may be executed. To do so enter
the commands in the On-Script and Off-Script text fields. The colored box in front of each input displays
the input status: ON = green, OFF = white. The topic Script Language  explains commands and how
to use them in more detail.

Tick the check box [Enable Scripts] to enable the On- and Off Scripts.

To enable or disable the execution of a script triggered by the digital inputs via a command (e.g. by
clicking a Custom Script Button), use these commands , you can as well control the outputs via
commands.

Setting up the digital outputs

Each digital output you want to use needs to be enabled by ticking the check box according to the
output. 

1312
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18.6.6.2  IR - Receiver Transmitter

(P/N 1055 – PhidgetIR)

This Tool allows sending and receiving of IR Codes, e.g. to and from an IR remote control.
Received IR Codes can be learned and stored with an Alias name to be used in commands to retransmit
the code. 
This way any remote control IR code can be recorded and send via commands.

These commands  are available to enable/disable the IR Phidget and to send the IR Alias code:

To link commands to incoming IR Codes, please use the Phidget IR Script Node .

1378
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18.6.6.3  Relay Interface 0/4/4

The PhidgetInterfaceKit 0/0/4 allows opening and closing 4 Relay Outputs for switching AC or DC power;
the relays are Single Pole Double Throw (SPDT).

Maximum DC Switching Voltage: 100VDC
Maximum DC Switching Current: 5A
Maximum AC Switching Voltage: 250VAC
Maximum AC Switching Current: 10A

Connecting to the Relay Interface Kit 0/4/4

To connect to your Phidget InterfaceKit 0/4/4 you may press [Info?]. A pop-up dialog will show the serial
numbers of all Phidget Interface Kit connected to your computer.

Enter the Serial Number of the device you want to connect to in the text field for “Serial No:”
Press [Start] to start the connection. The connection status will be shown below the Serial No.’s text
field.

Changing the relay output status

To open and close the relay outputs you may tick the check boxes for the Outputs 0-4 inside this tool.
They can be opened and close via these commands  as well:

Please note:
The tool just controls the output status, you won’t get a feedback from the relay interface about the its
real state.

18.6.6.4  RFID

(P/N 2002 - PhidgetRFID Kit)

The RFID (Radio Frequency Identification) Phidget reads RFID tags that are brought in close proximity to
the reader.

To enable the RFID Phidget Controller, please activate the check box.

These commands  are available to enable/disable the RFID Phidget Controller:

1373
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To link commands to incoming RFID Codes, please use the Phidget RFID Script Node .

Please note:
It is possible that the Phidgets RFID do work only under Win7.

App hang has occurred on XP when a RFID Tool and RFID Script Node Property Window is open at the
same time

18.6.6.5  Servo Motor Advanced 8

(P/N 1061 - PhidgetAdvancedServo 8-Motor)

The Phidget Advanced Servo provides an interface to control 8RC analog servo motors.

To enable the Advanced Servo Controller, please activate the check box top right.

These commands  are available to enable/disable the motors and to change their acceleration,
maximum velocity and position.
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18.7  Tools

The Tools menu lists all tools available in Widget Designer. In contrast to a physical hardware device ,
a tool is rather a software tool. In addition, it is also possible to set up a connection , e.g. a TCP
connection.

Once you have chosen an entry a dialog opens with more options.

Events

Keyboard Input

Midi Input

Blacklist  (not included in the WD Free Edition)

Email Settings  (not included in the WD Free Edition)

RSS Settings  (not included in the WD Free Edition)

SMS Settings  (not included in the WD Free Edition)

Projector Calibration Manager  (Beta)

Pandoras Box

Video Logger

Video Recorder

Image Resource Manager

Lock Interface

Options…

Lock Interface
When choosing the "Lock Interface" command from the Tools menu a password dialog will pop up and
restrict the access to the interface from Widget Designer. The interface can be only unlocked when the
correct password is entered.
The default password is empty. 
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18.7.1  Events

The Event Editor allows you to execute commands at a certain time or repeated in a certain time
interval.

Enter the Event's name in the Event text field or choose an existing Event from the list to view and edit it.

Set up the Repeat option. Choose a Single Event or a repeat time interval: every minute, hour, day,
week, month or year.

If the Count should end at a certain time, please choose "End Date" from the Count list. Then the End
Date lists will be enabled.

Choose a Start date from the calendar list and the start time. If you need a start time that differs from the
options in the time list, please enter it manually.

If the Count has an End Date, please also choose end date and time from the list below.

In the Script section you may enter commands to be executed. You may use the drop-down list and the
"Add" button or type directly in the text field. The topic Script Language  explains this in more detail.
To delete a single command, select it and click on [Delete]. To clear the entire script from the script text
box, press [Clear All].

1312
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18.7.2  Blacklist

Use the blacklist for filtering incoming Emails , SMS  and RSS feeds  for specific words.

Enter the keywords one after another in the Item text field. Apply each keyword by pressing [Add]

To clear a single keyword from the list, right-click on this entry and choose "Delete".
To clear the whole list, use the button [Clear List]. 

18.7.3  Email Settings

The Email Settings is the tool to setup all incoming and outgoing Email communication.
To process the incoming emails inside Widget Designer, also use the Email commands
“EmailSend,'To','Subject','Message'” and “EmailSendAtt,'To','Att','Subject','Message'”, see script language

.
Email Input Node .
To process any data inside Widget Designer to send via Email, also use the dedicated .

1289 1294 1292
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Outgoing Email Server

Please enter all relevant information for your SMTP Mail Server settings, such as
- Mail Server (SMTP),
- Email Address,
- Username,
- Password.

Tick the check box "Use SSL" to use SSL (Secure Socket Layer).
Tick the check box "Use Default Authentication" to use default authentication.

Incoming Email Server

Please enter all relevant information for your POP Mail Server settings, such as
- Mail Server (POP),
- Email Address,
- Password.

Tick the check box "Use SSL" to use SSL (Secure Socket Layer).
Tick the check box "Auto Poll" to automatically poll your email account. Enter the interval time in the
text field aside.
If Auto Poll is not checked, your Email account will only be polled once when pressing Apply.

Email I/O

Inbox:
To use the Blacklist  filter, please check this option.

Click on "Create Incoming Mail Message" to get an email message without polling it from the mail
server.
The following pop-up window opens:

1289
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Click "Add to inbox" to receive this email in your inbox, click on Close Window if you do not want to
send the email.

If you right-click on an email in your inbox, you have the opportunities to:

- Delete this mail,
- Refresh the Inbox List,
- Clear the Inbox.

Outbox:
In the Outbox all emails sent will be listed.

Click on "Send Email" to create an email directly in the outbox.
The following pop-up window opens:

Enter the receiver, subject and message and press "Send" to send this email or directly "Close Window"
to leave this dialogue.

If you right-click on an email in your outbox, you have the opportunities to:
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- Delete this mail,
- Refresh the Outbox List,
- Clear the Outbox.

Export Email:
Exports all emails addresses listed in the inbox into a text file.

Export Outbox:
Exports all emails listed in the outbox into a text file.

Export Inbox:
Exports all emails listed in the inbox into a text file.

18.7.4  RSS Settings

The RSS Settings is the tool to setup and create all RSS feeds.
To process the incoming RSS feed inside Widget Designer, also use the RSS Input Node .

URL List:
Enter a new URL manually in the text field or choose one from the list.
To add an URL to the list, press [Add] after you entered it into the text field. Click [Remove] to remove
this entry from the list.

1132



1293

Check "Auto Poll" and enter the Poll interval in seconds to automatically poll the RSS Feed. If this
option is unchecked the RSS Feed will only be polled once when pressing [Apply] or [OK].

To use a prepared Blacklist  for filtering the RSS Feeds for specific words, please check the option
Blacklist Filter.

All received RSS Feeds will be displayed in the incoming RSS list.

Create new Items:
Click on this button create a RSS feed manually. 
In the upcoming dialog enter the link that should be displayed, a title and the RSS message text.
Press [Add to RSS List] to transfer it to the incoming RSS list.

1289
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18.7.5  SMS Settings

Setup your GSM modem in this tool to be able to receive and send SMS via the Widget Designer.

GSM Modem Settings:
Choose the COM Port, Baud rate, Data Bits, Parity, Stop Bits and the Flow control. Enter the Pin for the
GSM Modem and press [Connect].

Blacklist Filter
To use a prepared Blacklist  for filtering the incoming SMS for specific words, please check the option
Blacklist Filter.

Send SMS To All:
Click on this Button to send a SMS message to all Phone numbers in the SMS List. The following pop-
up window opens:

1289
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Additionally to all Phone numbers in the SMS list, the new SMS can be sent to any number entered in
the text field next to Phone Number.
Enter the SMS text in the text box.

Create Incoming SMS Message:
Click on "Create Incoming SMS Message" to create a SMS message without polling it via the GSM
Modem.
The following pop-up window opens:
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Enter the phone number that should appear as faked SMS sender in the text field.

Use the text box to enter the SMS text.

Push [Add to SMS List] to add this entry to the SMS Inbox list. 
If you want to discard this entry, just press [Close Window] without adding it.

Clear List:
Click this button to clear the SMS List.

Export Phone List:
Click this button to export all SMS sender's phone numbers to a text file.

Export SMS List:
Click this button to export all SMS (phone number and message text) to a text file.

Load Inbox to List:
Load all SMS from your SIM Card into the Inbox.

18.7.6  Projector Calibration Manager

The Projector Calibration Manager is a Tool that allows to setup the connection between a Calibration
Link  and other Pandoras Box software components. It is a fundamental item in the entire Re-
Calibration process.

The principle behind "Re-Calibration"

Currently only projections onto 2D-planes can be re-calibrated. The automation for 3D structured screens
will follow. However, the general principle behind the calibration applies to any screen shape.
The fibre cable ends are mounted into the screen in the below described way. Then the projector setup is

777
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done as usual, followed by the warping or keystone step and / or softedge. Now, the image fits onto the
screen. After a while, this might not be the case anymore, because the projector or the screen have
moved. A typical scenario is a lamp change for a projector in a fixed installation. It is important that the
projector still covers about 90% of the screen area. At least the projector needs to hit all calibration
points.
This is when the Calibration Link is used as the screen- /projector-shift can be evened out with an
automated re-calibration. This works with fiber cables measuring the light from the projector which
projects different testpattern. The process does not include any cameras, only fibre cables and the
Calibration Link. Based on these light measurements, the exact pixel location can be determined and
necessary changes can be applied (automatically) to Pandoras Box software.
In short, the re-calibration is not an automated warping for the first setup. Once the projectors are setup
by a technician who knows the system but a projector- or screen-shift has occurred, the re-calibration
allows anybody to adjust the new output offset within a couple of minutes. The entire process can be
started with one button click and no further manual settings are necessary. This is useful when the
installation is serviced by staff who does not know how to reset the warp and blend properly.

The pixel accuracy that can be achieved in a best case scenario is 1mm / +- 1pixel accuracy.

There are different modes for both, 2D and 3D re-calibration, some are restricted to Server features whilst
others are accessible for Pandoras Box Player as well.

Currently, the calibration points are fibre tips. However, in the near future, they can be alternatively
replaced with markers or digital markers seen by cameras.

Mounting the fibre cables

The Calibration Link is a device that allows to measure the light intensity levels of a 1mm fiber cable. The
Re-Calibration process is based on these measurements. Hence, the quality of light transmission effects
the quality of the process significantly.

The cable ends are mounted into the screen in a way that the fibers "look" straight at the projector to
catch as much light as possible. The more offset the cable ends have, the more precise the calibration
can be. At best, they are mounted into the corners.
A minimum number of four cables is required per projector. However one can be shared by several
projectors. That is, if you have a softedge blend with two projectors then you can use six fiber cables
(two in the overlap, and the other four near the corner of the screen).

Direct sun light needs to be avoided. By the very nature of the cables, they should be bend as less as
possible. Also, the fibre cables that form a group for one projector should be equally long. The minimum
length depends on the brightness of the projector. The longer the fibre cable is, the more light needs to
hit the tip of the cable. As a rule of thumb, a 10m fiber cable requires at least 100lux. If you have 20m
cables then you need to have a minimum brightness of 200lx and so on.

The cable ends must be clean and cut as straight as possible. It is highly recommended to use a
professional fibre cutter to do so as other tools squeeze the fibre and reduce the transmission quality.
Neither end from the glass itself must stick out from the cable sheath! Simply hold to isolated end into
the fibre input and move slightly forwards until it withstands, then tighten the screw-able input.

It is recommended that the projector pixels are in a best focus position for all fiber points.
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Hardware and software setup

This depicts the communication
between Pandoras Box (PB)
components, Widget Designer
(WD), Calibration Link and fibre
cables.

First of all, a PB Master (e.g. a
Manager) is connected with a PB
Client (Server or Player) or a
Server / Player run in stand-alone
mode. The PB Menu runs in the
background of the PB Client.
Widget Designer may run on the
same or a separate hardware and
is connected to the PB Master
and the Calibration Link. Fibre
cables run from the Calibration
Link to the screen and detect
light from a projector that is
connected to the PB Client.

1. The user starts the re-
calibration process by clicking a
button in WD.
2. WD tells PB Client via network
to leave fullscreen.

3. WD tells PB Menu via network to start slide show of calibration testpattern.
4. Each testpattern is shown by the projector(s).
5. According to their position, the fibre cables receive a certain light amount per each testpattern.
6. The Calibration Link measures the light amount and transmits that information via network.
7. WD calculates the position from the fibre tips (markers) based on the light measurements for each
testpattern.
8. WD calculates the necessary re-calibration settings.
9. WD applies the changes to the PB Master (via network). The changes are defined by the chosen
mode:
  a) WD calculates and applies new parameters for the Camera layer.
  b) WD creates and applies a new warp object for the Output layer.
10. WD toggles the PB Client into fullscreen mode. The re-calibration process is finished within a few
minutes.

Software components

The following software components are needed and should be connected to each other:
- a running Pandoras Box Master with Camera Layer / Output Layer settings for the Client
- a running Pandoras Box Client
- a running PB Menu on the Client
- for some modes, an installed Warper on the Client
- a running Widget Designer project with the following two nodes and a tool 

Create > Nodes > Input > Devices > Calibration Link  - one node per Calibration Link device
Create > Nodes > Input > Pandoras Box > System Menu (or search for PB Menu) - one node per Client
Tools > Projector Calibration Manager
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In the Projector Calibration Manager "Add a new Output" and the according "Edit" dialog opens. Each
projector is to be managed individually. If you like to open the Edit dialog, simply double-click on an
existing entry.
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Item ID
The internal ID cannot be edited.

Name
Choose a name for the output.

Menu Node ID
Enter the Node ID from the PB Menu node. Within the node itself, the IP address from the Client must
be entered.

Output Mode
Choose the according output mode according to the Client's graphics card settings.

Output Preset and Resolution
Choose the resolution per output according to the Client's graphics card settings. You may use the
preset list or enter a custom (pixel accurate) custom resolution.

Calibration Mode
Choose the calibration mode you wish to use.

2D Screen Offset (implemented and tested) - This mode the most simple one. It modifies the X & Y
offset parameters in the Output Device Layer in the Master software to offset its warp object. The
changes are based on the average offset of the projectors original home position and its new position. No
scaling or rotation is applied in this mode.
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2D Planar Perspective (implemented and tested) - This mode opens the defined warp file and modifies
the mesh according to the projector changes (X & Y offset, rotation, size and perspective
transformation). A new warp file is being generated, saved under the given name and applied to the
output in the Master software.

3D Planar Calibration - (for future use) - This mode will use the 2D planar calibration method of
Pandoras Box Warper. In this case the fiber points and the 4 coplanar (!) markers must match. The
result of this process is that a new Camera Position will be calculated and applied in the Pandoras Box
Master.

3D Object Calibration - (for future use) - This mode will use the 3D pose calibration method of
Pandoras Box Warper. In this case the fiber points and the 4 non-coplanar (!) markers must match. The
result of this process is that a new Camera Position will be calculated and applied in the Pandoras Box
Master.

Interval
This interval determines the calibration image update rate. The default value is 200ms and can be
increased when the network performance does not allow to change the calibration images that fast.

Warp and X File
Depending on the chosen Calibration mode, you are asked to name a Warp and X file. Click the [...] icon
to choose the file directory on the Client. For the X file, please enter the File and Folder ID used in the
Pandoras Box Master.
The Import Markers button is for future use.

PB Camera and Output ID
Depending on the chosen Calibration mode, select the Site and Device ID (as seen in the PB Master's
Devices tab) for the camera or output layer.

Device Type
For future use. The current Re-Calibration process is based on the Calibration Link's measurements.
Later, a camera-based process will be possible too.

PB Camera and Output ID
In order to get the home position data, a first initial calibration routine is required to calculate the pixel
position of each fiber point per projector.

Calibration Point List
Create an entry for each Calibration point i.e. fibre tip. The order does not matter.
ID - the ID from the Calibration node
Input - the input from the Calibration device to which the cable is attached
Marker - the ID from a Marker in the Warper (only necessary for some Calibration modes)
Max: the maximum allowed brightness value as seen in the Calibration node's properties. The default
value is 1024 and can be reduced to your expected value for a white pixel. If then a value above the
maximum is measured, you know, that something unexpected occurred during the calibration process,
e.g a moving light hit the screen.
Threshold - the minimum value difference between "white" and "black". Note that lowering the threshold
might result in entirely wrong re-calibration results due to misinterpretations. Due to light noise, the
default threshold of 50 is reasonable. Please read below passage "Possible error messages".

X, Y - The stored X and Y position per calibration point after the button "Store Home Position" was
clicked. You may modify the number by clicking in the field and typing.

X', Y' and Z' - The new X, Y and Z position per calibration point after the button "Re-Calibrate and Apply"
was clicked.
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number  It is important to note that the physical fiber point location should not be changed after the
home position has been initialized and stored.

Store Home Position
The process to find the home position is done by projecting a series of black and white horizontal and
vertical images. This process takes minimum 30 sec per projector (the time depends on the systems
signal latency and network speed). As a result the X and Y positions are stored in the above described
Calibration Point List.

Re-Calibrate and Apply
The re-calibration process is done in the same way as finding the "Home Position". As a result the X', Y'
and Z' positions are stored in the above described Calibration Point List. Depending on the chosen
Calibration Mode, the necessary changes are calculated and applied.

Possible error messages

To find a "Home Position" or "Re-Calibrate Position" a series of black and white horizontal and vertical
images is projected. With pure logical combination Widget Designer then determines where the fibre tip
is located.
0,0 is the X and Y pixel position for the left upper corner. 1920,1080 would be the right bottom corner for
an HD projector.
This entire process requires that "white" and "black" can be clearly distinguished. The above mentioned
"Threshold" parameter in the Calibration Point List defines this minimum value difference.

If the minimum is not reached, the Calibration process fails and gives an according warning. Possible
reasons why a black pixel cannot be distinguished from a white one could be that black is too bright or
white is too dark or even black equals white:
- too much (side) light on screen that raises the value for black
- broken projector lamp
- poor cable transmission quality
  - broken Calibration Link
  - broken cables
  - too long cables
  - cables bend
  - cable tips dusty, dirty
In the worst case, the projector moved so much that its light does not hit the fibre tips any more. So
before starting the process, ensure that the projector covers all of its related fiber points as well as all of
its dedicated screen-space.

The minimum values in the Calibration Link node for white should be above 100, for black 30-40 and most
importantly, the difference between white and black should be around 30-120.
If your value for white exceeds 1024 you may set the Calibration Link to coarse mode. It roughly doubles
the value range. If you need to do that, open the Calibration Link and find a dip switch on the circuit
board. If you need assistance, please contact coolux support.
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18.7.7  Pandoras Box

In the WD Tools menu , the category "Pandoras Box" offers the following options that add and edit
Layers and Cues in a Pandoras Box  Master software:

Add Layers to Pandoras Box

Array Align Layers

Circle Align Layers

Cue Generator

18.7.7.1  Add Layers to Pandoras Box

This tool allows you to easily add one or several new graphic or video layers to the PB V5 Master Device
(and its connected Clients) directly from within the Widget Designer.

Please note:
This tool does not work if connected to a PB Master Device below Version 5. The maximum number of
supported layers can not be exceeded, e.g. a Server LT provides 8 video layers, thus only graphic layers
can be added to it. The number of supported layers per device can be found in the chapter Product
Overview .

[Video Layer] / [Graphic Layer]:
Choose whether you like to add video or graphic layers.

[Site ID]:
Enter here the ID of the site to which new layers should be added.

[Count]:
Enter here the amount of layers you want to add to the specific site. 

[Generate]:
Press [Generate] in order to generate the specified amount of layers to
the site. Depending on the amount, this may take a while and prevent
the Master from reacting.

18.7.7.2  Array Align Layers

This tool allows you to arrange several graphic or video layers from your PB Master Device and its
connected Clients to form a pattern - a line (1D), a rectangle (2D) or a rectangular box (3D). This kind of
arrangement can be done from within the Widget Device faster and easier.
Please read the next topic  if you are interested in a circular alignment.

Please note:
It is recommended to use this tool with a PB Master Device Version 5.
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[Site ID] and [Device ID]:
Enter here the ID of the site and the starting device to address the layers which should be arranged.

[Silent]:
Tick the check box if the generated position values should not be entered as active values, but silent
values.

[No Damping]:
Tick the check box if the position values should be applied instantly without the Pandoras Box setting for
Translation Smoothing.
This damping time can be adjusted in the site's Inspector .

[Start Location]:
Enter the X, Y, Z position and choose whether the starting point should be centered or not.

[Align]:
Set the radio buttons to form a line (1D), a rectangle (2D) or a rectangular box (3D). The X, Y, Z values
apply for the offset between the layers whereas "Count" defines, how many layers are influenced. In the
depicted example the offsets between the 5 horizontal layers are set to 2 and the vertical offset to -3, in
total 10 layers (2.1 to 2.10) are arranged. 
Please note that the positive X direction points to the right side, the positive Y direction points to the
bottom and Z points into the display.

18.7.7.3  Circle Align Layers

This tool allows you to arrange several graphic or video layers from your PB Master Device and its
connected Clients to form a circular pattern. This kind of arrangement can be done from within the
Widget Device faster and easier.
Please read the previous topic  if you are interested in an array alignment.

Please note:
It is recommended to use this tool with a PB Master Device Version 5.

208
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[Site ID] and [Device ID]:
Enter here the ID of the site and the starting device to address the layers which should be arranged.

[Silent]:
Tick the check box if the generated position values should not be entered as active values, but silent
values.

[No Damping]:
Tick the check box if the position and rotation values should be applied instantly without the Pandoras
Box setting for Translation and Rotation Smoothing.
These damping times can be adjusted in the site's Inspector .

[Start Location]:
Enter the X, Y, Z position for the starting point. The "Start Angle" defines where the first layer is
positioned.

[Align Mode]:
The "Layer Count" influences how many layers are arranged in a circular pattern. "Radius" enlarges the
size of the formed circle. "Orientation" gives the possibility to span the circle in a XY / YZ / XZ plane.

In the image the option "Rotate Layers" is activated, the layer's lower sides do not face down any more
but towards the circle`s center.

"Set Pivot To Circle Center" was ticked as well. The Rotation Pivot Point is positioned in the circle's
center. Now, a constant rotation can be applied, for example.

208
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18.7.7.4  Cue Generator

The Cue Generator Tool allows you adding cues into a timeline in Pandoras Box Master Device.

This can be done in two different ways:
- Arranging a specific amount of new cues evenly over a time period.
- Arranging a specific amount of new cues with intervals.

[Sequence ID]
Enter here the ID of the sequence in which you want to add new cues.

Generate Cues Over Time

[Start Cue]
Enter here the ID for the first cue that will be added.

[Cue Count]:
Enter here the amount of cues that will be added.

[Start Time]:
Enter here the time at which the first cue will be placed, in the format (hh:mm:ss:ff).

[End Time]:
Enter here the time at which the last cue will be placed, in the format (hh:mm:ss:ff).

[FPS]:
Enter here the frame rate the sequence is set to in Pandoras Box (FPS = Frames per second), see 
Sequence Inspector .

[Type]:
Enter here the type of the new cues: Play, Pause or Stop.

Generate Cue with Interval

[Start Cue]
Enter here the ID for the first cue that will be added.

201
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[Cue Count]:
Enter here the amount of cues that will be added.

[Start Time]:
Enter here the time at which the first cue will be placed, in the format (hh:mm:ss:ff).

[FPS]:
Enter here the frame rate the sequence is set to in Pandoras Box (FPS = Frames per second), see 
Sequence Inspector .

[Interval]:
Enter here the time interval after which the next cue will be added to the timeline, in the format
(hh:mm:ss:ff).

[Type]:
Enter here the type of the new cues: Play, Pause or Stop.

18.7.8  Video Logger

The Video Logger allows logging the timeline of Pandoras Box. The feature is useful when clients ask for
a playback documentation, e.g. what media was seen for how long.

Please see below a showcase timeline with 3 video containers programmed on two layers. The cues are
dispensable.

When importing the log file into a tabulation program like Excel from Microsoft, the result could look like
this. For documentation reasons the cues where inserted into the table as well.

Time Descript. Site
ID

Device
ID

Folder
ID

File
ID

FilePath Starttime    Duration
      (hh:mm:ss)

Total
Sec.

A 10:22:59 MediaLog 2 1 -1 -1 None 10:22:36 00:00:22 22.5

B 10:23:28 MediaLog 2 2 -1 -1 None 10:22:36 00:00:51 51.5

C 10:23:29 MediaLog 2 1 10 1 c:\video1.m2v 10:22:59 00:00:29 29.9

D 10:23:32 MediaLog 2 1 -1 -1 None 10:23:29 00:00:02 2.9

E 10:23:33 MediaLog 2 2 10 2 c:\video2.m2v 10:23:28 00:00:04 4.9

F 10:23:35 MediaLog 2 1 10 3 c:\video3.m2v 10:23:32 00:00:02 2.9

At time 0:00 the video logging in Widget Designer was started, 22.5 seconds later the first container on
the first layer started. In other words, and this is what the first line in the table tells us, for 22.5 seconds
nothing was rendered on that layer.
The next line informs that nothing was seen on the second layer for 51.5 seconds.
Line C states that the file "video1.m2v" saved directly on hard drive C:/ was played back on the first layer
(site 2 - device 1) for 29.9 seconds. The duration is given in seconds  and in time code language. As well
the Folder and File ID (setup in the File Inspector ) is logged. When no IDs are assigned "-1" will be
saved.

201
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This image shows the Video Logger from Widget Designer. The Video Logger was set up to log Layer 1
and 2 on Site 2. The trigger for the opacity parameter was set to 0.

[Site ID] and [Device ID]
Enter here the ID of the site and the device that should be logged. After setting up the opacity click
"Add" to adjoin the layer to the Video Logger's list.

[Min. Opacity]
As soon as a layer exceeds the minimum opacity a log entry is generated.

[Add]
First set up the site and device ID and the opacity trigger value, then click "Add" to adjoin the layer to
the Video Logger's list.

[Remove]
If you like to erase a layer with from the Video Logger's list, set up the site and device ID and click
"Remove". The opacity value is of no importance.

[Clear devices]
Erases all layers from the Video Logger's list.

[Refresh Devices]
Refreshes the list of layers.

[Start Logging]
Defines a moment 0:00 and starts the logging process with the sequence of the Pandoras Master
System that is connected to the Widget Designer.

[Clear Log]
Erases all log entries (without pausing the logging process). If you like to erase particular lines only you
may as well select them with the mouse or keyboard and press the Delete key.

[Save Log]
Saves the log as a *.csv file to a file path of your choice. When importing the csv into another program
you may choose to use the semicolons as a separation symbol.
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18.7.9  Image Resource Manager

The Resource Manager gives a fast and easy possibility to manage images within Widget Designer. 
Example1: You are using images for controls like buttons and faders.
Example2: You are using the WD Remote App  and send pictures from your Apple mobile device to
WD.

The right-click menu lists the commands to add a file from your hard drive and to reset and refresh the
resources within the Resource Manager. The "Delete" command works only for added images, not the
once that are displayed per default.
If you send images via the WD Remote App , they are displayed automatically in Style:Default,
Control:User.

In the item's properties (e.g a fader) you may find a [Res] button which opens the Manager as well.
Instead of opening a specific file path for each item separately you may use the Resource Manager for a
faster access.

If you like to have the same custom look for all Faders and Custom Script Buttons you may design it
once in the dialog "Default Image Settings" in the "Tools" menu and all new items created then will adopt
to it.

1260
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18.7.10  Options

The Options tool allows to set advanced options to
- influence the performance of the node system
- load your own custom script plugin
- enable the Debug Logging to search for errors in your programming

Node System

When the user interface contains a lot of controls (labels, faders etc.) that are updated via output nodes,
these updates could slow down the whole system performance. In these cases it could make sense to
slow down the output node processing to gain overall system performance.

The disadvantage of slowing down the node processing is that all data given out by the nodes, for
example Art-Net data, will be slowed down as well.

[Node Interval]:

By default the Node Interval is set to 0 ms. This means
that there is no delay between the processing of values
from one node to the following node. If setting the Node
Interval to x ms, there will be a pause of x ms after the
processing of each(!) node within one node chain.

[Node Cycle Interval]:

A node cycle interval is the interval, in which all output
nodes are processed once, in other words after what
time the Output updates / sends out its current value. By
default the Node Cycle Interval is set to 15 ms. This
means that after all output nodes are processed once
there is a wait time of 15 ms, i.e 40 times per second.
You may set this wait time to a different value to slow
down or speed up the node processing interval.

[Node Priority]

In reference to process scheduling which controls the
usage of the system's CPU for each single process (or
thread), the node priority can be reduced or enforced.
Please note that this might influence the entire operating
systems and how other applications work.

[Defaults]:

Press this button to set the Node Interval and Node
Cycle Interval back to their default values.

Since the Property pages request the node chain to update 25 times per second to display the current
values, it is recommended to have all property dialogs closed during show mode for exact value
processing.

Script Plugins

It is possible to integrate custom nodes and commands in Widget Designer.

If you are interested in a code sample for Visual Studio .NET, please contact our support team. These
sample project files are meant as an introduction for experienced developers who have knowledge in C#
or Visual Basic .NET. The compiled *.dll file containing your custom features need to be saved in the
program directory under Data\Plugins, e.g. C:\Program Files (x86)\coolux\Widget Designer 4.5 Rev 642
\Data\Plugins\Scripts

mailto:support@coolux.de
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18.8  Scripting

The Scripting menu  lists all information around using commands in Widget Designer.

The chapter Script Language  explains the general usage of the script language in Widget Designer,
e.g. what is a command and how do I write it. Further advanced programming statements are explained,
e.g. the if-statement .

In addition it covers helping tools and scripting techniques regarding scripting in Widget Designer.
Functions and Macros
Variables
The Object and Member Notation (dot syntax)

See the chapter Scripting Menu  for information about the options you can choose there, e.g. the
Debug Logger.
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18.8.1  Script Language

The built-in script language allows you to create customized routines of commands. Currently over 1500
commands  are available to control specific features of Pandoras Box, Widget Designer or other 3rd
party products and protocols.

Commands can be used as a project's Start-up Script  or in some nodes, tools and many widgets.
For example, you may assign one or more commands to a button click.

How to enter a command using Script Assistant

In order to use a command, open the widget's Item properties, for example from a Custom Script Button
.

As soon as you start typing in the dedicated script text field, the feature Script Assistant will
automatically search for available commands that contain the typed characters and display the result in
a list box. The [ESC] key hides this list. The availability of commands depends also on the fact, whether
a widget is already added to the project, i.e. without existing faders, the Script Assistant will not offer
fader commands. 

You have three possibilities for setting up the script filter of your assistant, just right-click in your script
field and choose one of the following filter styles:

- Starts with expression
The Script Assistant will show only entries that start with the entered expression. This is useful if you
are already familiar with the command structure and know which group of commands you need.

 - Contains expression (this is default)
You do not need to know how exactly the command starts, typing "fader" will suggest "WDFader..." too.
Type more characters to shorten the list or use the arrow keys (up and down) to select a command from
it and press carriage return.

- Camel Case
This is the fastest way of getting the correct command if you already know which command you want to
use. This filter type requires deep knowledge of the command structure, as you only type in the letters
that are written with capitals in the command (this way of writing with capitals inside an expression is
called "camel case").
e.g.: type in "wdfd" and the command "WDFaderDown" will appear in the list box.

If you have one preferred filter style, you can set it up in your User Profile  as the default value.

Now, the placeholders need to be filled with concrete information, e.g. a numeric ID for a certain element
that you would like to control or send values to. In addition you may use variables. Again, the Script
Assistant offers a drop-down with all available variables.
The Script Assistant will guide you through the arguments, too, by listing all arguments and their
respective data types (like, String, Integer, Bool, ...)

Please note that all literal values, meaning any kind of character string, has to be enclosed in either
single or double quotation marks. If one of those is part of your string, just use the other one for declaring
the literal. Do not use accents like ´ or `!
WDLabelText(1,'Hello World!')
WDLabelText(2,"Hello World!")
WDLabelText(3,'Hello "World"!')
Some strings, like Pandoras Box device parameters or variable names, already appear at the Script
assistant with quotation marks. You can select one of those without adding anything and proceed with
the next argument. If you like to use a variable's value, type the variable name without quotation marks.

All commands affecting a widget are available with the object and member notation , too.
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Multiple commands (i.e. one script) can be executed by delimiting every command with a carriage return
at the end of each command, simply hit the "enter" key. To delete a command, select it and press the
"Delete" key.

Command examples

For example, to set the opacity of Layer 1 on Server 1 to 128 you will need the following command:
DeviceSetParam(SiteID,DeviceID,ParamName,AbsoluteValue)

Since this is only a template of the command, you will need to enter the numeric values for the SiteID,
DeviceID, AbsoluteValue and the ParamName  as plain text.
The correct command for this example would be written like this:
DeviceSetParam(1,1,"Opacity",128)

Alternatively you may enter a variable  name for any placeholder. Assuming you have an integer
variable defined with the name varNumber and the value of 1, you could write the command as follows:
DeviceSetParam(varNumber,varNumber,"Opacity",128)

Advanced script techniques

Normally, you would enter a command and then fill out the placeholders (also called the "arguments" of
a command). But there is also a technique that allows more direct programming. Still the syntax must
conform, but as it is more open it can be used more flexible. You have direct script access to Variables
and certain member values including nodes. This allows direct value assignment and item control. For
further information and examples click the according links.

direct command corresponding common command

Variables

Variable = Value
varNumber = 123
ListVariable[Index] = Value
varList[5] = 123

VValue(VarName,Value)
VValue(varNumber,123)
VSetArrayValue(VarName,Index,Value)
VSetArrayValue("varList",5,123)

Members

MemberID.MemberValue = Value
label1.text = "Hello"

fader2.value = 123
fader2.value = varNumber

WDLabelText(ID,Text)
WDLabelText(1,"Hello")
WDFaderValue(ID,Value)
WDFaderValue(2,123)
WDFaderValue(2,varNumber)

Nodes

NodeID.Nodecommand
node1.ResetPlaylist
node2.PowerOn

The last row mentions Node Commands . They cannot only access functions of a node but also the
parameters. Please see the according chapter for more details.

Of course, mathematical functions can be applied to values and variables, too. Please refer to the
chapter Mathematical expressions and conditions  for more information.
Since Version 6, it is even possible to use mathematical expressions as command arguments or
programming statements, e.g.:
DeviceSetParam(varNumber,varNumber+10,"Opacity",128)
If  varRes >= (varNumber*5) {True Script}
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Useful Tools from the Context Menu 

When you right-click somewhere inside a scripting field, the
context menu opens up and offers you some practical items:

Test: Executes the whole script inside this field

Test selected Lines: Executes all highlighted lines or the line
in which the cursor is located

Find... : Searches for the highlighted expression (only text
search)

Find references: Searches for the highlighted expression
(searches for references to the marked object)

Find next  / previous: Goes through all found expressions

Go to definition...: Shows the origin of the object, i.e. the line
where a local variable is initialized, the variable list if the object
is a global variable, or it opens the function / macro editor if the
object is one of those.

Automatically show Assistant: Uncheck this if you do not need the Script Assistant 

Filter Style: Select the Script Assistant's filter style which is described above

Test Debugging: Enables the Debug Logger  for the "Test" function mentioned above and clears it if
necessary

Enable Debug Logging: Uncheck this if you do not want the Debug Logger to open

Open Debug Logger: This opens the dialog Debug Logger

Always show errors / warnings: Per default, the Debug Logger does not open automatically to show
whether a script includes an error. It opens only if you choose the "Test"command from the right-click
menu. If you like to always see errors and warnings, enable this option.

More information

WD commands can be written in upper or lower case style or mixed, with one exception:
Wherever you need to specify text-based parameters such as Opacity, the entry is case sensitive and
must not have additional blanks (space characters). 
Please see the next page for a list with all parameter names  from Pandoras Box. Then, a Command
List  explains all available commands.
Advanced users can merge commands in functions and macros  or combine them with If-queries and
for loops repetitions as explained in the topic programming statements .
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18.8.1.1  Parameter List

This list helps with commands  in Widget Designer where a so called "ParamName" needs to be
defined (e.g. DeviceSetParam(SiteID,DeviceID,ParamName,AbsoluteValue))

The overview lists all names from parameters within Pandoras Box and their value range. 

Please note:
- the name is case sensitive, e.g. "X Scale", not "x scale" or "XScale" etc.
- for effects  the entire name consists of the FX name and the FX parameter, both combined with a
pipe "|" character (vertical bar) but no spaces before or after the pipe, e.g. "Blur|Mix" or "B&W Add|Invert"
- for particle systems  the name is composed like this "Particle System|Wind" for parameters directly
underneath the system and "Particle System|Particle Emitter|Radius" for parameters underneath the
emitter. (For revision lower 7832 the syntax was "Particle Emitter|Radius"
- if the value needs to be a decimal value, always use a point "." as separator not a comma "," e.g. "0.5"

PARAMETER LIST PB V5 PARAMETER LIST PB V4.7

Parameter Value range Parameter Value range

Opacity 0-255 Opacity 0-255

Volume 0-2 (= -96.00 - +6 dB) Trans FX 0-244 (PB MS)

X Pos -999.999 – +999.999 X Pos 0-65535

Y Pos -999.999 – +999.999 Y Pos 0-65535

Z Pos -999.999 – +999.999 Z Pos 0-65535

X Angle -9999.99° – +9999.99° X Rot 0-65535

Y Angle -9999.99° – +9999.99° Y Rot 0-65535

Z Angle -9999.99° – +9999.99° Z Rot 0-65535

X Rot Mode 0; 1 X Scale 0-65535

Y Rot Mode 0; 1 Y Scale 0-65535

Z Rot Mode 0; 1 Z Scale 0-65535

X Rot Speed 0-655535

Video Mode

0 (Stop)

Y Rot Speed 0-655535 64 (Pause)

Z Rot Speed 0-655535 128 (Play Once)

X Scale -999.999 – +999.999 192 (Play Loop)

Y Scale -999.999 – +999.999 Colour Fx 0-66 (PB MS)

Z Scale -999.999 – +999.999 Colour 1 0-255

Rot Pivot X Pos -999.999 – +999.999 Colour 2 0-255

Rot Pivot Y Pos -999.999 – +999.999 Colour 3 0-255

Rot Pivot Z Pos -999.999 – +999.999 Video Fx 0-221 (PB MS)

Scale Pivot X Pos -999.999 – +999.999 Fx 1 0-255
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Scale Pivot Y Pos -999.999 – +999.999 Fx 2 0-255

Scale Pivot Z Pos -999.999 – +999.999 Fx 3 0-255

Playback Transport

0 (Stop)

64 (1-127) (Play)

128 (Pause)

192 (129-255) (Loop)

Playback Speed 0-255

Inpoint 0-65535

Outpoint 0-65535

Blend Mode 0-6

'FXName'|'FXParameter'

(e.g. Blur|Mix)
see here  for more
info

Particle
System|'PSParameter'
(e.g. Particle System|Wind)

see here  for more
info

Particle System|Particle
Emitter|'PEParameter'
(e.g. Particle System|
Particle Emitter|Radius)

see here  for more
info

Camera Layer (see here  for all parameters)

Proj. Mode 0; 1

Viewpoint X Pos -999.999 – +999.999

Target X Pos -999.999 – +999.999

FOV -180.000 – +180.000

Near Plane 0-65535

Far Plane 0-65535

Aspect 0.000 – 6.000

X Offset -999.999 – +999.999

Z Roll -9999.99° – +9999.99°

RtClearColor Red 0-255

RtClearColor Alpha 0-255
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Output Layer (see here  for all parameters)

Opacity 0-255

X Pos -999.999 – +999.999

X Angle -9999.99° – +9999.99°

X Rot Mode 0; 1

X Rot Speed 0-65535

X Scale -999.999 – +999.999

Rot Pivot X Pos -999.999 – +999.999

Scale Pivot X Pos -999.999 – +999.999

Viewpoint X Pos -999.999 – +999.999

Target X Pos -999.999 – +999.999

FOV -180.000 – +180.000

Near Plane 0-65535

Far Plane 0-65535

Aspect 0.000 – 6.000

X Offset -999.999 – +999.999

Z Roll -9999.99° – +9999.99°

RtClearColor Red 0-255

RtClearColor Alpha 0-255

KS L 0-65535

KS LR 0-65535

Lin X 0-65535

SE L 0.000 – 100.000%

SE LC 0.000 – 100.000%

SE L Marker 0.000 – 100.000%

State 0; 1

621
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Light Layer (see here  for all parameters)

Light Intensity 0-255

Playback Transport

0 (Stop)

64 (1-127) (Play)

128 (Pause)

192 (127-255) (Loop)

Playback Speed 0-255

Inpoint 0-65535

Outpoint 0-65535

Light Source X Pos -999.999 – +999.999

Light Target X Pos -999.999 – +999.999

Light Color Red 0-255

Light Angle 0.000° – 180.000°

Light Aspect 0.000 – 20.000

Light Z Roll -9999.99° – +9999.99°

Near Plane 0-65535

Far Plane 0-65535

Light Tolerance 0.000 – 1.000

Shadow Softness 0-1000

Sonic Emotion Audio Track

Sonic Volume 0-65535

X 0-65535

Z 0-65535

Playback Transport

0 (Stop)

64 (1-127) (Play)

128 (Pause)

192 (127-255) (Loop)

606
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18.8.1.2  Command List

This topic lists all commands that are available in Widget Designer . How they are used is explained
in the introducing topic .

A  B  C  D  E  F  G  H  I  J  K  L  M  N  O  P  Q  R
 S  T  U  V  W  X  Y  Z

A A

ActivateAll

ActivateAll

Example:
ActivateAll

Activates all parameters of all layers of all Servers within the Pandoras Box Project.

ActivateDevice

ActivateDevice(SiteID,DeviceID)

Example:
ActivateDevice(1,3)

Activates all parameters of layer 3 of site 1 within the Pandoras Box Project.

ActivateParam

ActivateParam(SiteID,DeviceID,ParamName)

Example:
ActivateParam(1,3,"X Scale")

Activates the parameter  X Scale of layer 3 of site 1 within the Pandoras Box Project.

ActivateSite

ActivateSite(SiteID)

Example:
ActivateSite(1)

Activates all parameters of all layers of site 1 within the Pandoras Box Project.

AddEncryptionKey

AddEncryptionKey(Key)

894
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Example:
AddEncryptionKey("Key1|uYxJLovsAK+ZAJplLQgpSf1u6wwaA5e0UurBJq2
+MTsugQpLiXSOHRCAHdcMBVf2GSfZLRn5UoURjIfnmpJOF78d33pFdTfdKdj6YjnJEr0=")

This applies to the Media Encryption feature  in Pandoras Box. Using this command you can
import a key that was exported earlier with another PB project.

AddEncryptionPolicy

AddEncryptionPolicy(Policy)

Example:
AddEncryptionPolicy("Pol1|Y3dm4ld4S7XB0NzYLinuseF7jXzUexhTBWSysoPlXZKUmgnbuvWfG/t39j
+qxUE5FdDSaoZpOzbQUuje0E13FeKfMHKbfFpvS5FATyI8LvU=")

This applies to the Media Encryption feature  in Pandoras Box. Using this command you can
import a policy that was exported earlier with another PB project.

AddFileToPBPlaylistByID

AddFileToPBPlaylistByID(FileName,ProjectFolder,TempFolderID,TempFileID,PbPlaylistFolderID,PbPl
aylistFileID)

Example:
AddFileToPBPlaylistByID("C:\coolux\content\playlist\image5.png","playlist",2,5,3,6)

First( the file )"image5.png" from the path "C:\coolux\content\playlist" is loaded and added to the
subfolder "playlist" within your Pandoras Box project. Secondly, the file is assigned with the Folder
and File ID 2,5. Last, this file is added to the Playlist  with Folder/File ID 3,6.
If you do not need a Folder/File ID in the second step, simply use "0,0" instead of "2,5".

AddGraphicLayer

AddGraphicLayer(SiteID,Count)

Example:
AddGraphicLayer(1,3)

Adds three new Graphic Layers  to Site 1 (e.g. a Server). All Pandoras Box products  have an
unlimited number of Graphic Layers.

AddVideoLayer

AddVideoLayer(SiteID,Count)

Example:
AddVideoLayer(1,3)

Adds three new Video Layers  to Site 1 (e.g. a Server). This command depends on the Pandoras
Box product , whilst a Server PRO is not limited to a maximum number of Video Layers, a Server
STD or a Player are limited.
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ApplicationClose

ApplicationClose(Processname)

Example:
ApplicationClose("notepad")

Closes all running notepad applications. Please have a look into the windows taskmanager to get the
correct process name of the running application you want to close, enter this name without ".exe".

ApplicationKill

ApplicationKill(Processname)

Example:
ApplicationKill("vlc")
ApplicationKill("mspaint") 
ApplicationKill("PB_Widget_Designer")

This ends the process of VLC Player, Microsoft Paint and Widget Designer of the local WD computer
without asking to save any projects. Please have a look into the windows taskmanager to get the
correct process name of the running application you want to close, enter this name without ".exe".

ApplicationKillAllOtherWDInstances

ApplicationKillAllOtherWDInstances

Example:
ApplicationKillAllOtherWDInstances

This ends all background processes of Widget Designer that do not belong to the one currently
running and have added up by mistake. This command is of interest for permanent installations
without technical staff.
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ApplicationStart

ApplicationStart(Filepath)

Example:
ApplicationStart("C:\program files\VideoLAN\VLC\vlc.exe") 
ApplicationStart("mspaint") 
ApplicationStart("C:\Program Files (x86)\coolux\Widget Designer 4.7 Rev 1294
\PB_Widget_Designer.exe")

Starts the VLC Player, Microsoft Paint and Widget Designer on the local WD computer.
----------
ApplicationStart(Filepath,Optional Commandline Arguments)

Example: 
ApplicationStart("C:\program files\VideoLAN\VLC\vlc.exe","C:\Music\Sound.mp3") 
ApplicationStart("C:\Program Files\Christie\Widget Designer 6.0 Rev 5002\PB_Widget_Designer.exe"
STARTWDF )

Starts the VLC Player and plays back the file "Sound.mp3" as this command line is supported by
VLC.

Widget Designer starts with two commandline arguments:
- STARTWDF: in the free edition (use STARTWDU for the edition with unlimited web clients and
STARTWD (or nothing) for the normal edition)

ApplyView

ApplyView(ViewID)in the free edition

Example:
ApplyView(2)

This applies the View  with ID 2 to the Pandoras Box user interface. Views can be saved in the
Project tab or View tab .

ArtNetDisableAllUniverses

ArtNetDisableAllUniverses

Example:
ArtNetDisableAllUniverses

Disables the Art-Net Output on all Universes. This command clears the Universe List in the 
Connection Manager .

ArtNetDisableUniverse

ArtNetDisableUniverse(Subnet 0-15,Universe 0-15)

Example:
ArtNetDisableUniverse(0,1)

280
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Disables the Art-Net Output on Art-Net Subnet 0, Universe 1. The specified Art-Net Universe will be
removed from the Universe List in the Connection Manager .

ArtNetInputDisabled

ArtNetInputDisabled

Example:
ArtNetInputDisabled

Disables the Art-Net Input in the Connection Manager .

ArtNetInputEnabled

ArtNetInputEnabled

Example:
ArtNetInputEnabled

Enables the Art-Net Input in the Connection Manager .

ArtNetOutputDisabled

ArtNetOutputDisabled

Example:
ArtNetOutputDisabled

Disables the Art-Net Output in the Connection Manager .

ArtNetOutputEnabled

ArtNetOutputEnabled

Example:
ArtNetOutputEnabled

Enables the Art-Net Output in the Connection Manager .

ArtNetSetVal16bit

ArtNetSetVal16bit(Subnet 0-15,Universe 0-15,Channel,Value 0-65535)

Example:
ArtNetSetVal16bit(0,1,41,255)

Sets the Channel 41 on Art-Net Subnet 0, Universe 1 to the value 32768. 

Please note, that the next channel you can control is now Channel 43 as the 16 bit value occupied
Channel 41 (and 42).

Art-Net Output needs to be enabled in the Connection Manager .
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ArtNetSetVal24bit

ArtNetSetVal24bit(Subnet 0-15,Universe 0-15,Channel,Value 0-16.777.215)

Example:
ArtNetSetVal24bit(0,1,44,2.255.248)

Sets the Channel 44 on Art-Net Subnet 0, Universe 1 to the value 2.555.248. 

Please note, that the next channel you can control is now Channel 47 as the 24 bit value occupied
Channel 44 (and 45 and 46).

Art-Net Output needs to be enabled in the Connection Manager .

ArtNetSetVal8bit

ArtNetSetVal8bit(Subnet 0-15,Universe 0-15,Channel,Value 0-255)

Example:
ArtNetSetVal8bit(0,1,38,255)

Sets the Channel 38 on Art-Net Subnet 0, Universe 1 to the value 255.

Art-Net Output needs to be enabled in the Connection Manager .

B B

C C

ClearActiveDevice

ClearActiveDevice(SiteID,DeviceID)

Example:
ClearActiveDevice(1,3)

Clears all active parameters of layer 3 of site 1 within the Pandoras Box Project.

ClearActiveParam

ClearActiveParam(SiteID,DeviceID,ParamName)

Example:
ClearActiveParam(1,3,"X Scale")

Sets a clear active to the parameter  X Scale of layer 3 of site 1 within the Pandoras Box Project.

ClearActiveSite

ClearActiveSite(SiteID)
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Example:
ClearActiveSite(1)

Clears all active parameters of all layers of site 1 within the Pandoras Box Project.

ClearAllActive

ClearAllActive

Example:
ClearAllActive

Clears all active parameters of all layers of all Servers within the Pandoras Box Project.

ClearSelection

ClearSelection

Example:
ClearSelection

Clears the device selection within the Pandoras Box project.

CloseAirScanProperties

CloseAirScanProperties

Example:
CloseAirScanProperties

Closes the dialog for the AirScan tool .

CloseAllDialogs

CloseAllDialogs

Example:
CloseAllDialogs

This closes all dialogs from Widget Designer.

CloseArtNetMonitor

CloseArtNetMonitor

Example:
CloseArtNetMonitor

Closes the Art-NetMonitor  which can also be accessed through the Connection Manager .

CloseArtNetUniverselist

1262
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CloseArtNetUniverselist

Example:
CloseArtNetUniverselist

Closes the Art-Net Universe List which can also be accessed through the Connection Manager .

CloseCameraTrackerDialog

CloseCameraTrackerDialog

Example:
CloseCameraTrackerDialog

Closes the Camera Tracker  dialog.

CloseCitpBrowser

CloseCitpBrowser

Example:
CloseCitpBrowser

Closes the Thumbnail Browser which can also be accessed through the dialog Network Configuration
.

CloseComConnections

CloseComConnections

Example:
CloseComConnections

Closes the COM Connection  dialog which gives an better overview than the Connection Manager
.

CloseConnectionManager

CloseConnectionManager

Example:
CloseConnectionManager

Closes the Connection Manager .

CloseEmailSettings

CloseEmailSettings

Example:
CloseEmailSettings

1239

1275

896

1247

1239

1239



1327

Closes the Email Settings Tool .

CloseEventEditor

CloseEventEditor

Example:
CloseEventEditor

Closes the Event Editor Tool .

CloseIpConfiguration

CloseIpConfiguration

Example:
CloseIpConfiguration

Opens the IP Configuration  dialog.

CloseKeyboardShortcuts

CloseKeyboardShortcuts

Example:
CloseKeyboardShortcuts

Closes the Keyboard Shortcut Editor.

CloseKinectDialog

CloseKinectDialog

Example:
CloseKinectDialog

Closes the Kinect Tool .

CloseMacroEditor

CloseMacroEditor

Example:
CloseMacroEditor

Closes the Macro Editor dialog in WD.

CloseMidiNoteEditor

CloseMidiNoteEditor
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Example:
CloseMidiNoteEditor

Closes the Midi Note Editor .

ClosePageBrowser

ClosePageBrowser

Example:
ClosePageBrowser

Closes the Page Browser .

CloseRemoteInput

CloseRemoteInput

Example:
CloseRemoteInput

Closes the Remote Input Tool .

CloseSmsSettings

CloseSmsSettings

Example:
CloseSmsSettings

Closes the SMS Settings Tool .

CloseTcpConnections

CloseTcpConnections

Example:
CloseTcpConnections

Closes the TCP Connection  dialog which gives an better overview than the Connection Manager
.

CloseUdpConnections

CloseUdpConnections

Example:
CloseUdpConnections

Closes the UDP Connection  dialog which gives an better overview than the Connection Manager
.
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CloseVariableList

CloseVariableList

Example:
CloseVariableList

Closes the dialog Variable List .

COMInject

COMInject(ID,Message)

Example:
COMInject(1,"Play")

Injects the message "Play" directly into the stream of the COM Connection with ID 1, without waiting
for other messages or packages to be finished.

The UDP Connection needs to be defined first in the Connection Manager .

Incoming or outgoing values in TCP-, UDP- and COM Port nodes can be entered as string, decimal or
hexadecimal values as explained in the chapter Syntax TCP-/UDP-/Serial Messages .

Example:
 Use [d13] to enter a carriage return as a decimal value.
 Use [h0D] to enter a carriage return as a hexadecimal value.
 Use [CR] to enter a carriage return as a ASCII symbol.

For two commands - e.g. a carriage return and a line feed - you may use this syntax: [d13 d10]
respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example String[CR d10].

COMSend

COMSend(ID,Message)

Example:
COMSend(1,"Play")

Sends the message "Play" via the COM Port Connection with the ID 1 in the Connection Manager
.

COMSendDec

COMSendDec(ID,Message)

Example:
COMSendDec(1,"Play")

Sends the message "Play" in decimal values via the COM Port Connection with the ID 1 in the 
Connection Manager .

See the chapter Syntax TCP-/UDP-/Serial Messages .
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COMSendHex

COMSendHex(ID,Message)

Example:
COMSendHex(1,"Play")

Sends the message "Play" in hexadecimal values via the COM Port Connection with the ID 1 in the 
Connection Manager .

See the chapter Syntax TCP-/UDP-/Serial Messages .

COMStart

COMStart(ID)

Example:
COMStart(1)

Starts the COM Port Connection with the ID 1 in the Connection Manager .

COMStop

COMStop(ID)

Example:
COMStop(1)

Stops the COM Port Connection with the ID 1 in the Connection Manager .

D D

DebugMessage

DebugMessage(Message)

Example:
DebugMessage("Home Button clicked")
DebugMessage("Macro 'Restart' executed at "+Now)

Writes a message into the Debug Logger  and stores it there, e.g. for debugging or logging. Text
must be enclosed in double or single quotation marks and can be combined with variables using a
plus sign. The second example uses the global variable  "Now" which expresses the current date
and time. Thus the Debug Logger displays:
Home Button clicked
Macro 'Restart' executed at 2017-03-09 09:21:05.472

Note: Debug Logging has to be enabled in the Scripting menu. Here you can also choose to open the
Debug Logger manually.

DeviceAcceptDmxById
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DeviceAcceptDmxById(SiteID,DeviceID,"On"/"Off")

Example:
DeviceAcceptDmxById(2,1,"On")

Patches Layer 1 of Site 2 in the Patch tab  so that it can be controlled via an attached DMX / Art-
Net device.

Example 2:
DeviceAcceptDmxById(2,1,"Off")

Unpatches Layer 1 of Site 2 in the Patch tab  so that it cannot be controlled via an attached DMX /
Art-Net device anymore.

Please note:
Art-Net Input needs to be enabled in Configuration Tab  in order to remote control the Layer via Art-
Net.

To change the Devices DMX / Art-Net start address (Channel, Art-Net Subnet and Universe) use
either the Patch Tab in PB or the WD command DeviceSetDmxAddress .

DeviceAddToSelection

DeviceAddToSelection(SiteID,DeviceID)

Example:
DeviceAddToSelection(1,3)

Selects layer 3 of Site 1 (e.g. a Server) and adds it to the current selection within the Pandoras Box
project: If other layers were selected before, they are still selected. If you like to select solely layer 3,
use the command DeviceSelect(SiteID,DeviceID)

DeviceBringToFront

DeviceBringToFront(SiteID,DeviceID)

Example:
DeviceBringToFront(1,3)

Changes the layer order in the Pandoras Box Device Tree  for Site 1 (e.g. a Server). Per default,
the layer 3 is rendered after layer 1 and 2 and before layer 4,5,6 etc. With this command layer 3 is
moved on top of all other layers. Please note that you might need to toggle the layers to be visible.

DeviceFadeParam

DeviceFadeParam(SiteID,DeviceID,Param,StartValue,EndValue,Time)

Example:
DeviceFadeParam(2,3,"Opacity",45,108,11)

The parameter “Opacity” of layer 3 of site 2 starts at value 45 and increases gradually to 108 in 11
seconds. In addition the parameter will be activated and highlighted in red.
Note that the parameter name is case-sensitive, see the topic "Parameter List" ..
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DeviceFadeToParam

DeviceFadeToParam(SiteID,DeviceID,Param,Value,Time)

Example:
DeviceFadeToParam(2,4,"Opacity",103,8)

The parameter “Opacity” of layer 4 of site 2 will gradually change in 8 seconds to value 103. In
addition the parameter will be activated and highlighted in red.
Note that the parameter name is case-sensitive, see the topic "Parameter List" .

DeviceMoveToBack

DeviceMoveToBack(SiteID,DeviceID)

Example:
DeviceMoveToBack(1,3)

Changes the layer order in the Pandoras Box Device Tree  for Site 1 (e.g. a Server). Per default,
the layer 3 is rendered after layer 1and 2 and before layer 4,5,6 etc. With this command layer 3 is
moved one step behind layer 2 but stays in front of layer 1. To move it behind all other layers, use the
command DeviceSendToBack(SiteID,DeviceID). Please note that you might need to toggle

the layers to be visible.

DeviceMoveToFront

DeviceMoveToFront(SiteID,DeviceID)

Example:
DeviceMoveToFront(1,3)

Changes the layer order in the Pandoras Box Device Tree  for Site 1 (e.g. a Server). Per default,
the layer 3 is rendered after layer 1and 2 and before layer 4,5,6 etc. With this command layer 3 is
moved one step in front of layer 4 but stays behind layers 5,6 etc. To move it in front all other layers,
use the command DeviceBringToFront(SiteID,DeviceID). Please note that you might need

to toggle the layers to be visible.

DeviceSelect

DeviceSelect(SiteID,DeviceID)

Example:
DeviceSelect(1,3)

Selects layer 3 of Site 1 (e.g. a Server) within the Pandoras Box project: If other layers were selected
before, they are now deselected. If you like to add layer 3 to the current selection, use the command 
DeviceAddToSelection(SiteID,DeviceID)

DeviceSendToBack

DeviceSendToBack(SiteID,DeviceID)
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Example:
DeviceSendToBack(1,3)

Changes the layer order in the Pandoras Box Device Tree  for Site 1 (e.g. a Server). Per default,
the layer 3 is rendered after layer 1and 2 and before layer 4,5,6 etc. With this command layer 3 is
moved behind all other layers. Please note that you might need to toggle the layers to be visible.

DeviceSetDmxAddress

DeviceSetDmxAddress(SiteID,DeviceID,DMXStart,Universe,Subnet)

Example:
DeviceSetDmxAddress(2,1,0,5,4)

Patches Layer [2,1] in Pandoras Box to the DMX start address 1, Art-Net Universe 5 and Subnet ID
4.

DeviceSetIp

DeviceSetIp(SiteID,IP Address)

Example:
DeviceSetIp(3,"2.0.0.103")

Sets the IP of Site 3 inside your PB project to 2.0.0.103. 

Please note:
This command is only working from PB version 5237 on.

DeviceSetMedia

DeviceSetMedia(SiteID,DeviceID,FolderID,FileID)

Example:
DeviceSetMedia(1,3,2,4)

Assigns the media file with the File and Folder ID 2,4 to layer 3 of Site 1 (e.g. a Server).

DeviceSetMediaByName

DeviceSetMediaByName(SiteID,DeviceID,MediaName)

Example:
DeviceSetMediaByName(1,3,"Testpattern/Calibrate.png")

Assigns the media file with the name "Calibrate.png" from the subfolder "Testpattern" within the
project folder to layer 3 of the Site 1 (e.g. a Server). If there is more than one file in the subfolder that
holds this name, the first file is taken. If the file is not in a special subfolder, simply use
"Calibrate.png". Please note that "MediaName" is case-sensitive.

DeviceSetMediaInSelection
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DeviceSetMediaInSelection(FolderID,FileID)

Example:
DeviceSetMediaInSelection(2,4)

Assigns the media file with the File and Folder ID 2,4 to all layers that are currently selected.

DeviceSetMediaParamByID

DeviceSetMediaParamByID(SiteID,DeviceID,ParamName,FolderID,FileID)

Example:
DeviceSetMediaParamByID(1,3,"Quad Media Overlay|Media1",2,4)

Assigns the media file with the File and Folder ID 2,4 to layer 3 of the Site 1 (e.g. a Server) but not as
the main media but the first media for the effect named "Quad Media Overlay".

DeviceSetMediaParamByName

DeviceSetMediaParamByName(SiteID,DeviceID,ParamName,MediaName)

Example:
DeviceSetMediaParamByName(1,3,"Quad Media Overlay|Media1","Testpattern/Calibrate.png")

Assigns the media file with the name "Calibrate.png" from the subfolder "Testpattern" within the
project folder to layer 3 of the Site 1 (e.g. a Server) but not as the main media but the first media for
the effect named "Quad Media Overlay". 
If there is more than one file in the subfolder that holds this name, the first file is taken. If the file is
not in a special subfolder, simply use "Calibrate.png". Please note that "MediaName" and
"ParamName" is case-sensitive. "ParamName" consists of the name of the effect  followed by the
character pipe (vertical bar) and the name of the media field (in most cases simply "Media").

DeviceSetMesh

DeviceSetMesh(SiteID,DeviceID,FolderID,FileID)

Example:
DeviceSetMesh(1,3,2,4)

Assigns the mesh file with the File and Folder ID 2,4 to layer 3 of Site 1 (e.g. a Server).

DeviceSetMeshByName

DeviceSetMeshByName(SiteID,DeviceID,MediaName)

Example:
DeviceSetMeshByName(1,3,"Objects/Cone.x")

Assigns the mesh file with the name "Cone.x" from the subfolder "Objects" within the project folder to
layer 3 of the Site 1 (e.g. a Server). If there is more than one file in the subfolder that holds this name,
the first file is taken. If the file is not in a special subfolder, simply use "Cone.x". Please note that
"MediaName" is case-sensitive.
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DeviceSetMeshInSelection

DeviceSetMeshInSelection(FolderID,FileID)

Example:
DeviceSetMeshInSelection(2,4)

Assigns the mesh file with the File and Folder ID 2,4 to all layers that are currently selected.

DeviceSetMeshParamByID

DeviceSetMeshParamByID(SiteID,DeviceID,ParamName,FolderID,FileID)

Example:
DeviceSetMeshParamByID(1,3,"FXName|Mesh1",2,4)

Assigns the mesh file with the File and Folder ID 2,4 to layer 3 of the Site 1 (e.g. a Server) but not as
the main mesh but the first mesh of the effect named "FXName".

DeviceSetMeshParamByName

DeviceSetMeshParamByName(SiteID,DeviceID,ParamName,MediaName)

Example:
DeviceSetMeshParamByName(1,3,"FXName|Mesh1","Objects/Car.x")

Assigns the mesh file with the name "Car.x" from the subfolder "Objects" within the project folder to
layer 3 of the Site 1 (e.g. a Server) but not as the main mesh but the first mesh of the effect named
"FXName".

If there is more than one file in the subfolder that holds this name, the first file is taken. If the file is
not in a special subfolder, simply use "Car.x". Please note that "MediaName" and "ParamName" is
case-sensitive. "ParamName" consists of the name of the effect followed by the character pipe
(vertical bar) and the name of the mesh field.

DeviceSetParam

DeviceSetParam(SiteID,DeviceID,ParamName,AbsoluteValue)

Example:
DeviceSetParam(1,2,"X Pos",3)

Sets the X Position of Server 1, Layer 2 to the value 3. In the manual, there is a topic with all 
parameter names .

DeviceSetParamDirect

DeviceSetParamDirect(SiteID,DeviceID,ParamName,AbsoluteValue)

Example:
DeviceSetParamDirect(1,2,"X Pos",3)

1315
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In Pandoras Box, the X Position of Server 1, Layer 2 is set to the value 3 WITHOUT applying
translation smoothing in the Device Inspector . Since PB 9088 all parameters can be smoothend.
Before, this applied only to position, scaling and rotation.
Note that the parameter name is case-sensitive, see the topic "Parameter List" .

DeviceSetParamDirectSilent

DeviceSetParamDirectSilent(SiteID,DeviceID,ParamName,AbsoluteValue)

Example:
DeviceSetParamDirectSilent(1,2,"X Pos",3)

This command combines the commands DeviceSetParamDirect and DeviceSetParamSilent:
In Pandoras Box it sets the X Position of Server 1, Layer 2 to the value 3 WITHOUT applying
translation smoothing in the Device Inspector  and WITHOUT setting the parameter active in PB if
it was not active before.
Note that the parameter name is case-sensitive, see the topic "Parameter Llist" .

DeviceSetParamInSelection

DeviceSetParamInSelection(ParamName,AbsoluteValue)

Example:
DeviceSetParamInSelection("Opacity",255)

Sets the Opacity of all selected Devices in PB to the value 255.
Note that the parameter name is case-sensitive, see the topic "Parameter List" .

Please note:
This command will only work with Pandoras Box Version 4535 or higher!

DeviceSetParamRelative

DeviceSetParamRelative(SiteID,DeviceID,ParamName,RelativeValue)

Example:
DeviceSetParamRelative(1,2,"Opacity",100)

Adds the value 100 to the parameter  Opacity of Server 1, Layer 2.

DeviceSetParamRelativeInSelection

DeviceSetParamRelativeInSelection(SiteID,DeviceID,ParamName,RelativeValue)

Example:
DeviceSetParamRelativeInSelection("Opacity",20)

Adds the value 20 to the Opacity parameter of all selected Devices in PB.
Note that the parameter name is case-sensitive, see the topic "Parameter List" .

Please note:
This command will only work with Pandoras Box Version 4535 or higher!
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DeviceSetParamSilent

DeviceSetParamSilent(SiteID,DeviceID,ParamName,AbsoluteValue)

Example:
DeviceSetParamSilent(1,2,"X Pos",3)

Sets the X Position of Server 1, Layer 2 to the value 3 WITHOUT setting the parameter active in PB if
it was not active before.
Note that the parameter name is case-sensitive, see the topic "Parameter List" .

DeviceSetPreset

DeviceSetPreset(SiteID,DeviceID,PresetID1,PresetID2)

Example:
DeviceSetPreset(1,3,2,4)

Applies the Preset  with the ID 2.4 to layer 3 of Site 1 (e.g. a Server). Please note that the
command will not paste keys into the timeline but apply the value of the first key.

DeviceUnselect

DeviceUnselect(SiteID,DeviceID)

Example:
DeviceUnselect(1,3)

Unselects layer 3 of Site 1 (e.g. a Server) within the Pandoras Box project. If other layers were
selected before, they are still selected.

DirCopy

DirCopy(SourcePath,TargetPath)

Example:
DirCopy("C:\coolux\WD_test\Dir_1","C:\coolux\WD_test\Dir_2")

Copies the content of directory Dir_1 into directory Dir_2. If there are files in Dir_2 with the same
name as in Dir_1, they are not being replaced.

DirCopyBackup

DirCopyBackup(SourcePath)

Example:
DirCopyBackup("C:\coolux\WD_test\Dir_1")

Generates a backup of the selected folder Dir_1 and saves it with date and time at the same directory
as the source folder "C:\coolux\WD_test\Dir_1(2015-09-08_10-12-09)".

DirCopyChanges
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DirCopyChanges(SourcePath,TargetPath)

Example:
DirCopyChanges("C:\coolux\WD_test\Dir_1","C:\coolux\WD_test\Dir_2")

Copies the content of directory Dir_1 into directory Dir_2, files in Dir_2 with the same name as files in
Dir_1 are being overwritten.

DirCopyOverwrite

DirCopyOverwrite(SourcePath,TargetPath)

Example:
DirCopyOverwrite("C:\coolux\WD_test\Dir_1","C:\coolux\WD_test\Dir_2")

Copies the content of directory Dir_1 into directory Dir_2, files in Dir_2 with the same name as files in
Dir_1 are being overwritten.

DirCopyUI

DirCopyUI(SourcePath,TargetPath)

Example:
DirCopyUI("C:\coolux\WD_test\Dir_1","C:\coolux\WD_test\Dir_2")

Copies the content of directory Dir_1 into directory Dir_2. If there are files in Dir_2 with the same
name as in Dir_1, a dialog window how to proceed with those files opens at the Widget Designer.

DirDelete

DirDelete(Path)

Example:
DirDelete("C:\coolux\WD_test\Dir_3")

Deletes the whole directory Dir_3 permanently including its content.

DMXLinkInDisable

DMXLinkInDisable

Example:
DMXLinkInDisable

Disables the Widget Designer to receive values via the coolux DMX Link . This can also be done in
the Connection Manager .

DMXLinkInEnable

DMXLinkInEnable
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Example:
DMXLinkInEnable

Enables the Widget Designer to receive values via the coolux DMX Link . This can also be done in
the Connection Manager .

DMXLinkInReset

DMXLinkInReset

Example:
DMXLinkInReset

Resets the value of all channels received via the coolux DMX Link  which is enabled in the
Connection Manager .

DMXLinkOutDisable

DMXLinkOutDisable

Example:
DMXLinkOutDisable

Disables the Widget Designer to send out values via the coolux DMX Link . This can also be done
in the Connection Manager .

DMXLinkOutEnable

DMXLinkOutEnable

Example:
DMXLinkOutEnable

Enables the Widget Designer to send out values via the coolux DMX Link . This can also be done
in the Connection Manager .

DMXLinkOutReset

DMXLinkOutReset

Example:
DMXLinkOutReset

Resets the value of all channels send out via the coolux DMX Link  which is enabled in the
Connection Manager .

DMXLinkOutSetVal16bit

DMXLinkOutSetVal16bit(Channel,Value 0-65535)

Example:
DMXLinkOutSetVal16bit(255,32768)
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Sends out the value 32768 on channel 255 via the coolux DMX Link  which is enabled in the
Connection Manager .

DMXLinkOutSetVal8bit

DMXLinkOutSetVal8bit(Channel,Value 0-255)

Example:
DMXLinkOutSetVal8bit(255,20)

Sends out the value 20 on channel 255 via the coolux DMX Link  which is enabled in the
Connection Manager .

E E

EmailClearInbox

EmailClearInbox

Example:
EmailClearInbox

Clears the Email Inbox from the Email tool .

EmailClearOutbox

EmailClearOutbox

Example:
EmailClearOutbox

Clears the Email Outbox from the Email tool .

EmailOutputAddressSet

EmailOutputAddressSet(EmailAddress)

Example:
EmailOutputAddressSet("support@coolux.de")

Sets the Email Address for the outgoing Email Server in the Email Settings Tool  to
"support@coolux.de".

EmailOutputPasswordSet

EmailOutputPasswordSet(Password)

Example:
EmailOutputPasswordSet("SECRET")

Sets the Email Password for the outgoing Email Server in the Email Settings Tool  to "SECRET".
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EmailOutputSendDisable

EmailOutputSendDisable

Example:
EmailOutputSendDisable

When this command is executed, no email can be sent out. Use the command EmailSendEnable to
enable this function again.

Please use the Email Settings Tool  to setup all incoming and outgoing Email communication.

EmailOutputUseDefaultAuthentication

EmailOutputUseDefaultAuthentication(True/False)

Example:
EmailOutputUseDefaultAuthentication("True")

Checks the option "Use Default Authentification" for the outgoing Email Server in the Email Settings
Tool .

EmailOutputUsernameSet

EmailOutputUsernameSet(Username)

Example:
EmailOutputUsernameSet("support")

Sets the Email Username for the outgoing Email Server in the Email Settings Tool  to "support".

EmailSend

EmailSend(To,Subject,Message)

Example:
EmailSend("support@coolux.de","Question WD","What are the system requirements for running
WD?")

Sends an Email with the subject "Question WD" and the message "What are the system
requirements for running WD?" to support@coolux.de.

Please use the Email Settings Tool  first to setup all incoming and outgoing Email communication.

EmailSendAtt

EmailSendAtt(To,Att,Subject,Message)

Example:
EmailSendAtt("support@coolux.de","C:\coolux\commandlist.txt","Question WD","Please explain the
commands!")
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Sends an Email with the subject "Question WD", the message "Please explain the commands!" and
the attachment "commandlist.txt" from the specified directory (C:\coolux\commandlist.txt) to
support@coolux.de.

Please use the Email Settings Tool  first to setup all incoming and outgoing Email communication.

EmailSendEnable

EmailSendEnable

Example:
EmailSendEnable

Enables the EmailSend function after it was disabled.

Please use the Email Settings Tool  to setup all incoming and outgoing Email communication.

EmailSendFromLabel

EmailSendFromLabel(To,Subject From LabelID,Message From LabelID)

Example:
EmailSendFromLabel("support@coolux.de",1,2 )

Sends an Email with the text of Label 1 as subject and with the text of Label 2 as message to
support@coolux.de.

Please use the Email Settings Tool  first to setup all incoming and outgoing Email communication.

EmailSendFromTextBox

EmailSendFromTextBox(To,Subject From TextBoxID,Message From TextBoxID)

Example:
EmailSendFromTextBox("support@coolux.de",1,2 )

Sends an Email with the text of TextBox 1 as subject and with the text of TextBox 2 as message to
support@coolux.de.

Please use the Email Settings Tool  first to setup all incoming and outgoing Email communication.

EmailServerSet

EmailServerSet(EmailServerSmpt)

Example:
EmailServerSet("smtp.googlemail.com")

Sets the SMTP Mail Server in the Email Settings Tool  to smtp.googlemail.com.

EmailUseSSL
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EmailUseSSL(True/False)

Example:
EmailUseSSL(True)

Checks the option "Use SSL" for the outgoing Email Server in the Email Settings Tool .

F F

FileCopy

FileCopy(SourcePath,TargetPath)

Example:
FileCopy("C:\coolux\WD_test\Dir_1\file_1.txt","C:\coolux\WD_test\Dir_2\file_flollop.txt")

Copies the Content of the file “file_1.txt” in directory Dir_1 and pastes it to the newly generated file
“file_flollop.txt” in directory Dir_2. 

FileDelete

FileDelete(FileName)

Example:
FileDelete(“C:\coolux\WD_test\Dir_2\file_4.txt”)

Deletes the file “file_4.txt” permanently.

FullScreenByID

FullScreenByID(SiteID)

Example:
FullScreenByID(4)

Switches the site 4 to fullscreen mode in Pandoras Box project whether it is in windowed mode or in
fullscreen mode already.

G G

H H

HTTPRequestToVar

HTTPRequestToVar(URL,VarName)

Example:
HTTPRequestToVar("http://www.coolux.de/index.php?id=dowload-center","var1")
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Inserts the requested HTTP data from “http://www.coolux.de/index.php?id=dowload-center“ to the
variable  var1.

Note: Make sure the variable has the correct type.

I I

IncludeInSpread

IncludeInSpread(SiteID)

Example:
IncludeInSpread(2)

This deactivates the option "Spare from Spread" for Site ID 2 in Pandoras Box. The option can be
found in the Device Inspector  .

J J

K K

KeyboardKeyPress

KeyboardKeyPress(Keycode)

Example:
KeyboardKeyPress("A")

The first example executes a keystroke with the character A.

KeyboardKeyPress("Abc")
This example executes a keystroke with the character A, then b and c.

KeyboardKeyPress(" ĉ v̂")
This example executes the shortcuts to copy and paste.

To combine a key with SHIFT, precede the key code with + (plus sign). 
To combine a key with CTRL, precede the key code with  ̂(caret). 
To combine a key with ALT, precede the key code with % (percent sign). 

To specify repeating keys, use the form {key number}. You must put a space between key and
number.

KeyboardKeyPress("{h 10}")
This example presses the letter h 10 times.

KeyboardKeyPress("{LEFT 42}")
This example presses the LEFT ARROW key 42 times.

KeyboardKeyPress("{DEL}")
This example presses the DELETE key.
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These keys are available:

{BACKSPACE} or {BS}
{BREAK}
{CAPSLOCK}
{CLEAR}
{DELETE} or {DEL}
Arrow keys: {LEFT} {RIGHT} {DOWN} {UP}
{END}
Enter on the numeric keypad {ENTER}
ENTER ~
ESC {ESCAPE} or {ESC}
{HELP}
{HOME}
{INSERT}
{NUMLOCK}
Page Down and up {PGDN} {PGUP}
{RETURN}
{SCROLLLOCK}
{TAB}
{F1} through {F15}.

If you want to send a keystroke to an application that currently is not activated, you may want to use
the command WindowFocus,WindowTitleText .

KeyboardToggleVolume

KeyboardToggleVolume

Example:
KeyboardToggleVolume

Toggles the Keyboards Sound On / Off Button.

KeyboardVolumeDown

KeyboardVolumeDown

Example:
KeyboardVolumeDown

Executes the Keyboards Volume Down Button.

KeyboardVolumeUp

KeyboardVolumeUp

Example:
KeyboardVolumeUp

Executes the Keyboards Volume Up Button.

KinectDisable
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KinectDisable

Example:
KinectDisable

Disables the Kinect  device.

KinectDisableClick

KinectDisableClick

Example:
KinectDisableClick

If this option is disabled in the Kinect tool  the mouse cursor controlled by the Kinect will not
generate clicks. 

KinectEnable

KinectEnable

Example:
KinectEnable

Enables the Kinect  device.

KinectEnableClick

KinectEnableClick

Example:
KinectEnableClick

If this option is enabled in the Kinect tool  the mouse cursor generates clicks. You can choose
between the following Mouse Modes:
KinectMouseModeDefault
KinectMouseModeOnEnter
KinectMouseModeOnLeave
KinectMouseModeOn2ndHand

KinectMouseModeDefault

KinectMouseModeDefault

Example:
KinectMouseModeDefault

Sets the Mouse Mode in the Kinect tool  to default: 
Default generates mouse down on enter and mouse up on leave.

KinectMouseModeDisable
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KinectMouseModeDisable

Example:
KinectMouseModeDisable

Disables the mouse control in the Kinect Tool .

KinectMouseModeEnable

KinectMouseModeEnable

Example:
KinectMouseModeEnable

Enables the mouse in the Kinect tool . This is of interest if Point1 input data should control the
mouse of your WD computer.

KinectMouseModeOn2ndHand

KinectMouseModeOn2ndHand

Example:
KinectMouseModeOn2ndHand

Sets the Mouse Mode in the Kinect tool  to On2ndHand: 

The click is generated as soon as a 2nd point (through the 2nd hand) is detected..

KinectMouseModeOnEnter

KinectMouseModeOnEnter

Example:
KinectMouseModeOnEnter

Sets the Mouse Mode in the Kinect tool  to OnEnter: 

The click is generated on enter.

KinectMouseModeOnLeave

KinectMouseModeOnLeave

Example:
KinectMouseModeOnLeave

Sets the Mouse Mode in the Kinect tool  to OnLeave: 

The click is generated on leave.

KinectSetBlur
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KinectSetBlur(0-15)

Example:
KinectSetBlur(8)

Changes the blur option in the Kinect Tool  to the value 8.

KinectSetDamping

KinectSetDamping(Value)

Example:
KinectSetDamping(0.1)

Sets the damping in the Kinect tool  to 0,1.

The damping allows to reduce noisy input values. This value can be changed from 0,1 = maximum
damping up to 1 = no damping.

KinectSetDepthThreshold

KinectSetDepthThreshold(0-2047)

Example:
KinectSetDepthThreshold(1000)

Sets the Depth Threshold in the Kinect Tool  to the value 1000.

KinectSetInflate

KinectSetInflate(0-15)

Example:
KinectSetInflate(8)

Changes the inflate option in the Kinect Tool  to the value 8.

KinectSetLedGreen

KinectSetLedGreen

Example:
KinectSetLedGreen

Will light up the Status LED of the Kinect  device in green.

KinectSetLedGreenBlink

KinectSetLedGreenBlink

Example:
KinectSetLedGreenBlink
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Will flash up the Status LED of the Kinect  device in green.

KinectSetLedOff

KinectSetLedOff

Example:
KinectSetLedOff

Turns off the Status LED of the Kinect  device.

KinectSetLedOrange

KinectSetLedOrange

Example:
KinectSetLedOrange

Will light up the Status LED of the Kinect  device in orange.

KinectSetLedOrangeRedBlink

KinectSetLedOrangeRedBlink

Example:
KinectSetLedOrangeRedBlink

Will flash up the Status LED of the Kinect  device in orange and red.

KinectSetLedRed

KinectSetLedRed

Example:
KinectSetLedRed

Will light up the Status LED of the Kinect  device in red.

KinectSetMaxDelta

KinectSetMaxDelta(Value)

Example:
KinectSetMaxDelta(50)

Changes the maximum delta option in the Kinect Tool  to 50 (px).

KinectSetMaxHeight

KinectSetMaxHeight(Value)
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Example:
KinectSetMaxHeight(250)

Sets the maximum height of a point in the Kinect Tool  to the value 250 (px).

KinectSetMaxWidth

KinectSetMaxWidth(Value)

Example:
KinectSetMaxWidth(250)

Sets the maximum width of a point in the Kinect Tool  to the value 250 (px).

KinectSetMinHeight

KinectSetMinHeight(Value)

Example:
KinectSetMinHeight(50)

Sets the minimum height of a point in the Kinect Tool  to the value 50 (px).

KinectSetMinWidth

KinectSetMinWidth(Value)

Example:
KinectSetMinWidth(50)

Sets the minimum width of a point in the Kinect Tool  to the value 50 (px).

KinectSetNearThreshold

KinectSetNearThreshold(0-2047)

Example:
KinectSetNearThreshold(800)

Sets the Near Threshold in the Kinect Tool  to the value 900.

KinectSetPoints

KinectSetPoints(1-8)

Example:
KinectSetPoints(4)

Changes the current amount of points in the Kinect Tool  to 4 points.

KinectSetShrink

1269

1269

1269

1269

1269

1269
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KinectSetShrink(0-15)

Example:
KinectSetShrink(8)

Changes the shrink option in the Kinect Tool  to the value 8.

KinectSetTilt

KinectSetTilt(-8000>+8000)

Example:
KinectSetTilt(2500)

Tilts the Kinect  device via the integrated servo motor to the value 2500. As it can be tilted 27° up
and down, the value 2500 is equivalent to ~8,5°.

KinectStart

KinectStart

Example:
KinectStart

Starts the Kinect  device.

L L

LogitechPresenterR400Disabled

LogitechPresenterR400Disabled

Example:
LogitechPresenterR400Disabled

Disables the Logitech Presenter R400. 

LogitechPresenterR400Enabled

LogitechPresenterR400Enabled

Example:
LogitechPresenterR400Enabled

Enables the Logitech Presenter R400. 

M M

MagicQActivatePlayback

1269

1269

1269
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MagicQActivatePlayback(ID)

Example:
MagicQActivatePlayback(8)

Activates (starts) the playback 8 within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQChangePage

MagicQChangePage(ID)

Example:
MagicQChangePage(11)

Changes to playback page 11 within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQChannelLevel

MagicQChannelLevel(ID,Level)

Example:
MagicQChannelLevel(8,90)

Sets the Level of channel 8 within MagicQ to 90%.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQFastBackOnPlayback

MagicQFastBackOnPlayback(ID)

Example:
MagicQFastBackOnPlayback(8)

Goes back one step in the Cue Stack of Playback 8 without taking the step and fade times into
account.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQFastForwardOnPlayback

MagicQFastForwardOnPlayback(ID)

Example:
MagicQFastForwardOnPlayback(8)
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Goes back one step in the Cue Stack of Playback 8 without taking the step and fade times into
account.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQGoOnPlayback

MagicQGoOnPlayback(ID)

Example:
MagicQGoOnPlayback(8)

Gives a Go on playback 8 within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQJumpToCue

MagicQJumpToCue(ID,CueID)

Example:
MagicQJumpToCue(8,4)

Jumps to cue 4 at playlist 8 within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQPlaybackLevel

MagicQPlaybackLevel(ID,Level)

Example:
MagicQPlaybackLevel(8,90)

Sets the Level of Playback 8 within MagicQ to 90%.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQReleasePlayback

MagicQReleasePlayback(ID)

Example:
MagicQReleasePlayback(8)

Releases (stops) the playback 8 within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.
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MagicQRemoteTrigger

MagicQRemoteTrigger(State)

Example:
MagicQRemoteTrigger(State)

Sends a remote trigger signal to MagicQ. 

Note: The absolute state is 0 or 1, 2 can be used for toggling the current state.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQStopOnPlayback

MagicQStopOnPlayback(ID)

Example:
MagicQStopOnPlayback(8)

Sets playback 8 within MagicQ to pause.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQTestCue

MagicQTestCue(ID)

Example:
MagicQTestCue(4)

Sets cue 4 in test mode within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQTestCueStack

MagicQTestCueStack(ID)

Example:
MagicQTestCueStack(6)

Sets cue stack 6 in test mode within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQTestPlayback
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MagicQTestPlayback(ID)

Example:
MagicQTestPlayback(8)

Sets the playback 8 in test mode within MagicQ: activates playback 8 and sets the level to 100%.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQUntestCue

MagicQUntestCue(ID)

Example:
MagicQUntestCue(4)

Takes cue 4 out of test mode within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQUntestCueStack

MagicQUntestCueStack(ID)

Example:
MagicQUntestCueStack(6)

Takes cue stack 6 out of test mode within MagicQ.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MagicQUntestPlayback

MagicQUntestPlayback(ID)

Example:
MagicQUntestPlayback(8)

Takes the playback 8 out of test mode within MagicQ: releases the playback 8 and sets the level to
0%.

This command is a Chamsys MagicQ Remote Playback Command based on the MagicQ default
UDP Port 6553.

MA-NetInputDisabled

MANetInputDisabled

Example:
MANetInputDisabled
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Disables the MA Net Input in the Connection Manager .

MA-NetInputEnabled

MANetInputEnabled

Example:
MANetInputEnabled

Enables the MA Net Input in the Connection Manager .

MANetMode1

MANetMode1

Example:
MANetMode1

Sets the MA Net Mode in the Connection Manager  to “MA Net 1”.

MANetMode2

MANetMode2

Example:
MANetMode2

Sets the MA Net Mode in the Connection Manager  to “MA Net 2”.

MANetSessionID

MANetSessionID(ID)

Example:
MANetSessionID(2)

Sets the MA Net Session ID in the Connection Manager  to 2.

MidiInputDisabled

MidiInputDisabled

Example:
MidiInputDisabled

Disables the Midi Input in the Connection Manager .

MidiInputEnabled

MidiInputEnabled

1239

1239

1239

1239

1239
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Example:
MidiInputEnabled

Enables Midi Input in the Connection Manager . Please choose a Midi Device first.

MidiOutputDisabled

MidiOutputDisabled

Example:
MidiOutputDisabled

Disables the Midi Output in the Connection Manager .

MidiOutputEnabled

MidiOutputEnabled

Example:
MidiOutputEnabled

Enables Midi Output in the Connection Manager . Please choose a Midi Device first.

MidiSendControlChange

MidiSendControlChange(Channel 1-16,Control 0-127,Value 0-127)

Example:
MidiSendControlChange(1,35,127)

Sets the Control 35 on Midi Channel 1 to the value 127.

The Midi connection needs to be enabled in the Connection Manager .

MidiSendNoteOff

MidiSendNoteOff(Channel 1-16,Note C0-G10)

Example:
MidiSendNoteOff(1,"E5")

Sends the Midi Note Off command to Note E5 on channel 1.

The Midi connection needs to be enabled in the Connection Manager .

MidiSendNoteOn

MidiSendNoteOn(Channel 1-16,Note C0-G10,Velocity 0-127)

Example:
MidiSendNoteOn(1,"E5",80)

1239

1239

1239

1239
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Sends the Midi Note On command to Note E5 on channel 1 with velocity 80.

The Midi connection needs to be enabled in the Connection Manager .

MidiSendProgramChange

MidiSendProgramChange(Channel 1-16,Program 0-127)

Example:
MidiSendProgramChange(1,20)

Changes the current program for Midi channel 1 to the program 20.

The Midi connection needs to be enabled in the Connection Manager .

MidiSendRawMsg

MidiSendRawMsg(Status,Channel,Data1,Data2,Data3)

Example:
MidiSendRawMsg(10,11,128,0,0)

Sends a Midi Raw Message with the 5 Midi control bytes 10,11,128,0,0.

The Midi connection needs to be enabled in the Connection Manager .

MouseLeftClick

MouseLeftClick

Example:
MouseLeftClick

Executes a Mouse Left Click.

MouseLeftDown

MouseLeftDown

Example:
MouseLeftDown

Simulates the depression of the left mouse button.

MouseLeftUp

MouseLeftUp

Example:
MouseLeftUp

Simulates the release of the left mouse button

1239

1239
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MouseMove

MouseMove(xPos,yPos)

Example:
MouseMove(200,100)

Moves the mouse cursor to the X Position 200 px and Y Position 100 px.

Tip: If you want to display the current mouse values, create a Mouse Input Node  and see its Item
Properties.

MouseRightClick

MouseRightClick

Example:
MouseRightClick

Executes a Mouse Right Click.

MouseRightDown

MouseRightDown

Example:
MouseRightDown

Simulates the depression of the right mouse button.

MouseRightUp

MouseRightUp

Example:
MouseRightUp

Simulates the release of the right mouse button

N N

O O

OpenAirScanProperties

OpenAirScanProperties

Example:
OpenAirScanProperties

Opens the dialog for the AirScan tool .

1120

1262
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OpenArtNetMonitor

OpenArtNetMonitor

Example:
OpenArtNetMonitor

Opens the Art-NetMonitor  which can also be accessed through the Connection Manager .

OpenArt-NetUniverseList

OpenArtNetUniverseList

Example:
OpenArtNetUniverseList

Opens the Art-Net Universe List which can also be accessed through the Connection Manager .

OpenCameraTrackerDialog

OpenCameraTrackerDialog

Example:
OpenCameraTrackerDialog

Opens the Camera Tracker  dialog.

OpenCITPBrowser

OpenCITPBrowser

Example:
OpenCITPBrowser

Opens the Thumbnail Browser which can also be accessed through the dialog Network Configuration
.

OpenComConnections

OpenComConnections

Example:
OpenComConnections

Opens the COM Connection  dialog which gives an better overview than the Connection Manager
.

OpenConnectionManager

OpenConnectionManager

1256 1239
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Example:
OpenConnectionManager

Opens the Connection Manager .

OpenEmailSettings

OpenEmailSettings

Example:
OpenEmailSettings

Opens the Email Settings Tool .

OpenEventEditor

OpenEventEditor

Example:
OpenEventEditor

Opens the Event Editor Tool .

OpenHelp

OpenHelp

Example:
OpenHelp

Opens this Help File.

OpenIPConfiguration

OpenIPConfiguration

Example:
OpenIPConfiguration

Opens the IP Configuration  dialog.

OpenKeyboardShortcuts

OpenKeyboardShortcuts

Example:
OpenKeyboardShortcuts

Opens the Keyboard Shortcut Editor.

OpenKinectDialog

1239
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OpenKinectDialog

Example:
OpenKinectDialog

Opens the Kinect Tool .

OpenLoadFileDialog

OpenLoadFileDialog

Example:
OpenLoadFileDialog

Opens the "Load File" dialog in WD to load an existing project.

OpenMacroEditor

OpenMacroEditor

Example:
OpenMacroEditor

Opens the Macro Editor dialog in WD.

OpenMidiNoteEditor

OpenMidiNoteEditor

Example:
OpenMidiNoteEditor

Opens the Midi Note Editor .

OpenPageBrowser

OpenPageBrowser

Example:
OpenPageBrowser

Opens the Page Browser .

OpenRemoteInput

OpenRemoteInput

Example:
OpenRemoteInput

Opens the Remote Input Tool .

1269

1250
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OpenSaveAsFileDialog

OpenSaveAsFileDialog

Example:
OpenSaveAsFileDialog

Opens the "Save as" dialog in WD to save the current project to a different name and directory.

OpenSMSSettings

OpenSMSSettings

Example:
OpenSMSSettings

Opens the SMS Settings Tool .

OpenTcpConnections

OpenTcpConnections

Example:
OpenTcpConnections

Opens the TCP Connection  dialog which gives an better overview than the Connection Manager
.

OpenTrackCamProperties

OpenTrackCamProperties

Example:
OpenTrackCamProperties

Opens the Track Cam Tool (Beta).

OpenUdpConnections

OpenUdpConnections

Example:
OpenUdpConnections

Opens the UDP Connection  dialog which gives an better overview than the Connection Manager
.

OpenVariableList

OpenVariableList

1294

1243

1239

1245

1239



1364

Example:
OpenVariableList

Opens the dialog Variable List .

P P

PBApplicationClose

PBApplicationClose(IP address,Processname)

Example:
PBApplicationClose("10.169.10.60","notepad")

Closes the running notepad application on the PB computer with the IP address 10.169.10.60 in the
local network. Please have a look into the windows taskmanager to get the correct process name of
the running application you want to close, enter this 

name without ".exe".

Please note: 

All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBApplicationCloseAll

PBApplicationCloseAll(Processname)

Example:
PBApplicationCloseAll("notepad")

1639
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Closes the running notepad application on all PB computers in the local network. Please have a look
into the windows taskmanager to get the correct process name of the running application you want to
close, enter this name without ".exe".

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBApplicationStart

PBApplicationStart(IP address,Filepath)

Example:
PBApplicationStart("10.169.10.60","notepad.exe")

Opens the notepad on the PB computer with the IP address 10.169.10.60 in the local network.

Example 2:
PBApplicationStart("10.169.10.60","C:\Program Files\Internet Explorer\iexplore.exe")

Opens the Internet Explorer on the PB computer with the IP address 10.169.10.60 in the local
network.
If the application you want to start is not a standard windows application, please use the whole file
path.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBApplicationStartAll

PBApplicationStartAll(Filepath)

Example:
PBApplicationStartAll("notepad.exe")
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Opens the notepad on all PB computers in the local network. 

Example 2:
PBApplicationStartAll("C:\Program Files\Internet Explorer\iexplore.exe")

Opens the Internet Explorer on all PB computers in the local network. 
If the application you want to start is not a standard windows application, please use the whole file
path.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBClose

PBClose(IP address)

Example:
PBClose("10.169.10.65")

Closes the PB software on the computer with the IP address 10.169.10.65 in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBCloseAll

PBCloseAll

Example:
PBCloseAll

Closes the PB software on all computers in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBCloseProject

PBCloseProject("SaveCurrent"/"DoNotSaveCurrent")

Example:
PBCloseProject("SaveCurrent")

Closes the current project in PB after saving it.

Example 2:
PBCloseProject("DoNotSaveCurrent")

Closes the current project in PB without saving it.

PBCueMap
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PBFaderMap(ButtonID,SeqID,CueID)

Example:
PBCueMap(2,1,10)

Links Button 2 of the PB Jog Shuttle Board to Cue 10 of sequence 1 in Pandoras Box Master
System.

PBDeactivateOutput2

PBDeactivateOutput2(IP address)

Example:
PBDeactivateOutput2("10.169.10.65")

Deactivates output 2 of the PB computer with the IP address 10.169.10.65.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBDeactivateOutput2All

PBDeactivateOutput2All

Example:
PBDeactivateOutput2All

Deactivates output 2 of all PB computers in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBFaderMap

PBFaderMap(FaderID,SeqID)

Example:
PBFaderMap(3,1)

Links Fader 3 of the PB Fader Board to the sequence 1 in Pandoras Box Master System.

PBLoadProject

PBLoadProject(Path,Name,"SaveCurrent"/"DoNotSaveCurrent")

Example:
PBLoadProject("C:\coolux\Projects\Rotation.xml","SaveCurrent")

Saves the current PB project and opens the project "Rotation.xml" from the specified directory.
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Example 2:
PBLoadProject("C:\coolux\Projects\Rotation.xml","DoNotSaveCurrent")

Opens the PB project "Rotation.xml" from the specified directory without saving the current project.

PBProjectRefresh

PBProjectRefresh

Example:
PBProjectRefresh

This reads-out information from a Pandoras Box project and stores it in a temporary cache. The
command needs to be called before other commands like VGetAsset...

PBReboot

PBReboot(IP address)

Example:
PBReboot("10.169.10.65")

Reboots the PB computer with the IP address 10.169.10.65 in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBRebootAll

PBRebootAll

Example:
PBRebootAll

Reboots all PB computers in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSaveProject

PBSaveProject

Example:
PBSaveProject

Saves the current project of the PB Master device that is connected to the Widget Designer.

PBSetIP1
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PBSetIP1(IP address,NewIP,NewMask)

Example:
PBSetIP1("10.169.10.65","2.0.0.115","255.255.255.0")

Changes the first IP address of the PB computer with the IP address 10.169.10.65 to the IP 2.0.0.115
with the subnet mask 255.255.255.0.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSetIP1DHCP

PBSetIP1DHCP(IP address)

Example:
PBSetIP1DHCP("2.0.0.111")

Sets the first network adapter of the PB computer with the IP address 2.0.0.111 to DHCP.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSetIP2

PBSetIP2(IP address,NewIP,NewMask)

Example:
PBSetIP2("10.169.10.65","2.0.0.115","255.255.255.0")

Changes the second IP address of the PB computer with the IP address 10.169.10.65 to the IP
2.0.0.115 with the subnet mask 255.255.255.0

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSetIP2DHCP

PBSetIP2DHCP(IP address)

Example:
PBSetIP2DHCP("2.0.0.111")

Sets the second network adapter of the PB computer with the IP address 2.0.0.111 to DHCP.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSetOutput1Resolution



1370

PBSetOutput1Resolution(IP address,1024 768 60)

Example:
PBSetOutput1Resolution("10.169.10.65",1920 1080 60)

Sets the resolution of output 1 of the PB computer with the IP address 10.169.10.65 to 1920x1080 px
and 60 Hz.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSetOutput1ResolutionAll

PBSetOutput1ResolutionAll(1024 768 60)

Example:
PBSetOutput1ResolutionAll(1024 768 60)

Sets the resolution of output 1 of all PB computers in the local network to 1024x786 px @ 60 Hz.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSetOutput2Resolution

PBSetOutput2Resolution(IP address,1024 768 60)

Example:
PBSetOutput2Resolution("10.169.10.65",1920 1080 60)

Sets the resolution of output 2 of the PB computer with the IP address 10.169.10.65 to 1920x1080 px
and 60 Hz.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBSetOutput2ResolutionAll

PBSetOutput2ResolutionAll(1024 768 60)

Example:
PBSetOutput2ResolutionAll(1024 768 60)

Sets the resolution of output 2 of all PB computers in the local network to 1024x786 px @ 60 Hz.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBShutDown
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PBShutDown(IP address)

Example:
PBShutDown("10.169.10.65")

Turns off the PB computer with the IP address 10.169.10.65 in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBShutDownAll

PBShutDownAll

Example:
PBShutDownAll

Shuts down all PB computers in the local network. 

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBStartClient

PBStartClient(IP address)

Example:
PBStartClient("10.169.10.65")

Launches the PB Client software on the computer with the IP address 10.169.10.65 in the local
network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBStartClientAll

PBStartClientAll

Example:
PBStartClientAll

Launches the PB Client software on all computers in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBStartMaster
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PBStartMaster(IP address)

Example:
PBStartMaster("10.169.10.65")

Launches the PB Master software on the computer with the IP address 10.169.10.65 in the local
network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PBStartMasterAll

PBStartMasterAll

Example:
PBStartMasterAll

Launches the PB Master software on all computers in the local network.

Please note: 
All PB commands will only work when the Onscreen Menu up from Rev. 34 is installed on the
computers!

PHAdvServoDisable

PHAdvServoDisable(ID)

Example:
PHAdvServoDisable(1)

Disables the Controller for the first Phidget Advanced Servo Motor.

PHAdvServoEnable

PHAdvServoEnable(ID)

Example:
PHAdvServoEnable(1)

Enables the Controller for the first Phidget Advanced Servo Motor.

PHAdvServoSetAcceleration

PHAdvServoSetAcceleration(ID,Pos)

Example:
PHAdvServoSetAcceleration(1,5)

Sets the acceleration of the first Phidget Advanced Servo Motor to 5.

PHAdvServoSetPosition
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PHAdvServoSetPosition(ID,Pos)

Example:
PHAdvServoSetPosition(2,100)

Sets the position of the second Phidget Advanced Servo Motor to 100.

PHAdvServoSetVelocity

PHAdvServoSetVelocity(ID,Pos)

Example:
PHAdvServoSetVelocity(1,50)

Sets the velocity of the first Phidget Advanced Servo Motor to 50.

PHAdvServoSpeedRampingOff

PHAdvServoSpeedRampingOff(ID)

Example:
PHAdvServoSpeedRampingOff(3)

Disables the Speed Ramping of the third Phidget Advanced Servo Motor.

PHAdvServoSpeedRampingOn

PHAdvServoSpeedRampingOn(ID)

Example:
PHAdvServoSpeedRampingOn(3)

Enables the Speed Ramping of the third Phidget Advanced Servo Motor.

PHInterface_0_0_4_OutputClose

PHInterface_0_0_4_OutputClose(ID)

Example:
PHInterface_0_0_4_OutputClose(2)

Closes the digital output number 2 of the Phidget Relay Interface 0/0/4 .

PHInterface_0_0_4_OutputCloseAll

PHInterface_0_0_4_OutputCloseAll

Example:
PHInterface_0_0_4_OutputCloseAll

Closes all digital outputs of the Phidget Relay Interface 0/0/4 .

1285
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PHInterface_0_0_4_OutputOpen

PHInterface_0_0_4_OutputOpen(ID)

Example:
PHInterface_0_0_4_OutputOpen(2)

Opens the digital output number 2 of the Phidget Relay Interface 0/0/4.

PHInterface_0_0_4_OutputOpenAll

PHInterface_0_0_4_OutputOpenAll

Example:
PHInterface_0_0_4_OutputOpenAll

Opens all digital outputs of the Phidget Relay Interface 0/0/4 .

PHInterface_0_16_16_DisableScripts

PHInterface_0_16_16_DisableScripts

Example:
PHInterface_0_16_16_DisableScripts

Disables the execution of scripts when the inputs switch on or off. 

PHInterface_0_16_16_EnableScripts

PHInterface_0_16_16_EnableScripts

Example:
PHInterface_0_16_16_EnableScripts

Enables the execution of scripts when the inputs switch on or off. 

PHInterface_0_16_16_HideDialog

PHInterface_0_16_16_HideDialog

Example:
PHInterface_0_16_16_HideDialog

Hides the dialog window of the Phidgets Interfacekit 0/16/16.

PHInterface_0_16_16_Init

PHInterface_0_16_16_Init

Example:
PHInterface_0_16_16_Init

1285
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Initializes a connection with a Phidgets Interfacekit 0/16/16.

PHInterface_0_16_16_OutputClose

PHInterface_0_16_16_OutputClose(ID)

Example:
PHInterface_0_16_16_OutputClose(2)

Closes the digital output number 2.

PHInterface_0_16_16_OutputCloseAll

PHInterface_0_16_16_OutputCloseAll

Example:
PHInterface_0_16_16_OutputCloseAll

Closes all digital outputs.

PHInterface_0_16_16_OutputOpen

PHInterface_0_16_16_OutputOpen(ID)

Example:
PHInterface_0_16_16_OutputOpen(2)

Opens the digital output number 2.

PHInterface_0_16_16_OutputOpenAll

PHInterface_0_16_16_OutputOpenAll

Example:
PHInterface_0_16_16_OutputOpenAll

Opens all digital outputs.

PHInterface_0_16_16_Reconnect

PHInterface_0_16_16_Reconnect

Example:
PHInterface_0_16_16_Reconnect

Reconnects a connection with a Phidgets Interfacekit 0/16/16.

PHInterface_0_16_16_ShowDialog

PHInterface_0_16_16_ShowDialog

1283
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Example:
PHInterface_0_16_16_ShowDialog

Shows the dialog window of the Phidgets Interfacekit 0/16/16.

PHInterface_8_8_8_DisableScripts

PHInterface_8_8_8_DisableScripts

Example:
PHInterface_8_8_8_DisableScripts

Disables the execution of scripts from the Phidgets Interfacekit 8/8/8 when the inputs switch on or off.

PHInterface_8_8_8_EnableScripts

PHInterface_8_8_8_EnableScripts

Example:
PHInterface_8_8_8_EnableScripts

Enables the execution of scripts from the Phidgets Interfacekit 8/8/8 when the inputs switch on or off.

PHInterface_8_8_8_HideDialog

PHInterface_8_8_8_HideDialog

Example:
PHInterface_8_8_8_HideDialog

Hides the dialog window of the Phidgets Interfacekit 8/8/8.

PHInterface_8_8_8_Init

PHInterface_8_8_8_Init

Example:
PHInterface_8_8_8_Init

Initializes a connection with a Phidgets Interfacekit 8/8/8.

PHInterface_8_8_8_OutputClose

PHInterface_8_8_8_OutputClose(ID)

Example:
PHInterface_8_8_8_OutputClose(2)

Closes the digital output number 2 of the Phidgets Interfacekit 8/8/8.

PHInterface_8_8_8_OutputCloseAll
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PHInterface_8_8_8_OutputCloseAll

Example:
PHInterface_8_8_8_OutputCloseAll

Closes all digital outputs of the Phidgets Interfacekit 8/8/8.

PHInterface_8_8_8_OutputOpen

PHInterface_8_8_8_OutputOpen(ID)

Example:
PHInterface_8_8_8_OutputOpen(2)

Opens the digital output number 2 of the Phidgets Interfacekit 8/8/8.

PHInterface_8_8_8_OutputOpenAll

PHInterface_8_8_8_OutputOpenAll

Example:
PHInterface_8_8_8_OutputOpenAll

Opens all digital outputs of the Phidgets Interfacekit 8/8/8.

PHInterface_8_8_8_Reconnect

PHInterface_8_8_8_Reconnect

Example:
PHInterface_8_8_8_Reconnect

Reconnects a connection with a Phidgets Interfacekit 8/8/8.

PHInterface_8_8_8_ShowDialog

PHInterface_8_8_8_ShowDialog

Example:
PHInterface_8_8_8_ShowDialog

Shows the dialog window of the Phidgets Interfacekit 8/8/8.

PHIRDisable

PHIRDisable

Example:
PHIRDisable

Disables the IR Phidget Controller.
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PHIREnable

PHIREnable

Example:
PHIREnable

Enables the IR Phidget Controller.

PHIRSend

PHIRSend(IRAlias)

Example:
PHIRSend("abc")

Sends the learned IR Alias code “abc” via the IR Phidget Controller. Please use the Phidgets IR
Receiver / Transmitter Tool  to create these IR Alias.

PHRFIDDisable

PHRFIDDisable

Example:
PHRFIDDisable

Disables the RFID Phidget Controller.

PHRFIDEnable

PHRFIDEnable

Example:
PHRFIDEnable

Enables the RFID Phidget Controller.

PHRFIDRecentTagToListView

PHRFIDRecentTagToListView(ID,Col,Row)

Example:
PHRFIDRecentTagToListView(ID,Col,Row)

This

PHRFIDRecentTagToListViewNewLine

PHRFIDRecentTagToListViewNewLine(ID,Col)
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Example:
PHRFIDRecentTagToListViewNewLine(ID,Col)

This

PlaySound

PlaySound(Filename)

Example:
PlaySound("C:\Coolux\media\instrument.wav")

Plays the wave file "instrument.wav" from the specified directory. Please note, that WD does not play
another format than wave files.

PlaySoundLoop

PlaySoundLoop(Filename)

Example:
PlaySoundLoop(C:\Coolux\media\instrument.wav)

Loops the wave file "instrument.wav" from the specified directory. Please note, that WD does not play
another format than wav files.

Q Q

R R

RemoveGraphicLayer

RemoveGraphicLayer(SiteID,DeviceID)

Example:
RemoveGraphicLayer(1,3)

Removes layer 3 from the Site 1 (e.g. a Server) if ti is a Graphic Layer. This command does not just
toggle the layer invisible, it deletes it entirely.

RemoveVideoLayer

RemoveVideoLayer(SiteID,DeviceID)

Example:
RemoveVideoLayer(1,3)

Removes layer 3 from the Site 1 (e.g. a Server) if it is a Video Layer. This command does not just
toggle the layer invisible, it deletes it entirely.

ResetAll



1380

ResetAll

Example:
ResetAll

Resets all parameters of all layers of all Servers within the Pandoras Box Project.

ResetDevice

ResetDevice(SiteID,DeviceID)

Example:
ResetDevice(1,3)

Resets all parameters of layer 3 of site 1 within the Pandoras Box Project.

ResetParam

ResetParam(SiteID,DeviceID,ParamName)

Example:
ResetParam(1,3,"X Scale")

Resets the parameter  X Scale of layer 3 of site 1 within the Pandoras Box Project.

ResetSite

ResetSite(SiteID)

Example:
ResetSite(1)

Resets all parameters of all layers of site 1 within the Pandoras Box Project.

ResourceAdd

ResourceAdd(FilePath,SiteID,FolderID,FileID)

Example:
ResourceAdd("C:\coolux\content\Video.mpg",3,4,2)

This adds a file from a remote or local node (i.e. Client or Master) to the main folder of your Pandoras
Box project.
The file "Video.mpg" is loaded from the Site with ID 3 from the path "C:\coolux\content". It is added to
the project folder and assigned with Folder and File ID 4,2. If you do not need a Folder/File ID you
may set it to "0,0" in the command.

ResourceAddFileFromLocal

ResourceAddFileFromLocal(FilePath)
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Example:
ResourceAddFileFromLocal("C:\coolux\content\Image.png")

This adds a file from your local node (i.e. the Master) to the main folder of your Pandoras Box
project. 
The file "Image.png" is loaded from the path "C:\coolux\content" and added to the project folder.

ResourceAddFileFromLocalToProjectPath

ResourceAddFileFromLocalToProjectPath(FilePath,ProjectPath)

Example:
ResourceAddFileFromLocalToProjectPath("C:\coolux\content\Image.png","background\images")

This adds a file from your local node (i.e. the Master) to a subfolder of your Pandoras Box project.
The file "Image.png" is loaded from the path "C:\coolux\content" and added to the subfolder "images"
in the subfolder "background" within the project folder.

ResourceAddFolder

ResourceAddFolder(FolderName)

Example:
ResourceAddFolder("loops")

This adds a subfolder to your Pandoras Box project. 
A new subfolder named "loops" is generated.

ResourceAddFolderFromLocal

ResourceAddFolderFromLocal(FilePath)

Example:
ResourceAddFolderFromLocal("C:\coolux\content\testpattern")

This adds a folder from your local node (i.e. the Master) to the main folder of your Pandoras Box
project. 
The folder "testpattern" including all files is loaded from the path "C:\coolux\content" and added to the
project folder.

ResourceAddFolderFromLocalByID

ResourceAddFolderFromLocalByID(FolderPath,FolderID,FileID)

Example:
ResourceAddFolderFromLocalByID("C:\coolux\content\testpattern",5,1)

This adds a folder from your local node (i.e. the Master) to the main folder of your Pandoras Box
project and assigns Folder/File IDs.
The folder "testpattern" including all files is loaded from the path "C:\coolux\content" and added to the
project folder. In addition all files are numbered consecutively with a Folder/File ID starting from 5,1.
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ResourceAddFolderFromLocalToProjectPath

ResourceAddFolderFromLocalToProjectPath(FilePath,ProjectPath)

Example:
ResourceAddFolderFromLocalToProjectPath("C:\coolux\content\testpattern","background\images")

This adds a folder from your local node (i.e. the Master) to a subfolder of your Pandoras Box project. 
The folder "testpattern" including all files is loaded from the path "C:\coolux\content" and added to the
subfolder "images" in the subfolder "background" within the project folder.

ResourceAddFolderFromLocalToProjectPathByID

ResourceAddFolderFromLocalToProjectPathByID(FolderPath,ProjectPath,FolderID,FileID)

Example:
ResourceAddFolderFromLocalToProjectPathByID("C:\coolux\content\testpattern","background
\images",5,1)

This adds a folder from your local node (i.e. the Master) to a subfolder of your Pandoras Box project
and assigns Folder/File IDs.
The folder "testpattern" including all files is loaded from the path "C:\coolux\content" and added to the
subfolder "images" in the subfolder "background" within the project folder. In addition all files are
numbered consecutively with a Folder/File ID starting from 5,1.

ResourceAddFolderToPath

ResourceAddFolderToPath(FolderName,ProjectPath)

Example:
ResourceAddFolderToPath("loops","background\images")

This adds a subfolder to an existing subfolder in your Pandoras Box project.
A new subfolder named "loops" is generated in the subfolder "images" in the subfolder "background"
within the project folder.

ResourceAddImageSeq

ResourceAddImageSeq(FolderPath,FPS,SiteID,FolderID,FileID)

Example:
ResourceAddImageSeq("C:\ImgSeq\Intro",25,1,2,3)

This adds the image sequence saved under "C:\ImgSeq\Intro" on the hard disc of Site 1 to the main
folder in the Pandoras Box Project tab. The frame rate of the image sequence is set to 25 frames/
second and the File and Folder ID is [2,3]. If you do not need a Folder and File ID you may set it to
“0,0” in the command.

ResourceAddImageSeqFromLocal

ResourceAddImageSeqFromLocal(FolderPath,FPS)
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Example:
ResourceAddImageSeqFromLocal("C:\ImgSeq\Intro",25)

This adds the image sequence saved under "C:\ImgSeq\Intro" on the hard disc of the local Site to the
main folder in the Pandoras Box Project tab. The frame rate of the image sequence is set to 25
frames/second.

ResourceAddImageSeqFromLocalByID

ResourceAddImageSeqFromLocalByID(FolderPath,FPS,FolderID,FileID)

Example:
ResourceAddImageSeqFromLocalByID("C:\ImgSeq\Intro",25,2,3)

This adds the image sequence saved under "C:\ImgSeq\Intro" on the hard disc of the local Site to the
main folder in the Pandoras Box Project tab. The frame rate of the image sequence is set to 25
frames/second and the File and Folder ID is [2,3].

ResourceAddImageSeqFromLocalToProjectPath

ResourceAddImageSeqFromLocalToProjectPath(FolderPath,FPS,ProjectPath)

Example:
ResourceAddImageSeqFromLocalToProjectPath("C:\ImgSeq\Intro",25,"Image Sequences")

This adds the image sequence saved under "C:\ImgSeq\Intro" on the hard disc of the local Site to the
folder "Image Sequences" in the Pandoras Box Project tab. The frame rate of the image sequence is
set to 25 frames/second.

ResourceAddImageSeqFromLocalToProjectPathByID

ResourceAddImageSeqFromLocalToProjectPathByID(FolderPath,FPS,ProjectPath,FolderID,FileID)

Example:
ResourceAddImageSeqFromLocalToProjectPathByID("C:\ImgSeq\Intro",25,"Image Sequences",2,3)

This adds the image sequence saved under "C:\ImgSeq\Intro" on the hard disc of the local Site to the
folder "Image Sequences" in the Pandoras Box Project tab. The frame rate of the image sequence is
set to 25 frames/second and the File and Folder ID is [2,3].

ResourceAddImageSeqToProjectPath

ResourceAddImageSeqToProjectPath(FolderPath,FPS,SiteID,ProjectPath,FolderID,FileID)

Example:
ResourceAddImageSeqToProjectPath("C:\ImgSeq\Intro",25,1,"Image Sequences",2,3)

This adds the image sequence saved under "C:\ImgSeq\Intro" on the hard disc of Site 1 to the sub
folder "Image Sequences" in the Pandoras Box Project tab. The frame rate of the image sequence is
set to 25 frames/second and the File and Folder ID is [2,3]. If you do not need a Folder and File ID
you may set it to “0,0” in the command.
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ResourceAddToProjectPath

ResourceAddToProjectPath(FilePath,SiteID,FolderID,FileID,ProjectPath)

Example:
ResourceAddToProjectPath("C:\coolux\content\Video.mpg",3,4,2,background\images")

This adds a file from a remote or local node (i.e. Client or Master) to a subfolder of your Pandoras
Box project.
The file "Video.mpg" is loaded from the Site with ID 3 from the path "C:\coolux\content". It is added to
the project folder and assigned with Folder and File ID 4,2. If you do not need a Folder/File ID you
may set it to "0,0" in the command.

ResourceAttachByID

ResourceAttachByID(FolderID,FileID,SiteID,FilePath)

Example:
ResourceAttachByID(2,4,3,"C:\coolux\content\image2.png")

This attaches a file link in your Pandoras Box project so that the specified node loads another file
than the one the Master system calls, e.g. as an active value or from the timeline. The node can be a
remote or local node (i.e. Client or Master). See the topic "Attaching Files ".
In the example, the Site with ID 3 (e.g. a Server) loads the file "image2.png" from the path "C:\coolux
\content" as soon as the Master system calls the file with Folder and File ID 2,4.

ResourceAttachByPath

ResourceAttachByPath(ProjectPath,SiteID,FilePath)

Example:
ResourceAttachByPath("backgrounds\images\image1.png",3,"C:\coolux\content\image2.png")

This attaches a file link in your Pandoras Box project so that the specified node loads another file
than the one the Master system calls, e.g. as an active value or from the timeline. The node can be a
remote or local node (i.e. Client or Master). See the topic "Attaching Files ".
In the example, the Site with ID 3 (e.g. a Server) loads the file "image2.png" from the path "C:\coolux
\content" as soon as the Master system calls the file "image1.png" that is located in the subfolder
"images" in the subfolder "background" within the project folder.

ResourceBrowserClearCacheByID

ResourceBrowserClearCacheByID(FolderID,FileID)

Example:
ResourceBrowserClearCacheByID(2,3)

This clears the browser cache from the Browser Asset with the Folder and File ID [2,3] in the
Pandoras Box Project tab. Clear the web cache to renew stored document information including
images. Alternatively, click "Clear Cache" in the Browser Inspector .

ResourceBrowserClearCacheByName
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ResourceBrowserClearCacheByName(BrowserNamePath)

Example:
ResourceBrowserClearCacheByName("file:///C:\website\index.html")

This clears the browser cache from the Browser Asset "file:///C:\website\index.html" in the main
folder in the Pandoras Box Project tab. Clear the web cache to renew stored document information
including images. Alternatively, click "Clear Cache" in the Browser Inspector .

ResourceBrowserSetURLbyID

ResourceBrowserSetURLbyID(FolderID,FileID,URL)

Example:
ResourceBrowserSetURLbyID(2,4,"www.coolux.de")

In PB, the Browser Asset with Folder and File ID 2,4 changes its URL to "www.coolux.de".

ResourceBrowserSetURLbyName

ResourceBrowserSetURLbyName(BrowserNamePath,URL)

Example:
ResourceBrowserSetURLbyName("coolux.de","www.manual.coolux.de")

In PB, the Browser Asset that is displayed with the name "coolux.de" in the Project tab, changes its
URL to "www.manual.coolux.de".

ResourceCanvasClearByID

ResourceCanvasClearByID(FolderID,FileID)

Example:
ResourceCanvasClearByID(2,4)

This clears the Canvas Asset  in your Pandoras Box project so that it is empty.

ResourceCreatePBPlaylistByID

ResourceCreatePBPlaylistByID(FolderID,FileID)

Example:
ResourceCreatePBPlaylistByID(1,2)

This creates a new empty Pandoras Box playlist  and assigns the folder and file ID [1,2]. 

ResourceCreatePBPlaylistByPath

ResourceCreatePBPlaylistByPath(ProjectPath)

Example:
ResourceCreatePBPlaylistByPath("Playlist Test\First")
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This creates a new empty Pandoras Box playlist  and adds it to the subfolder “First” in the
subfolder “Playlist Test” within the project folder.

ResourceCreatePBPlaylistByPathWithID

ResourceCreatePBPlaylistByPathWithID(ProjectPath,FolderID,FileID)

Example:
ResourceCreatePBPlaylistByPathWithID("Playlist Test\Second",4,8)

This creates an new empty Pandoras Box playlist . It is added to the subfolder “Second” in the
subfolder “Playlist Test” within the project folder and then assigned with the folder and file ID [4,8].

ResourceCreatePBPlaylistFromFolderByPath

ResourceCreatePBPlaylistFromFolderByPath(PlaylistPath,SourceFolderPath)

Example:
ResourceCreatePBPlaylistFromFolderByPath("Playlist Test\First","Content\Medialoops")

This creates a new Pandoras Box playlist  and adds it to the subfolder “First” in the subfolder
“Playlist Test” within the project folder. The content from “Content\Medialoops” will be added to the
playlist.

ResourceCreatePBPlaylistFromFolderByPathWithID

ResourceCreatePBPlaylistFromFolderByPathWithID(PlaylistPath,SourceFolderPath,FolderID,FileID)

Example:
ResourceCreatePBPlaylistFromFolderByPathWithID("Playlist Test\First","Content\Medialoops",3,5)

This creates a new Pandoras Box playlist  and adds it to the subfolder “First” in the subfolder
“Playlist Test” within the project folder. The content from “Content\Medialoops” will be added to the
playlist and the folder and file ID [3,5] is assigned.

ResourceCreateText

ResourceCreateText(FolderID,FileID,Text)

Example:
ResourceCreateText(2,10,"design2")

Creates a new text asset with the folder and file ID [2,10] in PB with the text "design2".

ResourceDetachByID

ResourceDetachByID(FolderID,FileID,SiteID)

Example:
ResourceDetachByID(2,4,3)
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This detaches a file link in your Pandoras Box project so that the specified node does not load this
file anymore when the Master system calls it, e.g. as an active value or from the timeline. It is now
possible to attach another file that should be loaded instead. The node can be a remote or local node
(i.e. Client or Master). See the topic "Attaching Files ".
In the example, the Site with ID 3 (e.g. a Server) does not load the file with Folder and File ID 2,4 any
more.

ResourceDetachByPath

ResourceDetachByPath(ProjectPath,SiteID)

Example:
ResourceDetachByPath("backgrounds\images\image1.png",3)

This detaches a file link in your Pandoras Box project so that the specified node does not load this
file anymore when the Master system calls it, e.g. as an active value or from the timeline. It is now
possible to attach another file that should be loaded instead. The node can be a remote or local node
(i.e. Client or Master). See the topic "Attaching Files ".
In the example, the Site with ID 3 (e.g. a Server) does not load the file "image1.png" any more. The
file is located in the subfolder "images" in the subfolder "background" within the project folder.

ResourceEncodeFile

ResourceEncodeFile(FileName,Preset)

Example:
ResourceEncodeFile("Videos\loop.wmv","Auto")

This sends the file "loop.wmv" from the folder "Videos" in the Pandoras Box Project tab to the
internal Encoder Extension  and encodes it with the Preset named "Auto". The encoded file is
saved in the original path. Obviously, the Encoder Extension needs to be available in the PB Master.

ResourceEncodeFileByID

ResourceEncodeFileByID(FolderID,FileID,Preset)

Example:
ResourceEncodeFileByID(1,2,"Auto")

This sends the file with the File and Folder ID [1,2] in the Pandoras Box Project tab to the internal 
Encoder Extension  and encodes it with the Preset named "Auto". The encoded file is saved in the
original path. Obviously, the Encoder Extension needs to be available in the PB Master.

ResourceEncodeFileByIDToPath

ResourceEncodeFileByIDToPath(FolderID,FileID,TargetPath,Preset)

Example:
ResourceEncodeFileByIDToPath(1,2,"C:\Encoded","Auto")

This sends the file with the File and Folder ID [1,2] in the Pandoras Box Project tab to the internal 
Encoder Extension  and encodes it with the Preset named "Auto". The encoded file is saved in a
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new path under "C:\Encoded". Obviously, the Encoder Extension needs to be available in the PB
Master.

ResourceEncodeFileToPath

ResourceEncodeFileToPath(FileName,TargetPath,Preset)

Example:
ResourceEncodeFileToPath("Videos\loop.wmv","C:\Encoded","Auto")

This sends the file "loop.wmv" from the folder "Videos" in the Pandoras Box Project tab to the
internal Encoder Extension  and encodes it with the Preset named "Auto". The encoded file is
saved in a new path under "C:\Encoded". Obviously, the Encoder Extension needs to be available in
the PB Master.

ResourceExportSeq

ResourceExportSeq(SeqID,FileName,Preset,StartHH,MM,SS,FF,StopHH,MM,SS,FF)

Example:
ResourceExportSeq(2,"C:\coolux\content\export\001","HD 1280x720",00,05,22,12,00,15,23,13)

This records what you have programmed on a sequence using the Video Export  feature in the
Pandoras Box project. The feature is limited to some Pandoras Box products .
The Sequence with ID 2 is recorded and saved with the file name "001.m2v" under the path "C:\coolux
\content\export". "HD 1280x720" is used as the Encoder Setting. The recording starts at 00:05:22:12
and ends at 00:15:23:13 (hh:mm:ss:ff). Afterwards the recorded file is added to the Pandoras Box
project automatically.

ResourceExportSeqF

ResourceExportSeqF(SeqID,FileName,Preset,StartHH:MM:SS:FF,StopHH:MM:SS:FF)

Example:
ResourceExportSeqF(2,"C:\coolux\content\export\001","HD 1280x720","00:05:22:12","00:15:23:13")

This records what you have programmed on a sequence using the Video Export  feature in the
Pandoras Box project. The feature is limited to some Pandoras Box products .
The Sequence with ID 2 is recorded and saved with the file name "001.m2v" under the path "C:\coolux
\content\export". "HD 1280x720" is used as the Encoder Setting. The recording starts at 00:05:22:12
and ends at 00:15:23:13 (hh:mm:ss:ff). Afterwards the recorded file is added to the Pandoras Box
project automatically.
With this command both timecodes can also be stored and recalled using string variables .

ResourceGetTextFromLabel

ResourceGetTextFromLabel(LabelID,FolderID,FileID)

Example:
ResourceGetTextFromLabel(3,2,9)

Sets the text of the text asset with the Folder and File ID [2.9] in PB to the text of label 3 in WD.
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ResourceGetTextFromLabelUnicode

ResourceGetTextFromLabelUnicode(LabelID,FolderID,FileID)

Example:
ResourceGetTextFromLabelUnicode(3,2,9)

Sets the text of the text asset with the Folder and File ID [2.9] in PB to the text of label 3 in WD.
Using this Unicode-command, text strings in any language format can be sent to Pandoras Box text
assets.

ResourceGetTextFromTextbox

ResourceGetTextFromTextbox(TextboxID,FolderID,FileID)

Example:
ResourceGetTextFromTextbox(4,2,10)

Sets the text of the text asset with the Folder and File ID [2.10] in PB to the text of textbox 4 in WD.

ResourceGetTextFromTextboxUnicode

ResourceGetTextFromTextboxUnicode(TextboxID,FolderID,FileID)

Example:
ResourceGetTextFromTextboxUnicode(4,2,10)

Sets the text of the text asset with the Folder and File ID [2.10] in PB to the text of textbox 4 in WD.
Using this Unicode-command text strings in any language format can be sent to Pandoras Box text
assets.

ResourceMove

ResourceMove(Content,ProjectPath)

Example:
ResourceMove("Image.png","background\images")

This moves the file "Image.png" that is already part of your Pandoras Box project to the subfolder
"images" in the subfolder "background" within the project folder.
If there is more than one file in the project that holds this name, the first file is taken.

ResourcePBPlaylistAddItemByID

ResourcePBPlaylistAddItemByID(PlaylistFolderID,PlaylistFileID,ItemFolderID,ItemFileID)

Example:
ResourcePBPlaylistAddItemByID(4,5,1,8)

This adds the media file with the folder and file ID [1,8] to the end of the Pandoras Box playlist
with the folder and file ID [4,5].
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ResourcePBPlaylistAddItemByPath

ResourcePBPlaylistAddItemByPath(PlaylistPath,ItemPath)

Example:
ResourcePBPlaylistAddItemByPath("Playlist Test\Playlist 1","Gradients\Calibrate.png")

This adds the media file "Calibrate.png" to the end of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder,

ResourcePBPlaylistInsertItemByID

ResourcePBPlaylistInsertItemByID(PlaylistFolderID,PlaylistFileID,ItemFolderID,ItemFileID,Index)

Example:
ResourcePBPlaylistInsertItemByID(4,5,1,8,3)

This inserts the media file with the folder and file ID [1,8] to the Pandoras Box playlist  with the
folder and file ID [4,5] as index 3. All following items increase their indices by one, e.g. the former
item number 3 becomes item number 4.

ResourcePBPlaylistInsertItemByPath

ResourcePBPlaylistInsertItemByPath(PlaylistPath,ItemPath,Index)

Example:
ResourcePBPlaylistInsertItemByPath("Playlist Test\Playlist 1","Gradients\Calibrate.png",3)

This inserts the media file "Calibrate.png" to the Pandoras Box playlist  “Playlist 1” of the subfolder
“Playlist Test” within the project folder. The new media is assigned with index 3. All following items
increase their indices by one, e.g. the item number 3 becomes item number 4.

ResourcePBPlaylistRemoveAllItemByID

ResourcePBPlaylistRemoveAllItemByID(FolderID,FileID)

Example:
ResourcePBPlaylistRemoveAllItemByID(1,9)

This removes the content from the Pandoras Box playlist  with the folder and file ID [1,9].

ResourcePBPlaylistRemoveAllItemByPath

ResourcePBPlaylistRemoveAllItemByPath(PlaylistPath)

Example:
ResourcePBPlaylistRemoveAllItemByPath("Playlist Test\Playlist 1")

This removes the content from the Pandoras Box playlist  “Playlist 1” of the subfolder “Playlist
Test” within the project folder.

ResourcePBPlaylistRemoveItemByID
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ResourcePBPlaylistRemoveItemByID(FolderID,FileID,RemoveID)

Example:
ResourcePBPlaylistRemoveItemByID(1,9,5)

This removes the item with index number 5 from the Pandoras Box playlist  with the folder and file
ID [1,9]. All following items decrease their indices by one, e.g. item number 6 becomes item number
5.

ResourcePBPlaylistRemoveItemByPath

ResourcePBPlaylistRemoveItemByPath(PlaylistPath,RemoveID)

Example:
ResourcePBPlaylistRemoveItemByPath("Playlist Test\Playlist 1",5)

This removes the item with index number 5 from the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder. All following items decrease their indices by one,
e.g. item number 6 becomes item number 5.

ResourcePBPlaylistSetItemDurationByID

ResourcePBPlaylistSetItemDurationByID(PlaylistFolderID,PlaylistFileID,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemDurationByID(2,1,8,00,05,22,12)

This sets the duration of the item with index 8 of the Pandoras Box playlist  with the folder and file
ID [2,1] to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemDurationByIDF

ResourcePBPlaylistSetItemDurationByIDF(PlaylistFolderID,PlaylistFileID,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemDurationByIDF(2,1,8,"00:05:22:12")

This sets the duration of the item with index 8 of the Pandoras Box playlist with the folder and file ID
[2,1] to 00:05:22:12 (hh:mm:ss:ff). With this command, the timecode can also be stored and recalled
using a string variable .

ResourcePBPlaylistSetItemDurationByPath

ResourcePBPlaylistSetItemDurationByPath(PlaylistPath,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemDurationByPath("Playlist Test\Playlist 1",8,00,05,22,12)

This sets the duration of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemDurationByPathF
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ResourcePBPlaylistSetItemDurationByPathF(PlaylistPath,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemDurationByPathF("Playlist Test\Playlist 1",8,"00:05:22:12")

This sets the duration of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff). With this command,
the timecode can also be stored and recalled using a string variable .

ResourcePBPlaylistSetItemFadeOutByID

ResourcePBPlaylistSetItemFadeOutByID(PlaylistFolderID,PlaylistFileID,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemFadeOutByID(2,1,8,00,05,22,12)

This sets the fade out time of the item with index 8 of the Pandoras Box playlist  with the folder
and file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemFadeOutByIDF

ResourcePBPlaylistSetItemFadeOutByIDF(PlaylistFolderID,PlaylistFileID,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemFadeOutByIDF(2,1,8,"00:05:22:12")

This sets the fade out time of the item with index 8 of the Pandoras Box playlist  with the folder
and file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff). With this command, the timecode can also be stored
and recalled using a string variable .

ResourcePBPlaylistSetItemFadeOutByPath

ResourcePBPlaylistSetItemFadeOutByPath(PlaylistPath,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemFadeOutByPath("Playlist Test\Playlist 1",8,00,05,22,12)

This sets the fade out time of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemFadeOutByPathF

ResourcePBPlaylistSetItemFadeOutByPathF(PlaylistPath,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemFadeOutByPathF("Playlist Test\Playlist 1",8,"00:05:22:12")

This sets the fade out time of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff). With this command,
the timecode can also be stored and recalled using a string variable .

ResourcePBPlaylistSetItemIndexByID
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ResourcePBPlaylistSetItemIndexByID(PlaylistFolderID,PlaylistFileID,OldIndex,NewIndex)

Example:
ResourcePBPlaylistSetItemIndexByID(2,1,7,4)

This sets the item with index 7 to index 4 of the Pandoras Box playlist  with the folder and file ID
[2,1]. All original items 4-6 increase their indices by one, e.g. the item of index 4 moves forward to
index 5.

ResourcePBPlaylistSetItemIndexByPath

ResourcePBPlaylistSetItemIndexByPath(PlaylistPath,OldIndex,NewIndex)

Example:
ResourcePBPlaylistSetItemIndexByPath("Playlist Test\Playlist 1",7,4)

This sets the item with index 7 to index 4 of the Pandoras Box playlist  “Playlist 1” of the subfolder
“Playlist Test” within the project folder. All original items 4-6 increase their indices by one, e.g. the
item of index 4 moves forward to index 5.

ResourcePBPlaylistSetItemInPointByID

ResourcePBPlaylistSetItemInPointByID(PlaylistFolderID,PlaylistFileID,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemInPointByID(2,1,8,00,05,22,12)

This sets the inpoint time of the item with index 8 of the Pandoras Box playlist  with the folder and
file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemInPointByIDF

ResourcePBPlaylistSetItemInPointByIDF(PlaylistFolderID,PlaylistFileID,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemInPointByIDF(2,1,8,"00:05:22:12")

This sets the inpoint time of the item with index 8 of the Pandoras Box playlist  with the folder and
file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff). With this command, the timecode can also be stored and
recalled using a string variable .

ResourcePBPlaylistSetItemInPointByPath

ResourcePBPlaylistSetItemInPointByPath(PlaylistPath,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemInPointByPath("Playlist Test\Playlist 1",8,00,05,22,12)

This sets the inpoint time of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemInPointByPathF
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ResourcePBPlaylistSetItemInPointByPathF(PlaylistPath,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemInPointByPathF("Playlist Test\Playlist 1",8,"00:05:22:12")

This sets the inpoint time of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff). With this command,
the timecode can also be stored and recalled using a string variable .

ResourcePBPlaylistSetItemOutPointByID

ResourcePBPlaylistSetItemOutPointByID(PlaylistFolderID,PlaylistFileID,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemOutPointByID(2,1,8,00,05,22,12)

This sets the outpoint time of the item with index 8 of the Pandoras Box playlist  with the folder
and file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemOutPointByIDF

ResourcePBPlaylistSetItemOutPointByIDF(PlaylistFolderID,PlaylistFileID,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemOutPointByIDF(2,1,8,"00:05:22:12")

This sets the outpoint time of the item with index 8 of the Pandoras Box playlist  with the folder
and file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff). With this command, the timecode can also be stored
and recalled using a string variable .

ResourcePBPlaylistSetItemOutPointByPath

ResourcePBPlaylistSetItemOutPointByPath(PlaylistPath,Index,HH,MM,SS,FF)

Example:
ResourcePBPlaylistSetItemOutPointByPath("Playlist Test\Playlist 1",8,00,05,22,12)

This sets the outpoint time of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff).

ResourcePBPlaylistSetItemOutPointByPathF

ResourcePBPlaylistSetItemOutPointByPathF(PlaylistPath,Index,HH:MM:SS:FF)

Example:
ResourcePBPlaylistSetItemOutPointByPathF("Playlist Test\Playlist 1",8,"00:05:22:12")

This sets the outpoint time of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to 00:05:22:12 (hh:mm:ss:ff). With this command,
the timecode can also be stored and recalled using a string variable .

ResourcePBPlaylistSetItemTransitionFXByID
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ResourcePBPlaylistSetItemTransitionFXByID(PlaylistFolderID,PlaylistFileID,Index,FXID)

Example:
ResourcePBPlaylistSetItemTransitionFXByID(2,1,8,1)

This sets the Transition FX of the item with index 8 of the Pandoras Box playlist  with the folder
and file ID [2,1] to "TransitionFX 001". If you like to change it back to the default "Crossfade", use 0.

ResourcePBPlaylistSetItemTransitionFXByPath

ResourcePBPlaylistSetItemTransitionFXByPath(PlaylistPath,Index,FXID)

Example:
ResourcePBPlaylistSetItemTransitionFXByPath("Playlist Test\Playlist 1",8,1)

This sets the Transition FX of the item with index 8 of the Pandoras Box playlist  “Playlist 1” of the
subfolder “Playlist Test” within the project folder to "TransitionFX 001". If you like to change it back to
the default "Crossfade", use 0.

ResourceRecordLiveInput

ResourceRecordLiveInput(InputName,FileName,Preset,HH,MM,SS,FF)

Example:
ResourceRecordLiveInput("Integrated Webcam-2","C:\coolux\content\recordings\001","HD
1280x720",00,05,22,12)

This records a Live Input using the Video Recording  feature in the Pandoras Box project. The
feature is limited to some Pandoras Box products .
The Live Input with the name "Integrated Webcam-2" is recorded and saved with the file name
"001.m2v" under the path "C:\coolux\content\recordings". "HD 1280x720" is used as the Encoder
Setting. The total length of the file is 00:05:22:12 (hh:mm:ss:ff). Afterwards the recorded file is added
to the Pandoras Box project automatically.

ResourceRecordLiveInputByID

ResourceRecordLiveInputByID(FolderID,FileID,FileName,Preset,HH,MM,SS,FF)

Example:
ResourceRecordLiveInputByID(2,4,"C:\coolux\content\recordings\001","HD 1280x720",00,05,22,12)

This records a Live Input using the Video Recording  feature in the Pandoras Box project. The
feature is limited to some Pandoras Box products .
The Live Input with the Folder and File ID 2,4 is recorded and saved with the file name "001.m2v"
under the path "C:\coolux\content\recordings". "HD 1280x720" is used as the Encoder Setting. The
total length of the file is 00:05:22:12 (hh:mm:ss:ff). Afterwards the recorded file is added to the
Pandoras Box project automatically.

ResourceRecordLiveInputByIDF

ResourceRecordLiveInputByIDF(FolderID,FileID,FileName,Preset,HH:MM:SS:FF)
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Example:
ResourceRecordLiveInputByIDF(2,4,"C:\coolux\content\recordings\001","HD
1280x720","00:05:22:12")

This records a Live Input using the Video Recording  feature in the Pandoras Box project. The
feature is limited to some Pandoras Box products .
The Live Input with the Folder and File ID 2,4 is recorded and saved with the file name "001.m2v"
under the path "C:\coolux\content\recordings". "HD 1280x720" is used as the Encoder Setting. The
total length of the file is 00:05:22:12 (hh:mm:ss:ff). Afterwards the recorded file is added to the
Pandoras Box project automatically.
With this command the timecode can also be stored and recalled using a string variable .

ResourceRecordLiveInputByIDStart

ResourceRecordLiveInputByIDStart(FolderID,FileID,FileName,Preset)

Example:
ResourceRecordLiveInputByIDStart(2,4,"C:\coolux\content\recordings\001","HD
1280x720",00,05,22,12)

This starts to record a Live Input using the Video Recording  feature in the Pandoras Box project.
The feature is limited to some Pandoras Box products .
The Live Input with the Folder and File ID 2,4 is recorded and saved with the file name "001.m2v"
under the path "C:\coolux\content\recordings". "HD 1280x720" is used as the Encoder Setting. The
total length of the file depends on when the recording is stopped again. Afterwards the recorded file is
added to the Pandoras Box project automatically.

ResourceRecordLiveInputF

ResourceRecordLiveInputF(InputName,FileName,Preset,HH:MM:SS:FF)

Example:
ResourceRecordLiveInputF("Integrated Webcam-2","C:\coolux\content\recordings\001","HD
1280x720",00:05:22:12)

This records a Live Input using the Video Recording  feature in the Pandoras Box project. The
feature is limited to some Pandoras Box products .
The Live Input with the name "Integrated Webcam-2" is recorded and saved with the file name
"001.m2v" under the path "C:\coolux\content\recordings". "HD 1280x720" is used as the Encoder
Setting. The total length of the file is 00:05:22:12 (hh:mm:ss:ff). Afterwards the recorded file is added
to the Pandoras Box project automatically.
With this command the timecode can also be stored and recalled using a string variable .

ResourceRecordLiveInputStart

ResourceRecordLiveInputStart(InputName,FileName,Preset)

Example:
ResourceRecordLiveInputStart("Integrated Webcam-2","C:\coolux\content\recordings\001","HD
1280x720",00,05,22,12)

This starts to record a Live Input using the Video Recording  feature in the Pandoras Box project.
The feature is limited to some Pandoras Box products .
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The Live Input with the name "Integrated Webcam-2" is recorded and saved with the file name
"001.m2v" under the path "C:\coolux\content\recordings". "HD 1280x720" is used as the Encoder
Setting. The total length of the file depends on when the recording is stopped again. Afterwards the
recorded file is added to the Pandoras Box project automatically.

ResourceRecordLiveInputStop

ResourceRecordLiveInputStop

Example:
ResourceRecordLiveInputStop

This stops to record a Live Input using the Video Recording  feature in the Pandoras Box project.

ResourceReloadMedia

ResourceReloadMedia(FolderID,FileID)

Example:
ResourceReloadMedia(2,5)

Reloads the media file with the Folder and File ID [2,5] in the Pandoras Box project. In PB, this
option can be found in the File Inspector .

ResourceReloadMesh

ResourceReloadMesh(FolderID,FileID)

Example:
ResourceReloadMesh(3,9)

Reloads the mesh file with the Folder and File ID [3,9] in the Pandoras Box project. In PB, this option
can be found in the File Inspector .

ResourceRemove

ResourceRemove(Name)

Example:
ResourceRemove("Image.png")

This removes the file "Image.png" from your Pandoras Box project. It does not matter whether the file
is in the main folder or a subfolder but if there is more than one file in the project that holds this
name, the first file is deleted.

ResourceRemoveAll

ResourceRemoveAll

Example:
ResourceRemoveAll
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This removes all files from your Pandoras Box project.
In some WD versions it is necessary to declare whether folders should be deleted too. Whilst the
command with an attached "true" (i.e. ResourceRemoveAll,true ) deletes all files PLUS the

folder structure the command ResourceRemoveAll,false deletes only single files but leaves all

folders.

ResourceRemoveFolder

ResourceRemoveFolder(ProjectPath\)

Example:
ResourceRemoveFolder("Videos\Background")

This removes the sub folder "Background" from the folder "Videos" in the Pandoras Box Project tab.

ResourceRemoveInconsistent

ResourceRemoveInconsistent

Example:
ResourceRemoveInconsistent

Removes all inconsistent files from the Pandoras Box Master system. In PB, this option can be found
in the Folder Inspector .

ResourceRemoveMedia

ResourceRemoveMedia(FolderID,FileID)

Example:
ResourceRemoveMedia(2,5)

Removes the media file with the Folder and File ID [2,5] from the PB project.

ResourceRemoveMesh

ResourceRemoveMesh(FolderID,FileID)

Example:
ResourceRemoveMesh(3,9)

Removes the mesh file with the Folder and File ID [3,9] from the Pandoras Box Project Tab .

ResourceResize

ResourceResize(FilePath,Width,Height)

Example:
ResourceResize("C:\coolux\content\image2.png",256,256)
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This command does not necessarily apply to a Pandoras Box project. It simply resizes an image
(here: the file named "image2.png" saved under the path "C:\coolux\content") on the hard drive and
saves it under the same name but with the different size. The image from the example would have a
new height and width of 256 pixels. If the image is part of a Pandoras Box project it then needs to be
reloaded to read-out the new size. The reload happens automatically with the default options and a
Revision 9088 or higher. When using an older revision, please reload the file manually, e.g. by using
the File Inspector  or reloading the project.

ResourceSetAlphaChannel

ResourceSetAlphaChannel(FolderID,FileID,State)(True or False)

Example:
ResourceSetAlphaChannel(2,5,False)

Disables the alpha channel of the media file with the Folder and File ID [2,5] in the File Inspector
in Pandoras Box.

Use "true" if movie type supports embedded alpha.

ResourceSetAnisotropicFiltering

ResourceSetAnisotropicFiltering(FolderID,FileID,State)(True or False)

Example:
ResourceSetAnisotropicFiltering(2,5,False)

Deactivates anisotropic filtering (pixel smoothing for real-time video and image scaling) for the media
file with the Folder and File ID [2,5] in the File Inspector  in Pandoras Box.

ResourceSetDeinterlacing

ResourceSetDeinterlacing(FolderID,FileID,State)(0,1,2,3)

Example:
ResourceSetDeinterlacing(2,5,3)

Activates the deinterlacing mode "fieldblending" for the media file with the Folder and File ID [2,5] in
the File Inspector  in Pandoras Box.

Deinterlacing Modes:
0 = Off
1 = Top Field
2 = Bottom Field
3 = Fieldblending

ResourceSetFrameBlending

ResourceSetFrameBlending(FolderID,FileID,State)(True or False)

Example:
ResourceSetFrameBlending(2,5,True)
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Activates frameblending for the media file with the Folder and File ID [2,5] in the File Inspector  in
Pandoras Box. Choose this option for slow motion or smooth motion frame-adaptive frameblending
and framerate conversion.

ResourceSetID

ResourceSetID(ProjectPath,FolderID,FileID)

Example:
ResourceSetID("backgrounds\images",5,1)

This applies to the subfolder "images" in the subfolder "background" within the Pandoras Box project
folder. All files included in the subfolder are assigned consecutively with a Folder and File ID starting
from 5,1.
If you like to a assign a Folder/File ID to a single file instead of an entire folder, specify "ProjectPath"
as "backgrounds\images\image1.png".

ResourceSetMpegColourSpace

ResourceSetMpegColourSpace(FolderID,FileID,State)(True or False)

Example:
ResourceSetMpegColourSpace(2,5,True)

Enables the optimization of MPEG Colorspace for the media file with the Folder and File ID [2,5] in
the File Inspector  in Pandoras Box.

ResourceSetText

ResourceSetText(FolderID,FileID,Text)

Example:
ResourceSetText(2,9,"design")

Sets the text of text asset [2,9] in PB to "design".

ResourceSetTextCentered

ResourceSetTextCentered(FolderID,FileID )

Example:
ResourceSetTextCentered(1,2)

Centers the text of text asset [1,2] in PB on its texture.
This command is available from PB Rev. 4982 or higher.

ResourceSetTextFullSize

ResourceSetTextFullSize(FolderID,FileID )
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Example:
ResourceSetTextFullSize(1,2)

Removes the center-option of the text asset [1,2] in PB.
This command is available from PB Rev. 4982 or higher.

ResourceSetTextSize

ResourceSetTextSize(FolderID,FileID,Width,Height )

Example:
ResourceSetTextSize(1,2,800,600)

Sets the texture size of text asset [1,2] in PB to 800x600 px.
This command is available from PB Rev. 4982 or higher.

ResourceSetTextStyle

ResourceSetTextStyle(FolderID,FileID,Font,Size,Style,Alignment,Red,Green,Blue )

Example:
ResourceSetTextStyle(1,2,"Times New Roman",24,"Bold","Left",255,0,0)

Sets the Text Asset [1,2] to the following properties:
Font: Time New Roman, Font Size: 24, Font Style: Bold, Alignment: Left, Color: Red.

This command is available from PB Rev. 4982 or higher.

Style options: Regular, Bold, Italic, BoldItalic, Underline.
Alignment options: Left, Center, Right.

ResourceSetTextUnicode

ResourceSetTextUnicode(FolderID,FileID,Text)

Example:
ResourceSetTextUnicode(1,2,"?a?? µ??a")

Sets the text of text asset [1,2] in PB to "?a?? µ??a". 
Using this unicode-command, text strings in any language format can be sent to PB.

ResourceSetUnderscan

ResourceSetUnderscan(FolderID,FileID,State)(True or False)

Example:
ResourceSetUnderscan(2,5,True)

Enables Underscan for the media file with the Folder and File ID [2,5] in the File Inspector  in
Pandoras Box.

ResourceSpreadAll
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ResourceSpreadAll

Example:
ResourceSpreadAll

Spreads all resources in PB.

ResourceSpreadMedia

ResourceSpreadMedia(FolderID,FileID)

Example:
ResourceSpreadMedia(2,10)

Spreads the media file with the Folder and File ID [2,10] in PB.

ResourceSpreadMesh

ResourceSpreadMesh(FolderID,FileID)

Example:
ResourceSpreadMesh(3,7)

Spreads the mesh file with the Folder and File ID [3,7] in PB.

S S

SeqAddPauseCue

SeqAddPauseCue(SeqID,CueID,HH,MM,SS,FF,Name)

Example:
SeqAddPauseCue(1,2,00,01,22,15,"Scene4")

A Pause Cue with the ID 2 will be added in Sequence 1 at the timecode 00:01:22:15. It will be named
“Scene4.

SeqAddPauseCueF

SeqAddPauseCueF(SeqID,CueID,HH:MM:SS:FF,Name)

Example:
SeqAddPauseCueF(1,2,"00:01:22:15","Scene4")

A Pause Cue with the ID 2 will be added in Sequence 1 at the timecode 00:01:22:15. It will be named
“Scene4.
With this command, the timecode can also be stored and recalled using a string variable .

SeqAddPlayCue

SeqAddPlayCue(SeqID,CueID,HH,MM,SS,FF,Name)
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Example:
SeqAddPlayCue(1,5,00,01,22,15,"Scene3")

A Play Cue with the ID 5 will be added in Sequence 1 at the timecode 00:01:22:15. It will be named
“Scene3”.

SeqAddPlayCueF

SeqAddPlayCueF(SeqID,CueID,HH:MM:SS:FF,Name)

Example:
SeqAddPlayCueF(1,5,"00:01:22:15","Scene3")

A Play Cue with the ID 5 will be added in Sequence 1 at the timecode 00:01:22:15. It will be named
“Scene3”.
With this command, the timecode can also be stored and recalled using a string variable .

SeqContentAtTime

SeqContentAtTime(SiteID,DevID,SeqID,HH,MM,SS,FF,FolderID,FileID)

Example:
SeqContentAtTime(1,3,1,00,05,22,12,1,1)

If a clip container exists at timecode 00:05:22:12 in Sequence 1, the content inside this clip container
will get exchanged by the content with the Folder and File ID 1,1 and it also will be re-synced.

SeqContentAtTimeF

SeqContentAtTimeF(SiteID,DevID,SeqID,HH:MM:SS:FF,FolderID,FileID)

Example:
SeqContentAtTimeF(1,3,1,"00:05:22:12",1,1)

If a clip container exists at timecode 00:05:22:12 in Sequence 1, the content inside this clip container
will get exchanged by the content with the Folder and File ID 1,1 and it also will be re-synced.
The timecode can also be stored and recalled using a string variable .

SeqContentReplaceAtTime

SeqContentReplaceAtTime(Site,Device,SeqID,HH,MM,SS,FF,FolderID,FileID)

Example:
SeqContentReplaceAtTime(1,3,2,00,05,22,12,4,6)

This applies to layer 3 of Site 1 (e.g. a Server) in your Pandoras Box project. The container in
Sequence 2 at timecode 00:05:22:12 (hh,mm,ss,ff) is filled with the media file that holds the Folder
and File ID 4,6. Please note, that this command requires an existing container whereto it can drop
the media file.

SeqContentReplaceAtTimeByPath
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SeqContentReplaceAtTimeByPath(Site,Device,SeqID,HH,MM,SS,FF,ProjectPath)

Example:
SeqContentReplaceAtTimeByPath(2,1,1,00,05,22,12,"Testpattern/Calibrate.png")

This applies to layer 3 of Site 1 (e.g. a Server) in your Pandoras Box project. The container in
Sequence 2 at timecode 00:05:22:12 (hh,mm,ss,ff) is filled with the media file "Calibrate.png" from
the subfolder "Testpattern" within the project folder. 

If there is more than one file in the subfolder that holds this name, the first file is taken. If the file is
not in a special subfolder, simply use "Calibrate.png". Please note that "ProjectPath" is case-
sensitive and that this command requires an existing container whereto it can drop the media file.

SeqContentReplaceAtTimeByPathF

SeqContentReplaceAtTimeByPathF(Site,Device,SeqID,HH:MM:SS:FF,ProjectPath)

Example:
SeqContentReplaceAtTimeByPathF(2,1,1,"00:05:22:12","Testpattern/Calibrate.png")

This applies to layer 3 of Site 1 (e.g. a Server) in your Pandoras Box project. The container in
Sequence 2 at timecode 00:05:22:12 (hh:mm:ss:ff) is filled with the media file "Calibrate.png" from
the subfolder "Testpattern" within the project folder. 

If there is more than one file in the subfolder that holds this name, the first file is taken. If the file is
not in a special subfolder, simply use "Calibrate.png". Please note that "ProjectPath" is case-
sensitive and that this command requires an existing container whereto it can drop the media file.
The timecode can also be stored and recalled using a string variable .

SeqContentReplaceAtTimeF

SeqContentReplaceAtTimeF(Site,Device,SeqID,HH:MM:SS:FF,FolderID,FileID)

Example:
SeqContentReplaceAtTimeF(1,3,2,"00:05:22:12",4,6)

This applies to layer 3 of Site 1 (e.g. a Server) in your Pandoras Box project. The container in
Sequence 2 at timecode 00:05:22:12 (hh:mm:ss:ff) is filled with the media file that holds the Folder
and File ID 4,6. Please note, that this command requires an existing container whereto it can drop
the media file.
The timecode can also be stored and recalled using a string variable .

SeqDeleteAllCues

SeqDeleteAllCues(SeqID)

Example:
SeqDeleteAllCues(1)

All Cues in Sequence 1 will be deleted.

SeqDeleteCue
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SeqDeleteCue(SeqID,CueID)

Example:
SeqDeleteCue(1,4)

Cue 4 in Sequence 1 will be deleted.

SeqEdit

SeqEdit(ID)

Example:
SeqEdit(2)

This command toggles Sequence with ID 2 into the Sequence tab of Pandoras Box so that it is
visible and editable.

SeqGotoCue

SeqGotoCue(SeqID,CueID)

Example:
SeqGotoCue(2,3)

Sets the nowpointer of sequence 2 to the third cue.

SeqLastCue

SeqLastCue(SeqID)

Example:
SeqLastCue(1)

Sets the nowpointer of sequence 1 to the last cue.

SeqLastFrame

SeqLastFrame(SeqID)

Example:
SeqLastFrame(2)

Sets the nowpointer of sequence 2 to the last frame. 

SeqNextCue

SeqNextCue(SeqID)

Example:
SeqNextCue(1)

Sets the nowpointer of sequence 1 to the next cue.
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SeqNextFrame

SeqNextFrame(SeqID)

Example:
SeqNextFrame(2)

Sets the nowpointer of sequence 2 to the next frame ahead.

SeqResetJumps

SeqResetJumps(SeqID,CueID)

Example:
SeqResetJumps(2,3)

This applies to Sequence 2 in Pandoras Box. The "Repeat Count" of the Cue with ID 3 is reset to the
value it was programmed with. In PB, this can be done in the Cue Inspector .

SeqSetCueJumpCount

SeqSetCueJumpCount(SeqID,CueID,Count)

Example:
SeqSetCueJumpCount(2,3,5)

This applies to Sequence 2 in Pandoras Box. The "Repeat Count" of the Cue with ID 3 is set to 5. In
PB, this can be done in the Cue Inspector .

SeqSetCueJumpTargetTime

SeqSetCueJumpTargetTime(SeqID,CueID,HH,MM,SS,FF)

Example:
SeqSetCueJumpTargetTime(2,3,00,05,22,12)

This applies to Sequence 2 in Pandoras Box. The "Jump Target" of the Cue with ID 3 is set to
00:05:22:12 (hh:mm:ss:ff). Please note that the Cue must be a Jump Cue. In PB, this can be done in
the Cue Inspector .

SeqSetCueJumpTargetTimeF

SeqSetCueJumpTargetTimeF(SeqID,CueID,HH:MM:SS:FF)

Example:
SeqSetCueJumpTargetTimeF(2,3,"00:05:22:12")

This applies to Sequence 2 in Pandoras Box. The "Jump Target" of the Cue with ID 3 is set to
00:05:22:12 (hh:mm:ss:ff). In PB, this can be done in the Cue Inspector .
The timecode can also be stored and recalled using a string variable . Please note that the Cue
must be a Jump Cue.

205
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SeqSetCueName

SeqSetCueName(SeqID,CueID,Name1)

Example:
SeqSetCueName(1,3,"Scene4")

This renames the Cue 3 of Sequence 1 in Pandoras Box to "Scene4". In PB, this can be done in the 
Cue Inspector .

SeqSetCuePlayMode

SeqSetCuePlayMode(SeqID,CueID,Play/Pause/Stop/Jump/Wait)

Example:
SeqSetCuePlayMode(1,17,"Pause")

Sets the play mode of cue 17 in Sequence 1 to “Pause”. 
The following cue play modes are available: Play, Pause, Stop, Jump and Wait.

SeqSetCueWaitTime

SeqSetCueWaitTime(SeqID,CueID,HH,MM,SS,FF)

Example:
SeqSetCueWaitTime(2,3,00,05,22,12)

This applies to Sequence 2 in Pandoras Box. The "Wait Time" of the Cue with ID 3 is set to
00:05:22:12 (hh:mm:ss:ff). In PB, this can be done in the Cue Inspector .

SeqSetCueWaitTimeF

SeqSetCueWaitTimeF(SeqID,CueID,HH:MM:SS:FF)

Example:
SeqSetCueWaitTimeF(2,3,"00:05:22:12")

This applies to Sequence 2 in Pandoras Box. The "Wait Time" of the Cue with ID 3 is set to
00:05:22:12 (hh:mm:ss:ff). The timecode can also be stored and recalled using a string variable .
In PB, this can be done in the Cue Inspector .

SeqSetDoNotIgnoreNextCue

SeqSetDoNotIgnoreNextCue(SeqID)

Example:
SeqSetDoNotIgnoreNextCue(1)

The next cue in Sequence 1 will not be ignored .

SeqSetIgnoreNextCue
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SeqSetIgnoreNextCue(SeqID)

Example:
SeqSetIgnoreNextCue(1)

The next cue in Sequence 1 will be ignored (cue turns orange).

SeqSetNextCuePlayMode

SeqSetNextCuePlayMode(SeqID,Play/Pause/Stop/Jump/Wait)

Example:
SeqSetNextCuePlayMode(1,"Pause")

Sets the play mode of the next cue in Sequence 1 to “Pause”.
The following cue play modes are available: Play, Pause, Stop, Jump and Wait.

SeqSetState

SeqSetState(SeqID,"Play"/"Pause"/"Stop")

Example:
SeqSetState(2,"Play")

Sets sequence 2 to Play.

Example 2:
SeqSetState(2,"Pause")
Sets sequence 2 to Pause. 

Example 3:
SeqSetState(2,"Stop")
Sets sequence 2 to Stop.

SeqSetTimecode

SeqSetTimecode(SeqID,HH,MM,SS,FF)

Example:
SeqSetTimecode(2,00,05,22,12)

Sets sequence 2 within the Pandoras Box project to the timecode 00:05:22:12 (hh:mm:ss:ff)

SeqSetTimecodeF

SeqSetTimecodeF(SeqID,HH:MM:SS:FF)

Example:
SeqSetTimecodeF(2,"00:05:22:12")

Sets sequence 2 within the Pandoras Box project to the timecode 00:05:22:12 (hh:mm:ss:ff). With
this command the timecode can also be stored and recalled using a string variable .1638
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SeqSetTimecodeMode

SeqSetTimecodeMode(SeqID,"None"/"Send"/"Receive")

Example:
SeqSetTimecodeMode(2,"None")

Sets the timecode mode of sequence 2 in Pandoras Box to "None". In PB, this can be done in the 
Sequence Inspector .

Example 2:
SeqSetTimecodeMode(2,"Send")
Sets the timecode mode of sequence 2 to "Send".

Example 3:
SeqSetTimecodeMode(2,"Receive")
Sets the timecode mode of sequence 2 in Pandoras Box to "Receive". In PB, this can be done in the 
Sequence Inspector .

SeqSetTimecodeOffset

SeqSetTimecodeOffset(SeqID,HH,MM,SS,FF)

Example:
SeqSetTimecodeOffset(2,00,05,22,12)

Sets an offset of 00:05:22:12 (hh:mm:ss:ff) to the timecode of sequence 2.

SeqSetTimecodeOffsetF

SeqSetTimecodeOffsetF(SeqID,HH:MM:SS:FF)

Example:
SeqSetTimecodeOffsetF(2,"00:05:22:12")

Sets an offset of 00:05:22:12 (hh:mm:ss:ff) to the timecode of sequence 2. The timecode can also be
stored and recalled using a string variable .

SeqSetTimecodeRelative

SeqSetTimecodeRelative(SeqID,HH,MM,SS,FF)

Example:
SeqSetTimecodeRelative(2,00,05,22,12)
SeqSetTimecodeRelative(2,00,-05,-22,-12)

Adds an time interval of 00:05:22:12 (hh:mm:ss:ff) to the timecode of sequence 2 within the Pandoras
Box project. If the timecode was at 00:01:02:03, it is now at 00:06:24:15.

The second example subtracts the same time interval again. The command is the same but in front of
each time value there is a minus (-) symbol.

SeqSetTimecodeRelativeF
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SeqSetTimecodeRelativeF(SeqID,HH:MM:SS:FF)

Example:
SeqSetTimecodeRelativeF(2,"00:05:22:12")
SeqSetTimecodeRelativeF(2,00:-05:-22:-12)

Adds an time interval of 00:05:22:12 (hh:mm:ss:ff) to the timecode of sequence 2 within the Pandoras
Box project. If the timecode was at 00:01:02:03, it is now at 00:06:24:15.

The second example subtracts the same time interval again. The command is the same but in front of
each time value there is a minus (-) symbol.

With this command the timecode can also be stored and recalled using a string variable .

SeqSetTimecodeStopAction

SeqSetTimecodeStopAction(SeqID,"Stop"/"Pause"/"Continue")

Example:
SeqSetTimecodeStopAction(1,"Stop")

Stops sequence 1 in Pandoras Box if the incoming timecode stops. In PB, this can be done in the 
Sequence Inspector .

Example 2:
SeqSetTimecodeStopAction(1,"Pause")
Pauses sequence 1 in Pandoras Box if the incoming timecode stops. In PB, this can be done in the 
Sequence Inspector .

Example 3:
SeqSetTimecodeStopAction(1,"Continue")
Sequence 1 in Pandoras Box will continue playing if the incoming timecode stops. In PB, this can be
done in the Sequence Inspector .

SeqStoreActive

SeqStoreActive(SeqID)

Example:
SeqStoreActive(2)

Stores all active parameters in Pandoras Box to sequence 2.

SeqStoreActiveDevice

SeqStoreActiveDevice(SeqID,SiteID,DeviceID)

Example:
SeqStoreActiveDevice(1,2,4)

Stores all active parameters of layer 4 of site 2 in Pandoras Box to sequence 1 to the position of the
nowpointer.

SeqStoreActiveParameter
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SeqStoreActiveParameter(SeqID,SiteID,DeviceID,Parameter)

Example:
SeqStoreActiveParameter(1,2,5,"Opacity")

Stores all active "Opacity" parameters of layer 4 of site 2 in Pandoras Box to sequence 1 to the
position of the nowpointer.

SeqStoreActiveSite

SeqStoreActiveSite(SeqID,SiteID)

Example:
SeqStoreActiveSite(2,1)

Stores all active parameters of site 1 in Pandoras Box to sequence 2 to the position of the
nowpointer.

SeqStoreActiveToTime

SeqStoreActiveToTime(SeqID,HH,MM,SS,FF)

Example:
SeqStoreActiveToTime(2,00,05,22,12)

Stores all active parameters in Pandoras Box to sequence 2 at timecode 00:05:22:12 (hh,mm,ss,ff).

SeqStoreActiveToTimeF

SeqStoreActiveToTimeF(SeqID,HH:MM:SS:FF)

Example:
SeqStoreActiveToTimeF(2,"00:05:22:12")

Stores all active parameters in Pandoras Box to sequence 2 at timecode 00:05:22:12 (hh,mm,ss,ff).
The timecode can also be stored and recalled using a string variable .

SetExcelCellValue

SetExcelCellValue(File,Table,Cell,Value)

Example:
SetExcelCellValue("C:\Data\excel.xls","Sheet1","C7",42)

Sets the value of Excel document “excel.xls”, table “Sheet1”, cell C7 to 42.

Note: The document has to be an “.xls”-file and has to be closed during function call. If it is opened, a
Windows dialog will open and propose to save a copy of the file.

SetPBPlaylistAllItemsDurationByID

SetPBPlaylistAllItemsDurationByID(Folder,File,HH,MM,SS,FF)

1638
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Example:
SetPBPlaylistAllItemsDurationByID(2,1,00,05,22,12)

This sets the duration of all items of the Pandoras Box playlist  with the folder and file ID [2,1] to
00:05:22:12 (hh:mm:ss:ff).

SetPBPlaylistAllItemsDurationByIDF

SetPBPlaylistAllItemsDurationByIDF(Folder,File,HH:MM:SS:FF)

Example:
SetPBPlaylistAllItemsDurationByIDF(2,1,"00:05:22:12")

This sets the duration of all items of the Pandoras Box playlist  with the folder and file ID [2,1] to
00:05:22:12 (hh:mm:ss:ff). With this command, the timecode can also be stored and recalled using
a string variable .

SetPBPlaylistItemDurationByID

SetPBPlaylistItemDurationByID(Folder,File,ItemID,HH,MM,SS,FF)

Example:
SetPBPlaylistItemDurationByID(2,1,8,00,05,22,12)

This sets the duration of the item with index 7(!) of the Pandoras Box playlist  with the folder and
file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff). Note that ItemID 0 refers to the PB index 1!

SetPBPlaylistItemDurationByIDF

SetPBPlaylistItemDurationByIDF(Folder,File,ItemID,HH:MM:SS:FF)

Example:
SetPBPlaylistItemDurationByIDF(2,1,8,"00:05:22:12")

This sets the duration of the item with index 7(!) of the Pandoras Box playlist  with the folder and
file ID [2,1] to 00:05:22:12 (hh:mm:ss:ff). Note that ItemID 0 refers to the PB index 1!
With this command, the timecode can also be stored and recalled using a string variable .

ShareLayerTexture

ShareLayerTexture(SiteID,SourceDevice,TargetDevice)

Example:
ShareLayerTexture(3,1,2)

This shares the texture from Layer 1 of Site 3 with Layer 2. Note that Texture Sharing is only
available for PB Servers.

ShareLayerTextureByName

ShareLayerTextureByName(SiteID,SourceDevice,TargetDevice,TargetParam)
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Example:
ShareLayerTextureByName(3,1,2,"Quad Media Overlay|Media1")

This shares the texture from Layer 1 of Site 3 with Layer 2, but not as the main media but the first
media of the effect named "Quad Media Overlay". Note that Texture Sharing is only available for PB
Servers.

Please note that "TargetParam" is case-sensitive and consists of the name of the effect  followed
by the character pipe (vertical bar) and the name of the media field (in most cases simply "Media").

ShowEnvironmentVariables

ShowEnvironmentVariables

Example:
ShowEnvironmentVariables

Opens a dialog showing the current Windows environment variables, to ease remote debugging for
example.

More information can be found under:
https://en.wikipedia.org/wiki/Environment_variable 
http://www.7tutorials.com/simple-questions-what-are-environment-variables 

SiteAcceptDmxById

SiteAcceptDmxById(SiteID,"On"/"Off")

Example:
SiteAcceptDmxById(2,"On")

Patches Site 2 in the Patch tab  so that it can be controlled via an attached DMX / Art-Net device.

Example 2:
SiteAcceptDmxById(2,"Off")

Unpatches Site 2 in the Patch tab  so that it cannot be controlled via an attached DMX / Art-Net
device anymore.

Please note:
Art-Net Input needs to be enabled in Configuration Tab  in order to remote control the Site via Art-
Net.

To change the Devices DMX / Art-Net start address (Channel, Art-Net Subnet and Universe) use
either the Patch Tab in PB or the WD command DeviceSetDmxAddress .

SMPTELinkModeNone

SMPTELinkModeNone

Example:
SMPTELinkModeNone

Sets the SMPTE Link Mode in the Connection Manager  to "None".

353
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SMPTELinkModeReceive

SMPTELinkModeReceive

Example:
SMPTELinkModeReceive

Sets the SMPTE Link Mode in the Connection Manager  to "Receive".

SMPTELinkModeSend

SMPTELinkModeSend

Example:
SMPTELinkModeSend

Sets the SMPTE Link Mode in the Connection Manager  to "Send".

SMPTELinkReConnect

SMPTELinkReConnect

Example:
SMPTELinkReConnect

This re-connects your SMPTE Link connection in the Connection Manager .

SMPTELinkSet

SMPTELinkSet(00:00:00:00)

Example:
SMPTELinkSet("00:01:50:10")

Sets the SMPTE Link (which is enabled in the Connection Manager)  to timecode 00:01:50:10
(hh:mm:ss:ff).

SMSClearList

SMSClearList

Example:
SMSClearList

Clears the SMS list within the SMS Settings Tool .

SMSSend

SMSSend(PhoneNumber,Message)
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Example:
SMSSend(00492211306540,"Test")

Sends an SMS with the message "Test" to the phone number "00492211306540".

Setup your GSM modem in the SMS Settings Tool  first to be able to receive and send SMS via
the Widget Designer.

SMSSendDisable

SMSSendDisable

Example:
SMSSendDisable

When this command is executed, no SMS will be send out. Use the script SMSSendEnable to
enable this function again.

Setup your GSM modem in the SMS Settings Tool  first to be able to receive and send SMS via
the Widget Designer.

SMSSendEnable

SMSSendEnable

Example:
SMSSendEnable

Enables the SMSSend function after it was disabled.

Setup your GSM modem in the SMS Settings Tool  first to be able to receive and send SMS via
the Widget Designer.

SpareFromSpread

SpareFromSpread(SiteID)

Example:
SpareFromSpread(2)

This activates the option "Spare from Spread" for Site ID 2 in Pandoras Box. The option can be found
in the Device Inspector  .

StopSound

StopSound

Example:
StopSound 

Stops the currently playing sound that was started via the command PlaySound,Filename . 

SystemLock
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SystemLock

Example:
SystemLock

This locks the system. You will see the screen were Windows asks for your password to unlock the
system again.

SystemLogOff

SystemLogOff

Example:
SystemLogOff

Logs off the user of the local WD computer in a way that you do not have to confirm it.

SystemReboot

SystemReboot

Example:
SystemReboot

Reboots the local WD computer in a way that you do not have to confirm it.

SystemShutdown

SystemShutdown

Example:
SystemShutdown

Shuts down the local WD computer in a way that you do not have to confirm it.

SystemVolume

SystemVolume(0-100)

Example:
SystemVolume(50)

Sets the System Volume to 50%.

T T

TCPClearBuffer

TCPClearBuffer(ID)
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Example:
TCPClearBuffer(1)

Clears the buffer from the TCP Connection with ID 1 from the Connection Manager 

TCPInject

TCPInject(ID,Message)

Example:
TCPInject(1,"Play")

Injects the message "Play" directly into the stream of the TCP Connection with ID 1, without waiting
for other messages or packages to be finished.

The TCP Connection needs to be defined first in the Connection Manager .

Incoming or outgoing values in TCP-, UDP- and COM Port nodes can be entered as string, decimal or
hexadecimal values as explained in the chapter Syntax TCP-/UDP-/Serial Messages .

Example:
 Use [d13] to enter a carriage return as a decimal value.
 Use [h0D] to enter a carriage return as a hexadecimal value.
 Use [CR] to enter a carriage return as a ASCII symbol.

For two commands - e.g. a carriage return and a line feed - you may use this syntax: [d13 d10]
respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example String[CR d10].

TCPSend

TCPSend(ID,Message)

Example:
TCPSend(1,"Play")

Sends the ASCII message "Play" via the TCP Connection with the ID 1 in the Connection Manager
.

Incoming or outgoing values in TCP-, UDP- and COM Port nodes can be entered as string, decimal or
hexadecimal values as explained in the chapter Syntax TCP-/UDP-/Serial Messages .

Use [d13] to enter a carriage return as a decimal value.
Use [h0D] to enter a carriage return as a hexadecimal value.
Use [CR] to enter a carriage return as a ASCII symbol.

For two commands - e.g. a carriage return and a line feed - you may use this syntax: [d13 d10]
respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example String[CR d10].

TCPSendDec

TCPSendDec(ID,Message)

Example:
TCPSendDec(1,"72 105 33")

1239
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Sends the message "Hi!" in decimal values via the TCP Connection with the ID 1 in the Connection
Manager .

See the chapter Syntax TCP-/UDP-/Serial Messages .

TCPSendHex

TCPSendHex(ID,Message)

Example:
TCPSendHex(1,"48 69 21")

Sends the message "Hi!" in hexadecimal values via the TCP Connection with the ID 1 in the 
Connection Manager .

See the chapter Syntax TCP-/UDP-/Serial Messages .

TCPSendToIP

TCPSendToIP(ID,IP,Message)

Example:
TCPSendToIP(1,"192.168.1.38","Play")

Sends the message “Play” via the TCP Connection with ID 1 from the Connection Manager to IP
address 192.168.1.38.

Incoming or outgoing values in TCP-, UDP- and COM Port nodes can be entered as string, decimal or
hexadecimal values as explained in the chapter Syntax TCP-/UDP-/Serial Messages .

Example:
 Use [d13] to enter a carriage return as a decimal value.
 Use [h0D] to enter a carriage return as a hexadecimal value.
 Use [CR] to enter a carriage return as a ASCII symbol.

For two commands - e.g. a carriage return and a line feed - you may use this syntax: [d13 d10]
respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example String[CR d10].

TCPStart

TCPStart(ID)

Example:
TCPStart(1)

Starts the TCP Connection with the ID 1 in the Connection Manager .

TCPStartAll

TCPStartAll

Example:
TCPStartAll
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Starts all TCP Connections in the Connection Manager .

TCPStop

TCPStop(ID)

Example:
TCPStop(1)

Stops the TCP Connection with the ID 1 in the Connection Manager .

TCPStopAll

TCPStopAll

Example:
TCPStopAll

Stops all TCP Connections in the Connection Manager .

ToggleFullScreen

ToggleFullScreen(SiteID)

Example:
ToggleFullScreen(4)

Switches the site 4 from windowed to fullscreen mode in Pandoras Box project.

U U

UDPClearBuffer

UDPClearBuffer(ID)

Example:
UDPClearBuffer(1)

Clears the buffer from the UDP Connection with ID 1 from the Connection Manager 

UDPInject

UDPInject(ID,Message)

Example:
UDPInject(1,"Play")

Injects the message "Play" directly into the stream of the UDP Connection with ID 1, without waiting
for other messages or packages to be finished.

The UDP Connection needs to be defined first in the Connection Manager .

1239
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Incoming or outgoing values in TCP-, UDP- and COM Port nodes can be entered as string, decimal or
hexadecimal values as explained in the chapter Syntax TCP-/UDP-/Serial Messages .

Example:
 Use [d13] to enter a carriage return as a decimal value.
 Use [h0D] to enter a carriage return as a hexadecimal value.
 Use [CR] to enter a carriage return as a ASCII symbol.

For two commands - e.g. a carriage return and a line feed - you may use this syntax: [d13 d10]
respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example String[CR d10].

UDPSend

UDPSend(ID,Message)

Example:
UDPSend(1,"Play")

Sends the message "Play" via the UDP Connection with the ID 1 in the Connection Manager .

Incoming or outgoing values in TCP-, UDP- and COM Port nodes can be entered as string, decimal or
hexadecimal values as explained in the chapter Syntax TCP-/UDP-/Serial Messages .

Use [d13] to enter a carriage return as a decimal value.
Use [h0D] to enter a carriage return as a hexadecimal value.
Use [CR] to enter a carriage return as a ASCII symbol.

For two commands - e.g. a carriage return and a line feed - you may use this syntax: [d13 d10]
respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example String[CR d10].

UDPSendDec

UDPSendDec(ID,Message)

Example:
UDPSendDec(1,"Play")

Sends the message "Play" in decimal values via the UDP Connection with the ID 1 in the Connection
Manager .

See the chapter Syntax TCP-/UDP-/Serial Messages .

UDPSendHex

UDPSendHex(ID,Message)

Example:
UDPSendHex(1,"Play")

Sends the message "Play" in hexadecimal values via the UDP Connection with the ID 1 in the 
Connection Manager .

See the chapter Syntax TCP-/UDP-/Serial Messages .
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UDPSendToPort

UDPSendToPort(Port,Message)

Example:
UDPSendToPort(10000,"Play")

Sends the message “Play” to the port 10000 via an UDP Connection .

Incoming or outgoing values in TCP-, UDP- and COM Port nodes can be entered as string, decimal or
hexadecimal values as explained in the chapter Syntax TCP-/UDP-/Serial Messages .

Example:
 Use [d13] to enter a carriage return as a decimal value.
 Use [h0D] to enter a carriage return as a hexadecimal value.
 Use [CR] to enter a carriage return as a ASCII symbol.

For two commands - e.g. a carriage return and a line feed - you may use this syntax: [d13 d10]
respectively [h0D h0A] or [CR LF]. Mixed values are also possible, e.g: Example String[CR d10].

UDPStart

UDPStart(ID)

Example:
UDPStart(1)

Starts the UDP Connection with the ID 1 in the Connection Manager .

UDPStartAll

UDPStartAll

Example:
UDPStartAll

Starts all UDP Connections in the Connection Manager .

UDPStop

UDPStop(ID)

Example:
UDPStop(1)

Stops the UDP Connection with the ID 1 in the Connection Manager .

UDPStopAll

UDPStopAll
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Example:
UDPStopAll

Stops all UDP Connections in the Connection Manager .

V V

VAdd

VAdd(VarName,Var1,Var2)

Example:
VAdd("V_Add","Counter1","Counter2")

Adds the variable Counter1 and Counter2 and passes this Add result to the variable V_Add. 

To monitor all variables, their type and value, please refer to the Variable List .

Variable /= Value

Variable /= Value

Example:
varCounter /= 20

Divides the current value of the variable  “varCounter” with the value "20” and assigns the result to
the same variable "varCounter".

Variable -= Value

Variable -= Value

Example:
varCounter -=20

Subtracts the value "20” from the current value of the variable  “varCounter” and assigns the result
to the same variable "varCounter".

Variable += Value

Variable += Value

Example:
varCounter += 20

Adds the value "20” to the current value of the variable  “varCounter” and assigns the result to the
same variable "varCounter".

Variable *= Value

Variable *= Value
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Example:
varCounter *= 20

Multiplies the current value of the variable  “varCounter” with the value "20” and assigns the result
to the same variable "varCounter".

Variable = Value

Variable = Value

Example:
varCounter = 20

Applies the value “20” to the variable  “varCounter”.

VArrayAppend

VArrayAppend(VarName,Value)

Example:
VArrayAppend("var_List",99)

Adds 99 as an element at the end of the variable  “var_List” that was defined beforehand with the
List type. Note that the type of the sub element is automatically adjusted. 

VArrayGetFileNames

VArrayGetFileNames(VarName,Folder)

Example:
VArrayGetFileNames("var_List","C:\Videos")

Returns the names (including paths) of all files saved in the folder "Videos" to the variable
“var_List” that was defined beforehand with the List type. Note that the amount and type of the sub
elements are automatically adjusted.

For example, the variable (with separator "|") could return:
C:\Videos\1.m2v|C:\Videos\2.m2v|C:\Videos\3.m2v|

In case the specified folder is empty or includes only sub folders, the List is cleared.

VArrayGetFilePathsFromFileDialog

VArrayGetFilePathsFromFileDialog(VarName)

Example:
VArrayGetFilePathsFromFileDialog("var_StringArray")

Opens an explorer dialog for the user to select multiple files. By clicking “Open” the file paths are
written to the variable  array “var_List” that was defined beforehand.

VArrayGetFilePathsFromFileDialogWithPath

1638

1638

1638

1638

1638



1424

VArrayGetFilePathsFromFileDialogWithPath(Path,VarName)

Example:
VArrayGetFilePathsFromFileDialogWithPath("C:\Program Files\Christie,"var_List")

Opens an explorer dialog displaying the specified folder for the user to select multiple files. By
clicking “Open” the file paths are written to the variable  array “var_List” that was defined
beforehand.

VArrayGetListViewRow

VArrayGetListViewRow(Varname,ID,Row)

Example:
VArrayGetListViewRow("var_List",2,3)

Imports all values from row 3 of ListView  ID 2 to variable  array “var_List” that was defined
beforehand.

VArrayPrepend

VArrayPrepend(VarName,Value)

Example:
VArrayPrepend("var_List",99)

Adds 99 as an element at the beginning of the variable  “var_List” that was defined beforehand with
the List type. Note that the type of the sub element is automatically adjusted. 

VArrayRemoveFirst

VArrayRemoveFirst(VarName)

Example:
VArrayRemoveFirst("var_List")

Removes the first element of the variable  array “var_List” that was defined beforehand with the List
type.

VArrayRemoveLast

VArrayRemoveLast(VarName)

Example:
VArrayRemoveLast("var_List")

Removes the last element of the variable  array “var_List” that was defined beforehand with the List
type.

VArrayResize
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VArrayResize(VarName,Size)

Example:
VArrayResize("var_List",8)

Resizes the variable  array “var_List”, that was defined beforehand with the List type to 9 elements
and clears already existing data. Use the command VArrayResizePreserve if you like to keep

existing data.

Note: As indexing begins with 0 and ends here with 8, there are 9 reserved elements.

VArrayResizePreserve

VArrayResizePreserve(VarName,Size)

Example:
VArrayResizePreserve(VarName,Size)

Resizes the variable  array “var_List”, that was defined beforehand with the List type, to 9 elements
and preserves the already existing data. If the original array is larger than the resized one, the
redundant elements are deleted. If it is smaller, the missing elements are filled with empty spaces.

Note: As indexing begins with 0 and ends here with 8, there are 9 reserved elements.

VArrayReverse

VArrayReverse(VarName)

Example:
VArrayReverse("var_List")

Reverses the order of elements of the variable  array “var_List” that was defined beforehand with the
List type.

VArraySort

VArraySort(VarName)

Example:
VArraySort("var_List")

Sorts the elements of the variable  array “var_List” alphabetically, e.g. ,|.|1|9|a|A|z|Z

VDelete

VDelete(Name)

Example:
VDelete("City")

Deletes the variable  with the name “City”.
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VDeleteAll

VDeleteAll

Example:
VDeleteAll

Deletes all existing variables  inside WD.

VDivide

VDivide(VarName,Var1,Var2)

Example:
VDivide("V_Divide","Counter1","Counter2")

Divides the variable Counter1 by the variable Counter2 and passes this Divide result to the variable
V_Divide. 

To monitor all variables, their type and value, please refer to the Variable List .

VExecuteAsScript

VExecuteAsScript(VariableName)

Example:
VExecuteAsScript("var_String")

Executes the content of the string-type variable  “var_String” as a script.
E.g., if "var_String" has the following content, the variable "var_Count" increases one step
var_Count += 1
or
VAdd("var_Int",var_Int,1)

VFade

VFade(Variable,StartValue,EndValue,Time)

Example:
VFade("var_test",25,196,10)

Sets the variable  „var_test“ to the value 25 and fades it to 196 within 10 seconds. The variable
must be defined beforehand and with the type integer and double.

Note: The fade itself is not completely linear, it starts slowly, maintains its speed in the middle and
slows down again at the end!

VFadeTo

VFadeTo(Variable,Value,Time)
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Example:
VFadeTo("var_test",314,10)

Fades variable  „var_test“ to the value 314 within 10 seconds. The variable must be defined
beforehand and with the type integer and double.

Note: The fade itself is not completely linear, it starts slowly, maintains its speed in the middle and
slows down again at the end!

VGetArraySize

VGetArraySize(VarName,ArrName)

Example:
VGetArraySize("var_Count","var_List")

Returns the absolute number of elements of the variable  array “var_List” to the variable “var_Count”
that was defined beforehand with the Integer type. E.g. "var_List" = [1,2,3] -> "var_Count" = 3.

VGetArrayValue

VGetArrayValue(VarName,Index,ArrName)

Example:
VGetArrayValue(VarName,Index,ArrName)

Returns the value of the 8th element from the variable  array “var_List” to the variable “var_Value”.
Whilst "var_List" was defined with the List type, the type of "var_Value" needs to match the extracted
array data (Integer, String, etc.). 

Note: The index starts with 0 -> Index 7 matches the 8th element.

VGetAssetDurationHMSByID

VGetAssetDurationHMSByID(VarName,FolderID,FileID)

Example:
VGetAssetDurationHMSByID("var_String",1,3)

Returns the duration (in timecode format hh:mm:ss) of the media file with the Folder and File ID [1,3]
in the Pandoras Box Project Tab to the variable  “var_String” that was defined beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetAssetDurationHMSByPath

VGetAssetDurationHMSByPath(VarName,ProjectPath)

Example:
VGetAssetDurationHMSByPath("var_String","files\blue_lines.m2v")
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Returns the duration (in timecode format hh:mm:ss:ff ) of the media file “blue_lines.m2v”, located in
the folder “files” in the Pandoras Box Project Tab, to the variable  “var_String” that was defined
beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetAssetDurationTotalSecByID

VGetAssetDurationTotalSecByID(VarName,FolderID,FileID)

Example:
VGetAssetDurationTotalSecByID("var_Value",1,3)

Returns the duration (in seconds) of the media file with the Folder and File ID [1,3] in the Pandoras
Box Project Tab to the variable  “var_Value” that was defined beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetAssetDurationTotalSecByPath

VGetAssetDurationTotalSecByPath(VarName,ProjectPath)

Example:
VGetAssetDurationTotalSecByPath("var_Value","files\blue_lines.m2v")

Returns the duration (in seconds) of the media file “blue_lines.m2v”, located in the folder “files” in the
Pandoras Box Project Tab, to the variable  “var_Value” that was defined beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetAssetMediaHeightByID

VGetAssetMediaHeightByID(VarName,FolderID,FileID)

Example:
VGetAssetMediaHeightByID("var_Value",1,3)

Returns the height (in pixels) of the media file with the Folder and File ID [1,3] in the Pandoras Box
Project Tab to the variable  “var_Value” that was defined beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetAssetMediaHeightByName
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VGetAssetMediaHeightByName(VarName,AssetName)

Example:
VGetAssetMediaHeightByName("var_Value","files\blue_lines.m2v")

Returns the height (in pixels) of the media file “blue_lines.m2v”, located in the folder “files” in the
Pandoras Box Project Tab, to the variable  “var_Value” that was defined beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetAssetMediaWidthByID

VGetAssetMediaWidthByID(VarName,FolderID,FileID)

Example:
VGetAssetMediaWidthByID("var_Value",1,3)

Returns the width (in pixels) of the media file with the Folder and File ID [1,3] in the Pandoras Box
Project Tab to the variable  “var_Value” that was defined beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetAssetMediaWidthByName

VGetAssetMediaWidthByName(VarName,AssetName)

Example:
VGetAssetMediaWidthByName("var_Value","files\blue_lines.m2v")

Returns the width (in pixels) of the media file “blue_lines.m2v”, located in the folder “files” in the
Pandoras Box Project Tab, to the variable  “var_Value” that was defined beforehand.

Note: All VGetAsset... commands access cached information that is stored (and updated) through
the command PBProjectRefresh . Execute it once before running a VGetAsset command and any
time the project has changed.

VGetContainsText

VGetContainsText(VarName,SourceString,CompareString)

Example:
VGetContainsText("var_true","Hello World!","llo W")

Checks if the compare string ("llo W") matches with any string inside the source string ("Hello
World!") and returns “1” for a true argument and “0” for a false one through the variable  “var_true”
that was defined beforehand.

Note: This function is case-sensitive, space characters in front of any strings are not being counted.

VGetCSVFileColCount
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VGetCSVFileColCount(VarName,Filename,Separator)

Example:
VGetCSVFileColCount("var_Count","C:\Data\Matrix.csv",";")

Returns the amount of columns of the specified CSV file to the variable  “var_Count” that was
defined beforehand.

The separator can be any symbol except for the space character as WD does not recognize it as a
sole character for command arguments. Most programs like Microsoft Excel use the semicolon “;” by
default.

VGetCSVFileRowCount

VGetCSVFileRowCount(VarName,Filename)

Example:
VGetCSVFileRowCount("var_Count","C:\Data\Matrix.csv")

Returns the amount of rows of the specified CSV file to the variable  “var_Count” that was defined
beforehand.

VGetDeviceMediaFileID

VGetDeviceMediaFileID(VarName,SiteID,DeviceID)

Example:
VGetDeviceMediaFileID("var_Number",1,2)

Returns the File ID of the media file of Pandoras Box, Site 1, Layer 2 to variable  “var_Number” that
was defined beforehand with the Double or Integer type.
In PB, you can assign a Folder and File ID using the File Inspector .

VGetDeviceMediaFolderID

VGetDeviceMediaFolderID(VarName,SiteID,DeviceID)

Example:
VGetDeviceMediaFolderID("var_Number",1,2)

Returns the Folder ID of the media file of Pandoras Box, Site 1, Layer 2 to variable  “var_Number”
that was defined beforehand with the Double or Integer type.
In PB, you can assign a Folder and File ID using the File Inspector .

VGetDeviceMediaName

VGetDeviceMediaName(VarName,SiteID,DeviceID)

Example:
VGetDeviceMediaName("var_String",1,2)

Returns the name of the media file of Pandoras Box, Site 1, Layer 2 to the string-type variable
“var_String” that was defined beforehand.
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Note: The file name does not include the extension (.png / .avi / .wav …)

VGetDeviceMediaPath

VGetDeviceMediaPath(VarName,SiteID,DeviceID)

Example:
VGetDeviceMediaPath("var_String",1,2)

Returns the path of the media file of Pandoras Box, Site 1, Layer 2 to the string-type variable
“var_String” that was defined beforehand.

VGetDeviceObjectFileID

VGetDeviceObjectFileID(VarName,SiteID,DeviceID)

Example:
VGetDeviceObjectFileID("var_Number",1,2)

Returns the File ID of the object file of Pandoras Box, Site 1, Layer 2 to variable  “var_Number” that
was defined beforehand with the Double or Integer type.
In PB, you can assign a Folder and File ID using the File Inspector .

VGetDeviceObjectFolderID

VGetDeviceObjectFolderID(VarName,SiteID,DeviceID)

Example:
VGetDeviceObjectFolderID("var_Number",1,2)

Returns the Folder ID of the object file of Pandoras Box, Site 1, Layer 2 to variable  “var_Number”
that was defined beforehand with the Double or Integer type.
In PB, you can assign a Folder and File ID using the File Inspector .

VGetDeviceObjectPath

VGetDeviceObjectPath(VarName,SiteID,DeviceID)

Example:
VGetDeviceObjectPath("var_String",1,2)

Returns the path of the object file of Pandoras Box, Site 1, Layer 2 to the string-type variable
“var_String” that was defined beforehand.

VGetDeviceParam

VGetDeviceParam(VarName,SiteID,DeviceID,ParamName)

Example:
VGetDeviceParam("var_Number",1,2,"Opacity")
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Returns the value of the parameter "Opacity" of Pandoras Box, Site 1, Layer 2 to variable
“var_Number” that was defined beforehand with the Double or Integer type.

Note: The parameter name is case sensitive! You can copy all names including the syntax for an
Effect or Particle System from the chapter Parameter List .

VGetEndsWithText

VGetEndsWithText(VarName,SourceString,CompareString)

Example:
VGetEndsWithText("var_true","Hello World!","orld!")

Checks if the compare string ("orld!") matches with the end of the source string ("Hello World!") and
returns “1” for a true argument and “0” for a false one through the variable  “var_true” that was
defined beforehand.

Note: This function is case-sensitive, space characters in front of any strings are not being counted.

VGetExcelCellValue

VGetExcelCellValue(VarName,File,Table,Cell)

Example:
VGetExcelCellValue("var_Value","C:\Data\excel.xls","Sheet1","C7")

Assigns the value of cell C7 from Excel document “excel.xls”, table “Sheet1” to the variable
“var_Value” that was defined beforehand.

Note: The document has to be an “.xls”-file.

VGetFaderVal

VGetFaderVal(VarName,FaderID)

Example:
VGetFaderVal("Counter",1)

Applies the value of Fader 1 to the variable  “Counter”. 

VGetFileCount

VGetFileCount(VarName,Folder)

Example:
VGetFileCount("var_Count","C:\Videos")

Returns the amount of files saved in the folder “Videos” to variable  “var_Count” that was defined
beforehand with the Integer or Double type. Note that sub folders are not counted, but system or
hidden files are counted which includes for example a "thumbs.db" file.

VGetFileNameFromPath
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VGetFileNameFromPath(VarName,Path)

Example:
VGetFileNameFromPath("var_String","C:\Program Files\Christie\Widget Designer 6.0 Rev 4498\logs
\wd_gui_log.txt")

Writes the name of the file described by the path into the string-type variable  “var_String” that was
defined beforehand.

VGetFilePathFromFileDialog

VGetFilePathFromFileDialog(VarName)

Example:
VGetFilePathFromFileDialog("var_String")

Opens an explorer dialog for the user to select one file. By clicking “Open” the file path is written into
the string-type variable  “var_String” that was defined beforehand.

VGetFilePathFromFileDialogWithPath

VGetFilePathFromFileDialogWithPath(Path,VarName)

Example:
VGetFilePathFromFileDialogWithPath("C:\Program Files\Christie,"var_String")

Opens an explorer dialog displaying the specified folder for the user to select one file. By clicking
“Open” the file path is written into the string-type variable  “var_String” that was defined beforehand.

VGetLabelText

VGetLabelText(VarName,LabelID)

Example:
VGetLabelText("City",2)

Applies the text of Label 2 to the variable  “City”. 

VGetListViewAverageCol

VGetListViewAverageCol(VarName,ID,Col)

Example:
VGetListViewAverageCol("var_Value",1,2)

Calculates the arithmetic mean of all values located in column 2 in ListView  1 and assigns the
result to the variable  “var_Value” that was defined beforehand.

Note: If the variable is an integer-type, the result is being rounded!

VGetListViewAverageRow
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VGetListViewAverageRow(VarName,ID,Row)

Example:
VGetListViewAverageRow("var_Value",1,2)

Calculates the arithmetic mean of all values located in row 2 in ListView  1 and assigns the result
to the variable  “var_Value” that was defined beforehand.

Note: If the variable is an integer-type, the result is being rounded!

VGetListViewCell

VGetListViewCell(VarName,ID,Col,Row)

Example:
VGetListViewCell("var_Value",1,2,3)

Searches for the cell located in column 2, row 3 in ListView  1. Its value is assigned to the variable
 “var_Value” that was defined beforehand.

VGetListViewSearchCell

VGetListViewSearchCell(ID,Value,VariableCol,VariableRow)

Example:
VGetListViewSearchCell(1,3.142,"var_Col","var_Row")

Searches for a cell with the value 3.142 in ListView  1 and assigns its position (number of column
and number of row) to the variables  “var_Col” and ”var_Row” that were defined beforehand.

Note: If there is no such value in the Listview, the command will return -1 / -1.

VGetListViewSearchDown

VGetListViewSearchDown(VarName,ID,Value,Offset)

Example:
VGetListViewSearchDown("var_Value",1,13,2)

Searches for a cell with the value 13 in ListView  1 and looks for the cell three rows down (1 cell
down + 2 cells offset). Its value is assigned to the variable  “var_Value” that was defined
beforehand.

E.g, if Value 13 was found in (any column) row 1, the command returns the value of (same column)
row 4.

Example 2:
VGetListViewSearchDown("var_Value",1,13)
Without the optional "offset" parameter, the command returns the value of the neighbor cell.

VGetListViewSearchLeft

VGetListViewSearchLeft(VarName,ID,Value,Offset)
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Example:
VGetListViewSearchLeft("var_Value",1,13,2)

Searches for a cell with the value 13 in ListView  1 and looks for the cell three columns to the left
(1 cell to the left + 2 cells offset). Its value is assigned the variable  “var_Value” that was defined
beforehand.

E.g, if Value 13 was found in column 4 (any row), the command returns the value of column 1 (same
row)

Example 2:
VGetListViewSearchLeft("var_Value",1,13)
Without the optional "offset" parameter, the command returns the value of the neighbor cell.

VGetListViewSearchRight

VGetListViewSearchRight(VarName,ID,Value,Offset)

Example:
VGetListViewSearchRight("var_Value",1,13,2)

Searches for a cell with the value 13 in ListView  1 and looks for the cell three columns to the right
(1 cell to the right + 2 cells offset). Its value is assigned the variable  “var_Value” that was defined
beforehand.

E.g, if Value 13 was found in column 1 (any row), the command returns the value of column 4 (same
row).

Example 2:
VGetListViewSearchRight("var_Value",1,13)
Without the optional "offset" parameter, the command returns the value of the neighbor cell.

VGetListViewSearchUp

VGetListViewSearchUp(VarName,ID,Value,Offset)

Example:
VGetListViewSearchUp("var_Value",1,13,2)

Searches for a cell with the value 13 in ListView  1 and looks for the cell three rows up (1 cell up +
2 cells offset). Its value is assigned to the variable  “var_Value” that was defined beforehand.

E.g, if Value 13 was found in (any column) row 4, the command returns the value of (same column)
row 1.

Example 2:
VGetListViewSearchUp("var_Value",1,13)
Without the optional "offset" parameter, the command returns the value of the neighbor cell.

VGetListViewSelectedRow

VGetListViewSelectedRow(VarName,ID)
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Example:
VGetListViewSelectedRow("var_Int",1)

Assigns the number of the currently selected row of ListView  1 to variable  “var_Int” that was
defined beforehand.

VGetListViewSumCol

VGetListViewSumCol(VarName,ID,Col)

Example:
VGetListViewSumCol("var_Value",1,2)

Calculates the sum of all values located in column 2 in ListView  1 and assigns the result to the
variable  “var_Value” that was defined beforehand.

Note: If the variable is an integer-type, the result is being rounded!

VGetListViewSumRow

VGetListViewSumRow(VarName,ID,Row)

Example:
VGetListViewSumRow("var_Value",1,2)

Calculates the sum of all values located in row 2 in ListView  1 and assigns the result to the
variable  “var_Value” that was defined beforehand.

Note: If the variable is an integer-type, the result is being rounded!

VGetNodeOutputValue

VGetNodeOutputValue(Varname,NodeID,ParamID)

Example:
VGetNodeOutputValue("var_Value",1,2)

Assigns the second output value of the node with ID 1 to the variable  “var_Value” that was defined
beforehand. The second output is also the second entry in the drop-down list when choosing a value
in a connected node.

Note: Please use the correct type of variable matching the node output type.

VGetNodeVal

VGetNodeVal(VarName,NodeID,ParamID)

Example:
VGetNodeVal("Counter",10,1)

Applies the value of Node 10, Parameter 1 to the variable  “Counter”. 

VGetPBPlaylistItemCountByID
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VGetPBPlaylistItemCountByID(VarName,PlaylistFolderID,PlaylistFileID)

Example:
VGetPBPlaylistItemCountByID("var1",2,1)

This returns the total count of items of the Pandoras Box playlist  with the folder and file ID [2,1].
The (string or number) Variable  "var1" in Widget Designer will be assigned with this number.

VGetPBPlaylistItemCountByPath

VGetPBPlaylistItemCountByPath(VarName,PlaylistPath)

Example:
VGetPBPlaylistItemCountByPath("var1","Playlist Test\Playlist 1")

This returns the total count of items of the Pandoras Box playlist  “Playlist 1” of the subfolder
“Playlist Test” within the project folder. The (string or number) Variable  "var1" in Widget Designer
will be assigned with this number.

VGetRSSUrlItemBody

VGetRSSUrlItemBody(VarName,UrlID,ItemID)

Example:
VGetRSSUrlItemBody("var_String",1,14)

Assigns the body of RSS item 14 of the RSS feed with ID 1 to the string-type variable  “var_String”
that was defined beforehand. RSS news feeds can be accessed via the RSS Settings Tool .

VGetRSSUrlItemCount

VGetRSSUrlItemCount(VarName,UrlID)

Example:
VGetRSSUrlItemCount("var_Count",1)

Counts the number of RSS items within the RSS feed with ID 1 and assigns the result to the variable
 “var_Count” that was defined beforehand. RSS news feeds can be accessed via the RSS Settings

Tool .

VGetRSSUrlItemFeed

VGetRSSUrlItemFeed(VarName,UrlID,ItemID)

Example:
VGetRSSUrlItemFeed("var_String",1,14)

Assigns the title and body of RSS item 14 of the RSS feed with ID 1 to the string-type variable
“var_String” that was defined beforehand. RSS news feeds can be accessed via the RSS Settings
Tool .

VGetRSSUrlItemTitle
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VGetRSSUrlItemTitle(VarName,UrlID,ItemID)

Example:
VGetRSSUrlItemTitle("var_String",1,14)

Assigns the title of RSS item 14 of the RSS feed with ID 1 to the string-type variable  “var_String”
that was defined beforehand. RSS news feeds can be accessed via the RSS Settings Tool .

VGetSeqCueName

VGetSeqCueName(VarName,SeqID,CueID)

Example:
VGetSeqCueName("Counter",1,3)

This applies the name of Cue 3 from the Sequence 1 in Pandoras Box to the variable in Widget
Designer named “Counter”. If the cue name includes letters, the Variable's type must be "String". To
monitor all variables, their type and value, please refer to the Variable List .

VGetSeqState

VGetSeqState(VarName,SeqID)

Example:
VGetSeqState("Counter",2)

This applies the current playback state ‘Play’, ‘Pause or 'Stop' of the Sequence 1 in Pandoras Box to
the variable in Widget Designer which is named “Counter” . To monitor all variables, their type and
value, please refer to the Variable List .

VGetSeqTime

VGetSeqTime(VarName,SeqID)

Example:
VGetSeqTime("Counter",1)

This applies the timecode (e.g. 00:01:12:23) of Sequence 1 in Pandoras Box to the variable in Widget
Designer which is named “Counter” . The type of the variable must be "String". To monitor all
variables, their type and value, please refer to the Variable List .

VGetSiteConnectionBackup

VGetSiteConnectionBackup(VarName,SiteID)

Example:
VGetSiteConnectionBackup("var_Number",4)

Checks if Site 4 of Pandoras Box (Backup) is connected and returns “1” for a true argument and “0”
for a false one through the variable  “var_true” that was defined beforehand with the Integer or
Double type.
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The IP address for the PB Backup connection can be entered in the dialog Pandoras Box Network
Configuration .

VGetSiteConnectionMaster

VGetSiteConnectionMaster(VarName,SiteID)

Example:
VGetSiteConnectionMaster("var_Number",4)

Checks if Site 4 of Pandoras Box (Master) is connected and returns “1” for a true argument and “0” for
a false one through the variable  “var_Number” that was defined beforehand with the Integer or
Double type.

The IP address for the PB Master connection can be entered in the dialog Pandoras Box Network
Configuration .

VGetStartsWithText

VGetStartsWithText(VarName,SourceString,CompareString)

Example:
VGetStartsWithText("var_true","Hello World!","Hell")

Checks if the compare string ("Hell") matches with the beginning of the source string ("Hello World!")
and returns “1” for a true argument and “0” for a false one through the variable  “var_true” that was
defined beforehand.

Note: This function is case-sensitive, space characters in front of any strings are not being counted.

VGetStringLength

VGetStringLength(VarName,String)

Example:
VGetStringLength("var_length","I like trains")

Counts the amount of characters of the source string “I like trains” (= 13) and writes the result into
the variable  “var_lenghth” that was defined beforehand.

Note: Space characters in front of the string are not being counted.

VGetStringReplace

VGetStringReplace(VarName,String,OldString,NewString)

Example:
VGetStringReplace("var_String","Hello World!","llo Wor","lium Go")

Sets the string-type variable to the string “Hello World!” and replaces the part “llo Wor” with “lium Go”.
New Value of var_String: “Helium Gold!”

Note: Space characters in front of any strings are not being counted.
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VGetSubString

VGetSubString(VarName,String,StartIndex,Length)

Example:
VGetSubString("var_String","I like trains",3,8)

Shortens the string “I like trains” and writes the result into the string-type variable  “var_String” that
was defined before. In the example, the sub string has the length of 8 characters and begins with the
4th letter of the source string (“ike trai”). The start index 0 would refer to the first character.

VGetSubStringTrimStart

VGetSubStringTrimStart(VarName,String,StartIndex)

Example:
VGetSubStringTrimStart("var_String","Hello World!",7)

Trims the first 7 characters of the string “Hello World!”.
The remaining string (“orld!”) is written into the string-type variable  “var_String” that was defined
beforehand.

Note: Space characters in front of the string are not being counted.

VGetTextboxText

VGetTextboxText(VarName,TextboxID)

Example:
VGetTextboxText("V_Test",1)

Applies the text of Textbox 1 to the variable “V_Test”. 

To monitor all variables, their type and value, please refer to the Variable List .

VGetTreeviewSelectedItemName

VGetTreeviewSelectedItemName(VarName,ID)

Example:
VGetTreeviewSelectedItemName("var_String",1)

Writes the name of the currently selected item in the Tree View Control  with ID 1 into the string-
type variable “var_String” that was defined beforehand.

VGetTreeviewSelectedItemPath

VGetTreeviewSelectedItemPath(VarName,ID)

Example:
VGetTreeviewSelectedItemPath("var_String",1)
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Writes the path of the currently selected item in the Tree View Control  with ID 1 into the string-
type variable “var_String” that was defined beforehand.

VGetWDPlaylistCueAudio

VGetWDPlaylistCueAudio(VarName,ID,Cue)

Example:
VGetWDPlaylistCueAudio(„var_String“,1,3)

Assigns the content of the Audio field of cue 3 of Playlist control  1 to the string-type variable
„var_String“ that was defined beforehand.

VGetWDPlaylistCueMedia

VGetWDPlaylistCueMedia(VarName,ID,Cue)

Example:
VGetWDPlaylistCueMedia(„var_String“,1,3)

Assigns the content of the Media field of cue 3 of Playlist control  1 to the string-type variable
„var_String“ that was defined beforehand.

VGetWDPlaylistCueMode

VGetWDPlaylistCueMode(VarName,ID,Cue)

Example:
VGetWDPlaylistCueMode("var_String",1,2)

Assigns the Cue Mode (Continue / Pause&Hold / Pause&Fadeout) of Cue number 2 in Playlist
control  1 to the string-type variable  “var_String” that was defined beforehand.

VGetWDPlaylistCueName

VGetWDPlaylistCueName(VarName,ID,Cue)

Example:
VGetWDPlaylistCueName(„var_String“,1,3)

Assigns the name of cue 3 of Playlist control  1 to the string-type variable  „var_String“ that was
defined beforehand.

VGetWDPlaylistCueOverlay1

VGetWDPlaylistCueOverlay1(VarName,ID,Cue)

Example:
VGetWDPlaylistCueOverlay1(„var_String“,1,3)

Assigns the content of the Overlay 1 field of cue 3 of Playlist control  1 to the string-type variable
 „var_String“ that was defined beforehand.
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VGetWDPlaylistCueOverlay2

VGetWDPlaylistCueOverlay2(VarName,ID,Cue)

Example:
VGetWDPlaylistCueOverlay2(„var_String“,1,3)

Assigns the content of the Overlay 2 field of cue 3 of Playlist control  1 to the string-type variable
 „var_String“ that was defined beforehand.

VGetWDPlaylistCueScript

VGetWDPlaylistCueScript(VarName,ID,Cue)

Example:
VGetWDPlaylistCueScript(„var_String“,1,3)

Assigns the content of the Script field of cue 3 of Playlist control  1 to the string-type variable
„var_String“ that was defined beforehand.

VGetWDPlaylistCueTime

VGetWDPlaylistCueTime(VarName,ID,Cue)

Example:
VGetWDPlaylistCueTime(„var_String“,1,3)

Assigns the duration (in timecode format) of cue 3 of Playlist control  1 to the string-type variable
 „var_String“ that was defined beforehand, e.g. 00:01:10 for a cue that is 1 minute and 10 seconds

long.

Alternatively, the command VGetWDPlaylistCueTimeTotalSecs  provides the duration in total
seconds.

VGetWDPlaylistCueTimeTotalSecs

VGetWDPlaylistCueTimeTotalSecs(VarName,ID,Cue)

Example:
VGetWDPlaylistCueTimeTotalSecs(„var_Length“,1,3)

Assigns the total length (in seconds) of cue 3 of Playlist control  1 to the variable  „var_Length“
that was defined beforehand, e.g. 70 for a cue that is 1 minute and 10 seconds long.

Alternatively, the command VGetWDPlaylistCueTime  provides the duration in timecode format.

VGetWDPlaylistCurrentCue

VGetWDPlaylistCurrentCue(VarName,ID)

Example:
VGetWDPlaylistCurrentCue(„var_Cue“,1)
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Assigns the ID of the currently playing cue of Playlist control  1 to the variable  „var_Cue“ that
was defined beforehand.

VGetWDPlaylistCurrentCueAudio

VGetWDPlaylistCurrentCueAudio(VarName,ID)

Example:
VGetWDPlaylistCurrentCueAudio(„var_String“,1)

Assigns the content of the Audio field of the currently playing cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistCurrentCueMedia

VGetWDPlaylistCurrentCueMedia(VarName,ID)

Example:
VGetWDPlaylistCurrentCueMedia(„var_String“,1)

Assigns the content of the Media field of the currently playing cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistCurrentCueName

VGetWDPlaylistCurrentCueName(VarName,ID)

Example:
VGetWDPlaylistCurrentCueName(„var_String“,1)

Assigns the name of the currently playing cue of Playlist control  1 to the string-type variable
„var_String“ that was defined beforehand.

VGetWDPlaylistCurrentCueOverlay1

VGetWDPlaylistCurrentCueOverlay1(VarName,ID)

Example:
VGetWDPlaylistCurrentCueOverlay1(„var_String“,1)

Assigns the content of the Overlay 1 field of the currently playing cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistCurrentCueOverlay2

VGetWDPlaylistCurrentCueOverlay2(VarName,ID)

Example:
VGetWDPlaylistCurrentCueOverlay2(„var_String“,1)

Assigns the content of the Overlay 2 field of the currently playing cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.
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VGetWDPlaylistCurrentCueRemainingSec

VGetWDPlaylistCurrentCueRemainingSec(VarName,ID)

Example:
VGetWDPlaylistCurrentCueRemainingSec(„var_Time“,1)

Assigns the remaining time (in seconds) of the current cue of Playlist control  1 to the variable
„var_Time“ that was defined beforehand.

VGetWDPlaylistCurrentCueScript

VGetWDPlaylistCurrentCueScript(VarName,ID)

Example:
VGetWDPlaylistCurrentCueScript(„var_String“,1)

Assigns the content of the Script field of the currently playing cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistSelectedCue

VGetWDPlaylistSelectedCue(VarName,ID)

Example:
VGetWDPlaylistSelectedCue(„var_Cue“,1)

Assigns the ID of the currently selected cue in Playlist control  1 to the variable  „var_Cue“ that
was defined beforehand.

VGetWDPlaylistSelectedCueAudio

VGetWDPlaylistSelectedCueAudio(VarName,ID)

Example:
VGetWDPlaylistSelectedCueAudio(„var_String“,1)

Assigns the content of the Audio field of the currently selected cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistSelectedCueMedia

VGetWDPlaylistSelectedCueMedia(VarName,ID)

Example:
VGetWDPlaylistSelectedCueMedia(„var_String“,1)

Assigns the content of the Media field of the currently selected cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistSelectedCueName
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VGetWDPlaylistSelectedCueName(VarName,ID)

Example:
VGetWDPlaylistSelectedCueName(„var_String“,1)

Assigns the name of the currently selected cue of Playlist control  1 to the string-type variable
„var_String“ that was defined beforehand.

VGetWDPlaylistSelectedCueOverlay2

VGetWDPlaylistSelectedCueOverlay2(VarName,ID)

Example:
VGetWDPlaylistSelectedCueOverlay2(„var_String“,1)

Assigns the content of the Overlay 2 field of the currently selected cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistSelectedCueScript

VGetWDPlaylistSelectedCueScript(VarName,ID)

Example:
VGetWDPlaylistSelectedCueScript(„var_String“,1)

Assigns the content of the Script field of the currently selected cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VGetWDPlaylistSelectedTreeviewItemName

VGetWDPlaylistSelectedTreeviewItemName(Varname,ID)

Example:
VGetWDPlaylistSelectedTreeviewItemName("var_String",1)

Assigns the name of the item that is selected in the tree view of Playlist control  1 to the string-
type variable  “var_String” that was defined beforehand.

VGetWDPlaylistSelectedTreeviewItemProjectPath

VGetWDPlaylistSelectedTreeviewItemProjectPath(VarName,ID)

Example:
VGetWDPlaylistSelectedTreeviewItemProjectPath("var_String",1)

Assigns the project path of the item that is selected in the tree view of Playlist control  1 to the
string-type variable  “var_String” that was defined beforehand.

VGetWDPlaylistTotalCueCount

VGetWDPlaylistTotalCueCount(VarName,ID)
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Example:
VGetWDPlaylistTotalCueCount("var_Count",1)

Counts the number of cues of Playlist control  1 and assigns the result to the variable
“var_Count” that was defined beforehand.

VGeWDPlaylistSelectedCueOverlay1

VGeWDPlaylistSelectedCueOverlay1(VarName,ID)

Example:
VGeWDPlaylistSelectedCueOverlay1(„var_String“,1)

Assigns the content of the Overlay 1 field of the currently selected cue of Playlist control  1 to the
string-type variable  „var_String“ that was defined beforehand.

VLock

VLock(VarName)

Example:
VLock(VarName)

Locks the variable  “var_test” so that its value cannot be edited.

VMultiply

VMultiply(VarName,Var1,Var2)

Example:
VMultiply("V_Multi","Counter1","Counter2")

Multiplies the values of the variables Counter1 and Counter2 and passes this Multiply result to the
variable V_Multi. 

To monitor all variables, their type and value, please refer to the Variable List .

VPow

VPow(VarName,Var1,Var2)

Example:
VPow("V_Power","Counter1","Counter2")

Raises the variable Counter1 to the power of Counter2 and passes this Power result to the variable
V_Power. 

To monitor all variables, their type and value, please refer to the Variable List .

VReplaceAsciiNumberByHexCode

VReplaceAsciiNumberByHexCode(VarName,String,Delimter)
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Example:
VReplaceAsciiNumberByHexCode("var_String","1 64 256 hi 11",":")

Replaces any ASCII number in the entered string by its corresponding HEX code and separates them
with the separator character ":". Other characters simply remain in the string.

The result (:31 :36:34 :32:35:36 hi :31:31) is returned to the variable  “var_String” that was defined
beforehand with the string type.

VReplaceNumberByHexCode

VReplaceNumberByHexCode(VarName,String,Delimter,LeadingZeros)

Example:
VReplaceNumberByHexCode("var_String","1 64 256 hi 11",":",2)

Replaces any number in the entered string by its corresponding HEX code, adds up to 2 leading
zeros and separates the result with the separator character ":". Other characters than numbers
simply remain in the string.

The result (:001 :040 :100 hi :00B) is returned to the variable  “var_String” that was defined
beforehand with the string type.

VSetArrayFromSplitString

VSetArrayFromSplitString(VarName,String,Separator)

Example:
VSetArrayFromSplitString("var_List","fl;ol;lo;pi;ng",";")

Splits the specified string wherever the separator character ";" occurs. The resulting sub strings are
returned as elements of the variable  “var_List” that was defined beforehand with the List type. Note
that the amount and type of the sub elements are automatically adjusted. The separator can be any
single character including comma “,” and space character “ “.

VSetArrayFromTextBox

VSetArrayFromTextBox(VarName,TextBoxID)

Example:
VSetArrayFromTextBox(“var_List”,1)

Loads the content of Textbox  1 into the variable  “var_List” that was defined beforehand with the
List type. Note that the amount and type of the sub elements are automatically adjusted. A new line
represents a new element.

VSetArrayRNDUniqueInt

VSetArrayRNDUniqueInt('VarName',StartVal,EndVal)

Example:
VSetArrayRNDUniqueInt("var_List",0,100)
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Fills the variable  array “var_List”, that was defined beforehand with the List type, with random
integer values from 1 to 100, no value appears twice.

Note: The array’s size must be larger than the number of possible (unique) values!

VSetArrayValue

VSetArrayValue(VarName,Index,Value)

Example:
VSetArrayValue("var_List",7,444)

Sets the value of the 8th element in the variable  array “var_List”, that was defined beforehand with
the List type, to the value 444. The type of the sub element is automatically adjusted. 

Note: The index starts with 0 -> Index 7 matches the 8th element.

VSetValueFromSplitString

VSetValueFromSplitString(VarName,String,Separator,Index)

Example:
VSetValueFromSplitString("var_Value","00:10:30:42",":",2)

Splits the specified string wherever the separator character ":" occurs. The resulting sub string with
index 2 is returned to the variable  “var_Value” that was defined beforehand with the type that
matches the string data (Integer, String, etc.). As indexing starts with 0, var_Value = 30.

VSqrt

VSqrt(VarName,Var1)

Example:
VSqrt("V_Square","Counter1")

Calculates the square root of the variable Counter1 passes this Sqrt result to the variable V_Square. 

To monitor all variables, their type and value, please refer to the Variable List .

VSubtract

VSubtract(VarName,Var1,Var2)

Example:
VSubtract("V_Sub","Counter1","Counter2")

Subtracts the variable Counter2 from Counter1 and passes this Subtract result to the variable
V_Sub. 

To monitor all variables, their type and value, please refer to the Variable List .

VUnLock
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VUnLock(VarName)

Example:
VUnLock(VarName)

Unlocks the variable  “var_test” so that its value can be edited.

VValue

VValue(VarName,Value)

Example:
VValue("varCounter",20)

Applies the value “20” to the variable  “varCounter”.

VValueDate

VValueDate(VarName)

Example:
VValueDate("var_String")

Returns the current date (format: dd/mm/yyyy) to the variable  “var_String” that was defined
beforehand with the string type.

VValueDateAddDays

VValueDateAddDays(VarName,Days)

Example:
VValueDateAddDays("var_String",5)

Returns the current date (format: dd/mm/yyyy) plus five days to the variable  “var_String” that was
defined beforehand with the string type.

Note: To subtract please use negative values.

VValueDateAddDaysToDate

VValueDateAddDaysToDate(VarName,DD,MM,YYYY,Days)

Example:
VValueDateAddDaysToDate("var_String",25,01,2010,5)

Returns the specified date (format: dd/mm/yyyy) plus five years to the variable  “var_String” that
was defined beforehand with the string type: 25/06/2010

Note: To subtract please use negative values.

VValueDateAddDaysToDateF
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VValueDateAddDaysToDateF(VarName,DD/MM/YYYY,Days)

Example:
VValueDateAddDaysToDateF("var_String","25/01/2010",5)

Returns the specified date (format: dd/mm/yyyy) plus five days to the variable  “var_String” that
was defined beforehand with the string type: 30/01/2010

Note: To subtract please use negative values.

VValueDateAddMonths

VValueDateAddMonths(VarName,Months)

Example:
VValueDateAddMonths("var_String",5)

Returns the current date (format: dd/mm/yyyy) plus five months to the variable  “var_String” that
was defined beforehand with the string type.

Note: To subtract please use negative values.

VValueDateAddMonthsToDate

VValueDateAddMonthsToDate(VarName,DD,MM,YYYY,Months)

Example:
VValueDateAddMonthsToDate("var_String",25,01,2010,5)

Returns the specified date (format: dd/mm/yyyy) plus five years to the variable  “var_String” that
was defined beforehand with the string type: 25/06/2010

Note: To subtract please use negative values.

VValueDateAddMonthsToDateF

VValueDateAddMonthsToDateF(VarName,DD/MM/YYYY,Months)

Example:
VValueDateAddMonthsToDateF("var_String","25/01/2010",5)

Returns the specified date (format: dd/mm/yyyy) plus five years to the variable  “var_String” that
was defined beforehand with the string type: 25/06/2010

Note: To subtract please use negative values.

VValueDateAddYears

VValueDateAddYears(VarName,Years)

Example:
VValueDateAddYears("var_String",5)
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Returns the current date (format: dd/mm/yyyy) plus five years to the variable  “var_String” that was
defined beforehand with the string type.

Note: To subtract please use negative values.

VValueDateAddYearsToDate

VValueDateAddYearsToDate(VarName,DD,MM,YYYY,Years)

Example:
VValueDateAddYearsToDate("var_String",25,01,2010,5)

Returns the specified date (format: dd/mm/yyyy) plus five years to the variable  “var_String” that
was defined beforehand with the string type: 25/01/2015

Note: To subtract please use negative values.

VValueDateAddYearsToDateF

VValueDateAddYearsToDateF(VarName,DD/MM/YYYY,Years)

Example:
VValueDateAddYearsToDateF("var_String","25/01/2010",5)

Returns the specified date (format: dd/mm/yyyy) plus five years to the variable  “var_String” that
was defined beforehand with the string type: 25/01/2015

Note: To subtract please use negative values.

VValueDateF

VValueDateF(VarName)

Example:
VValueDateF("var_String")

Returns the current date (format: dd-mm-yyyy) to the variable  “var_String” that was defined
beforehand with the string type.

VValueDateTime

VValueDateTime(VarName)

Example:
VValueDateTime("var_String")

Returns the current time and date (format: hh:mm:ss dd/mm/yyyy) to the variable  “var_String” that
was defined beforehand with the string type.

VValueDateTimeF

VValueDateTimeF(VarName)

1638

1638

1638

1638

1638



1452

Example:
VValueDateTimeF("var_String")

Returns the current time and date (format: hh-mm-ss_dd-mm-yyyy) to the variable  “var_String”
that was defined beforehand with the string type.

VValueRandom

VValueRandom(VarName)

Example:
VValueRandom("var_Double")

Assigns a random value to the variable  “var_Double” that was defined beforehand with the Integer
or Double type. A double-type variable ranges between 0 and 1 and an integer-type variable between
0 and 100.

VValueRandomMinMax

VValueRandomMinMax(VarName,Min,Max)

Example:
VValueRandomMinMax("var_Double",10,100)

Assigns a random value between 10 and 100 to the variable  “var_Double” that was defined
beforehand with the Integer or Double type.

VValueRound

VValueRound(VarName,DecimalPlaces)

Example:
VValueRound("var_Double",2)

Rounds the double-type variable  “var_Double” to two digits. E.g: 3.1415926 -> 3.14

VValueTime

VValueTime(VarName)

Example:
VValueTime("var_String")

Returns the current time (format: hh:mm:ss) to the variable  “var_String” that was defined
beforehand with the string type.

VValueTimeAddHours

VValueTimeAddHours(VarName,Hour)

Example:
VValueTimeAddHours("var_String",3)
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Returns the current time (format: hh:mm:ss) plus three hours to the variable  “var_String” that was
defined beforehand with the string type.

Note: To subtract please use negative values.

VValueTimeAddMinutes

VValueTimeAddMinutes(VarName,Min)

Example:
VValueTimeAddMinutes("var_String",3)

Returns the current time (format: hh:mm:ss) plus three minutes to the variable  “var_String” that
was defined beforehand with the string type.

Note: To subtract please use negative values.

VValueTimeAddSeconds

VValueTimeAddSeconds(VarName,Sec)

Example:
VValueTimeAddSeconds("var_String",10)

Returns the current time (format: hh:mm:ss) plus ten seconds to the variable  “var_String” that was
defined beforehand with the string type.

Note: To subtract please use negative values.

VValueTimeF

VValueTimeF(VarName)

Example:
VValueTimeF("var_String")

Returns the current time (format: hh-mm-ss) to the variable  “var_String” that was defined
beforehand with the string type.

W W

WakeOnLan

WakeOnLan(MacAddress)

Example:
WakeOnLan("00-14-f5-0d-37-29")

Turns on or wakes up the computer with the MacAddress 08-00-20-ae-fd-7e.

Please note:
Precondition for using WakeOnLan is that the ethernet adapter of the computer you want to wake up
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supports WakeOnLan with Magic Packet. Please confirm these settings in the ethernet cards
properties in the computers device manager.

WDAirScanDamping

WDAirScanDamping(Value)

Example:
WDAirScanDamping(0.5)

Changes the value "Damping" inside the AirScan Tool  to 0.5.

WDAirScanDisableTouch

WDAirScanDisableTouch

Example:
WDAirScanDisableTouch

Disables the option inside the AirScan Tool  to send touch points to other controls like the Multi-
Touch Panel . Note that there is no check box for that option.

WDAirScanEnableTouch

WDAirScanEnableTouch

Example:
WDAirScanEnableTouch

Enables the option inside the AirScan Tool  to send touch points to other controls like the Multi-
Touch Panel . Note that there is no check box for that option.

WDAirScanGap

WDAirScanGap(Value)

Example:
WDAirScanGap(20)

Changes the value "Gap" inside the AirScan Tool  to 20.

WDAirScanMaxDelta

WDAirScanMaxDelta(Value)

Example:
WDAirScanMaxDelta(50)

Changes the value "Max Delta" inside the AirScan Tool  to 50.

WDAirScanMotion
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WDAirScanMotion(Value)

Example:
WDAirScanMotion(0.5)

Changes the value "Motion" (motion damping) inside the AirScan Tool  to 0.5.

WDAirScanMotionPredictionDisable

WDAirScanMotionPredictionDisable

Example:
WDAirScanMotionPredictionDisable

Disables the option "Motion Prediction" inside the AirScan Tool .

WDAirScanMotionPredictionEnable

WDAirScanMotionPredictionEnable

Example:
WDAirScanMotionPredictionEnable

Enables the option "Motion Prediction" inside the AirScan Tool .

WDAirScanMotionPredictionFactor

WDAirScanMotionPredictionFactor(Value)

Example:
WDAirScanMotionPredictionFactor(0.5)

Changes the value "Motion Prediction" inside the AirScan Tool  to 0.5.

WDAirScanMouseClickDefault

WDAirScanMouseClickDefault

Example:
WDAirScanMouseClickDefault

This command defines when a mouse click (controlled via AirScan) should be executed. 
"Default" generates mouse down on enter and mouse up on leave. 

Please note: 
The option Mouse Click in the AirScan Tool  needs to be enabled! 

WDAirScanMouseClickDisabled

WDAirScanMouseClickDisabled
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Example:
WDAirScanMouseClickDisabled

With this option the mouse cursor (controlled via the AirScan ) does not generate clicks.

WDAirScanMouseClickEnabled

WDAirScanMouseClickEnabled

Example:
WDAirScanMouseClickEnabled

With this option the mouse cursor (controlled via the AirScan ) generates clicks.

WDAirScanMouseClickOnEnter

WDAirScanMouseClickOnEnter

Example:
WDAirScanMouseClickOnEnter

This command defines when a mouse click (controlled via AirScan) should be executed. 
"OnEnter": the click is generated on mouse enter.

Please note: 
The option Mouse Click in the AirScan Tool  needs to be enabled! 

WDAirScanMouseClickOnLeave

WDAirScanMouseClickOnLeave

Example:
WDAirScanMouseClickOnLeave

This command defines when a mouse click (controlled via AirScan) should be executed. 

"OnLeave": the click is generated on mouse leave.

Please note: 
The option Mouse Click in the AirScan Tool  needs to be enabled! 

WDAirScanMouseDisabled

WDAirScanMouseDisabled

Example:
WDAirScanMouseDisabled

Disables the AirScan  to control the mouse.

WDAirScanMouseDownOnMoveDisabled

1262

1262

1262

1262

1262



1457

WDAirScanMouseDownOnMoveDisabled

Example:
WDAirScanMouseDownOnMoveDisabled

If this option is disabled in the AirScan Tool , left mouse down on move is not active.

WDAirScanMouseDownOnMoveEnabled

WDAirScanMouseDownOnMoveEnabled

Example:
WDAirScanMouseDownOnMoveEnabled

If this option is enabled in the AirScan Tool , left mouse down on move is always active.

WDAirScanMouseEnabled

WDAirScanMouseEnabled

Example:
WDAirScanMouseEnabled

Enables the AirScan  to control the mouse.

WDAirScanMultiPointModeDisabled

WDAirScanMultiPointModeDisabled

Example:
WDAirScanMultiPointModeDisabled

Disables the MultiPointMode in the AirScan Tool , so that the 2-Point-Mode will be used.

WDAirScanMultiPointModeEnabled

WDAirScanMultiPointModeEnabled

Example:
WDAirScanMultiPointModeEnabled

Enables the MultiPointMode in the AirScan Tool .

WDAirScanPointCount

WDAirScanPointCount(PointCount)

Example:
WDAirScanPointCount(12)

Changes the amount of detected touch points inside the AirScan Tool  to 12.
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WDAirScanPointIDOffset

WDAirScanPointIDOffset(Value)

Example:
WDAirScanPointIDOffset(2)

Changes the value "Point ID Offset" inside the AirScan Tool  to 2.

WDAirScanStart

WDAirScanStart(Value)

Example:
WDAirScanStart(50)

Changes the value "Start" inside the AirScan Tool  to 50.

WDAirScanStop

WDAirScanStop(Value)

Example:
WDAirScanStop(250)

Changes the value "Stop" inside the AirScan Tool  to 250.

WDAirScanTrim

WDAirScanTrim(Value)

Example:
WDAirScanTrim(25)

Changes the value "Trim" inside the AirScan Tool  to 25.

WDAirScanTUIODisable

WDAirScanTUIODisable

Example:
WDAirScanTUIODisable

Disables the option "TUIO" inside the AirScan Tool .

WDAirScanTUIOEnable

WDAirScanTUIOEnable

Example:
WDAirScanTUIOEnable
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Changes the amount of detected touch points inside the AirScan Tool  to 12.

WDAirScanVCount

WDAirScanVCount(Value)

Example:
WDAirScanVCount(5)

Changes the value "VCount" inside the AirScan Tool  to 5.

WDAirScanXOffset

WDAirScanXOffset(Value)

Example:
WDAirScanXOffset(1025)

Changes the value "X Offset" inside the AirScan Tool  to 50.

WDAirScanYOffset

WDAirScanYOffset(Value)

Example:
WDAirScanYOffset(769)

Changes the value "Y Offset" inside the AirScan Tool  to 50.

WDArtnetRecorderClickImage

WDArtnetRecorderClickImage(ID,File)

Example:
WDArtnetRecorderClickImage(1,"C:\coolux\content\buttonImage10.jpg")

Changes the look of the Art-Net Recorder  Button with ID 1 - it loads the image
"buttonImage10.jpg" that was saved under "C:\coolux\content" and displays it when the Art-Net
Recorder is in the mode "Click".

WDArtNetRecorderCssStyleDisable

WDArtNetRecorderCssStyleDisable(ID,StyleID)

Example:
WDArtNetRecorderCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Art-Net Recorder  button with ID
5.

WDArtNetRecorderCssStyleEdit
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WDArtNetRecorderCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDArtNetRecorderCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Art-Net Recorder  button with ID 5.
The parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDArtNetRecorderCssStyleEnable

WDArtNetRecorderCssStyleEnable(ID,StyleID)

Example:
WDArtNetRecorderCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Art-Net Recorder  button with ID
5.

WDArtNetRecorderFix

WDArtNetRecorderFix(ID)

Example:
WDArtNetRecorderFix(5)

This activates the option "Fix" in the Item Properties of the Art-Net Recorder  button with ID 5.
"Fix" influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDArtNetRecorderGotoFrame

WDArtNetRecorderGotoFrame(ID,Frame)

Example:
WDArtNetRecorderGotoFrame(1,330)

Sets the Art-Net Recorder  Button 1 to the frame 330 of the last recorded Art-Net Sequence.

WDArtnetRecorderImage

WDArtnetRecorderImage(ID,File)

Example:
WDArtnetRecorderImage(1,"C:\coolux\content\buttonImage10.jpg")

Changes the look of the Art-Net Recorder  Button with ID 1 - it loads the image
"buttonImage10.jpg" that was saved under "C:\coolux\content" and displays it when the Art-Net
Recorder is in the mode "Release".

WDArtNetRecorderLocation

WDArtNetRecorderLocation(ID,X,Y)
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Example:
WDArtNetRecorderLocation(5,100,200)

Sets the position of the Art-Net Recorder  button with ID 5 to 100px horizontally and 200px
vertically. 0,0 is the top left corner of the Page.

WDArtNetRecorderLocationLeft

WDArtNetRecorderLocationLeft(ID,X)

Example:
WDArtNetRecorderLocationLeft(5,100)

Sets the position of the Art-Net Recorder  button with ID 5 to 100px horizontally but remains the
current vertical position. 0,0 is the top left corner of the Page.

WDArtNetRecorderLocationTop

WDArtNetRecorderLocationTop(ID,Y)

Example:
WDArtNetRecorderLocationTop(5,200)

Sets the position of the Art-Net Recorder  button with ID 5 to 200px vertically but remains the
current horizontal position. 0,0 is the top left corner of the Page.

WDArtNetRecorderLoop

WDArtNetRecorderLoop(ID)

Example:
WDArtNetRecorderLoop(2)

Sets the playmode of the Art-Net sequence recorded with Art-Net Recorder  Button 2 to Loop.

WDArtnetRecorderMouseOverImage

WDArtnetRecorderMouseOverImage(ID,File)

Example:
WDArtnetRecorderMouseOverImage(1,"C:\coolux\content\buttonImage10.jpg")

Changes the look of the Art-Net Recorder  Button with ID 1 - it loads the image
"buttonImage10.jpg" that was saved under "C:\coolux\content" and displays it when the Art-Net
Recorder is in the mode "Highlight".

WDArtNetRecorderPause

WDArtNetRecorderPause(ID)

Example:
WDArtNetRecorderPause(2)
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Pauses the playing Art-Net sequence recorded with Art-Net Recorder  Button 2.

WDArtNetRecorderPlay

WDArtNetRecorderPlay(ID)

Example:
WDArtNetRecorderPlay(2)

Plays the Art-Net sequence recorded with Art-Net Recorder  Button 2 from it’s current time.

WDArtNetRecorderPlayOnce

WDArtNetRecorderPlayOnce(ID)

Example:
WDArtNetRecorderPlayOnce(2)

Sets the playmode of the Art-Net sequence recorded with Art-Net Recorder  Button 2 to PlayOnce.

WDArtNetRecorderRewind

WDArtNetRecorderRewind(ID)

Example:
WDArtNetRecorderRewind(2)

Rewinds the Art-Net sequence recorded with Art-Net Recorder  Button 2 to it’s inpoint. When the
sequence is currently playing, it won’t be stopped but starts from it’s beginning again.

WDArtNetRecorderSize

WDArtNetRecorderSize(ID,Width,Height)

Example:
WDArtNetRecorderSize(5,100,40)

Sets the size of the Art-Net Recorder  button with ID 5 to a width of 100px and a height of 40px.

WDArtNetRecorderSizeHeight

WDArtNetRecorderSizeHeight(ID,Height)

Example:
WDArtNetRecorderSizeHeight(5,40)

Sets the size of the Art-Net Recorder  button with ID 5 to a height of 40px but remains the current
width.

WDArtNetRecorderSizeWidth
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WDArtNetRecorderSizeWidth(ID,Width)

Example:
WDArtNetRecorderSizeWidth(5,100)

Sets the size of the Art-Net Recorder  button with ID 5 to a width of 100px but remains the current
height.

WDArtNetRecorderStart

WDArtNetRecorderStart(ID)

Example:
WDArtNetRecorderStart(1)

Starts the recording of Art-Net Recorder  Button 1.

WDArtNetRecorderStop

WDArtNetRecorderStop(ID)

Example:
WDArtNetRecorderStop(1)

Stops the recording of Art-Net Recorder  Button 1.

WDArtNetRecorderUnfix

WDArtNetRecorderUnfix(ID)

Example:
WDArtNetRecorderUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Art-Net Recorder  button with ID 5.
"Fix" influences whether the Widget is only visible on the Page it was created on, or on all Pages. 

WDArtNetSnapshotActivate

WDArtNetSnapshotActivate(ID)

Example:
WDArtNetSnapshotActivate(1)

Executes the Art-Net Snapshot  Button 1. This command does stop current fades of other running
Art-Net snapshots beforehand. This is an advantage when using multiple buttons in the same
universe. Art-Net always transmitts the entire universe, not only programmed channels (not specified
channels=0). If current fades are not stopped, all channels would bounce between the fade value and
0.
When multiple snapshots apply to different universes, this command has the disadvantage to stop a
channel's fade in between without setting it to a new value. In that scenario, please use the
command WDArtNetSnapshotActivateAllFade,ID.
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WDArtNetSnapshotActivateAllFade

WDArtNetSnapshotActivateAllFade(ID)

Example:
WDArtNetSnapshotActivateAllFade(1)

Executes the Art-Net Snapshot  Button 1. This command does not stop current fades of other
running Art-Net snapshots beforehand. This is an advantage when using multiple buttons in different
universes.
When multiple buttons apply to the same universe, please use the command
WDArtNetSnapshotActivate,ID as this stops all fades beforehand.

WDArtNetSnapshotCapture

WDArtNetSnapshotCapture(ID)

Example:
WDArtNetSnapshotCapture(1)

Art-Net Snapshot  Button 1 captures the current Art-Net status of the Art-Net Subnet and Universe
set up in the Button Properties and overwrites the Art-Net values stored to this button before. If you
like to merge the values (HTP), use the command 
WDArtNetSnapshotHTPMerge,ID,Subnet,Universe.

WDArtNetSnapshotClear

WDArtNetSnapshotClear(ID)

Example:
WDArtNetSnapshotClear(1)

This clears the programmed channel(s) from Art-Net Snapshot  Button 1. If the button is then
clicked, all values for the specified universe would fade to 0.

WDArtnetSnapshotClickImage

WDArtnetSnapshotClickImage(ID,File)

Example:
WDArtnetSnapshotClickImage(1,"C:\coolux\content\buttonImage10.jpg")

Changes the look of the Art-Net Snapshot  Button with ID 1 - it loads the image
"buttonImage10.jpg" that was saved under "C:\coolux\content" and displays it when the Art-Net
Snapshot is in the mode "Click".

WDArtNetSnapshotCssStyleDisable

WDArtNetSnapshotCssStyleDisable(ID,StyleID)

Example:
WDArtNetSnapshotCssStyleDisable(5,2)
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Disables the CSS Style  with ID 2 in the Item Properties of the Art-Net Snapshot  button with ID
5.

WDArtNetSnapshotCssStyleEdit

WDArtNetSnapshotCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDArtNetSnapshotCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Art-Net Snapshot  button with ID 5.
The parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDArtNetSnapshotCssStyleEnable

WDArtNetSnapshotCssStyleEnable(ID,StyleID)

Example:
WDArtNetSnapshotCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Art-Net Snapshot  button with ID
5.

WDArtNetSnapshotCut

WDArtNetSnapshotCut(ID)

Example:
WDArtNetSnapshotCut(1)

This applies the stored values of Art-Net Snapshot  Button 1 directly without fading.

WDArtNetSnapshotFix

WDArtNetSnapshotFix(ID)

Example:
WDArtNetSnapshotFix(5)

This activates the option "Fix" in the Item Properties of the Art-Net Snapshot  button with ID 5.
"Fix" influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDArtNetSnapshotHTPMerge

WDArtNetSnapshotHTPMerge(ID,Subnet,Universe)

Example:
WDArtNetSnapshotHTPMerge(1,2,3)

Art-Net Snapshot  Button 1 captures the current Art-Net status of the Art-Net Subnet 2 and
Universe 3 and merges the status with the status stored to this button before. The merge uses the
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method HTP: highest takes precedence, meaning that the largest value is stored. If you like to
overwrite the values (i.e. LTP), use the command WDArtNetSnapshotCapture,ID.

WDArtnetSnapshotImage

WDArtnetSnapshotImage(ID,File)

Example:
WDArtnetSnapshotImage(1,"C:\coolux\content\buttonImage10.jpg")

Changes the look of the Art-Net Snapshot  Button with ID 1 - it loads the image
"buttonImage10.jpg" that was saved under "C:\coolux\content" and displays it when the Art-Net
Snapshot is in the mode "Release".

WDArtNetSnapshotLocation

WDArtNetSnapshotLocation(ID,X,Y)

Example:
WDArtNetSnapshotLocation(5,100,200)

Sets the position of the Art-Net Snapshot  button with ID 5 to 100px horizontally and 200px
vertically. 0,0 is the top left corner of the Page.

WDArtNetSnapshotLocationLeft

WDArtNetSnapshotLocationLeft(ID,X)

Example:
WDArtNetSnapshotLocationLeft(5,100)

Sets the position of the Art-Net Snapshot  button with ID 5 to 100px horizontally but remains the
current vertical position. 0,0 is the top left corner of the Page.

WDArtNetSnapshotLocationTop

WDArtNetSnapshotLocationTop(ID,Y)

Example:
WDArtNetSnapshotLocationTop(5,200)

Sets the position of the Art-Net Snapshot  button with ID 5 to 200px vertically but remains the
current horizontal position. 0,0 is the top left corner of the Page.

WDArtnetSnapshotMouseOverImage

WDArtnetSnapshotMouseOverImage(ID,File)

Example:
WDArtnetSnapshotMouseOverImage(1,"C:\coolux\content\buttonImage10.jpg")
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Changes the look of the Art-Net Snapshot  Button with ID 1 - it loads the image
"buttonImage10.jpg" that was saved under "C:\coolux\content" and displays it when the Art-Net
Snapshot is in the mode "Highlight".

WDArtNetSnapshotSet16Bit

WDArtNetSnapshotSet16Bit(ID,Ch,Val)

Example:
WDArtNetSnapshotSet16Bit(1,50,255)

This command allows to change the stored value of the 16Bit Art-Net channel 50 to the value 255 in
the Art-Net Snapshot  Button 1

WDArtNetSnapshotSet8Bit

WDArtNetSnapshotSet8Bit(ID,Ch,Val)

Example:
WDArtNetSnapshotSet8Bit(1,50,255)

This command allows to change the stored value of the 8Bit Art-Net channel 50 to the value 255 in
the Art-Net Snapshot  Button 1.

WDArtNetSnapshotSize

WDArtNetSnapshotSize(ID,Width,Height)

Example:
WDArtNetSnapshotSize(5,100,40)

Sets the size of the Art-Net Snapshot  button with ID 5 to a width of 100px and a height of 40px.

WDArtNetSnapshotSizeHeight

WDArtNetSnapshotSizeHeight(ID,Height)

Example:
WDArtNetSnapshotSizeHeight(5,40)

Sets the size of the Art-Net Snapshot  button with ID 5 to a height of 40px but remains the current
width.

WDArtNetSnapshotSizeWidth

WDArtNetSnapshotSizeWidth(ID,Width)

Example:
WDArtNetSnapshotSizeWidth(5,100)

Sets the size of the Art-Net Snapshot  button with ID 5 to a width of 100px but remains the current
height.
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WDArtNetSnapshotStopAllFades

WDArtNetSnapshotStopAllFades

Example:
WDArtNetSnapshotStopAllFades

This stops all fades executed through currently running Art-Net Snapshot  Buttons. The
programmed channel(s) simply stop at their current value.

WDArtNetSnapshotStopFade

WDArtNetSnapshotStopFade(ID)

Example:
WDArtNetSnapshotStopFade(1)

This stops the fade executed from Art-Net Snapshot  Button 1. The programmed channel(s) simply
stop at their current value.

WDArtNetSnapshotUnfix

WDArtNetSnapshotUnfix(ID)

Example:
WDArtNetSnapshotUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Art-Net Snapshot  button with ID 5.
"Fix" influences whether the Widget is only visible on the Page it was created on, or on all Pages. 

WDButtonClick

WDButtonClick(ID)

Example:
WDButtonClick(1)

This clicks the Button with ID 1. Please note, that this command refers to legacy versions including
the item "Button". If you like to click a Custom Script Button instead, use the command 
WDCustomScriptClick,ID .

WDButtonText

WDButtonText(ID,Text)

Example:
WDButtonText(1,"Flip")

This labels the Button with ID 1 with the word "Flip". Please note, that this command refers to legacy
versions including the item "Button". If you like to label a Custom Script Button instead, use the
command WDCustomScriptText,ID,Text .
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WDButtonTextColour

WDButtonTextColour(ID,R,G,B)

Example:
WDButtonTextColour(1,255,90,0)

This changes the text color of the Button with ID 1 to orange. The values for R,G,B range from 0 to
255. Please note, that this command refers to legacy versions including the item "Button". If you like
to change a Custom Script Button instead, use the command 
WDCustomScriptTextColour,ID,R,G,B .

WDCameraPointTrackerBlur

WDCameraPointTrackerBlur(Value)

Example:
WDCameraPointTrackerBlur(2)

This sets the option "Blur" in the section "Image Processing" in the Camera Tracker  dialog to the
value 2.

WDCameraPointTrackerColor

WDCameraPointTrackerColor(R,G,B)

Example:
WDCameraPointTrackerColor(0,255,0)

This sets the color for Color Tracking in the section "Image Processing" in the Camera Tracker
dialog to pure green. Note that the option "Color Tracking" needs to be enabled too, e.g. via the
command WDCameraPointTrackerEnableColorTracking.

WDCameraPointTrackerDamping

WDCameraPointTrackerDamping(Value)

Example:
WDCameraPointTrackerDamping(0.25)

This sets the option "Damping" in the section "Point Tracker" in the Camera Tracker  dialog to the
value 0.25.

WDCameraPointTrackerDisableAverageColor

WDCameraPointTrackerDisableAverageColor

Example:
WDCameraPointTrackerDisableAverageColor

This disables the option "Output Average Color" in the section "Color Processing" in the Camera
Tracker  dialog.
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WDCameraPointTrackerDisableColorTracking

WDCameraPointTrackerDisableColorTracking

Example:
WDCameraPointTrackerDisableColorTracking

This enables the option "Color Tracking" in the section "Image Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerDisableInvert

WDCameraPointTrackerDisableInvert

Example:
WDCameraPointTrackerDisableInvert

This disables the option "Invert" in the section "Image Processing" in the Camera Tracker  dialog.

WDCameraPointTrackerDisableLookup

WDCameraPointTrackerDisableLookup

Example:
WDCameraPointTrackerDisableLookup

This disables the option "Use Lookup" in the section "Image Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerDisableMask

WDCameraPointTrackerDisableMask

Example:
WDCameraPointTrackerDisableMask

This disables the option "Use Mask" in the section "Image Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerDisableMotionPrediction

WDCameraPointTrackerDisableMotionPrediction

Example:
WDCameraPointTrackerDisableMotionPrediction

This disables the option "Motion Prediction" in the section "Point Tracker" in the Camera Tracker
dialog.

WDCameraPointTrackerDisableMuteUI
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WDCameraPointTrackerDisableMuteUI

Example:
WDCameraPointTrackerDisableMuteUI

This disables the option "Mute UI" in the general section in the Camera Tracker  dialog.

WDCameraPointTrackerDisableProcessing

WDCameraPointTrackerDisableProcessing

Example:
WDCameraPointTrackerDisableProcessing

This disables the processing from the Camera Tracker. To enable it again, please use the command 
WDCameraPointTrackerEnableProcessing. Note that there is no option to en-, or disable

processing within the Camera Tracker dialog. If you are interested to save performance of the Camera
Tracker, you can also use the option "Mute UI" (or the command 
WDCameraPointTrackerEnableMuteUI) which stops the rendering of the camera image in the

dialog but not the data processing.

WDCameraPointTrackerEnableAverageColor

WDCameraPointTrackerEnableAverageColor

Example:
WDCameraPointTrackerEnableAverageColor

This enables the option "Output Average Color" in the section "Color Processing" in the Camera
Tracker  dialog.

WDCameraPointTrackerEnableColorTracking

WDCameraPointTrackerEnableColorTracking

Example:
WDCameraPointTrackerEnableColorTracking

This enables the option "Color Tracking" in the section "Image Processing" in the Camera Tracker
dialog. Note that the color for "Color Tracking" can be set too, e.g. via the command 
WDCameraPointTrackerColor.

WDCameraPointTrackerEnableInvert

WDCameraPointTrackerEnableInvert

Example:
WDCameraPointTrackerEnableInvert

This enables the option "Invert" in the section "Image Processing" in the Camera Tracker  dialog.

WDCameraPointTrackerEnableLookup
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WDCameraPointTrackerEnableLookup

Example:
WDCameraPointTrackerEnableLookup

This enables the option "Use Lookup" in the section "Image Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerEnableMask

WDCameraPointTrackerEnableMask

Example:
WDCameraPointTrackerEnableMask

This enables the option "Use Mask" in the section "Image Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerEnableMotionPrediction

WDCameraPointTrackerEnableMotionPrediction

Example:
WDCameraPointTrackerEnableMotionPrediction

This enables the option "Motion Prediction" in the section "Point Tracker" in the Camera Tracker
dialog.

WDCameraPointTrackerEnableMuteUI

WDCameraPointTrackerEnableMuteUI

Example:
WDCameraPointTrackerEnableMuteUI

This enables the option "Mute UI" in the general section in the Camera Tracker  dialog.
 If you are interested to save performance of the Camera Tracker, you can also use the command 
WDCameraPointTrackerDisableProcessing which stops not only the rendering but the entire

data processing.

WDCameraPointTrackerEnableProcessing

WDCameraPointTrackerEnableProcessing

Example:
WDCameraPointTrackerEnableProcessing

This enables the processing from the Camera Tracker, if it was disabled before with the command 
WDCameraPointTrackerDisableProcessing. Note that there is no option to en-, or disable

processing within the Camera Tracker dialog.

WDCameraPointTrackerIDStart
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WDCameraPointTrackerIDStart(Value)

Example:
WDCameraPointTrackerIDStart(2)

This sets the option "ID Start" in the general section in the Camera Tracker  dialog to the value 2.

WDCameraPointTrackerInflate

WDCameraPointTrackerInflate(Value)

Example:
WDCameraPointTrackerInflate(10)

This sets the option "Inflate" in the section "Image Processing" in the Camera Tracker  dialog to
the value 10.

WDCameraPointTrackerMaxDelta

WDCameraPointTrackerMaxDelta(Value)

Example:
WDCameraPointTrackerMaxDelta(50)

This sets the option "Max Delta" in the section "Point Tracker" in the Camera Tracker  dialog to
the value 50.

WDCameraPointTrackerMaxHeight

WDCameraPointTrackerMaxHeight(Value)

Example:
WDCameraPointTrackerMaxHeight(50)

This sets the option "Max Height" in the section "Point Tracker" in the Camera Tracker  dialog to
the value 50.

WDCameraPointTrackerMaxWidth

WDCameraPointTrackerMaxWidth(Value)

Example:
WDCameraPointTrackerMaxWidth(50)

This sets the option "Max Width" in the section "Point Tracker" in the Camera Tracker  dialog to
the value 50.

WDCameraPointTrackerMinHeight

WDCameraPointTrackerMinHeight(Value)
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Example:
WDCameraPointTrackerMinHeight(10)

This sets the option "Min Height" in the section "Point Tracker" in the Camera Tracker  dialog to
the value 10.

WDCameraPointTrackerMinWidth

WDCameraPointTrackerMinWidth(Value)

Example:
WDCameraPointTrackerMinWidth(10)

This sets the option "Min Width" in the section "Point Tracker" in the Camera Tracker  dialog to
the value 10.

WDCameraPointTrackerMotionFactor

WDCameraPointTrackerMotionFactor(Value)

Example:
WDCameraPointTrackerMotionFactor(0.25)

This sets the option "Factor" in the section "Point Tracker" in the Camera Tracker  dialog to the
value 0.25.

WDCameraPointTrackerMotionModeBottom

WDCameraPointTrackerMotionModeBottom

Example:
WDCameraPointTrackerMotionModeBottom

This sets the option "Mode" in the section "Point Tracker" in the Camera Tracker  dialog to the
value "Bottom".

WDCameraPointTrackerMotionModeCenter

WDCameraPointTrackerMotionModeCenter

Example:
WDCameraPointTrackerMotionModeCenter

This sets the option "Mode" in the section "Point Tracker" in the Camera Tracker  dialog to the
value "Center".

WDCameraPointTrackerMotionModeTop

WDCameraPointTrackerMotionModeTop

Example:
WDCameraPointTrackerMotionModeTop
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This sets the option "Mode" in the section "Point Tracker" in the Camera Tracker  dialog to the
value "Top".

WDCameraPointTrackerPoints

WDCameraPointTrackerPoints(Value)

Example:
WDCameraPointTrackerPoints(5)

This sets the option "ID Start" in the general section in the Camera Tracker  dialog to the value 2.

WDCameraPointTrackerShrink

WDCameraPointTrackerShrink(Value)

Example:
WDCameraPointTrackerShrink(2)

This sets the option "Shrink" in the section "Image Processing" in the Camera Tracker  dialog to
the value 2.

WDCameraPointTrackerThreshold

WDCameraPointTrackerThreshold(Value)

Example:
WDCameraPointTrackerThreshold(50)

This sets the option "Threshold" in the section "Image Processing" in the Camera Tracker  dialog
to the value 50.

WDCameraPointTrackerTouchOutDisableInvX

WDCameraPointTrackerTouchOutDisableInvX

Example:
WDCameraPointTrackerTouchOutDisableInvX

This disables the option "Inv X" in the section "Touch Output Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerTouchOutDisableInvY

WDCameraPointTrackerTouchOutDisableInvY

Example:
WDCameraPointTrackerTouchOutDisableInvY

This disables the option "Inv Y" in the section "Touch Output Processing" in the Camera Tracker
dialog.
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WDCameraPointTrackerTouchOutDisableSwap

WDCameraPointTrackerTouchOutDisableSwap

Example:
WDCameraPointTrackerTouchOutDisableSwap

This disables the option "Swap" in the section "Touch Output Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerTouchOutDisableTUIO

WDCameraPointTrackerTouchOutDisableTUIO

Example:
WDCameraPointTrackerTouchOutDisableTUIO

This disables the option "TUIO Output" in the section "Touch Output Processing" in the Camera
Tracker  dialog.

WDCameraPointTrackerTouchOutEnableInvX

WDCameraPointTrackerTouchOutEnableInvX

Example:
WDCameraPointTrackerTouchOutEnableInvX

This enables the option "Inv X" in the section "Touch Output Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerTouchOutEnableInvY

WDCameraPointTrackerTouchOutEnableInvY

Example:
WDCameraPointTrackerTouchOutEnableInvY

This enables the option "Inv Y" in the section "Touch Output Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerTouchOutEnableSwap

WDCameraPointTrackerTouchOutEnableSwap

Example:
WDCameraPointTrackerTouchOutEnableSwap

This enables the option "Swap" in the section "Touch Output Processing" in the Camera Tracker
dialog.

WDCameraPointTrackerTouchOutEnableTUIO
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WDCameraPointTrackerTouchOutEnableTUIO

Example:
WDCameraPointTrackerTouchOutEnableTUIO

This enables the option "TUIO Output" in the section "Touch Output Processing" in the Camera
Tracker  dialog.

WDCameraPointTrackerTouchOutMutePointTime

WDCameraPointTrackerTouchOutMutePointTime(Value)

Example:
WDCameraPointTrackerTouchOutMutePointTime(12.5)

This sets the option "Mute Point Time" in the section "Touch Output Processing" in the Camera
Tracker  dialog to the value 12.5.

WDCameraPointTrackerTouchOutRangeHeight

WDCameraPointTrackerTouchOutRangeHeight(Value)

Example:
WDCameraPointTrackerTouchOutRangeHeight(1080)

This sets the option "h" (height of range) in the section "Touch Output Processing" in the Camera
Tracker  dialog to the value 1080.

WDCameraPointTrackerTouchOutRangeWidth

WDCameraPointTrackerTouchOutRangeWidth(Value)

Example:
WDCameraPointTrackerTouchOutRangeWidth(1920)

This sets the option "w" (width of range) in the section "Touch Output Processing" in the Camera
Tracker  dialog to the value 1080.

WDCameraPointTrackerTouchOutRangeX

WDCameraPointTrackerTouchOutRangeX(Value)

Example:
WDCameraPointTrackerTouchOutRangeX(100)

This sets the option "x" (horizontal offset of range) in the section "Touch Output Processing" in the 
Camera Tracker  dialog to the value 100.

WDCameraPointTrackerTouchOutRangeY

WDCameraPointTrackerTouchOutRangeY(Value)
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Example:
WDCameraPointTrackerTouchOutRangeY(100)

This sets the option "y" (vertical offset of range) in the section "Touch Output Processing" in the 
Camera Tracker  dialog to the value 100.

WDCameraPointTrackerTouchOutResolutionHeight

WDCameraPointTrackerTouchOutResolutionHeight(Value)

Example:
WDCameraPointTrackerTouchOutResolutionHeight(768)

This sets the option "h" (height of resolution) in the section "Touch Output Processing" in the Camera
Tracker  dialog to the value 768.

WDCameraPointTrackerTouchOutResolutionWidth

WDCameraPointTrackerTouchOutResolutionWidth(Value)

Example:
WDCameraPointTrackerTouchOutResolutionWidth(1024)

This sets the option "w" (width of resolution) in the section "Touch Output Processing" in the Camera
Tracker  dialog to the value 1024.

WDClose

WDClose

Example:
WDClose

Closes the current WD project. A pop-up dialog is going to ask you if you want to save the current
changes.

WDCloseSilent

WDCloseSilent

Example:
WDCloseSilent

Closes the current WD project without saving it (there will be no pop-up dialog asking to save the
project).

WDColorPickerBGColor

WDColorPickerBGColor(ID,R,G,B)

Example:
WDColorPickerBGColor(6,255,90,0)
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Changes the background color of the Color Picker  with the ID 6 in WD to orange. The values for
R,G,B range from 0 to 255.

WDColorPickerCssStyleDisable

WDColorPickerCssStyleDisable(ID,StyleID)

Example:
WDColorPickerCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Color Picker  with ID 5.

WDColorPickerCssStyleEdit

WDColorPickerCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDColorPickerCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Color Picker  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDColorPickerCssStyleEnable

WDColorPickerCssStyleEnable(ID,StyleID)

Example:
WDColorPickerCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Color Picker  with ID 5.

WDColorPickerDevices

WDColorPickerDevices(ID,1.1 1.2 1.3)

Example:
WDColorPickerDevices(6,"1.1 2.4")

Transfers the RGB-values of the Color Picker  with the ID 6 in WD to the Color FX fader 1-3 of
layers 1,1 and 2,4 in PB (before version 5!).

WDColorPickerFix

WDColorPickerFix(ID)

Example:
WDColorPickerFix(5)

This activates the option "Fix" in the Item Properties of the Color Picker  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.
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WDColorPickerLocation

WDColorPickerLocation(ID,X,Y)

Example:
WDColorPickerLocation(5,100,200)

Sets the position of the Color Picker  with ID 5 to 100px horizontally and 200px vertically. 0,0 is
the top left corner of the Page.

WDColorPickerLocationLeft

WDColorPickerLocationLeft(ID,X)

Example:
WDColorPickerLocationLeft(5,100)

Sets the position of the Color Picker  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDColorPickerLocationTop

WDColorPickerLocationTop(ID,Y)

Example:
WDColorPickerLocationTop(5,200)

Sets the position of the Color Picker  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDColorPickerSetHSB

WDColorPickerSetHSB(ID,Hue,Saturation,Brightness)

Example:
WDColorPickerSetHSB(1,200,255,190)

Changes the color of the Color Picker  with the ID 6 in WD to purple (Hue=150, Saturation=0,
Brightness=200). The values for H,S,B range from 0 to 255. Alternatively, you can specify the color
with the command WDColorPickerSetRGB.

WDColorPickerSetRGB

WDColorPickerSetRGB(ID,Red,Green,Blue)

Example:
WDColorPickerSetRGB(1,150,0,200)

Changes the color of the Color Picker  with the ID 6 in WD to purple (Red=150, Green=0,
Blue=200). The values for R,G,B range from 0 to 255. Alternatively, you can specify the color with the
command WDColorPickerSetHSB.
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WDColorPickerSize

WDColorPickerSize(ID,Width,Height)

Example:
WDColorPickerSize(5,100,40)

Sets the size of the Color Picker  with ID 5 to a width of 100px and a height of 40px.

WDColorPickerSizeHeight

WDColorPickerSizeHeight(ID,Height)

Example:
WDColorPickerSizeHeight(5,40)

Sets the size of the Color Picker  with ID 5 to a height of 40px but remains the current width.

WDColorPickerSizeWidth

WDColorPickerSizeWidth(ID,Width)

Example:
WDColorPickerSizeWidth(5,100)

Sets the size of the Color Picker  with ID 5 to a width of 100px but remains the current height.

WDColorPickerUnfix

WDColorPickerUnfix(ID)

Example:
WDColorPickerUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Color Picker  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDConnect

WDConnect(IP,Domain)

Example:
WDConnect("10.169.10.65",0)

Connects the Widget Designer to Pandoras Box with the IP address 10.169.10.65. The connection
can also be set up via IP Configuration  in WD.

WDConnectBackup

WDConnectBackup
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Example:
WDConnectBackup

Connects the Widget Designer to the Pandoras Box Backup after it was disconnected. See the topic 
IP Configuration  in WD for more information.

WDConnectMaster

WDConnectMaster

Example:
WDConnectMaster

Connects the Widget Designer to the Pandoras Box Master after it was disconnected. See the topic 
IP Configuration  in WD for more information.

WDControlBringToFront

WDControlBringToFront(ControlName)

Example:
WDControlBringToFront("Customscript2")

Changes the Z-Order and brings Custom Script Button 2 to the front. The name of a Widget is
suggested in the Script Assistant and can be changed in the Widget's Item Properties. 

WDControlFix

WDControlFix(ControlName)

Example:
WDControlFix("CustomScript5")

This activates the option "Fix" within the Item Properties of CustomScript Button 5. The name of a
Widget is suggested in the Script Assistant and can be changed in the Widget's Item Properties.
"Fix" influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDControlHide

WDControlHide(ControlName)

Example:
WDControlHide("Customscript2")

Hides Custom Script Button 2 outside of its page context. The name of a Widget is suggested in the
Script Assistant and can be changed in the Widget's Item Properties. 

This way you can hide a control that originates from another page. This may be done e.g. as On 
Page  Enter or Leave script.

WDControlSendToBack
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WDControlSendToBack(ControlName)

Example:
WDControlSendToBack("Customscript2")

Changes the Z-Order and sends Custom Script Button 2 to the back. The name of a Widget is
suggested in the Script Assistant and can be changed in the Widget's Item Properties. 

WDControlSetPage

WDControlSetPage(ControlName,Page)

Example:
WDControlSetPage("CustomScript5","Page2")

This moves the Widget CustomScript Button 5 to Page2. The name of a Widget is suggested in the
Script Assistant and can be changed in the Widget's Item Properties. The name of the Page is also
suggested and can be changed in the Page Properties .

WDControlSetPosition

WDControlSetPosition(ControlName,X,Y)

Example:
WDControlSetPosition("CustomScript5",100,-10)

Sets the position of CustomScript Button 5 to 100px horizontally and 200px vertically. The name of a
Widget is suggested in the Script Assistant and can be changed in the Widget's Item Properties.
The position is set absolutely, whereas 0,0 is the top left corner of the Page. 

Alternatively, the command WDControlSetPositionRelative sets the relative position.

WDControlSetPositionRelative

WDControlSetPositionRelative(ControlName,X,Y)

Example:
WDControlSetPositionRelative("CustomScript5",100,)

Sets the position of CustomScript Button 5. The name of a Widget is suggested in the Script
Assistant and can be changed in the Widget's Item Properties.
The command adds 100 pixels to the current horizontal position (the widget moves to the right) and
subtracts 10 pixels from the current vertical position (the widget moves up).
Alternatively, the command WDControlSetPosition sets the absolute position.

WDControlSetSize

WDControlSetSize(ControlName,Width,Height)

Example:
WDControlSetSize("CustomScript5",100,10)
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Sets the size of CustomScript Button 5 to a width of 100px and a height of 10px. The name of a
Widget is suggested in the Script Assistant and can be changed in the Widget's Item Properties.

WDControlShow

WDControlShow(ControlName)

Example:
WDControlShow("Customscript2")

Shows the Custom Script Button 2 outside of its page context. The name of a Widget is suggested in
the Script Assistant and can be changed in the Widget's Item Properties. 

This way you can show a control that originates from another page. This may be done e.g. as On 
Page  Enter or Leave script.

WDControlUnFix

WDControlUnFix(ControlName)

Example:
WDControlUnFix("CustomScript5")

This deactivates the option "Fix" within the Item Properties of CustomScript Button 5. The name of a
Widget is suggested in the Script Assistant and can be changed in the Widget's Item Properties.
"Fix" influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDCueListCancelWaits

WDCueListCancelWaits(ID)

Example:
WDCueListCancelWaits(1)

Cancels the current Wait time but does not continue executing the CueList.

WDCueListDeleteCue

WDCueListDeleteCue(ID,Cue)

Example:
WDCueListDeleteCue(1,5)

Deletes Cue 5 from CueList ID 1.

WDCueListFirstCue

WDCueListFirstCue(ID)

Example:
WDCueListFirstCue(1)
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Goes to the first cue in CueList 1 without running it.

WDCueListGo

WDCueListGo(ID)

Example:
WDCueListGo(1)

Starts the next Cue in CueList 1.

WDCueListGo-

WDCueListGo-(ID)

Example:
WDCueListGo-(1)

Goes one step back in CueList 1.

WDCueListGotoCue

WDCueListGotoCue(ID,Cue)

Example:
WDCueListGotoCue(1,5)

Jumps to Cue 5 in CueList 1.

WDCueListLastCue

WDCueListLastCue(ID)

Example:
WDCueListLastCue(1)

Goes to the last cue in CueList 1 without running it.

WDCueListNextCue

WDCueListNextCue(ID)

Example:
WDCueListNextCue(1)

Goes forward cue by cue in CueList 1 without running the Cue.

WDCueListPause

WDCueListPause(ID)
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Example:
WDCueListPause(1)

Pauses the CueList 1.

WDCueListPrevCue

WDCueListPrevCue(ID)

Example:
WDCueListPrevCue(1)

Goes back cue by cue in CueList 1 without running the Cue.

WDCueListRecall

WDCueListRecall(ID)

Example:
WDCueListRecall(1)

Recalls the current cue in CueList 1: sets the Cue back to its beginning and keeps the state of the
Cuelist (play / pause).

WDCueListResetJumps

WDCueListResetJumps(ID)

Example:
WDCueListResetJumps(1)

Sets the Jump Counter of every cue in CueList 1 back to 0.

WDCueTimerStart

WDCueTimerStart(ID)

Example:
WDCueTimerStart(2)

Starts the timeline of the Cue Timer with ID 2.

WDCueTimerStop

WDCueTimerStop(ID)

Example:
WDCueTimerStop(2)

Stops the timeline of the Cue Timer with ID 2.
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WDCustomScriptAddTextFromLabel

WDCustomScriptAddTextFromLabel(CustomScriptID,ID)

Example:
WDCustomScriptAddTextFromLabel(6,3)

Adds the text from Label  6 to the Custom Script Button  with the ID 3.

WDCustomScriptApplyCITPThumbnail

WDCustomScriptApplyCITPThumbnail(ID,FolderID,FileID)

Example:
WDCustomScriptApplyCITPThumbnail(5,1,2)

This depicts the thumbnail from the File and Folder ID 1,2 on Custom Script Button  5. Note that
the thumbnail overlays images for the clicked, released or highlight status and can only be reset with
the command WDCustomScriptResetCITPThumbnail. CITP Thumbnail Exchange can be setup

under Connections > PB Configuration . In Pandoras Box, please go to the Configuration tab >
Remote Control Protocols .

WDCustomScriptClick

WDCustomScriptClick(ID)

Example:
WDCustomScriptClick(5)

Clicks the Custom Script Button  with the ID 5. If the type of Custom Script Button 5 is "Toggle"
the command toggles the button.

Works for the Custom Script Button's type: Click, Flash, Toggle
Works for the Custom Script Button's state: Released or Clicked
Executes associated script: "On Click" or "On Release"

WDCustomScriptClickImage

WDCustomScriptClickImage(ID,File)

Example:
WDCustomScriptClickImage(5,"C:\coolux\clicked.png")

This sets the image for the clicked status of Custom Script Button  5 to the image saved under the
specified path.

WDCustomScriptClickImageResource

WDCustomScriptClickImageResource(ID,ResourceName)

Example:
WDCustomScriptClickImageResource(5,"Default\Button\Lock")
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This sets the image for the clicked status of Custom Script Button  5 to the image saved under the
specified name in the "Image Resource Manager " which is also accessible through the "Res"
button in the Item Properties dialog of the button.

WDCustomScriptClickToggle

WDCustomScriptClickToggle(ID)

Example:
WDCustomScriptClickToggle(5)

Sets the Custom Script Button  with ID 5 in the released mode and executes all commands. This
works only for Toggle Buttons which are in the Clicked mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash, 
Works for the Custom Script Button's state: Clicked, not: Released
Toggles the Toggle Custom Script Button's state: yes, to Released
Executes associated script: yes, "On Release"

WDCustomScriptCssStyleDisable

WDCustomScriptCssStyleDisable(ID,StyleID)

Example:
WDCustomScriptCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the CustomScript  button with ID 5.

WDCustomScriptCssStyleEdit

WDCustomScriptCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDCustomScriptCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the CustomScript  button with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDCustomScriptCssStyleEnable

WDCustomScriptCssStyleEnable(ID,StyleID)

Example:
WDCustomScriptCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the CustomScript  button with ID 5.

WDCustomScriptExecuteClick

WDCustomScriptExecuteClick(ID)
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Example:
WDCustomScriptExecuteClick(5)

Executes the "On Click Script" of Custom Script Button  with ID 5 without changing its Clicked /
Released mode.

Works for the Custom Script Button's type: Click, Flash, Toggle
Works for the Custom Script Button's state: Clicked, Released
Toggles the Toggle Custom Script Button's state: no
Executes script: yes, only "On Click"

WDCustomScriptExecuteEnter

WDCustomScriptExecuteEnter(ID)

Example:
WDCustomScriptExecuteEnter(5)

Executes the "On Mouse Enter Script" of Custom Script Button  with ID 5.

Works for the Custom Script Button's type: Click, Flash, Toggle
Works for the Custom Script Button's state: Clicked, Released
Toggles the Toggle Custom Script Button's state: no
Executes script: yes, only "On Enter"

WDCustomScriptExecuteLeave

WDCustomScriptExecuteLeave(ID)

Example:
WDCustomScriptExecuteLeave(5)

Executes the "On Mouse Leave Script" of Custom Script Button  with ID 5.

Works for the Custom Script Button's type: Click, Flash, Toggle
Works for the Custom Script Button's state: Clicked, Released
Toggles the Toggle Custom Script Button's state: no
Executes script: yes, only "On Leave"

WDCustomScriptExecuteRelease

WDCustomScriptExecuteRelease(ID)

Example:
WDCustomScriptExecuteRelease(5)

Executes the "On Release Script" of Custom Script Button  with ID 5 without changing its
Clicked / Released mode.

Works for the Custom Script Button's type: Flash, Toggle, not: Click
Works for the Custom Script Button's state: Clicked, Released
Toggles the Toggle Custom Script Button's state: no
Executes script: yes, only "On Release"
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WDCustomScriptFix

WDCustomScriptFix(ID)

Example:
WDCustomScriptFix(3)

Sets the option “Fix” for the Custom Script Button  with the ID 3, so that this CS Button is shown
on every page inside WD now.

WDCustomScriptHighlightImage

WDCustomScriptHighlightImage(ID,File)

Example:
WDCustomScriptHighlightImage(5,"C:\coolux\highlight.png")

This sets the image for the highlight status of Custom Script Button  5 to the image saved under
the specified path.

WDCustomScriptHighlightImageResource

WDCustomScriptHighlightImageResource(ID,ResourceName)

Example:
WDCustomScriptHighlightImageResource(5,"Default\Button_MouseOver.png")

This sets the image for the highlight status of Custom Script Button  5 to the image saved under
the specified name in the "Image Resource Manager " which is also accessible through the "Res"
button in the Item Properties dialog of the button.

WDCustomScriptLocation

WDCustomScriptLocation(ID,X,Y)

Example:
WDCustomScriptLocation(5,100,200)

Sets the position of the CustomScript  button with ID 5 to 100px horizontally and 200px vertically.
0,0 is the top left corner of the Page.

WDCustomScriptLocationLeft

WDCustomScriptLocationLeft(ID,X)

Example:
WDCustomScriptLocationLeft(5,100)

Sets the position of the CustomScript  button with ID 5 to 100px horizontally but remains the
current vertical position. 0,0 is the top left corner of the Page.

WDCustomScriptLocationTop
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WDCustomScriptLocationTop(ID,Y)

Example:
WDCustomScriptLocationTop(5,200)

Sets the position of the CustomScript  button with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDCustomScriptMuteClickDisabled

WDCustomScriptMuteClickDisabled(ID)

Example:
WDCustomScriptMuteClickDisabled(5)

This deactivates the option "Mute Click Script" within the Item Properties of Custom Script Button
5.

WDCustomScriptMuteClickEnabled

WDCustomScriptMuteClickEnabled(ID)

Example:
WDCustomScriptMuteClickEnabled(5)

This activates the option "Mute Click Script" within the Item Properties of Custom Script Button  5
to protect it from accidental double-clicks.

WDCustomScriptMuteClickTime

WDCustomScriptMuteClickTime(ID,Time)

Example:
WDCustomScriptMuteClickTime(5,500)

This sets the time for the option "Mute Click Script" within the Item Properties of Custom Script
Button  5 to 500ms.

WDCustomScriptQueueClickNext

WDCustomScriptQueueClickNext(ID)

Example:
WDCustomScriptQueueClickNext(1)

Clicks the next button of CustomScriptQueue 1.

WDCustomScriptQueueClickPrevious

WDCustomScriptQueueClickPrevious(ID)

935

935

935

935



1492

Example:
WDCustomScriptQueueClickPrevious(1)

Clicks the first button of CustomScriptQueue 1 if the queue has already finished.

WDCustomScriptQueueGotoPrevious

WDCustomScriptQueueGotoPrevious(ID)

Example:
WDCustomScriptQueueGotoPrevious(1)

Moves the marker of CustomScriptQueue 1 to the previous button without executing its script.

WDCustomScriptQueueHide

WDCustomScriptQueueHide

Example:
WDCustomScriptQueueHide

Hides the CustomScriptQueue connecting lines from the GUI.

WDCustomScriptQueueReset

WDCustomScriptQueueReset(ID)

Example:
WDCustomScriptQueueReset(ID)

Resets the CustomScriptQueue 1.

WDCustomScriptQueueShow

WDCustomScriptQueueShow

Example:
WDCustomScriptQueueShow

Shows the CustomScriptQueue connecting lines in the GUI.

WDCustomScriptReleaseImage

WDCustomScriptReleaseImage(ID,File)

Example:
WDCustomScriptReleaseImage(5,"C:\coolux\released.png")

This sets the image for the released status of Custom Script Button  5 to the image saved under
the specified path.
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WDCustomScriptReleaseImageResource

WDCustomScriptReleaseImageResource(ID,ResourceName)

Example:
WDCustomScriptReleaseImageResource(5,"Default\Button\Unlock")

This sets the image for the released status of Custom Script Button  5 to the image saved under
the specified name in the "Image Resource Manager " which is also accessible through the "Res"
button in the Item Properties dialog of the button.

WDCustomScriptReleaseToggle

WDCustomScriptReleaseToggle(ID)

Example:
WDCustomScriptReleaseToggle(5)

Clicks the Custom Script Button  with ID 5 and executes all commands. If it is a "Toggle" button,
the script works only if it is in Released mode.

Works for the Custom Script Button's type: Click, Flash, Toggle
Works for the Custom Script Button's state: Released; not: Clicked
Toggles the Toggle Custom Script Button's state: yes, to Clicked
Executes associated script: yes, "On Click" ("On Release" only for a Flash button)

WDCustomScriptResetCITPThumbnail

WDCustomScriptResetCITPThumbnail(ID)

Example:
WDCustomScriptResetCITPThumbnail(ID)

This resets the CITP Thumbnail from Custom Script Button  5 which was applied with the
command WDCustomScriptApplyCITPThumbnail.

WDCustomScriptSilentClickToggle

WDCustomScriptSilentClickToggle(ID)

Example:
WDCustomScriptSilentClickToggle(5)

Sets the Custom Script Button  with ID 5 in the released mode without executing commands. This
works only for Toggle Buttons which are in the Clicked mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Clicked, not: Released
Toggles the Toggle Custom Script Button's state: yes, to Released
Executes associated script: no

WDCustomScriptSilentClickToggleAll
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WDCustomScriptSilentClickToggleAll

Example:
WDCustomScriptSilentClickToggleAll

Sets all Custom Script Buttons  in the released mode without executing commands. This works
only for Toggle Buttons which are in the Clicked mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Clicked, not: Released
Toggles the Toggle Custom Script Button's state: yes, to Released
Executes associated script: no

WDCustomScriptSilentClickToggleAllBut

WDCustomScriptSilentClickToggleAllBut(ID1,ID2,...)

Example:
WDCustomScriptSilentClickToggleAllBut(5,9,12)

Sets all Custom Script Buttons  except ID 5,9 and 12 in the released mode without executing
commands. This works only for Toggle Buttons which are in the Clicked mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Clicked, not: Released
Toggles the Toggle Custom Script Button's state: yes, to Released
Executes associated script: no

WDCustomScriptSilentClickTogglePage

WDCustomScriptSilentClickTogglePage(PageName)

Example:
WDCustomScriptSilentClickTogglePage("Showroom2")

Sets all Custom Script Buttons  from page "Showroom2" in the released mode without executing
commands. This works only for Toggle Buttons which are in the Clicked mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Clicked, not: Released
Toggles the Toggle Custom Script Button's state: yes, to Released
Executes associated script: no

WDCustomScriptSilentReleaseToggle

WDCustomScriptSilentReleaseToggle(ID)

Example:
WDCustomScriptSilentReleaseToggle(5)

Clicks the Custom Script Button  with ID 5 without executing commands. This works only for
Toggle Buttons which are in the Released mode.
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Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Released; not: Clicked
Toggles the Toggle Custom Script Button's state: yes, to Clicked
Executes associated script: no

WDCustomScriptSilentReleaseToggleAll

WDCustomScriptSilentReleaseToggleAll

Example:
WDCustomScriptSilentReleaseToggleAll

Clicks all Custom Script Button  without executing commands. This works only for Toggle Buttons
which are in the Released mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Released; not: Clicked
Toggles the Toggle Custom Script Button's state: yes, to Clicked
Executes associated script: no

WDCustomScriptSilentReleaseToggleAllBut

WDCustomScriptSilentReleaseToggleAllBut(ID1,ID2,...)

Example:
WDCustomScriptSilentReleaseToggleAllBut(5,9,12)

Clicks all Custom Script Button  except ID 5,9 and 12 without executing commands. This works
only for Toggle Buttons which are in the Released mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Released; not: Clicked
Toggles the Toggle Custom Script Button's state: yes, to Clicked
Executes associated script: no

WDCustomScriptSilentReleaseTogglePage

WDCustomScriptSilentReleaseTogglePage(PageName)

Example:
WDCustomScriptSilentReleaseTogglePage("Showroom2")

Clicks all Custom Script Button  from page "Showroom2" without executing commands. This
works only for Toggle Buttons which are in the Released mode.

Works for the Custom Script Button's type: Toggle, not: Click, Flash
Works for the Custom Script Button's state: Released; not: Clicked
Toggles the Toggle Custom Script Button's state: yes, to Clicked
Executes associated script: no

WDCustomScriptSize
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WDCustomScriptSize(ID,Width,Height)

Example:
WDCustomScriptSize(5,100,40)

Sets the size of the CustomScript  button with ID 5 to a width of 100px and a height of 40px.

WDCustomScriptSizeHeight

WDCustomScriptSizeHeight(ID,Height)

Example:
WDCustomScriptSizeHeight(5,40)

Sets the size of the CustomScript  button with ID 5 to a height of 40px but remains the current
width.

WDCustomScriptSizeWidth

WDCustomScriptSizeWidth(ID,Width)

Example:
WDCustomScriptSizeWidth(5,100)

Sets the size of the CustomScript  button with ID 5 to a width of 100px but remains the current
height.

WDCustomScriptText

WDCustomScriptText(ID,Text)

Example:
WDCustomScriptText(3,"Flip")

Labels the Custom Script Button  with the ID 3 with the word "Flip".

WDCustomScriptTextColour

WDCustomScriptTextColour(ID,R,G,B)

Example:
WDCustomScriptTextColour(3,255,90,0)

Changes the text color of the Custom Script Button  with the ID 3 to orange. The values for R,G,B
range from 0 to 255.

WDCustomScriptTextFromLabel

WDCustomScriptTextFromLabel(CustomScriptID,ID)

Example:
WDCustomScriptTextFromLabel(2,4)
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Labels the Custom Script Button  with the ID 4 with the text from Label  2.

WDCustomScriptTint

WDCustomScriptTint(ID,Red,Green,Blue)

Example:
WDCustomScriptTint(5,0,255,0)

This tints the Custom Script Button  with the ID 5 in green.

WDCustomScriptUnfix

WDCustomScriptUnfix(ID)

Example:
WDCustomScriptUnfix(3)

Disables the option “Fix” for the Custom Script Button  with the ID 3, so that this CS Button is not
shown on every page inside WD any more.

WDDemoCssStyleDisable

WDDemoCssStyleDisable(ID,StyleID)

Example:
WDDemoCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Demo Widget with ID 5.

WDDemoCssStyleEdit

WDDemoCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDDemoCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Demo Widget with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDDemoCssStyleEnable

WDDemoCssStyleEnable(ID,StyleID)

Example:
WDDemoCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Demo Widget with ID 5.

WDDemoFix
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WDDemoFix(ID)

Example:
WDDemoFix(5)

This activates the option "Fix" in the Item Properties of the Demo Widget with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDDemoLocation

WDDemoLocation(ID,X,Y)

Example:
WDDemoLocation(5,100,200)

Sets the position of the Demo Widget with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.

WDDemoLocationLeft

WDDemoLocationLeft(ID,X)

Example:
WDDemoLocationLeft(5,100)

Sets the position of the Demo Widget with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDDemoLocationTop

WDDemoLocationTop(ID,Y)

Example:
WDDemoLocationTop(5,200)

Sets the position of the Demo Widget with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDDemoSize

WDDemoSize(ID,Width,Height)

Example:
WDDemoSize(5,100,40)

Sets the size of the Demo Widget with ID 5 to a width of 100px and a height of 40px.

WDDemoSizeHeight

WDDemoSizeHeight(ID,Height)
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Example:
WDDemoSizeHeight(5,40)

Sets the size of the Demo Widget with ID 5 to a height of 40px but remains the current width.

WDDemoSizeWidth

WDDemoSizeWidth(ID,Width)

Example:
WDDemoSizeWidth(5,100)

Sets the size of the Demo Widget with ID 5 to a width of 100px but remains the current height.

WDDemoUnfix

WDDemoUnfix(ID)

Example:
WDDemoUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Demo Widget with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDDigitalDisplayCssStyleDisable

WDDigitalDisplayCssStyleDisable(ID,StyleID)

Example:
WDDigitalDisplayCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Digital Display  with ID 5.

WDDigitalDisplayCssStyleEdit

WDDigitalDisplayCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDDigitalDisplayCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Digital Display  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDDigitalDisplayCssStyleEnable

WDDigitalDisplayCssStyleEnable(ID,StyleID)

Example:
WDDigitalDisplayCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Digital Display  with ID 5.
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WDDigitalDisplayFix

WDDigitalDisplayFix(ID)

Example:
WDDigitalDisplayFix(5)

This activates the option "Fix" in the Item Properties of the Digital Display  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDDigitalDisplayLocation

WDDigitalDisplayLocation(ID,X,Y)

Example:
WDDigitalDisplayLocation(5,100,200)

Sets the position of the Digital Display  with ID 5 to 100px horizontally and 200px vertically. 0,0 is
the top left corner of the Page.

WDDigitalDisplayLocationLeft

WDDigitalDisplayLocationLeft(ID,X)

Example:
WDDigitalDisplayLocationLeft(5,100)

Sets the position of the Digital Display  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDDigitalDisplayLocationTop

WDDigitalDisplayLocationTop(ID,Y)

Example:
WDDigitalDisplayLocationTop(5,200)

Sets the position of the Digital Display  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDDigitalDisplaySize

WDDigitalDisplaySize(ID,Width,Height)

Example:
WDDigitalDisplaySize(5,100,40)

Sets the size of the Digital Display  with ID 5 to a width of 100px and a height of 40px.

WDDigitalDisplaySizeHeight
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WDDigitalDisplaySizeHeight(ID,Height)

Example:
WDDigitalDisplaySizeHeight(5,40)

Sets the size of the Digital Display  with ID 5 to a height of 40px but remains the current width.

WDDigitalDisplaySizeWidth

WDDigitalDisplaySizeWidth(ID,Width)

Example:
WDDigitalDisplaySizeWidth(5,100)

Sets the size of the Digital Display  with ID 5 to a width of 100px but remains the current height.

WDDigitalDisplayUnfix

WDDigitalDisplayUnfix(ID)

Example:
WDDigitalDisplayUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Digital Display  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDDisable

WDDisable

Example:
WDDisable

Disables the GUI of Widget Designer. 

Please note, that you won´t have ANY access to the WD GUI anymore!

Enable the GUI for example via the incoming command (WDEnable) in the Remoting Tool . The
used connection has to be established first.

WDDisableAltF4

WDDisableAltF4

Example:
WDDisableAltF4

This disables the shortcut Alt+F4 which closes an application.

WDDisconnect

WDDisconnect
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Example:
WDDisconnect

Disconnects Widget Designer from both the Pandoras Box Master and Backup. To connect to PB
Master or Client System again, please go to Network Setup  in WD or use the WD command
WDConnect , WDConnectMaster  or WDConnectBackup .

WDDisconnectBackup

WDDisconnectBackup

Example:
WDDisconnectBackup

Disconnects the Widget Designer from Pandoras Box Backup. See the topic IP Configuration  in
WD for more information.

WDDisconnectMaster

WDDisconnectMaster

Example:
WDDisconnectMaster

Disconnects the Widget Designer from Pandoras Box Master. See the topic IP Configuration  in
WD for more information.

WDDownloadThumbnails

WDDownloadThumbnails

Example:
WDDownloadThumbnails

Downloads all Thumbnails from the connected PB.
Please make sure that the function to download Thumbnails  from PB is enabled!

WDDrawingCanvasClear

WDDrawingCanvasClear(ID)

Example:
WDDrawingCanvasClear(1)

Clears the interface of the Drawing Canvas with the ID 1.

WDDrawingCanvasCssStyleDisable

WDDrawingCanvasCssStyleDisable(ID,StyleID)
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Example:
WDDrawingCanvasCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Drawing Canvas  with ID 5.

WDDrawingCanvasCssStyleEdit

WDDrawingCanvasCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDDrawingCanvasCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Drawing Canvas  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDDrawingCanvasCssStyleEnable

WDDrawingCanvasCssStyleEnable(ID,StyleID)

Example:
WDDrawingCanvasCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Drawing Canvas  with ID 5.

WDDrawingCanvasFix

WDDrawingCanvasFix(ID)

Example:
WDDrawingCanvasFix(5)

This activates the option "Fix" in the Item Properties of the Drawing Canvas  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDDrawingCanvasLocation

WDDrawingCanvasLocation(ID,X,Y)

Example:
WDDrawingCanvasLocation(5,100,200)

Sets the position of the Drawing Canvas  with ID 5 to 100px horizontally and 200px vertically. 0,0
is the top left corner of the Page.

WDDrawingCanvasLocationLeft

WDDrawingCanvasLocationLeft(ID,X)

Example:
WDDrawingCanvasLocationLeft(5,100)
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Sets the position of the Drawing Canvas  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDDrawingCanvasLocationTop

WDDrawingCanvasLocationTop(ID,Y)

Example:
WDDrawingCanvasLocationTop(5,200)

Sets the position of the Drawing Canvas  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDDrawingCanvasSetBGCol

WDDrawingCanvasSetBGCol(ID,R,G,B)

Example:
WDDrawingCanvasSetBGCol(1,255,0,100)

Changes the current background color of the Drawing Canvas with the ID 1 to the color
R=255,G=0,B=100 (pink).

WDDrawingCanvasSetPenCol

WDDrawingCanvasSetPenCol(ID,R,G,B)

Example:
WDDrawingCanvasSetPenCol(1,255,0,0)

Changes the current pen color of the Drawing Canvas with the ID 1 to the color R=255,G=0,B=0 (red).

WDDrawingCanvasSetPenSize

WDDrawingCanvasSetPenSize(ID,Size)

Example:
WDDrawingCanvasSetPenSize(1,16)

Changes the current pen size of the Drawing Canvas with the ID 1 to the size 16.

WDDrawingCanvasSize

WDDrawingCanvasSize(ID,Width,Height)

Example:
WDDrawingCanvasSize(5,100,40)

Sets the size of the Drawing Canvas  with ID 5 to a width of 100px and a height of 40px.

WDDrawingCanvasSizeHeight
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WDDrawingCanvasSizeHeight(ID,Height)

Example:
WDDrawingCanvasSizeHeight(5,40)

Sets the size of the Drawing Canvas  with ID 5 to a height of 40px but remains the current width.

WDDrawingCanvasSizeWidth

WDDrawingCanvasSizeWidth(ID,Width)

Example:
WDDrawingCanvasSizeWidth(5,100)

Sets the size of the Drawing Canvas  with ID 5 to a width of 100px but remains the current height.

WDDrawingCanvasUnfix

WDDrawingCanvasUnfix(ID)

Example:
WDDrawingCanvasUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Drawing Canvas  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDDropDownListCssStyleDisable

WDDropDownListCssStyleDisable(ID,StyleID)

Example:
WDDropDownListCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Drop Down List  with ID 5.

WDDropDownListCssStyleEdit

WDDropDownListCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDDropDownListCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Drop Down List  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDDropDownListCssStyleEnable

WDDropDownListCssStyleEnable(ID,StyleID)

Example:
WDDropDownListCssStyleEnable(5,2)
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Enables the CSS Style  with ID 2 in the Item Properties of the Drop Down List  with ID 5.

WDDropDownListFix

WDDropDownListFix(ID)

Example:
WDDropDownListFix(5)

This activates the option "Fix" in the Item Properties of the Drop Down List  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDDropDownListLocation

WDDropDownListLocation(ID,X,Y)

Example:
WDDropDownListLocation(5,100,200)

Sets the position of the Drop Down List  with ID 5 to 100px horizontally and 200px vertically. 0,0 is
the top left corner of the Page.

WDDropDownListLocationLeft

WDDropDownListLocationLeft(ID,X)

Example:
WDDropDownListLocationLeft(5,100)

Sets the position of the Drop Down List  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDDropDownListLocationTop

WDDropDownListLocationTop(ID,Y)

Example:
WDDropDownListLocationTop(5,200)

Sets the position of the Drop Down List  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDDropDownListSetIndex

WDDropDownListSetIndex(ID,Value)

Example:
WDDropDownListSetIndex(1,3)

In the DropDownList  with ID 1, the entry element with index 3 is selected. Note: The indexing
starts with “0”.
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WDDropDownListSetItemsFromArray

WDDropDownListSetItemsFromArray(ID,VarName)

Example:
WDDropDownListSetItemsFromArray(1,"var_array")

Fills the elements of DropDownList  with ID 1 with the values from the array-type Variable
“var_array”.

WDDropDownListSetItemsFromExcel

WDDropDownListSetItemsFromExcel(ID,File,Table,CellStart,CellEnd)

Example:
WDDropDownListSetItemsFromExcel(1,"C:\coolux\content\drop_down.xls","Sheet1","A1","A4")

Fills the entry elements of DropDownList  with ID 1 with the values from cell A1 to A4, saved in the
Excel file “drop_down.xls”, Sheet1.
Note: The Excel document has to be an .xls file. The file may take some seconds to load.

WDDropDownListSetText

WDDropDownListSetText(ID,Text)

Example:
WDDropDownListSetText(1,"Load File")

Sets the default text of DropDownList  with ID 1 to “Load File”.

WDDropDownListSize

WDDropDownListSize(ID,Width,Height)

Example:
WDDropDownListSize(5,100,40)

Sets the size of the Drop Down List  with ID 5 to a width of 100px and a height of 40px.

WDDropDownListSizeHeight

WDDropDownListSizeHeight(ID,Height)

Example:
WDDropDownListSizeHeight(5,40)

Sets the size of the Drop Down List  with ID 5 to a height of 40px but remains the current width.

WDDropDownListSizeWidth

WDDropDownListSizeWidth(ID,Width)
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Example:
WDDropDownListSizeWidth(5,100)

Sets the size of the Drop Down List  with ID 5 to a width of 100px but remains the current height.

WDDropDownListUnfix

WDDropDownListUnfix(ID)

Example:
WDDropDownListUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Drop Down List  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDEnable

WDEnable

Example:
WDEnable

Enables the GUI of Widget Designer if it was disabled before.

WDEnableAltF4

WDEnableAltF4

Example:
WDEnableAltF4

This enables the shortcut Alt+F4 which closes an application.

WDEncoderCssStyleDisable

WDEncoderCssStyleDisable(ID,StyleID)

Example:
WDEncoderCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Encoder  with ID 5.

WDEncoderCssStyleEdit

WDEncoderCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDEncoderCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Encoder  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.
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WDEncoderCssStyleEnable

WDEncoderCssStyleEnable(ID,StyleID)

Example:
WDEncoderCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Encoder  with ID 5.

WDEncoderFactor

WDEncoderFactor(ID,Value)

Example:
WDEncoderFactor(7,5)

Sets the factor of Encoder  7 to the value 5.

WDEncoderFix

WDEncoderFix(ID)

Example:
WDEncoderFix(5)

This activates the option "Fix" in the Item Properties of the Encoder  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDEncoderGoDown

WDEncoderGoDown(ID,Value)

Example:
WDEncoderGoDown(7,10)

Subtracts immediately 10 values from the value of Encoder  7.

WDEncoderGoUp

WDEncoderGoUp(ID,Value)

Example:
WDEncoderGoUp(7,10)

Adds immediately 10 values to the value of Encoder  7.

WDEncoderLocation

WDEncoderLocation(ID,X,Y)
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Example:
WDEncoderLocation(5,100,200)

Sets the position of the Encoder  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.

WDEncoderLocationLeft

WDEncoderLocationLeft(ID,X)

Example:
WDEncoderLocationLeft(5,100)

Sets the position of the Encoder  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDEncoderLocationTop

WDEncoderLocationTop(ID,Y)

Example:
WDEncoderLocationTop(5,200)

Sets the position of the Encoder  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDEncoderSize

WDEncoderSize(ID,Width,Height)

Example:
WDEncoderSize(5,100,40)

Sets the size of the Encoder  with ID 5 to a width of 100px and a height of 40px.

WDEncoderSizeHeight

WDEncoderSizeHeight(ID,Height)

Example:
WDEncoderSizeHeight(5,40)

Sets the size of the Encoder  with ID 5 to a height of 40px but remains the current width.

WDEncoderSizeWidth

WDEncoderSizeWidth(ID,Width)

Example:
WDEncoderSizeWidth(5,100)

Sets the size of the Encoder  with ID 5 to a width of 100px but remains the current height.
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WDEncoderUnfix

WDEncoderUnfix(ID)

Example:
WDEncoderUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Encoder  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDEncoderValue

WDEncoderValue(ID,Value)

Example:
WDEncoderValue(7,33)

Sets the Encoder  7 to value 33 immediately.

WDEventCreate

WDEventCreate(EventName)

Example:
WDEventCreate("Show")

Creates the Event  “Show”.

WDEventCreateWithCategory

WDEventCreateWithCategory(EventName,Category)

Example:
WDEventCreateWithCategory("Show","Start")

Creates the Event  “Show” with the Category “Start”.

WDEventDelete

WDEventDelete(EventName)

Example:
WDEventDelete("Show")

Deletes the Event  “Show”.

WDEventDeleteAll

WDEventDeleteAll
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Example:
WDEventDeleteAll

Deletes all Events .

WDEventDeleteCategory

WDEventDeleteCategory(Category)

Example:
WDEventDeleteCategory("Start")

Deletes all Events  with the category “Start”.

WDEventDeleteObsoleteItems

WDEventDeleteObsoleteItems

Example:
WDEventDeleteObsoleteItems

Deletes passed Events .

WDEventEndDate

WDEventEndDate(EventName,YYYY,MM,DD,HH,MM,SS)

Example:
WDEventEndDate("Show",2015,12,24,20,00,00)

Sets the end date of the Event  “Show” to 8 p.m. at Christmas 2015.

WDEventEveryDay

WDEventEveryDay(EventName)

Example:
WDEventEveryDay("Show")

Repeats the Event  “Show” every day.

WDEventEveryHour

WDEventEveryHour(EventName)

Example:
WDEventEveryHour("Show")

Repeats the Event  “Show” every hour.

WDEventEveryMinute
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WDEventEveryMinute(EventName)

Example:
WDEventEveryMinute("Show")

Repeats the Event  “Show” every minute.

WDEventEveryMonth

WDEventEveryMonth(EventName)

Example:
WDEventEveryMonth("Show")

Repeats the Event  “Show” every month.

WDEventEveryWeek

WDEventEveryWeek(EventName)

Example:
WDEventEveryWeek("Show")

Repeats the Event  “Show” every week.

WDEventEveryYear

WDEventEveryYear(EventName)

Example:
WDEventEveryYear("Show")

Repeats the Event  “Show” every year.

WDEventModeEndDate

WDEventModeEndDate(EventName)

Example:
WDEventModeEndDate("Show")

The option "Count" of the Event  “Show” is set to "End Date". The Event will end at the specified
end date.

WDEventModeEndless

WDEventModeEndless(EventName)

Example:
WDEventModeEndless("Show")
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The option "Count" of the Event  “Show” is set to "Endless". The Event will not end at the specified
end date and is repeated endlessly.

WDEventMute

WDEventMute(EventName)

Example:
WDEventMute("Show")

Disables/Mutes the Event  “Show”.

WDEventScript

WDEventScript(EventName,Script)

Example:
WDEventScript("Show","WDFaderUp(1,3)")

Applies the command “WDFaderUp(1,3) to the Event  “Show”.

WDEventSingleEvent

WDEventSingleEvent(EventName)

Example:
WDEventSingleEvent("Show")

The Event  “Show” will not be repeated, it is a single event. 

WDEventStartDate

WDEventStartDate(EventName,YYYY,MM,DD,HH,MM,SS)

Example:
WDEventStartDate("Show",2015,12,24,20,00,00)

Sets the start date of the Event  “Show” to 8 p.m. at Christmas 2015.

WDEventUnMute

WDEventUnMute(EventName)

Example:
WDEventUnMute("Show")

Activates / Unmutes the Event  “Show”.

WDFaderAbortAllFades
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WDFaderAbortAllFades

Example:
WDFaderAbortAllFades

Abort all current fades from Faders .

WDFaderAbortFade

WDFaderAbortFade(ID)

Example:
WDFaderAbortFade(1)

Aborts the fade of Fader  1.

WDFaderBGImage

WDFaderBGImage(ID,File)

Example:
WDFaderBGImage(1,"C:\coolux\content\faderBG.png")

Changes the look of Fader  1 - it loads the image "faderBG.png" that was saved under "C:\coolux
\content" as the new background image.

WDFaderCssStyleDisable

WDFaderCssStyleDisable(ID,StyleID)

Example:
WDFaderCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Fader  with ID 5.

WDFaderCssStyleEdit

WDFaderCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDFaderCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Fader  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDFaderCssStyleEnable

WDFaderCssStyleEnable(ID,StyleID)

Example:
WDFaderCssStyleEnable(5,2)
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Enables the CSS Style  with ID 2 in the Item Properties of the Fader  with ID 5.

WDFaderDown

WDFaderDown(ID,Seconds)

Example:
WDFaderDown(7,2)

Fades Fader  7 in 2sec down to its minimum value.

WDFaderFix

WDFaderFix(ID)

Example:
WDFaderFix(2)

Sets the option “Fix” for Fader 2, so that this Fader  is shown on every page inside WD now.

WDFaderGoDown

WDFaderGoDown(ID,Value)

Example:
WDFaderGoDown(7,10)

Subtracts immediately 10 values from the value of Fader  7.

WDFaderGoUp

WDFaderGoUp(ID,Value)

Example:
WDFaderGoUp(7,10)

Adds immediately 10 values to the value of Fader  7.

WDFaderHandleImage

WDFaderHandleImage(ID,File)

Example:
WDFaderHandleImage(1,"C:\coolux\content\faderHandle.png")

Changes the look of the Fader  with ID 1 - it loads the image "faderHandle.png" that was saved
under "C:\coolux\content" as the new handle image.

WDFaderLocation
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WDFaderLocation(ID,X,Y)

Example:
WDFaderLocation(5,100,200)

Sets the position of the Fader  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the top
left corner of the Page.

WDFaderLocationLeft

WDFaderLocationLeft(ID,X)

Example:
WDFaderLocationLeft(5,100)

Sets the position of the Fader  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDFaderLocationTop

WDFaderLocationTop(ID,Y)

Example:
WDFaderLocationTop(5,200)

Sets the position of the Fader  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDFaderMidiInputDisable

WDFaderMidiInputDisable(ID)

Example:
WDFaderMidiInputDisable(3)

Disables the MIDI input of Fader  3.

WDFaderMidiInputEnable

WDFaderMidiInputEnable(ID)

Example:
WDFaderMidiInputEnable(3)

Enables the MIDI input of Fader  3.

WDFaderMidiOutputDisable

WDFaderMidiOutputDisable(ID)

Example:
WDFaderMidiOutputDisable(3)
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Disables the MIDI output of Fader  3.

WDFaderMidiOutputEnable

WDFaderMidiOutputEnable(ID)

Example:
WDFaderMidiOutputEnable(3)

Enables the MIDI output of Fader  3.

WDFaderSize

WDFaderSize(ID,Width,Height)

Example:
WDFaderSize(5,100,40)

Sets the size of the Fader  with ID 5 to a width of 100px and a height of 40px.

WDFaderSizeHeight

WDFaderSizeHeight(ID,Height)

Example:
WDFaderSizeHeight(5,40)

Sets the size of the Fader  with ID 5 to a height of 40px but remains the current width.

WDFaderSizeWidth

WDFaderSizeWidth(ID,Width)

Example:
WDFaderSizeWidth(5,100)

Sets the size of the Fader  with ID 5 to a width of 100px but remains the current height.

WDFaderUnfix

WDFaderUnfix(ID)

Example:
WDFaderUnfix(2)

Disables the option “Fix” for the Fader 2, so that this Fader  is not shown on every page inside WD
any more.

WDFaderUp
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WDFaderUp(ID,Seconds)

Example:
WDFaderUp(7,2)

Fades Fader  7 in 2sec up to its maximum value.

WDFaderValue

WDFaderValue(ID,Value)

Example:
WDFaderValue(7,33)

Sets the Fader  7 to value 33 immediately.

WDFadeToRelativeValue

WDFadeToRelativeValue(ID,Seconds,Value)

Example:
WDFadeToRelativeValue(6,13,41)

Fades Fader  6 in 13sec to the result of its current value plus 41.

WDFadeToRelativeValueSmooth

WDFadeToRelativeValueSmooth(ID,Time,Value)

Example:
WDFadeToRelativeValueSmooth(6,13,41)

Fades Fader  6 smoothly in 13sec to the result of its current value plus 41. "Smoothly" means that
the motion is eased in and out, on start and stop of each fade.

WDFadeToValue

WDFadeToValue(ID,Seconds,Value)

Example:
WDFadeToValue(1,4,200)

Fades Fader  1 in 4s to the value 200.

WDFadeToValueSmooth

WDFadeToValueSmooth(ID,Time,Value)

Example:
WDFadeToValueSmooth(2,5,170)
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Fades Fader  2 smoothly in 5sec up to value of 170. "Smoothly" means that the motion is eased
in and out, on start and stop of each fade.

WDHTTPRequest

WDHTTPRequest(Request)

Example:
WDHTTPRequest("http://192.168.50.40/cgi-bin/shutter_on")

This allows to send single HTTP commands via scripts directly to a web server. It is not necessary to
establish the connection from Widget Designer to the external web server using the Connection
Manager but they need to be connected via a switch for example.
The HTTP Request is useful when working with an external web server. It does not apply to the
integrated WD Web Server feature . As well, you may control external devices, e.g. a projector
supporting the HTTP protocol. This is an alternative to controlling them via a RS232 / Serial protocol.
If the external web server requires a username and / or a passwort and supports a HTTP Basic
Authentication (in most browsers that gives you a pop-up window asking for credentials) then you can
embed the user in the URL like this 
WDHTTPRequest("http://USERNAME@192.168.50.40/cgi-bin/shutter_on")
WDHTTPRequest("http://USERNAME:PASSWORD@192.168.50.40/cgi-bin/
shutter_on")

(USERNAME and PASSWORD have to be replaced)

WDHTTPRequestWithLogin

WDHTTPRequestWithLogin(Username,Password,URL)

Example:
WDHTTPRequestWithLogin("User1","Password1","http://www.coolux.de/index.php?id=dowload-
center")

Sends an HTTP Request to “http://www.coolux.de/index.php?id=dowload-center”, including required
login information username: User1 and password: Password1.

WDImageFile

WDImageFile(ID,File)

Example:
WDImageFile(1,"C:\coolux\content\test1.jpg")

Replaces the content of the image control with the ID 1 with the image “test1.jpg” from the path C:
\coolux\content.

WDImageLoaderClickImage

WDImageLoaderClickImage(ID,File)

Example:
WDImageLoaderClickImage(1,"C:\coolux\content\buttonImage10.jpg")
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Changes the look of the Image Loader Button  with ID 1 - it loads the image "buttonImage10.jpg"
that was saved under "C:\coolux\content" and displays it when the Image Loader is in the mode
"Click".

WDImageLoaderCssStyleDisable

WDImageLoaderCssStyleDisable(ID,StyleID)

Example:
WDImageLoaderCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Image Loader  button with ID 5.

WDImageLoaderCssStyleEdit

WDImageLoaderCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDImageLoaderCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Image Loader  button with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDImageLoaderCssStyleEnable

WDImageLoaderCssStyleEnable(ID,StyleID)

Example:
WDImageLoaderCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Image Loader  button with ID 5.

WDImageLoaderFix

WDImageLoaderFix(ID)

Example:
WDImageLoaderFix(5)

This activates the option "Fix" in the Item Properties of the Image Loader  button with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDImageLoaderImage

WDImageLoaderImage(ID,File)

Example:
WDImageLoaderImage(1,"C:\coolux\content\buttonImage10.jpg")

Changes the look of the Image Loader Button  with ID 1 - it loads the image "buttonImage10.jpg"
that was saved under "C:\coolux\content" and displays it when the Image Loader is in the mode
"Release".
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WDImageLoaderLocation

WDImageLoaderLocation(ID,X,Y)

Example:
WDImageLoaderLocation(5,100,200)

Sets the position of the Image Loader  button with ID 5 to 100px horizontally and 200px vertically.
0,0 is the top left corner of the Page.

WDImageLoaderLocationLeft

WDImageLoaderLocationLeft(ID,X)

Example:
WDImageLoaderLocationLeft(5,100)

Sets the position of the Image Loader  button with ID 5 to 100px horizontally but remains the
current vertical position. 0,0 is the top left corner of the Page.

WDImageLoaderLocationTop

WDImageLoaderLocationTop(ID,Y)

Example:
WDImageLoaderLocationTop(5,200)

Sets the position of the Image Loader  button with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDImageLoaderMouseOverImage

WDImageLoaderClickMouseOverImage(ID,File)

Example:
WDImageLoaderMouseOverImage(1,"C:\coolux\content\buttonImage10.jpg")

Changes the look of the Image Loader Button  with ID 1 - it loads the image "buttonImage10.jpg"
that was saved under "C:\coolux\content" and displays it when the Image Loader is in the mode
"Highlight". 

WDImageLoaderSize

WDImageLoaderSize(ID,Width,Height)

Example:
WDImageLoaderSize(5,100,40)

Sets the size of the Image Loader  button with ID 5 to a width of 100px and a height of 40px.

WDImageLoaderSizeHeight
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WDImageLoaderSizeHeight(ID,Height)

Example:
WDImageLoaderSizeHeight(5,40)

Sets the size of the Image Loader  button with ID 5 to a height of 40px but remains the current
width.

WDImageLoaderSizeWidth

WDImageLoaderSizeWidth(ID,Width)

Example:
WDImageLoaderSizeWidth(5,100)

Sets the size of the Image Loader  button with ID 5 to a width of 100px but remains the current
height.

WDImageLoaderUnfix

WDImageLoaderUnfix(ID)

Example:
WDImageLoaderUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Image Loader  button with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDImageLoadRecentResource

WDImageLoadRecentResource(ID)

Example:
WDImageLoadRecentResource(1)

Loads the last image that was send from with the WD Remote App  to the Image Resource
Manager  (Style: User, Control: User) to the Image / Picture Box  with ID 1. 
If you like to load other images from the Resource Manager, use the command 
WDImageLoadResource,ID,Resource .

WDImageLoadResource

WDImageLoadResource(ID,Resource)

Example:
WDImageLoadResource(1,"Default\Button\Forward") 

Loads the image with the name "Forward" from the Image Resource Manager  (Style: Default,
Control: Button) to the Image / Picture Box  with ID 1.

Example 2: 
WDImageLoadResource(1,"User\User\DSCN0780.JPG")
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This loads images either added manually or sent with the WD Remote App , as these images
automatically appear under Style: User, Control: User. If you automatically want to load the last
image that was sent, the command WDImageLoadRecentResource,ID  could be easier to

use.

WDImageSaveFile

WDImageSaveFile(ID,Path)

Example:
WDImageSaveFile(1,"C:\coolux\content\test.jpg")

The current image displayed by the Image / Picture Box  with ID 1 is saved with the name
"test.jpg" to the path "C:\coolux\content".

WDImageScreenshot

WDImageScreenshot(ID)

Example:
WDImageScreenshot(1)

Replaces the content of the image control with the ID 1 with a screenshot from the current desktop.

WDImageScreenshotRegion

WDImageScreenshotRegion(ID,X,Y,Width,Height)

Example:
WDImageScreenshotRegion(1,100,200,400,300)

Replaces the content of the image control with the ID 1 with a screenshot of a region from the current
desktop. The screenshot regions position starts at pixel 100,200 (X,Y) and is 400 px wide and 300 px
high.

WDInputBoxCssStyleDisable

WDInputBoxCssStyleDisable(ID,StyleID)

Example:
WDInputBoxCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Input Box  with ID 5.

WDInputBoxCssStyleEdit

WDInputBoxCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDInputBoxCssStyleEdit(5,2,"StartOpacity",50)
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Edits the CSS Style  with ID 2 in the Item Properties of the Input Box  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDInputBoxCssStyleEnable

WDInputBoxCssStyleEnable(ID,StyleID)

Example:
WDInputBoxCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Input Box  with ID 5.

WDInputBoxFix

WDInputBoxFix(ID)

Example:
WDInputBoxFix(5)

This activates the option "Fix" in the Item Properties of the Input Box  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDInputBoxLocation

WDInputBoxLocation(ID,X,Y)

Example:
WDInputBoxLocation(5,100,200)

Sets the position of the Input Box  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.

WDInputBoxLocationLeft

WDInputBoxLocationLeft(ID,X)

Example:
WDInputBoxLocationLeft(5,100)

Sets the position of the Input Box  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDInputBoxLocationTop

WDInputBoxLocationTop(ID,Y)

Example:
WDInputBoxLocationTop(5,200)

Sets the position of the Input Box  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.
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WDInputBoxSize

WDInputBoxSize(ID,Width,Height)

Example:
WDInputBoxSize(5,100,40)

Sets the size of the Input Box  with ID 5 to a width of 100px and a height of 40px.

WDInputBoxSizeHeight

WDInputBoxSizeHeight(ID,Height)

Example:
WDInputBoxSizeHeight(5,40)

Sets the size of the Input Box  with ID 5 to a height of 40px but remains the current width.

WDInputBoxSizeWidth

WDInputBoxSizeWidth(ID,Width)

Example:
WDInputBoxSizeWidth(5,100)

Sets the size of the Input Box  with ID 5 to a width of 100px but remains the current height.

WDInputBoxUnfix

WDInputBoxUnfix(ID)

Example:
WDInputBoxUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Input Box  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDKeyboardShortcutsDisable

WDKeyboardShortcutsDisable

Example:
WDKeyboardShortcutsDisable

Disables the use of Keyboard Shortcuts set up in the Keyboard Shortcut Editor.

WDKeyboardShortcutsEnable

WDKeyboardShortcutsEnable
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Example:
WDKeyboardShortcutsEnable

Enables the use of Keyboard Shortcuts set up in the Keyboard Shortcut Editor.

WDLabelCssStyleDisable

WDLabelCssStyleDisable(ID,StyleID)

Example:
WDLabelCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Label  with ID 5.

WDLabelCssStyleEdit

WDLabelCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDLabelCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Label  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDLabelCssStyleEnable

WDLabelCssStyleEnable(ID,StyleID)

Example:
WDLabelCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Label  with ID 5.

WDLabelFix

WDLabelFix(ID)

Example:
WDLabelFix(5)

This activates the option "Fix" in the Item Properties of the Label  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDLabelFlashInterval

WDLabelFlashInterval(ID,Value)

Example:
WDLabelFlashInterval(10,2000)

Sets the flash interval of Label  10 to 2 seconds (2000 ms).
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WDLabelLocation

WDLabelLocation(ID,X,Y)

Example:
WDLabelLocation(5,100,200)

Sets the position of the Label  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the top
left corner of the Page.

WDLabelLocationLeft

WDLabelLocationLeft(ID,X)

Example:
WDLabelLocationLeft(5,100)

Sets the position of the Label  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDLabelLocationTop

WDLabelLocationTop(ID,Y)

Example:
WDLabelLocationTop(5,200)

Sets the position of the Label  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDLabelStartFlash

WDLabelStartFlash(ID)

Example:
WDLabelStartFlash(10)

Will start flashing up Label  10.

WDLabelStopFlash

WDLabelStopFlash(ID)

Example:
WDLabelStopFlash(10)

Will stop flashing up Label  10.

WDLabelText

WDLabelText(ID,Text)
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Example:
WDLabelText(3,"Flip")

Changes the text of Label  3 to the word Flip.

WDLabelTextColour

WDLabelTextColour(ID,R,G,B)

Example:
WDLabelTextColour(3,255,90,0)

Changes the color of Label  3 to orange. The values for R,G,B range from 0 to 255.

WDLabelTextSubString

WDLabelTextSubString(ID,StartIndex,Length)

Example:
WDLabelTextSubString(1,2,2)

Removes any text from Label  1 except those letters that are within the series starting at the
second index for the length of 2 positions. Note that the indexing starts with “0” at the first symbol.

E.g.: Label text = Dewdrop; resulting sub string = wd

WDLabelTextTrimStart

WDLabelTextTrimStart(ID,Count)

Example:
WDLabelTextTrimStart(5,3)

Removes the first 3 characters of the text of Label  5. E.g.: Label text = Dewdrop; resulting sub
string = drop

WDLabelUnfix

WDLabelUnfix(ID)

Example:
WDLabelUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Label  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDListViewAbortLoadCSVFileExt

WDListViewAbortLoadCSVFileExt(ID)

Example:
WDListViewAbortLoadCSVFileExt(1)
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.

WDListViewCssStyleDisable

WDListViewCssStyleDisable(ID,StyleID)

Example:
WDListViewCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the List View  with ID 5.

WDListViewCssStyleEdit

WDListViewCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDListViewCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the List View  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDListViewCssStyleEnable

WDListViewCssStyleEnable(ID,StyleID)

Example:
WDListViewCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the List View  with ID 5.

WDListViewFix

WDListViewFix(ID)

Example:
WDListViewFix(5)

This activates the option "Fix" in the Item Properties of the List View  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDListViewLoadCSVFile

WDListViewLoadCSVFile(ID,FileName,Separator)

Example:
WDListViewLoadCSVFile(1,"C:\coolux\content\measured_data.csv","|")

Loads the data of the CSV file “measured_data.csv” into the ListView  1 and separates the data
sets from the CSV file with a “|” (pipe or vertical line) symbol.

Note: You may use any symbol as a separator, except the space " ".
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WDListViewLoadCSVFileExt

WDListViewLoadCSVFileExt(ID,FileName,Interval,LoadItemCount,Separator)

Example:
WDListViewLoadCSVFileExt(1,"C:\coolux\content\measured_data.csv",500,500,"|")

.

WDListViewLocation

WDListViewLocation(ID,X,Y)

Example:
WDListViewLocation(5,100,200)

Sets the position of the List View  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.

WDListViewLocationLeft

WDListViewLocationLeft(ID,X)

Example:
WDListViewLocationLeft(5,100)

Sets the position of the List View  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDListViewLocationTop

WDListViewLocationTop(ID,Y)

Example:
WDListViewLocationTop(5,200)

Sets the position of the List View  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDListViewNewLine

WDListViewNewLine(ID,Col,Value)

Example:
WDListViewNewLine(1,2,"hello")

Creates a new row beneath all other rows at ListView  1 and sets the value of column 2 of this new
line to "hello".

WDListViewResize
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WDListViewResize(ID,ColCount,RowCount)

Example:
WDListViewResize(1,5,4)

Resizes ListView  1 to a size of 5 columns and 4 rows.
Note: All existing data will be deleted when resizing the ListView.

WDListViewSetCell

WDListViewSetCell(ID,Col,Row,Value)

Example:
WDListViewSetCell(1,2,4,"hello")

Sets the value of ListView  1, row 2, column 4, to “hello”.

WDListViewSetColumnName

WDListViewSetColumnName(ID,Col,Name)

Example:
WDListViewSetColumnName(1,3,"Height")

Sets the name of ListView  1 column 3 to “Height”.

WDListViewSize

WDListViewSize(ID,Width,Height)

Example:
WDListViewSize(5,100,40)

Sets the size of the List View  with ID 5 to a width of 100px and a height of 40px.

WDListViewSizeHeight

WDListViewSizeHeight(ID,Height)

Example:
WDListViewSizeHeight(5,40)

Sets the size of the List View  with ID 5 to a height of 40px but remains the current width.

WDListViewSizeWidth

WDListViewSizeWidth(ID,Width)

Example:
WDListViewSizeWidth(5,100)

Sets the size of the List View  with ID 5 to a width of 100px but remains the current height.
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WDListViewUnfix

WDListViewUnfix(ID)

Example:
WDListViewUnfix(5)

This deactivates the option "Fix" in the Item Properties of the List View  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDListViewUpdateSource

WDListViewUpdateSource(ID)

Example:
WDListViewUpdateSource(1)

Updates the data from the source Excel file of ListView  1.

WDLoad

WDLoad(File)

Example:
WDLoad("C:\coolux\content Widget\test.wdp")

Loads the file "test.wdp" from the specified directory without saving the current WD project.

WDLoadProject

WDLoadProject(File)

Example:
WDLoadProject("C:\coolux\content\test\test.wdp")

Loads the file “test.wdp” from the specified directory without saving the current WD project.

WDLoadProjectRestart

WDLoadProjectRestart(File)

Example:
WDLoadProjectRestart("C:\coolux\content\test\test.wdp")

Restarts Widget Designer and loads the file “test.wdp” from the specified directory without saving the
current WD project. With restarting WD you can clean up the entire memory usage from the old
project.

WDLock

WDLock
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Example:
WDLock

This locks your WD project window and prevents mouse and keyboard input until it is unlocked again.
Alternatively, you can press Ctrl+Pause.

WDLockGui

WDLockGui

Example:
WDLockGui

This command works only when the User Interface protection is activated in the Protection Settings
. It then protects your WD project window from certain mouse and keyboard inputs. Widget

Designer cannot be toggeled into Edit Mode anymore, all right-click menus and the Item Properties
dialog are not available. To unlock the protection use the command WDUnlockGui  and enter the
password set up. Alternatively, the shortcut Ctrl+Shift+P toggles the Protection Mode.

WDLockInterface

WDLockInterface

Example:
WDLockInterface

This locks your WD project window and opens an onscreen keyboard dialog. Only if the correct
password is entered, the interface is unlocked again.

WDMacro

WDMacro(MacroName)

Example:
WDMacro("Fader Jump")

Executes Macro "Fader Jump", if it was created in the Macro Tool before.

WDMacroBoxOkCancel

WDMacroBoxOkCancel(Title,Content,MacroName1,MacroName2)

Example:
WDMacroBoxOkCancel("Attention!","WD will shut down!","MacroOk","MacroCancel")

Pops up a message box with the title “Attention!” and the text “WD will shut down!”.
If you click on "OK", the Macro “MacroOk” will be executed, if you click on "Cancel" the Macro
“MacroCancel” will be executed.

Note: The Macros need to be set up in the Macro tool before.
If there are following commands, they will not be executed until the message box is answered.
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WDMacroBoxYesNo

WDMacroBoxYesNo(Title,Content,MacroName1,MacroName2)

Example:
WDMacroBoxYesNo("Attention","Do you really want to do this?","MacroYes","MacroNo")

Pops up a message box with the title “Attention!” and the text “Do you really want to do this?”.
If you click on "Yes", the Macro “MacroYes” will be executed, if you click on "No" the Macro
“MacroNo” will be executed.
Note: The Macros need to be set up in the Macro tool before.
If there are following commands, they will not be executed until the message box is answered.

WDMediaControlCssStyleDisable

WDMediaControlCssStyleDisable(ID,StyleID)

Example:
WDMediaControlCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Media Control  Panel with ID 5.

WDMediaControlCssStyleEdit

WDMediaControlCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDMediaControlCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Media Control  Panel with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDMediaControlCssStyleEnable

926 942

926 942
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WDMediaControlCssStyleEnable(ID,StyleID)

Example:
WDMediaControlCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Media Control  Panel with ID 5.

WDMediaControlFix

WDMediaControlFix(ID)

Example:
WDMediaControlFix(5)

This activates the option "Fix" in the Item Properties of the Media Control  Panel with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDMediaControlLocation

WDMediaControlLocation(ID,X,Y)

Example:
WDMediaControlLocation(5,100,200)

Sets the position of the Media Control  Panel with ID 5 to 100px horizontally and 200px vertically.
0,0 is the top left corner of the Page.

WDMediaControlLocationLeft

WDMediaControlLocationLeft(ID,X)

Example:
WDMediaControlLocationLeft(5,100)

Sets the position of the Media Control  Panel with ID 5 to 100px horizontally but remains the
current vertical position. 0,0 is the top left corner of the Page.

WDMediaControlLocationTop

WDMediaControlLocationTop(ID,Y)

Example:
WDMediaControlLocationTop(5,200)

Sets the position of the Media Control  Panel with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDMediaControlSize

WDMediaControlSize(ID,Width,Height)

926 942
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Example:
WDMediaControlSize(5,100,40)

Sets the size of the Media Control  Panel with ID 5 to a width of 100px and a height of 40px.

WDMediaControlSizeHeight

WDMediaControlSizeHeight(ID,Height)

Example:
WDMediaControlSizeHeight(5,40)

Sets the size of the Media Control  Panel with ID 5 to a height of 40px but remains the current
width.

WDMediaControlSizeWidth

WDMediaControlSizeWidth(ID,Width)

Example:
WDMediaControlSizeWidth(5,100)

Sets the size of the Media Control  Panel with ID 5 to a width of 100px but remains the current
height.

WDMediaControlUnfix

WDMediaControlUnfix(ID)

Example:
WDMediaControlUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Media Control  Panel with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDMediaPanelSetDevices

WDMediaPanelSetDevices(PanelID,Devices)

Example:
WDMediaPanelSetDevices(3,"1.3 1.4 2.5")

Connects the Media Control Panel  with the ID 3 in WD to the devices 1,3 and 1,4 and 2,5 in PB.

WDMediaPanelSetFolder

WDMediaPanelSetFolder(PanelID,Folder)

Example:
WDMediaPanelSetFolder(3,004)

Loads the thumbnail folder 004 in the Media Control Panel  3.

942
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Please note, that the file number needs to have 3 digits.

WDMediaPanelSetIndex

WDMediaPanelSetIndex(PanelID,Index)

Example:
WDMediaPanelSetIndex(3,4)

Sets the start index of the files in the Media Control Panel  3 to 4.

WDMediaPanelSetLayout

WDMediaPanelSetLayout(PanelID,Columns,Rows)

Example:
WDMediaPanelSetLayout(3,2,6)

Changes the layout of Media Control Panel  3. The thumbnails will be displayed in 2 columns and
6 rows.

WDMediaPanelSetNextFolder

WDMediaPanelSetNextFolder(PanelID)

Example:
WDMediaPanelSetNextFolder(1)

Loads the next thumbnail folder in the Media Control Panel  1.
If the folder 002 is the current one, the next one in the list will be loaded.

WDMediaPanelSetPreviousFolder

WDMediaPanelSetPreviousFolder(PanelID)

Example:
WDMediaPanelSetPreviousFolder(1)

Loads the previous thumbnail folder in the Media Control Panel  1.
If the folder 002 is the current one, the previous one in the list will be loaded.

WDMessageBox

WDMessageBox(Title,Content)

Example:
WDMessageBox("Attention!","Please read this before continuing.")

Displays a message box with the title “Attention!” and the text “Please read this before continuing."

If there are following commands, they will not be executed until the message box is answered with
the "Ok" button.

942
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WDMotionMaskClear

WDMotionMaskClear(ID)

Example:
WDMotionMaskClear(1)

Clears the Motion Mask Display 1.

WDMotionMaskDoNotUseAirScan

WDMotionMaskDoNotUseAirScan(ID)

Example:
WDMotionMaskDoNotUseAirScan(1)

Disables the AirScan  as input for the Motion Mask Display 1.

WDMotionMaskDoNotUseCameraPointTracking

WDMotionMaskDoNotUseCameraPointTracking(ID)

Example:
WDMotionMaskDoNotUseCameraPointTracking(1)

Disables the Camera Point Tracking  as input for the Motion Mask Display 1.

WDMotionMaskDoNotUseIPhone

WDMotionMaskDoNotUseIPhone(ID)

Example:
WDMotionMaskDoNotUseIPhone(1)

Disables the iPhone  as input for the Motion Mask Display 1.

WDMotionMaskDoNotUseKinect

WDMotionMaskDoNotUseKinect(ID)

1262
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Example:
WDMotionMaskDoNotUseKinect(1)

Disables the Kinect  as input for the Motion Mask Display 1.

WDMotionMaskSetInValue

WDMotionMaskSetInValue(ID,Value)

Example:
WDMotionMaskSetInValue(1,0.5)

Sets the In-Value for the Motion Mask Display 1 to 0.5.

WDMotionMaskSetOutValue

WDMotionMaskSetOutValue(ID,Value)

Example:
WDMotionMaskSetOutValue(1,0.5)

Sets the Out-Value for the Motion Mask Display 1 to 0.5.

WDMotionMaskSetPaintOnly

WDMotionMaskSetPaintOnly(ID,Bool)

Example:
WDMotionMaskSetPaintOnly(1,true)

Enables the Paint Only option for the Motion Mask Display 1.

WDMotionMaskSetScale

WDMotionMaskSetScale(ID,Value)

Example:
WDMotionMaskSetScale(1,0.5)

Sets the Scale value for the Motion Mask Display 1 to 0.5.

WDMotionMaskSetThreshold

WDMotionMaskSetThreshold(ID,Value)

Example:
WDMotionMaskSetThreshold(1,4)

Sets the Threshold for the Motion Mask Display 1 to the value 4.

WDMotionMaskUseAirScan

1269
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WDMotionMaskUseAirScan(ID)

Example:
WDMotionMaskUseAirScan(1)

Enables the AirScan  as input for the Motion Mask Display 1.

WDMotionMaskUseCameraPointTracking

WDMotionMaskUseCameraPointTracking(ID)

Example:
WDMotionMaskUseCameraPointTracking(1)

Enables the Camera Point Tracking  as input for the Motion Mask Display 1.

WDMotionMaskUseIPhone

WDMotionMaskUseIPhone(ID)

Example:
WDMotionMaskUseIPhone(1)

Enables the iPhone  as input for the Motion Mask Display 1.

WDMotionMaskUseKinect

WDMotionMaskUseKinect(ID)

Example:
WDMotionMaskUseKinect(1)

Enables the Kinect  as input for the Motion Mask Display 1.

WDMultiMouseLinkLoop

WDMultiMouseLinkLoop(ID)

Example:
WDMultiMouseLinkLoop(1)

Sets the video mode of the item in MultiTouch Panel 1, that currently is linked to the mouse, to
“Loop”.

WDMultiMouseLinkPause

WDMultiMouseLinkPause(ID)

Example:
WDMultiMouseLinkPause(1)
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Sets the video mode of the item in MultiTouch Panel 1, that currently is linked to the mouse, to
“Pause”.

WDMultiMouseLinkPlay

WDMultiMouseLinkPlay(ID)

Example:
WDMultiMouseLinkPlay(1)

Sets the video mode of the item in MultiTouch Panel 1, that currently is linked to the mouse, to
“Play”.

WDMultiMouseLinkStop

WDMultiMouseLinkStop(ID)

Example:
WDMultiMouseLinkStop(1)

Sets the video mode of the item in MultiTouch Panel 1, that currently is linked to the mouse, to
“Stop”.

WDMultiTouchApplyDefaults

WDMultiTouchApplyDefaults(ID)

Example:
WDMultiTouchApplyDefaults(1)

Applies the stored default values to the Multitouch Panel 1.
To store new default values to the panel please use the command WDMultiTouchStoreDefaults,ID .
Please note that every Multitouch Panel has it’s own default values. 

WDMultiTouchBringToFront

WDMultiTouchBringToFront(ID,ItemID)

Example:
WDMultiTouchBringToFront(1,2)

Brings the Multitouch item 2 of Multitouch panel 1 to the front if it is completely or partially covered by
another Multitouch item. 

WDMultiTouchClearInputs

WDMultiTouchClearInputs(ID)

Example:
WDMultiTouchClearInputs(1)

1553
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In case that the network connection to the AirScan or another Remote input was lost while these
devices sent active touch points, the Multitouch Panel ID 1 will be cleared from these hanging touch
points by executing this command.

WDMultiTouchDisableAirScan

WDMultiTouchDisableAirScan

Example:
WDMultiTouchDisableAirScan

Disables the AirScan for MultiTouch Panel 1.

WDMultiTouchDisableCamera

WDMultiTouchDisableCamera

Example:
WDMultiTouchDisableCamera

Disables the Camera Tool for MultiTouch Panel 1.

WDMultiTouchDisableDrag

WDMultiTouchDisableDrag(ID,ItemID)

Example:
WDMultiTouchDisableDrag(1,2)

Disables the Drag option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchDisableGestures

WDMultiTouchDisableGestures(ID)

Example:
WDMultiTouchDisableGestures(1)

Disables Gestures for Synaptics Touch Pads and Wacom Bamboo Devices for MultiTouch Panel 1.

WDMultiTouchDisableIPhone

WDMultiTouchDisableIPhone

Example:
WDMultiTouchDisableIPhone

Disables the iPhone for MultiTouch Panel 1.

WDMultiTouchDisableKinect
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WDMultiTouchDisableKinect

Example:
WDMultiTouchDisableKinect

Disables the Kinect for MultiTouch Panel 1.

WDMultiTouchDisableMouse

WDMultiTouchDisableMouse(ID)

Example:
WDMultiTouchDisableMouse(1)

Disables the Mouse for MultiTouch Panel 1.

WDMultiTouchDisablePan

WDMultiTouchDisablePan(ID,ItemID)

Example:
WDMultiTouchDisablePan(1,2)

Disables the Pan option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchDisableRotate

WDMultiTouchDisableRotate(ID,ItemID)

Example:
WDMultiTouchDisableRotate(1,2)

Disables the Rotate option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchDisableSize

WDMultiTouchDisableSize(ID,ItemID)

Example:
WDMultiTouchDisableSize(1,2)

Disables the Size option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchDisableTouch

WDMultiTouchDisableTouch(ID)

Example:
WDMultiTouchDisableTouch(1)

Disables Touch for MultiTouch Panel 1.
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WDMultiTouchDisableZoom

WDMultiTouchDisableZoom(ID,ItemID)

Example:
WDMultiTouchDisableZoom(1,2)

Disables the Zoom option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchDisableZorder

WDMultiTouchDisableZorder(ID)

Example:
WDMultiTouchDisableZorder(1)

Disables the Z-Order option for the MultiTouch Panel with the ID 1.

WDMultiTouchDisplayMode

WDMultiTouchDisplayMode(ID,DisplayMode)

Example:
WDMultiTouchDisplayMode(1,"16:10")

Sets the Display Mode for the MultiTouch Panel with the ID 1 to the aspect ratio 16:10.

The following aspect ratios can be assigned:
4:3, 16:9, 16:10.

WDMultiTouchEnableAirScan

WDMultiTouchEnableAirScan

Example:
WDMultiTouchEnableAirScan

Enables the AirScan for MultiTouch Panel 1.

WDMultiTouchEnableCamera

WDMultiTouchEnableCamera

Example:
WDMultiTouchEnableCamera

Enables the Camera Tool for MultiTouch Panel 1.

WDMultiTouchEnableDrag

WDMultiTouchEnableDrag(ID,ItemID)
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Example:
WDMultiTouchEnableDrag(1,2)

Enables the Drag option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchEnableGestures

WDMultiTouchEnableGestures(ID)

Example:
WDMultiTouchEnableGestures(1)

Enables Gestures for Synaptics Touch Pads and Wacom Bamboo Devices for MultiTouch Panel 1. 

WDMultiTouchEnableIPhone

WDMultiTouchEnableIPhone

Example:
WDMultiTouchEnableIPhone

Enables the iPhone for MultiTouch Panel 1.

WDMultiTouchEnableKinect

WDMultiTouchEnableKinect

Example:
WDMultiTouchEnableKinect

Enables the Kinect for MultiTouch Panel 1.

WDMultiTouchEnableMouse

WDMultiTouchEnableMouse(ID)

Example:
WDMultiTouchEnableMouse(1)

Enables the Mouse for MultiTouch Panel 1.

WDMultiTouchEnablePan

WDMultiTouchEnablePan(ID,ItemID)

Example:
WDMultiTouchEnablePan(1,2)

Enables the Pan option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchEnableRotate
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WDMultiTouchEnableRotate(ID,ItemID)

Example:
WDMultiTouchEnableRotate(1,2)

Enables the Rotate option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchEnableSize

WDMultiTouchEnableSize(ID,ItemID)

Example:
WDMultiTouchEnableSize(1,2)

Enables the Size option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchEnableTouch

WDMultiTouchEnableTouch(ID)

Example:
WDMultiTouchEnableTouch(1)

Enables Touch for MultiTouch Panel 1.

WDMultiTouchEnableZoom

WDMultiTouchEnableZoom(ID,ItemID)

Example:
WDMultiTouchEnableZoom(1,2)

Enables the Zoom option for Item 2 in the MultiTouch Panel with the ID 1.

WDMultiTouchEnableZorder

WDMultiTouchEnableZorder(ID)

Example:
WDMultiTouchEnableZorder(1)

Enables the Z-Order option for the MultiTouch Panel with the ID 1.

WDMultiTouchItemLoop

WDMultiTouchItemLoop(ID,ItemID)

Example:
WDMultiTouchItemLoop(1,4)

Sets the video mode of item 4 in MultiTouch Panel 1 to “Loop”.
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WDMultiTouchItemPause

WDMultiTouchItemPause(ID,ItemID)

Example:
WDMultiTouchItemPause(1,4)

Sets the video mode of item 4 in MultiTouch Panel 1 to “Pause”.

WDMultiTouchItemPlay

WDMultiTouchItemPlay(ID,ItemID)

Example:
WDMultiTouchItemPlay(1,4)

Sets the video mode of item 4 in MultiTouch Panel 1 to “Play”.

WDMultiTouchItemStop

WDMultiTouchItemPause(ID,ItemID)

Example:
WDMultiTouchItemStop(1,4)

Sets the video mode of item 4 in MultiTouch Panel 1 to “Stop”.

WDMultiTouchLayerMode

WDMultiTouchLayerMode(ID,ItemID,DisplayMode)

Example:
WDMultiTouchLayerMode(1,2,"16:9")

Sets the Layer Mode for Item 2 in the MultiTouch Panel with the ID 1 to the aspect ratio 16:9.

The following aspect ratios can be assigned:
4:3, 16:9, 16:10.

WDMultiTouchLinkItemToMouse

WDMultiTouchLinkItemToMouse(ID)

Example:
WDMultiTouchLinkItemToMouse(1)

Links the item of MultiTouch Panel 1 to the mouse, that is currently selected by the mouse.

This command e.g.. could be placed as Mouse Down or Mouse Enter script for an item inside the
MultiTouch Panel: as soon you clicked on or entered this item, it will follow the mouse (whether
Move-Mode is enabled for this item or not).
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The link is active as long as 
a) another item is linked to the mouse,
b) a non active item is assigned or 
c) a non-existing Item (like “0” ) is linked to the mouse.

WDMultiTouchLinkToMouse

WDMultiTouchLinkToMouse(ID, ItemID)

Example:
WDMultiTouchLinkToMouse(1,4)

Links Item 4 of MultiTouch Panel 1 to the mouse (whether Move-Mode is enabled for this item or not),
as long as 
a) another item is linked to the mouse,
b) a non active item is assigned or 
c) a non-existing Item (like “0” ) is linked to the mouse.

WDMultiTouchPanelCssStyleDisable

WDMultiTouchPanelCssStyleDisable(ID,StyleID)

Example:
WDMultiTouchPanelCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the MultiTouch  Panel with ID 5.

WDMultiTouchPanelCssStyleEdit

WDMultiTouchPanelCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDMultiTouchPanelCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the MultiTouch  Panel with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDMultiTouchPanelCssStyleEnable

WDMultiTouchPanelCssStyleEnable(ID,StyleID)

Example:
WDMultiTouchPanelCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the MultiTouch  Panel with ID 5.

WDMultiTouchPanelFix

WDMultiTouchPanelFix(ID)

926 1000
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Example:
WDMultiTouchPanelFix(5)

This activates the option "Fix" in the Item Properties of the MultiTouch  Panel with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDMultiTouchPanelLocation

WDMultiTouchPanelLocation(ID,X,Y)

Example:
WDMultiTouchPanelLocation(5,100,200)

Sets the position of the MultiTouch  Panel with ID 5 to 100px horizontally and 200px vertically. 0,0
is the top left corner of the Page.

WDMultiTouchPanelLocationLeft

WDMultiTouchPanelLocationLeft(ID,X)

Example:
WDMultiTouchPanelLocationLeft(5,100)

Sets the position of the MultiTouch  Panel with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDMultiTouchPanelLocationTop

WDMultiTouchPanelLocationTop(ID,Y)

Example:
WDMultiTouchPanelLocationTop(5,200)

Sets the position of the MultiTouch  Panel with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDMultiTouchPanelSize

WDMultiTouchPanelSize(ID,Width,Height)

Example:
WDMultiTouchPanelSize(5,100,40)

Sets the size of the MultiTouch  Panel with ID 5 to a width of 100px and a height of 40px.

WDMultiTouchPanelSizeHeight

WDMultiTouchPanelSizeHeight(ID,Height)

Example:
WDMultiTouchPanelSizeHeight(5,40)

1000
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1000
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Sets the size of the MultiTouch  Panel with ID 5 to a height of 40px but remains the current width.

WDMultiTouchPanelSizeWidth

WDMultiTouchPanelSizeWidth(ID,Width)

Example:
WDMultiTouchPanelSizeWidth(5,100)

Sets the size of the MultiTouch  Panel with ID 5 to a width of 100px but remains the current height.

WDMultiTouchPanelUnfix

WDMultiTouchPanelUnfix(ID)

Example:
WDMultiTouchPanelUnfix(5)

This deactivates the option "Fix" in the Item Properties of the MultiTouch  Panel with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDMultiTouchRefresh

WDMultiTouchRefresh(ID)

Example:
WDMultiTouchRefresh(1)

Refreshes the values of MultiTouch Panel 1 to Pandoras Box.

WDMultiTouchSetActive

WDMultiTouchSetActive(ID,ItemID)

Example:
WDMultiTouchSetActive(1,3)

Enables the Item 3 in the MultiTouch Panel with the ID 1.

WDMultiTouchSetDevice

WDMultiTouchSetDevice(ID,ItemID,SiteID,DeviceID)

Example:
WDMultiTouchSetDevice(1,3,2,5)

Assigns the PB Device 2,5 to the Item 3 in the MultiTouch Panel with the ID 1.

WDMultiTouchSetInActive
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1000

1000
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WDMultiTouchSetInActive(ID,ItemID)

Example:
WDMultiTouchSetInActive(1,4)

Disables the Item 4 in the MultiTouch Panel with the ID 1.

WDMultiTouchSetPan

WDMultiTouchSetPan(ID,X,Y)

Example:
WDMultiTouchSetPan(1,10,5)

Changes the Pan in the MultiTouch Panel with the ID 1 to the value X=10 and Y=5.

WDMultiTouchSetPos

WDMultiTouchSetPos(ID,ItemID,XPos,YPos)

Example:
WDMultiTouchSetPos(1,3,25,50)

Sets the Item 3 in the MultiTouch Panel with the ID 1 to the Position X=25 and Y=50.

WDMultiTouchSetRot

WDMultiTouchSetRot(ID,ItemID,Rot)

Example:
WDMultiTouchSetRot(1,3,90)

Sets the Item 3 in the MultiTouch Panel with the ID 1 to the rotation value of 90°.

WDMultiTouchSetScale

WDMultiTouchSetScale(ID,ItemID,Scale)

Example:
WDMultiTouchSetScale(1,3,40)

Scales the Item 3 in the MultiTouch Panel with the ID 1 to 40%.

WDMultiTouchSetZoom

WDMultiTouchSetZoom(ID,Zoomfactor)

Example:
WDMultiTouchSetZoom(1,100)

Changes the Zoom in the MultiTouch Panel with the ID 1 to the value 100.
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WDMultiTouchStoreDefaults

WDMultiTouchStoreDefaults(ID)

Example:
WDMultiTouchStoreDefaults(1)

Stores all current values of the Multitouch Panel 1 as Defaults. To apply these values later on to the
Multitouch Panel again, use the command WDMultiTouchApplyDefaults,ID .
Please note that every Multitouch Panel has it’s own default values. 

WDNBSBroadcastDisable

WDNBSBroadcastDisable

Example:
WDNBSBroadcastDisable

Disables the Network Broadcast Service (NBS) for Faders , Labels  and Custom Script Buttons
.

WDNBSBroadcastEnable

WDNBSBroadcastEnable

Example:
WDNBSBroadcastEnable

Enables the Network Broadcast Service (NBS) for Faders , Labels  and Custom Script Buttons
.

WDNBSReceiveDisable

WDNBSReceiveDisable

Example:
WDNBSReceiveDisable

Disables Faders , Labels  and Custom Script Buttons  to receive values via Network
Broadcast Service from other controls.

WDNBSReceiveEnable

WDNBSReceiveEnable

Example:
WDNBSReceiveEnable

Enables Faders , Labels  and Custom Script Buttons  to receive values via Network
Broadcast Service from other controls.

WDNew
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WDNew

Example:
WDNew

Creates a new WD project without saving the current WD project.

WDNodeCommand

WDNodeCommand(NodeID,Args0,ArgsN)

Example:
WDNodeCommand(1,"PowerOn")

Executes a “Power On” command at the Projector Control Node ID 1, please refer to the topic Node
Commands  for further information.

WDNodeConnect

WDNodeConnect(SourceNodeID,TargetNodeID)

Example:
WDNodeConnect(2,5)

Connects the Source Node with the ID 2 to the Target Node with the ID 5.

WDNodeDisableOutput

WDNodeDisableOutput(ID)

Example:
WDNodeDisableOutput(35)

Disables Output node 36 (for example an Output Node like a Fader Output).

WDNodeDisableOutputAll

WDNodeDisableOutputAll

Example:
WDNodeDisableOutputAll

Enables all Output Nodes.

WDNodeDisconnect

WDNodeDisconnect(NodeID,SourceNodeID)

Example:
WDNodeDisconnect(3,2)

Disconnects the Node with the ID 3 from the Source Node with the ID 2.

1059
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WDNodeEnableOutput

WDNodeEnableOutput(ID)

Example:
WDNodeEnableOutput(35)

Enables Output node 36 (for example an Output Node like a Fader Output).

WDNodeEnableOutputAll

WDNodeEnableOutputAll

Example:
WDNodeEnableOutputAll

Disables all Output Nodes.

WDNodeProcessOutput

WDNodeProcessOutput(NodeID)

Example:
WDNodeProcessOutput(12)

Per default all output nodes update their value according to the Node Cycle Interval (Tools >
Options). This means their entire preceding node chain is run through starting with the input node and
passing all possible filter nodes. With this command, output node 12 updates its value (once and
independent from the set Node Cycle Interval) by pulling new data from its preceding node chain and
sending it to the according output control or connection.

WDNodeRefreshOutput

WDNodeRefreshOutput(NodeID)

Example:
WDNodeRefreshOutput(12)

Per default all output nodes update their value according to the Node Cycle Interval (Tools >
Options). This means their entire preceding node chain is run through starting with the input node and
passing all possible filter nodes. With this command, output node 12 sends its current value (once
and independent from the set Node Cycle Interval) to the according output control or connection.
However, it does not pull new data from its preceding node chain, this happens with the next Node
Cycle.

Please note:
This command is only valid for the output nodes for a Label, Fader, Bargraph, AngularDisplay,
DigitalDisplay. In addition the Script Output Node can be refreshed which executes (depending on the
input data) the True or False Script.

WDNodesDisable

1310

1310
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WDNodesDisable

Example:
WDNodesDisable

Disables all nodes and releases their connection to other nodes and outputs in WD.

WDNodesEnable

WDNodesEnable

Example:
WDNodesEnable

Enables all nodes in WD if disabled before and re-establishes their connection to other nodes and
outputs.

WDNodeSetOutput

WDNodeSetOutput(NodeID,ParamID,Value)

Example:
WDNodeSetOutput(2,1,100)

Sets the first output parameter of Input Node 2 to the value 100.

This command allows to set an output parameter of an Input Node to a specific value (applies to TCP,
UDP and COM ASCII String / Stream Input Nodes)

WDNodeSetParam

WDNodeSetParam(NodeID,ParamID,Value)

Example:
WDNodeSetParam(12,3,32)

Sets Parameter 3 of Node 12 to the value 32, for example if Node 12 is a Range filter node, the Input
Max will be changed to 32, see Picture below. 
All parameters with a small number behind can be changed with this command. 



1557

Rev 668 and higher support Node Commands  in a more direct form. The above command can be
replaced with the more direct command NodeID.ParamID@Value. With the numbers from the

example, that would be: Node12.3@32

WDNodeSetParamAdd

WDNodeSetParamAdd(NodeID,ParamID,Value)

Example:
WDNodeSetParamAdd(3,1,10)

Adds the value 10 to parameter 1 of Node 3, for example if Node 3 is a Value Input Node, its Output
value will be increased by 10. 

WDNodeSetParamDivide

WDNodeSetParamDivide(NodeID,ParamID,Value)

Example:
WDNodeSetParamDivide(3,1,10)

Divides the value of parameter 1 of Node 3 through 10, for example if Node 3 is a Value Input Node,
its Output value will be divided through 10. 

WDNodeSetParamFromNodeAdd

1059
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WDNodeSetParamFromNodeAdd(NodeID,ParamID,SourceNodeID,SourceNodeParamID)

Example:
WDNodeSetParamFromNodeAdd(4,1,2,3)

Adds the value of parameter 3 of Node 2 to the value of parameter 1 of Node 4. 

This way node values can be dynamically changed via commands to any number, without causing
infinite loops.

WDNodeSetParamFromNodeDivide

WDNodeSetParamFromNodeDivide(NodeID,ParamID,SourceNodeID,SourceNodeParamID)

Example:
WDNodeSetParamFromNodeDivide(4,1,2,3)

Divides the value of parameter 1 of Node 4 through the value of parameter 3 of Node 2. 

This way node values can be dynamically changed via commands to any number, without causing
infinite loops.

WDNodeSetParamFromNodeInputValue

WDNodeSetParamFromNodeInputValue(NodeID,ParamID,SourceNodeID,SourceNodeInParamID)

Example:
WDNodeSetParamFromNodeInputValue(7,2,6,1)

Sets the parameter 2 of Node 7 to the input value of parameter 1 of Node 6.

Allows to combine the current values of Nodes by ID

WDNodeSetParamFromNodeMinus

WDNodeSetParamFromNodeMinus(NodeID,ParamID,SourceNodeID,SourceNodeParamID)

Example:
WDNodeSetParamFromNodeMinus(4,1,2,3)

Subtracts the value of parameter 3 of Node 2 from the value of parameter 1 of Node 4. 

This way node values can be dynamically changed via commands to any number, without causing
infinite loops.

WDNodeSetParamFromNodeMultiply

WDNodeSetParamFromNodeMultiply(NodeID,ParamID,SourceNodeID,SourceNodeParamID)

Example:
WDNodeSetParamFromNodeMultiply(4,1,2,3)

Multiplies the value of parameter 1 of Node 4 with the value of parameter 3 of Node 2. 
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WDNodeSetParamFromNodeOutputValue

WDNodeSetParamFromNodeOutputValue(NodeID,ParamID,SourceNodeID,SourceNodeOutParamID)

Example:
WDNodeSetParamFromNodeOutputValue(7,2,6,1)

Sets the parameter 2 of Node 7 to the output value of parameter 1 of Node 6.

Allows to combine the current values of Nodes by ID

WDNodeSetParamMinus

WDNodeSetParamMinus(NodeID,ParamID,Value)

Example:
WDNodeSetParamMinus(3,1,10)

Subtracts the value 10 from parameter 1 of Node 3, for example if Node 3 is a Value Input Node, its
Output value will be decreased by 10. 

WDNodeSetParamMultiply

WDNodeSetParamMultiply(NodeID,ParamID,Value)

Example:
WDNodeSetParamMultiply(3,1,10)

Multiplies the value parameter 1 of Node 3 with the factor 10, for example if Node 3 is a Value Input
Node, its Output value will be multiplied by 10. 

WDNodeSetParamSource

WDNodeSetParamSource(NodeID,ParamID,SourceNodeID,SourceNodeParamID)

Example:
WDNodeSetParamSource(7,1,6,2)

Changes the source for the input parameter if two or more nodes or a single one with several values is
connected to a filter or output node.

In this depicted example the input parameter (1) of the Add node (7) will change to the value for Y
Position (2) of the Mouse Input node (6). 
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Rev 668 and higher support Node Commands  in a more direct form. The above command can be
replaced with the more direct command NodeID.ParamID&NodeID,ParamID. With the numbers

from the example, that would be: Node7.1&6.2

WDOffsetAllControls

WDOffsetAllControls(X,Y)

Example:
WDOffsetAllControls(100,50)

Moves all Widget Designer control widgets  100px to the right and 50px down.

WDOffsetControl

WDOffsetControl(ControlName,X,Y)

Example:
WDOffsetControl("CustomScript3",100,50)

Moves the button “CustomScript 3” 100px to the right and 50px down.

Note: Per default, the name of the control widget  consists of control type (Custom Script, Fader,
XY Panel, etc.) and ID without space characters. It is displayed in the Item Properties dialog at the
very beginning and can also be changed there.

WDOpacity

WDOpacity(Value 0-1)

Example:
WDOpacity(0.5)

1059

930

930
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Displays the entire Widget Designer window as a see-through (transparent) window. Insert values
between 0 and 1, with 0 being completely transparent and 1 being completely opaque.

WDPageBackgroundBottomColor

WDPageBackgroundBottomColor(Page,R,G,B)

Example:
WDPageBackgroundBottomColor("Page1,150,0,255)

Sets the background bottom color of page “Page1” to an intensive violet (R: 150, G: 0, B: 255). You
can change the color manually in the dialog "Page Settings " (Page > Edit Page) where you can
also set the Page size which, by the way, is independent from the Window size.

WDPageBackgroundColor

WDPageBackgroundColor(Page,R,G,B)

Example:
WDPageBackgroundColor("Page1,150,0,255)

Sets the background color of page “Page1” to an intensive violet (R: 150, G: 0, B: 255). You can
change the color manually in the dialog "Page Settings " (Page > Edit Page).

WDPageBackgroundTopColor

WDPageBackgroundTopColor(Page,R,G,B)

Example:
WDPageBackgroundTopColor("Page1,150,0,255)

Sets the background top color of page “Page1” to an intensive violet (R: 150, G: 0, B: 255). You can
change the color manually in the dialog "Page Settings " (Page > Edit Page) where you can also
set the Page size which, by the way, is independent from the Window size.

WDPageClearHistory

WDPageClearHistory

Example:
WDPageClearHistory

Clears the history, so that "WDPageForward" and "WDPagePrevious" do not call up another page
different than the "Default" one.

WDPageCssStyleDisable

WDPageCssStyleDisable(PageName,StyleID)

Example:
WDPageCssStyleDisable("Page5",2)

916

916

916
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Disables the CSS Style  with ID 2 in the Item Properties of the Page  with the name "Page5".

WDPageCssStyleEnable

WDPageCssStyleEnable(PageName,StyleID)

Example:
WDPageCssStyleEnable("Page5",2)

Enables the CSS Style  with ID 2 in the Item Properties of the Page  with the name "Page5".

WDPageDataRefresh

WDPageDataRefresh(Page,Interval)

Example:
WDPageDataRefresh(Page,Interval)

.

WDPageDisablePassword

WDPageDisablePassword(Page)

Example:
WDPageDisablePassword(“Page2”)

Disables the password of page “Page2”.

WDPageEnablePassword

WDPageEnablePassword(Page)

Example:
WDPageEnablePassword(“Page2”)

Enables the password of page “Page2”. If there was no password set before, nothing has to be
entered before clicking on “OK”.

WDPageExecuteEnterScript

WDPageExecuteEnterScript(Pagename)

Example:
WDPageExecuteEnterScript("Settings2")

Executes the On Page  Enter Script of the page named “Settings2”.

WDPageExecuteLeaveScript

926 916

926 916
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WDPageExecuteLeaveScript(Pagename)

Example:
WDPageExecuteLeaveScript("Settings2")

Executes the On Page  Leave Script of the page named “Settings2”.

WDPageForward

WDPageForward

Example:
WDPageForward

Calls up the next page in history.

WDPageGoto

WDPageGoto(Pagename)

Example:
WDPageGoto("faders")

Changes to page "faders" if the page "faders" was created before.

WDPageGotoSilent

WDPageGotoSilent(Pagename)

Example:
WDPageGotoSilent("faders")

Changes to page "faders" without executing its page enter script.

WDPageIndexWebPage

WDPageIndexWebPage(Page)

Example:
WDPageIndexWebPage(Page)

.

WDPageLabelConvertToPNG

WDPageLabelConvertToPNG(Page,File,Red,Green,Blue,Alpha)

Example:
WDPageLabelConvertToPNG("Page1","C:\Temp",150,0,255,128)

.

916
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WDPageLabelPictureBoxConvertToPNG

WDPageLabelPictureBoxConvertToPNG(Page,File)

Example:
WDPageLabelPictureBoxConvertToPNG("Page1","C:\Temp")

.

WDPageLabelPictureBoxConvertToTransparentPNG

WDPageLabelPictureBoxConvertToTransparentPNG(Page,File)

Example:
WDPageLabelPictureBoxConvertToTransparentPNG("Page1","C:\Temp")

.

WDPageLast

WDPageLast

Example:
WDPageLast

Goes to the last page in order. If this command is called when being on the first page, the last one
will be called.

WDPageNext

WDPageNext

Example:
WDPageNext

Goes to the next page in order. If this command is called when being on the last page, the first one
will be called.

WDPagePassword

WDPagePassword(Page,Password)

Example:
WDPagePassword(“Page2”,"PW123")

Sets (or changes) the password of page “Page2” to “PW123”. This command does not enable the
password function automatically.

WDPagePrevious

WDPagePrevious
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Example:
WDPagePrevious

Calls up the last page in history.

WDPagePrint

WDPagePrint

Example:
WDPagePrint

Choose this command to print the current WD GUI without opening the Windows Print-Dialog where
you can to choose and setup the printer. 

WDPagePrintGray

WDPagePrintGray

Example:
WDPagePrintGray

This command prints the current WD GUI in gray scale. 

WDPagePrintGrayInvert

WDPagePrintGrayInvert

Example:
WDPagePrintGrayInvert

This command prints the current WD GUI in inverted gray scale. 

WDPagePrintGrayInvertWithDialog

WDPagePrintGrayInvertWithDialog

Example:
WDPagePrintGrayInvertWithDialog

This command prints the current WD GUI in inverted gray scale. The Windows Print-Dialog opens
where you can choose and setup the printer. 

WDPagePrintGrayWithDialog

WDPagePrintGrayWithDialog

Example:
WDPagePrintGrayWithDialog

This command prints the current WD GUI in gray scale. The Windows Print-Dialog opens where you
can choose and setup the printer. 
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WDPagePrintInvert

WDPagePrintInvert

Example:
WDPagePrintInvert

This command prints the current WD GUI in inverted colors. 

WDPagePrintInvertWithDialog

WDPagePrintInvertWithDialog

Example:
WDPagePrintInvertWithDialog

This command prints the current WD GUI in inverted colors. The Windows Print-Dialog opens where
you can choose and setup the printer. 

WDPagePrintWithDialog

WDPagePrintWithDialog

Example:
WDPagePrintWithDialog

To print the current WD GUI this command opens the Windows Print-Dialog where you can to choose
and setup the printer. 

WDPagePublishAsWebPage

WDPagePublishAsWebPage(Page,True/False)

Example:
WDPagePublishAsWebPage(Page,True/False)

.

WDPageTransparent

WDPageTransparent(Page,True/False)

Example:
WDPageTransparent(Page,True/False)

.

WDPasswordDialog

WDPasswordDialog(Password)
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Example:
WDPasswordDialog("Coolux")

This command opens a Password Dialog, passwords can only be entered using the displayed
keyboard. In case the password is incorrect the script will not continue. If Coolux is typed in
correctly, the following commands will be executed.
This is useful to lock access to specific Pages or Commands.

WDPictureBoxApplyCITPThumbnail

WDPictureBoxApplyCITPThumbnail(ID,FolderID,FileID)

Example:
WDPictureBoxApplyCITPThumbnail(ID,FolderID,FileID)

Applies the CITP Thumbnail with Folder/File ID 1/5 to the PictureBox  with ID 1. A connection to
the respective Pandoras Box Master application has to be established. The Thumbnails do not have
to be exchanged manually between Widget Designer and Pandoras Box.

In Pandoras Box, the Folder and File ID can be applied or changed in the File Inspector .

WDPictureBoxCssStyleDisable

WDPictureBoxCssStyleDisable(ID,StyleID)

Example:
WDPictureBoxCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Picture Box  with ID 5.

WDPictureBoxCssStyleEdit

WDPictureBoxCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDPictureBoxCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Picture Box  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDPictureBoxCssStyleEnable

WDPictureBoxCssStyleEnable(ID,StyleID)

Example:
WDPictureBoxCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Picture Box  with ID 5.

WDPictureBoxFile

1014

191

926 1014
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WDPictureBoxFile(ID,File)

Example:
WDPictureBoxFile(1,"C:\coolux\content\test1.jpg")

Replaces the content of the PictureBox  control with the ID 1 with the image “test1.jpg” from the
path C:\coolux\content.

WDPictureBoxFix

WDPictureBoxFix(ID)

Example:
WDPictureBoxFix(5)

This activates the option "Fix" in the Item Properties of the Picture Box  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDPictureBoxLocation

WDPictureBoxLocation(ID,X,Y)

Example:
WDPictureBoxLocation(5,100,200)

Sets the position of the Picture Box  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.

WDPictureBoxLocationLeft

WDPictureBoxLocationLeft(ID,X)

Example:
WDPictureBoxLocationLeft(5,100)

Sets the position of the Picture Box  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDPictureBoxLocationTop

WDPictureBoxLocationTop(ID,Y)

Example:
WDPictureBoxLocationTop(5,200)

Sets the position of the Picture Box  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDPictureBoxRefresh

WDPictureBoxRefresh(ID)
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Example:
WDPictureBoxRefresh(ID)

Refreshes the PictureBox  1 and displays the current file. This command is useful if the file is
changed occasionally.

WDPictureBoxScreenshot

WDPictureBoxScreenshot(ID)

Example:
WDPictureBoxScreenshot(1)

Replaces the content of the PictureBox  control with the ID 1 with a screenshot from the current
desktop.

WDPictureBoxScreenshotRegion

WDPictureBoxScreenshotRegion(ID,X,Y,Width,Height)

Example:
WDPictureBoxScreenshotRegion(1,100,200,400,300)

Replaces the content of the PictureBox  control with the ID 1 with a screenshot of a region from
the current desktop. The screenshot regions position starts at pixel 100,200 (X,Y) and is 400 px wide
and 300 px high.

WDPictureBoxSize

WDPictureBoxSize(ID,Width,Height)

Example:
WDPictureBoxSize(5,100,40)

Sets the size of the Picture Box  with ID 5 to a width of 100px and a height of 40px.

WDPictureBoxSizeHeight

WDPictureBoxSizeHeight(ID,Height)

Example:
WDPictureBoxSizeHeight(5,40)

Sets the size of the Picture Box  with ID 5 to a height of 40px but remains the current width.

WDPictureBoxSizeWidth

WDPictureBoxSizeWidth(ID,Width)

Example:
WDPictureBoxSizeWidth(5,100)

1014
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Sets the size of the Picture Box  with ID 5 to a width of 100px but remains the current height.

WDPictureBoxUnfix

WDPictureBoxUnfix(ID)

Example:
WDPictureBoxUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Picture Box  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDPlaylistCssStyleDisable

WDPlaylistCssStyleDisable(ID,StyleID)

Example:
WDPlaylistCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Playlist  with ID 5.

WDPlaylistCssStyleEdit

WDPlaylistCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDPlaylistCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Playlist  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDPlaylistCssStyleEnable

WDPlaylistCssStyleEnable(ID,StyleID)

Example:
WDPlaylistCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Playlist  with ID 5.

WDPlaylistFix

WDPlaylistFix(ID)

Example:
WDPlaylistFix(5)

This activates the option "Fix" in the Item Properties of the Playlist  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDPlaylistLocation
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WDPlaylistLocation(ID,X,Y)

Example:
WDPlaylistLocation(5,100,200)

Sets the position of the Playlist  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the top
left corner of the Page.

WDPlaylistLocationLeft

WDPlaylistLocationLeft(ID,X)

Example:
WDPlaylistLocationLeft(5,100)

Sets the position of the Playlist  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDPlaylistLocationTop

WDPlaylistLocationTop(ID,Y)

Example:
WDPlaylistLocationTop(5,200)

Sets the position of the Playlist  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDPlaylistPause

WDPlaylistPause(ID)

Example:
WDPlaylistPause(5)

Pauses the playback of the Playlist  with ID 5.

WDPlaylistPlay

WDPlaylistPlay(ID)

Example:
WDPlaylistPlay(5)

Starts the playback of the Playlist  with ID 5.

WDPlaylistSize

WDPlaylistSize(ID,Width,Height)

Example:
WDPlaylistSize(5,100,40)
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Sets the size of the Playlist  with ID 5 to a width of 100px and a height of 40px.

WDPlaylistSizeHeight

WDPlaylistSizeHeight(ID,Height)

Example:
WDPlaylistSizeHeight(5,40)

Sets the size of the Playlist  with ID 5 to a height of 40px but remains the current width.

WDPlaylistSizeWidth

WDPlaylistSizeWidth(ID,Width)

Example:
WDPlaylistSizeWidth(5,100)

Sets the size of the Playlist  with ID 5 to a width of 100px but remains the current height.

WDPlaylistStop

WDPlaylistStop(ID)

Example:
WDPlaylistStop(5)

Stops the playback of the Playlist  with ID 5.

WDPlaylistUnfix

WDPlaylistUnfix(ID)

Example:
WDPlaylistUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Playlist  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDProjectorManagerApplyHomeLocation

WDProjectorManagerApplyHomeLocation(ID)

Example:
WDProjectorManagerApplyHomeLocation(ID)

Resets the calibrated points from Output ID 1 in the Projector Calibration Manager  to the stored
home location.

WDProjectorManagerApplyRecalOnly
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WDProjectorManagerApplyRecalOnly(ID)

Example:
WDProjectorManagerApplyRecalOnly(ID)

Applies the re-calibrated point values from Output ID 1 in the Projector Calibration Manager  to the
x-file without calibrating again. This might be useful if the X’-, Y’- and Z’-values were modified
manually.

WDProjectorManagerRecalibrate

WDProjectorManagerRecalibrate(ID)

Example:
WDProjectorManagerRecalibrate(ID)

Re-calibrates and applies the changes of Output ID 1 in the Projector Calibration Manager  to the
x-file.

WDProjectorManagerRecalOnly

WDProjectorManagerRecalOnly(ID)

Example:
WDProjectorManagerRecalOnly(ID)

Re-calibrates the calibration points from Output ID 1 in the Projector Calibration Manager  without
applying them to the x-file. This might be useful if the calibration has to be checked before overwriting
the x-file.

WDProjectorManagerShowCalibratedPoints

WDProjectorManagerShowCalibratedPoints(ID)

Example:
WDProjectorManagerShowCalibratedPoints(ID)

Shows the location of the re-calibrated points from Output ID 1 in the Projector Calibration Manager
. This is useful for checking if the calibration was done accurately e.g. if they match physical

reference points or fiber tips.

WDProjectorManagerShowHomePoints

WDProjectorManagerShowHomePoints(ID)

Example:
WDProjectorManagerShowHomePoints(ID)

Shows the location of the home points from Output ID 1 in the Projector Calibration Manager . This
is useful for checking if the calibration was done accurately e.g. if they match physical reference
points or fiber tips.

1296
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WDProjectorManagerStoreHome

WDProjectorManagerStoreHome(ID)

Example:
WDProjectorManagerStoreHome(ID)

Calibrates and stores the home points of Output ID 1 in the Projector Calibration Manager .

WDRemoteCOMDisable

WDRemoteCOMDisable

Example:
WDRemoteCOMDisable

Disables the COM Port connection set up via the Remoting Tool .

WDRemoteCOMEnable

WDRemoteCOMEnable

Example:
WDRemoteCOMEnable

Enables the COM Port connection set up via the Remoting Tool .

WDRemoteHTTPDisable

WDRemoteHTTPDisable

Example:
WDRemoteHTTPDisable

Disables the HTTP Listener set up via the Remoting Tool .

WDRemoteHTTPEnable

WDRemoteHTTPEnable

Example:
WDRemoteHTTPEnable

Enables the HTTP Listener set up via the Remoting Tool .

WDRemoteInputBufferClearCommands

WDRemoteInputBufferClearCommands

Example:
WDRemoteInputBufferClearCommands
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Clears the Remote Input Buffer in the Remoting Tool .

Note: The option "Buffer Remote Input Commands" has to be enabled in the Remoting Tool.

WDRemoteInputBufferCommandsDisable

WDRemoteInputBufferCommandsDisable

Example:
WDRemoteInputBufferCommandsDisable

Disables the Remote Input Buffer in the Remoting Tool  (i.e. the check box "Buffer Remote Input
Commands").

WDRemoteInputBufferCommandsEnable

WDRemoteInputBufferCommandsEnable

Example:
WDRemoteInputBufferCommandsEnable

Enables the Remote Input Buffer in the Remoting Tool  (i.e. the check box "Buffer Remote Input
Commands").

WDRemoteInputBufferProcessCommands

WDRemoteInputBufferProcessCommands

Example:
WDRemoteInputBufferProcessCommands

Processes all commands from the Remote Input Buffer fro the Remoting Tool , according to their
order.

Note: The option "Buffer Remote Input Commands" has to be enabled in the Remoting Tool.

WDRemoteInputBufferProcessFirstCommand

WDRemoteInputBufferProcessFirstCommand

Example:
WDRemoteInputBufferProcessFirstCommand

Processes the first command from the Remote Input Buffer in the Remoting Tool .

Note: The option "Buffer Remote Input Commands" has to be enabled in the Remoting Tool.

WDRemoteTCPDisable

WDRemoteTCPDisable
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Example:
WDRemoteTCPDisable

Disables the TCP connection set up via the Remoting Tool .

WDRemoteTCPEnable

WDRemoteTCPEnable

Example:
WDRemoteTCPEnable

Enables the TCP connection set up via the Remoting Tool .

WDRemoteUDPDisable

WDRemoteUDPDisable

Example:
WDRemoteUDPDisable

Disables the UDP connection set up via the Remoting Tool .

WDRemoteUDPEnable

WDRemoteUDPEnable

Example:
WDRemoteUDPEnable

Enables the UDP connection set up via the Remoting Tool .

WDResourceRecentSave

WDResourceRecentSave(Path)

Example:
WDResourceRecentSave("C:\WDResources")

Takes the last image that was sent from the WD Remote App  to the Image Resource Manager
(Style: User, Control: User) and saves it to the path "C:\WDResources". If you like to load other
images from the Resource Manager, use the command WDResourceSave.

WDResourceSave

WDResourceSave(Resource,Path)

Example:
WDResourceSave("Default\Button\Forward","C:\WDResources")

This saves the image with the name "Forward" from the Image Resource Manager  (Style: Default,
Control: Button) to the path "C:\WDResources".
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Example 2:
WDResourceSave("User\User\DSCN0780.JPG","C:\WDResources")

This saves images either added manually or sent with the WD Remote App , as these images
automatically appear under Style: User, Control: User. Alternatively, the command 
WDResourceRecentSave could also be of interest.

WDRestart

WDRestart

Example:
WDRestart

This restarts Widget Designer without saving the current WD project and opens a new empty file.
With restarting WD you can clean up the entire memory usage from the old project.

WDRssAddFeed

WDRssAddFeed(URL)

Example:
WDRssAddFeed(“https://www.christiedigital.com/_layouts/15/christiefeeds.aspx”)

Adds the RSS feed  “https://www.christiedigital.com/_layouts/15/christiefeeds.aspx” to the RSS
feed list.

WDRssRefreshFeeds

WDRssRefreshFeeds

Example:
WDRssRefreshFeeds

Refreshes the RSS feed  list.

WDRssRemoveFeed

WDRssRemoveFeed(URL)

Example:
WDRssRemoveFeed(“https://www.christiedigital.com/_layouts/15/christiefeeds.aspx”)

Removes the RSS feed  “https://www.christiedigital.com/_layouts/15/christiefeeds.aspx” from the
RSS feed list.

WDSave

WDSave
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Example:
WDSave

Saves the current WD project.

WDSaveAs

WDSaveAs

Example:
WDSaveAs

Opens the WD "Save as" dialog.

WDSaveAsCopy

WDSaveAsCopy

Example:
WDSaveAsCopy

This opens the Save As dialog box to save a new version of the existing file. After saving the copy
you will keep working in the current file with the current saving path. You might want to save the
current file in addition to making a copy.

WDSaveFile

WDSaveFile(Filename)

Example:
WDSaveFile("C:\coolux\content\project_test\project_test.wdp")

Saves the file “project_test.wdp” from the specified directory.

WDScreenshot

WDScreenshot(FileName)

Example:
WDScreenshot("C:\coolux\screenshots\Page1")

Creates a screenshot of the current WD user interface and save it as Page1.png under the path C:
\coolux\screenshots. 

If you don’t specify the file path with this command, the screenshot will be saved as Page1.png in the
root folder of your WD project. 

WDScreenshotDialog

WDScreenshotDialog
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Example:
WDScreenshotDialog

Creates a screenshot of the current WD user interface and opens the Save As Dialog, where you can
choose the location you want the screenshot to be saved and its name. It allows you to choose the
file type of your screenshot as well (Bitmap, Jpeg or PNG). 

WDScreenshotRegion

WDScreenshotRegion(X,Y,Width,Height,FileName)

Example:
WDScreenshotRegion(1,1,400,300,"C:\coolux\screenshots\Test1")

Creates a screenshot that is 400px wide and 300 px high, starting at pixel X=1 and Y=1 of the current
screen and saves it as Test1.png under the path C:\coolux\screenshots. 

If you don’t specify the file path with this command, the screenshot will be saved in the root folder of
your WD project. 

WDScreenshotRegionDialog

WDScreenshotRegionDialog(X,Y,Width,Height)

Example:
WDScreenshotRegionDialog(1,1,400,300)

Creates a screenshot that is 400px wide and 300 px high, starting at pixel X=1 and Y=1 of the current
screen and opens the Save As Dialog, where you can choose the location you want the screenshot
to be saved and its name. It allows you to choose the file type of your screenshot as well (Bitmap,
Jpeg or PNG). 

WDScreenshotRegionWithTime

WDScreenshotRegionWithTime(X,Y,Width,Height,FileName)

Example:
WDScreenshotRegionWithTime(1,1,400,300,"C:\coolux\screenshots\Test1")

Creates a screenshot that is 400px wide and 300 px high, starting at pixel X=1 and Y=1 of the current
screen and saves it as e.g. Test1_31_05_2011-16_43_22.png under the path C:\coolux\screenshots. 

If you don’t specify the file path with this command, the screenshot will be saved in the root folder of
your WD project. 

WDScreenshotWithTime

WDScreenshotWithTime(FileName)

Example:
WDScreenshotWithTime("C:\coolux\screenshots\Page1")
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Creates a screenshot of the current WD user interface and save it e.g. as Page1_31_05_2011-
16_43_22.png under the path C:\coolux\screenshots. 

If you don’t specify the file path with this command, the screenshot will be saved in the root folder of
your WD project. 

WDScriptTimerCssStyleDisable

WDScriptTimerCssStyleDisable(ID,StyleID)

Example:
WDScriptTimerCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Script Timer  button with ID 5.

WDScriptTimerCssStyleEdit

WDScriptTimerCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDScriptTimerCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Script Timer  button with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDScriptTimerCssStyleEnable

WDScriptTimerCssStyleEnable(ID,StyleID)

Example:
WDScriptTimerCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Script Timer  button with ID 5.

WDScriptTimerFix

WDScriptTimerFix(ID)

Example:
WDScriptTimerFix(5)

This activates the option "Fix" in the Item Properties of the Script Timer  button with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDScriptTimerInterval

WDScriptTimerInterval(ID,Value)

Example:
WDScriptTimerInterval(1,5000)

Changes the Interval Time of the Script Timer  with the ID 1 to 5000 ms.
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WDScriptTimerLocation

WDScriptTimerLocation(ID,X,Y)

Example:
WDScriptTimerLocation(5,100,200)

Sets the position of the Script Timer  button with ID 5 to 100px horizontally and 200px vertically.
0,0 is the top left corner of the Page.

WDScriptTimerLocationLeft

WDScriptTimerLocationLeft(ID,X)

Example:
WDScriptTimerLocationLeft(5,100)

Sets the position of the Script Timer  button with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDScriptTimerLocationTop

WDScriptTimerLocationTop(ID,Y)

Example:
WDScriptTimerLocationTop(5,200)

Sets the position of the Script Timer  button with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDScriptTimerPause

WDScriptTimerPause(ID)

Example:
WDScriptTimerPause(3)

Pauses Script Timer  3.

WDScriptTimerResume

WDScriptTimerResume(ID)

Example:
WDScriptTimerResume(3)

Resumes the paused Script Timer  3.

WDScriptTimerRunContinuous

WDScriptTimerRunContinuous(ID)
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Example:
WDScriptTimerRunContinuous(1)

Changes the mode of the Script Timer  with the ID 1 to run continuously.

WDScriptTimerRunOnce

WDScriptTimerRunOnce(ID)

Example:
WDScriptTimerRunOnce(1)

Changes the mode of the Script Timer  with the ID 1 to run only once.

WDScriptTimerSize

WDScriptTimerSize(ID,Width,Height)

Example:
WDScriptTimerSize(5,100,40)

Sets the size of the Script Timer  button with ID 5 to a width of 100px and a height of 40px.

WDScriptTimerSizeHeight

WDScriptTimerSizeHeight(ID,Height)

Example:
WDScriptTimerSizeHeight(5,40)

Sets the size of the Script Timer  button with ID 5 to a height of 40px but remains the current
width.

WDScriptTimerSizeWidth

WDScriptTimerSizeWidth(ID,Width)

Example:
WDScriptTimerSizeWidth(5,100)

Sets the size of the Script Timer  button with ID 5 to a width of 100px but remains the current
height.

WDScriptTimerStart

WDScriptTimerStart(ID)

Example:
WDScriptTimerStart(1)

Starts the Script Timer  with the ID 1. It will keep on running until it is stopped via a command or
via a click on it with the mouse (when it is set to run continuously).
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WDScriptTimerStop

WDScriptTimerStop(ID)

Example:
WDScriptTimerStop(1)

Stops the Script Timer  with the ID 1.

WDScriptTimerUnfix

WDScriptTimerUnfix(ID)

Example:
WDScriptTimerUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Script Timer  button with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDScrollerCssStyleDisable

WDScrollerCssStyleDisable(ID,StyleID)

Example:
WDScrollerCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Scroller  with ID 5.

WDScrollerCssStyleEdit

WDScrollerCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDScrollerCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Scroller  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDScrollerCssStyleEnable

WDScrollerCssStyleEnable(ID,StyleID)

Example:
WDScrollerCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Scroller  with ID 5.

WDScrollerFix

WDScrollerFix(ID)
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Example:
WDScrollerFix(5)

This activates the option "Fix" in the Item Properties of the Scroller  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDScrollerLocation

WDScrollerLocation(ID,X,Y)

Example:
WDScrollerLocation(5,100,200)

Sets the position of the Scroller  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the top
left corner of the Page.

WDScrollerLocationLeft

WDScrollerLocationLeft(ID,X)

Example:
WDScrollerLocationLeft(5,100)

Sets the position of the Scroller  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDScrollerLocationTop

WDScrollerLocationTop(ID,Y)

Example:
WDScrollerLocationTop(5,200)

Sets the position of the Scroller  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDScrollerReset

WDScrollerReset(ID)

Example:
WDScrollerReset(1)

Resets Scroller  1 by bringing the first Item to the first position..

WDScrollerSize

WDScrollerSize(ID,Width,Height)

Example:
WDScrollerSize(5,100,40)
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Sets the size of the Scroller  with ID 5 to a width of 100px and a height of 40px.

WDScrollerSizeHeight

WDScrollerSizeHeight(ID,Height)

Example:
WDScrollerSizeHeight(5,40)

Sets the size of the Scroller  with ID 5 to a height of 40px but remains the current width.

WDScrollerSizeWidth

WDScrollerSizeWidth(ID,Width)

Example:
WDScrollerSizeWidth(5,100)

Sets the size of the Scroller  with ID 5 to a width of 100px but remains the current height.

WDScrollerUnfix

WDScrollerUnfix(ID)

Example:
WDScrollerUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Scroller  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDShapeCol

WDShapeCol(ID,R,G,B,A)

Example:
WDShapeCol(2,120,0,255,255)

Sets the Fill and Outline Color of Shape  2 to R: 120, G: 0, B: 255 (deep violett), the alpha
channel/opacity is set to 255.

Note: The properties "Fill Color" and "Line Color" have to be enabled.

WDShapeCssStyleDisable

WDShapeCssStyleDisable(ID,StyleID)

Example:
WDShapeCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Shape  with ID 5.
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WDShapeCssStyleEdit

WDShapeCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDShapeCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Shape  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDShapeCssStyleEnable

WDShapeCssStyleEnable(ID,StyleID)

Example:
WDShapeCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Shape  with ID 5.

WDShapeDisableFillCol

WDShapeDisableFillCol(ID)

Example:
WDShapeDisableFillCol(2)

Disables the fill color of Shape  2.

WDShapeDisableOutlineCol

WDShapeDisableOutlineCol(ID)

Example:
WDShapeDisableOutlineCol(2)

Disables the colored outline of Shape  2.

WDShapeEnableFillCol

WDShapeEnableFillCol(ID)

Example:
WDShapeEnableFillCol(2)

Enables the fill color of Shape  2.

WDShapeEnableOutlineCol

WDShapeEnableOutlineCol(ID)
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Example:
WDShapeEnableOutlineCol(2)

Enables the colored outline of Shape  2.

WDShapeFillCol

WDShapeFillCol(ID,R,G,B,A)

Example:
WDShapeFillCol(2,120,0,255,255)

Sets the Fill Color of Shape  2 to R: 120, G: 0, B: 255 (deep violett), the alpha channel/opacity is
set to 255.

Note: The property "Fill Color" has to be enabled.

WDShapeFix

WDShapeFix(ID)

Example:
WDShapeFix(5)

This activates the option "Fix" in the Item Properties of the Shape  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDShapeLocation

WDShapeLocation(ID,X,Y)

Example:
WDShapeLocation(5,100,200)

Sets the position of the Shape  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the top
left corner of the Page.

WDShapeLocationLeft

WDShapeLocationLeft(ID,X)

Example:
WDShapeLocationLeft(5,100)

Sets the position of the Shape  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDShapeLocationTop

WDShapeLocationTop(ID,Y)
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Example:
WDShapeLocationTop(5,200)

Sets the position of the Shape  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDShapeOutlineCol

WDShapeOutlineCol(ID,R,G,B,A)

Example:
WDShapeOutlineCol(2,120,0,255,255)

Sets the Outline Color of Shape  2 to R: 120, G: 0, B: 255 (deep violett), the alpha channel/opacity
is set to 255.

Note: The property "Line Color" has to be enabled.

WDShapeSize

WDShapeSize(ID,Width,Height)

Example:
WDShapeSize(5,100,40)

Sets the size of the Shape  with ID 5 to a width of 100px and a height of 40px.

WDShapeSizeHeight

WDShapeSizeHeight(ID,Height)

Example:
WDShapeSizeHeight(5,40)

Sets the size of the Shape  with ID 5 to a height of 40px but remains the current width.

WDShapeSizeWidth

WDShapeSizeWidth(ID,Width)

Example:
WDShapeSizeWidth(5,100)

Sets the size of the Shape  with ID 5 to a width of 100px but remains the current height.

WDShapeUnfix

WDShapeUnfix(ID)

Example:
WDShapeUnfix(5)
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This deactivates the option "Fix" in the Item Properties of the Shape  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDStickyNoteCssStyleDisable

WDStickyNoteCssStyleDisable(ID,StyleID)

Example:
WDStickyNoteCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Sticky Note  with ID 5.

WDStickyNoteCssStyleEdit

WDStickyNoteCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDStickyNoteCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Sticky Note  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDStickyNoteCssStyleEnable

WDStickyNoteCssStyleEnable(ID,StyleID)

Example:
WDStickyNoteCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Sticky Note  with ID 5.

WDStickyNoteFix

WDStickyNoteFix(ID)

Example:
WDStickyNoteFix(5)

This activates the option "Fix" in the Item Properties of the Sticky Note  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDStickyNoteLocation

WDStickyNoteLocation(ID,X,Y)

Example:
WDStickyNoteLocation(5,100,200)

Sets the position of the Sticky Note  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.
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WDStickyNoteLocationLeft

WDStickyNoteLocationLeft(ID,X)

Example:
WDStickyNoteLocationLeft(5,100)

Sets the position of the Sticky Note  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDStickyNoteLocationTop

WDStickyNoteLocationTop(ID,Y)

Example:
WDStickyNoteLocationTop(5,200)

Sets the position of the Sticky Note  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDStickyNoteSize

WDStickyNoteSize(ID,Width,Height)

Example:
WDStickyNoteSize(5,100,40)

Sets the size of the Sticky Note  with ID 5 to a width of 100px and a height of 40px.

WDStickyNoteSizeHeight

WDStickyNoteSizeHeight(ID,Height)

Example:
WDStickyNoteSizeHeight(5,40)

Sets the size of the Sticky Note  with ID 5 to a height of 40px but remains the current width.

WDStickyNoteSizeWidth

WDStickyNoteSizeWidth(ID,Width)

Example:
WDStickyNoteSizeWidth(5,100)

Sets the size of the Sticky Note  with ID 5 to a width of 100px but remains the current height.

WDStickyNoteUnfix

WDStickyNoteUnfix(ID)
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Example:
WDStickyNoteUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Sticky Note  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDTextboxAddTextFromLabel

WDTextboxAddTextFromLabel(TXTBoxID,LabelID)

Example:
WDTextboxAddTextFromLabel(1,3)

Adds the text from Label 3 to the text of Textbox  1.

WDTextboxAddTextFromLastSMS

WDTextboxAddTextFromLastSMS(TXTBoxID)

Example:
WDTextboxAddTextFromLastSMS(2)

This adds the penultimate incoming SMS message to the Textbox  with ID 2.

WDTextboxAddTextFromRSSFeed

WDTextboxAddTextFromRSSFeed(TXTBoxID,RSSFeedID)

Example:
WDTextboxAddTextFromRSSFeed(2,26)

This adds the RSS Feed  including its title and body with ID 26 to the Textbox  with ID 2. 

WDTextboxAddTextFromRSSFeedBody

WDTextboxAddTextFromRSSFeedBody(TXTBoxID,RSSFeedID)

Example:
WDTextboxAddTextFromRSSFeedBody(2,26)

This adds the RSS Feed  body content with ID 26 to the Textbox  with ID 2. 

WDTextboxAddTextFromRSSFeedTitle

WDTextboxAddTextFromRSSFeedTitle(TXTBoxID,RSSFeedID)

Example:
WDTextboxAddTextFromRSSFeedTitle(2,26)

This adds the RSS Feed  title with ID 26 to the Textbox  with ID 2. 
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WDTextboxAddTextFromSMS

WDTextboxAddTextFromSMS(TXTBoxID,SMSID)

Example:
WDTextboxAddTextFromSMS(2,26)

This adds the SMS message  with ID 26 to the Textbox  with ID 2. 

WDTextboxAddTextFromTextbox

WDTextboxAddTextFromTextbox(TXTBoxID,TXTBoxSourceID)

Example:
WDTextboxAddTextFromTextbox(1,3)

Adds the text from Textbox 3 to the text of Textbox  1.

WDTextboxAppend

WDTextboxAppend(ID,Value)

Example:
WDTextboxAppend(1,"Hello")

Adds the text “Hello” to the Textbox  1. If there is a variable with the name "Hello", its value will be
appended to the textbox instead.

This way you may compose a script inside a textbox that can be executed via the command 
WDTextboxExecuteAsScript,ID .

WDTextboxAppendFromFile

WDTextboxAppendFromFile(ID,Filename)

Example:
WDTextboxAppendFromFile(3,"C:\coolux\content\Test.txt")

This copies the content from the text file saved under C:\coolux\content\Test.txt and

appends it to the text in the Widget Designer Textbox  with ID 3.

WDTextboxAppendTextOnly

WDTextboxAppendTextOnly(ID,Text)

Example:
WDTextboxAppendTextOnly(1,"Hello")

Adds the text “Hello” to the Textbox  1. If there is a variable with the name "Hello", still the string
"Hello" is appended and not the variables value.
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This way you may compose a script inside a textbox that can be executed via the command 
WDTextboxExecuteAsScript,ID .

WDTextboxAppendToFile

WDTextboxAppendToFile(ID,Filename)

Example:
WDTextboxAppendToFile(3,"C:\coolux\content\Test.txt")

This copies the text content from the Widget Designer Textbox  with ID 3 and appends it to the
text from the file saved under the following path: C:\coolux\content\Test.txt.

WDTextboxClear

WDTextboxClear(TXTBoxID)

Example:
WDTextboxClear(1)

Clears all text from the Textbox  1.

WDTextboxConvertToHorizontalScrolltextPNG

WDTextboxConvertToHorizontalScrolltextPNG(ID,File,Red,Green,Blue,Alpha)

Example:
WDTextboxConvertToHorizontalScrolltextPNG(3,"C:\coolux\content\blue.png",0,0,170,255)

First( this command converts the text of )Textbox  with ID 3 to a horizontal scrolltext, meaning that
all line ends are deleted. Then it saves the text as an image file to the following path C:\coolux

\content\blue.png. The image size, text color and other font properties accord to the Textbox

font settings in Widget Designer whilst the image background color is set with the command. In the
example, the color 0,0,170,255 is chosen for RGBA, resulting in a fully opaque blue background.

WDTextboxConvertToPNG

WDTextboxConvertToPNG(ID,File)

Example:
WDTextboxConvertToPNG(3,"C:\coolux\content\text.png")

This command saves the text of Textbox  with ID 3 including all line ends as an image file to the
following path C:\coolux\content\text.png. The image size matches the Textbox size and

the text color and other font properties accord to the Textbox font settings in Widget Designer. The
image background color is always black.

WDTextBoxCssStyleDisable

WDTextBoxCssStyleDisable(ID,StyleID)
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Example:
WDTextBoxCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Textbox  with ID 5.

WDTextBoxCssStyleEdit

WDTextBoxCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDTextBoxCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Textbox  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDTextBoxCssStyleEnable

WDTextBoxCssStyleEnable(ID,StyleID)

Example:
WDTextBoxCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Textbox  with ID 5.

WDTextboxExecuteAsScript

WDTextboxExecuteAsScript(ID)

Example:
WDTextboxExecuteAsScript(1)

Executes the text in Textbox  1 as a command. You may use the command WDTextboxAppend
 to compose the script from single parts.

WDTextBoxFix

WDTextBoxFix(ID)

Example:
WDTextBoxFix(5)

This activates the option "Fix" in the Item Properties of the Textbox  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDTextboxFocus

WDTextboxFocus(ID)

Example:
WDTextboxFocus(3)
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This sets the Textbox  with ID 3 into the focus, meaning that the next keyboard input will be added
to this Textbox.

WDTextboxFromFile

WDTextboxFromFile(ID,Filename)

Example:
WDTextboxFromFile(3,"C:\coolux\content\Test.txt")

This copies the content from the text file saved under C:\coolux\content\Test.txt and

overwrittes the text in the Widget Designer Textbox  with ID 3.

WDTextBoxLocation

WDTextBoxLocation(ID,X,Y)

Example:
WDTextBoxLocation(5,100,200)

Sets the position of the Textbox  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the top
left corner of the Page.

WDTextBoxLocationLeft

WDTextBoxLocationLeft(ID,X)

Example:
WDTextBoxLocationLeft(5,100)

Sets the position of the Textbox  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDTextBoxLocationTop

WDTextBoxLocationTop(ID,Y)

Example:
WDTextBoxLocationTop(5,200)

Sets the position of the Textbox  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDTextboxNewline

WDTextboxNewline(ID)

Example:
WDTextboxNewline,1

Starts a new line in the Textbox  1.
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This way you may compose a script list inside a textbox that can be executed via the command 
WDTextboxExecuteAsScript,ID .

WDTextboxRefresh

WDTextboxRefresh(ID)

Example:
WDTextboxRefresh(1)

Updates the text of Textbox  1. This is useful when the Textbox Input Node  is used and the
Textbox ID inside the node is changed via a command.

WDTextboxReplaceLineEnd

WDTextboxReplaceLineEnd(ID,Text)

Example:
WDTextboxReplaceLineEnd(1,"FLIP")

This replaces each end of a line in Textbox  with ID 1 with the word "FLIP".
First Line
Second Line
Third Line
becomes: first lineFLIPsecond lineFLIPthird line

WDTextBoxSize

WDTextBoxSize(ID,Width,Height)

Example:
WDTextBoxSize(5,100,40)

Sets the size of the Textbox  with ID 5 to a width of 100px and a height of 40px.

WDTextBoxSizeHeight

WDTextBoxSizeHeight(ID,Height)

Example:
WDTextBoxSizeHeight(5,40)

Sets the size of the Textbox  with ID 5 to a height of 40px but remains the current width.

WDTextBoxSizeWidth

WDTextBoxSizeWidth(ID,Width)

Example:
WDTextBoxSizeWidth(5,100)

Sets the size of the Textbox  with ID 5 to a width of 100px but remains the current height.
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WDTextboxToFile

WDTextboxToFile(ID,Filename)

Example:
WDTextboxToFile(3,"C:\coolux\content\Test.txt")

This copies the text content from the Widget Designer Textbox  with ID 3 and overwrittes all text in
the text file saved under the following path: C:\coolux\content\Test.txt.

WDTextboxTrimEndToTotalCount

WDTextboxTrimEndToTotalCount(ID,Count)

Example:
WDTextboxTrimEndToTotalCount(1,8)

This removes all characters from Textbox  with ID 1, except the first 8 characters.

WDTextBoxUnfix

WDTextBoxUnfix(ID)

Example:
WDTextBoxUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Textbox  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDTextConvertToColoredQRCodePNG

WDTextConvertToColoredQRCodePNG(Size,R,G,B,A,R,G,B,A,File,Text)

Example:
WDTextConvertToColoredQRCodePNG(5,150,0,255,255,0,255,0,120,"C:\coolux\content
\qr_col.png","Hello")

This command converts the text "Hello" to a colored QR code. The QR code size 5 results in an
image width and height of 189px, see below. The foreground color is set to 150,0,255,255 for RGBA
(a fully opaque purple) and the background to 0,255,0,120, a half transparent green.

The size 0 results in an 1px large image. Every further step adds 47px. Hence, a size of 5 results in
189px as 1px+4*47px=189px.

WDTextConvertToHorizontalScrollTextPNG

WDTextConvertToHorizontalScrollTextPNG(Text(),Font(),File,Red,Green,Blue,Alpha)

Example:
WDTextConvertToHorizontalScrollTextPNG("Hello","Mistral/12/Bold/170/255/170/170","c:\coolux
\content\text.png",0,0,170,255)
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This command saves the text "Hello" as an image file to the following path C:\coolux\content

\text.png. The text font is set to "Mistral", the text size to 12pt, the text style to "Bold" and the

text color to 170,0,170,170 for RGBA. The image background color is set to 0,0,170,255 for RGBA,
resulting in a fully opaque blue background.

Font syntax: Name/Size/Style/R/G/B/A
Style options: Regular,Bold,Italic,Underline or Strikeout

WDTextConvertToQRCodePNG

WDTextConvertToQRCodePNG(File,Text)

Example:
WDTextConvertToQRCodePNG("C:\coolux\content\qr_bw.png","Widget Designer")

This command converts the text "Widget Designer" to a QR code. The black and white QR code is
saved as an image file to the following path C:\coolux\content\qr_bw.png.

WDTextInputClear

WDTextInputClear(ID)

Example:
WDTextInputClear(1)

Clears all text from the Text Input  1.

WDTextInputCssStyleDisable

WDTextInputCssStyleDisable(ID,StyleID)

Example:
WDTextInputCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Text Input  with ID 5.

WDTextInputCssStyleEdit

WDTextInputCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDTextInputCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Text Input  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDTextInputCssStyleEnable

WDTextInputCssStyleEnable(ID,StyleID)
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Example:
WDTextInputCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Text Input  with ID 5.

WDTextInputFix

WDTextInputFix(ID)

Example:
WDTextInputFix(5)

This activates the option "Fix" in the Item Properties of the Text Input  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDTextInputGotoLine

WDTextInputGotoLine(ID,SourceID)

Example:
WDTextInputGotoLine(1,2)

Jumps to the line number 2 in Text Input  1.

WDTextInputGotoLineFromTextBox

WDTextInputGotoLineFromTextBox(ID,SourceTextboxID)

Example:
WDTextInputGotoLineFromTextBox(1,2)

Jumps to the line in Text Input  1, that is taken from the numeric entry in Textbox  2.

WDTextInputLast

WDTextInputLast(ID)

Example:
WDTextInputLast(1)

Sets the Text Input  to the last available line.

WDTextInputLocation

WDTextInputLocation(ID,X,Y)

Example:
WDTextInputLocation(5,100,200)

Sets the position of the Text Input  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.
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WDTextInputLocationLeft

WDTextInputLocationLeft(ID,X)

Example:
WDTextInputLocationLeft(5,100)

Sets the position of the Text Input  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDTextInputLocationTop

WDTextInputLocationTop(ID,Y)

Example:
WDTextInputLocationTop(5,200)

Sets the position of the Text Input  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDTextInputNext

WDTextInputNext(ID)

Example:
WDTextInputNext(1)

Sets the Text Input  to the next available line.

WDTextInputReset

WDTextInputReset(ID)

Example:
WDTextInputReset(1)

Sets the Text Input  to the first available line.

WDTextInputSize

WDTextInputSize(ID,Width,Height)

Example:
WDTextInputSize(5,100,40)

Sets the size of the Text Input  with ID 5 to a width of 100px and a height of 40px.

WDTextInputSizeHeight

WDTextInputSizeHeight(ID,Height)
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Example:
WDTextInputSizeHeight(5,40)

Sets the size of the Text Input  with ID 5 to a height of 40px but remains the current width.

WDTextInputSizeWidth

WDTextInputSizeWidth(ID,Width)

Example:
WDTextInputSizeWidth(5,100)

Sets the size of the Text Input  with ID 5 to a width of 100px but remains the current height.

WDTextInputUnfix

WDTextInputUnfix(ID)

Example:
WDTextInputUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Text Input  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDTextInputUpdate

WDTextInputUpdate(ID)

Example:
WDTextInputUpdate(1)

Updates the current line in Text Input  1 (no effect when Auto-Update is set in the Item Properties
of this panel).

WDTransparencyKey

WDTransparencyKey(R,G,B)

Example:
WDTransparencyKey(255,255,255)

Sets the Transparency Key to white (Red:255, Green:255, Blue:255) and displays all pixels with this
color as see-through (transparent) areas. Note that this effects the entire Widget Designer window.
The command WDTransparencyKeyOff deactivates this feature again.

WDTransparencyKeyOff

WDTransparencyKeyOff

Example:
WDTransparencyKeyOff
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This deactivates the Transparency Key, when used before with the command 
WDTransparencyKey.

WDTreeViewCssStyleDisable

WDTreeViewCssStyleDisable(ID,StyleID)

Example:
WDTreeViewCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Tree View  with ID 5.

WDTreeViewCssStyleEdit

WDTreeViewCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDTreeViewCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Tree View  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDTreeViewCssStyleEnable

WDTreeViewCssStyleEnable(ID,StyleID)

Example:
WDTreeViewCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Tree View  with ID 5.

WDTreeViewFix

WDTreeViewFix(ID)

Example:
WDTreeViewFix(5)

This activates the option "Fix" in the Item Properties of the Tree View  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDTreeViewLocation

WDTreeViewLocation(ID,X,Y)

Example:
WDTreeViewLocation(5,100,200)

Sets the position of the Tree View  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.
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WDTreeViewLocationLeft

WDTreeViewLocationLeft(ID,X)

Example:
WDTreeViewLocationLeft(5,100)

Sets the position of the Tree View  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDTreeViewLocationTop

WDTreeViewLocationTop(ID,Y)

Example:
WDTreeViewLocationTop(5,200)

Sets the position of the Tree View  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDTreeviewRefreshTree

WDTreeviewRefreshTree(ID)

Example:
WDTreeviewRefreshTree(1)

Refreshes the TreeView  with ID 1.

WDTreeviewRoot

WDTreeviewRoot(ID,Path)

Example:
WDTreeviewRoot(1,“C:\coolux\content”)

Sets the root folder of TreeView with ID 1 to “C:\coolux\content”.

Note: The TreeView property "Source" needs to be set to "FileSystem" and the TreeView has to be
refreshed with the command WDTreeviewRefreshTree(1).

WDTreeViewSize

WDTreeViewSize(ID,Width,Height)

Example:
WDTreeViewSize(5,100,40)

Sets the size of the Tree View  with ID 5 to a width of 100px and a height of 40px.

WDTreeViewSizeHeight
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WDTreeViewSizeHeight(ID,Height)

Example:
WDTreeViewSizeHeight(5,40)

Sets the size of the Tree View  with ID 5 to a height of 40px but remains the current width.

WDTreeViewSizeWidth

WDTreeViewSizeWidth(ID,Width)

Example:
WDTreeViewSizeWidth(5,100)

Sets the size of the Tree View  with ID 5 to a width of 100px but remains the current height.

WDTreeViewUnfix

WDTreeViewUnfix(ID)

Example:
WDTreeViewUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Tree View  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDUnlock

WDUnlock

Example:
WDUnlock

This unlocks your WD project window and allows mouse and keyboard input again. Alternatively, you
can press Ctrl+Pause.

WDUnlockGui

WDUnlockGui

Example:
WDUnlockGui

This toogles the Protection Mode off and allows all mouse and keyboard input again. To enable the
Protection mode, use the command WDLockGui . Alternatively, the shortcut Ctrl+Shift+P toggles
the Protection Mode.

WDVariableAppendLineToFile

WDVariableAppendLineToFile(Variable,FileName)

1034

1034

1034

1534



1605

Example:
WDVariableAppendLineToFile(var_Message,"C:\Temp\file.txt")

Appends the value of the variable  “var_Message” as a new line to the text file “C:\Temp\file.txt”. If
the file does not exist yet, WD creates it.

WDVariableAppendTimelogLineToFile

WDVariableAppendTimelogLineToFile(Variable,FileName)

Example:
WDVariableAppendTimelogLineToFile(var_Message,"C:\Temp\file.txt")

Appends the current date and time as well as the value of the variable  “var_Message” as a new
line to the text file “C:\Temp\file.txt”. If the file does not exist yet, WD creates it.

E.g.: Nov 20, 2015 10:42:37 and var_Message = WD Message Test
Result: 20,11,2015,10,42,37,WD Message Test

WDVariableAppendToFile

WDVariableAppendToFile(Variable,FileName)

Example:
WDVariableAppendToFile(var_Message,"C:\Temp\file.txt")

Appends the value of the variable  “var_Message” to the text file “C:\Temp\file.txt”. If the file does
not exist yet, WD creates it.
If you like to append the message in a new line, please use the command 
WDVariableAppendLineToFile.

WDVideoControl

WDVideoControl(ID,"Play"/"Loop"/"Pause"/"Stop")

Example:
WDVideoControl(2,"Play")

Plays the file that is loaded into the Videoplayer  with the ID 2.

Example 2:
WDVideoControl(2,"Loop")
Loops the file that is played in the Videoplayer  with the ID 2.

Example 3:
WDVideoControl(2,"Pause")
Pauses the file that is played in the Videoplayer  with the ID 2.

Example 4:
WDVideoControl(2,"Stop")
Stops the file that is played in the Videoplayer  with the ID 2.

WDVideoFile
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WDVideoFile(ID,File)

Example:
WDVideoFile(2,"C:\coolux\content Pandora\MediaLoops 00201-00300\00214_kiosk.mpg")

Loads the file 00214_kiosk.mpg from the specified directory into the Videoplayer  with the ID 2.

WDVideoGotoTime

WDVideoGotoTime(ID,Second)

Example:
WDVideoGotoTime(1,80)

Jumps in the file loaded to Videoplayer  1 to the time 1min 20 sec (80 sec).

WDVideoGotoTimeRelative

WDVideoGotoTimeRelative(ID,Second)

Example:
WDVideoGotoTimeRelative(1,-25)

Jumps in the file loaded to Videoplayer  1 to the time 25 seconds backward.

To jump forward 15 seconds enter WDVideoGotoTimeRelative,1,15

WDVideoPlayerCssStyleDisable

WDVideoPlayerCssStyleDisable(ID,StyleID)

Example:
WDVideoPlayerCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Video Player  with ID 5.

WDVideoPlayerCssStyleEdit

WDVideoPlayerCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDVideoPlayerCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Video Player  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDVideoPlayerCssStyleEnable

WDVideoPlayerCssStyleEnable(ID,StyleID)

Example:
WDVideoPlayerCssStyleEnable(5,2)
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Enables the CSS Style  with ID 2 in the Item Properties of the Video Player  with ID 5.

WDVideoPlayerFix

WDVideoPlayerFix(ID)

Example:
WDVideoPlayerFix(5)

This activates the option "Fix" in the Item Properties of the Video Player  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDVideoPlayerLocation

WDVideoPlayerLocation(ID,X,Y)

Example:
WDVideoPlayerLocation(5,100,200)

Sets the position of the Video Player  with ID 5 to 100px horizontally and 200px vertically. 0,0 is
the top left corner of the Page.

WDVideoPlayerLocationLeft

WDVideoPlayerLocationLeft(ID,X)

Example:
WDVideoPlayerLocationLeft(5,100)

Sets the position of the Video Player  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDVideoPlayerLocationTop

WDVideoPlayerLocationTop(ID,Y)

Example:
WDVideoPlayerLocationTop(5,200)

Sets the position of the Video Player  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDVideoPlayerSize

WDVideoPlayerSize(ID,Width,Height)

Example:
WDVideoPlayerSize(5,100,40)

Sets the size of the Video Player  with ID 5 to a width of 100px and a height of 40px.
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WDVideoPlayerSizeHeight

WDVideoPlayerSizeHeight(ID,Height)

Example:
WDVideoPlayerSizeHeight(5,40)

Sets the size of the Video Player  with ID 5 to a height of 40px but remains the current width.

WDVideoPlayerSizeWidth

WDVideoPlayerSizeWidth(ID,Width)

Example:
WDVideoPlayerSizeWidth(5,100)

Sets the size of the Video Player  with ID 5 to a width of 100px but remains the current height.

WDVideoPlayerUnfix

WDVideoPlayerUnfix(ID)

Example:
WDVideoPlayerUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Video Player  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDVideoSetVolume

WDVideoSetVolume(ID,Value)

Example:
WDVideoSetVolume(2,50)

Sets the volume for the Videoplayer  with the ID 2 to the value 50. The value for volume ranges from
0 to 100.

WDVideoSnapshotCssStyleDisable

WDVideoSnapshotCssStyleDisable(ID,StyleID)

Example:
WDVideoSnapshotCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Video Snapshot  button with ID
5.

WDVideoSnapshotCssStyleEdit

WDVideoSnapshotCssStyleEdit(ID,StyleID,ParamName,Value)
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Example:
WDVideoSnapshotCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Video Snapshot  button with ID 5.
The parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDVideoSnapshotCssStyleEnable

WDVideoSnapshotCssStyleEnable(ID,StyleID)

Example:
WDVideoSnapshotCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Video Snapshot  button with ID
5.

WDVideoSnapshotFix

WDVideoSnapshotFix(ID)

Example:
WDVideoSnapshotFix(5)

This activates the option "Fix" in the Item Properties of the Video Snapshot  button with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDVideoSnapshotLocation

WDVideoSnapshotLocation(ID,X,Y)

Example:
WDVideoSnapshotLocation(5,100,200)

Sets the position of the Video Snapshot  button with ID 5 to 100px horizontally and 200px
vertically. 0,0 is the top left corner of the Page.

WDVideoSnapshotLocationLeft

WDVideoSnapshotLocationLeft(ID,X)

Example:
WDVideoSnapshotLocationLeft(5,100)

Sets the position of the Video Snapshot  button with ID 5 to 100px horizontally but remains the
current vertical position. 0,0 is the top left corner of the Page.

WDVideoSnapshotLocationTop

WDVideoSnapshotLocationTop(ID,Y)

Example:
WDVideoSnapshotLocationTop(5,200)
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Sets the position of the Video Snapshot  button with ID 5 to 200px vertically but remains the
current horizontal position. 0,0 is the top left corner of the Page.

WDVideoSnapshotSize

WDVideoSnapshotSize(ID,Width,Height)

Example:
WDVideoSnapshotSize(5,100,40)

Sets the size of the Video Snapshot  button with ID 5 to a width of 100px and a height of 40px.

WDVideoSnapshotSizeHeight

WDVideoSnapshotSizeHeight(ID,Height)

Example:
WDVideoSnapshotSizeHeight(5,40)

Sets the size of the Video Snapshot  button with ID 5 to a height of 40px but remains the current
width.

WDVideoSnapshotSizeWidth

WDVideoSnapshotSizeWidth(ID,Width)

Example:
WDVideoSnapshotSizeWidth(5,100)

Sets the size of the Video Snapshot  button with ID 5 to a width of 100px but remains the current
height.

WDVideoSnapshotUnfix

WDVideoSnapshotUnfix(ID)

Example:
WDVideoSnapshotUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Video Snapshot  button with ID 5.
"Fix" influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDVideoVolumeDown

WDVideoVolumeDown(ID,Value)

Example:
WDVideoVolumeDown(2,10)

Decreases the volume of the Videoplayer  with the ID 2 by 10 steps. The value for volume ranges
from 0 to 100.
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WDVideoVolumeUp

WDVideoVolumeUp(ID,Value)

Example:
WDVideoVolumeUp(2,10)

Increases the volume of the Videoplayer  with the ID 2 by 10 steps. The value for volume ranges
from 0 to 100.

WDViewerModeDisable

WDViewerModeDisable

Example:
WDViewerModeDisable

This disables the Viewer Mode  in Widget Designer meaning that the user has full access to the
WD options:
- Edit Mode and Run Mode possible
- the right-click menu as well as the Menu Bar offer all options

WDViewerModeEnable

WDViewerModeEnable

Example:
WDViewerModeEnable

This enables the Viewer Mode  in Widget Designer meaning that the user cannnot edit the
interface.
- no Edit Mode possible => no repositioning of GUI elements, etc.
- the right-click menu as well as the Menu Bar  only allow to load a new WD File => no saving
(under old or new name), no Item Properties, etc
- the Run Mode works without restriction.

WDWait

WDWait(Seconds)

Example:
WDWait(5.5)

WD waits 5.5 seconds (5500ms) before the next command in the script list is executed.

WDWaitCancelAll

WDWaitCancelAll

Example:
WDWaitCancelAll
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Cancels all running WDWait commands. 
Please note that a script list currently executing a WDWait command will be canceled at this point
as well.

WDWaitCancelItem

WDWaitCancelItem(ItemName)

Example:
WDWaitCancelItem("CustomScript1")

Cancels the running WDWait commands executed by Custom Script Button 1. 
Please note that a script list currently executing a WDWait command will be canceled at this point
as well.

WDWebBrowserClearCache

WDWebBrowserClearCache

Example:
WDWebBrowserClearCache

Clears the cache of the Web Browser .

WDWebBrowserContent

WDWebBrowserContent(BrowserID,Url)

Example:
WDWebBrowserContent(1,"www.coolux.de")

Displays the web site with the address http://www.coolux.de in the Web Browser  with the ID 1.

WDWebBrowserCssStyleDisable

WDWebBrowserCssStyleDisable(ID,StyleID)

Example:
WDWebBrowserCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Web Browser  with ID 5.

WDWebBrowserCssStyleEdit

WDWebBrowserCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDWebBrowserCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Web Browser  with ID 5. The
parameter "StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.
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WDWebBrowserCssStyleEnable

WDWebBrowserCssStyleEnable(ID,StyleID)

Example:
WDWebBrowserCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Web Browser  with ID 5.

WDWebBrowserFix

WDWebBrowserFix(ID)

Example:
WDWebBrowserFix(5)

This activates the option "Fix" in the Item Properties of the Web Browser  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDWebBrowserLocation

WDWebBrowserLocation(ID,X,Y)

Example:
WDWebBrowserLocation(5,100,200)

Sets the position of the Web Browser  with ID 5 to 100px horizontally and 200px vertically. 0,0 is
the top left corner of the Page.

WDWebBrowserLocationLeft

WDWebBrowserLocationLeft(ID,X)

Example:
WDWebBrowserLocationLeft(5,100)

Sets the position of the Web Browser  with ID 5 to 100px horizontally but remains the current
vertical position. 0,0 is the top left corner of the Page.

WDWebBrowserLocationTop

WDWebBrowserLocationTop(ID,Y)

Example:
WDWebBrowserLocationTop(5,200)

Sets the position of the Web Browser  with ID 5 to 200px vertically but remains the current
horizontal position. 0,0 is the top left corner of the Page.

WDWebBrowserSize
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WDWebBrowserSize(ID,Width,Height)

Example:
WDWebBrowserSize(5,100,40)

Sets the size of the Web Browser  with ID 5 to a width of 100px and a height of 40px.

WDWebBrowserSizeHeight

WDWebBrowserSizeHeight(ID,Height)

Example:
WDWebBrowserSizeHeight(5,40)

Sets the size of the Web Browser  with ID 5 to a height of 40px but remains the current width.

WDWebBrowserSizeWidth

WDWebBrowserSizeWidth(ID,Width)

Example:
WDWebBrowserSizeWidth(5,100)

Sets the size of the Web Browser  with ID 5 to a width of 100px but remains the current height.

WDWebBrowserUnfix

WDWebBrowserUnfix(ID)

Example:
WDWebBrowserUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Web Browser  with ID 5. "Fix"
influences whether the Widget is only visible on the Page it was created on, or on all Pages.

WDWheelAbortAllFades

WDWheelAbortAllFades

Example:
WDWheelAbortAllFades

Aborts all currently running fades on every Wheel .

WDWheelAbortFade

WDWheelAbortFade(ID)

Example:
WDWheelAbortFade(3)

Aborts the currently running fade of Wheel  3.
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WDWheelCssStyleDisable

WDWheelCssStyleDisable(ID,StyleID)

Example:
WDWheelCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the Wheel  with ID 5.

WDWheelCssStyleEdit

WDWheelCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDWheelCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the Wheel  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

WDWheelCssStyleEnable

WDWheelCssStyleEnable(ID,StyleID)

Example:
WDWheelCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the Wheel  with ID 5.

WDWheelFactor

WDWheelFactor(ID,Value)

Example:
WDWheelFactor(7,5)

Sets the factor of Wheel  7 to the value 5.

WDWheelFadeDown

WDWheelFadeDown(ID,Value)

Example:
WDWheelFadeDown(3,20)

Fades the current value of Wheel  3 down to the minimum value within 20 seconds.

WDWheelFadeToValue

WDWheelFadeToValue(ID,Time,Value)
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Example:
WDWheelFadeToValue(3,10,175)

Fades the current value of Wheel  3 to value 175 within 10 seconds.

WDWheelFadeUp

WDWheelFadeUp(ID,Value)

Example:
WDWheelFadeUp(3,10)

Fades the current value of Wheel  3 up to the maximum value within 10 seconds.

WDWheelFix

WDWheelFix(ID)

Example:
WDWheelFix(5)

This activates the option "Fix" in the Item Properties of the Wheel  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDWheelGoDown

WDWheelGoDown(ID,Value)

Example:
WDWheelGoDown(7,10)

Subtracts immediately 10 values from the value of Wheel  7.

WDWheelGoUp

WDWheelGoUp(ID,Value)

Example:
WDWheelGoUp(7,10)

Adds immediately 10 values to the value of Wheel  7.

WDWheelLocation

WDWheelLocation(ID,X,Y)

Example:
WDWheelLocation(5,100,200)

Sets the position of the Wheel  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the top
left corner of the Page.
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WDWheelLocationLeft

WDWheelLocationLeft(ID,X)

Example:
WDWheelLocationLeft(5,100)

Sets the position of the Wheel  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDWheelLocationTop

WDWheelLocationTop(ID,Y)

Example:
WDWheelLocationTop(5,200)

Sets the position of the Wheel  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDWheelSize

WDWheelSize(ID,Width,Height)

Example:
WDWheelSize(5,100,40)

Sets the size of the Wheel  with ID 5 to a width of 100px and a height of 40px.

WDWheelSizeHeight

WDWheelSizeHeight(ID,Height)

Example:
WDWheelSizeHeight(5,40)

Sets the size of the Wheel  with ID 5 to a height of 40px but remains the current width.

WDWheelSizeWidth

WDWheelSizeWidth(ID,Width)

Example:
WDWheelSizeWidth(5,100)

Sets the size of the Wheel  with ID 5 to a width of 100px but remains the current height.

WDWheelUnfix

WDWheelUnfix(ID)

988

988

988

988

988
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Example:
WDWheelUnfix(5)

This deactivates the option "Fix" in the Item Properties of the Wheel  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDWheelValue

WDWheelValue(ID,Value)

Example:
WDWheelValue(7,33)

Sets the Wheel  7 to value 33 immediately.

WDWindowCssStyleDisable

WDWindowCssStyleDisable(WindowName,StyleID)

Example:
WDWindowCssStyleDisable("Window5",2)

Disables the CSS Style  with ID 2 in the Item Properties of the Window  with the name
"Window5".

WDWindowCssStyleEnable

WDWindowCssStyleEnable(WindowName,StyleID)

Example:
WDWindowCssStyleEnable("Window5",2)

Enables the CSS Style  with ID 2 in the Item Properties of the Window  with the name
"Window5".

WDWindowLocation

WDWindowLocation(X,Y)

Example:
WDWindowLocation(500,300)

Locates the Widget Designer window (upper left corner) 500px from the left, and 300px from the top of
the screen.

Note: This command does not work in full-screen mode.

WDWindowSize

WDWindowSize(W,H)

988

988

926 913
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Example:
WDWindowSize(1000,600)

Sets the width of the Widget Designer window to 1000px and the height to 600px.

Note: This command does not work in full-screen mode.

WDWindowStateMaximized

WDWindowStateMaximized

Example:
WDWindowStateMaximized

Maximizes the Widget Designer Window.

WDWindowStateMinimized

WDWindowStateMinimized

Example:
WDWindowStateMinimized

Minimizes the Widget Designer Window.

WDWindowStateNormal

WDWindowStateNormal

Example:
WDWindowStateNormal

Restores the last size of the Widget Designer window in windowed mode.

WDXyPanelCssStyleDisable

WDXyPanelCssStyleDisable(ID,StyleID)

Example:
WDXyPanelCssStyleDisable(5,2)

Disables the CSS Style  with ID 2 in the Item Properties of the XY Panel  with ID 5.

WDXyPanelCssStyleEdit

WDXyPanelCssStyleEdit(ID,StyleID,ParamName,Value)

Example:
WDXyPanelCssStyleEdit(5,2,"StartOpacity",50)

Edits the CSS Style  with ID 2 in the Item Properties of the XY Panel  with ID 5. The parameter
"StartOpacity", e.g. from the Style "2D\FadeIn", is set to a value of 150.

926 1012

926 1012
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WDXyPanelCssStyleEnable

WDXyPanelCssStyleEnable(ID,StyleID)

Example:
WDXyPanelCssStyleEnable(5,2)

Enables the CSS Style  with ID 2 in the Item Properties of the XY Panel  with ID 5.

WDXyPanelFix

WDXyPanelFix(ID)

Example:
WDXyPanelFix(5)

This activates the option "Fix" in the Item Properties of the XY Panel  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WDXyPanelLocation

WDXyPanelLocation(ID,X,Y)

Example:
WDXyPanelLocation(5,100,200)

Sets the position of the XY Panel  with ID 5 to 100px horizontally and 200px vertically. 0,0 is the
top left corner of the Page.

WDXyPanelLocationLeft

WDXyPanelLocationLeft(ID,X)

Example:
WDXyPanelLocationLeft(5,100)

Sets the position of the XY Panel  with ID 5 to 100px horizontally but remains the current vertical
position. 0,0 is the top left corner of the Page.

WDXyPanelLocationTop

WDXyPanelLocationTop(ID,Y)

Example:
WDXyPanelLocationTop(5,200)

Sets the position of the XY Panel  with ID 5 to 200px vertically but remains the current horizontal
position. 0,0 is the top left corner of the Page.

WDXYPanelResetAngleRelative

926 1012
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WDXYPanelResetAngleRelative(PanelID)

Example:
WDXYPanelResetAngleRelative(1)

Resets the value for the internal Relative X Position inside XY Panel with the ID 1 back to its default
value.

WDXYPanelResetDefault

WDXYPanelResetDefault(PanelID)

Example:
WDXYPanelResetDefault(1)

Resets all current values inside XY Panel with the ID 1 back to the default values entered in its Item
Properties.

WDXYPanelResetDistanceRelative

WDXYPanelResetDistanceRelative(PanelID)

Example:
WDXYPanelResetDistanceRelative(1)

Resets the value for the internal Relative Distance inside XY Panel with the ID 1 back to its default
value.

WDXYPanelResetXPosRelative

WDXYPanelResetXPosRelative(PanelID)

Example:
WDXYPanelResetXPosRelative(1)

Resets the value for the internal Relative X Position inside XY Panel with the ID 1 back to its default
value.

WDXYPanelResetYPosRelative

WDXYPanelResetYPosRelative(PanelID)

Example:
WDXYPanelResetYPosRelative(1)

Resets the value for the internal Relative Y Position inside XY Panel with the ID 1 back to its default
value.

WDXYPanelSetAngleRelative

WDXYPanelSetAngleRelative(PanelID,Value)
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Example:
WDXYPanelSetAngleRelative(1,18000)

Sets the value for the internal Relative Angle inside XY Panel with the ID 1 to 18000.

WDXYPanelSetDistanceRelative

WDXYPanelSetDistanceRelative(PanelID,Value)

Example:
WDXYPanelSetDistanceRelative(1,18000)

Sets the value for the internal Relative Distance inside XY Panel with the ID 1 to 18000.

WDXYPanelSetXDefault

WDXYPanelSetXDefault(PanelID,Value)

Example:
WDXYPanelSetXDefault(1,32000)

Sets the value for the default of Mouse X inside XY Panel with the ID 1 to 32000.

WDXYPanelSetXPosRelative

WDXYPanelSetXPosRelative(PanelID,Value)

Example:
WDXYPanelSetXPosRelative(1,22000)

Sets the value for the internal Relative X Position inside XY Panel with the ID 1 to 22000.

WDXYPanelSetYDefault

WDXYPanelSetYDefault(PanelID,Value)

Example:
WDXYPanelSetYDefault(1,34000)

Sets the value for the default of Mouse Y inside XY Panel with the ID 1 to 34000.

WDXYPanelSetYPosRelative

WDXYPanelSetYPosRelative(PanelID,Value)

Example:
WDXYPanelSetYPosRelative(1,22000)

Sets the value for the internal Relative Y Position inside XY Panel with the ID 1 to 22000.

WDXyPanelSize
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WDXyPanelSize(ID,Width,Height)

Example:
WDXyPanelSize(5,100,40)

Sets the size of the XY Panel  with ID 5 to a width of 100px and a height of 40px.

WDXyPanelSizeHeight

WDXyPanelSizeHeight(ID,Height)

Example:
WDXyPanelSizeHeight(5,40)

Sets the size of the XY Panel  with ID 5 to a height of 40px but remains the current width.

WDXyPanelSizeWidth

WDXyPanelSizeWidth(ID,Width)

Example:
WDXyPanelSizeWidth(5,100)

Sets the size of the XY Panel  with ID 5 to a width of 100px but remains the current height.

WDXyPanelUnfix

WDXyPanelUnfix(ID)

Example:
WDXyPanelUnfix(5)

This deactivates the option "Fix" in the Item Properties of the XY Panel  with ID 5. "Fix" influences
whether the Widget is only visible on the Page it was created on, or on all Pages.

WindowedModeByID

WindowedModeByID(SiteID)

Example:
WindowedModeByID(4)

Switches the site 4 to windowed mode in Pandoras Box project whether it is in fullscreen mode or in
windowed mode already.

WindowFocus

WindowFocus(WindowTitleText)

Example:
WindowFocus("test.png - Paint")

1012

1012

1012

1012



1624

Activates the application with the Window Title Text “test.png – Paint” and sets it into the focus. This
command could be very useful if you e.g. want to send a Keystroke to an application window that is
not focused right now (via the command KeyboardKeyPress(Keycode) ).

WindowsDisableTaskManager

WindowsDisableTaskManager

Example:
WindowsDisableTaskManager

This blocks the Windows Task Manager from opening.

WindowsEnableTaskManager

WindowsEnableTaskManager

Example:
WindowsEnableTaskManager

This enables the Windows Task Manager it was blocked before from opening.

WriteEnvironmentVariablesToLog

WriteEnvironmentVariablesToLog

Example:
WriteEnvironmentVariablesToLog

Writes the current Windows environment variables into the Widget Designer’s logfile “wd_gui_log.txt”,
to ease remote debugging for example.

The log file can be found in the installation path, e.g. C:\Program Files\Christie\Widget Designer 6.0
Rev 4498\logs

More information can be found under:
https://en.wikipedia.org/wiki/Environment_variable 
http://www.7tutorials.com/simple-questions-what-are-environment-variables

X X

Y Y

Z Z

1344
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18.8.1.3  Programming Statements

If else
Switch Case
For Loop

Other advanced script techniques include:
Variables
Object and Member Notation  
Math Expressions
Functions and Macros

For all statements it is strongly recommended to add new lines and also tabs for a clear and easy to
read arrangement. Code blocks can be in/outdented using [TAB] or [SHIFT + TAB]. 

If you like to comment a line out without getting errors in the Debug Logger , use this syntax:

// one line that should not be processed

/* several lines

that should not 

be processed */

Keep in mind, that you can test selected lines  with the according command from the right-click menu
available in all scripting fields.

18.8.1.3.1  If ElseIf Else

As in other programming languages, the if-then-else statement in Widget Designer can be used to
program conditional actions. This means, that you may program to perform a certain action if a condition
is "true" and another action if it isn't. The result whether something is "true" is based on a comparison of
different values, e.g. "is value A bigger than value B?".

- A value can be a number (double, integer) or text (string); it can be a static value e.g. "10" or it can be
a variable  (holding "10").

- The comparison "bigger than" would be expressed with a logical operator ">". Four operators are
supported to evaluate whether two values are equal or unequal and in case of a numeric values, if one is
bigger or smaller than the other one.

- A entire condition can not only consist of one comparison of two values. It can be extended with a
second comparison (of two other values) using the logical "AND" or "OR", e.g. "is value A bigger than
value B and at the same time C smaller than D?"

- If a condition is true, the True Script is executed. It starts and ends with curly brackets {} and contains
an unlimited number of commands including functions and macros .

- You may decide what happens if the condition is not true. If nothing should take place, the statement
simply ends with the curly bracket behind the True Script. If something else should happen, it needs to
be announced with the word "Else" followed by the {False Script}

- You can also add several possibilities with the "Elseif" statement, followed by the {Else True Script}

   If you have several "Elseif" statements, the switch case  might be a better option.

Even encapsulated structures can be used, containing further if-else-statements, for-loops  or switch
cases .

Please note that you can also use mathematical expressions  as if values.
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Basic syntax: If A = B

If value A Operator value B {
True Script

}

Elseif value A Operator value B {
True Script

}

Else {
False Script

}

It does not matter whether the curly brackets are in the same or next line, you could even write:

If value A Operator value B {True Script}

Else {False Script}

But it is strongly recommended to add new lines and also tabs for a clear and easy to read arrangement.
Code blocks can be in/out-dented using [TAB] or [SHIFT + TAB]. 

If you like to comment a line out without getting errors in the Debug Logger , use this syntax:
// one line that should not be processed
/* several lines

that should not 

be processed */

Script Example
This example changes the value of Fader1. The first position is at 128. The second position depends on
the variable  Var1. If Var1 equals 100, the fader goes down after waiting 2 seconds. If the variable is
not 100, the fader goes up after 2 seconds. No matter what the second position was, the third position at
64 is set after waiting one second.

WDFaderValue(1,128)

if Var1 = 100 {

WDWait(2)

WDFaderDown(1,1)

}

 

Else {

WDWait(2)

WDFaderUp(1,1)

}

WDWait(1)

WDFaderValue(1,64)

The available operators

"=" equals

">" greater than

"<" lower than

"!=" not equal

">=" greater than or equals

923
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"<=" lower than or equals

It is not necessary to put white spaces between values and operators, but advisable for better readability.

If you are simply requesting a Boolean value as if-statement, e.g. "if var_bool = true {...}",

you can shorten this to "if var_bool {...}". Using a statement without operator automatically

checks if the statement is true.

Syntax for advanced conditions: If A = B AND / OR C = D 

Logical AND & OR are also possible in order to combine two sets of conditions:

If value A Operator value B AND value C Operator value D {
True Script

}
Else {

False Script
}

Alternatively the syntax could look as following:

If value A Operator value B OR value C Operator value D {

True Script

 }

Script Example
This example changes the value of Fader1. The first position is at 128. The second position depends on
the variables Var1 and Var2. Only if Var1 equals the word "Hello" and at the same time, Var2 equals the
word "World", the fader goes down after waiting 2 seconds. If the variable is not 100, the fader goes up
after 2 seconds. No matter what the second position was, the third position at 64 is set after waiting one
second.

WDFaderValue,1,128

if Var1 = Hello AND Var2 = World {

WDWait(2)

WDFaderDown(1,1)

}

 

Else {

WDWait(2)

WDFaderUp(1,1)

}

WDWait(1)

WDFaderValue(1,64)

18.8.1.3.2  Switch

The switch statement (also known as multi way branches) can be used to program nested if statements
more easily and with a better overview. Please refer to the previous chapter if-then-else statements . 

Basically, the statement starts with looking at a specific variable , the so-called "Input Value". It
needs to be declared beforehand. The following Cases (i.e command blocks) contain an individual value,

1625
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the "Case Value". Each Case is evaluated, that is, it is compared whether the Input Value equals Case
Value. If this condition is "true", the Case Script is executed.

The first Case could be "If the above variable equals value A then execute script A". All following Cases
would be "If it equals my value then execute my script". The entire select-case statement searches for
the Cases whose value equals the Input Value (the above variable) and executes the according scripts.

- A Case Value can be a variable itself.

- A Case Script starts and ends with curly brackets {} and contains an unlimited number of commands
including functions and macros .

- The number of Cases is unlimited.

- If there is no True Case (command block containing an equal value), an optional default script can be
defined. This block starts with "CaseElse".

Even encapsulated structures can be used, containing further switch cases, for-loops  or if-else-
statements .

Please note that you can also use mathematical expressions  as Input or Case Values.

Basic syntax

Switch YourVariable {

  

 Case VariableValue1

Value1 Script

  

 Case VariableValue2

Value2 Script

  

 Case VariableValueN

ValueN Script

  

 Case Else

Default Script

 }

 

It does not matter whether the curly brackets are in the same or next line, but it is strongly
recommended to add new lines and also tabs for a clear and easy to read arrangement.
Code blocks can be in/out-dented using [TAB] or [SHIFT + TAB]. 

If you like to comment a line out without getting errors in the Debug Logger , use this syntax:
// one line that should not be processed
/* several lines

that should not 

be processed */

Script Example

This example is based on the string variable "VarName". It holds the forename of a customer who has
logged in before. The idea is, that a Label displays a text with the country, the customer comes from and
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in addition the Widget Designer calls a page containing regional information and control elements.
Three Cases are programmed, one for "Daniel", one for "Rene" and one for "Rajesh".
Afterwards, a "Case Else"  is defined as it is possible that unknown persons log in. In that case, he is
routed to a Home Screen and the Label displays "Please register".

Switch VarName {

 

Case Daniel

Label1.Text = "from Finland"

WDPageGoto("Europe")

 

Case Rene

Label1.Text = "from France"

WDPageGoto("Europe")

 

Case Rajesh

Label1.Text = "from India"

WDPageGoto("Asia")

 

CaseElse

Label1.Text = "Please register..."

WDPageGoto("Home")

}

Alternatively, the CaseElse block can be eliminated from the statement if it is not needed. Or, the Page
"Home" is called at the very beginning of the entire script, even before the main variable is selected.
Different solutions are possible and depend on your project.

18.8.1.3.3  For Loop

If you want to repeat a certain script segment several times or based on a time that can change through
a variable, then For Loop scripts are ideal to solve such a task efficiently.
Here is a quick example of how this will look like in a WD script:

Basic syntax

For i = Value1 to Value2 Step Value{

Script

}

It does not matter whether the curly brackets are in the same or next line, but it is strongly
recommended to add new lines and also tabs for a clear and easy to read arrangement.
Code blocks can be in/out-dented using [TAB] or [SHIFT + TAB]. 

If you like to comment a line out without getting errors in the Debug Logger , use this syntax:
// one line that should not be processed
/* several lines

that should not 

be processed */

923
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Script Example

For i = 1 to 10 {

 

WDFaderUp(1,2)

WDWait(2)

WDFaderDown(1,2)

}

This script will execute 10 times the code between the curly brackets.
A special local variable is defined and iterated by the step count for every further loop. In this case, "i" is
set to "1" and will be increased by one (if you leave the optional step count, 1 is the default value) in
each loop until it reaches "10". Hence you can also write:

For i = 1 to 10 Step 1{

 

WDFaderUp(1,2)

WDWait(2)

WDFaderDown(1,2)

}

 

You can make use of your iteration variable by putting it e.g. at your commands. The following script
fades the faders with ID 2,4,6,8 and 10 each up and down within four seconds.

For i = 1 to 10 Step 2{

 

WDFaderUp(i+1,2)

WDWait(2)

WDFaderDown(i+1,2)

}

You can use any valid name for the iteration variable, it doesn't necessarily have to be "i".
If you want to run nested For Loops, you would have to use a different iteration variable for each loop.

Please do not use already defined variables as iteration variable, too.

18.8.1.4  Mathematical Expressions

When working with variables , you sometimes need to assign its value directly, but other times you
might also want to recalculate your variable and use it for other mathematical calculations. You can
achieve this with special commands, or with a very easy to understand mathematical syntax.

Obviously, the variable must be of the type integer or double to allow mathematical operations. Integers
are rounded to the according whole number. However there is one exception to this rule. Adding letters is
actually possible and equals appending letters.
Array variables are supported too. You call an index with square brackets: Variable[Index].

1638
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First, the below examples for a relative value assignment work in direct and in common commands. They
offer five basic arithmetical operations: addition, subtraction, multiplication, division and exponentiation.
The value itself can be a number you choose, another Variable, or a Member Value.

direct command Result varRes corresponding common command

Var VarName = Value
(creates a LOCAL variable)
Var varRes = 123

Variable += Value
varRes += 3
Variable = Variable + Value
varRes = varRes +3

Variable -= Value
varRes -= 1
(or: varRes += -1)
Variable = Variable - Value
varRes = varRes -1

Variable *= Value
varRes *= 2
Variable = Variable * Value
varRes = varRes *2

Variable /= Value
varRes /= 5
Variable = Variable / Value
varRes = varRes /5

Variable = Variable ^ Value
varRes = varRes ^4

Variable = Variable ^ 0.5
varRes = varRes ^0.5
varRes = varRes ^(2/2)

123

126

125

250

50

6.250.000

11.0905...

VCreate(VarName,Value)
(creates a GLOBAL variable)
VCreate("varRes",123)

VAdd(VarName,Var1,Var2)
VAdd("varRes",varRes,3)

VSubtract(VarName,Var1,Var2)
VSubtract("varRes",varRes,1)

VMultiply(VarName,Var1,Var2)
VMultiply("varRes",varRes,2)

VDivide(VarName,Var1,Var2)
VDivide("varRes",varRes,5)

VPow(VarName,Var1,Var2)
VPow("varRes",varRes,4)

VSqrt(VarName,Var1)
VSqrt("varRes",varRes)

Var VarName = Value
(creates a LOCAL variable)
Var varRes = "he"

Variable += Value
varRes += "llo"

he

hello

VCreate(VarName,Value)
(creates a GLOBAL variable)
VCreate("varText","he")

VAdd(VarName,Var1,Var2)
VAdd("varText",varText,"llo")

For more complex operations, you can use mathematical syntax as you would write it, see some
examples below, for var1 = 5 and var2 = 11.
Remember to assign a suiting type to the variable for the result, e.g. Integer.
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Syntax Result

varRes = calculation
varRes = var1 + var2
 
varRes = var1 - 10
 
varRes = var1 * var2 * 2
 
varRes = 45 / var1
 
varRes = var1 ^4

16

5

110

9

625

For more sopisticated mathematical functions, like sinus, logarithms or modulo, please also refer to the
chapter Math Object . This object provides several members for further mathematical operations.

Conditions

If you use those conditions outside of an if-statement, it will return a Boolean value.
Normal condition statements like "is bigger as?" or "equals?" can be combined with AND or OR
statements. Please note that those two expressions are not case sensitive.

1660
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Description and Syntax Result

Checks if value 1 is bigger than value 2
varRes = (3 > 4)

 
 
Checks if value 1 is bigger than or equals value 2
varRes = (3 >= 3)

 
 
Checks if value 1 is smaller than value 2
varRes = (3 < 4)

 
 
Checks if value 1 is smaller than or equals value 2
varRes = (4 <= 4)

 
 
Checks if value 1 equals value 2
varRes = (3 = 4)

 
 
Checks if value one does not equal value 2
varRes = (3 != 4)

False
 
 
 
True
 
 
 
True
 
 
 
True
 
 
 
False
 
 
 
True

Checks if all conditions have the SAME state
varRes = ((3 < 4) AND (3*5 = 15))
varRes = ((3 < 4) AND (3*5 = 7))
varRes = ((3 > 4) AND (3*5 = 7))

 
 
Checks if all conditions have DIFFERENT states
varRes = ((3 < 4) OR (3*5 = 15))
varRes = ((3 < 4) OR (3*5 = 7))
varRes = ((3 > 4) OR (3*5 = 7))

True
False
True
 
 
 
False
True
False
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18.8.1.5  Scripting Cheat Sheet V6
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18.8.2  Functions and Macros

The Function and Macro Editor lets you store a series of commands as a script. It can include variable
parameters that can be changed easily and any time when calling the script to be executed. In other
words, a script is a sub routine, with or without input variables, that allows dynamic programming. The
difference between functions and macros is explained below.

Using scripts in form of functions or macros is helpful when the same series of commands should be
called from different places especially when the same command structure should be executed but its
effect should be adjusted flexibly. Those scripts save time entering and editing commands.

Setting up a Function or Macro

To open the editor go to "Scripting" and "Scripts (Functions & Macros)". An exemplary function is
depicted below. Enter a function or macro name with arguments (the colored placeholders) if needed,
and then the scripting text itself referring to these arguments.
Click "Apply" to save the script or changes you made in it.

If you have many macros and functions in your project, it might come in handy to have them sorted in
folders. The "Path" field enables you enter a path that creates folders within the Scripting menu and files
your script there. In the example below, the function can be found in the folder "functions" in the sub
folder "faders".

In the scripting field you may enter commands to be executed, just type in the command directly in the
text field. The topic Script Language  explains this in more detail.
See here a list of all commands .
You can also use other functions and macros, Variables  and other programming statements  e.g.
an If-clause . It is not recommended to call the same function or macro recursively as you might
create a deadlock!

A function must end with a return statement, a line that says "return" and "something". You can return
all kind of values, e.g. variables, strings or Boolean values. This value can be used from outside the
function for further usage or maybe simply as a "function completed" message. Macros do not have
return expressions.

If you decide you would rather use a macro than a function, you can change the type anytime with the
drop-down below the scripting section.
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Testing a Function or Macro

To test a script, you can right-click in the script field and press "Test". A new window will open where
you can enter values to substitute your optional arguments. When you use this way of testing, you don't
have a display for your function return value. You could for example enter a "DebugMessage" command
right before your return statement to check if your return value was computed correctly. 

Calling a Function or Macro - the Difference

You can call a macro within scripts, functions or other macros by its name and values for your
arguments in round brackets, like any normal Widget Designer command.

e.g.: FaderMacro(1,5)
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Macros are normally called in blocking mode. This means that it is not possible to run several macros in
parallel within one script, they will always be executed one after another, i.e. after the previous macro
has finished.
If you want to execute macros asynchronously (i.e. simultaneously), use the command "WDMacro" to
call your macro:

WDMacro("FaderJump")

WDMacro("FaderJump")

WDMacro("FaderJump")

This will execute the macro "FaderJump" three times at once. Please note that only macros without
additional input arguments can be called asynchronously!

Functions are called the same way, but due to their return value, they need an additional object
receiving this value:

e.g.: Label1.Text = FaderFunction(1,5)

The fading script is being executed and the text of Label1 is set to "Done"

Functions always run in blocking mode. This means that it is not possible to run several functions in
parallel within one script, they will always be executed after the previous function has finished. If you
need to run functions parallel, you would have to call them from separate places, e.g. two different button
scripts.

Additional Example for a Function

This example shows how a function can be used to compare two numbers and return the higher number
so that it can be used for displaying it in a label and fading an according fader.

Function name max(num1,num2)

Function script If num1 > num2 {
var result = num1
}
Else {
var result = num2
}

return result

Calling script Label6.Text = max(5,3)
WDFaderUp(max(5,3),2)
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18.8.3  Variables

What is a variable?

Variables are a powerful feature in Widget Designer. Any value can be stored within a variable and be
called from another widget or node or command. Variables can hold one (or more) variable value(s) that
update automatically, or they can hold one (or more) constant value(s).

Variables are subdivided into these types: String, Double, Integer, Boolean, Date, List, Color and JSON.

String Ex. 1: 'hello'

= ASCII text in 'single' or "double" quotation marks

(do not use accents like ` or ´)
Ex. 2: 'C:\folder1\subfolder2'

If you want to use quotation marks as part of your
string, use
the other kind for declaring the string.

Ex. 3:  'Hello, "World"!'

Double Ex. 1: -5.567

= number with decimal places Ex. 2: 12.123456789

(a floating-point number) Ex. 3: 99999.9

Integer Ex. 1: -50

= number without decimal places Ex. 2: 0

Ex. 3: 51347

Boolean Ex. 1: True

= Boolean value "True" or "False"
(the letters are case insensitive)

Ex. 2: False

Date Ex. 1: 11/30/2016 09:30:38

= a special data type containing time and date
information

List
Ex. 1: ["Sample", "John", 31, false]

(two strings, an integer, a Boolean)

= formerly known as arrays; holds several objects
of the same or different data type even other
variables and other lists can be part of a list

Ex. 2: [3, "abc", v_double, ["i", "j", "k"]]

Color Ex. 1 #808080 (dark gray)

= an object containing 8bit information (value
ranges from 0 to 255) about the red, green, blue
and alpha channel of a color

Ex. 2: #8000FF (intense violet)

The RGB value in the variable list is displayed as
hexadecimal code, this page might come in useful
when translating colors to and from hex code:

https://www.w3schools.com/colors/
colors_hexadecimal.asp 

Ex. 3: #FFFFFF (white)

JSON Ex. 1 {"name": "Tom", "age": 29}

= a format for easily storing, editing and
exchanging sets of data.

Ex. 2 {"string":"Hello!", "bool": true, "pi": 3.14}

For more information concerning syntax and
usage, please refer to the chapter Using JSON

{"arr": [12,34,56], "map": {"a":1.2, "b":
2.3, "c": 3.4}}

Variables can be defined either globally or locally:
Global variables can be called and edited within the complete project, they are saved in the Variable List.
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Local variables are initialized inside a script and will be deleted as soon as this script is finished, their
values are also only accessible from inside this single script.

How to create a global variable?

Widget Designer includes a (below depicted) tool called "Variable List". Go to the Scripting menu and
choose "Variables" to open it. The list shows all existing global variables, their type and value.
The free version does not include the Variable List though it supports variables.

If you open the Variable List the first time, you will see that there are already some variables. These
system variables are called internal variables and are created per default, update automatically and can
not be deleted nor edited. The system Variable "Now" for example returns time and date at the moment
it is accessed and can be useful for debug messages, protocols or timed events.

The additional variables starting with "var_" were declared by the user as follows:

First of all, a variable needs
to be declared. You may
use the right-click menu
within the Variable List or
the command VCreate to

do so. Commands are also
interesting in the further
workflow e.g. calling and
editing a variable,
particularly a list variable.
When you create the
variable, decide what type,
name and (starting) value it
should have. 

Please note that the name may consist of letters (lowercase or capital) and numbers, as well as
underscore "_", the first character must be a letter. A valid variable name would be e.g. "Var_String123".

For most variable types you simply pick the value you like to assign and click "Ok". With the Locked
option the variable stays constant, you cannot edit the value until it is unlocked.
A new Boolean variable is initiated with the value "False". Tick the check box "True / Active / Yes" to
turn it to "True".
For a list variable enter the elements and separate them with the symbol you choose from the drop-
down, e.g. "1,2,3". The square brackets you see later, are added automatically. Building nested lists is
only possible from within scripts, adding a list in a list is not possible by directly editing a global variable.
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Every Variable type has its own group of available members. To learn more about object members,
please refer to the chapter Object and Member Notation .

A complete list of all members related to special types can be found in the chapter Data Type Specific
Member .

How to assign another value to a global variable?

After having declared a variable it can adopt a different value at any time. Obviously the new value must
be of the same type. For assigning a new value, there are three ways: use the right-click menu in the
Variable List, a node or commands.

The Variable Output Node can be found under Nodes > Output > Generic and can be linked to a filter or
input node in order to use their value as the new variable value. The Nodes chapter  explains the
usage of nodes. The output node updates the variable constantly with a new value. An example is
depicted below.

There are very fast commands like Variable = Value to assign a new (member) value. This is also

called a direct command, in difference to common commands, they are more direct, fast and flexible.
Please see the below table for possibilities to assign new values to variables. Commands are listed in
the command list , and more information about the way to write commands is described in the
chapter "Script Language" .

direct command corresponding common command

Variable = Value
varNumber = 123
varString = "Hello"
ListVariable[Index] = Value
varList[5] = 123

Variable = Variable
varNumber1 = varNumber2
varString1 = varString2
varList[5] = varNumber
varList[varNumber] = 5

Variable = MemberID.MemberValue
varNumber = fader2.value
varString = label1.text
varList[varNumber] = fader2.value
varList[fader2.value] = varNumber
varList[label1.text] = varNumber
(if label holds numeric value!)

VValue,VarName,Value
VValue("varNumber",123)
VValue("varString","Hello")
VSetArrayValue,VarName,Index,Value
VSetArrayValue("varList",5,123)

VValue,VarName,Variable
VValue("varNumber",varNumber2)
VValue("varString",varString2)
VSetArrayValue("varList",5,varNumber)
VSetArrayValue("varList",varNumber,5)

VValue,VarName,MemberID.MemberValue
VValue("varNumber",fader2.value)
VValue("varString",label1.text)
VSetArrayValue("varList",varNumber,fader
2.value)
VSetArrayValue("varList",fader2.value,va
rNumber)
VSetArrayValue("varList",label1.text,var
Number)

As you see above you can assign values in many ways. In most cases, you can only assign a correct
variable type, e.g. a string to a string variable. If you like to assign another type, you need to convert it
first, e.g. like this varInteger = varBoolean.ToInteger The chapter Object and Member

Notation (dot syntax)  explains this syntax in more detail and gives more examples.

In case you work with list variables, you might wonder how to write or read them if they get more
complex. As an example the variable varList holds different value types, first the integer 3, then the string
"abc" and a (so called nested) list with the strings "i" and "j". So the list should look like this: [3,"abc",
["i","j"]]

VCreate("varList",[3,"abc",["i","j"]])
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Elements of the list can be accessed via an index in square brackets. 
varList[0] -> returns 3
varList[1] -> returns "abc"
varList[2] -> returns ["i", "j"]
varList[2][1] -> returns "j"

There are also commands like Variable += 1, that adds 1 to the current value of the variable.

Variable = (1+2*3) even does a complex mathematical calculation for you. More of these

advanced variable assignments can be found in the chapter Math Expression .

There are many ways to draw a value from another control like a Label, ListView element, Fader etc.:
Start typing the command "VGet" and you will see the full list of possibilities. Alternatives are described
in the topic Object and Member Notation (dot syntax) .

If you like to lock a variable, use the command VLock(Name). The variable can not be changed until it

is unlocked. In the Variable List there is a check box called Lock.
Fading a variable is possible with these commands VFadeTo(Variable,Value,Time and
VFade,Variable,StartValue,EndValue,Time).

How to use variables?

Once a variable is declared it can be used by its alias name. There are several ways to do so; one is
creating nodes.
The Variable Input node can be found under Nodes > Input > Generic and can be linked to a filter or
output node in order to use the variable's value there. The Variable Output node can be found under
Nodes > Output > Generic and can be linked to a filter or input node in order to use their value as the
new variable value. In the depicted example the Fader Input node writes the fader's value into a variable.
Then the Variable Input node writes the value into a label.

Some controls, e.g. a label, allows accessing a variable directly. In the example we could delete the
Variable Input Node (ID 1) and the Label Output Node (ID 3) and instead tick the check box "Variable
Source" in the label's Item Properties.

The last way is using a variable in commands. There are several commands that allow writing a value
into a variable, in the command list they start with VGet...  . As well you may use commands to
assign a specific value or result of a math operation to a variable.
To use a variable's value instead of an argument within a command simply use the variable name. For
example, TCPSend(1,var_String) will send "hello" via the TCP Connection if you have declared this

variable before.
The chapter Object and Member Notation (dot syntax)  gives more examples of commands with
variables.

How to create and use a local variable?

You can define a local variable inside of a script by using the indicator "var " (var and space) before a
variable name. The variable name must be new and valid, i.e. as for global variables, it may consist of
letters only (lowercase or capital) and numbers, as well as underscore "_" and the first character must
be a letter. A valid variable name would be e.g. "Var_String123".
A value can, but does not have to be assigned in the same step.
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The type of the local variable will be determined automatically by its first value as seen in the following
examples:

This will set Label1 to "example" and Label2 to "another example".
var x = "an example"
Label1.text = x
var y = "another example"
WDLabelText(2,y)

This will set the Fader1 to 50 and Fader2 to 150.
var z = 50
Fader1.Value = z
WDFaderValue(2,z+100)

For more examples of use and practical hints concerning everything around the Widget Designer's
scripting language, please also have a look at the Scripting Guide

What is the difference between a variable and a member value ?

Member values, e.g. "Fader.Value", could be explained as internal variables. Widget Designer declares
them automatically with each item you add to your project. Their name and value relate to the item they
belong to. Otherwise you can use member values and variables in the Script language in the same way.
See the next chapter Object and Member Notation (dot syntax)  for more details.

18.8.4  Object and Member Notation (dot syntax)

What are objects and members?

The term "object" in this context refers to windows , pages , widgets , nodes  and (global
and local) variables .

Each object has a unique name, e.g. CustomScript3, Node14 or var_String, by which it can be accessed
in scripts . You can change the automatically generated name of every object in the object's
properties dialog. Variable names can not be edited once they are declared, however, you can replace
them.

The term "properties" refers to specific values of those objects that can be requested or set. The term
"methods" describes actions that can be performed with this object.
Properties and Methods are so called "members" of the object. Each object, e.g. Fader, CustomScript,
string variable, etc. has its specific members. A list of all possible members of an object is visualized in
the Script Assistant  when placing a dot "." after an object name, this is why it is also called the "dot
syntax".

Example:
"Fader1.Value" returns the current value of Fader1 as a double value (Property)
"Fader1.FadeUp(2)" fades Fader1 to 100% within 2 seconds (Method)

The Script Assistant also gives information whether the member is a property or a method, and which 
data type  the property has (i.e. whether it is a string, Boolean, integer, ...), or which arguments the
method expects.

Every command in Widget Designer that handles a window, page, widget or node has an equivalent
method.
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There are two special objects besides the already mentioned, the are called "Project" and "Context".
Those provide ancillary members, for example for session related values. Please refer to the chapter 
"Project and Context Member"  for further information.

Data type specific members are explained in a separate sub chapter  in detail.  Each data type
(String, Integer, etc.) has own members that can be used for conversion, editing and information. The
data type specific members can be used for variables as well as for object properties. Simply type in
another dot after the variable's or object's name and the Script Assistant will list all available members.
Example: varString and Label1.Text are both strings. When writing "varString." or "Label1.Text." the
string members are displayed, including the member "contains". Hence you can ask whether varString or
Label1 contain a specific expression.
Please note that these methods only return values, they do not change the object they refer to
themselves.

How to use members?

Property members can be used exactly the same way as variables are being used. You can perform
mathematical actions  or use them for conditions . You can assign them to variables or other
object properties. You can even use further methods respective to the type.

Some examples:

var_Fader =
Fader3.Value + 10

This assigns the current value of Fader3 plus 10 to the double type
variable var_Fader.

Wheel1.Max = 314 This assigns a max value of 314 to the widget Wheel1.

if CustomScript5.Fix =
true {Label1.Text =
"Button fixed"}

Only in case the button CustomScript5 is fixed, Label 1 will say "Button
fixed".

Fader6.Value =
var_bool.ToInteger

This assigns either 0 or 1 to the widget Fader6, depending on the value
of the Boolean type variable var_bool. The additional method "ToInteger"
is necessary to convert the Boolean terms "True" and "False" into the
values "0" and "1".

var_int =
Fader6.Value.ToInteger

This assigns the value of Fader6 to the variable var_int, rounded to an
integer value.

Method members can be used like the normal WD-commands, if they require parameters, the Script
Assistant points them out. As the object is already defined by the object name in front of the method,
you do not have to enter an ID or name as a parameter. The parameters, too, can be substituted by
variables or other object properties, even functions  are possible if they return the correct value type.

Some examples:

Fader1.FadeToValu
e(5,var_Fader)

This fades Fader1 to the value of variable var_Fader within 5 seconds. This
method equals the command WDFadeToValue(1,5,var_Fader).

PictureBox1.SaveF
ile(TreeView1.Sel
ectedPath

This saves the content of PictureBox1 to the path that is currently selected in
the widget TreeView1.

CustomScript1.Cli
ck

This clicks CustomScript1, no parameter is needed to perform the action.

TextBox2.AddTextF
romLabel(14)

This adds Label14's text to TextBox2.

The next chapters include more information regarding object and member notation.
The chapter Project and Context Member  describes two special, superior objects, Project and
Context.
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The chapter Data Type Specific Members  explains how the members of each data type (String,
Integer, etc.) can be used for conversion, editing and information.
The chapter Using JSON  gives a quick overview of the JavaScript Object Notation, a format for easily
storing, editing and exchanging data. 

18.8.4.1  Project and Context Member

The previous topic describes members referring to objects like widgets or variables . Besides them,
there are two special, superior objects, Project and Context. They provide information and functionality
more abstracted than the normal objects.

Those two powerful tools enable you to program highly sophisticated and automated interfaces, they can
turn scripting more complex on one hand, but much more flexible and effective on the other hand.

Project member

The Project is the main parent element of the whole Widget Designer. Using this object permits you
access to all child objects like widgets, nodes and global variables.
The main purpose of using the Project object is automating actions that should be performed on many
child elements at once. This makes it for example easy to substitute a row of widget IDs with iterating
variables to access their members, or to write a script that searches for all widgets with a special type or
value.

Object Members Further
Members

Description Example

Project .WidgetType

.Variables.T
ype

The Script Assistant
offers you a list of all
available widget types,
nodes and variables
that exist in your
project.

If you want to access
variables, you also
have to specify the
data type.

Project.Fader

Project.CustomScript

Variables.String

Variables.List

.WidgetType
(ID or name)

.Variables.T
ype(name)

To access the
members of a specific
object, you have to
enter either the ID (for
widgets and nodes) or
the name of the object.

Project.Fader("Fader15")

Project.CustomScript(3)

Variables.String("var_str
ing")

Variables.List("var_list)

.WidgetMember

.NodeMember

Every object specific
member is accessible
from the Project object
too. All properties can
be read or set, all
methods can be
executed.

If you access a
property, you can even
use the data type
specific members on
them.

Project.Fader("Fader15").
Value = 128

Project.CustomScript(3).E
xecuteClick

Project.Label("Label22").
ForeColor.SetRGB(50,0,90)

Node15.ConnectTarget(12)
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.VariableDataTy
peMember

All variables accessed
by the Project object
have their respective
data type member.

Project.Variables.Integer
("var_int") = 10

Project.Variables.Boolean
("var_bool").ToInteger

Please note that every member returning a value, like string, double, Boolean or list, can have further
members respective to their data type. This is explained in the next chapter .

Context members

The object "Context" always refers to the context of the script wherein it is run.
For example, if you execute a script by clicking a CustomScript button, the context includes the page
and window where the widget is located. In addition, it holds the information with which client it was
executed. Imagine your project is displayed in your GUI and at the same time via the Web Server in an
external browser. It makes a difference whether you click the button in your GUI, or in the browser, they
have two different contexts. If you add faders to the project, each client can have different values for the
same fader, because the widget is used in different contexts.
If you are interested in the Web Server and the control of those client differing values, please have a look
at the topic Group Values .

However, as said above, the context does not only refer to multiple clients. It is also useful for
addressing windows, pages and widgets automatically. Try the following:
Create a project and set up one CustomScript button in Page1. Create another window with Page2 and
set up a label.
Open the property dialog of the button and type the following into the "On Click Script" section:
DebugMessage(Context.Name)

Click on the button to execute the script, the Debug Logger will show: Window1/Page1/CustomScript1/
ClickScript.
This is the whole context of the executed script, including all parent elements.
Repeat this with the label's On Click Script, and you will get this result: Window2/Page2/Label1/
ClickScript.

This should give you a good impression of what a script's context is, it always matters from where it is
executed.

Please be aware that scripts must be executed "for real", i.e. for example, a button must be clicked.
If you right-click in the script field and choose "Test" or "Test Selected Lines", there is no context!
Always execute the script the way it will be by the user afterwards.

Here is a list of all available Context members and what they are intended to do, it is recommended to
take some time and try them all out. The Debug Logger is a useful tool for this purpose:

Object Members Further Members Description

Context .Name

Returns the name of the widget, macro, etc.
from which the script is executed, including
the parent objects. E.g. Window1/Page1/
CustomScript1/ClickScript

.Stack

Returns a list of all objects (different
widgets or macros that call other objects/
macros/ functions) taking part at the chain
of executing scripts.

.Page .PageMember
Accesses all available page members for
the page the object is located on.

.WidgetID
Returns the ID of the widget whereof the
script is executed as an integer.
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.WidgetName
Returns the name of the widget whereof the
script is executed as a string.

.WidgetType
Returns the type of the widget whereof the
script is executed as a string.

.Script
Returns the type of script field from which it
is executed as a string. E.g. "ClickScript"
or "EnterScript"

.Client
(session key
- optional)

If no client key is inserted, the client value
of the actual context will be used.

If you enter a client key (the Script
Assistant will offer you all available keys),
the member will address this specific client,
even if it is not the actual context of the
script.

You will find a description of all expressions
concerning the usage of clients in the
chapter Group Values .

.Groups
.Group
Name

This member refers to Group Values , it
offers a list of available groups to request or
edit the respective key.

.Key
This member returns the session key of the
indicated client context.

.IP
This member returns the IP address of the
indicated client context. 

.ClientExists
(session key)

Returns a Boolean value (False or True) that
indicates if a client with the respective
session key is currently connected.

.ClientKeys
Returns a list containing all session keys of
currently connected clients.

.Session .Value(specifier)

Here you can set or retrieve your own
custom value, stored within the WD and
responding to the Key in the Session
cookie. Please note that you can only store
string values!

Example:

Context.Session.Value("EU") = "europe"  ->
stores a new value "EU" and sets it to
"europe"

DebugMessage(Context.Session.Value("EU
")) -> shows "europe" in the Debug Logger

Context.Session.Value("country") =
"Switzerland"  -> stores a new value
"country" and sets it to "Switzerland"

DebugMessage(Context.Session.Value("co
untry")) -> shows "Switzerland" in the
Debug Logger

Please refer to the topic Session and
Session Value  for further information.

.Contains
(search expression)

Returns a Boolean value (False or True) if
the indicated expression is stored in the
Session.
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As explained in the next chapter, each member that returns a value, can have additional members
referring to their data type .

18.8.4.2  Session and Session Value

The Session mentioned in the chapters Project and Context Member  as well as Group Values
enables you to distinguish between different instances accessing your Widget Designer project. While it
originally belongs to the section "Group Values", it is not only available in the Unlimited Webclients
version, you can even use it in the Free Version.

The Session Value here is a valuable tool for generating session- or user-based data sets.

What is a Session?

A Session is generated every time a new browser connects to the Widget Designer project. As the main
GUI is also displayed in an internal browser, this is always the first session. The Free Version offers only
one additional connection, the normal and Unlimited Version allows as many connected browsers as
physically possible. 

A new browser tab belongs to the same Session as the previous one, but if you open a second, different
browser, like Chrome and Internet Explorer or Mozilla Firefox and Opera, a second Session is created.
Each Session can be identified by its Key, a unique combination of letters and numbers. The Keys can
be accessed from the Web Server menu, just go to Edit > Web Server Settings and open the tab
"Sessions". There you will find a table containing all currently connected Session and the amount ob
Clients connected to this Session (note: two browser tabs of the same browser equal one Session and
two Clients)

When a new Session is generated, a temporary cookie is stored with the browser and enables the
Widget Designer to retrieve the stored information for several days, even if the browser was
disconnected.
As a part of this conjunction between WD and specific Clients, data can be saved corresponding to each
Session: the Session Value.

How can I use the Session Value?

A Session Value can be set with the Context object. It always consists of the specifier and a string
value, other data formats are not allowed. You are also not limited to only one set of data per Session.
The value can be initialized, changed and retrieved with the expression: 
Context.Session.Value(specifier)

Imagine a user log in for every person accessing the WD interface per remote. 
The user, let us call him "Jonathan" can enter his name with an InputBox  and submit this with a
CustomScript button next to it:

Context.Session.Value("Username") = InputBox1.Text

Now a new Session Value called "Username" with the value "Jonathan" was generated and is accessible
for this Session.

Now you want to use this information, e.g. log who accessed the interface and when. A ListView
might be an option here:

ListView1.SetCell(1,1,Context.Session.Value("Username"))

ListView1.SetCell(2,1,Now)

Of course you can have more sophisticated logic behind this application and check if the respective cell
is empty before writing something in it. If it is not, you would proceed to the next one or start from the
beginning if the list is already full.
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The true power of the Session Value comes into view when you combine this tool with JSON
expressions . You can create entire large sets of data for each Session, store this with the Session
Value and have complex, user input defined scripts and actions according to that.

Please bear in mind that a script containing the Context object, especially in combination with
the Session Value, has to be executed from a real script, e.g. a CustomScript click. The "Test"
function will not show the correct behavior!

18.8.4.3  Data Type Specific Members

Each data type in Widget Designer, String, Integer, Double, Boolean, Date, List, Color and JSON, has
its own, specific members. Those Members can be used for conversion, editing and information. Those
of the members returning a result can even be used with further members.

Please note that these methods only return values, they do not change the object they refer to
themselves. One exception here are some members of the color and JSON data types.
The data type of the return value is highlighted in the table below.

Example:

var x = "Hello World!"

var y = x.Contains("llo").ToInteger

DebugMessage(y)

The Debug Logger shows "1", as the Boolean value (true) returned by the Contains-member was
additionally converted to an integer value (1). The variable "x" keeps its value "Hello World!".

Even object properties can be used like this:
"var x = Fader1.Value.Round(2)" assigns the value of Fader1, rounded to two digits, to the local variable
"x".

.Contains(search
expression) 

Returns a Boolean value, indicating if
the search expression is included at the
object string 

Var x = "Hello World"

Label1.Text =
x.Contains("ello")

-> Label1 shows "True"

-> Label1 shows "matriarchal"

Member Description Example

Data type: String

 .Contains(search
expression) 

Returns a Boolean value, indicating if
the search expression is included at
the object string 

Var x = "Hello World"

Label1.Text =
x.Contains("ello")

-> Label1 shows "True"

 .EncodeBytes Returns a list containing the UTF-8
byte value of each character as integer

Var x = "Hello World"

Var y = x.EncodeBytes

-> y =
[72,101,108,108,111,32,87,111,114,10
8,100]

 .EndWith(search
expression) 

Returns a Boolean value, indicating if
the object string ends with the search

Var x = "Hello World"
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expression Label1.Text =
x.EndWith("orld")

-> Label1 shows "True"

.Format(string
representation, ...)

Uses the C# method "String.Format"
on the object string and returns the
formatted string. For further information
on String.Format, please visit https://
msdn.microsoft.com/de-de/library/
system.string.format(v=vs.110).aspx#F
ormat_Custom or http://timtrott.co.uk/
string-formatting-examples/

var x = "I like {0} and {1}."

Label1.Text =
x.Format("trains","turtles")

-> Label1 shows "I like trains and
turtles."

.IsMatch(search
expression)

Returns a Boolean value, indicating if
the search expression is included in
the object string. This method is
compatible to RegEx (regular
expressions). For further information on
RegEx, please visit: https://
msdn.microsoft.com/en-us/library/
az24scfc%28v=vs.110%29.aspx

Var x = "Hail the Banana King"

Label1.Text = x.IsMatch("(na)
{2,3}"))

-> searches if x contains the
expression "na" two or three times in a
row

-> Lable1 shows "True"

.Left(characters) Separates the object string at the
indicated number of characters
(starting at the beginning) and returns
all characters of the left split string as
a string value

Var x = "mathematical"

Label1.Text = x.Left(6)

-> Label1 shows "mathem"

.Length Returns an integer with the length of
the string object

Var x = "mathematical"

Label1.Text = x.Length

-> Label1 shows "12"

.Locked Returns a Boolean value, indicating if
the object is locked. Only useful for
global variables, as they are the only
lockable objects. Local variables are
always unlocked.

Label1.Text = LocalIP.Locked

-> Label1 shows "True"

.PadLeft(total
length, padding
character
(optional))

Pads the object string with white
spaces (or the optional padding
character) in front of the expression,
until the total length of characters is
achieved and returns the respective 
string

Var x = "BOX"

Label1.Text = x.PadLeft(7,"+")

-> Label1 shows "++++BOX"

.Padright(total
length, padding
character
(optional))

Pads the object string with white
spaces (or the optional padding
character) behind the expression, until
the total length of characters is
achieved and returns the respective 
string

Var x = "BOX"

Label1.Text =
x.PadRight(7,"+")

-> Label1 shows "BOX++++"

.Replace(search
string,
replacement)

Searches the object string for the
indicated string and replaces all found
strings with the secondly indicated
one, the result is also returned as 
string value

Var x = "mathematical"

Label1.Text =
x.Replace("hematic","riarch")

-> Label1 shows "matriarchal"

.Right(characters) Separates the object string at the
indicated number of characters
(starting at the end) and returns all

Var x = "mathematical"

Label1.Text = x.Right(6)

-> Label1 shows "atical"

https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom
https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom
https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom
https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom
http://timtrott.co.uk/string-formatting-examples/
http://timtrott.co.uk/string-formatting-examples/
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx
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characters of the right split string as a 
string value

.Split(separator) Splits the object string indicated by the
separator and returns a list of all sub
strings 

var x = "name|date|address"

var y = x.Split("|")

-> y = ["name","date","address"]

.StartsWith(searc
h expression)

Returns a Boolean value, indicating if
the object string starts with the search
expression

Var x = "Hello World"

Label1.Text =
x.EndWith("Hell")

-> Label1 shows "True"

.SubString(start,
length)

Returns a sub string of the object
string that starts at the indicated index
(first character has index 0) and has
the indicated length

Var x = "chemically"

Label1.text = x.SubString(3,5)

-> Label1 shows "mical"

.ToCamelCase Returns the object string formatted to
a CamelCase expression

Var x = "WD custom script
click"

Label1.Text = x.ToCamelCase

-> Label1 shows
"WDCustomScriptClick"

.ToColor Returns the object string formatted to
a color type object, the object string
has to be a six-digit hexadecimal value

Var x = "#ABC123"

Label1.text = x.ToColor.G

-> Label1 shows "193" (value of the
green component of this color)

.ToDate Returns the object string formatted to
a date type object

Var x = "2016-12-16
15:52:48.593"

Label1.text = x.ToDate.Day

-> Label1 shows "16"

.ToDouble Returns the value of the object string
in double format if the characters form
a real number

Var x = "3.14156"

Var y = x.ToDouble

-> y = 3.14156

.ToInteger Returns the value of the object string
in integer format if the characters form
a real whole number

Var x = "703"

Var y = x.ToInteger

-> y = 703

.ToJson Returns the value of the object string in 
JSON format if the syntax applies to the
respective rules for JSON objects

.ToSnakeCase Returns the object string formatted to
a Snake Case expression

Var x = "WD Custom Script
Click"

Label1.Text = x.ToSnakeCase

-> Label1 shows
"wd_custom_script_click"

.Trim Returns the object string without any
white spaces at the end or the
beginning

Var x = "   BOX   "

Label1.text = x.Trim

-> Label1 shows "BOX"

.TrimEnd Returns the object string without any
white spaces at the end

Var x = "   BOX   "

Label1.text = x.TrimEnd

-> Label1 shows "   BOX"
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.TrimStart Returns the object string without any
white spaces at the beginning

Var x = "   BOX   "

Label1.text = x.TrimStart

-> Label1 shows "BOX   "

.Type Returns the type of the respective
object as string

Var x = "hypnotized"

Label1.Text = x.Type

-> Label1 shows "String"

.Unescape Returns the object string with the
correct formatting concerning "\n" (new
line), "\r" (carriage return) and "\t" (tab).

Without unescaping these
expressions, they are handled as
simple characters.

Var x = "Hello World,\n\r\tHow
are you?"

Label1.Text = x.Unescape

-> Label1 shows:

"Hello World,

      How are you?"

Data type: Integer

.Locked Returns a Boolean value, indicating if
the object is locked. Only useful for
global variables, as they are the only
lockable objects. Local variables are
always unlocked.

Label1.Text = LocalIP.Locked

-> Label1 shows "True"

.ToString Returns the value of the object integer
as a string

Var x = 703

Var y = x.ToString

-> y = "703"

.Type Returns the type of the respective
object as a string

Var x = 703

Label1.Text = x.Type

-> Label1 shows "Integer"

Data type: Double

.Ceiling Returns the rounded up value (to a
whole number) of the object double as 
integer value

Var x = 3.14156

Var y = x.Ceiling

-> y = 4

.Floor Returns the rounded down value (to a
whole number) of the object double as 
integer value

Var x = 3.14156

Var y = x.Floor

-> y = 3

.Locked Returns a Boolean value, indicating if
the object is locked. Only useful for
global variables, as they are the only
lockable objects. Local variables are
always unlocked.

Label1.Text = LocalIP.Locked

-> Label1 shows "True"

.Round(digits) Returns the value of the double object,
rounded to the indicated number of
decimals.

Var x = 3.14156

Var y = x.Round(4)

-> y = 3.1416

.ToInteger Returns the value of the object double
as an integer (and rounds the value to
a whole number)

Var x = 3.14156

Var y = x.ToInteger

-> y = 3

.ToString Returns the value of the object double
as a string

Var x = 3.14156

Var y = x.ToString

-> y = "3.14156"
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.Type Returns the type of the respective
object as a string

Var x = 3.14156

Label1.Text = x.Type

-> Label1 shows "Double"

Data type:
Boolean

.Locked Returns a Boolean value, indicating if
the object is locked. Only useful for
global variables, as they are the only
lockable objects. Local variables are
always unlocked.

Label1.Text =
MasterConnectionStatus.Locked

-> Label1 shows "True"

.Not Returns the negated Boolean value of
the object Bool

Var x = True

Var y = x.Not

-> y = False

.ToInteger Returns an integer for the object value.
"False" is converted to "0", "True" to
"1"

Var x = True

Var y = x.ToInteger

-> y = 1

.ToString Returns the value of the object Bool as
a string

var x = True

Var y = x.ToString

-> y = "True"

.Type Returns the type of the respective
object as a string

Var x = True

Label1.Text = x.Type

-> Label1 shows "Boolean"

Data type: Date

.AddDays(days) Returns the object date plus the
indicated amount of days

.AddHours(hours) Returns the object date plus the
indicated amount of hours

.AddMilliseconds(
milliseconds)

Returns the object date plus the
indicated amount of milliseconds 

.AddMinutes(minu
tes)

Returns the object date plus the
indicated amount of minutes

.AddMonths(mont
hs)

Returns the object date plus the
indicated amount of months

.AddSeconds(sec
onds)

Returns the object date plus the
indicated amount of seconds

.AddYears(years) Returns the object date plus the
indicated amount of years

.Day Returns the object date's days as an 
integer

.DiffDays(date) Returns the amount of days of
difference between the object date and
the indicated date as integer

Var x = Now

Var y = x.AddYears(1)

Label1.Text = x.DiffDays(y)

-> Label1 shows "-365"

.DiffHours(date) Returns the amount of hours of
difference between the object date and
the indicated date as an integer

Var x = Now

Var y = x.AddDays(5)

Label1.Text = x.DiffHours(y)

-> Label1 shows "-120"
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.DiffMilliseconds(d
ate)

Returns the amount of milliseconds of
difference between the object date and
the indicated date as an integer

Var x = Now

Var y = x.AddSeconds(5)

Label1.Text =
x.DiffMilliseconds(y)

-> Label1 shows "-11000"

.DiffMinutes(date) Returns the amount of minutes of
difference between the object date and
the indicated date as an integer

Var x = Now

Var y = x.AddDays(5)

Label1.Text = x.DiffMinutes(y)

-> Label1 shows "-7200"

.DiffSeconds(date) Returns the amount of seconds of
difference between the object date and
the indicated date as an integer

Var x = Now

Var y = x.AddHours(3)

Label1.Text = x.DiffSeconds(y)

-> Label1 shows "-10800"

.Format(format
string)

Uses the C# method "String.Format"
on the object date and returns the
formatted string. For further information
on String.Format, please visit https://
msdn.microsoft.com/de-de/library/
system.string.format(v=vs.110).aspx#F
ormat_Custom  or http://timtrott.co.uk/
string-formatting-examples/ 

Var x = Now (e.g. 12/01/2016

11:45:23)

Label1.Text = x.Format("t")

-> Label1 shows "11:45"

.Hour Returns the object date's hours as an 
integer

.Locked Returns a Boolean value, indicating if
the object is locked. Only useful for
global variables, as they are the only
lockable objects. Local variables are
always unlocked.

Label1.Text = Now.Locked

-> Label1 shows "True"

.Millisecond Returns the object date's milliseconds
as an integer

.Minute Returns the object date's minutes as
an integer

.Month Returns the object date's months as
an integer

.Second Returns the object date's seconds as
an integer

.Type Returns the type of the respective
object as a string

Var x = Now

Label1.Text = x.Type

-> Label1 shows "Date"

.Year Returns the object date's years as an 
integer

Data type: List

.Avg Returns the average value of all list
items as double. 

Var x = [10, 20, 30]

Label1.Text = x.Avg

-> Label1 shows "20"

.Copy

.Count Returns an integer with the number of
elements of the list object

https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom 
https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom 
https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom 
https://msdn.microsoft.com/de-de/library/system.string.format(v=vs.110).aspx#Format_Custom 
http://timtrott.co.uk/string-formatting-examples/ 
http://timtrott.co.uk/string-formatting-examples/ 
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.DecodeBytes Returns a string decoded from the
UTF-8 byte values of each element of
the list object. The integers in the list
have to range from 0 to 255.

Please also refer to the string member
".EncodeBytes"

Var x =
[72,101,108,108,111,32,87,111,
114,108,100]

Label1.Text = x.DecodeBytes

-> Label1 shows "Hello World"

.Distinct

.IndexOf(search
expression)

Searches for the indicated search
expression and returns its index as an 
integer value. If the expression is
contained more than once, the index if
the first one is returned, if the
expression is not included at all, "-1" is
returned

var x = [a, "sdf", 130, 132]

Label1.Text = x.IndexOf(130)

-> Label1 shows "2"

.Join(separator) Concatenates all items of the list
object, separated by the specified
separator string, and returns this value
as a single string

Var x = [10, 20, 30]

Label1.Text = x.Join("/")

-> Label1 shows "10/20/30"

.Locked Returns a Boolean value, indicating if
the object is locked. Only useful for
global variables, as they are the only
lockable objects. Local variables are
always unlocked.

Label1.Text = LocalIP.Locked

-> Label1 shows "True"

.Max Searches the list object for the item
with the highest value and returns this
as an integer value. Only applicable
for lists containing solely integer values

Var x = [10, 20, 30]

Label1.Text = x.Max

-> Label1 shows "30"

.Min Searches the list object for the item
with the lowest value and returns this
as an integer value. Only applicable
for lists containing solely integer values

Var x = [10, 20, 30]

Label1.Text = x.Min

-> Label1 shows "10"

.Sort(Boolean
expression)

Sorts the list object according to
increasing (true) or decreasing (false)
values, where the Boolean expression
differs between the two methods and
returns the sorted list

Var x = [5, 203, 144, 42]

DebugMessage(x.Sort(false))

-> DebugLogger shows
"[203,144,42,5]"

.Type Returns the type of the respective
object as a string

Var x = [10, 20, 30]

Label1.Text = x.Type

-> Label1 shows "List"

.WhereRegex(sear
ch expression)

Returns a list of all items of the list
object where the search expression is
included. This method is compatible to
RegEx (regular expressions). For
further information on RegEx, please
visit: https://msdn.microsoft.com/en-
us/library/az24scfc%28v=vs.110%
29.aspx

Var x =
["banana","handkerchief","Anan
as","that's German for
'pineapple'"]

DebugMessage(x.WhereRegEx("(na
){2,3}"))

-> searches which elements of x
contain the expression "na" two or
three times in a row

-> DebugLogger shows
"["banana","Ananas"]"

https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx
https://msdn.microsoft.com/en-us/library/az24scfc%28v=vs.110%29.aspx
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Data type: Color

.A Returns the alpha value of the object
color as an integer (0-255)

Var x =
ColorPicker1.SelectedColor

Label1.Text = x.A

-> Label1 shows "255"

.B Returns the blue value of the object
color as an integer (0-255)

Var x =
ColorPicker1.SelectedColor

Label1.Text = x.B

-> Label1 shows "255"

.G Returns the green value of the object
color as an integer (0-255)

Var x =
ColorPicker1.SelectedColor

Label1.Text = x.G

-> Label1 shows "0"

.Locked Returns a Boolean value, indicating if
the object is locked. Only useful for
global variables, as they are the only
lockable objects. Local variables are
always unlocked.

Label1.Text = LocalIP.Locked

-> Label1 shows "True"

.R Returns the red value of the object
color as an integer (0-255)

Var x =
ColorPicker1.SelectedColor

Label1.Text = x.R

-> Label1 shows "128"

.SetRGB(red,gree
n,blue)

Sets the RGB values of the object color Var x =
ColorPicker1.SelectedColor 

(e.g. R=128 G=0 B=255)

x.SetRGB(100,200,30)

Label1.Text = x.B

-> Label1 shows "30"

.SetRGBA(red,gre
en,blue,alpha)

Sets the RGB values of the object color Var x =
ColorPicker1.SelectedColor 

(e.g. R=128 G=0 B=255)

x.SetRGB(100,200,30,0)

Label1.Text = x.A

-> Label1 shows "0"

.ToHex Returns the hexadecimal color value of
the object color as a string

Var x =
ColorPicker1.SelectedColor 

(e.g. R=128 G=0 B=255)

Label1.Text = x.ToHex

-> Label1 shows "#8000FF"

.Type Returns the type of the respective
object as a string

Var x =
ColorPicker1.SelectedColor

Label1.Text = x.Type

-> Label1 shows "Color"

One special data type is JSON, it enables you to store large sets of data and edit and retrieve this
information for other purposes. The "location" of a JSON element is the key (e.g. "arr"), or in case of
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nested maps the path expressed with a dot syntax (e.g."map.b"). If you are interested in the use of
JSON objects, please refer to the chapter Using JSON . 

Data type: JSON

.Add(array
location,value)

Adds a new item to an array at
the specified location and
returns the changed JSON array
(optional)

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text = x.Add("arr",
78).ToInteger

-> Label1 shows "[12,34,56,78]"

.Clear(map location) Removes all child items at the
specified location and returns
the JSON element containing
the changed item (optional)

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text = x.Clear("map")

-> Label1 shows "{"arr":[12,34,56],"map":{}}"

.Count(array or map
location)

Returns the number of child
items at the specified location
as an integer value. If the
location is not a map or an
array, an exception is thrown

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text = x.Count("map")

-> Label1 shows "3"

.Get(location) Returns the value at specified
location as a JSON expression

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text =
x.Get("map.b").ToString

-> Label1 shows "2.3"

.GetDate(location) Returns the value at the
specified location as a date
value. If the value cannot be
converted, a default value is
returned

var x = '{"start":"2016-02-
03"}'.ToJson

Label1.text =
x.GetDate("start").Month

-> Label1 shows "2"

.GetDouble(location) Returns the value at the
specified location as a double
value. If the value cannot be
converted, a default value is
returned

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text =
x.GetDouble("map.a")

-> Label1 shows "1.2"

.GetInteger(location) Returns the value at the
specified location as an integer
value. If the value cannot be
converted, a default value is
returned

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text =
x.GetInteger("map.c")

-> Label1 shows "3"

.GetString(location) Returns the value at the
specified location as a string
value.

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text = x.GetString("arr")

-> Label1 shows "[12,34,56]"
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.Keys(optional array
or map location)

Returns a list of all keys/indices
at the specified location

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text = x.Keys("map")

-> Label1 shows "["a", "b", "c"]"

.Locked Returns a Boolean value,
indicating if the object is locked.
Only useful for global variables,
as they are the only lockable
objects. Local variables are
always unlocked.

Label1.Text = LocalIP.Locked

-> Label1 shows "True"

.Set(location, value) Changes the value or defines a
new one at the specified
location and returns the JSON
element containing the changed
item (optional)

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text =
x.Set("map.a",123).ToString

-> Label1 shows "{"a":123,"b":2.3,"c":3.4}"

.ToString(location) Returns the JSON object as a 
string

var x = '{"start":"2016-02-
03"}'.ToJson

Label1.text =
x.GetDate("start").Month

-> Label1 shows "{"start":"2016-02-03"}"

.Type Returns the type of the
respective object as a string

var x = '{"start":"2016-02-
03"}'.ToJson

Label1.Text = x.Type

-> Label1 shows "Json"

.Values(array or
map location)

Returns a list of all values at the
specified location

var x = '{"arr":[12,34,56],
"map":{"a":1.2, "b":2.3,
"c":3.4}}'.ToJson

Label1.text =
x.Values("map").Join(", ")

-> Label1 shows "1.2, 2.3, 3.4"

The object data type is always applied when it is not possible to determine the specific type of an object
beforehand, e.g. for list elements, local variables without a value assigned or for the return value of a
function.

Data type: Object

.ToDate Returns the object content
formatted to a date type object

Var x = ["a","2017-03-
17",123.456,true,[3,6,9]]

Label1.Text = x[2].ToDate.Year

-> Label1 shows "2017"

.ToDouble Returns the value of the object
content in double format if the
characters form a real number

Var x = ["a",b,123.456,true,
[3,6,9]]

Fader1.Value = x[2].ToDouble

-> Fader1 will take the value 123.456

.ToInteger Returns the value of the object
content in integer format if the

Var x = ["a",b,123,true,[3,6,9]]

Fader1.Value = x[2].ToInteger
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characters form a real whole
number

-> Fader1 will take the value 123

.ToJson Returns the value of the object
content in JSON format if the
syntax applies to the respective
rules for JSON objects

.ToList Returns the object content
formatted to a list type object

Var x = ["a",b,123,true,[3,6,9]]

Label1.Text = x[4].ToList.Avg

-> Label1 shows "6"

.ToString Returns the object content
formatted to a string type object

Var x = ColorPicker1.SelectedColor 

(e.g. R=128 G=0 B=255)

Label1.Text = x[0].ToString

-> Label1 shows "a"

.Type Returns the type of the
respective object as a string

Var x

Label1.Text = x.Type

-> Label 1 shows "Object"

18.8.4.4  Using JSON

The previous chapter explained the Object and Member Notation  in Widget Designer, this chapter will
give you a quick overview of the JavaScript Object Notation, a format for easily storing, editing and
exchanging data.

Additionally, you will learn how to make use of this format in your Widget Designer project.

What is JSON?

JSON, or JavaScript Object Notation, is a format designed for data exchange. It derived from JavaScript,
but is by now also included in many other programming languages.
One of its advantages is that the stored data consists of human readable text and is based on a very
simple and straight forward structure.

Each set of data consists of a key and a value, separated by a colon ":". Several sets can be separated
by a comma "," and a collection of sets of data is called a JSON object, enclosed in curly brackets "{ }".
A key is always a string, enclosed in double quotation marks, a value can be one of the following types:

Number: Can be either an integer or a decimal number, exponential E notation is possible, too.
String: a sequence of characters, delimited with double quotation marks
Boolean: either one of the expressions true or false

Array: an ordered list of zero or more values of any type, delimited with square brackets "[ ]"
Map (Object): JSON objects are nestable, so an object can always contain another object, called map.
null: an empty value indicated with the expression null

White spaces, line feeds and tabs don't affect the functionality of the object, but  can be used to arrange
code.

If you open the Widget Designer project file (.wdpj) with a text editor, you will see that the whole file
consists of JSON data. You can easily read out information from this file concerning properties or
settings, unless something is password protected or encrypted.

Example

{

"company": "Christie",

1658
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"year_founded": 1929,

"over_1000_employees": true,

"products": {

"media_server":"Pandoras Box",

"projector":"Boxer",

"video_wall":"MicroTiles"

}

}

How to use JSON in Widget Designer?

JSON is available as a global variable: simply right-click on the variable list , choose "Create > Json"
and enter a name and a value. As a JSON object can be quite large and hard to overview, it might be
easier to write the complete object down in a script window and then either copy and paste the whole
text into the "Value" field, or directly assign the value via a script to an empty JSON variable. 

Other than other variable types, the automatic type recognition for local variables is not available for the
JSON type. You would have to type in a string with the correct format (pay attention to use the single
quotation marks ' '  to indicate the string!) and convert it via the .ToJson member:

var participant1 = '{

"name":"Jonathan", 

"age":27, 

"nationality":"UK",

"languages": {

"English":"expert",

"French":"basic",

"Spanish":"advanced",

"other":["Russian-little","German-advanced"]

}

}'.ToJson

Now you can make use of the various JSON members  to update, retrieve and use the stored data.

When accessing nested maps and arrays, the location is defined by a dot-separated path:

"participant1.Count("languages")" returns "4", "participant1.Count("languages.other")" returns "2".

It is even possible to store and readout data as a Session value by using the Context object :

Context.Session.Value("JSON_data") = participant1

Label1.Text = Context.Session.Value("JSON_data").ToJson.GetString("name")

-> Label1 shows "Jonathan"

For more detailed information on JSON and its syntax, please refer to: http://json.org/ 
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18.8.4.5  Math Object

The Math object offers a wide variety of mathematical functions. It always returns the computed result as
a numeric value without changing the argument itself.

Find here a list of all available methods. Remember to assign a suiting type to the variable for the result,
e.g. "Double". In the interests of clarity, the result is rounded to two digits.
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Description and Syntax Result

Abs returns the absolute value of a specified number.
varRes = Math.Abs(-1.23)

Acos returns the angle whose cosine is the specified number (in radians!).
varRes = Math.Acos(0.99)

Asin returns the angle whose sine is the specified number (in radians!).
varRes = Math.Asin(0.99)

Atan returns the angle whose tangent is the specified number (in radians!).
varRes = Math.Atan(0.99)

Ceiling returns the smallest integer greater than or equal to the specified number.
varRes = Math.Ceiling(1.5)

Cos returns the cosine of the specified angle (in radians!).
varRes = Math.Cos(30)

Exp returns e raised to the specified power.
varRes = Math.Exp(1)

Floor returns the largest integer less than or equal to the specified number.
varRes = Math.Floor(1.5)

Log returns the natural logarithm of a specified number.
varRes = Math.Log(2.718)

Log10 returns the base 10 logarithm of a specified number.
varRes = Math.Log10(5)

Max returns the larger of two specified numbers.
varRes = Math.Max(1, 2)

Min returns the smaller of two numbers.
varRes = Math.Min(3, 4)

Mod returns the remainder after the division of one number by another.
varRes = Math.Mod(10, 3)

Pow returns a specified number raised to the specified power.
varRes = Math.Pow(5, 2)

Round rounds a value to the nearest integer or specified number of decimal places.
varRes = Math.Round(1.234, 2)

Sign returns a value indicating the sign of a number.
varRes = Math.Sign(-10)

Sin returns the sine of the specified angle (in radians!).
varRes = Math.Sin(30)

Sqrt returns the square root of a specified number.
varRes = Math.Sqrt(25)

Tan returns the tangent of the specified angle (in radians!).
varRes = Math.Tan(30)

Truncate calculates the integral part of a number.
varRes = Math.Truncate(10.73)
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18.9  Web Server

Since version 4 Widget Designer (WD) is able to publish its pages as html files and operates as a Web
Server. Simply open your web browser and connect to the IP address and port number where the Widget
Designer application runs on. Now you can view the Widget Designer page with its controls and use
them.
Since version 6, all controls are supported as a web control too. All widgets like Custom Script Buttons
and Faders can be used within the web browser in the same way as in Widget Designer. This includes of
course the possibility to execute one of the 1500 commands of WD's build-in script language .
Please make sure to use the latest updates for your web browser. Currently Google Chrome, Mozilla
Firefox, Opera, Apple Safari and Windows Internet Explorer are recommended.

Session Synchronization and Multi-Session

As soon as a user connects to the Web Server, a so called session is created, together with a unique
session key. A special session cookie stores this data within the browser and can last several days. A
second user with another connection would create a second session and gets another key. If your page,
for example, contains a fader, there are two possible scenarios how the two users may interact with the
fader:

- the page(s) and the faders are published and displayed synchronized.
All web faders are copies or instances of the main, local WD faders; their values are always linked to
each other. If a web fader is moved, it reports its value to the local fader and this one in turn to the other
web instances. In other words, no matter whether the programmer moves the fader in the Widget
Designer interface or a user does so in the web browser interface, everybody sees the same fader and
value.
If your project consists of several pages, every session would switch to the same page as soon as one
user (or operator) calls another page.

- the page(s) and controls are published and displayed in multi-session mode (Unlimited Web Clients
Version only, see below)
Each session and user can have an individualized view and control setting. If one user moves the fader
now, only his fader will adopt to its individual session value. Another user might set up the fader with
another session value, he is not influenced by the first user or rather the WD operator. The main
Widget Designer application is able to receive, collect and evaluate all session values. For example, if
the fader is used for a voting event, WD could evaluate the highest / lowest value or the average one.
Regarding the page behavior, each user can view and switch the page of choice and is not linked to the
other users.
The Unlimited version supports even a combination of these two scenarios. If desired you may choose
to have a synchronized page behavior but multi-session tool behavior, it is even possible to arrange the
grouping of values for different clients.

Web Server features in different Widget Designer Versions

The Web Server is a very powerful feature in Widget Designer. Its three editions have different
implementation levels.

WD Free Version may publish one page to be accessed by one user. It is not possible to create a
second session. If the project consists of several pages, you may decide which one should be
published, it does not necessarily need to be "Page1".

WD may publish an unlimited number of pages to be accessed by an unlimited number of users at the
same time. If the project consists of several pages, you may decide which one should be published as
the index page - the one you will be automatically redirected to, when connecting to a web server. It is
not possible to create a multi-session, all sessions are synchronized. Thus, all users will have access to
the same page and its controls simultaneously.
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WD Unlimited Web Clients may publish an unlimited number of pages to be accessed by an unlimited
number of users at the same time. If the project consists of several pages, again, you may decide which
one should be published as the index page. In addition you may decide whether all sessions should be
synchronized or whether a multi-session should be supported which will allow simultaneous as well as
individual setups. In individual setups each user can see a different page and in addition multi-session
controls like Faders and Custom Script Buttons may have deviating values. 

How to use the Web Sever?

In the main menu bar: Click on Edit > Web Server Settings

The web server is automatically enabled, you do not need to start it manually to use this feature. The
default ports being used are: 80 for HTTP, 8080 for WebSockets and 81 for uploads. If those ports are
already in use, for example by another WD instance, free ports in the range of 30300 and higher will be
searched and applied automatically. The chapter Ports Used by PB and WD  lists all occupied ports.

If you use the web server on your local PC, open a browser and type in "localhost". You will then be
redirected to your index page or a directory of all available pages. For other PCs in the network enter the
IP address of the WD machine, e.g. http://10.169.10.31.
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As long as you are using the default ports, no additional value has to be entered. However, if you have to
use another port than 80 for HTTP, you will have to specify so in the address in order to get to the
correct WD instance interface.
Example for HTTP port 30300: http://10.169.10.31:30300 

Certain pages can be accessed by typing in the respective window and page name and separate them
with a hash tag (#):
http://10.169.10.31/Window1#Page1

If you like to use the feature not only within a local area network (LAN), you may do so as well. First of
all your router must be set up to allow access on the chosen port. Then it must be configured to forward
this wide area network (WAN) request to the specific Widget Designer IP address within your local area
network (LAN). Now you may enter your IP address and again the port number.
If you like to use the feature for a longer period keep in mind that you might not have a static IP address.
Most providers assign a deviating IP address every 24h, thus you have a dynamic IP address. In that
case, a ddns service (dynamic domain name system, e.g. dyndns.org) is very useful. The system
provides a persistent domain name and points to a changing, dynamic IP address on the internet. Your
router must support ddns in order to update the system's database.

Global Settings

If you want to change anything in this section, you need to stop the web server first by clicking the
"Stop" button at the top left corner. Press the "Start" button to enable it again.
You can set the ports to custom values if needed and also adjust the amount of listeners. The last may
come in handy, if you have a very large amount of clients accessing your project.
When you use group values, you can define your custom groups here. Just enter a valid name for a
group, multiple groups can be separated either by a white space or a comma.

You can also export your project to a native html-file and use this as a resource for your project. Here
you can define this project at the stand-alone mode, if you just want to display your normal WD project,
use WYSIWYG mode.

Export Settings
Here you can export your project as native HMTL-files. Please refer to the chapter HTML Export for more
information

Sessions

The log text field lists for example whether a new session has connected to the web server as well as
the respective session keys and the count of all clients connected via the session. The first session is
always the internal GUI.

Group Values

If you work with group values, you will find a table with all values of all widgets according to their groups.
For more information, please refer to the chapter Group Values .

If you like to have an index page that is displayed instead of the page directory when you did not specify
a certain page, switch to this page and edit the settings. Either right-click somewhere in the empty main
background and choose Pages > Edit Page or open the Pages menu in the main menu bar and choose
the command there. Tick the check box "Redirect to this page (when invalid URL is requested)".
If you like to exclude pages from the web access, uncheck the box "Make this page accessible for
external clients".
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Visual and technical differences between the interfaces in Widget Designer and web
browser

As WD V6 is natively based on HTML5, the main GUI and every client interface should look exactly the
same. Depending on the browser version, there might occur slight differences, especially if exotic fonts
are used.

Technically, it is very important to understand that all nodes, tools and all widgets are "live" in the
Widget Designer. The web browser interface is a second interface, it represents what is set up in the
main WD interface, it can be seen as an instance or copy of it.

Only the WD itself gives you the possibility to create new elements and to change their Item Properties.
For example, if you create a fader in WD, the browser adopts and displays a fader too. If you like to
change its look or value range, do so in Widget Designer and it will send the new properties to the web
instances. So, the look of every interface will always be the same and the widget's Item Properties
always match.

A widget can be actually used in both interfaces. Some of the most important widgets: Window,
DropDown List, Fader, ColorPicker, Encoder, Wheel, InputBox, Label and TextBox are able to respond
to Group Values . All others are always synched.
For example, you may change the fader's value by dragging its handle either in WD or in the web
browser. Depending on the setting to have a synchronized session or to use group values, the other web
copies of the fader will update too and move automatically to the new value; or in case of a group value
setup, they can be only moved in the local interface, corresponding to the group. That means that a fader
can not only hold one value but several ones and each web instance shows the same fader but with a
different value, its own group value.

In a nutshell, the widgets' properties are identical, but their values can be customized
separately.

A command only works in the Widget Designer application and is executed there. You may send a
command, either from within the WD or a browser but it only affects the control in WD.
For example, if you send "WDFaderUp(ID,Seconds)" only the local WD Fader will actually do the fade.
Of course, if you have a synchronized session, all web faders will fade too. This is not the case when
using group values, as those faders are now detached.
Importantly, if you send a command that alters the appearance of a control, e.g. the color of a Custom
Script Button (WDCustomScriptTint(ID,Red,Green,Blue)) again, this alters the local button and as the
Item Properties always match, all other web buttons will be tinted in that color too.

Some of the property members of the group value compatible widgets can be alternated separately for
each client using the widget's group items (e.g.: Label1.GroupItems.ForeColor). Please refer to the point 
Group Items  for an overview of available widgets and properties.

A node can be used in WD only and similarly to commands, it works up local values. Also, no group
values may be assigned to a widget that is used in combination with a node.

As mentioned above, Widgets  can be multi-session controls and have different values per session (or
other group participant). Widgets, pages and variables may have group values. It is possible to read
these out and evaluate them or to process them in commands or variables. Please read the topic Group
Values  if you are interested in that feature.

18.9.1  Group Values

What are Group Values?

Group Values are only of interest for those who use the Web Server feature with the optional feature
"Unlimited Web Clients" in Widget Designer. The Web Server allows to view your Widget Designer
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interface with an external web browser. As you can "load" the programmed interface in several browsers,
you can see and use it in various places.
Sometimes, you might not want all those interfaces to show exactly the same thing, e.g. when one
participant moves a fader, the faders in the other interfaces should not move. You would want to use
each fader in each browser, or even in each browser tab, independently from each other, and you would
want to be able to read out every single fader value.

This is what group values are for. If a Widget is assigned to a group, it creates instances of itself.
Instances can be synchronized or differ from other instances. Two fader instances for example can have
the same or a different value. Label instances can be even more multifaceted: two label instances can
display the same text but have different text colors. In other words, if a Label is assigned to a group, its
text and its color property become group values that can differ within the group. The Fader value and the
Label color depend on the place where you see and use the interface.

Before we have a deeper look at the meaning of "groups", just bear in mind that every Widget supports
different group values. A Fader supports only a multifaceted value (handle position) whilst a Label
supports also some multifaceted properties but a CustomScript button cannot be assigned to a group
i.e. has no group values at all. A CustomScript button can only be used globally. As nodes are also
operating globally only, the usage of those in a group context is not possible.

Working with group values requires being familiar with the concept of context object notation . In this
chapter, you will also find a list and description of context based members dealing with clients and group
values.

What is a Group and a Key?

Each widget can belong to exactly one group. Within the WD project however you can define multiple
groups that you use for different widgets and windows. Per default, a widget is not assigned to a group at
all, which means that it is synchronized in all interfaces (the main Widget Designer interface and all
browsers that connect to it).

Widget Designer offers four default groups, and on top you can create custom ones. To get a less
abstracted understanding what a "group" is, lets take our example widgets, the fader and the label, and
assign them to the default group called "InternalExternal". As explained further down, this is done in the
Item Properties dialog.
This default group consists of two group section, the first is called Internal and the other External. The
Internal group section refers to the main Widget Designer user interface and cannot be subdivided
further. The external section however refers to all interfaces outside of WD. Every browser that connects
to the Web Server to render our widgets is part of the external group section. Per definition, the widget's
group values are synchronized within one group section which means it is synchronized in all browsers.
The main WD is the internal section and can differ from the external one. 
The explanation of this behavior introduces the term "key". By assigning a widget to a group, instances
are created. Each instance is identified by a so called key. The keys in the InternalExternal group are
simply called "internal" and "external". So there is a set of widget instances that have the "internal" key
and there is a set that has the "external" key. The main Widget Designer displays the Widgets with the
internal key, all other browser get a copy of the widgets with the external key. For other groups it is
possible that every single widget gets a different key when it is displayed in another interface, those
keys are less readable as they are a strings with letters and numbers.

Default Groups

There are four default groups which generate keys automatically for each object:

- Client:
Each tab inside a single browser equals one Client. Even if you refresh a browser tab, a new client key is
generated.
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- Session:
Each browser that connects to the Widget Designer generates a new session. This is probably the most
used group as it covers the majority of applications.
The information about this session is saved in a session cookie sent by the browser and remains saved
for some days, so that you can resume this session. Within the Context object, you can even store
custom string values for each session (e.g. user name and password).
The Widget Designer session integration proofs as a very powerful tool in web server applications. It
enables you to generate user defined data within a session, process, store and recall it. 
The session key of a client is always available, even if there is no object's group value set to "Session".

- InternalExternal:
Internal means all objects inside the main Widget Designer user interface, external describes every
object accessed from an external browser (even on the same PC). The keys here are simply called
"internal" and "external".

- IPAddress:
This group distinguishes between different IP addresses for assigning keys. The key here equals the
participating IP address.

Custom Groups

You also have the option to define your own custom groups and assign your own keys to the objects. 

Imagine a game show with three teams, each member of a team has his own tablet PC displaying the
team's progress and offering interaction when the member's task is done (pressing a button, answering
questions...).
You would use a custom group "Team" and assign the three keys "team_red", "team_blue" and
"team_green" at each tablet, respective to each member. With this, every participant has access to his
team's data only.

To create Custom groups, go to Edit > Web Server Settings > Global Settings.
If you want to change anything there, you have to stop the web server first by clicking the "Stop" button
at the top left corner. Do not forget to start it again after doing your settings. 
Enter the names of your custom groups at the respective field, multiple names can be separated either
by a comma or a white space. Use only letters (capital or lowercase), numbers and underscores for your
group names, the name has to start with a letter.

For custom groups (not for default groups) you have to assign a key to each Widget. To do so, you will
have to call a script from within the context of every instance of your interface (e.g. with a CustomScript
button). 

Here is an example command for a custom group named "Sea":
Context.Client.Groups.Sea = "Swordfish"

This Command assigns the key "Swordfish", belonging to the group "Sea", to the one specific client
where the script was executed. You could design it for example as a user login: The user has to enter a
user name in an Input Box  and when submitting the name (Enter script of the InputBox or extra
button), the key is set to the user name for all items of the group. With this, the user would also have
access to his own values when changing the computer.

How do I assign a widget to a group in order to get real values from my clients? 

First of all, you have to tell each widget to which group it should belong. You can do so by clicking at
"Group Values" at the respective widget's item properties and simply choose one group from the list.

There are some helpful members for each widget, designed especially for the purpose of accessing
group values:
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Object Group
Member

Further
Members

Description Example

WidgetID .Group Returns a string with the
group name the widget
belongs to.

Label1.Text = Fader1.Group

-> Label 1 shows "Sea" 

.GroupItems .Property Returns the client specific
value of the selected
widget property. Each
widget has different
available properties. A
label offers e.g.
"BackColor", "ForeColor",
"Text" and "Transparent",
a fader only offers "Value".

Label1.Text =
Fader1.GroupItems.Value

-> Label1 shows "123" when
executed at the WD GUI

-> Label1 shows "10" when
executed at an external browser

.GroupItems(
Key)

.Property If a specific key is
specified for the group
items, the selected widget
property for this specific
key will be returned,
regardless of the context
in which the command
was executed. 

The Script Assistant offers
all available keys for this
widget.

Label1.Text =
Fader1.GroupItems("Swordfi
sh").Value

-> Label1 shows "123"
wherever it is executed

.GroupKeys Returns a list of used keys
for the indicated widget.

Var x = Fader1.GroupTags

-> x =
["Swordfish","Orca","Octopus"]

.GroupValues .Property Returns a list containing
all different values of the
selected widget property at
the group.

Var x =
Fader1.GroupValues.Value

-> x = [123,10,255]

As all of these members return values like strings, doubles, list , etc., the respective data type
members  can be used in addition to that.
E.g.: Fader5.GroupValues.Value.Avg -> returns the average fader value of all group values of this

fader. 

The same goes for the Context members of each widget handling group value related values: 

Object Members Further Members Description

Context
.Client
(session key
- optional)

If no client key is inserted, the client value of the
actual context will be used.

If you enter a client key (the Script Assistant will
offer you all available keys), the member will
address this specific client, even if it is not the
actual context of the script.

You will find a description of all expressions
concerning the usage of clients in the chapter Group
Values .

.Groups
.Group
Name

This member refers to Group Values , it offers a
list of available groups to request or edit the
respective key.
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.Key
This member returns the session key of the
indicated client context.

.IP
This member returns the IP address of the indicated
client context. 

.ClientExists
(session key)

Returns a Boolean value (False or True) that
indicates if a client with the respective session key
is currently connected.

.ClientKeys
Returns a list containing all session keys of
currently connected clients.

.Session
This member can set custom string values that are
stored at the session key. This can be of interest if
you like to store user data for a session.

.Value(value
name)

Here you can set or retrieve your own custom value,
stored within the WD and responding to the key in
the session cookie. Please note that you can only
store string values!

Example:

Context.Session.Value("EU") = "europe"  -> stores
a new value "EU" and sets it to "europe"

DebugMessage(Context.Session.Value("EU")) ->
shows "europe" in the Debug Logger

.Contains
(search
expression)

Returns a Boolean value (False or True) if the
indicated expression is stored in this session.

Group Items

Each of the widgets being able to hold group values has a specific set of properties affected by the group
values. They can be either read out or set like any other property.

Widget Available Group Values

DropDown List Index

Fader Value

Encoder Value

ColorPicker SelectedColor

Wheel Value

InputBox Text

Label BackColor

ForeColor

Text

Transparent

TextBox Text

Window PageName

976

984

981

979

988

991

993

1028
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19  SDK

The software development kit (SDK) including the PB Automation allows to integrate Pandoras Box
interaction into your custom application. This can be realized with common programming languages
such as Visual Basic scripts as well C# and C++.
The Pandoras Box Automation allows your custom program to control almost any aspect from the PB
software, e.g. parameters on video or graphic layers, sequence values and content data. As the
Pandoras Box Clients are connected to the Master system, they are controlled indirectly. The control
parameters can be sent using the network protocols TCP and UDP.

This chapter is written for:
- software programmers who have little knowledge of Pandoras Box and want to integrate it into their
application
- Pandoras Box users who have little programming knowledge but need to write a custom application.
Please have a look at the Widget Designer  too. One of the main purposes of Widget Designer is to
enable users who do not have any programming skills, to create their own custom applications or
interfaces. Widget Designer provides a graphical user interface and runtime environment. You can create
user-controls such as faders, buttons, labels and many more and instantly use them without compiling
any code. The PRO version allows to program visually with so called nodes. By simply connecting those
visual control components you may create a dedicated interaction logic.

If you like to build your own custom application to interact with Pandoras Box, the following scenarios
are possible.

One user application - One Pandoras Box Master system

One custom application with one integrated "PandorasAutomation.dll" sends and receives TCP or UDP
commands to and from one Pandoras Box Master system. A Master system can be either a Pandoras
Box Manager or a Pandoras Box Player / Server started in Master mode. The product range is
described here  in detail.
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One user application - Multiple Pandoras Box Master systems

If you like to control more than one Pandoras Box Master system with your program, easily duplicate the
"PandorasAutomation.dll" as many times as you wish.

Multiple user applications - One Pandoras Box Master system

You can hook up as many applications to one Pandoras Box Master system as you wish. The
commands will work in LTP mode (latest takes precedence).
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Multiple user applications - Multiple Pandoras Box Master systems

This scenario combines the one-to-many and the many-to-one scenario. Coolux does not set any limit
regarding the application or PB Master count.

The following topics include a short Getting Started , some examples how to connect the SDK to a
PB system , how to send  and receive  values as well as typical error messages . Afterwards
the general datatypes and structures  are explained and finally you find a list including all available
functions .

19.1  Getting Started

Software Development Kits are available for the programming languages Visual Basic and C#. It is also
possible to use JavaScript in Html pages. Other languages can also be used, but are not in the scope of
this document.
We provide documented code for both Visual Basic and C# when used in combination with Visual
Studio. You can obtain a copy of Visual Studio at the Microsoft website.

Required resources (Programming/Applications)
Step 1: Obtain PandorasAutomation.dll
You can find the PandorasAutomation.dll in every Pandoras Box installation folder (where
PandorasBox.exe is located).
A typical location would be: C:/Program Files/coolux/Pandoras Box V5 ... Rev .../
PandorasAutomation.dll

Step 2: Download SDK
Eventhough the SDK includes a PandorasAutomation.dll, it is recommended to substitute it with the one
from the current version!

Required resources (Scripting/Html+JS)
All the required files come with Pandoras Box.

The next topic describes the steps to get started with Visual Basic or C# . For scripting with
JavaScript read Using JavaScript . Information about other languages can be found here .
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19.1.1  Using Visual Basic / C#

To get started with Visual Basic or C# please follow these steps.

Installing the IDE (Integrated Development Environment)
To be able to convert the code you write to an actual executable program you will need a few tools.
Fortunately, Microsoft provides all these tools bundled in one application called Visual Studio. Download
Microsoft Visual Studio 2010 Express for Visual Basic or C#.
Download page: http://microsoft.com/visualstudio/eng/downloads#d-2010-express
Direct installer downloads: Visual Basic & C#

Creating a project
After starting Visual Studio click File > New to create a new Project. Choose your project type (ex:
Console Application) from the list and name it using the text box at the bottom. When the project has
finished loading, you need to add the Pandoras Box SDK. Select Project > Add Existing Item from the
top menu. Choose PbAutomation.* in the file dialog . In case you have not previously downloaded it:
Download SDK

Adding PandorasAutomation.dll
After saving your project, open the Windows Explorer and navigate to your project's folder. There you will
find a couple of directories. Put PandorasAutomation.dll in the following directory: <ProjectPath>/bin/
Debug/

Now you are ready to use Pandoras Automation with Visual Basic. When exporting applications, make
sure you keep PandorasAutomation.dll next to the application.exe

Visual Basic Specific Information
The Visual Basic SDK provides an additional class to ease the workflow. The Class Param contains

constants for the default parameter names (excluding effect parameters) used in all parameter functions.

C# Specific Information
It is required by C# that all functions are within a class. That means, that all C# functions are in class
Auto and instead of calling AutoGetContentIsConsistent(2,2)you will have to put a dot in

between Auto and the function name like this: Auto.GetContentIsConsistent(2,2)

When using Auto.SetParamDouble in combination with enum TransportMode you need to

convert the enumerator to a double value.

Example (using explicit cast):
Auto.SetParamDouble(1,1,"Playback Transport",TransportMode.Pause) must be

changed to Auto.SetParamDouble(1,1,"Playback Transport",(double)
TransportMode.Pause)

19.1.2  Using JavaScript

This chapter assumes that you already have a little knowledge about Html and JavaScript.

Setup of Pandoras Box web server
Open Pandoras Box and go to the Configuration tab. Choose Web Server from the categories list and
change the settings as you like. Make sure to click the "Start" button as well. If you like, you can have a
look at the demo pages which can be viewed from your web browser. Simply navigate to the IP address
of your Pandoras Box Master using the port you previously set up in the Configuration tab.
URL example: Assuming your IP is 192.168.178.100 and the configured port is 6214:
http://192.168.178.100:6214

http://www.microsoft.com/visualstudio/eng/downloads#d-2010-express
http://go.microsoft.com/?linkid=9709929
http://go.microsoft.com/?linkid=9709939
http://coolux.de/root/downloads/support/SDK/PandorasBoxSDK.zip
http://msdn.microsoft.com/en-us/library/xhbhezf4%28v=vs.100%29.aspx
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Once you are familiar with using Pandoras Box web server you can go ahead and write your own html.
The only thing required to be included is the pandora.js In your header section use
<script type="text/javascript" src="web_ui.js"></script>

The web server utilizes the very same commands as all the other languages. To be able to retrieve data,
all commands ask for a callback function as the first parameter. This mechanism is explained in the
demo files.

Using a dedicated web server
For advanced uses it is also possible to use a dedicated web server such as Apache to proxy the
commands to Pandoras Box. We supplied a simple .php script for that. All you need to do is to change
one line in pandora.js. Change "var usesProxy = false;" to "var usesProxy = true;"

Example - Sequence Control
// The first parameter is the callback, which is described later on.
// The second parameter is the sequence id, which in our case is simply 1
// The third parameter describes the desired state, which can be "Play","Pause" or "Stop" (case-
sensitive!)
// "Play"-button code is

PBAutoCommands.setSequenceTransportMode(false,1,'Play')

Example - Retrieving Values
// callback_sequencemode is the callback (the function that is responsible to handle the incoming data)
PBAutoCommands.getSequenceTransportMode(callback_sequencemode,1)

function callback_sequencemode(response){

// Quit if "false" is passed. That means that there is no response
if(response === false) return;

// Check for errors (On error, the first short is eAutoCmdError)
if( && response.getNextAsShort() == eAutoCmdGetSequenceTransportMode){

// Get the mode number
var mode = response.getNextAsInt();
var modeText = "???";
// Translate numeric "mode" to text
if(mode == 1) modeText = "Play";
if(mode == 2) modeText = "Stop";
if(mode == 3) modeText = "Pause";

// Display
document.getElementById("seq1mode").value = modeText;

}
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19.1.3  Other Languages

So far, we do not provide a complete SDK for other languages, but with a little knowledge you can use
the PandorasAutomation.dll for them too. First, convert the following C++ export definitions to the
language of choice in order to use the commands.
This list includes all commands PandorasAutomation.dll exports:

bool __stdcall AutoInitialize(char* pIpStr,int domain);
double __stdcall AutoGetParam(int siteNum,int deviceNum,char* pParamName);
bool __stdcall AutoSetParamInSelection(char* pParamName,int value);
bool __stdcall AutoSetParamInSelectiondouble(char* pParamName,double
value);
bool __stdcall AutoSetContentAtTime(int siteNum,int deviceNum,int
seqNum,int hours,int minutes,int seconds,int frames,int dmxFolderId,int
dmxId);
bool __stdcall AutoAssignMesh(int siteNum,int deviceNum,int dmxFolderId,int
dmxId);
bool __stdcall AutoAssignMeshByName(int siteNum,int deviceNum,char*
pMeshName,char* pParamName);
bool __stdcall AutoAssignMeshToSelection(int dmxFolderId,int dmxId);
bool __stdcall AutoAssignMedia(int siteNum,int deviceNum,int
dmxFolderId,int dmxId);
bool __stdcall AutoAssignMediaByName(int siteNum,int deviceNum,char*
pMediaName,char* pParamName);
bool __stdcall AutoAssignMediaToSelection(int dmxFolderId,int dmxId);
bool __stdcall AutoMoveContentToFolder(char*
pContentName,char*pFolderName);
bool __stdcall AutoMoveTreeItem(int itemIdFrom,int itemIdTo);
bool __stdcall AutoSetSequenceTransportMode(int sequenceNum,char*
pModeName);
bool __stdcall AutoMoveSequenceToCue(int sequenceNum,int cueId);
bool __stdcall AutoMoveSequenceToTime(int sequenceNum,int hours,int
minutes,int seconds,int frames);
bool __stdcall AutoMoveSequenceToLastNextFrame(int sequenceNum,bool
isNext);
bool __stdcall AutoMoveSequenceToLastNextCue(int sequenceNum,bool isNext);
bool __stdcall AutoSetSequenceTransparency(int seqNum,int transparency);
int __stdcall  AutoGetSequenceTransparency(int seqNum);
bool __stdcall AutoSetSequenceTimeCodeMode(int seqNum,int timeCodeMode);
bool __stdcall AutoSetSequenceTimeCodeOffset(int seqNum,int hours,int
minutes,int seconds,int frames);
bool __stdcall AutoSetSequenceTimeCodeStopAction(int seqNum,int
stopAction);
bool __stdcall AutoResetAll();
bool __stdcall AutoResetSite(int siteNum);
bool __stdcall AutoResetDevice(int siteNum,int deviceNum);
bool __stdcall AutoResetParam(int siteNum,int deviceNum,char* pParamName);
bool __stdcall AutoActivateAll();
bool __stdcall AutoActivateSite(int siteNum);
bool __stdcall AutoActivateDevice(int siteNum, int deviceNum);
bool __stdcall AutoActivateParam(int siteNum,int deviceNum,char*
pParamName);
bool __stdcall AutoClearAllActive();
bool __stdcall AutoClearActiveSite(int siteNum);
bool __stdcall AutoClearActiveDevice(int siteNum,int deviceNum);
bool __stdcall AutoClearActiveParam(int siteNum,int deviceNum,char*
pParamName);
bool __stdcall AutoToggleFullscreen(int siteNum);
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bool __stdcall AutoSetParamRelative(int siteNum,int deviceNum,char*
pParamName,int value);
bool __stdcall AutoSetParamRelativedouble(int siteNum,int deviceNum,char*
pParamName,double value);
bool __stdcall AutoSetParamRelativedoubleExtended(int siteNum,int
deviceNum,char* pParamName,double value,bool silent,bool direct);
bool __stdcall AutoSetParamRelativeInSelection(char* pParamName,int value);
bool __stdcall AutoSetParamRelativeInSelectiondouble(char*
pParamName,double value);
bool __stdcall AutoAddContent(char* pFullPath,int siteNum,int
dmxFolderId,int dmxId);
bool __stdcall AutoAddContentToFolder(char* pFullPath,int siteNum,int
dmxFolderId,int dmxId,char* pFoldername);
bool __stdcall AutoAddContentToTreeItem(char* pFullPath,int siteNum,int
dmxFolderId,int dmxId,int treeItemId);
bool __stdcall AutoAddContentFromLocalNode(char* pFullPath);
bool __stdcall AutoAddContentFromLocalNodeToFolder(char* pFullPath,char*
pFoldername);
bool __stdcall AutoAddContentFromLocalNodeToTreeItem(char* pFullPath,int
treeItemId);
bool __stdcall AutoAddContentFolder(char* pFolderPath,int siteNum,int
dmxFolderId,int dmxId,char* pProjectPath);
bool __stdcall AutoAddContentFolderFromLocalNode(char* pFolderPath);
bool __stdcall AutoAddContentFolderFromLocalNodeToFolder(char*
pFolderPath,char* pFoldername);
bool __stdcall AutoAddContentFolderFromLocalNodeToTreeItem(char*
pFolderPath,int treeItemId);
bool __stdcall AutoRemoveMediaById(int dmxFolderId,int dmxId);
bool __stdcall AutoRemoveMeshById(int dmxFolderId,int dmxId);
bool __stdcall AutoRemoveContentByName(char* pProjectPath,bool
allEquallyNamed);
bool __stdcall AutoRemoveTreeItem(int treeItemId);
bool __stdcall AutoRemoveAllResources(bool removeFolder);
bool __stdcall AutoSpreadAll();
bool __stdcall AutoSpreadMediaById(int dmxFolderId,int dmxId);
bool __stdcall AutoSpreadMeshById(int dmxFolderId,int dmxId);
bool __stdcall AutoReloadMediaById(int dmxFolderId,int dmxId);
bool __stdcall AutoReloadMeshById(int dmxFolderId,int dmxId);
bool __stdcall AutoReloadResource(char* pProjectPath);
bool __stdcall AutoSpreadResource(char* pProjectPath);
bool __stdcall AutoReloadAndSpreadResourceByPath(char* pProjectPath);
bool __stdcall AutoReloadAndSpreadResourceByItemIndex(int treeItemId);
bool __stdcall AutoReloadAndSpreadResourceByDmxId(int dmxfolderId,int
dmxId);
bool __stdcall AutoRemoveInconsistent();
bool __stdcall AutoStoreActive(int seqNum);
bool __stdcall AutoStoreActiveToTime(int seqNum,int hours,int minutes,int
seconds, int frames);
bool __stdcall AutoSetMediaFrameBlendingById(int dmxFolderId,int dmxId,bool
frameBlended);
bool __stdcall AutoSetMediaDeinterlacingById(int dmxFolderId,int dmxId,int
deinterlacer);
bool __stdcall AutoSetMediaAnisotropicFilteringById(int dmxFolderId,int
dmxId,bool useFiltering);
bool __stdcall AutoSetMediaUnderscanById(int dmxFolderId,int dmxId,bool
useUnderscan);
bool __stdcall AutoSetMediaMpegColourSpaceById(int dmxFolderId,int
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dmxId,bool useMpegColourSpace);
bool __stdcall AutoSetMediaAlphaChannelById(int dmxFolderId,int dmxId,bool
useAlphaChannel);
bool __stdcall AutoCreateTextInput(int dmxFolderId,int dmxId,char* pText);
bool __stdcall AutoSetText(int dmxFolderId,int dmxId,char* pText);
bool __stdcall AutoLoadProject(char* pPath,char* pName,bool saveExisting);
bool __stdcall AutoCloseProject(bool save);
bool __stdcall AutoClearSelection();
bool __stdcall AutoSetDeviceAcceptDmxById(int siteNum,int deviceNum,bool
acceptDmx);
bool __stdcall AutoSetSiteAcceptDmxById(int siteNum,bool acceptDmx);
bool __stdcall AutoSetDeviceDmxAddressById(int siteNum,int deviceNum,int
index,int id1,int id2);
bool __stdcall AutoSetSequenceCuePlayMode(int seqNum,int cueId,int
playMode);
bool __stdcall AutoSetNextSequenceCuePlayMode(int seqNum,int playMode);
bool __stdcall AutoSetIgnoreNextSequenceCue(int seqNum,bool doIgnore);
bool __stdcall AutoSetChannelEvents(int ctEvents,int* pEvents);
bool __stdcall AutoSaveProject();
bool __stdcall AutoChangeFullscreenStateById(int siteNum,bool
enterFullscreen);
bool __stdcall AutoChangeFullscreenStateByIp(char* pIp,bool
enterFullscreen);
bool __stdcall AutoSetTextTextureSize(int dmxFolderId,int dmxId,int
width,int height);
bool __stdcall AutoSetTextProperties(int dmxFolderId,int dmxId,char*
pFont,int size,int style,int alignment,int colorRed,int colorGreen,int
colorBlue);
bool __stdcall AutoSetTextCenterOnTexture(int dmxFolderId,int dmxId,bool
centerOnTexture);
bool __stdcall AutoCreateTextInputWide(int dmxFolderId,int dmxId,wchar_t*
pText);
bool __stdcall AutoSetTextWide(int dmxFolderId,int dmxId,wchar_t* pText);
bool __stdcall AutoSetSiteIpById(int siteNum,char* pIp);
bool __stdcall AutoIsLayerReallySelected(int siteNum,int deviceNum);
int  __stdcall AutoGetNumMediaInProject();
int  __stdcall AutoGetNumTreeItemsInProject();
bool __stdcall AutoGetMediaInfo(int index,MediaStruct* pMediaInfo);
bool __stdcall AutoGetMediaInfo1(int index,MediaStruct1* pMediaInfo);
bool __stdcall AutoGetMediaInfoFromTreeItem(int treeItemIndex,MediaStruct1*
pMediaInfo);
bool __stdcall AutoGetTreeItemInfo(int index,TreeItemStruct* pItemInfo);
int  __stdcall AutoGetSequenceTransportMode(int seqNum);
bool __stdcall AutoGetSequenceTime(int seqNum,TimeStruct* pTime);
bool __stdcall AutoGetClipRemainingTime(int siteNum,int deviceNum,int
seqNum,TimeStruct* pTime);
bool __stdcall AutoGetRemainingTimeUntilNextCue(int seqNum,TimeStruct*
pTime);
int  __stdcall AutoGetNumSelectedLayers();
bool __stdcall AutoGetSelectedLayer(int layerIndex,LayerStruct* layerInfo);
bool __stdcall AutoAddFolderToProject(char* pName);
bool __stdcall AutoAddFolderToProjectPath(char* pName, char* pFolderRoot);
bool __stdcall AutoAddFolderToTreeItem(char* pName,int treeItemId);
bool __stdcall AutoRemoveFolderFromProject(char* pFolderPath);
bool __stdcall AutoSetDeviceSelection(int siteNum,int deviceNum,int
selectionMode);
bool __stdcall AutoSetClxControllerFaderMapping(int faderId,int seqNum);
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bool __stdcall AutoSetClxControllerCueMapping(int cueBtnId,int seqNum,int
cueId);
bool __stdcall AutoAddCue(int seqNum,int cueId,int hours,int minutes,int
seconds,int frames,char* pName,int cueKindId);
bool __stdcall AutoRemoveCueById(int seqNum,int cueId);
bool __stdcall AutoRemoveAllCues(int seqNum);
int __stdcall AutoAddGraphicLayer(int siteId);
int __stdcall AutoAddVideoLayer(int siteId);
bool __stdcall AutoRemoveGraphicLayer(int siteId,int layerId);
bool __stdcall AutoRemoveVideoLayer(int siteId,int layerId);
bool __stdcall AutoBackupMode(bool enable);
bool __stdcall AutoApplyView(int viewNum);
bool __stdcall AutoSetSpareFromSpread(int siteId,bool spareFromSpread);
bool __stdcall AutoGetParamMedia(int siteNum,int deviceNum,char*
pParamName,ParamResStruct* pInfo);
bool __stdcall AutoGetParamMedia1(int siteNum,int deviceNum,char*
pParamName,ParamResStruct1* pInfo);
bool __stdcall AutoGetParamObject(int siteNum,int deviceNum,char*
pParamName,ParamResStruct* pInfo);
bool __stdcall AutoGetParamObject1(int siteNum,int deviceNum,char*
pParamName,ParamResStruct1* pInfo);
bool __stdcall AutoAddMediaIncrementID(char* pMediaPath,int
siteNum,ParamResStruct* pInfo);
bool __stdcall AutoGetMediaTransportMode(int siteNum,int deviceNum,int*
pTransportMode);
bool __stdcall AutoIsSiteConnected(int siteNum);
bool __stdcall AutoMoveLayerUp(int siteNum,int deviceNum);
bool __stdcall AutoMoveLayerDown(int siteNum,int deviceNum);
bool __stdcall AutoMoveLayerToFirstPosition(int siteNum,int deviceNum);
bool __stdcall AutoMoveLayerToLastPosition(int siteNum,int deviceNum);
bool __stdcall AutoSetEnableClxJogShuttle(bool enable);
bool __stdcall AutoGetEnableClxJogShuttle();
bool __stdcall AutoSetEnableClxFaderExt(bool enable);
bool __stdcall AutoGetEnableClxFaderExt();
bool __stdcall AutoSetSequenceCueWaitTime(int seqNum,int cueId,int
hours,int minutes,int seconds,int frames);
bool __stdcall AutoSetSequenceCueJumpTargetTime(int seqNum,int cueId,int
hours,int minutes,int seconds,int frames);
bool __stdcall AutoSetSequenceCueJumpCount(int seqNum,int cueId,int
jumpCount);
bool __stdcall AutoResetSequenceCueTriggerCount(int seqNum,int cueId);
int __stdcall AutoGetContentIsConsistent(int dmxFolderId,int dmxId);
int __stdcall AutoGetContentIsConsistentByName(char* pProjectPath);
int __stdcall AutoCreateSequence();
bool __stdcall AutoRemoveSequence(int seqNum);
bool __stdcall AutoGetIsConnected();
bool __stdcall AutoSendMouseInput(int siteNum,int eventType,int
screenPosX,int screenPosY,int screenWidth,int screenHeight);
bool __stdcall AutoSendTouchInput(int siteNum,int touchId,int touchType,int
screenPosX,int screenPosY,int screenWidth,int screenHeight);
bool __stdcall AutoSendKeyboardInput(int siteNum,int eventType,int
keyCode);
bool __stdcall AutoSetShowCursorInFullscreen(int siteNum,bool showCursor);
bool __stdcall AutoSetNodeOfSiteIsAudioClockMaster(int siteNum,bool
isMaster);
bool __stdcall AutoGetThumbnailByPath(char* pProjectPath,int* pWidth,int*
pHeight,VARIANT* pData);
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bool __stdcall AutoGetThumbnailByItemIndex(int treeItemIndex,int*
pWidth,int* pHeight,VARIANT* pData);
bool __stdcall AutoAddEncryptionKey(char* pKey);
bool __stdcall AutoAddEncryptionPolicy(char* pPolicy);
int  __stdcall AutoGetLastError();

19.2  Examples

The following topics contain quick tutorials explaining the basic functionality of Pandoras Box
Automation. They assume that you have already set up your programming environment and have added
one of the SDKs to the project (as explained in Getting Started ).

To continue, go to Connect SDK to Pandoras Box

19.2.1  Connect SDK to Pandoras Box

TCP versus UDP
The Pandoras Automation allows both, TCP and UDP connections. Both protocols allow sending data via
a network connection. The ports that are used are 6211 for TCP and 6212 for UDP whilst the ports used
for the TCP and UDP communication between a PB Master and PB Client are 1234 and 1235.

TCP has the advantage, that all packages are guaranteed to be delivered. To make that possible, TCP
requires to send additional data, the so called acknowledge bits. The message sender asks the receiver
for an acknowledge bit. If the receiver does not confirm, the message is send again. In addition TCP
ensures the correct order of message packages. This is done by the network adapter; if packages are
received in non-chronological order, it buffers the packages. The downside is, that the connection gets
slower. The disadvantage of the acknowledging process is to be found when very large amounts of data
is send as more network traffic is caused. Most sensors, for example send a lot of data, thus TCP would
not be the protocol of choice. It is a different matter when you need to send "important" data and want to
be sure that it arrives.
In short, decide for a TCP connection if the applications are connected in a stable network (by cable) and
react to user interaction by sending a manageable amount of commands to PB Automation. When using
TCP you can choose between automatic mode which will automatically reconnect or a "try once".

UDP is a better choice in scenarios where a lot of data is sent, or in case packages do not necessarily
need to be acknowledged. In the UDP protocol the server does not know whether the clients received the
messages, it rather sends the messages "blind". This way, UDP offers a faster response time for your
application. The main disadvantage from a UDP protocol is that UDP packages are not as prioritized as
TCP data. Thus each switch in the network may discard UDP data without further notice as soon as the
network traffic reaches its limit.
In short, decide for a UDP connection if the application is allowed to get disconnected from the Master
for short periods of time. Also, UDP is the better choice for applications that are updating values
permanently, like in tracking systems or systems with permanent user interaction.

The following commands are needed to initialize the connection. The commands are listed with an
example, assuming the Master system runs on a certain IP address and is set up with a certain domain
number. The IP address can be found in the Asset tab  of the PB software, the domain channel is a
Pandoras Box internal number set up in the Configuration tab .
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Initializing TCP
Make sure you configured (or disabled) your firewall to allow your application to communicate with
Pandoras Box.
Initialize the connection to the Pandoras Box Master running at IP 10.0.0.1 with Domain number 0. The
third parameter allows to choose between
- False: instantly try to connect once
- True: wait and connect as soon as possible
Setting "waitForConnection" to True also enables automatic reconnecting on connection loss.
Note: You can later on enable the "waitForConnection" feature by using AutoWaitForConnection() and
disable it by using AutoStopWaitingForConnection()

Visual Basic

AutoInitializeTCP("10.0.0.1", 0, True)

C#

Auto.InitializeTCP("10.0.0.1", 0, true);

Initializing UDP connections
Initialize the connection to Pandoras Box Master running at IP 10.0.0.1 with Domain number 0.
Pandoras Automation will try to connect to Pandoras Box and verify the connection with a handshake.

Visual Basic

AutoInitialize("10.0.0.1", 0)

C#

Auto.Initialize("10.0.0.1", 0);

Now that you are connected to Pandoras Box, you can start Sending Parameter Values .1681



1681

19.2.2  Sending Parameter Values

The following examples show you how to set parameter values from Pandoras Box using the SDK .
The examples require a working connection to Pandoras Box. (see Connect SDK to Pandoras Box )

Visual Basic

' Set the opacity of layer 3 of site 2 to 240.
' The parameter will be marked active and transition smoothing applies
AutoSetParamDouble(2, 3, Param.Opacity, 240)

' Set the x position of layer 1 of site 2 to -2 without setting the value
active.
' Use Transition Smoothing
AutoSetParamDoubleExtended(2, 1, Param.Position.X, -2, True, False)

' Set the x position of layer 1 of site 2 to -2 and set value as active.
' Do not use Transition Smoothing
AutoSetParamDoubleExtended(2, 1, Param.Position.X, -2, False, True)

' Set the Mix parameter of the "White Key" effect on layer 1 of site 2 to a
value of 255
AutoSetParamDouble(2, 1, "White Key|Mix", 255)

C#

// Set the opacity of layer 3 of site 2 to 240.
// The parameter will be marked active and transition smoothing applies
Auto.SetParamDouble(2, 3, "Opacity", 240)

// Set the x position of layer 1 of site 2 to -2 without setting the value
active.
// Use Transition Smoothing
Auto.SetParamDoubleExtended(2, 1, "X Pos", -2, True, False)

// Set the x position of layer 1 of site 2 to -2 and set value as active.
// Do not use Transition Smoothing
Auto.SetParamDoubleExtended(2, 1, "X Pos", -2, False, True)

// Set the Mix parameter of the "White Key" effect on layer 1 of site 2 to
a value of 255
Auto.SetParamDouble(2, 1, "White Key|Mix", 255)

If you are not familiar with Pandoras Box "vocabulary", please follow the links. In short, a site refers to a
Client e.g. a Server, in the Device Tree tab . A site has many devices, also called layers, e.g. graphic
layers  or video layers . A video layer has many parameters, e.g. position  on the X-axis. If a new
value is applied to the parameters position / rotation / scaling, the layer would abruptly jump to it, which,
does not look nice. Therefore, "Smoothing" applies a delay. It can be set up in the Device Inspector .
Other examples above refer to parameters "effects", more information about effects can be found in the
tab Aeon FX  and FX on Layers , including an illustrated FX List  with all available effects. A list
with all parameter names  can be found here.

The next topic informs you about Receiving Parameter Values  from Pandoras Box.
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19.2.3  Receiving Parameter Values

The following examples show you how to request information from Pandoras Box using the SDK  and
how to handle incoming values.
The examples require a working connection to Pandoras Box (see Connect SDK to Pandoras Box) . If
you like to know, how to send values yourself please go back to the topic Sending Parameter Values
)

Visual Basic

' Get the Y position of layer 1 of site 2
Dim y_pos As Double = AutoGetParam(2, 1, Param.Position.Y)

' Get the "Left" parameter value of effect "Crop Edges" on layer 3 of site
1
Dim crop_edges_left As Double = AutoGetParam(1, 3, "Crop Edges|Left")

' Get the transport mode of sequence 2 (Play/Stop/Pause)
Dim sequence_status As TransportMode = AutoGetSequenceTransportMode(2)

' Get the current time position of sequence 1 and extract the number of
seconds
Dim sequence_time As TimeType
AutoGetSequenceTime(1, sequence_time)
Dim sequence_seconds As Integer = sequence_time.Seconds

C#

// Get the Y position of layer 1 of site 2
double y_pos = AutoGetParam(2, 1, "Pos Y")

// Get the "Left" parameter value of effect "Crop Edges" on layer 3 of site
1
double crop_edges_left As Double = AutoGetParam(1, 3, "Crop Edges|Left")

// Get the transport mode of sequence 2 (Play/Stop/Pause)
TransportMode sequence_status = Auto.GetSequenceTransportMode(2);

// Get the current time position of sequence 1 and extract the number of
seconds
TimeType sequence_time = new TimeType();
Auto.GetSequenceTime(1, ref sequence_time);
int sequence_seconds = sequence_time.Seconds;

If you are not familiar with Pandoras Box "vocabulary", please follow the links. In short, a site refers to a
Client e.g. a Server, in the Device Tree tab . A site has many devices, also called layers, e.g. graphic
layers  or video layers . A video layer has many parameters, e.g. position  on the X-axis. If a new
value is applied to the parameters position / rotation / scaling, the layer would abruptly jump to it, which,
does not look nice. Therefore, "Smoothing" applies a delay. It can be set up in the Device Inspector .
Other examples above refer to parameters "effects", more information about effects can be found in the
tab Aeon FX  and FX on Layers , including an illustrated FX List  with all available effects. A list
with all parameter names  can be found here.

The next topic, Error Handling , covers the way the SDK reports problems.
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19.2.4  Error Handling

Whilst using the SDK , e.g. sending  and receiving  parameter values you might encounter
problems.
The following function for error handling works only for functions which are not returning information
directly. All other functions return a value true or false. If "false" was returned, you can get the type of
problem with the function AutoGetLastError()

Visual Basic

// Store the error code in "error_code" and store a string describing the
error in "error_text"
Dim error_code As AutoError = AutoGetLastError()
Dim error_text As String = error_code.ToString()

C#

// Store the error code in "error_code" and store a string describing the
error in "error_text"
AutoError error_code = Auto.GetLastError();
string error_text = error_code.ToString();

19.3  Datatypes and Structures

This topic lists all available datatypes and their structures that are used by the SDK . Please see the
next topic for all available functions .

Enumeration AutoError - Contains the error codes which describe the problem that occurred

None = 0 ' No Error occurred
NoConnection = 1 ' Automation is not connected
WrongParam = 2 ' You have supplied a invalid parameter name (exceeded 100 characters)
AddressTranslation = 3 ' There seems to be a problem with the IP/Host you supplied
CouldNotConnectToSocket = 4 ' Failed to open a port for communication
HandshakeFailed = 5 ' The handshake was unsuccessful. For UDP connections: Make sure the
connection is stable
RequestTimedOut = 6 ' The site failed to respond
WrongMessageReturned = 7 ' The Server returned a wrong message
ParamPointer = 8 ' Make sure you supplied all of the required arguments
WrongClient = 9 ' unused
HostInvalidLayer = 10 ' You supplied an invalid layer id
HostInvalidSequence = 11 ' You supplied an invalid sequence
HostInvalidPointer = 12 ' You supplied an invalid pointer
HostInvalidParameterName = 13 ' You supplied an invalid pointer name
HostInvalidParam = 14 ' You supplied an invalid parameter
InvalidPort = 15 ' Failed to connect to the Master
WrongNetworkProtocol = 16 ' unused
AlreadyConnected = 17 ' Failed to connect because the connection is already established
InvalidCueId = 18 ' You supplied an invalid cue
InvalidCueButtonId = 19 ' You supplied an invalid button id
InvalidDomainNr = 20 ' You supplied an invalid domain number
GraphicLayerNotCreated = 21 ' Failed to create a new graphics layer
InvalidSiteId = 22 ' You supplied an invalid site id
InvalidViewId = 23 ' You supplied an invalid view id

1670 1681 1682
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InvalidCast = 24 ' (deprecated)
AddingVideoLayerNotAllowed = 25 ' Unable to add more video layers
InvalidLayerMoveTarget = 26 ' (deprecated)
InvalidFolderPath = 27 ' (deprecated)
DmxResourceNotFound = 28 ' 
NoAdditionalSequenceAllowed = 29
InvalidContentPath = 30
HandshakeTimeout = 31
FunctionNotSupportedByOS = 32 ' unused
TreeItemIndexNoMediaFile = 33 ' 
TreeItemNotFound = 34 ' The tree item was not found
InvalidTreeItemIndex = 35 ' The tree item was not found
NoThumbnailAvailable = 36 ' Indicates, that no thumbnail is available
EncryptionKeyNotValid = 37
EncryptionPolicyNotValid = 38
NoEncryptionManager = 39

Enumeration SequenceTimeCodeMode - Contains the codes for timecode modes

None = 0
Send = 1
Receive = 2

Enumeration SequenceTimeCodeStopAction - Contains the codes which determine what to do after
a SMTPE timecode stop

None = 0
Stop = 1
Pause = 2
Continue = 3

Enumeration TransportMode - Contains the codes for play/pause/stop/playloop

Stop = 0
Pause = 128
Play = 64
PlayLoop = 192

Enumeration CuePlayMode - Contains the cue types (play,pause,stop,jump,wait)

Play = 0
Pause = 1
Stop = 2
Jump = 3
Wait = 4

Structure TimeType - Is used for functions that return time information

VersionNum As Integer
Hours As Integer
Minutes As Integer
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Seconds As Integer
Frames As Integer

Structure MediaOptionsType - Contains options for media assets

anisotropicFiltering As Boolean
ignoreThumbnail As Boolean
alphaChannel As Boolean
fluidFrame As Boolean
optimizeMpegColorspace As Boolean
underscan As Boolean
optimizeLooping As Boolean
muteSound As Boolean

Structure MediaType1 - Contains information on media assets  ("MediaType" is for legacy support)

dmxId As Integer
dmxFolderId As Integer
path As Byte()
projectPath As Byte()
width As Integer
height As Integer
fps As Integer
Length As TimeType
options As MediaOptionsType

Structure LayerType - Contains site and device number of a layer

VersionNum As Integer
siteNum As Integer
deviceNum As Integer

Structure ParamResourceType1 - Contains information about a resource  ("ParamResourceType" is
for legacy support)

folderId As Integer
fileId As Integer
path As Byte()
projectPath As Byte()

TreeItemType - Contains information about a tree item

projectPath As Byte()
idPath As Byte()
type As Integer
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19.4  Function Reference

This topic lists all functions that are available in the SDK . A list with the exact parameter names can
be found here .

AutoInitialize(IpStr As String, domain As Integer)

AutoInitializeTCP(IpStr As String, domain As Integer, waitForConnection As Boolean)

AutoUnInitialize ()

AutoWaitForConnection ()

AutoStopWaitingForConnection ()

AutoGetIsConnected ()

AutoGetLastError ()

AutoSetParamDouble(siteNum As Integer, deviceNum As Integer, ParamName As String, value As
Double)

AutoSetParamDoubleExtended(siteNum As Integer, deviceNum As Integer, ParamName As String, value
As Double, silent As Boolean, direct As Boolean)

AutoSetParamInSelectionDouble(ParamName As String, value As Double)

AutoGetParam (siteNum As Integer, deviceNum As Integer, ParamName As String)

AutoSetContentAtTime (siteNum As Integer, deviceNum As Integer, seqNum As Integer, hours As
Integer, minutes As Integer, seconds As Integer, frames As Integer, dmxFolderId As Integer, dmxId As
Integer)

AutoAssignMesh(siteNum As Integer, deviceNum As Integer, dmxFolderId As Integer, dmxId As Integer)

AutoAssignMeshByName(siteNum As Integer, deviceNum As Integer, MeshName As String,
ParamName As String)

AutoAssignMeshToSelection(dmxFolderId As Integer, dmxId As Integer)

AutoAssignMedia(siteNum As Integer, deviceNum As Integer, dmxFolderId As Integer, dmxId As Integer)

AutoAssignMediaByName(siteNum As Integer, deviceNum As Integer, MediaName As String,
ParamName As String)

AutoAssignMediaToSelection(dmxFolderId As Integer, dmxId As Integer)

AutoMoveContentToFolder(ContentName As String, FolderName As String)

AutoMoveTreeItem(itemIdFrom As Integer, itemIdTo As Integer)

AutoSetSequenceTransportMode(sequenceNum As Integer, ModeName As String)

AutoMoveSequenceToCue(sequenceNum As Integer, cueId As Integer)

AutoMoveSequenceToTime(sequenceNum As Integer, hours As Integer, minutes As Integer, seconds As
Integer, frames As Integer)
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AutoMoveSequenceToLastNextFrame(sequenceNum As Integer, isNext As Boolean)

AutoMoveSequenceToLastNextCue(sequenceNum As Integer, isNext As Boolean)

AutoSetSequenceTransparency(seqNum As Integer, transparency As Integer)

AutoGetSequenceTransparency (seqNum As Integer)

AutoSetSequenceTimeCodeMode(seqNum As Integer, timeCodeMode As
Param.SequenceTimeCodeMode)

AutoSetSequenceTimeCodeOffset(seqNum As Integer, hours As Integer, minutes As Integer, seconds
As Integer, frames As Integer)

AutoSetSequenceTimeCodeStopAction(seqNum As Integer, stopAction As
Param.SequenceTimeCodeStopAction)

AutoResetAll ()

AutoResetSite(siteNum As Integer)

AutoResetDevice(siteNum As Integer, deviceNum As Integer)

AutoResetParam(siteNum As Integer, deviceNum As Integer, ParamName As String)

AutoActivateAll ()

AutoActivateSite(siteNum As Integer)

AutoActivateDevice(siteNum As Integer, deviceNum As Integer)

AutoActivateParam(siteNum As Integer, deviceNum As Integer, ParamName As String)

AutoClearAllActive ()

AutoClearActiveSite(siteNum As Integer)

AutoClearActiveDevice(siteNum As Integer, deviceNum As Integer)

AutoClearActiveParam(siteNum As Integer, deviceNum As Integer, ParamName As String)

AutoToggleFullscreen(siteNum As Integer)

AutoSetParamRelativeDouble(siteNum As Integer, deviceNum As Integer, ParamName As String, value
As Double)

AutoSetParamRelativeDoubleExtended(siteNum As Integer, deviceNum As Integer, ParamName As
String, value As Double, silent As Boolean, direct As Boolean)

AutoSetParamRelativeInSelectionDouble (ParamName As String, value As Double)

AutoAddContent(FullPath As String, siteNum As Integer, dmxFolderId As Integer, dmxId As Integer)

AutoAddContentToFolder(FullPath As String, siteNum As Integer, dmxFolderId As Integer, dmxId As
Integer, Foldername As String)

AutoAddContentToTreeItem(FullPath As String, siteNum As Integer, dmxFolderId As Integer, dmxId As
Integer, treeItemId As Integer)
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AutoAddContentFromLocalNode (FullPath As String)

AutoAddContentFromLocalNodeToFolder(FullPath As String, Foldername As String)

AutoAddContentFromLocalNodeToTreeItem(FullPath As String, treeItemId As Integer)

AutoAddContentFolder(FolderPath As String, siteNum As Integer, dmxFolderId As Integer, dmxId As
Integer, ProjectPath As String)

AutoAddContentFolderFromLocalNode(FolderPath As String)

AutoAddContentFolderFromLocalNodeToFolder(FolderPath As String, Foldername As String)

AutoAddContentFolderFromLocalNodeToTreeItem(FolderPath As String, treeItemId As Integer)

AutoRemoveMediaById(dmxFolderId As Integer, dmxId As Integer)

AutoRemoveMeshById(dmxFolderId As Integer, dmxId As Integer)

AutoRemoveContentByName(ProjectPath As String, allEquallyNamed As Boolean)

AutoRemoveTreeItem(treeItemId As Integer)

AutoRemoveAllResources(removeFolder As Boolean)

AutoSpreadAll ()

AutoSpreadMediaById(dmxFolderId As Integer, dmxId As Integer)

AutoSpreadMeshById(dmxFolderId As Integer, dmxId As Integer)

AutoReloadMediaById(dmxFolderId As Integer, dmxId As Integer)

AutoReloadMeshById(dmxFolderId As Integer, dmxId As Integer)

AutoReloadResource(ProjectPath As String)

AutoSpreadResource(ProjectPath As String)

AutoReloadAndSpreadResourceByPath(ProjectPath As String)

AutoReloadAndSpreadResourceByItemIndex(treeItemId As Integer)

AutoReloadAndSpreadResourceByDmxId(dmxfolderId As Integer, dmxId As Integer)

AutoRemoveInconsistent ()

AutoStoreActive(seqNum As Integer)

AutoStoreActiveToTime(seqNum As Integer, hours As Integer, minutes As Integer, seconds As Integer,
frames As Integer)

AutoSetMediaFrameBlendingById(dmxFolderId As Integer, dmxId As Integer, frameBlended As Boolean)

AutoSetMediaDeinterlacingById(dmxFolderId As Integer, dmxId As Integer, deinterlacer As Integer)

AutoSetMediaAnisotropicFilteringById(dmxFolderId As Integer, dmxId As Integer, useFiltering As
Boolean)
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AutoSetMediaUnderscanById(dmxFolderId As Integer, dmxId As Integer, useUnderscan As Boolean)

AutoSetMediaMpegColourSpaceById(dmxFolderId As Integer, dmxId As Integer, useMpegColourSpace
As Boolean)

AutoSetMediaAlphaChannelById(dmxFolderId As Integer, dmxId As Integer, useAlphaChannel As
Boolean)

AutoCreateTextInput(dmxFolderId As Integer, dmxId As Integer, Text As String)

AutoSetText(dmxFolderId As Integer, dmxId As Integer, Text As String)

AutoLoadProject(Path As String, Name As String, saveExisting As Boolean)

AutoCloseProject(save As Boolean)

AutoClearSelection()

AutoSetDeviceAcceptDmxById(siteNum As Integer, deviceNum As Integer, acceptDmx As Boolean)

AutoSetSiteAcceptDmxById(siteNum As Integer, acceptDmx As Boolean)

AutoSetDeviceDmxAddressById(siteNum As Integer, deviceNum As Integer, index As Integer, id1 As
Integer, id2 As Integer)

AutoSetSequenceCuePlayMode(seqNum As Integer, cueId As Integer, playMode As
Param.CuePlayMode)

AutoSetNextSequenceCuePlayMode(seqNum As Integer, playMode As Integer)

AutoSetIgnoreNextSequenceCue(seqNum As Integer, doIgnore As Boolean)

AutoChangeFullscreenStateById(siteNum As Integer, enterFullscreen As Boolean)

AutoChangeFullscreenStateByIp(Ip As String, enterFullscreen As Boolean)

AutoSetTextTextureSize(dmxFolderId As Integer, dmxId As Integer, width As Integer, height As Integer)

AutoSetTextProperties(dmxFolderId As Integer, dmxId As Integer, Font As String, size As Integer, style
As Integer, alignment As Integer, colorRed As Integer, colorGreen As Integer, colorBlue As Integer)

AutoSetTextCenterOnTexture(dmxFolderId As Integer, dmxId As Integer, centerOnTexture As Boolean)

AutoCreateTextInputWide(dmxFolderId As Integer, dmxId As Integer, Text As String)

AutoSetTextWide(dmxFolderId As Integer, dmxId As Integer, Text As String)

AutoSetSiteIpById(siteNum As Integer, Ip As String)

AutoIsLayerReallySelected(siteNum As Integer, deviceNum As Integer)

AutoGetNumMediaInProject ()

AutoGetNumTreeItemsInProject ()

AutoGetMediaInfo1(index As Integer,  MediaInfo As MediaType1)
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AutoGetMediaInfoFromTreeItem(treeItemIndex As Integer,  MediaInfo As MediaType1)

AutoGetTreeItemInfo(index As Integer,  ItemInfo As TreeItemType)

AutoGetSequenceTransportMode(seqNum As Integer)

AutoGetSequenceTime(seqNum As Integer,  Time As TimeType)

AutoGetClipRemainingTime(siteNum As Integer, deviceNum As Integer, seqNum As Integer,  Time As
TimeType)

AutoGetRemainingTimeUntilNextCue(seqNum As Integer,  Time As TimeType)

AutoGetNumSelectedLayers ()

AutoGetSelectedLayer(layerIndex As Integer,  layerInfo As LayerType)

AutoAddFolderToProject(Name As String)

AutoAddFolderToProjectPath(Name As String, FolderRoot As String)

AutoAddFolderToTreeItem(Name As String, treeItemId As Integer)

AutoRemoveFolderFromProject(FolderPath As String)

AutoSetDeviceSelection(siteNum As Integer, deviceNum As Integer, selectionMode As Integer)

AutoSetClxControllerFaderMapping(faderId As Integer, seqNum As Integer)

AutoSetClxControllerCueMapping(cueBtnId As Integer, seqNum As Integer, cueId As Integer)

AutoAddCue(seqNum As Integer, cueId As Integer, hours As Integer, minutes As Integer, seconds As
Integer, frames As Integer, Name As String, cueKindId As Param.CuePlayMode)

AutoRemoveCueById(seqNum As Integer, cueId As Integer)

AutoRemoveAllCues(seqNum As Integer)

AutoAddGraphicLayer(siteId As Integer)

AutoAddVideoLayer(siteId As Integer)

AutoRemoveGraphicLayer(siteId As Integer, layerId As Integer)

AutoRemoveVideoLayer(siteId As Integer, layerId As Integer)

AutoBackupMode(enable As Boolean)

AutoApplyView(viewNum As Integer)

AutoSetSpareFromSpread(siteId As Integer, spareFromSpread As Boolean)

AutoGetParamMedia1(siteNum As Integer, deviceNum As Integer, ParamName As String,  Info As
ParamResourceType1)

AutoGetParamObject1(siteNum As Integer, deviceNum As Integer, ParamName As String,  Info As
ParamResourceType1)
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AutoGetMediaTransportMode(siteNum As Integer, deviceNum As Integer,  TransportMode As
Param.TransportMode)

AutoIsSiteConnected (siteNum As Integer)

AutoMoveLayerUp(siteNum As Integer, deviceNum As Integer)

AutoMoveLayerDown(siteNum As Integer, deviceNum As Integer)

AutoMoveLayerToFirstPosition(siteNum As Integer, deviceNum As Integer)

AutoMoveLayerToLastPosition(siteNum As Integer, deviceNum As Integer)

AutoSetEnableClxJogShuttle(enable As Boolean)

AutoGetEnableClxJogShuttle()

AutoSetEnableClxFaderExt(enable As Boolean)

AutoGetEnableClxFaderExt()

AutoSetSequenceCueWaitTime(seqNum As Integer, cueId As Integer, hours As Integer, minutes As
Integer, seconds As Integer, frames As Integer)

AutoSetSequenceCueJumpTargetTime(seqNum As Integer, cueId As Integer, hours As Integer, minutes
As Integer, seconds As Integer, frames As Integer)

AutoSetSequenceCueJumpCount(seqNum As Integer, cueId As Integer, jumpCount As Integer)

AutoResetSequenceCueTriggerCount(seqNum As Integer, cueId As Integer)

AutoGetContentIsConsistent(dmxFolderId As Integer, dmxId As Integer)

AutoGetContentIsConsistentByName(ProjectPath As String)

AutoCreateSequence ()

AutoRemoveSequence (seqNum As Integer)

AutoSetNodeOfSiteIsAudioClockMaster(siteNum As Integer, isMaster As Boolean)

AutoGetThumbnailByPath(ProjectPath As String,  Width As Integer,  Height As Integer,  Data As
Object)

AutoGetThumbnailByItemIndex(treeItemIndex As Integer,  Width As Integer,  Height As Integer,  Data As
Object)

AutoAddEncryptionKey(Key As String)

AutoAddEncryptionPolicy(Policy As String)

AutoInitialize(IpStr As String, domain As Integer

Initializes the connection to a Pandoras Box Master System using UDP 
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IpStr: IP Address of the machine running PB-Master
domain: Domain ID

True: No error ocurred False: Error ocurred

AutoInitializeTCP(IpStr As String, domain As Integer, waitForConnection As
Boolean)

Initializes the connection to a Pandoras Box Master System using TCP 

IpStr: IP Address of the machine running PB-Master
domain: Domain ID
waitForConnection: True: start a background thread to wait for a new connection False: only try once
to connect

Success. When false is returned check AutoGetLastError()

AutoUnInitialize ()

Close any open connections 

Success. When false is returned check AutoGetLastError()

AutoWaitForConnection ()

Starts a thread that keeps trying to connect to the PB-Master 

Success. When false is returned check AutoGetLastError()

AutoStopWaitingForConnection ()

Stops the thread that keeps trying to connect to the PB-Master 

Success. When false is returned check AutoGetLastError()

AutoGetIsConnected ()

Gets the current connection state 

Success. When false is returned check AutoGetLastError()



1693

AutoGetLastError ()

Gets the code for the last error that occurred 

Error code

AutoSetParamDouble(siteNum As Integer, deviceNum As Integer,
ParamName As String, value As Double)

Set a parameter to a specific value 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )
value: The value will be interpreted 

Success. When false is returned check AutoGetLastError()

AutoSetParamDoubleExtended(siteNum As Integer, deviceNum As Integer,
ParamName As String, value As Double, silent As Boolean, direct As
Boolean)

Set a parameter to a specific value 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )
value: Value
silent: Do not mark parameter active
direct: Do not use transition smoothing

Success. When false is returned check AutoGetLastError()

AutoSetParamInSelectionDouble(ParamName As String, value As Double)

Sets the given parameter to given value for all layers in the current selection 

ParamName: Name for the parameter. (see Class Param or this parameter list )
value: The value will be interpreted

Success. When false is returned check AutoGetLastError()

AutoGetParam (siteNum As Integer, deviceNum As Integer, ParamName As
String)

Gets the value of the parameter for given site/device 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )
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Success. When false is returned check AutoGetLastError()

AutoSetContentAtTime (siteNum As Integer, deviceNum As Integer, seqNum
As Integer, hours As Integer, minutes As Integer, seconds As Integer, frames
As Integer, dmxFolderId As Integer, dmxId As Integer)

Sets the media for the container found at the given Site/Device/Sequence/Time combination. Note:
This function will neither create new containers nor will it add keys. It only works with existing
containers. 

siteNum: Target Site ID
deviceNum: Target Device ID
seqNum: Sequence ID
hours: Time (Hours)
minutes: Time (Minutes)
seconds: Time (Seconds)
frames: Time (Frames)
dmxFolderId: Media Folder ID
dmxId: Media ID

Returns true if the PB-Master received the command

AutoAssignMesh(siteNum As Integer, deviceNum As Integer, dmxFolderId As
Integer, dmxId As Integer)

Assign a Mesh to given site/device identified by DmxFolder and DmxId 

siteNum: Site ID
deviceNum: Device ID
dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoAssignMeshByName(siteNum As Integer, deviceNum As Integer,
MeshName As String, ParamName As String)

Assign a Mesh to given site/device identified by name. Also allows to assign eeshes to effects etc.
using ParamName 

siteNum: Site ID
deviceNum: Device ID
MeshName: Mesh Name
ParamName: The parameter to assign the mesh to. Use "Mesh" to assign to the device itself. (see
Class Param or this parameter list )

Success. When false is returned check AutoGetLastError()

AutoAssignMeshToSelection(dmxFolderId As Integer, dmxId As Integer)

Assign a Mesh to selected devices 
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dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoAssignMedia(siteNum As Integer, deviceNum As Integer, dmxFolderId
As Integer, dmxId As Integer)

Assign Media to given site/device identified by DmxFolder and DmxId 

siteNum: Site ID
deviceNum: Device ID
dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoAssignMediaByName(siteNum As Integer, deviceNum As Integer,
MediaName As String, ParamName As String)

Assign Media to given site/device identified by name 

siteNum: Site ID
deviceNum: Device ID
MediaName: Media Name
ParamName: Name for the parameter. (see Class Param or this parameter list )

Success. When false is returned check AutoGetLastError()

AutoAssignMediaToSelection(dmxFolderId As Integer, dmxId As Integer)

Assign Media to selected devices 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoMoveContentToFolder(ContentName As String, FolderName As String)

Moves content identified by name to given folder 

ContentName: The path+name of the content in the projects tab. ex.: Myfolder/mySubfolder/
somecontent.mpg
FolderName: Path to move to. ex.: SomeFolder/MyTargetFolder

Success. When false is returned check AutoGetLastError()

AutoMoveTreeItem(itemIdFrom As Integer, itemIdTo As Integer)

Move tree item to another tree item 
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itemIdFrom: tree item source
itemIdTo: tree item target

Success. When false is returned check AutoGetLastError()

AutoSetSequenceTransportMode(sequenceNum As Integer, ModeName As
String)

Sets the transport mode for sequence with given ID 

sequenceNum: Sequence ID
ModeName: Transport mode, case sensitive (Play/Pause/Stop)

Success. When false is returned check AutoGetLastError()

AutoMoveSequenceToCue(sequenceNum As Integer, cueId As Integer)

Moves the nowpointer to the position of the cue with given ID 

sequenceNum: Sequence ID
cueId: Cue ID

Success. When false is returned check AutoGetLastError()

AutoMoveSequenceToTime(sequenceNum As Integer, hours As Integer,
minutes As Integer, seconds As Integer, frames As Integer)

Moves the nowpointer to given time 

sequenceNum: Sequence ID
hours: Time (Hours)
minutes: Time (Minutes)
seconds: Time (Seconds)
frames: Time (Frames)

Success. When false is returned check AutoGetLastError()

AutoMoveSequenceToLastNextFrame(sequenceNum As Integer, isNext As
Boolean)

Moves to either the next/previous frame 

sequenceNum: Sequence ID
isNext: true: next frame | false: previous frame

Success. When false is returned check AutoGetLastError()

AutoMoveSequenceToLastNextCue(sequenceNum As Integer, isNext As
Boolean)

Moves to either the next/previous cue 
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sequenceNum: Sequence ID
isNext: true: next cue | false: previous cue

Success. When false is returned check AutoGetLastError()

AutoSetSequenceTransparency(seqNum As Integer, transparency As
Integer)

Sets the transparency for given sequence 

seqNum: Sequence ID
transparency: Opacity between 0 and 255

Success. When false is returned check AutoGetLastError()

AutoGetSequenceTransparency (seqNum As Integer)

Get the transparency of given sequence 

seqNum: Sequence ID

Sequence Transparency (0-255)

AutoSetSequenceTimeCodeMode(seqNum As Integer, timeCodeMode As
Param.SequenceTimeCodeMode)

Enables or disables a sequence to send/receive timecode 

seqNum: Sequence ID
timeCodeMode: The timecode mode to use

Success. When false is returned check AutoGetLastError()

AutoSetSequenceTimeCodeOffset(seqNum As Integer, hours As Integer,
minutes As Integer, seconds As Integer, frames As Integer)

Set the offset that will be added to the Pandoras Box Timecode. Negative values possible. 

seqNum: Sequence ID
hours: Time (Hours)
minutes: Time (Minutes)
seconds: Time (Seconds)
frames: Time (Frames)

Success. When false is returned check AutoGetLastError()

AutoSetSequenceTimeCodeStopAction(seqNum As Integer, stopAction As
Param.SequenceTimeCodeStopAction)

Set the behavior on timecode signal stop 
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seqNum: Sequence ID
stopAction: stop,pause or continue playback

Success. When false is returned check AutoGetLastError()

AutoResetAll ()

Reset all active values 

Success. When false is returned check AutoGetLastError()

AutoResetSite(siteNum As Integer)

Reset all active values for given site 

siteNum: Site ID

Success. When false is returned check AutoGetLastError()

AutoResetDevice(siteNum As Integer, deviceNum As Integer)

Reset all active values for given device 

siteNum: Site ID
deviceNum: Device ID

Success. When false is returned check AutoGetLastError()

AutoResetParam(siteNum As Integer, deviceNum As Integer, ParamName As
String)

Remove active value of specific parameter 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )

Success. When false is returned check AutoGetLastError()

AutoActivateAll ()

Select all parameters as active 

Success. When false is returned check AutoGetLastError()
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AutoActivateSite(siteNum As Integer)

Set all parameters of all devices of a whole site as active 

siteNum: Site ID

Success. When false is returned check AutoGetLastError()

AutoActivateDevice(siteNum As Integer, deviceNum As Integer)

Set all parameters of a specific device as active 

siteNum: Site ID
deviceNum: Device ID

Success. When false is returned check AutoGetLastError()

AutoActivateParam(siteNum As Integer, deviceNum As Integer, ParamName
As String)

Set a specific parameter as active 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )

Success. When false is returned check AutoGetLastError()

AutoClearAllActive ()

Set all active values as inactive. The values themselves are preserved. 

Success. When false is returned check AutoGetLastError()

AutoClearActiveSite(siteNum As Integer)

Set all active values of a site as inactive. The values themselves are preserved. 

siteNum: Site ID

Success. When false is returned check AutoGetLastError()

AutoClearActiveDevice(siteNum As Integer, deviceNum As Integer)

Set all active values of a specific device as inactive. The values themselves are preserved. 

siteNum: Site ID
deviceNum: Device ID
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Success. When false is returned check AutoGetLastError()

AutoClearActiveParam(siteNum As Integer, deviceNum As Integer,
ParamName As String)

Set a parameter value inactive. The values themselves are preserved. 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )

Success. When false is returned check AutoGetLastError()

AutoToggleFullscreen(siteNum As Integer)

Toggles full screen mode of a site 

siteNum: Site ID

Success. When false is returned check AutoGetLastError()

AutoSetParamRelativeDouble(siteNum As Integer, deviceNum As Integer,
ParamName As String, value As Double)

Add or subtract a value from a parameter 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )
value: Value to add, can be negative

Success. When false is returned check AutoGetLastError()

AutoSetParamRelativeDoubleExtended(siteNum As Integer, deviceNum As
Integer, ParamName As String, value As Double, silent As Boolean, direct As
Boolean)

Add or subtract a value from a parameter 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )
value: Value to add, can be negative
silent: Do not mark parameter active
direct: Do not use transition smoothing

Success. When false is returned check AutoGetLastError()
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AutoSetParamRelativeInSelectionDouble (ParamName As String, value As
Double)

Add or subtract a value from a parameter in the current selection 

ParamName: Name for the parameter. (see Class Param or this parameter list )
value: Value to add, can be negative

Success. When false is returned check AutoGetLastError()

AutoAddContent(FullPath As String, siteNum As Integer, dmxFolderId As
Integer, dmxId As Integer)

Add content from given path and assign DmxIDs 

FullPath: Absolute system path to media to add (ex. c:/coolux/content/...)
siteNum: Site ID
dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoAddContentToFolder(FullPath As String, siteNum As Integer,
dmxFolderId As Integer, dmxId As Integer, Foldername As String)

Adds content from given folder to a specific folder, also assigning DmxIDs 

FullPath: Absolute system path to media to add (ex. c:/coolux/content/...)
siteNum: Site ID
dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
Foldername: Target folder to add content to

Success. When false is returned check AutoGetLastError()

AutoAddContentToTreeItem(FullPath As String, siteNum As Integer,
dmxFolderId As Integer, dmxId As Integer, treeItemId As Integer)

Add content to a tree item 

FullPath: Absolute system path to media to add (ex. c:/coolux/content/...)
siteNum: Site ID
dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
treeItemId: Target tree item

Success. When false is returned check AutoGetLastError()

AutoAddContentFromLocalNode (FullPath As String)

Add content from local node using an absolute path 
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FullPath: Absolute system path to media to add (ex. c:/coolux/content/...)

Success. When false is returned check AutoGetLastError()

AutoAddContentFromLocalNodeToFolder(FullPath As String, Foldername As
String)

 

FullPath: Absolute system path to media to add (ex. c:/coolux/content/...)
Foldername: Target path in PB project

Success. When false is returned check AutoGetLastError()

AutoAddContentFromLocalNodeToTreeItem(FullPath As String, treeItemId
As Integer)

Add content from an absolute system path to a specific tree node 

FullPath: Absolute system path to media to add (ex. c:/coolux/content/...)
treeItemId: target tree item

Success. When false is returned check AutoGetLastError()

AutoAddContentFolder(FolderPath As String, siteNum As Integer,
dmxFolderId As Integer, dmxId As Integer, ProjectPath As String)

Add a complete folder with content to the project 

FolderPath: Path to content
siteNum: Site ID
dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
ProjectPath: Project path

Success. When false is returned check AutoGetLastError()

AutoAddContentFolderFromLocalNode(FolderPath As String)

Add a complete folder with content to the projecta 

FolderPath: Folder to add

Success. When false is returned check AutoGetLastError()

AutoAddContentFolderFromLocalNodeToFolder(FolderPath As String,
Foldername As String)

Add a complete folder with content to the project at a specific folder 
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FolderPath: Folder to add
Foldername: Target folder in project tree

Success. When false is returned check AutoGetLastError()

AutoAddContentFolderFromLocalNodeToTreeItem(FolderPath As String,
treeItemId As Integer)

Add a complete folder with content to the project to a specific TreeItem 

FolderPath: Folder to add
treeItemId: tree item to add to

Success. When false is returned check AutoGetLastError()

AutoRemoveMediaById(dmxFolderId As Integer, dmxId As Integer)

Removes Media with given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoRemoveMeshById(dmxFolderId As Integer, dmxId As Integer)

Removes Mesh with given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoRemoveContentByName(ProjectPath As String, allEquallyNamed As
Boolean)

Removes content by project path 

ProjectPath: Path to the project content
allEquallyNamed: True: Removes all contents with the same name| False: Remove only one (the first)
content with that name

Success. When false is returned check AutoGetLastError()

AutoRemoveTreeItem(treeItemId As Integer)

Remove a tree item 

treeItemId: tree item to remove

Success. When false is returned check AutoGetLastError()
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AutoRemoveAllResources(removeFolder As Boolean)

Remove all resources in specific folder 

removeFolder: True: Removes everything | False: Remove files only. Folder structure stays intact

Success. When false is returned check AutoGetLastError()

AutoSpreadAll ()

Trigger a "Spread All Resources" 

Success. When false is returned check AutoGetLastError()

AutoSpreadMediaById(dmxFolderId As Integer, dmxId As Integer)

Trigger spread for media identified by DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoSpreadMeshById(dmxFolderId As Integer, dmxId As Integer)

Trigger spread for mesh identified by DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoReloadMediaById(dmxFolderId As Integer, dmxId As Integer)

Trigger reload for media with given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoReloadMeshById(dmxFolderId As Integer, dmxId As Integer)

Trigger reload for mesh with given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()
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AutoReloadResource(ProjectPath As String)

Trigger reload for resource with given name 

ProjectPath: project path

Success. When false is returned check AutoGetLastError()

AutoSpreadResource(ProjectPath As String)

Trigger spread for resource with given name 

ProjectPath: project path

Success. When false is returned check AutoGetLastError()

AutoReloadAndSpreadResourceByPath(ProjectPath As String)

Trigger reload and spread for resource identified by path name 

ProjectPath: project path

Success. When false is returned check AutoGetLastError()

AutoReloadAndSpreadResourceByItemIndex(treeItemId As Integer)

Trigger reload and spread for resource identified by tree item index 

treeItemId: tree item id of resource

Success. When false is returned check AutoGetLastError()

AutoReloadAndSpreadResourceByDmxId(dmxfolderId As Integer, dmxId As
Integer)

Trigger reload and spread for resource identified by DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Success. When false is returned check AutoGetLastError()

AutoRemoveInconsistent ()

Remove all inconsistent files 

Success. When false is returned check AutoGetLastError()
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AutoStoreActive(seqNum As Integer)

Stores active values in given sequence at the current timecode 

seqNum: Sequence ID

Success. When false is returned check AutoGetLastError()

AutoStoreActiveToTime(seqNum As Integer, hours As Integer, minutes As
Integer, seconds As Integer, frames As Integer)

Stores active values in given sequence at given time 

seqNum: Sequence ID
hours: Time (Hours)
minutes: Time (Minutes)
seconds: Time (Seconds)
frames: Time (Frames)

Success. When false is returned check AutoGetLastError()

AutoSetMediaFrameBlendingById(dmxFolderId As Integer, dmxId As Integer,
frameBlended As Boolean)

Sets the Frame Blending for media identified by given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
frameBlended: Use fra

Success. When false is returned check AutoGetLastError()

AutoSetMediaDeinterlacingById(dmxFolderId As Integer, dmxId As Integer,
deinterlacer As Integer)

Sets the Deinterlacing for media identified by given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
deinterlacer: Use deinterlacing?

Success. When false is returned check AutoGetLastError()

AutoSetMediaAnisotropicFilteringById(dmxFolderId As Integer, dmxId As
Integer, useFiltering As Boolean)

Sets the Anisostropic Filtering for media identified by given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
useFiltering: Use Anisostrophicfiltering?
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Success. When false is returned check AutoGetLastError()

AutoSetMediaUnderscanById(dmxFolderId As Integer, dmxId As Integer,
useUnderscan As Boolean)

Sets the Underscan for media identified by given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
useUnderscan: Use underscan?

Success. When false is returned check AutoGetLastError()

AutoSetMediaMpegColourSpaceById(dmxFolderId As Integer, dmxId As
Integer, useMpegColourSpace As Boolean)

Sets wether to use mpeg color space conversion for media identified by given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
useMpegColourSpace: Use mpeg color space conversion?

Success. When false is returned check AutoGetLastError()

AutoSetMediaAlphaChannelById(dmxFolderId As Integer, dmxId As Integer,
useAlphaChannel As Boolean)

Sets the Alpha Channel usage for media identified by given DmxID 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
useAlphaChannel: Use alpha channel?

Success. When false is returned check AutoGetLastError()

AutoCreateTextInput(dmxFolderId As Integer, dmxId As Integer, Text As
String)

Creates a new text asset with given DmxIDs 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
Text: Asset text

Success. When false is returned check AutoGetLastError()

AutoSetText(dmxFolderId As Integer, dmxId As Integer, Text As String)

Sets the text for the text asset with given DmxIDs 
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dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
Text: Text

Success. When false is returned check AutoGetLastError()

AutoLoadProject(Path As String, Name As String, saveExisting As Boolean)

Loads a project from given path with given filename. 

Path: Folder name
Name: Project file name
saveExisting: Save the existing project before opening the new one?

Success. When false is returned check AutoGetLastError()

AutoCloseProject(save As Boolean)

Closes the current project 

save: Save project before close?

Success. When false is returned check AutoGetLastError()

AutoClearSelection()

Clears the device selection 

Success. When false is returned check AutoGetLastError()

AutoSetDeviceAcceptDmxById(siteNum As Integer, deviceNum As Integer,
acceptDmx As Boolean)

Set wether given device should accept Dmx values 

siteNum: Site ID
deviceNum: Device ID
acceptDmx: Accept Dmx?

Success. When false is returned check AutoGetLastError()

AutoSetSiteAcceptDmxById(siteNum As Integer, acceptDmx As Boolean)

Set wether given site should accept Dmx values 

siteNum: Site ID
acceptDmx: Accept Dmx?

Success. When false is returned check AutoGetLastError()
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AutoSetDeviceDmxAddressById(siteNum As Integer, deviceNum As Integer,
index As Integer, id1 As Integer, id2 As Integer)

Sets the Dmx address for given site/device 

siteNum: Site ID
deviceNum: Device ID
index: Channel Id
id1: Dmx Subnet
id2: Dmx Universe

Success. When false is returned check AutoGetLastError()

AutoSetSequenceCuePlayMode(seqNum As Integer, cueId As Integer,
playMode As Param.CuePlayMode)

Sets the play mode for a cue at given sequence 

seqNum: Sequence ID
cueId: Cue ID
playMode: The cue play mode

Success. When false is returned check AutoGetLastError()

AutoSetNextSequenceCuePlayMode(seqNum As Integer, playMode As
Integer)

Sets the play mode for the next cue at given sequence 

seqNum: Sequence ID
playMode: The cue play mode

Success. When false is returned check AutoGetLastError()

AutoSetIgnoreNextSequenceCue(seqNum As Integer, doIgnore As Boolean)

Sets wether to ignore the next cue in given sequence 

seqNum: Sequence ID
doIgnore: Ignore next cue?

Success. When false is returned check AutoGetLastError()

AutoSaveProject ()

Saves the current project 

Success. When false is returned check AutoGetLastError()
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AutoChangeFullscreenStateById(siteNum As Integer, enterFullscreen As
Boolean)

Change the fullscreen mode for given site identified by Id 

siteNum: Site ID
enterFullscreen: Enter fullscreen?

Success. When false is returned check AutoGetLastError()

AutoChangeFullscreenStateByIp(Ip As String, enterFullscreen As Boolean)

Change the fullscreen mode for given site identified by Ip 

Ip: IP Address
enterFullscreen: Enter fullscreen?

Success. When false is returned check AutoGetLastError()

AutoSetTextTextureSize(dmxFolderId As Integer, dmxId As Integer, width As
Integer, height As Integer)

Sets the texture size for text asset identified by DmxId 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
width: New texture width
height: New texture height

Success. When false is returned check AutoGetLastError()

AutoSetTextProperties(dmxFolderId As Integer, dmxId As Integer, Font As
String, size As Integer, style As Integer, alignment As Integer, colorRed As
Integer, colorGreen As Integer, colorBlue As Integer)

Set the style for an existing text asset 

dmxFolderId: Dmx ID (Folder)
dmxId: Dmx ID (Item)
Font: Font name
size: size in pixels
style: text style
alignment: text alignment
colorRed: Color (Red)
colorGreen: Color (Green)
colorBlue: Color (Blue)

Success. When false is returned check AutoGetLastError()
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AutoSetTextCenterOnTexture(dmxFolderId As Integer, dmxId As Integer,
centerOnTexture As Boolean)

Set the center on texture for text asset identified by DmxId 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
centerOnTexture: Center text on texture?

Success. When false is returned check AutoGetLastError()

AutoCreateTextInputWide(dmxFolderId As Integer, dmxId As Integer, Text As
String)

Creates new text asset. Adjusts width automatically. 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
Text: Text

Success. When false is returned check AutoGetLastError()

AutoSetTextWide(dmxFolderId As Integer, dmxId As Integer, Text As String)

Sets the text of a text asset and adjusts width automatically 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)
Text: Text

Success. When false is returned check AutoGetLastError()

AutoSetSiteIpById(siteNum As Integer, Ip As String)

Changes the IP address of a site. 

siteNum: Site ID
Ip: IP Address

Success. When false is returned check AutoGetLastError()

AutoIsLayerReallySelected(siteNum As Integer, deviceNum As Integer)

Check if layer is in current selection 

siteNum: Site ID
deviceNum: Device ID

Is the given layer currently selected?
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AutoGetNumMediaInProject ()

Gets the number of media in the project 

Number of media in project

AutoGetNumTreeItemsInProject ()

Gets the number of tree items in project 

Number of tree items in project

AutoGetMediaInfo1(index As Integer,  MediaInfo As MediaType1)

Gets information on media identified by index 

index: Index
MediaInfo: MediaInfo1 object to write information to

Success. When false is returned check AutoGetLastError()

AutoGetMediaInfoFromTreeItem(treeItemIndex As Integer,  MediaInfo As
MediaType1)

Gets information on media identified by index 

treeItemindex: Index
MediaInfo: MediaInfo1 object to write information to

Success. When false is returned check AutoGetLastError()

AutoGetTreeItemInfo(index As Integer,  ItemInfo As TreeItemType)

Get information on tree item identified by index 

index: Index
ItemInfo: TreeItemType object to write results to

Success. When false is returned check AutoGetLastError()

AutoGetSequenceTransportMode(seqNum As Integer)

Get the transport mode of a sequence 

seqNum: Sequence ID

Success. When false is returned check AutoGetLastError()
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AutoGetSequenceTime(seqNum As Integer,  Time As TimeType)

Get the time of a sequence 

seqNum: Sequence ID
Time: TimeType to write information to

Success. When false is returned check AutoGetLastError()

AutoGetClipRemainingTime(siteNum As Integer, deviceNum As Integer,
seqNum As Integer,  Time As TimeType)

Get the remaining time for a clip on a specific layer for given sequence 

siteNum: Site ID
deviceNum: Device ID
seqNum: Sequence ID
Time: TimeType to write information to

Success. When false is returned check AutoGetLastError()

AutoGetRemainingTimeUntilNextCue(seqNum As Integer,  Time As
TimeType)

Get remaining time until the next cue for given sequence 

seqNum: Sequence ID
Time: TimeType to write information to

Success. When false is returned check AutoGetLastError()

AutoGetNumSelectedLayers ()

Get the number of selected layers 

Number of selected layers

AutoGetSelectedLayer(layerIndex As Integer,  layerInfo As LayerType)

Get the selected layer with given number in selection. 

layerIndex: Index of the layer in selection. Values between 0 and (AutoGetNumSelectedLayers - 1)
layerInfo: LayerType object to write results to

Success. When false is returned check AutoGetLastError()

AutoAddFolderToProject(Name As String)

Create a new folder 
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Name: Name for the new folder

Success. When false is returned check AutoGetLastError()

AutoAddFolderToProjectPath(Name As String, FolderRoot As String)

Create new folder in given path 

Name: Name for the new folder
FolderRoot: Path to create folder in

Success. When false is returned check AutoGetLastError()

AutoAddFolderToTreeItem(Name As String, treeItemId As Integer)

Create new folder in given tree item 

Name: Name for the new folder
treeItemId: Tree item to create folder in

Success. When false is returned check AutoGetLastError()

AutoRemoveFolderFromProject(FolderPath As String)

Remove a folder from the project 

FolderPath: Folder with path

Success. When false is returned check AutoGetLastError()

AutoSetDeviceSelection(siteNum As Integer, deviceNum As Integer,
selectionMode As Integer)

Select / Deselect a device 

siteNum: Site ID
deviceNum: Device ID
selectionMode: True: Selected| False: Not selected

Success. When false is returned check AutoGetLastError()

AutoSetClxControllerFaderMapping(faderId As Integer, seqNum As Integer)

Map a coolux controller fader to a sequence 

faderId: Fader ID
seqNum: Sequence ID

Success. When false is returned check AutoGetLastError()
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AutoSetClxControllerCueMapping(cueBtnId As Integer, seqNum As Integer,
cueId As Integer)

Map a coolux controller button to a cue 

cueBtnId: Button ID
seqNum: Sequence ID
cueId: Cue ID

Success. When false is returned check AutoGetLastError()

AutoAddCue(seqNum As Integer, cueId As Integer, hours As Integer, minutes
As Integer, seconds As Integer, frames As Integer, Name As String, cueKindId
As Param.CuePlayMode)

Add cue to given sequence at given time 

seqNum: Sequence ID
cueId: Cue ID
hours: Time (Hours)
minutes: Time (Minutes)
seconds: Time (Seconds)
frames: Time (Frames)
Name: Cue name
cueKindId: Kind of cue

Success. When false is returned check AutoGetLastError()

AutoRemoveCueById(seqNum As Integer, cueId As Integer)

Remove cue with given ID on given sequence 

seqNum: Sequence ID
cueId: Cue ID

Success. When false is returned check AutoGetLastError()

AutoRemoveAllCues(seqNum As Integer)

Remove all cues for a sequence 

seqNum: Sequence ID

Success. When false is returned check AutoGetLastError()

AutoAddGraphicLayer(siteId As Integer)

Add new graphic layer 

siteId: Site ID

Success. When false is returned check AutoGetLastError()
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AutoAddVideoLayer(siteId As Integer)

Add new video layer 

siteId: Site ID

Success. When false is returned check AutoGetLastError()

AutoRemoveGraphicLayer(siteId As Integer, layerId As Integer)

Remove a graphic layer by id 

siteId: Site ID
layerId: Layer ID

Success. When false is returned check AutoGetLastError()

AutoRemoveVideoLayer(siteId As Integer, layerId As Integer)

Remove a video layer by id 

siteId: Site ID
layerId: Layer ID

Success. When false is returned check AutoGetLastError()

AutoBackupMode(enable As Boolean)

Enables/Disables the backup mode 

enable: Enable backup mode?

Success. When false is returned check AutoGetLastError()

AutoApplyView(viewNum As Integer)

Applies view identified by given number 

viewNum: The view number

Success. When false is returned check AutoGetLastError()

AutoSetSpareFromSpread(siteId As Integer, spareFromSpread As Boolean)

Set the spare from spread option 

siteId: Site ID
spareFromSpread: True: Do not spread resources to this site | False: Spreading resources possible

Success. When false is returned check AutoGetLastError()
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AutoGetParamMedia1(siteNum As Integer, deviceNum As Integer,
ParamName As String,  Info As ParamResourceType1)

Get resource information of a device 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )
Info: ResourceType1 object to write information to

Success. When false is returned check AutoGetLastError()

AutoGetParamObject1(siteNum As Integer, deviceNum As Integer,
ParamName As String,  Info As ParamResourceType1)

Get information of a specific parameter 

siteNum: Site ID
deviceNum: Device ID
ParamName: Name for the parameter. (see Class Param or this parameter list )
Info: ParamResourceType1 object to write information to

Success. When false is returned check AutoGetLastError()

AutoGetMediaTransportMode(siteNum As Integer, deviceNum As Integer, 
TransportMode As TransportMode)

Checks wether given site is connected 

siteNum: Site ID
deviceNum: Device ID
TransportMode: TransportMode object to write the result to

Success. When false is returned check AutoGetLastError()

AutoIsSiteConnected (siteNum As Integer)

Checks wether given site is connected 

siteNum: Site ID

Success. When false is returned check AutoGetLastError()

AutoMoveLayerUp(siteNum As Integer, deviceNum As Integer)

Move given layer up by one in the device tree 

siteNum: Site ID
deviceNum: Device ID

Success. When false is returned check AutoGetLastError()

1312

1312
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AutoMoveLayerDown(siteNum As Integer, deviceNum As Integer)

Move given layer down by one in the device tree 

siteNum: Site ID
deviceNum: Device ID

Success. When false is returned check AutoGetLastError()

AutoMoveLayerToFirstPosition(siteNum As Integer, deviceNum As Integer)

Move given layer to the first position in the device tree 

siteNum: Site ID
deviceNum: Device ID

Success. When false is returned check AutoGetLastError()

AutoMoveLayerToLastPosition(siteNum As Integer, deviceNum As Integer)

Move given layer to the last position in the device tree 

siteNum: Site ID
deviceNum: Device ID

Success. When false is returned check AutoGetLastError()

AutoSetEnableClxJogShuttle(enable As Boolean)

Enable/Disable the JogShuttle 

enable: Enable?

Success. When false is returned check AutoGetLastError()

AutoGetEnableClxJogShuttle()

Get wether the JogShuttle is enabled 

JogShuttle enabled?

AutoSetEnableClxFaderExt(enable As Boolean)

Enable/Disable the FaderExtention 

enable: Enable?

Success. When false is returned check AutoGetLastError()
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AutoGetEnableClxFaderExt()

Gets wether the FaderExtention is enabled 

FaderExtention enabled?

AutoSetSequenceCueWaitTime(seqNum As Integer, cueId As Integer, hours
As Integer, minutes As Integer, seconds As Integer, frames As Integer)

Set the wait time for given cue 

seqNum: Sequence ID
cueId: Cue ID
hours: Time (Hours)
minutes: Time (Minutes)
seconds: Time (Seconds)
frames: Time (Frames)

Success. When false is returned check AutoGetLastError()

AutoSetSequenceCueJumpTargetTime(seqNum As Integer, cueId As Integer,
hours As Integer, minutes As Integer, seconds As Integer, frames As Integer)

Set the jump target for given cue 

seqNum: Sequence ID
cueId: Cue ID
hours: Time (Hours)
minutes: Time (Minutes)
seconds: Time (Seconds)
frames: Time (Frames)

Success. When false is returned check AutoGetLastError()

AutoSetSequenceCueJumpCount(seqNum As Integer, cueId As Integer,
jumpCount As Integer)

Set the jump count for given cue 

seqNum: Sequence ID
cueId: Cue ID
jumpCount: Number of jumps

Success. When false is returned check AutoGetLastError()

AutoResetSequenceCueTriggerCount(seqNum As Integer, cueId As Integer)

Reset the trigger count for given cue 
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seqNum: Sequence ID
cueId: Cue ID

Success. When false is returned check AutoGetLastError()

AutoGetContentIsConsistent(dmxFolderId As Integer, dmxId As Integer)

Get wether given content is consistent 

dmxFolderId: DmxID (Folder)
dmxId: DmxID (Item)

Is content consistent?

AutoGetContentIsConsistentByName(ProjectPath As String)

Get wether content identified by name is consistent 

ProjectPath: Path to project item

Is content consistent?

AutoCreateSequence ()

Create a new sequence 

Sequence ID

AutoRemoveSequence (seqNum As Integer)

Remove sequence 

seqNum: Sequence ID

Success. When false is returned check AutoGetLastError()

AutoSetShowCursorInFullscreen(siteNum As Integer, showCursor As
Boolean)

Enable/Disable cursor in fullscreen 

siteNum: Site ID
showCursor: Show cursor?

Success. When false is returned check AutoGetLastError()
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AutoSetNodeOfSiteIsAudioClockMaster(siteNum As Integer, isMaster As
Boolean)

Set site as audio clock Master 

siteNum: Site ID
isMaster: Is site Master?

Success. When false is returned check AutoGetLastError()

AutoGetThumbnailByPath(ProjectPath As String,  Width As Integer,  Height
As Integer,  Data As Object)

Get thumbnail for given path 

ProjectPath: Path to project item
Width: Integer to write width to
Height: Integer to write height to
Data: Image Data

Success. When false is returned check AutoGetLastError()

AutoGetThumbnailByItemIndex(treeItemIndex As Integer,  Width As Integer, 
Height As Integer,  Data As Object)

Get thumbnail for given item index 

treeItemIndex: Item index
Width: Integer to write width to
Height: Integer to write height to
Data: Image Data

Success. When false is returned check AutoGetLastError()

AutoAddEncryptionKey(Key As String)

Add encryption key 

Key: The encrption key

Success. When false is returned check AutoGetLastError()

AutoAddEncryptionPolicy(Policy As String)

Add encryption policy 

Policy: The encryption policy

Success. When false is returned check AutoGetLastError()
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AutoSetRouteInputToLayer(ByVal siteNum As Integer</text></para>  ByVal
enable As Boolean</text></para>  )

Sets input routing for given layer 

AutoSetRouteInputToWidgetDesigner(ByVal siteNum As Integer</text></
para>  ByVal enable As Boolean</text></para>  )

Sets input routing to the Widget Designer

AutoEnableOutputForPicking(ByVal siteNum As Integer</text></
para>  ByVal outputNum As Integer</text></para>  ByVal enable As
Boolean</text></para>  )

Enable/Disable Output for layer picking feature

AutoSetASIOMasterVolume(ByVal siteNum As Integer</text></para>  ByVal
value As Double</text></para>  )

Sets the ASIO master volume

AutoSetRouteInputToLayer(ByVal siteNum As Integer,ByVal enable As
Boolean)

Sets input routing for given layer 

AutoSetRouteInputToWidgetDesigner(ByVal siteNum As Integer,ByVal
enable As Boolean)

Sets input routing to the Widget Designer

AutoEnableOutputForPicking(ByVal siteNum As Integer,ByVal outputNum As
Integer,ByVal enable As Boolean)

Enable/Disable Output for layer picking feature

AutoSetASIOMasterVolume(ByVal siteNum As Integer,ByVal value As
Double)

Sets the ASIO master volume

AutoCreatePlaylist(ByVal setDmxIds As Boolean,ByVal newDmxFolderId As
Integer,ByVal newDmxId As Integer)

Creates a new Playlist
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AutoCreatePlaylistByPath(ByRef PlaylistFolderPath As String
PlaylistFolderPath,ByVal setDmxIds As Boolean,ByVal newDmxFolderId As
Integer,ByVal newDmxId As Integer)

Creates a new Playlist in given path

AutoCreatePlaylistByItemId(ByVal playlistFolderItemId As Integer,ByVal
setDmxIds As Boolean,ByVal newDmxFolderId As Integer,ByVal newDmxId
As Integer)

Creates a new Playlist by given item id

AutoCreatePlaylistFromFolderByPath(ByRef PlaylistFolderPath As String
PlaylistFolderPath,ByRef ResourceFolderPath As String
ResourceFolderPath,ByVal setDmxIds As Boolean,ByVal newDmxFolderId
As Integer,ByVal newDmxId As Integer)

Creates a new playlist from files in given folder

AutoCreatePlaylistFromFolderByItemId(ByVal playlistFolderItemId As
Integer,ByVal resourceFolderItemId As Integer,ByVal setDmxIds As
Boolean,ByVal newDmxFolderId As Integer,ByVal newDmxId As Integer)

Creates a new playlist from files in given folder

AutoPushBackPlaylistEntryByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal resourceDmxFolderId As
Integer,ByVal resourceDmxId As Integer)

Pushes back Playlist entry by given dmx id

AutoPushBackPlaylistEntryByPath(ByRef PlaylistPath As String
PlaylistPath,ByRef ResourcePath As String ResourcePath)

Pushes back Playlist entry by given path

AutoPushBackPlaylistEntryByItemId(ByVal playlistItemId As Integer,ByVal
resourceItemId As Integer)

Pushes back Playlist entry by given item id

AutoInsertPlaylistEntryByDmxId(ByVal playlistDmxFolderId As Integer,ByVal
playlistDmxId As Integer,ByVal resourceDmxFolderId As Integer,ByVal
resourceDmxId As Integer,ByVal index As Integer)

Inserts new Playlist entry by dmx id
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AutoInsertPlaylistEntryByPath(ByRef PlaylistPath As String
PlaylistPath,ByRef ResourcePath As String ResourcePath,ByVal index As
Integer)

Inserts Playlist entry by path

AutoInsertPlaylistEntryByItemId(ByVal playlistItemId As Integer,ByVal
resourceItemId As Integer,ByVal index As Integer)

Inserts playlist entry by item id

AutoRemovePlaylistEntryByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal index As Integer)

Removes Playlist entry by dmx id

AutoRemovePlaylistEntryByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer)

Removes Playlist entry by path

AutoRemovePlaylistEntryByItemId(ByVal playlistItemId As Integer,ByVal
index As Integer)

Removes Playlist entry by item id

AutoGetPlaylistSizeByDmxId(ByVal playlistDmxFolderId As Integer,ByVal
playlistDmxId As Integer)

Gets the number of items in Playlist

AutoGetPlaylistSizeByPath(ByRef PlaylistPath As String PlaylistPath)

Gets the number of items in Playlist

AutoGetPlaylistSizeByItemId(ByVal playlistItemId As Integer)

Gets the number of items in Playlist

AutoGetPlaylistEntryByDmxId(ByVal playlistDmxFolderId As Integer,ByVal
playlistDmxId As Integer,ByVal entryIndex As Integer,ByVal
pPlaylistEntryInfo As PlayListEntry)

Gets the Playlist entry of given Playlist at given position
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AutoGetPlaylistEntryByPath(ByRef PlaylistPath As String PlaylistPath,ByVal
entryIndex As Integer,ByVal pPlaylistEntryInfo As PlayListEntry)

Gets the Playlist entry of given Playlist at given position

AutoGetPlaylistEntryByItemId(ByVal playlistItemId As Integer,ByVal
entryIndex As Integer,ByVal pPlaylistEntryInfo As PlayListEntry)

Gets the Playlist entry of given Playlist at given position

AutoGetPlaylistEntryIndicesByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal pData() As Byte,ByRef pSize As
Integer)

Not yet documented.

AutoGetPlaylistEntryIndicesByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal pData() As Byte,ByRef pSize As Integer)

Not yet documented.

AutoGetPlaylistEntryIndicesByItemId(ByVal playlistItemId As Integer,ByVal
pData() As Byte,ByRef pSize As Integer)

Not yet documented.

AutoSetPlayListEntryIndexByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal index As Integer,ByVal
newIndex As Integer)

Sets Playlist entry by dmx id

AutoSetPlayListEntryIndexByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer,ByVal newIndex As Integer)

Sets Playlist entry by path

AutoSetPlayListEntryIndexByItemId(ByVal playlistItemId As Integer,ByVal
index As Integer,ByVal newIndex As Integer)

Sets Playlist entry by item id
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AutoSetPlayListEntryDurationByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal index As Integer,ByVal hours
As Integer,ByVal minutes As Integer,ByVal seconds As Integer,ByVal frames
As Integer)

Sets the duration of given Playlist item

AutoSetPlayListEntryDurationByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer,ByVal hours As Integer,ByVal minutes As
Integer,ByVal seconds As Integer,ByVal frames As Integer)

Sets the duration of given Playlist item

AutoSetPlayListEntryDurationByItemId(ByVal playlistItemId As Integer,ByVal
index As Integer,ByVal hours As Integer,ByVal minutes As Integer,ByVal
seconds As Integer,ByVal frames As Integer)

Sets the duration of given Playlist item

AutoSetPlayListEntryFadeOutTimeByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal index As Integer,ByVal hours
As Integer,ByVal minutes As Integer,ByVal seconds As Integer,ByVal frames
As Integer)

Sets the fade out duration of given Playlist item

AutoSetPlayListEntryFadeOutTimeByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer,ByVal hours As Integer,ByVal minutes As
Integer,ByVal seconds As Integer,ByVal frames As Integer)

Sets the fade out duration of given Playlist item

AutoSetPlayListEntryFadeOutTimeByItemId(ByVal playlistItemId As
Integer,ByVal index As Integer,ByVal hours As Integer,ByVal minutes As
Integer,ByVal seconds As Integer,ByVal frames As Integer)

Sets the fade out duration of given Playlist item

AutoSetPlayListEntryInPointByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal index As Integer,ByVal hours
As Integer,ByVal minutes As Integer,ByVal seconds As Integer,ByVal frames
As Integer)

Sets the entry's inpoint
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AutoSetPlayListEntryInPointByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer,ByVal hours As Integer,ByVal minutes As
Integer,ByVal seconds As Integer,ByVal frames As Integer)

Sets the entry's inpoint

AutoSetPlayListEntryInPointByItemId(ByVal playlistItemId As Integer,ByVal
index As Integer,ByVal hours As Integer,ByVal minutes As Integer,ByVal
seconds As Integer,ByVal frames As Integer)

Sets the entry's inpoint

AutoSetPlayListEntryOutPointByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal index As Integer,ByVal hours
As Integer,ByVal minutes As Integer,ByVal seconds As Integer,ByVal frames
As Integer)

Sets the entry's outpoint

AutoSetPlayListEntryOutPointByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer,ByVal hours As Integer,ByVal minutes As
Integer,ByVal seconds As Integer,ByVal frames As Integer)

Sets the entry's outpoint

AutoSetPlayListEntryOutPointByItemId(ByVal playlistItemId As Integer,ByVal
index As Integer,ByVal hours As Integer,ByVal minutes As Integer,ByVal
seconds As Integer,ByVal frames As Integer)

Sets the entry's outpoint

AutoSetPlayListEntryTransitionByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal fadeFxId As Integer)

Sets the entry's transition

AutoSetPlayListEntryTransitionByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer,ByVal fadeFxId As Integer)

Sets the entry's transition

AutoSetPlayListEntryTransitionByItemId(ByVal playlistItemId As
Integer,ByVal index As Integer,ByVal fadeFxId As Integer)

Sets the entry's transition
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AutoSetPlayListEntryNoteByDmxId(ByVal playlistDmxFolderId As
Integer,ByVal playlistDmxId As Integer,ByVal index As Integer,ByRef Note As
String Note)

Sets the entry's note

AutoSetPlayListEntryNoteByPath(ByRef PlaylistPath As String
PlaylistPath,ByVal index As Integer,ByRef Note As String Note)

Sets the entry's note

AutoSetPlayListEntryNoteByItemId(ByVal playlistItemId As Integer,ByVal
index As Integer,ByRef Note As String Note)

Sets the entry's note

AutoRecordLiveInputById(ByVal folderID As Integer,ByVal fileID As
Integer,ByRef Filename As String Filename,ByRef EncodingPreset As String
EncodingPreset,ByVal durationHour As Integer,ByVal durationMin As
Integer,ByVal durationSec As Integer,ByVal durationFrames As Integer)

Records live input with given id

AutoRecordLiveInputByIdStart(ByVal folderID As Integer,ByVal fileID As
Integer,ByRef Filename As String Filename,ByRef EncodingPreset As String
EncodingPreset)

Starts recording live input with given id

AutoRecordLiveInputStop()

Stops recording live input

AutoRecordLiveInputByName(ByRef LiveInput As String LiveInput,ByRef
Filename As String Filename,ByRef EncodingPreset As String
EncodingPreset,ByVal durationHour As Integer,ByVal durationMin As
Integer,ByVal durationSec As Integer,ByVal durationFrames As Integer)

Records live input with given name

AutoRecordLiveInputByNameStart(ByRef LiveInput As String
LiveInput,ByRef Filename As String Filename,ByRef EncodingPreset As
String EncodingPreset)

Starts recording live input with given name
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AutoExportVideo(ByRef Filename As String Filename,ByRef EncodingPreset
As String EncodingPreset,ByVal seqNum As Integer,ByVal startHour As
Integer,ByVal startMinute As Integer,ByVal startSec As Integer,ByVal
startFrame As Integer,ByVal endHour As Integer,ByVal endMinute As
Integer,ByVal endSec As Integer,ByVal endFrame As Integer)

Exports video with given parameters

AutoEncodeFileByName(ByRef Filename As String Filename,ByRef Preset
As String Preset)

Encodes file by name

AutoEncodeFileById(ByVal folderID As Integer,ByVal fileID As Integer,ByRef
Preset As String Preset)

Encodes file by id

AutoEncodeFileToTargetByName(ByRef Filename As String Filename,ByRef
TargetPath As String TargetPath,ByVal overwriteExisting As Boolean,ByRef
Preset As String Preset)

Encodes file to target by name 

AutoEncodeFileToTargetById(ByVal folderID As Integer,ByVal fileID As
Integer,ByRef TargetPath As String TargetPath,ByVal overwriteExisting As
Boolean,ByRef Preset As String Preset)

Encodes file to target by id
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20  Third Party Software

This chapter describes shortly how to use gmax, 3ds Max and Blender when working with 3D models.
These third party applications allow creating 3D objects that can be used in the Warper or in Pandoras
Box. If you are using a different 3D program please have a look at the end of this topic.

File formats supported by Pandoras Box and the Warper

Objects for Pandoras Box Servers and Players are stored as .x-file format. This format is a DirectX file
format that can be exported with most 3D applications such as 3ds Max, Maya and Cinema4D among
many others. A separate export plugin might be required for your specific application in order to export to
.x directly.
The Warper is not only restricted to x files, but accepts 3ds files and others as well. (read more... )

gmax, 3ds Max and Blender

This topic focuses on three programs. It is only a brief introduction into 3D modeling, more
documentation and tutorials might be found using various internet sources.
The 3D web resource page for 3D models www.turbosquid.com offers a light version of 3ds Max for
personal use that is called gmax. gmax unlike 3ds Max will allow you to learn the most basic modeling
and texturing concepts of 3D objects and exporting to .x files with a 3rd party exporter.
The last program mentioned in this topic is the free and open-source 3D application Blender.

- Object Creation with gmax
- Exporting Objects from 3ds Max
- Object Creation with Blender

The chapter covering the Warper  might be of interest as well. 

Basic information you need to know when creating objects for Pandoras Box and the
Warper

The chapter covering the Warper  includes common 3D modeling term definitions  that are quite
useful. For example it includes explanations of the coordinate system used in Pandoras Box and the
Warper as well as what units they are based on. UV Mapping is described too. This is a brief summary,
as well of interest for those who use other programs than the ones described here:

First of all, Pandoras Box' 3D space is based on a left-handed system. The units
used are generic units defining that a screen's width is always 16 generic units. The
camera's default position is (X,Y,Z) = (0,0,-25). The FOV is set to 35,489 degree (or
56,251 mm). If a planar object is positioned at (0,0,0) and is 16 generic units wide,
it fills exactly the fullscreen size. The height is calculated by the display's aspect
ratio. For example, if working with an output set to 1920x1080px, the planar object
should have a size of 16x9 units, if working with an output set to 1024x768px, the
planar object should have a size of 16x12 units.

When exporting objects, make sure a UVW mapping is applied.

For gmax, coolux has created Native Files that consist of different planes (for different aspect ratios) and
a camera. Again, If you would export the planar object as it is to an .x File and load it into Pandoras
Box, the shape of a layer would not change, since this plane is a reference file to match the fullscreen
scaling of a layer object. The camera helps us with a fixed view to see the boundaries of our output and
allows us to create shapes that cross the boundaries.
When you use the files for warping, please make sure to always work within the camera view when
shaping the grid. You may use the front view to work outside of the screen boundaries, but the camera
view is a static reference for Pandoras Box.
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If you have already started with your object in gmax and want to know how it would in Pandoras Box with
the default settings applied, simply adjust the gmax camera in the above described way.

If using 3ds Max or Blender you can easily create this setup yourself.

20.1  gmax

As explained in the introducing chapter , gmax is a freeware 3D modeling program for personal use
that allows you to do create 3D objects and to export them as .x files (with a 3rd party exporter) in order
to use them in the Warper or in Pandoras Box.

Gmax Software Setup
Overview object creation and export with Gmax
Screen warping with Gmax
Keyboard Shortcuts

20.1.1  Software Setup

You may download gmax from the web resource page for 3D models www.turbosquid.com.

coolux has programmed some additional files that can be downloaded from the Download-Center on the
coolux website in order to improve the object creation and warping workflow. These files include:
- changes in the user interface that allow going into real fullscreen without any borders
- a default file including planes that stand for fullscreen objects with different aspect ratios as well as a
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camera with correct position and lens settings
- an exporter plugin to be able to save an object as a *.x file

After installing gmax, you may either download these files separately from the Download-Center and
copy them into the according plugins,ui and scenes folder or simply run the gmax_installer that contains
all needed files and copies them to the correct directory automatically. Please read the following topics
for more detailed information.

Once gmax is installed and the plugin files are added to gmax, you may start the application. If you start
gmax for the first time, you will be asked for your registration key that you can obtain by registering at 
www.turbosquid.com. Once the key is entered, the application will ask, which 3D graphics hardware
acceleration to choose for gmax. Choose "HEIDI" and "Software Z Buffer".

The next chapter will give an overview about object creation and export .

20.1.2  Object Creation and Export Using gmax

When creating a 3D object in gmax for Pandoras Box, it is helpful to use one of the PB Native Files.
When exporting the Native File straight forward and importing it in Pandoras Box, it will fit exactly the
fullscreen area as it is based on the coordinate system and camera settings used in Pandoras Box.
Please make yourself familiar with the basics described in the introducing chapter .

There are different Native Files, which one you need depends on two facts:
1) Do you create the object for Pandoras Box version 4.1 or version 4.5 and higher?
From Pandoras Box version 4.5 on the 3D perspective has been adjusted to match any output aspect
ratio. For this reason 3D objects created for PB version 4.1 won´t exactly match when being used with
PB version 4.5.

2) Do you want to use the (recommended) PB Exporter or the gmax Internal Aircraft Flightsim Exporter?
Generally, an exporter converts the gmax object to an *.x file to be imported in Pandoras Box. The
exporters have different ways to convert units, thus the original file must have a different size.

The following table explains which Native File is needed and includes download links for the coolux'
Download-Center.

PB Version Exporter Name of correct native file Aspect Ratio

4.1 gmax International Flightsim
Aircraft Exporter

PB Native 4to3 Scale 4:3

PB Native 16to9 Scale 16:9

4.5 and higher PB Native v4.5 4:3, 16:9, 16:10, 5:4
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PB Exporter
(included in gmax_installer)

PB Native v4.5 PB Exporter 4:3, 16:9, 16:10, 5:4

The different native files can be downloaded separately from the Download-Center to be copied into the
"scenes" subfolder in the gmax installation folder. The files for the gmax International Flightsim Aircraft
Exporter have to be copied to the "plugins" folder.
Alternatively, you may run the gmax_installer that contains the following files which are copied to the
correct directory automatically:
- both exporters, the gmax International Flightsim Aircraft Exporter and the PB Exporter
- files that are needed to be able to go into real fullscreen
- the "PB Native v4.5 PB Exporter" file

See here further explanations for
- General object creation with Gmax : a tutorial showing the basic steps through a simple object
creation and mapping process
- Object creation and export for PB Vers. 4.1 : shows how to export an object for PB version 4.1
- Object creation and export up from PB Vers. 4.5. : shows two ways how to export an object for PB
version 4.5

- Warping with gmax : a tutorial showing more advanced steps in gmax and how to warp
- gmax keyboard shortcuts

20.1.2.1  General Object Creation in gmax

The following tutorial will show you the basic steps through a simple object creation and mapping
process.  Furthermore it explains the pattern to export to an x-file from gmax. This topic assumes that
you are familiar with the basics described in the introducing chapter .

All most important features to start with are outlined in red.

Creating a box object and applying a texture

1. Click on Box in the create tab.
2. Draw the Box with the mouse in the front view (upper right viewport), by left clicking and holding the
mouse to define the front face size. Once the mouse left click is released, you can continue moving the
mouse up and down to determine the depth of the box.
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Once the box is created, you will need to assign the texture coordinates to the object in order to define
how the texture should be displayed on the surfaces of the box.

Therefore go to the Modify tab while the object is still selected (object is outlined white while selected)
and apply a "UVW MAP" modifier from the pull down list to the object.

Once the "UVW MAP" modifier is applied to the object, you will see an orange outline that shows you
how the texture is projected on the object.  



1735

The last setup before exporting the file as .x you will have to apply a material with a diffuse channel to
the object so that Pandoras Box can use this texture channel to map images on it. To create a new
material click on the Material icon or use the keyboard shortcut "M" to open the Material Editor.



1736

1. Create a new material
2. Toggle checked box to show texture in shaded viewport
3. Click on square box of the Diffuse channel

Choose bitmap from the dialog to assign a bitmap to the diffuse texture channel.

Next choose a bitmap from the opening file browser.

Now apply the material to the selected object by clicking "Apply" and you should be able to preview your
mapping in the perspective viewport of gmax right away. If you do not see the texture in the viewport, the
object was either not selected, the checked box not toggled or none of your views is in shaded preview
(F3).
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Exporting an object

Before exporting the object for Pandoras Box you will have to make sure that it's placed correctly, since
the 0,0,0 is relevant for the pivot point of an object once this is used in Pandoras Box.

To place the object right in the center, use the move tool from the main toolbar in gmax.

As last step you have to export your file as .x-file, for further information please see:
- Gmax Object Export for PB Vers. 4.1  or 
- Gmax Object Export for PB Vers. 4.5 .

20.1.2.2  Object Creation and Export for PB Version 4.1

As explained in the introducing chapter  the Native File "PB Native 4to3 Scale" and the "gmax
International Flightsim Aircraft Exporter" are needed. You may download the files separately and copy
them to the "scenes" and "plugins" subfolder in the gmax installation folder. Alternatively, you may run
the gmax_installer that contains all needed files and copies them to the correct directory automatically.
Please restart gmax after copying the plugin files. If running the fullscreen edition all commands are
accessible within the context menu, please right-click into one of the four viewports to open it. Choose
"File" > "Open" to load a file.
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PB Native 4to3 Scale contains a flat planar object and a camera. If you would export the planar object as
it is to an .x File and load it into Pandoras Box, the shape of a layer would not change since this plane
is a reference file to match the full screen scaling of a layer object. 

The camera helps us with a fixed view to see the boundaries of our output and allows us to create
shapes that cross the boundaries. Please make sure to always work within the camera view when
shaping the grid. You may use the front view to work outside of the screen boundaries, but the camera
view is a static reference for Pandoras Box.

If you finished editing your object, you have to export it.

Exporting an object for PB version 4.1 using the Flightsim Aircraft Exporter

To export the object, make sure it is selected by clicking on it and then choose from the file menu
“export selected”. Export selected as "Flightsim Aircraft Object (*.MDL)".

Since the Flightsimulator uses different units a message box will pop up, simply click "OK" to continue.

In the next dialog that opens go to Options and check "xfile" and "no compile" and click on "GO".

You might save the options so that you don´t have to check this at every export by clicking "Save as
Default".

The object is now properly exported as .x file and can be loaded into Pandoras Box.

20.1.2.3  Object Creation and Export for PB Version 4.5

As explained in the introducing chapter  you have two opportunities to export your 3D object for
Pandoras Box version 4.5 (or higher). You may use the following exporters:
- the Flightsim Aircraft Exporter  or 
- the Pandoras Box Exporter Script .

The difference between these two exporters is their handling of unit conversion. Via the flightsimulator
plugin the scalings are always transformed to an inch based measuring system, the PB Exporter script
transforms the units 1:1. Both exporters will give you the same result, but you have to use different PB
Native Setup files, which gives you reference to the camera settings inside Pandoras Box.

The flightsimulator plugin can be downloaded separately and be copied to the "plugins" subfolder in the
gmax installation folder. Alternatively, you may run the gmax_installer that contains both exporters and
other files needed and copies them to the correct directory automatically.
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Please restart gmax after copying the plugin files.

20.1.2.3.1  Export Using Flightsim Aircraft Exporter Plugin

As explained in the introducing chapter , when exporting with the "gmax International Flightsim
Aircraft Exporter" for Pandoras Box version 4.5 and higher, the Native File "PB Native v4.5" is needed.
Please run the gmax_installer that contains all needed files and copies them to the correct directory
automatically or download the files separately before starting gmax. 

If running the fullscreen edition all commands are accessible within the context menu, please right-click
into one of the four viewports to open it. Choose "File" > "Open" to load a file.

The PB Native 4.5 Setup File contains several items: 
- four flat planar objects with different aspect ratios: 4:3 (visible) and 16:9, 16:10, 5:4 (hidden)
- a camera.

If you would export the 4:3 planar plane as it is to an .x File and load it into Pandoras Box, the shape of
a layer would not change since this plane is a reference file to match the full screen scaling of a layer
object. 

If you need another aspect ratio you want to fit your layer or camera to, like 16:9, 16:10 or 5:4, please do
a right-click on the plane to open the context menu and choose Hide > Unhide All.
Then, via the Select by Name-Tool (found in the toolbar) you can choose another aspect ratio and
confirm with clicking the "Select" Button. Open the context menu again by right-clicking and this time,
choose Hide > Hide Unselected.
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The camera helps us with a fixed view to see the boundaries of our output and allows us to create
shapes that cross the boundaries. Please make sure to always work within the camera view when
shaping the grid. You may use the front view to work outside of the screen boundaries, but the camera
view is a static reference for Pandoras Box.

Exporting an object for PB version 4.5 using the Flightsim Aircraft Exporter

To export the object, make sure it is selected by clicking on it and then choose from the File > Export
Selected from the right-click menu. Export selected as "Flightsim Aircraft Object (*.MDL)".

Since the Flightsimulator uses different units a message box will pop up, simply click "OK" to continue.

In the next dialog that opens go to Options and check "xfile" and "no compile" and click on "GO".

You might save the options so that you don´t have to check this at every export by clicking "Save as
Default".

The object is now properly exported as .x file and can be loaded into Pandoras Box.
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20.1.2.3.2  Export Using the PB Exporter Script

As explained in the introducing chapter , when exporting with the "PB Exporter" for Pandoras Box
version 4.5 and higher, the Native File "PB Native v4.5 PB Exporter" is needed. Please run the
gmax_installer that contains all needed files and copies them to the correct directory automatically
before starting gmax.

If running the fullscreen edition all commands are accessible within the context menu, please right-click
into one of the four viewports to open it. Choose "File" > "Open" to load a file.

The PB Native 4.5 Setup File contains several items: 
- four flat planar object, with different aspect ratios: 4:3 (visible) and 16:9, 16:10, 5:4 (hidden)
- a camera.

If you would export the 4:3 planar plane as it is to an .x File and load it into Pandoras Box, the shape of
a layer would not change since this plane is a reference file to match the full screen scaling of a layer
object. 

If you need another aspect ratio you want to fit your layer or camera to, like 16:9, 16:10 or 5:4, please do
a right-click on the plane to open the context menu and choose Hide > Unhide All.
Then, via the Select by Name-Tool (found in the toolbar) you can choose another aspect ratio and
confirm with clicking the "Select" Button. Open the context menu again by right-clicking and this time,
choose Hide > Hide Unselected.
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The camera helps us with a fixed view to see the boundaries of our output and allows us to create
shapes that cross the boundaries. Please make sure to always work within the camera view when
shaping the grid. You may use the front view to work outside of the screen boundaries, but the camera
view is a static reference for Pandoras Box.

Exporting an object for PB version 4.5 using the PB Exporter

Before exporting the finished object via PB Exporter, please
navigate to Hierarchy tab.
In the region "Adjust Transform" click on Reset: [Transform].

This rotates the axis inside Gmax to fit to Pandoras Box.
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Please navigate to the Utilities Tab now.

Click on MAXScript, and you will get the following menu below
the MAXScript button:

If you now unfold the Utilities list and choose the Pandoras
Box Exporter again, below the list you will get the export
option.

After you clicked [Export Selected], a Dialog opens and asks
you to run the Pandoras Box Exporter. Please execute this
exporter (PB GMAX X File Exporter.exe) that you downloaded.

Choose a file location and your x-file will be created there.
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20.1.3  Warping with gmax

Pandoras Box provides the ability to use shapes and objects for any display output to be rendered to.
This tutorial is intended to show the basic steps for correcting curved screens. If you are interested in
warping please have a look at the Warper  too. It was developed by coolux to ease the warping
process and provides specialized tools to optimize the workflow.

As gmax is a extensive and powerful 3D modeling tool we will only scratch the surface of 3D modeling in
this tutorial. 

Geometric correction has to be set up on-site with the projector hooked up to your system and running
gmax in  full-screen.

First steps: Adjusting the view settings

In order to get started, make sure that gmax is installed properly on your system. If you need to work
from a distance, use a remote desktop viewer like Real VNC to mirror the output of the projectors on
your laptop or PC. 

To gain a maximum warping area, make sure that the Windows taskbar is not set to be "on top of other
windows" by right-clicking on the windows taskbar and choosing its properties dialog.

810
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Start gmax.

If you need to setup two outputs simultaneously, start gmax in Desktop extended mode once for each
screen so that you can edit two warping grids at the same time.

Once gmax is started it is recommended to adjust the following settings for a better workflow during the
screen shaping process:

First of all we want to make sure that the background is all black and that all lines to be edited turn to
primary green. This makes it much easier to see the grid in most lighting conditions.

To do this, click on Customize User Interface in the Main menu. Follow these steps:
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1. Select Viewports from the Elements pull-down menu 
2. Choose Viewport Background 
3. Change the colour in the colour dialog to black
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1. Select Geometry from the Elements pull-down menu 
2. Choose Selection 
3. Change the colour in the colour dialog to primary green
4. Apply the new settings
5. Save these settings for the future in File dialog by overwriting the
   default colour file.

Last, make sure to hide the track bar from the main UI by u-checking "Show Track Bar".

Now you are ready to start warping! Please always make sure that your gmax is set up this way, these
settings are important for working in expert mode with gmax in order to use the full desktop.
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How to warp using a plane

In this next section we will look at the basic deformation of a flat planar object. This tutorial is based on
the steps explained in the previous chapters , please be sure to have downloaded the according gmax
PB Native File and Exporter.

The most common task for screen shaping is a curved screen. To achieve this task, the planar object
must be modified. The grid points have to be re-arranged in a way that the grid unwraps itself on the
curved surface of your screen. To do this, all you need to do is to apply a tool that allows bending and
shaping of planar objects.

In order to apply a new tool or a so called "modifier" in gmax, first select the planar object by clicking on
it. Once it is selected it should turn primary green.

To apply a new modifier to the selected object you will need to switch to the modify mode by clicking on
the "Modify" tab. Here you will see a hierarchy list of the history of the objects modifiers.

In order to apply a new one, select FFD 3x3x3 from the pull down menu.
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Then open the FFD 3x3x3 modifier in the stack and click on the Control Point level. Now you should see
a 9 point orange control point grid surrounding the planar object.
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Since gmax and all objects are always treated as 3D objects, the modifier works also in the 3rd
dimension. Therefore there are 2 more control points underneath each of the 9 points . Since the object
that we want to modify is totally flat we need to make sure to always catch all three control points by
dragging a selection window over the control points.

Now feel free to select and move the control points around to get a feeling of the dynamic behavior of the
underlying planar grid according to the control points positions.

Please Note: Always make sure that none of your points moves towards the Z axis, all control points
must stay at the same distance from the camera at all times. To control this, check your control points
positions in the top and left view.

You might wonder how you can actually draw and shape this plane according to your screen, the answer
is only a few clicks away.

In order to control the FFD´s Control points you are in the control point level of the selected objects
modifier stack. Once you are in this mode you can right-click in the camera view and press CTRL+X to
toggle to the expert fullscreen mode of gmax. By pressing "W" on the keyboard you may toggle to the
maximized camera view.

Now start modeling your planar object according to the physical shape of the screen. 
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If you need to toggle to the front view while in expert mode, you may use the "F" key for front view, "L" for
left view and "C" for the camera view.
The last gmax chapter includes all available shortcuts .

Please make sure that you make all adjustments to match your screens only according to the camera
view, as this is your reference view for Pandoras Box output.

Once you’re done with shaping the screen, you only have to export the selected object from the file
menu and load the object into the output camera.

Anytime you need to get more detailed control over every grid point, explore the "edit mesh" modifier.
Just add it to the stack and choose the Vertex level for in depth control of every segment of the shape.

This modifier will do a great job when you do Softedge setups with over-laying grids. The Edit Mesh
modifier will allow you to get the overlapping vertices accurately on top of each other for a perfect shaped
Softedge blend.
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For this 180 degree screen, two gmax applications are edited at the same time. In the overlapping zone
all vertices were touched up to match exactly the screen deformation.

Exporting an object

Please export your file as an *.x-file. as described in the previous chapters:
- gmax Object Export for PB Vers. 4.1  or
- gmax Object Export for PB Vers. 4.5  (and higher)

20.1.4  gmax Keyboard Shortcuts

F3 - Toggle textured view
F4 - Toggle grid on textured view

F - Front View
C - Camera View
L - Left View
R - Right View
T - Top View
P - Perspective View

G - Toggle Background Grid 

Ctrl+X - Toggle Fullscreen Mode

X - Toggle XYZ Axis Control

20.2  3ds Max

Please make yourself familiar with the basics described in the introducing chapter . You need to know
them when using 3ds Max to create objects to be used in the Warper  or in Pandoras Box . Even
more detailed information can be found in the Warper's chapter "General 3D Modeling Terms ".

If you like to learn how to generally create an object , please refer to the chapter in gmax as these
programs are very similar.
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The next chapter describes the X-File Exporter in 3ds Max .

20.2.1  X-File Exporter for 3ds Max

When creating a warping grid or 3D objects with 3ds Max, you will need to install the x-file exporter in
order to use the object with Pandoras Box.

We recommend using the Panda DirectX Exporter, it can be downloaded here: http://
www.andytather.co.uk/Panda/directxmax_downloads.aspx. Choose the Pandasoft Version according to
your 3ds Max Version and install it, following the installing instructions on the website. 

Please see here the recommended x-file exporting settings for 3ds Max 5:
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20.3  Blender

Please make yourself familiar with the basics described in the introducing chapter . You need to know
them when using Blender to create objects to be used in the Warper  or in Pandoras Box . Even
more detailed information can be found in the Warper's chapter "General 3D Modeling Terms ".
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To set up generic units in Blender, usually you do not have to do anything. The "None" setting matches
the generic unit already. In the same dialog you may adjust the camera to match Pandoras Box'
camera.

If you like to learn how to generally create an object  and how to apply an UVW Map, please refer to
the chapters in gmax.

The next chapter describes how to create and export objects in Blender .

20.3.1  Object Creation and Export Using Blender

Creating objects in Blender

Object creation is very similar in every 3D program, please have a look at the gmax chapter  as well.
For Blender, we suggest the following tutorials to get started with the application itself: http://gryllus.net/
Blender/3D.html

Exporting from Blender to Pandoras Box

If you are done with your object and are ready to export it, first of all, go into Object Mode and press
CTRL+A. Then select "Rotation & Scale". This will apply all your rotation and scaling. It might also be
required to apply "Location". Now you can export either as .x or .3ds

To export directly to Pandoras Box simply choose "File->Export->Direct X (.x)". You might have to
activate the plugin first (see image):
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The Warper, may as well import files saved in 3ds format. Choose "File->Export->3DStudio (.3ds)" to
export a *.3ds file. Refer to the following image for the correct export settings:
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